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Strategic Portfolio Management

Strategically align work with business goals to deliver products and services. ServiceNow® 

Strategic Portfolio Management  (SPM), enables digital transformation by helping you can plan, 
deliver, and track value across different methodologies and drive customer value faster.

https://player.vimeo.com/video/1172311283?
h=67d26d03af&badge=0&autopause=0&player_id=0&app_id=58479

Improve 
productivity 

with Now 
Assist for SPM

Learn about 
various generative 

AI skills that 
are available 

within SPM apps.

Strategic Planning 
Workspace

Innovate from 
product feedback, 

align work 
with strategy, 
and execute 
with flexible 

configurations.

Project 
Workspace

Plan and manage 
projects from 
an interactive 

central workspace.

Resource 
Management 

Workspace

View the allocation 
and breakdown of 
the work assigned 
to the resources 

from a centralized 
workspace.

Portfolio Planning 
Workspace

Enhance your 
traditional product 

and portfolio 
management.

Collaborative 
Work 

Management

Collaborate with 
your teams from a 
central workspace 

and avoid 
switching between 

multiple tools to 
manage work.

Project Portfolio 
Management 

Classic

Follow a simplified, 
team-oriented 

approach to 
managing 

demands, projects, 
programs, 

and portfolios.

SPM custom 
tables

Extend and 
customize your 

Strategic Portfolio 
Management 

applications with 
additional features 

and capabilities.

Organization Extension (com.snc.organization_extension) plugin

Organization Extension (com.snc.organization_extension) plugin activates Goals, Business unit, 
Enterprise strategy, and Business unit strategy entities. It is available on zBoot to all customers 
with demo data.

Business Units, Goals, Enterprise Strategy, and Business Unit Strategy modules are available in 
the Organization application menu.
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Business Applications and Business Capabilities modules are also available within the 
Organization application menu, however, their related tables are moved to Configuration 
Management (CMDB) (com.snc.cmdb) plugin, which is available on zBoot but without demo data.

Learn

• What is strategic portfolio management?

• What is digital transformation?

• What is Gantt chart?

• What is Agile?

• What is the difference between Agile vs. Waterfall?

• What is Agile project management?

• What is a key performance indicator (KPI)?

• What is Project Portfolio Management (PPM)?

• What is a work breakdown structure (WBS)?

• What is value stream mapping (VSM)?

• What is resource management?

Get started

• Understand how to deliver business outcomes with speed and agility using ServiceNow  SPM. 
For more information, see Customer Success Center .

• Learn how to align execution with business goals and priorities. For more information, see 
Strategic Planning.

• Create goals, set targets for them, and evaluate the progress of your goals and targets to 
accomplish the organizational plans and drive business outcomes. For more information, see 
Goal Framework and Goal Framework for SPM.

• Enhance your SPM capabilities with specialized plugins that provide read-only roles for various 
modules, confirming secure access to dashboards and reports.

Applications and features

• Now Assist for SPM

• Collaborative Work Management

• Now Assist for CWM

• Product Feedback

• Portfolio Planning in SPW

• Enterprise Agile Planning

• SPW Dashboards

• Project Workspace

• Resource Management Workspace

• Goal Framework and Goal Framework for SPM

• Project Portfolio Management

• Export to PowerPoint for Strategic Portfolio Management
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• Time Card Management

• Agile Development 2.0

• Microsoft Azure DevOps Integration for Agile Development

• Atlassian Jira Integration for Agile Development

• Test Management applications

• Cost Management

• SPM custom tables

Portfolio Planning
Enhance your traditional product and portfolio management by prioritizing work and visualizing 
plans with ServiceNow®  Portfolio Planning. Effectively plan, track, and manage work for projects 
and demands using a centralized workspace.

Portfolio Planning  is available for users with a Strategic Portfolio Management  (SPM) Standard 
license.

Get started

Explore

Learn the key 
features and value 

that Portfolio 
Planning offers 
your business

Configure

Set up the core 
configuration

Use

Learn how to 
plan and align 

work across 
your portfolios

Prioritize

Rank and prioritize 
work for your 

portfolio plans

Roadmap

Roadmap work for 
your portfolio plan

Report

Export portfolio 
plan and 

roadmap status 
report as a PPT

Integrate

Integrate Portfolio 
Planning with 

Project Portfolio 
Management

Compare

Compare 
capabilities 
of Portfolio 

Planning with 
Strategic Planning
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Scenario planning

Optimize 
planning with 

scenario planning

Demands

Create, evaluate, 
and prioritize 

demands 
throughout the 

demand life-cycle

Reference

Get details about 
components and 

domain separation

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Portfolio Planning
Prioritize, roadmap, and track the work planned for your products and portfolios using Portfolio 
Planning. Enhance management of your traditional project and product delivery approach.

Portfolio Planning  overview

Portfolio Planning  helps you plan work for your products and portfolios in the desired delivery 
perspective. Cascade the plans from the enterprise level down through portfolios and products 
or plan work to align with your business objectives.

With lens in Portfolio Planning, you can flexibly switch between planning perspectives and create 
personalized plans to achieve focused planning for your products and portfolios. From the work 
associated to these portfolio plans, prioritize and roadmap relevant work, thus aligning the right 
execution teams to the right strategy.
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Comparing Portfolio Planning Workspace  with Strategic Planning Workspace

• Portfolio Planning Workspace: Prioritize, roadmap, and track work when using waterfall 
methodology. Enhance traditional portfolio planning for demand and project management.

• Strategic Planning Workspace: Prioritize, roadmap, and track work when using traditional, agile, 
or hybrid methodologies. Align strategy to execution by defining and tracking goals across the 
organization. To learn more about Strategic Planning, see Strategic Planning.
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Feature Portfolio Planning Workspace Strategic Planning Workspace

Pre-defined lens: Project 
Portfolio

Pre-defined lens: Organization

Pre-defined lens: Project 
Program

Pre-defined lens: Product

Pre-defined lens: Strategic 
Investments

Pre-defined lens: Goals

Pre-defined lens: Value 
Stream

Pre-defined lens: Business 
Capability

Lens configuration: Modify 
existing lens

Lens configuration: Create 
new lens

Portfolio plans: Create and 
share

Planning items: Supported 
planning items

Project, Demand Project, Demand, Epic, 
Custom

Supported items for high-level 
planning

Program (pm_program) Strategic Program, Initiative, 
Custom

Planning items: Custom 
planning item tables

Five predefined tables

Prioritization

Hierarchy (Prioritization)

Kanban (Prioritization)

Roadmaps: Timeline

Roadmaps: Kanban

Scenario planning

Scoring

Goals

Product Feedback

Capacity planning
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Feature Portfolio Planning Workspace Strategic Planning Workspace

Financials

Create and share free-form 
roadmaps

Project, Demand, and Program 
tables

Any ServiceNow®  platform 
entity

Enterprise Agile Planning

Dashboards

Monitor goals and strategies 
in ServiceNow  AI Control 
Tower

Strategy and Goals - 
Managing enterprise goals 
using boards

Next Experience for Demand 
Management

Learn about different features of Portfolio Planning  in detail from the following sections.

Lenses in Portfolio Planning

Flexibly switch planning perspectives to prioritize, roadmap, and view the alignment of work 
using personalized portfolio plans. Improve enterprise planning by discovering planning insights 
that drive shared outcomes.

Lenses

Lens in Portfolio Planning  indicate a perspective by which you can prioritize and plan your 
work. Lens and its structure represent the way that different planning managers choose to 
prioritize, fund, and plan work. For example, depending on your role, you can plan work from the 
perspective of a delivery organization, strategic investment, product, and others.

Pre-defined lenses and their structure

Portfolio Planning  provides two pre-defined lenses to get you started with building your portfolio 
plans - Organization and Project Portfolio.

Planning managers can use these lenses based on their role at the company. Each lens includes 
multiple levels, that the personas can plan at, and together these levels form the structure for 
that lens.
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Structure of pre-defined lenses

Lens Planning levels Planning manager Description

Organization

• Company

• Business unit

• Department

• Department head

• Business unit head

Visualize how work is 
aligned to company's 
objectives

Project Portfolio
Portfolio • Product manager

• Portfolio manager

Visualize how work is 
aligned to portfolios 
across the company

Project Program • Portfolio

• Program

• Portfolio manager

• Program manager

Plan, prioritize, and 
roadmap the work in 
your programs.

You can work with your administrator to modify the structure for these pre-defined lenses. For 
more information, see Configuring lens in Portfolio Planning.

Start creating portfolio plans to improve the alignment of your work with the business strategy. 
See Create a portfolio plan.

Portfolio plans in Portfolio Planning

Personalized portfolio plans help you align work with your company's objectives and roadmap 
the right work for the right time.

Portfolio plans overview

Portfolio plans are custom plans per planning manager that are built using a lens. A portfolio 
manager can use the Project Portfolio lens to plan in the perspective of portfolios, and a 
department head can use the Organization lens to plan in the perspective of a department.

As a planning manager, you can create multiple portfolio plans using different lenses. Visualize 
the plans and progress of work from different perspectives and share them with stakeholders.

Using portfolio plans, you can:

• Enable focused planning of work in the desired perspective (lens).

• Prioritize and roadmap the right work to ensure alignment with the company's objectives.

• Reduce the time spent on aligning execution teams to the right work.
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High-level planning using portfolio plans

In Portfolio Planning, you can prioritize and roadmap programs (pm_program) for your 
organization by building high-level portfolio plans. High-level planning items usually span across 
multiple business units, departments, or portfolios of a company. These high-level planning 
items help you further breakdown a company's priorities and achieve specific milestones and 
outcomes.

Using the Hierarchy view, review the work pipeline and drill down to the low-level planning items 
that are associated with your programs.

For example, as an EPMO, you can view the epics associated with each program.

You can use Programs (pm_program) from the Project Program lens to create high-level portfolio 
plans. See Create a high-level portfolio plan.

Here's a sample portfolio plan that shows a few programs of the company 
and the low-level work (projects and demands) that are aligned with 

them.

Start creating portfolio plans to align work with your company's objectives. See Managing 
portfolio plans in Portfolio Planning.

Work prioritization in Portfolio Planning

Prioritize work that is relevant for your portfolio using a centralized Workspace in Portfolio 
Planning. Review and determine the right work to invest in.

Before scheduling the roadmap for your portfolio plan, it’s helpful to first know the existing and 
upcoming workload. Having all the work items listed at one place helps you understand the 
overall work pipeline. The consolidated view enables smoother backlog grooming so that you 
easily review and decide which items must be prioritized.

Using the Prioritization tab in the workspace, you can review all the new and existing work 
for your portfolio plan, representing its backlog. To help you review the workload efficiently, 
Prioritization provides information for each work item such as the associated goal, planned costs, 
and planned benefits. Using these data points, you can stack-rank the items and decide which 
items are to be prioritized over the others.

Prioritization tab

Planning items are listed in a grid format. You can stack-rank the items, group them 
by a desired attribute, and sort them based on their priority by using the drag 
functionality.
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Alternatively, you can use the Hierarchy tab to review and manage your backlog.

Hierarchy tab

This tab displays how work in the current portfolio plan is aligned with respect to 
entities of other lenses. Using the lens switcher, you can change the perspective 
in which you view the alignment of the work. Using the timeline section of the view, 
prioritize work effectively by gaining visibility into the schedule and dependencies 
between the planning items.

For example, as a portfolio manager, you can view the projects and demands created for your 
portfolio all in one place, as your portfolio's backlog. If your portfolio must take up a new project, 
you can add it to this backlog directly. These items are marked as New  for easy identification. 
If you are in discussion over certain items with your stakeholders, mark them as In Review  until 
you decide on its priority. After you decide which items are ready to be worked on, mark them 
as Prioritized  and they would be added to your portfolio roadmap. If you don’t want to pursue a 
project or a demand, mark it Cancelled.

To get started with managing your work pipeline in Portfolio Planning, see Prioritizing portfolio 
plan work in Portfolio Planning.
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Roadmaps in Portfolio Planning

Effectively plan work for your company using visual roadmaps in Portfolio Planning  Workspace.

As your organization grows and priorities change, it’s important to have the flexibility of changing 
existing plans and making new plans with ease. Using roadmaps, you can create a layout of 
current and upcoming plans while aligning them with your business objectives. Share these 
visual plans with other stakeholders across the organization, drive meaningful conversations, 
and validate common understandings.

Each roadmap is a high-level block of work, prioritized by different planning personas such as 
enterprise project managers, portfolio managers, project managers, or others. Roadmaps also 
provide insights to the stakeholders while guiding the delivery teams during development.

The following are the types of roadmaps that you can work with:

• Portfolio plan roadmaps

• Free-form roadmaps

The features available in these roadmaps are:

• Hybrid roadmaps

• Roadmap-level milestones

• Planning item-level milestones

• Planning item dependencies

• Tracking mode

Note: 
Roadmaps are available with Portfolio Planning  by default. Roadmap Planning 
(sn_roadmap_plng) is no longer available to install as a separate application.

Portfolio plan roadmaps

By creating a flexible portfolio plan using lenses, you can prioritize and roadmap work for your 
portfolio. Use these portfolio roadmaps to plan and track work in different perspectives of the 
organization separately, while connecting them to the high-level plans of the company.

Create a portfolio plan  to get started.
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Free-form roadmaps

Free-form roadmaps provide you the flexibility of planning and tracking work from different units 
of your company, such as work across multiple portfolios.

Using a filter condition, you can define what kind of work items you want on your roadmap. If you 
want to have a roadmap dedicated to just the projects of your department, define a roadmap 
for projects to start tracking the progress of current projects and create plans for new ones. See 
Create a free-form roadmap.

Free-form roadmaps provide you the flexibility of planning and tracking work from different units 
of your company, such as work across multiple portfolios.

Using a filter condition, you can define what kind of work items you want on your roadmap. If you 
want to have a roadmap dedicated to just the projects of your department, define a roadmap for 
projects to start tracking the progress of current projects and create plans for new ones.

See Create a free-form roadmap.
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Hybrid roadmaps

In Portfolio Planning, with both the portfolio roadmaps and free-form roadmaps, you can build 
hybrid roadmaps. For example, you can have a combination of projects and demands in a single 
view.

Milestones on the roadmap

You can create milestones for your roadmap, or for each planning item on the roadmap.

Roadmap-level or portfolio-level milestones

The milestones created at the roadmap level can help with tracking launch dates 
or key events during that roadmap's timeline. To learn how to create roadmap 
milestones, see Add milestones for roadmap.

Planning item milestones

Using the milestones created at the item level, you can focus better on strategic 
outcomes. These milestones help with tracking deadlines or other important dates. 
You can access milestones on projects and demands.
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You can create and update milestones for all types of planning items from the 
roadmap, but the project milestones are read-only. As any changes to project 
milestones may impact the associated project plans, it is recommended to 
create or update project milestones using Project Workspace in Project Portfolio 
Management  (PPM).

To learn how to create item-level milestones on a roadmap, see Add milestones for 
roadmap items.

Planning item dependencies

While planning, it is essential to know how your planning items are connected with each other. 
Unless you know the dependency for each item, you might miss prioritizing time-critical projects 
or demands. This lack of information may also put you at risk of not scheduling the right work for 
the right time period.

Dependencies on the roadmap help you visualize these relationships between the planning 
items, so that you can adjust their scheduling accordingly.

In Portfolio Planning, you can create simple or hybrid dependencies. For example, you can 
establish dependencies between two projects or between a project and an epic. Also, planning 
items can have dependency on items within the same portfolio plan or on items that aren't 
planned yet.

The dependency lines help you easily identify the items that may have to be prioritized together. 
Such easy identification of relationships between planning items provides better collaboration 
and facilitates enhanced decision making in the planning process.

To learn about creating and managing dependencies, see Add dependencies for roadmap items.
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Tracking mode in roadmaps

Track status, progress, and metrics for each item on the roadmap. Using the status indicators and 
the percentage complete score on the planning item bars, make informed decisions ahead of 
time and easily communicate your work progress to the stakeholders.

See Track the progress of roadmap items.

Scenario planning in Portfolio Planning

Create and evaluate strategic scenarios to explore different planning approaches. Approve the 
optimal scenario that aligns with the organizational goals and strategic priorities.

Scenario planning overview

Scenario planning in Portfolio Planning  enables organizations to create, evaluate, and approve 
the best strategic scenario that aligns with their strategic goals and intended business 
outcomes. This process helps in visualizing different approaches, assessing their impacts, and 
making informed decisions before implementing the live plan. By utilizing scenario planning, 
organizations can anticipate potential challenges.  Scenario planning overview

What is a scenario

A scenario in Portfolio Planning  is a simulated version of a plan that enables you to explore a 
strategic approach without affecting the live plan. It provides a safe environment to prioritize 
items, adjust timelines, and evaluate the potential impacts of each approach.
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As compared to a plan, a scenario additionally has the following:

• In Plan  toggle: The In Plan  toggle enables you to prioritize or de-prioritize the planning items 
in the scenario you’re creating. By default, when you create a scenario, the In Plan  toggle is 
turned on for planning items that have all of the following field values:

◦ Planning state as Prioritized or Done

◦ Start and end dates within the portfolio plan dates.

• Date  fields: The Start date  and End date  fields for the scenario are automatically populated 
based on either the planned or actual start and end dates of the planning items. You can 
update these dates during the scenario planning process. Once the scenario is approved, the 
updated dates are recorded as the approved dates for the planning items. If the updated dates 
fall outside the acceptable range, they’re highlighted in yellow.

For more information on portfolio plans, see Portfolio plans in Portfolio Planning.

By comparing scenarios side by side, you can assess the differences in goal alignment and 
trade-offs between each scenario. This comparative analysis helps identify the scenario that 
best meets strategic objectives. For more information on comparing the scenarios, see Compare 
scenarios.

Scenario planning workflow in Portfolio Planning

Using the Scenario Planning feature in Portfolio Planning, you can perform the following 
activities:

• Create a scenario to explore different strategic approaches and business outcomes. For more 
information, see Create a scenario.

• Adjust and compare multiple scenarios side by side to evaluate differences in goal alignment 
and trade-offs. For more information, see Compare scenarios.

• Approve the best scenario that aligns with the organizational goals. For more information, see 
Approve a scenario.

• Set a target portfolio budget for each of your planning cycle, which can be for fiscal period, 
quarter, yearly, or portfolio timeline.

• Evaluate the target vs proposed budget of In-plan items and review the monetary benefit from 
the prioritized items.
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Scenario Planning workflow overview

The scenario planning workflow involves an execution owner and a portfolio owner. The following 
illustration illustrates how scenario plans are created based on the planned or actual dates of 
planning items and how the In-plan toggle is adjusted based on the states of these planning 
items.
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User journey in Scenario planning

For more detailed guidance on using scenario planning to enhance your Portfolio Planning 
process, see Optimizing planning with scenario planning in Portfolio Planning.

Portfolio Planning  with Project Portfolio Management

Facilitate execution of the work planned in Portfolio Planning  in ServiceNow  Project Portfolio 
Management  (PPM) application.

While planning personas like portfolio managers or product owners use Portfolio Planning  to 
align their plans with the business objectives, execution teams can use PPM to deliver work on 
the planned projects and demands.

Portfolio Planning  integration with ServiceNow®  Project Portfolio Management

Key benefits of Portfolio Planning  with PPM

• View available PPM planning items in Portfolio Planning.

• Import planning items from PPM to Portfolio Planning.
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• Export planning items from Portfolio Planning  to PPM.

• Synchronize updates for linked planning items of Portfolio Planning  with PPM.

• Track the progress of the linked planning items in Portfolio Planning.

To get started on integrating Portfolio Planning  with PPM, see Configuring Portfolio Planning with 
PPM.

Capacity planning in Portfolio Planning

The Capacity Planning screen provides portfolio managers a comprehensive view of capacity, 
allocations, and utilization of resources.

Analyzing the Capacity Planning screen, you can easily:

• View resource capacity for prioritized items in your portfolio.

• Understand the resource capacity needs and estimates across your organization by using key 
attributes such as group, role, and skill.

• Effectively forecast the supply of resources and the demand of work in your portfolio.

• Understand and get an overview of the resource capacity allocations by using the color 
indicators.

• Plan for resources with specific skills or roles for future assignments.

• View the resource allocation health instantly with the new intuitive user interface that gives you 
a detailed breakdown of portfolio duration by month having over allocations.

Capacity Planning screen

• The top tray of the screen displays:

◦ Resource capacity details depending on the defined resource criteria.

◦ Allocation details for the time period.

◦ Resources grouped by primary attributes.

• The bottom tray of the screen displays:
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◦ Prioritized planning items.

◦ Interactive Gantt chart for the duration of planning items.

You can click a Gantt chart bar to see the capacity for that specific planning item only.

You can move the Gantt chart to adjust your resource capacity details accordingly.

◦ Toggle option ( ) to adjust your view of the Capacity Planning screen.

Using the Capacity Planning screen

Follow these steps to analyze and manage resource capacity for your portfolio:

1. Navigate to Portfolio Planning  > Portfolios  and open a portfolio.

2. Select the Capacity  tab to open the Capacity Planning screen.

3. In the top tray, define your resource criteria by selecting primary attributes such as Group, 
Role, or Skill  to filter the resource view.

4. Review the resource capacity bars to identify over-allocated or under-utilized resources across 
the time period.

5. In the bottom tray, review prioritized planning items and their Gantt chart bars. Select a Gantt 
bar to see capacity for that specific item.

6. Drag the Gantt bars of planning items to adjust planned dates based on available resource 
capacity.

Note: 
Planning items with actual dates (indicated by the in-progress icon) cannot be adjusted.

7. Use the toggle option ( ) to adjust your capacity view between different display modes.

Financial planning for Projects and Demands

Plan, re-forecast, track the financials, and create baselines for projects and demands.

The financials view provides a streamlined perspective, showcasing the actual and planned 
expenses for the entire fiscal period. You can view the latest estimated cost of completion by 
displaying the Actual costs for the past fiscal periods, planned costs for the current and future 
fiscal periods, the totals for quarter, year, and total duration of work.

The interface gives you the ability to create cost plans, expense lines, and baselines. As a project 
manager or a financial user, you can:

• Enter high-level financial forecasts for planning items using the simple financials section in the 
Details tab.

• Work on high-level estimating for Planned opEx and Planned capEx.

• Create a detailed breakdown of the planned costs using the financials tab.

• View the rollups of Planned costs, Actuals costs, and Planned benefits for all of your planning 
items in the Prioritization grid.

• Add, edit, or delete cost plans  effortlessly from the Cost screen.

• Re-forecast your planned expenses using the in-line editing feature.

• View a streamlined perspective, showcasing your actual costs for the past and planned 
expenses for the future, for the entire time scope of the planning item.
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• Get a better comprehensive solution by viewing the Forecast (previously EAC - Estimate at 
Completion), Remaining Estimates (previously ETC - Estimate to Completion), and Actuals of 
each cost plan for the total time scope and the yearly breakdowns.

• Re-forecast the planned cost for future fiscal periods by directly updating the quarterly and 
yearly totals using the in-line editing capability of the grid.

• Generate labor costs  depending on the resource assignments for the entire scope of the 
planning item broken down by the financial attributes configured for your organization. For 
more information on the planning attributes for attribute-based mapping, see Using the 
Planning attributes.

• Add or edit expense lines  against the cost plans easily from the side panel with the associated 
cost plan details pre-populated.

• Record unplanned expenses using the New expense line side panel.

• Create and compare financial baseline to track the financials of your planning items.

• Compare the latest costs (actual expenses for past fiscal periods and planned costs for 
current and future fiscal periods) with the initial forecasted planned costs by creating financial 
baseline and using the compare baselines capability.

• Analyze the cause of variance in costs and when did this occur over time by capturing the 
financial baselines manually or automatically.

You can view the following information on the financials screen.

• Time scope: duration of the planning item or a cost plan, whichever has a larger fiscal period 
range.

• Functional currency: currency defined and used to calculate the financials.

• Customizable widgets showing different financial information such as allocated budget, 
Forecast (previously EAC - Estimate at Completion), Variance (the difference between budget 
and Forecast), breakdown of planned costs, and actuals by cost type.

Note: 
Budget and Budget vs EAC Variance widgets are available for Demands and Projects 
only.
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• Time scale: time period breakdowns to view the financials. Default value is set to Month/
Period, depending on the fiscal calendar type.

• Display mode: list options to switch between different modes to get a focused view of 
financials.

• Generate labor costs: one-click solution to generate or refresh the planned labor costs for the 
planning item depending on resource assignments.

Note: 
This option is enabled for the projects with resource assignments only.

• The pane gives you a tabulated view of the cost plan attributes displaying the Name, Cost type, 
Expense type, Stat fiscal period, End fiscal period, Total planned cost, Employee type, and 
Role. You can customize these fields. For more information, see Customize the left pane view 
for financials.

• In the right pane, you can view the total Actuals, Forecast, and Remaining Estimates for the 
selected Time scope duration. Actual expenses against a cost plan for the past fiscal periods, 
Actuals, Forecast, and Remaining Estimates for the current fiscal year, and planned costs for 
the current and future fiscal periods.

Note: 
The header rows of actuals and planned are color-coded differently to help you easily 
identify and differentiate between the expense types.

• New cost plan: opens a simplified side-panel to create a new cost plan for the entity.

• Personalize option to customize the columns in the left pane of the table.

• Export option to download Cost or Baselines comparison as Microsoft Excel or CSV file.

Dashboards in Portfolio Planning Workspace

As a product and portfolio manager, use dashboards in Portfolio Planning Workspace  to monitor 
performance, track progress, and make informed decisions related to planning and execution. 
These dashboards leverage Platform Analytics  to provide a trend of historical data and regular 
reports.

The Execution Dashboard is available in the Portfolio Planning Workspace:

You can use the default dashboard or create your own dashboards to monitor performance and 
take informed decisions.

Benefits of dashboards

• Create data visualizations and add them to the dashboards using the Platform Analytics 
experience.

• Monitor performance, track progress, and make informed decisions related to planning and 
execution.

• Duplicate existing dashboards and customize them as needed, without modifying the out-of-
the-box dashboards.

• Use the out-of-the-box dashboards or configure your own dashboards as needed.

• Share dashboards with stakeholders to enable collaboration.
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• View relevant data by applying filters directly within a dashboard.

• Any filters applied are saved as part of user personalization and are available the next time you 
log in.

For guidance on using and managing dashboards in the Portfolio Planning Workspace, see Using 
dashboards in Portfolio Planning.

Better together with other ServiceNow®  applications

Integration of Portfolio Planning  with other ServiceNow®  applications helps portfolio and product 
managers to optimize planning, collaboration, and release management for their products.

Portfolio Planning  with Collaborative Work Management

With the integration of ServiceNow®  Collaborative Work Management  (CWM) with Portfolio 
Planning, you can plan and roadmap with Boards in a portfolio plan. By adding CWM  Boards to 
a lens configuration, you can access them in the Prioritization and Roadmap pages of a portfolio 
plan as planning items.

The lenses supported to configure CMW Board as a planning item are Organization and Project 
Portfolio.

For more information on integration of CWM  with Portfolio Planning, see Connecting CWM with 
Strategic Planning or Portfolio Planning.

Configuring Portfolio Planning
Learn about the process required to set up Portfolio Planning  to enable your product and 
portfolio managers start aligning their work business objectives.

Configuration workflow

Use the following steps as guidelines to set up Portfolio Planning. Some of these steps require 
the admin role and some require the sn_align_core.apw_admin role.

1. Install Portfolio Planning.

2. Assign user roles.

See the Roles installed table in Components installed with Portfolio Planning.

Note: 
If you are upgrading from an older version to Portfolio Planning  v6.1.1 or higher, a fix script 
is run to remove the milestone_editor role from the roadmap_editor role because the 
roadmap_editor role is no longer used. In this case, you may experience a longer time for 
the upgrade to complete if your ServiceNow  instance has a large number of users with 
the roadmap_editor role. For more information, see KB1443618 .

3. Configure lenses to enable portfolio plans.

See Configuring lens in Portfolio Planning.

4. Integrate ServiceNow®  Portfolio Planning  with Project Portfolio Management  (PPM).

See Portfolio Planning with Project Portfolio Management.

5. Configure Capacity Planning and generate resource capacity.
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See Capacity configuration in Portfolio Planning.

6. Enable financial planning for epics and customise the Financials screen view.

See Configure financials for Portfolio Planning.

Guided Setup to configure Portfolio Planning

Guided Setup provides a sequence of tasks to help you with the required configuration on your 
ServiceNow  instances. After installing Portfolio Planning, navigate to All  >  > Portfolio Planning  > 
Guided Setup.

When you’re configuring a task from the Guided Setup, you can launch the in-app help for 

additional guidance by clicking the Show Help icon ( ).

Install Portfolio Planning

You can install the Portfolio Planning  application (sn_align_ws) if you have the admin role.The 
application includes demo data and installs related ServiceNow®  Store  applications and plugins 
if they are not already installed.

Before you begin

• Confirm that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Portfolio Planning  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

Role required: admin

About this task
The following items are installed with Portfolio Planning:

• Roles

• Tables

For more information, see Components installed with Portfolio Planning.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Portfolio Planning  application (sn_align_ws) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.
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5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data comprises the sample records that describe application features for the common 
use cases. Load the demo data when you first install the application on a development or test 
instance.

6. Select Install.

Result
The following components are installed with installation of the Portfolio Planning  application:

• Roles

• Tables

See Components installed with Portfolio Planning  for more information.

Configuring lens in Portfolio Planning

Learn about lens structure and pre-defined lenses in Portfolio Planning  so that you can configure 
a lens that represents your company's planning process.

Lens structure

Each lens in Portfolio Planning  consists of a structure that is made up of lens entities. These 
entities represent different levels of planning. Planning managers can build portfolio plans at one 
of these levels, and create plans for the type of work items that are associated to this lens.

Sample lens structure

Pre-defined lenses in Portfolio Planning

Two pre-defined lenses, Organization and Project Portfolio are available.

For example, the Organization lens has Company, Business Unit, and Department as its entities. 
A department head can create a portfolio plan at the department level, and start to prioritize and 
roadmap the department's work. This work can be in the form of projects, demands, or any other 
custom type that is configured.
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Lens structure of pre-defined lens

In the Portfolio Planning  Workspace, planning managers can get started with creating portfolio 
plans with one of the pre-defined lenses.

Planning items for a lens

For every portfolio plan that is built using a lens, only those item types that are included with that 
lens are available for planning. For example, a lens XYZ has just demands added to it. Then, in 
any portfolio plan that is built using the XYZ lens, work can be planned in the form of demands 
only.

Configuring lens and lens structure

You can either use a pre-defined lens as it is or update its existing configuration.

• To use the lens as it is, complete your lens setup by configuring integration with a ServiceNow 
Project Portfolio Management.

See Configuring Portfolio Planning with PPM.

• To update the lens configuration:

◦ Change the planning items included within the lens. See Lens Form.

◦ Add more entities to the lens structure. See Modify lens structure in Portfolio Planning.

Modify lens structure in Portfolio Planning

Add or modify entities for your lens structure so that your planning managers can start creating 
their portfolio plans in Portfolio Planning.

Before you begin
Ensure that your application scope is set to Portfolio Planning Core.

Role required: admin
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About this task
For a lens, add entities to modify its existing structure. You can add up to six entities in a lens 
structure. For more information on lens and its structure, see Configuring lens in Portfolio 
Planning.

Procedure

1. Navigate to All  > Portfolio Planning  > Lenses.

2. From the Lenses list, select a lens for which you want to update the lens structure.

3. Add an entity to the lens structure.

a. From the Lens structure related list, select New.

b. On the form, fill in the fields.

For field information, see Lens structure form.

c. Select Submit.

4. Repeat step 3 to complete adding all your lens entities.

◦ Add the entities in a top-down manner:

Add the top-level entity first, followed by the second-level entity, followed by the third, and so 
on.

◦ Ensure that every entity, except the top-level, has a parent entity reference.

For example, the second-level entity must refer to the top-level entity as its parent.

What to do next

1. Verify that the Planning item table [sn_align_core_planning_item] has a field that references 
the bottom entity of this lens.

2. Ensure that the following form views for all the planning item types that are associated in your 
lens contains a field for the bottom entity of your lens structure.
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◦ APW Preview

◦ APW New

◦ APW Default

3. Update the roadmap configuration for the tables of all planning item types that you associate 
with this lens:

Add the bottom entity of this lens structure and its parent to Group by fields  and Color by 
fields. These fields are used as the default group by and color by settings for the portfolio 
roadmap. See Customize the planning item display preferences for Prioritization and Roadmap 
in Portfolio Planning Workspace.

4. Validate your lens configuration and activate it. See Activate a lens in Portfolio Planning.

Activate a lens in Portfolio Planning

Validate your lens configuration and activate it so that your planning managers can start creating 
portfolio plans using this lens.

Before you begin
Role required: admin

About this task
If you've changed the structure of an existing lens, validate its configuration and set its state to 
Active.

Planning managers can create portfolio plans using only lenses that are active. For a lens to be 
available in the workspace for a planning manager, its configuration must be valid and must be in 
the Active state.

Procedure

1. Navigate to All  > Portfolio Planning  > Lenses.

2. From the Lenses list, select a lens.

3. On the lens form, click the Validate Lens  related link.

◦ If the lens configuration is valid, a success message prompts you that you can now activate 
it.

◦ If the lens configuration isn’t valid, use the error messages to understand the issues and fix 
the configuration.

Try validating the lens using the related link again.

4. Select the Active  field and save the form.

Related topics

Modify lens structure in Portfolio Planning

Configuring additional columns for Prioritization page in Portfolio Planning

Configure what columns must be displayed on the Prioritization page of portfolio plans so that 
your planning managers can select the appropriate data points they need.

Portfolio managers or product owners can show or hide the data for their planning items by using 
the Personalize side panel in the Prioritization page of their workspace. By default, this side 
panel of Prioritization and Hierarchy tabs provide all the default fields available for that planning 
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item. If your planning managers want to see additional columns, for example, there could be 
a requirement of information from a dot-walked field. In such cases or to remove any existing 
choices, you can configure them using the admin role.

Personalize settings for List view Personalize settings for Hierarchy view

Add extra columns as choices to this side panel or remove any of the default column choices by 
updating the list layout configuration for the planning item types associated to the portfolio plan.

• If the portfolio plan has multiple item types associated to it, update the view configuration of 
the Planning Item [sn_align_core_planning_item] table.

• If the portfolio plan has a single item type associated to it, update the view configuration of the 
relevant table.

From the form view of the identified table, change the view to APW Prioritization, and update the 
list layout. For the detailed procedure of updating the layout configuration for a list, see Configure 
the list layout .

Note: 
List v3 is no longer available for new deployments. If you are already using list v3, you may 
continue to do so, but in this case some of the functionalities might not be available.

Configuring Prioritization and Roadmap settings in Portfolio Planning

Configure the way data is shown on the Prioritization and Roadmap pages of the workspace so 
that your planning managers view the information that is relevant for them.
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Customizing highlighted fields on prioritization tab of Portfolio Planning  workspace

Customize the fields to be highlighted on the Prioritization tab of a portfolio plan according to 
your planning manager's needs.

By default, the Prioritization and Hierarchy tabs of a portfolio plan highlight the Planning 
state  and Status  fields of a planning item with colors. Based on your planning manager's 
requirements, you can configure fields that are of Choice type, such as Owner or Priority to also 
be the highlighted columns on the page. This customization requires:

• Modifying the Prioritization view Script Includes (APWBacklogConfigImpl for List view and 
APWGanttConfigImpl for Hierarchy view).

• Configuring a new record for the required field in the sys_highlighted_value table.

Modify Script Includes for Prioritization page in Portfolio Planning

Modify the Script Includes for List and Hierarchy views of the Prioritization page to change the 
columns to be highlighted in these views in the workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Script Includes.

2. From the list, select one of the following:

◦ For List view, select APWBacklogConfigImpl

◦ For Hierarchy view, select APWGanttConfigImpl

3. Update the column name in the Script  field of the Script Include.

In the getColumnsForHighlightedValues  function, update the return value to the 
desired column.

For example, if you want to highlight the Priority column, update the return value to 
("planning_state", "state", "priority").

4. Select Update.

What to do next
Create new highlighted values for Prioritization columns in Portfolio Planning

Create new highlighted values for Prioritization columns in Portfolio Planning

Customize the fields to be highlighted on the Prioritization page of a portfolio plan according to 
your planning manager's needs.

Before you begin
Modify Script Includes for Prioritization page in Portfolio Planning.

Role required: admin

Procedure

1. Navigate to Workspace Experience  > Administration  > Highlighted Values.

2. Select New.

3. On the form, fill in the fields.
For field information, see Highlighted Value form.
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4. Save the form.

5. In the Highlighted Value Conditions related list, create records to configure the color, order, 
and icon for each of the field values that you want to be highlighted in the workspace.

a. Select New

b. On the form, fill in the fields.
For field, information, see Highlighted Value Condition form.

c. Select Submit.

6. Repeat step 5 to complete this configuration for all the field values.
For example, if you are configuring for status column, you must create three records in the 
Highlighted Value Conditions related list for each of the choices Red, Green, and Yellow.

7. Select Update.

Modify Script Includes for milestone icons in Portfolio Planning Workspace

Modify the Script Includes for milestone icons of the roadmap and portfolio plan to customize the 
icons to be shown in the Roadmap tab in the workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Script Includes.

2. From the list, select RoadmapMilestoneAPIImpl.

3. Update the milestone icon type in the Script  field of the Script Include.
In the getMilestoneMetadata  method, update the return value to the required icon.

For example, if you want to display the Circle exclamation icon ( ) for key event milestone, 
update the return value to 'circle-exclamation-outline'  for the key_event 
milestone.

The default icons are as follows:

◦ key_event: 'flag-fill'

◦ launch_date: 'rocketship-fill'

◦ important_date: 'calendar-clock-fill'

◦ key_milestone: 'diamond-fill'

◦ deadline: 'star-fill'
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4. Select Update.

Configure additional source tables for free-form roadmap in Portfolio Planning

Add new tables to roadmap preferences and configure their details so that these tables can be 
used as source tables while creating a free-form roadmap in Portfolio Planning.

Before you begin
Install Portfolio Planning.

Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Portfolio Planning  > Portfolio Plan Configuration.

2. Select New.

3. On the form, fill in the fields.
For field information, see Portfolio plan configuration form.

4. Select Submit.

Customize the planning item display preferences for Prioritization and Roadmap in Portfolio 
Planning  Workspace

Update source table configurations so that you can customize the roadmap view in Portfolio 
Planning  according to your business priorities.

Before you begin
Install Portfolio Planning.

Role required: sn_roadmap_plng.roadmap_admin or sn_align_core.apw_admin

About this task
For the source tables that you use to create your portfolio plans or free-form roadmaps, modify 
the configuration. You can update the fields to group and color the items on the roadmap, the 
metrics to be displayed for each item, and others.
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Procedure

1. Navigate to All  > Portfolio Planning  > Portfolio Plan Configuration.

2. Open a table for which you want to edit the configuration.

3. Edit the required fields.
For field information, see Portfolio plan configuration form.

4. Select Update.

Update the display limit of items for Prioritization and Roadmap in Portfolio Planning

Create a system property to update the display limit of the items shown in Prioritization page, 
Roadmap page, and the item milestones on the roadmap view in Portfolio Planning.

Before you begin
Ensure the application scope in your instance is set to Global.

Role required: admin

About this task
The default display limit for Prioritization and Roadmap pages are:

• Planning items shown in the Prioritization tab = 250

• Roadmap items shown in the Roadmap tab = 250

• Item-level milestones in the Roadmap tab = 100

• Items shown in the Kanban tab = 250

If the total number exceeds these default limits, the additional number of planning items, 
milestone indicators, and vertical lanes are not visible in the workspace. To overwrite this default 
setting, create a system property and set it value to a desired limit of display.

Important: 
If the value of a system property exceeds its default value, the UI performance can degrade.

Procedure

1. Navigate to All  > System Properties  > All Properties.
A list of all the properties in the System Properties [sys_properties] table appears.

2. Click New.

3. On the form, fill in the fields.
For information on the other form fields, see the field description table in Add a system 
property .

4. Select Submit.

Hierarchy view configuration in Portfolio Planning

Show or hide parent records of planning items shown in the Hierarchy view for high-level and 
regular portfolio plans by configuring system properties.

Display empty parent entities in the Hierarchy tab

In the Hierarchy tab, the parent records are displayed only if they have any 
associated planning items.
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For example, a portfolio plan built from the Organization lens (Company > Business 
Unit > Department) is used to manage and track plans for Demands and Projects. 
So, when you switch to the Hierarchy tab, only those departments that have at least 
one Demand or Project associated with it are shown in the view.

If you want to see other departments that are included in this portfolio plan but have 
no planning items associated to them, work with your administrator to create the 
system property sn_align_ws.gantt_hide_empty_entities  and set it to 
false.

Display complete hierarchy for high-level portfolio plans

For high-level portfolio plans, the Hierarchy tab by default shows only the hierarchy 
up to the parent level.

For example, a portfolio plan built from the Strategic Investment lens (Company > 
Strategic priority > Initiative > Strategic program) is used to manage and track plans 
for strategic programs. So, when you switch to the Hierarchy tab, only Strategic 
Priority > Initiative levels are shown by default.

If you want to see the whole hierarchy of Strategic priority > Initiative > Strategic 
program > planning items, work with your administrator to create the system 
property true.
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Configuring roadmap in Portfolio Planning

Create custom themes to configure roadmap bar colors, ensuring they align with your 
organization’s standards.

Use the following steps as guidelines for configuring custom themes for your roadmap bar colors:

1. Create a custom theme for roadmap bar colors. For details, see Create a custom theme for 
roadmap.

2. Publish your custom theme so that you can apply it to your roadmap. For details, see Publish a 
custom roadmap theme.

3. Apply a custom theme for your roadmap. For details, see Apply a custom theme to roadmap.

4. Verify that the custom theme is applied for your roadmap.

Create a custom theme for roadmap

Customize roadmap bar colors to align with your organization’s branding guidelines and maintain 
visual consistency.

Before you begin
Role required: admin

About this task
The roadmap applies the colors defined in the UI theme’s Alert  and Grouped  options.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Management  > Theme Builder.

2. From the Theme Builder Home page or Editor page, select Create a theme.
The theme creation wizard opens.

3. On the Before we get started window, select Continue.

Complete the following steps for each screen in the wizard.

Note: 

◦ Only the step 1 (Naming your theme) is required to create a theme.

◦ Configuring items in steps 2–8 (such as primary, secondary, and neutral colors, 
company logo, additional colors, fonts, and corner shapes) doesn’t affect roadmap bar 
colors.

On this wizard screen... Perform these steps...

Step 1 of 9

First, let’s name your theme

a. Enter a name for your theme in the Theme 
name  field.

b. (Optional) Enter a brief description for your 
theme in the Description  field.

c. Select Next  to continue.
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On this wizard screen... Perform these steps...

Step 2–8 of 9

◦ Step 2: What's your brand's primary color

◦ Step 3: Do you want to add a secondary 
color

◦ Step 4: Now, choose a neutral brand color

◦ Step 5: Do you want to add any additional 
colors

◦ Step 6: Next, let's add your company logo

◦ Step 7: Which font would you like to use

◦ Step 8: Almost done. Choose the corner 
shape you prefer.

a. (Optional) Choose the primary color, 
secondary color, neutral color, add any 
extra colors, company logo, font style, 
user interface corner shapes for your 
organization on the respective screens.

b. Select Next  to continue until you reach 
step 9.

Finally, review your selections. a. Review all configured items (colors, logo, 
font, and shape).

b. Select Create theme  to finalize.
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On this wizard screen... Perform these steps...

4. On the Theme Builder page under Global styles, select Color icon ( ) to configure colors for 
your roadmap bars.

5. Under UI colors, in the Show  option, select All colors
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6. Configure Alert colors.

a. Under UI colors, select Alert.

b. Configure colors for the following required alert options.

▪ Alert Critical

▪ Alert High

▪ Alert Warning

▪ Alert Moderate

▪ Alert Info

▪ Alert Positive

▪ Alert Low
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7. Configure Grouped colors.

a. Under UI colors, select Grouped.

b. Configure colors for the following required groups.

▪ Grouped Blue

▪ Grouped Brown

▪ Grouped Gray

▪ Grouped Green

▪ Grouped Green
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▪ Yellow Grouped

▪ Magenta Grouped

▪ Orange Grouped

▪ Orange Grouped

▪ Pink Grouped Purple

▪ Grouped Teal

▪ Grouped Yellow
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What to do next
Publish your custom theme so that you can apply it to your roadmap. For details, see Publish a 
custom roadmap theme.

Publish a custom roadmap theme

Publish a custom roadmap theme so that you can apply it to your roadmap.

Before you begin
You have created a custom theme to apply to the roadmap.

Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Management  > Theme Builder.

2. On the Theme Builder page, select Manager  from the Page  drop-down.

3. In the Unpublished section, find your theme in the list, select the More actions icon ( ), and 
then select Publish.
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4. On the Publish the theme window, select Publish.

Result
Your custom theme is now published.
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What to do next
Apply your custom theme to update the colors displayed in the roadmap. For details, see Apply a 
custom theme to roadmap.

Apply a custom theme to roadmap

Apply your custom theme to ensure roadmap bar colors align with your organization’s style.

Before you begin

• You have created and published a custom theme to apply to the roadmap.

• Ensure the application scope in your instance is set to Portfolio Planning.

Role required: admin

About this task
To update the color theme for your roadmap bars, you must copy the sys_id of your custom 
theme, and then create a system property and set its value to the copied sys_id.

The colors configured in the custom theme will be applied to the roadmap bars. However, these 
colors won’t affect the colors of roadmap milestones or planning item milestones.

Procedure

1. Copy the sys_id of the custom theme.

a. Navigate to Now Experience Framework  > Theme Management  > Themes.

b. Search for the custom theme that you want to apply to the roadmap.

c. Right-click the name of your custom theme and select Copy sys_id.
The sys_id of your custom theme is copied.

2. Create a system property and enter the copied sys_id in the form.

a. Navigate to All  > System properties  > All properties.

b. Select New.

c. On the form, fill in the fields.

System Property

Field Description

Name Name of the system property.

Enter the name as sn_align_ws.spw_custom_theme

Application Application scope for the system property.

Ensure the scope is set to Portfolio Planning.

Type System property type.

Set the type to string.

Value Sys_id of the custom theme you created for roadmap bar colors.
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Field Description

Enter the copied sys_id.

d. Select Submit.

The system property is created and updated to include the custom theme information.

Result
The roadmap bars now display the colors configured in the custom theme.

Customizing Lists in Portfolio Planning  Workspace

You can add custom tables to the Lists menu in Portfolio Planning  Workspace and manage 
access to the newly created categories and lists.

Perform the following tasks to customize Lists and manage access to the newly created 
categories and lists in the Lists page of Portfolio Planning  Workspace:

• Add the New  button to the APW List Menu Configuration page. For more information, see 
Enable adding custom tables to the Lists menu.

• Add custom tables to the Lists menu. For more information, see Customize Lists in Portfolio 
Planning Workspace.

• Manage who can view the newly created categories and lists in the Lists page. For more 
information, see Define audience for new lists in Portfolio Planning.

Enable adding custom tables to the Lists menu

Add the New  action button to the APW List Menu Configuration page, so that you can add 
custom tables to the Lists menu in Portfolio Planning  Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspace Experience  > Actions & Components  > List Actions.

2. From the Action Assignments page, select New  to create the action button.

3. On the form, fill in the fields.
For a description of the field values, see Action Assignment form.

4. Select Submit.

Result
The New  action button is added to the APW List Menu Configuration page.

What to do next
Customize Lists in Portfolio Planning Workspace.

Customize Lists in Portfolio Planning  Workspace

Add custom tables to the Lists menu in Portfolio Planning  Workspace.

Before you begin
Role required: admin
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• Ensure that your application scope is set to Portfolio Planning.

• Enable adding custom tables to the Lists menu.

About this task
Lists menu in the Workspace homepage helps planning managers quickly find a record that they 
need. By default, this view shows the list of entities of all the planning items and lens available for 
this ServiceNow  instance. If your planning managers need more categories or lists, you can add 
them.

For more information of configuring lists in a workspace, see Lists .

Procedure

1. Navigate to sys_ux_list_menu_config.list.

2. From the UX List Menu Configurations list, select APW List Menu Configuration.

3. Select a new category or a new list.

Tip: 
Create a category first and then create a list.

4. On the form, fill in the fields.

◦ UX List Category form.

◦ UX List form.

5. Select Submit.
Repeat this procedure until you've created all the custom categories and lists.

Define audience for new lists in Portfolio Planning

Manage who can view the newly created categories and lists in the Lists page of Portfolio 
Planning  Workspace.

Before you begin
Customize Lists in Portfolio Planning Workspace.

Role required: admin

Procedure

1. Navigate to sys_ux_applicability_m2m_list.list.

2. Select New.

3. On the form, fill in the fields.
For field information, see List Applicability form.

4. Select Submit.

Configure scenario planning in Portfolio Planning

Configure scenario planning in strategic planning to create and compare multiple scenarios.

1. Enable or disable scenario planning.

For more information, see Enable or disable scenario planning in Portfolio Planning.
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2. Manage financial widgets in compare scenarios page.

For more information on how to add and manage widgets to the comparison view, see 
Configure financial widgets in compare scenario.

Enable or disable scenario planning in Portfolio Planning

Enable or disable scenario planning in Portfolio Planning.

Before you begin
Role required: sn_align_core.apw_admin

About this task
Scenario planning is enabled by default. Use the following steps to disable or enable scenario 
planning, as required.

Procedure

1. Navigate to All  > System properties  > All properties.

2. Search for the property 

sn_align_ws.is_scenario_planning_disabled.

3. Verify the value of the property.

◦ To enable scenario planning, verify that the property is set to False.

◦ To disable scenario planning, verify that the property is set to True.

What to do next
Create a scenario

Configure financial widgets in compare scenario

Add or manage existing widgets to view financial insights while comparing scenarios. Define your 
own attribute from the cost types to view it's details in the Compare scenario page.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. In the Widgets list, filter the Short description with Compare scenario  to view the existing list.

By default, there are five financial widgets enabled to compare the financial performance of 
scenarios.
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3. Edit an existing widget or create a widget to use it in scenario planning.

4. Select Submit.

Portfolio Planning  diagnostics

Run diagnostic scans to identify and fix errors in the configuration and other common settings 
for Portfolio Planning  before your planning managers prioritize and roadmap their projects and 
demands.

Portfolio Planning  diagnostic scans help you find discrepancies by validating the configuration 
for the following:

• Lens and lens structure

• Form views, list views, related list views, and workspace view rules for planning items

• Global ranking for planning items

• Portfolio plans

The following are the default diagnostic scans available for Portfolio Planning.

Portfolio Planning  diagnostics

Name of the scan Description

Identify planning items without a global rank Identifies the number of planning items on the 
Prioritization List page, for which the global 
rank is not populated.

If this scan fails, the result shows the planning 
items that do not have a global rank. Click Run 
Fix Script  to populate a global rank to items for 
which this field is empty.

Validate List views for planning items Verifies that all the planning items that can 
be added to portfolio plans have the APW 
Prioritization and APW Default List views.

If this scan fails, the result displays the List 
views that are missing for certain planning 
item tables.
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Name of the scan Description

To learn how to fix these, see Create list views 
for new planning item tables in Strategic 
Planning.

Validate Form section views for planning items Verifies that all the planning items that can 
be added to portfolio plans have the APW 
Prioritization, APW Default, and APW New form 
views.

If this scan fails, the result displays the Form 
section views that are missing for certain 
planning item tables.

To learn how to fix these, see Create form 
views for new planning item tables in Strategic 
Planning.

Validate Related list views for planning items Verifies that all the planning items that are 
allowed on portfolio plans have the APW 
Default Related list view.

If this scan fails, the result displays the Related 
list views that are missing for certain planning 
item tables.

To learn how to fix these, see Create related 
list views for new planning item types in 
Strategic Planning.

Validate Workspace view rule for Default view 
of planning items

Verifies that all the planning items that are 
allowed on portfolio plans have the Default 
view's workspace view rule.

If this scan fails, the result displays the Default 
view rule is missing for certain planning item 
tables.

To learn how to fix these, see Create 
workspace view rules for new planning item 
forms in Strategic Planning.

Validate Workspace view rule for APW  Default 
view of planning items

Verifies that all the planning items that are 
allowed on portfolio plans have the APW 
Default view's workspace view rule.

If this scan fails, the result displays the 
APW  Default view rule is missing for certain 
planning item tables.

To learn how to fix these, see Create 
workspace view rules for new planning item 
forms in Strategic Planning.
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Name of the scan Description

Validate invalid fields in the Portfolio Plan 
configuration

Finds any invalid fields in the portfolio plan 
configuration records for all existing portfolio 
plans.

If this scan fails, click Run Fix Script  to remove 
the identified invalid fields.

Validate Portfolio Plan Configuration for all the 
portfolio plans

Verifies if each existing portfolio plan created 
in your instance has a valid portfolio plan 
configuration.

Capacity configuration in Portfolio Planning

Generate employee profiles for resources and map them with primary attributes to start capacity 
planning.

• Enable the planning attributes for capacity to map resources to a unique attribute. For more 
information, see Enable planning attributes for capacity in Portfolio Planning.

• Create resource assignments and generate employee profiles. For more information, see 
Generate employee profiles for resources to work with capacity planning.

• Map resources to a unique group, role, and skill to generate employee profiles. For more 
information, see Map primary attributes to resources.

Enable planning attributes for capacity in Portfolio Planning

Enable the planning attributes Group, Skill, and Role so that your planning managers can view 
the resource capacity details.

Before you begin
Role required: admin

Note: 
This activation is a one-time task to enable planning attributes to plan and work on resource 
capacity.

Procedure

1. Navigate to All  > Portfolio Planning  > Planning Attributes.

2. Filter the Attribute name to locate and open the Group  attribute.

3. Select the Enable for capacity planning  option.

4. Select Update.

Note: 
If an attribute is enabled for capacity planning, it is enabled for resource management by 
default.
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5. Repeat the steps 2 through 4 for the Skill  and Role  attributes.

You can create custom attributes and map them to resources. For more information, see Create 
or edit planning attributes.

6. Set the value of the Enable for capacity planning column for Group, Role, and Skill field to true.

What to do next

1. Configure attribute values: Navigate to All  > Strategic Planning  > Planning Attributes  to view 
and manage attribute values. You can add, edit, or import attribute entries for Group, Skill, and 
Role.

2. Map attributes to resources: Assign the enabled planning attributes to your resources so they 
appear in capacity views. For custom attributes, see Create or edit planning attributes.

3. Start capacity planning: Navigate to the Capacity tab in your Strategic Planning 
Workspace  to view resource capacity based on the enabled attributes.

Generate employee profiles for resources to work with capacity planning

Generate employee profiles for the resources to map against primary attributes.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Employee Profile  > Employee Definition.

2. Filter the name to locate and open the sys_user table.

3. In the Employee Definition page, select User  from the Table list.

4. Use the condition builder to filter the required resources and then select the update count icon 

( ).

5. Select Generate Employee Profiles  ( ).

6. In the Generate Employee Profiles window, select Proceed.

Result
Employee profiles for the selected resources are generated.

What to do next
Populate a primary group, primary role, and primary skill for the resources with employee profiles. 
For more information, see Map primary attributes to resources.

Map primary attributes to resources

Locate and map the primary group, primary role, and primary skill for the resources associated 
with existing employee profile tables.

Before you begin
Generate employee profiles for resources to work with Capacity.

Role required: admin

Procedure

1. Navigate to All  > Employee Profile  > Employee Profiles.

2. Filter the User column to locate and open the resources with employee profiles.

3. Select the Populate primary resource attributes  related link to auto-populate the attributes.

◦ If an employee is assigned to a single group, role, and skill, the primary attributes are 
populated.

◦ If an employee is assigned to multiple groups, skills, or roles, select the Primary Resource 
Group, Primary Resource Role, and Primary Resource Skill, using the lookup icon.

4. Select Update.

Activate a scheduled job to automatically generate resource capacity

Activate the scheduled job to auto-generate the resource capacity at required cadence.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Generate Resource Capacity.

3. Select Active  option to activate the schedule job.
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4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

Configure financials for Portfolio Planning

Configure the ServiceNow  Internal integrations to view the financials for planning items in 
Portfolio Planning.

Before you begin
Role required: admin

Procedure

1. Configure the attributes to generate labor costs in financials based on the resource 
assignments on the work items.
For more information, see Using the Planning attributes  and Create or edit planning attributes.

2. Generate default mapping configurations to create table maps.
For more information, see Generate default mapping configurations.

3. Create new widgets to view the rolled up financial data at planning item level.
For more information, see Configure a widget and associate it with project.

4. Optional:  Customize the left pane in the financials screen to match the requirements of your 
organization.
For more information, see Customize the left pane view for financials.

5. Enable budgeting option to allocate and manage budget of your planning items.
For more information, see Enable financial budget allocation for planning items in Portfolio 
Planning.

6. Configure the budget attribute to expense type or cost type to manage the budget of your 
planning items.
For more information, see Configure budget attribute at instance-level to allocate budget.

7. Optional:  Customize the Create cost plan form fields to match the requirements of your 
organization.
For more information, see Customise cost plan form.

8. Customize the default expense types to manage cost plans for your planning items.
For more information, see Change the default expense type in Portfolio Planning.

9. Define a custom prefix for your baseline name.
For more information, see Create a custom prefix for baseline.

10. Activate and define a scheduled job to migrate budget for your planning items.
For more information, see Activate a scheduled job to migrate budget of your planning items

11. Activate and define scheduled job to automatically create financial baselines for your planning 
items at a defined cadence.
For more information, see Activate a scheduled job to create financial baselines for your 
projects and demands.

12. Activate and define a scheduled job to generate labor costs for your projects and demands 
based on the attribute-based resource assignments.
For more information, see Activate a scheduled job to generate labor costs for your projects 
and demands.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

58

https://www.servicenow.com/docs/access?context=t_ScheduleAScriptExecution&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US#t_ScheduleScriptExecution
https://www.servicenow.com/docs/access?context=t_ScheduleAScriptExecution&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US#t_ScheduleScriptExecution
https://www.servicenow.com/docs/access?context=t_ScheduleAScriptExecution&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US#t_ScheduleScriptExecution
https://www.servicenow.com/docs/access?context=t_ScheduleAScriptExecution&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US#t_ScheduleScriptExecution


Customize the left pane view for financials

Customize the left pane for financials to view custom field information.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate and open the Cost Plan  table.

3. Select the Show List  related link.

4. Select the financials view by navigating to List controls  > View  > Financials View.

The selected view ( ) is displayed on the header.

5. Select the header options to configure list layout.
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6. Add or remove the fields in the Selected column to customize the left pane view in financials 
view.

7. Select Save.

Result
Cost plans table with customized fields for Financials View is displayed.

Enable monetary benefit plans for planning items

Enable the benefit plans property to create and manage benefit plans for planning items.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open 
sn_invst_pln.enable_benefit_plan_in_new_financials  property.

3. Enter true  in the Value field.

4. Select the Update  button.

Add monetary and non-monetary benefit plans related lists

Add the monetary benefit plans and non-monetary benefit plans related lists for your planning 
item.

Before you begin

• This is a one time activity to enable and view the monetary benefit plans and non-monetary 
benefit plans related list for all the planning items.

• Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate a planning item type.

3. Select the Show List  related link.

4. Open a record from the list of Features or Capabilities.

5. Change the scope of the application if you do not see the editable form of the record page.

6. Change the record page view to EAP Default.

To change the view, select Additional actions  menu ( ), select View, and select the EAP 
Default  view.
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7. Select Additional actions  menu ( ), select Configure, and select the Related Lists  option.

8. Select Monetary Benefit Plans  and Non-monetary Benefit Plans  from the Available list and 
add them to Selected list.

9. Select Save.

10. Select Update  on the planning item record page.

What to do next
Create and manage monetary and non-monetary benefits plans for your planning items.

• Create monetary benefit plans for your planning items in Portfolio Planning

• Manage non-monetary benefit plans for your planning items in Portfolio Planning

Enable financial budget allocation for planning items in Portfolio Planning

Enable allocation property after migrating to Next Experience  to work on budget allocation for 
your planning items using Portfolio Planning.

Before you begin

• For new customers accessing financials in Next Experience, this property is enabled by 
default.

• Role required: admin

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open sn_invst_pln.enable_budget_allocation_v2 
property.

3. Update the Value field to True  and select Update.
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What to do next
Configure budget attributes to work on managing budget of your planning items. For more 
information, see Configure budget attribute at instance-level to allocate budget.

Configure budget attribute at instance-level to allocate budget

Configure the budget attribute by expense type or cost type as an instance-level to work on 
budget allocations for your planning items using Portfolio Planning.

Before you begin

• Enable the budget allocation property to work on budgeting for planning items. For more 
information, see Enable financial budget allocation for planning items in Portfolio Planning.

• Role required: admin

Important: 
Existing customers cannot change the budget attribute to cost_type.

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open sn_invst_pln.budget_allocation_attribute 
property.

3. Update the Value field to one of the following.

◦ cost_type  - view financials by cost types such as Hardware Opex, External labor Capex, 
Software Capex, Software Opex, and so on.

◦ expense_type  - view financials by expense types such as Capex and Opex.

4. Select Update.

Customise cost plan form

Manage the fields required on the new cost plan form as per your organization needs.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate and open the Cost Plan  table.

3. Select the Design Form  related link.

4. On the header row, select Cost Plan [cost_plan]  from the table list and Financials View  from 
the view list.

5. On the form, you can:

◦ Drag and drop the required fields from the Fields column.

◦ Remove the existing fields using the Remove field icon.

6. Select Save.

Change the default expense type in Portfolio Planning

Configure the default expense type to create or edit cost plans for your planning items.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > All properties.

2. Filter the name to locate and open the sn_plng_att_core.default.expense_type  table.

3. Change the Value field to the required expense type and select Save.
Opex is the default value.

Create custom labor costs and map them to sys_id

Create and map custom labor costs to sys_id to generate labor costs based on the relevant 
expenses.

Before you begin
Role required: admin

Procedure

1. Create custom labor costs.

a. Navigate to All  > System Definition  > Tables.

b. Filter the Label field to locate the open Cost Type Definition.

c. From the Related Links, select Show List.

List of OOB labor costs is displayed.

d. Select New.

e. On the Cost Type Definition form, fill the fields.

▪ Name  - enter the name of the labor cost plan.

Tip: 
Adding the cost type, either capex or opex, as a suffix to the name helps you to easily 
identify while creating cost plans.

▪ Expense type  - select Capex or Opex from the list to define expense.

For example, you can create Software Capex labor cost to capture software purchasing 
expenses. Hardware Opex labor cost to capture your hardware purchasing expenses.

f. Click Submit.

The new cost plan is displayed on the list.

g. Right-click on the cost plan row and select Copy sys_id.

2. Map the custom labor costs with sys_id.

a. Navigate to All  > System Properties  > All properties.

b. Filter the name field to locate and open the 
sn_plng_att_core.labor_costtype_sysid_mapping  property.

c. In the Value field, enter the labor cost type name and it's sys_id in the same format as the 
OOB labor costs mapping format.

d. Select Update.
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Activate a scheduled job to migrate budget of your planning items

Activate the Migrate budget for active demands and projects  scheduled job to migrate budget 
of active planning items from Classic UI to Next Experience.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Migrate budget for active demands and projects.

3. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

4. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

Activate a scheduled job to create financial baselines for your projects and demands

Define a scheduled job to automatically create financial baselines for your planning items at a 
required cadence.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Create Financial Baseline For active Demands and 
Projects.

3. Select Active  option to activate and schedule the job.

4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

Activate a scheduled job to generate labor costs for your projects and demands

Activate a scheduler job to automatically create labor costs for attribute-based resource 
assignments.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate the Generate Labor Costs  scheduled job and open it.

3. Select Active  and on the Scheduled Script Execution form, fill the fields.
For a description of the field names, see Scheduled Script Execution form to generate labor 
costs for projects and demands.

4. Select Update  to save your changes or Execute Now  to run the scheduled job.
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Configure portfolio financials in Portfolio Planning

Configuration details for properties and scheduled jobs to view and manage portfolio financials 
in Portfolio Planning

Before you begin
Role required: admin

Procedure

1. Enable integration for an internal planning item type.
For more information, see Enable integration for internal planning item.

2. Activate the investment entities for Demands and Projects.
For more information, see Activate investment entities for planning items.

3. Enable the roll up system property to true to view financials.
For more information, see Activate rollup property for projects to view portfolio financials.

4. Activate the data generation scheduled job to view portfolio financials.
For more information, see Activate a scheduled job to generate data to view portfolio 
financials.

Enable integration for internal planning item

Enable the integration for an internal planning item type to view portfolio financials.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the name field to locate and open the Table Map  [sn_align_cmn_int_table_map] table.

3. Select the Show List  Related Link.

4. Set the Active field to true  for dmn_demand and pm_project.

Activate investment entities for planning items

Activate the investment entitied for Demands, Projects, and Epics to view portfolio financials.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the name field to locate and open the Investment Entity 
[sn_invst_pln_invst_funding_entity] table.
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3. Select the Show List  Related Link.

4. Set the Active field to true  for Demand and Project fields.

Activate rollup property for projects to view portfolio financials

Activate project cost rollup property to view the rolled up costs of top projects in portfolio 
financials.

About this task
Financial fields such as planned costs, forecasts, actual costs are rolled up from sub-projects to 
top projects upon setting this property to true.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > All Properties.

2. Filter the name field and select the com.snc.project.rollup.cost  property.

3. Enter true  in the Value field and select Update.

Activate a scheduled job to generate data to view portfolio financials

Activate and define Data generation for financials in SPW/PPW  scheduled job to migrate 
budget from old data model to new data model and view portfolio financials.

About this task
It is a one-time activity to define and run this scheduled job to view portfolio financials.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Data generation for financials in SPW/PPW.

3. Select Active option to activate and schedule the job.

4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
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For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Select Execute Now  to execute the scheduled job.

Result
All the required mappings to view the portfolio financials for Epics, Demands, and Projects are 
mapped.

To validate if the data generation job is successful, navigate to All  > System Definition  > Tables 
and check the mappings for Investment  record in the Project  [sn_align_core_project] table.

Configuring Portfolio Planning  with PPM

Understand the process required to set up Portfolio Planning  to work with ServiceNow®  Project 
Portfolio Management.

Configuration workflow

Use the following steps as guidelines for your Portfolio Planning  with Project Portfolio 
Management  (PPM) setup process. Some of these steps require the admin role 
(sn_align_core.apw_admin) and some require the user role (sn_align_core.apw_user).

1. Create an alignment integration.

2. Generate default mapping configurations.

3. Create custom mapping configurations.

Guided Setup

After installing Portfolio Planning, you can use the guided setup to help you with the required 
configuration. To open the guided setup, navigate to Portfolio Planning  > Guided Setup.

Create an alignment integration

Internal alignment integration synchronizes internal processes and data to support Strategic 
Portfolio Management, confirming that planning and execution are aligned with business 
objectives through real-time bi-directional synchronization with applications such as Project 
Portfolio Management, Agile Development 2.0, and Scaled Agile Framework (SAFe).

About this task
After you have Portfolio Planning  installed, the ServiceNow Internal  Alignment integration 
is created by default. In case the alignment integration isn’t available, you can create your 
alignment integration type.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Portfolio Planning  > Integrations.

2. Verify if the Servicenow Internal  alignment integration exists.

3. If not, click New  to create an alignment integration.

4. In the Name  field, enter a name for the alignment integration (For example, ServiceNow 
Internal).
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Alternatively, you can also click Create ServiceNow Internal Integration  from the related links 
to create an internal alignment integration.

5. Click Submit.

Generate default mapping configurations

Generate default mapping configurations to create table maps for Project Portfolio Management 
(PPM).

Before you begin
Role required: sn_align_core_apw.admin

Procedure

1. Navigate to All  > Portfolio Planning  > Integrations.

2. Click ServiceNow Internal  to view the alignment integrations for the internal applications.

3. Click Generate Default Mapping Configurations  to create the table maps for projects and 
demands.

Note: 
Mapping configurations consist of table, field, and choice maps.

Create custom mapping configurations

Create mapping configurations for planning items that are not created by default such as 
features, stories, etc.

As an admin, you can choose to create table maps, field maps, and choice maps for the planning 
items that are not created by default. For more information, see:

1. Create a table map.

2. Create a field map.

3. Create a choice map.

Create a table map

Create a table map to define the mapping between tables in Portfolio Planning  with the tables in 
Project Portfolio Management  (PPM).

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Portfolio Planning  > Integrations.

2. Select ServiceNow Internal.

3. Create a new table map by selecting New  in the Table maps  tab.

4. In the Table map form, fill in the fields.

5. Select Submit.

Result
A new table map is created with your alignment and execution table configurations.

Note: 
To create or update a table map for a planning item type other than demand or project, the 
SPM Pro license is required. Contact your administrator for more details.
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What to do next
Create a business rule to support export of this new table map configuration to PPM. For more 
information, see Create a business rule to apply a custom table map configuration.

Create a business rule to apply a custom table map configuration

Create a business rule to enable import for your new custom table map configuration from and 
Project Portfolio Management  (PPM) application.

Before you begin
Role required: sn_align_core_apw.admin

About this task
After you create a custom table map in Portfolio Planning  integrations, create a business rule 
similar to 'Sync Data from Execution to Alignment' business rule in the rm_epic or dmn_demand 
tables.

Note: 
Ensure that the business rule is created in the execution application, PPM.

Procedure

1. Navigate to All  > System Definition  > Business Rules.

2. From the list of available business rules, locate and open the Sync Data from Execution to 
Alignment rule.

3. From the context menu ( ), perform an Insert and Stay operation on this business rule.
If you have not enabled the Insert and Stay  action in your ServiceNow  instance, see Allow 
insert options on records .

4. On the business rule form, edit the following fields.

Business rule form

Field Description

Name Unique name for the business rule.

For example, if your new table map is to map 
demands, name this rule as Sync Demands 
with Portfolio Planning.

Table Select the table for which you've created the 
custom map.

For example, Feature [sn_safe_feature].

5. Click Update.

Create a field map

Map the fields for each table map from Portfolio Planning  to Project Portfolio Management  and 
vice-versa.

Before you begin
Ensure that you have created a table map for an alignment integration record. For more 
information, see Create a table map.
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Note: 
If the execution field type is 'Reference' and the alignment field type is 'String', then the 
sync will not work.

Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Portfolio Planning  > Integrations.

2. Select ServiceNow Internal.

3. In the Table Maps  related list, select the table map for which you want to create a field map.

4. Create a new field map by selecting New  in the Field Maps tab.

5. In the Field map form, fill in the fields.

6. Click Submit.

Create a choice map

Map the choice list for each field map for fields with a list of values from Portfolio Planning  to 
Project Portfolio Management  and vice-versa.

Before you begin
Ensure that you have created a field map and it contains choice fields with a list of values. For 
more information, see Create a field map.

Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Portfolio Planning  > Integrations.

2. Select ServiceNow Internal.

3. In the Table Maps  related list, select the table map which has the fields for which you want to 
create a choice map.

4. In the Field Maps  related list, select a relevant field map for which you want to create a choice 
map.

5. Create a new choice map by selecting New  in the Choice Maps tab.

6. In the Choice map form, fill in the fields.

7. Click Submit.

Configure bulk import

This system property enables you to update the bulk import functionality in Portfolio Planning 
with PPM.

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Enter sys_properties.list  in the navigation filter.

2. Search for com.sn_align_cmn_int.bulk_import.

3. Set the property value to either of the following options.
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Managing portfolio plans in Portfolio Planning
Create personalized portfolio plans in Portfolio Planning Workspace  and enable focused 
planning of work in the desired perspective (lens) to align with business objectives.

The following sections guide you on creating, updating, sharing, and collaborating with portfolio 
plans in Portfolio Planning  Workspace.

For details on how to use roadmaps for your portfolio plans, see Planning roadmaps in Portfolio 
Planning.

Create a high-level portfolio plan

Build a portfolio plan for high-level items (programs) in the Portfolio Planning Workspace  so that 
you can prioritize, roadmap, and manage work aligned to these programs.

Before you begin
Role required: sn_align_core.apw_user or business_stakeholder

About this task
You can create high-level planning only for Program (pm_program) planning items and is 
supported by the Project Program lens.

In this task, select the Project Program lens, add conditions to filter the planning item data that 
you need, and enter additional details to build a portfolio plan.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the Portfolio Plans page, select New.
If there are no existing portfolio plans, select Create your first portfolio plan.

3. Select Project Program  lens for your high-level planning.
The Create portfolio plan wizard is shown.

4. For the lens, select Programs  as work items for planning.

a. For the lens, select work that you want to plan.

For example, you want to manage work for programs in your company. Select Programs as 
your high-level planning item. This enables you to plan for programs and review the work 
aligned to these programs.
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b. Add conditions to further filter the data of your planning items.

For example, you are responsible for the programs of the Customer Support department. 
You can set a condition to filter programs of only the Customer Support department from the 
Program table.

You can also add multiple conditions to help you set a complex filter and add the right kind 
of data to your portfolio plan.

c. Fill in the details of the portfolio plan.

Provide the information of the portfolio plan's name, owner, start and end dates, and 
description.

Use the Previous  and Next  buttons to navigate between the steps.

5. Select Create.

Result
The portfolio plan is created and the page is refreshed to show the Planning page. You can view 
the list of all portfolio plans that you own or shared with you from the Home page.

What to do next
Analyze the backlog and prioritize work for your portfolio plan. See Prioritizing portfolio plan work 
in Portfolio Planning.

Create a portfolio plan

Use lens and build a personalized portfolio plan in Portfolio Planning  Workspace so that you can 
start to prioritize and align work in the planning perspective of your choice.

Before you begin
Role required: sn_align_core.apw_user or business_stakeholder

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. Select New.
If there are no portfolio plans existing, select Create your first portfolio plan.
The Create Portfolio plan wizard is shown.

3. Make your selections by using the Create Portfolio plan wizard.
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a. Select a lens.

b. For the selected lens, choose the entity type and the desired entities of that type.

The entity type represents the perspective that you plan your work in. For example, if you've 
chosen the Organization lens, you can select Business Unit as your entity type, and then 
select the required business units, to plan work from their perspective.

You can also add multiple conditions to help you set a complex filter and add the right kind 
of data to your portfolio plan.

c. Select the type of planning items that you want to include in your portfolio plan.

You can further filter the planning item data with additional conditions.

d. Fill in the details of the portfolio plan.

Provide the information of the portfolio plan's name, start and end dates, and description.

You can use the Previous  and Next  buttons to navigate between the steps.

4. Select Create.

Result
The portfolio plan is created and the page is refreshed to show the Planning page for this new 
portfolio plan. You can view the list of all portfolio plans that you own or shared with you from the 
Home page.

Planning items that meet the following criteria appear in the portfolio plan:
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• Planning items that belong to one of the entity types selected in Step 3(b)

• Planning items that match the planning item types selected in Step 3(c)

• Planning items with an approved start date or an end date that falls within the portfolio plan 
timeline

• Planning items that don't have both Approved start and Approved end dates

Note: 
If any demands were converted into projects in Project Portfolio Management, only the 
resulting project planning items (converted from demands) appear in the portfolio plan.

What to do next

• Analyze the backlog and prioritize work for your portfolio plan. See Prioritizing portfolio plan 
work in Portfolio Planning.

• Roadmap the prioritized work to visualize and track progress of your plans. See Planning 
roadmaps in Portfolio Planning.

• Modify a portfolio plan.

• Show or hide features for your portfolio plan according to your requirement while sharing a 
portfolio plan with your stakeholders. See, Show or hide the features for a portfolio plan.

• Share a portfolio plan with stakeholders.

Duplicate a portfolio plan

Create a portfolio plan with the data of an existing portfolio plan. If the portfolio plan you want 
to create is similar to an existing portfolio plan, duplicating the existing portfolio plan saves your 
time. You can also copy portfolio plans that were shared with you either with view or edit access.

Before you begin
Role required: sn_align_core.apw_user or business_stakeholder

About this task
The Duplicate portfolio plan  option copies the selected portfolio plan with its all data 
(Prioritization and Roadmap) into the portfolio plan. It also preserves all dependencies and 
relationships among the copied items and their child items.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header, select the More actions icon ( ) and then select Duplicate 
portfolio plan.

4. On the Duplicate portfolio plan window, fill the details.

a. Enter a name for the portfolio plan in the Portfolio plan name  field.
By default, the name is ABC (Copy)  where ABC is the name of the portfolio plan you 
copied from.

b. Optional:  Select Share with same users and groups  option to grant access to the users of 
the portfolio plan you copied from.
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The action grants the same read and edit access as is the users had for the portfolio plan 
you copied from.

c. Select Confirm.

Result
The new portfolio plan is created and a link is generated on the screen to access the new 
portfolio plan.

What to do next

• Analyze the backlog and prioritize work for your portfolio plan. See Prioritizing portfolio plan 
work in Portfolio Planning.

• Roadmap the prioritized work to visualize and track progress of your plans. See Planning 
roadmaps in Portfolio Planning.

• Modify a portfolio plan.

• Show or hide features for your portfolio plan according to your requirement while sharing a 
portfolio plan with your stakeholders. See, Show or hide the features for a portfolio plan.

• Share a portfolio plan with stakeholders.

Modify a portfolio plan

Update the details of a portfolio plan in Portfolio Planning  Workspace or delete it, to reflect the 
changes in your planning priorities.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user or business_stakeholder

About this task
Note: 
Only the owner or editors of a portfolio plan can modify it.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header, select the More actions icon ( ).
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4. Update the details of the portfolio plan or delete it using the Portfolio plan actions menu.

What to do next
Share your updated portfolio plan or collaborate with other stakeholders.

• Show or hide features for your portfolio plan according to your requirement while sharing a 
portfolio plan with your stakeholders. See, Show or hide the features for a portfolio plan.

• Share a portfolio plan with stakeholders.

• Collaborate on portfolio plans.

Show or hide the features for a portfolio plan

As a portfolio manager, show or hide the features (for example, Prioritization, Roadmap, and 
so on) for your portfolio plan as needed so that you can share only the required data with your 
stakeholders.

About this task
Hiding features for your portfolio plan helps you share only the data that matters to your 
stakeholders and restrict access to the other data in your portfolio plan.

Note: 
When you share a portfolio plan with your stake holder  providing view access and hiding 
a feature (for example, Capacity Planning), the viewer can only view the enabled features 
and can't see the hidden feature (Capacity Planning) in the shared portfolio plan. However, 
when you share a portfolio plan providing edit access, the editor can enable or hide the 
features as required and can view and edit any data in the shared portfolio plan.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user or business_stakeholder
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select the portfolio plan for which you want to show or hide the 
features.

3. From the left pane of the portfolio plan, select Show/hide modules.

4. On the Show/hide modules window, select the features that you want to show and deselect 
the features that you want to hide.

5. Select Apply changes.

Related topics

Share a portfolio plan with stakeholders

Share a portfolio plan with stakeholders

Share your portfolio plan with stakeholders and other planning managers so that they have 
visibility into the plan's progress and start collaborating.

Before you begin

• Create a portfolio plan.

• Users or groups that you want to share the portfolio plan with must have the 
sn_align_core.ap_read_only or sn_align_core.apw_user role to get the read or edit access to 
the portfolio plan respectively.

Role required: sn_align_core.apw_user or business_stakeholder

About this task
Select individual users or groups to share the portfolio with.

When you share a portfolio plan with an individual user or a group, they can access the 
entire portfolio plan, which includes Prioritization and Roadmap. Also, they can access the 
Capacity tab in the Planning page if the user has the sn_align_ws.spw_capacity_user or 
sn_align_ws.spw_capacity_read role.
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header in the Planning page, select the Share portfolio plan  icon ( ).

4. On the Share portfolio plan form, select users to share the portfolio plan with and set their 
access appropriately.

a. In the Members or Groups  field, enter the names of individual users or groups.

b. From the Access  field, select the access level as Viewer  or Editor  for the selected names.

▪ An editor can view and change the portfolio plan's settings and data.

▪ A viewer can comment and add attachments to the portfolio plan, but cannot modify the 
portfolio plan's settings or data.

Note: 
Even if a user has the sn_align_core.apw_user role, they cannot edit planning item 
data from the portfolio plan grid view when granted view-only access. However, users 
with the sn_align_core.apw_user role can edit planning items and related tables from 
the record page.

5. Select Send invite.

Result
The selected individual and group users are notified of the portfolio plan sharing through an 
email.

What to do next
Collaborate on portfolio plans.

You can change the access level or remove access for a user or a group.

1. On the Share portfolio plan form, select Manage access.

2. From the user or group card, select the Action Menu icon ( ).

3. Select the right access level or select Remove.

Related topics

Modify a portfolio plan

Show or hide the features for a portfolio plan

Collaborate on portfolio plans

Add comments and attachments to your portfolio plan so that users can review and share their 
feedback. Collaborate with stakeholders and drive shared outcomes.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user or business_stakeholder
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About this task
Comment on plans and data points, share attachments, and provide feedback from a single 
place in the workspace to ensure all the stakeholders are in alignment with the business 
priorities.

The attachments and comments that you add from the portfolio plan's header, they apply to the 
entire portfolio plan, which includes Prioritization and Roadmap.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the portfolio plan header in the Planning page, select the Comments  icon ( ).

4. Add comments or attachments to the portfolio plan.

Related topics

Show or hide the features for a portfolio plan

Prioritizing portfolio plan work in Portfolio Planning
Use the Prioritization feature of the Portfolio Planning  Workspace to add, update, and rank 
planning items so that you can prioritize the right work for the right time.

Views for prioritizing planning items

Prioritization tab in Portfolio Planning  represents your backlog, displaying the items of your work 
pipeline. The Hierarchy tab also represents your backlog, each providing a different view of the 
same items. For an overview of these views, see Work prioritization in Portfolio Planning  for an 
overview of these views.

Note: 
The Prioritization feature is available only for portfolio plans.

Prioritization features

In each of these views on the Prioritization page, you can perform the following actions:

Add new planning items

Add new items to your backlog directly from the Prioritization page. The type 
of planning items that you can create here depends on your portfolio plan 
configuration. See Add planning items to Prioritization.

Update planning item details

You can edit details of the planning items, add attachments, and collaborate on 
them with the stakeholders directly from the Prioritization page views to enable 
smoother real-time backlog grooming.

See Update planning item details from Prioritization view.

Open the planning item in the Execution app

If you're using ServiceNow  PPM, Agile Development 2.0, or SAFe  applications 
to execute the planned work, you can open the planning items in their own 
application. For example, if your planning item is a project, you can navigate to the 
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project form, project planning console, or project status report directly from the 
Prioritization page.

Personalize the Prioritization tab view

Change the way that the Prioritization tab is displayed so that you can view the 
information in the format that you need. See Personalizing views for prioritization.

All settings, such as row and column personalization, grouping, and sorting, are 
saved as the portfolio plan preferences. So, these settings are applied to all the 
users or user groups that the portfolio plan is shared with.

Add planning items to Prioritization

Add new planning items to your portfolio plan's work backlog in Portfolio Planning  Workspace 
and ensure that the work pipeline is current.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user

About this task
Use the Prioritization tab of your portfolio plan to add new planning items or import them from 
other ServiceNow  execution system such as Project Portfolio Management  (PPM).

You can use the List or Hierarchy views while you perform this task.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization tab, add a new planning item for your portfolio plan.

Use the More options drop-down to select the planning item that you want to create.
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4. On the form, fill in the short description and approved dates.
For full field information, see Demand planning item form  or Project planning item form.

5. Select Submit.

6. Optional:  If you're using PPM to execute the planned work, you can also import your work 
items from the application.
For more information, see Executing Portfolio Planning work in PPM.

Result
The new item is created with its Planning state  field is set to New  and the position of the item is 
based on the view that you are in.

• Prioritization tab: Added to the bottom of the list.

• Hierarchy tab: Added to the appropriate grouping. For example, your selected lens is 
Organization. Then, the new item is added to the grouping of its department.

What to do next

• Rank planning items.

• Update planning item details from Prioritization view.

Duplicate a planning item

Create a copy of an existing planning item to add it to your portfolio plan's work backlog in 
Portfolio Planning  Workspace and ensure that the work pipeline is current. If the planning item 
you want to create is similar to an existing planning item, duplicating the existing planning item 
saves your time.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user

About this task
Use the Prioritization page of your portfolio plan to add new planning items or import them from 
other ServiceNow  execution system such as Project Portfolio Management  (PPM).

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Planning page, select Prioritization  tab.
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4. Select the More actions icon ( ) of the planning item that you want to copy and then select 
Duplicate.
The new planning item is created and the item appears right below the planning item you 
copied from. Also, the rank is updated for the new planning item automatically based on the 
rank of the planning item you copied from.

By default, the name is Copy of ABC  where ABC is the name of the planning item you 
copied from.

5. Optional:  If you're using PPM to execute the planned work, you can also import your work 
items from the application.
For more information, see Executing Portfolio Planning work in PPM.

What to do next

• Rank planning items.

• Update planning item details from Prioritization view.

• Personalizing views for prioritization.

Update planning item details from Prioritization view

Update the details of your planning items or delete them so that the Prioritization page in 
Portfolio Planning  Workspace reflects the latest work pipeline.

Before you begin
Role required: sn_align_core.apw_user

About this task
Update the details of a planning item using the Prioritization and Hierarchy tabs in the portfolio 
planning page. Edit the details inline from the grid view to facilitate smoother real-time backlog 
grooming. Use the full details page of the planning item to add attachments and collaborate on 
them with the stakeholders.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Update item details, attach files to the item, or delete the item.

Information of certain columns that aren’t editable in the full details page, can’t be edited inline 
too. For example, planned cost and planned benefit. These cells are visually differentiated 
using grey color as their background.

If you group the Prioritization items list by any attribute, you can’t edit the short description of 
the items directly from the grid view.

Rank planning items

Rank the planning items that are added to the pipeline of your portfolio plan and decide on their 
priority so that you can start planning your portfolio roadmap.
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Before you begin

• Create a portfolio plan.

• Ensure that the planning items in the Prioritization tab are sorted by the Rank column in 
ascending order.

Role required: sn_align_core.apw_user

About this task
Use the Prioritization tab to stack-rank the planning items of your portfolio plan.

Within the ServiceNow  system, all the planning items are assigned a global rank. Reorder the 
items in the Prioritization tab to change their rank and update their planning state. If you decide 
to include a planning item into your roadmap schedule, mark its Planning State as Prioritized  to 
add it to the roadmap directly from the Prioritization tab.

The Rank column helps you quickly identify the rank of an item relative to the other items in the 
backlog. This information is useful to determine the top-ranked items from a long list of planning 
items. When there’s no custom grouping or sorting, the planning items are sorted by their rank, 
and you can reorder the rows.

Note: 
Reordering of rows is not allowed if the planning items are already grouped or sorted by any 
other attribute. Remove the grouping or sorting to reorder rows.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization tab, rank the planning items according to your priority by rearranging 
their order.

Repeat this step until the ranking of the planning items align with your business priorities. To 
get better visibility of data that you need:

◦ Sort or group the list by the required columns. See Personalize Prioritization view.

◦ Filter the planning items. See Apply quick filters for Prioritization and Roadmap data in 
Portfolio Planning.

Tip: 

Using the Row context menu ( ), you can also assign the highest and lowest ranks to 
the planning items using the Move to top  and Move to bottom  options respectively.

Result
The rank of the item is automatically updated and can be seen from the Rank column. The Rank 
column is read-only.

Prioritize work

Review and prioritize the items of your portfolio plan pipeline to add them to the plan's roadmap 
so that your teams can start working on them.
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Before you begin

• Create a portfolio plan.

• Ensure that the planning items in the Prioritization page are sorted by the Rank column in 
ascending order.

Role required: sn_align_core.apw_user

About this task
Review and prioritize the items in the Prioritization or Hierarchy tab views during your grooming 
sessions. You can use the MoSCoW values assigned to an item to help you decide the priority of 
work.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization or Hierarchy tab, mark a planning item as In Review or Prioritized.

Once you mark a planning item as Prioritized, it is automatically added to your portfolio 
roadmap, based on the values in the Approved start date  and Approved end date  fields.

◦ If the dates fall within the portfolio planning period, then the item is displayed on the 
roadmap.

◦ If either of the date fields is empty, then the item is added to the Unscheduled items list of 
the roadmap.

Note: 
Your roadmap shows only those items that have Planning state set to Prioritized.

If you've marked an item as Done  or Cancelled, that item is not displayed on the Prioritization 
page by default. You can update the filter on the Planning state column to show the items that 
are completed or cancelled.

4. Optional:  From the Prioritization tab, you can update the planning state of multiple items at 
once.
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a. Select the Planning state  cell of one of the rows that you want to update.

b. Press and hold the Ctrl  key (for Windows OS) or command  key (for Mac OS), and select the 
Planning state  cells of the other rows that you want to update.

c. Double-click one of the selected cells and choose a state.

(Optional)

Categorize planning items using tags

Categorize your planning items based on your requirement by adding tags.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user

About this task
Tags enable you to categorize planning items. You create the tag name, which should name the 
reason for the tag. You can make the tags visible to everyone, some people, or just yourself. The 
visibility setting specifies who can use the tags to search for planning items.

Any tagging additions or removals made to a planning item are automatically synced across all 
views in the Planning page and in the Scoring page. After tagging planning items, you can use 
the tags to search for planning items using the Filter  option ( ) in the List view of Prioritization 
and in the Scoring page.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the List view of Prioritization, add a tag for a planning item using one of the following 
options.

Note: 
The tag visibility setting defaults to private, which means the tag is only visible to the user 
who created the tag. So, only the user who created the tag can use the tag to search for 
planning items labeled with that tag.
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4. To change the visibility setting of the tag, on the Details page of the planning item, select the 
tag and change the Viewable by  setting.

Option Description

Me

Tag is visible only to the person who created 
the tag. Only the user who created the tag 
can use the tag to search for planning items la­
beled with that tag. This setting is the default.

Groups and Users
Tag is visible to specific groups or users. You 
can specify the groups and users who can 
view this tag.

Everyone

Tag is visible to everyone.

Note: 
This visibility setting is only available to 
an admin or tags_admin role.

A planning item can have multiple tags and each can have a different visibility setting.
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5. To remove a tag from a planning item, double-click the cell in the Tag column on the List view or 

select the filled tag icon ( ) on the Details page of the planning item to open the list of tags, 
then select the X  next to the tag you want to remove.

Personalizing views for prioritization

Personalize how the Prioritization and Hierarchy tabs on the Planning page are displayed in 
Portfolio Planning  Workspace so that you can view the information that is most relevant to you 
and your stakeholders.

Personalize Prioritization view

Group and sort the planning items by the attributes of your choice, and customize 
the displayed columns to facilitate effective grooming.

Personalize Hierarchy view

Modify the views based on the lens to learn how work in the current portfolio 
plan relates to other lenses and gain better visibility into roll-ups of finances and 
schedules.

Personalize Prioritization view

Personalize the Prioritization tab view in the Planning page in the workspace so that you can view 
the information that is most relevant to you and your stakeholders.

Before you begin
Create a portfolio plan

Role required: sn_align_core.apw_user

About this task
This task provides guidance on different options to personalize the Prioritization view of the 
Planning page.
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Personalization preferences are saved as the portfolio plan's settings in Portfolio Planning. So, 
these settings are applied to all the users or user groups that the portfolio plan is shared with.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Use the Personalize side panel to update the display of rows and columns on the page.

a. Select the Personalize icon ( ).

b. From the Columns section, select the columns that you want to see or hide the data of.

You can reorder the columns here to change their display order on the backlog.

If you want additional columns to be available in this page, your admin can configure them. 
See Configuring additional columns for Prioritization page in Portfolio Planning.

c. From the Rows section, choose how the rows are displayed, using the Shade alternate rows 
toggle.

4. Group your items by one or multiple columns that are on display in the Prioritization page.

You can group the planning items by an attribute of the type choice or reference. Some 
examples to group by are Planning state, Planning item type, Owner, and Primary goal.

Use one of the following ways to group the planning items. Repeat the action to group the list 
by multiple attributes.

5. Sort the planning items by any column, by clicking the column name.
For example, you can sort the items by Approved start date.

6. Filter the planning items by an attribute.

a. For the column that you want to filter, select the Column actions icon ( ).

b. Select Filter.

c. Select or type the filter that you want to apply.

For example, you can have the list to show only New  items, by filtering the Planning state 
column. Other examples to filter by are the item's planning state, primary goal, or priority.

Note: 

You can filter only on those attributes that are of the type choice, string, or reference.

7. Pin columns to the left or right of the list.

a. For the column that you want to pin, select the Column actions icon ( ).

b. From the Pin column section, select Pin to left  or Pin to right.
The default selection is Unpin.
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8. Adjust the width of the columns as per choice or set the width to autofit.
Hold and drag the column border to adjust its width. You can set the column width to autofit 

using the Autofit this column  or Autofit all columns  options from the Column actions ( ).

9. Reset columns to default settings by selecting Reset columns  from the Personalize menu ( ).

Selecting this option reverts the column personalization, grouping, and sorting to default 
settings.

Personalization settings that you've made so far on the Prioritization page would be cleared. 
Any personalization that you make after this point is set as the new preference for the portfolio.

10. Apply quick filters for Prioritization and Roadmap data in Portfolio Planning

Personalize Hierarchy view

Personalize the Hierarchy view in the Planning page of Portfolio Planning  Workspace so that you 
can view the information that is most relevant to you and your stakeholders.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user

About this task
Sort the planning items by an attribute of your choice and use the Personalize side panel to 
customize the display of the columns.

Personalization preferences are saved as the portfolio plan's settings in Portfolio Planning. So, 
these settings are applied to all the users or user groups that the portfolio plan is shared with.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Personalize the timeline view and the columns on the grid view using the Personalize side 
panel.

a. Select the Personalize icon ( ).

The personalize side panel opens.
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b. From the Timeline section, toggle the display of item names and dependency lines.
You can also choose to update the layout. Select Grid and timeline view, Grid view, or just the 
Timeline view.

c. From the Columns section, update the planning item fields that are displayed in the grid 
view.
Select the necessary columns and click Apply.

4. Sort the planning items by any column, by clicking the column name.
For example, you can sort the items by Approved start date.

5. Apply quick filters for Prioritization and Roadmap data in Portfolio Planning

Export data of portfolio plan items from Prioritization to Excel or CSV

Export the data of portfolio plan items from your portfolio plan into a Microsoft  Excel or CSV file. 
You can share this data and collaborate with your business stakeholders.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. In the Prioritization tab, select List  view.

4. Verify that the columns you want to export are personalized.

Note: 
If the filters are applied on the view, the filtered data is exported.

5. Use the personalized side panel to export the data of your portfolio plan items.

a. Select Export icon ( ).

b. From the File type  drop-down on the Export window, select Excel  or CSV  to export the data 
to a Microsoft  Excel or CSV file respectively.
A file with the selected format is exported. By default, the name of the file is 
ABC_Prioritization_List  where ABC is the name of the portfolio plan you exported 
the data from.

Planning roadmaps in Portfolio Planning
Create a layout of the plans for upcoming projects or initiatives while aligning them with your 
business objectives using roadmaps in a centralized workspace. Facilitate collaboration among 
stakeholders and adjust plans on the go.

Roadmaps in Portfolio Planning  Workspace are of two types: Portfolio plan roadmaps and free-
form roadmaps.

For portfolio plans, only those planning items that are prioritized from the Prioritization page are 
shown on the roadmap. See Prioritize work.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

90



Use the information in the following sections to start using roadmap capabilities for your 
business plans.

Related topics

Roadmaps in Portfolio Planning

Create a free-form roadmap

Create a standalone visual roadmap to start high-level planning of work from different units of the 
company.

Before you begin
Role required: sn_align_core.apw_user

About this task
Create a standalone roadmap to plan work across multiple units of your organization, such as 
projects of all departments. To learn more about free-form roadmaps, see Roadmaps in Portfolio 
Planning.

Select a source table as a starting point to base your roadmap on. Select one of project or 
demand for a simple roadmap or Planning Item table for a hybrid roadmap.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select New.
If this is the first free-form roadmap in your ServiceNow®  instance, select Create your first 
free-form roadmap.

3. Use the Create free-form roadmap wizard to fill out the details of your roadmap.

a. Select a source table to base your roadmap on.

b. Add conditions to filter the data from the source table.

For example, if your source table is Project, the related filter condition can be Business Unit 
is Finance AND Active is true.

c. Enter details of the name and planned dates for the roadmap.

Note: 
The start and end dates for your roadmap act as a date range filter for all the items 
displayed in the roadmap.

4. Select Create.

Result

• A new roadmap is created and displayed.

• This roadmap is listed in the Free-form roadmaps  tab of the home page of Portfolio Planning 
Workspace.

What to do next

• Update, personalize, and collaborate with your roadmap.

• Add milestones or create dependencies for the items planned on your roadmap.
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Update details of free-form roadmap

Update the details of a free-form roadmap to reflect the changes in priorities or the timeline of 
the roadmap.

Before you begin
Create a free-form roadmap.

Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap to open it.

3. From the roadmap header, select the More actions icon ( ).

4. Use the Update free-form roadmap wizard to edit out the details of your roadmap.

5. Select Update.

Result
The roadmap is updated and the roadmap items are displayed according to the latest changes.

Share a free-form roadmap with stakeholders

Add people from your organization who are the stakeholders for the work involved in your 
roadmap plan so that they have visibility into the roadmap's progress.

Before you begin

• Create a free-form roadmap.

• Ensure that the users that you add as stakeholders have the appropriate role to access the 
roadmap. For more details on user roles, see Components installed with Portfolio Planning.

Role required: sn_align_core.apw_user

About this task
Grant access for the free-form roadmap to other users and stakeholders in your organization.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap to open it.

3. From the roadmap header, select the Share roadmap  icon ( ).

4. On the Share roadmap form, select users to share the roadmap with and set their access 
appropriately.

a. In the Members or Groups  field, enter the names of individual users or groups.

b. From the Access  field, select the access level as Viewer  or Editor  for the users selected.
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▪ An editor can view and change the roadmap's settings and data.

▪ A viewer can only comment or add attachments. They can’t change any settings or data.

5. Select Send invite.

What to do next
Change the access level or remove access for a user or a group.

1. On the Share roadmap form, select Manage access.

2. From the user or group card, select the action menu icon ( ).

3. Select the right access level or select Remove.

Collaborate on a free-form roadmap with stakeholders

Add comments and attachments to a free-form roadmap for other users of your organization can 
review and share their feedback. Collaborate and ensure that your roadmap aligns with your 
company's priorities.

Before you begin
Role required: sn_align_core.apw_user or sn_roadmap_plng.roadmap_editor

About this task
Using the Comments side panel, add attachments or notes at the roadmap-level or the planning 
item-level.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap to collaborate on.

3. Select the appropriate tab at the roadmap-level or planning item-level.

4. Add attachments or worknotes.

Managing free-form roadmap views

Portfolio managers can create customized views for their free-form roadmap by applying 
personalization settings such as grouping, milestones selection, dependencies selection, and 
tracking mode. Portfolio owners or editors can share these personalized views with stakeholders 
to enable easier collaboration on the free-form roadmaps.

Benefits of free-form roadmap views

Portfolio managers can create personalized views as needed by applying settings such as 
grouping, milestones selection, dependencies selection, and tracking mode.

• Views can be created as private or public.

• Can create up to three private views and up to 10 shared (public) views.

• Free-form roadmap views can be shared with stakeholders to enable collaboration on the free-
form roadmap.

• Switch between shared and private views as needed.
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Create a free-form roadmap view

Create a customized free-form roadmap view based on your requirements, so you can access it 
when you log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
You can create up to three private views and up to 10 shared (public) views per free-form 
roadmap.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a free-form roadmap to open it.

3. Change the view as needed.
For example, you can enable the Tracking mode  toggle.

The Save as new view  option appears on the free-form roadmap header.

4. From the free-form roadmap header, select Save as new view.

5. On the Save as new view window, fill the details.

a. Enter a name for the view in the View name  field.

b. Optional:  Select the Shared view  toggle to make this view public.
Selecting the Shared view  toggle makes the view visible to all stakeholders with whom this 
free-form roadmap is shared.

c. Select Save.

Result
The shared view for the free-form roadmap is created and is visible to all stakeholders with whom 
this free-form roadmap is shared.
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What to do next

• Share the free-form roadmap with your stakeholders to start collaborating on the free-form 
roadmap. See Share a free-form roadmap with stakeholders.

• Edit a free-form roadmap view to change the existing view. See Edit a free-form roadmap view.

Edit a free-form roadmap view

Edit a customized free-form roadmap view based on your requirements, so you can access it 
when you log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task

• Only the owner of a free-form roadmap view can edit a shared (public) view.

• You can have up to three private views and up to ten shared (public) views per free-form 
roadmap.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a free-form roadmap to open it.

3. From the free-form roadmap header, select the view you want to edit or override with your 
personalization settings from the list of available free-form roadmap views.
The selected view appears.

4. Make changes to the view as needed.
For example, enable Tracking mode  toggle.

After you make any change to the view, the Save view option appears in the free-form roadmap 
header.

5. Select Save view.
The view is updated to reflect the changes made.

6. Optional:  To edit the name of the view, select the Free-form roadmap drop-down from the 

free-form roadmap header and then select the Edit view icon ( ) next to the view you want to 
edit the name for.
On the Edit view window, fill the details.

a. Update the name for the view in the View name  field as required.

Note: 
Only the owner of the free-form roadmap view can rename the view.

b. Optional:  Select the Shared view  toggle to make this view public or disable the Shared 
view  toggle to make the view private.

Important: 
Changing a shared view to a private view removes access for existing stakeholders.
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c. Select Save.

What to do next
Share the free-form roadmap with your stakeholders to start collaborating on the free-form 
roadmap. For more information, see Share a free-form roadmap with stakeholders.

Related topics

Create a free-form roadmap view

Delete a free-form roadmap view

Delete a free-form roadmap view

Delete a customized free-form roadmap view if it is no longer needed or if the maximum limit of 
ten shared or three private views has been reached.

Before you begin
Role required: sn_align_core.ap_read_only

About this task

• Only the owner of the free-form roadmap view or an editor of the free-form roadmap can delete 
the view.

• Deleting a free-form roadmap deletes the view, including any changes made to the view. 
However, this action keeps the items (projects, demands, epics) intact in the free-form 
roadmap.

• You can have up to three private views and up to ten shared (public) views per free-form 
roadmap.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a free-form roadmap to open it.

3. Select the Free-form roadmap view drop-down from the free-form roadmap header and then 

select the Delete view icon ( ) next to the view you want to delete.
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The Delete this view window appears.

4. On the Delete this view window, select Delete.

Related topics

Create a free-form roadmap view

Edit a free-form roadmap view

Duplicate a free-form roadmap

Create a roadmap with the data of an existing roadmap. If the roadmap you want to create is 
similar to an existing roadmap, duplicating the existing roadmap saves your time.

Before you begin
Role required: sn_align_core.apw_user

About this task
Create a standalone roadmap to plan work across multiple units of your organization, such as 
projects of all departments. To learn more about free-form roadmaps, see Roadmaps in Portfolio 
Planning.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap that you want to create a copy from.

3. From the roadmap header, select the More actions icon ( ) and then select Duplicate 
roadmap.

4. On the Duplicate roadmap window, fill the details.

a. Enter a name for the roadmap in the Roadmap name  field.
By default, the name is ABC (Copy)  where ABC is the name of the roadmap you copied 
from.

b. Optional:  Select Share with same users and groups  option to grant access to the users of 
the roadmap you copied from.
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The action grants same read and edit access as is the users had for the roadmap you copied 
from.

c. Select Confirm.

Result

• A new roadmap is created and a link is generated on the screen to access the new roadmap.

• This roadmap is listed in the Free-form roadmaps  tab of the Home page of Portfolio Planning 
Workspace.

What to do next

• Update, personalize, and collaborate with your roadmap.

• Add milestones or create dependencies for the items planned on your roadmap.

Create planning items from roadmap view

Create and add new planning items to your portfolio roadmap or free-form roadmap directly from 
the roadmap view.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, select the New <item type>  option.

◦ For a free-form roadmap, the option depends on the roadmap's source table.

◦ For a portfolio plan roadmap, the option depends on the portfolio plan settings.

One planning item type Multiple planning item types

3. On the form, fill in the required field information.
For full field information, see Demand planning item form  or Project planning item form.

4. Select Submit.

Result
The new item appears on the roadmap, at a place based on its approved start and end dates.

If you don’t fill both the approved start and end date fields, the item that you created would be 
moved to the list of unscheduled items. You can add them to your roadmap plan later. For more 
information, see Plan unscheduled items into roadmap.
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Modify planning items from roadmap

Update the details of planning items or delete them from a portfolio plan or free-form roadmap so 
that your roadmap reflects the latest plans.

Before you begin
Role required: sn_align_core.apw_user

About this task
Edit the details of planning items from a side panel view, or the full details view in the roadmap.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, select a planning item that you want to update or delete.

The side panel opens with the Details tab.

Further, you can select Full details  and open the item's record page. On the full details page, 
you can also view related lists such as Milestones, Dependencies, and others. For field 
information, see Demand planning item form  or Project planning item form.

Note: 
If your free-form roadmap was built on one of the PPM tables, such as project 
[pm_project] or demand [dmn_demand], you can only make updates from the full details 
page.

3. Update the details or delete the item.

◦ To update, edit the field details and select Update.

If you're on the full details page, select Save.

◦ To delete, do the following:

a. On the full details page, select the More Actions icon ( ) and select Delete.

b. Select OK  to confirm.

Plan unscheduled items into roadmap

Add items without start or end dates yet to your portfolio plan or free-form roadmap.

Before you begin
Role required: sn_align_core.apw_user

About this task
Planning items that meet the criteria of your portfolio plan or free-form roadmap, but don’t have 
either the start or end dates are categorized as unscheduled items. As you progress in your 
planning, use the unscheduled items list to schedule these items into your roadmap timeline.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.
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2. From the sidebar, select Unscheduled items ( ).

3. From the list of unscheduled items in the side panel, drag and drop a planning item at a place 
of your choice on the roadmap.

Reschedule roadmap items

Update the planned dates of your roadmap items to account for any changes in your scheduling 
priorities.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. To change the dates planned for a roadmap item, resize the roadmap item bar.

3. To reschedule the roadmap item, drag and drop the item to a timeline area of your choice.
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Add milestones for roadmap

Track key dates of your plan's timeline by creating milestones and displaying them on the 
roadmap.

Before you begin
Role required: sn_align_core.apw_user

About this task
For the timeline of your portfolio plan or free-form roadmap, create milestones such as launch 
dates, deadlines, or other key events directly from the roadmap view.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the More actions drop-down, select New milestone.

3. On the form, fill in the fields.

For field information, see Roadmap milestone form.

4. Select Submit.

5. Optional:  Repeat steps 2 through 4 to add more milestones to your roadmap.

Result
Milestones that you created are visible on the roadmap.
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Here is an image of a sample roadmap with the milestone bar showing different milestones for 
the planning 

period.

The color of the milestone, shown on the legend, indicates the status of the milestone.

• Red: Missed milestone.

• Green: Achieved milestone.

• Grey: Upcoming milestone.

If multiple milestones are scheduled close to each other, they might appear grouped in the 
milestone bar. In this case, you can expand and collapse the milestone bar to view all the 
milestones of that period.

Update a roadmap milestone

Update or delete the milestones that you added to your portfolio plan or free-form roadmap so 
that they reflect any change of plans.

Before you begin
Add milestones for roadmap.

Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.
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2. To reschedule a milestone, you can drag and drop it at a timeline area of your choice.

If you want to update other details or delete the milestone, proceed with the following steps.

3. From the roadmap view, click the milestone that you want to update.
The side panel opens showing the milestone details.

4. Update or delete the milestone.

◦ To update, edit the field details and click Save.

For information on the form fields, see Roadmap configuration form.

◦ To delete the milestone, click Delete.

Select OK  to confirm.

Add milestones for roadmap items

Track key outcomes of your planning items (such as demands and projects) by creating 
milestones for them, directly from the roadmap view.

Before you begin
Role required: sn_align_core.apw_user

About this task
Select a roadmap item and create a milestone for it. Use the roadmap side panel to fill in the 
details and submit.

For free-form roadmaps, milestones are supported only if the source table is Planning Item 
[sn_align_core_planning_item] or one of its extensions.

Important: 

You can’t add a project milestone from the roadmap view. Creating or updating project 
milestones may impact the associated project plans. So, it’s recommended to create or 
update project milestones using Project Workspace in Project Portfolio Management  (PPM).

However, any existing milestones of the project are visible on the roadmap if you've 
integrated Portfolio Planning with Project Portfolio Management.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.
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2. From the roadmap view, click a planning item to which you want to add the milestone.
The side panel opens showing the item details.

3. Select the Milestones tab.
Alternatively, you can click Full details  and select the Milestones tab from the full details page.

4. Select the Add milestone icon ( ).
If the item doesn't have any milestones, select New milestone.

5. On the form, fill in the fields.

For field information, see Planning item milestone form.

6. Select Save.
When you go back to the Milestones tab, you can see the milestone listed there.

7. Optional:  Repeat steps 2 through 6 to add more milestones to your items.

Result

• Milestones that you created are indicated on the roadmap item bars.

Here’s an image of a sample roadmap with the roadmap items indicating that they have 

milestones.

• Pointing your cursor over these milestone indicators shows the details such as the milestone 
name, type, and due date.

• Clicking one of these indicators opens the Milestones tab of the Item details side panel. Here, 
you can see a list of all the milestones for this planning item.

What to do next
Learn more about managing milestones:

• Customizing milestone display on roadmap

• Item milestone errors in Portfolio Planning Workspace

• Update roadmap item milestones

Update roadmap item milestones

Update or delete the milestones that you added to your planning items (such as demands, scrum 
epics, or programs) so that they reflect any change of plans.
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Before you begin
Add milestones for roadmap items.

Role required: sn_align_core.apw_user

About this task
From the portfolio roadmap or free-form roadmap, select a planning milestone to update its 
details. Use the roadmap side panel to edit the details and submit.

For free-form roadmaps, milestones are supported only if the source table is Planning Item 
[sn_align_core_planning_item] or one of its extensions.

Important: 

You can’t add a project milestone from the roadmap view. Creating or updating project 
milestones may impact the associated project plans. So, it’s recommended to create or 
update project milestones using Project Workspace in Project Portfolio Management  (PPM).

However, any existing milestones of the project are visible on the roadmap if you've 
integrated Portfolio Planning with Project Portfolio Management.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item and select the Milestones tab.

The side panel shows the list of all the milestones associated with this planning item.

Alternatively, you can click Full details  and open the item's record page and then select the 
Milestones tab.

3. Click the milestone that you want to update.

4. From the milestone form, update the details or delete the milestone.

◦ To update, edit the field details and click Save.

For information on the form fields, see Planning item milestone form.

◦ To delete the milestone, click Delete.

Select OK  to confirm.

Add dependencies for roadmap items

Create dependencies and visualize relationships between planning items of your portfolio or 
free-form roadmap, so that you can adjust their scheduling.

Before you begin
Role required: sn_align_core.apw_user

About this task
From the portfolio roadmap or the free-form roadmap, use the item details side panel to create 
dependencies between two planning items. Dependencies are supported for projects, epics, 
demands, initiatives, programs, or any custom planning item types that you may have created.
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The dependency for a planning item on your roadmap can be on an item from the same 
roadmap, a different roadmap, or the item might not be planned yet. Learn more about 
dependencies in the roadmap.

Note: 
Dependencies for free-form roadmaps are available only if the roadmap's source table is 
Planning Item [sn_align_core_planning_item] or one of its extensions.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item for which you want to add the dependency.
The side panel opens showing the item details.

3. Select More  > Dependencies.

4. From the Dependencies tab, select the Add dependency icon ( ).

5. On the form, fill in the fields.

For form field information, see Dependency form.

6. Select Save.

Result
The dependency is created between the selected planning items 
and is listed in the Dependencies tab of the Item details side 

panel.

On the roadmap, you can see the dependency details from the roadmap item card or the 
dependency lines. Learn about display settings available for dependencies on the roadmap.

If one of the dependency items is not on the roadmap, then the dependency details are shown 
on the roadmap item card, with a redirect link to the external planning item. In this case, the items 
could belong to the same roadmap or not.
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What to do next

• Learn how to resolve a roadmap item dependency error.

• Update the dependency details or delete it. See Update roadmap item dependencies.

Update roadmap item dependencies

Update or delete the dependencies for the planning items on your roadmap so that they reflect 
any change of plans.

Before you begin
Role required: sn_align_core.apw_user

About this task
Use the roadmap side panel to change the details of a dependency or delete it.

Dependencies for free-form roadmaps are available only if the roadmap's source table is 
Planning Item [sn_align_core_planning_item] or one of its extensions.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item whose dependencies you want to update or 
delete.

The side panel opens showing the item details.

3. Select More  > Dependencies.
Dependencies for this planning item are listed in the form of cards.

4. From the side panel, locate your dependency and use the More actions icon ( ) to edit or 
delete.
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Personalize roadmap view

Customize the way that your roadmap is displayed. Group the roadmap items, color them by a 
category, add numerical data points, and display milestones and dependencies to analyze your 
roadmap efficiently and take informed decisions.

Before you begin
Role required: sn_align_core.apw_user

About this task
This task provides guidance on different options to personalize your roadmap view. Choose the 
options that you want to apply.

Any settings that you apply here are saved as preferences per roadmap. All users who can 
access the roadmap would see the same settings.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. Modify the scale of the timeline of your roadmap.
Select the time scale icon ( ) and choose Month, Quarter, or Year.

Note: 
The timescale view that you choose is saved in the roadmap preferences.

3. Use the side panel to personalize how your roadmap looks like.

a. From the side bar, select the Personalize icon ( ).

b. Group and color your roadmap items by the available attributes.

You can group the roadmap items by up to two attributes and color-code them by one 
attribute.

You can work with your admin to add other attributes for the Group by, Color by, and Metrics 
fields. See Customize the planning item display preferences for Prioritization and Roadmap 
in Portfolio Planning Workspace.

c. Enable visibility of owners of the roadmap items by using the Owner  toggle.

d. Display data points such as planned cost on the roadmap item bars by adding fields in the 
Metrics  section.

You can add up to three metrics.
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e. If your roadmap items (such as projects, epics, or demands) have milestones, adjust how 
they’re displayed using the toggles in the Milestones section.
For more information, see Customizing milestone display on roadmap.

f. If your roadmap items have dependencies, adjust how they’re displayed using the toggles in 
the Dependencies section.
For more information, see Customizing roadmap item dependency display.

g. Identify the current date on your timeline using the current date indicator.
Enable the Current date line  toggle from the Other settings section.

4. Filter the data shown on the roadmap by applying conditions to the planning items.

a. From the sidebar, select the Filter roadmap items icon ( ).
The side panel opens to show the currently applied filters in the Filter overview.

b. Select Update filter  to add or update the conditions.
Use the AND  and OR  operators to build your conditions.

c. Select Apply.

5. Quickly enable or disable the display of dependency lines between the roadmap items using 

the Display dependency lines icon ( ).

6. Zoom in, zoom out, and reset the zoom of your roadmap view by using the zoom options.

Note: 
The zoom level that you choose isn’t saved as the roadmap preferences.

7. Apply quick filters for Prioritization and Roadmap data in Portfolio Planning

Customizing milestone display on roadmap

Easily track the milestones of your roadmap timeline or its planning items by choosing how the 
milestones are displayed on the roadmap view.

The Personalize ( ) side panel on the roadmap provides different toggles to personalize the 
display of milestones on your roadmap.

• For portfolio plan roadmaps, these toggles are always available.

• For free-form roadmaps, these toggles are available only if the roadmap's source table is the 
Planning Item table [sn_align_core_planning_item] or one of its extensions.
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Milestones toggle Roadmap view

Roadmap milestones

Shows the milestones of the roadmap 
timeline.

Item milestones

Shows the milestones of the planning items.

Only milestones

Shows just the milestones on the roadmap by 
hiding all the planning item bars.

When you select this toggle, the group by and 
color by fields are changed and made inactive. 
Your previous personalization settings are 
available when you turn off this toggle.

You can also see that the milestone indicators 
are colored in this view.

• Red: Missed

• Green: Achieved

• Black/Dark gray: Upcoming
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Milestones toggle Roadmap view

Note: 
If the total number of item-level 
milestones, including the milestones for 
unscheduled items, exceeds 100, the 
item milestone indicators aren’t visible 
on the roadmap. You can work with your 
admin to change this number to a value 
of your preference. For more information, 
see Update the display limit of items for 
Prioritization and Roadmap in Portfolio 
Planning.

Milestone label

Shows the milestone labels.

Milestone indicator with label

Milestone indicator without 
label

Customizing roadmap item dependency display

Improve the efficiency of identifying the relationships between your planning items by choosing 
how the dependencies are displayed on the roadmap view.

The Personalize ( ) side panel on the roadmap provides different toggles to personalize the 
display of dependencies on your roadmap.

• For portfolio plan roadmaps, these toggles are always available.

• For free-form roadmaps, these toggles are available only if the roadmap's source table is the 
Planning Item table [sn_align_core_planning_item] or one of its extensions.
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Dependencies Toggle Roadmap view

View dependencies

Indicates dependencies in the form of circles 
on either side of the planning item bars.

These circles either contain a number 

inside them ( ), indicating the number of 
dependencies that item shares, or is colored 

red ( ) indicating a conflicting dependency.

Note: 
This toggle must be enabled to use the 
other two toggles in the Dependencies 
section.

Dependency circles on the 
roadmap

Dependency lines

Indicates dependencies using lines between 
the planning items.

These lines are shown only if:

• Both planning items of the dependency are 
within the same roadmap

• Dependency is of the Depends on  type

Dependency lines between the 
planning items

Only items with dependencies

Filters the roadmap to show only those 
planning items that have that have at-least one 
Depends on  type of relationship.

The items shown here can depend on items 
on or out of the current roadmap.

Roadmap showing only items 
with dependencies

Track the progress of roadmap items

Visually track the completion of a work item on your portfolio plan roadmap or free-form roadmap 
using the tracking mode.

Before you begin
Role required: sn_align_core.apw_user

About this task
Use a toggle to switch your roadmap view from planning mode to tracking mode. The roadmap 
item cards turn into progress bars to indicate the status and progress.

Note: 
While in Tracking mode, you cannot create, update, or reschedule roadmap items and 
milestones. This view is a read-only mode.
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. Use the Tracking mode toggle to turn on the tracking view of the roadmap.

3. Optional:  Personalize the roadmap view in tracking mode.

Note: 
The group by and color by personalization that you've done in the planning mode of your 
roadmap gets carried over to the tracking mode but the metrics are not carried over.

a. Enable or disable the visibility of the roadmap item status and percentage complete using 
the Status  and % Complete  toggles respectively.

b. Display data points such as planned cost on the roadmap item bars by adding fields in the 
Metrics  section.
You can add up to two metrics in tracking mode.

c. Personalize the display of milestones.
You can choose to display the milestone with just its icon or along with its label.

Milestone indicator with label Milestone indicator

Result
The tracking view of your roadmap is displayed according to your personalization settings. A 
sample view of roadmap tracking is shown in the following image.
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Apply quick filters for Prioritization and Roadmap data in Portfolio 
Planning
Quickly apply filters for data in the Prioritization or Roadmap tabs to help you seamlessly plan 
using a consistent data set across all views of the tab.

Before you begin
Role required: sn_align_core.apw_user

About this task
Quick filters help you filter the data shown in the List and Hierarchy views of Prioritization and 
Roadmap. These filters are saved as your preferences. This way, you can view the same data 
across all views for a tab, even when you log back in later, helping you seamlessly plan, prioritize 
and roadmap work.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Based on the tab you want to work in, select Prioritization, Roadmap, or Capacity Planning.

By default, the data in the Roadmap tab is filtered with the Planning state of Prioritized  and 
you see only prioritized items.

4. From the portfolio plan header, select Filter  and add conditions.

You can add filters for only those fields that are of the choice or reference type, within the tab.

◦ You can apply filters on only those fields that are available in those views.

◦ The filters are automatically applied and the data shown in the tabs is automatically 
refreshed.

◦ The filters set in the Prioritization tab are not applied to the Roadmap tab and vice-versa.

◦ The filters set in to one view are also applied to the other views, within the same tab.

Optimizing planning with scenario planning in Portfolio Planning
As a portfolio manager, optimize your portfolio planning by comparing potential outcomes, 
assessing their alignment with strategic goals, and approving the best scenario as your live plan.
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Scenario planning items in the Prioritization tab

The Prioritization  tab of the Scenario page enables you to add and remove planning items 
to/from a scenario and adjust their dates.

Scenario planning items in the Roadmap tab

The Roadmap  tab displays a Gantt chart-like view of the planning items in the scenario, showing 
their planned start and end dates across the portfolio plan timeline. Using the Roadmap tab, you 
can drag the bars representing planning items across the timeline to adjust their dates.

Scenario planning items in Financials tab

The Financials  tab of the Scenario page enables you to set custom targets, budget, and 
compare the allocated budget against target using the outcomes panel.
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Portfolio Manager can simulate multiple scenarios with different budget combinations and 
compare their outcomes to arrive at an informed decision to balance the resources and strategic 
objectives. Using the financials view in Scenario planning, you can get a simulation mode for the 
financial information. Using this view, the strategic planning users such as Portfolio managers, 
Program managers, or Portfolio user working on the portfolios, can set a portfolio budget target 
for a particular planning cycle, which could be a monthly, quarterly, yearly, or beyond a year up 
to 5 years. Using this defined budget, portfolio users can prioritize the planning items within the 
portfolio to analyze if the prioritized items can be executed within their portfolio budget, while 
reviewing the monetary benefit from the prioritized items.

Important: 
Enable the budget allocation property  to allocate budget to your planning items at portfolio-
level and configure the budget attributes  to allocate budget by expense type or cost type.

Create multiple scenarios to compare them, and work with your stakeholders to approve an ideal 
plan with better monetary benefit returns. Once approved, the approved Scenario will become 
your new portfolio plan for the defined planning cycle. For more information to know about the 
changes happening in a portfolio after scenario approval, see Approve a scenario.

You can perform financial scenario planning throughout your planning or execution cycle 
depending on your organization needs such as at your regular planning cycles, quarterly 
reviews, or financial review cycles. Financials in scenario planning helps you to arrive at an 
informed decision and customize the portfolio planning to match with your organization needs.

Note: 

• Finanicals in scenario planning is supported only for Epics, Projects, and Demands type 
of planning items.

• Customers using the Legacy Investment Funding should migrate to new experience to 
work on the financial scenario planning.

Personalize your scenario planning financials view using the Time scale and Range filters. 
Manage the budget of your planning items by monthly, quarterly, or yearly cadence depending 
on the planning cycle of your organization.

Outcomes panel in Scenario planning

The outcomes panel in the simulation indicates the financial information of the portfolio such as 
target and budget amounts for Capex and Opex, set budget target for this simulation, utilized and 
remaining budget from the target, benefit from the In-plan items, and the actual costs accounting 
from the out of plan items. The aggregated data is fetched based on the portfolio timeline range 
including the target and budget data.
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Representations in outcomes panel for the identification.

Outcomes panel representation

Indication Definition

Red text for amount without progress bar 
indication for Total Simulated Budget

No defined or set target amount for this 
scenario.

Red text for amount and red progress bar for 
Total Simulated Budget

Total allocated budget for planning items 
exceeds the scenario's set target amount.

Red text amount for Capex Budget Capex Budget allocations exceed the 
scenario's Capex target.

Red text amount for Opex Budget Opex Budget allocations exceed the 
scenario's Opex target.

Green text for budget amounts and green 
progress bar

Budget allocation for each expense types and 
total budget is within the scenario's set target.

Scenario planning features

In scenario planning, you can perform the following actions:

Feature Description

Create a scenario Create a scenario from the current plan, or 
another scenario, in a simulated environment 
to compare the scenario with the live plan and 
other scenarios.

Compare scenarios Compare scenarios and the live plan side by 
side to review tradeoffs and items added or 
removed from the plans.

Approve a scenario Approve the best scenario.

Manage scenarios View list of scenarios, rename scenarios, and 
delete scenarios.

Scenario planning use cases

The following are high-level use cases for scenario planning.

• Fiscal year planning: Megan Burke, Portfolio Manager at ACME Inc, is planning for the next 
fiscal year and is required to prioritize planning items and align them with the organizational 
strategic goals. Megan creates a scenario for the portfolio plan and then uses the Prioritization 
tab to align items with goals. Megan holds discussions with program managers and with the 
financial team, creates multiple scenarios, and compares them. Megan approves the optimal 
scenario as a well-aligned strategic portfolio plan for the next fiscal year.

• Mid-cycle reprioritization; Changed priorities emerging mid-year require adjustments to the 
current portfolio plan. John Doe, the product manager at ACME Inc, creates a scenario and 
incorporates the changed priorities. John adjusts the plan based on the program manager's 
and financial team's feedback and finalizes the plan.
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Create a scenario

Create a scenario from a live plan or another scenario in a simulated environment to compare the 
scenario with the live plan and other scenarios.

Before you begin
Role required:

• sn_align_core.apw_user

• sn_align_ws.spw_financial_user - to view and edit financial details.

About this task
Creating a scenario enables you to visualize and anticipate potential outcomes. You can create 
a scenario based on the live plan or on another existing scenario. Once you have created one 
or more scenarios, you can compare them side by side with the live plan and approve the most 
desirable scenario. The scenario you approve becomes the live plan.

Procedure

1. Navigate to Workspaces  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Select Create scenario.

Note: 
Before you have created your first scenario, you see the Scenario planning  button on the 
Scenario page. In such a case, select Scenario planning  and then you see the Create 
scenario  button.

a. Enter a name for your scenario in the Scenario name  field.

b. Optional:  Enter the details of your scenario in the Description  field.

c. In the Copy From  field, select the Current Plan  or the name of an existing scenario based on 
which you want to create the scenario.

d. Select Create.
The Scenario planning- [Scenario Name] page appears with the Prioritization tab open. The 
Prioritization tab lists all the planning items that you have in the live plan, or in the existing 
scenario that you copied the scenario from. The planning item start and end dates are 
determined based on the dates specified in the live plan or the actual execution dates.

◦ In Plan  toggle: By default, the In Plan  toggle is switched on for planning items that have 
the planning state as Prioritized or Done and have their start dates within the portfolio plan 
timeline. The In Plan  toggle is turned off for items that have the status New, In Review, or 
Canceled.

◦ Yellow highlights for out of range dates: The planning item dates that are out of range of the 
portfolio plan timeline are highlighted with a yellow background. For such items, the In Plan 
toggle is turned off.

4. Use the Prioritization tab to include or exclude additional planning items in the scenario.
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a. Optional:  To exclude a planning item from the scenario, turn off the In Plan  toggle.

b. Optional:  To include a planning item in the scenario, edit the start and end dates of the item 
to fall within the portfolio plan timeline, and then turn on the In Plan  toggle.

If you include out-of-timeline items in a scenario, these items remain in the scenario during 
the planning and prioritization process. When the scenario is approved, the dates of these 
items are updated to align with the scenario dates. However, because these updated dates fall 
outside the original portfolio plan timeline, the items are moved out of the live portfolio plan.

5. Use the Roadmap  tab to view planning item dependencies and adjust planning item dates:

a. Drag the start or end of the planning item bars to change their start or end dates.

b. Drag the planning item bars to shift them in the plan timeline.

c. View the dependencies and milestones of the various planning items.

6. Use the Financials  tab view the prioritize, invest, and execute the right items to provide best 
returns on investments for your organization.
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a. Set target for your portfolio budget.

i. Select the Set Targets  ( ) button.

ii. In the Set Targets window, set budget for an expense type or a cost type using the inline 
edit feature.

Tip: 
You can change the Time scale  and Range  to set targets for each fiscal period at 
monthly, quarterly, or yearly cadence to meet your organization's planning cycle. The 
target set for a higher timescale, it is equally split it between the fiscal periods.

Once the target is set for a scenario, the Target  row displays the defined target amount by 
fiscal period and budget allocation choices.

b. Include or exclude planning items in scenario using the In-plan  toggle.

c. Add or reduce budget for individual planning items using the inline editing feature.

Changes made to the budget using while creating a scenario are marked with  icon.

What to do next

• Create more scenarios, if necessary.

• Compare scenarios. You can directly compare scenarios from simulation mode by selecting 
Compare scenarios  from the Scenario actions list.

• Approve a scenario.

Compare scenarios

Compare scenarios side by side to evaluate comprehensive planning, optimize resource usage, 
confirm feasibility, and financial information.

Before you begin
Verify that you have created one or more planning scenarios and selected planning items for 
execution. For more information, see Create a scenario.

Role required:

• sn_align_core.apw_user

• sn_align_ws.spw_financial_user - to view the financial widgets.
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Procedure

1. Navigate to Workspaces  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Create scenario menu, select Compare scenarios.
The Compare scenarios page appears.

4. Select Add Scenario To Compare  and select or deselect scenarios to be included in the 
comparison.
You can add up to five scenarios to the comparison.

5. Select Compare.
You can also view the Compare Scenario page by selecting Compare Scenarios  from the 
Scenario Actions menu in the Scenario page. The Compare Scenario page appears with the 
scenario open in the Scenario page included in the comparison with the current plan.
The selected scenarios appear side by side on the Compare Scenario page.

6. Compare different aspects of the scenarios such as Budget vs Target, Benefit, Budget 
distribution, trade offs.
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Note: 
Cost and benefit widgets in compare scenarios page reads the live data of In-Plan  items 
for which the budget isn’t manually changed while scenario planning.

Visual cues in scenario comparison

Criteria Description

Removed from this plan Items that are removed from the plan when 
the scenario is approved, are marked with a 
red X.

Added to this plan Items that are added to the plan, when the 
scenario is approved, are marked with a 
green checkmark.

The following are some indications of the suitability of a scenario for approval:

◦ All planning items providing a focused strategy that supports the organization's objectives 
effectively.

◦ The trade-off section includes relevant items, demonstrating comprehensive and inclusive 
planning that addresses various aspects of the project or initiative.

◦ The scenario is realistic and achievable, considering current constraints and capabilities, 
confirming that planned actions can be executed within the given timeframe and budget.

◦ Better benefit from financial planning using the widgets, Budget vs Target to validate the 
allocated budget against the set targets, Benefit to identify scenario with better monetary 
benefit, and Budget Distribution.

7. Optional:  Select the Approve Scenario  button relevant to a scenario to approve it.
For more information about approving existing scenarios in the Portfolio Planning Workspace, 
see Approve a scenario.

What to do next
Approve a scenario

Approve a scenario

Approve a scenario that aligns with your organizational goals and offers the best business 
outcomes to make the scenario your current plan.

Before you begin
Ensure that you have compared the scenarios and selected the one you want to approve. For 
more information, see Compare scenarios.

Role required:

• sn_align_ws.scenario_approver

• sn_align_ws.spw_funding_user - to view and approve the financial changes.

About this task
When you approve a scenario:

• Planning items with the In Plan state are updated to the Prioritized state.

• Planning items that you moved out of the plan are changed to the In Review state.

• The approved dates are revised accordingly.

• Changes made to the budget of a planning item is will be approved as the budget.
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Procedure

1. Navigate to Workspaces  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Create scenario menu, select Compare scenarios.

The Approve scenario  button is also available on the Scenario page. As soon as you have 
created a scenario, you can directly approve a scenario without comparing it with the other 
scenarios.

4. Select the Approve scenario  button relevant to the scenario that you want to approve.

While approving a scenario, you can:

◦ Convert the priotitized demands to projects to automatically build a portfolio plan by 
selecting the Convert In-plan Demands to Projects  toggle.

◦ Delete the remaining scenarios by selecting the Delete other scenarios  toggle.

◦ Enter a reason for approving the scenario in the Notes field.

5. Select Approve.

Manage scenarios

Use the Manage scenarios option to view a list of all scenarios, rename scenarios, or delete 
scenarios.

Before you begin
Role required:sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Navigate to Create Scenario  > Manage Scenarios..
You can also select Manage Scenarios  in the Recent Scenarios menu in the Scenario page.
The Manage scenarios dialog appears with the list of scenarios relevant to the current plan.
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4. Do any of the following actions.

Using capacity planning in Portfolio Planning
Assess the resource capacity and review existing allocations, which help you to make informed 
decisions while working on assigning resources.

Use the manage resource capacity  screen to generate resource capacity details.

Use the Capacity Planning screen  to view detailed information about the resource capacity 
mapping to a portfolio.

Manage resource capacity

Manage resource capacity screen

Using Manage resource capacity, select a time frame and primary attributes to view number of 
available resources. Generated resource capacity details are saved. You can regenerate capacity 
to view latest changes in the resource availability.

Resource capacity screen helps you to view the following data.

• Resource availability for generated capacity.

• Total number of available resources in a monthly breakdown view.

• Latest date of generating the capacity details.

• Option to regenerate and fetch the latest capacity details from the employee profile mappings.

On the Manage resource capacity screen, you can:

• Filter resources with specific capacity attributes for a required date range to view the number 
of available resources.

• Regenerate capacity details to view the latest details from the resource employee profile 
mapping.
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Select resource criteria

• Select a primary attribute to automatically view the available groups, roles, or skills from the 
resource assignments of the prioritized planning items.

• Switch between Auto-select  and Manual-select  option to view the allocated resource efforts 
for all planning items or to view a custom data, respectively.

• Define resource criteria to view the available groups, roles, or skills from the resource 
assignments of the prioritized planning items.

Capacity Planning

Capacity Planning screen displays the resource efforts from the prioritized planning items.

• Comprehensive overview of resource capacity and allocations.

• Current resource capacity allocation.

• Interactive Gantt chat to view prioritized planning items in the bottom tray to analyze and plan 
work.
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Understanding the Capacity Planning screen.

Capacity Planning legend

Color Description

Yellow (Gantt bar) Planning item with no resource assignments.

Blue (Gantt bar) Resource estimates for Planning items are 
within the resource capacity.

Red (Cells and Gantt bar) Overallocation in resource estimates.

Green (Cells) Resource estimates within the resource 
capacity.

Using Capacity Planning, you can:

• View the capacity allocations of prioritized planning items for your current portfolio and better 
forecast your future resource requirements.

• Use the filter option ( ) to view planning items by their type, state, priority or any by any 
required attributes to create capacity plans.

Note: 
Default filter is set to display prioritized planning items only.

• View the updated resource capacity based on the assigned operational resource assignments.

• View the total resource capacity in the heatmap view.
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• View total resource capacity and total estimates.

• View the efforts for operational work and efforts for estimates outside of portfolio in the 
Additional items  list.

• Redefine the workforce criteria by selecting Resource criteria  ( )

Example: Calculation of Operational Resource Assignment in Capacity Planning
As a Resource Manager, you can create operation resource assignments  or migrate existing 
operational resource plans  of your employees to handle the required meetings, trainings, time off 
and so on to meet your work requirements.

Consider a group with capacity of 2 FTE and resource manager creates a Group type operation 
resource assignment for 10% of the capacity for training. This operational assignment can be 
viewed in the Operational work  line item in the top-tray of the Capacity Planning screen. The 
value of the Operational work  line item will be 0.2, which is 10% of total capacity of the group.

When a resource manager creates a Group type operation resource assignment for time off, this 
doesn't update the Operational work  line item but reduces the total available capacity.

Consider the same group for which resource manager creates an operation resource assignment 
for 25% of the capacity for time off, for a quarter from April to June. The total available capacity 
of the group for the quarter April to June will be 1.5 FTE, which is 75% of the total capacity after 
reducing the 25% time off.

0.5 FTE, which is 25% of total capacity of the group will be reduced.

Note: 
The Operational work  line item is highlighted in gray color.
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Generate resource capacity

Generate and view the total capacity of the resources with primary attributes. Capacity details 
helps Portfolio Managers to plan and manage planning items depending on the resource 
availability.

Before you begin

1. Enable planning attributes for capacity planning. For more information, see Enable planning 
attributes for capacity in Portfolio Planning.

2. Generate employee profiles for resources. For more information, see Generate employee 
profiles for resources to work with capacity planning.

Role required: sn_align_ws.spw_capacity_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace.

2. Select the Manage resource capacity  option ( ).

Note: 
If planning attributes aren’t enabled for capacity planning, you see an empty state screen 
with an option to configure. Contact your admin to enable planning attributes for capacity 
planning. For more information, see enable planning attributes for capacity planning.

3. Use one the following options to view and regenerate the capacity details.

What to do next
Use Capacity Planning  to view the resource capacity, resource-to-work mapping and re-prioritize 
resource allocations to effective execute your prioritized planning items.

Use Capacity Planning in Portfolio Planning

View and analyze the resource capacity for your portfolio to plan and re-forecast the resource 
assignments.
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Before you begin
Generate resource capacity using Generate resource capacity.

Role required: sn_align_ws.spw_capacity_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace.

2. Select a plan from Portfolio Plans.

3. Select Planning  > Capacity Planning.

4. Define a resource criteria by selecting a primary attribute from the list.
If you select Group, all the available groups from the resource assignments of the prioritized 
planning items are automatically displayed in the Auto-select option. You can add or remove 
the suggestions to view the resource capacity using the Manual-select option.

Tip: 
You can always redefine and change the resource criteria to view custom results using 
the Resource criteria  ( ) button.
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5. Select Submit.

Result
The Capacity Planning screen for resource capacity allocation for the selected workforce criteria 
is displayed. Based on the workforce criteria selection, the resource capacity is nested by Group, 
Skill, and Role.

Managing financials for planning items in Portfolio Planning
Manage budget, cost plans as forecasts, actual expenses as expense lines, generate labor 
costs, create financial baselines, and view, analyze, and compare the financial performance of 
your planning items at required cadence in Portfolio Planning  Workspace.

The comprehensive financials view helps you to understand planned and actual costs, Forecast 
(previously EAC - Estimate At Completion), Remaining Estimates (previously ETC - Estimate 
To Completion), Actual (previously Actuals to date), and so on, for the selected item. You can 
manage cost plans and associate the expense lines and process them to reflect the actuals for a 
planning item.

Export the financials data from Costs and benefits or Baseline comparison view as Microsoft 
Excel or a CSV file and share it with your stakeholders to review the financial performance of your 
planning items and portfolio.

Cost view

Forecast your planned costs, create, and manage cost plans and expense lines to track the 
financial performance of your planning items, review the latest costs and actuals.
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In the Cost screen, you can:

• As a Project Manager, you have the enhanced visibility and ability to manage the financial data 
across multiple project levels. Cost view of financials shows cost plans and expense lines from 
sub-projects, allowing you to track the finances.

• The parent project widgets display the consolidated values of forecasted costs and expenses.

• Identify and manage costs using the Project/Demand  column for any sub-project or demand 
directly from Cost view of the parent planning item.

• Reforecast all the cost plan values for future fiscal periods by double-clicking to edit the value 
in the least time scale view, either by month or by period.

• Manage cost plans for your planning items. For more information, see Add, edit, or delete cost 
plans.

• Add or edit expense lines for your planning items to record any planned or unplanned 
expenses. For more information, see Add or edit expense lines.

• Generate labor costs for the fiscal period. For more information, see Generate labor costs.

• Create and compare baselines to capture the financial snapshot of your planning items. For 
more information, see Create and compare financial baselines for demands and projects.

• Configure widgets  to get a high-level overview of the financial data for your planning item.

• All financial details from sub-projects will be aggregated and displayed in the parent project's 
cost plans and widgets.

Tip: 
Cost view gives you enhanced user experience to customize the left pane columns 

by using the personalize icon ( ) and by saving user preferences to retain the 
customizations made to hide, view, or adjust columns, time scope viewing, and so on.

Multicurrency

The multicurrency feature enables you to manage the financials of your planning items in 
two different currencies, Functional currency and Investment currency. Functional currency 
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is typically defined by the admin based as the primary currency that is used for planning, 
budgeting, and tracking the financials of your planning items.

Financial users can now perform the following financial activities in Investment currency.

• Ability to select the Investment currency.

• Track the planned and actual expenses.

• Allocate and manage the budget.

• View simple financials data.

Important: 
New customers should install the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin to enable multicurrency feature and Activate 
scheduled job to populate to multicurrency fields.

Using this feature, you can work on financial reporting at a global level and see the real-time 
currency conversions of your financial records.

Organizations operation at a global or multinational level, the work is planned and financed at 
one location and executed at a different location. Each might use a different currency from what 
was used in the planning phase, multicurrency makes it easy to manage and track your planning 
items using any currency.

You can monitor and track the financials in one currency, and capture the costs in a different 
currency.

Using multicurrency, you can see all the costs in the currency you choose for the planning item, 
instead of restricting to use Functional currency defined in your locale. For more information 
on how to choose investment currency of your planning items, see Configure multicurrency for 
planning items.

Financial records and widgets will display the costs based on the currency selection.

Note: 
Once a cost plan, benefit plan or expense line or an investment budget gets created, you 
won’t be able to change investment currency. You can change the investment currency as 
long as there are no financial records captured against the planning item.

Display modes

On the financials page for a planning item in Portfolio Planning Workspace, you have Display 
Mode drop-down switch between different modes to view different formats of financial 
information of your planning items. These views provide the relevant and focused information 
which helps project managers and funding users to work on the financial planning.

• Forecast

• Budget vs forecast

• Planned vs actual

• Planned

Users with financial funding role [sn_align_ws.spw.funding_user] will see the Budget allocation 
option instead of the Budget vs forecast.
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Display modes value

Mode Value

Forecast View Actuals, Remaining estimates, and 
Forecast for the entire scope of the planning 
items.

Use the time scale to view the actuals for the 
past fiscal periods and planned costs for the 
current and future fiscal periods.

Budget vs forecast View the Budget, Actuals, and Variance for 
the fiscal periods and Forecast values for the 
entire scope of the planning items.

Using this mode, you can:

• Compare the latest forecasts with the 
approved budget at different time scales.

• View the budget vs actual for past fiscal 
periods and budget vs planned for current 
and future fiscal periods at fiscal period 
level.

Budget allocation (funding role) View the Budget, Actuals, and Variance for 
the fiscal periods and Forecast values for the 
entire scope of the planning items.

Using this mode, funding users can:

• View the latest forecast and enter the 
budget that can they be approved to the 
work item.

• Analyze the variance for the past fiscal 
periods and work on budget allocation for 
future fiscal periods.

• Compare latest forecast with approved 
budget and revise the budget, if necessary.

Planned vs actual Compare the planned costs with actual 
expense for the past and current fiscal 
periods, and view planned costs for the future 
fiscal periods.

Planned View only planned costs for the full range and 
manage the planned costs using the inline 
editing feature.

Note: 

• If you don’t see the Budget allocation or Budget vs forecast display options, enable the 
budget allocation property  and configure the budget attribute  at instance level.

• To work on budget allocation using the Next Experience, Activate a scheduled job to 
migrate budget of your planning items.

The last selected view is saved as user preferences.
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Default display mode and access level for financial users

User role Default mode Role-level access

sn_align_ws.spw_funding_user Budget Allocation Allocate and approve budget, 
manage cost plans and 
expenses lines.

sn_align_ws.spw_financial_userForecast Manage cost plans and 
expense lines.

business_stakeholder Forecast View financial data.

Baseline view

Create a financial to capture a snapshot of the financial changes for your planning items. You can 
create on-demand baselines manually or automatically at a required cadence using a scheduler 
job. For more information, see Create a baseline

Note: 
Baselines created on the parent project include cost plans and expense lines from all of the 
child projects to calculate and give you a better breakdown of the financial performance of 
the projects and sub-projects.

Compare baselines  to compare the difference in costs between latest status against a baseline 
or between any two baselines.

Note: 
Each baseline is tagged with a number based on the order that they’re created. The Current 
Financials baseline captures the financials details in real-time and is always represented 

with a flag icon ( ).

Financial baselines now capture the investment currency for customers using multicurrency.

A planning item baseline includes the following financial metrics in investment currency.

• Investment currency

• Total planned cost

• Planned benefit

• Planned return

• Budget cost

At the investment baseline level, a corresponding investment baseline is automatically created. 
This baseline captures:

• Planned cost

• Actual cost

• Planned benefit

• Actual benefit

• Total budget

• Capex, Opex, and breakdown of these fields, and so on

All values are populated along with their respective investment currency.
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Cost plan baselines now store actual cost values in investment currency, along with the 
investment currency field. Benefit plan baselines capture benefit values in the investment 
currency, along with the associated currency. At the breakdown level (for example, fiscal period 
or monthly breakdowns), actual cost and actual benefit values are populated in investment 
currency where actuals exist.

Note: 
Comparison of financial baselines using multicurrency is not yet supported.

You can view the planning item and investment baseline using the list view. 
Access the pm_project_baseline  list to view project baselines, and 
sn_invst_pln_invst_investment_baseline  to view the investment baselines.

The baselines comparison view helps you to understand the variances between the two 
baselines.

Use the widgets when you compare baselines to view:

• Two dedicated widgets for each baseline displaying the EAC.

• The third widget displays the total variance between the EAC values of the selected baselines.

• The fourth widget displays the top three variances contributing to the overall variance by cost 
type.

The widgets and the header rows are color-coded to help you identify the selected baselines.

Tip: 
Switch between different baselines from the comparison view by selecting the name of a 
baseline from one of the widgets.

When you compare baselines, you get the list of cost plans with their associated costs types, 
EAC at full scope, and a breakdown view of actual expenses and planned costs.

By default, the time scale of the breakdown view is set to Month.

• Use the Time scale  option to view the comparison breakdown view at monthly, quarter, and 
yearly levels.

• Select Time scope  to filter fiscal periods, data in the widgets, and the comparison table.

The widgets and the header rows are color-coded to help you identify the selected baselines.
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Tip: 
Select the name of a baseline from the first or second widget to compare different 
baselines.

Let's take an example of the comparison view of two baselines: 2023-10-01, Baseline A, and 
Current Financials, Baseline B.

Example: How actuals, planned, and EAC are compared between two baselines 
captured at different timestamps

For a selected baseline, based on the creation date, the table shows Actuals values for the past 
fiscal periods from the created date and Planned values for the current and future fiscal periods.

Consider a planning item scoped from July 2023 to June 2024. Baseline A is created on 
2023-10-01. If you compare the Current Financials baseline in December 2023 to the baseline 
captured in October 2023:

1. The baseline comparison view show Actuals vs Actuals columns from July 2023 to September 
2023.

2. Planned vs Actuals for October 2023 and November 2023.

3. Planned vs Planned from December 2023 to June 2024.
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Note: 
The columns are defined to calculate EAC, which is the sum of Actual costs until the last 
fiscal period and Planned costs from current to future fiscal periods.

Budget allocation

Portfolio managers can manage and approve the budget for planning items. The approved 
budget helps project managers to plan and meet the expenses to execute work.

Plan and approve the budget for a shorter planning cycle at monthly, quarterly, or yearly level 
using the lean budgeting and funding feasibility. Lean budgeting helps Portfolio managers to 
track the value in return for the approved budget and to better plan the budget for future fiscal 
periods.

Note: 
If the budget is allocated monthly, the total budget is rolled up to quarterly and yearly 
level. Similarly, if the budget is allocated at a quarterly or yearly level, the equal breakdown 
happens until monthly level.

For more information on how to allocate, approve, and handle budget for planning items, see, 
Manage budget of your planning items in Strategic Planning.

Tip: 
In the budget allocation view, Portfolio managers review the EAC to understand the 
financial projections made by Project managers and use the Copy cost as budget  option to 
allocate the entire planned cost as budget.

Choose the cost type as the attribute to allocate and approve the budget for individual cost 
types such as labor, non-labor.

Project managers can view the approved budget at the required time scale using the Budget vs 
forecast option from the display modes. As the work progresses and the actuals are captured, 
you can compare the budget and actual costs using the Budget vs forecast mode and reforecast 
the planned costs where the actuals are exceeding the budget using the inline edit feature at the 
required time scale.

Product managers can compare the latest cost with the approved budget by Capex or Opex, cost 
types, and for the required time scale at monthly, quarterly, or yearly level. The comparison view 
provides insights to Product managers to locate any variance at expense type or cost type, and 
at which fiscal period. Product manager can leverage this information to request for additional 
budget from the Portfolio manager.

You can migrate the budget of existing active projects and demands items from the Classic UI to 
Next Experience. Financials in the Next Experience  has new budget data model that facilitates to 
store the budget at a detailed level by monthly breakdowns and cost types. You can migrate the 
budget for active projects and demands individually or by bulk using the scheduled job.

• Migrate budget of active projects from Classic UI to Next Experience. For more information, see 
Migrate budget of active projects to Next Experience.

• Migrate budget of active demands from Classic UI to Next Experience. For more information, 
see Migrate budget of active demands to Next Experience.

Note: 
The migrated budget is captured in the sn_invst_pln_invst_budget  table to enable 
the lean budgeting for required time scope.

Budget distribution logic
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The budget allocation approach introduces data‑aware  budget distribution, prioritizing 
actuals for completed periods and planned costs for future periods. The system uses different 
distribution strategies depending on whether actuals or Estimate at Completion (EAC) values are 
available, and whether the fiscal period falls in the past, present, or future.

Budget allocation logic is divided into three focus areas: past fiscal periods, current fiscal 
periods, and future fiscal periods.

1. Past fiscal periods that have already ended.

◦ If actuals exist, the budget is distributed proportionally to actual spending. If the total budget 
amount equals the total actuals, the distribution exactly matches the actual values.

◦ If there are no actuals, the budget is distributed evenly across the past fiscal periods.

2. The current fiscal year is like a mid‑year  scenario where both past and future fiscal periods are 
available.

◦ For past or completed fiscal periods, the system distributes the budget proportionally 
matching the actual expenses. If there are no actual expenses, budget is allocated as zero 
(0).

◦ If planned costs exists for the current and future fiscal periods the remaining budget is 
distributed proportionally based on the planned costs.

◦ If planned costs doesn't exists for the current and future fiscal periods, budget is distributed 
evenly across the fiscal periods.

3. Future fiscal periods

◦ If planned costs exists, the remaining budget is distributed proportionally based on planned 
costs.

◦ If planned costs doesn't exists, the remaining budget is distributed evenly across the 
remaining fiscal periods.

Budget distribution based on financial records

Fiscal periods Available financial data Distribution method

Past fiscal Actual expenses Proportional to actuals

Past fiscal No financial records No budget allocation

Current year – past fiscals Actual expenses Allocate budget proportionate 
to actual values

Current year – remaining 
months

Planned costs exists Allocate budget proportionate 
to planned costs

Current year – remaining 
months

No planned costs Even distribution

Future fiscal periods Planned costs exists Allocate budget proportionate 
to planned costs

Future fiscal periods No financial records Even distribution

Benefit plans

Monetary benefit plans capture potential benefits accrued while executing a planning item. Non-
monetary benefit plans capture the potential non-financial benefits accrued while executing a 
planning item. You can create and manage monetary benefit plans  and non-monetary benefit 
plans  to capture the potential benefits of your planning items.
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Instead of switching to and fro from the financials record page to benefit plan tabs, you now have 
a seamless experience to manage all the cost plans and benefit plans from the Cost and benefits 
view and can leverage the new financials experience with the side panel and grids for quick 
forecasting and tracking of monetary benefit plans.

Simple financials

Simple financials gives you the ability to enter the preliminary high-level planned capex, opex, 
benefit, and so on from the Details page without capturing the costs plans from the Cost view. 
You can update the simple financials values as required until you have the planned and actual 
costs captured.

Using the baseline feature, you can capture these simple financial values in a baseline and 
compare them against any existing baseline. You can:

• Reforecast simple financials and compare the by selecting the Current Financials from the list 
of baselines.

• Capture the planned and actual expenses as the project progresses and compare any 
financial baseline with a simple financials baseline to track the financial performance of the 
planning item.

Configure multicurrency for planning items

Select investment currency as an additional currency, which can be different from your functional 
currency, to manage financial records of your planning items.

Before you begin

• Enable monetary benefit plans for planning items

• Role required: admin

Procedure

1. Navigate to Workspaces  > Portfolio Planning  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.
In the Currency  field, the current system currency is displayed. For example, if your Functional 
currency is in USD, the field is displayed as USD (Functional).
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4. Select Confirm  to save the investment currency selection.

Add, edit, or delete cost plans

Create a cost plan for a required duration to track your planned and actual expenses. Edit cost 
plans to adjust your planned expenses and delete any de-scoped forecasts.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and open a planning item.

2. Select the Financials  tab.

Tip: 
Create a financial baseline  immediately after capturing the initial planned costs to have 
a snapshot of your planned costs. Use this baseline to compare it against the baselines 
from later dates, as the work progresses, to identify the variance between initial planned 
costs and actual expenses.

This helps you to plan for the future expenses and re-forecast the planned costs.

Manage budget of your planning items in Portfolio Planning

Allocate, manage, and approve budget for your planning items. Lean budgeting enables you to 
allocate budget for short planning cycles for different fiscal periods such as monthly, quarterly, or 
yearly breakdown level rather than allocating the budget to the complete duration of the planning 
item.

Before you begin

• As an Admin, enable the property to work on budgeting. For more information, see Enable 
financial budget allocation for planning items in Portfolio Planning.

• As an Admin, configure the attribute to allocate and approve budget by cost type or expense 
type. For more information, see Configure budget attribute at instance-level to allocate budget.

• Role required: it_portfolio_manager

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and open a planning item.

2. Select the Financials  tab.

3. Enable the Budget allocation  toggle ( ).

4. You can manage the budget by one of the following ways for the selected time scale at 
monthly, quarterly, or yearly level.

◦ Double-click each cell in the Budget column to manually enter the value.

◦ Select Copy cost as budget  from the Budget column options to copy the EAC as budget.
You can always reforecast the budget for each cost type using the in-grid editing feature even 
if the EAC is copied as budget.
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Note: 

Unapproved budget values are indicated with  icon.

5. Select Approve budget  ( ).
Approve budget confirmation window is displayed. The Create a financial baseline for this 
budget approval  option is enabled by default which captures the latest budget and financial 
estimates.

Tip: 
The financial baseline created while approving the budget can be compared with the 
future baselines once the actual expenses are captured to track financial performance.

6. On the confirmation window, select Approve  ( ).

Result
Budget widget is updated to reflect the latest approved budget. Project Manager can view the 
approved budget and compare it with the planned costs using the budget vs cost  view by cost 
type.

Add or edit expense lines

Create or edit expense lines to capture the actuals costs. You can associate the expense lines 
with a cost plan or create standalone expense lines to record unplanned expenses.

Before you begin
Role required: sn_align_ws.spw_financial_user

About this task
An expense line is part of the project cost plans that can be associated with a specific source. 
You can create multiple expense lines for a cost plan. Only the expense lines that are in the 
processed state are considered for roll ups on the work item.
For unplanned expense lines which are not associated to any cost plan, system automatically 
creates an cost plan or associates to an existing system generated cost plan of the same 
expense type.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and open a planning item.

2. Select the Financials  tab.

3. Add an expense line using one of the following options.

4. On the Create expense line form, fill the fields.
For a description of the field names, see Create expense line form.

5. Select Save.

Generate labor costs

Generate labor costs in the Financials view for attribute-based resource assignments based on 
the financial attributes configured in the planning attributes page.
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Before you begin
When the distribution of effort for a resource assignment is adjusted without changing the 
total planned effort, the system automatically recalculates and generates labor costs to align 
with the updated effort distribution. For example, consider a resource assignment of 100 hours 
distributed as 60 hours in January and 40 hours in February; now if you swap the efforts to make 
40 hours in January and 60 hours in February. Now the system automatically adjusts the labor 
costs so that January reflects the cost of 40 hours and February reflects the cost of 60 hours, 
ensuring that costs accurately correspond to the revised effort distribution.

Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and select a planning 
item.

2. Select the Financials  tab.

3. Select Generate labor costs  ( ).

4. Select Generate  on the Generate labor costs confirmation window.

Note: 
Alternatively, you can activate a scheduled job  to automatically create baselines at the 
required cadence.

Create and compare financial baselines for demands and projects

Create and compare financial baselines to get a snapshot of the project expenses and compare 
the planned costs against the actual expenses.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and select a planning 
item.

2. Select Financials  from the left menu.

3. Create or compare baselines.

Tip: 
You can migrate existing financials baselines of your projects or demands from Classic UI 
to Financials in Next Experience.

For more information on how to migrate financial baselines of demands, see Migrate financial 
baselines of demands to Next Experience.

For more information on how to migrate financial baselines of projects, see Migrate financial 
baselines of projects to Next Experience.

Create monetary benefit plans for your planning items in Portfolio Planning

Create and manage monetary benefit plans to capture the potential benefits while executing 
your planning items.
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Before you begin

• Enable monetary benefit plans for planning items

• Add monetary and non-monetary benefit plans related lists

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and select a planning 
item.

2. From the list of portfolio plans, select a portfolio plan.

3. From the Prioritization or Roadmap tab, select the planning item to create a monetary benefit 
plan.
The full details page of the planning item is displayed.

4. Create a monetary benefit plan using one of the following options.

5. On the Benefit Plan form, fill the fields.
For a description of the field names, see Benefit Plan form

6. Select Save.

Result
The newly created monetary benefit plan appears in the finanicals record page and in the 
monetary benefit plans related list.

What to do next

• Edit monetary benefit plan.

• Capture actual monetary benefits.

Edit monetary benefit plan

Edit a planned monetary benefit plan to revise the benefits, dates, offset, and so on, to maintain 
the updated financial records as your work progresses.

Before you begin

• Create monetary benefit plans for your planning items in Portfolio Planning

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and select portfolio plan.

2. From the Prioritization or Roadmap tab, select the planning item for which you want to edit a 
monetary benefit plan.
The full details page of the planning item is displayed.

3. Update a monetary benefit plan using one of the following options.

Capture actual monetary benefits

Capture the actual benefit from the planned benefits to measure revenue and calculate the 
profits.
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Before you begin

• Create monetary benefit plans for your planning items in Portfolio Planning

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and select portfolio plan.

2. From the list of portfolio plans, select a portfolio plan.

3. From the Prioritization or Roadmap tab, select the planning item for which you want to capture 
actual monetary benefits.
The full details page of the planning item is displayed.

4. Capture actual monetary benefits using one of the following options.

5. Optional:  You can change the previously captured planned benefit from the Entered benefit 
field.

6. Enter the actuals benefits resulted from the work execution in the Actual benefit  field and 
select Save.

Manage non-monetary benefit plans for your planning items in Portfolio 
Planning

Create and manage monetary benefit plans to capture the potential benefits while executing 
your planning items.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Non-monetary Benefit Plans  related list.
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4. On the Benefit Plan form, fill the fields.
For a description of the field names, see Non-monetary benefit plans form.

5. Select Save.

Export financials as Excel or CSV file

Export the costs or baseline comparison data of your planning items to easily share them with 
your stakeholders.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and select a planning 
item.

2. Select the Financials  tab.

3. Select the Export option ( ).

4. In the Export side panel, select Excel  or CSV  from the File type list and select the Export 

button ( ).

The financials data is download as an Excel or CSV file with name_fin_mmddyy  naming 
convention. The breakdown of the naming convention:

a. name - fetches the first 10 characters from the name of the planning item.

b. fin - denotes that the file has financial data.

c. mmddyy - system date format when you're exporting this data.
For example, if you're downloading financials data for a planning item named Documentation 
on January 26, 2024, then the file name reads documentat_fin_012624.

Note: 
You can export financials data from Cost view and Baselines comparison view.

Managing portfolio financials in Portfolio Planning
View the financial breakdown of estimates, approved costs, benefits, and actuals and so on for 
portfolio financials.

As a portfolio user, you can view the rolled up financial values of top-level demands and projects.

You can view the costs by expense type or cost type. Using the Financials view at portfolio level, 
you can view different financial fields such as Budget (approved budget for planning items), 
Forecast, Variance (difference between the approved budget and latest forecast), Actuals, 
and the Remaining Estimates for Capex, Opex, Total, and Benefits for each planning item. This 
information can be used to track the financials status of the planning items and take an informed 
decision on which planning items to consider while working on the next planning cycle and track 
the to avoid overspending.

Using the portfolio financials, portfolio managers can:

• Track the financial performance and status of planning items.

• Arrive at an informed decision by analyzing the estimated cost and benefits of a planning item 
while planning and prioritizing for the next Portfolio cycle.
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• View the financials based on the expense type or cost type depending on the budget attribute 
configuration.

• Avoid overspending on planning items by comparing the approved budget with the latest 
forecast and actuals.

Important: 
New and existing customers need to configure the portfolio financials to view the financials 
of your planning items at portfolio level. For more information, see Configure portfolio 
financials in Portfolio Planning.

The portfolio financials view supports Demands and Projects with Fiscal Calendar type 
configuration only.

Portfolio financials grouped by Budget status with expense type as the budget 
attribute

Portfolio financials grouped by Planning status with cost type as the budget 
attribute
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Note: 
Group header row displays the rolled up values for Budget, Forecast, Variance, Actuals, and 
Remaining estimate of all the planning items in the group.

The default view of portfolio financials is set to display the planning items grouped by their 
budget approval status. Budget approved grouping lists the planning items which have the 
budget allocated and approved. Approval pending grouping lists the planning items which do 
not have any budget or if the requested budget is not approved.

Note: 
Portfolio financials view is not yet compatible with Investment Funding. This view may 
not show the right budget values allocated to planning items from Investment Funding 
application. This will be add as a future enhancement.

In the left-grid, planning item details such as name, rank, planning state, planning item type, 
approved start date, total planned cost, total actual costs, total planned benefits and ROI for the 
full planning item duration.

In the right-grid, financial attributes of the planning items such as, Budget, Forecast, Variance, 
Actuals, and Remaining Estimates for Capex, Opex, Total, and Benefits portfolio for the portfolio 
timeline or breakdowns by year, quarter, month, or period.

Tip: 
You can select the name of a planning item from the left-grid to directly access the 
financials record page of that planning item.

You can export the portfolio financials details to Excel or CSV using the Export  option ( ).

Customize your financials view

Customize the portfolio financials to view and access the required parameters helping you in 
better planning your portfolio and planning items.

• You can get a more detailed and granular view of the financials at monthly, quarterly, and yearly 
view by defining Timescale and Range. Use time scale to select a fiscal period and filter the 
range within the time scale to view the financials for any specific months, quarters, or years.
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Time scale and range parameters

Time scale Description and range

Fiscal Month Portfolio financials view by monthly 
breakdown.

You can select up to 12 months.

Fiscal Quarter Portfolio financials view by quarterly 
breakdown.

You can select up to 4 quarters.

Fiscal Year Portfolio financials view by yearly breakdown.

You can select up to 5 years period.

Plan Timeline Portfolio financial breakdown for the entire 
portfolio timeline.

• Personalize grouping and columns in the grids.

Configure the columns and groupings in the right-grid using Personalize option ( ) to build a 
custom view.

For example, if you want to compare budget and actuals breakdowns, select only these two 
options and apply your preferences. You can also customize the left-grid by selecting the 
required columns from the Left Grid  list from the personalize settings.
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• Group the planning items.

By default, the financials view is grouped by the Budget status column. You can remove Budget 
status grouping from the Grouped by row and drag-drop the required header to change this 
view.

Docs for planning items in Portfolio Planning
Store and manage all kinds of documentation for planning items from a centralized location of 
Portfolio Planning  Workspace.

Docs overview

Product and portfolio managers can store information for planning items using the Docs feature.

• Each planning item can have a separate doc page to capture the information related to it.

For example, for an Epic planning item, you create a doc page for high level business 
objectives or technical product requirements.

• Each planning item can have multiple doc pages associated to it to help you effectively 
organize key artifacts.

• Predefined templates such as Project Brief, Product Requirements, Brainstorming Ideas, and 
Meeting notes are available. Create doc pages for your planning items using one of these 
templates or start with a blank page.

Features of Docs

The following are the key features of Docs:

• Auto-save content.

• See who is viewing or working on a doc page using the feature of live user presence.

• Create documents using pre-defined templates.

• Use rich text paragraph formatting, which includes headings, lists, alignment, and others.

• Move text blocks to change their placement using block-level editing.

• Tag team members inline or insert tables using the /  command.

• Add reference to other ServiceNow AI Platform  tables to connect work across teams.

• Insert images by uploading files or using web URLs.

Note: 
The experience of inserting Google  Images links might not work.

Real-time collaboration within planning item Docs

With the feature of real-time collaboration, edit a doc page concurrently with multiple other 
editors. Colored cursors denote the current location of each editor on the page. You can choose 
to show or hide these live presence indicators based on your preference while working on or 
reviewing the content of the page.
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Note: 
Huge number of users editing the same block of content simultaneously might result in 
issues with application performance.

Dynamic data linking in Docs

Keep record information in your documentation always current and reduce manual effort with the 
Dynamic data linking feature in Docs. You can now reference any ServiceNow  application record 
and Docs will automatically reflect the latest updates from those records.

For example, if you add a reference to a Project record, the reference shows the latest field 
information of the project in Docs without requiring manual edits. Selecting the project reference 
opens up the project form so that you can view the full details of the project and make any 
necessary changes.

A hover popover displays the details of the mentioned record, providing quick access to 
additional information without leaving the current context.
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Dynamic linking also enables adding references to a particular field of a record, such as 
Assigned to of a Project record.

You can add references from any ServiceNow  table you have access to, with no setup or 
configuration needed.

This feature reduces the need to switch between multiple ServiceNow  applications within your 
instance and helps maintain a single, reliable source of truth for collaborative work, making it 
easier for teams to stay aligned and informed.

Create and manage pages and subpages for planning items

Flexibly organize information for your planning items by creating, duplicating, and deleting pages 
and subpages in Strategic Planning.

Before you begin
Role required: sn_align_core.apw_user
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select a portfolio plan.

3. From the Prioritization or Roadmap page, select a planning item that you would like to create a 
doc page for.
If you have selected a planning item from the Roadmap page, select Full details  from the 
Details  tab of the item's side panel.

4. From the planning item's record page, select Docs.

5. To create a page, you can create a blank page or start with a predefined template.

◦ For a blank page, select Create page.

◦ To create from templates:

a. Select Create Page from template.

b. Select a template from the Template Center and select Create page.

The new page is created and added to your Doc with the name Untitled, which you can 
rename.

6. To create a subpage, select the Page Actions  menu ( ) and select Create subpage.
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7. To delete a page or a subpage, select the Page Actions  menu ( ) and select Delete.

Managing portfolio plan views in Portfolio Planning
Portfolio managers can create customized views for their portfolio plans by applying 
personalization settings such as column selection, grouping, and filtering. Portfolio owners or 
editors can share these personalized views with stakeholders to enable easier collaboration on 
the portfolio plans.

Benefits of portfolio plan views

Portfolio managers can create personalized views as needed by applying settings such as 
column selection, grouping, and filtering.

• Views can be created as private or public.

• Can create up to three private views and up to 10 shared (public) views.

• Portfolio plan views can be shared with stakeholders to enable collaboration on the portfolio 
plan.

• Switch between shared and private views as needed.

• Each view saves your display preferences across the Prioritization, Roadmap, Capacity, and 
Financials tabs.

Create a portfolio plan view

Create a customized portfolio plan view based on your requirements, so you can access it when 
you log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
You can create up to three private views and up to 10 shared (public) views per portfolio plan.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. Make any changes to the view as needed.
For example, apply filter with the Department  attribute and the value as Finance.

The Save as new view  option appears on the portfolio plan header.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

153



4. From the portfolio plan header, select Save as new view.

5. On the Save as new view window, fill the details.

a. Enter a name for the view in the View name  field.

b. Optional:  Select the Shared view  toggle to make this view public.
Selecting the Shared view  toggle makes the view visible to all stakeholders with whom this 
portfolio plan is shared.

c. Select Save.

Result
The shared view for the portfolio plan is created and will be visible to all stakeholders with whom 
this portfolio plan is shared.

What to do next

• Share the portfolio plan with your stakeholders to start collaborating on the portfolio plan. See 
Share a portfolio plan with stakeholders.

• Edit a portfolio plan view to make any changes to the existing view. See Edit a portfolio plan 
view.

Edit a portfolio plan view

Edit a customized portfolio plan view based on your requirements, so you can access it when you 
log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task

• Only the owner of a portfolio plan view can edit a shared (public) view.

• You can have up to three private views and up to ten shared (public) views per portfolio plan.
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header, select the view you want to edit or override with your 
personalization settings from the list of available portfolio plan views.
The selected view appears.

4. Make changes to the view as needed.
For example, apply filter with the Department  attribute and the value as Finance.

After you make any change to the view, the Save view option appears in the portfolio plan 
header.

5. Select Save view.
The view is updated to reflect the changes made.

6. Optional:  To edit name of the view, select the Portfolio plan view drop-down from the portfolio 

plan header and then select Edit view icon ( ) next to the view you want to edit the name for.
On the Edit view window, fill the details.

a. Update the name for the view in the View name  field as required.

Note: 
Only the owner of the portfolio plan view can rename the view.

b. Optional:  Select the Shared view  toggle to make this view public or disable the Shared 
view  toggle to make the view private.

Important: 
Changing a shared view to a private view removes access for existing stakeholders.

c. Select Save.

(Optional) The name of the view is updated.

What to do next
Share the portfolio plan with your stakeholders to start collaborating on the portfolio plan. See 
Share a portfolio plan with stakeholders.
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Related topics

Create a portfolio plan view

Delete a portfolio plan view

Delete a portfolio plan view

Delete a customized portfolio plan view if it is no longer needed or if the maximum limit of ten 
shared or three private views has been reached.

Before you begin
Role required: sn_align_core.ap_read_only

About this task

• Only the owner of the portfolio plan view or an editor of the portfolio plan can delete the view.

• Deleting a portfolio plan deletes the view, including any changes made to the view. However, 
this action keeps the items (projects, demands, epics) intact in the portfolio plan.

• You can have up to three private views and up to ten shared (public) views per portfolio plan.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. Select the Portfolio plan view drop-down from the portfolio plan header and then select Delete 

view icon ( ) next to the view you want to delete.
The Delete this view window appears.

4. On the Delete this view window, select Delete.

Related topics

Create a portfolio plan view

Edit a portfolio plan view
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Using dashboards in Portfolio Planning
Using the Platform Analytics  dashboards in Portfolio Planning Workspace, you can monitor 
performance, track progress, and make informed decisions related to planning and execution.

Roles required for managing dashboards

Required roles to access out-of-the-box dashboards

Access level Required roles

Read, duplicate, or share 
the Execution Dashboard

sn_align_core.ap_read_only

Note: 
To view data in financial-related and capacity-planning-
related widgets, users must have the appropriate roles.

Edit the Execution 
Dashboard

admin

Required roles to create or edit dashboards (excluding out-of-the-box dashboards)

Access level Required roles

Create 
dashboards

sn_align_core.apw_user

Edit 
dashboards

sn_align_core.apw_user

Note: 
You can edit dashboards that you own or those you’ve been granted 
permission to edit.

Note: 
You can create widgets in dashboards by configuring any available data source table in the 
ServiceNow AI Platform. However, you must have read access to the source tables to view 
key data, metrics, or visualizations.

For example, if you create a widget in a dashboard configuring the Cost Plan Breakdown 
table to display budget data, the budget summary is visible on the dashboard only if 
you have read access to the Cost Plan Breakdown table. Similarly, when you share this 
dashboard with a stakeholder, the stakeholder must also have read access to the Cost Plan 
Breakdown table to view the budget summary.

For more information on the required roles to manage Platform Analytics  dashboards, see 
Platform Analytics dashboard roles .

Execution Dashboard in Portfolio Planning Workspace

The Execution Dashboard helps portfolio and product managers gain real-time visibility into 
delivery progress across work items, enabling portfolio leads to detect delays, course-correct 
early, and keep the strategy on track.

The Execution Dashboard provides various analytics across different tabs, including Overview, 
Financial, Milestones & Dependency, Capacity, RIDAC, Data Quality, and Geo.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

157

https://www.servicenow.com/docs/access?context=pa-dashboard-roles&version=zurich&pubname=zurich-now-intelligence&ft:locale=en-US
https://www.servicenow.com/docs/access?context=pa-dashboard-roles&version=zurich&pubname=zurich-now-intelligence&ft:locale=en-US
https://www.servicenow.com/docs/access?context=pa-dashboard-roles&version=zurich&pubname=zurich-now-intelligence&ft:locale=en-US


Overview tab in the Execution Dashboard

Widget/Visualization Description

Delayed Planning Items Planning items that were prioritized but 
haven’t started yet (no recorded actual start 
date), despite having an approved start date in 
the past.

Overdue Items Prioritized planning items that remain 
incomplete (no recorded actual end date), 
despite having an approved end date in the 
past.

Dependencies whose provider planning item 
is in Red status

Dependencies that have a provider planning 
item in red status, affecting all dependent 
planning items.

Planning Items

New and In-Review Items Visualization of new and in-review planning 
items grouped by Priority. You can also group 
the items using other available options.

Prioritized Items Visualization of prioritized planning items 
grouped by Status. You can also group the 
items using other available options.

Completed Items Visualization of planning items whose state 
is Done. You can also group the items using 
other available options.

Execution Items

Projects Visualization of projects count grouped by 
State. You can also group the items using 
other available options.
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Widget/Visualization Description

Demands Visualization of demands count grouped by 
State. You can also group the items using 
other available options.

Financial tab in the Execution Dashboard

Widget/Visualization Description

Select a fiscal period to view relevant data Option to select date range as This year 
or Last year  to filter and display the data 
accordingly. Clearing the date range displays 
the data considering from the start date of the 
portfolio plan.

Planned Costs Estimated cost for executing the plan.

Budget Estimated budget for executing the plan.

Actual Costs Actual cost incurred during plan execution.

Planned vs Budget vs Actual by Cost Type Visualization of Planned vs Budget vs Actuals 
by Cost Type.

Planned vs Budget vs Actual Visualization of cost by Planned vs Budget vs 
Actual.

Budget by Investment Type Visualization of budget by Investment type.

Benefits

Planned Monetary Benefits Monetary benefits that have been planned.

Actual Monetary Benefits. Monetary benefits that have been achieved.

Pending Monetary Benefits. Monetary benefits that are in pending state.

Benefits by Category Benefits by category such as Revenue, Cost 
savings, and Customer satisfaction score.
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Widget/Visualization Description

Monetary Benefits Visualization of monetary benefits with respect 
to planned and actual benefits.

Milestones & Dependency tab in the Execution Dashboard

Widget/Visualization Description

Dependencies whose provider planning item 
is in Red status

Count of dependencies that have a provider 
planning item in red status, affecting all 
dependent planning items.

Missed Key Milestones in Last 30 Days Count of planning items whose key milestones 
were missed within the last 30 days.

Upcoming Milestones Likely to Be Missed List of planning items whose key milestones 
about to be missed soon with details including 
Name, Type, Due date, Assigned to, Source 
item.

Missed Milestones in Last 30 Days List of planning items whose key milestones 
were missed within the last 30 days with 
details including details, Name, Type, Due 
date, Assigned to, and Source item.

Achieved Milestones in Last 30 Days List of planning items whose key milestones 
were achieved within the last 30 days with 
details including details, Name, Type, Due 
date, Assigned to, and Source item.

Milestones Analyzer Visualization of key milestones grouped by 
state and stacked by Type. You can also group 
and stack the items using other available 
options.
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Capacity tab in the Execution Dashboard

Widget/Visualization Description

Resource Assignments Status Visualization of resource assignments status.

Resource Assignments Ready for Review Visualization of resource assignments count 
that is ready for review.

Upcoming Items with Resource Assignments 
That Are Unassigned, Unapproved, or Pending

List of upcoming planning items whose 
resource assignments status is Unassigned, 
Unapproved, or Pending.

Resource Assignments by Group, Role & Skill Visualization of resource assignments count 
by their group, role, and skill.

RIDAC tab in the Execution Dashboard
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Data Quality tab in the Execution Dashboard

Widget/Visualization Description

Alignment

Not Aligned to Goal Count of work items that aren’t associated with 
any goal.

Financials

No Planned Cost Count of work items for which cost estimation 
is done yet for execution.

No Planned Benefit Count of work items for which benefit 
estimation is done yet.

No ROI Count of work items for which ROI isn’t 
estimated yet.

Projects and Demands Without an Investment 
Type

Count of projects and demands for which 
Investment type isn’t defined yet.

Monetary Benefit Plans Without a Planned 
Benefit

Count of monetary benefit plans for which 
benefit isn’t defined yet.

Monetary Benefit Plans Without a Sponsor Count of monetary benefit plans for which a 
sponsor hasn’t been assigned yet.

Planning Items with Other Attributes

No Resource Assignments Count of planning items without resource 
assignments.

Unscheduled Items Count of planning items not scheduled yet.

No Portfolio Count of planning items with no portfolio 
defined.

No Program Count of planning items with no program 
defined.
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Widget/Visualization Description

No Department Count of planning items with no department 
populated.

No Business Unit Count of planning items with no business unit 
populated.

No Owner Count of planning items with no owner 
assigned.

Geo tab in the Execution Dashboard

Widget/Visualization Description

Planned cost by location Estimated cost by location for executing the 
plan.

View a dashboard in Portfolio Planning Workspace

View key data and metrics on a dashboard to monitor performance, track progress, and make 
informed decisions related to planning and execution.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
Dashboards consolidate data from multiple sources into a single, easily digestible format. Each 
widget within a dashboard displays key data and metrics and may include visualizations.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. Optional:  From the Change dashboard drop-down, select the dashboard you want to view.
The selected dashboard appears on the Dashboards page.

3. Optional:  Select a required tab that you want to view the key data and metrics for.
Each widget within a dashboard displays key data and metrics and may include visualizations.

4. Optional:  Select a widget to see more details of the data in list view.
If you have edit access, you can update the details of an individual record directly from the list 
view when necessary.

Related topics

Create a dashboard

Duplicate a dashboard

Share a dashboard

Add a Platform Analytics dashboard

Create a dashboard

In the Platform Analytics  experience, you can create shareable dashboards with data 
visualizations, filters, and other elements. You can use the available elements in the inline editor 
to create different types of widgets as needed.
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Before you begin
Role required: sn_align_core.apw_user

About this task
Dashboards consolidate data from multiple sources into a single, easily digestible format. Each 
widget within a dashboard displays key data and metrics and may include visualizations.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the dashboard header, select the More actions icon ( ) and then select Create new.

3. On the New dashboard window, fill the details.

a. Enter a name for the dashboard in the Name  field.

b. Optional:  Enter a brief description for the dashboard in the Description  field.

c. Select Create new dashboard.

What to do next
Edit a dashboard as needed by adding sections, filters, images, lists, process mining maps, and 
rich text. For more information, see Edit a dashboard.

Related topics

View a dashboard in Portfolio Planning Workspace

Duplicate a dashboard

Share a dashboard

Add a Platform Analytics dashboard

Edit a dashboard

Customize or edit a dashboard as needed by adding sections, filters, images, lists, process 
mining maps, and rich text. If the dashboard has been shared, any changes you make are 
applied globally.

Before you begin
Role required: sn_align_core.apw_user

About this task

Note: 

• You can edit dashboards that you own or those you’ve been granted permission to edit.

• Only an administrator can edit the out-of-the-box dashboard that is Execution Dashboard. 
However, you can duplicate an out-of-the-box dashboard  and customize it as needed.

You can use the following elements to create or edit your dashboard.

Dashboard elements in Strategic Planning

Element Description

Data visualization Enables you to present a visual representation 
of current instance data or temporary data that 
you’ve imported. Data visualizations include 
visualizations that you create in the dashboard 
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Dashboard elements in Strategic Planning  (continued)

Element Description

designer and data visualizations from the 
library.

Filter Enables you to filter the visualizations on a 
dashboard based on specified criteria. You 
can put filters either on the individual tabs 
or above the tabs so that the filter applies to 
elements every tab. Filters include both data 
filters and domain filters. You can create filters 
in the dashboard designer or select them from 
the library.

Heading Provides a place for text at the top of a 
dashboard or section of a dashboard. 
Formatting for headings is limited to six 
heading levels.

Image Holds static or animated images on the 
dashboard.

List - Simple Shows table data that you can customize for 
the dashboard audience.

Process Mining - Map Maps the different states that are part of your 
process and the transitions between those 
states. See which states the objects of the 
process are in and the speed with which they 
change state. Requires an existing Process 
Mining project.

Rich text Holds text that you can format either as text 
or as html, including font selection, text size, 
highlighting, and hyperlinks. To edit HTML 
markup, open the HTML editor from the 
Configuration panel and select the Code tags 
< > icon.
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the Change dashboard drop-down, select the dashboard you want to edit.
The selected dashboard appears.

3. From the dashboard header, select Edit.

4. Drag to move the widget or resize it as required.

5. From the dashboard header, select Save.

6. From the dashboard header, select Exit editing mode.

Result
The dashboard is updated with the latest changes.

What to do next

• Add more elements and customize your dashboard as required.

• For detailed instructions on editing a dashboard using the Platform Analytics  experience in 
Portfolio Planning, see Edit Platform Analytics dashboards .

Related topics

View a dashboard in Portfolio Planning Workspace

Create a dashboard
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Duplicate a dashboard

Share a dashboard

Add a Platform Analytics dashboard

Duplicate a dashboard

If the dashboard you want to create is similar to an existing one, duplicating the existing 
dashboard saves your time. After duplicating the dashboard, you can customize the tabs and 
widgets as required.

Before you begin

• Users or groups that you want to share the dashboard with must have the 
sn_align_core.ap_read_only or sn_align_core.apw_user role to get the read or edit access to 
the portfolio plan respectively.

• When you duplicate a dashboard, you copy all settings and details of the original. Content that 
exists locally on the original dashboard is duplicated onto the new dashboard. If the original 
dashboard contains references to content in a library, such as a shared visualization, the 
references are duplicated. The role requirements for editing an element in a library apply to the 
latter.

Role required: sn_align_core.ap_read_only

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the Change dashboard drop-down, select the dashboard that you want to duplicate.

3. From the dashboard header, select the More actions icon ( ) and then select Duplicate.

4. On the Duplicating dashboard window, fill the details.

a. Enter a name for the portfolio plan in the New name  field.
By default, the name is ABC (Copy)  where ABC is the name of the dashboard you 
duplicated from.

b. Optional:  Enter a brief description of the goal in the Description  field.

c. Select Duplicate.

Duplicating the dashboard can be time-consuming. Select Continue in background  to keep 
using the application in the meantime.

Result
The dashboard is copied with the new name. The appearance of the dashboard is identical to 
the original.

What to do next
Edit a dashboard as needed by adding sections, filters, images, lists, process mining maps, and 
rich text. For more information, see Edit a dashboard.

Related topics

View a dashboard in Portfolio Planning Workspace

Create a dashboard
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Share a dashboard

Add a Platform Analytics dashboard

Share a dashboard

Share a dashboard with stakeholders, planning managers, portfolio managers, or product 
managers to provide visibility into work progress and foster collaboration. You can grant either 
view-only rights or both view and edit rights to a shared dashboard.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
Users or groups you want to share the dashboard with must have the appropriate roles assigned 
to access shared dashboards:

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the Change dashboard drop-down, select the dashboard you want to share.
The selected dashboard appears.

3. From the dashboard header, select the More actions icon ( ) and then select Share.

4. On the Share Dashboard window, fill the details.

a. Enter a user name or group name in the Grant access to  field to provide access to individual 
users or user groups, respectively.
You can also select a role to grant dashboard access to all users assigned to that role.

b. Optional:  Select Allow recipients to add, edit, or delete sharing permissions associated 
with this dashboard  to enable users to grant access to new users and modify or remove 
existing permissions.

c. Select Add as viewer  or Add as editor  as required.

Note: 
You can select Add as editor  only if you have the sn_align_core.apw_user role 
assigned to you.

The selected users, groups, and roles appear under Manage Access.
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You can also manage to share permissions by selecting a user, group, or role and enabling 
the Can share  option.

d. Select Confirm.

Result
The roles, groups, and users you have shared the dashboard with appears again when you 
reopen the dialog, along with the rights you have given them.

What to do next
You can change the rights of whom you have shared the dashboard with in the Share Dashboard 
dialog, under the Can view/Can share list for each user, group, or role.

Related topics

View a dashboard in Portfolio Planning Workspace

Create a dashboard

Duplicate a dashboard

Add a Platform Analytics dashboard

Add a Platform Analytics  dashboard

If you have existing dashboards created using Platform Analytics, you can add them to the 
Portfolio Planning Workspace  to access them directly from a single location.

Before you begin
Role required: sn_align_core.apw_user
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About this task
You can add any Platform Analytics  dashboard to the Portfolio Planning Workspace.

Procedure

1. Navigate to All  > Platform Analytics  > Analytics Center.
The Dashboards section appears on the page.

2. From the Bookmarked  or Certified  tabs, select a bookmarked or certified dashboard .
If the dashboard that you want to add isn’t bookmarked or certified, select View all  from the 
Dashboards section, and then select the dashboard from the Dashboards page.

3. From the dashboard header, select Edit.

4. From the dashboard header, select the View dashboard details icon ( ).

a. In the Details side panel, fill in the Dashboard visibility  field with Portfolio Planning 
Workspace.

5. From the dashboard header, select Save.

6. From the dashboard header, select Exit editing mode.

Result
The dashboard appears on the Portfolio Planning Workspace.

Related topics

View a dashboard in Portfolio Planning Workspace

Create a dashboard

Duplicate a dashboard

Share a dashboard

Export the portfolio plan status or roadmap to Microsoft 
PowerPoint
Export the status of work items, roadmap, and key metrics of your portfolio plan and free-form 
roadmap into a Microsoft PowerPoint  file so that you can keep your business stakeholders 
updated on the progress. Save time by avoiding copying data into reports and drive shared 
outcomes by enabling collaboration even with stakeholders who cannot access your ServiceNow 
instance.

Before you begin
Install Export to PowerPoint for Strategic Portfolio Management.

Important: 
Export to PowerPoint  is currently unavailable for customers in the FedRAMP, NSC DOD 
IL5, or Australia IRAP-Protected data centers, self-hosted customers, or in other restricted 
environments. Please check for availability updates in future releases.

Role required: admin

About this task
The following two PowerPoint templates are provided by default to generate a status report for 
your portfolio plan:
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• Portfolio plan status: Contains individual detailed slides for the top five items prioritized by 
rank.

• Roadmap Template - default: Contains slides for Roadmap for this portfolio. You can export 
roadmap data for a maximum period of a year at a time.

You can customize the type of the data to be shown in the generated report by updating 
a predefined template or by creating your own branded template. See Create a Microsoft 
PowerPoint template.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Portfolio Planning.

2. Export the status of goals, work items, roadmap, and key metrics of your portfolio plan and 
free-form roadmap into a Microsoft PowerPoint  file.

Result
A PowerPoint file is generated with the relevant data.

This image is an example for an exported 

roadmap.

Executing Portfolio Planning  work in PPM
Facilitate execution of the work planned in Portfolio Planning  in ServiceNow  Project Portfolio 
Management  application.

Import, export, and manage your planning items between Portfolio Planning  and PPM.

Integrating Portfolio Planning  and PPM
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Key benefits of Portfolio Planning  with PPM

• View available PPM planning items in Portfolio Planning.

• Import planning items from PPM to Portfolio Planning.

• Export planning items from Portfolio Planning  to PPM.

• Synchronize updates for linked planning items of Portfolio Planning  with PPM.

• Track the progress of the linked planning items in Portfolio Planning.

To get started on integrating Portfolio Planning  with PPM, see Configuring Portfolio Planning with 
PPM.

Frequently asked questions about execution integration

Can I use PPM Standard  for project execution without Agile 2.0 or SAFe?

Yes. If your teams follow waterfall or traditional Project Management  methodology, 
use PPM Standard  (Project Portfolio Management) as your execution system. 
Planning items created in Portfolio Planning  can be exported to PPM  as projects. 
Changes in PPM  (project status, costs, resources) sync back to Portfolio Planning 
automatically.

Use case: Infrastructure team plans in Portfolio Planning, executes data-center 
migration project in PPM Standard  with Gantt charts, task dependencies, and 
resource management.

When do I use PPM  for execution?

Base your decision on team methodology and org scale: PPM Standard: For 
waterfall projects, traditional PM teams, infrastructure work, conformance-driven 
initiatives.

Should I install PPM Standard  to use Portfolio Planning?

No. Install PPM Standard  if your teams actually uses it. Portfolio Planning  works 
standalone for planning and prioritization. Add the PPM  plug-in when teams are 
ready to execute work in this system.

What data syncs between Portfolio Planning  and PPM?

Bi-directional sync includes:

• From Portfolio Planning  → execution: Planning item name, description, owner, 
goals, budget, priority, timeline.

• From execution → Portfolio Planning: Status, progress %, actual costs, resource 
assignments, risks/issues.

• Real-time updates: Changes in either system appear in both within seconds.

Common execution scenarios
Scenario: PPM  only organization (waterfall projects)

1. Portfolio managers create planning items in Portfolio Planning.

2. After prioritization, export planning items to PPM Standard  as projects.

3. Project managers build WBS, create tasks, assign resources, manage timeline in PPM.

4. Portfolio Planning  shows project status, costs, risks automatically
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Troubleshoot execution integration

• Issue: Planning item not appearing in PPM

◦ Verify the execution system plugin is installed and activated.

◦ Check that planning item state is Prioritized (items in the Backlog state don't export).

◦ Confirm user has required role in execution system (project_manager, scrum_admin, 
safe_admin).

• Issue: Changes in PPM  not syncing back to Portfolio Planning

◦ Verify bi-directional sync is enabled in integration configuration.

◦ Check that the planning item and PPM  project/epic are properly linked (primary planning 
item field is populated).

◦ Review transformation maps for any table, field, or choice mapping issues.

Import records to Portfolio Planning Workspace

Import records from Project Portfolio Management, after the relevant table maps, fields maps, 
and choice maps are configured.

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Portfolio Planning  > Integrations.

2. Select ServiceNow Internal  Alignment Integration record.

3. Click Import.

4. On the Create Import Request form, fill in the date range for importing the records.

Create Import Request

5. Select OK.

Note: 
Records that have been created within the specified dates will be imported.
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View error logs

View error logs to understand the cause of any issues that might have occurred during the 
integration process.

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Portfolio Planning  > Integrations.

2. To view the error logs, select the Integrations Errors  tab.

Portfolio Planning  reference
Reference information to provide additional details about Portfolio Planning  such as user roles, 
tables, and domain separation information.

Components installed with Portfolio Planning

Several types of components are installed with activation of the Portfolio Planning  application, 
including tables and user roles.

Roles installed

Role title [name] Description Contains roles

Portfolio Planning  admin

[sn_align_core.apw_admin]

Can access all the 
modules in the Portfolio 
Planning  application

• it_portfolio_manager

• sn_align_core.apw_user

• view_changer

Portfolio Planning  user

[sn_align_core.apw_user]
Can create, update, and 
delete portfolio plans, 
free-form roadmaps, 
and planning items.

This role can be given 
to users such as 
portfolio or product 
managers, business 
unit leads, and other 
planning personas.

• sn_align_cmn_int.user

• sn_milestones.milestone_editor

sn_align_core.ap_read_only • Can view portfolio 
plans and free-form 
roadmaps that are 
shared with them.

• Can add notes, 
comments, or 
attachments to 
portfolio plans and 
roadmaps that are 
shared with them.

sn_milestones.milestone_viewer
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Role title [name] Description Contains roles

• Can create, edit, and 
delete portfolio plan 
views and free-form 
roadmap views.

Note: 
Only the 
owner can edit 
or delete a 
portfolio plan 
view or a free-
form roadmap 
view.

Milestones editor

[sn_milestones.milestone_editor]

Can create, update, and 
delete milestones on 
the roadmap.

sn_milestones.milestone_viewer

Milestones viewer

[sn_milestones.milestone_viewer]

Can view milestones on 
the roadmap.

None

Business stakeholder

[business_stakeholder]

• Can create and 
update portfolio 
plans and free-form 
roadmaps.

• Can add notes, 
comments, or 
attachments to 
portfolio plans and 
roadmaps that are 
shared with them.

• Can personalize the 
roadmaps.

• Can view generated 
resource capacity for 
planning items in the 
Capacity Planning 
screen.

• Can view goals and 
related records using 
the platform view.

Note: 
Users with this 
role do not 
have access to 
create or edit any 
roadmap items.

• sn_align_core.ap_read_only

• sn_align_ws.spw_capacity_read

• sn_gf.goal_user_read
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Scenario Planning roles

Role title [name] Description Contains roles

sn_align_ws.scenario_approver Can approve the scenarios for 
the portfolio.

sn_align_core.apw_user

Portfolio Planning  with PPM roles

Role title [name] Description Contains roles

Portfolio Planning  integrations 
user

[sn_align_cmn_int.user]

Imports, exports, and 
manages planning items 
between Portfolio Planning 
and PPM.

connection_admin

Capacity roles

Role title [name] Description Contains role

sn_align_ws.spw_capacity_user Can generate resource 
capacity details.

sn_align_ws.spw_capacity_read

sn_align_ws.spw_capacity_readCan view resource capacity 
details.

None

Financial planning roles

Role title [name] Description Contains roles

sn_align_ws.spw_financial_userCreate cost plans and 
expense lines for planning 
items.

None

Tables installed

Table Description

Alignment Integration

[sn_align_cmn_int_integrations_setup]

Stores data of integration information for your 
ServiceNow  instance

Choice Map

sn_align_cmn_int_choice_map

Stores choice map relationships between fields of 
planning items of Portfolio Planning  and PPM

Demand

[sn_align_core_demand]

Stores records created with Demand planning item 
type.

Dependency
Stores data of dependencies between roadmap 
items.
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Table Description

[sn_align_core_dependency]

Field Map

[sn_align_cmn_int_field_map]

Stores field map relationships between planning 
items of Portfolio Planning  and PPM

Import Request

[sn_align_cmn_int_import_request]

Stores imports requests from Portfolio Planning  to 
PPM

Instance Mapping

[sn_align_cmn_int_instance_mapping]

Stores mapping information between instances

Integration Error

[sn_align_cmn_int_integration_error]

Stores errors for integration between Portfolio 
Planning  and PPM

Integration Mapping

[sn_align_cmn_int_integration_mapping]

Stores Integration mappings between Portfolio 
Planning  and PPM

Lens

[sn_align_core_lens]

Stores data of the lens configuration.

Lens structure

[sn_align_core_lens_structure]

Stores data of lens entities and the relationship 
between them for different lenses.

Planning Item

[sn_align_core_planning_item]

Stores the data of all planning item types.

Portfolio plan

[sn_align_ws_portfolio_plan]

Stores data of portfolio plans.

Project

[sn_align_core_project]

Stores records created with Project planning item 
type.

Roadmap configuration

[sn_align_ws_roadmap_configuration]

Stores the configuration data for tables that are 
used to create portfolio roadmaps and free-form 
roadmaps.

Table Map
Stores table mapping relationships between 
planning items in Portfolio Planning  and PPM
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Table Description

sn_align_cmn_int_table_map

System properties installed

Portfolio Planning with PPM system properties

Name Description

com.sn_align_cmn_int.bulk_import • Type: Choice list

• Default value: INSERT

• Other possible values:

◦ INSERT

◦ <Value 2 name>:

• Location: System Property [sys_properties] table

• Learn more: Configure bulk import

Domain separation and Portfolio Planning

Domain separation is supported for Portfolio Planning. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Overview of domain separation in Portfolio Planning

You can create lens, portfolio plans, planning items, and roadmaps in different domains.

How domain separation works in Portfolio Planning

After you enable domain separation on your ServiceNow  instance, the data of Portfolio Planning 
is automatically domain separated. So, the data of lens, portfolio plans, planning items, and 
roadmap configuration for different domains is visible to only those users who have access to 
these domains.
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Domain separated tables in Portfolio Planning

All the tables installed with Portfolio Planning  support domain separation. For a complete list of 
tables, see Components installed with Portfolio Planning.

Related topics

Domain separation for service providers

Planning item reorder errors in Portfolio Planning

Review the scenarios when the reordering of items can fail in the List view of Prioritization in 
Portfolio Planning  Workspace.

To update the rank of the planning items in the work pipeline of your portfolio plan, you can 
reorder the items from the List view of the Prioritization page. While doing so, the reorder can 
fail due to an error in the ranking configuration. Following are the scenarios where reordering of 
planning items can fail:

Scenario 1: Global ranking plugin is not active

Check if the Global Ranking Application plugin (com.snc.sdlc.ranking) is active in 
your ServiceNow  instance. If not, contact your admin to activate it.

Scenario 2: Planning item doesn't have a rank configuration

Check if all the planning items that you are reordering have a rank configuration. If 
not, contact your admin to update rank configuration for these planning item types.

Scenario 3: Target row doesn't have a global rank

Check if the planning item before or after your target position to reorder has a global 
rank. If not, contact your system admin to generate a global rank for them.

Related topics

Rank planning items

Item milestone errors in Portfolio Planning  Workspace

Learn about the scenarios when the planning item milestones on the portfolio plan roadmap or 
free-form roadmap can be in an error state in the Portfolio Planning  Workspace.

An item milestone can fall out of the approved start or end dates of the item when you 
reschedule the existing planning item.

When you reschedule a planning item on the roadmap, the due dates of its milestones 
don’t change. So, if the due date of a milestone is falls outside the item’s date 
range, the indicator for that out-of-range milestone is hidden and moved to an 
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error state. Indicators for milestones that are still within the item's date range are 

visible.

The milestones that are out of sync with the item's schedule can be viewed from the 
Milestones tab on the side panel. From the side panel, you can edit and adjust the 
due date of the milestone to reflect the change of plans. See Update roadmap item 

milestones.

Note: 
You can’t update a project milestone from the roadmap view. Updating project milestones 
may impact the associated cost and resource plans of the project. So, it’s recommended to 
update project milestones using Project Workspace in Project Portfolio Management  (PPM).

Item dependency errors in Portfolio Planning  Workspace

Learn about the scenarios when the planning item dependencies on the portfolio plan roadmap 
or free-form roadmap in Portfolio Planning  Workspace can be in an error state.

A dependency between two planning items can be in an error state when a scheduling conflict 
exists between the items. In a linear (Depends on) dependency, the items are scheduled in a way 
that starting the work on one item requires completing the work on another item.

Note: 
Error states are displayed for only if the planning items have a Depends on  type of 
relationship.
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In the sample roadmap shown here, starting work on Employee onboarding process 
improvement  is dependent on the completion of Specific onboarding path for new hire. This 
relation is considered a linear dependency. Here, Employee onboarding process improvement 
is scheduled to start before the end date of Specific onboarding path for new hire. This conflict 

is indicated on the roadmap with an error icon ( ), and is also mentioned in the Dependencies 
tab of the Item details side panel.

To resolve such errors, review the scope of the planning items and update the start or end dates 
to adjust their scheduling accordingly.

Related topics

Add dependencies for roadmap items

Update roadmap item dependencies

Managing Portfolio Planning  with PPM

Ensure that Portfolio Planning  is integrated properly with Project Portfolio Management (PPM) 
following these guidelines.

• Do not change the filter condition of a table map after the records are interfaced. The already 
interfaced records might not match with the new filter condition and any change in the filter 
condition can result in data inconsistency. If you need to change the filter condition, ensure 
that the relevant attributes on the interfaced records are updated manually to avoid data 
inconsistency issues.

• Whenever a table map is created, ensure that the relevant field maps and choice maps are 
also configured.

• When an import job for a table map is running (processing), do not modify the table map or its 
field maps.

• Using the Converted to  field on the planning item form, you can identify the original record 
from which it was converted.

• Ensure that the Lookup field  and Lookup column  values are added whenever the execution 
and alignment tables are referencing two different tables, while creating a field map for field 
type of reference or glide list.

• If there is a data synchronization failure, check if:

◦ The Integration error logs  related list within that Alignment integration record.

◦ The Alignment table filter  (for import) and Execution table filter  (for export) conditions are 
met.

◦ The Active  flag in both the alignment integration and the table map is checked.

◦ The appropriate fields and choices are configured for each table map.
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• If you want to view the Execution URL  field, configure the planning item record to view it.

• If the Execution URL field in your synced planning item(s) is blank, navigate to Portfolio 
Planning  > Integrations  and click Fix execution URL(s) for planning items. This action creates 
and updates the execution URL field.

• A Primary goal  field is introduced to the projects, demands, and epics table maps to support 
the integration of the Goal  field between alignment and execution tables.

• When you are trying to import or export a project, ensure that the demands (that are a part of 
that project) are synced.

• You can create a table map for any execution table. If a table map is not created from one 
of the delivered tables (dmn_demand, pm_project) or does not extend from them, you are 
required to create a business rule to support the interfacing of the table map records. For more 
information on creating a business rule, see Create a business rule to apply a custom table 
map configuration.

Form field information for Portfolio Planning

Field information for forms used in the Portfolio Planning  application.

Action Assignment form

Learn about the fields of the Action Assignment form. Use this form to add the New  action button 
to the APW List Menu Configuration page.

Goal form

Field Description

Action Label Name of the action label. Enter New.

Action name Name of the action. Enter create-new-uxf.

Implemented as Implementation for the action. Select UXF Client Action.

Table Name of the table the action is created for. Select 
sys_ux_list_menu_config.

Specify client 
Action

Client action. Look up and select Create New Record.

View View of the form on which the action button is displayed.

Choice map form

Understand the fields of the choice map form. This form is used to create choice maps.

Choice map form

Field Description

Execution table column Field column of the selected execution table 
that needs to be mapped. The value in this 
field is automatically added based on the 
selection made in the field map configuration.

Execution choice Select the choice field value of the selected 
execution table column field.

Alignment table column Field column of the selected alignment table 
that needs to be mapped. The value in this 
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Choice map form  (continued)

Field Description

field is automatically added based on the 
selection made in the field map configuration.

Alignment choice Select the choice field value of the selected 
alignment table column field.

Create cost plan form

Use this form to create cost plans for your planning items.

Create cost plan form

Field Description

Name Name of the cost plan.

Entered currency Currency to capture the unit cost value.

Unit cost Planned cost for the cost plan.

Quantity Quantity of cost plans.

Total planned cost Total planned costs value of the cost plan.

Start fiscal period Starting month in a fiscal period for the cost 
plan.

End fiscal period Ending month in a fiscal period for the cost 
plan.

Cost distribution Allocate planned cost by fiscal period or 
duration.

Select a value from the list.

• Split equally across fiscal periods  - 
Distributes the cost equally among all the 
fiscal periods across the duration.

• Recurring per fiscal period  - Recurs the 
cost for each fiscal period across the 
duration.

Cost type Cost type of the cost plan.

Select a cost type form the list.

Note: 
Based on the selected cost type, the 
Role  and Product model  fields appear.

Employee type Read-only field.

• External  if Cost type is External labor Capex 
or External labor Opex.

• Internal  if Cost type is Labor Capex or Labor 
Opex.

Role Name of the role to expense the cost plan.
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Create cost plan form  (continued)

Field Description

Product model Available if the Cost type is Software, 
Hardware, or Other Capex or Opex.

Select a model from the list to expense the 
cost plan.

Model name of a hardware expenditure to 
expense the cost plan.

Create expense line form

Use this form to create expense lines for your actual expense.

Create expense line form

Field Description

Number Auto-generated number for the expense line.

Amount Expense incurred.

Short description Short description of the expense.

Mention unique and specific details to identify 
the expense line.

Date Date of the expense.

Process date Processed date of the expense.

Cost plan Associated cost plan name for recording the 
expense line.

Cost type Cost type of the expense.

by default, the cost type of the cost plan is 
selected.

State State of the expense line.

Only processed expense lines are considered 
for an investment entity.

Expense type Defines the expense type, internal or external.

By default, the expense type is considered 
from the Cost type  field entry.

Rate card Name of the rate card.

Summary type Business purpose of the expense line.

Dependency form

Learn about the fields of the dependency form. Use this form to add and establish dependencies 
between planning items on the roadmap in Portfolio Planning .
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Dependency form

Field Description

Planning item
Planning item that you selected from the 
roadmap, to create the dependency. Consider 
this as the successor item.

This field is automatically filled based on your 
selection.

Relationship type Choose one of the following:

• Depends on: Starting the work on one item 
depends on finishing the work of the other 
item. This dependency is considered a 
linear relationship.

• Relates to: Work of the two items is related 
to each other but doesn’t have a strict 
dependency on each other's completion. 
This dependency is considered a non-linear 
relationship.

Planning item Planning item that is required. Consider this as 
the predecessor item.

Number System-generated unique identification 
number for the dependency.

Field map form

Understand the fields of the field map form. This form is used to create mappings for a 
corresponding table map.

Field map form

Field Description

Execution table Table in Agile Development 2.0, SAFe, or 
PPM that needs to be mapped with a table in 
Strategic Planning. The value in this field is 
automatically added based on the selection 
made in the table map configuration.

Execution table column Field column of the selected execution table 
that needs to be mapped.

Alignment table Table in Strategic Planning  that needs to be 
mapped with a table in Agile Development 
2.0, SAFe, or PPM. The value in this field is 
automatically added based on the selection 
made in the table map configuration.

Alignment table column Field column of the selected alignment table 
that needs to be mapped.
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Field map form  (continued)

Field Description

Flow type Specifies whether the mapping is done 
from alignment to execution, execution to 
alignment, or both.

Here, alignment implies Strategic Planning, 
and execution implies PPM, Agile 
Development 2.0, and SAFe  applications.

Demand planning item form

Learn about the fields of the demand form. Use this form to create or edit the details of a planning 
item of the type Demand in Portfolio Planning.

These fields are displayed on the full details page of the planning item.

Demand planning item form

Field Description

Name Brief description of the planning item.

Description Detailed information of the planning item.

You can refine demand description using the 
Write planning item skill, if the Now Assist for 
SPM  application is installed.

State Current working state of the planning item.

Owner User assigned to this planning item.

Planning state State of the planning item in the Strategic 
Planning  Backlog.

Category Category of this planning item. Choose from 
Strategic  or Operational.

Execution URL Link to the demand's execution record in Next 
Experience for Demand Management.

MoSCoW Priority of this planning item based on its 
importance. The available options are:

• 1 - Must have

• 2 - Should have

• 3 - Could have

• 4 - Won’t have

Portfolio Portfolio that this planning item is associated 
to.

Program Program that this planning item is associated 
to.
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Demand planning item form  (continued)

Field Description

Product Product that this planning item is associated 
to.

Strategic program Strategic program that this planning item is 
associated to.

Primary goal Goal that is associated with this planning item 
as the primary goal.

Product enhancement Product enhancement that this planning item 
is associated to.

Primary target Target that is associated with this planning 
item as the primary target.

Work notes Notes to capture the updates and discussions 
on the planning item as the work progresses.

Strategic priority Strategic priority that this planning item is 
associated to.

Dates section of the Demand planning item form

Field Description

Approved start date Approved start date for this planning item.

Approved end date Approved end date for this planning item.

Planned start date Date on which the work for this planning item 
is planned to start. This value is copied from 
the Approved start date  field.

Planned end date Date on which the work for this planning 
item is planned to be complete. This value is 
copied from the Approved end date  field.

Details section of the Demand planning item form
In this section, capture additional details for this planning item such as 
Investment type, Execution type, impacted business application, and more.

Field Description

Investment class Choose from Run  and Change

Investment type Type of investment this planning item comes 
under. For example, if completing work on this 
item improves the user experience for your 
product, select End User Experience.

Priority Priority of this planning item.

Business application Business application that this planning item is 
related to.
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Details section of the Demand planning item form
In this section, capture additional details for this planning item such as 
Investment type, Execution type, impacted business application, and more.

(continued)

Field Description

Other impacted business applications Business applications that this planning item 
has an impact on.

Business capabilities Business capabilities of this planning item.

Business case section of the Demand planning item form
In this section, capture business details for this planning item such as risks, 
scope, blockers for this planning item.

Field Description

Business case Business case to invest in this planning item.

Risk of performing Risks to the business if work on this planning 
item is completed.

Risk of not performing Risks to the business if work on this planning 
item isn’t completed.

Enablers Enablers for this demand.

Barriers Blockers, if any, for this planning item.

In scope Defined criteria for this planning item.

Out of scope Clearly defined criteria that is not necessary 
for this planning item.

Assumptions Assumptions, if any, to work on this planning 
item.

Financials section of the Demand planning item form
In this section, capture financial details for this planning item such as cost, 
CapEx, OpEx, benefit, ROI, and other estimates.

Field Description

Planned cost Planned cost to take up this planning item.

Planned capEx Planned capital expenditure for this planning 
item.

Planned opEx Planned operational expenditure for this 
planning item.

Planned ROI Planned return of investment for this planning 
item.

Financial return Financial return on this planning item.

Planned benefit Planned benefit from this planning item.
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Assessment data section of the Demand planning item form

Field Description

Impact Impact that this planning item has on the 
business.

Risk Numerical value for the risk associated with 
this planning item.

Value Numerical value for the value obtained with 
this planning item.

Score Score of the planning item.

Highlighted Value Condition form

Learn about the fields of the Highlighted Value Conditions form. Use this form to configure the 
display of highlighted fields in Portfolio Planning  workspace.

Field Description

Condition Condition for the field value.

For example, Status is Green.

Color Color for the field value that meets the 
condition specified.

Application Scope of yourServiceNow  instance. By default, 
this field is set to Portfolio Planning.

Order
Order in which this color appears on 
the legend in the Hierarchy view of the 
Prioritization page.

For example, for the Planning Status column, 
the value New  is given the order 1.

Hide Label Option to hide the label for the highlighted 
value condition. When selected, the Label field 
is not available.

Label Name of the label displayed for the highlighted 
value condition. This field is not available 
when Hide Label  is selected.

Show Icon Option to show icon beside the field value.
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Field Description

Icon Icon that is displayed beside the field value. 
This field is shown only if the Show Icon  field 
is selected.

Variant Option to define color variant. The available 
options are primary, secondary, and tertiary.

Value Override Custom display text that replaces the actual 
field value in the view. When specified, the 
override text appears instead of the stored 
value.

Highlighted Value form

Learn about the fields of the Highlighted Value form. Use this form to customize the fields to be 
highlighted on the Prioritization page of a portfolio plan in Portfolio Planning  workspace.

Field Description

Table Table which contains the highlighted columns. 
Enter sn_align_core_planning_item.

Application Scope of yourServiceNow  instance. By default, 
this field is set to Portfolio Planning.

Field Column of the table that is highlighted in the 
workspace.

Lens Form

Learn about the fields of the Lens form. Use this form to create a lens in Portfolio Planning.

Lens form

Field Description

Name Name of the lens.

Active Indicates if the lens is active.

Description Brief description of the lens.

You can indicate the business purpose of this 
lens and the planning managers that would 
use this lens.

Planning items Type of work that can be planned using this 
lens.

Move the desired planning item types from the 
Available  list to the Selected  list.

Lens structure form

Learn about the fields of the Lens structure form. Use this form to define a structure for your lens 
in the Portfolio Planning  application.
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Lens structure form

Field Description

Entity Source table for your lens entity.

An entity represents a planning level in the 
perspective of your lens.

Select the entity that is relevant for your 
planning persona from the perspective of 
this lens. For example, Department, Product 
Model, or Business Objective.

Entity filter Conditions to filter data from your entity 
source.

The filtered data is shown on the workspace 
for your planning persona to select and plan 
for.

Top entity Indicates if this entity is the top-level entity of 
your lens structure.

Parent entity Entity that is one level above this entity in your 
current lens structure.

This field is available only if the Top entity  field 
isn’t selected.

Reference to parent entity Column in the current entity table that 
references the parent entity table.

For example:

• Entity is Strategic Program 
[sn_align_core_program]

• Parent entity is Department 
[cmn_department]

Then the field of the Strategic Program 
[sn_align_core_program] table that references 
the Department [cmn_Department] table 
would be Department.

This field is available only if the Top entity  field 
isn’t selected.

Related topics

Modify lens structure in Portfolio Planning

List Applicability form

Learn the field information for the List Applicability form. Use this information to define audience 
for the newly created lists for Portfolio Planning  workspace.
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Field Description

List Name of the list that you want to define 
audience for.

Application This field is set to Portfolio Planning  by 
default.

Applicability Audience for this list.

Set this field to Alignment Workspace Home 
Audience.

Active Option to enable this applicability to the list.

Planning item milestone form

Learn about the fields of the planning item milestone form. Use this form to create milestones for 
the planning items in your roadmap in Portfolio Planning.

Field Description

Name Preferred name for your milestone.

Type Milestone type. Select one from the following:

• Deadline

• Key Milestone

• Key Event

• Launch Date

• Important Date

Due date The date of the milestone.

State Status of the milestone. Select one from the 
following:

• Upcoming

• Missed

• Achieved

Assigned to User who is assigned to the milestone.

Description Brief description about the milestone.

Project planning item form

Learn about the fields of the project form. Use this form to create or edit the details of a planning 
item of the type Project in Portfolio Planning.

These fields are displayed on the full details page of the planning item.
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Project planning item form

Field Description

Name Brief description of the planning item.

Description Detailed information of the planning item.

You can refine project description using the 
Write planning item skill, if the Now Assist for 
SPM  application is installed.

Status Status of the planning item.

Owner User assigned to this planning item.

State Current working state of the planning item.

Percent complete Percentage of work completed for this 
planning item.

Planning state State of the planning item in the Strategic 
Planning  or Portfolio Planning  Backlog.

Execution URL Link to the project's execution record in the 
Project Workspace.

MoSCoW Priority of this planning item based on its 
importance. The available options are:

• 1 - Must have

• 2 - Should have

• 3 - Could have

• 4 - Won’t have

Portfolio Portfolio that this planning item is associated 
to.

Program Program that this planning item is associated 
to.

Product Product that this planning item is associated 
to.

Strategic program Strategic program that this planning item is 
associated to.

Product enhancement Product enhancement that this planning item 
is associated to.

Primary goal Goal that is associated with this planning item 
as the primary goal.

Primary target Target that is associated with this planning 
item as the primary target.

Work notes Notes to capture the updates and discussions 
on the planning item as the work progresses.

Strategic priority Strategic priority that this planning item is 
related to.
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Dates section of the Project planning item form

Field Description

Planned start date Date on which the work for this planning item 
is planned to start. This value is copied from 
the Approved start date  field.

Planned end date Date on which the work for this planning 
item is planned to be complete. This value is 
copied from the Approved end date  field.

Approved start date Approved start date for this planning item.

Approved end date Approved end date for this planning item.

Actual start date Actual date on which the work for this planning 
item has started.

Actual end date Actual date on which the work for this planning 
item is complete.

Details section of the Project planning item form
In this section, capture additional details for this planning item such as 
Investment type, Phase of the planning item, Execution type, affected business 
application, and more.

Field Description

Investment class Type of investment class that this planning 
item comes under. Choose from Run  and 
Change

Investment type Type of investment that this planning item 
comes under. For example, if completing work 
on this item improves the user experience for 
your product, select End User Experience.

Demand Demand that this planning item is associated 
with.

Execution type Execution methodology for this planning item. 
Select from Waterfall, Agile, or Hybrid.

This field is available only if the planning item 
is of the type Project.

Priority Priority of this planning item.

Phase Phase of this planning item.

This field is available only if the planning item 
is of the type Project.

Business application Business application that this planning item is 
related to.

Other impacted business applications Business applications that this planning item 
has an impact on.
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Details section of the Project planning item form
In this section, capture additional details for this planning item such as 
Investment type, Phase of the planning item, Execution type, affected business 
application, and more.

(continued)

Field Description

Business capabilities Business capabilities of this planning item.

Business case section of the Project planning item form
In this section, capture business details for this planning item such as risks, 
scope, and blockers for this planning item.

Field Description

Business case Business case to invest in this planning item.

Risk of performing Risks to the business if work on this planning 
item is completed.

Risk of not performing Risks to the business if work on this planning 
item isn’t completed.

Enablers Enablers for this project.

Barriers Blockers, if any, for this planning item.

In scope Defined criteria for this planning item.

Out of scope Clearly defined criteria that is not necessary 
for this planning item.

Assumptions Assumptions, if any, to work on this planning 
item.

Financials section of the Project planning item form
In this section, capture financial details for this planning item such as cost, 
CapEx, OpEx, benefit, ROI, and other estimates.

Field Description

Planned cost Planned cost to take up this planning item.

Planned capEx Planned capital expenditure for this planning 
item.

Planned opEx Planned operational expenditure for this 
planning item.

Planned benefit Planned benefit from this planning item.

Actual benefit Actual benefit achieved from this planning 
item,

Estimate to completion Estimated cost to complete work on this 
planning item.

Actual cost Actual cost on this planning item.
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Financials section of the Project planning item form
In this section, capture financial details for this planning item such as cost, 
CapEx, OpEx, benefit, ROI, and other estimates.

(continued)

Field Description

Actual capEx Actual value of capital expenditure for this 
planning item.

Actual opEx Actual value of operational expenditure for this 
planning item.

Planned ROI Planned return of investment for this planning 
item.

Planned return Financial return on this planning item.

Estimate at completion Estimated cost at the time that work on this 
planning item is completed.

Score section of the Project planning item form
In this section, capture scoring details for this planning item such as score, 
value score, risk score, and size score.

Field Description

Score

Value score Score for the value obtained with this planning 
item.

Risk score Score for the risk associated with this planning 
item.

Size score Score for the job required to complete the 
task.

Roadmap configuration form

Learn about the fields of the roadmap configuration form. Use this form to add new tables to 
roadmap preferences and configure their details in Portfolio Planning.

Roadmap configuration form

Field Description

Source table Table that is used to build your roadmap.

Start date field
Field that is used for the start date of the 
roadmap item.

For example, Planned start date.

End date field
Field that is used for the end date of the 
roadmap item.
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Roadmap configuration form  (continued)

Field Description

For example, Planned end date.

Item name field
Field that is used for the name of the roadmap 
item.

For example, Short description.

Item owner field
Field that is used for the owner of the roadmap 
item.

For example, Assigned to.

Status
Field that is used for the status of the roadmap 
item.

Percent Complete
Field that is used to track the completion of 
the roadmap item.

This field value is used to visualize the 
progress of the roadmap item in the tracking 
mode.

Group by fields List of fields with which the roadmap items can 
be categorized into groups.

For example, the State  attribute can be used 
to categorize the items into groups of states 
such as Draft, Ready, Work in progress, and 
others.

Color by fields List of fields with which the roadmap items can 
be categorized by color.

For example, the Planning item type  attribute 
can be used to assign a unique color to each 
group of items belonging to a specific type.

Metric fields
List of fields used as the metrics for the 
roadmap items.

For example, Planned benefit  or Actual cost.

These values are displayed when you point 
the mouse cursor on the roadmap item.

Table map form

Understand the fields of the table map form. This form is used to create a new custom table map 
for any record to integrate with Agile Development 2.0, SAFe, and PPM.
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table map form

Field Description

Alignment Integration Specifies the Alignment integration type. The 
value is ServiceNow Internal  by default.

Execution table Table in Agile Development 2.0, SAFe, or 
PPM that needs to be mapped with a table 
in Strategic Planning. For example, Defect 
[rm_defect].

Alignment table Table in Strategic Planning  that needs to be 
mapped with a table in Agile Development 
2.0, SAFe, or PPM. For example, Milestone 
[sn_milestones_milestone].

Milestone table map This field is relevant only for Project 
[pm_project] table map. It is a reference 
to the new Milestone table map 
(sn_milestones_milestone) for integrating 
project milestones from Project Portfolio 
Management workspace to Strategic Planning. 
For all the other table maps, the milestone 
table map field is not available.

Execution table filter Filter condition to retrieve the relevant records 
from PPM, Agile Development 2.0, or SAFe. For 
example, Portfolio is HR or Active is True.​

Alignment table filter Filter condition to retrieve the relevant records 
from Strategic Planning.​

Active flag Ensures that the table map sync is active. This 
field is checked by default.

Sync attachments Ensures that the attachments are synced 
between the applications. This field is 
checked by default.

Roadmap milestone form

Learn about the fields of the roadmap milestone form. Use this form to create a milestone for the 
timeline of your roadmap in Portfolio Planning.

Field Description

Name Preferred name for your milestone.

Type Milestone type. Select from one of the 
following:

• Key Event

• Launch Date

• Important Date

• Deadline

• Key Milestone
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Field Description

Due date The date of the milestone.

Assigned to User who is assigned to the milestone.

Scheduled Script Execution form to generate labor costs for projects and demands

Use the Scheduled Script Execution form to enable Generate Labor Costs scheduler job for 
projects and demands.

Schedule Item form

Field Description

Name Name that identifies this scheduled job.

Active Option that indicates that scheduled job is active and should be executed at the 
specified date and time.

Run
Time interval to use for running the scheduled job:

• Daily: Runs daily, at a designated time.

• Weekly: Runs on a weekly basis, at a designated time and day of the week.

• Monthly: Runs on a monthly basis, at a designated time and day of the month.

• Periodically: Runs on a designated repeating interval.

• Once: Runs for a single occurrence only.

• On Demand: Runs immediately on demand.

• Business Calendar: Entry Start: Runs on the starting entry dates for the 
business calendar that you select in the Business Calendar  field. A scheduled 
job runs for the starting date of each of the business entries that you defined for 
the business calendar.

For example, if the business calendar represents a fiscal year, and the starting 
date of each entry is a fiscal month, the scheduled job runs on the first day of 
each month.

• Business Calendar: Entry End: Runs for the ending date for the business 
calendar that you select in the Business Calendar  field. This selection runs in 
the same manner as Business Calendar: Entry Start, but for the end dates of 
the associated business calendar entries.

Note: 
When you select Business Calendar: Entry Start  or Business Calendar: 
Entry End, you can apply an offset factor to schedule the job to run before 
or after the time span of the selected business calendar. To learn more, 
see the Offset type  and Offset  fields.

To learn more about creating and using business calendars and defining 
business calendar entries, see Creating business calendars  and Define 
business calendar entries .

Time zone
Time zone to use with the Time  field entry when you specify the time at which the 
scheduled job should run. Select a time zone entry:
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Schedule Item form  (continued)

Field Description

• -None-: Use the default time zone for the logged-in user who is creating the 
scheduled job.

For example, the scheduled job runs at 04:45 p.m. US/Pacific time if it is the 
user's assigned time zone, and you enter 16:45  into the Time  field.

• Use System Time Zone: Use the default system time zone that is specified for 
the instance in which it runs.

For example, the scheduled job runs at 10:15 p.m. London time if Europe/
London is the default system time zone for the instance, and you enter 22:15 
in the Time  field.

• Actual time zone.

For example, the scheduled job runs at 1:30 p.m. in the US Eastern time zone if 
you select US/Eastern, and enter 13:30  in the Time  field.

Day
Day on which the scheduled job should run.

• If Run  is set to Weekly, select the day of the week. For example, select 
Wednesday.

• If Run  is set to Monthly, select the day of the month. For example, select 25 for 
the 25th day of the month.

This field appears only if you select Monthly  or Weekly  in the Run  field.

Repeat 
Interval Duration of the repeat interval for each scheduled job execution. Enter the 

duration in the number of days, hours, or minutes. For example:

• To run the scheduled job every four days, enter 04  in the Days  field.

• To run it every 26 hours, enter 26  in the Hours  field.

• If it should repeat at an interval of 13:30:25, enter 13  in the Hours  field, and 
then enter 30  and 25  in the two unlabeled fields after it.

These fields appear only if you select Periodically  in the Run  field.

Note: 
This setting does not account for Daylight Saving Time changes. For 
example, if you select a period of one day, the calculation adds 24 hours to 
the starting time of the job. If the start time is in a Daylight Saving Time (DST) 
period, the job runs with a one-hour offset when that time zone is not in DST.

Business 
Calendar Business calendar entry that you are using to determine the business calendar 

start or end date for the scheduled job. This field appears only if you select 
Business Entry: Start Date  or Business Entry: End Date  in the Time  field.

Offset Type
Type of time offset, if any, to apply to the business calendar that you selected for 
scheduling this job:
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Schedule Item form  (continued)

Field Description

• Past: Apply an offset factor to schedule the job to run before the start of the 
time span of the selected business calendar.

• Future: Apply an offset factor to schedule the job to run after the end of the time 
span of the selected business calendar.

• --None--: Do not apply a time offset when scheduling this job.

Adding an offset factor enables you to schedule the job to run before, or after, the 
formal time span that is defined in the business calendar for the following use 
cases:

• Schedule a job at a certain time, outside of the time span for the selected 
business calendar.

• Arrange multiple jobs to run in sequence, around the time span of the selected 
business calendar.

The Offset type  and Offset  fields appear only if you select Business Calendar: 
Entry Start  or Business Calendar: Entry End  in the Run  field.

Offset
Amount of time offset, expressed in days, hours, minutes, and seconds, to apply 
to the business calendar that you selected for scheduling this job. For example, 
if you want to schedule the job to start three days, 14 hours, 10 minutes, and 45 
seconds before the business calendar start date, do the following actions:

• Select Past  in the Offset type  field.

• Enter 3  in the Days  field.

• Enter 14, 10, and 45  in the Hours  field.

The Offset Days  and Hours  fields appear only if you select Business Calendar: 
Entry Start  or Business Calendar: Entry End  in the Run  field, and Past  or Future 
in the Offset type  field.

Time Time of day at which the scheduled job should run, expressed in hours, minutes, 
and seconds on a 24-hour clock. The selection that you make in the Time zone 
field determines the time zone for this entry.

Note: 
Time values are always saved in the ServiceNow AI Platform®  in UTC time 
and then translated into the proper time. This translation depends on the 
selected Time zone  and the entry in the Time  field.

This field appears only if you select Daily, Weekly, or Monthly  in the Run  field.

Starting Date and time of the first scheduled job generation. Select the calendar date and 
time. This field appears only if you select Periodically  in the Run  field.

Priority
Numerical priority for the scheduled job:
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Schedule Item form  (continued)

Field Description

• Set essential jobs to a priority value below 100.

• Set nonessential jobs to a priority above 100.

• If 70 percent or more of all scheduled jobs are Overdue, any jobs that are 
marked with a value above 100 do not run.

Run as Name of the user who is creating and running the scheduled job. To assign the 
scheduled job to the system instead of the person creating the scheduled job, 
create a system or dummy user and add it to this field.

Conditional Option for enabling the running of the scheduled job if certain conditions are met 
in the associated script.

Condition Conditional script that determines if a scheduled job should run. The last 
expression of the script should evaluate to a Boolean (true/false) value. This text 
box appears only if you select Use conditions.

Starting Date and time of the first scheduled job generation. Select the calendar date and 
time. This field appears only if you select Periodically  in the Run  field.

UX List Category form

Learn about the fields of the UX List Category form. Use this form to create additional categories 
for lists in the Lists menu of Portfolio Planning  workspaces.

Field Description

Title Display name of the category in the 
workspace.

Application Application scope. Ensure that this is set to 
Portfolio Planning.

Order Order in which this category is displayed in 
the workspace.

Active Option to enable the display of this category in 
the workspace.

Description Brief description of the category.

Configuration
Configuration that the category is referencing.

By default, this field is set to APW List Menu 
Configuration.

Related topics

Customize Lists in Portfolio Planning Workspace

UX List form

Learn about the fields of the UX List form. Use this form to create additional lists in the Lists menu 
of Portfolio Planning  workspaces.
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Field Description

Title Display name of the category in the 
workspace.

Application Application scope. Ensure that this is set to 
Portfolio Planning.

Order Order in which this category is displayed in 
the workspace.

Category Category that this list would be displayed 
under, in the workspace.

Active Option to enable the display of this category in 
the workspace.

Table Source table for the list.

Configuration
Configuration that the category is referencing.

By default, this field is set to APW List Menu 
Configuration.

Conditions Conditions to filter the records of the source 
table.

Fixed query Current fixed query conditions applied to the 
list.

Columns Columns of the table that must be displayed in 
the list in the workspace.

Group by column Attribute that would be used to group the list of 
records by.

View View to determine which columns are 
displayed in the list in the workspace. If you 
select a view, the Columns  field is disabled.

Related topics

Customize Lists in Portfolio Planning Workspace

Next Experience for Demand Management  in Portfolio Planning
Create, evaluate, and prioritize demands throughout the demand life-cycle using Next 
Experience for Demand Management.

Next Experience for Demand Management  gives organizations and teams a structured way to 
capture, assess, and prioritize different types of work before committing to execution. Using Next 
Experience for Demand Management, demand managers can review incoming requests, assess 
business cases and capacity, estimate costs, evaluate risks, and decide which demands are 
worth moving forward. Playbooks allow teams to define different governance processes as well.

Next Experience for Demand Management  comes with the Playbook, Details, and Docs pages 
and is available for users with the Strategic Portfolio Management  (SPM) Standard license.

Key benefits of Next Experience for Demand Management:
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• Consistent demand intake and evaluation process - Next Experience for Demand Management 
enables a structured workflow where each demand progresses through defined evaluation 
stages such as intake, capacity and assessment, financial assessment, and approval.

• Centralized visibility into demand information - Next Experience for Demand Management 
provides a single interface to view all demands and their associated details such as business 
cases, capacity, and financials. This feature eliminates the need to cross-reference multiple 
forms, modules, or applications to compile a complete picture of a demand.

• Playbook-guided demand life-cycle - Playbooks define the sequence of stages and activities 
that a demand must go through such as creation, planning, assessment, and approval. Each 
stage contains a set of prescribed activities that must be completed before the demand 
transitions to the next stages. Using playbooks, you can define your own processes according 
to your requirements.

• Consolidated data for demand prioritization - Next Experience for Demand Management 
provides demand details, capacity and risk assessment outputs, financial summaries, and 
progress indicators in a unified view. This feature helps demand managers to compare, rank, 
and prioritize demands based on any defined criteria of an organization.

• AI system integration through playbook activities - The AI playbook enables the association of 
AI systems to a demand through a playbook activity. This feature enables demand managers to 
associate a demand with an AI system from directly within the demand workflow.

Get started

Explore

Learn about Next Experience for Demand 
Management features and business value.

Configure

Learn how to configure Next 
Experience for Demand Management.

Use

Create and manage demands, 
use playbooks, and manage 

financials and resources.

Reference

Get details about demand components like 
roles, tables, properties, forms, and lists.
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Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Next Experience for Demand Management

Next Experience for Demand Management  helps you to create, evaluate, and prioritize demands, 
throughout the demand life-cycle.

Next Experience for Demand Management  overview

Next Experience for Demand Management  is a centralized workspace experience that 
streamlines how organizations capture, evaluate, and progress demands through their life-
cycle. It brings together all demand‑related  activities, such as intake, qualification, and task 
management, into a single interface. By consolidating access to demands, tasks, resources, 
financials, and supporting records, the workspace experience eliminates the need to navigate 
across multiple modules.

Next Experience for Demand Management  gives product owners, portfolio managers, and 
demand managers a comprehensive overview of all active and incoming demands. It enhances 
planning accuracy by providing structured ways to define demand scope, assess capacity, 
estimate effort, and evaluate financial and strategic impact. With guided governance through 
Playbooks, the Next Experience for Demand Management  helps teams prioritize work effectively, 
improve decision‑making,  and ensure consistent progression of demands from intake to 
completion.

Next Experience for Demand Management  benefits

Benefit Feature

Capture a new business need and kick off 
structured governance from intake.

Create a demand and start the intake flow. For 
more information, see Create a demand.

Use advanced filtering options to find specific 
demands based on criteria such as status, 
start and end dates, and project type.

Filter and sort demands. For more information, 
see Demands list view.
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Next Experience for Demand Management  benefits  (continued)

Benefit Feature

Define different governance processes for 
demands.

Use playbooks (default and custom) for 
demand governance processes with low 
code/no code changes. For more information, 
see Use Playbooks.

Add and manage work needed to progress a 
demand to approval or delivery readiness.

Create and manage demand tasks (including 
time card submission). For more information, 
see Create and manage demand tasks.

Collaborate on specifications, notes, and 
decisions within the demand record.

Use Docs to co-author content directly from 
the demand. For more information, see Docs 
for demands in Next Experience for Demand 
Management.

Track risks, issues, and decisions to maintain 
traceability and control.

Add or associate RIDAC records with the 
demand. For more information, see Add and 
manage RIDAC records.

Plan and control financials associated with a 
demand.

Create cost plans, generate labor costs, and 
manage expense lines. For more information, 
see Managing financials for demands.

Create financial baselines to track variance 
over time.

Create demand baselines to track the demand 
finances. For more information, see Create 
financial baselines.

Quantify expected value for business cases. Create and manage monetary and non-
monetary benefit plans for your demand 
and associate them to each other. For more 
information, see Create and manage benefit 
plans.

Align work capacity with demand scope and 
timelines.

Create and manage capacity for a demand. 
For more information, see Create and manage 
resource assignments.

Progress qualified demands into downstream 
delivery entities.

Create entities from a demand such as 
projects, enhancements, and changes. For 
more information, see Create an entity from a 
demand.

Link AI systems to a demand directly from Next 
Experience for Demand Management.

Associate AI systems with your demand as 
and when necessary. For more information, 
see Create AI systems.

Demand workflow

The demand workflow defines the life-cycle of a request, from initial intake through assessment 
and approval to downstream execution. This structured approach ensures that each request is 
evaluated consistently, aligned with business objectives, and supported by the right processes 
before any resources are committed.

Workflow overview

The end-to-end life-cycle for managing demands is described in the following table. This 
workflow confirms that the demands are progressively refined, validated, and aligned with 
business and strategic objectives.
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Note: 
The demand workflow overview table describes the traditional demand management 
process. You can customize the states and activities according to the requirements of your 
organization by defining your custom playbook.

Demand workflow overview

Task Description
Demand states 
involved

Roles involved

Create a demand Demands enter the system via 
Service Catalog, Idea Portal, or 
directly by demand managers:

• Business users can submit an 
idea via the Service Catalog 
or Idea Portal. These ideas 
are evaluated by demand 
managers and promoted to a 
demand, if necessary.

• Business users can bypass the 
ideation process and submit 
a demand directly from the 
Service Catalog.

• Demand managers or demand 
users can directly submit 
demands from Next Experience 
for Demand Management.

Draft Business user, 
demand manager, 
demand user

Complete demand 
details

The demand manager or demand 
user reviews and adds the 
required details. Demand 
managers can create and assign 
demand tasks to gather more 
information, if necessary.

The demand is moved from the 
draft to the submitted state once 
the basic demand details are 
added.

Draft → 
Submitted

Demand manager, 
demand user

Refine and finalize 
demand

The demand manager completes 
all required information (size, 
impact, business case, timeline, 
resources, costs/benefits, 
stakeholder registry, strategy 
alignment). They can assign 
tasks or request SME (subject 
matter expert) support, whenever 
required.

Submitted Demand manager

Move demand to 
screening

The demand manager moves the 
demand to screening.

The assessments are sent 
to the stakeholders to score 

Submitted → 
Screening

Demand manager
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Demand workflow overview  (continued)

Task Description
Demand states 
involved

Roles involved

the demand once it is in the 
screening state.

Complete 
assessments

Stakeholders complete and 
submit assessments for scoring.

Screening Stakeholder

Move demand to 
qualified

The demand moves to the 
qualified state once the required 
assessments are submitted.

• Next Experience for Demand 
Management  updates the state 
automatically.

• Demand manager manually 
sets the demand to qualified 
while it is in screening. For 
example, when assessments 
are delayed or not required.

Screening → 
Qualified

Demand manager, 
Next Experience for 
Demand Management

Review demand Stakeholders review the demand 
for approval or deferral.

Qualified Stakeholder

Approve/Defer a 
demand

The demand manager sets 
demand as approved (moves 
forward for execution) or deferred 
(moves to Deferred state).

Qualified → 
Approved/
Deferred

Demand manager. 
demand approver

Convert demand 
to strategic/
operational entity

Once the Demand is approved, 
the demand manager creates the 
selected entity such as project, 
enhancement, or Enterprise Agile 
Planning  (EAP) entities.

The created entity is based 
on the values in the Category 
and Type  fields of the Demand 
record.

Depending on the type of record 
created, the demand data is 
migrated to the created entity.

Approved Demand manager

Complete 
demands

Based on the selection in the 
Close Demand  field, a demand 
is completed automatically when 
converted entity is completed, 
or manually by the demand 
manager at any state.

Approved → 
Completed

Demand manager, 
Next Experience for 
Demand Management

Playbooks in Next Experience for Demand Management

Playbooks in Next Experience for Demand Management  provide a guided, structured approach 
to managing a demand from initiation to completion. Playbooks focus specifically on helping 
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demand teams follow the standard demand life-cycle, confirming every demand progresses 
consistently and no critical steps are missed. You can define your playbooks according to your 
requirements.

Purpose of Playbooks in Demand Management

Playbooks provide a structured way to manage work by guiding teams through predefined steps. 
It shows what to do, when to do it, and where to find the tools or information required to complete 
each task. You can apply a playbook to processes such as managing a demand, resolving an 
issue, launching a product, onboarding new employees, or define key steps of a process. For 
more information on playbooks and how to create them, see Workflow studio playbooks .

In Next Experience for Demand Management, playbooks help demand managers and reviewers:

• Understand exactly which activities must be completed at each demand stage.

• Track required inputs, approvals, and validations for demand progression.

• Confirm that demand evaluation, prioritization, and planning follow the organization’s standard 
governance.

• Provide built‑in  process guidance within the demand record, reducing the need to rely on 
informal or undocumented knowledge.

• Maintain process consistency across all demands, regardless of the requester or manager.

• Enable you to define multiple standardized governance processes across the organization.

How Playbooks work for demands

When a playbook is applied to a demand:

• Demand life-cycle stages such as ideation, assessment, prioritization, and planning are 
outlined.

• Each stage contains activities and tasks tailored to demand requirements, such as defining 
scope, estimating effort, documenting benefits, or securing stakeholder approval.

• Playbooks guide demand managers through dependencies before the demand can move 
forward.

• Demand records automatically capture progress and trigger actions such as assessments and 
approvals as the tasks are completed.

For example, a demand about a Customer Self‑Service  Portal enhancement uses a playbook to 
guide its progress as follows:

• The ideation stage prompts the demand manager to capture objectives and benefits.

• The assessment stage guides effort, cost, and risk evaluation.

• Prioritization helps validate scoring and funding.

• Planning finalizes the scope and links the demand to a potential work entity.

As each stage is completed, the playbook ensures that the demand follows the standard life-
cycle without missing any required steps.

Playbook benefits

Playbooks add value to demand management by:

• Standardizing demand intake: Ensuring required information is captured early.

• Providing step-by-step instructions: Useful for new demand managers or occasional users.
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• Supporting governance: Ensuring stage gating for evaluation and approval.

• Improving visibility: Showing exactly where a demand sits in the life-cycle and what is blocking 
its progress.

• Integrating workflows: Using Flow Designer to set up different business logic for each playbook 
flow.

Types of Playbooks

• Demand default playbook - The default demand playbook is a stage-gate playbook. In a stage-
gate playbook, the stages and tasks must be completed in a linear order. Each stage must be 
finished before moving to the next one. The stages are visible only when all activities in the 
previous stage are completed or skipped. After completing a stage, demand managers can still 
return to previous stages if needed.

• AI playbook - The AI playbook is available for a demand when the AI Control Tower plugin is 
installed and the investment type of the demand is set to artificial intelligence. This playbook 
has an additional AI checkpoint stage where you can associate new or existing AI systems to 
your demand.

Note: 

• You can use the demand default playbook and customize it according to your 
organization's requirements. For more information about the stages and activities of this 
playbook, see Demand default playbook stages and activities.

• You can also create a demand playbook according to your requirements. For more 
information, see Create and configure playbooks .

Related topics

Create and customize playbooks

Use Playbooks

Demand default playbook stages and activities

Configuring Next Experience for Demand Management

Configure your Next Experience for Demand Management  to assess and promote demands to 
projects, enhancements, changes, defects, or Enterprise Agile Planning  (EAP) entities.

Next Experience for Demand Management  planning
Use the following table to identify what you must define before setting up the 
Next Experience for Demand Management.

Item name Description

Roles Define who can access and work in the 
Next Experience for Demand Management. 
Includes identifying workspace administrators, 
demand managers, approvers, and reviewers 
who participate in the demand process.

Stakeholders Identify individuals or groups who review 
or need visibility into demand items. 
Stakeholders provide domain insight during 
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Next Experience for Demand Management  planning
Use the following table to identify what you must define before setting up the 
Next Experience for Demand Management.

(continued)

Item name Description

evaluation. For more information, see Populate 
the stakeholder registry for demands.

Information model Specify the fields and attributes required to 
capture demand data. Includes form layouts, 
required fields, and custom data elements.

Evaluation criteria Define the metrics used to assess and 
compare demand items. Common criteria 
include business value, complexity, cost 
estimates, and alignment to strategy. For more 
information, see View an assessment metric 
category.

Resource considerations Determine what resource related information 
must be associated with demand items, such 
as estimated effort or team availability.

Workflow expectations Describes the life-cycle stages for a demand 
item, from creation to review, approval, or 
conversion through Playbooks.

Playbooks Define or verify that the demand playbooks 
are in accordance with the processes of your 
organization. For more information, see Create 
and customize playbooks.

Dependencies with other applications Identify related workspaces or applications 
are required with Next Experience for Demand 
Management, such as Project Workspace  or 
Resource Management Workspace. Ensures 
consistent data across applications.

Populate the stakeholder registry for demands

Add users to the stakeholder registry so that Next Experience for Demand Management  can 
automatically populate the stakeholder list when demand users create a demand.

Before you begin
Role required: pps_admin

Procedure

1. Access the Stakeholder Register record form in one of the following ways.

◦ Navigate to All  > Project Administration  > Settings  > Stakeholders.

◦ Navigate to a demand playbook or the Stakeholders  tab in Details  page, and select New. 
For more information, see Access demands.

2. On the Stakeholder Register record form, fill in the fields.
For a description of the field values, see Stakeholder register form.
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3. Select Submit.

Note: 
When adding a user to the stakeholder registry, the combination of the user and the 
assigned portfolio must be unique. However, there can be multiple records for the same 
user but with different portfolios.

Configure a custom risk rank and risk value

Configure custom risk ranks and value scores to rate the impact and probability factors for a risk.

Before you begin
Role required: pps_admin

About this task
Use the Risk Value Lookup module to set up the risk rank and risk value for a specific 
combination of risk impact and probability. The system uses these values to determine the 
degree of risk (Absolute, High, Medium, and Low) based on the impact and probability factors of 
a risk.

The value in the Probability  field is multiplied by the value of the Impact  field to generate the 
values for the Risk rank  and corresponding Risk value  in the Create New Risk form.

By default, you can use the following impact, value, and probability scores for a risk to create a 
risk rank and risk value score:

• Absolute

• Low

• Medium or Moderate

• High

For example, a risk might have high probability and medium impact but you might want to 
consider it as an overall low risk for the demand. In that case, you would configure the Risk Value 
Matcher form with the following values:

• Impact = 2 Medium

• Risk Rank Color = Green

• Probability = High

• Probability Number = 1

• Risk Value = 3 Low

In this case, the calculated risk rank and value are as follows:

• Calculated risk rank = 2

• Calculated risk value = 2
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The following image illustrates a Risk 

form.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Risk Value Lookup.

2. Select New.

3. On the risk value lookup form, fill in the fields.
For a description of the field names, see Risk value lookup form.

4. Select Submit.

View an assessment metric category

View assessment metric categories that are used with assessment metric types and assessment 
metrics.

Before you begin
Role required: pps_admin

About this task
Demands come with an assessment metric type named Demand, five default assessment metric 
categories, and assessment metrics.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Assessments Metric Categories.

2. Open an assessment metric category to review it.
The following default assessment metric categories are available with demands.

Demand assessment metric categories

Assessment 
metric 
category

Data source Description

Size T-Shirt size  field on the demand form. Assesses demand size 
relative to the size of other 
demands.

Strategic 
Alignment

View an assessment category result field in the 
assessment category result for the Strategic 
Alignment metric category. For more information, 
see View an assessment category result

Assesses how closely the 
demand aligns with strategic 
goals of the organization 
compared to other demands.

Risk Rating  field in the assessment category result for 
the Risk metric category.

Assesses demand risks 
compared to other demands.
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Assessment 
metric 
category

Data source Description

ROI Impact  and Financial return  fields on the 
Demand form.

Assesses demand return 
on investment compared to 
other demands.

Cost Labor costs, Capital expense, and Operating 
expense  fields on the Demand form.

Assesses demand cost 
compared to other demands.

Multicurrency in Next Experience for Demand Management

Manage and track demand financials in your corporate currency, regional currency, or project 
currency using the multicurrency feature.

Overview of multicurrency

In global organizations, demands are often managed at one location and executed at another. 
Each location might use different currencies for budget spending, making it difficult to monitor 
and track financials.

The multicurrency feature in Next Experience for Demand Management  lets you manage and 
track demands from any geographic location in any currency. You can monitor demand financials 
in one currency while spending the budget in a different currency, such as your functional 
currency or regional currency. You can also manage your demands in one currency and specify a 
different currency for managing your future projects.

Activation information

To enable multicurrency features in Next Experience for Demand Management, activate the PPM 
Standard Multicurrency (com.snc.ppm_multicurrency) plugin. This activation:

• Enables the demand currency view in demand, cost plan, and benefit plan forms.

• Enables you to manage simple demand financials, cost plans, benefit plans, and budgets in 
the demand currency

• Automatically activates the PPM Standard (com.snc.financial_planning_pmo) plugin, giving 
you the option to switch between the default view and demand currency view

Currency preferences

After activating the plugin, specify your currency preference for managing demand financials. 
You can select your functional currency, a regional currency, or a local currency. For more 
information, see Select demand currency preference.

Demand currency view

The Demand Currency view displays multicurrency fields in addition to the standard demand 
form fields. Enable this view from the form context menu.

You can designate a currency other than the functional currency as the processing demand 
currency. The Demand currency  field appears on the Financials section of the Demand form, 
where you can select any active currency from the Currencies [fx_currency] table.

Note: 
The Demand currency field becomes read only once you create a cost plan, cost plan 
breakdown, benefit plan, or benefit plan breakdown for the demand.
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Multicurrency in demand tasks

Track expenses for demand tasks in demand currency. When a time card for a demand task is 
submitted and processed, the actual cost is calculated based on the rate model, default labor 
rate, or system property rate. View this actual cost in the Demand Task form in the Demand 
currency  and Actual cost in demand currency  fields.

Multicurrency in demand baselines

Compare financial baselines to track demand performance over time. Baseline comparison 
helps you identify and review financial changes made to the demand at various life-cycle stages. 
With the multicurrency feature, you can view financial information in demand currency when 
comparing baselines. You can also configure the baseline view to add fields and view details in 
demand currency. For more information, see Create financial baselines.

Select demand currency preference

Set your currency preference for managing and tracking demand financials from the functional 
currency, regional currency, or local currency.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Preferences-Project.

2. Select a currency option from the Demand currency setup list.

3. Select Save.

What to do next
Enable the multicurrency view in the demand form and other demand-related forms. For more 
information, see Enable demand currency view.

Enable demand currency view

Switch to the demand currency view to track the planned costs of a demand in the selected 
currency.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin or it_demand_manager

About this task
To manage demands in a currency different from the functional currency, demand currency fields 
are added to the demand tables such as dmn_demand and dmn_demand_task.

Tables with demand currency fields

Table Description

Demand [dmn_demand] Demands can be tracked in a different 
currency. When you create a demand, 
select another currency by navigating to the 
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Tables with demand currency fields  (continued)

Table Description

Financials  tab and selecting a currency in the 
Demand Currency  field.

Demand Task [dmn_demand_task] Demand tasks delegate cost, effort, risk, and 
benefit assessment activities.

Cost Plans [cost_plan] Cost plans capture the costs of demands.

Cost Plan Breakdown [cost_plan_breakdown] Cost plan breakdowns specify the estimated 
cost and actual cost at a granular level for a 
fiscal period.

Benefit Plan [benefit_plan] When you open the demand form in Demand 
Currency view, fields related to the demand 
currency appear in the Benefit Plans related 
list by default.

Benefit Plan Breakdowns 
[benefit_plan_breakdown]

Benefit plans capture the potential benefits 
accrued when the demand is executed.

Expense Line [fm_expense_line] Expense lines are part of demand cost plans 
and store costs associated with a specific 
resource.

Project Funding [project_funding] Stores the demand target and budget 
expense values for both capital and operating 
expenses for a single fiscal period.

Procedure

1. Navigate to the form in which you want to enable the demand currency view.

2. Right-click the form header or select the additional actions icon to open the context menu.

3. Select View.

4. Select Demand Currency  from the list.

What to do next
Review the form fields exclusive to the Demand Currency  view. All other form tabs and fields 
remain the same in both default view and demand currency view. Continue entering values as 
you would in the default view. For more information, see Multicurrency fields in demand-related 
forms.

Quick start tests for multicurrency in Next Experience for Demand Management

Validate that multicurrency in Next Experience for Demand Management  works correctly after 
making configuration changes such as applying an upgrade or developing an application. Copy 
and customize these quick start tests to pass when using your instance-specific data.

Danger: 
By default, the system property that is used to run automated tests is disabled to prevent 
you from accidentally running these tests on a production system. To avoid data corruption 
or an outage, run tests only on development, test, and other non-production instances. See 
Enable or disable executing Automated Test Framework tests .

Activate the PPM Standard Multicurrency – ATF Tests plugin (com.snc.ppm_multicurrency.atf) to 
use demand currency quick start tests.
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Demand currency test suites tests

Test Description

Verify cost in demand currency on cost plan Validates the calculation of cost plan 
breakdown with budget reference rate and 
verifies the roll up to cost plan in demand 
currency.

Verify benefit in demand currency on benefit 
plan

Validates the calculation of benefit plan 
breakdown with budget reference rate and 
verifies the roll up to benefit plan in demand 
currency.

Related topics

Quick start tests

Upgrade existing demands

Execute scheduled jobs to upgrade your existing active and inactive demands after activating 
the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin

About this task
Run these scheduled jobs on demand to upgrade your existing active and inactive demands in 
demand currency only when necessary.

Note: 
The jobs can impact performance depending on the number of demands and cost plans. 
Run the jobs only when necessary.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Execute the appropriate scheduled job for your demands.

Create and customize playbooks

Configure playbooks to customize demand workflows or create playbooks for your organization.

Before you begin
Role required: admin

About this task
Next Experience for Demand Management  includes two predefined playbooks available in 
Workflow Studio:

• Demand default

• AI playbook

Note: 
The AI playbook is available only when the AI Control Tower plugin is installed and the 
investment type of the demand is set to artificial intelligence.
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These playbooks are ready to use without any additional configuration. Configure playbooks 
only when you must customize an existing playbook or create one for your organization's specific 
demand workflows.

In Next Experience for Demand Management, playbooks are triggered by record creation. A 
playbook is associated with demand records, and the Playbook page appears in the L-2 (level 2) 
menu when a demand meets the trigger condition.

For more information on how to create or customize playbooks, see Configuring playbooks

Procedure

1. Navigate to Workflow Studio  > Playbooks.

2. To customize an existing playbook or create one, create and configure the playbook according 
to your requirement.

◦ To activate a predefined playbook, select the required playbook and define an appropriate 
trigger condition. For more information, see Activate playbooks  and Triggers .

◦ To create a playbook, select New. For more information, see Create and configure 
playbooks .

◦ Multiple playbooks can be enabled at a time. Define trigger conditions so that each 
demand maps to only one playbook type. For more information, see Create and configure 
playbooks .

Related topics

Building playbooks

Designing playbooks

Playbooks in Next Experience for Demand Management

Use Playbooks

Demand default playbook stages and activities

Managing demands in Next Experience for Demand Management

Next Experience for Demand Management  features support end-to-end planning and 
management of your demands.

All Demands list view

When you navigate to the Next Experience for Demand Management, you land on the All 
Demands  home page. This page displays the demands in a list view. You can create a demand, 
edit a demand, or export demands from this page. For more information, see Demands list view.
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Access demands

Learn how to navigate to the Next Experience for Demand Management  and open a demand 
from the All Demands  page.

Before you begin
Role required: it_demand_user, it_demand_manager, sn_ppm_read, demand_approver, 
apw_read

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Demands.
Demands on the All Demands  home page are displayed 
in a list view. For more information, see Demands list 

view.

2. Select a demand to open it.

◦ If a playbook is available for the demand, the Playbook  page is displayed.

◦ If there are no playbooks associated with the demand, the Details  page is displayed.
If you select the short description of a demand, it opens the demand details in a side panel, 
enabling you to edit them. For more information, see Update the demand details.
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3. Optional:  Select Personalize fields  from More Actions to customize the All Demands  page 

view.

4. Optional:  Select Apply.

Note: 
You can also increase or reduce the area occupied by the columns in the data grid by 
dragging the line that separates them.

Related topics

Demands list view

Create a demand

Create demands to capture your strategic and operational requirements and centralize 
information for stakeholder assessment and prioritization.

Before you begin
Role required: it_demand_manager, it_demand_user
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Demands  > 

New.

2. On the Demand form, fill in the fields.

Demand form

Field Description

Name Name of the demand.

Start date The preliminary or estimated date when the 
work is initially planned to begin. This date 
helps outline the intended timing for early 
demand planning and prioritization. You can 
set this date during initial demand creation or 
anytime in the planning phase when a rough 
idea forms. This date can be updated until 
the demand is officially approved.

For example, you’re planning for a database 
upgrade to start on 2025-11-01.

This date is changed to Planned start date 
when the demand is converted to a project.
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Field Description

Note: 
When you change the planned start 
date of a demand or project, the 
associated cost plans and resource 
assignments also change. The Change 
Resource Plan and Cost Plan Start 
Date with Demand or Project Start 
Date Change  property controls the 
behavior for a demand date change. 
This property isn’t enabled by default. 
For more information, see Properties 
installed with Project Management.

Due date The preliminary or estimated date when the 
planned work is expected to be completed. 
This date provides an expected completion 
window for planning and stakeholder 
communication. You can set this date 
anytime in the planning phase when a rough 
idea forms and can be updated until the 
demand is officially approved.

For example, you’re planning to complete the 
database upgrade by 2025-12-31.

Note: 
This date is changed to Planned end 
date  when the demand is converted to 
a project.

3. Select Create.
The created demand opens in the Playbook 

page.
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What to do next

• Review and refine the demand details and progress the demand using the playbook stages. 
For more information, see Use Playbooks.

• Review and refine the demand details using the forms and tabs in the Details  page. For more 
details, see Update the demand details.

Related topics

Use Playbooks

Update the demand details

Customize the demand new record form

You can customize the fields displayed on the demand new record form in Next Experience for 
Demand Management  by modifying the APW New view.

Before you begin
Role required: admin

About this task
By default, the demand new record form in Next Experience for Demand Management  displays a 
predefined set of fields. Modifying the APW New view allows you to add, remove, or reorder fields 
to meet your organization's requirements.

Procedure

1. Navigate to All  > Demands  > Demand  > All  > New.

2. Select Additional actions  and navigate to Configure  > Form 

Layout.

3. In the View name  field, select APW New.

4. Add, remove, or reorder fields as needed.

5. Select Save.

Result
The updated field layout is applied to the demand new record form for all users.
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Use Playbooks

Use a playbook to guide a demand through each stage of its life-cycle, from creating the initial 
brief to final approval and completion. Playbooks provide step-by-step activities within each 
stage, ensuring that all required information is captured and governance processes are followed.

Before you begin

• Role required: it_demand_user, it_demand_manager

• As an administrator, ensure that either the default or custom playbooks are activated.

About this task
A playbook defines the standard stages of a demand (for example, Initiation, Planning, 
Execution, Monitoring, and Closure) and includes activities or action items to complete at each 
stage.

Note: 
The playbook presents demand information in a guided, stage-based workflow. The same 
fields and lists are also available in the Details  page of the demand record. You can update 
demand information from either location, and changes made in one are reflected in the 
other.

This task topic follows the demand AI playbook. It’s a standard playbook comprising the following 
seven stages:

• Create demand brief

• Define demand alignment

• Estimate demand cost and effort

• AI checkpoint

• Confirm demand readiness for review

• Approve and finalize demand

• Complete demand

Note: 
The AI checkpoint stage is available if the AI Control Tower plugin is installed and the 
investment type of the demand is set to artificial intelligence.
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Each stage consists of activities, action items, or steps that guide the demand manager in 
successfully completing the demand. You can view the Playbook  menu only if the demand 
matches the trigger condition defined for that playbook.

Note: 
A demand created in Next Experience for Demand Management  opens in the playbook 
page.

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Demands.

2. Open an existing demand or create a demand.
For more information on creating demands, refer to Create a demand.

3. Use the default playbook or create or customize one.

◦ To use the default playbook:

a. Select Playbooks  from the L-2 (level 2) navigation menu.

b. Select a stage to view its activities. Each activity displays its status (In Progress, Pending, 
or Complete) and the fields or lists to update.

Note: 
The default playbook is a stage-gate playbook, that is, a stage is unlocked only when 
its prior stages are marked as completed or skipped.

c. Complete the activities within each stage. For more information, see Demand default 
playbook stages and activities.

d. For each activity, perform one of the following actions:

▪ Select Mark Complete  to mark the activity as done and move to the next activity.

▪ Select Save  to save your progress without completing the activity.

▪ Select Skip  to bypass the activity and move to the next one.

Note: 

▪ An activity becomes read-only when you select Mark Complete  or Skip.

▪ A stage is marked as completed once all activities within it are either completed or 
skipped.

▪ Use the Restart  option (available at both the activity and stage levels) to revisit or 
edit completed or skipped activities.

▪ Some stages include an automated task that advances the demand state when all 
activities in the stage are completed. These automated tasks don’t require manual 
action.

◦ To create a playbook, define the trigger condition in Workflow Studio. For more information, 
see Triggers .

For more information on how to create and use playbooks, see Building playbooks  and 
Designing playbooks .

Related topics

Running playbooks

Playbooks reference

Playbooks in Next Experience for Demand Management
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Create and customize playbooks

Demand default playbook stages and activities

Update the demand details

Update the details of a demand record in Next Experience for Demand Management  to reflect 
any changes in scope, priority, or capacity.

Before you begin
Role required: it_demand_user, it_demand_manager

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Demands.

2. Update the demand record details in any of the following ways.
For a description of the field values, see Demand form.

Related topics

Use Playbooks

Demand form

Demand default playbook stages and activities

Create and manage demand tasks

Create tasks for a demand to delegate cost, effort, risk, and benefit assessment activities. Assign 
a resource or group to the demand task to track the actual time and effort spent on performing 
the specified activities.

Before you begin
Role required: it_demand_manager

About this task
You create demand tasks to plan the work for demands rather than for the target work entity such 
as a project, change, defect, or enhancement. The resources assigned to a demand task can 
submit the time spent on it using a time card.

Note: 
If you’re creating a demand task with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and Demand Currency view enabled, 
additional fields are available. For more information about the fields that are available 
only in the Demand Currency view, see Multicurrency in Next Experience for Demand 
Management reference.

For more information about demand tasks, see Demand tasks.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.
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3. Select Demand 

Tasks.

Note: 
If the Demand Tasks  tab isn’t visible, select More  and then select Demand Tasks.

4. Add or edit a demand task from the Demand Tasks  tab:

◦ To add a demand task, select New.

◦ To update the details of an existing demand task, select the record.

5. On the Create New Demand Task form, fill in the fields.
For a description of the field names, see Create demand task form.

6. Select Save.

Note: 

◦ To delete a demand task, select the record and select Delete  from the More Actions 
option.

◦ Alternatively, you can create, edit, or delete demand tasks using the Add demand 
tasks  playbook activity. For more information, see Use Playbooks.

After completing your work on the demand task, use the breadcrumb navigation to return to 
the Demand Tasks  tab.

Note: 
Team members can access demand tasks assigned to them from Collaborative Work 
Management. For more information, see Managing SPM work in Collaborative Work 
Management.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create demand task form

Submit a time card for a demand task

The resources assigned to a demand task create and submit a time card or time sheet to record 
the time spent on a demand task. The reported hours are used to calculate the actual cost and 
effort for a demand task.

Before you begin
Role required: timecard_user
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About this task
The resource submits the time card or time sheet to record and track the work performed on 
a demand task. An appropriate approver then has to approve the submitted time card or time 
sheet.

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Create a time card.

3. Fill in the hours for each day spent working on the demand task.

4. Select Submit.

Add and manage stakeholders

Add and manage stakeholders for a demand to delegate assignments and progress the demand 
in its life cycle.

Before you begin
Role required: it_demand_manager

About this task
When a demand is submitted, the demand stakeholder list is populated automatically from the 
associated portfolio. You can also add stakeholders.

A demand can have multiple stakeholders and a stakeholder can be associated with multiple 
demands.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Stakeholders.

Note: 
If the Stakeholders  tab isn’t visible, select More  and then select Stakeholders.

4. Add or edit a stakeholder record:

◦ To add a stakeholder, select New.

◦ To update the details of an existing stakeholder, select the record.

5. On the Create New Demand Stakeholder form, fill in the fields.
For a description of the field names, see Create stakeholder form.

6. Select Save.
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Note: 

◦ To delete a stakeholder record, select the record and select Delete  from the More 
Actions option.

◦ Alternatively, you can create, edit, or delete stakeholder records using the Add 
stakeholders  playbook activity. For more information, see Use Playbooks.

After completing your work on the stakeholder record, use the breadcrumb navigation to return 
to the Stakeholders  tab.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create stakeholder form

Add and manage goal/target relationships

Track and manage the relationship between demands and organizational goals or targets 
directly from the Next Experience for Demand Management. Linking demands to goals or targets 
helps ensure alignment with strategic priorities and provides visibility into how each demand 
contributes to broader organizational objectives.

Before you begin
Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the Goal/Target Relationships 

tab.

Note: 
If the required Goal/Target Relationships  tab isn’t visible, select More  and then select 
the required Goal/Target Relationships  tab.

4. Add or edit a goal/target relationship record:

◦ To add a goal/target relationship record, select New.

◦ To update the details of an existing goal/target relationship record, select the record.

5. On the form, fill in the fields.
For field information, see Create goal/target relationship form.

6. Select Save.
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Note: 

◦ To remove a goal/target relationship record:

▪ Select a record from the Goal/Target Relationships  tab and select Remove.

▪ Select Remove  from the More Actions option in the goal/target relationship form.

◦ Alternatively, you can add, edit, or remove goal/target relationship records using the 
Add secondary goals  playbook activity. For more information, see Use Playbooks.

After completing your work on the goal/target relationship record, use the breadcrumb 
navigation to return to the Goal/Target Relationships  tab.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create goal/target relationship form

Add and manage requirements

Define and manage requirements for a demand to capture the functional and technical 
specifications needed for its fulfillment. Keeping requirements up to date within the demand 
record ensures clarity for stakeholders and reduces ambiguity during the demand evaluation and 
approval process.

Before you begin
Role required: it_demand_user, it_demand_manager

About this task
Typically, the stakeholders associated with a demand request have insights into what the 
requirements are for a demand request to be completed. The demand manager can create 
requirements from their inputs.

Demand managers use the Requirement form to describe the requirement and assign an owner 
who is responsible for making sure that the requirement is met. When a requirement is complex, 
demand managers can associate planned tasks, such as project tasks, with the requirement. The 
demand manager assigns and tracks the tasks until they’re complete.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select 

Requirements.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

230



Note: 
If the Requirements  tab isn’t visible, select More  and then select Requirements.

4. Add or edit a requirement record from the Requirements  tab:

◦ To add a requirement, select New.

◦ To update the details of an existing requirement record, select the record.

5. On the Create New Requirement form, fill in the fields.
For a description of the field names, see Create requirement form.

6. Select Save.

Note: 
To delete a requirement record, select the record and select Delete  from the More 
Actions option.

After completing your work on the requirement record, use the breadcrumb navigation to 
return to the Requirements  tab.

Add and manage RIDAC records

Add a Risk, Issue, Decision, Action, or Request Change (RIDAC) record to your demand in the 
Next Experience for Demand Management. Adding RIDAC records enables you to keep a track of 
risks or issues during the demand life cycle and help in analyzing the outcome of a demand.

Before you begin
Role required: it_demand_user, it_demand_manager

About this task
You can select the type of record you want to create, fill in the required details, and associate it to 
your demand. You can use the RIDAC page in Next Experience for Demand Management  to view, 
add, manage, and evaluate all the RIDAC records.

For information about RIDAC records for demand management, see RIDAC (Risk, Issue, Decision, 
Action, and Request Changes) records for a demand.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the required RIDAC tab.

Note: 
If the required RIDAC tab isn’t visible, select More  and then select the required RIDAC 
tab.

4. Add or edit a RIDAC record from the required RIDAC tab:

◦ To add a RIDAC record, select New.

◦ To update the details of an existing RIDAC record, select the record.

5. On the form, fill in the fields.
For field information, see:
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◦ Create risk form

◦ Create issue form

◦ Create action form

◦ Create decision form

◦ Create request change form

6. Select Save.

Note: 
To delete a RIDAC record, select Delete  from the More Actions option in the RIDAC record 
form.

After completing your work on the RIDAC record, use the breadcrumb navigation to return to 
the required RIDAC tab.

Submit a demand

Submit the demand record once the necessary details are provided for a demand.

Before you begin
Role required: it_demand_manager, it_demand_user

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Submit 

demand.

Note: 
The submit option is available only when the demand is in the Draft state.

The demand moves to the Submitted state.

Manage assessment instances and questions

Add and manage assessment instances and questions for a demand to evaluate its feasibility 
and gather structured feedback from relevant stakeholders.
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Before you begin
Role required: admin

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Assessment 

Instances.

Note: 
If the Assessment Instances  tab isn’t visible, select More  and then select Assessment 
Instances.

4. Add or edit an assessment instance record:

◦ To add an assessment instance record, select New.

◦ To update the details of an assessment instance record, select the record.

5. On the assessment instance form, fill in the fields.
For a description of the field names, see Assessment instance form  form.

6. Select Save.

7. Select Assessment Instance Questions.

8. To add a question, select New.

9. On the Create New Assessment Instance Question form, fill in the fields.
For a description of the field names, see Create assessment instance question form.

10. Select Save.

Note: 
To delete an assessment instance record, select the record and select Delete  from the 
More Actions option.

After completing your work on the assessment instance question and record, use the 
breadcrumb navigation to return to the Assessment Instances  tab.

Create and manage resource assignments

Create and manage resource assignments for a demand to find the availability of the resources 
and allocate them to the demand tasks. Effective resource assignment ensures that demands 
are adequately staffed and helps demand managers track resource availability and utilization.

Before you begin
Role required: it_demand_manager
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Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Resource 

Assignments.

Note: 
If the Resource Assignments  tab isn’t visible, select More  and then select Resource 
Assignments.

4. Add or edit a resource assignment record:

◦ To add a resource assignment record, select New.

◦ To update the details of an existing resource assignment record, select the record.

5. On the Create New Resource assignment form, fill in the fields.
For a description of the field names, see Create resource assignment form.

6. Select Save.

Note: 

◦ To delete a resource assignment record, select the record and select Delete  from the 
More Actions option.

◦ Alternatively, you can create, edit, or delete resource assignment records using the 
Estimate resource requirements  playbook activity. For more information, see Use 
Playbooks.

After completing your work on the resource assignment record, use the breadcrumb navigation 
to return to the Resource Assignments  tab.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create resource assignment form

Recalculate costs of resource assignments of a demand

Recalculate the costs of all active resource assignments of a demand whenever the hourly rates 
change in the associated rate model. This feature helps keep the plan costs are up to date.

Before you begin

• The demand must be active.

• The demand must have an active rate model assigned.
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Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the Resource assignments  tab.

Note: 
If the required Resource assignments  tab isn’t visible, select More  and then select the 
required Resource assignments  tab.

4. Select the resource assignment record that you want to recalculate the costs for.

5. Select the More Actions option and select Recalculate Resource 

Cost.

6. On the Recalculate Resource Cost form, fill in the fields.

Field Description

Start date Start date of the time period for which the 
costs are recalculated.

By default, the field shows the current date.

End date End date of the time period for which the 
costs are recalculated.

By default, the field shows the due date of the 
demand. If the due date isn’t specified for the 
demand, the field is empty.

7. Select OK.

Note: 
Alternatively, you can recalculate the resource costs using the Estimate resource 
requirements  playbook activity. For more information, see Use Playbooks.
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Result

• Recalculates the selected resource costs of all the applicable resource assignments in the 
demand based on the latest hourly rates. The hourly rates are derived from the rate model 
associated with the demand.

• Updates the recalculated resource costs on the respective cost fields on the resource 
assignment form and the Resource assignments  tab.

• Reflects the revised values in the respective cost fields of the demand.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create resource assignment form

Realign resource assignments for demands

Planning and execution of your roadmap involves change in priority or timelines of your work. In 
such cases, you can adjust the resource assignment dates to match with the latest dates of your 
demands.

Before you begin
Migrate resource plans to resource assignments

Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Change the Approved start date  and Planned start date  to meet your organizational priorities.

4. Select Save.

5. Select the More Actions option and select Realign assignments to demand.

Result
In the Resource assignments tab, you can see the Start date of the resource assignments 
aligned with the demand start dates.

View assessment results

View assessment results for a demand to evaluate its feasibility, priority, and alignment with 
organizational objectives. Assessment results provide demand managers with the insights 
needed to make informed decisions on whether to approve, defer, or reject a demand.

Before you begin
Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Assessment Results.
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Note: 
If the Assessment Results  tab isn’t visible, select More  and then select Assessment 
Results.

4. Select an assessment result record to view the details.

Approve demands

Review and approve demands in Next Experience for Demand Management  to move them 
forward in the demand life cycle.

Before you begin
Role required: demand_approver, it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.

Note: 
Users with the demand_approver role only see demands that are in the Qualified state.

For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select 

Approve.

Note: 
The Approve  option is available only when a demand is in the Qualified state.

Create an entity from a demand

Create an entity, such as a work item, from a demand so that you can track work on the demand.

Before you begin
A demand must have been created. For more information, see Create a demand.

The category and type of a demand and the applications you have installed determine the entity 
you can create from it. The available entity types and the applications you must have installed to 
be able to create them are listed in the following table.
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Entity Required application

Enhancement, change, or defect Project Portfolio Suite

Agile Development  entities (story or epic) Agile Development 2.0

Enterprise Agile Planning  (EAP) entities (epic, 
feature, or capability)

Strategic Planning

Role required: it_demand_manager

Note: 
The sn_apw_advanced.eap_user role is required to convert a demand to EAP  entities.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Verify that the values in the Category  and Type  fields are appropriate for the entity you want to 
create.
The options in the Type list change according to the category that you select. For more 
information, see Demand form.

Note: 
The Category  and Type  fields are set to read only when an entity is created from a 
demand. If you delete the created entity, these fields become editable again.

3. Select Save.

4. Create the entity by selecting the appropriate option from the More Actions 

option.
Depending on the category and type of the demand, options related to the entity you can 
create become available.
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Related topics

Use Playbooks

Demand default playbook stages and activities

Reset a demand to draft state

Move a demand back to the Draft state, if necessary.

Before you begin
Role required: it_demand_manager

About this task
A demand can be reset to Draft from the Completed, Approved, Screening, or Submitted states, 
or until an entity such as a project is created from it. The Reset to Draft  option is unavailable if 
the demand is in the Qualified state.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Reset to 

Draft.
A confirmation message appears, if there are:

◦ Active assessments pending with stakeholders, or

◦ Resource assignments are created for the demand

4. Select the check box to replan the allocated resource plans that have no actual hours 
reported.

5. Select OK.
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Result

• The demand is moved to the Draft state.

• All the score values in Assessment Data  tab are reset to default.

• All active assessments for the demand are canceled. New assessments are triggered when the 
demand moves to the Screening state and if the Assessment Required  field on the demand 
form is set to true.

Defer demands

Defer demands in Next Experience for Demand Management  to move them to the backlog. You 
can review them and move them back to any other demand state.

Before you begin
Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select 

Defer.

Note: 
You can defer the demands that are not in the Draft or Completed states.

Delete demands

Delete demands to remove them from Next Experience for Demand Management. Demands can 
be deleted only while in the Pending state.

Before you begin
Role required: it_demand_manager, it_demand_user

About this task
When you delete a demand, all data related to the demand, such as risks, demand tasks, 
requirements, and decisions are deleted. However, the stakeholders aren’t deleted from the 
Stakeholder Register [dmn_stakeholders_register] table.

If a project is already created from a demand, its reference is removed from the project along 
with the data related to the demand. However, the project isn’t deleted from the database.
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Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Delete  from the More Actions 

option.

4. Select OK  to delete the demand.

Export demands

Export demand records from the Next Experience for Demand Management  to share data with 
stakeholders or perform further analysis outside the platform.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  > Demands.

2. Select the demands that you want to export.
You can export all demands on the record page by selecting the check box in the column 
header.

3. Select Export.

4. Select the File Type  as Excel, CSV, JSON, or PDF.
The export file is created in the selected format.
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5. Select the Delivery Type  as Download or 

Email.

6. Provide your preferred email address if you selected Email as the delivery type.

7. Select Export.
The export file is downloaded on your system or mailed to your provided email addressed.

Create AI systems

Create AI systems from directly within the demand workflow and associate them with your 
demands.

Before you begin

• The AI Control Tower  plugin must be installed. For more information, see Activation and 
installation of AI Control Tower .

• The investment type of the demand is set to artificial intelligence.

• Role required: sn_ai_steward

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select a demand record from the All Demands  list.

3. Select Details  from the L-2 (level 2) navigation menu.

4. Select the Create AI System  button to create an AI system in the AI Control Tower  workspace.
For more information on creating AI systems, see Create AI system assets .

What to do next
Associate your demands with the created AI systems:

• Using the AI checkpoint stage in your demand AI playbook. For more information, see Use 
Playbooks.

• Using the AI Associations  section in the Details  tab.
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Managing financials for demands

Manage budget, cost plans as forecasts, actual expenses as expense lines, generate labor 
costs, and create financial baselines at a required cadence in Next Experience for Demand 
Management.

The following features help you to manage your financials.

• Manage cost plans for your demands. For more information, see Add, edit, or delete demand 
cost plans.

• Add or edit expense lines for your demands to record any planned or unplanned expenses. 
For more information, see Add or edit expense lines.

• Generate labor costs for the fiscal period. For more information, see Generate labor costs.

• Create baselines to capture the financial snapshot of your demands. For more information, see 
Create financial baselines.

Multicurrency

The multicurrency feature enables you to manage the financials of your demands in two different 
currencies, Functional currency and Demand currency. Functional currency is typically defined 
by the admin based as the primary currency, which is used for planning, budgeting, and tracking 
the financials of your planning items.

You can perform the following financial activities in Demand currency.

• Select the Demand currency.

• Track the planned and actual expenses.

• Allocate and manage the budget.

• View simple financials data.

Using this feature, you can work on financial reporting at a global level and see the real-time 
currency conversions of your financial records.

Organizations operate at a global or multinational level, the work is planned and financed at one 
location and executed at a different location. Each might use a different currency from what was 
used in the planning phase. Multicurrency makes it easy to manage and track your planning 
items using any currency.

You can monitor and track the financials in one currency, and capture the costs in a different 
currency. For more information, see Multicurrency in Next Experience for Demand Management.

Note: 
Once a cost plan, benefit plan or expense line or an investment budget gets created, you 
can't change the Demand currency. You can change the Demand currency as long as there 
are no financial records captured against the demand.

Baselines

Create a baseline to capture a snapshot of the financial changes for your demands. You can 
create on-demand baselines or at a cadence using a scheduler job. For more information, see 
Create financial baselines.
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Budget allocation

Portfolio managers can manage and approve the budget for demands. The approved budget 
helps demand managers to plan and meet the expenses to execute work. For more information, 
see Allocate budget to a demand.

Benefit plans

Monetary benefit plans capture potential benefits accrued while executing a demand. Non-
monetary benefit plans capture the potential non-financial benefits accrued while executing a 
demand. You can create and manage monetary and non-monetary benefit plans and to capture 
the potential benefits of your planning items. For more information, see Create and manage 
benefit plans.

Add, edit, or delete demand cost plans

Create a cost plan for a required duration to track your planned and actual expenses. Edit cost 
plans to adjust your planned expenses and delete any descoped forecasts.

Before you begin
Role required: it_demand_manager

About this task
The application automatically creates cost plan breakdown records when you save the cost 
plan. The cost plan breakdowns are records that specify the estimated and actual costs and 
the budget at a granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The 
demand cost plans are added to the parent program and portfolio.

If you want to use multiple currencies, create a cost plan for another currency.

If you’re creating a cost plan for a demand with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and Demand Currency view enabled, the fields in 
the Financials  section differ from the Default view. For more information about the fields that are 
available only in the Demand Currency view, see Multicurrency in Next Experience for Demand 
Management reference.

Note: 
For projects, the cost plan breakdowns specify the estimated cost and actual cost at 
a granular level for a fiscal period of the demand cost plan. These breakdowns are 
recalculated in the project currency. Similarly, the estimated breakdown amounts of the 
planned benefit and actual benefit of the demand benefit plans are recalculated in the 
project currency. The project currency amounts are then rolled up to the cost plan, benefit 
plan, and the project records.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Cost Plans.

Note: 
If the Cost Plans  tab isn’t visible, select More  and then select Cost Plans.
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Tip: 
Create financial baselines  immediately after capturing the initial planned costs to have 
a snapshot of your planned costs. Use this baseline to compare it against the baselines 
from later dates, as the work progresses, to identify the variance between initial planned 
costs and actual expenses.

This step helps you to plan for the future expenses and reforecast the planned costs.

Alternatively, you can create, edit, or delete cost plans and cost plan breakdowns using the 
Estimate financial cost  playbook activity. For more information, see Use Playbooks.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create cost plan form

Create cost plan breakdown form

Create and manage benefit plans

Create a monetary or non-monetary benefit plan to specify the estimated monetary or non-
monetary benefit in a category for a fiscal period. Demand benefit plans capture the potential 
benefits accrued by the demand when the demand is executed.

Before you begin
Role required: it_demand_manager

About this task
The monetary benefit plan breakdown records are automatically created when you save the 
benefit plan. The monetary benefit plan breakdown records specify the estimated and actual 
benefits at a granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The 
Monetary Benefit Plan Breakdowns  tab shows the aggregated benefits for estimated and actual 
benefits for each fiscal period for the demand.

The non-monetary benefit plan breakdown records are automatically created when you save the 
benefit plan by selecting Automatic  or Manual  in the Breakdown Type  field. The non-monetary 
benefit plan breakdown records specify the estimated and actual non-financial benefits at a 
granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The Non-monetary 
Benefit Plan Breakdowns  tab shows the aggregated benefits for estimated and actual non-
financial benefits for each fiscal period of the demand.

Note: 
Converting a demand to a project or EAP  entity transfers the benefit plan from the demand 
to the target project or EAP  entity.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Add, edit, or delete a benefit plan.
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Related topics

Use Playbooks

Demand default playbook stages and activities

Monetary benefit plan form

Non-monetary benefit plan form

Monetary benefit breakdown form

Non-monetary benefit plan breakdown form

Associate monetary and non-monetary benefit plans

Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the demand.

Before you begin
Role required: it_demand_manager

About this task
You can associate a monetary benefit plan with a non-monetary benefit plan and vice versa.

Note: 
When you delete a benefit plan, its relationship with the associated benefit plan (if any) is 
also removed.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the Monetary Benefit Plans  or Non-monetary Benefit Plans  tab.

Note: 
If the Monetary Benefit Plans  or Non-monetary Benefit Plans  tabs aren't visible, select 
More  and then select the Monetary Benefit Plans  or Non-monetary Benefit Plans  tab.

4. Select the benefit plan that you want to associate.

5. On the Benefit Plan form, fill in the Associated benefit  field with the benefit plan that you want 
to associate.

6. Select Save.
The selected benefit plan is associated with this benefit plan.

Note: 
Alternatively, you can associate benefit plans with each other from the Benefit estimate 
playbook activity. For more information, see Use Playbooks.
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Related topics

Use Playbooks

Demand default playbook stages and activities

Create and manage benefit plans

Monetary benefit plan form

Non-monetary benefit plan form

Create financial baselines

Create a financial baseline of a demand, which captures benefit and financial metric information 
(snapshot of cost plan, benefit plan, and demand-level financial metrics) at a particular moment 
in time.

Before you begin
Role required: it_demand_manager

About this task
You can create as many financial baselines as necessary and review the financials changes 
that have been made to the demand since the previous baseline. Any financial baseline doesn’t 
capture the actual cost component of the demand.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. To create a financial baseline of a demand, use either of the options.

4. On the Create New Demand Baseline form, fill in the fields.

Demand form

Field Description

Name Name of the demand baseline.

Demand Demand to which the baseline belongs.

Description Description of the demand baseline.

5. Select Save.

Note: 
To delete a demand baseline, select the record and select Delete  from the More Actions 
option.

After completing your work on the demand baseline, use the breadcrumb navigation to return 
to the Demand Baselines  tab.

Allocate budget to a demand

Set the capital expense (Capex) and operating expense (Opex) budgets in demand or functional 
currency according to the fiscal years. The sum of the Capex and Opex budgets is calculated as 
the total budget in demand currency.
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Before you begin
Role required: portfolio_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Demand Budget.

Note: 
If the Demand Budget  tab isn’t visible, select More  and then select Demand Budget.

4. Add or edit a demand budget record:

◦ To add a demand budget record, select New.

◦ To update the details of a demand budget record, select the record.

5. On the Create New Project Funding form, fill in the fields.

Tip: 
You can work on allocating lean budgets at the fiscal period level using the Investment 
Budget. For more information, see Enable lean budgeting for demands.

For a description of the field names, see Create project funding form.

6. Select Save.

Note: 

◦ To delete a demand budget record:

▪ Select a demand budget record from the Demand Budget  tab and select Delete.

▪ Select Delete  from the More Actions option in the project funding record form.

◦ If the demand doesn’t have a cost plan, start date, and due date, then demand budget 
is distributed from the current month until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan, start date, and due date, then demand budget 
is distributed from the current month until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan and a due date but has a start date, then the 
demand budget is distributed from either:

▪ Start date (if the start date falls in the given budget fiscal year) until the end of the 
demand budget fiscal year.

▪ Start of the demand budget fiscal year until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan and a start date but has a due date, then the 
demand budget is distributed from either:

▪ Current month until due date (if the due date falls in the given budget fiscal year).

▪ Current month until the end of demand budget fiscal year.

◦ If the demand has a cost plan associated, then demand budget is distributed by 
honoring the cost plan fiscal periods.

After completing your work on the demand budget record, use the breadcrumb navigation to 
return to the Demand Budget  tab.
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Result
The demand budget for the selected year appears in the Demand Budget  tab. You can select the 
amounts in the list to revise them.

Enable lean budgeting for demands

Enable the Investment Budget option to allocate budgeting for demands at a fiscal period level.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Demands  > Demand  > All.

2. Open the required demand.

3. Select the Additional actions and navigate to View  > APW Default.
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4. Select the Additional actions and navigate to Configure  > Related 

Lists.

5. Select Investment Budget  from the Available column and add it to Selected column.

6. Select Save.

Manage lean budgeting for demand

Allocate budget for demands at each fiscal period instead of the entire fiscal year to reduce the 
overhead costs associated with traditional approach.

Before you begin

• Lean budgeting is enabled. For more information, see Enable lean budgeting for demands.

• Role required: sn_invst_pln.sn_spm_funding_user

Any user role with this specific role attached can add or manage the investment budgets.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Investment Budget.
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Note: 
If the Investment Budget  tab isn’t visible, select More  and then select Investment 
Budget.

4. Add or edit an investment budget record:

◦ To add an investment budget record, select New.

◦ To update the details of an investment budget record, select the record.

5. On the Create New Investment Budget form, fill in the fields.

Investment Budget form details

Field Description

Amount Investment budget amount.

Fiscal period Fiscal period to allocate the budget.

Investment Planning item to allocate this budget to.

Note: 
The current demand is selected by 
default.

Expense type Type of the expense.

◦ Capex  - Budget for capital expenses.

◦ Opex  - Budget for operational expenses.

6. Select Save.

Note: 
To delete an investment budget record:

◦ Select a demand budget record from the Investment Budget  tab and select Delete.

◦ Select Delete  from the More Actions option in the investment budget record form.

After completing your work on the demand budget record, use the breadcrumb navigation to 
return to the Investment Budget  tab.

Add or edit expense lines

Create an expense line to capture the cost associated with a specific source, such as a user or a 
fixed asset. Expense lines are part of demand cost plans.

Before you begin
Role required: it_demand_manager

About this task
Expense lines on a demand record track the costs incurred during the demand evaluation 
process. You can add multiple expense lines to a single demand, but they can only be used for 
evaluation costs and can’t be linked to cost plans. Only processed expense lines are counted, 
and their total automatically rolls up to the Demand actual costs  field on the demand record.

Note: 
When a demand is converted to a project, the expense lines remain with the demand, while 
the cost plans and budget are moved over to the project.
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Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Expense Lines.

Note: 
If the Expense Lines  tab isn’t visible, select More  and then select Expense Lines.

4. Add or edit an expense line:

◦ To add an expense line, select New.

◦ To update the details of an existing expense line, select the record.

5. On the Create New Expense Line form, fill in the fields.
For a description of the field names, see Create expense line form.

6. Select Save.

Note: 
To view the expense allocations associated with the expense line, select Expense 
Allocations.

After completing your work on an expense line, use the breadcrumb navigation to return to the 
Expense Lines  tab.

Generate labor costs

Generate labor costs to view the expenses of resources using resource assignments and cost 
plans.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the Generate labor costs for demands and projects  scheduled job.

3. Select Active.

4. On the Scheduled Script Execution form, fill the fields.
For a description of the field names, see Scheduled Script Execution Form.

5. Select Update.

Tip: 
Alternatively, as an admin, you can activate and define a scheduled job to generate labor 
costs at the required frequency. For more information, see Activate a scheduled job to 
generate labor costs.

Docs for demands in Next Experience for Demand Management

Store and manage documentation for demands from a centralized location in Next Experience for 
Demand Management.
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Docs overview

Demand managers can store information for demands using the Docs feature.

• Each demand can have a separate doc page to capture related information. For example, 
create a doc page for business objectives or technical requirements.

• Each demand can have multiple doc pages to help you effectively organize key artifacts.

• Predefined templates such as Project Brief, Product Requirements, Brainstorming Ideas, and 
Meeting Notes are available. Create doc pages using one of these templates or start with an 
empty page.

Features of Docs

The following are the key features of Docs:

• Auto-save content.

• See who is viewing or working on a doc page using the feature of live user presence.

• Create documents using pre-defined templates.

• Use rich text paragraph formatting, which includes headings, lists, alignment, and others.

• Move text blocks to change their placement using block-level editing.

• Tag team members inline or insert tables using the /  command.

• Add reference to other ServiceNow AI Platform  tables to connect work across teams.

• Insert images by uploading files or using web URLs.

Note: 
The experience of inserting Google  Images links might not work.

Real-time collaboration in Docs

With the feature of real-time collaboration, edit a doc page concurrently with multiple other 
editors. Colored cursors denote the current location of each editor on the page. You can choose 
to show or hide these live presence indicators based on your preference while working on or 
reviewing the content of the page.
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Note: 
A huge number of users editing the same block of content simultaneously might result in 
issues with application performance.

Dynamic data linking in Docs

Keep record information in your documentation always current and reduce manual effort with the 
Dynamic data linking feature in Docs. You can now reference any ServiceNow  application record 
and Docs will automatically reflect the latest updates from those records.

For example, if you add a reference to a Project record, the reference shows the latest field 
information of the project in Docs without requiring manual edits. Selecting the project reference 
opens up the project form so that you can view the full details of the project and make any 
necessary changes.

A hover popover displays the details of the mentioned record, providing quick access to 
additional information without leaving the current context.
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Dynamic linking also enables adding references to a particular field of a record, such as 
Assigned to of a Project record.

You can add references from any ServiceNow  table you have access to, with no setup or 
configuration needed.

This feature reduces the need to switch between multiple ServiceNow  applications within your 
instance and helps maintain a single, reliable source of truth for collaborative work, making it 
easier for teams to stay aligned and informed.

Images in Docs

Insert images into your Docs by uploading a file from your device or adding a web URL. Note that 
inserting Google  Images links might not work.

Save images from your CWM documents directly to your device, making it easier to share or use 

them outside of the Docs environment. Click an image to access the download icon ( ), then 
click the icon to save it to your device. Alternatively, right-click the image and use your browser's 
built-in save option.
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Create and manage pages and subpages for demands

Flexibly organize information for your planning items by creating, duplicating, and deleting pages 
and subpages in Next Experience for Demand Management.

Before you begin
Role required:

• Create and manage pages and subpages - it_demand_user, it_demand_manager, 
demand_approver

• Read pages and subpages - apw_read, ppm_read

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Docs  from the L-2 (level 2) navigation menu.

3. Create or manage docs in any of the following ways.

Next Experience for Demand Management  reference

Reference information to provide additional details about Next Experience for Demand 
Management  such as the fields, user roles, tables, and multicurrency.

Actual cost and effort calculation for a demand and demand task

Actual cost and effort represent the realized cost and time spent working on demands and 
demand tasks during a specific time period. These values are calculated based on approved 
time cards and hourly rates for resources.

Overview of calculation

Working on demands and demand tasks involves cost and time that add to the overall 
expenditure of converting a demand to a product, feature, or enhancement. Demand managers 
must track the actual cost and effort incurred in assessment and planning activities.
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• The actual cost is calculated by multiplying the hours reported in the time card by the hourly 
rate of the resource.

• The actual effort for a demand task is calculated based on the hours reported in the time card.

• The actual effort and cost for demand tasks roll up to calculate the actual effort and cost for the 
demand.

Hourly rate calculation

The hourly rate for calculating actual cost is derived in the following order:

1. If a rate model is associated with the demand, the actual cost is calculated based on the hourly 
rate defined in the rate model.

2. If a rate model is absent or if an hourly rate isn’t found in the rate model, the hourly rate is 
derived from the default labor rate.

3. If an hourly rate isn’t found in the default labor rate, the hourly rate is derived from the default 
system property.

Resource assignments and Time cards

Don’t create resource assignments for allocating resources or groups to a demand task. 
Resource assignments created in the demand are used for resource estimation of the work entity 
created from the demand. These resource assignments automatically move to the resulting work 
entity when a demand is qualified and converted.

When you submit a time card for a demand, the actual effort and cost aren’t reflected in the 
resource assignment. Resource assignments aren't associated with the demand by default. 
The actual cost and actual effort remain with the demand and aren't transferred to the created 
projects, even if you manually associate a resource assignment.

If a resource spends extra hours working on a demand that aren’t associated with demand tasks, 
this time must also be recorded. The resource submits the time card for recording extra hours 
using the Time Sheet Portal. This extra cost and effort is added to the demand but isn’t reflected 
in the actual cost and effort for the demand tasks.

Demand-level calculations

The actual cost and actual effort for the demand are calculated as follows:

• Demand Actual Cost = actual cost of all demand tasks + actual cost of extra activities

• Demand Actual Effort = actual effort of all demand tasks + actual effort of extra activities

If a demand has no task or assigned resource, you can capture the actual cost by submitting a 
time card against the demand. Once the time card is approved, an expense line is created on the 
demand. The expense line is processed and the actual cost of work for that time card rolls up to 
the demand in the Demand Actual Cost column.

This example demonstrates actual cost and effort calculation for demand tasks and rollup to the 
demand.

Scenario setup - For demand D1, the demand manager creates three demand tasks (DT1, DT2, 
and DT3) and assigns resources R1, R2, and R3 to each task respectively.
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Hourly resource rates

Resource
Hourly rate in the rate 
model

Hourly rate in the 
default labor rate

Hourly rate in the 
system property

R1 $200 $150 $50

R2 $250 $200 $50

R3 $150 $100 $50

Each resource spends eight hours on the assigned demand task and submits a time card.

Scenario 1: Rate derived from the rate model

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 200 * 8 = $1600 250 * 8 = $2000 150 * 8 = $1200

Demand rollup:

• Demand Actual Cost = $4,800

• Demand Actual Effort = 24 hours

Rate derived from default labor rate
(Rate model not associated with demand.)

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 150 * 8 = $1200 200 * 8 = $1600 100 * 8 = $800

Demand rollup:

• Demand Actual Cost = $3,600

• Demand Actual Effort = 24 hours

Rate derived from default system property
(Rate model not associated with demand and hourly rate not found in default 
labor rate.)

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 50 * 8 = $400 50 * 8 = $400 50 * 8 = $400

Demand rollup:

• Demand Actual Cost = $1,200

• Demand Actual Effort = 24 hours
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Data migrated from demands to created entities

Data fields that are migrated from a demand to an entity when the selected entity is created from 
the demand.

Data migrated from a demand to a created project

Data fields are migrated from a demand to a project when the project is created from the 
demand.

Field type Description

Demand The following demand fields are migrated to a 
project:

• Description

• Business case

• Investment Class

• Investment Type

• Risk of performing

• Risk of not performing

• Enablers

• Barriers

• In scope

• Out of scope

• Assumptions

• Business Unit

• Department

• Impacted Business Units

• Business Capabilities

• Priority

• Impact

• Rate Model

• Approved start date

• Approved end date

• Short description

• Program

• Domain

• Goals

• Strategies

• Impacted Business Applications

• Configuration item

• Company

• Urgency

• Project Manager
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Field type Description

• Project currency

• Project calculation

Resource assignments Resource assignments are migrated to a 
project by updating the task reference from 
the demand to project.

Requirements Demand requirements.

Financial records Financial records such as cost plans and 
breakdowns, benefit plans and breakdowns 
(monetary and non-monetary), and demand 
budgets are migrated to a project. This 
process updates the task reference from 
demand to project.

RIDAC RIDAC entities are migrated to a project by 
updating the task reference from demand to 
project. The migrated entities include the risks, 
issues, decisions, project actions, request 
changes, and RIDAC_m2m records.

Assessment The following assessment data fields are 
migrated to a project:

• Risk

• Value

• Score

• T-Shirt size

Stakeholders Stakeholder records.

Project Currency Financial If the multicurrency feature is active, the 
project financial fields are calculated 
according to the project currency and 
reference rate.

Data migrated from demands to Enterprise Agile Planning  (EAP) entities

Data fields are migrated from a demand to an EAP  entity when the entity is created from the 
demand.

Data fields migrated from demand to EAP entity

Field type Description

Demand The following demand fields are migrated to 
the created entity:

• Business Capabilities

• Product

• Primary target

• Team

• Demand manager
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Data fields migrated from demand to EAP entity  (continued)

Field type Description

• Description

• Department

• Priority

• Approved start date

• Approved end date

• Short description

• Primary goal

• Strategic program

• Service offering

• Business service

• Business applications

• Score

• Requested by

• Capital expense

• Operating expense

• Start date

• Program

• Total planned cost

• Investment Class

• Portfolio

• Investment Type

• ROI %

• Rate Model

• Model ID

• Expense type

• Financial benefit

Resource assignments The resource assignments of a demand are 
migrated to the created entity.

Financial records Cost plans and breakdowns, benefit plans and 
breakdowns (monetary and non-monetary), 
and investment budgets are migrated to the 
created entity.

Attachments Demand attachments.

Goal/target relationships Goal/target relationships of the demand.
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Demands list view

The All Demands  home page displays demands in a list view and contains specific UI 
components to create, edit, and export demands.

Actions

The actions available on the home page are listed in this 

table.

All Demands UI

Feature Description

Search Option to search for demands by name.

Filter Option to apply filters on the list. The filter preferences that you 
choose are retained in the filter criteria.

Sort by Option to sort the demand list in ascending or descending order 
based on a selected field.

Group by Option to group the demands by a selected field, such as state 
or stage, for better organization and visibility.

Refresh Option to reload the list.

New Option to create a demand.

Edit Option to edit the selected demands.

Assign to me Option to assign the selected demand to the logged-in user.

Export Option to export the demand list to an external file format such 
as Excel or CSV.

More Actions Option to see more features available in the All Demands  list.

Personalize fields Option to customize the columns displayed in the demand list to 
show only the fields relevant to you.

Data grid

The data grid shows the list of demands in rows, and the following options to perform actions on 
the rows.
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Option Description

Column actions
Group the demands by a column field using 
the action on the header. Point your mouse 
device to a column header to see the context 

menu icon ( ).

Rearrange columns
Enables the dragging of the columns to a 
position of your choice on the grid.

Select row ( ) Choose to select multiple demand rows at 
once.

Cell actions
Show matching or filter out demands by 

selecting the cell context menu ( ) or select 
and hold (or right-click) a cell.

Demand default playbook stages and activities

The default demand playbook includes certain predefined stages and activities. These activities 
guide you through the demand life-cycle, from capturing the initial brief to completing the 
demand.

Create demand brief

In this stage, capture the foundational information for the demand including the business 
justification, risks, and assumptions.
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Create demand brief stage details

Activity Type Description

Define demand details Form Enter the demand name, 
description, and business 
case. For more information, 
see Demand form.

Document risks and 
assumptions

Form Document the risk of not 
performing the demand and 
any assumptions. For more 
information, see Demand 
form.

The demand state will be 
moved to submitted

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

Define demand alignment

In this stage, align the demand with organizational goals, stakeholders, and team members.

Define demand alignment stage details

Activity Type Description

Define business alignment Form Define the business 
classification for the demand. 
For more information, see 
Demand form.

Define strategic alignment Form Define how the demand 
aligns with the organization's 
strategic objectives. For more 
information, see Demand 
form.

Add secondary goals Related list Associate secondary goals 
and targets with the demand.

• You can also add a goal or 
target relationship.

• You can view the details of 
an entry by selecting it from 
the list.

For more information, see 
Demand form.

Update demand dates Form Specify or update the planned 
dates for the demand. 
For more information, see 
Demand form.

Add collaborators Form Add collaborators to the 
demand and indicate whether 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

264



Define demand alignment stage details  (continued)

Activity Type Description

an assessment is required. 
For more information, see 
Demand form.

Add stakeholders Related list Add stakeholders associated 
with the demand.

You can view the details of an 
entry by selecting it from the 
list. For more information, see 
Create stakeholder form.

Add demand tasks Related list Create demand tasks to break 
down initial planning activities. 
For more information, see 
Create demand task form.

Update EAP  details Form Update the Team  field for the 
Enterprise Agile Planning 
(EAP) entity, to which the 
demand is converted.

Note: 
This activity is available if 
the Type  field is an EAP 
entity.

The demand state will be 
moved to screening

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

Estimate demand cost and effort

In this stage, evaluate the financial and resource requirements for the demand.

Estimate demand cost and effort stage details

Activity Type Description

Update assessment details Form Update the assessment 
information for the demand. 
For more information, see 
Demand form.

Estimate financial cost Related list View and manage cost plans 
associated with the demand.

• You can add a cost plan or 
delete an existing one.

• You can view the details of 
an entry by selecting it from 
the list.
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Estimate demand cost and effort stage details  (continued)

Activity Type Description

For more information, see 
Create cost plan form.

Estimate resource 
requirements

Related list View and manage resource 
assignments for the demand.

You can view the details of an 
entry by selecting it from the 
list.

For more information, see 
Create resource assignment 
form.

Define benefit estimates Related list View and manage benefit 
plans for the demand.

• You can add a benefit plan 
or delete an existing one.

• You can view the details of 
an entry by selecting it from 
the list.

For more information, see 
Monetary benefit plan form 
and Non-monetary benefit 
plan form.

Cost estimates Form Review or update the cost 
estimate details for the 
demand.

The demand state will be 
moved to qualified

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

AI checkpoint

In this stage, associate AI systems with the demand to identify potential AI impacts.

Note: 
If the AI Control Tower plugin is installed and the investment type of the demand is set to 
artificial intelligence, the AI checkpoint stage is available for playbooks.

AI checkpoint stage details

Activity Type Description

Associate AI systems Form Add AI systems to the demand 
by selecting from the existing 
systems. To link existing 
systems, use the Product  and 
Impacted AI systems  fields.
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Confirm demand readiness for review

In this stage, verify that the demand is complete and ready for approval.

Confirm demand readiness for review stage details

Activity Type Description

Align demand and assign 
portfolio/program

Form Review the demand details 
and confirm readiness for the 
approval process.

The demand state will be 
moved to approved

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

Approve and finalize demand

In this stage, confirm the demand details and convert the demand to a work entity.

Approve and finalize demand stage details

Activity Type Description

Confirm details and convert to 
selected entity

Form Review the selected work 
entity type, such as project 
or enhancement, and the 
approved timeline.

Complete demand

This stage is the final stage of the demand workflow.

Complete demand stage details

Activity Type Description

Review the converted entity Form Review the work entity created 
from the demand to verify that 
the conversion is complete.

Related topics

Playbooks in Next Experience for Demand Management

Create and customize playbooks

Use Playbooks

Demand tasks

A demand task is a unit of work created within a demand to break down initial planning activities 
before converting the demand into an entity.

Demand tasks overview

You can create a demand task from the Demand Tasks  related list to delegate activities that help 
assess demand feasibility.
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Demand tasks differ from project tasks in the following ways:

• Planned dates, actual dates, and original dates aren’t supported in demand tasks.

• The due date indicates when the task is targeted for completion and doesn’t affect the 
demand workflow. Project tasks affect project completion dates when planned dates and 
actual dates are changed.

• Nested demand tasks aren’t supported.

• Task constraints such as Start ASAP and Start on a specific date aren’t supported.

• Execution types such as Agile, Waterfall, or Hybrid aren’t supported.

Resource assignment

Resources for a demand task can be assigned using the Assigned to, Additional Assignee 
list, and Assignment Group  fields. Don’t create resource assignments to allocate resources 
or groups to a demand task or submit time spent on the demand. If you associate a resource 
assignment with a demand task, the associated resource plan isn’t transferred to the work entity 
created from that demand.

Resource assignments aren’t associated with the demand by default. Don’t use the resource 
assignments you created for the future work entity to submit time spent on a demand. When you 
submit a time card for a demand, the time and cost incurred aren’t transferred to the work entity 
created from the demand. The time and cost remain within the demand as the demand cost and 
effort. Resources assigned to a demand task can submit the time spent on it using a time card.

Actual cost and effort

The actual effort for work performed on the demand task is derived from the time card. The actual 
cost is derived from the hourly resource rate defined in the rate model, default labor rate, or 
default system property. The actual cost and effort for a demand task roll up to derive the actual 
cost and effort for the associated demand. For more information, see Actual cost and effort 
calculation for a demand and demand task.

Multicurrency in Next Experience for Demand Management  reference

The multicurrency features in Next Experience for Demand Management  enable you to manage 
and track demand financials in multiple currencies. This section provides field references and 
explains how cost and benefit plan updates recalculate values in demand currency.

Multicurrency fields in demand-related forms

When you enable the Demand Currency  view in Demand, Cost Plan, and Cost Plan Breakdown 
forms, multicurrency fields appear in the Financials section of these forms.

Financials tab of the Demand form

Field Description

Demand currency Currency for managing and tracking the 
demand. The available currency options 
depend on your selection in Preferences-
Project  under Project Administration. 
For more information, see Select demand 
currency preference.

This field becomes read only once you create 
a cost plan, cost plan breakdown, benefit plan, 
or benefit plan breakdown.
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Financials tab of the Demand form  (continued)

Field Description

Project currency Currency for implementing the project when 
this demand is converted to a project. This 
value carries over to the Project form in Project 
Management.

Capital expense in demand currency Capital expenditure (Capex) for the demand.

Capital budget in demand currency Total capital budget allocated to the demand 
across all fiscal years. Rolled up from the 
Capex budget of the demand.

Operating expense in demand currency Operational expenditure (Opex) for the 
demand in the selected demand currency.

Operating budget in demand currency Total operational budget allocated to the 
demand across all fiscal years in the selected 
demand currency. Rolled up from the Opex 
budget of the demand.

Total planned cost in demand currency Estimated cost of the demand in demand 
currency.

Financial return in demand currency Estimated revenue based on the Total 
planned costs in demand currency  and 
Financial benefit in demand currency  fields.

Financial benefit in demand currency Estimated revenue if the demand is approved 
in the selected demand currency. Rolled up 
from the benefit breakdown of the demand.

Net present value in demand currency Present value of future cash based on the 
given annual interest rate in the selected 
demand currency. A measure for comparing 
money spent today against future expected 
financial benefits, helping evaluate overall 
investment performance.

Actual cost in demand currency Total cost incurred while working on a demand 
and demand tasks in the selected demand 
currency.

Multicurrency fields of the Demand Task form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Actual cost in demand currency Total cost incurred while working on the 
demand tasks in the selected demand 
currency. Actual cost populates after the 
assignee creates and submits a time card. 
When the time card is approved, the resource 
rate from the rate card, labor rate, or system 
properties populates this field.
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Financials section of the Cost Plan form

Cost Plan form

Field Description

Demand currency Currency specified in the Demand 
currencyDemand currency field of the 
Demand form.

Cost in demand currency Value that is rolled up from the Entered cost 
field of all cost plan breakdowns.

Note: 
Any change to the unit cost, quantity, or fiscal period of a cost plan recalculates the 
amounts in demand currency. See Cost plan updates and cost recalculation in demand 
currency.

Multicurrency fields in the Cost Plan Breakdown form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Cost in demand currency Breakdown amount in demand currency.

Demand currency exchange rate Rate in effect for the period corresponding 
to the cost plan breakdown in the demand 
currency.

Demand currency exchange rate date Reference date on which the currency 
exchange rate is applied for conversion.

Financials section of the Benefit Plan form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Benefit in demand currency Benefit incurred from demand in demand 
currency.

Actual benefit in demand currency Actual benefit value rolled up from the actual 
benefit in the benefit breakdown.

Multicurrency fields in the Benefit Plan Breakdown form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Benefit in demand currency Benefit incurred from demand in demand 
currency.
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Multicurrency fields in the Benefit Plan Breakdown form  (continued)

Field Description

Demand currency exchange rate Rate in effect for the period corresponding 
to the benefit plan breakdown in demand 
currency.

Demand currency exchange rate date Reference date on which the currency 
exchange rate is applied for conversion.

Multicurrency fields in the Expense Line form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Amount in demand currency Expense cost in demand currency. Amount 
entered in the Amount field is converted to 
demand currency.

Multicurrency fields in the Demand Budget form

Field Description

Capex budget in Demand Currency Planned expense amount allocated for capital 
expenditure in the selected currency.

Opex budget in Demand Currency Operating expense amount in the selected 
currency.

Total Budget in Demand Currency Sum of Capex and Opex amounts in the 
selected currency.

Cost plan updates and cost recalculation in demand currency

Updating the unit cost, quantity, or fiscal period of a cost plan updates all related amount fields in 
the cost plan and its breakdowns. The amounts in the related demand fields are recalculated and 
reflected in the demand currency.

Unit cost, Quantity, and Recurring field changes

When you modify these fields in the Cost Plan form with multicurrency view enabled, the 
following values are recalculated:

• Total planned cost  in demand currency.

• Cost in demand currency  in the Cost Plan Breakdown.

• Capital expense in demand currency, Operating expense in demand currency, and Total 
planned cost in demand currency  fields in the demand.

Fiscal period changes

When you change the fiscal period (start date or end date) in the Cost Plan form, the following 
values are recalculated:
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• Total planned cost  and Cost in demand currency  of the cost plan. Cost Plan Breakdown 
records can be added or removed.

• If the Recurring  check box isn’t selected, the Cost in demand currency  value of each Cost 
Plan Breakdown record is recalculated.

• Capital expense in demand currency, Operating expense in demand currency, and Total 
planned cost in demand currency  fields in the demand.

Cost plan breakdown changes

When you change the entered cost in an individual Cost Plan Breakdown record or manually add 
cost plan breakdowns to a cost plan, the following values are recalculated:

• Total planned cost  of the cost plan in demand currency.

• Capital expense in demand currency, Operating expense in demand currency, and Total 
planned cost in demand currency  fields in the demand.

Benefit plan updates and recalculation in demand currency

Updating the entered currency, entered benefit, offset type, or fiscal period of a benefit plan 
updates all related amount fields in the benefit plan and its breakdowns. The amounts in the 
related demand fields are recalculated and reflected in demand currency.

Entered currency, Entered benefit, and Recurring field changes

When you modify these fields in the Benefit Plan form with multicurrency view enabled, the 
following values are recalculated:

• Total planned cost  in demand currency.

• Benefit in demand currency  in the Benefit Plan Breakdown.

• Financial benefit in demand currency  field in the demand.

Offset type changes

When you change the offset type (start date or end date) and specify the offset period and 
duration in the Benefit Plan form, the following values are recalculated:

• Total planned benefit  and Benefit in demand currency  of the benefit plan. Benefit Plan 
Breakdown records can be added or removed.

• If the Recurring  check box isn’t selected, the Benefit in demand currency  value of each 
Benefit Plan Breakdown record is recalculated.

• Financial benefit in demand currency  field in the demand.

Fiscal period changes

When you change the fiscal period (start date or end date) in the Benefit Plan form, the following 
values are recalculated:

• Benefit in demand currency  and Total planned benefit  of the benefit plan. Benefit Plan 
Breakdown records can be added or removed.

• If the Recurring  check box isn't selected, the Benefit in demand currency  of each Benefit Plan 
Breakdown record is recalculated.

• Financial benefit in demand currency  field in the demand.
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Benefit plan breakdown changes

When you change the entered benefit in an individual Benefit Plan Breakdown record, the 
following values are recalculated:

• Benefit in demand currency  of the benefit plan.

• Financial benefit in demand currency  field in the demand.

Form field information

Field information for forms used in Next Experience for Demand Management.

Assessment instance form

The assessment instance form information is used to create and edit an assessment instance for 
a demand.

Assessment Instance

Field Description

Number Auto-generated unique identifier for the 
assessment instance.

State Status of the assessment instance. Defaults to 
Ready to take.

Metric type Type of metric used to define the evaluation 
criteria for the assessment.

Assessment group Group responsible for completing the 
assessments.

Due date Date by which the assessment must be 
completed.

Assigned to Users responsible for completing the 
assessment instance.

Expiration date Date after which the assessment instance is 
no longer valid.

Signature Signature associated with the assessment 
instance on completion.

Preview Indication of whether a preview of the 
assessment before it’s submitted is available.

Signature result Outcome or status of the signature collected 
for the assessment instance.

Create action form

The action form information is used to create an action for a demand.

Create New Action form

Field Description

Number System-generated number with a configurable 
prefix.
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Create New Action form  (continued)

Field Description

State Current state of the action. All new action 
records are created with the state set to Open.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency for implementing or approving the 
action based on impact.

Estimated Cost Estimated cost generated by the action.

Impact The impact on the outcome of the demand if 
you don’t implement the action.

Approval Status of approval from the stakeholders for 
the action. The available options are:

• Not Yet Requested

• Requested

• Approved

• Rejected

Assigned to Primary resource assigned to implement the 
action.

Due date Requested date on which the action must be 
approved or implemented.

Parent The demand to which this action belongs.

Short description Brief description of the action such as what 
the action involves, how to implement the 
action, who it affects, and the action outcome.

Description Details of the action and its potential impact.

Work notes Information about the action. Add work notes 
to communicate about the status of action 
approval, rejection, or implementation with 
other users.

Create assessment instance question form

The assessment instance question form information is used to create and edit an assessment 
questions for a demand.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

274



Assessment Instance Question

Field Description

Source table Table from which the assessment instance 
question originates.

Category Category used to classify the assessment 
instance question.

Source Source record associated with the assessment 
instance question.

Domain Domain to which the assessment instance 
question belongs. Defaults to global.

Metric Assessment metric that defines the criteria 
being evaluated.

Instance Assessment instance to which this question 
belongs. Auto-populated with the instance 
number.

Value Numeric or scored value assigned to the 
assessment question response.

String value Text-based response or value entered for the 
assessment question.

Reference id Unique identifier of the referenced record 
associated with this question.

Additional information Any supplementary details or context relevant 
to the assessment instance question.

Create cost plan breakdown form

The cost plan breakdown form information is used to create and edit a cost plan breakdown 
record for a cost plan of a demand.

Cost plan breakdown

Field Description

Cost plan Name of the cost plan to which the breakdown 
is associated.

Fiscal period Fiscal period for the cost plan breakdown.

Entered currency Currency to capture the unit cost value.

If the selected currency is different from 
the default currency configured in the 
Financial Management  application, the budget 
reference rate is used to calculate the cost of 
the demand.

Entered cost Breakdown amount in entered currency.

Task Task to which the cost plan breakdown 
belongs.
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Cost plan breakdown  (continued)

Field Description

Functional cost Functional cost obtained by multiplying 
exchange rate with entered cost.

Exchange rate Rate in effect for the period corresponding to 
the cost plan breakdown. When the period 
corresponding to the cost plan break down 
has multiple rates, the rate in effect on the first 
date of that period is used.

Exchange rate is used to convert entered cost 
into functional cost. It is obtained from the 
itfm_fx_rate [budget_reference_rates] table.

Exchange rate date First date of the fiscal period corresponding to 
the cost plan breakdown.

Create cost plan form

The cost plan form information is used to create a cost plan for a demand.

Cost plan section

Field Description

Name Name of the cost plan.

Project/Demand The demand to which this cost plan belongs.

Start fiscal period Starting month in a fiscal period for the cost 
plan.

When you change the start fiscal period, 
the associated cost breakdown values also 
change.

End fiscal period Ending month in a fiscal period for the cost 
plan.

When you change the end fiscal period, 
the associated cost breakdown values also 
change.

Financials section

Field Description

Entered currency Currency to capture the unit cost value.

If the selected currency is different from 
the default currency configured in the 
Financial Management  application, the budget 
reference rate is used to calculate the cost of 
the demand.
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Financials section  (continued)

Field Description

Total planned cost Total planned cost value of the cost plan. If the 
cost is recurring, the calculation is Quantity x 
Unit cost x number of fiscal periods.

If the cost is non-recurring, the calculation is 
Quantity x Unit cost.

This value is rolled up from the cost 
breakdown.

Unit cost Cost of single unit of the resource.

Functional currency The default currency configured in the 
Financial Management  application and used 
for managing the demand.

Quantity Quantity of cost plans.

Cost in functional currency The total planned cost for the demand in 
functional currency. The value in this field 
changes if the entered currency is different 
from the functional currency.

Recurring Indicates if the cost is recurring for each fiscal 
period.

Quantity x Unit cost value is incurred for every 
fiscal period.

Total actual cost Total actual costs of the cost plan. This value is 
rolled up from cost breakdown.

Cost type Cost type of the plan.

Source Funding entity value from which you request 
fund.

The field is available when you select a value 
in the Source type field.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Investment Name of the investment created for the 
project.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.
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Financials section  (continued)

Field Description

Source type Funding entity type from which you request 
fund.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Create decision form

The decision form information is used to create a decision for a demand.

Decision form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the decision. All new decision records are created with the Open 
state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency of approving or implementing the decision based on the possible impact.

Decision 
status

Status of the decision. The available options are:

• Pending

• Approved

• Rejected

Impact Impact on the outcome of the demand if you don’t implement the decision.

Approval 
required

Option for determining whether approval of the decision is required.

Estimated 
Cost

Estimated cost of implementing the decision in the selected currency.

Due date Requested date on which the decision must be approved or implemented.

Assigned 
to

Primary resource assigned to work on the decision. The default value is the name 
of the user creating the decision record.

Parent Demand number to which this decision belongs.
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Decision form  (continued)

Field Description

Short 
description

Brief description of the decision such as what the decision is about, who made it, 
what it affects, and the decision outcome.

Description Details of the decision and its potential impact.

Work notes Information to record and track the status of decision implementation or 
approvals.

Create demand task form

The demand task form information is used to create a demand task for the demand.

Demand Task form

Field Description

Short description A brief summary of the task, which helps 
quickly identify the purpose or nature of the 
work.

Assignment group Team or group responsible for handling the 
task.

Number System-generated ID number with a 
configurable prefix.

Assigned to Primary resource responsible for executing or 
progressing the task. The following conditions 
apply:

• If an assignment group is defined, users in 
the assignment group are listed.

• If skills are defined, users with those skills 
are listed.

• If no assignment groups or skills are 
defined, users with one of the Project 
Management application user roles are 
listed.

• Users with the timecard_user role are also 
listed.

Priority Indicates the urgency and importance of the 
task. Determines how quickly it should be 
addressed.

Additional assignee list Users assigned to the demand task in addition 
to the single primary resource defined in the 
Assigned to  field.

State Current state of the demand task. All new 
demand task records are created in the Open 
state.

The states include:
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Demand Task form  (continued)

Field Description

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Category Category of the demand task.

The categories include:

• Initial review

• Effort estimate

• Cost estimate

• Benefit estimate

• Risk assessment

Due date The expected completion date and time for 
the task.

Actual effort The actual time spent working on the demand 
task, which is derived from the approved time 
card for this demand task.

You must add this field by personalizing the 
Create New Demand Task form as this field 
doesn’t appear by default on the form.

Actual cost The actual cost of the demand task derived 
from the number of hours worked and hourly 
rate of the resource as defined in the rate card. 
In the absence of a rate card, the hourly rate 
is derived from the default labor rate card or 
default system property.

Description Brief description of the demand task.

Work notes Information about the demand task. Work 
notes are added throughout the demand 
management life cycle to communicate with 
other users associated with the demand.

Create expense line form

The expense line form information is used to create an expense line for your actual expenses.

Expense Line section

Field Description

Number Auto-generated number for the expense line.
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Expense Line section  (continued)

Field Description

Amount Expense cost in the selected currency.

Date Date on which the expense was generated.

Process date Date on which the expense line was 
processed.

Rate card Name of the rate card.

Inherited Indicates if the expense line is inherited from 
another expense line.

Parent The parent expense line from which this 
expense line is inherited.

Rate type Rate type for the expense line.

State State of the expense line. Only processed 
expense lines are considered for an 
investment entity.

Source ID Record that generated the associated cost.

Summary type Business purpose of the expense line.

Cost plan Associated cost plan name for recording the 
expense line.

Expense type Defines the expense type, internal or external.

By default, the expense type is considered 
from the cost type field entry.

Cost type Cost type of the expense.

By default, the cost type of the cost plan is 
selected.

Short description Short description of the expense.

Mention unique and specific details to identify 
the expense line.

Source Sources of the expense line. These sources 
include:

• Asset

• Configuration item

• Fixed asset

• Task

• Contract

• Cost center

• User
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Create goal/target relationship form

The goal/target relationship form information is used to create a relationship between a goal and 
a demand.

Create New Goal/Target Relationship form

Field Description

Goal Name of the goal.

Demand Demand with which a goal relationship is 
created with the goal.

Target Name of the target.

Primary Indicates that this goal is the primary goal 
associated with a demand. Although multiple 
goals can be linked to a demand, only one of 
them must be designated as the primary goal.

Parent goal Name of the parent goal that this goal 
contributes to.

Status Status of the goal. Status can be Red, Yellow, 
Green, or None.

State State of the goal. The state can be Draft, In 
progress, Approved, Complete, Pending, 
Achieved, or Not Achieved.

End date End date for the goal. By default, the end 
date of the current quarter is populated. For 
a subgoal, the end date of its parent goal is 
populated.

Start date Start date for the goal. By default, the start 
date of the current quarter is populated. 
For a subgoal, start date of its parent goal is 
populated.

Progress Percentage completion for the goal. If the goal 
has subgoals or/and targets, the progress 
value is calculated automatically.

For more information on how the progress 
value is calculated, see Progress value 
calculation.

Category Category of the goal. The available options 
are:

• Total Applications

• Total Cost

• Opex

• Capex

• Cloud Applications

• Homegrown Applications

• Support Cost
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Create New Goal/Target Relationship form  (continued)

Field Description

• Labor Cost

• Standards Compliance

• Strategic

• Operational

• Tactical

• Artificial Intelligence

Create issue form

The issue form information is used to create an issue for the demand.

Issue form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the issue. All new issue records are created in the Open state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency of resolving or managing the issue based on possible impact.

Estimated 
cost

Estimated cost generated by the issue.

Impact Impact on the outcome of the demand if the issue remains unresolved.

Due date Requested date for one of the following situations:

• If the issue has an assigned resource, then the due date is the date for 
resolving the issue.

• If the issue isn’t assigned to any resource, then the due date is the date when 
the issue must be closed or addressed.

Assigned 
to

Primary resource assigned to work on the issue resolution.

Parent Demand to which this issue belongs.

Short 
description Brief description of the issue and its potential impact on the success of the 

demand.
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Issue form  (continued)

Field Description

Description Details of the issue and its potential impact.

Work notes Information to record and track the work accomplished for resolving the issue.

Create request change form

The request change form information is used to create a request change for a demand.

Request change form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the request change. All new request change records are 
created in the Open state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency for approving the requested changes based on impact.

Estimated Cost Estimated cost generated by the requested changes.

Impact Impact on the outcome of the demand if you don’t approve the requested 
changes.

Approval Status of approval from the stakeholders for the requested changes.

Assigned to Primary resource assigned to work on the request change.

Due date Requested date to complete the request change.

Category Entity for which you’re creating the request change. The options are:

• Resource

• Scope

• Cost

• Schedule

Parent Demand number to which this request change belongs.

Title Title for the change request.

Description Details of the request change and its potential impact.

Business 
Justification

Reason for requesting the proposed change in the demand. The change's 
impact on the business.
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Request change form  (continued)

Field Description

Work notes Additional information to indicate progress on the demand request change.

Create requirement form

The requirement form information is used to create a requirement for a demand.

Requirement form

Field Description

Number Unique identification number for the requirement. Automatically generated when 
a new requirement record is created.

Source User requesting the requirement. This field automatically populates with the name 
of the person filling out the form, but the source can be a different person who 
identified the requirement.

Owner User responsible for managing the requirement or ensuring that the requirement 
is met.

Estimated 
effort

Approximate amount of time to complete the requirement and any associated 
tasks.

Priority Importance of the requirement as it applies to the overall demand.

State Status of the requirement such as Pending, Approved, or Rejected.

Note: 
The requirement state is independent of the demand state and the states 
of any planned tasks associated with the requirement. The demand can be 
closed without the requirement state being closed. Closing the demand 
doesn’t change the state of the requirement.

Type Type of requirement such as Business, Solution (Functional), Solution (Non-
Functional), Quality, Stakeholder, or Transition.

Short 
description

Brief description of the requirement.

Description Detailed description of the requirement and any associated tasks. For example, 
describe an expected outcome or result.

Create resource assignment form

The resource assignment form information is used to create a resource assignment record for a 
demand.

Resource assignment

Field Description

Assignment type Select an assignment type from the list.
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Resource assignment  (continued)

Field Description

• User - to create a resource assignment for a 
user.

• Group - to crate a resource assignment for a 
group.

Resource Name of the resource.

This field is turned off for Group assignment.

Group Name of the group to create resource 
assignment.

If a resource is selected, the primary group 
name is populated by default.

Role Primary role for the employee.

• If a resource is selected, the primary role is 
populated by default.

• This field is turned off for Group assignment.

Skill Primary skill of the resource.

• If a resource is selected, the primary role is 
populated by default.

• This field is turned off for Group assignment.

Effort type Select the effort type to request a resource.

• Hours - to request a resource or group by 
hourly basis.

• FTE - to request a resource or group by FTE.

By default, one FTE is 8 hours.

• Person days - to request a resource or group 
by Person days.

Effort Enter the required effort count.

Task Select the task from the list to associate the 
resource assignment.

Start date Select the start date of the assignment using 
the calendar palette.

End date Select the end date of the assignment using 
the calendar palette.

Resource status Select the state of the resource assignment.

• Pending

• Approved
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Resource assignment  (continued)

Field Description

• Unapproved

• Unassigned

Rate override Select this option to override the resource rate 
to match with your organization requirements.

Ready for review Select an option from the list so that the 
resource manager can review the request for 
allocation.

• Yes - if the resource assignment request is 
finalized and ready for resource manager's 
review for allocation.

• No - if the resource assignment details are 
still being updated.

Notes Enter details about the assignment to help 
resource manager or project manager with 
insights and additional information.

Create risk form

The risk form information is used to create a risk for the demand.

Risk form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the risk. All new risks are created in the Pending state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Risk status Status of the risk. All new risks are created in the Pending risk status. The 
available options are:

• Pending

• Achieved

• Not Achieved

• Avoid

• Mitigate
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Risk form  (continued)

Field Description

• Transfer

• Accept

Probability The likelihood that the event described in the risk can occur. All new risks are 
created in the Low probability. The available options are:

• Absolute

• High

• Moderate

• Low

Impact Impact of the risk event on the outcome of the demand.

Estimated 
cost

Estimated cost generated by the risk event.

Risk rank A value and color assigned to the risk. This value is calculated using risk 
probability and impact. You can configure the color and value using the Risk Value 
Lookup. For more information, see Configure a custom risk rank and risk value.

Risk owner Primary resource who is responsible for monitoring and managing the risk.

Assigned 
to

Primary resource assigned to work on the risk.

Risk value A value calculated from the Risk Value Lookup. For more information, see 
Configure a custom risk rank and risk value.

Due date Requested date for one of the following situations:

• If the risk has an assigned resource, then the due date is the date for resolving 
the risk.

• If the risk isn't assigned to any resource, then the due date is the date when the 
risk must be closed or addressed.

Task Demand to which this risk belongs.

Short 
description

Brief description of the event and its potential impact on the success of the 
demand.

Description Details of the event and its potential impact.

Mitigation 
plan

Brief description of the efforts taken to mitigate the risk.

Work notes Information to record and track the work accomplished for resolving the risk.

Create stakeholder form

The stakeholder form information is used to create a stakeholder record for the demand.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

288



Stakeholder register form

Field Description

Stakeholder Name of the stakeholder being added to the demand.

Demand Demand to which the stakeholder is assigned.

Level of Interest Level of interest that the stakeholder has in pursuing the demand.

Assessment 
recipient

Indication of whether the stakeholder is authorized to receive assessment 
questionnaires for a demand.

Approver Indication of whether the stakeholder has authority to approve demands.

Influence Level of influence the stakeholder has over the group assessing the demand.

Engagement Indication of the way the stakeholder is engaged with the demand.

Function Function of the stakeholder in the demand process.

Create project funding form

The project funding form information is used to create a project funding budget for the demand.

Project Funding

Field Description

Fiscal Year The fiscal year for which you want to set the 
budget for the demand.

Capex target Planned target amount allocated for capital 
expenditure.

Opex target Planned target amount allocated for operating 
expenditure.

Target Sum of capex and opex target amounts.

Demand/Project Demand to which the budget belongs.

Capex budget Planned expense amount allocated for capital 
expenditure.

Operating budget Operating expense amount.

Budget Sum of capex and opex amounts.

Selected for execution Indication of whether the demand is planned 
for execution.

Demand form

The demand form information is used to create a demand.

Demand form fields

Field Description

Name Name of the demand.

Category Category of the demand:
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Demand form fields  (continued)

Field Description

• Strategic: For demands for plans, such as projects or stories.

• Operational: For demands for operational work, such as changes or defects.

Type The Category  field selection determines the selections available in the Type 
field.

• The following demand types are available if the demand category is Strategic:

◦ Enhancement

◦ Project

◦ Epic

◦ Story

◦ EAP Epic

◦ EAP Feature

◦ EAP Capability

◦ No Conversion

• The following demand types are available if the category is Operational:

◦ Change

◦ Defect

◦ No Conversion

If the Agile Development 2.0  application is active, the Story, Epic, 
Enhancement, and Defect options are available.

If the Strategic Planning  application is active, the EAP Epic, EAP Feature, and 
EAP Capability options are available.

The No Conversion option enables you to use your demand to fund a large 
project that includes one or more projects, epic, or programs.

The selections in the Category  and Type  field also determine the fields that are 
displayed in the Assessment Data section.

Project Name of the project created from this demand.

This read-only field is visible only when you convert the demand into a project.

Enhancement Number of the enhancement created from this demand.

This read-only field is visible only when you convert the demand into an 
enhancement.

Epic Name of the epic created from this demand.

This read-only field is visible only when you convert the demand into an epic.

Story Name of the story created from this demand.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

290



Demand form fields  (continued)

Field Description

This read-only field is visible only when you convert the demand into a story.

Number Unique, auto-generated identification number for the demand.

Approved 
start date

The formal date approved by stakeholders for starting the demand. This date is 
set after prioritization and stakeholder approval and represents the committed 
and authorized timeline for execution. It’s used for governance and traceability.

For example, the approved date to start the database upgrade is 2026-01-10.

This field is carried forward to the Approved start date  field of the Project form 
if the demand is converted to a project and remains unchanged, even if the 
project starts later.

This field is highlighted in red if the date is different than the value in the Start 
date  field.

Note: 
If this field is empty while creating a demand, the date from the Start date 
field is inserted.

Approved 
end date

The formal date approved by stakeholders for completing the demand. This 
date is set after prioritization and stakeholder approval and defines the 
approved execution window and supports historical tracking.

For example, the approved end date to complete the demand is 2026-02-15.

This field is carried forward to the Approved end date  field of the Project form 
if the demand is converted to a project and remains unchanged, even if the 
project ends later.

This field is highlighted in red if the date in this field is different than the value in 
the Due date  field.

Note: 
If this field is empty while creating a demand, the date from the Due date 
field is inserted.

Start date The preliminary or estimated date when the work is initially planned to begin. 
This date helps outline the intended timing for early demand planning and 
prioritization. You can set this date during initial demand creation or anytime in 
the planning phase when a rough idea forms. This date can be updated until 
the demand is officially approved.

For example, you’re planning for a database upgrade to start on 2025-11-01.

This date is changed to Planned start date  when the demand is converted to a 
project.
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Demand form fields  (continued)

Field Description

Note: 
When you change the planned start date of a demand or project, the 
associated cost plans and resource assignments also change. The 
Change Resource Plan and Cost Plan Start Date with Demand or Project 
Start Date Change  property controls the behavior for a demand date 
change. This property isn’t enabled by default. For more information, see 
Properties installed with Project Management.

Due date The preliminary or estimated date when the planned work is expected to be 
completed. This date provides an expected completion window for planning 
and stakeholder communication. You can set this date anytime in the planning 
phase when a rough idea forms and can be updated until the demand is 
officially approved.

For example, you’re planning to complete the database upgrade by 2025-12-31.

Note: 
This date is changed to Planned end date  when the demand is converted 
to a project.

Description Description of the demand.

Details section of the Demand form

Field Description

Portfolio Portfolio indicating the business focus of the 
demand.

Program Name of the program to which the demand 
belongs.

Investment Class Type of investment class category assigned to 
the demand:

• Run: Investment made to sustain the 
existing business.

• Change: Investment made to implement a 
change in the business.

Investment Type Investment type of the demand:

• Cost Reduction

• End User Experience

• Legal and Regulatory

• Revenue Generating

• Service Sustaining

• Strategic Enabler

• Artificial Intelligence
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Details section of the Demand form  (continued)

Field Description

Demand manager Name of the demand manager.

Collaborators Users who can edit or contribute to the 
demand. A demand requester can select any 
user as a collaborator.

Expense type The type of the expense, either capex (capital 
expense) or opex (operational expense).

Priority The priority of the demand.

Department Department in a business unit to which the 
demand submitter belongs.

Note: 
If you don’t select a department, 
the default value is the name of the 
department to which the submitter 
belongs.

Project Manager Project manager that would be assigned to 
the project created from this demand. When 
a project is created, this field becomes read 
only. This field appears if the Category  field 
is set to Strategic and the Type  field is set to 
Project. If you delete the project created from 
this demand, this field becomes editable.

Business Unit Business unit to which the demand submitter 
belongs.

Impacted Business Units Business units affected by the submitted 
demand. The selected units could experience 
operational impact, process changes, 
technology adoption, and so on.

For example, if a demand is submitted by the 
procurement business unit, it can impact the 
finance, legal, and IT business units.

Idea Unique identification number of the idea from 
which the demand was created.

Business Capabilities Business capabilities associated with 
the demand that links the demand to 
organizational goals and value. Business 
capabilities are defined in the Enterprise 
Architecture  (formerly Application Portfolio 
Management) module.

Impacted Business Applications If the demand is to change, enhance, or 
add one or more business applications, the 
applications associated with the demand. 
Business applications are defined in 
the Enterprise Architecture  (formerly 
Application Portfolio Management) module. 
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Details section of the Demand form  (continued)

Field Description

For more information, see Exploring business 
applications .

You can select any business application 
in your enterprise regardless of whether 
it’s related to a capability selected in the 
Business Capabilities  field.

Business Applications If the demand is to change, enhance, or 
add one or more business applications, the 
applications associated with the demand. 
Business applications are defined in 
the Enterprise Architecture  (formerly 
Application Portfolio Management) module. 
For more information, see Exploring business 
applications .

You can select any business application 
in your enterprise regardless of whether 
it’s related to a capability selected in the 
Business Capabilities  field.

Business Case section of the Demand form

Field Description

Strategic priority Strategic objectives of the organization that 
the demand fulfills. A demand can fulfill 
multiple strategic objectives.

If a business unit has been selected in 
the Details  tab, the business strategies 
for the selected business unit along with 
other enterprise strategies are available for 
selection.

Primary goal The primary goal associated with the strategy 
selected in the Strategic priority  field.

If a strategy hasn’t been selected, all goals are 
available for selection.

Business case Business arguments that support the demand.

Risk of performing Risks if the demand is approved and 
implemented.

Risk of not performing Risks if the demand isn’t approved, for 
example, risk of loss of opportunity.

Enablers Key enablers for the demand that would aid 
the demand to be completed. For example, 
clearly defined resource and cost plans.
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Business Case section of the Demand form  (continued)

Field Description

Barriers Major barriers to the demand that would 
obstruct the demand's completion. For 
example, incomplete or unclear demand 
details.

In scope Scope of the demand, which is the set 
of boundaries that define the extent of a 
demand.

Out of scope Activities or deliverables not in the scope 
of the demand. Anything not defined in the 
scope is out of scope.

Assumptions Assumptions made for the demand. 
Assumptions help to define the scope and 
risks, and fine-tune the estimates for time and 
cost.

Financials section of the Demand form

Field Description

Rate Model Rate model assigned to the demand. This 
setting is used to derive hourly rates for the 
associated resource assignments and time 
cards. For more information, see Rate Models.

Note: 
If the rate model assigned to the demand 
is changed or removed, the cost fields 
on the associated resource assignments 
aren’t recalculated.

Project Currency Currency used to execute the project once the 
project is created from this demand.

You can select any active currency from the 
values listed in the Currency [fx_currency] 
table.

After you create a project in the selected 
project currency, you can't change the project 
currency in the Project form if the demand 
contains a cost plan, a benefit plan, or a 
project budget. If the demand has no attached 
plan or budget, you can change the project 
currency in the Project form.
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Financials section of the Demand form  (continued)

Field Description

Note: 
The value of this field defaults to 
the Project currency  field of the 
Financials  tab in the project currency 
view of the Project form as well. 
This field is available only when 
the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) feature 
is activated and the Demand Currency 
view is enabled.

Capital expense Capital expenditure (capex) for the demand.

Operating expense Operational expenditure (opex) for the 
demand.

Total planned cost Result calculated based on the values in the 
Capital expense  and Operating expense 
fields.

Financial return Result calculated based on the values in the 
Total costs  and Financial benefit  fields.

Financial benefit Estimate of revenue if the demand is 
approved.

This value is rolled up from the benefit 
breakdown of the demand.

You can also enter the value manually by 
selecting a currency icon and entering a value.

ROI % ROI calculated based on the values in the 
Total costs  and Financial return  fields.

The value in this field is updated when a cost 
plan, benefit plan, or resource assignment 
is created or updated for the demand in the 
Qualified or Approved state.

Capital budget Total capital budget allocated to the demand 
across all fiscal years.

The value is rolled up from the capex budget 
of the demand.

Operating budget Total operational budget allocated to the 
demand across all fiscal years.

The value is rolled up from the opex budget of 
the demand.

Discount Rate % Demand discount rate, which is the interest 
rate to determine the present value of future 
cash flows.
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Financials section of the Demand form  (continued)

Field Description

Net present value Present value of future cash based on the 
given annual interest rate, a measure for 
comparing money spent today against future 
expected financial benefits. This value is 
useful when evaluating the overall investment 
performance.

For example, at a 12% discount rate, $1.00 
today is worth $0.80 in two years. Therefore, 
receiving $1.00 in two years is the same as 
receiving $0.80 today.

Net present value (NPV) is calculated from 
total costs according to year, financial 
benefit per year, and the discount rate for the 
demand.

Internal rate of return % Annual interest rate required to achieve an 
NPV of zero.

Internal rate of return (IRR) helps to determine 
which demands can deliver a higher rate of 
return in terms of revenue.

Demand Actual Cost Total cost incurred while working on a demand 
and demand tasks. Demand actual cost is 
calculated after the assignee of the demand 
task creates and submits a time card. When 
the time card is approved, the resource rate, 
which is derived from the rate card, labor rate, 
or system properties, is used to populate this 
field.

Demand Actual Effort Time accrued or spent by a resource while 
working on a demand or a demand task as 
derived from the submitted and approved time 
cards. This field isn’t available on the Demand 
form by default.

Note: 
If you’re creating a demand with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and the Demand Currency  view enabled, 
then the fields in the Financials  tab differ from the Default  view. For more information about 
the fields that are available only in the Demand Currency view, see Multicurrency fields in 
demand-related forms.

Assessment Data section of the Demand form

Field Description

Impact Level of business impact created by the 
demand.
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Assessment Data section of the Demand form  (continued)

Field Description

Risk Risk value calculated from the demand 
assessment.

Value Business value of the demand calculated from 
the Impact  and Financial return  fields.

T-Shirt size Size of the demand.

Before using this value as an indicator 
of demand size, consider creating and 
publishing definitions for each option outside 
the application. That process ensures that 
the values are interpreted correctly and 
consistently across the organization or 
department.

Score The demand score is calculated based on 
the risk, value, and size  attributes in the 
base system.

The value of the risk, value, and size 
attributes are derived from the assessment 
metric category results. For more information, 
see View assessment results  and assessment 
category results .

• When the risk  and size  values are high, 
the score of the demand is low.

• When the value  setting is high, the score 
of the demand is high.

Assessment Required Option for enabling the assessments for the 
demand. This option is active by default.

Only a demand manager can update this value 
when the demand is in the Draft or Submitted 
state.

Note: 
If this option isn’t selected and you reset 
the demand to the Draft state, the option 
remains unselected.

Note: 
The values in the Value  and Score  fields are updated when a cost plan, benefit plan, 
or resource assignment is created or updated for the demand in the Qualified or 
Approved state. The values in the fields are updated only until an artifact such as project, 
enhancement, defect, or change is created from the demand.
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Notes section of the Demand form

Field Description

Watch list The groups and users subscribed to the 
demand who can view the information in the 
Additional comments  field.

Work notes list The groups and users subscribed to the 
demand who can view the information in the 
Work notes  field.

Work notes Information about the demand. This 
information isn’t visible to customers. Work 
notes are added throughout the demand 
management life cycle to communicate with 
other users associated with the demand.

Preferences section of the Demand form

Field Description

Close Demand
Determines when to close the demand 
automatically if it’s converted to a project.

• None: Keeps the demand in the Open state 
after it’s converted to a project.

• On creation of project: Closes the demand 
when the demand is converted to a project.

• On closure of project: Closes the demand 
when the project created from the demand 
is closed.

Note: 
The On creation of project  and On 
closure of project  options appear 
when the value for the Type  field is 
set to Project. If the Type  field is set 
to Enhancement, the default setting is 
None.

Project calculation Determines the calculation to use for task 
dependencies for the project when the 
demand is converted to a project. The default 
value is Automatic.

• Manual: Task dates don’t reflect any 
changes made to dependencies.

• Automatic: Task dates are automatically 
updated to reflect any changes made to 
dependent or child tasks.
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EAP Details section of the demand form
This section appears only if the selected type is an EAP entity.

Field Description

Team The planning team to which the created EAP 
entity is assigned. This field becomes read 
only once the EAP entity is created. This value 
is an optional value.

Converted to The name of the created EAP entity. This field 
is read-only.

AI Associations section of the demand form
This section appears only if the AI Control Tower plugin is installed and the 
investment type of the demand is set to artificial intelligence.

Field Description

Product Product or system that the demand relates to.

Impacted AI systems Impacted AI systems associated with the 
demand. You can select existing AI systems 
from the list or remove systems that are no 
longer relevant.

Monetary benefit breakdown form

The monetary benefit breakdown form information is used to create and edit a monetary benefit 
breakdown record for the demand.

Monetary Benefit Breakdown form

Field Description

Task Task to which the benefit plan breakdown 
belongs.

Portfolio Portfolio to which the benefit plan breakdown 
belongs.

Entered currency Currency specified in the benefit plan.

Exchange rate Rate in effect for the period corresponding to 
the benefit plan breakdown. When the period 
corresponding to the benefit plan breakdown 
has multiple rates, the rate in effect on the first 
date of that period is used.

Exchange rate is used to convert the entered 
benefit into the functional benefit. It’s obtained 
from the itfm_fx_rate [budget_reference_rates] 
table.

Actual benefit Actual benefit that is incurred from the project 
or demand.
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Monetary Benefit Breakdown form  (continued)

Field Description

Benefit plan Benefit plan to which the benefit plan 
breakdown belongs.

Fiscal period Fiscals generated at the period level. For 
information on periods, see fiscal calendars .

Entered benefit Benefit in entered currency.

Functional benefit Functional benefit obtained by multiplying the 
exchange rate with the entered benefit.

Exchange rate date First date of the fiscal period corresponding to 
the benefit plan breakdown.

Monetary benefit plan form

The benefit plan form information is used to create monetary and non-monetary benefit plans for 
a demand.

Create New Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Demand number to which the benefit plan belongs.

Sponsor Sponsor for the demand.

Category Type of benefit:

• Hard: Benefits measured in terms of revenue.

• Soft: Benefits measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The selection in the Category  field determines the available options in this field.

Benefit 
type

Type of the benefit: monetary or non-monetary.

Offset type Indicates when the benefits start realizing. If the value in the selected offset type 
changes, the benefit plan start date shifts accordingly.

For example, if the offset type is set to End Date and the demand due date 
changes, the benefit plan start date shifts to align with the new due date.

Start fiscal 
period

Starting fiscal period. Populated based on values in the Offset field relative to the 
selected Project or Demand start date or Project or Demand end date, and the 
Duration in period values.

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.
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Create New Benefit Plan form  (continued)

Field Description

End fiscal 
period

Ending fiscal period.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Benefits associated with this benefit plan.

Description Description of the benefit plan.

Financials section

Field Description

Entered benefit Estimated amount of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods.

Entered currency Currency for the benefit plan. If the selected 
currency differs from the default currency 
configured in the Financial Management 
application, the budget reference rate is 
used to calculate the financial benefit of the 
demand. For more information, refer to budget 
reference rate.

Functional currency Default currency configured in the Financial 
Management  application and used for 
managing the demand or project.

Total planned benefit Total benefit value rolled up from the benefit 
breakdown.

Benefit in functional currency Benefit incurred from demand in functional 
currency. The value in this field changes if the 
Entered currency  differs from the functional 
currency.

Actual benefit Actual benefit value rolled up from the actual 
benefit in the benefit breakdown.

Recurring Indicates if the benefit is recurring for each 
fiscal period in the benefit breakdown.

Non-monetary benefit plan breakdown form

The non-monetary benefit breakdown form information is used to create and edit a non-
monetary benefit breakdown record for the demand.
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Non-monetary Benefit Plan Breakdown form

Field Description

Task Task to which the benefit plan breakdown 
belongs.

Portfolio Portfolio to which the benefit plan breakdown 
belongs.

Measure Measure type specified in the benefit plan.

Actual benefit Actual benefit that is incurred from the 
demand.

Benefit plan Benefit plan to which the benefit plan 
breakdown belongs.

Fiscal period Fiscals generated at the period level. For 
information on periods, see fiscal calendars .

Entered benefit Benefit in entered value.

Variance The difference between the estimated and 
actual benefit.

Non-monetary benefit plan form

The benefit plan form information is used to create monetary and non-monetary benefit plans for 
a demand.

Create New Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Demand number to which the benefit plan belongs.

Sponsor Sponsor for the demand.

Category Type of benefit:

• Hard: Benefits measured in terms of revenue.

• Soft: Benefits measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The selection in the Category  field determines the available options in this field.

Benefit 
type

Type of the benefit: monetary or non-monetary.

Offset type Indicates when the benefits start realizing. If the value in the selected offset type 
changes, the benefit plan start date shifts accordingly.

For example, if the offset type is set to End Date and the demand due date 
changes, the benefit plan start date shifts to align with the new due date.

Start fiscal 
period

Starting fiscal period. Populated based on values in the Offset field relative to the 
selected Project or Demand start date or Project or Demand end date, and the 
Duration in period values.
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Create New Benefit Plan form  (continued)

Field Description

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.

End fiscal 
period

Ending fiscal period.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Benefits associated with this benefit plan.

Description Description of the benefit plan.

Non-monetary Details section

Field Description

Non-monetary entered benefit Estimated amount of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods.

Measure Type of measure for the non-monetary 
benefit plan. The measure types are Count, 
Percentage, Hours, Days, and Score.

The Yes/No options are used to track the 
benefits that aren’t quantifiable. When this 
option is selected, the only field available 
is Benefits achieved. You can select the 
Benefits achievedcheck box to indicate that 
the benefits have been achieved.

Benefits achieved Option to indicate if the benefit is achieved.

Non-monetary planned benefit Estimated value of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods 
only.

Breakdown type Type of breakdown creation when you save 
the benefit plan.

• None: No breakdowns are created.

• Automatic: A non-monetary benefit plan 
breakdown record is created automatically 
with data. The breakdown is calculated 
linearly.
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Non-monetary Details section  (continued)

Field Description

• Manual: A non-monetary benefit plan 
breakdown record is created automatically 
but without data in the entered benefit 
column.

Non-monetary actual benefit Actual benefit value rolled up from the actual 
benefit in the benefit breakdown.

Aggregation mode Determines how the roll-up happens from 
breakdowns to the benefit plan and updates 
the values in the Non-monetary planned 
benefit  and Non-monetary actual benefit 
fields.

• Sum: Aggregates data from all breakdowns.

• Average: Average value from all 
breakdowns.

• Most recent: Recent breakdown value.

• Max: Maximum value among the 
breakdowns.

• Min: Minimum value among the 
breakdowns.

Risk value lookup form

The risk value lookup form information is used to rate the impact and probability of a risk.

Risk Value Matcher form

Field Description

Impact Impact value of the risk.

The default values are:

• 1 = High

• 2 = Medium

• 3 = Low

Application The application to which these risk values 
belong.

Risk Rank Color Color to indicate the severity of the risk.

Tip: 
You can enter variations of a color to 
differentiate between risks with similar 
impact and probability values. For 
example, you could enter light green to 
indicate a low-severity risk.
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Risk Value Matcher form  (continued)

Field Description

Risk Value The value for the specified risk impact and 
probability combination.

The options are: High, Medium, and Low.

This value is displayed in the Risk value  field 
of the Risk form.

Probability Risk probability value is associated with the 
impact value of the risk. The options are: 
Absolute, High, Moderate, and Low.

Probability Number Numerical value to indicate the probability. 
This value is multiplied by the value of the 
Impact  field for calculating risk rank.

The default values are:

• 1 = Absolute

• 1 = High

• 2 = Moderate

• 3 = Low

The calculated risk rank and the risk rank color 
are displayed in the Risk rank  field of the Risk 
form.

Stakeholder register form

The stakeholder register form information is used to add users to the stakeholder registry.

Stakeholder register form

Field Description

Number Unique identification number for the stakeholder. This number is automatically 
generated when a new entry is created.

User Name of user being added to the stakeholder registry.

Portfolio Portfolio to which the user is assigned. A group of activities managed to align to 
business or operational objectives constitutes a portfolio. Typically, portfolios are 
named according to the business units of an organization.

Level of 
Interest

Level of interest that the stakeholder has in pursuing the demand.

Assessment 
recipient

Indication of whether the user is authorized to receive assessment 
questionnaires for a demand.

Approver Indication of whether the user has authority to approve demands.

Influence Level of influence the user has over the group assessing the demand.

Engagement Indication of the way the user is engaged with the demand.
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Stakeholder register form  (continued)

Field Description

Function Function of the user in the demand process.

Next Experience for Demand Management  key terms

Important terms in Next Experience for Demand Management  are listed in the table.

Next Experience for Demand Management  Key Terms

Term Description

Portfolio A collection of demands managed as a group to achieve strategic and 
operational objectives.

Assessable 
record

A demand record that you want to evaluate for metric type demand.

You evaluate the assessable records with metric categories and metrics, which 
define traits and values to assess.

Metric A trait or value used to evaluate assessable records.

A metric can measure subjective values in an assessment questionnaire or 
gather objective values in a database query run by a script.

Examples of metrics include perceived value of demands and return on 
investment for a demand.

Metric type A characteristic that defines a set of records you want to evaluate.

Demand management comes with the metric type demand, which uses records 
from the Demand [dmn_demand] table.

Metric 
category

A theme for evaluating assessable records. Categories contain one or more 
individual metrics, which define specific traits or values that comprise the theme.

Examples of categories include return on investment and cost. Set filter 
conditions to control which assessable records to evaluate for the metrics in a 
category.

Stakeholder A person affected by the demand or who has interest in the demand.

Scorecard A visual breakdown on performance of an assessable record based on 
assessment results.

Use scorecards to view various data summaries for one assessable record and 
to compare the ratings with other assessable records.

Requirement An extra item that must be present or an extra action item that must be finished 
before a demand request closes.

Demand 
Task

A unit of work, created within a demand, to break down initial planning activities 
before converting the demand into a project. A demand task isn’t a planned task 
like a project task.
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Strategic Planning
Strategic Planning  Workspace (SPW) enables you to manage enterprise strategy and goals, 
product feedback, portfolio planning, and enterprise agile planning for your organization. 
Evaluate product performance, align work with strategy, and scale your Agile framework from a 
single workspace.

Strategic Planning  is available for users with a Strategic Portfolio Management  (SPM) Pro license.

Explore the generative AI features available in the Strategic Planning  application, including the 
Multi-Feedback Summarization skill to generate summaries of one or more feedback items, the 
Planning Item Gen AI Docs skill to generate a summary of selected text in Docs, and the Target 
Generation skill to generate targets for goals.

Installing Strategic Planning  also installs Strategy and Goals, Product Feedback, Demands, 
Portfolio Planning, and Enterprise Agile Planning features. Access to these features is based on 
the user roles assigned. Learn more about these features in the following sections.

Get started

Strategy 
and Goals

Feedback Demands Portfolio 
Planning

Enterprise 
Agile 

Planning

Dashboards

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Strategy and Goals
Strategy and Goals in Strategic Planning Workspace  enables your organization to create boards 
and manage your strategic plans, priorities, goals, and targets to drive business outcomes.

https://player.vimeo.com/video/1174858258?
h=5e04c02eb2&badge=0&autopause=0&player_id=0&app_id=58479%22

A board is a collection of strategic plans, strategic priorities, goals, and targets based on your 
selected filter criteria, helping you focus on and manage them effectively.
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Explore

Learn the key features 
and business value 

of Strategy and Goals 
in Strategic Planning

Configure

Configure strategy 
and goals preferences

Manage boards

Organize enterprise 
goals and targets in a 
single, focused view

Use

Define strategic plans, 
priorities, create 

goals, set targets, and 
evaluate the progress

AI capabilities

Generate targets and 
insights for goals with 

Now Assist for SPM

Reference

Get details about 
components, form fields, 
and general guidelines

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Strategy and Goals in Strategic Planning Workspace

Use Strategy and Goals in Strategic Planning Workspace  to create boards that organize your 
organization's strategic plans, strategic priorities, goals, and targets in a single, focused view.

Strategy and Goals key components

Understanding the key components of Strategy and Goals in Strategic Planning Workspace 
helps you structure your organization's strategic vision and track progress toward meaningful 
outcomes.

The key components for managing enterprise goals in Strategy and Goals are strategic plans, 
strategic priorities, goals, targets, and any work items associated with goals or targets.
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A board is a collection of strategic plans, strategic priorities, goals, and targets based on your 
selected filter criteria—helping you stay focused and manage them effectively.

For an example of the structure of a strategy from the strategic plan level down to targets, see 
Enterprise strategy example.

Board types

When you create a board, you can choose whether to base it on strategic plans, goals, or both.

• A strategy-based board lets you create and manage strategic plans and priorities, aligning 
high-level direction with the priorities your teams are executing against.

• A goals-based board lets you create goals and targets that align with your strategic priorities, 
with the ability to tailor the board by entity type and entity to focus on the goals that matter 
most.

• A combined strategy and goals board includes two pages—Strategy and Goals—supporting 
both strategic planning and goal execution within a single board.

For any board type, you can define what items appear using advanced filter conditions, giving 
you precise control over the scope and focus of each view. For details, see Managing boards in 
Strategic Planning Workspace  and Managing strategy and goals using boards.
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Goals page within a strategy and goals-based board

Now Assist for Strategic Portfolio Management (SPM)  capabilities for Strategy 
and Goals

If Now Assist for Strategic Portfolio Management (SPM)  is installed, you can use the following 
capabilities to enhance your strategic planning and goal management:

• With the Goals insights skill, you can generate AI-powered insights for goals and review the 
results to identify at-risk goals, assess forecasted statuses, and act on recommendations 
before goals fall off track. For details, see Generate insights for a goal.

• With the Target generation skill, you can generate measurable targets for your goals, reducing 
the effort required to define quantifiable success criteria. For details, see Generate targets for a 
goal.

Reminders for target actuals check-in

The target check-in reminder feature lets you schedule automatic reminders that notify target 
owners and contributors to update actuals for their targets based on the defined check-in 
frequency and before the due date. This ensures that target actuals are updated on time.

To enable the feature, system properties must be configured. For details, see Configure 
reminders for target actuals.

Goal owners, target owners, and contributors can also send reminders manually when needed. 
For details, see Send a reminder for target actuals check in.

Comparing portfolio plan goals with enterprise goals (Strategy and Goals)

Creating goals for portfolio plans requires selecting a lens hierarchy and defining goals at the 
entity level based on the portfolio plan's hierarchy, which can limit flexibility and make it difficult 
to get started.

In Strategy and Goals, you can create boards and manage goals directly based on board filter 
criteria, without defining a lens hierarchy, providing a simpler and more flexible approach.

If you are already managing goals in portfolio plans, you can create corresponding boards 
based on your assigned entities or filter criteria to manage your goals and targets in one location 
without any additional configuration. For a portfolio plan created using the Goals lens, the goals 
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displayed in the portfolio plan match the goals displayed on a board when both are configured 
with the same filter criteria.

• Portfolio plan goals: Create goals for your portfolio plans, set targets for them, and evaluate 
the progress of the goals and targets in Strategic Planning Workspace  to accomplish your 
organizational plans and drive business outcomes. For details, see Managing portfolio plan 
goals in Strategic Planning Workspace.

• Enterprise goals (Strategy and Goals): Create boards to manage your organization's strategic 
plans (Mission, Vision, and values), strategic priorities, goals, and targets in a single, focused 
view. Create boards to manager org splans (missin, vision, values), sps, goals, and targets for 
your organization level. For details, see Managing boards in Strategic Planning Workspace  and 
Managing strategy and goals using boards.

Comparison of portfolio plan goals and strategic goals (Strategy and Goals) features

Feature Portfolio plan goals
Enterprise goals (Strategy and 
Goals)

Create strategic plans

Create strategic priorities

Create goals

Add targets

Associate work with goals or 
targets

Send reminders to owners 
and contributors for target 
actuals check in

Generate goal insights with 
Now Assist for SPM

Generate targets for goals with 
Now Assist for SPM

Note: 
Strategic plans and strategic priorities for portfolio plans can still be created using the list 
view within the Strategic Planning Workspace  or the classic UI. The key difference is that 
in Strategy and Goals, you can create these directly within the workspace — whereas for 
portfolio plans, they must be created outside the workspace and then associated with goals 
inside it.

Enterprise strategy example

In Strategy and Goals, you start by creating a strategic plan that captures your organization's 
mission, vision, and values. You then define strategic priorities that align with your mission 
and vision of your organization, and create goals under each priority to establish what your 
organization wants to achieve. For each goal, you can set targets to track and measure progress 
toward achieving it.

The following illustration provides an example of a strategic plan, including its strategic priorities, 
goals, and targets.
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Configuring Strategy and Goals

Strategy and Goals in Strategic Planning Workspace  requires no mandatory configuration to get 
started.

Unlike portfolio plan goals, you can create and manage goals on a board without prerequisites 
or limitations. For example, portfolio plan goals do not display if they are not created at the lens 
entity level or if the assigned entity fields are empty. In Strategy and Goals, all goals that match 
the applied filter criteria or selected entity are visible on the board. For details, see Managing 
boards in Strategic Planning Workspace  and Managing strategy and goals using boards.

Optional configuration for Strategy and Goals

Although no mandatory configuration is required, you can perform the following administrative 
tasks based on your organization's needs.

Migrate legacy goals data

If your organization uses the legacy goal and strategy tables (Goal, Enterprise 
Strategy, Business Unit Strategy, and Strategic Objective), you can migrate the 
existing data to the new tables by running a scheduled job. After migration, you can 
create boards and manage your existing goals and strategic priories. For details, 
see Migrate existing goals data to Goal Framework tables.

Set display limit for goals

By default, 250 goals are displayed in the Goals page. To modify this limit, configure 
the value in the sn_align_ws.goal_hierarchy.max_records  system 
property. For details, see Set display limit for goals and targets in Strategic Planning.
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Customize goal and target labels

You can customize the labels for the Goal [sn_gf_goal] and Target 
[sn_gf_goal_target] tables to match your organization's terminology. For example, 
you can rename Goal to Objective and Target to Key Result. For details, see 
Customize label for Goal and Target tables.

Configure assigned entities

You can define goals at any level in your organization without assigning them to a 
specific entity. Using advanced filter criteria when creating a board, you can manage 
a specific set of goals based on any goal field value. For example, you can create a 
board to manage goals that belong to the Chatbot team.

You can also create boards for your goals based on assigned entities. The default 
assigned entities are Business Unit [business_unit], Department [cmn_department], 
Company [core_company], Product Model [cmdb_model], Value Stream 
[cmn_value_stream], Initiative [sn_align_core_initiative], and Strategic Program 
[sn_align_core_program].

To create boards based on assigned entities other than the defaults, create an 
entry in the assigned entity configuration. For details, see Configure a table for an 
assigned entity.

Configure goal preferences

Configure goal preferences including the calendar type for goal setting, weighted 
average calculation for goal progress, and deletion settings for goals and targets. 
For details, see Configure goal preferences.

Configure reminders for target actuals

Configure reminders to automatically notify target owners and contributors 
to update actuals for their targets before the due date, based on the check-in 
frequency defined for each target. For details, see Configure reminders for target 
actuals.

Configure Goal insights generation

Activate the Goal insights generation scheduled job and configure the filter criteria 
to automatically generate AI-driven insights for a defined set of goals at a scheduled 
frequency. For details, see Goal insights generation job.
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Configure reminders for target actuals

Configure reminders to notify target owners and contributors to update actuals for their targets 
by a specified date.

Before you begin
Role required: sn_gf.goal_admin

About this task
The following two system properties must be configured to notify target owners and contributors 
to update the actuals for their targets:

• target_checkin_due_date_reminder_feature_toggle: Enables the reminder notifications 
feature for target actuals check-in.

• target_checkin_due_date_reminder_config: Defines the number of days before the due date 
to send the reminder. The following are the default values based on the check-in frequency:

Check-in frequency Default number of days before due date

None 7

Weekly 2

Monthly 5

Quarterly 7

Yearly 10

Procedure

1. Navigate to All  > System Properties  > All Properties.
A list of all the properties in the System Properties [sys_properties] table appears.

2. Search for each of the following system properties, enter the required value in the Value  field, 
and then select Update.

System property Value

target_checkin_due_date_reminder_feature_toggle Enter true  to enable reminder 
notifications.

target_checkin_due_date_reminder_config Enter the number of days before 
the due date to send the reminder 
automatically.

Result
Reminder notifications are enabled for target actuals check-in. Target owners and contributors 
are automatically notified to submit actuals for their targets based on the configured number of 
days before the due date and the check-in frequency defined for each target.

Goal insights generation job

The Goal insights generation scheduled job automatically generates AI-driven insights for a 
defined set of goals at a scheduled frequency.

Goal insights generation job configuration involves two components:
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1. Configure the goals set for goal insights generation by editing the default filter criteria. This 
step is required only when the predefined filter criteria does not match the goals set you want 
to run the job against. For details, see Configure the goals set for goal insights generation.

2. Activate the Goal insights generation scheduled job to automatically generate AI-driven 
insights for a predefined set of goals at a scheduled frequency. By default, the job is set to 
inactive. For details, see Activate and configure the Goal insights generation job.

Configure the goals set for goal insights generation

Configure the filter criteria for the Goal insights generation scheduled job to define the set of 
goals for which insights are automatically generated.

Before you begin
Role required: sn_gf.goal_admin

About this task
By default, the Goal insights generation job runs on the predefined set of goals using the goals 
filter criteria (Goal insights generation filter) in the system. If the predefined filter criteria doesn’t 
match goals set that you want to run the job, administrators must edit the predefined filter criteria 
to run the goal insights generation job on the specific set of goals as required.

Goal insights generation filter

Tip: 
Defining a precise goals set helps optimize AI resource usage and prevents excessive 
token consumption.

If a goal does not match the configured filter criteria, users can still generate insights for it 
manually by selecting the Goal insights  button on the Goals page.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Goals.
A list of all goals appears.

2. Select the predefined goals list view by navigating to List controls  > Filters  > Goal insights 
generation filter
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3. Select the Show / hide filter icon ( ).

4. Add or edit the filter conditions as needed per your set of goals on which you want to the 
scheduled job.

5. Select Save Filters  to save the filter criteria.

Result
The filter criteria is saved. The Goal insights generation job processes the goals that match the 
defined filter criteria and automatically generates insights for them at the configured frequency. 
Goals outside the filter criteria are not processed by the job.

What to do next
Activate the Goal insights generation scheduled job to automatically generate AI-driven insights 
for a predefined set of goals at a scheduled frequency. For details, see Activate and configure 
the Goal insights generation job.

Activate and configure the Goal insights generation job

Activate the Goal insights generation scheduled job to automatically generate AI-driven insights 
for a predefined set of goals at a scheduled frequency.

Before you begin
Role required: sn_gf.goal_admin

About this task
The Goal insights generation scheduled job is inactive by default. After activation, the job runs at 
the configured frequency and generates insights for all goals that match the admin-defined filter 
criteria. With this, goal users no need to generate insights individually for each goal.

Tip: 
For better reviews and recommendations, use the Goal insights skill with the AWS Claude 
model.
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Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.
A list of all scheduled jobs appears.

2. Search for and select the Goal insights generation job  scheduled job.

3. Select the Active  check box to run the job at a scheduled time.

4. In the Run  field, select the frequency at which you want to run the scheduled job.
For example, you can select Weekly  to run the job every week.

5. Select Update  to save the configuration.

Important: 
The job runs only on goals that match the defined filter criteria. Goals outside the 
filter criteria are not processed by the job. To optimize system resources and prevent 
excessive token consumption, define the filter criteria as specifically as possible. For 
details, see Configure the goals set for goal insights generation.

6. Optional:  To run the job immediately outside the scheduled frequency, select Execute Now.

Result
The Goal insights generation job is active and configured. The job automatically generates AI-
driven insights for all goals that match the defined filter criteria at the configured frequency. The 
latest insights and their timestamps are displayed on the Goals page.

What to do next
To generate insights for goals outside the filter criteria, users can manually select Goal insights 
on the Goals page for the required goal. For details, see Generate insights for a goal.

Managing boards in Strategic Planning Workspace

Using boards in Strategy and Goals within Strategic Planning Workspace, you can organize 
strategic plans, priorities, goals, and targets in a single, focused view.

Strategy and Goals within Strategic Planning Workspace  lets you create and manage boards. A 
board is a collection of strategic plans, priorities, goals, and targets based on your selected filter 
criteria—helping you stay focused and manage them effectively.
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Roles required for using and managing boards

Access level Required role

Read access to boards sn_apw_advanced.spw_goal_user_read

Edit access to boards sn_apw_advanced.spw_goal_user

Board types

When you create a board, you can choose whether to base it on strategic plans, strategic 
priorities, goals, or both.

• A strategy-based board lets you create and manage strategic plans and priorities, aligning 
high-level direction with the priorities your teams are executing against.

• A goals-based board lets you create goals and targets that align with your strategic priorities, 
with the ability to tailor the board by entity type and entity to focus on the goals that matter 
most.

• A combined strategy and goals board includes two pages—Strategy and Goals—supporting 
both strategic planning and goal execution within a single board.

Creating a combined strategy and goals-based board

What you can do with boards

Boards support the following capabilities to help you manage your organization's strategic 
priorities:

Filter and focus

Define what items appear on a board using advanced filter conditions. Build boards 
tailored to specific goals by entity type and entity, ensuring focus on the goals that 
matter most to your team or organization.

Share with stakeholders

Share boards with stakeholders to align efforts and drive shared outcomes. Shared 
boards give collaborators a consistent view of priorities and progress.

Add to favorites
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Add boards to your favorites for faster navigation. Favorited boards appear in your 
quick-access list, reducing time spent searching for frequently used views.

Create a board

Create boards that bring strategic priorities, goals, and targets together in one focused view, 
helping your organization stay aligned and drive measurable business outcomes.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
Boards can be configured in three ways:

• Strategy-based board: Tracks strategic plans or strategic priorities to align high-level direction 
with team execution.

• Goal or target-based board: Tracks goals, targets, or a combination, with filtering by entity type 
and entity to focus on the most relevant goals.

• A combined strategy and goals-based board: Tracks both strategy (strategic plans and 
strategic priorities) and goals or targets together.

Note: 
By default, only records with the Active field set to true are displayed.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select New board.

3. Make your selections by using the New board wizard.

a. On the Board details  step, fill the details and then select Next.

Option Description

Board name Enter a name for the board.

Select what you want to track Select one or both options to determine 
what you want to track on the board:

▪ Strategy: Enables you to filter strategic 
plans and strategic priorities that you want 
to view and track on the board. This option 
enables the Strategy page on the board 
after creation.

▪ Goals: Enables you to select entities 
to track goals for, or filter the goals and 
targets that you want to view and track on 
the board. This option enables the Goals 
page on the board after creation.

Selecting both Strategy  and Goals  options 
enables both Strategy and Goals pages on 
the board.
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Option Description

Select the start and end dates for the 
strategic priorities or goals you want to track

Fill the start and end dates for the board.

Note: 
The start and end dates for your 
board act as a date range filter for all 
the items (strategic plans, strategic 
priorities, and goals) displayed in the 
board.

b. On the Filter Strategy  step, fill the details and then select Next.

Option Description

Select what to filter by Select Strategic plans or Strategic priorities 
option based on which you want to filter 
data create board.

▪ Strategic Plans: Enables you to filter the 
strategic plans that you want to view on 
the board and their associated strategic 
priorities (if any).

▪ Strategic Priorities: Enables you to filter 
the strategic priorities that you want to 
view on the board and their associated 
strategic plans (if any).

For example, you can filter the strategic 
priorities that are part of the strategic plan, 
Enterprise AI transmission.
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Option Description

Filter conditions to show strategic plans / 
strategic priorities on the board

Apply the filters to see the required records 
on the board.

For example, you can further filter the 
strategic priorities that belong to the HR 
department.

c. On the Filter Goals/Targets  step, select an entity type from the Select an entity type  list, 
select the required entities, and then select Create.

Tip: 
To narrow your focus, select Advanced filter criteria  to apply additional filters on 
the goals or targets displayed on the board. For example, you can filter the goals 
associated with the Chatbot team.

You can use Previous  and Next  to navigate between the steps.

d. Select Create.
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

322



Result
The board is created and displays the Strategy page, Goals page, or both, depending on what 
you selected to track.

Related topics

Create a strategic plan

Create a strategic priority

Create a goal

Share a board

Modify a board

Update the details of a board, including its name, description, and configuration settings, to 
reflect changes in your strategic direction or organizational needs as they evolve.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. From the Strategy and Goals page, select the board you want to edit.

3. From the board page, select the Board actions icon ( ) and then select Edit.

4. Make your selections by using the Edit board wizard.

a. On the Board details  step, fill or update the details and then select Next.

Option Description

Board name Update name of the board if necessary.

Select what you want to track Update the options selection to determine 
what you want to track on the board:

▪ Strategy: Enables you to filter strategic 
plans and strategic priorities that you want 
to view and track on the board.

▪ Goals: Enables you to select entities 
to track goals for, or filter the goals and 
targets that you want to view and track on 
the board.

Selecting both Strategy  and Goals  options 
enables both Strategy and Goals pages on 
the board.

Select the start and end dates for the 
strategic priorities or goals you want to track

Update the start and end dates for the board 
if necessary.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

323



Option Description

Note: 
The start and end dates for your 
board act as a date range filter for all 
the items (strategic plans, strategic 
priorities, and goals) displayed in the 
board.

b. On the Filter Strategy  step, fill or update the details and then select Next.

Option Description

Select what to filter by Select Strategic plans or Strategic priorities 
option based on which you want to filter 
data create board.

▪ Strategic Plans: Enables you to filter the 
strategic plans that you want to view on 
the board and their associated strategic 
priorities (if any).

▪ Strategic Priorities: Enables you to filter 
the strategic priorities that you want to 
view on the board and their associated 
strategic plans (if any).

Filter conditions to show strategic plans on 
the board

Apply or update the filters to see the 
required records on the board.

For example, if you want to see the strategic 
priorities that belong to HR Department, 
select the filter as shown after this.

Department  > is  > HR

c. On the Filter Goals/Targets  step, select or update an entity type from the Select an entity 
type  list, select the required entities, and then select Create.

Tip: 

▪ If the Goals  option was selected in the Board details  step during board creation 
previously, the previously selected entity type is displayed instead of the Select an 
entity type  option.

▪ To narrow your focus, select Advanced filter criteria  to apply additional filters on the 
goals or targets displayed on the board.

You can use Previous  and Next  to navigate between the steps.

d. Select Update.

Result
The board is updated and displays the Strategy page, Goals page, or both, depending on what 
you selected to track.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

324



Related topics

Create a strategic plan

Create a strategic priority

Create a goal

Share a board

Share a board

Share your board with stakeholders and planning managers to provide visibility into goal and 
target progress, and enable collaboration across your organization.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
Users or groups that you want to share the board with must have the 
sn_apw_advanced.spw_goal_user_read or sn_apw_advanced.spw_goal_user role to get the read 
or edit access to the board respectively.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. From the Strategy and Goals page, select the board you want to share with stakeholders.

3. From the board page, select the Board actions icon ( ) and then select Share.

4. On the Share board window, fill the board sharing access details to collaborate on the board.

a. In the Board sharing and access  field, select Restricted  or Public.

▪ Restricted: Visible to users with whom the board will be shared.

▪ Public: Visible to everyone within your organization.

b. In the Members or Groups  field, enter the names of individual users or groups.
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Note: 
The Members or Groups  field doesn’t appear if the board sharing type is selected as 
Public.

c. Select Share  or Done.

Alternatively, you can select Copy link  for the Board actions icon and share it with your 
stakeholder to access the board.

Result
The selected individual and group users are notified of the board sharing through an email.

Related topics

Create a strategic plan

Create a strategic priority

Create a goal

Managing strategy and goals using boards

After creating a board, you can create strategic plans, priorities, goals, and targets that align with 
your strategic priorities to drive business outcomes.

A strategy-based board supports the full strategic planning hierarchy, from organizational 
purpose to measurable outcomes. A goals-based board focuses on goal execution and outcome 
tracking. You can also create a combined strategy and goals board, which includes two pages
—Strategy  and Goals—to help you focus on both strategic planning and goal execution.

You can do the following in a board to manage your enterprise goals and drive business 
outcomes:

• Define the purpose and direction of your organization by creating strategic plans that serve as 
the foundation for your priorities and goals. For details, see Create a strategic plan.

• Orient your strategic plan toward your goals by creating strategic priorities that reflect the most 
important areas of focus for your organization. For details, see Create a strategic priority.

• Create goals that align with your organizational strategic priorities, translating high-level 
direction into specific, actionable outcomes. For details, see Create a goal.

• Generate measurable targets for your goals using Now Assist for SPM. For details, see 
Generate targets for a goal in Strategic Planning Workspace using Now Assist for SPM.

• Set targets for goals to track and measure progress toward achieving each goal within the 
defined time frame. For details, see Add a target for goal.

• Align work or planning items with goals or targets to align your current or future work with your 
strategic priorities, helping your team achieve goals and targets efficiently. For details, see 
Align work with a goal or target.

• Associate a goal or target as the primary for the work and planning items where the items 
contribute to achieving the goal or target. For details, see Associate or update primary goal or 
target.

• Generate AI-powered insights for goals to identify at-risk goals, assess forecasted statuses, 
and act on recommendations before goals fall off track. For details, see Generate insights for a 
goal.

• Send reminders to the target owner and contributors to ensure target check-ins are completed 
before the due date. For details, see Send a reminder for target actuals check in.
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Roles required for managing enterprise goals using boards

Access level Required role

Read access sn_apw_advanced.spw_goal_user_read

Edit access sn_apw_advanced.spw_goal_user

Strategy and Goals pages on a board

• Strategy: The Strategy page displays the strategic plans and their associated priorities that are 
defined in the board or that match the board criteria.

• Goals: The Goals page displays the goals and its associated targets that are defined in the 
board or that match the board criteria.

Strategy page on a board

Goals page on a board
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Create a strategic plan

Create and manage strategic plans to define your organization's purpose, strategic priorities, and 
associated goals.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
You can create strategic plans only on boards that were created with the Strategy  tracking option 
selected.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the strategy-based board for which you want to create 
a strategic plan.
The Strategy page opens.

3. Select New strategic plan.

4. On the form, fill in the Name, Sponsor, Start date, and End date, and other required fields.
For a description of the field values, see Strategic Plan form.

5. Select Submit.

Related topics

Create a strategic priority

Create a goal

Create a strategic priority

Create a strategic priority to define and focus your organization's strategic direction, and align it 
with the goals you want to achieve.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the strategy-based board for which you want to create 
a strategic priority.
The Strategy page opens.

3. Select New strategic priority  or New  next to the Strategic Priorities heading.

4. On the form, fill in the Name, Strategic Plan, Owner, and other required fields.
For a description of the field values, see Strategic Priority form.

5. Select Submit.

What to do next
Define goals and set targets for them to accomplish the strategic priorities.

Related topics

Create a goal

Duplicate a goal or target

Add a target for goal
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Align work with a goal or target

Create a strategic plan

Create a goal

Create a goal and set targets to measure progress and align with your organization's strategic 
priorities.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the strategy-based board or goal-based board for 
which you want to create a goal.
The Strategy page opens if selected a strategy-based or combined strategy and goals-based 
board. The Goals page opens if selected a goals-based board.

3. Create a goal using one of the following methods depending on your board type.

4. On the form, fill in the Name  and other required fields.
For a description of the field values, see Goal form.

5. Select Save.

Related topics

Add a target for goal

Duplicate a goal or target

Align work with a goal or target

Create a strategic plan

Create a strategic priority

Add a target for goal

Create SMART targets for goals to track and measure the progress of your goals.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
If you’re using Now Assist for SPM, you can use the Target generation skill to generate targets 
for a goal. The skill uses the goal’s details and provided context to create a precise target for the 
goal. The more specific the input, the stronger the recommendations. For details, see Generate 
targets for a goal in Strategic Planning Workspace using Now Assist for SPM.

Configuring a target source for your target updates the Actuals to date  field on the Target form 
automatically. For more information on target automation, see Target actuals automation in 
Strategic Planning.

A SMART target can be defined as S = Specific, M = Measurable, A = Attainable, R = Relevant, 
and T = Time-bound.
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Note: 

• Only the owner or contributors of the goal can create targets for the goal.

• You can also restrict the access for a target record to the specific users by enabling the 
Confidential  field on the Target form if the ServiceNow®  ESG Management  application is 
installed.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the strategy-based board or goal-based board for 
which your goal belongs to.
The Strategy page opens if selected a strategy-based or combined strategy and goals-based 
board. The Goals page opens if selected a goals-based board.

3. Add a target for your goal using one of the following methods depending on your board type.

4. On the form, fill in the fields.
For a description of the field values, see Target form.

5. Select Save.
If you are adding a target from the New target window on the Goals page, you can also select 
Save and add a new target  and add more targets for the goal on the flow.

Result
The target progress records are automatically created when you save the target post populating 
the Actuals to date  field. The target progress records specify the progress of each target for the 
goal.

Note: 
When you delete a goal, its associated targets (if any) and their progress records are also 
deleted even though the Allow the deletion of targets  property is set to No.

What to do next
Update the progress of the target  manually if the target isn’t enabled for target automation.

Related topics

Create a goal

Duplicate a goal or target

Align work with a goal or target

Create a strategic plan

Create a strategic priority

Send a reminder for target actuals check in

Update the progress of a manual target

Update the progress of a target when its status is changed.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task

Note: 
Only the owner or contributors of the goal can update a goal target.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the strategy-based board or goal-based board for 
which your target belongs to.
The Strategy page opens if selected a strategy-based or combined strategy and goals-based 
board. The Goals page opens if selected a goals-based board.

3. Update the target for your goal using one of the following methods depending on your board 
type.

4. On the form, update the Actuals to date  or Actual  field and add a business justification in the 
Remark  field.

For a description of the field values, see Target form.

5. Select either Update  or Save.

Related topics

Create a goal

Duplicate a goal or target

Align work with a goal or target

Create a strategic plan

Create a strategic priority

Send a reminder for target actuals check in

Update the progress of an automated target

Update the progress of a target using the Update Actual value  related link on the Target form.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task

Note: 
Only the owner or contributors of the goal can update a goal target.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the strategy-based board or goal-based board for 
which your target belongs to.
The Strategy page opens if selected a strategy-based or combined strategy and goals-based 
board. The Goals page opens if selected a goals-based board.

3. Update the target for your goal using one of the following methods depending on your board 
type.

4. On the Target form, select the Update Actual value  related link.
For a description of the field values, see Target form.
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Related topics

Create a goal

Duplicate a goal or target

Align work with a goal or target

Create a strategic plan

Create a strategic priority

Send a reminder for target actuals check in

Duplicate a goal or target

Create a copy of an existing goal or target to align goals with your organizational strategic 
priorities. If the goal or target you want to create is similar to an existing one, duplicating the 
existing record saves your time.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
Goals are typically qualitative by nature. Goals should be ambitious and are expected to motivate 
and challenge your teams.

Note: 

• Only the owner or contributors of the goal can edit the goal.

• Goals and targets can be duplicated only from the goal‑based  board. However, you can 
create goals and targets from the Goals  tab on the Strategic Priority record page.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the goal-based board for which you want to duplicate a 
goal or target.

3. Select the Row context menu icon ( ) of the goal or target that you want to duplicate and then 
select Duplicate.

◦ For a goal, the New goal window opens with all details of the goal you copied from. You can 
update the details for the goal as needed and then select Save  to save the goal or select 
Save and add a target  to save the goal and add a target for the goal. For a description of the 
field values, see Goal form.

◦ For a target, the New target window opens with all details of the target you copied from. You 
can update the details for the target as needed and then select Save  to save the target or 
select Save and add a new target  to save the target and add another target for the goal. For 
a description of the field values, see Target form.

By default, the name is Copy of ABC  where ABC is the name of the target or target you 
copied from.

What to do next
Add more targets for the goals. For more information, see Add a target for goal  or Configuring 
target source for target automation.
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Related topics

Create a goal

Add a target for goal

Align work with a goal or target

Create a strategic plan

Create a strategic priority

Send a reminder for target actuals check in

Target actuals automation

Automate the actual value for your targets using the target automation feature.

Use the following steps as guidelines to enable actuals automation and configure a target source 
for a target using the target automation feature.

You must perform the following steps on the Target form  to enable target automation for the 
target.

1. Enter the Start value, Final target value, and Check-in frequency, and fill the other required 
fields for the target.

2. Select the Automate actual value  field.

3. Select a target source in the Actual value source  field, from which the value must be fetched 
for target automation.

A target source is a configuration (of a custom script, PA indicator, or Assessments) for a target 
to auto-update the actual value of the target, so that the progress of the target and its goal are 
auto-updated.
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You can select either the Benefit Plans option or a custom target source as a target source for 
the target. After selecting a target source, save the target record to view additional actual value 
source configuration.

◦ Benefit Plans target source - A target source that is created using a custom script where the 
actual benefit value of benefit plans of the planning items associated with the goal or target 
fetches the target actuals. Then the application updates the actual value of the target based 
on the actual benefit value.

When you select Benefit Plans target source (predefined target automation script for benefit 
plans) as the Actual value source for the target, the benefit_plan  field appears in the 
Variables section, from which you can select the required benefit plans for fetching the value 
and automating the actual value of the target.

Note: 
Only benefit plans of the planning items associated with the goal or target will be 
available to select in the benefit_plan  field as a source for target automation.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

334



◦ Custom target source - Create a custom target source and configure it as a source to update 
the actual value of the target. For instructions on how to create a target source, see Create a 
target source.

For instructions on creating targets for a goal, see Add a target for goal.

Related topics

Create a goal

Add a target for goal

Duplicate a goal or target

Send a reminder for target actuals check in

Target breakdowns

Breaking down a target into smaller periods (for example, Monthly) helps you set a target 
value for each month and focus on that specific monthly target. The target breakdowns are 
automatically created based on the Check-in frequency and Target value distribution set for the 
target.

The check-in frequency for a target can be set to Daily, Weekly, Monthly, Quarterly, or Yearly. 
Based on the Check-in frequency of the target, the corresponding target breakdowns are 
created. For example, if the Check-in frequency is set to Monthly for a target spanning for a year, 
12 monthly target breakdowns are created. Planned target values are automatically set for each 
target breakdown based on the Target value distribution setting of the target.

Note: 
The target breakdowns feature isn’t supported for qualitative targets.

The following examples help you understand how the target progress is calculated for targets 
with different target distribution type.

Example 1: Acquire 1200 new customers in the calender year 2026 (Track non-
cumulatively)
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In this example, you want to achieve a target of acquiring 1200 new customers in 
the calender year 2026 and track the progress monthly (non-cumulatively), then you 
can set the target as the following:

• Set the start date and end dates to 2026-01-01 and 2026-12-31, respectively

• Set the start value and final target values to 0 and 1200, respectively

• Set the Check-in frequency for the target to Monthly

• Set the Target value distribution to Split equally across the time period (non-
cumulative)

This Target value distribution means that the final target value is divided into 12 
equal values (planned target value for each target breakdown) which aggregates 
to the final target value. You can edit the planned target value later from the 
respective target breakdown record as needed.

In this case, the application creates 12 target breakdowns (January, February,
………, and December) for calender year 2026 and sets the Planned target value for 
each target breakdown to 100 (Final target value divided by the number of target 
breakdowns).

Because the application sums up the actual value entered in each monthly target 
breakdown, you must enter the actual value that is achieved in the particular month 
for the target breakdown. For example, you acquired 100 customers in January, 
then enter 100 as the actual value in the January target breakdown. And, you 
acquired another 100 customers in February, then enter 100 as the actual value in 
the February target breakdown. Similarly, if you acquired another 100 in March and 
100 in April, then enter 100 as the actual value in both the March and April target 
breakdowns.

The application sums up the actual values entered in each monthly target 
breakdown and rolls up the sum value to the actual value of the main target. Then, 
the progress of the target and its goal are auto-updated.

Example 2: Acquire 1200 new customers in the calender year 2026 (Track cumulatively)

In this example, you want to achieve a target of acquiring 1200 new customers in the 
calender year 2026 and track the progress monthly (cumulatively), then you can set 
the target as the following:
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• Set the start date and end dates to 2026-01-01 and 2026-12-31, respectively

• Set the start value and final target values to 0 and 100, respectively

• Set the Check-in frequency for the target to Monthly

• Set the Target value distribution to Spread linearly across the time period 
(cumulative)

This Target value distribution means that the final target value is divided linearly 
into 12 planned target values (such a way that the value for the last monthly 
breakdown is equal to the final target value). You can edit the planned target value 
later from the respective target breakdown record as needed.

In this case, the application creates 12 target breakdowns (January, February,………, 
and December) for calender year 2026 and sets the Planned target value for the 
January, February,………, and December breakdowns to 100, 200,…….., and 1200 
respectively.

Because the application considers only the actual value entered in the latest 
monthly target breakdown, you must enter the cumulative actual value in the latest 
monthly target breakdown. For example, you acquired 100 customers in January, 
then enter 100 as the actual value in the January target breakdown. And, you 
acquired another 100 customers in February, then enter 200 as the actual value 
in the February target breakdown. Similarly, if you acquired another 100 in March 
and 100 in April, then enter 300 and 400 as the actual value in the March and April 
target breakdowns, respectively.

The application considers the actual value entered in the latest monthly target 
breakdown and rolls up to the actual value of the main target. Then, the progress of 
the target and its goal are auto-updated.

Graphical visualisation of target progress

The Overview  tab in the target’s record page provides graphical visualization for the trend of the 
target progress based on the planned target value and the actual value of the breakdowns. You 
can also edit the planned target and view the check-in history of the target actuals selecting the 
Show check-in history  in the Actuals check-in information  section.
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Benefits of target breakdowns

The target breakdowns feature helps you when you want to set a target for a period but want to 
track the progress of the target in smaller periods such as daily, weekly, monthly, quarterly, and 
yearly. For example, you have set a target for a year with start value and final target values of 0 
and 1200, respectively. Also, you want to set monthly targets of 100 for each quarter. In this case, 
you can break down the target into monthly targets and set a target value for each month so that 
you can focus on the specific monthly target and update your actuals against those monthly 
targets.

The target breakdowns feature has the following benefits:

• Break down the long-term targets into short-term intervals such as Daily, Weekly, Monthly, 
Quarterly, and Yearly for a better tracking or reporting of your progress

• Set or modify a planned target value for each target breakdown as needed

• Update the actual value for each target breakdown and track the progress of the main target

• Focus on the specific short-term target (target breakdown) rather than the whole target

• Track the progress of your short-term and long-term targets cumulatively or non-cumulatively

• Visualize the trend of the target's process wrt the planned target in the line or bar chart

How the actual value is calculated when the check-in frequency set to None

When the check-in frequency is set to None for a target, the actual value must be entered in 
the Actuals to date  field in the main target record. The actual value entered must be cumulative 
irrespective of the time period of the target. Target breakdowns aren’t created when the check-in 
frequency is set to None.

Target breakdowns in target automation

If you’ve enabled the target automation feature for a target and set the check-in frequency and 
Target value distribution, the target automation feature automatically updates the actual value 
in the respective target breakdown based on the check-in due date. After the actual value of 
a target breakdown is updated, the value is rolled up to rolls up to the actual value of the main 
target. Then, the progress of the target and its goal are auto-updated.

Update the actual value of a target breakdown

Update the actual value of a target breakdown when its status is changed.
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

338



Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
Updating the actual value of a target breakdown automatically updates the actual value of its 
target. After the Actual to date  field of the target is updated, the progress value for the target and 
its goal are auto-updated.

Note: 
Only the owner or contributors of the goal can update the target breakdowns.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the strategy-based board or goal-based board for 
which your target belongs to.
The Strategy page opens if selected a strategy-based or combined strategy and goals-based 
board. The Goals page opens if selected a goals-based board.

3. Update the target for your goal using one of the following methods depending on your board 
type.

4. On the form, update the Actual  field for the target breakdown and add a business justification 
in the Remark  field.
For a description of the field values, see Target Breakdown form.

5. Select Save.

Result
After the Actual  field is updated, the progress value for the target and its goal are auto-updated. 
For information on how the progress value is calculated, see progress value calculation. For 
information on how the actual value of the target breakdown is rolled up to its target, see Target 
breakdowns.

Related topics

Update the progress of a manual target

Update the progress of an automated target

Create a goal

Duplicate a goal or target

Align work with a goal or target

Send a reminder for target actuals check in

Align work with a goal or target

Create a goal or target relationship with a planning item or any other item to identify and 
associate your current or future work and achieve your goals and targets.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
You can associate a goal or target with planning items as well as with any ServiceNow AI Platform 
table record.
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From the Align work window, you can associate a goal or target with multiple planning items at 
a time. From the Planning items tab of the goal or target, you can associate a goal or target with 
only one planning item at a time.

You can create goal or target relationships with a custom planning item 
from the Align work window only if the planning item table is added to the 
planning_item_types_allow_list  property. For more information, see Enable custom 
item types in Strategic Planning.

Note: 
When a goal or target relationship is created with a planning item (Project, Demand, or Epic) 
or any other ServiceNow AI Platform  table record, the record appears on the Aligned work 
tab on the goal record.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the goal-based board for which your goal or target 
belongs to.

3. Select the Row context menu icon ( ) of the goal or target that you want to align work and then 
select Align work.

4. On the Align work window, select items that you want to align.

a. Select Planning item  to align planning items or select Other item  to align any ServiceNow AI 
Platform  table records other than planning items.

b. From the list of items, select the items that you want to associate with the selected goal or 
target.
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Tip: 
You can search for the required items by applying a filter on the Name or any other 
required column.

c. Select Confirm.

For a description of the field values, see Goal/Target Relationship form.

Related topics

Create a goal

Add a target for goal

Duplicate a goal or target

Send a reminder for target actuals check in

Associate or update primary goal or target

Associate a primary goal or target for the planning items where the items contribute to achieving 
the goal or target.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
You can associate a goal or target as primary with a planning item by populating the Primary 
goal  and Primary target  fields on the Planning item form respectively. When you populate the 
Primary target  field, the Primary goal  is automatically populated with the goal of the populated 
target. For more information, see Planning item form.

After you associate planning items with goals or targets, you can check these relationships 
directly on the Planning items tab of the goal's form or on the Goal/Target Relationships tab of 
the planning item's form.

Note: 

• By default, the goal or target becomes the primary when you associate a goal or target 
with a planning item for the first time. Then after, association of any goal or target with 
the planning item becomes a secondary association unless the Primary  field is selected 
while associating the goal or target.

• When a planning item already has a primary goal association and you want to make 
another goal as primary, the existing primary goal association becomes secondary and 
the fresh association becomes primary for the planning item.

• Associating the primary goal or target isn’t supported for strategic items such as 
initiatives and strategic programs.

• To associate the primary goal or target with a custom planning item, ensure that the 
custom planning item is added to the planning_item_types_allow_list 
property.

Procedure

1. Open the required planning item form using one of the following options.

2. On the Item details side panel or Details  tab, fill in or update the Primary goal  and Primary 
target  fields with the goal and target respectively that you want to associate or update.
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Alternatively, you can select Add  in the Goal/Target Relationships  tab, populate the Goal  and 
Target  fields as needed, and then select Primary. The Primary goal  and Primary target  fields 
are then automatically populated on the planning item form.

For a description of the field values, see Planning item form.

3. Select either Update  or Save.

What to do next
If you want to remove the existing goal or target association, you can remove the association 
by selecting the association record and selecting the Remove  option on the Goal/Target 
Relationships tab of the planning item record. If the planning item has the primary goal and 
secondary goal association, you can remove the primary association only after you make any 
other goal as primary for the planning item.

Related topics

Create a goal

Add a target for goal

Duplicate a goal or target

Align work with a goal or target

Send a reminder for target actuals check in

Generate insights for a goal

Review AI-generated insights to identify at-risk goals, assess forecasted statuses, and act on 
recommendations before goals fall off track.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_apw_advanced.spw_goal_user

About this task
The Goal insights skill analyzes the goal, its targets, subgoals, and aligned work, then delivers 
concise, data‑driven  insights—including AI forecasted status, confidence of achieving the goal, 
targets at risk, delayed or stalled aligned work and recommendations.

Note: 
When you generate insights for a goal, insights are also generated individually for each of 
its targets.

The skill analyzes the real-time data — including check-in patterns, comments, and planned 
versus actual progress — to forecast goal status and surface proactive recommendations.

Tip: 
For better reviews and recommendations, use the Goal insights skill with the AWS Claude 
model.

Note: 
Only the owner or contributors of the goal can generate insights for the goal.
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Note: 
If the Goal insights generation job is enabled, it automatically generates insights for 
each goal based on the job's run frequency. Before manually regenerating, check the 
timestamp on the goal insights summary card to confirm when insights were last generated 
— regenerating unnecessarily increases token consumption. You can also view the last 
generated insights in the AI rationale  column of the goal list. If goal or target data has 
changed since the last run, select the refresh icon on the goal insights summary card to 
regenerate the insights.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. Select Favorites, Shared with me, Created by me, or Public, depending on where the board is 
located.

3. Select the board that contains the goal for which you want to generate insights.

4. From the list of goals, select the Goal insights icon next to the goal.

Alternatively, you can select Show insights  on the goal's full details page.

The Goal insights side pane appears to process the insights for the goal. After a while, 
the Insights by Now Assist pane shows the insights for the goal including AI forecasted 
status, confidence of achieving the goal, targets at risk, delayed or stalled aligned work and 
recommendations.

5. Review AI-generated insights to identify risk, assess forecasted statuses, and act on 
recommendations before goals fall off track.

Related topics

Create a goal

Add a target for goal

Duplicate a goal or target

Align work with a goal or target

Send a reminder for target actuals check in
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Send a reminder for target actuals check in

Send reminders to the target owner and contributors to ensure target check-ins are completed 
before the due date.

Before you begin
Role required: sn_apw_advanced.spw_goal_user

About this task
Sending the reminders to the contributor owner of the target helps them ensuring the target 
checkins before the due date.

Note: 
Only the owner or contributors of the goal or target can send check-in reminders.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. On the Strategy and Goals page, select the goal-based board for which your target belongs to.

3. Select the Row context menu icon ( ) of the target that you want to send a reminder and then 
select Send reminder.

4. On the Send target check-in reminder window, enter an optional message in the Message  field 
to help users update the target actuals, then select Send.

Result
Contributors are notified with a check‑in  reminder to update the target actuals.

Related topics

Create a goal

Add a target for goal

Duplicate a goal or target

Align work with a goal or target
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Strategy and Goals reference

Reference information to provide additional details about Strategy and Goals such as the fields, 
user roles, tables, and system properties information.

Note: 
This section covers reference information specific to Strategy and Goals, including user 
roles, tables, and system properties. For common reference information about tables, roles, 
and system properties installed with Strategic Planning, see Strategic Planning Workspace 
reference.

Components installed with Strategy and Goals

Several types of components are installed with installation of the Strategic Planning  application, 
such as user roles, tables, scheduled jobs, system properties, and custom scripts.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Note: 
This topic covers reference information specific to Strategy and Goals, including user roles, 
tables, and system properties. For common reference information about tables, roles, and 
system properties installed with Strategic Planning, see Strategic Planning Workspace 
reference.

Tables installed with Strategic Planning  Workspace

Table Description

Strategic Plan

[sn_gf_strategic_plan]

Stores the strategic plans defined for each planning organization 
hierarchy.

Strategic Priority

[sn_gf_strategy]

Stores the strategic priorities defined for the organization.

System properties installed with Strategic Planning  Workspace

Strategy and Goals system properties

Name Description

target_checkin_due_date_reminder_feature_toggle Option to enable the reminder 
notifications feature for target actuals 
check-in.

target_checkin_due_date_reminder_config Option to define the number of days 
before the due date to send the reminder 
for target actuals check-in.

The default values depend on the check-
in frequency set for the target:
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Strategy and Goals system properties  (continued)

Name Description

• For the None  check-in frequency, the 
default is 7 days.

• For Weekly  it's 2 days.

• For Monthly, it's 5 days.

• For Quarterly, it's 7 days.

• For Yearly, it's 10 days.

Scheduled jobs installed with Strategic Planning  Workspace

Scheduled job Description

Goal insights 
generation job

Generates goal insights automatically for the set of goals that match the 
defined goal filter criteria.

Strategic Plan form

Use the Strategic Plan form to define the purpose of your organization, its strategic priorities, and 
the associated goals.

Strategic Plan form

Field Description

Name Name of the strategic plan.

Sponsor Sponsor for the strategic plan.

Start date Start date for the strategic plan.

End date End date for the strategic plan.

Description A detailed description of the strategic plan.

Vision A brief description about where your organization’s business will be at some point 
in the future, based on its strategies and associated goals.

Mission A brief description about what your organization’s objectives are and its approach 
to reach those objectives.

Strategic Priority form

Use the Strategic Priority form to orient your organization strategic plan toward your goal.

Strategic Priority form

Field Description

Name Name of the strategic priority.

Parent Name of the parent strategic priority that this strategic priority contributes to.

Owner Owner of the strategic priority. By default, the name of the user creating the 
strategy is populated.
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Strategic Priority form  (continued)

Field Description

Start date Start date for the strategic priority.

End date End date for the strategic priority.

Type Strategic priority type. The available options are:

• Key Initiative

• Shared Vision

• Strategic Target

• Operating Principle

• Relationship Strategy

• Environmental

• Social

• Governance

• Artificial Intelligence

Status Status of the strategic priority. Status can be Red, Yellow, Green, or None.

Strategic 
Plan

Name of the strategic plan for which this strategic priority is created.

Description A detailed description of the strategic priority.

Feedback
Build a customer-centric feedback management system and optimize the process of creating 
and associating feedback and product ideas with Feedback  application.

https://player.vimeo.com/video/1015698735?
h=308bd4151e&badge=0&autopause=0&player_id=0&app_id=58479

Feedback  overview

The Feedback  application is available for users with a Strategic Portfolio Management  (SPM) Pro 
license.

The Feedback  application simplifies the process of gathering and analyzing user feedback to 
make informed decisions on your product. The intuitive interface provides real-time feedback on 
your product features, usability, and performance and help users to share their thoughts. With 
Feedback  application, you create feedback or product ideas and link them with a feedback or 
product idea or planning or non-planning items.

Leverage the multi-feedback summarization skill to quickly summarize one or multiple feedback 
and streamline feedback analysis. Create planning or non-planning items by copying the 
generated summary and save time on manual item creation. Use the Planning item Gen AI Docs 
skill to generate a summary from selected content in Docs.
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Get started

Explore

Learn the key features and business 
value of Feedback in Strategic Planning

Configure

Set up the core configuration for Feedback

Use

Manage feedback or product idea 
and take feedback-driven decisions

Reference

Get information about components, 
forms, tables, and system properties

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum of ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Feedback  application in Strategic Planning

Learn how to manage feedback and product ideas and make informed decisions in the 
Feedback  application.

Feedback  overview

The Feedback  application is designed to collect, manage, and evaluate feedback and product 
ideas. Feedback is received from various sources such as emails, social media, chats, meetings, 
and the Idea portal. With Feedback, you can analyze feedback on your product, link feedback 
to a product idea. You can associate feedback or a product idea directly to a planning or non-
planning item. This application aligns customer feedback with the product roadmap, identify 
trends and statistics, and track the progress of feedback implementation.

Feedback  benefits

With Feedback, you can:

• Gather feedback from users and make data-driven decisions about product development, 
improvements, and future strategies.

• Create feedback or product ideas and link them with a feedback or product idea or planning or 
non-planning items.
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• Import ideas from the Idea portal to Feedback  application.

• Configure Microsoft Outlook  add-ins to submit feedback directly from your Outlook account.

• Configure an email account in your instance so that sending emails to this configured email 
address creates a feedback record.

Benefit Feature Role

Capture and evaluate feedback from multiple 
sources to make informed decisions on your 
product.

Create Feedback in 
Strategic Planning

pf_user

Create and prioritize product ideas that can be 
implemented.

Create Product idea in 
Strategic Planning

pf_user

Manage your feedback by associating it with 
one or multiple product ideas that can be 
evaluated, prioritized, and worked on.

Associate feedback 
with a product idea

pf_user

Link your feedback or product idea to a 
planning or non-planning item to address 
concerns.

Associate a feedback 
or product idea with 
a planning item  and 
Associate a feedback 
or a product idea 
record with a non-
planning item

pf_user

Associate and manage goals associated with 
product ideas.

Associate a product 
idea with a goal

pf_user and goal_user

Collect and manage documents, files, or 
resources associated with product ideas.

Docs in Feedback pf_user

Import ideas from the Idea portal to Feedback. Integrate the Idea 
portal with Feedback 
application

sn_align_core.apw_admin

Create or submit feedback from the Microsoft 
Outlook  directly without disturbing the 
workflow.

Submit feedback from 
Microsoft Outlook

pf_user

Configure the non-planning items that you 
want to link with the feedback or product idea 
without having to switch between related 
items.

Configure non-
planning items for 
feedback or product 
ideas records

admin

Configure filters for feedback or product idea 
overview page to get information based on 
your preference.

Filter configuration admin

Generate concise and informative summary of 
customer feedback using Now Assist for SPM.

Summarize the 
feedback by using 
Now Assist for 
Strategic Portfolio 
Management (SPM)

pf_user

Generate a summary of selected text using 
Planning item Gen AI Docs skill.

Generate the 
summary for selected 
or complete content 
with Planning Item 

pf_user
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Benefit Feature Role

Doc Summarization 
skill

Refine planning item description using write planning item skill.Improve efficiency 
and quality using 
refine records skill 
with Now Assist 
Context Menu

sn_align_core.apw_user

Related topics

Configuring Feedback application in Strategic Planning

Managing Feedback application in Strategic Planning

Feedback reference

Configuring Feedback  application in Strategic Planning

Configure Feedback  application with other applications to submit your feedback.

Install the Strategic Planning  application from ServiceNow Store  and start configuring Feedback 
application. For more information on how to install Strategic Planning, see Install Strategic 
Planning.

Related topics

Configuring Strategic Planning Workspace

Install ServiceNow®  Add-in for Microsoft Outlook

Configure user roles and download the office add-in manifest file to use the ServiceNow®  add-in 
for Microsoft Outlook.

Before you begin
Role required: admin

Note: 

Verify that you have a ServiceNow®  add-in for Microsoft Outlook  (com.sn_outlook_addin).

Procedure

1. Navigate to All  > ServiceNow Add-Ins for Office  > Office Add-In-Manifests  from your 
ServiceNow  instance.

2. Select ServiceNow for Feedback.

3. Select Download Manifest.

4. Open your email account in Microsoft Outlook.

5. From the more items menu, select Get Add-ins  > My add-ins  > Add a custom add-in  > Add 
from File.

6. Select the manifest.xml  file that you’ve downloaded from your ServiceNow®  instance and 
select Open.

7. Select Install.
The ServiceNow for Feedback  tile is added in the custom add-ins section.

8. From the more items menu, select ServiceNow for Feedback, and log in with your credentials.
You can connect to your Microsoft Outlook  account with your ServiceNow®  instance.
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Related topics

Create feedback from Microsoft Outlook

Configure email for feedback submission

Create feedback from Microsoft Outlook

Create or submit feedback from Microsoft Outlook  directly. By configuring feedback creation 
and submission within Microsoft Outlook, project managers can easily provide feedback without 
having to switch between different applications.

Before you begin
Role required: pf_user

About this task
Project managers can provide feedback while performing their daily tasks on Microsoft Outlook. 
For example, if a Product Manager receives feedback over an email, they can submit the email 
directly as feedback using an Microsoft Outlook  add-in without disrupting the workflow.

Procedure

1. From your Microsoft Outlook  account, select an email that you want to use as feedback.

2. Select the ServiceNow for Feedback add-in.

The subject of the email is copied as the name of the feedback, and the body of the mail is 
added as the description. The source is auto-populated as Email.

3. From the Type list, select the Type  of feedback.

4. From the Assigned to  list, select the user.

5. Add a Tag  to the feedback and select Save.

Configure email for feedback submission

Configure email settings in your instance and send an email to this id to create feedback.

Before you begin
Role required: admin

About this task
Configure email settings in your instance use it to send an email directly. With the 
sn_apw_advanced.feedback.idea_feedback_queue_address  system property, 
you can configure email settings within your instance and submit feedback directly from your 
email account.

Procedure

1. Navigate to your instance.

2. Navigate to All  > System Properties  > Email Properties.

3. Optional:  Update the email properties.

a. Set Email sending enabled & Email receiving enabled  to Yes.

b. Set Automatically create users for incoming emails from trusted domains  to Yes.
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(Optional) The default value for this field is No. You can select Yes  to automatically create a 
user in the user table.

c. Select Save.

4. Update the system properties list.

a. Navigate to All  > System properties  > All properties  and search for 
sn_apw_advanced.feedback.idea_feedback_queue_address  property.

b. Open the sn_apw_advanced.feedback.idea_feedback_queue_address 
property and enter your instance email id in the Value  field.
Any configured email account can be used.

5. Select an existing email to forward as feedback or create feedback.

6. Select Send.

Integrate the Idea portal with Feedback  application

Integrate the Idea portal with Feedback  application to enable collaboration of product ideas with 
feedback.

Before you begin
Role required: sn_align_core.apw_admin

About this task
One-way synchronization is supported and mapping is done from the idea portal to Feedback. 
All the ideas are imported to Feedback. These ideas are created as feedback records in the 
Feedback  and the number of votes received for each idea is also imported. You can assess 
feedback popularity with the number of votes received and prioritize them to make informed 
decisions.

Procedure

1. Go to your ServiceNow  instance.

2. Navigate to All  > Strategic Planning  > Integrations.

3. View the alignment integrations for the internal applications by selecting ServiceNow Internal.

4. Create the table map between feedback and idea table by selecting Generate Default 
Mapping Configurations.
Mapping configurations consist of table, field, and choice maps for each record. For more 
information on creating custom mapping configurations between feedback and other tables, 
see Create custom mapping configurations.

Configure non-planning items for feedback or product ideas records

Configure non-planning items to link your feedback or product idea records to navigate quickly 
between related items.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System properties  > All properties.

2. Open the 
sn_apw_advanced.product_feedback_allowed_non_planning_items_for_link_item 
property.

3. Edit the property by selecting here.

4. In the value field, enter the non-planning item table name and select Update.
You can add the table name of an incident, case, scrum task, agile story, or tables from any 
global or scoped application. You can enter one or multiple table names separated by comma 
in the value field.

5. Configure the non-planning items that you want to link.

a. Navigate to All  > System Definition  > Tables.

b. Search for feedback from the Label list.

c. Open the feedback record that has the sn_align_core_feedback  table name and 
select the Show List  related link.

d. Open any feedback record, select the additional actions Configure  > Related Lists.

e. Select the Edit this view  link.

f. Move Related Items from Available panel to Selected panel.

g. Select Save.

6. Configure a form view with view name workspace_apw_new  for all the non-planning item 
tables added in step 4.

What to do next
Associate a feedback or a product idea record with a non-planning item

Configure the filters for feedback or product idea overview page

Configure the filters for the feedback or product idea overview page to display information based 
on the preferences of your users. Use filters to find and engage with feedback and product ideas 
that are the most relevant to their interests.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System properties  > All properties.

2. Open the sn_apw_advanced.product_feedback_product_idea_filters 
property.

3. Edit the property by selecting here.

4. In the value field, enter the field name in the query.
You can add field names in the JSON query. JSON has column objects for each filter. Each 
column object has two properties:

◦ fieldname: The field name on the feedback or product idea table.

◦ encodedQuery: The filter on the reference table.
You can only add reference or choice type fields on the feedback or product idea tables as 
filters. You can either add a new filter or add a condition to the existing filter.

5. Select Update.
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Managing Feedback  application in Strategic Planning

Use Feedback  application in Strategic Planning  and create Feedback  and product ideas to take 
data driven decisions during product development. Associate the feedback with a product idea 
or with a planning or non-planning item that can be tracked, prioritized, and implemented.

Use the following components to manage your Feedback  within Strategic Planning.

• Feedback

• Product idea

Feedback

Feedback  refers to a suggestion, issue, proposed solution, or problem statement provided 
by users or customers for a product. Strategic Planning  enables you to collect feedback from 
multiple sources and review the incoming feedback to understand the critical issues or feature 
requests. You can create feedback filters from feedback homepage. For more information on 
feedback filters, see Create feedback filters in Strategic Planning.

Feedback  overview

Get insights of feedback, number of product ideas linked to feedback, top tags, and customers 
based on the feedback count on the overview page. View trends and statistics based on these 
filters:

• Top tags, which are majorly used to conclude on the focus areas

• Top customers who are most actively submitting feedback

• Feedback received in the last seven days

• Feedback that is not linked to any product idea

• Feedback based on the overall status

• Feedback that is assigned and unassigned to the user

• Identify the overall sentiment distribution across your feedback data.

• Analyze the sentiments of the feedback received over the past nine months.

The following figure shows a sample overview of customer feedback and indicates the different 
features on the overview tab. For example, know which customer has provided the maximum 
feedback by viewing the feedback count based on top customers. Use the filters at the top of the 
page to view feedback information on the Feedback  application. For more information on filters, 
see Configure the filters for feedback or product idea overview page.
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Feedback  List view

As a Product Manager, you can see a list of feedback submissions received from users or 
customers. You can navigate, sort, filter, group, or link the feedback and prioritize your actions 
based on their requirements.

You can also create a feedback record and link it with an idea or planning items on this page. 
For example, you can select multiple feedback records and associate them with an idea, epic, 
demand, or project.
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Product idea

A product idea is a solution or improvement that is developed based on one or multiple feedback 
records, ensuring it benefits all the customers. Assess and prioritize the product idea or link it 
to another planning item (epic, demand, or project). Manage your product ideas and create a 
custom lens using the product ideas in Strategic Planning. Get an overview of product ideas, 
number of product ideas linked to the feedback, latest ideas, and planning state of the ideas. 
Use the filters at the top of the page to view the product ideas.

Product ideas List view

As a Product Manager, you can see a list of product idea submissions. You can sort ideas based 
on different attributes like planning state, MoSCoW, priority, and impact. Prioritize product ideas 
using the MoSCoW values in the list view. The list view displays linked feedback count and 
number of customers interested in a product idea. The number of customers is calculated or 
rolled up based on the linked feedback.

Product ideas list

Get started with these tabs to manage feedback or product idea.

Tabs in Feedback

Tabs Description Action

Details Provides additional information 
about the feedback that has been 
submitted.

• View and track the feedback 
information.

• Compose worknotes on the 
feedback.

• Add attachments or files to your 
feedback record.
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Tabs in Feedback  (continued)

Tabs Description Action

Product idea Enables you to manage the ideas 
that are linked to a feedback 
record. These ideas are evaluated, 
prioritized, and worked on.

• View and track the product ideas 
that are linked to the feedback 
record.

• Create a product idea and link it 
with the feedback record.

• Unlink the ideas from feedback 
record.

Planning item Track work items and ensure 
that the feedback translates into 
actionable items.

• View the number of planning items 
that are linked to the feedback 
record.

• Create a planning item and link it 
with the feedback record. Monitor 
the status of planning items and 
track the overall advancement of 
planning items.

• Unlink the planning items from 
feedback record.

Tabs in Product idea

Tabs Description Action

Details Detailed view of the product 
idea record. View the 
description, attachments, and 
activity.

• View the description, 
attachments, activity and 
access other relevant 
information associated with 
the product idea.

• Compose worknotes on the 
product idea.

• Add attachments or files to 
your product idea record.

Planning item Enables you to view the 
number of planning items 
linked to the product idea 
record.

• View the number of 
planning items that are 
linked to the product idea 
record.

• Create a planning item and 
link it with the product idea 
record.

• Unlink the planning items 
from product idea record.
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Tabs in Product idea  (continued)

Tabs Description Action

Goal/Target relationships Enables you to associate the 
product idea with specific 
goals that the idea aims to 
contribute to.

• Create and add goals to 
your product idea record.

• Remove the goals from your 
product idea record.

Feedback Enables you to view and 
manage the feedback 
records that are linked to 
the product idea. This tab 
displays feedback as cards. 
Selecting the card opens the 
feedback record and provides 
detailed information about the 
feedback.

• View the associated 
feedback that are linked to 
the product idea record.

• Select the feedback card 
to open the detailed 
information about the 
feedback.

• Sort feedback by status, 
priority, or other attributes.

• Search for feedback by 
titles, keywords, or content.

Doc Provides a centralized 
location for product managers 
to organize, store, and 
collaborate on documents 
related to the product idea 
or feedback or planning 
item. This can include 
detailed requirements, 
design documents, technical 
specifications, or any other 
files.

• Create multiple pages using 
templates.

• Tag or mention specific 
users within the 
documentation component.

• Mention a record to create 
a direct link of the record 
within the documentation 
component.

• Insert table, images, links 
and so on.

• Generate a summary of 
selected text in Docs using 
Planning item Gen AI Docs 
skill. For more information, 
see Generate the summary 
for selected or complete 
content with Planning Item 
Doc Summarization skill.

Related topics

Feedback reference

Create feedback filters in Strategic Planning

Create and organize feedback using feedback filters and reduce the need to manually apply 
filters each time to find specific feedback.
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Before you begin
Role required: pf_user

About this task
Project managers can retain the feedback filters, share them with team members or groups, and 
collaborate on specific feedback filters.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select Feedback  and then select New filter  to create a new filter.

3. On the form, fill in the Feedback filter name.
You can choose the filters or set up new filter condition if needed.

4. Select Confirm.

You can track your feedback filter, review statistics, and sentiments. You can also create new 
feedback directly from the filter page which is specific to this feedback filter.

Sort, pin, share, update, or delete the feedback filter card directly from feedback homepage. 
When sharing the feedback filter card, you can provide access to specific users or groups. You 
can also see who has access to the feedback filter card.

What to do next

• Update feedback filters in Strategic Planning

• Create Feedback in Strategic Planning

• Associate feedback with a product idea

• Associate a feedback or product idea with a planning item

Update feedback filters in Strategic Planning

Edit the details of a feedback filters and make real-time updates on your feedback filter.

Before you begin
Role required: pf_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select Feedback.

2. Create a feedback filter.
For more information, see Create feedback filters in Strategic Planning.

3. From the feedback page, select the feedback filter card that you want to edit.

4. Update the record details or delete the feedback filter card.

Create Feedback  in Strategic Planning

Create feedback using the Feedback  application and make informed decisions on your product.

Before you begin
Role required: pf_user
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select Feedback.

3. Select Feedback  and then choose one of these options to create a feedback.

4. On the form, fill in the fields.
For more information on fields and description, see Feedback form.

5. Select Submit.
You can now track your feedback. Go to the instance and search with the feedback number to 
open the feedback.

What to do next

• Update Feedback or Product idea records from the list page

• Associate feedback with a product idea

• Associate a feedback or product idea with a planning item

Update Feedback or Product idea records from the list page

Edit the details of a feedback or product idea record and make real-time updates using the list 
page of feedback or product ideas.

Before you begin
Role required: pf_user

About this task
Modify feedback or product idea records within the list view or side panel using inline editing. 
Edit the details inline from the list view or use the side panel. Enable quick updates for fields like 
short description, state, and others on the list page. You can use the full details page to add work 
notes, attachments, and view related lists of a feedback or product idea record.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the feedback or product idea list, select the feedback or product idea record that you 
want to edit.

You can use the full details page to edit the feedback or product idea record. Select  to 
open the preview of the feedback or product idea record from the list view.

3. Update the record details, attach files, or delete the feedback or product idea record.
Information of certain columns that aren't editable in the full details page can't be edited inline 
either. For example, product ideas count and votes. If you group the feedback or product idea 
records by any attribute, you can’t edit the short description of the items directly from the list 
view.

Associate feedback with a product idea

Link a feedback record with one or multiple product ideas that can be planned, prioritized, and 
executed.

Before you begin
Role required: pf_user
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select Feedback.

3. Select Feedback  and then Create feedback.

4. Once the feedback is created, select Link Product idea  to link the product idea.

5. Optional:  From the Product idea list page, select one or multiple product idea records that you 
want to associate and select Confirm.
You can view associated product ideas from Product ideas  tab.

Related topics

Associate a feedback or product idea with a planning item

Associate a feedback or a product idea record with a non-planning item

Associate a feedback or product idea with a planning item

Link a feedback or product idea record with a planning item. By doing this association, you 
can address customer concerns promptly in a central location and ensure that every input is 
considered when making decisions.

Before you begin
Role required: pf_user or apw_user

About this task
You can associate a feedback or product idea record with only one planning item at a time. You 
can link a feedback or product idea record with either a demand, epic, or project.

Note: 
When a feedback or product idea record is associated with a planning item (project, 
demand, or epic), the record appears on the Planning items tab on the feedback or product 
idea record.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select Feedback.

3. Select Feedback  and then Create feedback.

4. Once the feedback is created, from the link product idea list, select the planning item to 
associate with the feedback.

From the planning item list, select one or multiple records that you want to associate. You can 
follow similar steps for the product idea.
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5. Select Confirm.
You can view associated Planning items from Planning items  tab. Demands that are in the 
completed state cannot be associated with a product idea or feedback.

Create a product idea in Strategic Planning

Create a product idea using the Feedback  application and prioritize which ideas are important to 
users. Incorporate product ideas into feedback to enhance your product.

Before you begin
Role required: pf_user

About this task
User-created product ideas help in identifying focus areas of a product. These product ideas 
facilitate continuous improvement in the product development life cycle.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select Feedback.

3. Select Product idea  and then select New product idea.

4. On the form, fill in the fields.

For more information on fields and description, see Product idea form.

5. Select Submit.

What to do next

• Update Feedback or Product idea records from the list page

• Associate a product idea with feedback

• Associate a feedback or a product idea record with a non-planning item

• Associate a product idea with a goal

Associate a product idea with feedback

Link a product idea with one or multiple feedback records that can be analyzed, prioritized, and 
implemented.

Before you begin
Role required: pf_user

Procedure

1. Navigate to All  > Workspaces  > Strategic Planning Workspace.

2. Select Feedback.

3. Select Product idea  and then Create product idea.

4. From the Product ideas List page, select one or multiple ideas to associate.

5. Select Link Feedback.

6. From the Link Feedback list, select one or multiple feedback records and select Confirm.
You can now track your product idea. Go to the instance and search with the product idea 
number to open the product idea. You can also create a new feedback record and then 
associate it with the product idea using the Create new feedback link.
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Related topics

Associate a feedback or a product idea record with a non-planning item

Associate a product idea with a goal

Manage documentation in Feedback application

Associate a feedback or a product idea record with a non-planning item

Link a feedback record or product idea record with a non-planning item. By doing this 
association, you can address customer concerns promptly in a central location and ensure that 
every input is considered when making decisions.

Before you begin
Ensure to Configure non-planning items for feedback or product ideas records.

Role required: pf_user

About this task
You can associate single or multiple feedback records or product idea records with one or 
multiple non-planning items at a time. Non-planning items could be an incident, scrum task, agile 
story or item from any global or scoped application such as agile development, PPM standard or 
safe application.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select Feedback.

3. From the feedback list, select one or multiple feedback records that you want to associate with 
the non-planning item.
You can follow similar steps for the product idea. From the product idea list, select one or 
multiple ideas that you want to associate with the non-planning item and follow steps from 2 
through 4.

4. From the link product idea list, select the non-planning item.

The non-planning item is displayed in the link product idea list only if the item is configured. 
For example, if you have configured an incident, you can see the Link incident  option in the 
list.

5. From the non-planning item list, select one or multiple records and select Confirm.
You can now track your feedback or product idea with Related items Tab.

Associate a product idea with a goal

Create a goal relationship by associating one or more product ideas with goals. Focus and target 
on product ideas by defining specific goals.

Before you begin
Role required: pf_user or apw_user or goal_user
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select Feedback.

3. Select Product idea  and then Create product idea.

4. From the Product ideas List, select one or multiple ideas to associate.

5. Select Add.

6. From the Goal list, select a goal.
For more information on goals, see Align a planning item with goals or targets.

7. If you want to set a goal as primary goal, then select the Primary goal  check box.
The remaining fields are auto-populated from the goal record.

8. Select Save.
You can now track your goals from the Goal Relationship list.

Manage documentation in Feedback  application

Capture documents, files, or resources associated with a product idea in the Doc tab.

Before you begin
Role required: pf_user

Verify that you have a doc component plug-in (com.sn_docs) installed.

About this task

Procedure

1. Create a product idea in the Feedback  application.

2. From the Product idea list tab, select the record to open.

3. From the side panel, open the details of the record by selecting the Full Details  button.

4. Navigate to the Docs  tab.

5. From the Pages section, select Create page.

You can perform these tasks under the Doc  tab:
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◦ Select the more actions menu to delete, duplicate, or create child pages in the pages 
section.

◦ Use the forward slash on the keyboard to open a list of actions, including Mention a user  or 
Mention a record  as required.

◦ Customize the appearance of your text using the formatting section.

6. Select Save as Template  to save your worknotes.

Summarize the feedback by using Now Assist for Strategic Portfolio Management (SPM)

Generate a summary from the name and description of the feedback records so that you can 
analyze a large volume of feedback quickly without reading each feedback record manually. You 
can do this task by using the multi feedback summarization skill in the Now Assist for Strategic 
Portfolio Management (SPM)  application.

https://player.vimeo.com/video/1016235687?
h=c41764ac08&badge=0&autopause=0&player_id=0&app_id=58479

Before you begin

Important: 
This Now Assist  skill is now turned on by default. The skill will be automatically available to 
appropriate role users for the application. This change simply activates the skill and does 
not touch the roles that are needed to use the skill. The new default behavior works as 
follows:

New customers

When you install a Now Assist  product, designated skills will turn on 
automatically.

Existing customers who are upgrading

Any previously unconfigured skill will turn on automatically (the skill was never 
turned on, then off again).

There is no change to Now Assist  skills that are currently enabled and 
customized.

Previously configured skills that were turned on, then off, will remain inactive.

If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles and also add those custom roles to the In product role.

Role required: pf_user

About this task
With the feedback or multi feedback summarization skill, you can get enough details about 
the feedback that you received on your product so that you can improve the product features, 
usability, and performance.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select Feedback.

2. From the Feedback page, select any feedback filter card.

3. From the feedback list, select one or multiple feedback records.

View a loader for the side panel while the summary content loads for a more engaging loading 
experience.
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If you want to generate a summary for one feedback record, you can either generate it from the 
list level or at the record level. At the record level, the feedback summary is displayed in the 
Now Assist  component. The component is collapsed by default and expands to display the 
summary.

4. Select Summarize.

View an animation for the Now assist icon when you hover over it.

You can generate a summary of a single feedback record by using the feedback summarization 
skill. This image shows the AI-generated summary for a single feedback record.

You can use the multi feedback summarization skill to generate summaries of one or multiple 
feedback records. For example, you can analyze the high-priority feedback, filter them, 
summarize the records, and gain insights into the requirements.

Note: 
Because the information in these fields is automatically generated, it's a good idea to 
review the text and make sure it's accurate.

The feedback or multi feedback summarization skill uses the name and description 
information of the feedback record to generate a paragraph or bullet-point summary from the 
feedback.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

366



View the hover animation for the Now Assist icon on the Summarize button in the feedback list 
and Docs.

5. Optional:  When you're finished summarizing the feedback, you can expand or collapse the 
summary, provide feedback, copy it, or view information about it.

Note: 
The feedback summarization or multi summarization skill checks the feedback records to 
determine if enough information is available to generate a summary. If there isn't enough 
feedback content to summarize, you can add more content and retry.

On the side panel, you can select the preview record icon ( ) to view the additional details or 

select preview generated summary icon ( ) to view the summarization output.

6. Optional:  Select Copy and create epic  to copy the generated summary and create a planning 
item.

(Optional) Save time and streamline your work flow by linking the feedback with planning 
items, which eliminates the need to copy summaries. You can quickly create work items in 
Feedback  and view them in the roadmap.

Generate the summary for selected or complete content with Planning Item Doc 
Summarization skill

Quickly learn the details of the documents from the summary that is generated by Now Assist  in 
Strategic Planning.

Before you begin

Important: 
This Now Assist  skill is now turned on by default. The skill will be automatically available to 
appropriate role users for the application. This change simply activates the skill and does 
not touch the roles that are needed to use the skill. The new default behavior works as 
follows:

New customers

When you install a Now Assist  product, designated skills will turn on 
automatically.

Existing customers who are upgrading

Any previously unconfigured skill will turn on automatically (the skill was never 
turned on, then off again).

There is no change to Now Assist  skills that are currently enabled and 
customized.

Previously configured skills that were turned on, then off, will remain inactive.

If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles and also add those custom roles to the In product role.

Role required: sn_align_core.ap_read_only, sn_align_core.pf_read, 
sn_apw_advanced.eap_read_only, sn_apw_advanced.pf_user, sn_align_core.apw_user, or 
sn_align_core.ap_read_only

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

367



About this task
Minimize the time that you spend reading documents, meeting notes, project reports and so on 
by using a summary that is generated by Now Assist. You can also copy-and-paste the source 
materials that meet your learning needs in Docs and generate a quick summary.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and open any planning item 
records such as product idea from Feedback.

2. From the Docs  tab, perform one of these actions according to your requirements.

Note: 
Summarization of the entire content is also permitted for users with the read role.

3. Optional:  When you're finished summarizing the content in Docs, you can provide feedback, 
copy, or view information about it.

(Optional)

Note: 
Because the information in these fields is AI generated, it's a good idea to review the text 
and make sure it's accurate.

Only an administrator can activate the Now Assist  skills. For more information, see Configure 
Now Assist Admin features.

The Planning item doc summarization skill checks the doc content to determine if enough 
information is available to generate a summary. If there isn't enough content to summarize, you 
can add more content and retry.

Note: 
The Summarize  button is visible only if the Planning item doc summarization skill is 
active. If the selected text exceeds the token limit for Now Assist, the Planning item doc 
summarization skill can't be executed. If there is more content to summarize, you can 
remove some content and retry.

Feedback  reference

Reference information to provide additional details about Feedback  such as the fields, user 
roles, tables, and system properties information.
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Components installed with Feedback  application

Learn about several types of components installed with Feedback  application in Strategic 
Planning  such as user roles, tables, and, system properties.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description Contains role

[sn_align_core.pf_read] Can view the Feedback. None

[sn_apw_advanced.pf_user] Create, view, update, and 
delete the Feedback  entities.

• pf_read

• pf_basic

[sn_align_core.pf_basic] Create, view, update, and 
delete the Feedback  but 
cannot access the Feedback 
from Strategic Planning 
Workspace.

None

Tables installed

Table Description

Feedback

[sn_align_core_feedback]

Stores all the information about Feedback 
received from different sources.

Product idea

[sn_align_core_product_idea]

Stores all the information about product ideas.

Feedback relationship

[sn_align_core_m2m_feedback_rel]

Stores information about the feedback 
associated to an entity (planning or non-
planning items).

System properties installed

Name Description

sn_apw_advanced.feedback.idea_feedback_queue_addressSpecifies the address for creating or 
submitting the feedback. With the 
sn_apw_advanced.feedback.idea_feedback_queue_address 
system property, you can configure email 
settings within your instance and submit 
feedback directly from your email account.
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Name Description

sn_apw_advanced.product_feedback_allowed_non_planning_items_for_link_itemSpecifies the non-planning items that can be 
linked to feedback or product idea. With the 
sn_apw_advanced.product_feedback_allowed_non_planning_items_for_link_item 
system property, you can link non-planning 
items such as incident, scrum tasks, agile 
stories, or items from safe application, agile 
development, PPM standard, or any global or 
scoped application tables to your feedback or 
product idea.

sn_apw_advanced.product_feedback_feedback_filtersSpecifies filters to sort through 
feedback information. With the 
sn_apw_advanced.product_feedback_feedback_filters 
system property, you can configure to add and 
remove the filters on the feedback overview 
page.

sn_apw_advanced.product_feedback_product_idea_filtersSpecifies filters to sort through 
product idea information. With the 
sn_apw_advanced.product_feedback_product_idea_filters 
system property, you can configure to add 
or remove the filters on the product idea 
overview page.

sn_apw_advanced.pf_docs_config With the 
sn_apw_advanced.pf_docs_config, 
you can customize the Doc component using 
different attributes.

• Type: string

• Possible value: JSON with key-value pair 
with these attributes:

{
    "hideLeftPanel": 
 true/false,
    "hideDocTitle": false,
    "hideFavorites": false,
    "collapseLeftPanel": 
 false,
    "collapseRigthPanel": 
 false,
    "allowExternalLink": 
 false,
    "implicitSave": true,
    "recordMentionEnabled": 
 true,
    "userMentionEnabled": 
 true,
    "recordMentionConfig": 
 [{ (Record mention 
 configuration)
        "sourceTable": 
 TABLE_NAME,
        "filterCondition": 
 "",
        "label": TABLE_LABEL,
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Name Description

        "fields": [
            FIELD1_NAME,
            FIELD2_NAME
        ]
    }],
}

• Location: System Property [sys_properties] 
table

sn_align_ws.pf_max_list_items Specifies the maximum number of 
records displayed in the feedback 
or product idea list view. With the 
sn_align_ws.pf_max_list_items, 
you can customize the feedback or product 
idea list view by setting a limit for the number 
of records displayed.

• Type: integer

• Possible value: Any integer number greater 
than zero.

• Location: System Property [sys_properties] 
table

For more information on components installed with Strategic Planning, see Components 
installed with Strategic Planning Workspace.

Form field information for Feedback  application

Field information for forms used in the Feedback  application.

Product idea form

Learn about the fields of the Product idea form. Use this form to create or edit the details of a 
product idea in Strategic Planning.

Details tab of the Product idea form

Field Description

Name Brief description of the product idea.

Description Detailed description of the product idea.

Planning state State of the product idea. The available 
options are:

• New

• In Review

• Prioritized

• Done

• Cancelled
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Details tab of the Product idea form  (continued)

Field Description

Owner User assigned to this product idea.

MoSCoW Priority of the product idea is based on its 
importance. The available options are:

• Must have

• Should have

• Could have

• Won't have

Created by User who created this product idea.

Product Product associated with the product idea.

Customers Customers who have shown interest in the 
product idea. This field is automatically set 
based on the linked feedback.

Locations Location impacted by the product idea.

Department Department associated with the product idea.

Strategic program Strategic program associated with the product 
idea.

Work notes Notes for adding and tracking the activity of 
the product idea.

Dates section of the Product idea form

Field Description

Approved start date Approved start date for this product idea.

Approved end date Approved end date for this product idea.

Details section of the Product idea form

Field Description

Priority Priority of this product idea.

The following is the list of related tabs:

• Planning items tab: Displays all the planning items that are linked with the product idea record. 
For more information, see Associate a feedback or product idea with a planning item.

• Goal Relationships tab: Displays all the goals that are linked with the product idea record. For 
more information, see Associate a product idea with a goal.

• Feedback tab: Displays all the feedback records that are linked with the product idea record. 
For more information, see Associate a product idea with feedback.
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• Docs tab: Displays documents or information related to the product idea record. For more 
information, see Manage documentation in Feedback application.

• Related items tab: Displays all the non-planning items that are linked with the product idea 
record. This tab is only available if the non-planning items are linked. For more information, see 
Associate a feedback or a product idea record with a non-planning item.

Related topics

Create a product idea in Strategic Planning

Feedback form

Feedback form

Learn about the fields of the feedback form. Use this form to create or edit the details of a 
feedback record in Feedback.

Note: 
Operational Sustainability Workspace  and Strategic Planning  users can’t view the fields 
that aren’t added to the default/custom form layout in the workspace. Configure the 
default/custom form layout to view those fields. For information on how to configure the 
form layout, see Configuring the form layout .

Details tab of the Feedback form

Field Description

Name A brief description of the feedback.

Description Detailed description of the feedback.

Product idea count Number of product ideas associated with the 
feedback.

State Current state of the feedback. The available 
options are:

• Submitted

• Need more information

• Under review

• In backlog

• Planned

• In development

• Completed

• Unlikely to implement

• Duplicate

• Already exists

Assigned to User who is assigned to the feedback.

Source Source of the feedback. The available options 
are:

• Chat

• Customer meeting
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Details tab of the Feedback form  (continued)

Field Description

• Email

• Social media

• Idea portal

Type Type of the feedback. The available options 
are:

• Issue

• Enhancement request

• Insight

Product Product associated with the feedback.

Customer The customer who submitted the feedback.

Sentiment Sentiment of the feedback record. The 
available options are: Positive, Negative, or 
Neutral.

Created by User who created the feedback record.

Business application Business application that this feedback is 
related to.

The following is the list of related tabs:

• Product ideas tab: Displays all the ideas that are linked with the feedback record. For more 
information, see Associate feedback with a product idea.

• Planning items tab: Displays all the planning items that are linked with the feedback record. For 
more information, see Associate a feedback or product idea with a planning item.

• Related items tab: Displays all the non-planning items that are linked with the feedback record. 
This tab is only available if the non-planning items are linked. For more information, see 
Associate a feedback or a product idea record with a non-planning item.

Related topics

Create Feedback in Strategic Planning

Portfolio Planning in Strategic Planning Workspace
Portfolio Planning in Strategic Planning  Workspace helps product and portfolio managers align 
work with strategy across the organization, while facilitating Agile transformation by combining 
traditional and agile work streams.
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Get started

Explore

Learn the key features 
and business value 
of Portfolio Planning 
in Strategic Planning

Configure

Set up the core 
configuration

Use

Plan, fund, and align work 
across your company

Goals

Create goals, set targets, 
and evaluate the progress

Prioritize

Rank and prioritize work 
for your portfolio plans

Roadmap

Roadmap work for 
your portfolio plan

Report

Export portfolio plan 
status report as a PPT

Integrate

Integrate Strategic 
Planning with 

execution systems

Reference

Get details about 
components, form fields, 
and general guidelines

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Portfolio Planning in Strategic Planning Workspace

Learn about the features, functionality, and the business value that Strategic Planning  provides.

Strategic Planning  overview

Strategic Planning  uses Lenses to help you plan work for your company in a delivery perspective 
of your choice. Personalized portfolio plans that are created using a lens help you cascade 
the plans from the enterprise level down through portfolios and products or align work with an 
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organizational goal or a value stream. Prioritize and roadmap relevant work, thus aligning the right 
execution teams to the right strategy.

After strategic plans are broken down into planning items such as projects or epics, you can 
schedule these items into your product or portfolio roadmaps. Using hybrid roadmaps, you can 
roll up both Waterfall and Agile work items to a shared initiative. You can also plan capacity and 
financials for each of these planning items all from a single workspace.

From the following table, learn about features of Strategic Planning  in detail and how they enable 
managers to draw effective plans and drive agile transformation across the company.

Features and Benefits

Feature Benefit

Lens
Choose a planning perspective to prioritize, 
fund, and align your work.

Lens configuration Use six predefined lenses or create custom 
lenses.

Portfolio plans Enable focused planning of work in the 
desired lens to align with strategy and drive 
shared outcomes.

High-level portfolio plans Prioritize and roadmap work at a high-level 
by building portfolio plans for strategic items 
such as initiatives.

Planning items Plan work in the form of projects, epics, 
demands, or a custom type to suit traditional, 
Agile, or hybrid approaches.

Prioritization
Facilitate smoother backlog grooming and 
prioritize the right work using List, Kanban, and 
Hierarchy views.

Portfolio roadmaps
Visualize the prioritized work into roadmaps 
and set milestones to track key outcomes.

Free-form roadmaps
Flexibly plan and track work across the 
company, without restricting to a planning 
organization or portfolio.

Scenario planning Optimize your portfolio planning by comparing 
potential outcomes, assessing their alignment 
with strategic goals, and approving the best 
scenario as your live plan.

Scoring Start scoring items in your portfolio plan to 
prioritize work based on a pre-defined or a 
custom score.

Goal management Create goals for portfolio plans, set targets for 
them, and evaluate the progress of the goals 
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Feature Benefit

and targets to accomplish your organizational 
plans and drive business outcomes.

Diagnostics Identify and fix errors in the configuration and 
other common settings.

Capacity Planning Generate, view, and better plan the resource 
capacity for your prioritized planning items.

Financial planning View the financial planning of your planning 
items using the comprehensive view in the 
new Financials screen.

Comparing Portfolio Planning Workspace  with Strategic Planning Workspace

• Portfolio Planning Workspace: Prioritize, roadmap, and track work when using waterfall 
methodology. Enhance traditional portfolio planning for demand and project management. To 
learn more about Portfolio Planning, see Portfolio Planning.

• Strategic Planning Workspace: Prioritize, roadmap, and track work when using traditional, agile, 
or hybrid methodologies. Align strategy to execution by defining and tracking goals across the 
organization.

Feature Portfolio Planning Workspace Strategic Planning Workspace

Pre-defined lens: Project 
Portfolio

Pre-defined lens: Organization

Pre-defined lens: Project 
Program

Pre-defined lens: Product

Pre-defined lens: Strategic 
Investments

Pre-defined lens: Goals

Pre-defined lens: Value 
Stream

Pre-defined lens: Business 
Capability

Lens configuration: Modify 
existing lens

Lens configuration: Create 
new lens

Portfolio plans: Create and 
share

Planning items: Supported 
planning items

Project, Demand Project, Demand, Epic, 
Custom
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Feature Portfolio Planning Workspace Strategic Planning Workspace

Supported items for high-level 
planning

Program (pm_program) Strategic Program, Initiative, 
Custom

Planning items: Custom 
planning item tables

Five predefined tables

Prioritization

Hierarchy (Prioritization)

Kanban (Prioritization)

Roadmaps: Timeline

Roadmaps: Kanban

Scenario planning

Scoring

Goals

Product Feedback

Capacity planning

Financials

Create and share free-form 
roadmaps

Project, Demand, and Program 
tables

Any ServiceNow®  platform 
entity

Enterprise Agile Planning

Dashboards

Monitor goals and strategies 
in ServiceNow  AI Control 
Tower

Strategy and Goals - 
Managing enterprise goals 
using boards

Next Experience for Demand 
Management

Lenses in Strategic Planning

Lenses represent planning perspectives, which would be different for planning managers at 
different levels in an organization. Lenses enable you to create personalized portfolio plans 
through which you prioritize and align work with high-level initiatives and goals.

Lenses overview

Lenses in Strategic Planning  indicate a perspective in which you can plan and fund work. By 
selecting a lens, you choose a planning perspective to prioritize and align your work in. For 
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example, if you're a department leader, you can choose the Organization lens. If you're a product 
manager, you can choose the Product lens.

Lens structure

Each lens in Strategic Planning  consists of a structure that is made up of entities. Lens entities 
represent different levels of planning for your company. You can build portfolio plans at one of 
these levels.

The planning item types associated with the bottom entity of a lens represent the type of work 
that can be planned using these portfolio plans.

Sample lens structure

For example, the Organization lens has a Company, Business Unit, and Department as 
its entities. As the head of the Support department, you can create a portfolio plan at the 
department level. Then, you can prioritize the work that is assigned to the department and plan a 
roadmap for the prioritized work. This work can be in the form of epics, projects, demands, or any 
other custom type.

Get started with one of the pre-defined lenses, or build a custom lens structure, with up to six 
levels, to suit your planning needs.

Pre-defined lenses and their structure

Strategic Planning  provides nine pre-defined lenses to get you started with building your 
portfolio plans - Project Portfolio, Project Program, Organization, Strategic Investments, Product, 
Digital Product, Value Stream, Goals, and Business Capability. Planning managers can use these 
lenses based on their role at the company.
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Structure of pre-defined lenses

Lens
Planning levels (Lens 
entities)

Planning manager Description

Organization

• Company

• Business unit

• Department

• Department head

• Business unit head

Plan and track the 
delivery of work in 
my organization and 
visualize how the work 
is aligned to various 
levels.

Product

• Company

• Product models

• Product leader

• Product manager

Plan, fund, and 
prioritize work from a 
product lens.

Digital Product

• Application Model

• Product Feature

• Product 
Enhancement

• Product leader

• Product manager

Plan, prioritize, and 
roadmap work for 
digital products.

If the ServiceNow® 

Digital Product 
Release  Workspace is 
installed, the planning 
items associated 
with the product 
enhancement appear 
in the Planning items 
tab of the Release 
scope page in Digital 
Product Release 
Workspace. For 
details, see Scope of 
a release .

Strategic Investments

• Company

• Strategic priority

• Strategy leader

• EPMO

Plan, manage, and 
provide oversight for 
strategic initiatives or 
programs regardless 
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Lens
Planning levels (Lens 
entities)

Planning manager Description

• Initiative

• Strategic program

of who is doing the 
work.

Goals
Goal • Portfolio manager

• Business unit head

• Create, share, and 
collaborate on a 
portfolio plan for 
defined goals.

• Set targets for the 
goals to track their 
progress.

• Align, prioritize, 
and roadmap the 
work you must do to 
achieve them.

Value stream

• Product model

• Value Stream

• Value stream 
manager

• ART manager

Plan, fund, and 
prioritize work for a 
value stream.

Project Portfolio
Portfolio • Product manager

• Portfolio manager

Plan, fund, and 
prioritize work in your 
project portfolios.

Business Capability • Business capability

• Business 
application

Enterprise architect Plan, prioritize, 
and roadmap the 
work based on 
your business 
capabilities or 
business applications.

This lens can be 
used only if the 

ServiceNow® 

Enterprise 
Architecture 
Workspace  is 
installed.

Project Program • Portfolio

• Program

• Portfolio manager

• Program manager

Plan, prioritize, and 
roadmap the work in 
your programs.

• If you're an admin, you can modify the structure for these pre-defined lenses or configure a 
new lens altogether based on your planning manager's requirements. For more information, 
see Lens configuration in Strategic Planning.

• If you're a planning manager, learn about portfolio plans to start aligning your work with the 
business strategy. See Portfolio plans in Strategic Planning.
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Portfolio plans in Strategic Planning

Personalized portfolio plans help you align work with your company's objectives and roadmap 
the right work for the right time. Drive shared strategy using planning insights from portfolio plans 
and improve enterprise planning.

Portfolio plans overview

Portfolio plans are custom plans per planning manager that are built using a lens. They enable 
planning managers to define goals, set targets for these goals, and then roadmap the work to 
ensure alignment between goals and the planned work.

A strategy leader using the Strategic Investment lens plans in the perspective of initiatives, and a 
department head using the Organization lens plans in the perspective of a department.

As a planning manager, you can create multiple portfolio plans using different lenses. Visualize 
the plans and progress of work from different perspectives and share them with stakeholders.

Using portfolio plans, you can:

• Enable focused planning of work in the desired perspective (lens).

• Prioritize the right work and improve alignment with business strategy.

• Reduce the time spent on aligning execution teams to the right work.

High-level planning using portfolio plans

In Strategic Planning, you can roadmap work for your organization at a high level by building 
portfolio plans for strategic items such as initiatives. High-level planning items usually span 
across multiple business units, departments, or portfolios of a company. These strategic work 
items help you further breakdown a company's priorities.

• Initiative: Used to achieve long-term goals. Initiatives are designed to create a sustainable 
competitive advantage for the organization. They often involve large-scale effort that requires 
coordination and collaboration across multiple departments or business units.

• Strategic Program: Used to achieve specific milestones and outcomes of an Initiative.

• Program (pm_program): Used to achieve milestones and outcomes of a program.

• Product Enhancement: Used to plan and achieve feature enhancements for digital products.

Using the Hierarchy view, review the work pipeline and drill down to the low level planning items 
that are associated to your strategic item.

For example, as an EPMO, you can view the epics associated to each initiative. Also, you can 
view and manage the goals that these initiatives are aligned to.

By default, you can use Initiatives or Strategic Programs from the Strategic Investments lens or 
Programs (pm_program) from the Project Program lens to create high-level portfolio plans. See 
Create a high-level portfolio plan.

If you need high-level planning enabled for items other than Initiatives, Strategic Programs, 
Programs (pm_program), work with your ServiceNow  admin to complete the additional 
configuration. See High-level planning configuration in Strategic Planning.
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Here's a sample portfolio plan that shows a few strategic programs of the 
company and the low-level work (projects and demands) that are aligned with 

them.

Work with your administrator to ensure the required lens setup. See Lens configuration in 
Strategic Planning.

Start creating portfolio plans to align work with strategy. See Managing portfolio plans in Strategic 
Planning Workspace.

Scoring in Strategic Planning

Scoring enables you to prioritize items, such as epics, projects, demands, initiatives, strategic 
programs, and other planning items, based on a defined quantitative metric.

Before selecting a scoring framework for your portfolio plan, it's helpful to first learn about the 
pre-defined frameworks available for you to use. Later you can choose if you want to use one 
of the pre-defined scoring frameworks, or create a custom scoring framework, based on your 
preferred scoring parameters.

The following are the three pre-defined scoring frameworks available to use for your portfolio 
plan:

• RICE

• Value vs Effort

• WSJF

RICE

A framework to prioritize and evaluate items by scoring each criterion. It helps teams assess and 
compare items based on four key criteria: Reach, Impact, Confidence, and Effort.

Parameters:

• Reach- Indicates the number of people or users who will be affected by the project or feature. 
It's essential to estimate the potential audience that the item can reach. For example, if a 
new feature is likely to be used by a small subset of users, it might have a lower reach score 
compared to a feature that will be utilized by a large portion of the user base.

To populate this value, answer the question- How many existing/target users within a given 
period of time?
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• Impact- Measures the potential impact or benefit that the item will bring to the users or the 
organization. This criterion focuses on the positive outcomes and value that the project can 
deliver.

To populate this value, answer the question- How much will this impact individual users?

• Confidence- Confidence gauges the level of certainty that the project will achieve its intended 
results. This criterion assesses how confident the team is in their estimates of reach and 
impact. Items with higher confidence are generally based on solid data, user feedback, or 
previous experiences, making it more likely for them to deliver the expected results.

To populate this value, answer the question- How confident are you about the impact and 
reach scores?

• Effort- Duration in person months, based on product, design, and development effort. This 
criterion helps teams understand the relative difficulty of executing. Items with higher effort 
scores may require more development time, financial investment, or significant changes to 
existing systems.

To populate this value, answer the question- How much time will this item require in person 
months?

The RICE score is calculated with this formula:

RICE Score = (Reach x Impact x Confidence)/Effort

Value vs Effort

A framework to prioritize planning items, based on the effort estimate and the value it brings to 
the users/customers. The Value vs. Effort method is the quickest way to prioritize your backlog 
items.

Parameters:

• Value- Significance of items based on the potential revenue, user benefit, business impact, 
and strategic goals.

To populate this value, answer the question- How does this contribute to your goal?

• Effort- Duration to build the product, including product, design, and development estimates.

To populate this value, answer the question- How difficult it is to deliver the task?

The Value vs. Effort score is calculated with this formula:

Value vs. Effort Score = Value/Effort

WSJF

A framework to sequence items for maximum benefit, particularly useful where frequent re-
prioritization is a driver of economic value. This score is based on the relative cost of delay and 
relative job duration, business value, time criticality, risk reduction, and job size.

Parameters:

• User Business value- The relative importance to the users/customers and its potential impact 
on revenue.

To populate this value, answer the question- How important is this item to your business?
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• Time Criticality- Identifies how the user business value will decay over time and denotes the 
urgency to release the item/feature.

To populate this value, answer the question- How does the item value decay over time?

• Risk Reduction- Identifies the items that can reduce technological and business risks and 
enable new opportunities.

To populate this value, answer the question- What else does the item do for your business?

• Job Size- Relative duration to complete the task.

To populate this value, answer the question- When will you complete the task?

The WSJF score is calculated with this formula:

WSJF Score = (User Business value + Time criticality + Risk 
 reduction)/Job Size

To get started with Scoring your planning items in Strategic Planning, see Scoring planning items 
in Strategic Planning Workspace.

Related topics

Custom scoring frameworks in Strategic Planning

Goals in Strategic Planning

Create goals for your portfolio plan, set targets for them, and evaluate the progress of these goals 
and targets to accomplish your organizational plans and drive business outcomes.

Goals key components:

• Goals: Objectives that you want to reach based on your strategic plans.

• Targets: Targets for goals to track and measure the progress of the goals.

• Target source: A configuration for a target to auto-update the actual value of the target.

Goals

Goals refer to objectives that an organization sets for itself to accomplish their organizational 
plans. Goals are typically qualitative by nature. Goals should be ambitious and are expected to 
motivate and challenge your teams. Some examples of goals are as follows:

• Using renewable energy by the end of the year 2022.

• Increase diversity in the workplace by 50 percent.

A goal can also have subgoals. You can associate work (planning items) to a goal so that you can 
track who is responsible for fulfilling the goal.

You can associate planning items - Demand, Project, and Epic, and strategic items - Program and 
Initiative - with a goal to capture the work being done to meet your goal.

Targets

Targets help you measure your goal. For example, to meet the goal of increasing diversity in the 
workplace by 50 percent, the target can be to hire a 30 percent diverse workforce by the first 
quarter of 2022.
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Targets can be quantitative or qualitative, by defining the unit of measure for the target. 
Quantitative targets are numbers-based, countable, and measurable. Qualitative targets are 
interpretation-based, descriptive, and typically a yes or no type.

You can also break down a target into smaller periods (for example, Quarterly), which helps you 
set a target for each quarter and focus on the specific breakdown targets. The target breakdowns 
are automatically created based on the breakdown interval set for the target. For details on how 
the target breakdowns feature works, see Target breakdowns in Strategic Planning.

Qualitative targets

Qualitative targets are typically non-measurable but can be tracked if the target has 
been achieved. The available unit of measure for qualitative targets is Yes/No. You 
can also define a custom unit of measure (for the available choice set) for qualitative 
targets according to your need and set qualitative targets for your goals.

For example, to achieve a target of conducting a hackathon in Q2-2023, the target 
can be set as conduct a hackathon in Q2-2023 with the unit of measure Yes/No. The 
base and target value of the target can be No and Yes, respectively. After the target 
is successful with the hackathon event, the target value can be updated to Yes.

Target sources

A target source is a configuration for a target to auto-update the actual value of the target, so that 
the progress of the target and its goal are auto-updated. Any table or a combination of tables 
(for example, benefit plans, cost plans, surveys, incidents, and PA indicators) present on the 
ServiceNow AI Platform®  can be configured as a target source.

The following target source types are supported for automating the actual value of a target:

• PA Indicator: Updates the Actual to date  field on the target form by fetching the required data 
from the PA Indicator.

• Assessment/Survey: Updates the Actual to date  field on the target form by fetching the 
required data from the Assessment metric type and Assessment metric category records.

• Custom script: The Custom script fetches the required data from any ServiceNow AI Platform 
table that is configured. With the Custom script option, any table or a combination of tables 
present on the ServiceNow AI Platform  can be configured as a target source.

Predefined target automation script for benefit plans: The predefined, default script is a target 
source that updates the Actual to date  field on the target form by fetching the value from the 
Actual benefit  field or Non-monetary actual benefit  field from the monetary or non-monetary 
benefit plans of relevant work items.

Context variable

The context variable is an additional configuration for the target source. The context 
variable provides information that can be used on the Target form to fetch the 
required data and update the Actual to date  field on the Target form. The context 
variable is required for target source types Assessment/Survey and PA Indicator. If 
the Goal Framework for SPM  scope is selected while creating a target source, the 
context variable is automatically created for the target source (of type Assessment/
Survey and PA Indicator). For more information on context variables, see Context 
variable in target source.
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Example goals view

Goals workflow in Strategic Planning

Using the Goals view in the Strategic Planning  Workspace, you can do the following activities:

• Create a goal for an entity such as company, business unit, department, and so on. For more 
information, see Create a goal in Strategic Planning.

• Set targets and automate the actual value of the targets. For more information, see Add targets 
for a goal in Strategic Planning.

Note: 

◦ Automating the actual value of the targets is optional. If you don't want to automate 
the actual value of your targets, you can still update the actual value of the targets 
manually.

◦ You can also generate targets for your goals using the Target generation skill, if the Now 
Assist for SPM  application is installed.

• Associate a planning item with goals. For more information, see Align a planning item with 
goals or targets.

• Associate or update the primary goal for a planning item. For more information, see Associate 
or update the primary goal or target for a planning item.

For more information on how to define and manage your goals in Strategic Planning  see 
Managing portfolio plan goals in Strategic Planning Workspace.

Prioritization in Strategic Planning

Prioritize work that is relevant for your portfolio using a centralized workspace in Strategic 
Planning. Review and determine the right work to invest in.

Before scheduling the roadmap for your portfolio plan, it’s helpful to first know the existing and 
upcoming workload. Having all the work items listed at one place helps you understand the 
overall work pipeline. The consolidated view enables smoother backlog grooming so that you 
easily review and decide which items must be prioritized.

Using the Prioritization tab in the workspace, you can review all the new and existing work 
for your portfolio plan, representing its backlog. To help you review the workload efficiently, 
Prioritization provides information for each work item such as the associated goal, planned costs, 
and planned benefits. Using these data points, you can stack-rank the items and decide which 
items are to be prioritized over the others.

Prioritization tab

Planning items are listed in a grid format. You can stack-rank the items, group them 
by a desired attribute, and sort them based on their priority by using the drag 
functionality.
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Alternatively, you can also use the Kanban or Hierarchy tab to review and manage your backlog.

Kanban tab

Planning items are displayed in a Kanban board. Portfolio managers can visualize 
and adjust items in vertical lanes and horizontal lanes. Using the Personalize 
settings, you can choose to modify the attributes by which you want to view your 
vertical lanes and the horizontal lanes. For example, you can view the records 
grouped by planning state and priority, by simply changing the values of the vertical 
lanes and horizontal lanes. You can also choose not to have any horizontal lane 
value, by selecting None  from the drop-down list. The data displayed on the cards 
can be modified using the side panel. With this feature, you will be able to prioritize 
more effectively and view just the required details on the cards. Also, click the card 
to open a side panel with details, to edit the planning item details on the same page.

Hierarchy tab

This tab displays how work in the current portfolio plan is aligned with respect to 
entities of other lenses. Using the lens switcher, you can change the perspective 
in which you view the alignment of the work. Using the timeline section of the view, 
prioritize work effectively by gaining visibility into the schedule and dependencies 
between the planning items.
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To get started with managing your work pipeline in Strategic Planning, see Prioritizing portfolio 
plan work in Strategic Planning Workspace.

Roadmaps in Strategic Planning

Strategically plan work for your company using visual roadmaps in Strategic Planning 
Workspace.

As your organization grows and priorities change, it’s important to have the flexibility of changing 
existing plans and making new plans with ease. Using roadmaps, you can create a layout of 
current and upcoming plans while aligning them with your business objectives. Share these 
visual plans with other stakeholders across the organization, drive meaningful conversations, 
and validate common understandings.

Each roadmap is a high-level block of work, prioritized by different planning personas such as 
enterprise project managers, portfolio managers, project managers, or others. Roadmaps also 
provide insights to the stakeholders while guiding the delivery teams during development.

The following are the types of roadmaps that you can work with:

• Portfolio plan roadmaps

• Free-form roadmaps

The features available in these roadmaps are:

• Hybrid roadmaps

• Roadmap-level milestones

• Planning item-level milestones

• Planning item dependencies

• Tracking mode

Note: 
Roadmaps are available with Strategic Planning  by default. Roadmap Planning 
(sn_roadmap_plng) is no longer available to install as a separate application.
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Portfolio plan roadmaps

By creating a flexible portfolio plan using lenses, you can prioritize and roadmap work for your 
portfolio. Use these portfolio roadmaps to plan and track work in different perspectives of the 
organization separately, while connecting them to the high-level plans of the company.

Create a portfolio plan  to get started. You can view and edit your roadmap in both Roadmap and 
Kanban tabs.

Roadmap tab

Kanban tab

Free-form roadmaps

Free-form roadmaps provide you the flexibility of planning and tracking work from different units 
of your company, such as work across multiple portfolios.

Using a filter condition, you can define what kind of work items you want on your roadmap. If you 
want to have a roadmap dedicated to just the projects of your department, define a roadmap for 
projects to start tracking the progress of current projects and create plans for new ones.
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You can view and edit your free-form roadmap in both Timeline and Kanban views.

See Create a free-form roadmap.

Hybrid roadmaps

In Strategic Planning, with both the portfolio roadmaps and free-form roadmaps, you can build 
hybrid roadmaps. For example, you can have a combination of projects, demands, and epics in a 
single view.

Milestones on the roadmap

You can create milestones for your roadmap, or for each planning item on the roadmap.

Roadmap-level or portfolio-level milestones

The milestones created at the roadmap level can help with tracking launch dates 
or key events during that roadmap's timeline. To learn how to create roadmap 
milestones, see Add milestones for a roadmap.

Planning item milestones

Using the milestones created at the item level, you can focus better on strategic 
outcomes. These milestones help with tracking deadlines or other important dates. 
You can access milestones on all the planning items such as projects, demands, 
epics, and others.

From the roadmap, milestones can be created and updated for all types of planning 
items, except on projects. Project milestones are read-only on the roadmap 
because any changes to project milestones may impact the associated project 
plans. So, it is recommended to create or update project milestones using Project 
Workspace in Project Portfolio Management  (PPM).

To learn how to create item-level milestones on a roadmap, see Add milestones for 
roadmap items.

Planning item dependencies

While planning, it is essential to know how your planning items are connected with each other. 
Unless you know the dependency for each item, you might miss prioritizing time-critical projects 
or demands. This lack of information may also put you at risk of not scheduling the right work for 
the right time period.

Dependencies on the roadmap help you visualize these relationships between the planning 
items, so that you can adjust their scheduling accordingly.

In Strategic Planning, you can create simple or hybrid dependencies. For example, you can 
establish dependencies between two projects or between a project and an epic. Also, planning 
items can have dependency on items within the same portfolio plan or on items that aren't 
planned yet.

The dependency lines help you easily identify the items that may have to be prioritized together. 
Such easy identification of relationships between planning items provides better collaboration 
and facilitates enhanced decision making in the planning process.

To learn about creating and managing dependencies, see Add dependencies for roadmap items.
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Tracking mode in roadmaps

Track status, progress, and metrics for each item on the roadmap. Using the status indicators and 
the percentage complete score on the planning item bars, make informed decisions ahead of 
time and easily communicate your work progress to the stakeholders.

See Track the progress of roadmap items.

Alignment of your work with business goals

Each planning item that you create and schedule into a roadmap can associate to high-level 
business goals. Strategic Planning  enables you to visualize how your work is aligned to these 
business goals directly from the roadmap view.

On the roadmap, you can group your planning items by the Strategic priority  and Primary goal 
fields so that you can map your work to their goals.

Better together with other ServiceNow®  applications

Integrate ServiceNow®  Digital Portfolio Management  (DPM) with Strategic Planning  to provide 
DPM  managers the access to roadmap planning. With this integration, you can:

• Optimize portfolio performance by monitoring services and their performance levels in a 
comprehensive roadmap.

• Make informed budgetary decisions and deliver shared outcomes by prioritizing backlogs and 
managing roadmaps of business applications.

For more information, see Exploring Digital Portfolio Management .

Related topics

Planning roadmaps in Strategic Planning Workspace

Goal Framework and Goal Framework for SPM

Scenario planning in Strategic Planning

Create and evaluate strategic scenarios to explore different planning approaches. Approve the 
optimal scenario that aligns with the organizational goals and strategic priorities.

Scenario planning overview

Scenario planning in Strategic Planning  enables organizations to create, evaluate, and approve 
the best strategic scenario that aligns with their strategic goals and intended business 
outcomes. This process helps in visualizing different approaches, assessing their impacts, 
and making informed decisions before implementing the live plan. By using scenario planning, 
organizations can anticipate potential challenges.  Scenario planning overview

What is a scenario

A scenario in Strategic Planning  is a simulated version of a plan that enables you to explore a 
strategic approach without affecting the live plan. It provides a safe environment to prioritize 
items, adjust timelines, and evaluate the potential impacts of each approach.

As compared to a plan, a scenario additionally has the following:
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• In Plan  toggle: The In Plan  toggle enables you to prioritize or de-prioritize the planning items 
in the scenario you’re creating. By default, when you create a scenario, the In Plan  toggle is 
turned on for planning items that have all of the following field values:

◦ Planning state as Prioritized or Done

◦ Start and end dates within the portfolio plan dates.

• Date  fields: The Start date  and End date  fields for the scenario are automatically populated 
based on either the planned or actual start and end dates of the planning items. You can 
update these dates during the scenario planning process. Once the scenario is approved, the 
updated dates are recorded as the approved dates for the planning items. If the updated dates 
fall outside the acceptable range, they’re highlighted in yellow.

For more information on portfolio plans, see Portfolio plans in Strategic Planning.

By comparing scenarios side by side, you can assess the differences in goal alignment and 
trade-offs between each scenario. This comparative analysis helps identify the scenario that 
best meets strategic objectives. For more information on comparing the scenarios, see Compare 
scenarios.

Scenario planning workflow in Strategic Planning

Using the Scenario Planning feature in Strategic Planning, you can perform the following 
activities:

• Create a scenario to explore different strategic approaches and business outcomes. For more 
information, see Create a scenario.

• Adjust and compare multiple scenarios side by side to evaluate differences in goal alignment, 
trade-offs, and financial benefits. For more information, see Compare scenarios.

• Approve the best scenario that aligns with the organizational goals. For more information, see 
Approve a scenario.

• Set a target portfolio budget for each of your planning cycle, which can be for fiscal period, 
quarter, yearly, or portfolio timeline.

• Evaluate the target vs proposed budget of In-plan items and review the monetary benefit from 
the prioritized items.
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Scenario Planning workflow overview

The scenario planning workflow involves an execution owner and a portfolio owner. The following 
illustration illustrates how scenario plans are created based on the planned or actual dates of 
planning items and how the In-plan toggle is adjusted based on the states of these planning 
items.
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User journey in Scenario planning

For more detailed guidance on using scenario planning to enhance your Strategic Planning 
process, see Optimizing planning with scenario planning in Strategic Planning Workspace.

Capacity in Strategic Planning

The Capacity tab provides portfolio managers a comprehensive view of capacity, allocations, 
and utilization of resources.

Analyzing the Capacity screen, you can:

• View resource capacity for prioritized items in your portfolio.

• Understand the resource capacity needs and estimates across your organization by using key 
attributes such as group, role, and skill.

• Effectively forecast the supply of resources and the demand of work in your portfolio.

• Understand and get an overview of the resource capacity allocations by using the color 
indicators.

• Plan for resources with specific skills or roles for future assignments.

• View the resource allocation health instantly with the new intuitive user interface that gives you 
a detailed breakdown of portfolio duration by month having over allocations.

• Identify the risks in resource capacity for the prioritized planning items using the Rank field.

• Use the warning icons to easily identify the over utilized resources ( ), planning items with 

actual dates ( ), and the planning items or resource groups with no resource assignments 

( ).
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Capacity screen

The top screen area displays:

• Resource capacity details depending on the defined resource criteria.

• Allocation details for the time period.

• Resources grouped by primary attributes.

The bottom screen area displays:

• Prioritized planning items.

• Interactive Gantt chart for the duration of planning items. Select a Gantt bar to see 
the capacity for that specific planning item only.

Note: 
Move the Gantt bar of a planning item to adjust the planned dates 
depending on the available resource capacity. Planning items with actual 

dates, indicated with in-progress icon ( ), cannot be adjusted for resource 
availability.

• Toggle option ( ) to adjust the resource capacity view.

• Legend explaining the visual representation of the resource capacity and Gantt 
bar of planning items.
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Financial planning for planning items

Plan, re-forecast, track the financials, and create baselines for all of your planning items.

You can work on financial planning supported on low level planning items like demands, 
projects, epics, features, capabilities, and so on.

The financials view provides a streamlined perspective, showcasing the actual and planned 
expenses for the entire fiscal period. You can view the latest estimated cost of completion by 
viewing the Actual costs for the past fiscal periods, planned costs for the current and future fiscal 
periods, and the total by quarter, year, or for the full scope of the item.

Note: 

• Currently, Financials is not yet supported for high level entities like Initiatives, Strategic 
programs, Product ideas, and so on.

• Labor costs generation is not supported at planning item level.

Interface of the financials record page gives you the ability to create cost plans, expense lines, 
and baselines. As a financial user, you can:

• Enter high-level financial forecasts for planning items using the simple financials section in the 
Details tab.

• Work on high-level estimating for Planned opEx and Planned capEx.

• Create a detailed breakdown of the planned costs using the financials tab.

• View the rollups of Planned costs, Actuals costs, and Planned benefits for all of your planning 
items in the Prioritization grid.

• Add, edit, or delete cost plans  effortlessly from the Cost screen.

• Re-forecast your planned expenses using the in-line editing feature.

• View a streamlined perspective, showcasing your actual costs for the past and planned 
expenses for the future, for the entire time scope of the planning item.

• Get a better comprehensive solution by viewing the Forecast (previously EAC - Estimate at 
Completion), Remaining Estimates (previously ETC - Estimate to Completion), and Actuals of 
each cost plan for the total time scope and the yearly breakdowns.

• Re-forecast the planned cost for future fiscal periods by directly updating the quarterly and 
yearly totals using the in-line editing capability of the grid.

• Generate labor costs  depending on the resource assignments for the entire scope of the 
planning item broken down by the financial attributes configured for your organization. For 
more information on the planning attributes for attribute-based mapping, see Using the 
Planning attributes.

• Add or edit expense lines  against the cost plans easily from the side panel with the associated 
cost plan details pre-populated.

• Record unplanned expenses using the New expense line side panel.

• Create and compare financial baseline to track the financials of your planning items.

• Compare the latest costs (actual expenses for past fiscal periods and planned costs for 
current and future fiscal periods) with the initial forecasted planned costs by creating financial 
baseline and using the compare baselines capability.

• Analyze the cause of variance in costs and when did this occur over time by capturing the 
financial baselines manually or automatically.

• Switch between different display modes to get a focused view of the financial records.
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You can view the following information on the financials screen.

• Time scope: duration of the planning item or a cost plan, whichever has a larger fiscal period 
range.

• Functional currency: currency defined and used to calculate the financials.

• Customizable widgets showing different financial information such as allocated budget, 
Forecast (previously EAC - Estimate at Completion), Variance (the difference between budget 
and Forecast), breakdown of planned costs, and actuals by cost type.

Note: 
Budget and Budget vs EAC Variance widgets are available for Demands and Projects 
only.

• Time scale: time period breakdowns to view the financials. Default value is set to Month/
Period, depending on the fiscal calendar type.

• Display mode: list options to switch between different modes to get a focused view of 
financials.

• Generate labor costs: one-click solution to generate or refresh the planned labor costs for the 
planning item depending on resource assignments.

Note: 
This option is enabled for the projects with resource assignments only.

• The left pane gives you a tabulated view of the cost plan attributes displaying the Name, Cost 
type, Expense type, Stat fiscal period, End fiscal period, Total planned cost, Employee type, 
and Role. You can customize these fields. For more information, see Customize the left pane 
view for financials.

• In the right pane, you can view the total Actuals, Forecast, and Remaining Estimates for the 
selected Time scope duration. Actual expenses against a cost plan for the past fiscal periods, 
Actuals, Forecast, and Remaining Estimates for the current fiscal year, and planned costs for 
the current and future fiscal periods.
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Note: 
The header rows of actuals and planned are color-coded differently to help you easily 
identify and differentiate between the expense types.

• New cost plan: opens a simplified side-panel to create a new cost plan for the entity.

• Personalize option to customize the columns in the left pane of the table.

• Export option to download Cost or Baselines comparison as Microsoft Excel or CSV file.

Financial widgets in Strategic Planning

Financial widgets provide at-a-glance visibility into the portfolio’s financial health. These widgets 
aggregate cost, budget, and benefit data to help you monitor spending, track variances, and 
measure return on investment.

Budget widget

The Budget widget displays the total approved budget for your planning item. 
This widget shows the funds allocated to the item against which all spending is 
measured. You can track how much money is allocated and compare latest forecast 
and actuals against the allocated budget.

The widget displays Total budget amount and the breakdown based on the Capex 
(capital expenditure) allocation or Opex (operational expenditure) allocation.

A project with a $500,000 budget split into $300,000 Capex and $200,000 Opex 
helps you understand the nature of the investment—Capex for long-term assets, 
Opex for ongoing operations.

You can use this widget to ensure spending aligns with approved funding. A 
negative value indicates overspending against the budget.

EAC Cost widget

The EAC (Estimate at Completion) Cost widget shows the projected total cost 
when the project completes, based on current spending patterns. The widget 
forecasts final project cost by combining actuals with remaining estimates. This 
helps portfolio managers to anticipate whether you’ll finish your work under, at, or 
over budget.

The widget displays Total projected cost at completion and the breakdown and 
Capex and Opex breakdown of the estimate.

If your budget is $300,000 and EAC shows $350,000, you know the project is 
trending $50,000 over budget before completion.

You can review EAC widget regularly to catch cost overruns early. Use this data to 
justify budget adjustments or scope changes.

Budget vs EAC Variance widget

The Budget vs EAC Variance widget calculates the difference between your 
approved budget and the estimated cost at completion. This highlights the gap 
between what you planned to spend and what you expect to spend. Positive values 
indicate savings; negative values signal potential overruns.

The widget displays Variance amount (Budget minus EAC) and the Capex and Opex 
variance breakdown.

A variance of -$50,000 means you're projecting to exceed budget by $50,000. This 
might trigger discussions about cost control or additional funding.
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You can use this widget to identify planning items that need intervention. A growing 
negative variance requires immediate attention.

Planned Cost widget

The Planned Cost widget displays the total cost you expect to incur based on 
approved cost plans. Widget shows how much you intend to spend across all cost 
categories before actuals are recorded. This serves as your spending roadmap.

The widget displays Total planned cost amount and the planned Capex and Opex 
amounts.

A $1.50 M planned cost with $1.00 M Capex and $500.00 K Opex tells stakeholders 
exactly how the investment breaks down by expenditure type.

You can use this widget to compare planned costs against budget to validate 
feasibility. Compare against actuals to measure execution accuracy.

Actuals (Including current fiscal period) widget

The Actuals widget shows the actual money spent, including transactions from the 
current fiscal period. This provides the ground truth for financial tracking. While 
plans and forecasts are estimates, the processed actual expenses reflect real 
expenditures.

The widget displays Total actual spend and Capex and Opex breakdown of actual 
expenses.

If actuals show $200,000 spent against a $300,000 plan, you're 66% through your 
planned spending.

You can use this widget to monitor actual expenses against planned costs and 
budgets to track spending velocity and identify variances early.

Planned Benefits widget

The Planned Benefits widget displays the expected financial returns or savings from 
your portfolio. This quantifies the anticipated value your investment will deliver. This 
data supports business case validation and ROI calculations.

The widget displays Total planned benefit amount and the actual benefit captured 
via benefit plans.

A $500,000 planned benefit against $300,000 planned cost suggests a positive 
return, making the investment a good bet.

You can use this widget to compare planned benefits against actual benefits to 
validate the real-time benefits. Track throughout the project to ensure expected 
value remains achievable.

Total Return widget

The Total Return widget displays the absolute financial returns from your portfolio. 
This widget shows the net financial gain or loss in currency terms, making it easier 
to understand the actual dollar impact of your investment. The widget displays the 
Total return amount (Benefits minus Costs), ROI% and NPV. The ROI and NPV fields 
are only calculated on estimated benefits (planned benefits) and planned costs.

A $200,000 total return means your planned estimate return $200,000 more in 
benefits than it consumed in costs.
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Use this widget to Report total return alongside ROI to give stakeholders both 
percentage and absolute value perspectives. Use the ROI widget to prioritize your 
work, justify investments, and report portfolio performance to stakeholders. The ROI 
calculates the financial return as a percentage of your investment. This provides 
a standardized metric to compare project performance and investment efficiency 
across your portfolio.

This widget displays ROI percentage calculated as: (Planned benefits – Planned 
costs) / Costs × 100. An ROI of 67% means for every dollar spent, you received $1.67 
in value—a positive return on your investment.

The NPV widget calculates the present value of future cash flows, adjusted for the 
time value of money. NPV helps you compare planning items with different timelines 
and cash flow patterns. NPV can help you identify whether the portfolio is growing 
to be an asset (positive NPV) or liability (negative NPV). A positive NPV of $150,000 
means the project creates $150,000 in value when future benefits are discounted 
to today's dollars. Use NPV for long-term planning items where cash flows span 
multiple years.

Best practices

• Review financial widgets weekly during active project phases.

• Investigate variances greater than 10% immediately.

• Create financial baselines at major milestones to track and compare changes over time.

• Use fiscal year breakdowns to identify seasonal spending patterns.

• Compare ROI and NPV together for comprehensive investment analysis.

Strategic Planning  with PPM, Agile 2.0, and SAFe

Facilitate execution of the work planned in Strategic Planning  in ServiceNow  applications such 
as Project Portfolio Management  (PPM), Agile Development 2.0, or Scaled Agile Framework.

While planning personas like portfolio managers or product owners use Strategic Planning  to 
align their plans with the business objectives, they can provide flexibility to the execution teams 
to decide how they deliver their work.

Teams can choose the methodology that would be the most effective for them, and decide 
on the execution system that would best fit their needs. They can use applications such as 
ServiceNow®  Project Portfolio Management, Agile Development 2.0, or Scaled Agile Framework 
(SAFe)  to execute the work planned by their managers.​

With this flexible approach of delivering work, empower your teams to deliver more value, while 
being able to fund, manage, and monitor all work from a single workspace.
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Strategic Planning  integration with ServiceNow®  applications

Key benefits of Strategic Planning  with PPM, Agile 2.0, and SAFe

• View available PPM, Agile 2.0, and SAFe  planning items in Strategic Planning.

• Import planning items from PPM, Agile 2.0, or SAFe  to Strategic Planning.

• Export planning items from Strategic Planning  to PPM, Agile 2.0, or SAFe.

• Synchronize updates for linked planning items of Strategic Planning  with PPM, Agile 2.0, and 
SAFe.

• Track the progress of the linked planning items in Strategic Planning.

To get started on integrating Strategic Planning  with PPM, Agile 2.0, and SAFe, see Configuring 
Strategic Planning with PPM, Agile 2.0, and SAFe.

Frequently asked questions about execution integration

Can I use PPM Standard  for project execution without Agile or SAFe?

Yes. If your teams follow waterfall or traditional Project Management  methodology, 
use PPM Standard  (Project Portfolio Management) as your execution system. 
Planning items created in Strategic Planning  can be exported to PPM  as projects. 
Changes in PPM  (project status, costs, resources) sync back to Strategic Planning 
automatically.

Use case: Infrastructure team plans in Strategic Planning, executes data-center 
migration project in PPM Standard  with Gantt charts, task dependencies, and 
resource management.

How do I decide between PPM, Agile 2.0, and SAFe  for execution?

Base your decision on team methodology and org scale:

• PPM Standard: For waterfall projects, traditional PM teams, infrastructure work, 
conformance-driven initiatives.

• Agile 2.0: For single scrum teams, small agile projects, product development 
teams under 50 people.

• SAFe: For enterprise-scale agile, multiple Agile Release Trains (ARTs), large 
programs with 50+ team members, portfolio-level coordination.

Hybrid approach: Many organizations use multiple execution systems. Marketing 
team uses Agile 2.0 for campaigns, IT uses PPM  for infrastructure, product 
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engineering uses SAFe  for platform development—all visible in one Strategic 
Planning  view.

Should I install all three execution systems to use Strategic Planning?

No. Install only the execution systems your teams actually use. Strategic Planning 
works standalone for planning and prioritization. Add PPM, Agile Development 2.0, 
or SAFe  plug-ins when teams are ready to execute work in those systems.

What data syncs between Strategic Planning  and execution systems?

Bi-directional sync includes:

• From Strategic Planning  → execution: Planning item name, description, owner, 
goals, budget, priority, timeline.

• From execution → Strategic Planning: Status, progress %, actual costs, resource 
assignments, risks/issues.

• Real-time updates: Changes in either system appear in both within seconds.

Can a single planning item be executed in multiple systems?

No. Each planning item links to a single execution system. However, you can break 
down a large initiative into child planning items, each executed in different systems. 
For example, the Digital Transformation Initiative parent planning item contains: 
Mobile App Redesign (Agile 2.0), Legacy System Migration (PPM), and API Platform 
Modernization (SAFe).

Common execution scenarios

• Scenario 1: PPM  only organization (waterfall projects)

1. Portfolio managers create planning items in Strategic Planning.

2. After prioritization, export planning items to PPM Standard  as projects.

3. Project managers build WBS, create tasks, assign resources, manage timeline in PPM.

4. Strategic Planning  shows project status, costs, risks automatically

• Scenario 2: SAFe  only enterprise (Scaled Agile Framework)

1. Product managers create epics in Strategic Planning.

2. Export epics to SAFe  for Program Increment (PI) planning.

3. SAFe  teams break epics into features and stories, execute in sprints.

4. SAFe  tracks epic progress across multiple ARTs.

• Scenario 3: Hybrid organization (multiple methodologies)

1. Strategic Planning  backlog contains projects (PPM), epics (Agile 2.0 and SAFe), and 
demands.

2. Each team exports their planning items to their preferred execution system.

3. Executives view unified progress, costs, and goals achievement in Strategic Planning 
regardless of the execution method.
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Troubleshoot execution integration

• Issue: Planning item not appearing in PPM/Agile Development 2.0/SAFe

◦ Verify the execution system plugin is installed and activated.

◦ Check that planning item state is Prioritized (items in the Backlog state don't export).

◦ Confirm user has required role in execution system (project_manager, scrum_admin, 
safe_admin).

• Issue: Changes in PPM  not syncing back to Strategic Planning

◦ Verify bi-directional sync is enabled in integration configuration.

◦ Check that the planning item and PPM  project/epic are properly linked (primary planning 
item field is populated).

◦ Review transformation maps for any table, field, or choice mapping issues.

For detailed configuration steps, see Configuring Strategic Planning with PPM, Agile 2.0, and 
SAFe.

Better together with other ServiceNow  applications

The integration of Strategic Planning  with other ServiceNow  applications helps portfolio and 
product managers to optimize planning, collaboration, and release management for their 
products.

Strategic Planning  with AI Control Tower  workspace

The ServiceNow®  AI Control Tower  workspace enables you to track and monitor all your 
strategic priorities, goals, targets, planning items, and execution items—projects and demands 
categorized as Artificial Intelligence in the Strategic Planning Workspace.

Populate the Type  field for strategic priorities, the Category  field for goals, and the Investment 
type  field for planning items with the Artificial Intelligence  option to monitor their progress in the 
AI Control Tower  workspace. For more information, see Create a strategic priority, Create a goal, 
and Add a planning item.

When AI Control Tower  is installed, the AI strategy  tab appears in the AI Control Tower 
workspace, featuring different widgets for AI strategies, goals, targets, costs of planning items, 
prioritized work, and RIDAC details. For more information, see AI strategy tab in AI Control 
Tower .

Strategic Planning  with Digital Product Release  workspace

Using the Digital Product lens, product managers can plan, prioritize, and roadmap the work for 
digital products by aligning with the business strategy.

As part of planning when you associate planning items with the product enhancement in the 
Strategic Planning Workspace, those associated planning items appear in the Planning items 
tab of the Release scope page in ServiceNow  Digital Product Release  workspace. This tab 
helps product managers track the status of the planning items associated with the product 
enhancements in the Digital Product Release  workspace itself to ease the release management 
for their products. For more information, see Scope of a release .

Strategic Planning  with Collaborative Work Management

With the integration of ServiceNow  Collaborative Work Management  (CWM) with Strategic 
Planning, you can plan, roadmap, and associate goals to Boards in a portfolio plan. By adding 
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CWM  Boards to a lens configuration, you can access them in the Prioritization, Roadmap, and 
Goals pages of a portfolio plan as planning items.

The lenses supported to configure the CWM Board as a planning item are Organization, Project 
Portfolio, and Strategic Investments.

For more information on integration of CWM  with Strategic Planning, see Connecting CWM 
with Strategic Planning or Portfolio Planning. To learn how to update the lens configuration, see 
Create or modify a lens in Strategic Planning.

Strategic Planning  with Enterprise Architecture Workspace

Using the Business Capability lens, enterprise architects can plan, prioritize, and roadmap the 
work based on business capabilities or business applications. For information on ServiceNow 
Enterprise Architecture Workspace, see  Enterprise Architecture Workspace .

Strategic Planning  with Digital Portfolio Management

Integrate ServiceNow  Digital Portfolio Management  (DPM) with Strategic Planning  to provide 
DPM  managers the access to roadmap planning. With this integration, you can:

• Optimize portfolio performance by monitoring services and their performance levels in a 
comprehensive roadmap.

• Make informed budgetary decisions and deliver shared outcomes by prioritizing backlogs and 
managing roadmaps of business applications.

For more information, see Exploring Digital Portfolio Management .

Configuring Strategic Planning Workspace

Learn about the process required to set up Strategic Planning  to enable your product and 
portfolio managers start aligning their work with business goals and strategy.

Configuration workflow

Use the following steps as guidelines to set up Strategic Planning. Some of these steps require 
the admin role and some require the sn_align_core.apw_admin role.

1. Install Strategic Planning.

2. Assign user roles.

See the Roles installed table in Components installed with Strategic Planning Workspace.

Note: 
If you are upgrading from an older version to Strategic Planning  v2.1.0 or higher, a fix 
script is run to remove the milestone_editor role from the roadmap_editor role because 
the roadmap_editor role is no longer used. In this case, you may experience a longer time 
for the upgrade to complete if your ServiceNow  instance has a large number of users with 
the roadmap_editor role. For more information, see KB1443618 .

3. Configure lenses to enable your planning managers to create portfolio plans.

See Lens configuration in Strategic Planning.

4. Enable high-level planning for tables that are not enabled by default.

(Optional) See High-level planning configuration in Strategic Planning.
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5. Validate your configuration for lens, planning items, portfolio plans, high-level planning, and 
others.

See Strategic Planning diagnostics.

6. Configure Prioritization and Roadmap display settings.

(Optional) See Prioritization display settings in Strategic Planning.

7. Configure Feedback  and manage your feedback and product ideas. See Configuring 
Feedback application in Strategic Planning.

8. Integrate Strategic Planning  with a ServiceNow®  execution system of your choice. This 
integration enables you to plan in Strategic Planning  and execute in your chosen app.

See Configuring Strategic Planning with PPM, Agile 2.0, and SAFe  and Configuring Feedback 
application in Strategic Planning.

9. Migrate your existing goals to Strategic Planning  and configure goal preferences.

See Configuring goals in Strategic Planning.

10. Configure Capacity Planning and generate resource capacity.

See Capacity configuration in Strategic Planning.

11. Enable financial planning for epics and customise the Financials screen view.

See Configure financials for planning items in Strategic Planning.

Guided Setup to configure Strategic Planning

Guided Setup provides a sequence of tasks to help you with the required configuration on your 
ServiceNow  instances. After installing Strategic Planning, navigate to All  > Strategic Planning  > 
Guided Setup.

When you’re configuring a task from the Guided Setup, you can launch the in-app help for 

additional guidance by clicking the Show Help icon ( ).

Install Strategic Planning

Install the Strategic Planning  application from ServiceNow Store  if you have the admin role.

Before you begin
Ensure that the application and all of its associated store applications have valid ServiceNow 
entitlements. For more information, see Get entitlement for a ServiceNow  product or 
application .

Role required: admin

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the Strategic Planning  application using the filter criteria and search bar.

You can search for the application by its name or ID (sn_apw_advanced). If you cannot find an 
application, you may have to request it from ServiceNow  store.

3. Click Install.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

406

https://store.servicenow.com/$appstore.do#!/store/help?article=KB0030186
https://store.servicenow.com/$appstore.do#!/store/help?article=KB0030186
https://store.servicenow.com/$appstore.do#!/store/help?article=KB0030186
https://store.servicenow.com/$appstore.do#!/store/help?article=KB0030186
https://store.servicenow.com/$appstore.do#!/store/help?article=KB0030186
https://store.servicenow.com/$appstore.do#!/store/help?article=KB0030186


4. In the Application installation dialog box, review the application dependencies.

If your application requires other applications, install them first if they are not already installed. 
Installing your application also automatically installs the dependent applications or plugins if 
they are not installed already.

5. If you want to install demo data, click Load demo data.
Demo data includes sample records that describe application features for common use cases. 
Load demo data when you first install the application on a development or test instance.

6. Click Install.

Result
The following components are installed with installation of the Strategic Planning  application:

• Roles

• Tables

See Components installed with Strategic Planning Workspace  for more information.

Planning item configuration for lenses and portfolio plans

Learn about the types of default and custom planning items that planning managers can work 
with in Strategic Planning  Workspace.

For every portfolio plan that you build using a lens, only those item types that are added to that 
lens are available for planning. For example, a lens XYZ has epics and projects added to it. Then, 
in any portfolio plan that you build using the XYZ lens, you can plan for work in the form of epics 
and projects only.

Default planning items

By default, you can use Projects, Demands, and Epics as planning items for your lens and build 
plans using them.

Pre-defined custom planning items

If you want to use a different item type, you can use up to five pre-defined custom planning item 
tables that are available in your ServiceNow  instance.

1. Select one of the custom planning item type tables available. See Components installed with 
Strategic Planning Workspace.

2. Modify the label of the table that you want to use.

For example, you want to plan for incidents, change the label of Custom planning item 1 to 
Incident.

3. Add this table to the sn_align_core.planning_item_types_allow_list  property. 
See Enable custom item types in Strategic Planning.

New custom planning items

If you've used up all these five pre-defined custom planning item tables and want a different item 
type to use for your portfolio plans, you can define new item types. See Define a new planning 
item type in Strategic Planning.
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Review existing planning item types in Strategic Planning

Before you create a portfolio plan using lenses, start with verifying that the default planning item 
types in Strategic Planning  suit your company's planning needs.

Before you begin
Ensure you have the details of your company's planning needs.

Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the list of tables by using sn_align_core  in the Name column.

3. Review the tables that have Planning Item  in the Extends table column.
Confirm if those are all the tables that you would require to set up lens required for portfolio 
plans.

What to do next
If you need a planning item type other than those available, use one of the five pre-defined 
custom planning item tables or you can create your own.

• Enable pre-defined custom planning item tables.

• Define a new planning item type in Strategic Planning

Define a new planning item type in Strategic Planning

Create a custom planning item type in Strategic Planning  to enable planning them on the 
portfolio plans.

Before you begin
Ensure the application scope in your instance is set to Portfolio Planning.

Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Tables.

2. Select New.

3. On the form, fill in the fields.

For field information, see Planning item type form.

4. Optional:  Deselect the Create module  checkbox.

5. Save the form.

a. Select the Additional actions icon ( ).

b. Select Save.

What to do next
If you've created any planning item types, create relevant form views for it. For more information, 
see Create form views for new planning item tables in Strategic Planning.

Create form views for new planning item tables in Strategic Planning

For every new planning item table that you create, you must create the necessary form views. 
You can also customize the views for existing planning items.

Before you begin

• Define a new planning item type in Strategic Planning.

• Ensure that the application scope in your instance is set to Portfolio Planning.

Role required: admin

About this task
The following are the necessary form views:

• APW Preview: Supports the view that is used to display the planning item details on the 
roadmap side panel.

• APW Default: Supports the default view of the planning item form in Strategic Planning.

• APW New: Supports the form view that is used while creating a planning item of this type from 
the roadmap.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the list of tables by using Planning Item  in the Extends table column.

3. Select a planning item type that you created.

4. Select the Layout Form  related link.

5. From the View name  field, select New.

6. In the Create New View  window, enter one of the following names in the View name  field:

◦ To create the APW Preview view, enter Workspace APW Preview

◦ To create the APW Default view, enter Workspace APW Default

◦ To create the APW New view, enter Workspace APW New
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If you're creating a view other than these, ensure that your view name does not contain any 
special characters. For example, if you want to create a view with the name SAFe-Portfolio, 
replace the hyphen (-) with a space and enter the name as SAFe Portfolio.

7. Select OK

8. Using the Available and Selected lists of fields, select the fields to be visible on the form.
You can also rearrange them in the order of your choice. To keep the form views of new tables 
consistent with that of the default settings, ensure you do the following changes:

◦ For Preview and APW Default views, select the Strategic priority  and the Primary goal  fields 
to be visible on the form.

◦ For all three views, select the field for the bottom entity of your lens to be visible on the form.

◦ For all three views, add the Milestones related list. See Add a related list to a form .

9. Select Save.
A new form view is created for this planning item type.

10. Repeat the steps 4 through 8 to complete creating the other two form views.

What to do next
Create list views for new planning item tables in Strategic Planning.

Create list views for new planning item tables in Strategic Planning

For every new planning item table that you create, you must create the necessary list views. You 
can also customize the views for existing planning items.

Before you begin

• Define a new planning item type in Strategic Planning.

• Ensure that the application scope in your instance is set to Portfolio Planning.

Role required: admin

About this task
Create the APW Default and APW Prioritization list views for the planning item table that you 
created.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the list of tables by using Planning Item  in the Extends table column.

3. Select a planning item type that you created.

4. Select the Layout List  related link.

5. From the View name  field in the List view section, select New.

6. In the View name  field, enter APW Default.

7. Select OK

8. Using the Available and Selected lists of fields, select the fields to be visible for the list view of 
this planning item.
You can also rearrange them in the order of your choice.

9. Select Save.
A new list view is created for this planning item type.

10. Repeat steps 4 to 9 to create a list view for APW Prioritization
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What to do next
Create related list views for new planning item types in Strategic Planning

Create related list views for new planning item types in Strategic Planning

For every new planning item table that you create, you must create the necessary related list 
views. You can also customize the related list views for existing planning items.

Before you begin

• Define a new planning item type in Strategic Planning.

• Ensure that the application scope in your instance is set to Portfolio Planning.

Role required: admin

About this task
Every Related list that you add to your planning item tables must be in the APW Default view.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the list of tables by using Planning Item  in the Extends table column.

3. Select a planning item type that you created.

4. Select the Show Form  related link.

5. From the form header, select the Additional actions menu ( ) and select Configure  > Related 
Lists.

6. From the View name  field in the List view section, select New.

7. In the View name  field, enter APW Default.

8. Select OK

9. Using the Available and Selected lists of related lists, select the ones that you want on your 
planning item form.
You can also rearrange them in the order of your choice.

10. Select Save.

What to do next
Create workspace view rules for new planning item forms in Strategic Planning.

Create workspace view rules for new planning item forms in Strategic Planning

Define workspace view rules for the form views of new planning item types in Strategic Planning.

Before you begin

• Create form views for new planning item tables in Strategic Planning

• Ensure the application scope in your instance is set to Portfolio Planning

Role required: admin

Procedure

1. Navigate to All  > Workspace Experience  > Forms  > Workspace View Rules.

2. Select New.

3. On the form, fill in the fields.
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For field information, see View rule form.

4. In the Conditions section, select Add Filter Condition  and add the following condition:

◦ For APW Default view: Created  is not empty

◦ For Default view: Created  is empty

5. Select Submit.

6. Repeat this process until you have completed creating both workspace view rules.

What to do next
Enable custom item types in Strategic Planning.

Enable custom item types in Strategic Planning

Enable the usage of a custom planning item type in Strategic Planning  so that your planning 
managers can start adding them to their free-form roadmaps or portfolio plans.

Before you begin
Role required: sn_align_core.apw_admin

About this task
Add the table that you want to allow for planning in Portfolio plans and free-form roadmaps to a 
system property.

Procedure

1. Navigate to All  > System Properties  > All Properties.

2. Open one of the following system properties.

◦ For portfolio plans: sn_align_core.planning_item_types_allow_list

◦ For free-form roadmaps: 
sn_align_ws.freeform_planning_items_creation_list

3. In the Value  field, add your custom table.

For example, add sn_align_core_custom_planning_item_1.

4. Select Update.
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What to do next

• For portfolio plans: Add your custom planning item type to the lens that your planning 
managers want to use. See Lens form.

• For free-form roadmaps: Create planning items from the roadmap view.

Lens configuration in Strategic Planning

Learn how to configure settings for planning items and add additional configuration for a lens in 
Strategic Planning  so that you can set up lenses for your planning manager.

Your planning manager can use one of the nine pre-defined lenses - Project Portfolio, Project 
Program, Organization, Strategic Investments, Product, Digital Product, Value Stream, Goals, and 
Business Capability - to create portfolio plans, or you can set up a custom lens structure for them.

Pre-defined lens Custom lens

1. Navigate to the Lenses list and add Epic as 
a planning item for each of the pre-defined 
lenses. See Lens form.

2. (Optional) Change the structure for these 
lenses per your requirements. See Add or 
modify lens structure in Strategic Planning.

3. For the planning items types included in 
the Product or Strategic Investment lenses, 
ensure that all necessary form and list views 
have a field for the bottom entity of the lens.

4. For Product or Strategic Investment lenses, 
update roadmap configuration to include the 
bottom entity and its parent entity in Group 
by fields  and Color by fields. See Customize 
the planning item display preferences for 
Prioritization and Roadmap.

5. Configure integration with a ServiceNow 
execution application of your choice. See 
Configuring Strategic Planning with PPM, 
Agile 2.0, and SAFe.

1. Create or modify a lens in Strategic 
Planning.

2. Add or modify lens structure in Strategic 
Planning.

3. Associate planning items to the bottom 
entity of the lens. See Lens structure form.

4. Ensure that all APW  form views of all 
planning item types include a field for the 
bottom entity of the lens.

5. Update roadmap configuration to include 
the bottom entity and its parent entity 
in Group by fields  and Color by fields. 
See Customize the planning item 
display preferences for Prioritization and 
Roadmap.

6. Validate and activate your lens. See 
Activate a lens in Strategic Planning.

7. Configure integration with a ServiceNow 
execution application of your choice. See 
Configuring Strategic Planning with PPM, 
Agile 2.0, and SAFe.

Create or modify a lens in Strategic Planning

Start defining your company's planning perspectives in Strategic Planning  by creating a lens.

Before you begin
Role required: admin

About this task
Create a lens record and add the type of items (Project, Demand, and others) that can be 
planned using this lens. The type of planning items that you associate with the lens are the only 
type of work that the planning managers can use, in their portfolio plans.
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Procedure

1. Navigate to All  > Strategic Planning  > Lenses.

2. Select New.

3. On the form, fill in the fields.
For field information, see Lens form.

4. Select Submit.

What to do next
Add or modify lens structure in Strategic Planning.

Related topics

Lenses in Strategic Planning

Add or modify lens structure in Strategic Planning

Add entities to your lens and build its structure so that your planning managers can start creating 
their portfolio plans in Strategic Planning.

Before you begin
Ensure that your application scope is set to Portfolio Planning Core.

Role required: admin

About this task
For a lens, add entities to build a new lens structure or to modify the existing structure. You can 
add up to six entities in a lens structure. For more information on lens and its structure, see Lens 
configuration in Strategic Planning.

Procedure

1. Navigate to All  > Strategic Planning  > Lenses.

2. From the Lenses list, select a lens for which you want to add or update the lens structure.

3. Add an entity to the lens structure.

a. From the Lens structure related list, select New.

b. On the form, fill in the fields.

For field information, see Lens structure form.

c. Select Submit.

4. Repeat step 3 to complete adding all your lens entities.

◦ Add the entities in a top-down manner:

Add the top-level entity first, followed by the second-level entity, followed by the third, and so 
on.

◦ Ensure that every entity, except the top-level, has a parent entity reference.
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For example, the second-level entity must refer to the top-level entity as its parent.

What to do next

1. Verify that the Planning item table [sn_align_core_planning_item] has a field that references 
the bottom entity of this lens.

2. Ensure that the following form views for all the planning item types that are associated in your 
lens contains a field for the bottom entity of your lens structure.

◦ APW  Preview

◦ APW  New

◦ APW  Default

3. Update the roadmap configuration for the tables all planning item types that you associate with 
this lens:

Add the bottom entity of this lens structure and its parent to Group by fields  and Color by 
fields. These fields are used as the default group by and color by settings for the portfolio 
roadmap. See Customize the planning item display preferences for Prioritization and Roadmap.

4. Validate your lens configuration and activate it. See Activate a lens in Strategic Planning.

Activate a lens in Strategic Planning

Validate your lens configuration and activate it so that your planning managers can start creating 
portfolio plans using this lens.

Before you begin
Role required: admin

About this task
If you've changed the structure of an existing lens or created a custom lens, validate its 
configuration and set its state to Active.

Planning managers can create portfolio plans using only lenses that are active. For a lens to be 
available in the workspace for a planning manager, its configuration must be valid and must be in 
the Active state.
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Procedure

1. Navigate to All  > Strategic Planning  > Lenses.

2. From the Lenses list, select a lens.

3. On the lens form, click the Validate Lens  related link.

◦ If the lens configuration is valid, a success message prompts you that you can now activate 
it.

◦ If the lens configuration isn’t valid, use the error messages to understand the issues and fix 
the configuration.

Try validating the lens using the related link again.

4. Select the Active  field and save the form.

Related topics

Add or modify lens structure in Strategic Planning

High-level planning configuration in Strategic Planning

If your planning managers need high-level planning enabled for items other than the default 
ones, you need to update the configuration for lens entities and portfolio plans.

By default, Strategic Programs, Programs (pm_program), and Initiatives are the items that are 
enabled for high-level planning. Also by default, the Product Enhancement entity with the Digital 
Product lens is enabled for high-level planning. To enable other planning item types, complete 
the following configuration tasks.

Note: 
High-level planning is enabled for Strategic Planning  v2.1.0 and higher.

For items that extend the Planning Item table

For example, you added Custom planning item 1 [sn_align_core_custom_planning_item_1] to 
your lens structure and you want to use it for high-level portfolio plans. In the Lens structure 
related list for your lens, set the Planning enabled  field to true  for the Custom planning item 1 
entity. For detailed information, see Enable high-level planning for a lens entity.

For items that do not extend the Planning Item table

Consider the example of enabling high-level planning for the Strategic Priority [sn_gf_strategy] 
planning item type.

1. Create a global rank column in the Strategic Priority [sn_gf_strategy] table. See Create global 
rank column for high-level planning.

2. Create rank configuration for the new global rank column. See Create rank configuration for 
high-level planning.

3. Create portfolio plan configuration for the Strategic Priority [sn_gf_strategy] table. See Create 
portfolio plan configuration for high-level planning.

4. Enable high-level planning for the Strategic Priority [sn_gf_strategy] entity in the lens structure 
record. See Enable high-level planning for a lens entity.
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5. Run diagnostics and fix script to populate global rank for all existing Strategic Priority records. 
See Populate global rank for high-level planning items.

6. Create a business rule for the Strategic Priority [sn_gf_strategy] table to enable setting a global 
rank for any future records created. See Create a business rule for high-level planning.

Tip: 
While choosing a table as your high-level planning entity, ensure that it has fields such as 
start date and end date, owner or assigned to, name or short description, so that this can 
be used as a planning item. For example, you cannot use the Organization or Product tables 
as your high-level planning entities. On the other hand, the Strategic Priority tables meets 
the requirements of a planning item and can be configured for high-level planning.

Once all these tasks are complete, your planning manager can create a high-level portfolio plan 
for the desired entity - for this example, portfolio plans can be created to prioritize and roadmap 
the strategic priorities of the company, and to view how the work across the company is aligned 
to these strategic priorities.

Create global rank column for high-level planning

Create a global rank column for planning item types that do not extend the Planning Item 
[sn_align_planning_item] table so that you can enable high-level planning for these items in 
Strategic Planning  Workspace.

Before you begin
Upgrade to Strategic Planning  v2.1.0.

Role required: admin

About this task
Create a Global rank  column on the planning item table for which you want to enable high-level 
planning. This column allows populating a global rank for all existing and new records of this 
table in your ServiceNow  instance.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Search for and open your planning item table.

For example, search for and open the Strategic Priority [sn_gf_strategy] table.

3. From the Columns related list, select New.

4. On the form, fill in the following fields.

Dictionary Entry form fields

Field Description

Table
Table for which you are creating this column.

This field is automatically set to the table 
you've selected in Step 2.

Type
Value type of the column that you're creating.

Select Long.
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Field Description

Column label Label for the rank column.

Enter Global rank.

Column name Auto-generated unique name for the column.

Application Application scope of the table.

This field is populated automatically based 
on the table that you selected.

For complete details of the Dictionary Entry form fields, see Dictionary entry form .

5. Save the form.

What to do next
Create a rank configuration for the global rank field you created. See Create rank configuration 
for high-level planning.

Create rank configuration for high-level planning

To enable high-level planning on a table that is not a planning item in Strategic Planning 
Workspace, create a rank configuration for the global rank column of the table.

Before you begin
Create global rank column for high-level planning.

Role required: admin

About this task
Create a configuration for the global_rank column for the table that you want to enable for high-
level planning. Completing this task would allow you assigning a global rank value to the records 
of this table.

In this task, consider the example of creating a rank configuration for the Strategic Priority 
[sn_gf_strategy] table.

Procedure

1. Navigate to All  > rank_configuration.list.
A list of tables that have a configuration for their Global rank field is shown.

2. Select New.

3. On the form, fill in the fields.

Rank Configuration form

Field Description

Table Table that you want to enable high-level 
planning.

For example, Strategic Priority 
[sn_gf_strategy]
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Field Description

Column Global rank column of your table.

4. Select Submit.

What to do next
Create a portfolio plan configuration for your high-level planning table. See Create portfolio plan 
configuration for high-level planning.

Create portfolio plan configuration for high-level planning

To enable high-level planning on a table that is not a planning item in Strategic Planning 
Workspace, create portfolio plan configuration for the table.

Before you begin
Create rank configuration for high-level planning

Role required: admin

About this task
After creating a global rank column and a rank configuration for that column, create a portfolio 
plan configuration for the table that you chose for high-level planning. Following this task, 
configure the Proritization and Rodmap page settings for a portfolio plan that your planning 
managers would create for this table.

In this task, consider the example of Strategic Priority [sn_gf_strategy] table.

Procedure

1. Navigate to All  > sn_align_ws_roadmap_configuration.list.
A list of existing portfolio plan configuration records for the Strategic Planning  tables is shown.

2. Select New  to create a portfolio plan configuration for your table.

3. On the form, fill the fields.

Portfolio plan configuration

Field Description

Source table Table that you want to enable high-level 
planning for.

For example, Strategic Priority 
[sn_gf_strategy].

Rank configuration

Field Description

Rank configuration Table that is used to create the portfolio plan.

The value for this field is the table selected in 
the Source table  field.

For complete details of the fields on this form, see Portfolio plan configuration form.

4. Save the form.
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What to do next
Populate global rank value for all existing records of your high-level planning table.

Enable high-level planning for a lens entity

To enable high-level planning on for an entity in Strategic Planning  Workspace, update the lens 
entity configuration.

Before you begin
Create portfolio plan configuration for high-level planning.

Role required: admin

About this task
For the table that you want to enable high-level planning, set the Planning enabled  field to Yes 
in the Lens form. Completing this task would enable your planning managers to create portfolio 
plans using this table as a planning item, in Strategic Planning  Workspace.

For this task, consider the example of Strategic Investments as the lens and the Strategic Priority 
[sn_gf_strategy] table as the high-level planning entity.

Procedure

1. Navigate to All  > Strategic Planning  > Lenses.

2. Select and open the lens that you want to use for high-level planning.
For example, select Strategic Investments.

3. In the Lens structures related list of the Lens form, set the Planning enabled  field of your high-
level entity to true.
For example, set the Planning enabled field of Strategic Priority entity to true.

If your high-level entity is not a part of your lens structure, you can add it. See Add or modify 
lens structure in Strategic Planning.

4. Save the Lens form.

Result
Your planning managers can now create portfolio plans on the Strategic Investment lens and use 
Strategic Priority as their planning item.

Important: 
Once a portfolio plan is creating based on this entity, you can neither disable high-level 
planning for it nor delete the entity record from the lens structure.

What to do next
Populate global rank for high-level planning items.
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Populate global rank for high-level planning items

To enable high-level planning on a table that is not a planning item in Strategic Planning 
Workspace, populate global rank for existing records of this table.

Before you begin
Enable high-level planning for a lens entity.

Role required: admin

About this task
Use the Strategic Planning diagnostics module to populate global rank for all existing records of 
the table that your planning managers chose for high-level planning. Completing this task would 
generate a value for the Global rank field of your table.

For this task, consider the example of generating a rank value for all existing records of the 
Strategic Priority [sn_gf_strategy] table.

Procedure

1. Navigate to All  > Strategic Planning  > Diagnostics.

2. Run the Identify the high-level entities enabled for planning, without a global rank diagnostic 
script by selecting Run Diagnosis.
The diagnosis would fail and show you the type and the total number of records that are 
missing a global rank.

3. Select Run fix script  to populate global rank value for all the flagged records.
You can verify that the rank is populated by running the diagnostic script again. You would see 
that the diagnosis is a success.

What to do next
Create a business rule to populate global rank on any future records create on your high-level 
planning table. See Create a business rule for high-level planning.

Create a business rule for high-level planning

To enable high-level planning on a table that is not a planning item in Strategic Planning 
Workspace, create a business rule to allow assigning a rank value for all future records of this 
table.

Before you begin
Populate global rank for high-level planning items.

Role required: admin

About this task
All future records of your high-level planning entity must have a global rank so that when your 
planning managers reorder and prioritize items of this type in their portfolio plan, their rank is 
automatically updated. To enable this auto assigning of rank value to any new records, create a 
business rule.

For this task, consider the example of creating a business rule on the Strategic Priority 
[sn_gf_strategy], to enable auto-assignment of rank value for all its future records.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Search for and open your planning item table.
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For example, search for and open the Strategic Priority [sn_gf_strategy] table.

3. Right-click the form header and select Configure  > Business Rule.

4. Select New.

5. On the form, fill in the fields.

Business Rule form

Field Description

Name Name to identify the rule.

For example, Strategic Priority rank insert 
rule.

Table Table on which this business rule is applied.

For this example, select Strategic Priority 
[sn_gf_strategy].

Advanced Option to enable advanced settings for this 
business rule.

6. In the Advanced related list, enter the following code in the Script  field.

(function executeRule(current, previous /*null when async*/)
{
    var spwRankingHelper = new 
 sn_align_core.SPWRankingHelper();
    var rankConfig = 
 spwRankingHelper.getRankConfiguration(current.getTableName());
    if (rankConfig.isValidRecord())
    {
        var sequencer = new 
 sn_align_core.AlignmentPlanningRankProcessor(rankConfig.getVal
ue("table"), rankConfig.getValue("column"));
        sequencer.generateNewIndex(current);
    }
})
(current, previous);

7. In the When to run related list, enable the Insert  option.

8. Save the form.

Result
This task is the end of the series of tasks to enable high-level planning on a table that does not 
extend the Planning Item [sn_align_planning_item] table. After this task is complete, you can 
notify your planning managers that they can start creating portfolio plans for the configured 
entity type.

See Managing portfolio plans in Strategic Planning Workspace.

Custom scoring frameworks in Strategic Planning

Learn how to create a custom scoring framework and associate it with a portfolio plan, so you can 
prioritize your planning items based on a defined score.
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You may use one of the three pre-defined scoring frameworks - RICE, Value vs Effort, or WSJF, or 
you can create a custom scoring framework and associate it with your portfolio plan.

Note: 
The pre-defined scoring frameworks aren't editable. Administrators can enable or disable 
the base system scoring frameworks by setting the Active field on the Scoring Framework 
form.

Create a custom scoring framework

Start scoring your planning items based on your preferences by creating a custom scoring 
framework.

Before you begin
Role required: sn_align_core_apw_admin

About this task
Creating a custom scoring framework.

Procedure

1. Navigate to All  > Strategic Planning  > Scoring Frameworks.

2. Select New.

3. Enter a name of your scoring framework in the Name  field.

4. Enter the details of your scoring framework in the Description  field.

5. Select Submit.

What to do next
Create your scoring framework attributes

Create your scoring framework attributes

Add attributes within your scoring framework, so that you can build a formula and start scoring 
your planning items within your portfolio plan.

Before you begin
Role required: sn_align_core.apw_admin

About this task
Create Scoring Framework attribute.

Procedure

1. Navigate to All  > Strategic Planning  > Scoring Frameworks.

2. From the Scoring Frameworks list, select a framework for which you want to add the Scoring 
Framework Attributes.

3. Select New, from the Scoring Framework Attributes related list.

4. On the form, fill in the fields.

Scoring Framework Attribute form

Field Description

Label Name that defines your scoring Framework.
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Field Description

Type Type of the label, such as integer, choice, 
star, and so on.

Description Details of the Scoring Framework.

Tip: 
If you want to add a choice type scoring attribute, ensure to have Decimal or Integer in 
the Type  field, and Choice in the Display type  field.

5. Select Submit.

6. Repeat step 3 to add all your Scoring Framework Attributes.

What to do next
Create a final score attribute

Create a final score attribute

Learn how to create an attribute to calculate the final score of your Scoring Framework.

Before you begin
Role required: sn_align_core_apw_admin

About this task
Create an attribute to calculate the final score of a Scoring Framework.

Procedure

1. Navigate to All  > Strategic Planning  > Scoring Frameworks.

2. From the Scoring Frameworks list, select a framework for which you want to add the final score 
attribute.

3. Select New, from the Scoring Framework Attributes related list.

4. On the form, fill in the fields.

Scoring Framework Attribute form

Field Description

Label Name that defines your Scoring Framework's 
final score.

Type Type of the label, such as choice, decimal, 
integer, or string.

Description Details of the Scoring Framework attribute.

5. Select the Final score  option to mark this attribute as the final score attribute of your Scoring 
Framework.

6. Select the Calculated Value  tab and add a formula to derive the value of the final score 
attribute
This formula should be based only on the scoring attributes of your scoring framework. In the 
this example, the ICE custom framework has the formula:

ICE score = Impact * Confidence * Ease
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7. Select Update.

Configuring goals in Strategic Planning

To define and manage goals in Strategic Planning, you must perform some initial administrative 
tasks for the workspace to be fully functional. The data displayed in the goals view in Strategic 
Planning  is stored in the Goal Framework  tables.

• With the admin role, you can migrate the existing goals data to the Goal Framework  tables.

• With the sn_gf.goal_admin role, you can set the goal preferences.

Post migration of your existing goals (if any) and configuring the goal preferences, use the Goals 
view in Strategic Planning  to define your goals. For more information, see Managing portfolio 
plan goals in Strategic Planning Workspace.

Import goals and targets data from a spreadsheet

With the admin role, you can import your existing goals and targets data from a spreadsheet to 
the Goal Framework  tables.

Before you begin
Role required: sn_gf.goal_admin

• On a successful job run, the goals data from your spreadsheet is imported to the Goal 
[sn_gf_goal] table.

• On a successful job run, the targets data from your spreadsheet is imported to the Target 
[sn_gf_goal_target] table.

Note: 
Because the targets are associated to a goal, you should import the goals first and then the 
targets.

Important: 
Goals and targets data in the spreadsheet must be in the supported format. For details on 
the supported data format to import goals and targets data from a spreadsheet, see Import 
goals and targets data [KB1191233] .

Procedure

1. Navigate to All  > System Import Sets  > Load Data.

2. From the Import set table drop-down list, select Goal Import Set [imp_sn_gf_goal]  or Target 
Import Set [imp_sn_gf_goal_target].

3. From the Source of the import  option, select File.

4. In the File  option, click Choose  and select your spreadsheet to import the data.
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Important: 

◦ Goals and targets data in the spreadsheet must be in a specific format. For details on 
the supported data format, see Import goals and targets data [KB1191233] .

◦ Don't modify the names in the header row of the spreadsheet because the data is 
imported to the respective fields in the goal and target tables based on the header title 
of each column.

5. Click Submit.

6. On the Progress page, click Run Transform.

7. On the Specify Import set and Transform map page, click Transform.

8. Click Transform history  and verify that the State column is set to Complete  in the Import Set 
Runs related list.
Depending on the option that you selected from the Import set table drop-down list, your goals 
or targets data is imported to the Goal [sn_gf_goal] or Target [sn_gf_goal_target] tables.

If the job is failed, click Transform history  and refer to the details.

Note: 
The Import operation can be used for inserting new data or updating the existing data 
in the tables. By default, the Name and Owner values are the primary keys used for 
updating the existing records. You can also add additional fields as primary key for 
inserting new data or updating the existing data. For details on how to add additional 
fields as primary key, see Import goals and targets data [KB1191233] .

Migrate existing goals data to Goal Framework  tables

With the admin role, you can migrate the existing goals data to the Goal Framework  tables by 
running the scheduled job.

Before you begin
Role required: admin

About this task

Note: 
Migrating data to the Goal Framework  tables is a one-time job, and not meant to be on a 
schedule.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and click the Migrate Goal, Strategy, and Work item data to the Goal Framework 
and related Planning item tables  scheduled job.

3. On the Scheduled Script Execution form:

a. Ensure that the frequency is selected as On Demand  in the Run  field.

b. Set the value to true  for the required parameters in the Run this script  field.
For parameters information, see Migrate Goal, Strategy, and Work item data to the Goal 
Framework and related Planning item tables.

4. Click Execute Now.
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Configure goal preferences

Configure goal preferences to manage goals such as the calendar type used for goal setting, 
weighted average calculation for goal progress, and deletion of goals and targets.

Before you begin
Role required: sn_gf.goal_admin

Procedure

1. Navigate to All  > Enterprise Goal Management  > Preferences.

2. On the Goal Preferences form, configure the properties.
For properties information, see Goal Preferences form.

3. Click Save.

Customize label for Goal and Target tables

Customize the label for Goal [sn_gf_goal] and Target [sn_gf_goal_target] tables according to your 
organization’s requirement.

Before you begin
Role required: admin

About this task
When you rename the label for the Goal [sn_gf_goal] and Target [sn_gf_goal_target] tables, 
the changes apply to these labels across the Heisenberg UI and the Workspace UI. Also, the 
Goals  and Targets  modules under Enterprise Goal Management  in the navigation pane will be 
renamed.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Customize the label name for the tables according to your requirement.

Configure a table for an assigned entity

Configure a table for an assigned entity type, so that the goal user can associate goals with the 
required assigned entity.

Before you begin
Role required: sn_gf.goal_admin

About this task

• By default, with the installation of Strategic Planning, the assigned entities, Business Unit 
[business_unit], Department [cmn_department], and Company [core_company], Product 
Model [cmdb_model], Value Stream [cmn_value_stream], Intiative [sn_align_core_initiative], 
and Strategic Program [sn_align_core_program] are installed.

• With the activation of PPM Standard (Project Portfolio Management), the Portfolio 
[pm_portfolio] assigned entity is installed.

About this task
An assigned entity is an organizational unit or structure that a goal can be associated with, such 
as a business unit or department. Assigned entities provide context for goals by linking them to 
the relevant part of your organization, making it easier to track and manage goals at any level.
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Procedure

1. Navigate to All  > Enterprise Goal Management  > Assigned Entities.

2. Click New.

3. On the form, fill in the fields.
For field information, see Goal Assigned Entity Configuration form.

4. Click Submit.

Create goals demo data with target breakdowns

Run the Create Goals Demo Data with Target Breakdowns  schedule job to create goals demo 
data with target breakdowns, so that you can view the target breakdowns section on the Goals 
page.

About this task
You must run the job to be able to see the target breakdowns section in the Goals and targets tab 
on the Goals page.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and select the Create Goals Demo Data with Target Breakdowns  scheduled job.

3. On the Scheduled Script Execution form, ensure that the frequency is selected as On Demand 
in the Run  field.

4. Select Execute Now.

Result
A goals demo data with target breakdowns is created. You can now view the target breakdowns 
for your goals in the Goals and targets tab on the Goals page.

Update a schedule job to automate Actual value of the targets

Use the Goal Framework for SPM  application to modify the run time for the scheduled job 
according to your preference to auto-update the actual value of the targets for which a target 
source has been configured.

Before you begin
Role required: sn_gf.goal_admin

About this task
By default, the scheduled job runs daily at 00:00:00 AM (System Time Zone).

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and click the Update Actual value of the targets using Goal Framework for SPM 
scheduled job.

3. Ensure that the Active  check box is selected to run the job at a scheduled time.

4. Edit the details of the Run  and Time  fields according to your preference.

5. Click Update.
To learn more about scheduled jobs, see Scheduled jobs .

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

428

https://www.servicenow.com/docs/access?context=c_ScheduledJobs&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ScheduledJobs&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ScheduledJobs&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Set display limit for goals and targets in Strategic Planning

Update system property value to set the display limit for goals on the Goals page in Strategic 
Planning.

Before you begin
Role required: sn_gf.goal_admin

About this task
The default display limit for goals on the Goals page is 250.

Important: 
If the value of a system property exceeds its default value, the UI performance can degrade.

Procedure

1. Navigate to All  > System Properties  > All Properties.
A list of all the properties in the System Properties [sys_properties] table appears.

2. Search for the sn_align_ws.goal_hierarchy.max_records  system property and 
open it.

3. In the Value  field, enter the desired number of goals to display in the Goals view.

4. Select Update.

Migrate target breakdowns

After upgrading to Strategic Planning  v4.3.2 or later, run the Migrate BreakdownInterval To 
Checkinfrequency  scheduled job to migrate the existing values from the Review frequency  field 
to the Check-in frequency  field in the target records.

About this task
After running the job, the value in the Check-in frequency  field for a target is populated based 
on the existing value in the Review frequency  field of the target. If the existing value in the 
Review frequency  field was set to any option other than None, then target breakdowns will be 
created for such targets based on the value in the existing check-in frequency of the target. For 
more information on how these values are migrated for targets with different values, see Target 
breakdowns migration.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and select the Migrate BreakdownInterval To Checkinfrequency  scheduled job.

3. On the Scheduled Script Execution form, ensure that the frequency is selected as On Demand 
in the Run  field.

4. Select Execute Now.

Target breakdowns migration

As an administrator, when you run the Migrate BreakdownInterval To Checkinfrequency 
scheduled job, the existing values in the Review frequency  and Breakdown interval  fields are 
migrated to the Check-in frequency  field in the target records.

The value in the Actuals to date  field for the target and values in the Planned target value  and 
Actual  fields for the target breakdowns are populated based on the current actual value of the 
target and values in the existing target breakdowns.
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Target breakdowns migration for targets with breakdown interval set to None

After running the job, the value in the Check-in frequency  field for a target is populated based on 
the existing value in the Review frequency  field of the target. If the existing value in the Review 
frequency  field was set to any option other than None, then target breakdowns will be created 
for such targets based on the existing review frequency of the target. Even though Breakdown 
interval  was set to None  for a target, target breakdowns will be created for the target based on 
the existing review frequency of the target.

The following table describes how the check-in frequency value is populated for targets with 
different values in the Review frequency  and Breakdown interval  fields.

Target breakdowns migration with breakdown interval set to None

Review frequency (Before 
upgrade)

Breakdown interval (Before 
upgrade)

Check-in frequency (After 
upgrading and running the job)

Yearly None Yearly

Quarterly None Quarterly

Monthly None Monthly

Fortnightly None Fortnightly

The Fortnightly option is 
retained and no target 
breakdowns will be created 
because the Fortnightly option 
is no longer supported.

After the owner or a 
contributor of the target 
updates the check-in 
frequency for the target, the 
target breakdowns will be 
created accordingly.

Weekly None Weekly

Daily None Daily

None None None

In this case, no target 
breakdowns will be created.

For example, consider a scenario where details of a target are as follows before upgrade:

• The base value and target value of the target is 0 and 100, respectively

• The review frequency is set to Monthly  and Breakdown interval was set to None

• The start date and end date of the target are 2024-01-01 and 2024-12-31, respectively

• The current actual value of the target is 60 and the current month is August

In this case, after running the scheduled job 12 monthly target breakdowns are created for the 
target and the current actual value as 60 is populated in the August monthly breakdown. Also, 
the planned target value is populated for each breakdown.
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Target breakdowns migration for targets with breakdown interval set to 
Quarterly or Yearly

After running the job, the value in the Check-in frequency  field for a target is populated based 
on the existing value in the Review frequency  field of the target. Then, target breakdowns are 
created for the targets based on the existing review frequency of the target.

The following table describes how the check-in frequency value is populated for targets with 
different values in the Review frequency  and Breakdown interval  fields.

Target breakdowns migration with breakdown interval set to Quarterly or Yearly

Review frequency (Before 
upgrade)

Breakdown interval (Before 
upgrade)

Check-in frequency (After 
upgrading and running the job)

Quarterly Quarterly Quarterly

Quarterly Yearly Quarterly

Note: 
For targets with breakdowns interval set to Yearly, irrespective of the target is of type 
cumulative or non-cumulative, after running the scheduled job quarterly target breakdowns 
will be created and the Target value distribution is set to Spread linearly across the time 
period (cumulative)  for the target.

For example, consider a scenario where details of a target are as follows before upgrade:

• The base value and target value of the target is 0 and 80, respectively

• The review frequency is set to Quarterly  and Breakdown interval was set to Yearly

• The start date and end date of the target are 2023-01-01 and 2024-12-31, respectively

• The target is of type non-cumulative

• The actual value achieved in each quarter is 10 starting from Q1-2023 till Q2-2024

• The current total actual value of the target is 60 and the current quarter is Q2-2024

In this case, after running the scheduled job 8 quarterly breakdowns are created and the Target 
value distribution is set to Spread linearly across the time period (cumulative)  for the target. The 
current actual value for Q1-2023, Q2-2023, Q3-2023, Q4-2023, Q1-2024, and Q2-2024 quarterly 
target breakdowns are populated as 10, 20, 30, 40, 50, and 60, respectively. Also, the planned 
target value is populated for each breakdown.

Migrate goal relationships for assigned entities

Migrate the existing goal relationship data from the Goal Relationship 
[sn_gf_goal_m2m_relationship] table by running the scheduled job.

Before you begin
Role required: admin

About this task

• If you’ve upgraded from Alignment Planner Workspace  v4.1.1 or v5.0.1 to Strategic Planning 
v2.0.1 and have created m2m relationship with lens entities other than Company, Business 
Unit, Department, and Portfolio, you can migrate those lens entities from the Goal 
Relationship [sn_gf_goal_m2m_relationship] table to the Goals table to access and manage 
the goals for those lens entities in the respective portfolio plans.
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• Migrating goal relationships data for assigned entities is a one-time job, and not meant to be 
on a schedule.

• Running the job populates the Assigned entity type  and Assigned entity  fields on the Goal 
form  based on the data in the Goal Relationship [sn_gf_goal_m2m_relationship] table if 
you have any customized lenses other than the lens entity types, Company, Business Unit, 
Department, and Portfolio.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and click the Migrate goal relationships for assigned entities 
scheduled job.

3. On the Scheduled Script Execution form:

a. Ensure that the frequency is selected as On Demand  in the Run  field.

b. In the Run this script  field, list the entities configured in the Goal Assigned Entity 
Configuration [sn_gf_assigned_entity_config] table that you want to migrate the goal 
relationship data for.
For parameters information, see Scheduled Script Execution form.

4. Click Execute Now.

Configuring target source for target automation

Configure target sources for target automation so that the goal user can define a target source 
when setting a target for the goal. Defining a target source for a target updates the actual value of 
the target automatically.

Use the following steps as guidelines for configuring target sources.

1. Create a target source for a target to configure it as a source to update the actual value of the 
target. For more information, see Create a target source.

The context variable is required for target source types Assessment/Survey and PA Indicator. 
The mandatory context variables are automatically created while creating a target source with 
the type selected as Assessment/Surveys or PA Indicator. For more information on when the 
mandatory context variables are created, see Context variable in target source.

2. If required, create context variables for the target source so that the required data is fetched 
from the context variables to update the actual value of the target. For more information, see 
Create context variables for a target source.

Context variable in target source

The context variable is an additional configuration for the target source that can be used on the 
Target form to fetch the required data and auto-update the Actual value  field on the Target form. 
A context variable is required for target source types Assessment/Survey and PA Indicator.

The context variable is automatically created (with the Mandatory  field set to true  on the context 
variable form) for the target source (of type Assessment/Survey and PA Indicator) when the Goal 
Framework for SPM  scope is selected before creating a target source. The context variables 
created automatically are also known as mandatory context variables.

The mandatory context variables are created when you've selected the Goal Framework for SPM 
scope and you've met one of the following conditions:
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• (For target source type, Assessment/Survey) On the Target Source form, the Type  field is set to 
Assessment/Survey  and the Assessment Metric Types  field is populated with a metric type 
of Evaluation method = Assessment.

• (For target source type, PA Indicator) On the Target Source form, the Type  field is set to PA 
Indicator  and the value populated in the Breakdown  field isn't of Choice list type.

To create a context variable for the target source type, PA Indicator, where the Breakdown field 
is of Choice list type, see Create a context variable for the target source type PA Indicator.

Note: 
Mandatory context variables can't be deleted.

You can also create context variables manually for a target source and use them to configure 
for fetching the required data and auto-updating the Actual value  field on the Target form. For 
more information on how to create a context variable manually, see Create a context variable for 
a target source.

Create a target source for automating the Actual value of the targets

Create a target source so that the goal user can configure it for the targets to automate the Actual 
value of the targets.

Before you begin
Select the Goal Framework for SPM  scope for the application.

Role required: sn_gf.goal_admin

About this task
The context variable is required for target source types Assessment/Survey and PA Indicator. 
The mandatory context variables are automatically created while creating a target source with 
the type selected as Assessment/Surveys or PA Indicator. For more information on when the 
mandatory context variables are created, see Context variable in target source.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Target Sources.

2. Click New.

3. On the form, fill in the fields.
For a description of the field values, see Target Source form.

4. Click Submit.
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Create a context variable for a target source

Create a context variable manually if you want to configure more context variables for a target 
source.

Before you begin
Select the Goal Framework for SPM  scope for the application.

Role required: sn_gf.goal_admin

About this task
The Context variable provides information that can be used to fetch the required data and auto-
update the Actual value on the target form. After a context variable is created for the target 
source, the goal user can configure the Actual Value Source Configuration section on the Target 
form so that the Actual value gets auto-updated.

Creating a context variable is similar to creating a column on a table.

To create a context variable for the target source type PA Indicator and the breakdown is of 
Choice list type, see Create a context variable for the target source type PA Indicator.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Target Sources.

2. Open the required target source that you want to create a context variable for.

3. In the Context Variables related list, click New.

4. On the form, fill in the fields.
For a description of the field values, see Context Variable form.

5. Click Submit.

Create a context variable for the target source type PA Indicator

Create a context variable manually for the target source type PA Indicator if the breakdown is of 
Choice list type.

Before you begin
Select the Goal Framework for SPM  scope for the application.

Role required: sn_gf.goal_admin

About this task
The context variable provides information that can be used to fetch the required data and auto-
update the Actual value on the Target form. After a context variable is created for the target 
source, the goal user can configure the Actual Value Source Configuration section on the Target 
form for the Actual value to get auto-updated.

Creating a context variable is similar to creating a column on a table.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Target Sources.

2. Open the required target source that you want to create a context variable for.

3. In the Context Variables related list, click New.

4. On the form, fill in the Type  field as Choice and the other fields as needed.
For a description of the field values, see Context Variable form.

5. Click Submit.
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A context variable of choice type is created.

6. In the Choices related list of the context variable you created, click New.

Note: 
If you don’t see the Choices related list on the Context Variable form, add it by navigating 
to Configure  > Related Lists  on the form.

7. On the form, fill in the fields.

Choice form

Field Description

Table Name of the context variable for which the choice is created.

Element Column name in the context variable form for which the choice is created.

Label Name of the choice.

Value Sys_id of the choice value for which the context variable is created.

You can copy the sys_id from the Choices related list of the Dictionary Entry 
[sys_dictionary] table.

8. Click Submit.

9. Optional:  Repeat the steps 6 through 8 to create more choices for the context variable.

What to do next
The goal user can configure these choices as context variables on the Target form for which the 
target source is configured.

Defining a custom unit of measure

Defining a custom unit of measure helps the goal users to set the unit of measure for targets as 
per their choice. Unit of measures are two types, quantitative and qualitative.

By default, the available unit of measures for quantitative targets are #, $, %, Days. By default, 
the available unit of measure for qualitative targets is Yes/No.

As an administrator, you must create custom unit of measures so that the goal user can use them 
for setting a unit of measure for their targets:

• For quantitative targets, you can define a custom unit of measures from the Unit [sn_gf_unit] 
table.

• For qualitative targets, you must first create a choice set and then create a choice list for the 
choice set.

Prioritization display settings in Strategic Planning

Configure the way data is shown on the Prioritization tab of the workspace so that your planning 
managers view the information that is relevant for them.

Configuring additional columns for Prioritization in Strategic Planning

Customize the default column configuration for the Prioritization page of your portfolio plan so 
that your planning managers can select the appropriate data points they need.

Portfolio managers or product owners can show or hide the data for their planning items by 
using the Personalize side panel in the Prioritization tab of their workspace. By default, this side 
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panel of Prioritization tab provides all the default fields available for that planning item. If your 
planning managers want to see additional columns, for example, there could be a requirement 
of information from a dot-walked field. In such cases or to remove any existing choices, you can 
configure them using the admin role.

Personalize settings for 
Prioritization tab

Personalize settings for Kanban 
tab

Personalize settings for 
Hierarchy tab

Add extra columns as choices to this side panel or remove any of the default column choices by 
updating the list layout configuration for the planning item types associated to the portfolio plan.

• If the portfolio plan has multiple item types associated to it, update the view configuration of 
the Planning Item [sn_align_core_planning_item] table.

• If the portfolio plan has a single item type associated to it, update the view configuration of the 
relevant table.

From the form view of the identified table, change the view to APW Prioritization, and update the 
list layout. For the detailed procedure of updating the layout configuration for a list, see Configure 
the list layout .

Note: 
List v3 is no longer available for new deployments. If you are already using list v3, you may 
continue to do so, but in this case some of the functionalities might not be available.

Customizing highlighted fields on Prioritization page of Strategic Planning  Workspace

Customize the fields to be highlighted on the Prioritization page of a portfolio plan according to 
your planning manager's needs.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

436

https://www.servicenow.com/docs/access?context=t_ConfigureTheListLayout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ConfigureTheListLayout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ConfigureTheListLayout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_ConfigureTheListLayout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


By default, the Prioritization and Hierarchy tabs of a portfolio plan highlight the Planning 
state  and Status  fields of a planning item with colors. Based on your planning manager's 
requirements, you can configure fields that are of Choice type, such as Owner or Priority to also 
be the highlighted columns on the page. This customization requires:

• Modifying the Prioritization view Script Includes (APWBacklogConfigImpl for List view and 
APWGanttConfigImpl for Hierarchy view).

• Configuring a new record for the required field in the sys_highlighted_value table.

Modify Script Includes for Prioritization page in Strategic Planning

Modify the Script Includes for List and Hierarchy views of the Prioritization page to change the 
columns to be highlighted in these views in the workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Script Includes.

2. From the list, select one of the following:

◦ For List view, select APWBacklogConfigImpl

◦ For Hierarchy view, select APWGanttConfigImpl

3. Update the column name in the Script  field of the Script Include.

In the getColumnsForHighlightedValues  function, update the return value to the 
desired column.

For example, if you want to highlight the Priority column, update the return value to 
("planning_state", "state", "priority").

4. Select Update.

What to do next
Create new highlighted values for Prioritization columns in Strategic Planning

Create new highlighted values for Prioritization columns in Strategic Planning

Customize the fields to be highlighted on the Prioritization page of a portfolio plan according to 
your planning manager's needs.

Before you begin
Modify Script Includes for Prioritization page in Strategic Planning.

Role required: admin

Procedure

1. Navigate to Workspace Experience  > Administration  > Highlighted Values.

2. Select New.

3. On the form, fill in the fields.
For field information, see Highlighted Value form.

4. Save the form.

5. In the Highlighted Value Conditions related list, create records to configure the color, order, 
and icon for each of the field values that you want to be highlighted in the workspace.
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a. Select New

b. On the form, fill in the fields.
For field, information, see Highlighted Value Condition form.

c. Select Submit.

6. Repeat step 5 to complete this configuration for all the field values.
For example, if you are configuring for status column, you must create three records in the 
Highlighted Value Conditions related list for each of the choices Red, Green, and Yellow.

7. Select Update.

Modify Script Includes for milestone icons in Strategic Planning

Modify the Script Includes for milestone icons in the roadmap and portfolio plan to customize the 
icons displayed in the Roadmap tab in the workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Script Includes.

2. From the list, select RoadmapMilestoneAPIImpl.

3. Update the milestone icon type in the Script  field of the Script Include.
In the getMilestoneMetadata  method, update the return value to the required icon.

For example, if you want to display the Circle exclamation icon ( ) for key event milestone, 
update the return value to 'circle-exclamation-outline'  for the key_event 
milestone.

The default icons are as follows:

◦ key_event: 'flag-fill'

◦ launch_date: 'rocketship-fill'

◦ important_date: 'calendar-clock-fill'

◦ key_milestone: 'diamond-fill'

◦ deadline: 'star-fill'
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4. Select Update.

Update the display limit of items on Prioritization and Roadmap

Create a system property to update the display limit of the items shown in Prioritization and 
Roadmap views in Strategic Planning  Workspace.

Before you begin
Ensure the application scope in your instance is set to Global.

Role required: admin

About this task
The default display limit for Prioritization and Roadmap pages are:

• Planning items shown in the Prioritization tab = 250

• Roadmap items shown in the Roadmap tab = 250

• Goals shown in the Hierarchy tab =250

• Item-level milestones in the Roadmap view = 100

• Items shown in the Kanban tab = 250

• Lanes shown in the Kanban tab = 30

If the total number exceeds these default limits, the additional number of planning items, 
milestone indicators, and vertical lanes are not visible in the workspace. To overwrite this default 
setting, create a system property and set its value to a desired limit of display.

Important: 
If the value of a system property exceeds its default value, the UI performance can degrade.

Procedure

1. Navigate to All  > System Properties  > All Properties.
A list of all the properties in the System Properties [sys_properties] table appears.

2. Click New.

3. On the form, fill in the fields.
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For information on the other form fields, see the field description table in Add a system 
property .

4. Select Submit.

Configure additional source tables for a free-form roadmap

Add new tables to roadmap preferences and configure their details so that these tables can be 
used as source tables while creating a free-form roadmap in Strategic Planning.

Before you begin
Install Strategic Planning.

Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Strategic Planning  > Portfolio Plan Configuration.

2. Select New.

3. On the form, fill in the fields.

For field information, see Portfolio plan configuration form.

4. Select Submit.

Customize the planning item display preferences for Prioritization and Roadmap

Update the default display configuration of planning item attributes in Prioritization, portfolio plan 
Roadmap, and Free-form roadmap pages so that data relevant to you is displayed in Strategic 
Planning  Workspace.

Before you begin
Install Strategic Planning.

Role required: sn_align_core.apw_admin

About this task
Update default settings for the display of planning items such as Group by fields, Color by fields, 
Metrics fields, and Kanban preferences, such as default vertical lane and horizontal lane, metrics 
on the Kanban cards and others, on the following pages:

• Portfolio plans:

◦ Prioritization view

◦ Kanban view

◦ Roadmap view

• Free-form roadmaps:

◦ Timeline view

◦ Kanban view

The options in these configurations are as follows:
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Table Configurations

Configuration table Fields

Prioritization and Roadmap configuration • Group by fields

• Color by fields

• Metrics fields

• Status field

• Percent complete field

Kanban configuration Prioritization, roadmap, and free-form roadmap 
tabs:

• Horizontal lane

• Vertical lane

• Metrics on Kanban card

Rank configuration Rank configuration

Procedure

1. Navigate to All  > Strategic Planning  > Portfolio Plan Configuration.

2. Open a table for which you want to edit the configuration.

3. Edit the required fields.
For field information, see Portfolio plan configuration form.

4. Select Update.

Hierarchy tab display configuration in Strategic Planning

Show or hide parent records of planning items shown in the Hierarchy tab for high-level and 
regular portfolio plans by configuring system properties.

Display empty parent entities in the Hierarchy tab

In the Hierarchy tab, the parent records are displayed only if they have any 
associated planning items.

For example, a portfolio plan built from the Organization lens (Company > Business 
Unit > Department) is used to manage and track plans for Demands and Projects. 
So, when you switch to the Hierarchy tab, only those departments that have at least 
one Demand or Project associated with it are shown in the view.

If you want to see other departments that are included in this portfolio plan but have 
no planning items associated to them, work with your administrator to create the 
system property sn_align_ws.gantt_hide_empty_entities  and set it to 
false.
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Display complete hierarchy for high-level portfolio plans

For high-level portfolio plans, the Hierarchy tab by default shows only the hierarchy 
up to the parent level.

For example, a portfolio plan built from the Strategic Investment lens (Company > 
Strategic priority > Initiative > Strategic program) is used to manage and track plans 
for strategic programs. So, when you switch to the Hierarchy tab, only Strategic 
Priority > Initiative levels are shown by default.

If you want to see the whole hierarchy of Strategic priority > Initiative > Strategic 
program > planning items, work with your administrator to create the system 
property true.

Configuring roadmap in Strategic Planning

Create custom themes to configure roadmap bar colors, ensuring they align with your 
organization’s standards.

Use the following steps as guidelines for configuring custom themes for your roadmap bar colors:

1. Create a custom theme for roadmap bar colors. For details, see Create a custom theme for 
roadmap.

2. Publish your custom theme so that you can apply it to your roadmap. For details, see Publish a 
custom roadmap theme.

3. Apply a custom theme for your roadmap. For details, see Apply a custom theme to roadmap.

4. Verify that the custom theme is applied for your roadmap.
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Create a custom theme for roadmap

Customize roadmap bar colors to align with your organization’s branding guidelines and maintain 
visual consistency.

Before you begin
Role required: admin

About this task
The roadmap applies the colors defined in the UI theme’s Alert  and Grouped  options.

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Management  > Theme Builder.

2. From the Theme Builder Home page or Editor page, select Create a theme.
The theme creation wizard opens.

3. On the Before we get started window, select Continue.

Complete the following steps for each screen in the wizard.

Note: 

◦ Only the step 1 (Naming your theme) is required to create a theme.

◦ Configuring items in steps 2–8 (such as primary, secondary, and neutral colors, 
company logo, additional colors, fonts, and corner shapes) doesn’t affect roadmap bar 
colors.

On this wizard screen... Perform these steps...

Step 1 of 9

First, let’s name your theme

a. Enter a name for your theme in the Theme 
name  field.

b. (Optional) Enter a brief description for your 
theme in the Description  field.

c. Select Next  to continue.

Step 2–8 of 9 a. (Optional) Choose the primary color, 
secondary color, neutral color, add any 
extra colors, company logo, font style, 
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On this wizard screen... Perform these steps...

◦ Step 2: What's your brand's primary color

◦ Step 3: Do you want to add a secondary 
color

◦ Step 4: Now, choose a neutral brand color

◦ Step 5: Do you want to add any additional 
colors

◦ Step 6: Next, let's add your company logo

◦ Step 7: Which font would you like to use

◦ Step 8: Almost done. Choose the corner 
shape you prefer.

user interface corner shapes for your 
organization on the respective screens.

b. Select Next  to continue until you reach 
step 9.

Finally, review your selections. a. Review all configured items (colors, logo, 
font, and shape).

b. Select Create theme  to finalize.

4. On the Theme Builder page under Global styles, select Color icon ( ) to configure colors for 
your roadmap bars.
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5. Under UI colors, in the Show  option, select All colors

6. Configure Alert colors.

a. Under UI colors, select Alert.

b. Configure colors for the following required alert options.

▪ Alert Critical

▪ Alert High

▪ Alert Warning

▪ Alert Moderate

▪ Alert Info

▪ Alert Positive

▪ Alert Low
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7. Configure Grouped colors.

a. Under UI colors, select Grouped.

b. Configure colors for the following required groups.

▪ Grouped Blue

▪ Grouped Brown

▪ Grouped Gray

▪ Grouped Green

▪ Grouped Green
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▪ Yellow Grouped

▪ Magenta Grouped

▪ Orange Grouped

▪ Orange Grouped

▪ Pink Grouped Purple

▪ Grouped Teal

▪ Grouped Yellow
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What to do next
Publish your custom theme so that you can apply it to your roadmap. For details, see Publish a 
custom roadmap theme.

Publish a custom roadmap theme

Publish a custom roadmap theme so that you can apply it to your roadmap.

Before you begin
You have created a custom theme to apply to the roadmap.

Role required: admin

Procedure

1. Navigate to All  > Now Experience Framework  > Theme Management  > Theme Builder.

2. On the Theme Builder page, select Manager  from the Page  drop-down.

3. In the Unpublished section, find your theme in the list, select the More actions icon ( ), and 
then select Publish.
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4. On the Publish the theme window, select Publish.

Result
Your custom theme is now published.
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What to do next
Apply your custom theme to update the colors displayed in the roadmap. For details, see Apply a 
custom theme to roadmap.

Apply a custom theme to roadmap

Apply your custom theme to ensure roadmap bar colors align with your organization’s style.

Before you begin

• You have created and published a custom theme to apply to the roadmap.

• Ensure the application scope in your instance is set to Portfolio Planning.

Role required: admin

About this task
To update the color theme for your roadmap bars, you must copy the sys_id of your custom 
theme, and then create a system property and set its value to the copied sys_id.

The colors configured in the custom theme will be applied to the roadmap bars. However, these 
colors won’t affect the colors of roadmap milestones or planning item milestones.

Procedure

1. Copy the sys_id of the custom theme.

a. Navigate to Now Experience Framework  > Theme Management  > Themes.

b. Search for the custom theme that you want to apply to the roadmap.

c. Right-click the name of your custom theme and select Copy sys_id.
The sys_id of your custom theme is copied.

2. Create a system property and enter the copied sys_id in the form.

a. Navigate to All  > System properties  > All properties.

b. Select New.

c. On the form, fill in the fields.

System Property

Field Description

Name Name of the system property.

Enter the name as sn_align_ws.spw_custom_theme

Application Application scope for the system property.

Ensure the scope is set to Portfolio Planning.

Type System property type.

Set the type to string.

Value Sys_id of the custom theme you created for roadmap bar colors.
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Field Description

Enter the copied sys_id.

d. Select Submit.

The system property is created and updated to include the custom theme information.

Result
The roadmap bars now display the colors configured in the custom theme.

Configuring scenario planning in Strategic Planning

Configure scenario planning in strategic planning to create and compare multiple scenarios.

1. Enable or disable scenario planning.

For more information, see Enable or disable scenario planning in Strategic Planning.

2. Manage financial widgets in compare scenarios page.

For more information on how to add and manage widgets to the comparison view, see 
Configure financial widgets in compare scenario.

Enable or disable scenario planning in Strategic Planning

Enable or disable scenario planning in Strategic Planning.

Before you begin
Role required: sn_align_core.apw_admin

About this task
Scenario planning is enabled by default. Use the following steps to disable or enable scenario 
planning, as required.

Procedure

1. Navigate to All  > System properties  > All properties.

2. Search for the property 

sn_align_ws.is_scenario_planning_disabled.

3. Verify the value of the property.

◦ To enable scenario planning, verify that the property is set to False.

◦ To disable scenario planning, verify that the property is set to True.

What to do next
Create a scenario

Configure financial widgets in compare scenario

Add or manage existing widgets to view financial insights while comparing scenarios. Define your 
own attribute from the cost types to view it's details in the Compare scenario page.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. In the Widgets list, filter the Short description with Compare scenario  to view the existing list.

By default, there are five financial widgets enabled to compare the financial performance of 
scenarios.

3. Edit an existing widget or create a widget to use it in scenario planning.

4. Select Submit.

Capacity configuration in Strategic Planning

Generate employee profiles for resources and map them with primary attributes to start capacity 
planning.

• Enable the planning attributes for capacity to map resources to a unique attribute. For more 
information, see Enable planning attributes for Capacity in Strategic Planning.

• Create resource assignments and generate employee profiles. For more information, see 
Generate employee profiles for resources to work with Capacity.

• Map resources to a unique group, role, and skill to generate employee profiles. For more 
information, see Map primary attributes to resources.

Enable planning attributes for Capacity in Strategic Planning

Enable the planning attributes Group, Skill, and Role so that your planning managers can view 
the resource capacity details.

Before you begin
Role required: admin

Note: 
This activation is a one-time task to enable planning attributes to plan and work on resource 
capacity.

Procedure

1. Navigate to All  > Strategic Planning  > Planning Attributes.

2. Filter the Attribute name to locate and open the Group  attribute.

3. Select the Enable for capacity planning  option.
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4. Select Update.

Note: 
If an attribute is enabled for capacity planning, it is enabled for resource management by 
default.

5. Repeat the steps 2 through 4 for the Skill  and Role  attributes.

You can create custom attributes and map them to resources. For more information, see Create 
or edit planning attributes.

6. Set the value of the Enable for capacity planning column for Group, Role, and Skill field to true.

What to do next

1. Configure attribute values: Navigate to All  > Strategic Planning  > Planning Attributes  to view 
and manage attribute values. You can add, edit, or import attribute entries for Group, Skill, and 
Role.

2. Map attributes to resources: Assign the enabled planning attributes to your resources so they 
appear in capacity views. For custom attributes, see Create or edit planning attributes.

3. Start capacity planning: Navigate to the Capacity tab in your Strategic Planning 
Workspace  to view resource capacity based on the enabled attributes.
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Generate employee profiles for resources to work with Capacity

Generate employee profiles for the resources to map against primary attributes.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Employee Profile  > Employee Definition.

2. Filter the name to locate and open the sys_user  table.

3. In the Employee Definition page, select User  from the Table list.

4. Use the condition builder to filter the required resources and then select the update count icon 

( ).

5. Select Generate Employee Profiles  ( ).

6. In the Generate Employee Profiles window, select Proceed.

Result
Employee profiles for the selected resources are generated.

What to do next
Populate a primary group, primary role, and primary skill for the resources with employee profiles. 
For more information, see Map primary attributes to resources.

Map primary attributes to resources

Locate and map the primary group, primary role, and primary skill for the resources associated 
with existing employee profile tables.

Before you begin
Generate employee profiles for resources to work with Capacity.

Role required: admin

Procedure

1. Navigate to All  > Employee Profile  > Employee Profiles.

2. Filter the User column to locate and open the resources with employee profiles.

3. Select the Populate primary resource attributes  related link to auto-populate the attributes.

◦ If an employee is assigned to a single group, role, and skill, the primary attributes are 
populated.

◦ If an employee is assigned to multiple groups, skills, or roles, select the Primary Resource 
Group, Primary Resource Role, and Primary Resource Skill, using the lookup icon.

4. Select Update.

Activate a scheduled job to automatically generate resource capacity

Activate the scheduled job to auto-generate the resource capacity at required cadence.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Generate Resource Capacity.

3. Select Active  option to activate the schedule job.

4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

Configure financials for planning items in Strategic Planning

Configure the ServiceNow  Internal integrations to view the financials for planning items in 
Strategic Planning.

Before you begin
Role required: admin

Procedure

1. Configure the attributes to generate labor costs in financials based on the resource 
assignments on the work items.
For more information, see Using the Planning attributes  and Create or edit planning attributes.

2. Generate default mapping configurations to create table maps.
For more information, see Generate default mapping configurations.

3. Enable financials for epics to work on financial planning.
For more information, see Enable financials for planning items in Strategic Planning.

4. Enable budget allocation and define a budget attribute, cost type or expense type, to allocate 
budget for your planning items.
For more information see Enable financial budget allocation for planning items in Strategic 
Planning  and Configure budget attribute at instance-level to allocate budget

5. Enable financial benefit planning for planning items in workspace view.
For more information, see Enable monetary benefit plans for planning items

6. Add the monetary and non-monetary benefit plans related lists for your planning items in 
workspace view.
For more information, see Add monetary and non-monetary benefit plans related lists.

7. Create new widgets to view the rolled up financial data at planning item level.
For more information, see Configure a widget and associate it with project.

8. Optional:  Customize the left pane in the financials screen to match the requirements of your 
organization.
For more information, see Customize the left pane view for financials.

9. Optional:  Customize the Create cost plan form fields to match the requirements of your 
organization.
For more information, see Customise cost plan form.

10. Customize the default expense types to manage cost plans for your planning items.
For more information, see Change the default expense type for your planning items

11. Define a custom prefix for your baseline name.
For more information, see Create a custom prefix for baseline.

12. Activate and define scheduled job to automatically migrate budget for your planning items.
For more information, see Activate a scheduled job to migrate budget of your planning items.
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13. Activate and define a scheduled job to migrate financial baselines for your planning items.
For more information, see Migrate financial baselines to Next Experience.

14. Activate and define scheduled job to automatically create financial baselines for your planning 
items at a defined cadence.
For more information, see Activate scheduled job to create financial baselines for planning 
items.

15. Activate and define scheduled jobs to automatically generate labor costs for your planning 
items based on the attribute-based resource assignments at a defined cadence.
For more information, see Activate scheduled job to generate labor costs for your planning 
items.

Enable financials for planning items in Strategic Planning

EActivate financials for all the planning items to work on the financial estimates.

Before you begin
Role required: sn_invst_pln_v2.investment_admin

Procedure

1. Navigate to All  > Investment Funding  > Setup  > Investment Entities.

2. Filter the Table field to locate and open the required planning item.
For example, select sn_align_core_scrum_epic  for epics, select pm_project  for 
projects, dmn_demand  for demands, sn_align_core_capability  for capabilities, or 
sn_align_core_feature  for features.

3. In the Entity form, build the required condition to get the required planning items.

Note: 
If you want to work on the finanical records for completed or closed planning items, 
remove the Active is true  condition.

4. Select Update.

Enable financial budget allocation for planning items in Strategic Planning

Enable allocation property after migrating to Next Experience  to work on budget allocation for 
your planning items using Strategic Planning.

Before you begin

• For new customers accessing financials in Next Experience, this property is enabled by 
default.

• Role required: admin

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open sn_invst_pln.enable_budget_allocation_v2 
property.

3. Update the Value field to True  and select Update.

What to do next
Configure budget attributes to work on managing budget of your planning items. For more 
information, see Configure budget attribute at instance-level to allocate budget.
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Configure budget attribute at instance-level to allocate budget

Configure the budget attribute by expense type or cost type as an instance-level to work on 
budget allocations for your planning items using Strategic Planning.

Before you begin

• Enable the budget allocation property to work on budgeting for planning items. For more 
information, see Enable financial budget allocation for planning items in Strategic Planning.

• Role required: admin

Important: 
Existing customers can’t change the budget attribute to cost_type.

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open sn_invst_pln.budget_allocation_attribute 
property.

3. Update the Value field to one of the following.

◦ cost_type  - view financials by cost types such as Hardware Opex, External labor Capex, 
Software Capex, Software Opex.

Note: 
It's suggested to limit the number of cost types to four.

◦ expense_type  - view financials by expense types such as Capex and Opex.

4. Select Update.

Enable monetary benefit plans for planning items

Enable the benefit plans property to create and manage benefit plans for planning items.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open the 
sn_invst_pln.enable_benefit_plan_in_new_financials  system property.

3. In the Value  field, enter true.

4. Select Update.

Add monetary and non-monetary benefit plans related lists

Enable the monetary benefit plans and non-monetary benefit plans related lists for your planning 
item types such as Epics, Features, and Capabilities.

Before you begin

• This is a one time activity to enable and view the monetary benefit plans and non-monetary 
benefit plans related list for all the planning items.

• Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate a planning item type.

◦ If you want to enable the benefit plans for Feature, filter the Label field to locate and open 
Feature  [sn_align_core_feature] table.

◦ If you want to enable the benefit plans for Capability, filter the Label field to locate and open 
Capability  [sn_align_core_capability] table.

3. Select the Show List  related link.

4. Open a record from the list of Features or Capabilities.

5. Change the scope of the application if you don’t see the editable form of the record page.

6. Change the record page view to EAP Default.

To change the view, select Additional actions  menu ( ), select View, and select the 
EAP Default  view.

7. Select Additional actions  menu ( ), select Configure, and select the Related Lists 
option.

8. Select Monetary Benefit Plans  and Non-monetary Benefit Plans  from the Available list and 
add them to Selected list.

9. Select Save.

10. Select Update  on the planning item record page.
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What to do next
Create and manage monetary and non-monetary benefits plans for your planning items.

• Create monetary benefit plans for your planning items in Strategic Planning

• Manage non-monetary benefit plans for your planning items in Strategic Planning

Configure a widget and associate it with project

Enable and associate a widget to view financial summary of work items at a high-level.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. Select New.

3. On the Widget New Record form, fill the fields.
For a description of the field names, see Widget New Record form.

4. Select the Additional actions menu  and select Save

5. In the Widget associations related list, select New.

6. On the Widget association New Record form, fill the fields.
For a description of the field names, see Widget association form.

7. Select Submit.

Customize the left pane view for financials

Customize the left pane for financials to view custom field information.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate and open the Cost Plan  table.

3. Select the Show List  related link.

4. Select the financials view by navigating to List controls  > View  > Financials View.

The selected view ( ) is displayed on the header.

5. Select the header options to configure list layout.
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6. Add or remove the fields in the Selected column to customize the left pane view in financials 
view.

7. Select Save.

Result
Cost plans table with customized fields for Financials View is displayed.

Customise cost plan form

Manage the fields required on the new cost plan form as per your organization needs.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate and open the Cost Plan  table.

3. Select the Design Form  related link.

4. On the header row, select Cost Plan [cost_plan]  from the table list and Financials View  from 
the view list.

5. On the form, you can:

◦ Drag and drop the required fields from the Fields column.

◦ Remove the existing fields using the Remove field icon.

6. Select Save.
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Change the default expense type for your planning items

Configure the default expense type to create or edit cost plans for your planning items.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > All properties.

2. Filter the name to locate and open sn_plng_att_core.default.expense_type.

3. Change the Value field to the required expense type and select Save.
Opex is the default value.

Create a custom prefix for baseline

Modify the prefix to customize the name of the baselines for your planning items.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > All Properties.

2. Filter the name filed to locate and open sn_invst_pln.baseline_prefix.

3. Modify the Value  field to create a custom prefix for your baselines.

If you’re working on a sales portfolio, you may change the Value  field to Sales baseline 
on.

4. Select Update.

Example:
Assume you are creating a baseline for a sales project using the above prefix on December 04, 
2023. Name of the new baseline will be Sales baseline on 2023-12-04.

Create custom labor costs and map them to sys_id

Create and map custom labor costs to sys_id to generate labor costs based on the relevant 
expenses.

Before you begin
Role required: admin

About this task
Consider you removed the out-of-box cost types and created the following two labor cost types:

• Internal Workforce Capital Expenditure (to replace Labor Capex)

• Contractor Operational Expense (to replace External Labor Opex)

Once these new cost types are created, the system automatically assigns them unique sys_ids. 
These sys_ids are not same as the deleted defaults.

To ensure the system continues to recognize these new cost types for workflows, reporting, or 
calculations, you must manually updated in the sn_plng_att_core.labor_costtype_sysid_mapping 
system property with the new sys_ids.
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Omitting this update may result in system errors or incomplete data processing in cost-related 
operations.

Procedure

1. Create custom labor costs.

a. Navigate to All  > System Definition  > Tables.

b. Filter the Label field to locate the open Cost Type Definition.

c. From the Related Links, select Show List.

List of OOB labor costs is displayed.

d. Select New.

e. On the Cost Type Definition form, fill the fields.

▪ Name  - enter the name of the labor cost plan.

Tip: 
Adding the cost type, either capex or opex, as a suffix to the name helps you to easily 
identify while creating cost plans.

▪ Expense type  - select Capex or Opex from the list to define expense.

For example, you can create Software Capex labor cost to capture software purchasing 
expenses. Hardware Opex labor cost to capture your hardware purchasing expenses.

f. Click Submit.

The new cost plan is displayed on the list.

g. Right-click on the cost plan row and select Copy sys_id.

2. Map the custom labor costs with sys_id.

a. Navigate to All  > System Properties  > All properties.

b. Filter the name field to locate and open the 
sn_plng_att_core.labor_costtype_sysid_mapping  property.

c. In the Value field, enter the labor cost type name and it's sys_id in the same format as the 
OOB labor costs mapping format.

d. Select Update.

Example: Mappings of default out of box labor costs with their sys_id

{
  "labor_capex": "3d16eaf79330120064f572edb67ffb04",
  "labor_opex": "5b26eaf79330120064f572edb67ffb39",
  "external_labor_capex": "ed36eaf79330120064f572edb67ffb41",
  "external_labor_opex": "7b36eaf79330120064f572edb67ffb58"
}

Activate a scheduled job to migrate budget of your planning items

Activate the Migrate budget for active demands and projects  scheduled job to migrate budget 
of active planning items from Classic UI to Next Experience.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Migrate budget for active demands and projects.

3. Select Active  option to activate the schedule job.

4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

Activate scheduled job to create financial baselines for planning items

Activate and define a scheduled job to automatically create financial baselines for your planning 
items at a required cadence.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Create Financial Baseline For Planning Items.

3. Select Active  option to activate the schedule job.

4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

Activate scheduled job to generate labor costs for your planning items

Activate scheduled jobs to automatically generate labor costs for attribute-based resource 
assignments.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the Name field to locate and open Generate Labor Costs For Epic and other planning 
items.

3. Select Active  and on the Scheduled Script Execution form, fill the fields.

For a description of the field names, see Scheduled Script Execution form to generate labor 
costs for planning items.
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Note: 
You can generate the labor costs for inactive planning items. Remove true  in the 
following code line.

fundingEntityGr.addQuery('active', true);

4. Select Update  to save your changes or Execute Now  to run the scheduled job.

Activate scheduled job to populate to multicurrency fields

Activate and execute the scheduled job to map your costs and work with multicurrency.

Before you begin

• After upgrading from classic experience to the latest version, run this job once to populate 
the new investment currency fields for all existing projects. The job copies values from the 
corresponding demand currency or project currency fields. This ensures that financial data 
aligns with the updated multicurrency model.

• Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the Name field to locate and open Update multi-currency fields to investment currency 
for existing demands and projects.

3. Select Active  and on the Scheduled Script Execution form, fill in the details.

For a description of the field names, see Scheduled Script Execution form to generate labor 
costs for planning items.

4. Select Update  to save your changes and execute the job as scheduled, or select Execute Now 
to run the scheduled job.

What to do next
When the job completes, review your project records to confirm that the investment currency 
fields are accurately populated.

Configure portfolio financials in Strategic Planning

Configuration details for properties and scheduled jobs to view and manage portfolio financials 
in Strategic Planning

Before you begin
Role required: admin

Procedure

1. Enable integration for an internal planning item type.
For more information, see Generate default mapping configurations.

2. Activate the investment entities for Demands, Projects, and Epics.
For more information, see Activate investment entities for planning items.

3. Enable the roll up system property to true to view financials.
For more information, see Activate rollup property for projects to view portfolio financials.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

464



4. Activate the data generation scheduled job to view portfolio financials.
For more information, see Activate a scheduled job to generate data to view portfolio 
financials.

Activate investment entities for planning items

Activate the investment entitied for Demands, Projects, and Epics to view portfolio financials.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the name field to locate and open the Investment Entity 
[sn_invst_pln_invst_funding_entity] table.

3. Select the Show List  Related Link.

4. Set the Active field to true  for Demand, Epic, and Project fields.

Activate rollup property for projects to view portfolio financials

Activate project cost rollup property to view the rolled up costs of top projects in portfolio 
financials.

About this task
Financial fields such as planned costs, forecasts, actual costs are rolled up from sub-projects to 
top projects upon setting this property to true.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > All Properties.

2. Filter the name field and select the com.snc.project.rollup.cost  property.

3. Enter true  in the Value field and select Update.

Activate a scheduled job to generate data to view portfolio financials

Activate and define Data generation for financials in SPW/PPW  scheduled job to migrate 
budget from old data model to new data model and view portfolio financials.

About this task
It’s a one-time activity to define and run this scheduled job to view portfolio financials.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Data generation for financials in SPW/PPW.

3. Select the Active option to activate and schedule the job.

4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.

For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Optional:  Remove the condition 'active=true'  to generate the financial data and work on 
costs for inactive planning items.

6. Select Update  to save your changes and execute the job as scheduled, or select Execute Now 
to run the scheduled job.

Result
All the required mappings to view the portfolio financials for Epics, Demands, and Projects are 
mapped.

To validate if the data generation job is successful, navigate to All  > System Definition  > Tables 
and check the mappings for Investment  record in the Project  [sn_align_core_project] table.

Customizing Lists in Strategic Planning

You can add custom tables to the Lists menu in Strategic Planning  Workspace and manage 
access to the newly created categories and lists.

Perform the following tasks to customize Lists and manage access to the newly created 
categories and lists in the Lists page of Strategic Planning  Workspace:

• Add the New  button to the APW List Menu Configuration page. For more information, see 
Enable adding custom tables to the Lists menu.

• Add custom tables to the Lists menu. For more information, see Customize Lists in Strategic 
Planning Workspace.

• Manage who can view the newly created categories and lists in the Lists page. For more 
information, see Define audience for new lists in Strategic Planning.

Enable adding custom tables to the Lists menu

Add the New  action button to the APW List Menu Configuration page, so that you can add 
custom tables to the Lists menu in Strategic Planning  Workspace.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspace Experience  > Actions & Components  > List Actions.

2. From the Action Assignments page, select New  to create the action button.

3. On the form, fill in the fields.
For a description of the field values, see Action Assignment form.

4. Select Submit.
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Result
The New  action button is added to the APW List Menu Configuration page.

What to do next
Customize Lists in Strategic Planning Workspace.

Customize Lists in Strategic Planning  Workspace

Add custom tables to the Lists menu in Strategic Planning  Workspace.

Before you begin

• Ensure that your application scope is set to Portfolio Planning.

• Enable adding custom tables to the Lists menu.

Role required: admin

About this task
Lists menu in the Workspace homepage helps planning managers quickly find a record that they 
need. By default, this view shows the list of entities of all the planning items and lens available for 
this ServiceNow  instance. If your planning managers need more categories or lists, you can add 
them.

For more information of configuring lists in a workspace, see Lists .

Procedure

1. Navigate to sys_ux_list_menu_config.list.

2. From the UX List Menu Configurations list, select APW List Menu Configuration.

3. Select a new category or a new list.

Tip: 
Create a category first and then create a list.

4. On the form, fill in the fields.

◦ UX List Category form.

◦ UX List form.

5. Select Submit.
Repeat this procedure until you've created all the custom categories and lists.

What to do next
Define audience for new lists in Strategic Planning.

Define audience for new lists in Strategic Planning

Manage who can view the newly created categories and lists in the Lists page of Strategic 
Planning  Workspace.

Before you begin
Customize Lists in Strategic Planning Workspace.

Role required: admin
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Procedure

1. Navigate to sys_ux_applicability_m2m_list.list.

2. Select New.

3. On the form, fill in the fields.
For field information, see List Applicability form.

4. Select Submit.

Strategic Planning  diagnostics

Run diagnostic scans to identify and fix errors in the configuration and other common settings for 
Strategic Planning  before your planning managers prioritize and roadmap work for their portfolio 
plans.

Strategic Planning  diagnostic scans help you find discrepancies by validating the configuration 
for the following:

• Lens and lens structure

• Form views, list views, related list views, and workspace view rules for planning items

• Global ranking for planning items

• Portfolio plans

• Goals data

• high-level planning entities

The following are the default diagnostic scans available for Strategic Planning.

Strategic Planning diagnostics for high-level planning

Field Description

Validate Rank configuration for the high-level 
planning entities Verifies that entities enabled for high-level 

planning have a Rank configuration.

If this test fails, see Create rank configuration 
for high-level planning  to fix failure.
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Field Description

Validate Form section views for high-level 
planning entities

Verifies that all the lens entities that are 
enabled for high-level planning have the 
required Form section views.

If this scan fails, the result displays the Form 
section views that are missing for certain 
entities that are enabled for high-level 
planning.

To learn how to fix these, see Create form 
views for new planning item tables in Strategic 
Planning.

Validate Related list views for high-level 
planning entities

Verifies that all the lens entities that are 
enabled for high-level planning have the 
required Related list views.

If this scan fails, the result displays the Related 
List views that are missing for certain entities 
that are enabled for high-level planning.

To learn how to fix these, see Create related 
list views for new planning item types in 
Strategic Planning.

Validate List views for high-level planning 
entities

Verifies that all the lens entities that are 
enabled for high-level planning have the 
required List views.

If this scan fails, the result displays the List 
views that are missing for certain planning 
item tables.

To learn how to fix these, see Create list views 
for new planning item tables in Strategic 
Planning.

Identify high-level planning entities enabled 
for planning, without a global rank Identifies the number of high-level planning 

entities that do not have a global rank.

If this scan fails, the result shows the planning 
items that do not have a global rank. Click Run 
Fix Script  to populate a global rank to items for 
which this field is empty.

Portfolio Planning  diagnostics

The following are the diagnostic scans available to validate common configuration errors for 
planning items, goals, and portfolio plans:
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Name of the scan Description

Identify planning items without a global rank Identifies the number of planning items on the 
Prioritization List page, for which the global 
rank is not populated.

If this scan fails, the result shows the planning 
items that do not have a global rank. Click Run 
Fix Script  to populate a global rank to items for 
which this field is empty.

Check Goal Assigned Entity Configuration for 
lens entities

Identifies the lens entities for which the goal 
assigned entity configuration is missing.

If this scan fails, the result shows the lens 
entities that don’t have Assigned Entity 
Configuration.

Validate List views for planning items Verifies that all the planning items that can 
be added to portfolio plans have the APW 
Prioritization and APW Default List views.

If this scan fails, the result displays the List 
views that are missing for certain planning 
item tables.

To learn how to fix these, see Create list views 
for new planning item tables in Strategic 
Planning.

Validate Form section views for planning items Verifies that all the planning items that can 
be added to portfolio plans have the APW 
Prioritization, APW Default, and APW New form 
views.

If this scan fails, the result displays the Form 
section views that are missing for certain 
planning item tables.

To learn how to fix these, see Create form 
views for new planning item tables in Strategic 
Planning.

Validate Related list views for planning items Verifies that all the planning items that are 
allowed on portfolio plans have the APW 
Default Related list view.

If this scan fails, the result displays the Related 
list views that are missing for certain planning 
item tables.
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Name of the scan Description

To learn how to fix these, see Create related 
list views for new planning item types in 
Strategic Planning.

Validate Workspace view rule for Default view 
of planning items

Verifies that all the planning items that are 
allowed on portfolio plans have the Default 
view's workspace view rule.

If this scan fails, the result displays the Default 
view rule is missing for certain planning item 
tables.

To learn how to fix these, see Create 
workspace view rules for new planning item 
forms in Strategic Planning.

Validate the goal relationships for assigned 
entities

Identifies if there are any m2m goal 
relationships defined for assigned entities.

If this scan fails, the result displays the 
goals that do have m2m goal relationships 
any assigned entity table. You can run the 
Migrate goal relationships for 
assigned entities  scheduled job 
to migrate the existing goal relationship 
data from the Goal Relationship 
[sn_gf_goal_m2m_relationship] table to the 
Goals table. For more information, see Migrate 
goal relationships for assigned entities.

Validate Workspace view rule for APW  Default 
view of planning items

Verifies that all the planning items that are 
allowed on portfolio plans have the APW 
Default view's workspace view rule.

If this scan fails, the result displays the 
APW  Default view rule is missing for certain 
planning item tables.

To learn how to fix these, see Create 
workspace view rules for new planning item 
forms in Strategic Planning.

Validate invalid fields in the Portfolio Plan 
configuration

Finds any invalid fields in the portfolio plan 
configuration records for all existing portfolio 
plans.

If this scan fails, click Run Fix Script  to remove 
the identified invalid fields.

Validate Portfolio Plan Configuration for all the 
portfolio plans

Verifies if each existing portfolio plan created 
in your instance has a valid portfolio plan 
configuration.
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Configuring Strategic Planning  with PPM, Agile 2.0, and SAFe

Understand the process required to set up Strategic Planning  to work with Agile Development 
2.0, Scaled Agile Framework, Next Experience  for Demand Management, and Project Portfolio 
Management.

Configuration workflow

Use the following steps as guidelines for your Strategic Planning  with PPM, Agile 2.0, Next 
Experience  for Demand Management, and SAFe  setup process. Some of these steps require the 
admin role (sn_align_core.apw_admin) and some require the user role (sn_align_core.apw_user).

1. Create an alignment integration

2. Generate default mapping configurations

3. Create custom mapping configurations  (Optional)

Guided Setup

After installing Strategic Planning, you can use the guided setup to help you with the required 
configuration. To open the guided setup, navigate to Strategic Planning  > Guided Setup.

Create an alignment integration

Once you have Strategic Planning  installed, the ServiceNow Internal  Alignment integration 
is created by default. In case the alignment integration is not available, you can create your 
alignment integration type.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Strategic Planning  > Integrations.

2. Verify if the Servicenow Internal  alignment integration exists.

3. If not, click New  to create an alignment integration.

4. In the Name  field, enter the name of the alignment integration.
Alternatively, you can also click Create ServiceNow Internal Integration  from the related links 
to create an internal alignment integration.

5. Click Submit.

Generate default mapping configurations

Generate default mapping configurations to create table maps for the available applications.

Before you begin
Role required: sn_align_core_apw.admin

Procedure

1. Navigate to All  > Strategic Planning  > Integrations.

2. Click ServiceNow Internal  to view the alignment integrations for the internal applications.

3. Click Generate Default Mapping Configurations  to create the table maps for the available 
applications.
Table mapping for the planning item types such as Epic, Demand, Project, and project task 
are generated and the alignment mappings are displayed in the Table Maps related list. See 
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the following table for details on the list of table maps that are created for the respective 
applications.

Application installed Table maps created

Project Portfolio Management Projects, project tasks (for milestones), 
demands, and idea

Agile Development 2.0 Epics

SAFe SAFe  epic

Note: 
Mapping configurations consist of table, field, and choice maps for each record.

Default mapping configurations

Create custom mapping configurations

Create mapping configurations for planning items that are not created by default such as 
features, stories, etc.

As an admin, you can choose to create table maps, field maps, and choice maps for the planning 
items that are not created by default. For more information, see:

1. Create a table map

2. Create a field map

3. Create a choice map

Create a table map

Create a table map to define the mapping between tables in Strategic Planning  with the tables in 
Agile Development 2.0, SAFe, and PPM.

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Strategic Planning  > Integrations.

2. Select ServiceNow Internal.

3. Create a new table map by selecting New  in the Table maps  tab.

4. In the Table map form, fill in the fields.
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5. Select Submit.

Create a new table map

Result
A new table map is created with your alignment and execution table configurations.

Note: 
To create or update a table map for a planning item type other than demand or project, the 
SPM Pro license is required. Contact your administrator for more details.

What to do next
Create a business rule to support export of this new table map configuration to Agile 
Development 2.0, SAFe, or PPM. For more information, see Create a business rule to apply a 
custom table map configuration.

Create a business rule to apply a custom table map configuration

Create a business rule to enable import for your new custom table map configuration from Agile 
Development 2.0, SAFe, and PPM applications.

Before you begin
Role required: sn_align_core_apw.admin

About this task
After you create a custom table map in Strategic Planning  integrations, create a business rule 
similar to 'Sync Data from Execution to Alignment' business rule in the rm_epic or dmn_demand 
tables.

Note: 
Ensure that the business rule is created in the execution application, such as Agile 
Development 2.0, SAFe, or PPM.

Procedure

1. Navigate to All  > System Definition  > Business Rules.

2. From the list of available business rules, locate and open the Sync Data from Execution to 
Alignment rule.

3. From the context menu ( ), perform an Insert and Stay operation on this business rule.
If you have not enabled the Insert and Stay  action in your ServiceNow  instance, see Allow 
insert options on records .

4. On the business rule form, edit the following fields.
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Business rule form

Field Description

Name Unique name for the business rule.

For example, if your new table map is to map 
demands, name this rule as Sync Demands 
with Strategic Planning.

Table Select the table for which you've created the 
custom map.

For example, Feature [sn_safe_feature].

5. Click Update.

Create a field map

Map the fields for each table map from Strategic Planning  to Agile Development 2.0, SAFe, 
Project Portfolio Management and vice-versa.

Before you begin
Ensure that you have created a table map for an alignment integration record. For more 
information, see Create a table map.

Note: 
If the execution field type is 'Reference' and the alignment field type is 'String', then the 
sync will not work.

Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Strategic Planning  > Integrations.

2. Select ServiceNow Internal.

3. In the Table Maps  related list, select the table map for which you want to create a field map.

4. Create a new field map by selecting New  in the Field Maps tab.

5. In the Field map form, fill in the fields.

6. Click Submit.

Create a choice map

Map the choice list for each field map for fields with a list of values from Strategic Planning  to 
Agile Development 2.0, SAFe, Project Portfolio Management and vice-versa.

Before you begin
Ensure that you have created a field map and it contains choice fields with a list of values. For 
more information, see Create a field map.

Role required: sn_align_core.apw_admin
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Procedure

1. Navigate to All  > Strategic Planning  > Integrations.

2. Select ServiceNow Internal.

3. In the Table Maps  related list, select the table map which has the fields for which you want to 
create a choice map.

4. In the Field Maps  related list, select a relevant field map for which you want to create a choice 
map.

5. Create a new choice map by selecting New  in the Choice Maps tab.

6. In the Choice map form, fill in the fields.

7. Click Submit.

Configure bulk import

This system property enables you to update the bulk import functionality in Strategic Planning 
with PPM, Agile 2.0, and SAFe.

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Enter sys_properties.list  in the navigation filter.

2. Search for com.sn_align_cmn_int.bulk_import.

3. Set the property value to either of the following options.
When the records are imported from PPM, Agile Development 2.0, or SAFe  to Strategic 
Planning , only the last comment will be imported.

Working with Teamspaces

Strategic Planning  can be integrated with Project Portfolio Management's Teamspaces to access 
and manage relevant projects and demands with the corresponding planning item records.

You must activate a teamspace plugin to use the teamspace feature. The following teamspace 
plugins are available:

• Project Management TeamSpace 1 (com.snc.ppm_teamspace_1)

• Project Management TeamSpace 2 (com.snc.ppm_teamspace_2)

• Project Management TeamSpace 3 (com.snc.ppm_teamspace_3)

• Project Management TeamSpace 4 (com.snc.ppm_teamspace_4)

• Project Management TeamSpace 5 (com.snc.ppm_teamspace_5)

The teamspaces installed with these plugins contain the same components, but the components 
have different prefixes. For example, teamspace 1 includes a project table named Teamspace_1 
Project [tsp1_project]  and teamspace 5 includes a project table named Teamspace_5 Project 
[tsp5_project].

Also, the corresponding teamspace role must be added to the Strategic Planning  admin 
(sn_align_core.apw_admin) role. For example, tsp1_portfolio_manager for teamspace1, 
tsp2_portfolio_manager for teamspace2 and so on.

To integrate teamspaces with Strategic Planning  records:
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1. Create one alignment integration for all the teamspaces. On the alignment side, 
create extended tables to store individual teamspace table data (like TSP1 Portfolio 
[sn_align_core_tsp1_portfolio], TSP1 Demand [sn_align_core_tsp1_demand], TSP2 Project 
[sn_align_core_tsp2_project], and so on).

2. In the alignment integration, map the extended tables you have created in Step 1, to the 
respective teamspace tables (like tsp1_portfolio, tsp1_demand, tsp2_project, and so on).

Integration with Teamspaces

Related topics

Create a table map

Managing portfolio plans in Strategic Planning Workspace

Create personalized portfolio plans in Strategic Planning  Workspace and enable focused 
planning of work in the desired perspective (lens) to drive alignment.

The following sections guide you on creating, updating, sharing, and collaborating with portfolio 
plans in Strategic Planning  Workspace.

Create a high-level portfolio plan

Build a portfolio plan for high-level strategic items in the Strategic Planning  Workspace so that 
you can prioritize, roadmap, and manage work aligned to these strategic items.

Before you begin
Role required: sn_align_core.apw_user or business_stakeholder

About this task
By default, you can select the Strategic Investments lens and use Initiatives or Strategic 
Programs, or select the Project Program lens and use Programs as your high-level planning 
items. You can also select the Digital Product lens and use the Product Enhancement entity for 
high-level planning.  If you want to plan using a different item, work with your admin to enable 
those items in your ServiceNow  instance. For more information on the configuration, see High-
level planning configuration in Strategic Planning.

In this task, select a lens, add conditions to filter the planning item data that you need, and enter 
additional details to build a portfolio plan.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the Portfolio Plans page, select New.
If there are no existing portfolio plans, select Create your first portfolio plan.

3. Select a lens for your high-level planning.

By default, the Strategic Investments and Project Program lenses are enabled for high-level 
planning.

Note: 
Don’t select Goals lens because the Goal [sn_gf_goal] table doesn't support high-level 
planning.

The Create portfolio plan wizard is shown.

4. Make your selections by using the Create portfolio plan wizard.

a. For the selected lens, choose the type of work that you want to plan.

For example, you want to manage work for initiatives in your company. Select Initiatives as 
your high-level planning item. This enables you to plan for initiatives and review the work 
aligned to these initiatives.

b. Add conditions to further filter the data of your planning items.

For example, you’re responsible for the initiatives of the Customer Support department. You 
can set a condition to filter initiatives of only the Customer Support department from the 
Initiative table.

You can also add multiple conditions to help you set a complex filter and add the right 
information to your portfolio plan.

c. Fill in the details of the portfolio plan.

Provide the information of the portfolio plan's name, owner, start and end dates, and 
description.
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d. Select a scoring framework using the drop-down values or from the Scoring framework 
window.
To create a custom scoring framework for your portfolio plan, select Explore scoring 

frameworks.

Use the Previous  and Next  buttons to navigate between the steps.

5. Select Create.

Result
The portfolio plan is created and the page is refreshed to show the Goals, Scoring, and Planning 
pages. You can view the list of all portfolio plans that you own or shared with you from the Home 
page.

What to do next

• Define goals for your portfolio plan and align work to them. See Managing portfolio plan goals 
in Strategic Planning Workspace.

• Analyze the backlog and prioritize work for your portfolio plan. See Prioritizing portfolio plan 
work in Strategic Planning Workspace.

• Show or hide features for your portfolio plan according to your requirement while sharing a 
portfolio plan with your stakeholders. See, Show or hide the features for a portfolio plan.

Create a portfolio plan

Use lens and build a personalized portfolio plan in Strategic Planning  Workspace so that you can 
start to prioritize and align work.

Before you begin
Role required: sn_align_core.apw_user or business_stakeholder

About this task
Use a four-step wizard to select a lens, add conditions to filter the planning items that you need, 
and enter additional details to create a portfolio plan.

(For Enterprise Architecture Workspace  users only) You must install Enterprise Architecture 
Workspace  to create a portfolio plan using the Business Capability lens. You must have the 
sn_apm.apm_user role to create a portfolio plan using the Business Capability lens.

This task guides you on creating a regular work item-level portfolio plan. To create high-level 
portfolio plans, see Create a high-level portfolio plan.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the Portfolio Plans page, select New.
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If there are no existing plans, select Create your first portfolio plan.

3. Make your selections by using the Create Portfolio plan wizard.

a. Select a lens.

b. For the selected lens, choose an entity type and the desired entities of that type.

The entity type represents the level that you plan your work in.

For example, to plan work for the HR department, select the Organization  as lens, 
Department  as your entity type, and HR  from the list of departments. This selection ensures 
that only the work associated with the HR department is added to your portfolio plan.

c. Select the type of planning items that you want to include in your portfolio plan.

You can further filter the planning item data with additional conditions.

For example, to plan and track progress for all HR projects created this year, select Project 
as your planning item and add a condition to filter all the HR projects created this year.

You can also add multiple conditions to set a complex filter and add the right planning items 
to your portfolio plan.

d. Fill in the details of the portfolio plan.

Provide the portfolio plan's name, owner, start and end dates, and description.

Important: 
The start and end dates for your portfolio plan act as a date range filter for all the 
planning items that get added to the plan.
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For example, if your portfolio plan spans from March 1, 2023, to July 6, 2024, then the 
projects approved with start and end dates in Feb 2023 won't appear in the plan, despite 
meeting the "created in 2023" criteria.

e. Select a scoring framework using the drop-down values or from the Scoring framework 
window.
To create a custom scoring framework for your portfolio plan, select Explore scoring 

frameworks.

You can use Previous  and Next  to navigate between the steps.

4. Select Create.

Result
The portfolio plan is created and the page is refreshed to show the Goals, Scoring, and Planning 
pages for this new portfolio plan. You can view the list of all portfolio plans that you own or are 
shared with you from the Home page.

Planning items that meet the following criteria appear in the portfolio plan:

• Planning items that belong to one of the entity types selected in Step 3(b)

• Planning items that match the planning item types selected in Step 3(c)

• Planning items with an approved start date or an end date that falls within the portfolio plan 
timeline

• Planning items that don't have both Approved start and Approved end dates

Note: 
If any demands were converted into projects in Project Portfolio Management, only the 
resulting project planning items (converted from demands) appear in the portfolio plan.

What to do next

• Define goals for your portfolio plan and align your work to them. See Managing portfolio plan 
goals in Strategic Planning Workspace.

• Analyze the backlog and prioritize work for your portfolio plan. See Prioritizing portfolio plan 
work in Strategic Planning Workspace.

• Show or hide features for your portfolio plan according to your requirement while sharing a 
portfolio plan with your stakeholders. See, Show or hide the features for a portfolio plan.

Duplicate a portfolio plan

Create a portfolio plan with the data of an existing portfolio plan. If the portfolio plan you want 
to create is similar to an existing portfolio plan, duplicating the existing portfolio plan saves your 
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time. You can also duplicate portfolio plans that were shared with you either with view or edit 
access.

Before you begin
Role required: sn_align_core.apw_user or business_stakeholder

About this task
The Duplicate portfolio plan  option copies the selected portfolio plan with its all data (Goals, 
Prioritization, and Roadmap) into the portfolio plan. It also preserves all dependencies and 
relationships among the copied items and their child items.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header, select the More actions icon ( ) and then select Duplicate 
portfolio plan.

4. On the Duplicate portfolio plan window, fill the details.

a. Enter a name for the portfolio plan in the Portfolio plan name  field.
By default, the name is ABC (Copy)  where ABC is the name of the portfolio plan you 
copied from.

b. Optional:  Select Share with same users and groups  option to grant access to the users of 
the portfolio plan you copied from.
The action grants the same read and edit access as is the users had for the portfolio plan 
you copied from.

c. Select Confirm.

Result
The new portfolio plan is created and a link is generated on the screen to access the new 
portfolio plan.

What to do next

• View or update the goals for your portfolio plan according to the new portfolio plan. See 
Managing portfolio plan goals in Strategic Planning Workspace.

• Analyze the backlog and prioritize work for your portfolio plan. See Prioritizing portfolio plan 
work in Strategic Planning Workspace.

• Show or hide features for your portfolio plan according to your requirement while sharing a 
portfolio plan with your stakeholders. See, Show or hide the features for a portfolio plan.

Modify a portfolio plan

Update the details of a portfolio plan in Strategic Planning  Workspace or delete it, to reflect the 
changes in your planning priorities.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user or business_stakeholder
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About this task
Note: 
Only the owner or editors of a portfolio plan can modify it.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header, select the More actions icon ( ).

4. Update the details of the portfolio plan or delete it.

Related topics

Share a portfolio plan with stakeholders

Collaborate on a portfolio plan

Show or hide the features for a portfolio plan

Show or hide the features for a portfolio plan

As a portfolio manager, show or hide the features (for example, Goals, Scoring, Prioritization, 
Roadmap, and so on) for your portfolio plan as needed so that you can share only the required 
data with your stakeholders.

About this task
Hiding features for your portfolio plan helps you share only the data that matters to your 
stakeholders and restrict access to the other data in your portfolio plan.

Note: 
When you share a portfolio plan with your stake holder  providing view access and hiding 
a feature (for example, Scoring), the viewer can only view the enabled features and can't 
see the hidden feature (Scoring) in the shared portfolio plan. However, when you share a 
portfolio plan providing edit access, the editor can enable or hide the features as required 
and can view and edit any data in the shared portfolio plan.
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Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user or business_stakeholder

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select the portfolio plan for which you want to show or hide the 
features.

3. From the left pane of the portfolio plan, select Show/hide modules.

4. On the Show/hide modules window, select the modules and features that you want to show 
and deselect the modules and features that you want to hide.

5. Select Apply changes.

Related topics

Share a portfolio plan with stakeholders

Share a portfolio plan with stakeholders

Share your portfolio plan with stakeholders and other planning managers so that they have 
visibility into the plan's progress and start collaborating.

Before you begin

• Create a portfolio plan.

• Users or groups that you want to share the portfolio plan with must have the 
sn_align_core.ap_read_only or sn_align_core.apw_user role to get the read or edit access to 
the portfolio plan respectively.

Role required: sn_align_core.apw_user or business_stakeholder

About this task
Select individual users or groups to share the portfolio with.

When you share a portfolio plan with an individual user or a group, they can access the following 
data of the portfolio plan:
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• Planning page

◦ Prioritization, Roadmap, Kanban, Hierarchy tabs by default

◦ Capacity tab if the user has the sn_align_ws.spw_capacity_user or 
sn_align_ws.spw_capacity_read role

◦ Financials tab if the user has sn_align_ws.spw_financial_user role

• Goals page if the user has the sn_apw_advanced.spw_goal_user role

• Scoring page if the user has the sn_align_core.apw_user role

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header in the Planning page, select the Share portfolio plan  icon ( ).

Note: 
Alternatively, you can select Share actions icon ( ) and then select Copy link  to copy 
a direct link to the portfolio plan that you can share with other users. The link provides 
access only to users who already have the required permissions.

4. On the Share portfolio plan form, select users to share the portfolio plan with and set their 
access appropriately.

a. In the Members or Groups  field, enter the names of individual users or groups.

b. From the Access  field, select the access level as Viewer  or Editor  for the selected names.

▪ An editor can view and change the portfolio plan's settings and data.

▪ A viewer can comment and add attachments to the portfolio plan, but cannot modify the 
portfolio plan's settings or data.

Note: 
Even if a user has the sn_align_core.apw_user role, they cannot edit planning item 
data from the portfolio plan grid view or side panel when granted view-only access. 
However, users with the sn_align_core.apw_user role can edit planning items and 
related tables from the record page.

5. Select Send invite.

Result
The selected individual and group users are notified of the portfolio plan sharing through an 
email.

What to do next
Collaborate on a portfolio plan.
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Change the access level or remove access for a user or a group.

1. From the portfolio plan header, select Share actions icon ( ) and then select Manage 
access.

2. From the user or group card, select the Action Menu icon ( ).

3. Select the right access level or select Remove.

Related topics

Modify a portfolio plan

Show or hide the features for a portfolio plan

Collaborate on a portfolio plan

Add comments and attachments to your portfolio plan so that users can review and share their 
feedback. Collaborate with stakeholders and drive shared outcomes.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user or business_stakeholder

About this task
Comment on plans and data points, share attachments, and provide feedback from a single 
place in the workspace to ensure all the stakeholders are in alignment with the business 
priorities.

The attachments and comments that you add from the portfolio plan's header, they apply to the 
entire portfolio plan (Goals, Prioritization, and Roadmap).

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header in the Planning page, select the Comments  icon ( ).

4. Add comments or attachments to the portfolio plan.

Related topics

Modify a portfolio plan

Share a portfolio plan with stakeholders

Show or hide the features for a portfolio plan

Scoring planning items in Strategic Planning Workspace

Evaluate the work in your portfolio plans using scoring frameworks in Strategic Planning 
Workspace. Determine the priority and feasibility of planning items using the scores assigned to 
them so that you can make informed decisions about resource and finance allocations.

The following sections guide you on scoring and ranking the items in your portfolio plan in 
Strategic Planning  Workspace.

Score items in a portfolio plan

Score your items using the Scoring framework attributes that generate a score, that helps in 
prioritizing and ranking the items in your portfolio plan.
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Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace.

2. Select to open the portfolio plan for which you want to start scoring.
If you don’t have a scoring framework assigned to your portfolio plan:

a. Select the more actions icon ( ).

b. Select Edit portfolio plan.

c. Navigate to the Add Details  step.

d. Select a framework for your portfolio plan.

Note: 
The scoring framework selection is available only for planning items.

3. Select Scoring.

4. Enter values for each of the scoring framework attributes.

To learn about the scoring framework attributes and the scoring formula, select the information 

icon ( ) for each of the fields.

Result
The score for each item is populated based on the scoring attribute values and calculation 
formula.

Note: 
To generate a final score for a pre-defined scoring framework, all the attributes of a scoring 
framework need to have values.

Related topics

Scoring in Strategic Planning

Custom scoring frameworks in Strategic Planning

Rank items in a portfolio plan

Assign ranks to the items based on the planning item attributes and scoring framework attributes 
such as Planned Cost, Moscow, Priority, Score, and so on.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace.

2. Select to open the portfolio plan for which you want to start ranking of items.
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3. Select Planning.

4. Select Rank items  in the Prioritization view.

5. Select an attribute using the drop-down list.
For example, if you want to rank your items based on confidence, select Confidence  as an 
attribute. You can rank on choice and number type attributes of a planning item.

6. Choose the order in which you want the items to be ranked.

7. Select Apply.

Result
The items in your portfolio plan are ranked based on your ranked attribute.

Export planning items data from Scoring to Excel or CSV

Export the data of portfolio plan items from your portfolio plan into a Microsoft  Excel or CSV file. 
You can share this data and collaborate with your business stakeholders.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Scoring.

3. Verify that the columns you want to export are personalized.

Note: 
If the filters are applied on the view, the filtered data is exported.

4. Use the personalized side panel to export the data of your portfolio plan items.

a. Select Export icon ( ).

b. From the File type  drop-down on the Export window, select Excel  or CSV  to export the data 
to a Microsoft  Excel or CSV file respectively.
A file with the selected format is exported. By default, the name of the file is 
ABC_Scoring_List  where ABC is the name of the portfolio plan you exported the data 
from.

Managing portfolio plan goals in Strategic Planning Workspace

Create goals for your portfolio plans, set targets for them, and evaluate the progress of the goals 
and targets in Strategic Planning  Workspace to accomplish your organizational plans and drive 
business outcomes.

https://player.vimeo.com/video/1089949088?
h=313cb311d3&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

The Goals view in the Strategic Planning  Workspace gives you an overview of your goals and 
their targets with the Dashboard, List, and Hierarchy tabs. The Dashboard tab (formerly known 
as the Overview tab) provides a summary of all your goals in a particular portfolio plan. The 
List tab helps you view, create, and manage your goals and targets of the particular portfolio 
level. The Hierarchy tab helps you view the goals and targets of the portfolio plan entities in a 
hierarchical manner. This tab also helps you view the goals of the parent entities (of the portfolio 
plan entities) along with the goals and targets of the current portfolio plan.
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Roles required for managing goals

Access level Required roles

Read access to Goals • sn_align_core.apw_user

• sn_apw_advanced.spw_goal_user_read

Edit access to Goals • sn_align_core.apw_user

• sn_apw_advanced.spw_goal_user

Portfolio plan details section in the Goals view
The portfolio plan details section in the Goals view provides the portfolio plan details along with 
options to manage the portfolio plan and create goals. The header section is the same for all tabs 
in the Goals view.

From the Portfolio plan details section, you can:

• Create goals  for your portfolio plan.

• Share your portfolio plan  with stakeholders and other planning managers so that they have 
visibility into the progress of the plan and can start collaborating.

• Collaborate with stakeholders  and drive shared outcomes by adding comments and 
attachments to your portfolio plan so that users can review and share their feedback.

• Customize the widgets and cards that you want to view on the Dashboard tab using the 

Settings icon ( ). This setting is available only when the Dashboard tab is selected.

Note: 
Only users with access to edit the portfolio plan can customize the widgets and cards.

Example Header section in the Goals view

Dashboard tab in the Goals view
The Dashboard tab has multiple widgets that help you drill down in the goals and targets, see 
their details, and manage them. The following figure shows a sample goals list and indicates the 
different features for goals in Strategic Planning  Workspace on the Dashboard tab.

• Goals: A section with multiple widgets that help you view and manage your goals and targets 
defined for the portfolio plan.

◦ Total progress: Displays the average progress of all the goals from all the entities of the 
portfolio plan.

◦ Progress by <entity type of the portfolio plan>: Displays the average progress (in percentage) 
of total goals by each entity type of the portfolio plan. For example, if the portfolio plan is 
of entity type department, the widget shows the average progress of total goals in each 
department.
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◦ Status: Displays your goals based on their status (example, Red, Green, and Yellow).

◦ Status by <entity type of the portfolio plan>: Displays your goals status by each entity type of 
the portfolio plan. For example, if the portfolio plan is of entity type department, the widget 
shows the goals status in each department.

◦ Total goals: Displays the number of total goals defined for the portfolio plan.

◦ Not aligned to parent goals: Displays the goals that aren’t directly associated with its parent 
goal or any of the entities of the portfolio plan. Associate such goals with the parent goal or 
the entities so that the effort is visible.

Note: 
Associating a goal with the parent goal is optional.

◦ With no targets: Displays the goals that don’t have targets set for them. Set targets for such 
goals to achieve them.

◦ With no work aligned: Displays the goals that aren’t associated with work. You can 
associate work items (Project, Demand, and Epic) with goals so that the work being done to 
accomplish goals and meet targets is easily visible.

The “Not aligned to parent goals,” “With no targets,” and “With no work aligned” cards help you 
review and define the goals in the system properly from the alignment perspective. After goals 
are defined and aligned, you can choose to hide these cards.

Example Goals section on the Dashboard tab

• Targets: A section with multiple widgets that help you view and manage your targets set for the 
portfolio plan.

◦ Status: Displays your targets based on their status. The status indicates whether the target is 
likely to be completed by the planned end date.

◦ State: Displays the state of the targets from all the entities of the portfolio plan.
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◦ Due for review: Displays the targets that are due in a week or already overdue from their 
respective review due date perspective. The Check-in due date  field on the target form 
helps you to update your targets periodically based on their check-in frequency.

Example Targets section on the Dashboard tab

• Strategic priorities: A section with the By strategic priorities widget that helps you view how 
your goals are aligned with your organization's long-term strategies and manage them.

Example Strategic priorities section on the Dashboard tab

Filtering data of the portfolio plan

Use the filtering options on the Dashboard tab to filter the data of the goals 
and targets by their Strategic priority, entity type of the portfolio plan, Time 
period, Owner, State, and Status, so that you can focus on the particular 

information.

List view in the Goals and targets tab

The List view helps you view, create, and manage your goals and targets of the particular 
portfolio plan. The List tab hides the downstream and upstream goals, enabling you to focus on 
only the goals and targets of the current portfolio plan. The List tab helps you update the actual 
values for your target breakdowns directly. However, you can view the downstream and upstream 
goals and targets from the Hierarchy tab. The following figure shows a sample goals list and 
indicates the different features for goals in Strategic Planning  Workspace on the List tab.
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• The row context menu icon ( ) gives you options for managing a goal such as create subgoal, 
set target, and align work for the selected goal.

• Assigned entity: Name of the entity to which the goal belongs.

• Personalize: Helps you customize the columns that you want to view on the List tab. Select the 

settings icon ( ) to enable the columns that you want to view on the List tab.

• Check-in frequency: Specifies the breakdown interval for the target. Breaking down the target 
into smaller periods (example, Quarterly) helps you set targets for each quarter and focus on 
the specific breakdown targets.

• Add remarks icon ( ): Specifies the remarks that were entered by the user for business 
justification when updating the breakdown actuals. Selecting the Remark icon opens the 
breakdown side panel with Details and Comments tabs.

• Target breakdowns: Helps you view the details of target breakdowns in yearly or quarterly 
intervals. You can also enter or update the actual values in this window.

• Quarterly / Yearly: Helps to customize the view of target breakdowns quarterly or yearly.

Example goals and targets view on the List tab

Hierarchy view in the Goals and targets tab

The Hierarchy view helps you view the goals and targets of the portfolio plan entities in a 
hierarchical manner. Also, the tab helps you view the goals of the parent entities (of the portfolio 
plan entities) along with the goals and targets of the current portfolio plan. For example, in the 
following figure, the departments are the portfolio plan entities and business units are their 
parent entities. Enabling the Parent entities goals  option shows the goals of the parent entities 
(of the portfolio plan entities) along with the goals and targets of the current portfolio plan. 
Enabling the Parent entities goals  option helps you plan and align your portfolio goals with the 
goals of the parent entities.

• Parent entities goals: Displays the goals of the parent entities (of the portfolio plan entities) that 
helps you plan and align your portfolio goals with the goals of the parent entities.

• Personalize: Helps you customize the columns that you want to view on the Hierarchy tab. 

Select the settings icon ( ) to enable the columns that you want to view on the Hierarchy tab.

• The row context menu icon ( ) gives you options for managing a goal such as create subgoal, 
set target, and align work for the selected goal.

• Unaligned goals - Not directly associated with parent entities: Lists the goals that aren’t directly 
associated with the parent goals. You can open these goal records from the side panel and fill 
in the Parent goal  field that is based on the goal of the parent entities that your goal belongs 
to.
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Example goals view on the Hierarchy tab

Goals examples and recommendations

Business goals are an important part of establishing up priorities and setting a company for 
success. Understanding how to set achievable goals can greatly increase the ability to stay on 
track both in the short term and the long term for a company.

The following are the examples for strategic priorities along with their goals and targets.

Examples for strategic priorities along with their goals and targets

Strategic Priority Goal Target

Achieve a customer 
satisfaction score of 90% or 
higher by Q4 2024

Improve customer satisfaction

Reduce customer complaints 
by 20% by the end of 2024

Increase active users on the 
platform by 15% within 12 
months

Enhance customer experience

Increase customer 
engagement

Increase customer retention 
rate by 10% by Q4 2024

Launch 3 new products or 
features per year starting from 
2024

Accelerate time to market for 
new products

Reduce the product 
development cycle from 12 
months to 8 months by 2025

Allocate 15% of the annual 
budget to research and 
development

Drive innovation and product 
development

Foster a culture of innovation

Increase the number of 
innovation projects submitted 
by employees by 25% within 
18 months

Achieve 5% market share 
growth in the Asia-Pacific 
region by 2025

Expand market reach Increase market share in key 
regions

Expand into 3 new 
international markets by 2026
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Examples for strategic priorities along with their goals and targets  (continued)

Strategic Priority Goal Target

Establish 5 new strategic 
partnerships with local 
distributors or resellers by 
2024

Build strategic partnerships

Increase revenue from 
partnerships by 20% by the 
end of 2025

Implement an enterprise 
resource planning (ERP) 
system by Q3 2024

Optimize internal processes

Reduce operational costs 
by 10% by 2025 through 
automation

Increase employee 
satisfaction score to 85% by 
the end of 2024

Strengthen operational 
efficiency

Improve employee 
productivity

Reduce employee turnover by 
15% by 2025

Recommendations to setup goals and targets

The following are the recommendations on how to setup goals and targets for an organization 
business growth.

Goal: Increase overall revenue and market share in 2024

Target 1:  Expand market share by 10% in target regions

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24

• Type: Maximize

• Unit of measure: Percentage

• Start value: 40% (considering market share is already 40% by the end of 2023)

• Final target value: 50%

• Check-in frequency: Monthly or Quarterly

• Target value distribution: Spread linearly across the time period (cumulative)

Target 2:  Launch four new products or services by the end of Q4

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24
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• Type: Maximize

• Unit of measure: Count

• Start value: 0

• Final target value: 4

• Check-in frequency: Quarterly

• Target value distribution: Split equally across the time period (non-cumulative)

Target 3:  Acquire 1,000 new enterprise customers

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24

• Type: Maximize

• Unit of measure: Count

• Start value: 0

• Final target value: 1000

• Check-in frequency: Monthly or Quarterly

• Target value distribution: Split equally across the time period (non-cumulative) or 
Spread linearly across the time period (cumulative)

Goal: Improve customer satisfaction and retention

Target 1:  Increase Net Promoter Score (NPS) from 70 to 85

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24

• Type: Maximize

• Unit of measure: Count

• Start value: 70

• Final target value: 85

• Check-in frequency: Monthly or Quarterly

• Target value distribution: Spread linearly across the time period (cumulative)

Target 2:  Decrease customer churn rate from 12% to 8%

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24

• Type: Minimize

• Unit of measure: Percentage

• Start value: 12%
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• Final target value: 8%

• Check-in frequency: Monthly or Quarterly

• Target value distribution: Spread linearly across the time period (cumulative)

Target 3:  Conduct quarterly customer feedback surveys with a 60% response rate

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24

• Type: Maximize

• Unit of measure: Percentage

• Start value: 0

• Final target value: 60%

• Check-in frequency: Quarterly

• Target value distribution: Spread linearly across the time period (cumulative)

Goal: Build strategic partnership channels

Target 1:  Establish partnership with five new consulting firms

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24

• Type: Maximize

• Unit of measure: Count

• Start value: 0

• Final target value: 5

• Check-in frequency: Monthly or Quarterly

• Target value distribution: Spread linearly across the time period (cumulative)

Target 2:  Generate $100K revenue through partners

The following is the recommended setup for defining the target using the Target 
form  in the workspace:

• Start date: 1/1/24

• End date: 31/12/24

• Type: Maximize

• Unit of measure: Currency

• Start value: 0

• Final target value: 100K

• Check-in frequency: Monthly or Quarterly
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• Target value distribution: Spread linearly across the time period (cumulative) or 
Split equally across the time period (non-cumulative). Set this option depending 
on whether you want to track the target progress individually for each month or 
quarter, or at an aggregated level.

Create a goal in Strategic Planning

Create goals for your portfolio plans and set targets to measure overall goal progress and align 
goals with your organizational strategic priorities.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and (sn_align_core.apw_user  or 
sn_gf.goal_admin)

About this task
Goals are typically qualitative by nature. Goals should be ambitious and are expected to motivate 
and challenge your teams.

Only the owner or contributors of the goal can edit the goal.

Note: 
If you have created goals but don't see them appearing in the portfolio plan, populate the 
Assigned entity type and Assigned entity fields on the Goal form to display those goals in 
the portfolio plan.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select a portfolio plan that you want to create a goal for.

3. From the Goals page, select New goal.

4. On the form, fill in the fields.
For a description of the field values, see Goal form.

5. Select Save.
You can also select Save and add target  and add a target for the goal on the flow. For a 
description of the field values for a target, see Target form.

What to do next
Set targets for the goals. For more information, see Add targets for a goal in Strategic Planning  or 
Configuring target source for target automation.

Add targets for a goal in Strategic Planning

Create SMART targets for goals to track and measure the progress of your goals.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and (sn_align_core.apw_user  or 
sn_gf.goal_admin)

About this task
If you’re using Now Assist for SPM, you can use the Target generation skill to generate targets 
for a goal. The skill uses the goal’s details and provided context to create a precise target for the 
goal. The more specific the input, the stronger the recommendations. For details, see Generate 
targets for a goal in Strategic Planning Workspace using Now Assist for SPM.

Configuring a target source for your target updates the Actuals to date  field on the Target form 
automatically. For more information on target automation, see Target actuals automation in 
Strategic Planning.
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A SMART target can be defined as S = Specific, M = Measurable, A = Attainable, R = Relevant, 
and T = Time-bound.

Note: 

• Only the owner or contributors of the goal can create targets for the goal.

• You can also restrict the access for a target record to the specific users by enabling the 
Confidential  field on the Target form if the ServiceNow®  ESG Management  application is 
installed.

Procedure

1. Create a target for a goal using one of the following options.

2. On the form, fill in the fields.
For a description of the field values, see Target form.

3. Select Save.
You can also select Save and add new target  and add more targets for the goal on the flow.

Result
The target progress records are automatically created when you save the target post populating 
the Actuals to date  field. The target progress records specify the progress of each target for the 
goal.

Note: 
When you delete a goal, its associated targets (if any) and their progress records are also 
deleted even though the Allow the deletion of targets  property is set to No.

What to do next
Update the progress of the target  manually if the target is not enabled for target automation.

Update the progress of a manual target

Update the progress of a target when its status is changed.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and sn_align_core.apw_user

About this task

Note: 
Only the owner or contributors of the goal can update a goal target.

Procedure

1. Open the target record of the goal using one of the following options.

2. On the form, update the Actuals to date  or Actual  field and add a business justification in the 
Remark  field.

For a description of the field values, see Target form.

3. Select either Update  or Save.
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Result
After the Actuals to date  field is updated, the progress value for the target and its goal is auto-
updated. For information on how the progress value is calculated, see progress value calculation. 
For information on how the progress value is calculated for a target that has target breakdowns, 
see Target breakdowns in Strategic Planning.

Related topics

Update the actual value of a target breakdown

Update the progress of an automated target

Update the progress of an automated target

Update the progress of a target using the Update Actual value  related link on the Target form.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and sn_align_core.apw_user

About this task

Note: 
Only the owner or contributors of the goal can update a goal target.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select the required portfolio plan that the target belongs to.

3. In the Goals view, select the Goals and targets  tab.

4. Select the target that you want to update the progress for.
The Target side panel opens with the Details  tab.

If the target has breakdowns, selecting the target opens the Target side panel with the 
Progress  tab. Select the Details  tab on the Target side panel.

5. From the side panel, select Full Details  to open the target form.

6. On the Target form, select the Update Actual value  related link.
For a description of the field values, see Target form.

Result
After the Actuals to date  field is updated, the progress value for the target and its goal is auto-
updated. For information on how the progress value is calculated, see progress value calculation. 
For information on how the progress value is calculated for a target that has target breakdowns, 
see Target breakdowns in Strategic Planning.

Related topics

Update the progress of a manual target

Update the actual value of a target breakdown

Duplicate a goal or target

Create a copy of an existing goal or target to align goals with your organizational strategic 
priorities. If the goal or target you want to create is similar to an existing one, duplicating the 
existing record saves your time.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and sn_align_core.apw_user
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About this task
Goals are typically qualitative by nature. Goals should be ambitious and are expected to motivate 
and challenge your teams.

Only the owner or contributors of the goal can edit the goal.

Note: 
If you have created goals but don't see them appearing in the portfolio plan, populate the 
Assigned entity type and Assigned entity fields on the Goal form to display those goals in 
the portfolio plan.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select a portfolio plan that you want to create a goal for.

3. From the Goals page, select Goals and targets  and then select List  or Hierarchy  view.

4. Select the Row context menu icon ( ) of the goal or target that you want to copy and then 
select Duplicate.

◦ For a goal, the Goal modal opens with all details of the goal you copied from. You can update 
the details for the goal as needed and then select Save  to save the goal or select Save and 
add a target  to save the goal and add a target for the goal. For a description of the field 
values, see Goal form.

◦ For a target, the New target window opens with all details of the target you copied from. You 
can update the details for the target as needed and then select Save  to save the target or 
select Save and add a new target  to save the target and add another target for the goal. For 
a description of the field values, see Target form.

By default, the name is Copy of ABC  where ABC is the name of the goal or target you 
copied from.

What to do next
Set more targets for the goals. For more information, see Add targets for a goal in Strategic 
Planning  or Configuring target source for target automation.

Target actuals automation in Strategic Planning

Automate the actual value for your targets using the target automation feature.

https://player.vimeo.com/video/1077953139?
h=93de7e6865&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479%0Ahttps:/
/youtu.be/pd0dWCbHRkA

Use the following steps as guidelines to enable actuals automation and configure a target source 
for a target using the target automation feature.

You must perform the following steps on the Target form  to enable target automation for the 
target.

1. Enter the Start value, Final target value, and Check-in frequency, and fill the other required 
fields for the target.

2. Select the Automate actual value  field.
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3. Select a target source in the Actual value source  field, from which the value must be fetched 
for target automation.

A target source is a configuration (of a custom script, PA indicator, or Assessments) for a target 
to auto-update the actual value of the target, so that the progress of the target and its goal are 
auto-updated.

You can select either the Benefit Plans option or a custom target source as a target source for 
the target. After selecting a target source, save the target record to view additional actual value 
source configuration.

◦ Benefit Plans target source - A target source that is created using a custom script where the 
actual benefit value of benefit plans of the planning items associated with the goal or target 
fetches the target actuals. Then the application updates the actual value of the target based 
on the actual benefit value.
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When you select Benefit Plans target source (predefined target automation script for benefit 
plans) as the Actual value source for the target, the benefit_plan  field appears in the 
Variables section, from which you can select the required benefit plans for fetching the value 
and automating the actual value of the target.

Note: 
Only benefit plans of the planning items associated with the goal or target will be 
available to select in the benefit_plan  field as a source for target automation.

◦ Custom target source - Create a custom target source and configure it as a source to update 
the actual value of the target. For instructions on how to create a target source, see Create a 
target source.

For instructions on creating targets for a goal, see Add targets for a goal in Strategic Planning.

Target breakdowns in Strategic Planning

Breaking down a target into smaller periods (for example, Monthly) helps you set a target 
value for each month and focus on that specific monthly target. The target breakdowns are 
automatically created based on the Check-in frequency and Target value distribution set for the 
target.

The check-in frequency for a target can be set to Daily, Weekly, Monthly, Quarterly, or Yearly. 
Based on the Check-in frequency of the target, the corresponding target breakdowns are 
created. For example, if the Check-in frequency is set to Monthly for a target spanning for a year, 
12 monthly target breakdowns are created. Planned target values are automatically set for each 
target breakdown based on the Target value distribution setting of the target.

Note: 
The target breakdowns feature isn’t supported for qualitative targets.

The following examples help you understand how the target progress is calculated for targets 
with different target distribution type.
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Example 1: Acquire 1200 new customers in the calender year 2025 (Track non-
cumulatively)

In this example, you want to achieve a target of acquiring 1200 new customers in 
the calender year 2025 and track the progress monthly (non-cumulatively), then you 
can set the target as the following:

• Set the start date and end dates to 2025-01-01 and 2025-12-31, respectively

• Set the start value and final target values to 0 and 1200, respectively

• Set the Check-in frequency for the target to Monthly

• Set the Target value distribution to Split equally across the time period (non-
cumulative)

This Target value distribution means that the final target value is divided into 12 
equal values (planned target value for each target breakdown) which aggregates 
to the final target value. You can edit the planned target value later from the 
respective target breakdown record as needed.

In this case, the application creates 12 target breakdowns (January, February,
………, and December) for calender year 2025 and sets the Planned target value for 
each target breakdown to 100 (Final target value divided by the number of target 
breakdowns).

Because the application sums up the actual value entered in each monthly target 
breakdown, you must enter the actual value that is achieved in the particular month 
for the target breakdown. For example, you acquired 100 customers in January, 
then enter 100 as the actual value in the January target breakdown. And, you 
acquired another 100 customers in February, then enter 100 as the actual value in 
the February target breakdown. Similarly, if you acquired another 100 in March and 
100 in April, then enter 100 as the actual value in both the March and April target 
breakdowns.

The application sums up the actual values entered in each monthly target 
breakdown and rolls up the sum value to the actual value of the main target. Then, 
the progress of the target and its goal are auto-updated.

Example 2: Acquire 1200 new customers in the calender year 2025 (Track cumulatively)
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In this example, you want to achieve a target of acquiring 1200 new customers in the 
calender year 2025 and track the progress monthly (cumulatively), then you can set 
the target as the following:

• Set the start date and end dates to 2025-01-01 and 2025-12-31, respectively

• Set the start value and final target values to 0 and 100, respectively

• Set the Check-in frequency for the target to Monthly

• Set the Target value distribution to Spread linearly across the time period 
(cumulative)

This Target value distribution means that the final target value is divided linearly 
into 12 planned target values (such a way that the value for the last monthly 
breakdown is equal to the final target value). You can edit the planned target value 
later from the respective target breakdown record as needed.

In this case, the application creates 12 target breakdowns (January, February,………, 
and December) for calender year 2025 and sets the Planned target value for the 
January, February,………, and December breakdowns to 100, 200,…….., and 1200 
respectively.

Because the application considers only the actual value entered in the latest 
monthly target breakdown, you must enter the cumulative actual value in the latest 
monthly target breakdown. For example, you acquired 100 customers in January, 
then enter 100 as the actual value in the January target breakdown. And, you 
acquired another 100 customers in February, then enter 200 as the actual value 
in the February target breakdown. Similarly, if you acquired another 100 in March 
and 100 in April, then enter 300 and 400 as the actual value in the March and April 
target breakdowns, respectively.

The application considers the actual value entered in the latest monthly target 
breakdown and rolls up to the actual value of the main target. Then, the progress of 
the target and its goal are auto-updated.

Graphical visualisation of target progress

The Progress  tab in the target’s side panel provides graphical visualization for the trend of the 
target progress based on the planned target value and the actual value of the breakdowns. You 
can also edit the planned target and view the check-in history of the target actuals from the 
Progress  tab.
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Benefits of target breakdowns

The target breakdowns feature helps you when you want to set a target for a period but want to 
track the progress of the target in smaller periods such as daily, weekly, monthly, quarterly, and 
yearly. For example, you have set a target for a year with start value and final target values of 0 
and 1200, respectively. Also, you want to set monthly targets of 100 for each quarter. In this case, 
you can break down the target into monthly targets and set a target value for each month so that 
you can focus on the specific monthly target and update your actuals against those monthly 
targets.

The target breakdowns feature has the following benefits:

• Break down the long-term targets into short-term intervals such as Daily, Weekly, Monthly, 
Quarterly, and Yearly for a better tracking or reporting of your progress

• Set or modify a planned target value for each target breakdown as needed

• Update the actual value for each target breakdown and track the progress of the main target

• Focus on the specific short-term target (target breakdown) rather than the whole target

• Track the progress of your short-term and long-term targets cumulatively or non-cumulatively

• Visualize the trend of the target's process wrt the planned target in the line or bar chart

How the actual value is calculated when the check-in frequency set to None

When the check-in frequency is set to None for a target, the actual value must be entered in 
the Actuals to date  field in the main target record. The actual value entered must be cumulative 
irrespective of the time period of the target. Target breakdowns aren’t created when the check-in 
frequency is set to None.

Target breakdowns in target automation

If you’ve enabled the target automation feature for a target and set the check-in frequency and 
Target value distribution, the target automation feature automatically updates the actual value 
in the respective target breakdown based on the check-in due date. After the actual value of 
a target breakdown is updated, the value is rolled up to rolls up to the actual value of the main 
target. Then, the progress of the target and its goal are auto-updated.

Update the actual value of a target breakdown

Update the actual value of a target breakdown when its status is changed.
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Before you begin
Role required: sn_apw_advanced.spw_goal_user and (sn_align_core.apw_user  or 
sn_gf.goal_admin)

About this task
Updating the actual value of a target breakdown automatically updates the actual value of its 
target. After the Actual to date  field of the target is updated, the progress value for the target and 
its goal are auto-updated.

Note: 
Only the owner or contributors of the goal can update the target breakdowns.

Procedure

1. Open the target record of the goal using one of the following options.

2. On the form, update the Actual  field for the target breakdown and add a business justification 
in the Remark  field.
For a description of the field values, see Target Breakdown form.

3. Select Save.

Result
After the Actual  field is updated, the progress value for the target and its goal are auto-updated. 
For information on how the progress value is calculated, see progress value calculation. For 
information on how the actual value of the target breakdown is rolled up to its target, see Target 
breakdowns in Strategic Planning.

Related topics

Update the progress of a manual target

Update the progress of an automated target

Align a planning item with goals or targets

Create a goal or target relationship with a planning item or any other item to identify and 
associate your current or future work and achieve your goals and targets.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and sn_align_core.apw_user

About this task
You can associate a goal or target with the planning items - Project, Demand, and Epic.

From the Align work window, you can associate a goal or target with multiple planning items at 
a time. From the Planning items tab of the goal or target, you can associate a goal or target with 
only one planning item at a time.

You can create goal or target relationships with a custom planning item 
from the Align work window only if the planning item table is added to the 
planning_item_types_allow_list  property. For more information, see Enable custom 
item types in Strategic Planning.

Note: 
When a goal or target relationship is created with a planning item (Project, Demand, or 
Epic), the record appears on the Planning items tab on the goal record. When a goal or 
target relationship is created with any other item, the record appears on the Other items tab 
on the respective goal or target record.
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Procedure

1. Open the Goal/Target Relationship form using one of the following options.

2. Select either Done  or Save.

Associate or update the primary goal or target for a planning item

Associate a primary goal or target for the planning items where the items contribute to achieving 
the goal or target.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and sn_align_core.apw_user

About this task
You can associate a goal or target as primary with a planning item by populating the Primary 
goal  and Primary target  fields on the Planning item form respectively. When you populate the 
Primary target  field, the Primary goal  is automatically populated with the goal of the populated 
target. For more information, see Planning item form.

After you associate planning items with goals or targets, you can check these relationships 
directly on the Planning items tab of the goal's form or on the Goal/Target Relationships tab of 
the planning item's form.

Note: 

• By default, the goal or target becomes the primary when you associate a goal or target 
with a planning item for the first time. Then after, association of any goal or target with 
the planning item becomes a secondary association unless the Primary  field is selected 
while associating the goal or target.

• When a planning item already has a primary goal association and you want to make 
another goal as primary, the existing primary goal association becomes secondary and 
the fresh association becomes primary for the planning item.

• Associating the primary goal or target isn’t supported for strategic items such as 
initiatives and strategic programs.

• To associate the primary goal or target with a custom planning item, ensure that the 
custom planning item is added to the planning_item_types_allow_list 
property.

Procedure

1. Open the required planning item form using one of the following options.

2. On the Item details side panel or Details  tab, fill in or update the Primary goal  and Primary 
target  fields with the goal and target respectively that you want to associate or update.

Alternatively, you can select Add  in the Goal/Target Relationships  tab, populate the Goal  and 
Target  fields as needed, and then select Primary. The Primary goal  and Primary target  fields 
are then automatically populated on the planning item form.

For a description of the field values, see Planning item form.

3. Select either Update  or Save.
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What to do next
If you want to remove the existing goal or target association, you can remove the association 
by selecting the association record and selecting the Remove  option on the Goal/Target 
Relationships tab of the planning item record. If the planning item has the primary goal and 
secondary goal association, you can remove the primary association only after you make any 
other goal as primary for the planning item.

Generate insights for a goal in Strategic Planning Workspace  using Now Assist for SPM

Review AI-generated insights to identify at-risk goals, assess forecasted statuses, and act on 
recommendations before goals fall off track.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_apw_advanced.spw_goal_user and (sn_align_core.apw_user or 
sn_gf.goal_admin)

About this task
The Goal insights skill analyzes the goal, its targets, subgoals, and aligned work, then delivers 
concise, data‑driven  insights—including AI forecasted status, confidence of achieving the goal, 
targets at risk, delayed or stalled aligned work and recommendations.

The skill analyzes the real-time data — including check-in patterns, comments, and planned 
versus actual progress — to forecast goal status and surface proactive recommendations.

Note: 
Only the owner or contributors of the goal can generate insights for the goal.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select a portfolio plan for your the goal belongs to.

3. From the Goals page, select Goals and targets.

4. From the list of goals, select the name of the goal for which you want to generate insights.
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The goal side pane opens with the Details  tab.

5. From the side pane, select Full Details  to open the goal form.
The goal’s full details page opens.

6. Select Show insights.

The Goal insights side pane appears processing the insights for the goal. After a while, 
the Insights by Now Assist pane shows the insights for the goal including AI forecasted 
status, confidence of achieving the goal, targets at risk, delayed or stalled aligned work and 
recommendations.

7. Review AI-generated insights to identify risk, assess forecasted statuses, and act on 
recommendations before goals fall off track.

Export goals and targets data to Excel or CSV

Export the data of goals and targets from your portfolio plan into a Microsoft Excel  or CSV file. You 
can share this data and collaborate with your business stakeholders.

Before you begin
Role required: sn_apw_advanced.spw_goal_user and sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Goals.

3. From the Goals page, select List  view.

4. Verify that the columns you want to export are personalized.

Note: 
If the filters are applied on the view, the filtered data is exported. Also, to differentiate 
between goal and target record in the exported file, select Record type  in the 
personalized side panel.

5. Use the Personalize side panel to export the data of your goals and targets.

a. Select Export icon ( ).

b. From the File type  drop-down on the Export window, select Excel  or CSV  to export the data 
to a Microsoft Excel  or CSV file respectively.
The data is exported into the selected file format. By default, the name of the file is 
ABC_goals_and_targets_list  where ABC is the name of the portfolio plan you 
exported the data from.

Prioritizing portfolio plan work in Strategic Planning Workspace

Review the work pipeline for your portfolio in Strategic Planning Workspace. Add, update, and 
rank planning items so that you can prioritize the right work for the right time.

Views for prioritizing planning items

The Prioritization tab on the Planning page in Strategic Planning  represents your backlog, 
displaying the items in your work pipeline. The Kanban and Hierarchy tabs also represent your 
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backlog, each providing a different view of the same items. For an overview of these views, see 
Prioritization in Strategic Planning.

Note: 
The Prioritization feature is available only for portfolio plans.

Planning items in the Prioritization tab

By default, portfolio plans show only the records that are created within the Planning Item 
[sn_align_core_planning_item] table and its child tables. Any records stored in other ServiceNow 
AI Platform  tables aren't shown unless an integration is established.

Consider that you want to manage projects through a portfolio plan. Project records that are only 
stored in the Planning Item Project [sn_align_project] table are displayed in the Prioritization, 
Kanban, and Hierarchy tabs. But any projects created using the PPM Standard aren't shown 
by default because these project records are stored in the PPM Project [pm_project] table. To 
enable their display in Strategic Planning  Workspace, set up integration with PPM so that the 
tables of Strategic Planning  are mapped to the tables of PPM.

The same is the case with Epics created using Agile Development 2.0  and SAFe  applications. 
See Configuring Strategic Planning with PPM, Agile 2.0, and SAFe.

Prioritization features

In the Prioritization and Hierarchy tabs, you can perform the following actions:

Feature Description Example UI

Add new planning items
Add new items to your backlog 
directly from the Prioritization 
page.

The type of planning items 
that you can create here 
depends on your portfolio 
plan configuration.

Update planning item details
Edit details of the planning 
items, add attachments, and 
collaborate on them with the 
stakeholders directly from the 
Prioritization page to facilitate 
smoother real-time backlog 
grooming.
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Feature Description Example UI

MoSCoW values Categorize planning items 
using the Must have, Could 
have, Should have, or Won't 
have (MoSCoW) values in 
the List and Hierarchy views. 
This categorization creates a 
baseline of priority that you 
can later use when you're 
grooming and prioritizing work 
for your portfolio.

Rank planning items
Decide on the order of priority 
for the planning items by 
using the drag functionality to 
rearrange them.

Prioritize items to roadmap Set the planning state of an 
item to Prioritized  to add them 
to the portfolio's roadmap.

Open the planning item in the 
Execution app If you're using ServiceNow 

PPM, Agile Development 
2.0, or SAFe  applications to 
execute the planned work, you 
can open the planning items 
in their own application.

For example, if your planning 
item is an epic, you can 
navigate to the epic form 
directly from the Prioritization 
page.

Personalize the Prioritization 
page views Change the way that the 

Prioritization page is displayed 
so that you can view the 
information in the format that 
you need.

All settings, such as row 
and column personalization, 
grouping, and sorting, are 
saved as the portfolio plan 
preferences. So, these 
settings are applied to all the 
users or user groups that the 
portfolio plan is shared with.
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Feature Description Example UI

Apply filters for Prioritization Apply filters to all the views 
of Prioritization, Roadmap, 
Hierarchy, or Scoring so that 
you can view a consistent 
data set for your portfolio plan.

Reorder the columns by 
dragging them horizontally

Reorder the position of the 
columns in the Prioritization 
tab by dragging them 
horizontally.

Add planning items to Prioritization

Add new planning items to your portfolio plan's work backlog in Strategic Planning  Workspace 
and ensure that the work pipeline is current.

Before you begin
Create a portfolio plan

Role required: sn_align_core.apw_user

About this task
Use the Prioritization tab of your portfolio plan to add new planning items or import them from 
other ServiceNow  execution system such as PPM, Agile Development 2.0, or SAFe.

You can use the Prioritization, Kanban, or the Hierarchy tabs while you perform this task.

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization tab, add a new planning item for your portfolio plan.

Use the More options drop-down to select the planning item that you want to create.

4. On the form, fill in the short description and approved dates.
For full information, see Planning item form.
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You can refine planning item descriptions—for item types such as Demand, Epic, Project, 
Capability, Feature, and Story—using the Write planning item skill, if the Now Assist for SPM 
application is installed.

5. Select Submit.

6. Optional:  If you're using PPM, Agile Development 2.0, or SAFe  to execute the planned work, 
you can also import your work items from these applications.
For more information, see Executing Strategic Planning work in PPM, Agile 2.0, and SAFe.

Result
The new item is created with its Planning state  field is set to New  and the position of the item is 
based on the view that you are in.

• Prioritization tab: Added to the bottom of the list.

• Kanban tab: Added to the 4-Low priority  horizontal lane.

• Hierarchy tab: Added to the appropriate grouping.

For example, your selected lens is Organization. Then, the new item is added to the grouping 
of its department.

What to do next

• Rank planning items.

• Update planning item details from Prioritization tab.

• Learn about Personalizing views for prioritization

Duplicate a planning item

Create a copy of an existing planning item to add it to your portfolio plan's work backlog in 
Strategic Planning  Workspace and ensure that the work pipeline is current. If the planning item 
you want to create is similar to an existing planning item, duplicating the existing planning item 
saves your time.

Before you begin
Create a portfolio plan

Role required: sn_align_core.apw_user

About this task
Use the Prioritization tab of your portfolio plan to add new planning items or import them from 
other ServiceNow  execution system such as PPM, Agile Development 2.0, or SAFe.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Planning page, select Prioritization  tab.

4. Select the More actions icon ( ) of the planning item that you want to copy and then select 
Duplicate.
The new planning item is created and the item appears right below the planning item you 
copied from. Also, the rank is updated for the new planning item automatically based on the 
rank of the planning item you copied from.
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By default, the name is Copy of ABC  where ABC is the name of the planning item you 
copied from.

5. Optional:  If you're using PPM, Agile Development 2.0, or SAFe  to execute the planned work, 
you can also import your work items from these applications.
For more information, see Executing Strategic Planning work in PPM, Agile 2.0, and SAFe.

What to do next

• Rank planning items.

• Update planning item details from Prioritization tab.

• Learn about Personalizing views for prioritization

Update planning item details from Prioritization tab

Update the details of your planning items or delete them so that your Strategic Planning 
Prioritization tab reflects the latest work pipeline.

Before you begin
Role required: sn_align_core.apw_user

About this task
Update the details of a planning item using the Prioritization, Kanban, and Hierarchy tabs in the 
Planning page. Edit the details inline from the grid view or use the side panel. You can edit details 
such as short description, MoSCoW, approved dates and others to facilitate smoother real-
time backlog grooming. Use the full details page of the planning item to add attachments and 
collaborate on them with the stakeholders.

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Update item details, attach files to the item, or delete the item.

Information of certain columns that aren’t editable in the full details page, can’t be edited inline 
too. For example, planned cost and planned benefit. These cells are visually differentiated 
using grey color as their background.

If you group the Prioritization items list by any attribute, you can’t edit the short description of 
the items directly from the grid view.

Rank planning items

Rank the planning items that are added to the pipeline of your portfolio plan to decide on their 
priority so that you can start prioritizing work for your portfolio.

Before you begin

• Create a portfolio plan.

• Ensure that the planning items in the Prioritization tab are sorted by the Rank column in 
ascending order.

Role required: sn_align_core.apw_user
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About this task

Important: 
Use the List view to stack-rank the planning items of your portfolio plan.

Within the ServiceNow  system, all the planning items are assigned a global rank. Reorder the 
items in the Prioritization tab to change their rank and update their planning state. If you decide 
to include a planning item into your roadmap schedule, mark its Planning State as Prioritized  to 
add it to the roadmap directly from the Prioritization tab.

The Rank column helps you quickly identify the rank of an item relative to the other items in the 
backlog. This information is useful to determine the top-ranked items from a long list of planning 
items. When there’s no custom grouping or sorting, the planning items are sorted by their rank, 
and you can reorder the rows.

Note: 
Reordering of rows is not allowed if the planning items are already grouped or sorted by any 
other attribute. Remove the grouping or sorting to reorder rows.

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization tab, rank the planning items according to your priority by rearranging 
their order.

Repeat this step until the ranking of the planning items align with your business priorities. To 
get better visibility of data that you need:

◦ Sort or group the list by the required columns. See Personalize the Prioritization view

◦ Filter the planning items by applying filters.

Tip: 

Using the Row context menu ( ), you can also assign the highest and lowest ranks to 
the planning items using the Move to top  and Move to bottom  options respectively.

What to do next
Prioritize work

Prioritize work

Review and prioritize the items of your portfolio plan pipeline to add them to the plan's roadmap 
so that your teams can start working on them.

Before you begin

• Create a portfolio plan.

• Ensure that the planning items in the Prioritization tab are sorted by the Rank column in 
ascending order.

Role required: sn_align_core.apw_user

About this task
Review and prioritize the items in the Prioritization, Kanban, or Hierarchy tab during your 
grooming sessions. You can use the MoSCoW values assigned to an item to help you decide the 
priority of work.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

515



Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization tab or any other tab, mark a planning item as In Review or Prioritized.

After you mark a planning item as Prioritized, it’s automatically added to your portfolio 
roadmap, based on the values in the Approved start date  and Approved end date  fields. Your 
roadmap shows only those items that have their Planning state set to Prioritized.

◦ If the dates fall within the portfolio planning period, then the item is displayed on the 
roadmap.

◦ If either of the date fields is empty, then the item is added to the Unscheduled items list of 
the roadmap.

If you've marked an item as Done  or Cancelled, that item isn’t displayed on the Prioritization 
page by default. You can update the filter on the Planning state column to show the items that 
are completed or canceled.

4. Optional:  From the Prioritization tab, you can update the planning state of multiple items at 
once.

a. Select the Planning state  cell of one of the rows that you want to update.

b. Press and hold the Ctrl  key (for Windows OS) or command  key (for Mac OS), and select the 
Planning state  cells of the other rows that you want to update.

c. Double-click one of the selected cells and choose a state.

(Optional)

Categorize work items using tags

Categorize your planning items based on your requirement by adding tags.

Before you begin
Create a portfolio plan

Role required: sn_align_core.apw_user
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About this task
Tags enable you to categorize planning items. You create the tag name, which should name the 
reason for the tag. You can make the tags visible to everyone, some people, or just yourself. The 
visibility setting specifies who can use the tags to search for planning items.

Any tagging additions or removals made to a planning item are automatically synced across all 
views in the Planning page and in the Scoring page. After tagging planning items, you can use 
the tags to search for planning items using the Filter  option ( ) in the List view of Prioritization 
and in the Scoring page.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization or Scoring, add a tag for a planning item using one of the following 
options.

Note: 
The tag visibility setting defaults to private, which means the tag is only visible to the user 
who created the tag. So, only the user who created the tag can use the tag to search for 
planning items labeled with that tag.

4. To change the visibility setting of the tag, on the Details page of the planning item, select the 
tag and change the Viewable by  setting.

Option Description

Me

Tag is visible only to the person who created 
the tag. Only the user who created the tag 
can use the tag to search for planning items la­
beled with that tag. This setting is the default.

Groups and Users
Tag is visible to specific groups or users. You 
can specify the groups and users who can 
view this tag.

Everyone Tag is visible to everyone.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

517



Option Description

Note: 
This visibility setting is only available to 
an admin or tags_admin role.

A planning item can have multiple tags and each can have a different visibility setting.

5. To remove a tag from a planning item, double-click the cell in the Tag column on the List view or 

select the filled tag icon ( ) on the Details page of the planning item to open the list of tags, 
then select the X  next to the tag you want to remove.

Personalizing views for prioritization

Personalize how the Prioritization, Kanban, and Hierarchy tabs on the Planning page are 
displayed so that you can view the planning item information that is most relevant to you and 
your stakeholders.

Personalize the Prioritization view

Personalize the List view in the Prioritization page by grouping, sorting, and hiding columns so 
that you can view the information that is most relevant for planning.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user

About this task
This task provides guidance on different options to personalize the view of Prioritization tab in 
the Planning page.

Personalization preferences are saved as the portfolio plan's settings in Strategic Planning. So, 
these settings are applied to all the users or user groups that the portfolio plan is shared with.
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Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Use the Personalize side panel to update the display of rows and columns on the page.

a. Select the Personalize icon ( ).

b. From the Columns section, select the columns that you want to see or hide the data of.

You can reorder the columns here to change their display order on the backlog.

If you want additional columns to be available in this page, your admin can configure them. 
See Configuring additional columns for Prioritization in Strategic Planning.

c. From the Rows section, choose how the rows are displayed, using the Shade alternate rows 
toggle.

4. Group your items by one or multiple columns that are on display in the Prioritization tab.

You can group the planning items by an attribute of the type choice or reference. Some 
examples to group by are Planning state, Planning item type, Owner, and Primary goal.

Use one of the following ways to group the planning items. Repeat the action to group the list 
by multiple attributes.
Grouping remains unaffected even when you switch to Kanban or Hierarchy tabs. The same 
setting is retained when you come back to the Prioritization tab. This preference is saved per 
session for a portfolio plan.

5. Sort the planning items by any column, by clicking the column name.
For example, you can sort the items by Approved start date.

6. Pin columns to the left or right of the list.

a. For the column that you want to pin, select the Column actions icon ( ).

b. From the Pin column section, select Pin to left  or Pin to right.
The default selection is Unpin.

7. Adjust the width of the columns as per choice or set the width to autofit.
Hold and drag the column border to adjust its width. You can set the column width to autofit 

using the Autofit this column  or Autofit all columns  options from the Column actions ( ).

8. Reset columns to default settings by selecting Reset columns  from the Personalize menu ( ).

Selecting this option reverts the column personalization, grouping, and sorting to default 
settings.

Personalization settings that you've made so far on the Prioritization tab would be cleared. Any 
personalization that you make after this point is set as the new preference for the portfolio.

9. Apply filters to the data shown in Prioritization.
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Personalize Kanban view

Personalize the Kanban tab view in your portfolio plan's Planning page as displayed in Strategic 
Planning, so you can view information that is most relevant to you and your stakeholders.

Before you begin
Create a portfolio plan.

Role required: sn_align_core.apw_user

About this task
This task Provides guidance on different options to personalize the view of the Kanban tab in the 
Planning page.

Kanban preferences are saved in the portfolio plan level. So, these settings are applied to all the 
users or user groups that the portfolio plan is shared with.

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Select Kanban tab.

4. Select the Personalize icon ( ) to update the view, based on your preferences.
See Customize the planning item display preferences for Prioritization and 

Roadmap.

Important: 
The default display limit of vertical lanes and horizontal lanes shown on a Kanban board 
is 30 and 30 respectively. These lanes support only reference and choice fields. As you 
user, you will not be able to change the field metrics on a Kanban card.

Personalize Hierarchy view

Personalize the Hierarchy tab view in the Planning page of Strategic Planning  Workspace so that 
you can view the information that is most relevant to you and your stakeholders.

Before you begin
Create a portfolio plan.
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Role required: sn_align_core.apw_user

About this task
Sort the planning items by an attribute of your choice and use the Personalize side panel to 
customize the display of the columns.

Personalization preferences are saved as the portfolio plan's settings in Strategic Planning. So, 
these settings are applied to all the users or user groups that the portfolio plan is shared with.

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Personalize the timeline view and the columns on the grid view using the Personalize side 
panel.

a. Select the Personalize icon ( ).

The personalize side panel opens.

b. From the Timeline section, toggle the display of item names and dependency lines.
You can also choose to update the layout. Select Grid and timeline view, Grid view, or just the 
Timeline view.

c. From the Columns section, update the planning item fields that are displayed in the grid 
view.
Select the necessary columns and click Apply.

4. Sort the planning items by any column, by clicking the column name.
For example, you can sort the items by Approved start date.

5. Apply filters to the data shown in Prioritization.

Export data of portfolio plan items from Prioritization to Excel or CSV

Export the data of portfolio plan items from your portfolio plan into a Microsoft  Excel or CSV file. 
You can share this data and collaborate with your business stakeholders.

Before you begin
Role required: sn_align_core.apw_user
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Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. On the Planning page, select Prioritization  tab.

4. Verify that the columns you want to export are personalized.

Note: 
If the filters are applied on the view, the filtered data is exported.

5. Use the personalized side panel to export the data of your portfolio plan items.

a. Select Export icon ( ).

b. From the File type  drop-down on the Export window, select Excel  or CSV  to export the data 
to a Microsoft  Excel or CSV file respectively.
A file with the selected format is exported. By default, the name of the file is 
ABC_Prioritization_List  where ABC is the name of the portfolio plan you exported 
the data from.

Planning roadmaps in Strategic Planning Workspace

Create a layout of the plans for upcoming projects or initiatives while aligning them with your 
business objectives using roadmaps in Strategic Planning Workspace. Facilitate collaboration 
among stakeholders and adjust plans on the go.

Roadmaps in Strategic Planning  Workspace are of two types: Portfolio plan roadmaps and free-
form roadmaps.

For portfolio plans, only those planning items that are prioritized from the Prioritization tab are 
shown on the roadmap. For more information, see managing backlog items  and prioritizing those 
items  for the roadmap.

You can create roadmaps for a specific period, which could be the period that your organization 
focuses on meeting its goals. From a centralized view, you can do the following using the 
Roadmap capabilities in the Strategic Planning Workspace:

• Build simple roadmaps using a single type of planning item or hybrid roadmaps using multiple 
types of planning item at once.

• Visualize how your work aligns to the strategic priorities or goals of your business.

• Create and use direct and indirect dependencies between work items to understand how 
cross-organizational work aligns with the enterprise strategy.

• Use conversations and share files to enable collaboration among stakeholders.

• Focus on strategic outcomes using milestones for all the work items.

• Decide on necessary corrective actions ahead of time by tracking the progress and status of 
the work.

Related topics

Roadmaps in Strategic Planning

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

522



Create a free-form roadmap

Create a standalone visual roadmap to start high-level planning of work from different units of the 
company.

Before you begin
Role required: sn_align_core.apw_user

About this task
Create a standalone roadmap to plan work across multiple units of your organization, such as 
projects of all departments. To learn more about free-form roadmaps, see Roadmaps in Strategic 
Planning.

Select a source table as a starting point to base your roadmap on. Select one of project, epic, 
program, demand, SAFe epic, and SAFe feature tables for a simple roadmap or Planning Item 
table for a hybrid roadmap.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select New.
If this is the first free-form roadmap in your ServiceNow®  instance, select Create your first 
free-form roadmap.

3. Use the Create free-form roadmap wizard to fill out the details of your roadmap.

a. Select a source table to base your roadmap on.

Your admin can configure other tables to be visible in this list. For more information, see 
Portfolio plan configuration form.

b. Add conditions to filter the data from the source table.

For example, if your source table is Project, the related filter condition can be Business Unit 
is Finance AND Active is true.

c. Enter details of the name and planned dates for the roadmap.

Note: 
The start and end dates for your roadmap act as a date range filter for all the items 
displayed in the roadmap.

4. Select Create.

Result

• A new roadmap is created and displayed.

• This roadmap is listed in the Free-form roadmaps  tab of the Home page of Strategic Planning 
Workspace.

What to do next

• Update, personalize, and collaborate with your roadmap.

• Add milestones or create dependencies for the items planned on your roadmap.
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Related topics

Update details of a free-form roadmap

Create planning items from the roadmap view

Plan unscheduled items into a roadmap

Add dependencies for roadmap items

Collaborate on a free-form roadmap with stakeholders

Share a free-form roadmap with stakeholders

Update details of a free-form roadmap

Update the details of a free-form roadmap to reflect the changes in priorities or the timeline of 
the roadmap.

Before you begin
Create a free-form roadmap.

Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap to open it.

3. From the roadmap header, select the More actions icon ( ).

4. Use the Update free-form roadmap wizard to edit out the details of your roadmap.
For field information, see Create a free-form roadmap.

5. Select Update.

Result
The roadmap is updated and the roadmap items are displayed according to the latest changes.

Related topics

Create planning items from the roadmap view

Plan unscheduled items into a roadmap

Add dependencies for roadmap items

Collaborate on a free-form roadmap with stakeholders

Share a free-form roadmap with stakeholders

Share a free-form roadmap with stakeholders

Add people from your organization who are the stakeholders for the work involved in your 
roadmap plan so that they have visibility into the roadmap's progress.

Before you begin

• Create a free-form roadmap.

• Ensure that the users that you add as stakeholders have the appropriate role to access the 
roadmap. For more details on user roles, see Components installed with Strategic Planning 
Workspace.
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Role required: sn_align_core.apw_user

About this task
Grant access for the free-form roadmap to other users and stakeholders in your organization.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap to open it.

3. From the roadmap header, select the Share roadmap  icon ( ).

4. On the Share roadmap form, select users to share the roadmap with and set their access 
appropriately.

a. In the Members or Groups  field, enter the names of individual users or groups.

b. From the Access  field, select the access level as Viewer  or Editor  for the users selected.

For a business stakeholder user, even if you grant the Editor access, they can only add 
comments on the roadmap.

5. Select Send invite.

What to do next
Change the access level or remove access for a user or a group.

1. On the Share roadmap form, select Manage access.

2. From the user or group card, select the action menu icon ( ).

3. Select the right access level or select Remove.

Collaborate on a free-form roadmap with stakeholders

Add comments and attachments to a free-form roadmap for other users of your organization can 
review and share their feedback. Collaborate and ensure that your roadmap aligns with your 
company's priorities.

Before you begin
Role required: sn_align_core.apw_user or sn_roadmap_plng.roadmap_editor

About this task
Using the Comments side panel, add attachments or notes at the roadmap-level or the planning 
item-level.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap to collaborate on.

3. Select the appropriate tab at the roadmap-level or planning item-level.

4. Add attachments or worknotes.
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Managing free-form roadmap views

Portfolio managers can create customized views for their free-form roadmap by applying 
personalization settings such as grouping, milestones selection, dependencies selection, and 
tracking mode. Portfolio owners or editors can share these personalized views with stakeholders 
to enable easier collaboration on the free-form roadmaps.

Benefits of free-form roadmap views

Portfolio managers can create personalized views as needed by applying settings such as 
grouping, milestones selection, dependencies selection, and tracking mode.

• Views can be created as private or public.

• Can create up to three private views and up to 10 shared (public) views.

• Free-form roadmap views can be shared with stakeholders to enable collaboration on the free-
form roadmap.

• Switch between shared and private views as needed.

Create a free-form roadmap view

Create a customized free-form roadmap view based on your requirements, so you can access it 
when you log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
You can create up to three private views and up to 10 shared (public) views per free-form 
roadmap.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a free-form roadmap to open it.

3. Make any changes to the view as needed.
For example, enable Tracking mode  toggle.

The Save as new view  option appears on the free-form roadmap header.
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4. From the free-form roadmap header, select Save as new view.

5. On the Save as new view window, fill the details.

a. Enter a name for the view in the View name  field.

b. Optional:  Select the Shared view  toggle to make this view public.
Selecting the Shared view  toggle makes the view visible to all stakeholders with whom this 
free-form roadmap is shared.

c. Select Save.

Result
The shared view for the free-form roadmap is created and will be visible to all stakeholders with 
whom this free-form roadmap is shared.

What to do next

• Share the free-form roadmap with your stakeholders to start collaborating on the free-form 
roadmap. See Share a free-form roadmap with stakeholders.

• Edit a free-form roadmap view to make any changes to the existing view. See Edit a free-form 
roadmap view.

Edit a free-form roadmap view

Edit a customized free-form roadmap view based on your requirements, so you can access it 
when you log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task

• Only the owner of a free-form roadmap view can edit a shared (public) view.

• You can have up to three private views and up to ten shared (public) views per free-form 
roadmap.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a free-form roadmap to open it.

3. From the free-form roadmap header, select the view you want to edit or override with your 
personalization settings from the list of available free-form roadmap views.
The selected view appears.

4. Make changes to the view as needed.
For example, enable Tracking mode  toggle.

After you make any change to the view, the Save view option appears in the free-form roadmap 
header.

5. Select Save view.
The view is updated to reflect the changes made.
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6. Optional:  To edit name of the view, select the Free-form roadmap drop-down from the free-

form roadmap header and then select Edit view icon ( ) next to the view you want to edit the 
name for.
On the Edit view window, fill the details.

a. Update the name for the view in the View name  field as required.

Note: 
Only the owner of the free-form roadmap view can rename the view.

b. Optional:  Select the Shared view  toggle to make this view public or disable the Shared 
view  toggle to make the view private.

Important: 
Changing a shared view to a private view removes access for existing stakeholders.

c. Select Save.

What to do next
Share the free-form roadmap with your stakeholders to start collaborating on the free-form 
roadmap. See Share a free-form roadmap with stakeholders.

Related topics

Create a free-form roadmap view

Delete a free-form roadmap view

Delete a free-form roadmap view

Delete a customized free-form roadmap view if it is no longer needed or if the maximum limit of 
ten shared or three private views has been reached.

Before you begin
Role required: sn_align_core.ap_read_only
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About this task

• Only the owner of the free-form roadmap view or an editor of the free-form roadmap can delete 
the view.

• Deleting a free-form roadmap deletes the view, including any changes made to the view. 
However, this action keeps the items (projects, demands, epics) intact in the free-form 
roadmap.

• You can have up to three private views and up to ten shared (public) views per free-form 
roadmap.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a free-form roadmap to open it.

3. Select the Free-form roadmap view drop-down from the free-form roadmap header and then 

select Delete view icon ( ) next to the view you want to delete.
The Delete this view window appears.

4. On the Delete this view window, select Delete.

Related topics

Create a free-form roadmap view

Edit a free-form roadmap view

Duplicate a free-form roadmap

Create a roadmap with the data of an existing roadmap. If the roadmap you want to create is 
similar to an existing roadmap, duplicating the existing roadmap saves your time.

Before you begin
Role required: sn_align_core.apw_user

About this task
Create a standalone roadmap to plan work across multiple units of your organization, such as 
projects of all departments. To learn more about free-form roadmaps, see Roadmaps in Strategic 
Planning.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  > Free-form 
Roadmaps

2. Select a roadmap that you want to create a copy from.

3. From the roadmap header, select the More actions icon ( ) and then select Duplicate 
roadmap.

4. On the Duplicate roadmap window, fill the details.

a. Enter a name for the roadmap in the Roadmap name  field.
By default, the name is ABC (Copy)  where ABC is the name of the roadmap you copied 
from.

b. Optional:  Select Share with same users and groups  option to grant access to the users of 
the roadmap you copied from.
The action grants same read and edit access as is the users had for the roadmap you copied 
from.

c. Select Confirm.

Result

• A new roadmap is created and a link is generated on the screen to access the new roadmap.

• This roadmap is listed in the Free-form roadmaps  tab of the Home page of Strategic Planning 
Workspace.

What to do next

• Update, personalize, and collaborate with your roadmap.

• Add milestones or create dependencies for the items planned on your roadmap.

Create planning items from the roadmap view

Create and add new planning items to your portfolio roadmap or free-form roadmap directly from 
the roadmap view.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, select the New <item type>  option.

◦ For a free-form roadmap, the option depends on the roadmap's source table.

◦ For a portfolio plan roadmap, the option depends on the portfolio plan configuration.
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One planning item type Multiple planning item types

For a free-form roadmap, if the source table is Planning Item [sn_align_core_planning_item] 
table, then the options depend on the values configured for the 
freeform_planning_items_creation_list  property. By default, project and 
demand are available. Work with your admin to configure these options. See Enable custom 
item types in Strategic Planning.

3. On the form, fill in the required field information.
For full field information, see Planning item form.

You can refine planning item descriptions—for item types such as Demand, Epic, Project, 
Capability, Feature, and Story—using the Write planning item skill, if the Now Assist for SPM 
application is installed.

4. Select Submit.

Result
The new item appears on the roadmap, at a place based on its approved start and end dates.

If you don’t fill both the approved start and end date fields, the item that you created would be 
moved to the list of unscheduled items. You can add them to your roadmap plan later. For more 
information, see Plan unscheduled items into a roadmap.

Modify planning items from the roadmap view

Update the details of planning items or delete them from a portfolio plan or free-form roadmap so 
that your roadmap reflects the latest plans.

Before you begin
Role required: sn_align_core.apw_user

About this task
Edit the details of planning items from a side panel view, or the full details view in the roadmap.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item that you want to update or delete.

The side panel opens with the Details tab.
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Further, you can click Full details  and open the item's record page. On the full details page, 
you can also view related lists such as Milestones, Dependencies, and others. For field 
information, see Planning item form.

You can refine planning item descriptions—for item types such as Demand, Epic, Project, 
Capability, Feature, and Story—using the Write planning item skill, if the Now Assist for SPM 
application is installed.

Note: 
If your free-form roadmap was built on one of the PPM tables, such as project 
[pm_project] or demand [dmn_demand], you can only make updates from the full details 
page.

3. Update the details or delete the item.

◦ To update, edit the field details and click Update.

If you're on the full details page, click Save.

◦ To delete, do the following:

a. On the full details page, click the More Actions icon ( ) and select Delete.

b. Click OK  to confirm.

Related topics

Add milestones for roadmap items

Add dependencies for roadmap items

Plan unscheduled items into a roadmap

Add items without start or end dates yet to your portfolio plan or free-form roadmap.

Before you begin
Role required: sn_align_core.apw_user

About this task
Planning items that meet the criteria of your portfolio plan or free-form roadmap, but don’t have 
either the start or end dates are categorized as unscheduled items. As you progress in your 
planning, use the unscheduled items list to schedule these items into your roadmap timeline.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the sidebar, select Unscheduled items ( ).
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3. From the list of unscheduled items in the side panel, drag and drop a planning item at a place 
of your choice on the roadmap.

Related topics

Reschedule roadmap items

Reschedule roadmap items

Update the planned dates of your roadmap items to account for any changes in your scheduling 
priorities.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. To change the dates planned for a roadmap item, resize the roadmap item bar.

Note: 

◦ When the start date of a demand is changed along the roadmap, the start date of the 
demand record in the Demand [dmn_demand] table and the timeline of the associated 
cost plan are automatically updated to match the new date.

◦ When the dates of a project are changed along the roadmap, the changes are updated 
in the project record in the Project [pm_project] table.
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3. To reschedule the roadmap item, drag and drop the item to a timeline area of your choice.

Related topics

Add milestones for a roadmap

Add milestones for roadmap items

Add milestones for a roadmap

Track key dates of your plan's timeline by creating milestones and displaying them on the 
roadmap.

Before you begin
Role required: sn_align_core.apw_user

About this task
For the timeline of your portfolio plan or free-form roadmap, create milestones such as launch 
dates, deadlines, or other key events directly from the roadmap view.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the More actions drop-down, select New milestone.

3. On the form, fill in the fields.

For field information, see Roadmap milestone form.
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4. Select Submit.

5. Optional:  Repeat steps 2 through 4 to add more milestones to your roadmap.

Result
Milestones that you created are visible on the roadmap.

Here is an image of a sample roadmap with the milestone bar showing different milestones for 
the planning 

period.

The color of the milestone, shown on the legend, indicates the status of the milestone.

• Red: Missed milestone.

• Green: Achieved milestone.

• Grey: Upcoming milestone.

If multiple milestones are scheduled close to each other, they might appear grouped in the 
milestone bar. In this case, you can expand and collapse the milestone bar to view all the 
milestones of that period.

Related topics

Customizing milestones display on roadmap in Strategic Planning Workspace

Update a roadmap milestone

Update or delete the milestones that you added to your portfolio plan or free-form roadmap so 
that they reflect any change of plans.
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Before you begin
Add milestones for a roadmap.

Role required: sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. To reschedule a milestone, you can drag and drop it at a timeline area of your choice.

If you want to update other details or delete the milestone, proceed with the following steps.

3. From the roadmap view, click the milestone that you want to update.
The side panel opens showing the milestone details.

4. Update or delete the milestone.

◦ To update, edit the field details and click Save.

For information on the form fields, see Roadmap configuration form.

◦ To delete the milestone, click Delete.

Select OK  to confirm.

Related topics

Customizing milestones display on roadmap in Strategic Planning Workspace

Add milestones for roadmap items

Track key outcomes of your planning items (such as demands, epics, or programs) by creating 
milestones for them, directly from the roadmap view.

Before you begin
Role required: sn_align_core.apw_user

About this task
Select a roadmap item and create a milestone for it. Use the roadmap side panel to fill in the 
details and submit.

For free-form roadmaps, milestones are supported only if the source table is Planning Item 
[sn_align_core_planning_item] or one of its extensions.
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Important: 

You can’t add a project milestone from the roadmap view. Creating or updating project 
milestones may impact the associated project plans. So, it’s recommended to create or 
update project milestones using Project Workspace in Project Portfolio Management  (PPM).

However, any existing milestones of the project are visible on the roadmap if you've 
integrated Strategic Planning  with PPM.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item to which you want to add the milestone.
The side panel opens showing the item details.

3. Select the Milestones tab.
Alternatively, you can click Full details  and select the Milestones tab from the full details page.

4. Select the Add milestone icon ( ).
If the item doesn't have any milestones, select New milestone.

5. On the form, fill in the fields.

For field information, see Planning item milestone form.

6. Select Save.
When you go back to the Milestones tab, you can see the milestone listed there.

7. Optional:  Repeat steps 2 through 6 to add more milestones to your items.

Result

• Milestones that you created are indicated on the roadmap item bars.

Here’s an image of a sample roadmap with the roadmap items indicating that they have 

milestones.
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• Pointing your cursor over these milestone indicators shows the details such as the milestone 
name, type, and due date.

• Clicking one of these indicators opens the Milestones tab of the Item details side panel. Here, 
you can see a list of all the milestones for this planning item.

What to do next

• Learn how to customize the display of milestones on the roadmap.

• Learn when a planning item milestone can be in an error state.

• Learn how to manage the milestones for planning items.

Update roadmap item milestones

Update or delete the milestones that you added to your planning items (such as demands, epics, 
or programs) so that they reflect any change of plans.

Before you begin
Role required: sn_align_core.apw_user

About this task
From the portfolio roadmap or free-form roadmap, select a planning milestone to update its 
details. Use the roadmap side panel to edit the details and submit.

For free-form roadmaps, milestones are supported only if the source table is Planning Item 
[sn_align_core_planning_item] or one of its extensions.

Important: 

You can’t add a project milestone from the roadmap view. Creating or updating project 
milestones may impact the associated project plans. So, it’s recommended to create or 
update project milestones using Project Workspace in Project Portfolio Management  (PPM).

However, any existing milestones of the project are visible on the roadmap if you've 
integrated Strategic Planning  with PPM.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item and select the Milestones tab.

The side panel shows the list of all the milestones associated with this planning item.

Alternatively, you can click Full details  and open the item's record page and then select the 
Milestones tab.

3. Click the milestone that you want to update.

4. From the milestone form, update the details or delete the milestone.

◦ To update, edit the field details and click Save.

For information on the form fields, see Planning item milestone form.

◦ To delete the milestone, click Delete.

Select OK  to confirm.
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Related topics

Customizing milestones display on roadmap in Strategic Planning Workspace

Add dependencies for roadmap items

Create dependencies and visualize relationships between planning items of your portfolio or 
free-form roadmap, so that you can adjust their scheduling.

Before you begin
Role required: sn_align_core.apw_user

About this task
From the portfolio roadmap or the free-form roadmap, use the item details side panel to create 
dependencies between two planning items. Dependencies are supported for projects, epics, 
demands, initiatives, programs, or any custom planning item types that you may have created.

The dependency for a planning item on your roadmap can be on an item from the same 
roadmap, a different roadmap, or the item might not be planned yet. Learn more about 
dependencies in the roadmap.

Note: 
Dependencies for free-form roadmaps are available only if the roadmap's source table is 
Planning Item [sn_align_core_planning_item] or one of its extensions.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item for which you want to add the dependency.
The side panel opens showing the item details.

3. Select More  > Dependencies.

4. From the Dependencies tab, select the Add dependency icon ( ).

5. On the form, fill in the fields.

For form field information, see Dependency form.

6. Select Save.
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Result
The dependency is created between the selected planning items 
and is listed in the Dependencies tab of the Item details side 

panel.

On the roadmap, you can see the dependency details from the roadmap item card or the 
dependency lines. Learn about display settings available for dependencies on the roadmap.

If one of the dependency items is not on the roadmap, then the dependency details are shown 
on the roadmap item card, with a redirect link to the external planning item. In this case, the items 
could belong to the same roadmap or not.

What to do next

• Learn how to resolve roadmap item dependency errors.

• Update the dependency details or delete it. See Update roadmap item dependencies.

Update roadmap item dependencies

Update or delete the dependencies for the planning items on your roadmap so that they reflect 
any change of plans.

Before you begin
Role required: sn_align_core.apw_user
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About this task
Use the roadmap side panel to change the details of a dependency or delete it.

Dependencies for free-form roadmaps are available only if the roadmap's source table is 
Planning Item [sn_align_core_planning_item] or one of its extensions.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. From the roadmap view, click a planning item whose dependencies you want to update or 
delete.

The side panel opens showing the item details.

3. Select More  > Dependencies.
Dependencies for this planning item are listed in the form of cards.

4. From the side panel, locate your dependency and use the More actions icon ( ) to edit or 
delete.

Personalize roadmap Timeline view

Customize the way that your roadmap is displayed in the Timeline view. Group the roadmap 
items, color them by a category, add numerical data points, and display milestones and 
dependencies to analyze your roadmap efficiently and take informed decisions.

Before you begin
Role required: sn_align_core.apw_user

About this task
This task provides guidance on different options to personalize the Timeline view of your 
roadmap. Choose the options that you want to apply.

Any settings that you apply here are saved as preferences per roadmap. All users who can 
access the roadmap would see the same settings.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. Modify the scale of the timeline of your roadmap.
Select the time scale icon ( ) and choose Month, Quarter, or Year.

Note: 
The timescale view that you choose is saved in the roadmap preferences.

3. Use the side panel to personalize how your roadmap looks like.

a. From the side bar, select the Personalize icon ( ).

b. Group and color your roadmap items by the available attributes.
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You can group the roadmap items by up to two attributes and color-code them by one 
attribute.

You can work with your admin to add other attributes for the Group by, Color by, and Metrics 
fields. See Customize the planning item display preferences for Prioritization and Roadmap.

Important: 
Don't group your roadmap items by the name attribute because the application 
renames the roadmap item when you move the item bar from one group to another.

c. Enable visibility of owners of the roadmap items by using the Owner  toggle.

d. Display data points such as planned cost on the roadmap item bars by adding fields in the 
Metrics  section.

You can add up to three metrics.

e. If your roadmap items (such as projects, epics, or demands) have milestones, adjust how 
they’re displayed using the toggles in the Milestones section.
For more information, see Customizing milestones display on roadmap in Strategic Planning 
Workspace.

f. If your roadmap items have dependencies, adjust how they’re displayed using the toggles in 
the Dependencies section.
For more information, see Customizing the dependencies display on the roadmap in 
Strategic Planning Workspace.

g. Identify the current date on your timeline using the current date indicator.
Enable the Current date line  toggle from the Other settings section.

4. Quickly enable or disable the display of dependency lines between the roadmap items using 

the Display dependency lines icon ( ).

5. Zoom in, zoom out, and reset the zoom of your roadmap view by using the zoom options.

Note: 
The zoom level that you choose isn’t saved as the roadmap preferences.

6. Apply filters to the data shown on the roadmap.
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Personalize roadmap Kanban view

Customize the way that your roadmap Kanban is displayed. Modify the lane values to change the 
way your cards are sorted, or customize the card metrics to view only the fields you want to see 
on the cards.

Before you begin
Role required: sn_align_core.apw_user

Procedure

1. Navigate to All  > Strategic Planning  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. Select Kanban tab.

4. Select the Personalize icon ( ) to update the view, based on your preferences.
See Customize the planning item display preferences for Prioritization and 

Roadmap.

Important: 
The default display limit of vertical lanes and horizontal lanes shown on a Kanban board 
is 30 and 30 respectively. These lanes support only reference and choice fields. As you 
user, you will not be able to change the field metrics on a Kanban card.

Track the progress of roadmap items

Visually track the completion of a work item on your portfolio plan roadmap or free-form roadmap 
using the tracking mode.

Before you begin
Role required: sn_align_core.apw_user

About this task
Use a toggle to switch your roadmap view from planning mode to tracking mode. The roadmap 
item cards turn into progress bars to indicate the status and progress.

Note: 
While in Tracking mode, you cannot create, update, or reschedule roadmap items and 
milestones. This view is a read-only mode.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning  and open your 
roadmap.

2. Select the Tracking mode option to turn on the tracking view of the roadmap.

3. Optional:  Personalize the roadmap view in tracking mode.

Note: 
The group by and color by personalization that you've done in the planning mode of your 
roadmap gets carried over to the tracking mode but the metrics are not carried over.

a. Enable or disable the visibility of the roadmap item status and percentage complete using 
the Status  and % Complete  toggles respectively.

b. Display data points such as planned cost on the roadmap item bars by adding fields in the 
Metrics  section.
You can add up to two metrics in tracking mode.

c. Personalize the display of milestones.
You can choose to display the milestone with just its icon or along with its label.

Milestone indicator with label Milestone indicator

Result
The tracking view of your roadmap is displayed according to your personalization settings. A 
sample view of roadmap tracking is shown in the following image.
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Optimizing planning with scenario planning in Strategic Planning Workspace

As a portfolio manager, optimize your portfolio planning by comparing potential outcomes, 
assessing their alignment with strategic goals, and approving the best scenario as your live plan.

Scenario planning items in the Prioritization tab

The Prioritization  tab of the Scenario page enables you to add and remove planning items 
to/from a scenario and adjust their dates.

Scenario planning items in the Roadmap tab

The Roadmap  tab displays a Gantt chart-like view of the planning items in the scenario, showing 
their planned start and end dates across the portfolio plan timeline. Using the Roadmap tab, you 
can drag the bars representing planning items across the timeline to adjust their dates.

Scenario planning items in Financials tab

The Financials  tab of the Scenario page enables you to set custom targets, budget, and 
compare the allocated budget against target using the outcomes panel.
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Portfolio Manager can simulate multiple scenarios with different budget combinations and 
compare their outcomes to arrive at an informed decision to balance the resources and strategic 
objectives. Using the financials view in Scenario planning, you can get a simulation mode for the 
financial information. Using this view, the strategic planning users such as Portfolio managers, 
Program managers, or Portfolio user working on the portfolios, can set a portfolio budget target 
for a particular planning cycle, which could be a monthly, quarterly, yearly, or beyond a year up 
to 5 years. Using this defined budget, portfolio users can prioritize the planning items within the 
portfolio to analyze if the prioritized items can be executed within their portfolio budget, while 
reviewing the monetary benefit from the prioritized items.

Important: 
Enable the budget allocation property  to allocate budget to your planning items at portfolio-
level and configure the budget attributes  to allocate budget by expense type or cost type.

Create multiple scenarios to compare them, and work with your stakeholders to approve an ideal 
plan with better monetary benefit returns. Once approved, the approved Scenario will become 
your new portfolio plan for the defined planning cycle. For more information to know about the 
changes happening in a portfolio after scenario approval, see Approve a scenario.

You can perform financial scenario planning throughout your planning or execution cycle 
depending on your organization needs such as at your regular planning cycles, quarterly 
reviews, or financial review cycles. Financials in scenario planning helps you to arrive at an 
informed decision and customize the portfolio planning to match with your organization needs.

Note: 

• Finanicals in scenario planning is supported only for Epics, Projects, and Demands type 
of planning items.

• Customers using the Legacy Investment Funding should migrate to new experience to 
work on the financial scenario planning.

Personalize your scenario planning financials view using the Time scale and Range filters. 
Manage the budget of your planning items by monthly, quarterly, or yearly cadence depending 
on the planning cycle of your organization.

Outcomes panel in Scenario planning

The outcomes panel in the simulation indicates the financial information of the portfolio such as 
target and budget amounts for Capex and Opex, set budget target for this simulation, utilized and 
remaining budget from the target, benefit from the In-plan items, and the actual costs accounting 
from the out of plan items. The aggregated data is fetched based on the portfolio timeline range 
including the target and budget data.
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Representations in outcomes panel for the identification.

Outcomes panel representation

Indication Definition

Red text for amount without progress bar 
indication for Total Simulated Budget

No defined or set target amount for this 
scenario.

Red text for amount and red progress bar for 
Total Simulated Budget

Total allocated budget for planning items 
exceeds the scenario's set target amount.

Red text amount for Capex Budget Capex Budget allocations exceed the 
scenario's Capex target.

Red text amount for Opex Budget Opex Budget allocations exceed the 
scenario's Opex target.

Green text for budget amounts and green 
progress bar

Budget allocation for each expense types and 
total budget is within the scenario's set target.

Scenario planning features

In scenario planning, you can perform the following actions:

Feature Description

Create a scenario Create a scenario from the current plan, or 
another scenario, in a simulated environment 
to compare the scenario with the live plan and 
other scenarios.

Compare scenarios Compare scenarios and the live plan side by 
side to review tradeoffs and items added or 
removed from the plans.

Approve a scenario Approve the best scenario.

Manage scenarios View list of scenarios, rename scenarios, and 
delete scenarios.

Scenario planning use cases

The following are high-level use cases for scenario planning.

• Fiscal year planning: Megan Burke, Portfolio Manager at ACME Inc, is planning for the next 
fiscal year and is required to prioritize planning items and align them with the organizational 
strategic goals. Megan creates a scenario for the portfolio plan and then uses the Prioritization 
tab to align items with goals. Megan holds discussions with program managers and with the 
financial team, creates multiple scenarios, and compares them. Megan approves the optimal 
scenario as a well-aligned strategic portfolio plan for the next fiscal year.

• Mid-cycle reprioritization; Changed priorities emerging mid-year require adjustments to the 
current portfolio plan. John Doe, the product manager at ACME Inc, creates a scenario and 
incorporates the changed priorities. John adjusts the plan based on the program manager's 
and financial team's feedback and finalizes the plan.
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Create a scenario

Create a scenario from a live plan or another scenario in a simulated environment to compare the 
scenario with the live plan and other scenarios.

Before you begin
Role required:

• sn_align_core.apw_user

• sn_align_ws.spw_financial_user - to view and edit financial details.

About this task
Creating a scenario enables you to visualize and anticipate potential outcomes. You can create 
a scenario based on the live plan or on another existing scenario. Once you have created one 
or more scenarios, you can compare them side by side with the live plan and approve the most 
desirable scenario. The scenario you approve becomes the live plan.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the list of portfolio plans, select one and then select Planning.

3. Select Create scenario.

Note: 
Before you have created your first scenario, you see the Scenario planning  button on the 
Scenario page. In such a case, select Scenario planning  and then you see the Create 
scenario  button.

a. Enter a name for your scenario in the Scenario name  field.

b. Optional:  In the Description  field, enter the details of your scenario.

c. In the Copy From  field, select the Current Plan  or the name of an existing scenario based on 
which you want to create the scenario.

d. Select Create.
The Scenario planning- [Scenario Name] page appears with the Prioritization tab open. The 
Prioritization tab lists all the planning items that you have in the live plan, or in the existing 
scenario that you copied the scenario from. The planning item start and end dates are 
determined based on the dates specified in the live plan or the actual execution dates.

◦ In Plan  toggle: By default, the In Plan  toggle is switched on for planning items that have 
the planning state as Prioritized or Done and have their start dates within the portfolio plan 
timeline. The In Plan  toggle is turned off for items that have the status New, In Review, or 
Canceled.

◦ Yellow highlights for out of range dates: The planning item dates that are out of range of the 
portfolio plan timeline are highlighted with a yellow background. For such items, the In Plan 
toggle is turned off.

4. Use the Prioritization tab to include or exclude additional planning items in the scenario.
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a. Optional:  To exclude a planning item from the scenario, turn off the In Plan  toggle.

b. Optional:  To include a planning item in the scenario, edit the start and end dates of the item 
to fall within the portfolio plan timeline, and then turn on the In Plan  toggle.

If you include out-of-timeline items in a scenario, these items remain in the scenario during 
the planning and prioritization process. When the scenario is approved, the dates of these 
items are updated to align with the scenario dates. However, because these updated dates fall 
outside the original portfolio plan timeline, the items are moved out of the live portfolio plan.

5. Use the Roadmap  tab to view planning item dependencies and adjust planning item dates:

a. Drag the start or end of the planning item bars to change their start or end dates.

b. Drag the planning item bars to shift them in the plan timeline.

c. View the dependencies and milestones of the various planning items.

6. Use the Financials  tab view the prioritize, invest, and execute the right items to provide best 
returns on investments for your organization.
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a. Set target for your portfolio budget.

i. Select the Set Targets  ( ) button.

ii. In the Set Targets window, set budget for an expense type or a cost type using the inline 
edit feature.

Tip: 
You can change the Time scale  and Range  to set targets for each fiscal period at 
monthly, quarterly, or yearly cadence to meet your organization's planning cycle. The 
target set for a higher timescale, it is equally split it between the fiscal periods.

Once the target is set for a scenario, the Target  row displays the defined target amount by 
fiscal period and budget allocation choices.

b. Include or exclude planning items in scenario using the In-plan  toggle.

c. Add or reduce budget for individual planning items using the inline editing feature.

Changes made to the budget using while creating a scenario are marked with  icon.

What to do next

• Create more scenarios, if necessary.

• Compare scenarios. You can directly compare scenarios from simulation mode by selecting 
Compare scenarios  from the Scenario actions list.

• Approve a scenario

Compare scenarios

Compare scenarios side by side to confirm alignment with primary goals, evaluate 
comprehensive planning, optimize resource usage, confirm feasibility, and financial information.

Before you begin
Verify that you have created one or more planning scenarios and selected planning items for 
execution. For more information, see Create a scenario.

Role required:

• sn_align_core.apw_user

• sn_align_ws.spw_financial_user - to view the financial widgets and details.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Create scenario menu, select Compare scenarios.
The Compare scenarios page appears.

4. Select Add Scenario To Compare  and select or deselect scenarios to be included in the 
comparison.
You can add up to five scenarios to the comparison.

5. Select Compare.
You can also view the Compare Scenario page by selecting Compare Scenarios  from the 
Scenario Actions menu in the Scenario page. The Compare Scenario page appears with the 
scenario open in the Scenario page included in the comparison with the current plan.
The selected scenarios appear side by side on the Compare Scenario page.

6. Compare different aspects of the scenarios such as Budget vs Target, Benefit, Budget 
distribution, trade offs, and alignment with primary goals.
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Visual cues in scenario comparison

Criteria Description

Planning items with no primary goal The planning items with no primary goals are 
indicated in red font.

Removed from this plan Items that are removed from the plan when 
the scenario is approved, are marked with a 
red X.
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Criteria Description

Added to this plan Items that are added to the plan, when the 
scenario is approved, are marked with a 
green checkmark.

The following are some indications of the suitability of a scenario for approval:

◦ All planning items align with primary goals, with no items unassociated, providing a focused 
strategy that supports the organization's objectives effectively.

◦ The trade-off section includes relevant items, demonstrating comprehensive and inclusive 
planning that addresses various aspects of the project or initiative.

◦ The scenario is realistic and achievable, considering current constraints and capabilities, 
confirming that planned actions can be executed within the given timeframe and budget.

◦ Better benefit from financial planning using the widgets, Budget vs Target to validate the 
allocated budget against the set targets, Benefit to identify scenario with better monetary 
benefit, and Budget Distribution to see the amount of budget allocated to the top four goals.

7. Optional:  Select the Approve Scenario  button relevant to a scenario to approve it.
For more information about approving existing scenarios in the Strategic Planning Workspace, 
see Approve a scenario.

What to do next
Approve a scenario

Approve a scenario

Approve a scenario that aligns with your organizational goals and offers the best business 
outcomes to make the scenario your current plan.

Before you begin
Ensure that you have compared the scenarios and selected the one you want to approve. For 
more information, see Compare scenarios.

Role required:

• sn_align_ws.scenario_approver

• sn_align_ws.spw_funding_user - to view and approve the financial changes.

About this task
When you approve a scenario:

• Planning items with the In Plan state are updated to the Prioritized state.

• Planning items that you moved out of the plan are changed to the In Review state.

• The approved dates are revised accordingly.

• Changes made to the budget of a planning item is will be approved as the budget.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Create scenario menu, select Compare scenarios.

The Approve scenario  button is also available on the Scenario page. As soon as you have 
created a scenario, you can directly approve a scenario without comparing it with the other 
scenarios.
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4. Select the Approve scenario  button relevant to the scenario that you want to approve.

While approving a scenario, you can:

◦ Convert the priotitized demands to projects to automatically build a portfolio plan by 
selecting the Convert In-plan Demands to Projects  toggle.

◦ Delete the remaining scenarios by selecting the Delete other scenarios  toggle.

◦ Enter a reason for approving the scenario in the Notes field.

5. Select Approve.

Manage scenarios

Use the Manage scenarios  option to view a list of all scenarios, rename scenarios, or delete 
scenarios.

Before you begin
Role required:sn_align_core.apw_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the list of portfolio plans, select one and then select Planning.

3. Navigate to Create Scenario  > Manage Scenarios..
You can also select Manage Scenarios  in the Recent Scenarios menu in the Scenario page.
The Manage scenarios dialog appears with the list of scenarios relevant to the current plan.

4. Do any of the following actions.

Planning user capacity in Strategic Planning Workspace

Assess the resource capacity and review existing allocations, which help you to make informed 
decisions while working on assigning resources in Strategic Planning.

Use the manage resource capacity  screen to generate resource capacity details.
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Use the Capacity screen  to view detailed information about the resource capacity mapping to a 
portfolio.

Manage resource capacity

Manage resource capacity screen

Using Manage resource capacity, select a time frame and primary attributes to view number of 
available resources. Generated resource capacity details are saved. You can regenerate capacity 
to view latest changes in the resource availability.

Resource capacity screen helps you to view the following data.

• Resource availability for generated capacity.

• Total number of available resources in a monthly breakdown view.

• Latest date of generating the capacity details.

• Option to regenerate and fetch the latest capacity details from the employee profile mappings.

On the Manage resource capacity screen, you can:

• Filter resources with specific capacity attributes for a required date range to view the number 
of available resources.

• Regenerate capacity details to view the latest details from the resource employee profile 
mapping.

Select resource criteria

• Select a primary attribute to automatically view the available groups, roles, or skills from the 
resource assignments of the prioritized planning items.

• Switch between Auto-select  and Manual-select  option to view the allocated resource efforts 
for all planning items or to view a custom data, respectively.

• Define resource criteria to view the available groups, roles, or skills from the resource 
assignments of the prioritized planning items.
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Capacity

Capacity screen displays the resource efforts from the prioritized planning items.

• Comprehensive overview of resource capacity and allocations.

• Current resource capacity allocation.

• Interactive Gantt chat to view prioritized planning items in the bottom tray to analyze and plan 
work.

Understanding the Capacity screen.
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Capacity legend

Color Description

Yellow (Gantt bar) Planning item with no resource assignments.

Blue (Gantt bar) Resource estimates for Planning items are 
within the resource capacity.

Red (Cells and Gantt bar) Overallocation in resource estimates.

Green (Cells) Resource estimates within the resource 
capacity.

Using Capacity, you can:

• View the capacity allocations of prioritized planning items for your current portfolio and better 
forecast your future resource requirements.

• Use the filter option ( ) to view planning items by their type, state, priority or any by any 
required attributes to create capacity plans.

Note: 
Default filter is set to display prioritized planning items only.

• View the updated resource capacity based on the assigned operational resource assignments.

• View the total resource capacity in the heatmap view.

• View total resource capacity and total estimates.

• View the efforts for operational work and efforts for estimates outside of portfolio in the 
Additional items  list.

• Redefine the workforce criteria by selecting Resource criteria  ( )

Example: Calculation of Operational Resource Assignment in Capacity
As a Resource Manager, you can create operation resource assignments  or migrate existing 
operational resource plans  of your employees to handle the required meetings, trainings, time off 
and so on to meet your work requirements.

Consider a group with capacity of 2 FTE and resource manager creates a Group type operation 
resource assignment for 10% of the capacity for training. This operational assignment can be 
viewed in the Operational work  line item in the top-tray of the Capacity screen. The value of the 
Operational work  line item will be 0.2, which is 10% of total capacity of the group.

When a resource manager creates a Group type operation resource assignment for time off, this 
doesn't update the Operational work  line item but reduces the total available capacity.
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Consider the same group for which resource manager creates an operation resource assignment 
for 25% of the capacity for time off, for a quarter from April to June. The total available capacity 
of the group for the quarter April to June will be 1.5 FTE, which is 75% of the total capacity after 
reducing the 25% time off.

0.5 FTE, which is 25% of total capacity of the group will be reduced.

Note: 
The Operational work  line item is highlighted in gray color.

Generate resource capacity

Generate and view the total capacity of the resources with primary attributes. Capacity details 
helps Portfolio Managers to plan and manage planning items depending on the resource 
availability.

Before you begin

1. Enable planning attributes for capacity planning. For more information, see Enable planning 
attributes for capacity planning.

2. Generate employee profiles for resources. For more information, see Generate employee 
profiles for resources to work with Capacity.

Role required: sn_align_ws.spw_capacity_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select the Resource capacity  option ( ).

Note: 
If planning attributes aren’t enabled for capacity planning, you see an empty state screen 
with an option to configure. Contact your admin to enable planning attributes for capacity 
planning. For more information, see enable planning attributes for capacity planning.

3. Use one the following options to view and regenerate the capacity details.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

558



What to do next
Use Capacity Planning  to view the resource capacity, resource-to-work mapping and re-prioritize 
resource allocations to effective execute your prioritized planning items.

Using Capacity in Strategic Planning Workspace

View and analyze the resource capacity for your portfolio to plan and re-forecast the resource 
assignments.

Before you begin
Generate resource capacity using manage resource capacity.

Role required: sn_align_ws.spw_capacity_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Select a plan from Portfolio Plans.

3. Select Planning  > Capacity.

4. Define a resource criteria by selecting a primary attribute from the list.
If you select Group, all the available groups from the resource assignments of the prioritized 
planning items are automatically displayed in the Auto-select option. You can add or remove 
the suggestions to view the resource capacity using the Manual-select option.

Tip: 
You can always redefine and change the resource criteria to view custom results using 
the Resource criteria  ( ) button.
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5. Select Submit.

Result
The Capacity screen for resource capacity allocation for the selected workforce criteria is 
displayed. Based on the workforce criteria selection, the resource capacity is nested by Group, 
Skill, and Role.

Managing financials for planning items in Strategic Planning Workspace

Manage budget, cost plans as forecasts, actual expenses as expense lines, generate labor 
costs, create financial baselines, and view, analyze, and compare the financial performance of 
your planning items at required cadence in Strategic Planning  Workspace.

The comprehensive financials view helps you to understand planned and actual costs, Forecast 
(previously EAC - Estimate At Completion), Remaining Estimates (previously ETC - Estimate 
To Completion), Actual (previously Actuals to date), and so on, for the selected item. You can 
manage cost plans and associate the expense lines and process them to reflect the actuals for a 
planning item.

Export the financials data from Costs and benefits or Baseline comparison view as Microsoft 
Excel or a CSV file and share it with your stakeholders to review the financial performance of your 
planning items and portfolio.

Cost view

Forecast your planned costs, create, and manage cost plans and expense lines to track the 
financial performance of your planning items, review the latest costs and actuals.
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In the Cost screen, you can:

• As a Project Manager, you have the enhanced visibility and ability to manage the financial data 
across multiple project levels. Cost view of financials shows cost plans and expense lines from 
sub-projects, allowing you to track the finances.

• The parent project widgets display the consolidated values of forecasted costs and expenses.

• Identify and manage costs using the Project/Demand  column for any sub-project or demand 
directly from Cost view of the parent planning item.

• Reforecast all the cost plan values for future fiscal periods by double-clicking to edit the value 
in the least time scale view, either by month or by period.

• Manage cost plans for your planning items. For more information, see Add, edit, or delete cost 
plans.

• Add or edit expense lines for your planning items to record any planned or unplanned 
expenses. For more information, see Add or edit expense lines.

• Generate labor costs based on the resource assignments. For more information, see Generate 
labor costs.

• Create and compare baselines to capture the financial snapshot of your planning items. For 
more information, see Create and compare financial baselines for your planning items.

• Configure widgets  to get a high-level overview of the financial data for your planning item.

• All financial details from sub-projects will be aggregated and displayed in the parent project's 
cost plans and widgets.

Tip: 
Cost view gives you enhanced user experience to customize the left pane columns 

by using the personalize icon ( ) and by saving user preferences to retain the 
customizations made to hide, view, or adjust columns, time scope viewing, and so on.
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Multicurrency

The multicurrency feature enables you to manage the financials of your planning items in 
two different currencies, Functional currency and Investment currency. Functional currency 
is typically defined by the admin based as the primary currency that is used for planning, 
budgeting, and tracking the financials of your planning items.

Financial users can now perform the following financial activities in Investment currency.

• Ability to select the Investment currency.

• Track the planned and actual expenses.

• Allocate and manage the budget.

• View simple financials data.

Important: 
New customers should install the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin to enable multicurrency feature and Activate 
scheduled job to populate to multicurrency fields.

Using this feature, you can work on financial reporting at a global level and see the real-time 
currency conversions of your financial records.

Organizations operation at a global or multinational level, the work is planned and financed at 
one location and executed at a different location. Each might use a different currency from what 
was used in the planning phase, multicurrency makes it easy to manage and track your planning 
items using any currency.

You can monitor and track the financials in one currency, and capture the costs in a different 
currency.

Using multicurrency, you can see all the costs in the currency you choose for the planning item, 
instead of restricting to use Functional currency defined in your locale. For more information 
on how to choose investment currency of your planning items, see Configure multicurrency for 
planning items.

Financial records and widgets will display the costs based on the currency selection.

Note: 
Once a cost plan, benefit plan or expense line or an investment budget gets created, you 
won’t be able to change investment currency. You can change the investment currency as 
long as there are no financial records captured against the planning item.

Display modes

On the financials page for a planning item in Strategic Planning Workspace, you have Display 
Mode drop-down switch between different modes to view different formats of financial 
information of your planning items. These views provide the relevant and focused information 
that helps project managers and funding users to work on the financial planning.

• Forecast

• Budget vs forecast

• Planned vs actual

• Planned

Users with financial funding role [sn_align_ws.spw.funding_user] will see the Budget allocation 
option instead of the Budget vs forecast.
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Display modes value

Mode Value

Forecast View Actuals, Remaining estimates, and 
Forecast for the entire scope of the planning 
items.

Use the time scale to view the actuals for the 
past fiscal periods and planned costs for the 
current and future fiscal periods.

Budget vs forecast View the Budget, Actuals, and Variance for 
the fiscal periods and Forecast values for the 
entire scope of the planning items.

Using this mode, you can:

• Compare the latest forecasts with the 
approved budget at different time scales.

• View the budget vs actual for past fiscal 
periods and budget vs planned for current 
and future fiscal periods at fiscal period 
level.

Budget allocation (funding role) View the Budget, Actuals, and Variance for 
the fiscal periods and Forecast values for the 
entire scope of the planning items.

Using this mode, funding users can:

• View the latest forecast and enter the 
budget that can they be approved to the 
work item.

• Analyze the variance for the past fiscal 
periods and work on budget allocation for 
future fiscal periods.

• Compare latest forecast with approved 
budget and revise the budget, if necessary.

Planned vs actual Compare the planned costs with actual 
expense for the past and current fiscal 
periods, and view planned costs for the future 
fiscal periods.

Planned View only planned costs for the full range and 
manage the planned costs using the inline 
editing feature.

Note: 

• If you don’t see the Budget allocation or Budget vs forecast display options, enable the 
budget allocation property  and configure the budget attribute  at instance level.

• To work on budget allocation using the Next Experience, Activate a scheduled job to 
migrate budget of your planning items.

The last selected view is saved as user preferences.
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Default display mode and access level for financial users

User role Default mode Role-level access

sn_align_ws.spw_funding_user Budget Allocation Allocate and approve budget, 
manage cost plans and 
expenses lines.

sn_align_ws.spw_financial_userForecast Manage cost plans and 
expense lines.

business_stakeholder Forecast View financial data.

Baseline view

Create a financial to capture a snapshot of the financial changes for your planning items. You can 
create on-demand baselines manually or automatically at a required cadence using a scheduler 
job. For more information, see Create a baseline

Note: 
Baselines created on the parent project include cost plans and expense lines from all of the 
child projects to calculate and give you a better breakdown of the financial performance of 
the projects and sub-projects.

Compare baselines  to compare the difference in costs between latest status against a baseline 
or between any two baselines.

Note: 
Each baseline is tagged with a number based on the order that they’re created. The Current 
Financials baseline captures the financials details in real-time and is always represented 

with a flag icon ( ).

Financial baselines now capture the investment currency for customers using multicurrency.

A planning item baseline includes the following financial metrics in investment currency.

• Investment currency

• Total planned cost

• Planned benefit

• Planned return

• Budget cost

At the investment baseline level, a corresponding investment baseline is automatically created. 
This baseline captures:

• Planned cost

• Actual cost

• Planned benefit

• Actual benefit

• Total budget

• Capex, Opex, and breakdown of these fields, and so on

All values are populated along with their respective investment currency.
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Cost plan baselines now store actual cost values in investment currency, along with the 
investment currency field. Benefit plan baselines capture benefit values in the investment 
currency, along with the associated currency. At the breakdown level (for example, fiscal period 
or monthly breakdowns), actual cost and actual benefit values are populated in investment 
currency where actuals exist.

Note: 
Comparison of financial baselines using multicurrency is not yet supported.

You can view the planning item and investment baseline using the list view. 
Access the pm_project_baseline  list to view project baselines, and 
sn_invst_pln_invst_investment_baseline  to view the investment baselines.

The baselines comparison view helps you to understand the variances between the two 
baselines.

Use the widgets when you compare baselines to view:

• Two dedicated widgets for each baseline displaying the EAC.

• The third widget displays the total variance between the EAC values of the selected baselines.

• The fourth widget displays the top three variances contributing to the overall variance by cost 
type.

The widgets and the header rows are color-coded to help you identify the selected baselines.

Tip: 
Switch between different baselines from the comparison view by selecting the name of a 
baseline from one of the widgets.

When you compare baselines, you get the list of cost plans with their associated costs types, 
EAC at full scope, and a breakdown view of actual expenses and planned costs.

By default, the time scale of the breakdown view is set to Month.

• Use the Time scale  option to view the comparison breakdown view at monthly, quarter, and 
yearly levels.

• Select Time scope  to filter fiscal periods, data in the widgets, and the comparison table.

The widgets and the header rows are color-coded to help you identify the selected baselines.
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Tip: 
Select the name of a baseline from the first or second widget to compare different 
baselines.

Let's take an example of the comparison view of two baselines: 2023-10-01, Baseline A, and 
Current Financials, Baseline B.

Example: How actuals, planned, and EAC are compared between two baselines 
captured at different timestamps

For a selected baseline, based on the creation date, the table shows Actuals values for the past 
fiscal periods from the created date and Planned values for the current and future fiscal periods.

Consider a planning item scoped from July 2023 to June 2024. Baseline A is created on 
2023-10-01. If you compare the Current Financials baseline in December 2023 to the baseline 
captured in October 2023:

1. The baseline comparison view show Actuals vs Actuals columns from July 2023 to September 
2023.

2. Planned vs Actuals for October 2023 and November 2023.

3. Planned vs Planned from December 2023 to June 2024.
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Note: 
The columns are defined to calculate EAC, which is the sum of Actual costs until the last 
fiscal period and Planned costs from current to future fiscal periods.

Budget allocation

Portfolio managers can manage and approve the budget for planning items. The approved 
budget helps project managers to plan and meet the expenses to execute work.

Plan and approve the budget for a shorter planning cycle at monthly, quarterly, or yearly level 
using the lean budgeting and funding feasibility. Lean budgeting helps Portfolio managers to 
track the value in return for the approved budget and to better plan the budget for future fiscal 
periods.

Note: 
If the budget is allocated monthly, the total budget is rolled up to quarterly and yearly 
level. Similarly, if the budget is allocated at a quarterly or yearly level, the equal breakdown 
happens until monthly level.

For more information on how to allocate, approve, and handle budget for planning items, see, 
Manage budget of your planning items in Strategic Planning.

Tip: 
In the budget allocation view, Portfolio managers review the EAC to understand the 
financial projections made by Project managers and use the Copy cost as budget  option to 
allocate the entire planned cost as budget.

Choose the cost type as the attribute to allocate and approve the budget for individual cost 
types such as labor, non-labor.

Project managers can view the approved budget at the required time scale using the Budget vs 
forecast option from the display modes. As the work progresses and the actuals are captured, 
you can compare the budget and actual costs using the Budget vs forecast mode and reforecast 
the planned costs where the actuals are exceeding the budget using the inline edit feature at the 
required time scale.

Product managers can compare the latest cost with the approved budget by Capex or Opex, cost 
types, and for the required time scale at monthly, quarterly, or yearly level. The comparison view 
provides insights to Product managers to locate any variance at expense type or cost type, and 
at which fiscal period. Product manager can leverage this information to request for additional 
budget from the Portfolio manager.

You can migrate the budget of existing active projects and demands items from the Classic UI to 
Next Experience. Financials in the Next Experience  has new budget data model that facilitates to 
store the budget at a detailed level by monthly breakdowns and cost types. You can migrate the 
budget for active projects and demands individually or by bulk using the scheduled job.

• Migrate budget of active projects from Classic UI to Next Experience. For more information, see 
Migrate budget of active projects to Next Experience.

• Migrate budget of active demands from Classic UI to Next Experience. For more information, 
see Migrate budget of active demands to Next Experience.

Note: 
The migrated budget is captured in the sn_invst_pln_invst_budget  table to enable 
the lean budgeting for required time scope.

Budget distribution logic
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The budget allocation approach introduces data‑aware  budget distribution, prioritizing 
actuals for completed periods and planned costs for future periods. The system uses different 
distribution strategies depending on whether actuals or Estimate at Completion (EAC) values are 
available, and whether the fiscal period falls in the past, present, or future.

Budget allocation logic is divided into three focus areas: past fiscal periods, current fiscal 
periods, and future fiscal periods.

1. Past fiscal periods that have already ended.

◦ If actuals exist, the budget is distributed proportionally to actual spending. If the total budget 
amount equals the total actuals, the distribution exactly matches the actual values.

◦ If there are no actuals, the budget is distributed evenly across the past fiscal periods.

2. The current fiscal year is like a mid‑year  scenario where both past and future fiscal periods are 
available.

◦ For past or completed fiscal periods, the system distributes the budget proportionally 
matching the actual expenses. If there are no actual expenses, budget is allocated as zero 
(0).

◦ If planned costs exists for the current and future fiscal periods the remaining budget is 
distributed proportionally based on the planned costs.

◦ If planned costs doesn't exists for the current and future fiscal periods, budget is distributed 
evenly across the fiscal periods.

3. Future fiscal periods

◦ If planned costs exists, the remaining budget is distributed proportionally based on planned 
costs.

◦ If planned costs doesn't exists, the remaining budget is distributed evenly across the 
remaining fiscal periods.

Budget distribution based on financial records

Fiscal periods Available financial data Distribution method

Past fiscal Actual expenses Proportional to actuals

Past fiscal No financial records No budget allocation

Current year – past fiscals Actual expenses Allocate budget proportionate 
to actual values

Current year – remaining 
months

Planned costs exists Allocate budget proportionate 
to planned costs

Current year – remaining 
months

No planned costs Even distribution

Future fiscal periods Planned costs exists Allocate budget proportionate 
to planned costs

Future fiscal periods No financial records Even distribution

Benefit plans

Monetary benefit plans capture potential benefits accrued while executing a planning item. Non-
monetary benefit plans capture the potential non-financial benefits accrued while executing a 
planning item. You can create and manage monetary benefit plans  and non-monetary benefit 
plans  to capture the potential benefits of your planning items.
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Instead of switching to and fro from the financials record page to benefit plan tabs, you now have 
a seamless experience to manage all the cost plans and benefit plans from the Cost and benefits 
view and can leverage the new financials experience with the side panel and grids for quick 
forecasting and tracking of monetary benefit plans.

Simple financials

Simple financials gives you the ability to enter the preliminary high-level planned capex, opex, 
benefit, and so on from the Details page without capturing the costs plans from the Cost view. 
You can update the simple financials values as required until you have the planned and actual 
costs captured.

Using the baseline feature, you can capture these simple financial values in a baseline and 
compare them against any existing baseline. You can:

• Reforecast simple financials and compare the by selecting the Current Financials from the list 
of baselines.

• Capture the planned and actual expenses as the project progresses and compare any 
financial baseline with a simple financials baseline to track the financial performance of the 
planning item.

Configure multicurrency for planning items

Select investment currency as an additional currency, which can be different from your functional 
currency, to manage financial records of your planning items.

Before you begin

• You can define investment currency for planning items which do not have any financials 
records, such as cost plans, expense lines, benefit plans, and actual benefits. To define a 
investment currency for existing work, you should delete all the financial records and configure 
the investment currency.

• Enable monetary benefit plans for planning items

• Role required: admin

About this task
Following are the current limitations for multicurrency.
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• Multicurrency for cost plans that are bundled with project tasks. This feature is scheduled to be 
available starting with the January patch update.

• Financial baselines do not capture investment currency fields. This feature will be available 
with the March store release.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.
In the Currency  field, the current system currency is displayed. For example, if your Functional 
currency is in USD, the field is displayed as USD (Functional).

4. Select Confirm  to save the investment currency selection.

Add, edit, or delete cost plans

Create a cost plan for a required duration to track your planned and actual expenses. Edit cost 
plans to adjust your planned expenses and delete any de-scoped forecasts.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.

Tip: 
Create a financial baseline  immediately after capturing the initial planned costs to have 
a snapshot of your planned costs. Use this baseline to compare it against the baselines 
from later dates, as the work progresses, to identify the variance between initial planned 
costs and actual expenses.

This helps you to plan for the future expenses and re-forecast the planned costs.

Generate labor costs

Generate labor costs in the Financials view for attribute-based resource assignments based on 
the financial attributes configured in the planning attributes page.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.

4. Select Generate labor costs  ( ).
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5. Select Generate  on the Generate labor costs confirmation window.

Note: 
Alternatively, you can activate a scheduled job  to automatically create baselines at the 
required cadence.

Manage budget of your planning items in Strategic Planning

Allocate, manage, and approve budget for your planning items. Lean budgeting enables you to 
allocate budget for short planning cycles for different fiscal periods such as monthly, quarterly, or 
yearly breakdown level rather than allocating the budget to the complete duration of the planning 
item.

Before you begin

• As an Admin, enable the property to work on budgeting. For more information, see Enable 
financial budget allocation for planning items in Strategic Planning.

• As an Admin, configure the attribute to allocate and approve budget by cost type or expense 
type. For more information, see Configure budget attribute at instance-level to allocate budget.

• Role required: it_portfolio_manager

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.

4. Enable the Budget allocation  toggle ( ).

5. You can manage the budget by one of the following ways for the selected time scale at 
monthly, quarterly, or yearly level.

◦ Double-click each cell in the Budget column to manually enter the value.

◦ Select Copy cost as budget  from the Budget column options to copy the EAC as budget.
You can always reforecast the budget for each cost type using the in-grid editing feature even 
if the EAC is copied as budget.

Note: 

Unapproved budget values are indicated with  icon.

6. Select Approve budget  ( ).
Approve budget confirmation window is displayed. The Create a financial baseline for this 
budget approval  option is enabled by default which captures the latest budget and financial 
estimates.

Tip: 
The financial baseline created while approving the budget can be compared with the 
future baselines once the actual expenses are captured to track financial performance.

7. On the confirmation window, select Approve  ( ).
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Result
Budget widget is updated to reflect the latest approved budget. Project Manager can view the 
approved budget and compare it with the planned costs using the budget vs cost  view by cost 
type.

Add or edit expense lines

Create or edit expense lines to capture the actuals costs. You can associate the expense lines 
with a cost plan or create standalone expense lines to record unplanned expenses.

Before you begin
Role required: sn_align_ws.spw_financial_user

About this task
An expense line is part of the project cost plans that can be associated with a specific source. 
You can create multiple expense lines for a cost plan. Only the expense lines that are in the 
processed state are considered for roll ups on the work item.
For unplanned expense lines which are not associated to any cost plan, system automatically 
creates an cost plan or associates to an existing system generated cost plan of the same 
expense type.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.

4. Use one of the following options to add an expense line.

5. On the Create expense line form, fill the fields.
For a description of the field names, see Create expense line form.

6. Select Save.

Note: 
The expense lines created for sub projects can be viewed in the Cost screen of the 
parent project.

7. To edit a cost plan from the finanicals record page, select the actuals value from the cost plan 
to ex[open the Expense line side panel.

8. Select the expense you want to edit.

9. Update the expense values as needed and select Save.

Create and compare financial baselines for your planning items

Create and compare financial baselines to get a snapshot of the project expenses and compare 
the planned costs against the actual expenses.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.
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4. Create or compare baselines.

Tip: 
You can migrate existing financials baselines of your projects or demands from Classic UI 
to Financials in Next Experience.

For more information on how to migrate financial baselines of demands, see Migrate financial 
baselines of demands to Next Experience.

For more information on how to migrate financial baselines of projects, see Migrate financial 
baselines of projects to Next Experience.

Create monetary benefit plans for your planning items in Strategic Planning

Create and manage monetary benefit plans to capture the potential benefits while executing 
your planning items.

Before you begin

• Enable monetary benefit plans for planning items

• Add monetary and non-monetary benefit plans related lists

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select a portfolio plan.

3. From the Prioritization or Roadmap tab, select the planning item to create a monetary benefit 
plan.
The full details page of the planning item is displayed.

4. Create a monetary benefit plan using one of the following options.

5. On the Benefit Plan form, fill the fields.
For a description of the field names, see Benefit Plan form.

6. Select Save.

Result
The newly created monetary benefit plan appears in the finanicals record page and in the 
monetary benefit plans related list.

What to do next

• Edit monetary benefit plans.

• Capture actual monetary benefits.

Edit monetary benefit plan

Edit a planned monetary benefit plan to revise the benefits, dates, offset, and so on, to maintain 
the updated financial records as your work progresses.

Before you begin

• Create monetary benefit plans for your planning items in Strategic Planning

• Role required: sn_align_ws.spw_financial_user
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select a portfolio plan.

3. From the Prioritization or Roadmap tab, select the planning item for which you want to edit a 
monetary benefit plan.
The full details page of the planning item is displayed.

4. Update a monetary benefit plan using one of the following options.

Capture actual monetary benefits

Capture the actual benefit from the planned benefits to measure revenue and calculate the 
profits.

Before you begin

• Create monetary benefit plans for your planning items in Strategic Planning

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select a portfolio plan.

3. From the Prioritization or Roadmap tab, select the planning item for which you want to capture 
actual monetary benefits.
The full details page of the planning item is displayed.

4. Capture actual monetary benefits using one of the options.

5. Optional:  You can change the previously captured planned benefit from the Entered benefit 
field.

6. Enter the actuals benefits resulted from the work execution in the Actual benefit  field and 
select Save.

Manage non-monetary benefit plans for your planning items in Strategic Planning

Create and manage monetary benefit plans to capture the potential benefits while executing 
your planning items.

Before you begin

• Enable monetary benefit plans for planning items

• Add monetary and non-monetary benefit plans related lists

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Non-monetary Benefit Plans  related list.
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4. On the Benefit Plan form, fill the fields.
For a description of the field names, see Non-monetary benefit plans form.

5. Select Save.

Export financials as Excel or CSV file

Export the costs or baseline comparison data of your planning items to easily share them with 
your stakeholders.

Before you begin
Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Financials  tab.

4. Select the Export option ( ).

5. In the Export side panel, select Excel  or CSV  from the File type list and select the Export 

button ( ).

The financials data is download as an Excel or CSV file with name_fin_mmddyy  naming 
convention. The breakdown of the naming convention:

a. name - fetches the first 10 characters from the name of the planning item.

b. fin - denotes that the file has financial data.

c. mmddyy - system date format when you're exporting this data.
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For example, if you're downloading financials data for a planning item named Documentation 
on January 26, 2024, then the file name reads documentat_fin_012624.

Note: 
You can export financials data from Cost view and Baselines comparison view.

Managing portfolio financials in Strategic Planning Workspace

View the financial breakdown of estimates, approved costs, benefits, and actuals and so on for 
portfolio financials.

As a portfolio user, you can view the rolled up financial values of top-level demands, projects, 
and epics.

You can view the costs by expense type or cost type. Using the Financials view at portfolio level, 
you can view different financial fields such as Budget (approved budget for planning items), 
Forecast, Variance (difference between the approved budget and latest forecast), Actuals, 
and the Remaining Estimates for Capex, Opex, Total, and Benefits for each planning item. This 
information can be used to track the financials status of the planning items and take an informed 
decision on which planning items to consider while working on the next planning cycle and track 
the to avoid overspending.

Using the portfolio financials, portfolio managers can:

• Track the financial performance and status of planning items.

• Arrive at an informed decision by analyzing the estimated cost and benefits of a planning item 
while planning and prioritizing for the next Portfolio cycle.

• View the financials based on the expense type or cost type depending on the budget attribute 
configuration.

• Avoid overspending on planning items by comparing the approved budget with the latest 
forecast and actuals.

Important: 
New and existing customers need to configure the portfolio financials to view the financials 
of your planning items at portfolio level. For more information, see Configure portfolio 
financials in Strategic Planning.

The portfolio financials view supports Demands, Epics, and Projects with Fiscal Calendar 
type configuration only.
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Portfolio financials grouped by Budget status with expense type as the budget 
attribute

Portfolio financials grouped by Planning status with cost type as the budget 
attribute

Note: 
Group header row displays the rolled up values for Budget, Forecast, Variance, Actuals, and 
Remaining estimate of all the planning items in the group.

The default view of portfolio financials is set to display the planning items grouped by their 
budget approval status. Budget approved grouping lists the planning items which have the 
budget allocated and approved. Approval pending grouping lists the planning items which do 
not have any budget or if the requested budget is not approved.

Note: 
Portfolio financials view is not yet compatible with Investment Funding. This view may 
not show the right budget values allocated to planning items from Investment Funding 
application. This will be add as a future enhancement.

In the left-grid, planning item details such as name, rank, planning state, planning item type, 
approved start date, total planned cost, total actual costs, total planned benefits and ROI for the 
full planning item duration.
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In the right-grid, financial attributes of the planning items such as, Budget, Forecast, Variance, 
Actuals, and Remaining Estimates for Capex, Opex, Total, and Benefits portfolio for the portfolio 
timeline or breakdowns by year, quarter, month, or period.

Tip: 
You can select the name of a planning item from the left-grid to directly access the 
financials record page of that planning item.

You can export the portfolio financials details to Excel or CSV using the Export  option ( ).

Customize your financials view

Customize the portfolio financials to view and access the required parameters helping you in 
better planning your portfolio and planning items.

• You can get a more detailed and granular view of the financials at monthly, quarterly, and yearly 
view by defining Timescale and Range. Use time scale to select a fiscal period and filter the 
range within the time scale to view the financials for any specific months, quarters, or years.

Time scale and range parameters

Time scale Description and range

Fiscal Month Portfolio financials view by monthly 
breakdown.

You can select up to 12 months.

Fiscal Quarter Portfolio financials view by quarterly 
breakdown.

You can select up to 4 quarters.

Fiscal Year Portfolio financials view by yearly breakdown.

You can select up to 5 years period.
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Time scale Description and range

Plan Timeline Portfolio financial breakdown for the entire 
portfolio timeline.

• Personalize grouping and columns in the grids.

Configure the columns and groupings in the right-grid using Personalize option ( ) to build a 
custom view.

For example, if you want to compare budget and actuals breakdowns, select only these two 
options and apply your preferences. You can also customize the left-grid by selecting the 
required columns from the Left Grid  list from the personalize settings.

• Group the planning items.

By default, the financials view is grouped by the Budget status column. You can remove Budget 
status grouping from the Grouped by row and drag-drop the required header to change this 
view.

Docs for planning items in Strategic Planning

Store and manage all kinds of documentation for planning items from a centralized location of 
Strategic Planning Workspace.

Docs overview

Product and portfolio managers can store information for planning items using the Docs feature.

• Each planning item can have a separate doc page to capture the information related to it.

For example, for an Epic planning item, you create a doc page for high level business 
objectives or technical product requirements.
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• Each planning item can have multiple doc pages associated to it to help you effectively 
organize key artifacts.

• Predefined templates such as Project Brief, Product Requirements, Brainstorming Ideas, and 
Meeting notes are available. Create doc pages for your planning items using one of these 
templates or start with a blank page.

Features of Docs

The following are the key features of Docs:

• Auto-save content.

• See who is viewing or working on a doc page using the feature of live user presence.

• Create documents using pre-defined templates.

• Use rich text paragraph formatting, which includes headings, lists, alignment, and others.

• Move text blocks to change their placement using block-level editing.

• Tag team members inline or insert tables using the /  command.

• Add reference to other ServiceNow AI Platform  tables to connect work across teams.

• Insert images by uploading files or using web URLs.

Note: 
The experience of inserting Google  Images links might not work.

Summarize Docs content using Now Assist for SPM

Use Now Assist  capabilities to elaborate, shorten, and summarize selected content in Docs, or to 
get a summary of the whole document.

• Summarize, elaborate, or shorten selected text.
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• Summarize the entire content on the page.

Note: 

• Now Assist for Docs requires an SPM Pro + license. For more information, see Configure 
Now Assist Admin features.

• If there is more content to summarize, you can remove some content and retry.

• Because the information in these fields is AI generated, it's a good idea to review the text 
and make sure it's accurate.

Real-time collaboration within planning item Docs

With the feature of real-time collaboration, edit a doc page concurrently with multiple other 
editors. Colored cursors denote the current location of each editor on the page. You can choose 
to show or hide these live presence indicators based on your preference while working on or 
reviewing the content of the page.
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Note: 
Huge number of users editing the same block of content simultaneously might result in 
issues with application performance.

Dynamic data linking in Docs

Keep record information in your documentation always current and reduce manual effort with the 
Dynamic data linking feature in Docs. You can now reference any ServiceNow  application record 
and Docs will automatically reflect the latest updates from those records.

For example, if you add a reference to a Project record, the reference shows the latest field 
information of the project in Docs without requiring manual edits. Selecting the project reference 
opens up the project form so that you can view the full details of the project and make any 
necessary changes.

A hover popover displays the details of the mentioned record, providing quick access to 
additional information without leaving the current context.
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Dynamic linking also enables adding references to a particular field of a record, such as 
Assigned to of a Project record.

You can add references from any ServiceNow  table you have access to, with no setup or 
configuration needed.

This feature reduces the need to switch between multiple ServiceNow  applications within your 
instance and helps maintain a single, reliable source of truth for collaborative work, making it 
easier for teams to stay aligned and informed.

Create and manage pages and subpages for planning items

Flexibly organize information for your planning items by creating, duplicating, and deleting pages 
and subpages in Strategic Planning Workspace.

Before you begin
Role required: sn_align_core.apw_user
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one and then select Planning.

3. From the Prioritization or Roadmap page, select a planning item that you would like to create a 
doc page for.
If you have selected a planning item from the Roadmap page, select Full details  from the 
Details  tab of the item's side panel.

4. From the planning item's record page, select Docs.

5. To create a page, you can create a blank page or start with a predefined template.

◦ For a blank page, select Create page.

◦ To create from templates:

a. Select Create Page from template.

b. Select a template from the Template Center and select Create page.

The new page is created and added to your Doc with the name Untitled, which you can 
rename.

6. To create a subpage, select the Page Actions  menu ( ) and select Create subpage.
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7. To delete a page or a subpage, select the Page Actions  menu ( ) and select Delete.

Managing portfolio plan views in Strategic Planning Workspace

Portfolio managers can create customized views for their portfolio plans by applying 
personalization settings such as column selection, grouping, and filtering. Portfolio owners or 
editors can share these personalized views with stakeholders to enable easier collaboration on 
the portfolio plans.

Benefits of portfolio plan views

Portfolio managers can create personalized views as needed by applying settings such as 
column selection, grouping, and filtering.

• Views can be created as private or public.

• Can create up to three private views and up to 10 shared (public) views.

• Portfolio plan views can be shared with stakeholders to enable collaboration on the portfolio 
plan.

• Switch between shared and private views as needed.

• Each view saves your display preferences across the Prioritization, Roadmap, Capacity, and 
Financials tabs.

Note: 
Views are available only for the Planning module and are supported in live mode, but not in 
scenario mode.

Create a portfolio plan view

Create a customized portfolio plan view based on your requirements, so you can access it when 
you log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
You can create up to three private views and up to ten shared (public) views per portfolio plan.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. Make any changes to the view as needed.
For example, apply filter with the Department  attribute and the value as Finance.
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The Save as new view  option appears on the portfolio plan header.

4. From the portfolio plan header, select Save as new view.

5. On the Save as new view window, fill the details.

a. Enter a name for the view in the View name  field.

b. Optional:  Select the Shared view  toggle to make this view public.
Selecting the Shared view  toggle makes the view visible to all stakeholders with whom this 
portfolio plan is shared.

c. Select Save.

Result
The shared view for the portfolio plan is created and will be visible to all stakeholders with whom 
this portfolio plan is shared.

What to do next

• Share the portfolio plan with your stakeholders to start collaborating on the portfolio plan. See 
Share a portfolio plan with stakeholders.

• Edit a portfolio plan view to make any changes to the existing view. See Edit a portfolio plan 
view.

Edit a portfolio plan view

Edit a customized portfolio plan view based on your requirements, so you can access it when you 
log in again and share it with stakeholders for collaboration.

Before you begin
Role required: sn_align_core.ap_read_only

About this task

• Only the owner of a portfolio plan view can edit a shared (public) view.

• You can have up to three private views and up to ten shared (public) views per portfolio plan.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. From the portfolio plan header, select the view you want to edit or override with your 
personalization settings from the list of available portfolio plan views.
The selected view appears.

4. Make changes to the view as needed.
For example, apply filter with the Department  attribute and the value as Finance.

After you make any change to the view, the Save view option appears in the portfolio plan 
header.

5. Select Save view.
The view is updated to reflect the changes made.

6. Optional:  To edit name of the view, select the Portfolio plan view drop-down from the portfolio 

plan header and then select Edit view icon ( ) next to the view you want to edit the name for.
On the Edit view window, fill the details.

a. Update the name for the view in the View name  field as required.

Note: 
Only the owner of the portfolio plan view can rename the view.

b. Optional:  Select the Shared view  toggle to make this view public or disable the Shared 
view  toggle to make the view private.

Important: 
Changing a shared view to a private view removes access for existing stakeholders.

c. Select Save.

(Optional) The name of the view is updated.

What to do next
Share the portfolio plan with your stakeholders to start collaborating on the portfolio plan. See 
Share a portfolio plan with stakeholders.
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Related topics

Create a portfolio plan view

Delete a portfolio plan view

Delete a portfolio plan view

Delete a customized portfolio plan view if it is no longer needed or if the maximum limit of ten 
shared or three private views has been reached.

Before you begin
Role required: sn_align_core.ap_read_only

About this task

• Only the owner of the portfolio plan view or an editor of the portfolio plan can delete the view.

• Deleting a portfolio plan deletes the view, including any changes made to the view. However, 
this action keeps the items (projects, demands, epics) intact in the portfolio plan.

• You can have up to three private views and up to ten shared (public) views per portfolio plan.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select one.

3. Select the Portfolio plan view drop-down from the portfolio plan header and then select Delete 

view icon ( ) next to the view you want to delete.
The Delete this view window appears.

4. On the Delete this view window, select Delete.

Related topics

Create a portfolio plan view

Edit a portfolio plan view

Executing Strategic Planning  work in PPM, Agile 2.0, and SAFe

Facilitate execution of the work planned in Strategic Planning  in ServiceNow  applications such 
as Project Portfolio Management  (PPM), Agile Development 2.0, or Scaled Agile Framework 
(SAFe).
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Import, export, and manage your planning items between Strategic Planning  and PPM, Agile 2.0, 
and SAFe.

Integrating planning and execution systems

Import records to Strategic Planning Workspace

Import records from Agile Development 2.0, after the relevant table maps, fields maps, and 
choice maps are configured.

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Strategic Planning  > Integrations.

2. Select ServiceNow Internal  Alignment Integration type.

3. Click Import.

4. On the Create Import Request form, fill in the date range for importing the records.

Create Import Request

5. Select OK.

Note: 
Records that have been created within the specified dates will be imported.
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Result
An import request is created and a link is shared to track the progress of the request.

Note: 
If you want to import records for a specific table map, click the Import  button that is 
available for the respective table map.

View error logs

View error logs to understand the cause of any issues that might have occurred during the 
integration process.

Before you begin
Role required: sn_align_core.apw_admin

Procedure

1. Navigate to All  > Strategic Planning  > Integrations.

2. To view the error logs, select the Integrations Errors  tab.

Export the portfolio plan status or roadmap to Microsoft PowerPoint

Export the status of goals, work items, roadmap, and key metrics of your portfolio plan and free-
form roadmap into a Microsoft PowerPoint  file so that you can keep your business stakeholders 
updated on the progress. Save time by avoiding copying data into reports and drive shared 
outcomes by enabling collaboration even with stakeholders who can’t access your ServiceNow 
instance.

Before you begin
Install Export to PowerPoint for Strategic Portfolio Management.

Important: 
Export to PowerPoint  is currently unavailable for customers in the FedRAMP, NSC DOD 
IL5, or Australia IRAP-Protected data centers, self-hosted customers, or in other restricted 
environments. Please check for availability updates in future releases.

Role required: admin

About this task
https://player.vimeo.com/video/1004219064?
h=242c60b94c&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

The following three PowerPoint templates are provided by default to generate a status report for 
your portfolio plan:

• Portfolio plan status: Contains individual detailed slides for the top five items prioritized by 
rank.

• Portfolio plan & goals status: Contains slides for Goals and targets for this portfolio, achieved 
goals, goals at risk, and individual detailed slides for the top five items prioritized by rank.

• Roadmap Template - default: Contains slides for Roadmap for this portfolio. You can export 
roadmap data for maximum period of a year at a time.

You can customize the type of the data to be shown in the generated report by updating 
a predefined template or by creating your own branded template. See Create a Microsoft 
PowerPoint template.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. Export the status of goals, work items, roadmap, and key metrics of your portfolio plan and 
free-form roadmap into a Microsoft PowerPoint  file.

Result
A PowerPoint file is generated with the relevant data.

The following image shows the example for an exported 

roadmap.

Strategic Planning Workspace  reference

Reference information to provide additional details about Strategic Planning  such as the fields, 
user roles, tables, guidelines, and domain separation information.

Customizing milestones display on roadmap in Strategic Planning  Workspace

Easily track the milestones of your roadmap timeline or its planning items by choosing how the 
milestones are displayed on the roadmap view.

The Personalize ( ) side panel on the roadmap provides different toggles to personalize the 
display of milestones on your roadmap.

• For portfolio plan roadmaps, these toggles are always available.

• For free-form roadmaps, these toggles are available only if the roadmap's source table is the 
Planning Item table [sn_align_core_planning_item] or one of its extensions.
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Milestones toggle Roadmap view

Roadmap milestones

Shows the milestones of the roadmap 
timeline.

Item milestones

Shows the milestones of the planning items.

Only milestones

Shows just the milestones on the roadmap by 
hiding all the planning item bars.

When you select this toggle, the group by and 
color by fields are changed and made inactive. 
Your previous personalization settings are 
available when you turn off this toggle.

You can also see that the milestone indicators 
are colored in this view.

• Red: Missed

• Green: Achieved

• Black/Dark gray: Upcoming

Note: 
If the total number of item-level 
milestones, including the milestones for 
unscheduled items, exceeds 100, the 
item milestone indicators aren’t visible 
on the roadmap. You can work with your 
admin to change this number to a value 
of your preference. For more information, 
see Update the display limit of items on 
Prioritization and Roadmap.
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Milestones toggle Roadmap view

Milestone label

Shows the milestone labels.

Milestone indicator with label

Milestone indicator without 
label

Customizing the dependencies display on the roadmap in Strategic Planning  Workspace

Improve the efficiency of identifying the relationships between your planning items by choosing 
how the dependencies are displayed on the roadmap view.

The Personalize ( ) side panel on the roadmap provides different toggles to personalize the 
display of dependencies on your roadmap.

• For portfolio plan roadmaps, these toggles are always available.

• For free-form roadmaps, these toggles are available only if the roadmap's source table is the 
Planning Item table [sn_align_core_planning_item] or one of its extensions.

Dependencies Toggle Roadmap view

View dependencies

Indicates dependencies in the form of circles 
on either side of the planning item bars.

These circles either contain a number 

inside them ( ), indicating the number of 
dependencies that item shares, or is colored 

red ( ) indicating a conflicting dependency.

Dependency circles on the 
roadmap
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Dependencies Toggle Roadmap view

Note: 
This toggle must be enabled to use the 
other two toggles in the Dependencies 
section.

Dependency lines

Indicates dependencies using lines between 
the planning items.

These lines are shown only if:

• Both planning items of the dependency are 
within the same roadmap

• Dependency is of the Depends on  type

Dependency lines between the 
planning items

Only items with dependencies

Filters the roadmap to show only those 
planning items that have that have at-least one 
Depends on  type of relationship.

The items shown here can depend on items 
on or out of the current roadmap.

Roadmap showing only items 
with dependencies

Components installed with Strategic Planning  Workspace

Several types of components are installed with installation of the Strategic Planning  application, 
such as user roles, tables, scheduled jobs, system properties, and custom scripts.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed with Strategic Planning  Workspace

Strategic planning workspace roles

Role title [name] Description Contains roles

Strategic Planning  Workspace 
admin

[sn_align_core.apw_admin]

Can access all the features in the Strategic 
Planning  application.

Note: 
Goals and Capacity Planning 
can be accessed only with the 
sn_apw_advanced.spw_goal_user_read 
and sn_align_ws.spw_capacity_read 
roles respectively.

• it_portfolio_manager

• sn_align_core.apw_user

• sn_gf.goal_admin

• view_changer

Strategic Planning  Workspace 
user Can create, update, and delete portfolio 

plans, free-form roadmaps, and planning 
items.

• sn_align_cmn_int.user

• sn_milestones.milestone_editor
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Strategic planning workspace roles  (continued)

Role title [name] Description Contains roles

[sn_align_core.apw_user] This role can be given to users such as 
portfolio or product managers, business unit 
leads, and other planning personas.

• sn_gf.strategy_planner

• sn_gf.goal_user

• sn_align_core.ap_read_only

• model_manager

sn_align_core.ap_read_only • Can view portfolio plans (Planning and 
Scoring pages) and free-form roadmaps 
that are shared with them.

• Can add notes, comments, or attachments 
to portfolio plans and roadmaps that are 
shared with them.

• Can create, edit, and delete portfolio plan 
views and free-form roadmap views.

Note: 
Only the owner can edit or delete 
a portfolio plan view or a free-form 
roadmap view.

• sn_milestones.milestone_viewer

• sn_dpr_model.product_enhancement_read

• sn_dpr_model.product_feature_read

Milestones editor

[sn_milestones.milestone_editor]

Can create, update, and delete milestones 
on the roadmap.

sn_milestones.milestone_viewer

Milestones viewer

[sn_milestones.milestone_viewer]

Can view milestones on the roadmap. None

Business stakeholder

[business_stakeholder]

• Can create and update portfolio plans and 
free-form roadmaps.

• Can add notes, comments, or attachments 
to portfolio plans and roadmaps that are 
shared with them.

• Can personalize the roadmaps.

• Can view generated resource capacity for 
planning items in the Capacity Planning 
screen.

• Can view goals defined for the portfolio 
plan.

Note: 
Users with this role do not have access 
to create or edit any roadmap items.

• sn_align_core.ap_read_only

• sn_align_ws.spw_capacity_read

• sn_apw_advanced.spw_goal_user_read
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Scenario planning roles

Role title [name] Description Contains roles

sn_align_ws.scenario_approver Can approve the scenarios for 
the portfolio.

sn_align_core.apw_user

Goals roles

Role title [name] Description Contains roles

sn_gf.goal_user_read Can view the goals. This role 
can be given to users such as 
the project user and demand 
user.

None

sn_gf.goal_user • Can create, view, edit, and 
delete goals, subgoals, and 
associated targets.

Note: 

◦ A goal or sub-goal 
can be deleted 
only by the owner 
and contributors 
of the goal or its 
immediate parent 
goal when the 
sn_gf.allow_goal_deletion 
system property is 
set to Yes.

◦ An associated target 
can be deleted 
only by the owner 
and contributors 
of the target or 
its goal when the 
sn_gf.allow_goal_deletion 
system property is 
set to Yes.

◦ A goal can be edited 
only by the owner 
and contributors 
of the goal or its 
immediate parent 
goal.

◦ A target can be 
edited only by 
the owner and 
contributors of the 
target or its goal.

• Can remove the existing 
goal relationships between 

sn_gf.goal_user_read
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Goals roles  (continued)

Role title [name] Description Contains roles

work item and goal, from 
the Goal Relationship 
[sn_gf_goal_m2m_relationship] 
table.

sn_gf.goal_admin • Create goals and targets.

• Edit goals and targets 
created by other users.

• Edit target breakdowns.

Note: 
The user must also 
be assigned the 
sn_apw_advanced.spw_goal_user 
role to edit target 
breakdowns.

• Can update the goal 
preferences.

• Can create target sources 
and context variables as 
part of enabling the target 
automation feature.

Note: 
The sn_gf.goal_admin 
role is installed as part 
of Goal Framework 
installation but this 
privilege is added to 
the role when Goal 
Framework for SPM  is 
installed.

• sn_gf.goal_user_read

• sn_gf.goal_user

sn_gf.strategy_planner_read Can view all strategic plans 
and strategic values.

None

sn_gf.strategy_planner Can create, view, edit, and 
delete strategic plans and 
strategic values.

sn_gf.strategy_planner_read
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Goals roles  (continued)

Role title [name] Description Contains roles

Note: 

• A strategic plan can 
be edited only by the 
owner and sponsor of 
the strategic plan.

• A strategic value can 
be edited only by 
the sponsor of the 
strategic plan.

sn_gf.epmo_strategy_planner Can create, view, edit, and 
delete any goal.

• sn_gf.goal_user_read

• sn_gf.goal_user

• sn_gf.goal_admin

• sn_gf.strategy_planner

sn_apw_advanced.spw_goal_userCan view the Goals page 
in the Strategic Planning 
Workspace and edit goals and 
targets.

• sn_apw_advanced.spw_goal_user_read

• sn_gf.goal_user

sn_apw_advanced.spw_goal_user_readCan view the Goals page 
in the Strategic Planning 
Workspace.

sn_gf.goal_user_read

Alignment Planner Workspace with PPM, Agile 2.0, and SAFe  roles

Role title [name] Description Contains roles

Strategic Planning 
integrations user

[sn_align_cmn_int.user]

Imports, exports, and 
manages planning items 
between Strategic Planning 
and Agile, SAFe, and PPM.

connection_admin

Capacity roles

Role title [name] Description Contains roles

sn_align_ws.spw_capacity_user Can generate resource 
capacity details.

sn_align_ws.spw_capacity_read

sn_align_ws.spw_capacity_readCan view resource capacity 
details.

None
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Financial planning roles

Role title [name] Description Contains roles

sn_align_ws.spw_financial_user • Can view financials, create 
cost plans and expense 
lines, create and compare 
financial baselines for 
planning items.

• Can create, edit, and view 
financial values in scenario 
planning.

None

sn_align_ws.spw_funding_user Can view the financial widgets 
while comparing scenarios 
and approve a scenario with 
financial changes.

sn_align_ws.spw_financial_user

Tables installed with Strategic Planning  Workspace

Table Description

Custom planning item 1

[sn_align_core_custom_planning_item_1]

Stores information for a additional planning item 
type.

Custom planning item 2

[sn_align_core_custom_planning_item_2]

Stores information for a additional planning item 
type.

Custom planning item 3

[sn_align_core_custom_planning_item_3]

Stores information for a additional planning item 
type.

Custom planning item 3

[sn_align_core_custom_planning_item_3]

Stores information for a additional planning item 
type.

Custom planning item 4

[sn_align_core_custom_planning_item_4]

Stores information for a additional planning item 
type.

Custom planning item 5

[sn_align_core_custom_planning_item_5]

Stores information for a additional planning item 
type.

Demand

[sn_align_core_demand]

Stores records created with Demand planning item 
type.

Epic

[sn_align_core_scrum_epic]

Stores records created with Epic planning item 
type.

These records could be Scrum or SAFe epics.

Initiative Stores records created with Initiative item.
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Table Description

[sn_align_core_initiative]

Lens

[sn_align_core_lens]

Stores data of the lens configuration.

Lens structure

[sn_align_core_lens_structure]

Stores data of lens entities and the relationship 
between them for different lenses.

Milestone

[sn_milestones_milestone]

Stores data of milestones.

Planning Item

[sn_align_core_planning_item]

Stores the data of all planning item types.

Portfolio plan

[sn_align_ws_portfolio_plan]

Stores data of portfolio plans.

Project

[sn_align_core_project]

Stores records created with Project planning item 
type.

Roadmap configuration

[sn_align_ws_roadmap_configuration]

Stores the configuration data for tables that are 
used to create portfolio roadmaps and free-form 
roadmaps.

Strategic Program

[sn_align_core_program]

Stores records created with Strategic Program item.

Goals tables

Table Description

Context Variable

[sn_gfa_context_variable]

Stores the context variable details for the 
target source.

Goal

[sn_gf_goal]

Stores the goal details.

Goal Assigned Entity Configuration

[sn_gf_assigned_entity_config]

Store the assigned entity configuration for 
a table for an assigned entity type, so that 
the goal user can associate the goal with the 
required assigned entity.

Goal Core

[sn_gf_core_goal]

Stores the core (basic) details for the goal. The 
Goal [sn_gf_goal] table extends the Goal Core 
[sn_gf_core_goal] table.

Goal Relationship Defines the relationship between a goal and 
items (Project, Demand, Program, Scrum Epic, 
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Goals tables  (continued)

Table Description

[sn_gf_goal_m2m_relationship]
Scrum Feature, SAFe Epic, SAFe Feature, and 
Planning item).

Strategic Plan

[sn_gf_strategic_plan]

Stores the strategic plans defined for each 
planning organization hierarchy.

Strategic Priority

[sn_gf_strategy]

Stores the strategic priorities defined for the 
organization.

Strategy Value

[sn_gf_strategy_value]

Stores the strategic values for strategic plans.

Target

[sn_gf_goal_target]

Stores the target details for the goal.

Target Breakdown

[sn_gfa_target_breakdown]

Stores the target breakdown details for 
the target that were created based on the 
breakdown intervals specified for the target.

Target Progress

[sn_gf_goal_target_progress]

Stores the target progress details for the goal.

Target Source

[sn_gfa_target_source]

Stores the target source configuration details 
for automating the actual value of the targets.

Units

[sn_gf_units]

Stores the available units for measuring the 
progress of targets.

Strategic Planning  with PPM, Agile 2.0, and SAFe  tables

Table Description

Field Map

[sn_align_cmn_int_field_map]

Field mappings for work items between 
Strategic Planning  and the execution 
applications.

Alignment Integration

[sn_align_cmn_int_integrations_setup]

Integration setup information for your instance.

Table Map

[sn_align_cmn_int_table_map]

Table maps for work items between Strategic 
Planning  and the execution applications.
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Strategic Planning  with PPM, Agile 2.0, and SAFe  tables  (continued)

Table Description

Integration Mapping

[sn_align_cmn_int_integration_mapping]

Integration mappings for work items between 
Strategic Planning  and the execution 
applications.

Import Request

[sn_align_cmn_int_import_request]

Stores the information for import requests 
created to import records from PPM, Agile 
Development 2.0, or SAFe  to Strategic 
Planning.

Instance Mapping

[sn_align_cmn_int_instance_mapping]

Stores instance mapping information 
between Strategic Planning  and the execution 
applications.

Integration Error

[sn_align_cmn_int_integration_error]

List of the integration errors.

Choice Map

[sn_align_cmn_int_choice_map]

Workflow choice mappings for work items 
between Strategic Planning  and the execution 
applications.

Financials tables

Table Description

Investment Baselines

[sn_invst_pln_invst_investment_baseline]

Stores the information about the financial 
baselines.

Investment Baseline Headers

[sn_invst_pln_invst_investment_baseline_header]

Stores all the information about financial 
baselines and the investment tables.

Investment Budget

[sn_invst_pln_invst_budget]

Stores the migrated budget information to 
work on lean budgeting at required time 
scope.

Scoring tables

Table Description

Scoring Framework

[sn_apw_advanced_scoring_framework]

Stores the records of scoring frameworks such 
as RICE, WSJF, Value vs Effort, or any new 
custom framework.

Scoring Framework Attribute

[sn_apw_advanced_scoring_attributes]

Stores the attributes of each of the scoring 
frameworks such as Reach, Impact, 
Confidence, Effort, Value, Job Size, Time 
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Scoring tables  (continued)

Table Description

Criticality, and so on. These attributes are of 
Glide var type fields.

Digital Product Release Data Model tables

Table Description

Product Enhancement

[sn_dpr_model_product_enhancement]

Stores the information about the product 
enhancement of a product feature.

Product Feature

[sn_dpr_model_product_feature]

Stores the information about the function or 
capability that adds value to a product for the 
customer.

Scheduled jobs installed with Strategic Planning  Workspace

Goals scheduled jobs

Scheduled job Description

Migrate Goal, Strategy, 
and Work item data to 
the Goal Framework 
and related Planning 
item tables

Migrates the existing goals data to the Goal Framework  tables. 
For information on what data is migrated and how the data can be 
migrated, see goal data migration.

Migrate goal 
relationships for 
assigned entities

Populates the fields, Assigned entity type  and Assigned entity 
on the Goal form  based on the data in the Goal Relationship 
[sn_gf_goal_m2m_relationship] table if you have created m2m 
relationship with lens entities other than Company, Business Unit, 
Department, and Portfolio.

Clear the Planning 
item value in the 
Goal Relationship for 
strategic items

Clears the planning item value in the existing Goal Relationship 
records for strategic items - Program and Initiative.

Update Actual value of 
the targets using Goal 
Framework for SPM

Updates the actual value of the targets by collecting the data from 
the respective target sources, so that the progress of the targets is 
updated and then the targets' progress is rolled up to the goals.

Create Goals Demo 
Data with Target 
Breakdowns

Creates a target breakdowns demo data for the targets.

Financials scheduled jobs

Scheduled job Description

Create Financial Baseline For Planning Items Automatically create financial baselines for 
your planning items at a defined cadence.
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Financials scheduled jobs  (continued)

Scheduled job Description

Migrate budget for active demands and 
projects

Migrate the budget of your planning items as a 
bulk action.

Generate Labor Costs Activate scheduled jobs to automatically 
generate labor costs for attribute-based 
resource assignments for Projects and 
Demands.

Generate Labor Costs For Epic Activate scheduled jobs to automatically 
generate labor costs for attribute-based 
resource assignments for Epics.

Custom scripts installed with Strategic Planning  Workspace

Goals custom scripts

Name Description

Benefit 
Plans

A target 
source 
with 
predefined 
script.

Predefined script that updates the Actual value  field on the target form by fetching 
the required value from the Actual benefit  field or Non-monetary actual benefit 
field from the monetary or non-monetary benefit plan records. For script template, 
see Predefined target automation script for benefit plans.

Note: 
You can use the Benefit Plans custom script only when PPM Standard 
(Project Portfolio Management) is installed.

System properties installed with Strategic Planning  Workspace

Portfolio Planning and Portfolio Planning Core system properties

Name Description

sn_align_ws.portfolio_plan_items_limit Option to define the number of planning items 
to be loaded on the planning page.

Note: 
If the value in the system property is more 
than 250, the performance of the UI may 
degrade. The default value is 250.

sn_align_ws.item_milestone_limit Option to define the number of milestone items 
to be loaded in the Roadmap tab. The default 
value is 50.

sn_align_ws.is_scenario_planning_disabled Option to enable the scenario_planning feature.

sn_align_core.planning_item_types_allow_list Option to define the planning item types to be 
allowed for configured for a portfolio plan.
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Goals system properties

Name Description

glide.ui.sn_gf_goal_target_activity.fields Option to enable activity stream for fields of the 
targets.

glide.ui.sn_gf_goal_activity.fields Option to enable activity stream for fields of the 
goals.

sn_align_ws.goal_hierarchy.max_records Specifies the number of goals to be loaded on the 
Hierarchy tab on the Goals view.

Note: 
If the value in the system property is more than 
500, the performance of the Goals UI may 
degrade. The default value is 500.

sn_gf.allow_goal_deletion Option to enable deletion of goals. The default value 
is true.

sn_gf.allow_target_deletion Option to enable deletion of targets. The default 
value is true.

sn_gf.goal_calendar_type Option to set calender type for setting goals. The 
available calendar types are Gregorian Calendar 
and Fiscal Period. The default value is Gregorian 
Calendar.

sn_gf.weighted_average_enabled Option to enable the weighted average logic to 
calculate the progress of goals from their subgoals 
and targets.

sn_gfa_disable_target_breakdown Option to enable the target breakdowns feature at 
the instance level. The default value is false.

sn_gfa.target_breakdown_decimals Option to define the number of decimals to show 
for target values while generating the target 
breakdowns. The default value is 2.

sn_gfa.weeklyCheckInDayToMapMonth Option to define end day of the week for weekly 
target breakdowns mapping to month. The default 
value is Friday.

Strategic Planning  with PPM system properties

Name Description

com.sn_align_cmn_int.bulk_import • Type: Choice list

• Default value: INSERT

• Other possible values:

◦ INSERT

◦ <Value 2 name>:
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Strategic Planning  with PPM system properties  (continued)

Name Description

• Location: System Property [sys_properties] 
table

• Learn more: Configure bulk import

Domain separation and Strategic Planning

Domain separation is supported for Strategic Planning. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Overview of domain separation in Strategic Planning

You can create lens, portfolio plans, planning items, and roadmaps in different domains.

How domain separation works in Strategic Planning

After you enable domain separation on your ServiceNow  instance, the data of Strategic Planning 
is automatically domain separated. So, the data of lens, portfolio plans, planning items, and 
roadmap configuration for different domains is visible to only those users who have access to 
these domains.

Domain separated tables in Strategic Planning

All the tables installed with Strategic Planning  support domain separation. For a complete list of 
tables, see Components installed with Strategic Planning Workspace.

Related topics

Domain separation for service providers

Planning item reorder errors in Strategic Planning  Workspace

Review the scenarios when the reordering of items can fail in the List view of Prioritization in 
Strategic Planning  Workspace.

To update the rank of the planning items in the work pipeline of your portfolio plan, you can 
reorder the items from the List view of the Prioritization page. While doing so, the reorder can 
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fail due to an error in the ranking configuration. Following are the scenarios where reordering of 
planning items can fail:

Scenario 1: Global ranking plugin is not active

Check if the Global Ranking Application plugin (com.snc.sdlc.ranking) is active in 
your ServiceNow  instance. If not, contact your admin to activate it.

Scenario 2: Planning item doesn't have a rank configuration

Check if all the planning items that you are reordering have a rank configuration. If 
not, contact your admin to update rank configuration for these planning item types.

Scenario 3: Target row doesn't have a global rank

Check if the planning item before or after your target position to reorder has a global 
rank. If not, contact your system admin to generate a global rank for them.

Related topics

Rank planning items

Item milestone errors in Strategic Planning  Workspace

Learn about the scenarios when the planning item milestones on the portfolio plan roadmap or 
free-form roadmap can be in an error state in Strategic Planning  Workspace.

An item milestone can fall out of the approved start or end dates of the item when you 
reschedule the existing planning item.

When you reschedule a planning item on the roadmap, the due dates of its milestones 
don’t change. So, if the due date of a milestone is falls outside the item’s date 
range, the indicator for that out-of-range milestone is hidden and moved to an 
error state. Indicators for milestones that are still within the item's date range are 

visible.

The milestones that are out of sync with the item's schedule can be viewed from the 
Milestones tab on the side panel. From the side panel, you can edit and adjust the 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

607



due date of the milestone to reflect the change of plans. See Update roadmap item 

milestones.

Note: 
You can’t update a project milestone from the roadmap view. Updating project milestones 
may impact the associated cost and resource plans of the project. So, it’s recommended to 
update project milestones using Project Workspace in Project Portfolio Management  (PPM).

Related topics

Add dependencies for roadmap items

Update roadmap item dependencies

Customizing the dependencies display on the roadmap in Strategic Planning Workspace

Item dependency errors in Strategic Planning  Workspace

Learn about the scenarios when the planning item dependencies on the portfolio plan roadmap 
or free-form roadmap in Strategic Planning  and Portfolio Planning  can be in an error state.

A dependency between two planning items can be in an error state when a scheduling conflict 
exists between the items. In a linear (Depends on) dependency, the items are scheduled in a way 
that starting the work on one item requires completing the work on another item.

Note: 
Error states are displayed for only if the planning items have a Depends on  type of 
relationship.

In the sample roadmap shown here, starting work on Employee onboarding process 
improvement  is dependent on the completion of Specific onboarding path for new hire. This 
relation is considered a linear dependency. Here, Employee onboarding process improvement 
is scheduled to start before the end date of Specific onboarding path for new hire. This conflict 

is indicated on the roadmap with an error icon ( ), and is also mentioned in the Dependencies 
tab of the Item details side panel.

To resolve such errors, review the scope of the planning items and update the start or end dates 
to adjust their scheduling accordingly.
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Related topics

Add dependencies for roadmap items

Update roadmap item dependencies

Managing Strategic Planning  with Project Portfolio Management, Agile Development 2.0, and 
SAFe

Ensure that Strategic Planning  is integrated properly with PPM, Agile Development 2.0, and SAFe 
with these guidelines.

• Do not change the filter condition of a table map after the records are interfaced. The already 
interfaced records might not match with the new filter condition and any change in the filter 
condition can result in data inconsistency. If you need to change the filter condition, ensure 
that the relevant attributes on the interfaced records are updated manually to avoid data 
inconsistency issues.

• Whenever a table map is created, ensure that the relevant field maps and choice maps are 
also configured.

• When an import job for a table map is running (processing), do not modify the table map or its 
field maps.

• Using the Converted to  field on the planning item form, you can identify the original record 
from which it was converted.

• Ensure that the Lookup field  and Lookup column  values are added whenever the execution 
and alignment tables are referencing two different tables, while creating a field map for field 
type of reference or glide list.

• If there is a data synchronization failure, check if:

◦ The Integration error logs  related list within that Alignment integration record.

◦ The Alignment table filter  (for import) and Execution table filter  (for export) conditions are 
met.

◦ The Active  flag in both the alignment integration and the table map is checked.

◦ The appropriate fields and choices are configured for each table map.

• If you want to view the Execution URL  field, configure the alignment planning item record to 
view it.

• If the Execution URL field in your synced planning item(s) is blank, navigate to All  > Strategic 
Planning  > Integrations  and select the required alignment integration. If any of the execution 
URL is missing, select the Fix execution URL(s) for planning items  related link. This runs a job 
and updates the execution URL field.
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Note: 
The Fix execution URL(s) for planning items  related link is only available when the 
execution URL is missing for any of the planning item.

• A Primary goal  field is introduced to the projects, demands, and epics table maps to support 
the integration of the Goal  field between alignment and execution tables.

• When you are trying to import or export a project, ensure that the demands (that are a part of 
that project) are synced.

• You can create a table map for any execution table. If a table map is not created from one of 
the delivered tables (pm_portfolio, rm_epic, dmn_demand, pm_project) or does not extend 
from them, you are required to create a business rule to support the interfacing of the table 
map records. For more information on creating a business rule, see Create a business rule to 
apply a custom table map configuration.

Form field information for Strategic Planning

Field information for forms used in the Strategic Planning  application.

Action Assignment form

Learn about the fields of the Action Assignment form. Use this form to add the New  action button 
to the APW List Menu Configuration page.

Goal form

Field Description

Action Label Name of the action label. Enter New.

Action name Name of the action. Enter create-new-uxf.

Implemented as Implementation for the action. Select UXF Client Action.

Table Name of the table the action is created for. Select 
sys_ux_list_menu_config.

Specify client 
Action

Client action. Look up and select Create New Record.

View View of the form on which the action button is displayed.

Choice map form

Understand the fields of the choice map form. This form is used to create choice maps.

Choice map form

Field Description

Execution table column Field column of the selected execution table 
that needs to be mapped. The value in this 
field is automatically added based on the 
selection made in the field map configuration.

Execution choice Select the choice field value of the selected 
execution table column field.

Alignment table column Field column of the selected alignment table 
that needs to be mapped. The value in this 
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Choice map form  (continued)

Field Description

field is automatically added based on the 
selection made in the field map configuration.

Alignment choice Select the choice field value of the selected 
alignment table column field.

Context Variable form

Use the Context Variable form to create a context variable for a target source for calculating the 
actual value of the target based on the configured input values.

Context Variable form

Field Description

Type Context variable type.

For information about the different field types, see Field types .

Application Name of the application scope.

Label Name of the label that the context variable type is created for.

Column name ID of the context variable for which the context variable type is created.

Choice List 
Specification

Option to display the context variables on the Target form in the Actual 
Value Source Configuration section.

Default value Default value to consider for updating the actual value of the target.

Create cost plan form

Use this form to create cost plans for your planning items.

Create cost plan form

Field Description

Name Name of the cost plan.

Entered currency Currency to capture the unit cost value.

Unit cost Planned cost for the cost plan.

Quantity Quantity of cost plans.

Total planned cost Total planned costs value of the cost plan.

Start fiscal period Starting month in a fiscal period for the cost 
plan.

End fiscal period Ending month in a fiscal period for the cost 
plan.

Cost distribution Allocate planned cost by fiscal period or 
duration.

Select a value from the list.
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Create cost plan form  (continued)

Field Description

• Split equally across fiscal periods  - 
Distributes the cost equally among all the 
fiscal periods across the duration.

• Recurring per fiscal period  - Recurs the 
cost for each fiscal period across the 
duration.

Cost type Cost type of the cost plan.

Select a cost type form the list.

Note: 
Based on the selected cost type, the 
Role  and Product model  fields appear.

Employee type Read-only field.

• External  if Cost type is External labor Capex 
or External labor Opex.

• Internal  if Cost type is Labor Capex or Labor 
Opex.

Role Name of the role to expense the cost plan.

Product model Available if the Cost type is Software, 
Hardware, or Other Capex or Opex.

Select a model from the list to expense the 
cost plan.

Model name of a hardware expenditure to 
expense the cost plan.

Create expense line form

Use this form to create expense lines for your actual expense.

Create expense line form

Field Description

Number Auto-generated number for the expense line.

Amount Expense incurred.

Short description Short description of the expense.

Mention unique and specific details to identify 
the expense line.

Date Date of the expense.

Process date Processed date of the expense.

Cost plan Associated cost plan name for recording the 
expense line.
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Create expense line form  (continued)

Field Description

Cost type Cost type of the expense.

by default, the cost type of the cost plan is 
selected.

State State of the expense line.

Only processed expense lines are considered 
for an investment entity.

Expense type Defines the expense type, internal or external.

By default, the expense type is considered 
from the Cost type  field entry.

Rate card Name of the rate card.

Summary type Business purpose of the expense line.

Dependency form

Learn about the fields of the dependency form. Use this form to add and establish dependencies 
between planning items on the roadmap in Strategic Planning  workspace.

Dependency form

Field Description

Planning item
Planning item that you selected from the 
roadmap, to create the dependency. Consider 
this as the successor item.

This field is automatically filled based on your 
selection.

Relationship type Choose one of the following:

• Depends on: Starting the work on one item 
depends on finishing the work of the other 
item. This dependency is considered a 
linear relationship.

• Relates to: Work of the two items is related 
to each other but doesn’t have a strict 
dependency on each other's completion. 
This dependency is considered a non-linear 
relationship.

Planning item Planning item that is required. Consider this as 
the predecessor item.

Number System-generated unique identification 
number for the dependency.
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Related topics

Planning item dependencies

Add dependencies for roadmap items

Field map form

Understand the fields of the field map form. This form is used to create mappings for a 
corresponding table map.

Field map form

Field Description

Execution table Table in Agile Development 2.0, SAFe, or 
PPM that needs to be mapped with a table in 
Strategic Planning. The value in this field is 
automatically added based on the selection 
made in the table map configuration.

Execution table column Field column of the selected execution table 
that needs to be mapped.

Alignment table Table in Strategic Planning  that needs to be 
mapped with a table in Agile Development 
2.0, SAFe, or PPM. The value in this field is 
automatically added based on the selection 
made in the table map configuration.

Alignment table column Field column of the selected alignment table 
that needs to be mapped.

Flow type Specifies whether the mapping is done 
from alignment to execution, execution to 
alignment, or both.

Here, alignment implies Strategic Planning, 
and execution implies PPM, Agile 
Development 2.0, and SAFe  applications.

You can also create custom fields and map them to the required source fields as needed. For 
example, if you want to display the execution project number, you can create a custom field 
called 'Project number' in the Project planning item [sn_align_core_project] table within the 
Portfolio Planning Core application scope. Then, map this field to the 'Number' field of the Project 
table (pm_project) using the project field map.

Goal Assigned Entity Configuration form

Use the Goal Assigned Entity Configuration form to configure a table for an assigned entity type 
so that the goal user can associate goals with the required assigned entity.

Goal Assigned Entity Configuration form

Field Description

Assigned entity table Entity table that a goal is assigned to.

Application Name of the application scope.

Assigned entity field Reference field on the goal form.
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Goal form

Use the Goal form to create goals for your organizational strategic priorities.

Note: 
For Operational Sustainability Workspace  and Strategic Planning  users, to view the other 
fields (that are not added to the default or your custom form view) on the form in the 
workspace, configure the default/custom form layout. For information on how to configure 
the form layout, see Configuring the form layout .

Goal form

Field Description

Name Name of the goal.

State State of the goal. The state can be Draft, In progress, Approved, Complete, 
Pending, Achieved, Not Achieved, or Cancelled.

Category Category of the goal. The available options are:

• Total Applications

• Total Cost

• Opex

• Capex

• Cloud Applications

• Homegrown Applications

• Support Cost

• Labor Cost

• Standards Compliance

• Strategic

• Operational

• Tactical

• Artificial Intelligence

Status Status of the goal. Status can be Red, Yellow, Green, or None.

Progress Percentage complete for the goal. The progress value is calculated automatically 
if the goal has sub-goals or/and targets.

For more information on how the progress value is calculated, see Progress value 
calculation.

Description Brief description of the goal.

You can refine goal description using the Refine records skill, if the Now Assist for 
SPM  application is installed.
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Parent information section of the Goal form

Field Description

Strategic priority Name of the strategic priority that this goal is 
created for.

Parent goal Name of the parent goal that this goal 
contributes to.

Impact on parent goal A numerical value that represents the 
importance of this goal relative to sibling goals 
or other goals under its parent goal. By default, 
the value is (1) Neutral.

The available options are:

• (0) No impact

• (1) Neutral

• (2) Moderate

• (3) High

• (4) Very high

• (5) Maximum

Note: 
This field is available only when the 
sn_gf.weighted_average_enabled 
system property is set to Yes.

Owners & Contributors section of the Goal form

FIeld Description

Assigned entity type Entity type to which the goal is assigned. 
For example, Business Unit, Department, 
Company, or Portfolio.

Assigned entity Entity to which the goal is assigned. For 
example,if the portfolio plan is created with 
Business Units, HR and IT, populate the 
Assigned entity type as Business Unit and 
Assigned entity type as HR or IT.

Note: 
Populating the Assigned entity type and 
Assigned entity fields are required to 
display the goals in the portfolio plan.

Owner Owner of the goal. By default, the name of the 
user creating the goal is populated.

Contributors Users who contribute to the achievement of 
the goal.
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Duration section of the Goal form

Field Description

Start date Start date for the goal. By default, the start 
date of the current quarter is populated. For 
a sub-goal, start date of its parent goal is 
populated.

End date End date for the goal. By default, the end 
date of the current quarter is populated. For 
a sub-goal, the end date of its parent goal is 
populated.

Other section of the Goal form

Field Description

Comments Detailed comments for the goal to facilitate 
collaboration.

Team Assignment group responsible for different 
activities in achieving the goal.

Classification Goal classification type. The available options 
are Environmental, Social, and Governance. 
This field is applicable only for the Operational 
Sustainability Workspace  users.

Related topics

Iteration goals and work item goals in EAP

Goal Preferences form

Use the Goal Preferences form to manage goals such as the calendar type used for goal setting, 
weighted average calculation for goal progress, and deletion of goals and targets.

Goal Preferences form

Property Description

Enable the weighted 
average logic to calculate 
the progress of goals 
from their sub-goals and 
targets.

When enabled, the fields, Impact on parent goal  andImpact 
on goal  appear in the Goal [sn_gf_goal] and Target 
[sn_gf_goal_target] tables respectively. The progress value of the 
parent goal is calculated by applying the Weighted Average logic.

The default value is Yes.

The progress value of a parent goal is calculated based on the 
progress value and the value defined in the Impact on parent goal 
andImpact on goal  fields for sub-goals and targets respectively.

For more information on how the progress value is calculated, see 
progress value calculation.

Allow deletion of goals. Can delete the goals.

The default value is Yes.
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Goal Preferences form  (continued)

Property Description

Allow deletion of targets. Can delete the targets.

The default value is Yes.

Note: 
When you delete a goal, its associated targets (if any) are 
also deleted even though the Allow the deletion of targets 
property is set to No.

Calendar type used for 
setting goals.

Calendar type that is used for setting goals. The available 
calendar types are Gregorian calendar and Fiscal period.

The default value is Gregorian calendar.

Disable target breakdowns 
at the instance level.

Can disable the target breakdowns feature. When the feature is 
enabled, target breakdowns are automatically created based on 
the breakdown interval set for the target.

The default value is false.

Goal/Target Relationship form

Use the Goal/Target Relationship form to create a relationship between a goal and planning item, 
strategic item, or any other item.

Goal/Target Relationship form fields for Planning and Strategic item

Field Description

Goal Name of the goal you want to associate the planning item with.

Target Name of the target you want to associate the planning item with.

Primary Option to make the goal/target relationship as primary.

Selecting this field automatically populates the Primary goal  and Primary target 
fields on the planning item form.

Planning 
item type

Type of planning item.

Planning 
item

Planning item with which a goal relationship is created with the goal.

Goal/Target Relationship form fields for an item(that is of entity type, Product Model)

Field Description

Table Name of the reference table.

Document ID Document ID of the column from the selected 
reference table.
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Goal/Target Relationship form fields for an item(that is of entity type, Product Model) 
(continued)

Field Description

The suggested values in this field depend on 
the reference table selected in the Table  field.

Highlighted Value form

Learn about the fields of the Highlighted Value form. Use this form to customize the fields to be 
highlighted on the Prioritization page of a portfolio plan in Strategic Planning  workspace.

Field Description

Table Table which contains the highlighted columns. 
Enter sn_align_core_planning_item.

Application Scope of yourServiceNow  instance. By default, 
this field is set to Portfolio Planning.

Field Column of the table that is highlighted in the 
workspace.

Highlighted Value Condition form

Learn about the fields of the Highlighted Value Conditions form. Use this form to configure the 
display of highlighted fields in Strategic Planning  workspace.

Field Description

Condition Condition for the field value.

For example, Status is Green.

Color Color for the field value that meets the 
condition specified.

Application Scope of yourServiceNow  instance. By default, 
this field is set to Portfolio Planning.

Order
Order in which this color appears on 
the legend in the Hierarchy view of the 
Prioritization page.

For example, for the Planning Status column, 
the value New  is given the order 1.
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Field Description

Hide Label Option to hide the label for the highlighted 
value condition. When selected, the Label field 
is not available.

Label Name of the label displayed for the highlighted 
value condition. This field is not available 
when Hide Label  is selected.

Show Icon Option to show icon beside the field value.

Icon Icon that is displayed beside the field value. 
This field is shown only if the Show Icon  field 
is selected.

Variant Option to define color variant. The available 
options are primary, secondary, and tertiary.

Value Override Custom display text that replaces the actual 
field value in the view. When specified, the 
override text appears instead of the stored 
value.

Initiative form

Learn about the fields of the initiative form. Use this form to create or edit the details of an 
Initiative in Strategic Planning.

These fields are displayed on the full details page of the initiative.

Initiative form

Field Description

Name Brief description of the initiative.

Description Detailed information of the initiative.

You can refine initiative description using the 
Refine records skill, if the Now Assist for SPM 
application is installed.

State Current working state of the initiative.

Owner User assigned to this initiative.

Planning state State of the initiative in the Strategic Planning 
workspace.
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Initiative form  (continued)

Field Description

Percent complete Percentage of work completed for this 
initiative.

MoSCoW Priority of this initiative based on its 
importance. The available options are:

• 1 - Must have

• 2 - Should have

• 3 - Could have

• 4 - Won’t have

Work notes Notes to capture the updates and discussions 
on the initiative as the work progresses.

Strategic priority Strategic priority that this initiative is 
associated to.

Details section of the Initiative form

Field Description

Approved start date Approved start date for this initiative.

Approved end date Approved end date for this initiative.

Actual start date Actual date on which the work for this initiative 
has started.

Actual end date Actual date on which the work for this initiative 
is complete.

Priority Priority of this initiative.

Business capabilities Business capabilities of this initiative.

Business application Business application that this initiative is 
related to.

Other impacted business applications Business applications that this initiative has an 
impact on.

Business case section of the Initiative form

Field Description

Overview Business case overview of this initiative.

Background Background for this initiative.

Limitations Applicable limits to this initiative.

Approach Planned approach to work on this initiative.

Benefit Business benefit from this initiative.
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Financials section of the Initiative form
In this section, capture financial details for this initiative such as cost, CapEx, 
OpEx, benefit, ROI, and other estimates.

Field Description

Planned cost Planned cost to take up this initiative.

Planned capEx Planned capital expenditure for this initiative.

Planned opEx Planned operational expenditure for this 
initiative.

Planned benefit Planned benefit from this initiative.

Actual benefit Actual benefit achieved from this initiative,

Actual cost Actual cost on this initiative.

Actual capEx Actual value of capital expenditure for this 
initiative.

Actual opEx Actual value of operational expenditure for this 
initiative.

Planned ROI Planned return of investment for this initiative.

Related topics

Create planning items from the roadmap view

Add planning items to Prioritization

Lens form

Learn about the fields of the Lens form. Use this form to create a lens in Strategic Planning.

Lens form

Field Description

Name Name of the lens.

Active Indicates if the lens is active.

Description Brief description of the lens.

You can indicate the business purpose of this 
lens and the planning managers that would 
use this lens.

Planning items Type of work that can be planned using this 
lens.

Move the desired planning item types from the 
Available  list to the Selected  list.

If you want additional planning items types, you can create them. See Define a new planning item 
type in Strategic Planning.
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Related topics

Create or modify a lens in Strategic Planning

Lens structure form

Learn about the fields of the Lens structure form. Use this form to define a structure for your lens 
in Strategic Planning.

Lens structure form

Field Description

Entity Source table for your lens entity.

An entity represents a planning level in the 
perspective of your lens.

Select the entity that is relevant for your 
planning persona from the perspective of 
this lens. For example, Department, Product 
Model, or Business Objective.

Entity filter Conditions to filter data from your entity 
source.

The filtered data is shown on the workspace 
for your planning persona to select and plan 
for.

Top entity Indicates if this entity is the top-level entity of 
your lens structure.

Parent entity Entity that is one level above this entity in your 
current lens structure.

This field is available only if the Top entity  field 
isn’t selected.

Reference to parent entity Column in the current entity table that 
references the parent entity table.

For example:

• Entity is Strategic Program 
[sn_align_core_program]

• Parent entity is Department 
[cmn_department]

Then the field of the Strategic Program 
[sn_align_core_program] table that references 
the Department [cmn_Department] table 
would be Department.

This field is available only if the Top entity  field 
isn’t selected.

Related topics

Add or modify lens structure in Strategic Planning
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List Applicability form

Learn the field information for the List Applicability form. Use this information to define audience 
for the newly created lists for Strategic Planning  workspace.

Field Description

List Name of the list that you want to define 
audience for.

Application This field is set to Portfolio Planning  by 
default.

Applicability Audience for this list.

Set this field to Alignment Workspace Home 
Audience.

Active Option to enable this applicability to the list.

Planning item type form

Learn about the fields of the new table form that are required to add a new planning item type in 
Strategic Planning.

New table form

Field Description

Label Unique label for the table.

Name This field is auto generated from your input in 
the Label field.

Application
This field is automatically set to Portfolio 
Planning  based on your scope.

If this field shows a different value, then 
ensure that your ServiceNow  instance is in 
Portfolio Planning  scope.

Extends table If this new table is a type of planning item, 
select Planning Item.

Controls section of the new planning item type form

Field Description

User role Set this field to sn_align_core.apw_user  so 
that you grant access to the Strategic Planning 
user to this table.

Application Access section of the new planning item type form

Application Access

Enable the Can read, Can create, Can update, and Can delete  fields.
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Related topics

Define a new planning item type in Strategic Planning

Planning item form

Learn about the fields in the forms of the different planning item types available in Strategic 
Planning. Use these forms to add new planning items or update details of existing items.

All planning item types in Strategic Planning  including any custom item type that your admin may 
have created, are an extension of the Planning Item [sn_align_core_planning_item] table. The 
planning item form fields that you see in the workspace are based on the item types configured 
for your portfolio plan.

The following are the different planning item types available by default. Use the following 
sections for the details of the form fields for the planning item type that you want to use.

• Demand planning item form

• Epic planning item form

• Initiative form

• Project planning item form

• Strategic program form

Related topics

Create planning items from the roadmap view

Add planning items to Prioritization

Epic planning item form

Learn about the fields of the epic form. Use this form to create or edit the details of a planning 
item of the type Epic in Strategic Planning.

These fields are displayed on the full details page of the planning item.

Epic planning item form

Field Description

Name Brief description of the planning item.

Description Detailed information of the planning item.

You can refine epic description using the 
Refine records skill, if the Now Assist for SPM 
application is installed.

State Current working state of the planning item.

Owner User assigned to this planning item.

Planning state State of the planning item in the Strategic 
Planning  Backlog.

Percent complete Percentage of work completed for this 
planning item.

Methodology Agile methodology used.

Enabler Option to indicate if this epic is an enabler.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

625



Epic planning item form  (continued)

Field Description

MoSCoW Priority of this planning item based on its 
importance. The available options are:

• 1 - Must have

• 2 - Should have

• 3 - Could have

• 4 - Won’t have

Portfolio Portfolio that this planning item is associated 
to.

Product Product that this planning item is associated 
to.

Strategic program Strategic program that this planning item is 
associated to.

Product enhancement Product enhancement that this planning item 
is associated to.

Primary goal Goal that is associated with this planning item 
as the primary goal.

Primary target Target that is associated with this planning 
item as the primary target.

Work notes Notes to capture the updates and discussions 
on the planning item as the work progresses.

Strategic priority Strategic priority that this planning item is 
related to.

Dates section of the Epic planning item form

Field Description

Approved start date Approved start date for this planning item.

Approved end date Approved end date for this planning item.

Actual start date Actual date on which the work for this planning 
item has started.

Actual end date Actual date on which the work for this planning 
item is complete.

Planned start date Planned start date for this planning item.

Planned end date Planned end date for this planning item.
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Details section of the Epic planning item form
In this section, capture additional details for this planning item such as 
Investment type, Execution type, impacted business application, and more.

Field Description

Priority Priority of this planning item.

Phase Phase of this planning item.

This field is available only if the planning item 
is of the type Project.

Business capabilities Business capabilities of this planning item.

Business application Business application that this planning item is 
related to.

Other impacted business applications Business applications that this planning item 
has an impact on.

Missing estimate Number of stories in the epic that are missing 
estimates.

Percent complete by count Percentage of completed work in the epic. 
Story count is used to calculate this value.

Completed count Number of completed stories in the epic.

Completed estimate Sum of the estimates of all the completed 
stories in the epic.

T-Shirt size Size of the demand.

Total count Number of stories in the epic.

Total estimate Sum of the estimates of all stories in the epic.

Percent complete by estimate Percentage of completed work in the epic. 
Story estimate is used to calculate this value.

WSJF score section of the Epic planning item form
Use this section if your epic is a SAFe  epic.

Field Description

WSJF score Weighted Shortest Job First (WSJF) score is 
used to prioritize and sequence jobs to result 
in optimum business value. An epic with the 
highest WSJF score gets the highest priority 
for implementation.

This field is automatically filled using other 
field values in this section.

User-business Value Business value of the job based on 
parameters like impact on revenue or other 
solutions in the market offering similar 
capabilities.
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WSJF score section of the Epic planning item form
Use this section if your epic is a SAFe  epic.

(continued)

Field Description

Job size Estimated duration for completion of the job.

Time criticality Impact on the business when deadlines are 
missed. For example, how projected revenue 
gains are reduced over time when deadlines 
are shifted.

Risk reduction Analyze how much risk that this epic can help 
you avoid by answering questions such as:

• Does the job add value to the business in 
other ways?

• Does the job bring in new business 
opportunities?

• Does the job reduce the risk for a future 
delivery?

Financials section of the Epic planning item form
In this section, capture financial details for this planning item such as cost, 
CapEx, OpEx, benefit, ROI, and other estimates.

Field Description

Planned cost Planned cost to take up this planning item.

Planned capEx Planned capital expenditure for this planning 
item.

Planned opEx Planned operational expenditure for this 
planning item.

Planned benefit Planned benefit from this planning item.

Actual benefit Actual benefit achieved from this planning 
item,

Actual cost Actual cost on this planning item.

Actual capEx Actual value of capital expenditure for this 
planning item.

Actual opEx Actual value of operational expenditure for this 
planning item.

Planned ROI Planned return of investment for this planning 
item.

Related topics

Create planning items from the roadmap view

Add planning items to Prioritization
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Demand planning item form

Learn about the fields of the demand form. Use this form to create or edit the details of a planning 
item of the type Demand in Strategic Planning.

These fields are displayed on the full details page of the planning item.

Demand planning item form

Field Description

Name Brief description of the planning item.

Description Detailed information of the planning item.

You can refine demand description using the 
Write planning item skill, if the Now Assist for 
SPM  application is installed.

State Current working state of the planning item.

Owner User assigned to this planning item.

Planning state State of the planning item in the Strategic 
Planning  Backlog.

Category Category of this planning item. Choose from 
Strategic  or Operational.

Execution URL Link to the demand's execution record in Next 
Experience for Demand Management.

MoSCoW Priority of this planning item based on its 
importance. The available options are:

• 1 - Must have

• 2 - Should have

• 3 - Could have

• 4 - Won’t have

Portfolio Portfolio that this planning item is associated 
to.

Program Program that this planning item is associated 
to.

Product Product that this planning item is associated 
to.

Strategic program Strategic program that this planning item is 
associated to.

Primary goal Goal that is associated with this planning item 
as the primary goal.

Product enhancement Product enhancement that this planning item 
is associated to.

Primary target Target that is associated with this planning 
item as the primary target.
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Demand planning item form  (continued)

Field Description

Work notes Notes to capture the updates and discussions 
on the planning item as the work progresses.

Strategic priority Strategic priority that this planning item is 
associated to.

Dates section of the Demand planning item form

Field Description

Approved start date Approved start date for this planning item.

Approved end date Approved end date for this planning item.

Planned start date Date on which the work for this planning item 
is planned to start. This value is copied from 
the Approved start date  field.

Planned end date Date on which the work for this planning 
item is planned to be complete. This value is 
copied from the Approved end date  field.

Details section of the Demand planning item form
In this section, capture additional details for this planning item such as 
Investment type, Execution type, impacted business application, and more.

Field Description

Investment class Choose from Run  and Change

Investment type Type of investment this planning item comes 
under. For example, if completing work on this 
item improves the user experience for your 
product, select End User Experience.

Priority Priority of this planning item.

Business application Business application that this planning item is 
related to.

Other impacted business applications Business applications that this planning item 
has an impact on.

Business capabilities Business capabilities of this planning item.

Business case section of the Demand planning item form
In this section, capture business details for this planning item such as risks, 
scope, blockers for this planning item.

Field Description

Business case Business case to invest in this planning item.
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Business case section of the Demand planning item form
In this section, capture business details for this planning item such as risks, 
scope, blockers for this planning item.

(continued)

Field Description

Risk of performing Risks to the business if work on this planning 
item is completed.

Risk of not performing Risks to the business if work on this planning 
item isn’t completed.

Enablers Enablers for this demand.

Barriers Blockers, if any, for this planning item.

In scope Defined criteria for this planning item.

Out of scope Clearly defined criteria that is not necessary 
for this planning item.

Assumptions Assumptions, if any, to work on this planning 
item.

Financials section of the Demand planning item form
In this section, capture financial details for this planning item such as cost, 
CapEx, OpEx, benefit, ROI, and other estimates.

Field Description

Planned cost Planned cost to take up this planning item.

Planned capEx Planned capital expenditure for this planning 
item.

Planned opEx Planned operational expenditure for this 
planning item.

Planned ROI Planned return of investment for this planning 
item.

Financial return Financial return on this planning item.

Planned benefit Planned benefit from this planning item.

Assessment data section of the Demand planning item form

Field Description

Impact Impact that this planning item has on the 
business.

Risk Numerical value for the risk associated with 
this planning item.

Value Numerical value for the value obtained with 
this planning item.

Score Score of the planning item.
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Related topics

Create planning items from the roadmap view

Add planning items to Prioritization

Project planning item form

Learn about the fields of the project form. Use this form to create or edit the details of a planning 
item of the type Project in Strategic Planning  workspace.

These fields are displayed on the full details page of the planning item.

Project planning item form

Field Description

Name Brief description of the planning item.

Description Detailed information of the planning item.

You can refine project description using the 
Write planning item skill, if the Now Assist for 
SPM  application is installed.

Status Status of the planning item.

Owner User assigned to this planning item.

State Current working state of the planning item.

Percent complete Percentage of work completed for this 
planning item.

Planning state State of the planning item in the Strategic 
Planning  or Portfolio Planning  Backlog.

Execution URL Link to the project's execution record in the 
Project Workspace.

MoSCoW Priority of this planning item based on its 
importance. The available options are:

• 1 - Must have

• 2 - Should have

• 3 - Could have

• 4 - Won’t have

Portfolio Portfolio that this planning item is associated 
to.

Program Program that this planning item is associated 
to.

Product Product that this planning item is associated 
to.

Strategic program Strategic program that this planning item is 
associated to.

Product enhancement Product enhancement that this planning item 
is associated to.
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Project planning item form  (continued)

Field Description

Primary goal Goal that is associated with this planning item 
as the primary goal.

Primary target Target that is associated with this planning 
item as the primary target.

Work notes Notes to capture the updates and discussions 
on the planning item as the work progresses.

Strategic priority Strategic priority that this planning item is 
related to.

Dates section of the Project planning item form

Field Description

Planned start date Date on which the work for this planning item 
is planned to start. This value is copied from 
the Approved start date  field.

Planned end date Date on which the work for this planning 
item is planned to be complete. This value is 
copied from the Approved end date  field.

Approved start date Approved start date for this planning item.

Approved end date Approved end date for this planning item.

Actual start date Actual date on which the work for this planning 
item has started.

Actual end date Actual date on which the work for this planning 
item is complete.

Details section of the Project planning item form
In this section, capture additional details for this planning item such as 
Investment type, Phase of the planning item, Execution type, affected business 
application, and more.

Field Description

Investment class Type of investment class that this planning 
item comes under. Choose from Run  and 
Change

Investment type Type of investment that this planning item 
comes under. For example, if completing work 
on this item improves the user experience for 
your product, select End User Experience.

Demand Demand that this planning item is associated 
with.

Execution type Execution methodology for this planning item. 
Select from Waterfall, Agile, or Hybrid.
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Details section of the Project planning item form
In this section, capture additional details for this planning item such as 
Investment type, Phase of the planning item, Execution type, affected business 
application, and more.

(continued)

Field Description

This field is available only if the planning item 
is of the type Project.

Priority Priority of this planning item.

Phase Phase of this planning item.

This field is available only if the planning item 
is of the type Project.

Business application Business application that this planning item is 
related to.

Other impacted business applications Business applications that this planning item 
has an impact on.

Business capabilities Business capabilities of this planning item.

Business case section of the Project planning item form
In this section, capture business details for this planning item such as risks, 
scope, and blockers for this planning item.

Field Description

Business case Business case to invest in this planning item.

Risk of performing Risks to the business if work on this planning 
item is completed.

Risk of not performing Risks to the business if work on this planning 
item isn’t completed.

Enablers Enablers for this project.

Barriers Blockers, if any, for this planning item.

In scope Defined criteria for this planning item.

Out of scope Clearly defined criteria that is not necessary 
for this planning item.

Assumptions Assumptions, if any, to work on this planning 
item.
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Financials section of the Project planning item form
In this section, capture financial details for this planning item such as cost, 
CapEx, OpEx, benefit, ROI, and other estimates.

Field Description

Planned cost Planned cost to take up this planning item.

Planned capEx Planned capital expenditure for this planning 
item.

Planned opEx Planned operational expenditure for this 
planning item.

Planned benefit Planned benefit from this planning item.

Actual benefit Actual benefit achieved from this planning 
item,

Estimate to completion Estimated cost to complete work on this 
planning item.

Actual cost Actual cost on this planning item.

Actual capEx Actual value of capital expenditure for this 
planning item.

Actual opEx Actual value of operational expenditure for this 
planning item.

Planned ROI Planned return of investment for this planning 
item.

Planned return Financial return on this planning item.

Estimate at completion Estimated cost at the time that work on this 
planning item is completed.

Score section of the Project planning item form
In this section, capture scoring details for this planning item such as score, 
value score, risk score, and size score.

Field Description

Score

Value score Score for the value obtained with this planning 
item.

Risk score Score for the risk associated with this planning 
item.

Size score Score for the job required to complete the 
task.

Related topics

Create planning items from the roadmap view

Add planning items to Prioritization
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Planning item milestone form

Learn about the fields of the planning item milestone form. Use this form to create milestones for 
the planning items in your roadmap in Strategic Planning  workspace.

Field Description

Name Preferred name for your milestone.

Type Milestone type. Select one from the following:

• Deadline

• Key Milestone

• Key Event

• Launch Date

• Important Date

Due date The date of the milestone.

State Status of the milestone. Select one from the 
following:

• Upcoming

• Missed

• Achieved

Assigned to User who is assigned to the milestone.

Description Brief description about the milestone.

Related topics

Add dependencies for roadmap items

Update roadmap item dependencies

Customizing the dependencies display on the roadmap in Strategic Planning Workspace

Portfolio plan configuration form

Learn about the fields of the Portfolio plan form. Use this form to create or update display settings 
of the planning items for a portfolio plan in Strategic Planning  Workspace.

Portfolio plan configuration form

Field Description

Source table Table that you want to configure portfolio plan 
for.

For example, Strategic Priority 
[sn_gf_strategy].

Start date field Field to retrieve the start date value from.

End date field Field to retrieve the end date value from.

Item name field Field to retrieve the name of the item from.
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Portfolio plan configuration form  (continued)

Field Description

Item owner field Field to retrieve the item owner name from.

Roadmap timeline configuration section of the Portfolio plan configuration form

Field Description

Group by fields List of fields with which the roadmap items can 
be categorized into groups.

For example, the State  attribute can be used 
to categorize the items into groups of states 
such as Draft, Ready, Work in progress, and 
others.

Color by fields List of fields with which the roadmap items can 
be categorized by color.

For example, the Planning item type  attribute 
can be used to assign a unique color to each 
group of items belonging to a specific type.

Metrics fields
List of fields used as the metrics for the 
roadmap items.

For example, Planned benefit  or Actual cost.

These values are displayed when you point 
the mouse cursor on the roadmap item.

Status field
Field that is used for the status of the roadmap 
item.

Percent complete field
Field that is used to track the completion of 
the roadmap item.

This field value is used to visualize the 
progress of the roadmap item in the tracking 
mode.

Kanban configuration section of the Portfolio plan configuration form

Field Description

Swim lane Field to use for the swim lane on the board in 
the Prioritization Kanban view.

Vertical lane Field to use for the vertical lane on the board 
the Prioritization Kanban view.
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Kanban configuration section of the Portfolio plan configuration form  (continued)

Field Description

Metrics on Kanban card Default metrics that your planning managers 
want to view on a planning item card in the 
Prioritization Kanban view.

Swim lane Field to use for the swim lane on the board in 
the roadmap view.

Vertical lane Field to use for the vertical lane on the board 
in the roadmap view.

Metrics on Kanban card Default metrics that your planning managers 
want to view on a planning item card on the 
Kanban board in the roadmap view.

Rank configuration section of the Portfolio plan configuration form

Field Description

Rank Configuration Table that is used to create the portfolio plan.

The value for this field is the table selected in 
the Source table  field.

Related topics

Create portfolio plan configuration for high-level planning

Product Enhancement form

Learn about the fields of the product enhancement form. Use this form to create or edit the 
details of a product enhancement in Strategic Planning.

These fields are displayed on the full details page of the product enhancement.

Product Enhancement form

Field Description

Product Name of the product that this product 
enhancement is created for.

Product feature Product feature that this product 
enhancement is associated to.

Version Version of the product enhancement.

Name Name of the product enhancement.

State State of the product enhancement.

Assignment group User group that is assigned to the product 
enhancement.

Assigned to User who is assigned to the product 
enhancement.

Description Brief description of the product enhancement.
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Product Enhancement form  (continued)

Field Description

Start date Start date for the product enhancement.

End date End date for the product enhancement.

Progress value calculation

The progress or percentage complete value of goals is auto-calculated using different formulas. 
The formula depends on whether the goal has only targets, a combination of sub-goals and 
targets, and if it has weighted average calculation enabled.

Scenario Formula used to calculate the progress value of the goal

• The goal has targets.

• The goal doesn’t have sub-goals.

• The Impact on goal  field is 
defined for targets.

Progress value of the goal = Sum of 
progress values of its associated 
targets / number of targets

• The goal has sub-goals and 
targets.

• The Impact on parent goal 
and Impact on goal  fields are 
defined for sub-goals and targets 
respectively.

Progress value of the goal = Sum of 
progress values of its sub-goals and 
associated targets / number of sub-
goals and targets

• The goal has two targets (target 1 
and target 2).

• The goal doesn’t have sub-goals.

• The Impact on goal  field is 
defined for targets and the 
sn_gf.weighted_average_enabled 
system property is set to Yes.

Progress value of the goal = 
[(Progress of target 1 * Weight scale 
of target 1) + (Progress of target 2 
* Weight scale of target 2)] / (Weight 
scale of target 1 + Weight scale of 
target 2)

• The goal has two targets (target 1 
and target 2).

• The goal has two sub-goals (sub-
goal 1 and sub-goal 2).

• The Impact on parent goal 
and Impact on goal  fields are 
defined for sub-goals and 
targets respectively and the 
sn_gf.weighted_average_enabled 
system property is set to Yes.

Progress value of the goal = 
[(Progress of sub-goal 1 * Weight 
scale of sub-goal 1) + (Progress of 
sub-goal 2 * Weight scale of sub-
goal 2) + (Progress of target 1 * 
Weight scale of target 1) + (Progress 
of target 2 * Weight scale of target 
2)] / (Weight scale of sub-goal 1 + 
Weight scale of sub-goal 2 + Weight 
scale of target 1 + Weight scale of 
target 2)
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Consider a scenario where a goal (G1) has two targets (T1 and T2) and the Impact on goal  field 
for T1 and T2 is set to 2 and 3 respectively. The current Progress values of T1 and T2 are 40% and 
20% respectively. In this case, the progress value for G1 is calculated as follows:

• Contribution of T1 towards G1 progress = 2/(2+3)*40 = 16%

• Contribution of T2 towards G1 progress = 3/(2+3)*20 = 12%

• Therefore, Progress of G1 = 16% +12% = 28%

Roadmap milestone form

Learn about the fields of the roadmap milestone form. Use this form to create a milestone for the 
timeline of your roadmap in Strategic Planning  workspace.

Field Description

Name Preferred name for your milestone.

Type Milestone type. Select from one of the 
following:

• Key Event

• Launch Date

• Important Date

• Deadline

• Key Milestone

Due date The date of the milestone.

Assigned to User who is assigned to the milestone.

Related topics

Add milestones for a roadmap

Update a roadmap milestone

Roadmap configuration form

Learn about the fields of the roadmap configuration form. Use this form to add new tables to 
roadmap preferences and configure their details in Strategic Planning.

Roadmap configuration form

Field Description

Source table Table that is used to build your roadmap.

Start date field
Field that is used for the start date of the 
roadmap item.

For example, Planned start date.

End date field
Field that is used for the end date of the 
roadmap item.

For example, Planned end date.
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Roadmap configuration form  (continued)

Field Description

Item name field
Field that is used for the name of the roadmap 
item.

For example, Short description.

Item owner field
Field that is used for the owner of the roadmap 
item.

For example, Assigned to.

Status
Field that is used for the status of the roadmap 
item.

Percent Complete
Field that is used to track the completion of 
the roadmap item.

This field value is used to visualize the 
progress of the roadmap item in the tracking 
mode.

Group by fields List of fields with which the roadmap items can 
be categorized into groups.

For example, the State  attribute can be used 
to categorize the items into groups of states 
such as Draft, Ready, Work in progress, and 
others.

Color by fields List of fields with which the roadmap items can 
be categorized by color.

For example, the Planning item type  attribute 
can be used to assign a unique color to each 
group of items belonging to a specific type.

Metric fields
List of fields used as the metrics for the 
roadmap items.

For example, Planned benefit  or Actual cost.

These values are displayed when you point 
the mouse cursor on the roadmap item.

Related topics

Customize the planning item display preferences for Prioritization and Roadmap

Scheduled Script Execution form

Scheduled Jobs are automated pieces of work that can be performed at a specific time or on a 
recurring schedule.
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Migrate Goal, Strategy, and Work item data to the Goal Framework and related 
Planning item tables

Use the Migrate Goal, Strategy, and Work item data to the Goal Framework and related 
Planning item tables  job to migrate the existing goals data to the Goal Framework  tables.

Scheduled Script Execution form

Parameter Description

migrateGoalData • Migrates all existing goal records from the Goal [goal] 
table to the Goal [sn_gf_goal] table. The sys_id remains 
the same. The corresponding target records will be 
created in the Target [sn_gf_goal_target] table.

• Creates the existing relationship between the goal and 
work items (Project, Demand, Program) in the Goal 
Relationship [sn_gf_goal_m2m_relationship] table 
with the first goal (from the order in the glide list) as the 
primary goal.

migrateStrategyData Migrates all existing strategy records from the Enterprise 
Strategy [enterprise_strategy], Business Unit Strategy 
[business_unit_strategy], and Strategic Objective 
[strategic_objective] tables to the Strategic Priority 
[sn_gf_strategy] table. The sys_id remains the same.

migratingGoalStrategyM2Mdata In Goal Framework, a goal can be mapped to only one 
strategy. If an existing goal has two strategies mapped to it, a 
clone of the goal will be created (one as a generic goal and 
another as a sub-goal) with the same strategy populated for 
both. And, for the sub-goal, the first goal will be set as the 
parent goal.

For example, consider a scenario where an existing goal 
(G1) is mapped to five strategies (S1, S2, S3, S4, and S5). 
Then, four clones of G1 will be created as sub-goals (G2, G3, 
G4, and G5) and the parent goal is populated as G1. For the 
parent goal (G1) and the sub-goals (G2, G3, G4, and G5), the 
Strategy  field is populated respectively (S1, S2, S3, S4, and 
S5).

Note: 
The name of the cloned sub-goal will be prefixed with 
Cloned SubGoal:, followed by the parent goal 
name.

migrateStrategyWorkItemRelData • Migrates the existing relationship of strategy and work 
items (Project, Demand, Program) to the Goal Relationship 
[sn_gf_goal_m2m_relationship] table.

• If a goal doesn't have an association between the 
strategy (as current strategy) and the work item in the 
Goal Relationship [sn_gf_goal_m2m_relationship] table, 
a dummy goal will be created with a strategy value of 
current strategy. And, a goal relationship is created 
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Scheduled Script Execution form  (continued)

Parameter Description

with the dummy goal and the work item in the Goal 
Relationship [sn_gf_goal_m2m_relationship] table.

Note: 
The name of the dummy goal will be prefixed with 
Goal:, followed by the strategy name.

Migrate goal relationships for assigned entities

Use the Migrate goal relationships for assigned entities  job to populate the fields, Assigned 
entity type  and Assigned entity  on the Goal form  based on the existing values in the legacy 
fields, Business Unit, Department, Company, Portfolio, and any customized entity field.

Scheduled Script Execution form

Parameter Description

Migrate goal 
relationships 
for assigned 
entities

(For Strategic Planning  users) Populates the fields, Assigned entity type  and 
Assigned entity  on the Goal form  based on the data in the Goal Relationship 
[sn_gf_goal_m2m_relationship] table if you've created an m2m relationship with 
lens entities other than Company, Business Unit, Department, and Portfolio.

If users had already created m2m relationship, they may use this script to move 
those relationships from the m2m table to the goals table to access and manage 
those goals in the respective portfolio plans.

If the goal has only one relationship with an assign entity table type, the Assign 
entity type  and Assign entity  fields are populated on the Goal [sn_gf_goal] 
table based on the Goal Relationship [sn_gf_goal_m2m_relationship] table.

If the goal has multiple relationships with an assign entity table type, number of 
relationships (n) cloned sub-goals will be created and the Assign entity type 
and Assign entity  fields are populated on the Goal [sn_gf_goal] table based on 
the data in the Goal Relationship [sn_gf_goal_m2m_relationship] table for each 
cloned sub-goal.

Scheduled Script Execution form to generate labor costs for planning items

Use the Scheduled Script Execution form to enable Generate Labor Costs and Generate Labor 
Costs For Epic scheduler jobs for your planning items.

Schedule Item form

Field Description

Name Name that identifies this scheduled job.

Active Option that indicates that scheduled job is active and should be executed at the 
specified date and time.

Run
Time interval to use for running the scheduled job:
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Schedule Item form  (continued)

Field Description

• Daily: Runs daily, at a designated time.

• Weekly: Runs on a weekly basis, at a designated time and day of the week.

• Monthly: Runs on a monthly basis, at a designated time and day of the month.

• Periodically: Runs on a designated repeating interval.

• Once: Runs for a single occurrence only.

• On Demand: Runs immediately on demand.

• Business Calendar: Entry Start: Runs on the starting entry dates for the 
business calendar that you select in the Business Calendar  field. A scheduled 
job runs for the starting date of each of the business entries that you defined for 
the business calendar.

For example, if the business calendar represents a fiscal year, and the starting 
date of each entry is a fiscal month, the scheduled job runs on the first day of 
each month.

• Business Calendar: Entry End: Runs for the ending date for the business 
calendar that you select in the Business Calendar  field. This selection runs in 
the same manner as Business Calendar: Entry Start, but for the end dates of 
the associated business calendar entries.

Note: 
When you select Business Calendar: Entry Start  or Business Calendar: 
Entry End, you can apply an offset factor to schedule the job to run before 
or after the time span of the selected business calendar. To learn more, 
see the Offset type  and Offset  fields.

To learn more about creating and using business calendars and defining 
business calendar entries, see Creating business calendars  and Define 
business calendar entries .

Time zone
Time zone to use with the Time  field entry when you specify the time at which the 
scheduled job should run. Select a time zone entry:

• -None-: Use the default time zone for the logged-in user who is creating the 
scheduled job.

For example, the scheduled job runs at 04:45 p.m. US/Pacific time if it is the 
user's assigned time zone, and you enter 16:45  into the Time  field.

• Use System Time Zone: Use the default system time zone that is specified for 
the instance in which it runs.

For example, the scheduled job runs at 10:15 p.m. London time if Europe/
London is the default system time zone for the instance, and you enter 22:15 
in the Time  field.

• Actual time zone.

For example, the scheduled job runs at 1:30 p.m. in the US Eastern time zone if 
you select US/Eastern, and enter 13:30  in the Time  field.
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Schedule Item form  (continued)

Field Description

Day
Day on which the scheduled job should run.

• If Run  is set to Weekly, select the day of the week. For example, select 
Wednesday.

• If Run  is set to Monthly, select the day of the month. For example, select 25 for 
the 25th day of the month.

This field appears only if you select Monthly  or Weekly  in the Run  field.

Repeat 
Interval Duration of the repeat interval for each scheduled job execution. Enter the 

duration in the number of days, hours, or minutes. For example:

• To run the scheduled job every four days, enter 04  in the Days  field.

• To run it every 26 hours, enter 26  in the Hours  field.

• If it should repeat at an interval of 13:30:25, enter 13  in the Hours  field, and 
then enter 30  and 25  in the two unlabeled fields after it.

These fields appear only if you select Periodically  in the Run  field.

Note: 
This setting does not account for Daylight Saving Time changes. For 
example, if you select a period of one day, the calculation adds 24 hours to 
the starting time of the job. If the start time is in a Daylight Saving Time (DST) 
period, the job runs with a one-hour offset when that time zone is not in DST.

Business 
Calendar Business calendar entry that you are using to determine the business calendar 

start or end date for the scheduled job. This field appears only if you select 
Business Entry: Start Date  or Business Entry: End Date  in the Time  field.

Offset Type
Type of time offset, if any, to apply to the business calendar that you selected for 
scheduling this job:

• Past: Apply an offset factor to schedule the job to run before the start of the 
time span of the selected business calendar.

• Future: Apply an offset factor to schedule the job to run after the end of the time 
span of the selected business calendar.

• --None--: Do not apply a time offset when scheduling this job.

Adding an offset factor enables you to schedule the job to run before, or after, the 
formal time span that is defined in the business calendar for the following use 
cases:

• Schedule a job at a certain time, outside of the time span for the selected 
business calendar.

• Arrange multiple jobs to run in sequence, around the time span of the selected 
business calendar.
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Schedule Item form  (continued)

Field Description

The Offset type  and Offset  fields appear only if you select Business Calendar: 
Entry Start  or Business Calendar: Entry End  in the Run  field.

Offset
Amount of time offset, expressed in days, hours, minutes, and seconds, to apply 
to the business calendar that you selected for scheduling this job. For example, 
if you want to schedule the job to start three days, 14 hours, 10 minutes, and 45 
seconds before the business calendar start date, do the following actions:

• Select Past  in the Offset type  field.

• Enter 3  in the Days  field.

• Enter 14, 10, and 45  in the Hours  field.

The Offset Days  and Hours  fields appear only if you select Business Calendar: 
Entry Start  or Business Calendar: Entry End  in the Run  field, and Past  or Future 
in the Offset type  field.

Time Time of day at which the scheduled job should run, expressed in hours, minutes, 
and seconds on a 24-hour clock. The selection that you make in the Time zone 
field determines the time zone for this entry.

Note: 
Time values are always saved in the ServiceNow AI Platform®  in UTC time 
and then translated into the proper time. This translation depends on the 
selected Time zone  and the entry in the Time  field.

This field appears only if you select Daily, Weekly, or Monthly  in the Run  field.

Starting Date and time of the first scheduled job generation. Select the calendar date and 
time. This field appears only if you select Periodically  in the Run  field.

Priority
Numerical priority for the scheduled job:

• Set essential jobs to a priority value below 100.

• Set nonessential jobs to a priority above 100.

• If 70 percent or more of all scheduled jobs are Overdue, any jobs that are 
marked with a value above 100 do not run.

Run as Name of the user who is creating and running the scheduled job. To assign the 
scheduled job to the system instead of the person creating the scheduled job, 
create a system or dummy user and add it to this field.

Conditional Option for enabling the running of the scheduled job if certain conditions are met 
in the associated script.

Condition Conditional script that determines if a scheduled job should run. The last 
expression of the script should evaluate to a Boolean (true/false) value. This text 
box appears only if you select Use conditions.

Starting Date and time of the first scheduled job generation. Select the calendar date and 
time. This field appears only if you select Periodically  in the Run  field.
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Strategic program form

Learn about the fields of the Strategic program form. Use this form to create or edit the details of 
a Strategic Program in Strategic Planning.

These fields are displayed on the full details page of the strategic program.

Strategic program form

Field Description

Name Brief description of the strategic program.

Description Detailed information of the strategic program.

You can refine strategic program description 
using the Refine records skill, if the Now Assist 
for SPM  application is installed.

State Current working state of the strategic program.

Initiative Initiative that this strategic program is 
associated to.

Owner User assigned to this strategic program.

Percent complete Percentage of work completed for this 
strategic program.

MoSCoW Priority of this strategic program based on its 
importance. The available options are:

• 1 - Must have

• 2 - Should have

• 3 - Could have

• 4 - Won’t have

Work notes Notes to capture the updates and discussions 
on the strategic program as the work 
progresses.

Details section of the Strategic program form

Field Description

Approved start date Approved start date for this strategic program.

Approved end date Approved end date for this strategic program.

Actual start date Actual date on which the work for this strategic 
program has started.

Actual end date Actual date on which the work for this strategic 
program is complete.

Priority Priority of this strategic program.

Business capabilities Business capabilities of this strategic program.

Business application Business application that this strategic 
program is related to.
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Details section of the Strategic program form  (continued)

Field Description

Other impacted business applications Business applications that this strategic 
program has an impact on.

Business case section of the Strategic program form

Field Description

Overview Business case overview of this strategic 
program.

Background Background for this strategic program.

Limitations Applicable limitations to this strategic 
program.

Approach Planned approach to work on this strategic 
program.

Benefits Business benefit from this strategic program.

Financials section of the Strategic program form
In this section, capture financial details for this item such as cost, CapEx, 
OpEx, benefit, ROI, and other estimates.

Field Description

Planned cost Planned cost to take up this strategic program.

Planned capEx Planned capital expenditure for this strategic 
program.

Planned opEx Planned operational expenditure for this 
strategic program.

Planned benefit Planned benefit from this strategic program.

Actual benefit Actual benefit achieved from this strategic 
program.

Actual cost Actual cost on this strategic program.

Actual capEx Actual value of capital expenditure for this 
strategic program.

Actual opEx Actual value of operational expenditure for this 
strategic program.

Planned ROI Planned return of investment for this strategic 
program.

Related topics

Create planning items from the roadmap view

Add planning items to Prioritization
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Table map form

Understand the fields of the table map form. This form is used to create a new custom table map 
for any record to integrate with Agile Development 2.0, SAFe, and PPM.

table map form

Field Description

Alignment Integration Specifies the Alignment integration type. The 
value is ServiceNow Internal  by default.

Execution table Table in Agile Development 2.0, SAFe, or 
PPM that needs to be mapped with a table 
in Strategic Planning. For example, Defect 
[rm_defect].

Alignment table Table in Strategic Planning  that needs to be 
mapped with a table in Agile Development 
2.0, SAFe, or PPM. For example, Milestone 
[sn_milestones_milestone].

Milestone table map This field is relevant only for Project 
[pm_project] table map. It is a reference 
to the new Milestone table map 
(sn_milestones_milestone) for integrating 
project milestones from Project Portfolio 
Management workspace to Strategic Planning. 
For all the other table maps, the milestone 
table map field is not available.

Execution table filter Filter condition to retrieve the relevant records 
from PPM, Agile Development 2.0, or SAFe. For 
example, Portfolio is HR or Active is True.​

Alignment table filter Filter condition to retrieve the relevant records 
from Strategic Planning.​

Active flag Ensures that the table map sync is active. This 
field is checked by default.

Sync attachments Ensures that the attachments are synced 
between the applications. This field is 
checked by default.

Target automation script for benefit plans

Use the predefined Benefit Plans script as a target source to automate the actual value of your 
targets from the benefit plans of relevant work items.

Use the following predefined benefit plans script to configure the target source for your targets. 
The script fetches the required data for monetary or non-monetary benefit plans and updates 
the actual value for the target. You can use this script as is or you can also modify it according to 
your requirement. You can also create context variables and configure them for this target source 
(Benefit Plans).

result = '';
var benefitPlans = new 
 GlideRecord(sn_gfa.GFAdvancedConstants.BENEFIT_PLAN_TABLE);
benefitPlans.addQuery('sys_id', 'IN', benefit_plan);
benefitPlans.query();
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var nonMonetaryBenefitSum = 0;
var monetaryBenefitSum = 0;
var hasMonetary = false;
var hasNonMonetary = false;
while (benefitPlans.next() && !(hasMonetary && hasNonMonetary)) 
 {
    if (!gs.nil(benefitPlans.getValue('currency'))) {
        monetaryBenefitSum += 
 parseInt(benefitPlans.getValue('actual_benefit'));
        hasMonetary = true;
    } else {
        nonMonetaryBenefitSum += 
 parseInt(benefitPlans.getValue('nm_actual_benefit'));
        hasNonMonetary = true;
    }
}
 
if (hasMonetary && hasNonMonetary)
    gs.addErrorMessage(gs.getMessage('The Benefit Plan list can 
 contain either monetary or non-monetary benefit plans.'));
else
    result = hasMonetary ? monetaryBenefitSum : 
 nonMonetaryBenefitSum;

Target Breakdown form

Use the Target Breakdown form to track and measure the progress of the target breakdown and 
its goal.

Target Breakdown form

Field Description

Breakdown 
period

Period of the target breakdown.

Parent 
breakdown

Year of the target breakdown.

Target Parent target of the target breakdown.

Status Status of the target breakdown. The status indicates whether the target 
breakdown is likely to be completed by the planned end date.

Breakdown Breakdown interval specified in the parent target.

Planned 
target

Target value for the target breakdown.

Actual Actual value for the target breakdown.

Remark Remark entered for business justification when updating the actuals.

Target form

Use the Target form to track and measure the progress of the goals.
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Note: 
For Operational Sustainability Workspace  and Strategic Planning  users, to view the other 
fields that aren't added to the default view or your custom form view on the form in the 
workspace, configure the default or custom form layout. For information on how to configure 
the form layout, see Configuring the form layout .

Target form

Field Description

Name Name of the target.

Goal Name of the associated goal. This field is auto-populated when creating a target 
from the Targets related list on the Goal form.

Description Brief description of the target.

You can refine target description using the Refine records skill, if the Now Assist 
for SPM  application is installed.

State State of the target. The state can be Draft, In progress, Approved, Complete, 
Pending, Achieved, Not Achieved, or Cancelled.

Status Status of the target. The status indicates whether the target breakdown is likely to 
be completed by the planned end date.

Progress Percentage of the target execution that is complete. The value is calculated 
automatically.

If the Type  field is set to Maximize, the progress value is calculated using the 
following formula:

Progress = (Actual value - Base value) / (Target 
 value - Base value) x 100

If the Type  field is set to Minimize, the progress value is calculated using the 
following formula.

Progress = (Base value - Actual value) / (Base value 
 - Target value) x 100

For more information on how the progress value is calculated when the weight 
scale is defined, see Progress value calculation.

Impact on 
goal

A numerical value that represents the importance of the target relative to 
the other targets of the goal. If there are any subgoals present, they are also 
considered for relative weights and consequent progress calculation. By default, 
the value is (1) Neutral.

The available options are:

• (0) No impact

• (1) Neutral

• (2) Moderate

• (3) High

• (4) Very high

• (5) Maximum

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

651

https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=configure-form-layout&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Target form  (continued)

Field Description

Note: 
This field is available only when the sn_gf.weighted_average_enabled 
system property is set to Yes.

Assigned 
entity type

Entity type to which the target is assigned. For example, Business Unit, 
Department, Company, or Portfolio.

Assigned 
entity

Entity to which the target is assigned.

Owner Owner of the target. By default, the name of the user creating the target is 
populated.

Contributors Users who contributes to the achievement of the target. By default, the 
contributors of the associated goal are populated.

Duration section of the Target form

Field Description

Start date Start date for the target. By default, the start 
date of the associated goal is populated.

End date End date for the target. By default, the end 
date of the associated goal is populated.

Metrics section of the Target form

Field Description

Unit of measure Measure type for the specified value. Usage 
of the measure such as cost, time, and rate. 
The available measure types are stored in 
the Units [sn_gf_units] table. Unit of measure 
defines the type of the target as qualitative or 
quantitative. The available unit of measures 
for the quantitative target are #, $, %, and 
Days. The available unit of measure for the 
qualitative target is Yes/No.

Type Target type that signifies the direction of 
achievement.

• Maximize: The direction of the progress is 
toward the target value from the base value 
where the base value must be less than the 
target value.

• Minimize: The direction of the progress is 
toward the target value from the base value 
where the target value must be less than the 
base value.

• Milestone: Fixed type. Only the qualitative 
target values are allowed (that are set in 
the Unit of measure  field for the target) 
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Metrics section of the Target form  (continued)

Field Description

to capture the achievement of the target. 
The Milestone  option is applicable only for 
qualitative targets.

The Type  field becomes read-only with the 
value populated as Milestone  for qualitative 
targets (when the Unit of measure  field is set 
to a qualitative target value).

Start value Start value of the target. The start value can 
also be considered as the present or current 
value.

This field becomes read-only when a value 
is entered in the Actual value  field. Clear the 
Actual value  field to update a value in the 
Base value  field.

This field is available when the Type  field is set 
to Maximize  or Minimize.

Final target value Final target value of the target. The target 
value should be aspirational and should 
challenge the teams.

This field is available when the Type  field is set 
to Maximize  or Minimize.

Baseline reference Past achievement of the target to provide 
reference for future performance. This value is 
only for reference purpose and not considered 
for target progress calculation.

Actuals to date Actual value of the target at a given time.

This field is available when the Type  field is set 
to Maximize  or Minimize.

Check-in frequency Option to specify breakdown intervals for 
the target and how frequently the owner or 
contributor should update the actual value 
of the target. Breaking down the target into 
smaller periods helps you set a target for 
smaller periods and focus on the specific 
breakdown targets. The available options 
are Daily, Weekly, Monthly, Quarterly, and 
Yearly. Target breakdowns are automatically 
created when you set this field to any of the 
available options other than None. For more 
details on target breakdowns, see Target 
breakdowns in Strategic Planning.
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Metrics section of the Target form  (continued)

Field Description

Note: 
The target breakdowns feature isn’t 
supported for qualitative targets.

Target value distribution Option to specify the target to be calculated 
cumulatively or non-cumulatively. The 
available options are Split equally across the 
time period (non-cumulative)  and Spread 
linearly across the time period (cumulative).

This field is available only when the Check-in 
frequency  field is set to any of the available 
options other than None.

Remark Remark entered by the user for business 
justification when updating the actuals.

Check-in due date Due date that the owner or contributor of the 
target must update the actual value of the 
target to.

Confidential Option to restrict the access for this target 
record to the specific users populated in the 
Allowed groups  and Allowed users  fields.

This field is available when the ESG 
Management  application is installed and the 
sn_grc.enable_record_confidentiality 
property is enabled. This field is applicable 
only when the Classification  field in the 
goal form of the target is populated as 
Environmental, Social, or Governance. 
The required role to configure this field is 
sn_esg.reader.

Note: 
Irrespective of the target record set to 
confidential or not, the target progress 
value rolls up to its goal for calculating 
the progress value of the goal.

Allowed groups User groups who can access the target record. 
This field is applicable only for the Operational 
Sustainability Workspace  users.

Even though a user group is populated 
in this field, the users can access the 
confidential record only if the user group has 
the sn_esg.reader role.

This field is available when the Confidential 
field is set to true.
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Metrics section of the Target form  (continued)

Field Description

Allowed users Users who can access the target record. This 
field is applicable only for the Operational 
Sustainability Workspace  users.

Even though a user name is populated in this 
field, the user can access the confidential 
record only if the user has the sn_esg.reader 
role.

This field is available when the Confidential 
field is set to true.

Target Automation section of the Target form

Field Description

Comments Detailed comments for the target to facilitate 
collaboration.

Activity section of the Target form

Field Description

Automate actual value Option to enable the target automation feature 
for the target.

Actual value source Target source table that the data is fetched 
from to auto-update the actual value of the 
target on the target's review due date.

This field is available when the Automate 
actual value  field is set to true.

Variables section of the Target form

This section appears based on the context variables available in the target source that is 
selected in the Actual value source  field.

When you select Actual value source as Benefit Plans (predefined target automation script for 
benefit plans), the Benefit Plan  field appears in this section, from which you can select the 
required benefit plans for automating the actual value of the target.

Note: 
You can use the Benefit Plans custom script only when PPM Standard (Project Portfolio 
Management) is installed. If you can't find the benefit plan that you want to select, you can 
find and select the same from Heisenberg UI by navigate to Enterprise Goal Management 
> Targets  and opening the Target form.

Target Source form

Use the Target Source form to create and configure a source for your targets so that the actual 
value of the target is auto-updated.
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Target Source form

Field Description

Name Name of the target source.

Active Option to activate this target source for use.

Type Type of target source. Available options:

• Assessment/Survey

• PA Indicator

• Custom script

Advanced Enables the Custom script  option for the target source type Assessment/
Survey  with the pre-defined script.

This field is available when the Type  field is set to Assessment/Survey.

Assessment 
metric type

Assessment metric type for the target source.

Tip: 
A context variable is automatically created for the target source if the field 
is populated with a metric type of Evaluation method = Assessment.

This field is available when the Type  field is set to Assessment/Survey.

Assessment 
metric 
category

Assessment metric category for the assessment metric type.

This field is available when the Type  field is set to Assessment/Survey.

Description Brief description of the target source.

PA Indicator PA Indicator for the target source.

This field is available when the Type  field is set to PA Indicator.

Breakdown Breakdown for the PA Indicator.

This field is available when the Type  field is set to PA Indicator.

Custom script Custom script to fetch the required data from any ServiceNow AI Platform  table 
for the target source.

This field is available when the Type  field is set to Custom. Or, when the Type 
field is set to Assessment/Survey  and the Advanced  field is set to true.

UX List Category form

Learn about the fields of the UX List Category form. Use this form to create additional categories 
for lists in the Lists menu of Strategic Planning  workspaces.

Field Description

Title Display name of the category in the 
workspace.
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Field Description

Application Application scope. Ensure that this is set to 
Portfolio Planning.

Order Order in which this category is displayed in 
the workspace.

Active Option to enable the display of this category in 
the workspace.

Description Brief description of the category.

Configuration
Configuration that the category is referencing.

By default, this field is set to APW List Menu 
Configuration.

Related topics

Customize Lists in Strategic Planning Workspace

UX List form

Learn about the fields of the UX List form. Use this form to create additional lists in the Lists menu 
of Strategic Planning  workspaces.

Field Description

Title Display name of the category in the 
workspace.

Application Application scope. Ensure that this is set to 
Portfolio Planning.

Order Order in which this category is displayed in 
the workspace.

Category Category that this list would be displayed 
under, in the workspace.

Active Option to enable the display of this category in 
the workspace.

Table Source table for the list.

Configuration
Configuration that the category is referencing.

By default, this field is set to APW List Menu 
Configuration.

Conditions Conditions to filter the records of the source 
table.

Fixed query Current fixed query conditions applied to the 
list.

Columns Columns of the table that must be displayed in 
the list in the workspace.
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Field Description

Group by column Attribute that would be used to group the list of 
records by.

View View to determine which columns are 
displayed in the list in the workspace. If you 
select a view, the Columns  field is disabled.

Related topics

Customize Lists in Strategic Planning Workspace

View rule form

Learn about the fields of the view rule form. Use this form to define workspace view rules for the 
form views of new planning item types in Strategic Planning.

New View Rule form

Field Description

Name A unique name to identify the rule for your 
planning item.

For example, new_pi_type-alignment-
planner.

Application
This field is automatically set to Portfolio 
Planning  based on your scope.

If this field shows a different value, then 
ensure that your ServiceNow  instance is in 
Portfolio Planning  scope.

Table Select the planning item table that you 
created.

View Select one of the following:

• APW Default

• Default

Related topics

Create workspace view rules for new planning item forms in Strategic Planning

Widget association form

Use these form fields to associate a widget with project table and view it on financials.

Widget association form

Field Description

Association 
ID

Record to associate to the widget. Use the lookup icon to identify and select 
tables.
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Widget association form  (continued)

Field Description

To access the relevant records, select Table [sys_db_objects]  from the Table 
name list and Investment  from the Document list.

Association 
table

Table to associate to the widget.

You must select Table [sys_db_objects] from the list.

Widget Unique name of the widget.

Order Position of the widget in relation to other widgets in the Financials  tab of the 
Project Workspace.

Widgets appear in numeric order with the smallest number listed first.

Display on 
card

Option to display the widget in the Financials  tab.

Include by 
default

Option to show the widget by default in the Financials  tab.

Widget New Record form

Use these form fields to create a new widget for your project administration.

Widget form

Field Description

Name Unique name for the widget.

Scripted Option for indicating the value on the widget is from a code script.

By default, this option is selected and is read-only.

Show 
Label

Option for displaying either the label or the color indicator.

If you clear the check box, the Color  field appears and you can set the color.

Active Option for indicating the status of the widget.

Only active widgets can be shown on the Financials  tab of the Project Workspace.

Parent 
widget

Widget that is the parent of the current widget.

The current widget displays in the Child widgets related list of the selected widget.

You can add a maximum of three child widgets for a parent widget.

Formatter 
required

Option for specifying whether a currency formatter is required for the widget.

Script
Code script that returns a requested metric value that is displayed on the widget.

In the script, use the context and filter objects. The context object contains all of 
the project financial fields, such as capex_costs, opex_costs, and budget_cost.
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Widget form  (continued)

Field Description

The following sample script returns the Estimate At Completion metric value of a 
project to appear on the widget.

var context = JSON.parse(context);
var filter = context.filters;
 
var now_GR = new GlideRecord('pm_project');
gr.addEncodedQuery(filter['pm_project']);
gr.query();
if(gr.next())
 gr.getValue('forecast_cost');
Collapse

Short 
description

Description of the widget.

Enterprise Agile Planning  in Strategic Planning
ServiceNow®  Enterprise Agile Planning  helps streamline communication and collaboration 
between teams, and drive coordination with diverse teams. Using an intuitive workspace, 
scale your Agile framework across the organization with flexible work and team structure 
configurations.

https://player.vimeo.com/video/1059081473?
h=9af475911c&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Enterprise Agile Planning  (EAP) is available when you install the Strategic Planning  application 
from ServiceNow Store  using the SPM  Pro license.

Get started

Explore

Learn about Enterprise 
Agile Planning features.

Configure

Set up Agile configurations, 
team levels, and work types.
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Use

Build a backlog, plan program increments, 
and evaluate progress of assigned work.

Reference

Get details about EAP components like 
roles, tables, properties, forms, and lists.

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum of ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Enterprise Agile Planning

Learn more about Enterprise Agile Planning  (EAP) and review the benefits it can provide for your 
organization.

Enterprise Agile Planning  benefits

Scrum leaders, product owners, portfolio managers, solution train engineers, and Agile release 
train engineers can enhance their Agile framework using the following EAP  features:

Benefit Feature

Manage backlog and prioritize work. Backlog

Create and plan activities such as creating PIs and Sprints, 
assigning work to teams, and scheduling this work into team-
level iterations.

Backlog

Manage dependencies across teams and Agile release trains 
(ARTs).

Planning Board

Track activities and visualize progress. Backlog

Collaborate real-time and asynchronously to discuss 
resolutions for blockers.

Backlog

Manage work and track progress efficiently for Kanban teams 
that don't operate in a regular cadence.

Backlog  and Planning Board 
for Kanban-type teams

Get a unified, end-to-end view of your entire work item 
hierarchy from strategic epics down to individual stories. This 
way, every team member can instantly see how their work 
connects to broader organizational work, without navigating 
multiple screens or running reports.

Work item hierarchy for EAP 
teams

Flexibly configure team and work hierarchies. Agile configurations in EAP
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Benefit Feature

Store and manage all kinds of documentation for Agile teams 
and their work items from a centralized location.

Collaborate using Docs in EAP

Gain insights into the page content by summarizing it or 
improve content quality by refining it using Now Assist.

Summarize and refine Docs 
content in EAP using Now 
Assist for SPM

Save time and reduce manual effort by automatically generate 
stories for work items using Now Assist.

Generate stories for epics and 
features using Now Assist for 
SPM

Define goals at the iteration level or the team level iterations 
so that teams are aligned with the business value and 
have greater visibility into the work they contribute toward 
organizational objectives.

Iteration goals and work item 
goals in EAP

Analyze team progress, performance, and keep track of 
key metrics using preconfigured dashboards with data 
visualizations.

EAP Dashboards

Configuring Enterprise Agile Planning

Activate a configuration, add teams to your Agile structure, and define your planning calendars 
so that your team can get started with Backlog management and PI planning in EAP.

Agile structure configuration

1. Agile configurations in EAP.

2. Create or update a configuration in EAP.

3. Define agile structure in EAP.

4. Activate an EAP configuration.

5. Update epic methodology for an EAP configuration

Planning calendar configuration

1. Create a planning calendar in EAP.

2. Override planning calendar in EAP.

3. Create calendar entries for iterations in EAP.

Backlog and Planning board configuration

• Configure display of other work item types in EAP Backlog and Planning board.

• Configure the display limit of iterations in EAP Backlog.

Hierarchy tab configuration

• Enable Hierarchy tab in EAP

• Modify display limit in Hierarchy tab of EAP
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Custom dashboard configuration

Configuring custom dashboards in EAP

Other configuration tasks

• Create a custom team type in EAP.

• Create a custom work item type in EAP

• Create or update form views for EAP work items

• Create or update list view for EAP work items

Agile configurations in EAP

Learn about the different SAFe  configurations available in Enterprise Agile Planning  (EAP) so that 
you can work with your admin to update the configuration according to your team's needs.

Default EAP  configurations

A configuration includes the team level structure and work item types. The following Agile 
configurations, with the relevant team level, work item type, and planning calendar mapping, are 
available by default:

• Full Configuration

• Essential Configuration

• Large Solution Configuration

• Portfolio Configuration

• Kanban Configuration

If you installed the Strategic Planning  demo data, Full Configuration  is activated for you. You can 
choose to activate a different configuration or define a new configuration.

For more information, see Activate an EAP configuration  or Create or update a configuration in 
EAP.
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Default team level and work item hierarchy

• The EAP  teams follow the hierarchy of Portfolio > Solution Train > Agile Release Train > Agile 
Team.

• The work item types follow the hierarchy of Epic > Capability > Feature > Story.

However, while setting up a new configuration or editing an existing configuration, you can 
assign any work item type to any team level. For example, a Feature can be mapped to the 
Solution Train level or a Story can be mapped to the ART level. Based on how teams in your 
organization choose to operate, you can flexibly define or update the EAP  configurations.

• All work items types used in EAP  extend from the EAP  Planning item 
[sn_align_core_eap_planning_item] table, which in turn extends from the Planning Item 
[sn_align_core_planning_item] table of Strategic Planning.

• The Story records are saved in the Story [rm_story] table.

You can also create a custom work item type. See Create a custom work item type in EAP.

Create or update a configuration in EAP

Define your own Agile configuration or update an existing configuration in Enterprise Agile 
Planning  (EAP).

Before you begin
Install Strategic Planning.

Set the Application Scope of your ServiceNow  instance to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Configuration.

3. Choose to create a configuration or update an existing one.
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◦ To create, select New configuration.

◦ To update, select Edit  from one of the available configurations.

4. On the form, fill in or update the fields.

New configuration form

Field Description

Configuration name Name to identify the configuration.

State State of the configuration. The default value 
for this field is Inactive.

Change it to Active  to make it available to 
use for your Agile teams in Enterprise Agile 
Planning.

Sync with Agile Development Select this option to sync iterations such 
as Planning Intervals and Sprints with Agile 
Development 2.0. For more information, 
see Integration between EAP and Agile 
Development 2.0.

If your team is of the Kanban type, you can 
leave this option unselected.

5. Select the work item types to be available within this configuration.
Only the work item types that you enable here are available for your Agile teams in the Backlog 
and Planning board.

6. Select the team levels that you want to have in your configuration.
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Based on the team levels that you enable here, you can add only those entities to your Agile 
structure. For example, if you didn’t enable Solution Train  team level in the configuration, you 
can’t add any solution trains to your Agile structure and you can’t plan work for any solution 
trains from the Backlog or Planning board.

7. Select the default work item type to be available at each team level and its planning calendar.

Scrum teams with a regular cadence

Planning calendars can be set only for Agile Release Trains (ARTs) and Agile 
Teams and the planning calendar types available by default are Planning Interval 
and Sprint. If you want a different calendar, create one. See Create a planning 
calendar in EAP.

Kanban teams

If your team operates in a Kanban style, which is a continuous workflow structure 
without any regular planning interval schedule, you can set the Planning calendar 
fields to None.

8. Select Save.

What to do next

• If you have updated the planning calendar selection for any active configuration that has 
teams associated with it, update the relevant dashboard configuration too. This action ensures 
that the metrics displayed for those teams are accurate. See Updating dashboards for planning 
calendar changes in EAP.

• Activate an EAP configuration
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Define agile structure in EAP

Add organizational entities and teams to an Enterprise Agile Planning  (EAP) configuration so that 
users can plan work for them in the EAP  Backlog and Planning Board.

Before you begin
Activate an EAP configuration.

Ensure that Application Scope  of your ServiceNow  instance is set to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

About this task

https://player.vimeo.com/video/1067467329?
h=d09d828790&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Based on your configuration, add entities such as Portfolios, Solutions Trains, ARTs, and Agile 
Teams to different team levels of the configuration.

Note: 
This task is explained using Full Configuration  as an example. Use these steps as 
guidance to add entities and teams to any other configuration in EAP.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Agile structure.

3. Add a Portfolio by selecting the + icon ( ) next to the configuration name.

a. On the SAFe Portfolio form, fill in details such as name, description and parent portfolio.

b. Select Submit.

c. Repeat the action to add as many portfolios as you need.

4. Repeat this action to add other entities to a Portfolio.

◦ To a portfolio, add Solution Trains.

◦ To a Solution Train, add Agile Release Trains (ART).

◦ To an ART, add Agile Teams.

The teams that you add as Agile Teams must be of the type Agile. If you need new teams or 
cannot find any existing teams, contact your admin. For more information, see Assignment 
groups in Agile Development 2.0.

Activate an EAP  configuration

Activate a new or existing configuration in Enterprise Agile Planning  (EAP) so that your users can 
start planning work for their teams.

Before you begin
Set the Application Scope of your ServiceNow  instance to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Configuration.
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3. Select Edit  from one of the available configurations.

4. On the configuration form, set the State  field to Active.

5. Select Save.

What to do next
Add teams to your configuration. See Define agile structure in EAP.

Update epic methodology for an EAP  configuration

Change the epic methodology of your Enterprise Agile Planning  configuration to SAFe or Scrum 
based on your Agile workflow.

Before you begin
Set the Application Scope of your ServiceNow  instance to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

About this task
By default, the epic methodology for an EAP  configuration is set to SAFe  and all epics created for 
this configuration are SAFe epics. Based on how your Agile teams prefer to work, you can change 
the epic methodology to Scrum or retain it as SAFe.

Note: 
The epic methodology for an EAP  configuration can be updated only if there are no work 
items associated with it.

Procedure

1. Navigate to All  > Strategic Planning  > Enterprise Agile Planning  > EAP Configurations.

2. From the list of Enterprise agile configurations, locate the one you want to change the 
methodology for.

3. Double-click the Epic methodology cell to change and update the value.
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If the Epic methodology column is not displayed in your ServiceNow  instance, personalize the 

column settings using the Update Personalized List icon ( ) from the list header.

Configure display of other work item types in EAP Backlog and Planning board

Enable viewing different work item types in the Backlog and Planning board pages for EAP teams 
such as Portfolio, Solution Train, Agile Release Train, or Agile Team.

Before you begin
Ensure that you set the Application Scope  in your instance to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

About this task
The Planning board for an EAP team shows only those work items that are enabled in its default 
configuration. For example, for a Solution Train with Full Configuration, the Backlog and Planning 
board show only Capabilities by default. If your product managers or team members want to 
switch between viewing other work item types such as Features, Epics, or Stories, you can 
enable it by updating the team-level configuration details.

This task provides guidance on updating the Planning work types  or Backlog work 
types  fields for your Agile teams in the Enterprise agile configuration details table 
[sn_apw_advanced_eap_configuration_detail].

Procedure

1. Navigate to All  > Enterprise Agile Planning  > EAP Configurations.

2. Select a configuration that you need to update the work item type selections for.

s

3. In the Enterprise agile configuration details related list, select the team level that you want to 
update.
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4. Update the work types in the following fields.

◦ Backlog work types  to enable viewing multiple work item types in the Backlog page.

◦ Planning work types  to enable viewing multiple work item types in the Planning board page.
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5. Select Update  to save your changes to the form.

6. Repeat steps 3-5 to enable multiple work types for other team levels.

Related topics

Manage team backlog in EAP

Perform PI planning in EAP

Configure the display limit of iterations in EAP  Backlog

Create a system property to modify the limit on the number of iterations displayed for an EAP 
Team in its Backlog in Enterprise Agile Planning  (EAP).

Before you begin
Ensure the application scope in your instance is set to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

About this task
By default, the number of iterations shown in the Backlog page for an EAP Team is 6. If your 
organization's processes require more iterations to be displayed in the Backlog, create a system 
property sn_apw_advanced.eap_backlog_iterations_limit  and update the 
display limit.

Procedure

1. Navigate to sys_properties.list.

2. Select New.

3. On the form, fill in the fields.

System property form

Field Description

Suffix sn_apw_advanced.eap_backlog_iterations_limit

Type Integer

Value Desired maximum number of iterations in the 
Backlog

For information on the other form fields, see the field description table in Add a system 
property .

4. Select Submit.

Enable Hierarchy tab in EAP

Run a fix script to enable the Hierarchy tab in the Enterprise Agile Planning  (EAP) workspace.

Before you begin
Ensure that Application Scope  of your ServiceNow  instance is set to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

About this task
By default, the Hierarchy tab is not enabled for use in the EAP  workspace.
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Running the fix script Populate parent level data for work item  creates a 
system propertysn_apw_advanced.enable_hierarchy_view  the value of the property 
is set to true. This action activates the Hierarchy tab and makes it available to all team members 
alongside the Backlog and Planning board tabs in the workspace.

Procedure

1. Navigate to System Definition  > Fix Scripts.

2. Search for Populate parent level data for work item  and open the record.

3. Select Run Fix Script.

4. From the Run Fix Script window, select Proceed.
The fix script creates the sn_apw_advanced.enable_hierarchy_view if it's not already present in 
your instance and sets its value to true.

What to do next
Verify that the value of the sn_apw_advanced.enable_hierarchy_view  property is set 
to true.

1. Navigate to sys_properties.list

2. Search for sn_apw_advanced.enable_hierarchy_view  and open the record.

3. Verify if the Value field is set to true.

Related topics

Work item hierarchy for EAP teams

Modify display limit in Hierarchy tab of EAP

Modify display limit in Hierarchy tab of EAP

Configure an initial load limit system property to control how many work items the Hierarchy tab 
displays at each portfolio level in the Enterprise Agile Planning  (EAP) workspace.

Before you begin
Ensure that Application Scope  of your ServiceNow  instance is set to Strategic Planning.

Role required: admin

About this task
By default, the Hierarchy tab loads the top 100 work items at each portfolio level, ordered by 
global rank. This limit applies across all levels such as Portfolio, Solution Train, Agile Release 
Train, and Agile Team. When a portfolio contains more than 100 top-level items, team members 
may not see all relevant work without manually applying filters.

Creating the sn_apw_advanced.eap_hierarchy_items_limit  system property 
overrides this default and lets you set a display limit that better matches your organization's 
portfolio size and performance requirements.

Procedure

1. Navigate to sys_properties.list.

2. Select New.

3. On the form, fill in the fields.
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System property form

Field Description

Name sn_apw_advanced.eap_hierarchy_items_limit

Application Strategic Planning. This value is automatically 
filed based on your instance's application 
scope.

Description A clear description on the purpose and 
functionality of the property.

Type Integer

Value Number of work items to be displayed in the 
Hierarchy tab of Enterprise Agile Planning.

Read roles User roles who can view this property.

Write roles User roles who can edit this property.

4. Select Submit.

Create a planning calendar in EAP

Create any additional planning calendars that you use in your organization, such as Release, so 
that you can plan and track work in the calendar of your choice.

Before you begin
Role required: sn_apw_advanced.eap_admin

About this task
Sprint and Planning Interval are the two planning calendars available by default. To create a 
different planning calendar, create one from the EAP  Settings menu.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Planning calendars.

3. Select New.

4. On the form, fill in the fields.

Enterprise agile calendar form

Field Description

Name Unique name for the calendar.

Label Label of how this calendar shows up in the 
EAP  application.

Plural label plural form of this calendar's label.

Iteration type Type that this calendar belongs to. Select one 
from Planning Interval  and Sprint.

Parent Parent calendar for this calendar.
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Field Description

For example, Planning Interval is the parent 
for Sprint.

Description A brief description of the calendar, its use 
case, and other details.

5. Select Save.

What to do next
Create entries for the newly created calendar. See Create calendar entries for iterations in EAP.

Override planning calendar in EAP

Flexibly change the planning calendar for your Agile Release Train (ART) or Agile Team by 
overriding the default calendar that is set during configuration of Enterprise Agile Planning.

Before you begin
Set the Application Scope of your ServiceNow  instance to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

About this task
The override calendar option EAP settings helps you change the planning calendar that your 
teams use in EAP. This way, teams can choose their own planning calendars.

The new calendar takes effect after end date of the current calendar. If you want the calendar to 
take effect sooner or later, you must add or remove iterations to the current calendar.

The new calendar is automatically applied to child teams. For example, if an ART's planning 
calendar is changed, all child EAP teams associated with this ART must follow the new planning 
calendar.

This change is applied to only those ARTs that you update.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Agile structure  and navigate to your ART.

3. From the Details tab of your ART, select a value for the Override planning calendar  field.
The planning calendar that you select here must have calendar entries so that iterations can 
be created for this team and its child teams.

4. Select Save.
The page shows the date from which the new calendar will override the existing calendar.

For example, in the screenshot shown here, the new calendar Planning Interval  is set to 
override an existing calendar on 2024-07-30. If you choose to go back to using your old 
calendar:

◦ Before 2024-07-30, clear the Override planning calendar  field.

◦ After 2024-07-30, set your old calendar as the value for the Override planning calendar 
field.

Once the new calendar comes into effect, the child teams will inherit it for all their future 
iterations. For Agile Teams, the Override planning calendar  field is read-only and can't be 
changed independently of its parent ART.
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Create calendar entries for iterations in EAP

Define timelines for planning calendars so that the teams can create their own iterations in the 
Backlog and Planning Board of Enterprise Agile Planning.

Before you begin
Role required: sn_apw_advanced.eap_admin

About this task
This task is explained using Planning Interval (PI) and Sprint as an example. These are the 
calendars available by default in the workspace and PI is set as the parent for Sprint.

By the end of this task, you define the timeline for a PI and its child Sprints. The EAP  teams can 
then create their own team-specific PIs and Sprints, within this defined timeline, in a naming 
convention of their choice.

Note: 
You can create PIs in a naming convention of your choice, but the Sprint names are 
predefined. After creating Sprints for the PI, you can manually update their names per your 
preference.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Planning calendars.

3. Select Planning Interval  to create entries for it.

4. Select New calendar entry.

5. On the form, fill in the name of the entry, and the start and end dates for the planning interval.
For example, you’re creating a PI for 01 January 2024 to 31 March 2024.

6. Create calendar entries for the Sprint calendar based on the PI start and end dates.

a. Select Create child entries on Sprint.

b. In the Number of child entries (Sprint)  field, enter the number of sprints you want to create 
for this PI.

c. In the Sprint length (days)  field, enter the number of days your Sprint is made of.
For the PI that spans from 01 January 2024 to 31 March 2024, you can create 6 Sprints with a 
length of 14 days each.
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7. Select Create.

Result
A PI and its child sprints are created with the timelines that you defined. The EAP teams can 
create their own PI and Sprint iterations with their own naming convention.

Example:
PI 1 is created for 2024-01-01 to 2024-03-31. Within this PI, child six Sprints are created, each 
with a length of 14 days.
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Under the Digital Banking portfolio, the teams create their own ARTs and Sprints as follows:

• Payment Analytics ART creates two PIs: Digi bank ST2 ART1 PI1  and Digi bank ST2 ART1 PI2.

• The Agile Teams PAT Team 1 and PAT Team 2 create sprints within these PIs:

◦ PAT Team 1 creates PAT 1 Sprint 1, PAT 1 Sprint 2, and so on.

◦ PAT Team 2 creates PAT 2 Sprint 1, PAT 2 Sprint 2, and so on.

The teams can use these PIs and Sprints to schedule their work.
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Create a custom team type in EAP

Create a custom team type to include in the Agile configurations for Enterprise Agile Planning.

Before you begin
Set the application scope in your instance to Portfolio Planning Core.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Select New.

3. On the form, fill in the fields.

For field information, see Team type form.

4. Optional:  Deselect the Create module  check box.

5. Select Submit.

Create a custom work item type in EAP

Create a custom work item type to include in the Agile configurations for Enterprise Agile 
Planning.

Before you begin
Set the application scope in your instance to Portfolio Planning Core.

Role required: sn_apw_advanced.eap_admin
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Procedure

1. Navigate to All  > System Definition  > Tables.

2. Select New.

3. On the form, fill in the fields.

For field information, see Work item type form.

4. Optional:  Deselect the Create module  check box.

5. Select Submit.

What to do next
For any new work item type tables, create relevant form views and list views. See Create or 
update form views for EAP work items  and Create or update list view for EAP work items.

Create or update form views for EAP  work items

Create or update form views for work item types so that the fields displayed in the Backlog and 
Planning board pages of Enterprise Agile Planning  suit your team requirements.

Before you begin
Set the application scope in your instance to Portfolio Planning Core.

Role required: sn_apw_advanced.eap_admin

About this task
Configuration for form views of work item tables determines the fields that are displayed in the 
workspace. For a work item type in EAP, the following are the necessary form views:

• EAP  Default: Determines the fields to be displayed in the Full details page.

• EAP  Preview: Determines the fields to be displayed in the side panel of the Backlog or 
Planning board.

• EAP  New: Determines the fields to be displayed when creating a work item from the Backlog or 
Planning board.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the list of tables by using EAP planning item  in the Extends table column.

3. Select a work item type that you created.

4. Select the Layout Form  related link.

5. Create form views or update them.

6. Select Save.

What to do next
Create or update list view for EAP work items.

Create or update list view for EAP  work items

Create or update EAP  List View for work item types so that the columns displayed in the Backlog 
page of Enterprise Agile Planning  suit your team requirements.
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Before you begin
Set the application scope in your instance to Portfolio Planning Core.

Role required: sn_apw_advanced.eap_admin

About this task
Configuration for EAP  List View determines the columns that are displayed for a work item on the 
Backlog page of the workspace.

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the list of tables by using EAP planning item  in the Extends table column.

3. Select a work item type that you created.

4. Select the Layout List  related link.

5. Create the EAP  List View or update its configuration.

6. Select Save.

Configuring custom dashboards in EAP

Associate a custom dashboard to your Enterprise Agile Planning  configurations to track and 
measure key metrics for your teams.

Dashboard configuration overview

Get visibility into metrics of your Agile teams such as progress, blockers, team performance 
trends, and others using dashboards. You can associate any of the default dashboards or create 
a dashboard with custom queries to view and track specific metrics for your Agile team.

EAP  provides the following dashboards for different default configurations:

Default dashboards for EAP configurations

Team level
Full 
Configuration

Essential 
Configuration

Large Solution 
Configuration

Portfolio 
Configuration

Kanban 
Configuration

Portfolio Portfolio Inline 
Dashboard

NA NA Portfolio Inline 
Dashboard

Kanban 
Portfolio 
Dashboard

Solution Train Solution 
Train Inline 
Dashboard

NA Solution 
Train Inline 
Dashboard

NA NA

Agile Release 
Train

ART Inline 
Dashboard

ART Inline 
Dashboard

NA NA NA

Agile Team • Agile Team 
Inline 
Dashboard

• Agile Team 
Technical 
Dashboard

• Agile Team 
Inline 
Dashboard

• Agile Team 
Technical 
Dashboard

• Agile Team 
Inline 
Dashboard

• Agile Team 
Technical 
Dashboard

• Agile Team 
Inline 
Dashboard

• Agile Team 
Technical 
Dashboard

Kanban Team 
Dashboard
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Default dashboards for EAP configurations  (continued)

Team level
Full 
Configuration

Essential 
Configuration

Large Solution 
Configuration

Portfolio 
Configuration

Kanban 
Configuration

• Agile Team 
Velocity 
Inline 
Dashboard

• Agile Team 
Velocity 
Inline 
Dashboard

• Agile Team 
Velocity 
Inline 
Dashboard

• Agile Team 
Velocity 
Inline 
Dashboard

For more information about availability of these default dashboards with different configurations, 
see EAP reports and dashboards.

Important: 
You can only copy and customize an Inline dashboard.

The following tasks require the admin or EAP  admin (sn_apw_advanced.eap_admin) role.

1. Create or update a configuration in EAP.

2. Create a dashboard in EAP.

3. Add a tag to the EAP dashboard.

4. Associate the EAP read-only role to the dashboard.

5. Add EAP dashboards to an Agile configuration.

6. (Optional) Create implementation of a Scripted Extension Point in EAP.

Create a dashboard in EAP

Create a dashboard to track key metrics for your custom Agile configuration by creating a 
dashboard or duplicating and editing a default EAP  dashboard.

Before you begin
Create or update a configuration in EAP

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to All  > Platform Analytics  > Dashboards.

2. Create a dashboard or modify one of the default dashboards for your Agile configuration.

◦ To create a dashboard, select Create new dashboard. For more information, see Create a 
dashboard with the in-line editor .

◦ To modify an existing dashboard, create a copy of it so that you can the widgets that you 
need. For more information, see Duplicate a Platform Analytics dashboard .

Note: 
The Duplicate  option is available only for an Inline dashboard.

3. Add visualizations and widgets.

For more information, see step 6 through 10 in Create a dashboard with the in-line editor .
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For information about the default indicators, see Enterprise Agile Planning Indicators.

4. Select Save.

What to do next
Add a tag to the EAP dashboard.

Add a tag to the EAP  dashboard

Add the EAP  dashboards tag to identify your dashboard. The dashboards with tag appear in the 
reference qualified definition list, which helps you to add the dashboard to your configuration 
detail.

Before you begin
Create a dashboard in EAP.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to par_dashboard.list.

2. Add the Tags column to your view using the Update Personalized List  option.

3. For the dashboard you want to add a tag to, enter EAP Dashboards  in the Tags column.
The tag is added to the dashboard.

What to do next
Associate the EAP read-only role to the dashboard.

Associate the EAP  read-only role to the dashboard

Associate the EAP  read-only (sn_apw_advanced.eap_read_only) role to the dashboard. The 
users with this role can view and edit the dashboard for the teams in their Agile configuration.
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Before you begin

• Add a tag to the EAP dashboard.

• Set the Application Scope of your ServiceNow  instance to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to the PAR Dashboard Permissions [par_dashboard_permission] table.

2. Locate the dashboard that you created.

3. Double-click a cell in the Role column and then enter sn_apw_advanced.eap_read_only.

4. Select Save.
The role is associated with the dashboard.

What to do next
Add EAP dashboards to an Agile configuration.

Add EAP  dashboards to an Agile configuration

Add dashboards to your Agile configuration so that product managers or scrum team members 
can access them from the Home tab of their Agile teams in Enterprise Agile Planning  workspace.

Before you begin

• Associate the EAP read-only role to the dashboard.

• Set the Application Scope of your ServiceNow  instance to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

About this task
You can add single or multiple dashboards to your Agile configuration. If you are using a default 
configuration, a default dashboard is automatically associated with your Agile configuration. 
However, when you create a custom configuration, you must associate a dashboard with the 
configuration to view the metrics from selected data sources.

Procedure

1. Navigate to sn_apw_advanced_eap_configuration_detail.list.

2. Using the column options, group the records by Enterprise agile configuration.

3. For your Agile configuration, select an Agile Team to view its details.

4. From the Home dashboards  field, add the dashboards that your team needs.

5. Select Update.
The selected dashboard or dashboards are added to the Home  tab of the selected 
configuration.

Create implementation of a Scripted Extension Point in EAP

Update the default Scripted Extension Point or create a scripted extension point using the default 
one as a template to filter the data displayed on the EAP  dashboard.

Before you begin
Associate the EAP read-only role to the dashboard.
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Role required: sn_apw_advanced.eap_admin

About this task
The Scripted Extension Points  enable you to create a custom query to filter the information 
from different data sources. By default, each EAP configuration is associated with an extension 
point. Each extension point handles all the team types associated with it. You must create an 
implementation of the scripted extension point every time you create a new EAP configuration.

Important: 
Perform this task only for a custom configuration or if you want to customize a default 
dashboard. This task is not required if you are using any of the default configurations.

Procedure

1. Navigate to All  > Scripted Extension Points.

2. Search for and open the EAPDashboardsEncodedQueryProvider 
(sn_apw_advanced.EAPDashboardsEncodedQueryProvider)  scripted extension 
point.

3. Select the Create implementation  related link to create an implementation of this scripted 
extension point.
The new implementation record form is shown.

4. Update the Name  field of the newly created Implementation to a custom name of your choice.
Ensure that you don't include any spaces in the name. For example, rename the 
implementation to MyConfigEAPDashboardsEncodedQueryProvider.

5. Select Update.

6. Open the EAPDashboardsEncodedQueryProvider 
(sn_apw_advanced.EAPDashboardsEncodedQueryProvider)  scripted extension 
point.

7. From the Implementations related list, click the Class of your newly created implementation 
record to open it.

8. Update the Script  field to include the following.

◦ In the getConfigId  function, enter the sys_id of your EAP configuration.

◦ In the fetchEncodedQueries  function, enter queries to filter the information for each 
level of your EAP configuration such as iteration ID, team type, and team ID.

The following is an example script for the default Large Solution Configuration.

fetchEncodedQueries: function(teamType, teamId, iterationId) 
 {
        switch (teamType) {
            case "sn_apw_advanced_agile_team":
                return {
                    rm_story: `iteration=${iterationId}`,
                    sn_apw_advanced_eap_iteration: 
 `sys_id=${iterationId}`,
                    sn_gf_goal_m2m_relationship: 
 `table_name=sn_apw_advanced_eap_iteration^entity_id=${iterat
ionId}`,
                    sn_apw_advanced_eap_iteration_db_view: 
 `iter_eap_team=${teamId}`
                };
            case "sn_apw_advanced_agile_release_train":
                return {
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                    sn_align_core_feature: 
 `iteration=${iterationId}`,
                    sn_apw_advanced_eap_iteration: 
 `sys_id=${iterationId}`,
                    sn_gf_goal_m2m_relationship: 
 `table_name=sn_apw_advanced_eap_iteration^entity_id=${iterat
ionId}`,
                    sn_apw_advanced_eap_iteration_db_view: 
 `iter_parent=${iterationId}`
                };
            case "sn_apw_advanced_solution_train":
                return {
                    sn_apw_advanced_eap_iteration: 
 `eap_team.parent=${teamId}`,
                    sn_align_core_capability: 
 `eap_team=${teamId}^OReap_team.parent=${teamId}`
                };
            default:
                return {
                    sn_align_core_eap_planning_item: 
 `iteration=${iterationId}`,
                };
        }
    },
 
    getConfigId: function() {
        return "e4e11e0977243110740fefc0aa5a99f9";
    },
 

9. Update.

Result
The next time you reload the Home tab for your EAP teams, the dashboard shows the filtered 
data according to the updates you made to the implementation.

Updating dashboards for planning calendar changes in EAP

Update the EAP  dashboard configuration whenever there are changes to the planning calendar 
for any currently active configurations in Enterprise Agile Planning.

When your product managers update the planning calendars for an EAP  configuration with active 
teams and work items, the reports on the Home tab for those teams are affected. As an admin, 
you must update the corresponding dashboards for this EAP  configuration. This action ensures 
that the reports and metrics your teams see are accurate.

For example, the Agile Team's Planning Calendar value is updated from Sprint  to None  for a 
Full Configuration. Then, the Home tab should no longer display sprint-related reports such as 
Burnup or Burndown charts, Sprint velocity, and others.
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To ensure this change, you must configure new dashboards according to the latest planning 
calendar and replace the existing Agile Team dashboards of the Full Configuration with the new 
ones.

This procedure involves a series of tasks as listed here:

1. For the latest planning calendar, create a dashboard or duplicate the existing dashboard and 
add the reports that your teams want to have. See Create a dashboard in EAP.

2. Add a tag to the EAP dashboard.

3. Associate the EAP read-only role to the dashboard.
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4. Add the newly created dashboard to the EAP  configuration that has the planning calendar 
change. See Add EAP dashboards to an Agile configuration.

5. (Optional) Create implementation of a Scripted Extension Point in EAP.

Migrating from SAFe  to EAP

Learn about the process required For a successful migration of data from Scaled Agile 
Framework  applications to Enterprise Agile Planning.

https://vimeo.com/showcase/11420435/embed

Guided Setup to migrate data from SAFe  to EAP

Guided Setup provides a sequence of tasks to help you complete the required tasks on your 
ServiceNow  instances. Navigate to All  > Strategic Planning  > Enterprise Agile Planning  > SAFe 
Migration Guided Setup.

The following tasks are included in the guided setup.

SAFe to EAP migration tasks

1. Verify EAP configuration for migration from SAFe.

Based on your existing SAFe  configuration, verify that the right EAP  configuration is activated 
in your instance and ensure that the right work types (Epic, Feature, and Story) are allowed for 
this configuration.

For example, if you are a user of ServiceNow  Essential SAFe  application, you must activate 
the Essential Configuration in EAP  and ensure that EAP Epic and Feature are allowed as work 
types.

2. Verify table, field, and choice mapping between SAFe and EAP.

Verify that the tables, columns, choice fields, and custom tables of your SAFe  application are 
correctly mapped to those in EAP.

Note: 
By default, all columns of SAFe  Story [sn_safe_story] and SAFe  Scrum Task 
[sn_safe_scrum_task] tables are migrated to the Story [rm_story] and Scrum Task 
[rm_scrum_task] tables. To include or exclude any columns, see Modify columns to 
migrate from SAFe story and SAFe Scrum task tables to EAP.

3. Start migration of SAFe data to EAP.

4. Add Agile Team  as the type for existing SAFe  groups. See Add Agile Team type to SAFe groups 
for EAP migration.

5. Assign the EAP roles sn_apw_advanced.eap_read_only, sn_apw_advanced.eap_user, and 
sn_apw_advanced.eap_admin to your SAFe groups or to individual users in your teams.

See Assign a role to a group  or Assign a role to a user .

Verify EAP configuration for migration from SAFe

Ensure that the right EAP configuration which suits your current SAFe configuration is active and 
that the required work types are selected.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

687

https://vimeo.com/showcase/11420435/embed
https://www.servicenow.com/docs/access?context=t_AssignRoleToGroup&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_AssignRoleToGroup&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_AssignRoleToGroup&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_AssignARoleToAUser&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_AssignARoleToAUser&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_AssignARoleToAUser&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Before you begin
Check the SAFe  application (Essential SAFe  or Portfolio SAFe) that is currently in use in your 
ServiceNow  instance.

Role required: sn_apw_advanced.eap_admin

About this task

https://player.vimeo.com/video/1049452534?
h=ee0299eb63&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to All  > Strategic Planning  > Enterprise Agile Planning  > EAP Configurations.

2. Activate the EAP configuration that you need and verify that the required work types are 
allowed.

a. Open the EAP configuration record.

b. Enable the Active  field.

▪ For Essential SAFe: Activate Essential Configuration.

▪ For Portfolio SAFe: Activate Portfolio Configuration.

c. In the Work types allowed  field, ensure that Epic, Feature, and Story  are added to the 
Selected list.

3. Save the form.

What to do next
Verify table, field, and choice mapping between SAFe and EAP.

Verify table, field, and choice mapping between SAFe  and EAP

Before starting the migration from SAFe, verify that the default mapping of tables, fields, and 
column choices between Scaled Agile Framework  applications and Enterprise Agile Planning  is 
according to your requirements.

Before you begin
Verify EAP configuration for migration from SAFe.

Role required: sn_apw_advanced.eap_admin

About this task

https://player.vimeo.com/video/1023012765?
h=9fdc807e46&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to sn_apw_advanced_safe_eap_mig_setup.list.

2. Select the SAFe to EAP migration  record.

3. From the Table Maps related list, verify the table mapping between SAFe  and EAP.

4. Open each table mapping record to verify its field mapping.

For example, open the sn_safe_epic  record to see how the fields of SAFe epic are mapped to 
EAP epic.
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If you need to change a field mapping, open its record and update the fields.

5. From the Field Maps related list, open a choice column record to verify the choice mapping of 
the fields between SAFe and EAP.

For example, in the sn_safe_epic  table map, open the status  field map record to see how the 
choices for the Status  field are mapped between SAFe and EAP.

If you need to change a field mapping, open its record and update the fields.

What to do next

• For SAFe  Story [sn_safe_story] and SAFe  Scrum Task [sn_safe_scrum_task] 
tables, all default columns are migrated to the Story [rm_story] and Scrum 
Task [rm_scrum_task] tables. To include or exclude any columns, update the 
sn_apw_advanced.SAFeEAPStoryTaskMigrationAPI  script include. See Modify 
columns to migrate from SAFe story and SAFe Scrum task tables to EAP.

• Start migration of SAFe data to EAP.

Modify columns to migrate from SAFe story and SAFe Scrum task tables to EAP

For the SAFe Story and SAFe Scrum task tables, ensure that only the data from the necessary 
columns is migrated to Enterprise Agile Planning. By updating a Script Include, include or 
exclude any columns according to your requirements.

Before you begin
Verify table, field, and choice mapping between SAFe and EAP.

Role required: sn_apw_advanced.eap_admin

About this task

https://player.vimeo.com/video/1020716174?
h=3cf2011632&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to All  > System Definition  > Script Includes.

2. Search for and open the sn_apw_advanced.SAFeEAPStoryTaskMigrationAPI  script include.

3. Follow the comments in the Script  field to include or exclude any columns of the SAFe Story 
and SAFe Scrum Task tables.

4. Save the form.

What to do next
Start migration of SAFe data to EAP.

Start migration of SAFe  data to EAP

Submit a SAFe-EAP  migration request and start the migration of data between the tables of 
Scaled Agile Framework  and Enterprise Agile Planning.

Before you begin
Role required: sn_apw_advanced.eap_admin

About this task

https://player.vimeo.com/video/1049439810?
h=256249f11c&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479
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Procedure

1. Navigate to All  > Strategic Planning  > Enterprise Agile Planning  > SAFe Migration requests.

2. Select New.

3. On the form, fill in the fields.

For field information, see SAFe-EAP migration request form.

Note: 

◦ Planning intervals, formerly known as program increments, can only be migrated one 
time per team. Planning intervals falling before the selected date in the migration 
request and those created after the migration is complete, cannot be migrated through 
the automated migration (Guided Setup).

For example, submit migration requests in the sequence of PI 1 > PI 2 > PI 3 and so on.

◦ If the composition of a SAFe ART has been changed any time after it is created, it is 
suggested to migrate only those PIs that have the current composition of the ART.

◦ For a Portfolio SAFe migration, if a SAFe Epic is associated with SAFe Features but 
is not linked to any Portfolio, then this Epic will not be migrated by the automated 
migration.

◦ Migration can be run multiple times for the same criteria. In such case, any newly 
created records will be migrated to EAP.

◦ If changes are made to already migrated SAFe records, these changes will not be 
synched with the EAP records.

4. Select Submit.

Important: 
Submitting the request does not trigger the migration. Open the submitted recorded from 
the SAFe Migration requests list and select Start migration.

Result
Monitor the progress of data migration:

• If the migration is successful, the Import Requests related list shows the details of the data 
migration such as failed count, insert count, and total count of records moved from SAFe to 
EAP.

• If the migration encounters any error, the Migration Errors related list shows the details of 
records that failed to migrate from SAFe to EAP.

What to do next
Add Agile Team type to SAFe groups for EAP migration.

Add Agile Team type to SAFe  groups for EAP  migration

Add Agile Team  in the Type  field of existing SAFe groups to so that these teams are visible for 
your EAP users in the workspace.

Before you begin
Role required: sn_apw_advanced.eap_admin

About this task

https://player.vimeo.com/video/1062964725?
h=f69cc5c0e8&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479
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Procedure

1. Navigate to All  > Scaled Agile Framework  > SAFe Teams.

2. Open a SAFe team record.

3. From the Additional actions menu, change the form view to Default view.

4. If the Type  field is not visible, configure the form layout of the Default view to include it.
For information on configuring the form layout, see Show or hide fields on a form .

5. Add the value of Agile Team  to the Type  field.

6. Repeat steps 3 through 6 for all SAFe teams that are to be migrated to EAP.

Using Enterprise Agile Planning

Manage your team backlog, plan for sprints and iterations, add dependencies, and collaborate 
using team-level and work item level Docs using Enterprise Agile Planning  in the Strategic 
Planning Workspace.

Use the following areas of Enterprise Agile Planning  to plan, track, and collaborate on work 
across your agile structure.

Manage team backlog

Create, update, and prioritize work items from the Backlog page. Schedule work into 
Planning Intervals (PIs) or Sprints, make inline edits, and track progress at every 
level of your agile structure, from Agile Teams up through ARTs, Solution Trains, and 
Portfolios.

Perform PI planning

Plan work across multiple teams and iterations using the Planning board. Visualize 
and create dependencies between work items, track capacity, and reschedule work 
to respond to changing priorities during Big Room Planning events.

View work item hierarchy

Get a unified view of your entire work item hierarchy from high-level epics down 
to individual stories using the Hierarchy tab. Understand how team-level work 
contributes to broader organizational objectives without switching between multiple 
views or reports.

Collaborate using Docs

Store and manage documentation for Agile teams and planning items such as 
Epics, Capabilities, and Features from a centralized location. Use rich-text authoring, 
real-time collaboration, and Now Assist  to draft, refine, and share team knowledge 
alongside your work.

Track iteration and work item goals
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Define functional goals for PIs or sprints to keep teams aligned on what they plan to 
accomplish. Connect work items to portfolio-level or enterprise goals and OKRs to 
give teams greater visibility into the value their work delivers.

Manage team backlog in EAP

Using the Backlog page of Enterprise Agile Planning, create, update, and prioritize work items. 
Additionally, schedule work items into iterations such as Planning Intervals (PI) or Sprints.

The following sections provide a brief overview of EAP  Backlog and the actions that you can 
perform in it.

Layout and default grouping

The layout of Backlog across different team levels such as Agile Team, Agile Release Train (ART), 
Solution Train, or Portfolio, remains the same. The change is in the way that the work items 
are grouped. As you go bottom to top in an Agile structure, the work assigned to the teams is 
grouped as follows:

Important: 
The team hierarchy and the iterations within teams are based on your EAP  configuration. 
The following information applies to the default Full Configuration.

• Agile Team: Grouped by Sprints.

• ART: Grouped by Planning Intervals.

• Solution Train: Grouped by child ARTs.

• Portfolio: Grouped by child Solution Trains.

Any work item that doesn't fall into any of these groups is displayed in the Backlog section.

By default, the number of iterations that the Backlog page displays is set to 6. You can work with 
your admin to modify this number using a system property. For more information, see Configure 
the display limit of iterations in EAP Backlog.
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Layout and default grouping for Kanban teams

The Backlog for teams using the Kanban configuration is grouped as follows:

• Portfolio: Assigned work items are grouped by child teams. Any work item that is not assigned 
to the child teams is displayed in the Backlog section.

• Team: Assigned work is displayed in a list.

Default work items

The work items shown in Backlog are of the Type that is mapped for this team in the 
configuration. As you move up in your Agile structure, the level of the work assigned also 
increases. At an Agile Team level, you see information of stories. As you move up through ARTs 
and Portfolios, you see information of Features, Capabilities, and Epics. However, at any level, 
you can change the type of the work items displayed.

For example, in the screenshot, Capability  is the default item type mapped to Compliance and 
onboarding tech  Solution Train based on its configuration. You can change this selection to 
see work of other types assigned to this team. When this selection is changed to Feature, you 
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can see all the features assigned to this ART. Similarly, you can choose to create and assign a 
different type of work item for this Solution Train, even though its default item type is Capability.

View the details of any work item in the side panel by selecting its primary column. To access all 
the fields and related lists of the work item, select Full details  from the side panel.

Note: 
The Backlog page for an EAP team shows only those work items that are enabled in 
its default configuration. For example, for an ART with Full Configuration, the Backlog 
might show only Features by default. If you want to view other work item types such 
as Capabilities, Epics, or Stories, work with your admin to update the required EAP 
configuration details. For more information, see Configure display of other work item types 
in EAP Backlog and Planning board.

Column-level filtering of data

Quickly find the work items that you need by using column-level filters for the data on your EAP 

Backlog. Using the Column filtering option ( ), you can filter data on any column displayed on 
the Backlog  tab, which is of the type choice, string, or reference.

Actions within the Backlog

Within the Backlog, you can perform the following actions:

• Create iterations such as PIs or Sprints for your teams.

• Add work to the team's Backlog.

• Schedule work from Backlog into different iterations.

• Make in-line edits to update information of work such as Status, Assigned to, or Story points.

• Reorder planning items (in a section) to prioritize them.

However, reordering is not possible when the planning items are grouped. For example you 
grouped the items in the Backlog section by State, you won't be able to reorder the items 
unless the grouping is removed.

• Start and complete those iterations.

• Move incomplete work to the Backlog.

• Filter the data that's displayed.

• Choose the columns to be displayed.

• Open a work item in a new tab.
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Use the following tasks to start creating and scheduling work for teams in EAP.

Create next PI and Sprint from EAP  Backlog

Create iterations of Planning Intervals (PI) and Sprints so that teams can start prioritizing and 
scheduling their work from the Backlog in Enterprise Agile Planning  (EAP).

Before you begin
Role required: sn_apw_advanced.eap_user

About this task
From the Backlog, create the next iteration for Agile Release Trains (ARTs) and Teams. Based 
on your EAP  configuration of teams and planning calendars, you can create PIs, Sprints, or the 
iteration of any other calendar that you created.

This task is explained using the default Full Configuration as an example, where ARTs are 
mapped to Planning Intervals and Agile Teams are mapped to Sprints.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your ART.

3. Create Planning Intervals for ART.

a. From the Backlog tab of a selected ART, select Create next Planning Interval.

b. In the confirmation dialog box, select Create.

A PI is created for the selected ART. The start and end dates are based on the next available 
business calendar span that was created by your system admin.

The default name for the PI is <calendar name> <n+1>  where:

◦ calendar name  is the name of the business calendar entries that your system admin has 
created.

◦ n  is the number of the last created PI.

For example, if the name of your business calendar entry is set as Greenbacks PI  and 
Greenbacks PI 1 and Greenbacks PI 2 exist already, then the new PI is named Greenbacks 
PI 3.

After the PI is created, you can edit this name according to your naming convention. See 
Update iteration details in EAP.

For more information on how a system admin can define the calendar entries and their dates, 
see Create calendar entries for iterations in EAP.

Note: 
If you have Agile Teams added to this ART, Sprints are automatically created for them too. 
The number of Sprints created for the teams are based on the child calendar spans that 
match with the PI dates. If you add Agile Teams to this ART later, Sprints aren’t added to 
them automatically. In that case, proceed to step 4.

4. Create Sprints for Agile Teams.

a. From the left navigation panel, select an Agile Team.

b. From the Backlog tab of this team, select Create next Sprint.

c. Confirm by selecting Create.
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The default name and dates for this Sprint are according to the business calendar entry 
defined by the system admin.

After the Sprint is created, you can edit this name according to your naming convention. See 
Update iteration details in EAP.

What to do next

• Update iteration details in EAP.

• Schedule work items into iterations in EAP Backlog.

Update iteration details in EAP

Edit details of a PI or a Sprint to update details such as name, team capacity, committed points.

Before you begin
Create next PI and Sprint from EAP Backlog.

Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. From the Backlog tab of an ART or an Agile Team, select the name of the iteration to open its 
details in the side panel.

4. From the side panel, edit details such as Name, Capacity, Committed points and others.

5. Save changes by selecting Save.
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Related topics

Schedule work items into iterations in EAP Backlog

Create work items for teams in EAP  Backlog

Create stories, features, epics, or capabilities for teams to add work to their backlog in Enterprise 
Agile Planning.

Before you begin
Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. From the page header, select New <work item type>.

The item type that you see on the screen depends on the configuration for your EAP team. 
Alternatively, you can choose a different item type from the More options menu.

4. On the form, fill in the fields.

The fields that you see on the form vary based on the type of work item that you selected.

5. Select Submit.

Result
The new work item is added to one of the sections of the page, based on the values that you fill in 
on the form.

You can open the work item from the success message to add more information.

What to do next

• Refine the description with Now Assist. See Improve efficiency and quality using refine records 
skill with Now Assist Context Menu.

This feature requires activating the Write planning item skill of Now Assist for SPM. For more 
information, see .

• Schedule work items into iterations in EAP Backlog.

Breakdown work from parent work item into child items in EAP

Streamline breaking down work by creating child work items directly from the parent record page 
in Enterprise Agile Planning  workspace.

Before you begin
Role required: sn_apw_advanced.eap_user

About this task

https://player.vimeo.com/video/1079893987?
h=7eb7c4b082&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

From the full details page of a work item, you can create all types of associated child work items. 
For example, based on the EAP  configuration, the full details page of an Epic shows separate 
tabs for its child work items (Capabilities, Features, or Stories) and the full details page of a 
Capability shows separate tabs for Features and Stories.
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Use the New  button in each of these related tabs to breakdown work from the parent work item 
record.

Note: 
Views for all default EAP configurations include child item-specific related lists to enable 
work breakdown. For any new or custom configuration, work with your EAP admin to include 
these related lists in the EAP views for your configuration.

This task provides guidance to create child items directly from the parent work item record page, 
taking the example of creating a Capability record as the child item for an Epic.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. From the Backlog or Planning board, open the work item that you want to create the child items 
for and select Full details.

4. Select the related tab in which you want to create a child item.
Any child items that are already associated are shown in the tabs. The Digital Onboarding Epic 
already has 6 Capabilities, 1 Feature, and 2 Stories associated to it.

5. Select New  to create a child item.
For example, to add a new Capability to the Digital Onboarding Epic, select New  from the 
Capabilities tab.
An empty form to fill out the details of the child item opens. The Parent work item field is 
automatically set to the parent record, which is in this case Digital Onboarding.

6. Fill in the details for the child work item and select Save.
The full details page of the newly created child work item is opened.

7. Navigate back to the parent work item record page using the breadcrumb navigation.

What to do next

• Refine the description with Now Assist. See Improve efficiency and quality using refine records 
skill with Now Assist Context Menu.

This feature requires activating the Write planning item skill of Now Assist for SPM. For more 
information, see .

• Schedule work items into iterations in EAP Backlog.

Create stories for work items in EAP

Create stories directly from a work item's form. Create them manually or save time by generating 
them using Now Assist  in the Enterprise Agile Planning  (EAP) workspace.

Before you begin
Role required: sn_apw_advanced.eap_user

About this task
This task details the procedure of creating stories for work items such as Epic, Capability, and 
Feature and uses the example of creating stories for an Epic. To create other child work items, 
see Breakdown work from parent work item into child items in EAP.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your EAP  team.
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

698



3. From the Backlog or Planning board pages, select a work item for which you want to create 
stories.
In this example, an epic is selected and its details are displayed in the side panel.

4. From the side panel, select Full details.

5. From the work item details page, create stories manually or with Now Assist.
The newly created stories are listed in the Stories tab of the work item details page.

6. You can open a story to update further details or delete them.
From the full details page of a story, you can perform the following actions:

◦ Refine the description with Now Assist. See Improve efficiency and quality using refine 
records skill with Now Assist Context Menu.

This feature requires activating the Write planning item skill of Now Assist for SPM. For more 
information, see .

◦ Update other fields of the story.

◦ Add dependencies or scrum tasks to the story.
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◦ Add any files as attachments to the story.

◦ Delete the story by selecting Delete  from the More Actions menu on the header.

Generate acceptance criteria for stories using Now Assist for Strategic Portfolio Management 
(SPM)

Create clear, comprehensive, and testable acceptance criteria for user stories without writing 
them manually in Enterprise Agile Planning  (EAP). Review and refine suggested options to 
ensure they meet your requirements.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

For more information, see Configure Now Assist Admin features.

Role required: sn_apw_advanced.eap_user

About this task
For an EAP story, you can generate acceptance criteria by selecting Generate acceptance 
criteria  from the story header or using the Now Assist context menu in the Acceptance criteria 
field.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Navigate to your story using one of the following options from the left navigation menu:

◦ Enterprise Agile Planning: Select a team from the Agile structure and navigate to your story.

◦ Lists: Select Planning items  > Stories  and navigate to your story.
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3. Ensure that the story record is open in the Full details page.

4. Generate acceptance criteria for the story using one of the following options:

◦ From the story form header: Select Generate acceptance criteria.

◦ From the Acceptance criteria field:

a. Place your mouse cursor in the field.

b. Select the Refine with Now Assist  menu ( ).

c. Select Generate acceptance criteria.

5. Review the generated acceptance criteria.

6. You can choose to further refine the generated content using the Now Assist context menu 

( ) or generate a new criteria.

7. Save the Story form.

Create a copy of work items in EAP  Backlog

For creating work items with details similar to an existing item, save time and effort by creating a 
copy of the existing item.

Before you begin
Create work items for teams in EAP Backlog.

Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. From the Backlog page, locate the item that you want to create a copy of.
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4. Select the more icon ( ) and select Create copy.

Alternatively, you can right-click the work item to view the options.

Result
A copy of the selected work item is created, with the information in the required fields copied 
over. This new work item is added to the same section as the original. For example, if you created 
a copy of a Story from the Backlog section, then the copied story is added to the Backlog section.

What to do next
From the full details page of the work item, you can refine the description with Now Assist. 
See Improve efficiency and quality using refine records skill with Now Assist Context Menu. 
This feature requires activating the Write planning item skill of Now Assist for SPM. For more 
information, see Configure Now Assist Admin features .

Related topics

Manage team backlog in EAP

Schedule work items into iterations in EAP Backlog

Schedule work items into iterations in EAP  Backlog

Perform backlog grooming and schedule work from the team's backlog for the upcoming iteration 
Enterprise Agile Planning.

Before you begin

• Create next PI and Sprint from EAP Backlog.

• Create work items for teams in EAP Backlog.

Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. Move an item from the Backlog section to an iteration.

a. From the Backlog section, locate the item that you want to schedule into an iteration.
During backlog grooming sessions, you can estimate story points and add them in-line to 
this work item.

b. Select the more icon ( ) and choose to move the story to any existing iteration.
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Alternatively, you can right-click the work item to view these options.

4. Move an item across iterations.

a. From the iterations, locate the item that you want to reschedule.

b. Select the more icon ( ) and choose the iteration that you want to reschedule into or move 
the item to the backlog.

Alternatively, you can right-click the work item to view these options.

5. Repeat the process to complete scheduling work for the next iteration for the team.

What to do next

• Plan work for an ART in EAP.

• Start or complete iterations in EAP.

• Analyze team performance and progress using dashboards.
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Start or complete iterations in EAP

Start an iteration of a Sprint or PI so that your team can start working and tracking progress of 
work, and after your team finishes the assigned work, mark this iteration as complete, directly 
from the Backlog in Enterprise Agile Planning.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. Complete an iteration.

a. From the Backlog page, locate the iteration that you want to complete and select Complete 
<iteration>.

▪ For a Sprint, the option is displayed as Complete Sprint.

▪ For a PI, the option is displayed as Complete Planning Interval.

Note: 
Before marking a Planning Interval as Complete, all its associated child Sprints must be 
complete.

b. Depending on the amount of work that's left incomplete for the current iteration, confirm its 
completion.
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▪ If there are incomplete work items in the current iteration, you're asked to move the 
incomplete items to the Backlog or any future iteration.

▪ If all assigned work is complete, then the iteration is automatically marked complete 
without any confirmation from you.

Note: 
When you complete any iteration, it is no longer displayed in the Backlog page, and 
all the work items which are completed in that iteration are no longer available to view 
from the Backlog page either.

4. Start an iteration.

a. From the Backlog page, locate the iteration that you want to start and select Start 
<iteration>.

▪ For a Sprint, the option is displayed as Start Sprint.

▪ For a PI, the option is displayed as Start Planning Interval.

Add or remove teams from Favorites in EAP

Add the EAP  teams that you frequently work with to Favorites so that you can save time 
navigating to them in the workspace without searching for them.

Before you begin
Define agile structure in EAP.

Role required: sn_apw_advanced.eap_user
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. Add a team to Favorites.

a. From the left navigation panel, locate the team that you want to favorite.

b. Select the Add to favorites icon ( ) next to the team name.

The team is added to the Favorites section of the navigation panel.

3. Remove a team from Favorites.

a. From the Favorites section, locate the team that you want to remove.

b. Select the Remove from favorites icon ( ) next to the team name.

The team is removed from the Favorites section.
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Personalize and filter data in EAP  Backlog

View the information that is most relevant to you and your team on the Backlog tab by choosing 
the columns to be displayed and applying filters to narrow down the data on the page.

Before you begin
Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. Add or remove columns and change their order of display on the Backlog page.

a. Select Edit columns  ( ).

b. From the Available columns section, select the columns that you want to be displayed on the 
Backlog.

c. From the Selected columns section, Remove the columns that you don’t want on the 
Backlog.

d. From the selected columns section, rearrange the columns to change the order of their 
display on the Backlog.

e. Select Apply.

4. Apply filters to work items to narrow down the data that's displayed on the Backlog.

a. Select Filter  ( ).

b. Add conditions to filter the work items.
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You can add multiple conditions. These conditions apply to the Type  of work item that is 
displayed in the Backlog page.

c. Optional:  Select Save filter  so that you need not recreate the same conditions to apply 
them to a different set of data.

d. Select Apply.

5. For an ART, you can personalize the grouping of the work items by Planning Interval or Team.

Perform PI planning in EAP

Using the Planning board of Enterprise Agile Planning, plan work for multiple teams across 
iterations (for example, Big Room Planning). Track the progress of work, create and visualize 
dependencies between work items, and reschedule work to react quickly to changes while 
confirming alignment with business priorities.

Layout of Planning board

Planning Board for an Agile Release Train (ART)

Based on the EAP  configuration, the layout of the Planning board across different team levels 
such as Agile Team, ART, Solution Train, or Portfolio is:
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• ART, Solution Train, and Portfolio: Two-dimensional Kanban board layout with differences in the 
horizontal and vertical lanes.

• Agile Team: Simple Kanban board with work item States as the vertical lanes.

The work items are represented as cards. You can choose to display cards in the compact or 
full size. Full size cards have data points on them such as item Number, State, and indicators for 
enabler, dependencies, or blocked whereas compact cards display just the short description.

Default grouping of work items

As you go bottom to top in an Agile structure, the cards are grouped as follows for each team:

Important: 
The team hierarchy and the iterations within teams are based on your EAP  configuration. 
The following information applies to the default Full Configuration.

• Agile Team: For an iteration, vertical lanes represent the State of the story.

For example, if Sprint is the planning calendar configured for an Agile Team, the cards on the 
Planning Board represent the work assigned for the selected Sprint. For an Agile Team, you 
can see Stories on the planning board.

• ART: For an iteration, the Story cards are horizontally grouped by child teams and vertical lanes 
represent the iterations of the child teams.

If Planning Interval (PI) is the planning calendar configured for ART, the vertical lanes represent 
the Sprints within the selected PI.

• Solution Train: Horizontally grouped by child ARTs and vertical lanes represent the state of the 
item.

• Portfolio: Horizontally grouped by child Solution Trains and vertical lanes represent the state of 
the item.

• If the Dependency  toggle is enabled, you can visualize the dependencies between work items.

• If the Capacity  toggle is enabled, you can visualize the work load of the teams.

The Planning board for an EAP team shows only those work items that are enabled in its default 
configuration. For example, for an ART with Full Configuration, the Planning board shows only 
Features by default. If your product managers or team members want to switch to viewing other 
work item types such as Capabilities, Epics, or Stories, work with your admin to update the 
required EAP configuration details. For more information, see Configure display of other work 
item types in EAP Backlog and Planning board.
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Tip: 
For an ART, if you switch from viewing Story to another work item type on the planning 
board for the first time after updating this configuration, you might not have your work item 
cards displayed. To resolve this, ensure that the Vertical lane selection in the Planning 
board personalization is not set to Enterprise agile iteration.

Layout and default grouping for Kanban teams

The Planning board for Kanban teams is grouped as follows:

• Portfolio: Assigned work items are displayed in a two-dimensional Kanban board, with the 
teams as the horizontal lanes and state of the assigned work as the vertical lanes. Any work 
item that is not assigned to the child teams is displayed in the Portfolio section.

• Team: Assigned work is displayed in one-dimensional Kanban board.

As with Backlog, you can change the Type  of work items displayed and create work items of 
multiple types from the Planning board.

Use the following tasks to get started with PI Planning within Enterprise Agile Planning.

Plan work for an ART in EAP

Plan work across all teams in an ART for multiple Planning Intervals, coordinate with different 
teams to manage dependencies and resolve blockers in real-time using the Planning board in 
Enterprise Agile Planning.

Before you begin
Role required: sn_apw_advanced.eap_user

About this task
This task is explained using an Agile Release Train (ART) that has a Planning Interval (PI) as its 
calendar. This ART has child teams associated with it, which have Sprints defined for them.

On the board, move the story cards into different lanes or add new stories for the teams during 
planning meetings. Enable the Dependencies  toggle to view dependencies and blockers across 
work for the teams.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose an ART and select 
Planning Board.

◦ The planning board shows the current iteration for the ART by default. You can select a 
different iteration.

◦ Based on the scheduling of work done in the Backlog page, story cards are displayed in the 
Sprint lanes.

3. Enable the Dependencies  toggle to view dependencies between stories.
Based on how dependencies are created, the stories sometimes need rescheduling. For more 
information on story dependencies, see Create and manage dependencies between work 
items in EAP.

4. Enable the Capacity  toggle to view the workload of the teams for each Sprint.

The color of the capacity bar acts as a visual indicator of the workload:

◦ Red: Team is overloaded.

◦ Grey: Team is at 100% capacity.

◦ Blue: Team is at less that 100% capacity.

5. Collaborate with the teams on stories by clicking a card open in the side panel.
During the planning meetings, collaborate with multiple teams and update story information 
such as priority, story points, or blocked reason.

You can also upload files in the Attachments tab and add notes and @-mention team members 
in the Comments tab of the side panel.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

711



If you want to access additional information of the story such as scrum tasks, select Full 
details  from the side panel.

6. Reschedule a story into a different Sprint or reassign it to a different team by dragging the 
cards into the respective lanes.

What to do next
For the work that you assigned and scheduled, track the progress at different levels of your Agile 
structure using EAP dashboards. See EAP reports and dashboards.

Work item dependencies in EAP

Learn about work item dependencies and how they're shown on the Planning board for a team in 
Enterprise Agile Planning.

Dependencies overview

While planning, it’s essential to know how your work items are connected with each other. 
Knowing dependencies between work items enables identification of challenges, coordination 
for resolution, and an overall improvement in collaboration between teams. Unless you know 
the dependency for each item, you could be at risk of not scheduling the right work for the right 
iteration. To get started with dependencies in EAP, see Create and manage dependencies 
between work items in EAP.

Dependency line colors

On the Planning board in EAP, enable the Dependencies  toggle to view dependencies lines 
across teams. The color of the dependency line indicates how the stories are scheduled.

• Purple: The prerequisite story is scheduled in an earlier sprint than the dependent story. This 
dependency doesn't require any changes.

• Yellow: The prerequisite story is scheduled in the same sprint as the dependent story. In this 
case, rescheduling the stories might or might not be necessary.

• Red: The prerequisite story is scheduled in a later sprint than the dependent story. In this case, 
rescheduling stories is necessary.

Note: 
These colors are applicable to the Planning board of ARTs and Agile Teams because they 
typically involve a planning calendar.

• Dependencies on the Planning board of a Solution Train or Portfolio appear in purple and 
don’t indicate any scheduling conflicts.

• Dependencies on the Planning board of an Agile Team appear in Yellow because they're 
scheduled for the same Sprint.
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Dependency lines for an ART

Dependencies related lists for work items

Dependencies added to a work item are displayed in its Full details page. The dependent 
and prerequisite items are listed in the related lists of this work item. You can also add new 
dependencies from these related lists.

The name of these related lists varies between Epic, Capability, Feature, and Story. Based on 
the type of item that you're viewing, the lists could be named as Dependent items, Depends on, 
Prerequisite stories, and Dependent stories.

The following screenshot shows the dependencies related lists for a Story.

Related topics

Create and manage dependencies between work items in EAP
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Create and manage dependencies between work items in EAP

Draw work item dependencies in real-time across teams and iterations and visually analyze them 
while you collaborate using the Planning board in Enterprise Agile Planning.

Before you begin
Role required: sn_apw_advanced.eap_user

About this task
This task is explained using stories in an Agile Release Train (ART) as an example, which has 
Planning Interval (PI) as its calendar. The same guidance applies to creating, updating, and 
deleting dependencies for work items of an Agile Team, Solution Train, or Portfolio.

• A story that has a dependency on it by another story is called a prerequisite story.

• A story that is dependent on another story is called the dependent story.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your EAP  team.

3. Identify stories that have dependencies, and use the interactive functionality of the Planning 
board to draw dependency lines between them.

a. On the dependent story card, click the Add dependency line icon ( ).
A dotted dependency line appears.

b. Select the prerequisite story card to finish drawing the dependency line.

The dependencies are added to the work items on the board.

4. If the dependency line color is Yellow or Red, review it and reschedule stories as required.

5. Delete a dependency, to account for any change in the requirements.

a. Navigate to the full details page of a work item card that has a dependency to it.

b. From the Prerequisite Stories or the Dependent Stories related lists, locate the dependency 
that you want to remove.
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Note: 
The names of these related lists are different for Epic and Solution Train.

c. From the Sys class name column, select Story Dependencies.

d. From the dependency item header, select the More Actions icon ( ) and select Delete.

e. Select OK  to confirm deleting the dependency.

Personalize the EAP  Planning board

Choose metrics and indicators to be shown on cards so that key information is available at a 
glance on the Planning board in Enterprise Agile Planning  workspace.

Before you begin
Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, select your EAP  Team.

3. From the Planning board, select the Planning board personalize panel icon ( ).

4. From the Personalize side panel, update one or more of the following:

◦ Selections of vertical lane and horizontal lane grouping.

Note: 
When State  is selected as the vertical lane, the columns displayed on the Planning 
board are based on the Agile methodology (Scrum or SAFe) for the selected EAP team.

◦ Card size: Compact or Full.
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◦ Indicators and data points that you want displayed on the cards.
The selections are automatically applied to the cards. The following screenshot shows an ART 
planning board and its personalization options.

5. After making all the required selections, close the side panel.

Work item hierarchy for EAP  teams

View and manage the complete work item hierarchy across your portfolio configurations directly 
from the Hierarchy tab in the Enterprise Agile Planning  (EAP) workspace.

Agile teams may often struggle to understand how their day-to-day work rolls up to larger 
organizational work. A story that is assigned to a developer might support a feature that belongs 
to a capability, which ultimately delivers on a strategic epic. However, tracing that hierarchy 
typically requires navigating multiple screens or running reports.

The Hierarchy tab in Enterprise Agile Planning  (EAP) provides a unified view of work items 
across all levels of your portfolio structure, from high-level epics down to individual stories. This 
hierarchical display of work updates dynamically based on your selected portfolio configuration, 
giving team members immediate visibility into how their work contributes to broader objectives.
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Hierarchy tab of a Portfolio in Enterprise Agile Planning

When to use

The Hierarchy tab is valuable when you need to know the complete context of work items rather 
than viewing them in isolation. Consider using it in the following cases:

• Planning work and need to see what stories already exist under a feature before creating new 
ones.

• Reviewing progress at the portfolio level and to drill down into execution details.

• Onboarding team members who need to understand how their assigned work fits the bigger 
picture.

If you only need to track work items at a single level (for example, just stories for your sprint), the 
Backlog or Planning board views may be more efficient.

Benefits

For product owners

Quickly assess whether epics are broken down adequately, identify gaps in backlog 
refinement, and trace how customer requirements flow down through the hierarchy 
without switching between multiple views.

For scrum masters

Understand cross-team dependencies at a glance, facilitate conversations about 
work that spans multiple agile teams, and help team members see how their sprint 
commitments connect to release-level objectives.

For agile team members

Gain context for assigned work by seeing the parent feature and epic, get visibility 
into the business value behind technical tasks, and identify related stories that 
might affect their implementation approach.

Key capabilities

Multi-level hierarchy display
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View work items across four portfolio levels: Portfolio, Solution Train, Agile Release 
Train (ART), and Agile Team, with each level displaying its default work item type 
such as Epics, Capabilities, Features, and Stories based on the configuration.

Context-sensitive navigation

The hierarchy automatically adjusts based on your selected portfolio configuration. 
Selecting a Solution Train displays only the epics, capabilities, features, and stories 
relevant to that configuration.

On-demand expansion

Child work items load only when you expand a parent item. This approach keeps 
the interface responsive, as you only retrieve the data you need.

Interactive filters

Filter the hierarchy by work item type using the Filters option. Filtering enables you 
to focus on the work items that you need and are relevant for you.

Note: 
Your filter selections do not persist across sessions; you must reapply filters 
each time you access the hierarchy.

Personalized column display

Customize which columns appear in the hierarchy grid and adjust column widths 
to match your workflow. Your preferences persist across sessions, so you see your 
configured view each time you return. For more information, see Personalize column 
layout of Hierarchy in EAP.

Direct record access

Open any work item in a new browser tab using the context menu or by clicking the 
Name field hyperlink. This allows you to view or edit full record details without losing 
your place in the hierarchy.

Use cases

Release planning and dependency mapping

During Program Increment (PI) planning, release train engineers and product 
managers need to know how work flows across multiple agile teams. A common 
scenario: your organization is planning a major platform upgrade that requires 
coordinated changes across three agile teams.

Using the Hierarchy tab, the release manager can expand the epic to see all 
capabilities, then drill down to features assigned to each team. This visual mapping 
reveals which teams have dependencies on shared components, where hand-offs 
need to occur, and whether any critical path work lacks adequate story breakdown, 
all without leaving a single view or assembling data from multiple reports.

Impact assessment for scope changes

When stakeholders request changes to a feature mid-sprint, product owners need 
to quickly assess the downstream impact. For example, a customer escalation 
requires adding new acceptance criteria to a feature that is already in progress.

The product owner uses the Hierarchy tab to expand the affected feature and 
review all associated stories. They can immediately see which stories are in 
progress, which are complete, and which teams are involved. This visibility enables 
an informed conversation with stakeholders about the true cost of the change, 
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whether it affects one story or ripples across multiple teams, before committing to 
revised scope.

Considerations

Initial load limits

For optimal performance, the hierarchy initially loads only the top 100 work items at 
each level, ordered by global rank. If your portfolio contains more than 100 top-level 
work items, use filters to narrow your view to the relevant subset.

If you want to change this default number, work with your admin to create a 
sn_apw_advanced.eap_hierarchy_items_limit  system property. For 
more information, see Modify display limit in Hierarchy tab of EAP.

Enabling the Hierarchy view

The Hierarchy tab requires your admin to enable it through the 
sn_apw_advanced.enable_hierarchy_view  system property. See Enable 
Hierarchy tab in EAP.

Getting started

To access the Hierarchy tab, navigate to the EAP workspace and select your Agile team. The 
Hierarchy tab is available alongside the Backlog and Planning board tabs.

Personalize column layout of Hierarchy in EAP

Customize the column layout of the Hierarchy grid in the Enterprise Agile Planning  (EAP) 
workspace by selecting which columns to display, reordering them, or adjusting their widths.

Before you begin
Role required: sn_apw_advanced.eap_user

About this task
By default, the Hierarchy grid displays a standard set of columns that may not reflect the 
information most relevant to your role or workflow.

Column visibility, order, and width preferences are saved to your user profile and applied 
automatically each time you open the Hierarchy tab.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > EEnterprise 
Agile Planning.

2. From the Agile structure section of the left navigation panel, choose your team and open the 
Hierarchy  tab.

3. Select the Personalize icon ( ).
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4. Choose the columns to be displayed in the Hierarchy tab and rearrange their order per your 
preference.

5. Select Apply.

Related topics

Work item hierarchy for EAP teams

Collaborate using Docs in EAP

Store and manage all kinds of documentation for Agile teams and their planning items (Epics, 
Capabilities, and Features) from a centralized location of Enterprise Agile Planning  workspace.

https://player.vimeo.com/video/1029774226?
h=8e0cab6b63&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Docs overview

Product managers, team leads, and team members associated with EAP  teams can store and 
manage information at the Agile Structure level and work level (Epic, Capabilities, and Features).

• Each planning item or team in EAP  can have a separate doc to capture the information related 
to it.

For example, for an Epic, you create Docs for high-level business objectives or technical 
product requirements. Similarly at the team level, you can use Docs to capture the information 
related to team details, Scrum calls, iteration summaries, and so on.

• Each planning item or Agile Structure level can have multiple Docs associated with it and 
each Doc can have multiple pages to help you effectively organize key artifacts. Also, the Agile 
Structure can organize these pages into multiple documents.

• Predefined templates such as Iteration Retrospective, Marketing Plan, Meeting notes are 
available. Create pages for your Doc using one of these templates or start with an empty page. 
You can also create or modify the templates according to your requirements.
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Features of Docs

The following are the key features of Docs:

• Auto-save content.

• See who is viewing or working on a Doc using the feature of live user presence.

• Create documents using pre-defined templates. You can edit the templates to suit your team's 
requirements.

• Use rich text paragraph formatting, which includes headings, lists, alignment, and others.

• Move text blocks to change their placement using block-level editing.

• Tag team members inline or insert tables using the /  command.

• Add reference to other ServiceNow AI Platform  tables to connect work across teams.

• Insert images by uploading files or using web URLs.

Note: 
The experience of inserting Google  Images links might not work.

Dynamic data linking in Docs

Keep record information in your documentation always current and reduce manual effort with the 
Dynamic data linking feature in Docs. You can now reference any ServiceNow  application record 
and Docs will automatically reflect the latest updates from those records.

For example, if you add a reference to an Incident record, the reference will show the latest 
field information of the incident in Docs without requiring manual edits. Clicking the incident 
reference opens up the incident form so that you can view the full details of the incident and 
make any necessary changes.

A hover popover displays the details of the mentioned record, providing quick access to 
additional information without leaving the current context.

Dynamic linking also enables adding references to a particular field of a record, such as 
Assigned to of an Incident record.
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You can add references from any ServiceNow  table you have access to, with no setup or 
configuration needed.

This feature reduces the need to switch between multiple ServiceNow  applications within your 
instance and helps maintain a single, reliable source of truth for collaborative work, making it 
easier for teams to stay aligned and informed.

Draft content using Now Assist for SPM

Generate content with Now Assist for SPM  directly in your Docs using custom prompts. In 
addition, summarize existing sections, elaborate where needed, and refine drafts to help improve 
your productivity.

You can interact with Now Assist  directly in your Doc to create new content, add context, or 
improve existing sections. This helps you draft faster, refine ideas, and keep your work relevant 
without leaving the page.

Work with content of the whole page

Some examples are:

• For Marketing teams: Create a compelling product launch announcement 
highlighting the key benefits and emotional appeal for our target audience.

• For Legal teams: Write a plain-language summary of the privacy policy in this 
doc, that customers can easily understand.

• For product teams: Analyze the customer feedback comments in this Doc, group 
into top 5 themes, and suggest top 3 enhancements for highest impact.

Now Assist  uses the context from your Doc page to generate a response.

Refine, elaborate, or improve the existing content within the page

Some examples are:

• If you have a list of stakeholders, you can ask Elaborate on the scope of these 
roles.

• Rewrite this in a casual tone.
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Take assistance on a blank page

Some examples are:

1. Generate 5 icebreaker questions for a virtual team-building session.

2. Write a 3-paragraph blog post explaining why [industry trend] is changing how 
businesses operate.

3. Generate an outline for the Instagram campaign tasks for a Hackathon 
initiative.

Answer questions in the context of this Doc

Whether the content in the Doc is added manually or generated using Now Assist, 
you can ask questions to find anything in the page's context.

For example, if you have a project charter document, you can try asking What is the 
total budget of this project and which part is the most expensive?
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Real-time collaboration within EAP Docs

With the feature of real-time collaboration, edit a Doc page concurrently with 
multiple other editors. Colored cursors denote the current location of each editor 
on the page. You can choose to show or hide these live presence indicators 
based on your preference while working on or reviewing the content of the 

page.

Note: 
Application performance may degrade with a large number of concurrent editors.

Create a Doc in EAP

Store information related to your work, iterations, and teams, and collaborate in real-time using 
Docs in Enterprise Agile Planning  workspace.

Before you begin
Role required: sn_apw_advanced.eap_user
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About this task
Create a Doc at the team-level or planning item level.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. Navigate to a team or planning item that you would like to create a Doc for.

3. Select New  to create a new document for the team or planning item.

4. Provide the title for your document and select Create.

The Doc is created and an untitled blank page is opened for you to start capturing information. 
You can create multiple pages within the Doc.

What to do next
Manage pages and subpages within a Doc in EAP.

Summarize and refine Docs content in EAP  using Now Assist for SPM

Use Now Assist  capabilities to elaborate, shorten, and summarize selected content in Docs, or to 
get a summary of the whole document in Enterprise Agile Planning  (EAP).

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

• Create a Doc in EAP.

• Activate the EAP  doc summarization Now Assist  skill. See .

Role required: sn_apw_advanced.eap_user

If you have custom roles that require access to this skill, update the ACLs for those roles that 
require access. For more information, see Implement access control in Now Assist AI agents .

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. Navigate to your Doc.

3. From your Doc, open the page you want to summarize or refine.

4. Choose to summarize the selected text on the page or the whole page.

◦ To refine the selected text:

a. Select a single block or multiple blocks of content on the page.

b. Select Now Assist  and choose an option.
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i. Summarize  to summarize the selected text.

ii. Elaborate  to lengthen the selected text based on the existing context.

iii. Shorten  to make the selected text concise.

◦ To summarize the entire content on the page, select Now Assist  from the Doc header and 
select Summarize.

Tip: 
If there’s more content to summarize, you can remove some text and retry.

Now Assist  analyzes the text and generates an output in a separate pop-up.

5. Optional:  Based on the output generated, you can further refine the result or insert the 
generated content into the Doc.

(Optional)
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6. Optional:  Copy the generated output by selecting the Copy to clipboard icon ( ) to use it for 
purposes such as sending an email, saving to notes, and others.

Important: 
Because the output is AI-generated, review it to ensure accuracy.

Manage pages and subpages within a Doc in EAP

Flexibly organize information for your teams and work items by creating, duplicating, and deleting 
pages and subpages within a Doc in Enterprise Agile Planning  workspace.

Before you begin
Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. Navigate to your Doc.

3. To create a page, you can create a blank page or start with a predefined template.

◦ For a blank page, select Create page.

◦ To create from templates:

a. Select Create Page from template.

b. Select a template from the Template Center and select Create page.
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The new page is created and added to your Doc with the name Untitled, which you can 
rename.

4. To create a subpage, select the Page Actions  menu ( ) and select Create Subpage.

5. To delete a page or a subpage, select the Page Actions  menu ( ) and select Delete.

Iteration goals and work item goals in EAP

Within Enterprise Agile Planning, define PI-level or sprint level objectives or associate work items 
with enterprise goals.

Iteration goals

During planning interval (PI) or sprint planning, create functional goals for your team detailing 
what you plan to accomplish for the current iteration. Depending on your EAP  configuration 
and team structure, you can create goals at the planning interval level or sprint level from the 
Planning board tab of a team.

To learn how to create iteration goals in EAP, see Create iteration goals for a PI or sprint in EAP.

Work item goals

Establish a relationship between work items (Epic, Capability, Feature, or Story) with the portfolio-
level or enterprise-level goals and OKRs. When goals are added to work items, the teams working 
on these items have greater visibility into the value that their work would contribute to.
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Using the Primary goal  field of the work item details, goals can be added to work items 
individually.

Product managers, team leads, or team members can also view their work distribution with 
respect to goals associated in the Work item distribution  report of the dashboards.

Create iteration goals for a PI or sprint in EAP

Create iteration goals for your Agile teams to highlight the overall objectives to be accomplished 
for a planning interval or sprint.

Before you begin
Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the left navigation panel, choose an ART or an Agile team 
and select Planning Board.

◦ The Planning board shows the current iteration for the ART by default. You can select a 
different iteration.

◦ The Planning board shows the current sprint for the Agile team by default. You can select a 
different sprint.

3. Depending on the Agile team level that you are at, select Planning Interval goals  or Sprint 
goals.
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The Goals  tab displays existing goals for the PI or sprint.

4. Select New goal.

5. In the New iteration goal dialog box, enter the name and a description for the goal.

6. Select Save.

Result
The goal is created for the PI or sprint and is displayed in the Goals  tab.

What to do next
You can add details to your goal or add sub-goals to it by updating its fields. For information on 
the form fields for a goal, see Goal form.

Connecting EAP  with Collaborative Work Management

Enhance visibility and streamline planning for your Agile teams by connecting Enterprise Agile 
Planning  (EAP) with Collaborative Work Management  (CWM).

Overview of EAP-CWM  connection

The EAP-CWM integration enables organizations to connect strategic program planning with 
team-level execution in a single system, eliminating silos and improving delivery predictability.

Using EAP, program managers and release train engineers can define Program Increment (PI) 
objectives, align Epics, Features, and Stories, create sprints for teams, and manage cross-team 
dependencies. After completing a PI, they can conduct PI retrospectives and update roadmaps 
for the next cycle. These capabilities ensure that enterprise priorities are clearly structured and 
traceable across all levels.

By linking EAP  to CWM, product owners and team members can plan and execute sprints, 
manage agile stories alongside operational tasks such as incidents, track progress, and hold 
team-level retrospectives, all within the same workspace.

This connection between the applications reduces context switching and ensures that both 
planned and unplanned work is accounted for, without losing alignment to strategic goals. The 
result is end-to-end transparency where leadership can track progress against PI goals through 
EAP, while teams maintain flexibility to adapt to changing priorities.
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Workflow of EAP-CWM  integration

1. EAP admin connects an EAP  team to CWM. See Connect an EAP team with CWM.

2. A new Space and Board are created for this EAP  team in the CWM  workspace.

3. Existing work items assigned to this EAP  team are brought over to the newly created CWM 
Board through Connected Work filters.

4. Sprint planning view is enabled for this CWM  Board where the existing work items and sprints 
are automatically shown.

5. Check team's access to CWM and provide the CWM user [sn_cwm.cwm_user] to all team 
members.

6. EAP  team can start creating more work, manage current work, and update progress directly 
from the CWM  Board. See Sprint planning in CWM.

7. The team's progress and work status is reflected back on the Team dashboard in the EAP 
workspace. See EAP Agile Team dashboard

Creating or managing sprints for EAP  teams in CWM

For EAP  teams integrated with CWM, existing sprints and their scheduled work automatically 
sync to CWM. These details are displayed in the Sprint Planning view on the CWM  Board.

As the team progresses through assigned work, they can update the work status directly in the 
Sprints section. The sprint can be marked Complete  from this view and any incomplete work 
items can be moved either to the backlog or the next sprint, if it exists.

New sprints for the team must be created in EAP. After creating new sprints in EAP, they will sync 
to CWM, allowing the team to schedule work into these sprints from CWM.

Note: 
Sprints for EAP  teams are not created directly at the Agile team level. Sprints are created 
automatically when a Planning Interval (PI) is defined for the parent Agile Release Train 
(ART) in EAP  and sync to CWM  automatically.

Related topics

Collaborating with Spaces in CWM

Managing work using Boards in CWM
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Connected work in CWM

Sprint planning in CWM

EAP Agile Team dashboard

Connect an EAP  team with CWM

Establish a connection to CWM  by setting your EAP  team's Agile tool to Collaborative Work 
Management.

Before you begin
Ensure that Application Scope  of your ServiceNow  instance is set to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Agile structure.

3. Select an EAP team that you want to connect with CWM.

4. Set the Team agile tool  field to Collaborative Work Management.

5. Select Save.
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Result

• Collaborative Work Management is displayed underneath this team in EAP.

• A Space and Board are created for this team in Collaborative Work Management.

What to do next
Navigate to Workspaces  > Collaborative Work Management  to start managing this team's work. 
To learn more, see Managing work using Boards in CWM  and Sprint planning in CWM.

EAP  reports and dashboards

Use the EAP  dashboards to visualize metrics, identify blockers, and analyze performance trends 
for your Agile teams.

As a portfolio manager, product manager, team lead, or a team member, get insights into the 
team performance using the EAP  dashboard. EAP dashboards are available at each level of the 
Agile structure such as Portfolio, Solution Train, ART, or Team.
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You can use a default dashboard or you can configure a custom dashboard and associate it with 
your Agile configuration. For more information, see Configuring custom dashboards in EAP.

EAP  provides the following default Inline and Technical dashboards for different hierarchy levels 
based on your configuration.

Dashboard Available with

EAP Portfolio dashboard • Full Configuration

• Portfolio Configuration

EAP Solution Train dashboard • Full Configuration

• Large Solution Configuration

EAP ART dashboard • Full Configuration

• Portfolio Configuration

• Large Solution Configuration

• Essential Configuration

EAP Agile Team dashboard

The Agile Team dashboards consist of:

• Agile Team Inline Dashboard

• Agile Team Technical Dashboard

• Agile Team Velocity Inline Dashboard

• Full Configuration

• Portfolio Configuration

• Large Solution Configuration

• Essential Configuration

Kanban Portfolio Dashboard Kanban configuration

Kanban Team Dashboard Kanban configuration

EAP  Portfolio dashboard

The Portfolio dashboard provides a high-level view of all the active work items in your portfolio.
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You can use a default dashboard or you can configure a custom dashboard and associate it with 
your Agile configuration. For more information, see Configuring custom dashboards in EAP.

Required EAP  roles
The EAP  read-only (sn_apw_advanced.eap_read_only) role is required to view the dashboard.

Access the Portfolio  dashboard

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your EAP  Portfolio.

3. Select the Home  tab.

Use cases

User Dashboard use

• Portfolio manager

• Product manager

• Team lead

• Team member

View the active work items assigned to the 
teams in your portfolio and distribution of work 
items.

Reports

Title Type Source table Description

Epics by state Bar graph
sn_align_core_scrum_epic

Epics assigned to this 
Portfolio, grouped by 
their current state.

Work item distribution
Donut

sn_align_core_scrum_epicDistribution of work 
items for the selected 
attribute. You can 
group the data using 
one of the following 
options:

• Primary goal

• Primary goal > 
Category

• Strategic program

• Owner

• Department

Kanban Portfolio dashboard in EAP

The Kanban Portfolio dashboard in Enterprise Agile Planning  (EAP) provides progress metrics 
and work item status for your EAP  portfolios of the Kanban configuration.
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Required EAP  roles

sn_apw_advanced.eap_read_only or the sn_apw_advanced.eap_user.

Access the Kanban Portfolio dashboard

To open the dashboard:

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your Kanban EAP  Portfolio.

3. Select the Home  tab.

Use cases

For examples of how different people in your organization would use this dashboard, see these 
use cases.

User Dashboard use

• Portfolio manager

• Product manager

• Team lead

• Team member

View the active work items assigned to the 
teams in your portfolio and the distribution of 
work items.

Reports

Title Type Source table Description

Epics by state Bar graph
sn_align_core_scrum_epic

Epics assigned to 
this Kanban portfolio, 
grouped by their 
current state.
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Title Type Source table Description

Work item distribution
Donut

sn_align_core_scrum_epicDistribution of work 
items for the selected 
attribute. You can 
group the data using 
one of the following 
options:

• Primary goal

• Primary goal > 
Category

• Strategic program

• Owner

• Department

EAP  Solution Train dashboard

The Solution Train dashboard provides a snapshot of teams' work assignment status such as 
capabilities, work items, and team performance.

You can use a default dashboard or you can configure a custom dashboard and associate it with 
your Agile configuration. For more information, see Configuring custom dashboards in EAP.

Required EAP  roles

The EAP  read-only (sn_apw_advanced.eap_read_only) role is required to view the dashboard.
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Access the Solution Train  dashboard

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your EAP  Solution Train.

3. Select the Home  tab.

Use cases

User Dashboard use

• Portfolio Manager

• Product Manager

• Team Lead

• Team Member

View the state of capabilities assigned to the 
teams in your Solution Train, distribution of 
work items, and team performance.

Reports and data visualizations

Title Type Source table Description

Capabilities by state Bar graph
sn_align_core_capability

Capabilities assigned 
to this Solution Train, 
grouped by their 
current state.

Work item distribution
Donut

sn_align_core_capabilityDistribution of work 
items for the selected 
attribute. You can 
group the data using 
one of the following 
options:

• Primary goal

• Primary goal > 
Category

• Strategic program

• Owner

• Department

Team performance
List

sn_apw_advanced_eap_iteration
Evaluate child teams 
progress and help 
them enhance their 
performance.

You can choose 
and rearrange the 
columns of the report 
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Title Type Source table Description

by selecting the 
icon.

EAP  ART dashboard

The ART dashboard provides a snapshot of the overall progress of your Planning Interval (PI).

You can use a default dashboard or you can configure a custom dashboard and associate it with 
your Agile configuration. For more information, see Configuring custom dashboards in EAP.

Required EAP  roles

The EAP  read-only (sn_apw_advanced.eap_read_only) role is required to view the dashboard.

Access the ART  dashboard

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your EAP  ART.

3. Select the Home  tab.

Use cases

User Dashboard use

• Portfolio Manager

• Product Manager
View the progress and status of your Planning 
Interval's goals, features, overall progress, and 
team performance.
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User Dashboard use

• Team Lead

• Team Member

Reports and data visualizations

Title Type Source table Description

PI progress Gauge
sn_apw_advanced_eap_iteration

Percentage of points 
completed out of the 
total scope for this 
Planning Interval.

Total features Single Score
sn_align_core_feature

The total number of 
features scheduled for 
this Planning Interval.

Blocked features Single Score
sn_align_core_feature

Number of features 
scheduled for this PI 
that are blocked.

Total story points Single Score
sn_align_core_feature

Total story points 
for all the features 
scheduled for this 
Planning Interval.

Features missing 
estimates

Single Score
sn_align_core_feature

Number of features, 
scheduled for this 
iteration, that have 
child stories without 
estimates.
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Title Type Source table Description

Features by state Bar graph
sn_align_core_feature

Features scheduled 
for this PI, grouped by 
their current state.

Work item distribution Donut
sn_align_core_feature

Distribution of work 
items for the selected 
attribute. You can 
group the data using 
one of the following 
options:

• Primary goal

• Primary goal > 
Category

• Strategic program

• Owner

• Department

What does the team 
plan to achieve in this 
iteration?

List
sn_gf_goal

Status and progress 
of your Planning 
Interval's goals.

Team performance List
sn_apw_advanced_eap_iteration

Evaluate child teams 
progress and help 
them enhance their 
performance.

You can choose 
and rearrange the 
columns of the report 

by selecting the 
icon.

EAP  Agile Team dashboard

The Agile Team dashboard provides you with sprint progress and team performance details for 
an Agile team in the Enterprise Agile Planning  (EAP) workspace.
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You can use a default dashboard or you can configure a custom dashboard and associate it with 
your Agile configuration. For more information, see Configuring custom dashboards in EAP.

Required EAP  roles

The EAP  read-only (sn_apw_advanced.eap_read_only) role is required to view the dashboard.

Access the Agile Team  dashboard

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your EAP  team.

3. Select the Home  tab.

Use cases

User Dashboard use

• Portfolio manager

• Product manager

• Team lead

• Team member

View the progress and status of your sprint 
goals, stories, overall progress, and team 
performance.

Reports

Title Type Source table Description

Sprint progress Gauge
sn_apw_advanced_eap_iteration

Percentage of points 
completed out of the 
total scope for this 
sprint.

Total stories Single Score
rm_story

Number of stories that 
are scheduled for this 
sprint.

Blocked stories Single Score
rm_story

Number of stories that 
are blocked for this 
sprint.
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Title Type Source table Description

Total story points Single Score
rm_story

Sum of points of 
all stories that are 
scheduled for this 
sprint.

Stories missing 
estimates

Single Score
rm_story

Number of stories that 
are scheduled for this 
sprint that don't have 
story points.

Stories by state Bar graph
rm_story

Stories that are 
scheduled for this 
sprint, grouped by 
their current state.

What does the team 
plan to achieve in this 
iteration?

List
sn_gf_goal

Status and progress of 
your sprint's goals.

You can rearrange 
the columns of the 
report by selecting the 

Settings icon ( ).

Sprint burndown by 
story points

Trend
This trend uses the 
following indicators:

• EAP: Sum of story 
points of all stories 
in the current 
iteration.

• EAP: Sum of story 
points of active 
stories in the 
current iteration.

Burndown trend 
comparing the sprint's 
ideal pace with the 
current pace. This 
report can help you 
analyze if the scope 
can be completed 
before the end of the 
sprint.

Sprint burnup by story 
points

Trend
This trend uses the 
following indicators: Burnup trend 

comparing the sprint's 
ideal pace with the 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

744



Title Type Source table Description

• EAP: Sum of story 
points of completed 
stories in the 
current iteration.

• EAP: Sum of story 
points of all the 
stories in the 
current iteration

current pace. This 
report can help you 
analyze if the scope 
can be completed 
before the end of the 
sprint.

Avg velocity per sprint Single Score
sn_apw_advanced_eap_iteration

Number of story 
points the team can 
complete per sprint. 
Using this metric, 
you can evaluate 
the team's average 
performance.

Velocity
Trend

sn_apw_advanced_eap_iteration
Trend of story points 
completed by this 
team in the past 90 
days.

Story cycle time
Bubble chart sn_apw_advanced_story_cycle_time

Time taken for each 
story to move from an 
in-progress state to 
completion.

Each bubble on the 
graph represents 
a story and the 
graph shows stories 
completed in the past 
30 days. The height 
of the bubble from the 
x-axis shows the time 
(in days) to move from 
an in-progress state to 
completion. The size 
of the story bubbles is 
relative to each other 
based on their story 
points.

Pointing your cursor 
to a bubble on that 
chart shows story data 
such as story points, 
duration in days to 
complete, and name.

You can compare the 
cycle times of stories 
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Title Type Source table Description

with different story 
points and analyze 
the trend in the time 
taken by the team to 
complete them.

Note: 
The cycle time 
chart currently 
doesn't support 
selecting the 
story bubble to 
drill down into 
the stories.

Kanban Team dashboard in EAP

The Kanban Team Dashboard in EAP provides the work item status and progress metrics for 
the Agile teams following the Kanban configuration in the Enterprise Agile Planning  (EAP) 
workspace.

Required EAP  roles

sn_apw_advanced.eap_read_only or the sn_apw_advanced.eap_user.

Access the Kanban Team  dashboard

To open the dashboard:

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your Kanban EAP  Portfolio.

3. Select the Home  tab.
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Use cases

For examples of how different people in your organization would use this dashboard, see these 
use cases.

User Dashboard use

• Portfolio manager

• Product manager

• Team lead

• Team member

View the progress and status of the work items 
assigned to your Kanban team.

Reports

Title Type Source table Description

Total stories Single Score
rm_story

Number of stories 
assigned to this team.

Total story points Single Score
rm_story

Sum of points of all 
stories assigned to 
this team.

Blocked stories Single Score
rm_story

Number of stories 
that are assigned to 
this team and that are 
blocked.

Stories missing 
estimates

Single Score
rm_story

Number of stories 
assigned to this team 
that don't have story 
points.
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Title Type Source table Description

Stories by state Bar graph
rm_story

Stories assigned to 
this team, grouped by 
their current state.

Enterprise Agile Planning  reference

Reference topics provide additional information about the lists, forms, roles, tables, and other 
components that you use to configure and use Enterprise Agile Planning (EAP).

Components installed with Enterprise Agile Planning

Several types of components are installed with Enterprise Agile Planning  when you install the 
Strategic Planning  applications, including tables and user roles.

Roles installed

Role title [name] Description Contains roles

EAP  admin 
[sn_apw_advanced.eap_admin]

Can add teams to 
EAP  configurations 
or remove them.

sn_apw_advanced.eap_user

EAP  user 
[sn_apw_advanced.eap_user]

• Can create, 
update, and 
delete work items

• Can create and 
modify iterations 
like Planning 
Intervals and 
Sprints

• Can access the 
team's Backlog 
and Planning 
Board

• scrum_master

• sn_apw_advanced.eap_read_only

• now_assist_panel_user

This role is available only with the 
Now Assist for SPM  plugin.

EAP  read-only role 
[sn_apw_advanced.eap_read_only]

Can view the EAP 
team's Backlog and 
Planning Board

• scrum_user

• workspace_user

• canvas_user

Tables installed

Table Description

Agile Release Train

[sn_apw_advanced_agile_release_train]

Stores information of all Agile Release Trains 
created for the Agile structure of an EAP 
configuration.
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Table Description

This table extends the Enterprise agile team 
[sn_apw_advanced_eap_team] table.

Agile Team

[sn_apw_advanced_agile_team]

Stores information of all Agile Teams created for 
the Agile structure of an EAP  configuration.

This table extends the Enterprise agile team 
[sn_apw_advanced_eap_team] table.

Capability

[sn_align_core_capability]

Stores information of all Capability type of work 
items created in EAP.

This table extends the EAP  planning item 
[sn_align_core_eap_planning_item] table.

EAP  planning item

[sn_align_core_eap_planning_item]

Base table for all EAP  work item types.

This table extends the Planning Item Entry 
[sn_align_core_planning_item] table.

Enterprise agile calendar

[sn_apw_advanced_eap_calendar]

Stores information of iteration types such as 
Planning Intervals and Sprints.

This table extends the Business Calendar 
[business_calendar] table.

Enterprise agile calendar entry

[sn_apw_advanced_eap_calendar_span]

Stores information of the timeline defined or 
date span for calendar entries of a business 
calendar span.

For example, for a Sprint calendar type, six 
calendar entries spanning over three months 
can be created. This table stores the date 
spans for each of these Sprint calendar entries.

This table extends the Business Calendar Entry 
[business_calendar_span] table.

Enterprise agile configuration

(sn_apw_advanced_eap_configuration)

Stores information of agile configurations such 
as Full configuration, Portfolio configuration, 
and other default and custom configurations.

Enterprise agile configuration detail

[sn_apw_advanced_eap_configuration_detail]

Stores the details of the default work item type 
and planning calendar associated with a team 
type for a configuration.

It also stores:

• Team hierarchy in the Agile structure for a 
configuration.

• Work item type available on the Backlog and 
Planning board pages.

Enterprise agile iteration
Stores the details of team-level iterations 
details such as capacity, total points, State, and 
others.
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Table Description

[sn_apw_advanced_eap_iteration]

Enterprise agile iteration type

[sn_apw_advanced_eap_iteration_type]

Stores the information about planning calendar 
types such as Planning Intervals or Sprints.

Enterprise agile team

[sn_apw_advanced_eap_team]

Base table for all EAP  teams such as ART, 
Solution Trains, Agile Release Trains, and 
Portfolios created in the Agile structure for a 
configuration.

Enterprise agile team structure

[sn_apw_advanced_eap_team_structure]

Contains information of team hierarchy.

Enterprise agile work structure

[sn_apw_advanced_eap_work_structure]

Contains information of work item type 
hierarchy.

Epic

[sn_align_core_scrum_epic]

Stores information of all Epic work items 
created in EAP.

This table extends the EAP  planning item 
[sn_align_core_eap_planning_item] table.

Feature

[sn_align_core_feature]

Stores information of all Feature work items 
created in EAP.

This table extends the EAP  planning item 
[sn_align_core_eap_planning_item] table.

Solution Train

[sn_apw_advanced_solution_train]

Stores information of all Solution Trains created 
for the Agile structure of an EAP  configuration.

This table extends the Enterprise agile team 
[sn_apw_advanced_eap_team] table.

SAFe Portfolio

[sn_apw_advanced_eap_portfolio]

Stores information of all Portfolios created for 
the Agile structure of an EAP  configuration.

This table extends the Enterprise agile team 
[sn_apw_advanced_eap_team] table.

Story

[rm_story]
Stores information of all stories created.
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Scheduled jobs installed

Scheduled jobs installed with Enterprise Agile Planning

Scheduled job Description

Populate parent level data for work item and 
stories

Populates the details of the parent work item 
up to seven levels.

Populate parent level data for work item and 
stories (Bulk)

Populates the details of the parent work item 
up to seven levels. Run this scheduled jobs 
when you have multiple stories that needs 
update to parent work item details at once.

Properties installed with Enterprise Agile Planning

System properties that you can configure to modify the way your product manager or scrum team 
members view their work in the Enterprise Agile Planning  (EAP) workspace.

These properties are available for Enterprise Agile Planning.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

Properties for Enterprise Agile Planning

Property Description

sn_apw_advanced.eap_work_structure_allow_list
Enables viewing different work item types in the Backlog and Planning board pages 
for EAP  teams.

• Type: string

• Default value:

sn_align_core_scrum_epic,sn_align_core_capability,sn_align_core_feature,rm_story

Important: 
Any item, which is an extension of the Enterprise agile planning item 
[sn_align_core_eap_planning_item] table must be entered before rm_story.

• Location: System Property [sys_properties] table

• Learn more: Configure display of other work item types in EAP Backlog and 
Planning board

sn_apw_advanced.enable_hierarchy_view
Enables the Hierarchy view in Enterprise Agile Planning  to display work items in an 
expandable parent‑child  tree.

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] table
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Properties for Enterprise Agile Planning  (continued)

Property Description

• Learn more: Enable Hierarchy tab in EAP

This property is available only after the Populate parent level data for 
work item  fix script is run. For more information, see Enable Hierarchy tab in 
EAP.

Integration between EAP  and Agile Development 2.0

While setting up a configuration in Enterprise Agile Planning, you can establish an integration 
with Agile Development 2.0. Learn more about the tables connected and the way you access the 
information.

In the EAP  configuration form, when you enable the Sync with Agile Development  option, 
information of the following tables is synced between the two apps.

EAP  tables Agile Development 2.0  tables

Enterprise agile iteration 
[sn_apw_advanced_eap_iteration]

Sprint [rm_sprint]

When this sync is established for a configuration, the following are the functionality changes:

Sprint creation and updates

• Creating a Sprint is suggested to be done from EAP.

• Creating a Sprint in EAP  creates a related Sprint in Agile Development 2.0.

If the dates of the Sprint in EAP  overlap with a record in the rm_sprint table, then 
a new Sprint isn’t created for Agile Development 2.0. You can either choose to 
create sprints for non-overlapping dates or delete the existing sprint from the 
rm_sprint table.

• Fields of planned start and end dates for Sprints in Agile Development 2.0 
become read-only, and are derived from the business calendar spans mapped to 
the iterations in EAP.

• Updating Sprint details in EAP  updates the corresponding Sprint details in Agile 
Development 2.0.
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• Deleting Sprints from EAP  deletes the corresponding record from the Sprint 
[rm_sprint] table.

• On the Sprint [rm_sprint] table, reference fields are created for parent of the EAP 
iteration and the EAP  team this iteration belongs to.

Story creation and updates

• All Stories scheduled for any Sprints in this configuration can be accessed in 
Sprints of Agile Development 2.0.

You can track the progress of this Sprint from the Agile board.

• Any changes made to the story details or its progress are visible in both the 
applications.

• On the Story [rm_story] table, reference fields are created for EAP  team, iteration, 
configuration, and parent work item in the EAP  fields related list.

• If a story is rescheduled to a different sprint or moved to the Backlog on the Agile 
board, it's updated in EAP  and vice versa.

Note: 
The Story records for EAP are by default saved in the Story [rm_story] table, which is 
installed with the Agile Development 2.0  plugin.

Team type form

Learn about the fields of the new table form that are required to add a new team type in 
Enterprise Agile Planning.

New table form

Field Description

Label Unique label for the table.

Name This field is auto-generated from your input in 
the Label field.

Application
This field is automatically set to Portfolio 
Planning Core  based on your scope.

If this field shows a different value, then set 
the scope of your ServiceNow  instance to 
Portfolio Planning Core.

Extends table Select Enterprise agile team.

Controls section of the New team type form

Field Description

User role Set this field to sn_apw_advanced.eap_user 
so that you grant access to the EAP  user to 
this table.
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Application Access section of the New team type form

Application Access

Enable the Can read, Can create, Can update, and Can delete  fields.

Related topics

Create a custom team type in EAP

Work item type form

Learn about the fields of the new table form that are required to add a new work item type in 
Enterprise Agile Planning.

New table form

Field Description

Label Unique label for the table.

Name This field is auto-generated from your input in 
the Label field.

Application
This field is automatically set to Portfolio 
Planning Core  based on your scope.

If this field shows a different value, then set 
the scope of your ServiceNow  instance to 
Portfolio Planning Core.

Extends table Select EAP planning item.

Controls section of the Work item type form

Field Description

User role Set this field to sn_apw_advanced.eap_user 
so that you grant access to the EAP  user to 
this table.

Application Access section of the Work item type form

Application Access

Enable the Can read, Can create, Can update, and Can delete  fields.

Related topics

Create a custom work item type in EAP

Agile configurations in EAP

SAFe-EAP migration request form

Learn about the fields of SAFe-EAP migration form. Use this form to submit a request to migrate 
Scaled Agile Framework  data to Enterprise Agile Planning.
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SAFe-EAP migration request form

Field Description

Request name A unique name for the migration request.

EAP configuration Configuration in EAP that matches with your 
SAFe  configuration.

For example, if you're using Portfolio SAFe  in 
your ServiceNow  instance, select Portfolio 
configuration.

SAFe table Data from the SAFe table that you want to 
migrate to EAP.

• If you select Portfolio, the data from SAFe 
Portfolio tables, their immediate child ARTs, 
SAFe teams, and the iterations and work 
items associated with them will be migrated.

• If you select ART, the data from ART 
tables, their parent Portfolios, child SAFe 
teams, and the iterations and work items 
associated with them will be migrated.

Filter records SAFe portfolios/ARTs that match the filter 
conditions will be displayed for selection.

Records available for migration Records that match the filter conditions that 
you applied in the previous field are displayed 
in the Available list for you to choose from.

Only the records that are moved to the 
Selected list are considered for migration.

PIs starting on or after Program Increments with planned start 
date falling on or after the selected date are 
migrated.

Work items update after Epics, Features and Stories updated after the 
selected date are migrated.

Status Status of the migration request.

Related topics

Start migration of SAFe data to EAP

Migrating from SAFe to EAP

Enterprise Agile Planning  Indicators

Indicators included in the EAP  dashboard.

Indicator Description Version added

EAP: Sum of story points of 
completed stories in current 
iteration

Sum of story points of 
completed stories in current 

Washington DC
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Indicator Description Version added

iteration is measured daily as 
unit.

EAP: Sum of story points of all 
stories in the current iteration

Sum of story points of all 
stories in the current iteration 
is measured daily as unit.

Washington DC

EAP: Sum of story points of 
active stories in the current 
iteration

Sum of story points of active 
stories in the current iteration 
is measured daily as unit.

Washington DC

For information about the metrics you can view on the EAP  dashboard through these indicators, 
see EAP reports and dashboards.

Work item reorder errors in EAP  Backlog

Review the scenarios when the reordering of work items can fail in the Backlog of Enterprise 
Agile Planning  workspace.

While reordering work items in different sections of the EAP  Backlog, the reorder can fail due to 
an error in the ranking configuration. Following are the scenarios where reordering of work items 
can fail:

Scenario 1: Global ranking plugin is not active

Check if the Global Ranking Application plugin (com.snc.sdlc.ranking) is active in 
your ServiceNow  instance. If not, contact your admin to activate it.

Scenario 2: Work item doesn't have a rank configuration

Check if all the work items that you are reordering have a rank configuration. If not, 
contact your admin to update rank configuration for these work item types.

Scenario 3: Target row doesn't have a global rank

Check if the work item before or after your target position to reorder has a global 
rank. If not, contact your system admin to generate a global rank for them.

SPW  Jira  Integrations
Improve visibility from strategy to execution with Jira  Integration. This integration enables bi-
directional syncing of Epics, Features, Capabilities, and Stories. While sprints are created in 
Enterprise Agile Planning  (EAP) and synced to Jira, sprint status updates flow back from Jira  to 
EAP.

Get started

Explore

Learn about SPW 
Jira Integrations 
and its workflow.

Configure

Set up the integration 
between SPW and Jira.

Reference

More information on roles, 
tables, and forms used 
in SPW Jira integration.
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Exploring SPWJira  integrations

Learn more about integrating Strategic Planning Workspace  with Jira  and review the benefits it 
can provide for different users in your organization.

SPW  Jira  integration overview

As a portfolio manager, you may rely on Strategic Planning Workspace  (SPW) for roadmap 
planning, prioritization, and aligning work with strategic goals. However, your delivery teams 
could prefer using tools like Jira  for the actual execution of work such as creating and managing 
stories and epics. This disconnect could create a visibility gap for portfolio managers, making it 
difficult to track progress and ensure alignment between strategy and execution.

The SPW-Jira  integration helps solve this problem by providing seamless, bi-directional 
synchronization of key work items, including Epics, Features, Capabilities, and Stories. This 
synchronization ensures that updates made in either system are reflected in the other, giving 
portfolio managers real-time insight into execution without leaving SPW.

Sprints are created in EAP  and sync to Jira, while status updates flow back from Jira  to maintain 
visibility. This approach enables comprehensive end-to-end planning in SPW  with the ability to 
plan dependencies and capacities across teams and sprints in EAP.

By bridging the gap between strategic planning and operational execution, this integration 
provides end-to-end visibility, enabling better decision-making, improved collaboration, and 
stronger alignment across teams.

SPW  Jira  Integrations workflow

The following infographic shows how the integration between SPW  and Jira  work in both the 
applications.

• One-to-One Mapping: Each Jira Project is directly mapped to an EAP Team.

• Bidirectional Sync of Work Items:

◦ Epics, Features, Capabilities, and Stories are synced both ways between SPW  and Jira.

◦ Sync applies to creation and updates.
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Example: A product owner creates an Epic in EAP  and it appears in Jira. Team members 
update the Epic in Jira and the changes sync back to EAP.

Note: 
If your Jira  instance has state transition rules, the export sync from EAP  to Jira  might 
fail. For example, if a transition rule in Jira  restricts a story or work item from moving 
directly to a Complete  state without first passing through an In Progress  state, and the 
story is marked Complete  without that intermediate step, the sync fails.

• Sprint Management:

◦ Sprints can only be created in EAP, then synced to Jira.

◦ Updates to sprints can be made in either application and are synced bidirectionally.

What to explore next

To learn more about configuring and using SPW  Jira  Integrations, see:

• Configuring SPW Jira Integrations

• SPW Jira Integrations reference

Configuring SPW  Jira  Integrations

Configure the set up and implementation of SPW  Jira  Integrations. You can either follow the tasks 
listed in the configuration or use Guided Setup.

Configuration overview

1. Install SPW Jira Integrations.

2. Assign the Jira  integration admin role. See Components installed with SPW Jira Integrations.

3. Set up a Jira instance.

4. Connect SPW to Jira.

5. Import Jira projects to SPW.

6. Configure Jira Project settings.

a. Associate Jira projects with EAP teams.

b. Review default mapping configuration for Jira projects in SPW.

c. (Optional) Create custom mapping configuration.

d. Enable bidirectional sync between SPW and Jira.

7. Import issues from Jira to SPW.

8. Repeat steps 6 and 7 for all imported Jira projects.

9. Activate Jira configuration in Enterprise Agile Planning.

10. Define team structure in Enterprise Agile Planning.

Using guided setup to implement SPW  Jira  Integrations

Guided setup provides a sequence of tasks that help you configure SPW  Jira  Integrations on 
your ServiceNow  instance. To open guided setup for SPW  Jira  Integrations, navigate to All  > 
Strategic Planning  > Jira integration  > Guided Setup.
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Install SPW  Jira  Integrations

You can install the SPW  Jira  Integrations application (sn_spw_jira_int) if you have the admin 
role.The application installs related ServiceNow®  Store  applications and plugins if they are not 
already installed.

Before you begin

• Confirm that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the SPW  Jira  Integrations application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

Role required: admin

About this task
The following items are installed with SPW  Jira  Integrations:

• Store applications

• Roles

• Scheduled jobs

• Tables

For more information, see Components installed with SPW Jira Integrations.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the SPW  Jira  Integrations application (sn_spw_jira_int) using the filter criteria and search 
bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

A list of the versions available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are the sample records that describe application features for common use cases. 
Load the demo data when you first install the application on a development or test instance.

6. Select Install.

Setting up a Jira  instance for SPW  Jira  Integrations

Establish a connection between Strategic Planning Workspace  (SPW) and Jira  using a Jira 
instance record.

Before connecting SPW  and Jira, you need a Jira  instance record and Jira  connection alias in 
your ServiceNow  instance.
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Based on the type of your Jira  instance, perform the following steps:

• For Jira Cloud:

1. Create a child alias for the Jira Spoke alias.

2. Integrate your ServiceNow  instance with your Jira account using OAuth. See Option 1: Using 
OAuth authentication (Authorization Code grant type)

Note: 
To create credential record and connection record in this task, use the child alias that 
you created earlier and not the parent Jira Spoke.

3.

4.

5. Create a Jira instance record in ServiceNow AI Platform.

• For Jira Server or Data center:

1. Create a child alias for the Jira Spoke alias.

2. Set up a MID server. See Tips to set up your MID Server .

3. Create Personal Access Token (PAT) in Jira.

4. Using the PAT, set up connection & credentials for the child alias.

5. Create a Jira instance record in ServiceNow AI Platform.

After successfully setting up the Jira instance record, proceed to connect Strategic Planning 
Workspace  and Jira. For more information, see Connect SPW to Jira.

Create a child alias for Jira Spoke alias for SPW  Jira  Integrations

Create a child connection & credential alias that will be used to connect to Jira  later, to enable 
integration between Strategic Planning  and Jira.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Connection & Credentials  > Connection & Credential Aliases.

2. From the list of aliases, open the alias based on your Jira instance type.

◦ For Jira Cloud, open sn_jira_spoke.Jira.

◦ For Jira Server/Data Center, open sn_jira_int.Jira.

3. Create a child alias.

a. From the Child Aliases related list, select New.

b. Enter a name.
For example, Jira instance – GenAI team.

c. Select Submit.

What to do next

• For Jira Cloud: .

• For For Jira Server/Data Center: Create PAT for Jira Server.
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Create Personal Access Token in Jira Server/Data Center for SPW  Jira  Integrations

Create a Personal Access Token (PAT) for your Jira  Server/Data Center instance, which is later 
used to create a connection between Strategic Planning  and Jira.

Before you begin

• Create a child alias for Jira Spoke alias for SPW Jira Integrations.

• Set up a MID server. See Tips to set up your MID Server .

Role required: NA

About this task
This task is performed outside the ServiceNow  instance.

Important: 
A Jira Server account is used to create the PAT. After establishing the integration, any 
updates that are made in Strategic Planning Workspace  will show up in Jira  as done by 
this logged-in user. So, it is recommended that this account that is used to generate the 
PAT is either an admin or a placeholder user profile that is not used to make any updates in 
Jira  once the integration is complete. If this user makes any updates in Jira, it may result in 
cyclic changes.

Procedure

1. Log into your Jira Server instance.

2. Navigate to your profile.

3. From your profile details, select Personal Access Tokens  from the left navigation menu.

4. Select Create token.

5. Enter the details of name and expiry period.

6. Select Create.

7. Copy the created token and store it securely to retrieve it for later steps.

What to do next
Use this PAT as password while creating connection and credential for your Jira alias. See Create 
connection and credentials for SPW Jira Integrations.

Create connection and credentials for SPW  Jira  Integrations

Using your Jira  instance details, create a connection and credential for the child alias, which is 
used to enable the two-way sync of work item updates between Strategic Planning Workspace 
and Jira.

Before you begin

1. Create a child alias for Jira Spoke alias for SPW Jira Integrations.

2. or Create Personal Access Token in Jira Server/Data Center for SPW Jira Integrations.

Role required: admin or sn_jira_int.admin

About this task
This task is performed for Jira Server/Data Center type instances only. For Jira Cloud, follow the 
steps of OAuth authentication. For more information, see Option 1: Using OAuth authentication 
(Authorization Code grant type) .
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Procedure

1. Navigate to All  > Connection & Credentials  > Connection & Credential Aliases.

2. From the list of aliases, open sn_jira_int.Jira

3. From the Child Aliases related list, open the child alias record that you created earlier.

4. From the Connection & Credential Aliases form, select Create New Connection & Credential 
related link.

5. On the form, fill in the fields.
For field information, see Create Connection & Credential form.

6. Select Create.

What to do next
Create Jira instance for SPW Jira Integrations.

Create Jira  instance for SPW  Jira  Integrations

Create a Jira  instance record which is later used to connect Strategic Planning Workspace  and 
Jira.

Before you begin
Create connection and credentials for SPW Jira Integrations.

Role required: sn_jira_int.admin

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Instances.

2. Select New.

3. On the form, fill in the fields.
For field information, see Jira Instance form.

4. Select Submit.

What to do next
Connect SPW to Jira.

Connect SPW  to Jira

Connect Strategic Planning Workspace  to Jira  to enable the integration between the 
applications.

Before you begin
Role required: sn_jira_int.user

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Instances.

2. Select your Jira instance.

3. Click Get Webhook Callback URL.

4. Set up a webhook using this URL in Jira Administration.
This action is done outside your ServiceNow  instance.

Registering a webhook via the Jira administration console

5. On the Jira instance form, select Connect.
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Result
If the connection is successful, the State  field on your Jira instance record shows Connected. A 
webhook is now registered in Jira to receive update events.

What to do next
Import Jira projects to SPW.

Import Jira  projects to SPW

Discover and import all available Jira  projects and boards into Strategic Planning Workspace  to 
start using the integration between the two applications.

Before you begin
Connect SPW to Jira.

Role required: sn_jira_int.user

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. Select Discover Projects.

This action creates requests to import Jira projects and boards, and to create mapping 
configuration for all these projects. You can view all the import requests in the Jira Import 
Requests related list and the initial state of all the requests would be Requested

Result
Once the status of each import request changes to Complete, you can see that the related lists 
of this Jira instance are populated as follows:

• Jira Projects: All available projects from Jira

• Jira Boards: All available boards from Jira

• Project Style Mappings: Mapping configuration for all the imported Jira projects.

What to do next
Configure integration settings for a Jira project.

Configuring Jira project settings in SPW

Configure integration settings for each Jira project before importing issues to ensure accurate 
and consistent visibility of work in both Strategic Planning Workspace  and Jira. These settings 
such as team association and data mappings define how work items sync between both 
applications.

For each Jira project, perform the following tasks:

1. Associate the Jira project with an EAP team.

Each Jira project must be associated with an EAP team so that work items brought in from Jira 
map to the right team in SPW.

2. Review default data mapping configurations.

Predefined data mapping configurations for Epics, Sprints, and Stories between the two 
applications are available but if these default mappings don't fit your team's requirements, you 
can edit them or create new ones. See Create custom mapping configurations.
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3. Enable bidirectional data sync.

This step ensures updates done in either application are reflected in the other so that data is 
consistent across.

These steps must be completed for every Jira project that you plan to integrate. Doing so ensures 
that imported issues sync correctly and enables portfolio managers with real-time visibility into 
execution.

Associate Jira  projects with EAP  teams

Ensure work items from Jira are mapped to the right teams in Enterprise Agile Planning  (EAP) by 
associating Jira projects with EAP teams.

Before you begin
Import Jira projects to SPW

Role required: sn_jira_int.user

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Projects.

2. Open your Jira project record.

3. From the Team Integration Settings related list, select New.

4. On the Team Integration Settings form, fill in the fields,
For field information, see Team Integration Settings form.

5. Select Submit.

What to do next
Review default mapping configuration for Jira projects in SPW.

Review default mapping configuration for Jira projects in SPW

Verify that the default mapping configuration between work items in Strategic Planning 
Workspace  (SPW) and Jira aligns with your team's processes.

Before you begin
Import Jira projects to SPW

Role required: sn_jira_int.user

About this task
Review the predefined table, field, and choice mapping configuration for a Jira Project. For more 
information on the default configuration for Epics, Stories, and Sprints, see Default mapping 
configuration for SPW Jira Integrations.

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Projects.

2. Open your Jira project record.

3. From the Table Maps related list, review the list of mappings available between tables of Jira 
and SPW  for this project.

4. Review the field mapping for each table map.
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a. Select a table mapping record to open it.

b. From the Field Maps related list, review the mapping configuration of the fields between the 
tables.

5. Review the choice mapping for a field such as the State field.

a. Select a field mapping record to open it.

b. From the Choice Maps related list, review the mapping configuration of choices of the fields.

6. Repeat steps 3, 4, and 5 for all table maps of the Project.

What to do next
If the available mapping configuration doesn't fit your team's requirements or processes, you can 
create custom mappings between entities of Jira and SPW. For more information, see Custom 
mapping configuration for SPW Jira Integrations.

Custom mapping configuration for SPW  Jira Integrations

Learn about creating custom mapping configurations to map Jira issue types, fields, and choices 
with SPW  entities, to match your team's processes.

Custom mapping configurations allow you to control how Jira issue types, fields, and values align 
with SPW  planning items. While default mappings cover common use cases, they may not fit your 
team's processes or reporting needs. By creating custom mappings, you can:

• Ensure accurate synchronization of work items between Jira and SPW.

• Align data mapping to reflect your team’s terminology and workflows.

• Support consistent reporting and visibility across strategy and execution.

This flexibility helps provides a tailored integration experience, so that portfolio managers and 
delivery teams work with information that matches their context.

Create custom table mapping for SPW  Jira integrations

Create a custom mapping configuration between tables of Strategic Planning Workspace  (SPW) 
and Jira.

Before you begin
Review default mapping configuration for Jira projects in SPW.

Role required: sn_jira_int.user

About this task
Choose one table from Jira and one from SPW  to create a mapping between them.

For example, if your team uses an issue type like Feature that isn’t mapped by default, 
you can create a new mapping between the Feature issue type in Jira and the Feature 
[sn_align_core_feature] table in SPW.

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Projects.

2. Open your Jira project record.

3. From the Table Maps related list, select New.

4. On the Table Map form, fill in the fields.
For field information, see Table Map form.

5. Select Submit.
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What to do next

1. Validate your new table map configuration by clicking Validate and fix mapping  from the Jira 
project form.

2. For this table map, create field mappings. See Create custom field mapping for SPW Jira 
integrations.

Create custom field mapping for SPW  Jira integrations

Create a custom mapping configuration between fields of Strategic Planning Workspace  (SPW) 
and Jira.

Before you begin
Role required: sn_jira_int.user

About this task
Select a Jira field and map it to a corresponding SPW  field in the Table Map record.

For example, a table mapping between the Story entity in Jira and the Story [rm_story] table in 
SPW  is available by default. If you need to map additional fields, such as story points, create a 
custom Field Map record using the steps below.

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Projects.

2. Open your Jira project record.

3. From the Table Maps related list, open a table map record for which you want to create field 
maps.

4. From the Field Map related list, select New.

5. On the form, fill in the fields.
For field information, see Field Map form.

6. Select Submit.

What to do next

1. Validate your new mapping configuration by clicking Validate and fix mapping  from the Jira 
project form.

2. (Optional) If your new field is of the type Choice, create custom choice mapping for it. See 
Create custom choice mapping for SPW Jira integrations.

Create custom choice mapping for SPW  Jira integrations

Create a custom mapping configuration for field choices between Strategic Planning Workspace 
(SPW) and Jira.

Before you begin
Role required: sn_jira_int.user

About this task
Select a choice value from a Jira entity and map it to a corresponding choice value in an SPW 
table.

For example, Jira Stories include default states such as To Do, In Progress, and Done. If your 
team adds a custom state like Testing, you can create a choice mapping to link Testing  in Jira to 
the Ready for Testing  state in the Story [rm_story] table in SPW.
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Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Projects.

2. Open your Jira project record.

3. From the Table Maps related list, open your table map record.

4. From the Field Maps related list, open a field map record for which you want to create choice 
maps.

5. From the Choice Map related list, select New.

6. On the form, fill in the fields.
For field information, see Choice Map form.

7. Select Submit.

What to do next

1. Validate your new mapping configuration by clicking Validate and fix mapping  from the Jira 
project form.

2. Enable bidirectional sync of work items between Jira projects and SPW.

3. Import issues from Jira to SPW.

Enable bidirectional sync between SPW  and Jira

Enable import and export for a Jira project to ensure data is consistent across for all stakeholders 
using Strategic Planning Workspace  and Jira.

Before you begin
Role required: sn_jira_int.user

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Projects.

2. Open your Jira project record.

3. Select both the Enable Import  and Enable Export  options.

4. Select Update.

What to do next
Import issues from Jira to SPW.

Import issues from Jira to SPW

Import work items such as epics, features, capabilities, and stories from Jira to Strategic Planning 
Workspace  (SPW) to enable end-to-end visibility in SPW.

Before you begin
Enable bidirectional sync between SPW and Jira

Role required: sn_jira_int.user

Procedure

1. Navigate to All  > Strategic Planning  > Jira Integration  > Jira Projects.

2. Open your Jira project record.

3. Select Import issues.

4. Select a date range to import issues from your Jira project.
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5. On the Import Request form, select Submit.
An Import request is created and is shown in the Jira Import Requests related list of the Jira 
project.

Result
After the State of the import request changes to Complete, all the work items from Jira would 
have been imported into Strategic Planning Workspace  tables, based on the mapping 
configuration defined for the project.

What to do next

1. Activate Jira configuration in Enterprise Agile Planning.

2. Define Agile structure in EAP for Jira Configuration

Activate Jira configuration in Enterprise Agile Planning

Activate the Jira configuration so that EAP teams integrated with Jira projects can be shown in 
the Enterprise Agile Planning  workspace.

Before you begin
Ensure that Application Scope  of your ServiceNow  instance is set to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Configuration.

3. On the Jira configuration card, select Edit.

4. On the configuration form, set the State  field to Active.

5. Select Save.

What to do next
Define Agile structure in EAP for Jira Configuration.
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Define Agile structure in EAP  for Jira Configuration

Set up Agile team structures in Enterprise Agile Planning  (EAP) for teams associated with Jira 
projects so that imported work items and updates from Jira  display correctly in EAP.

Before you begin
Activate Jira configuration in Enterprise Agile Planning.

Ensure that Application Scope  of your ServiceNow  instance is set to Strategic Planning.

Role required: sn_apw_advanced.eap_admin

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From the Settings  menu, select Enterprise Agile Planning  > Agile structure.

3. Add an Agile Release Train (ART) by selecting the + icon ( ) next to Jira Configuration.

a. On the Agile Release Train form, fill in details such as name and description.

b. Select Submit.

c. Repeat the action to add as many ARTs as you need.

4. For each ART, add Agile Teams by selecting the + icon ( ) next to the ART's name.
If you cannot find your teams, contact your admin.
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Result
An Agile structure is defined for Jira Configuration in EAP.

What to do next
Start using SPW and EAP with Jira integration.

eap-config-hierarchy

TBD TBD.

Before you begin
Role required: admin

Procedure

Navigate to All  >  > .

Using EAP  with SPW  Jira  Integrations

After configuration is complete for SPW  Jira  Integrations, use Enterprise Agile Planning  (EAP) to 
bridge strategy and execution. Plan and schedule work in EAP, let teams deliver in Jira, and see 
progress and performance flow back to EAP  for accurate, real‑time  visibility.

Strategic planners such as portfolio managers and product owners can use EAP  to define 
planning intervals and sprints, create and prioritize epics and stories, and assign them to teams. 
These plans sync to Jira, where delivery teams execute and update work.

Changes made in Jira  such as sprint updates, status changes, or newly scheduled work flow 
back into EAP, maintaining end‑to‑end  visibility without switching tools.

From the EAP  team's Home tab, you can view reports to track current‑sprint  status, overall 
execution health, and team performance.

This workflow enables you to plan in EAP, execute in Jira, and monitor outcomes in one place.
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For more information on managing backlog and sprints using EAP, see Manage team backlog in 
EAP  and Perform PI planning in EAP.

SPW  Jira  Integrations reference

Reference topics provide additional information about the lists and forms that you use to 
configure SPW  Jira  Integrations.

Components installed with SPW  Jira  Integrations

Learn about the roles and tables installed with the SPW  Jira  Integrations application.

Roles installed

Role title [name] Description Contains roles

Jira integration 
admin

[sn_jira_int.admin]

Has complete access to the SPW Jira 
Integrations application

• sn_int_common.admin

• sn_jira_int.user

Jira integration 
user

[sn_jira_int.user]

• Sets up integration between Jira and Strategic 
Planning

• Can create new or update the existing map 
configurations between Jira and Strategic 
Planning

• connection_admin

• sn_int_common.user

• credential_admin

Tables installed

Table Description

Choice Map

[sn_int_common_choice_map]

Stores the list of workflow state mapping for Jira 
projects.
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Table Description

Event Type

[sn_int_common_input_event_type]

Stores information of the type of webhook events 
such as create, update, or delete of a work item.

External Identifiers

[sn_int_common_external_identifiers]

Stores the list of all Jira reference identifiers such 
as External ID, External Key, External Project, 
External URL, and so on.

External Project

[sn_int_common_project]

Stores information of the Jira project such as 
project ID, the Jira instance of this project, project 
name, and so on.

External system

[sn_int_common_external_system]

Stores information of Jira application used for the 
integration.

External System Version

[sn_int_common_external_system_version]

Stores version information of Jira application used 
for the integration.

Field Map

[sn_int_common_field_map]

Stores the list of field mapping of different issue 
types for Jira projects.

Jira Board

[sn_jira_int_board]

Stores the list of imported boards from Jira.

Jira Import Request

[sn_jira_int_import_request]

Stores the list of all import requests created 
to import projects, boards, and project style 
mappings from Jira.

Jira Instance

[sn_jira_int_instance]

Stores the list of all Jira instances.

Jira Project

[sn_jira_int_project]

Stores the list of all imported projects from Jira.

Team Integration Settings

[sn_agile_jira_int_import_settings]

Stores the list of one-to-one relation between a 
Jira project, board, and an EAP Team.

Project Style Mapping

[sn_jira_int_prj_style_mapping]

Store the list of map configuration templates per 
Jira project style.

Table Map

[sn_int_common_table_map]

Stores the list of table maps for Jira projects.

Default mapping configuration for SPW  Jira  Integrations

Learn about the default mapping configuration of Epic, Story, and Sprint work types between 
Strategic Planning  and Jira.
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Epic mapping configuration

Epic [sn_align_core_scrum_epic] in Strategic Planning  is mapped to Epic in Jira. The field 
mapping between these two tables is as follows.

Epic Table Map

Field in Strategic Planning Field in Jira

approved_start_date Start date

state Status

short_description Summary

approved_end_date Due date

Story mapping configuration

Story [rm_story] in Strategic Planning  is mapped to Story in Jira. The field mapping between 
these two tables is as follows.

Story Table Map

Field in Strategic Planning Field in Jira

assigned_to Assignee

description Description

iteration Sprint

parent_work_item Parent

priority Priority

short_description Summary

state Status

Sprint mapping configuration

Enterprise agile iteration [sn_apw_advanced_eap_iteration] in Strategic Planning  is mapped to 
Sprint in Jira. The field mapping between these two tables is as follows.

Sprint Table Map

Field in Strategic Planning Field in Jira

state state

start_date startDate

name name

end_date endDate

Related topics

Review default mapping configuration for Jira projects in SPW
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Team Integration Settings form

Learn about the fields of Team Integration Settings form that is used to create an association 
between Jira projects and EAP teams.

Team Integration Settings form

Field Description

Jira Project This field is auto-populated from your 
selection.

EAP Team The EAP team that you want to associate your 
Jira Project to.

All work items from the selected Jira project 
will be synced to this EAP team.

Jira Board
Jira board for the selected Jira project.

• For team-managed projects, enter the Jira 
board associated with the project.

• For company-managed projects, even if 
multiple boards exist for a single Jira project, 
you can map only one board to an EAP team 
in the Team Integration Settings form.

• The selected board determines which work 
items sync bidirectionally between the Jira 
Project and the EAP team.

• Real-time import and export will apply only 
to the mapped board for company-managed 
projects.

Related topics

Associate Jira projects with EAP teams

Table Map form

Learn about the fields of the Table Map form, which are used while creating a custom table 
mapping configuration for SPW  Jira Integrations.

Table Map form

Field Description

Internal Table Table name in Strategic Planning.

Internal Table must be set to Planning Item 
[sn_align_core_planning_item] or one of its 
child tables.

Map configuration Map configuration for this project.

This field is auto-populated based on the 
project.

External Table Table ID in Jira.
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Table Map form  (continued)

Field Description

External Table Name Table Name in Jira.

Integration Type Select Strategic Planning Workspace.

Related topics

Create custom table mapping for SPW Jira integrations

Field Map form

Learn about the fields of the Field Map form, which are used while creating a custom field 
mapping configuration for SPW  Jira Integrations.

Field Map form

Field Description

Internal Field Field name in Strategic Planning.

External Field Field ID in Jira.

External Field Name Field Name in Jira.

Table Map Table Map record for which this field mapping 
is created.

This field is auto-populated.

Internal Table Table in Strategic Planning.

This field is auto-populated based on the 
Table Map selection.

Related topics

Create custom field mapping for SPW Jira integrations

Choice Map form

Learn about the fields of the Choice Map form, which are used while creating a custom choice 
mapping configuration for SPW  Jira  Integrations.

Choice Map form

Field Description

Internal Choice Value of the choice in SPW. This value is an 
integer.

External Choice Name of the choice in Jira.

External Choice Name Display name of the choice in Jira.

Field Map Field Map record for which this choice 
mapping is created.

This field is auto-populated.
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Related topics

Create custom choice mapping for SPW Jira integrations

Create Connection & Credential form

Learn about the fields of the Create Connection & Credential form, which is used while setting up 
SPW  Jira  Integrations.

Create Connection & Credential form

Field Description

Connection URL Jira instance URL.

Server type Type of your Jira instance.

• For Jira Cloud, enter cloud.

• For Jira Server/Data Center, enter server.

User Name Username for your Jira instance account.

API key • For Jira Cloud, enter the API token that you 
generated. For more information, see .

• For Jira Server/Data Center, enter the PAT 
that you generated. For more information, 
see Create Personal Access Token in 
Jira Server/Data Center for SPW Jira 
Integrations.

Related topics

Create connection and credentials for SPW Jira Integrations

Jira Instance form

Learn about the fields of the Jira Instance form, used to connect Strategic Planning  to Jira.

Jira Instance form

Field Description

Name Name of your choice for the Jira instance 
record.

Connection Alias Select the connection alias that you created. 
For more information, see Create connection 
and credentials for SPW Jira Integrations.

URL URL of your Jira instance, Cloud or Server.

State Connection status of the Jira Instance.

Version Version of your Jira instance.

Integration Type Select Strategic Planning Workspace.

Related topics

Create Jira instance for SPW Jira Integrations
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Dashboards in Strategic Planning Workspace
Dashboards in Strategic Planning  Workspace help product and portfolio managers monitor 
performance, track progress, and make informed decisions related to ideas, feedback, strategy, 
planning, and execution.

Explore

Learn the key benefits 
of using dashboards 
in Strategic Planning

Use

Learn how to use 
dashboards and monitor 

performance, track 
progress, and make 
informed decisions

Integrate

Add existing 
Platform Analytics

dashboards to Strategic 
Planning Workspace

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Dashboards in Strategic Planning Workspace

As a product and portfolio manager, use dashboards in Strategic Planning  Workspace to monitor 
performance, track progress, and make informed decisions related to ideas, feedback, strategy, 
planning, and execution. These dashboards leverage Platform Analytics  to provide a trend of 
historical data and regular reports.

The following are four out-of-the-box dashboards available in the Strategic Planning Workspace:

• Product Idea Dashboard

• Feedback Dashboard

• Strategy Execution Dashboard

• Execution Dashboard

You can use the default dashboards or create your own dashboards to monitor performance and 
take informed decisions.

Benefits of dashboards

• Create data visualizations and add them to the dashboards using the Platform Analytics 
experience.

• Monitor performance, track progress, and make informed decisions related to ideas, feedback, 
strategy, planning, and execution.

• Duplicate existing dashboards and customize them as needed, without modifying the out-of-
the-box dashboards.

• Use the out-of-the-box dashboards or configure your own dashboards as needed.
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• Share dashboards with stakeholders to enable collaboration.

• View relevant data by applying filters directly within a dashboard.

• Any filters applied are saved as part of user personalization and are available the next time you 
log in.

For guidance on using and managing dashboards in the Strategic Planning Workspace, see 
Using Dashboards in Strategic Planning Workspace.

Feedback Dashboard in Strategic Planning Workspace

The Feedback Dashboard helps product managers track feedback volume and stakeholder 
trends to surface recurring pain points, inform prioritization decisions, and demonstrate 
responsiveness.

Feedback Dashboard

Widget/Visualization Description

Importance High - Awaiting review Count of feedback items with high importance 
(1-High) and a state of either Submitted or 
Need More Information.

Importance High - Not linked to ideas Count of feedback items with high importance 
(1-High) that aren’t linked to any ideas.

Importance High - Unassigned Count of feedback items with high importance 
(1-High) that aren’t assigned to anyone.

Importance High - Unlikely to implement Count of feedback items with high importance 
(1-High) and a state of Unlikely to Implement.

Feedback Created in Last 30 Days Count of feedback items created within the 
last 30 days.

List of Feedback Created in Last 30 Days List of feedback items created within the last 
30 days, including details such as Name, 
Importance, Source, Customer, Assigned to, 
and Product idea count.

Total Feedback Total number of feedback items received to 
date.
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Feedback Dashboard  (continued)

Widget/Visualization Description

Feedback Distribution Visualization of feedback items with grouped 
by Importance and stacked by Customer.

Overall Feedback Distribution Visualization of feedback items with grouped 
by Importance.

Feedback Linked to Ideas in the Last 30 Days Visualization of feedback items linked to 
ideas within the last 30 days and grouped by 
Importance.

Feedback Count by Location Count of feedback items by location.

Product Idea Dashboard in Strategic Planning Workspace

The Product Idea Dashboard helps product managers understand the health, flow, and maturity 
of submitted ideas, helping innovations progress and helping prevent backlog bottlenecks.

Product Idea Dashboard

Widget/Visualization Description

Ideas Not Linked to Feedback Count of ideas that aren’t linked to any 
feedback.

Planning State: Prioritized – No Owner Count of ideas whose planning state is 
Prioritized but that have no assigned owner.

Priority: Critical (Customer) – Not Yet 
Prioritized

Count of ideas whose:

• Planning state isn’t Prioritized or Done

• Priority is 1-Critical, and

• Customers field is populated

Priority: Critical – Not Yet Prioritized Count of ideas whose:
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Product Idea Dashboard  (continued)

Widget/Visualization Description

• Planning state isn’t Prioritized or Done, and

• Priority is 1-Critical

Ideas Created in Last 30 Days Count of ideas created within the last 30 days.

List of Ideas Created in Last 30 Days List of ideas created within the last 30 days, 
including details such as Name, Planning 
state, Status, Owner, Product, and Customers.

Total Ideas Total number of ideas received to date.

Breakdown of All Ideas Visualization of all ideas with grouped by 
Planning state.

Breakdown: Ideas Not Linked to Feedback Visualization of ideas not linked to feedback 
within the last 30 days and grouped by 
Planning state.

Idea Analyzer Visualization of ideas with grouped by Impact 
and stacked by Priority.

Execution Dashboard in Strategic Planning Workspace

The Execution Dashboard helps portfolio and product managers gain real-time visibility into 
delivery progress across work items, enabling portfolio leads to detect delays, course-correct 
early, and keep the strategy on track.

The Execution Dashboard provides various analytics across different tabs, including Overview, 
Financial, Milestones & Dependency, Capacity, RIDAC, Data Quality, and Geo.

Overview tab in the Execution Dashboard

Widget/Visualization Description

Delayed Planning Items Planning items that were prioritized but 
haven’t started yet (no recorded actual start 
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Widget/Visualization Description

date), despite having an approved start date in 
the past.

Overdue Items Prioritized planning items that remain 
incomplete (no recorded actual end date), 
despite having an approved end date in the 
past.

Dependencies whose provider planning item 
is in Red status

Dependencies that have a provider planning 
item in red status, affecting all dependent 
planning items.

Planning Items

New and In-Review Items Visualization of new and in-review planning 
items grouped by Priority. You can also group 
the items using other available options.

Prioritized Items Visualization of prioritized planning items 
grouped by Status. You can also group the 
items using other available options.

Completed Items Visualization of planning items whose state 
is Done. You can also group the items using 
other available options.

Execution Items

Projects Visualization of projects count grouped by 
State. You can also group the items using 
other available options.

Demands Visualization of demands count grouped by 
State. You can also group the items using 
other available options.

Financial tab in the Execution Dashboard
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Widget/Visualization Description

Select a fiscal period to view relevant data Option to select date range as This year 
or Last year  to filter and display the data 
accordingly. Clearing the date range displays 
the data considering from the start date of the 
portfolio plan.

Planned Costs Estimated cost for executing the plan.

Budget Estimated budget for executing the plan.

Actual Costs Actual cost incurred during plan execution.

Planned vs Budget vs Actual by Cost Type Visualization of Planned vs Budget vs Actuals 
by Cost Type.

Planned vs Budget vs Actual Visualization of cost by Planned vs Budget vs 
Actual.

Budget by Investment Type Visualization of budget by Investment type.

Benefits

Planned Monetary Benefits Monetary benefits that have been planned.

Actual Monetary Benefits. Monetary benefits that have been achieved.

Pending Monetary Benefits. Monetary benefits that are in pending state.

Benefits by Category Benefits by category such as Revenue, Cost 
savings, and Customer satisfaction score.

Monetary Benefits Visualization of monetary benefits with respect 
to planned and actual benefits.

Milestones & Dependency tab in the Execution Dashboard

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

782



Widget/Visualization Description

Dependencies whose provider planning item 
is in Red status

Count of dependencies that have a provider 
planning item in red status, affecting all 
dependent planning items.

Missed Key Milestones in Last 30 Days Count of planning items whose key milestones 
were missed within the last 30 days.

Upcoming Milestones Likely to Be Missed List of planning items whose key milestones 
about to be missed soon with details including 
Name, Type, Due date, Assigned to, Source 
item.

Missed Milestones in Last 30 Days List of planning items whose key milestones 
were missed within the last 30 days with 
details including details, Name, Type, Due 
date, Assigned to, and Source item.

Achieved Milestones in Last 30 Days List of planning items whose key milestones 
were achieved within the last 30 days with 
details including details, Name, Type, Due 
date, Assigned to, and Source item.

Milestones Analyzer Visualization of key milestones grouped by 
state and stacked by Type. You can also group 
and stack the items using other available 
options.

Capacity tab in the Execution Dashboard

Widget/Visualization Description

Resource Assignments Status Visualization of resource assignments status.

Resource Assignments Ready for Review Visualization of resource assignments count 
that is ready for review.
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Widget/Visualization Description

Upcoming Items with Resource Assignments 
That Are Unassigned, Unapproved, or Pending

List of upcoming planning items whose 
resource assignments status is Unassigned, 
Unapproved, or Pending.

Resource Assignments by Group, Role & Skill Visualization of resource assignments count 
by their group, role, and skill.

RIDAC tab in the Execution Dashboard

Data Quality tab in the Execution Dashboard

Widget/Visualization Description

Alignment

Not Aligned to Goal Count of work items that aren’t associated with 
any goal.

Financials
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Widget/Visualization Description

No Planned Cost Count of work items for which cost estimation 
is done yet for execution.

No Planned Benefit Count of work items for which benefit 
estimation is done yet.

No ROI Count of work items for which ROI isn’t 
estimated yet.

Projects and Demands Without an Investment 
Type

Count of projects and demands for which 
Investment type isn’t defined yet.

Monetary Benefit Plans Without a Planned 
Benefit

Count of monetary benefit plans for which 
benefit isn’t defined yet.

Monetary Benefit Plans Without a Sponsor Count of monetary benefit plans for which a 
sponsor hasn’t been assigned yet.

Planning Items with Other Attributes

No Resource Assignments Count of planning items without resource 
assignments.

Unscheduled Items Count of planning items not scheduled yet.

No Portfolio Count of planning items with no portfolio 
defined.

No Program Count of planning items with no program 
defined.

No Department Count of planning items with no department 
populated.

No Business Unit Count of planning items with no business unit 
populated.

No Owner Count of planning items with no owner 
assigned.

Geo tab in the Execution Dashboard

Widget/Visualization Description

Planned cost by location Estimated cost by location for executing the 
plan.

Strategy Execution Dashboard in Strategic Planning Workspace

The Strategy Execution Dashboard helps portfolio managers monitor the alignment between 
strategy and business outcomes, and quickly assess goal progress to ensure high-impact 
delivery.

The Strategy Execution Dashboard provides various analytics through the tabs and Execution 
Hub.
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Strategic Overview tab in the Strategy Execution Dashboard

Strategic Overview tab of Strategy Execution Dashboard

Widget/Visualization Description

Goal Status Goals that are In Progress or Approved, or 
have a status of Green, Yellow, or Red.

Goal Analyzer Visualization of goals with grouped by Owner 
and stacked by Strategic priority.

Target Status Visualization of targets count with their status 
as Red, Green, Yellow, and None.

Targets by Goal Visualization of targets count with their goals.

Goals and Targets List of goals and targets, including details such 
as Name, Status, and Progress.

Execution tab in the Strategy Execution Dashboard
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Widget/Visualization Description

Select a fiscal period to view relevant data Option to select date range as This year 
or Last year  to filter and display the data 
accordingly. Clearing the date range displays 
the data considering from the start date of the 
portfolio plan.

Planned Costs Estimated cost for executing the plan.

Budget Costs Estimated budget for executing the plan.

Actual Costs Actual cost incurred during plan execution.

Planned Monetary Benefits Monetary benefits that have been planned.

Actual Monetary Benefits Monetary benefits that have been achieved.

Planned vs Budget vs Actual by Cost Type Visualization of Planned vs Budget vs Actuals 
by Cost Type.

Budget by Investment type Visualization of budget by Investment type.

Supplementary Data

New and In-Review Items Visualization of new and in-review planning 
items with grouped by Priority.

Prioritized Items Visualization of prioritized planning items with 
grouped by Status.

Completed Items Visualization of planning items whose state is 
Done.

Delayed Planning Items Planning items that were prioritized but 
haven’t started yet (no recorded actual start 
date), despite having an approved start date in 
the past.

Items Overdue Prioritized planning items that remain 
incomplete (no recorded actual end date), 
despite having an approved end date in the 
past.

Dependencies whose provider planning item 
is in Red status

Dependencies that have a provider planning 
item in red status, affecting all dependent 
planning items.

Missed Key Milestones in Last 30 Days Count of planning items whose key milestones 
were missed within the last 30 days.

Upcoming Milestones Likely to Be Missed List of planning items whose key milestones 
about to be missed soon with details including 
Name, Type, Due date, Assigned to, Source 
item.

Resource Assignments Status Visualization of resource assignments status.

Resource Assignments Ready for Review Visualization of resource assignments count 
that is ready for review.

Upcoming Items with Resource Assignments 
That Are Unassigned, Unapproved, or Pending

List of upcoming planning items whose 
resource assignments status is Unassigned, 
Unapproved, or Pending.
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Using Dashboards in Strategic Planning Workspace

Using the Platform Analytics  dashboards in Strategic Planning Workspace, you can monitor 
performance, track progress, and make informed decisions related to ideas, feedback, strategy, 
planning, and execution.

Roles required for managing dashboards

Required roles to access out-of-the-box dashboards

Access level Required roles

Read, duplicate, or share the Strategy 
Execution Dashboard and Execution 
Dashboard

sn_align_core.ap_read_only

Note: 
To view data in financial-related and capacity-
planning-related widgets, users must have the 
appropriate roles.

Read, duplicate, or share the Product 
Idea Dashboard and Product Feedback 
Dashboard

pf_read

Edit the Strategy Execution Dashboard 
and Execution Dashboard

admin

Edit the Product Idea Dashboard and 
Product Feedback Dashboard

admin

Required roles to create or edit dashboards (excluding out-of-the-box dashboards)

Access level Required roles

Create 
dashboards

sn_align_core.apw_user

Edit 
dashboards

sn_align_core.apw_user

Note: 
You can edit dashboards that you own or those you’ve been granted 
permission to edit.

Note: 
You can create widgets in dashboards by configuring any available data source table in the 
ServiceNow AI Platform. However, you must have read access to the source tables to view 
key data, metrics, or visualizations.

For example, if you create a widget in a dashboard configuring the Cost Plan Breakdown 
table to display budget data, the budget summary is visible on the dashboard only if 
you have read access to the Cost Plan Breakdown table. Similarly, when you share this 
dashboard with a stakeholder, the stakeholder must also have read access to the Cost Plan 
Breakdown table to view the budget summary.

For more information on the required roles to manage Platform Analytics  dashboards, see 
Platform Analytics dashboard roles .
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View a dashboard

View key data and metrics on a dashboard to monitor performance, track progress, and make 
informed decisions related to ideas, feedback, strategy, planning, and execution.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
Dashboards consolidate data from multiple sources into a single, easily digestible format. Each 
widget within a dashboard displays key data and metrics and may include visualizations.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the Change dashboard drop-down, select the dashboard you want to view.

The selected dashboard appears.

3. Optional:  Select a required tab that you want to view the key data and metrics for.
Each widget within a dashboard displays key data and metrics and may include visualizations.

4. Optional:  Select a widget to see more details of the data in list view.
If you have edit access, you can update the details of an individual record directly from the list 
view when necessary.

Related topics

Create a dashboard

Duplicate a dashboard

Share a dashboard

Add a Platform Analytics dashboard

Create a dashboard

In the Platform Analytics  experience, you can create shareable dashboards with data 
visualizations, filters, and other elements. You can use the available elements in the inline editor 
to create different types of widgets as needed.

Before you begin
Role required: sn_align_core.apw_user
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About this task
Dashboards consolidate data from multiple sources into a single, easily digestible format. Each 
widget within a dashboard displays key data and metrics and may include visualizations.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the dashboard header, select the More actions icon ( ) and then select Create new.

3. On the New dashboard window, fill the details.

a. Enter a name for the dashboard in the Name  field.

b. Optional:  Enter a brief description for the dashboard in the Description  field.

c. Select Create new dashboard.

Result
The dashboard has been created.

What to do next
Edit a dashboard as needed by adding sections, filters, images, lists, process mining maps, and 
rich text. For more information, see Edit a dashboard.

Related topics

View a dashboard

Duplicate a dashboard

Share a dashboard

Add a Platform Analytics dashboard

Edit a dashboard

Customize or edit a dashboard as needed by adding sections, filters, images, lists, process 
mining maps, and rich text. If the dashboard has been shared, any changes you make are 
applied globally.

Before you begin
Role required: sn_align_core.apw_user

About this task

Note: 

• You can edit dashboards that you own or those you’ve been granted permission to edit.

• Only an administrator can edit the out-of-the-box dashboards, including the Product 
Idea Dashboard, Feedback Dashboard, Strategy Execution Dashboard, and Execution 
Dashboard. However, you can duplicate an out-of-the-box dashboard  and customize it as 
needed.

You can use the following elements to create or edit your dashboard.

Dashboard elements in Strategic Planning

Element Description

Data visualization Enables you to present a visual representation 
of current instance data or temporary data that 
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Dashboard elements in Strategic Planning  (continued)

Element Description

you’ve imported. Data visualizations include 
visualizations that you create in the dashboard 
designer and data visualizations from the 
library.

Filter Enables you to filter the visualizations on a 
dashboard based on specified criteria. You 
can put filters either on the individual tabs 
or above the tabs so that the filter applies to 
elements every tab. Filters include both data 
filters and domain filters. You can create filters 
in the dashboard designer or select them from 
the library.

Heading Provides a place for text at the top of a 
dashboard or section of a dashboard. 
Formatting for headings is limited to six 
heading levels.

Image Holds static or animated images on the 
dashboard.

List - Simple Shows table data that you can customize for 
the dashboard audience.

Process Mining - Map Maps the different states that are part of your 
process and the transitions between those 
states. See which states the objects of the 
process are in and the speed with which they 
change state. Requires an existing Process 
Mining project.

Rich text Holds text that you can format either as text 
or as html, including font selection, text size, 
highlighting, and hyperlinks. To edit HTML 
markup, open the HTML editor from the 
Configuration panel and select the Code tags 
< > icon.
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the Change dashboard drop-down, select the dashboard you want to edit.

The selected dashboard appears.

3. From the dashboard header, select Edit.

4. Drag to move the widget or resize it as required.

5. From the dashboard header, select Save.

6. From the dashboard header, select Exit editing mode.
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Result
The dashboard is updated with the latest changes.

What to do next

• Add more elements and customize your dashboard as required.

• For detailed instructions on editing a dashboard using the Platform Analytics  experience in 
Strategic Planning, see Edit Platform Analytics dashboards .

Related topics

View a dashboard

Create a dashboard

Duplicate a dashboard

Share a dashboard

Add a Platform Analytics dashboard

Duplicate a dashboard

If the dashboard you want to create is similar to an existing one, duplicating the existing 
dashboard saves your time. After duplicating the dashboard, you can customize the tabs and 
widgets as required.

Before you begin

• Users or groups that you want to share the dashboard with must have the 
sn_align_core.ap_read_only or sn_align_core.apw_user role to get the read or edit access to 
the portfolio plan respectively.

• When you duplicate a dashboard, you copy all settings and details of the original. Content that 
exists locally on the original dashboard is duplicated onto the new dashboard. If the original 
dashboard contains references to content in a library, such as a shared visualization, the 
references are duplicated. The role requirements for editing an element in a library apply to the 
latter.

Role required: sn_align_core.ap_read_only

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the Change dashboard drop-down, select the dashboard that you want to duplicate.
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The selected dashboard appears.

3. From the dashboard header, select the More actions icon ( ) and then select Duplicate.

4. On the Duplicating dashboard window, fill the details.

a. Enter a name for the portfolio plan in the New name  field.
By default, the name is ABC (Copy)  where ABC is the name of the dashboard you 
duplicated from.

b. Optional:  Enter a brief description of the goal in the Description  field.

c. Select Duplicate.

Duplicating the dashboard may take some time. Select Continue in background  to keep using 
the application in the meantime.

Result
The dashboard is copied with the new name. The appearance of the dashboard is identical to 
the original.

What to do next
Edit a dashboard as needed by adding sections, filters, images, lists, process mining maps, and 
rich text. For more information, see Edit a dashboard.

Related topics

View a dashboard

Create a dashboard

Share a dashboard

Add a Platform Analytics dashboard

Share a dashboard

Share a dashboard with stakeholders, planning managers, portfolio managers, or product 
managers to provide visibility into work progress and foster collaboration. You can grant either 
view-only rights or both view and edit rights to a shared dashboard.

Before you begin
Role required: sn_align_core.ap_read_only

About this task
Users or groups you want to share the dashboard with must have the appropriate roles assigned 
to access shared dashboards:

Required roles to access dashboards

Dashboard Role required

• Strategy Execution Dashboard

• Execution Dashboard

sn_align_core.ap_read_only

Note: 
To view data in financial-related and 
capacity-planning-related widgets, users 
must have the appropriate roles.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

794



Required roles to access dashboards  (continued)

Dashboard Role required

• Product Idea Dashboard

• Product Feedback Dashboard

pf_read

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Dashboards.
By default, the Execution Dashboard appears on the Dashboards page.

2. From the Change dashboard drop-down, select the dashboard you want to share.

The selected dashboard appears.

3. From the dashboard header, select the More actions icon ( ) and then select Share.

4. On the Share Dashboard window, fill the details.

a. Enter a user name or group name in the Grant access to  field to provide access to individual 
users or user groups, respectively.
You can also select a role to grant dashboard access to all users assigned that role.

b. Optional:  Select Allow recipients to add, edit, or delete sharing permissions associated 
with this dashboard  to enable users to grant access to new users and modify or remove 
existing permissions.

c. Select Add as viewer  or Add as editor  as required.

Note: 
You can select Add as editor  only if you have the sn_align_core.apw_user role 
assigned to you.

The selected users, groups, and roles appear under Manage Access.
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You can also manage sharing permissions by selecting a user, group, or role and enabling 
the Can share  option.

d. Select Confirm.

Result
The roles, groups, and users you have shared the dashboard with appear when you reopen the 
dialog, along with the rights you have given them.

What to do next
You can change the rights of whom you have shared the dashboard with in the Share Dashboard 
dialog, under the Can view/Can share list for each user, group, or role.

Related topics

View a dashboard

Create a dashboard

Duplicate a dashboard

Add a Platform Analytics dashboard

Add a Platform Analytics  dashboard

If you have existing dashboards created using Platform Analytics, you can add them to the 
Strategic Planning Workspace  to access them directly from a single location.

Before you begin
Role required: sn_align_core.apw_user
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About this task
You can add any Platform Analytics  dashboard to Strategic Planning Workspace.

Procedure

1. Navigate to All  > Platform Analytics  > Analytics Center.
The Dashboards section appears on the page.

2. Select a bookmarked or certified dashboard from the Bookmarked  or Certified  tabs, 
respectively.
If the dashboard you want to add is not bookmarked or certified, select View all  from the 
Dashboards section, and then select the dashboard from the Dashboards page.

The selected dashboard appears.

3. From the dashboard header, select Edit.

4. From the dashboard header, select the View dashboard details icon ( ).

a. In the Details side panel, fill in the Dashboard visibility  field with Strategic Planning 
Workspace.

5. From the dashboard header, select Save.

6. From the dashboard header, select Exit editing mode.

Result
The dashboard appears in the Strategic Planning Workspace.

Related topics

View a dashboard

Create a dashboard

Duplicate a dashboard

Share a dashboard

Next Experience for Demand Management  in Strategic Planning
Create, evaluate, and prioritize demands throughout the demand life-cycle using Next 
Experience for Demand Management.

Next Experience for Demand Management  gives organizations and teams a structured way to 
capture, assess, and prioritize different types of work before committing to execution. Using Next 
Experience for Demand Management, demand managers can review incoming requests, assess 
business cases and capacity, estimate costs, evaluate risks, and decide which demands are 
worth moving forward. Playbooks allow teams to define different governance processes as well.

Next Experience for Demand Management  comes with the Playbook, Details, and Docs pages 
and is available for users with the Strategic Portfolio Management  (SPM) Pro license.

Key benefits of Next Experience for Demand Management:

• Consistent demand intake and evaluation process - Next Experience for Demand Management 
enables a structured workflow where each demand progresses through defined evaluation 
stages such as intake, capacity and assessment, financial assessment, and approval.

• Centralized visibility into demand information - Next Experience for Demand Management 
provides a single interface to view all demands and their associated details such as business 
cases, capacity, and financials. This feature eliminates the need to cross-reference multiple 
forms, modules, or applications to compile a complete picture of a demand.
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• Playbook-guided demand life-cycle - Playbooks define the sequence of stages and activities 
that a demand must go through such as creation, planning, assessment, and approval. Each 
stage contains a set of prescribed activities that must be completed before the demand 
transitions to the next stages. Using playbooks, you can define your own processes according 
to your requirements.

• Consolidated data for demand prioritization - Next Experience for Demand Management 
provides demand details, capacity and risk assessment outputs, financial summaries, and 
progress indicators in a unified view. This feature helps demand managers to compare, rank, 
and prioritize demands based on any defined criteria of an organization.

• AI system integration through playbook activities - The AI playbook enables the association of 
AI systems to a demand through a playbook activity. This feature enables demand managers to 
associate a demand with an AI system from directly within the demand workflow.

• AI-assisted record refinement and summarization - Using the Now Assist for Strategic Portfolio 
Management (SPM)  skills, you can expand or condense text content in text fields and 
summarize the demand.

Get started

Explore

Learn about Next Experience for Demand 
Management features and business value.

Configure

Learn how to configure Next 
Experience for Demand Management.

Use

Create and manage demands, 
use playbooks, and manage 

financials and resources.

Reference

Get details about demand components like 
roles, tables, properties, forms, and lists.

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support
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Exploring Next Experience for Demand Management

Next Experience for Demand Management  helps you to create, evaluate, and prioritize demands, 
throughout the demand life-cycle.

Next Experience for Demand Management  overview

Next Experience for Demand Management  is a centralized workspace experience that 
streamlines how organizations capture, evaluate, and progress demands through their life-
cycle. It brings together all demand‑related  activities, such as intake, qualification, and task 
management, into a single interface. By consolidating access to demands, tasks, resources, 
financials, and supporting records, the workspace eliminates the need to navigate across 
multiple modules.

Next Experience for Demand Management  gives product owners, portfolio managers, and 
demand managers a comprehensive overview of all active and incoming demands. It enhances 
planning accuracy by providing structured ways to define demand scope, assess capacity, 
estimate effort, and evaluate financial and strategic impact. With guided governance through 
Playbooks, the Next Experience for Demand Management  helps teams prioritize work effectively, 
improve decision‑making,  and ensure consistent progression of demands from intake to 
completion.

Next Experience for Demand Management  benefits

Benefit Feature

Capture a new business need and kick off 
structured governance from intake.

Create a demand and start the intake flow. For 
more information, see Create a demand.

Use advanced filtering options to find specific 
demands based on criteria such as status, 
start and end dates, and project type.

Filter and sort demands. For more information, 
see Demands list view.

Define different governance processes for 
demands.

Use playbooks (default and custom) for 
demand governance processes with low 
code/no code changes. For more information, 
see Use Playbooks.
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Next Experience for Demand Management  benefits  (continued)

Benefit Feature

Add and manage work needed to progress a 
demand to approval or delivery readiness.

Create and manage demand tasks (including 
time card submission). For more information, 
see Create and manage demand tasks.

Collaborate on specifications, notes, and 
decisions within the demand record.

Use Docs to co-author content directly from 
the demand. For more information, see Docs 
for demands in Next Experience for Demand 
Management.

Track risks, issues, and decisions to maintain 
traceability and control.

Add or associate RIDAC records with the 
demand. For more information, see Add and 
manage RIDAC records.

Plan and control financials associated with a 
demand.

Create cost plans, generate labor costs, and 
manage expense lines. For more information, 
see Managing financials for demands.

Create financial baselines to track variance 
over time.

Create demand baselines to track the demand 
finances. For more information, see Create 
financial baselines.

Quantify expected value for business cases. Create and manage monetary and non-
monetary benefit plans for your demand 
and associate them to each other. For more 
information, see Create and manage benefit 
plans.

Align work capacity with demand scope and 
timelines.

Create and manage capacity for a demand. 
For more information, see Create and manage 
resource assignments.

Progress qualified demands into downstream 
delivery entities.

Create entities from a demand such as 
projects, enhancements, and changes. For 
more information, see Create an entity from a 
demand.

Summarize demands and refine them using 
Now Assist.

Summarize a demand record from its details 
and refine the text field values of a demand. 
For more information, see Now Assist skills in 
Next Experience for Demand Management.

Link AI systems to a demand directly from Next 
Experience for Demand Management.

Associate AI systems with your demand as 
and when necessary. For more information, 
see Create AI systems.

Demand workflow

The demand workflow defines the life-cycle of a request, from initial intake through assessment 
and approval to downstream execution. This structured approach ensures that each request is 
evaluated consistently, aligned with business objectives, and supported by the right processes 
before any resources are committed.

Workflow overview

The end-to-end life-cycle for managing demands is described in the following table. This 
workflow confirms that the demands are progressively refined, validated, and aligned with 
business and strategic objectives.
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Note: 
The demand workflow overview table describes the traditional demand management 
process. You can customize the states and activities according to the requirements of your 
organization by defining your custom playbook.

Demand workflow overview

Task Description
Demand states 
involved

Roles involved

Create a demand Demands enter the system via 
Service Catalog, Idea Portal, or 
directly by demand managers:

• Business users can submit an 
idea via the Service Catalog 
or Idea Portal. These ideas 
are evaluated by demand 
managers and promoted to a 
demand, if necessary.

• Business users can bypass the 
ideation process and submit 
a demand directly from the 
Service Catalog.

• Demand managers or demand 
users can directly submit 
demands from the Next 
Experience for Demand 
Management.

Draft Business user, 
demand manager, 
demand user

Complete demand 
details

The demand manager or demand 
user reviews and adds required 
details. Demand managers can 
create and assign demand tasks 
to gather more information, if 
necessary.

The demand is moved from the 
draft to the submitted state once 
the basic demand details are 
added.

Draft → 
Submitted

Demand manager, 
demand user

Refine and finalize 
demand

The demand manager completes 
all required information (size, 
impact, business case, timeline, 
resources, costs/benefits, 
stakeholder registry, strategy 
alignment). They can assign 
tasks or request SME (subject 
matter expert) support, whenever 
required.

Submitted Demand manager

Move demand to 
screening

The demand manager moves the 
demand to screening.

Submitted → 
Screening

Demand manager
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Demand workflow overview  (continued)

Task Description
Demand states 
involved

Roles involved

The assessments are sent 
to the stakeholders to score 
the demand once it is in the 
screening state.

Complete 
assessments

Stakeholders complete and 
submit assessments for scoring.

Screening Stakeholder

Move demand to 
qualified

The demand moves to the 
qualified state once the required 
assessments are submitted.

• Next Experience for Demand 
Management  updates the state 
automatically.

• Demand manager manually 
sets the demand to qualified 
while it is in screening. For 
example, when assessments 
are delayed or not required.

Screening → 
Qualified

Demand manager, 
Next Experience for 
Demand Management

Review demand Stakeholders review the demand 
for approval or deferral.

Qualified Stakeholder

Approve/Defer a 
demand

The demand manager sets 
demand as approved (moves 
forward for execution) or deferred 
(moves to Deferred state).

Qualified → 
Approved/
Deferred

Demand manager, 
demand approver

Convert demand 
to strategic/
operational entity

Once the Demand is approved, 
the demand manager creates the 
selected entity such as project, 
enhancement, or Enterprise Agile 
Planning  (EAP) entities.

The created entity is based 
on the values in the Category 
and Type  fields of the Demand 
record.

Depending on the type of record 
created, the demand data is 
migrated to the created entity.

Approved Demand manager

Complete 
demands

Based on the selection in the 
Close Demand  field, a demand 
is completed automatically when 
converted entity is completed, 
or manually by the demand 
manager at any state.

Approved → 
Completed

Demand manager, 
Next Experience for 
Demand Management
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Playbooks in Next Experience for Demand Management

Playbooks in Next Experience for Demand Management  provide a guided, structured approach 
to managing a demand from initiation to completion. Playbooks focus specifically on helping 
demand teams follow the standard demand life-cycle, confirming every demand progresses 
consistently and no critical steps are missed. You can define your playbooks according to your 
requirements.

Purpose of Playbooks in Demand Management

Playbooks provide a structured way to manage work by guiding teams through predefined steps. 
It shows what to do, when to do it, and where to find the tools or information required to complete 
each task. You can apply a playbook to processes such as managing a demand, resolving an 
issue, launching a product, onboarding new employees, or define key steps of a process. For 
more information on playbooks and how to create them, see Workflow studio playbooks .

In Next Experience for Demand Management, playbooks help demand managers and reviewers:

• Understand exactly which activities must be completed at each demand stage.

• Track required inputs, approvals, and validations for demand progression.

• Confirm that demand evaluation, prioritization, and planning follow the organization’s standard 
governance.

• Provide built‑in  process guidance within the demand record, reducing the need to rely on 
informal or undocumented knowledge.

• Maintain process consistency across all demands, regardless of the requester or manager.

• Enable you to define multiple standardized governance processes across the organization.

How Playbooks work for demands

When a playbook is applied to a demand:

• Demand life-cycle stages such as ideation, assessment, prioritization, and planning are 
outlined.

• Each stage contains activities and tasks tailored to demand requirements, such as defining 
scope, estimating effort, documenting benefits, or securing stakeholder approval.

• Playbooks guide demand managers through dependencies before the demand can move 
forward.

• Demand records automatically capture progress and trigger actions such as assessments and 
approvals as the tasks are completed.

For example, a demand about a Customer Self‑Service  Portal enhancement uses a playbook to 
guide its progress as follows:

• The ideation stage prompts the demand manager to capture objectives and benefits.

• The assessment stage guides effort, cost, and risk evaluation.

• Prioritization helps validate scoring and funding.

• Planning finalizes the scope and links the demand to a potential work entity.

As each stage is completed, the playbook ensures that the demand follows the standard life-
cycle without missing any required steps.

Playbook benefits

Playbooks add value to demand management by:
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• Standardizing demand intake: Ensuring required information is captured early.

• Providing step-by-step instructions: Useful for new demand managers or occasional users.

• Supporting governance: Ensuring stage gating for evaluation and approval.

• Improving visibility: Showing exactly where a demand sits in the life-cycle and what is blocking 
its progress.

• Integrating workflows: Using Flow Designer to set up different business logic for each playbook 
flow.

Types of Playbooks

• Demand default playbook - The default demand playbook is a stage-gate playbook. In a stage-
gate playbook, the stages and tasks must be completed in a linear order. Each stage must be 
finished before moving to the next one. The stages are visible only when all activities in the 
previous stage are completed or skipped. After completing a stage, demand managers can still 
return to previous stages if needed.

• AI playbook - The AI playbook is available for a demand when the AI Control Tower plugin is 
installed and the investment type of the demand is set to artificial intelligence. This playbook 
has an additional AI checkpoint stage where you can associate new or existing AI systems to 
your demand.

Note: 

• You can use the demand default playbook and customize it according to your 
organization's requirements. For more information about the stages and activities of this 
playbook, see Demand default playbook stages and activities.

• You can also create a demand playbook according to your requirements. For more 
information, see Create and configure playbooks .

Related topics

Create and customize playbooks

Use Playbooks

Demand default playbook stages and activities

Now Assist  skills in Next Experience for Demand Management

Now Assist for Strategic Portfolio Management (SPM)  provides AI-powered skills for demand 
records that help you quickly understand demand details and refine records. These skills 
improve planning efficiency and support informed decision-making.

Demand summarization

The demand summarization skill reviews the fields and related lists of a demand record and 
helps generate a clear summary. Use this skill to quickly understand the key details of a demand 
without reviewing individual fields, comments, and work notes.

The generated summary is displayed in a summary card on the demand record. You can copy the 
summary for further use.

For more information, see Summarize demands with demand summarization skill.
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Refine records

The refine record skill improves demand quality by enabling AI-assisted text refinement directly 
within the text fields of demand records. Using the skill, you can elaborate on a brief description 
or shorten lengthy content without losing key information. This feature ensures demands are 
clear, complete, and actionable from the start.

The skill considers other fields in the demand form to generate contextually relevant content. It 
reduces rework caused by missing or unclear information and helps demand managers create 
well-structured records more efficiently. For more information, see Improve efficiency and quality 
using refine records skill with Now Assist Context Menu.

Related topics

Now Assist for Strategic Portfolio Management (SPM)

Exploring Now Assist for Strategic Portfolio Management (SPM)

Summarize demands with demand summarization skill

Improve efficiency and quality using refine records skill with Now Assist Context Menu

Configuring Next Experience for Demand Management

Configure your Next Experience for Demand Management  to assess and promote demands to 
projects, enhancements, changes, defects, or Enterprise Agile Planning  (EAP) entities.

Next Experience for Demand Management  planning
Use the following table to identify what you must define before setting up the 
Next Experience for Demand Management.

Item name Description

Roles Define who can access and work in the 
Next Experience for Demand Management. 
Includes identifying workspace administrators, 
demand managers, approvers, and reviewers 
who participate in the demand process.

Stakeholders Identify individuals or groups who review 
or need visibility into demand items. 
Stakeholders provide domain insight during 
evaluation. For more information, see Populate 
the stakeholder registry for demands.

Integrations Set up Strategic Planning to work with 
Demands. For more information on how 
to define this integration, see Configuring 
Strategic Planning with PPM, Agile 2.0, and 
SAFe.

Information model Specify the fields and attributes required to 
capture demand data. Includes form layouts, 
required fields, and custom data elements.

Evaluation criteria Define the metrics used to assess and 
compare demand items. Common criteria 
include business value, complexity, cost 
estimates, and alignment to strategy. For more 
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Next Experience for Demand Management  planning
Use the following table to identify what you must define before setting up the 
Next Experience for Demand Management.

(continued)

Item name Description

information, see View an assessment metric 
category.

Resource considerations Determine what resource related information 
must be associated with demand items, such 
as estimated effort or team availability.

Workflow expectations Describes the life-cycle stages for a demand 
item, from creation to review, approval, or 
conversion through Playbooks.

Playbooks Define or verify that the demand playbooks 
are in accordance with the processes of your 
organization. For more information, see Create 
and customize playbooks.

Dependencies with other applications Identify related workspaces or applications 
are required with Next Experience for Demand 
Management, such as Project Workspace  or 
Resource Management Workspace. Ensures 
consistent data across applications.

Populate the stakeholder registry for demands

Add users to the stakeholder registry so that Next Experience for Demand Management  can 
automatically populate the stakeholder list when demand users create a demand.

Before you begin
Role required: pps_admin

Procedure

1. Access the Stakeholder Register record form in one of the following ways.

◦ Navigate to All  > Project Administration  > Settings  > Stakeholders.

◦ Navigate to a demand playbook or the Stakeholders  tab in Details  page, and select New. 
For more information, see Access demands.

2. On the Stakeholder Register record form, fill in the fields.
For a description of the field values, see Stakeholder register form.

3. Select Submit.

Note: 
When adding a user to the stakeholder registry, the combination of the user and the 
assigned portfolio must be unique. However, there can be multiple records for the same 
user but with different portfolios.

Configure a custom risk rank and risk value

Configure custom risk ranks and value scores to rate the impact and probability factors for a risk.

Before you begin
Role required: pps_admin
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About this task
Use the Risk Value Lookup module to set up the risk rank and risk value for a specific 
combination of risk impact and probability. The system uses these values to determine the 
degree of risk (Absolute, High, Medium, and Low) based on the impact and probability factors of 
a risk.

The value in the Probability  field is multiplied by the value of the Impact  field to generate the 
values for the Risk rank  and corresponding Risk value  in the Create New Risk form.

By default, you can use the following impact, value, and probability scores for a risk to create a 
risk rank and risk value score:

• Absolute

• Low

• Medium or Moderate

• High

For example, a risk might have high probability and medium impact but you might want to 
consider it as an overall low risk for the demand. In that case, you would configure the Risk Value 
Matcher form with the following values:

• Impact = 2 Medium

• Risk Rank Color = Green

• Probability = High

• Probability Number = 1

• Risk Value = 3 Low

In this case, the calculated risk rank and value are as follows:

• Calculated risk rank = 2

• Calculated risk value = 2

The following image illustrates a Risk 

form.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Risk Value Lookup.

2. Select New.

3. On the risk value lookup form, fill in the fields.
For a description of the field names, see Risk value lookup form.

4. Select Submit.
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View an assessment metric category

View assessment metric categories that are used with assessment metric types and assessment 
metrics.

Before you begin
Role required: pps_admin

About this task
Demands come with an assessment metric type named Demand, five default assessment metric 
categories, and assessment metrics.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Assessments Metric Categories.

2. Open an assessment metric category to review it.
The following default assessment metric categories are available with demands.

Demand assessment metric categories

Assessment 
metric 
category

Data source Description

Size T-Shirt size  field on the demand form. Assesses demand size 
relative to the size of other 
demands.

Strategic 
Alignment

View an assessment category result field in the 
assessment category result for the Strategic 
Alignment metric category. For more information, 
see View an assessment category result

Assesses how closely the 
demand aligns with strategic 
goals of the organization 
compared to other demands.

Risk Rating  field in the assessment category result for 
the Risk metric category.

Assesses demand risks 
compared to other demands.

ROI Impact  and Financial return  fields on the 
Demand form.

Assesses demand return 
on investment compared to 
other demands.

Cost Labor costs, Capital expense, and Operating 
expense  fields on the Demand form.

Assesses demand cost 
compared to other demands.

Multicurrency in Next Experience for Demand Management

Manage and track demand financials in your corporate currency, regional currency, or project 
currency using the multicurrency feature.

Overview of multicurrency

In global organizations, demands are often managed at one location and executed at another. 
Each location might use different currencies for budget spending, making it difficult to monitor 
and track financials.

The multicurrency feature in Next Experience for Demand Management  lets you manage and 
track demands from any geographic location in any currency. You can monitor demand financials 
in one currency while spending the budget in a different currency, such as your functional 
currency or regional currency. You can also manage your demands in one currency and specify a 
different currency for managing your future projects.
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Activation information

To enable multicurrency features in Next Experience for Demand Management, activate the PPM 
Standard Multicurrency (com.snc.ppm_multicurrency) plugin. This activation:

• Enables the demand currency view in demand, cost plan, and benefit plan forms.

• Enables you to manage simple demand financials, cost plans, benefit plans, and budgets in 
the demand currency

• Automatically activates the PPM Standard (com.snc.financial_planning_pmo) plugin, giving 
you the option to switch between the default view and demand currency view

Currency preferences

After activating the plugin, specify your currency preference for managing demand financials. 
You can select your functional currency, a regional currency, or a local currency. For more 
information, see Select demand currency preference.

Demand currency view

The Demand Currency view displays multicurrency fields in addition to the standard demand 
form fields. Enable this view from the form context menu.

You can designate a currency other than the functional currency as the processing demand 
currency. The Demand currency  field appears on the Financials section of the Demand form, 
where you can select any active currency from the Currencies [fx_currency] table.

Note: 
The Demand currency field becomes read only once you create a cost plan, cost plan 
breakdown, benefit plan, or benefit plan breakdown for the demand.

Multicurrency in demand tasks

Track expenses for demand tasks in demand currency. When a time card for a demand task is 
submitted and processed, the actual cost is calculated based on the rate model, default labor 
rate, or system property rate. View this actual cost in the Demand Task form in the Demand 
currency  and Actual cost in demand currency  fields.

Multicurrency in demand baselines

Compare financial baselines to track demand performance over time. Baseline comparison 
helps you identify and review financial changes made to the demand at various life-cycle stages. 
With the multicurrency feature, you can view financial information in demand currency when 
comparing baselines. You can also configure the baseline view to add fields and view details in 
demand currency. For more information, see Create financial baselines.

Select demand currency preference

Set your currency preference for managing and tracking demand financials from the functional 
currency, regional currency, or local currency.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin
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Procedure

1. Navigate to All  > Project Administration  > Settings  > Preferences-Project.

2. Select a currency option from the Demand currency setup list.

3. Select Save.

What to do next
Enable the multicurrency view in the demand form and other demand-related forms. For more 
information, see Enable demand currency view.

Enable demand currency view

Switch to the demand currency view to track the planned costs of a demand in the selected 
currency.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin or it_demand_manager

About this task
To manage demands in a currency different from the functional currency, demand currency fields 
are added to the demand tables such as dmn_demand and dmn_demand_task.

Tables with demand currency fields

Table Description

Demand [dmn_demand] Demands can be tracked in a different 
currency. When you create a demand, 
select another currency by navigating to the 
Financials  tab and selecting a currency in the 
Demand Currency  field.

Demand Task [dmn_demand_task] Demand tasks delegate cost, effort, risk, and 
benefit assessment activities.

Cost Plans [cost_plan] Cost plans capture the costs of demands.

Cost Plan Breakdown [cost_plan_breakdown] Cost plan breakdowns specify the estimated 
cost and actual cost at a granular level for a 
fiscal period.

Benefit Plan [benefit_plan] When you open the demand form in Demand 
Currency view, fields related to the demand 
currency appear in the Benefit Plans related 
list by default.

Benefit Plan Breakdowns 
[benefit_plan_breakdown]

Benefit plans capture the potential benefits 
accrued when the demand is executed.

Expense Line [fm_expense_line] Expense lines are part of demand cost plans 
and store costs associated with a specific 
resource.

Project Funding [project_funding] Stores the demand target and budget 
expense values for both capital and operating 
expenses for a single fiscal period.
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Procedure

1. Navigate to the form in which you want to enable the demand currency view.

2. Right-click the form header or select the additional actions icon to open the context menu.

3. Select View.

4. Select Demand Currency  from the list.

What to do next
Review the form fields exclusive to the Demand Currency  view. All other form tabs and fields 
remain the same in both default view and demand currency view. Continue entering values as 
you would in the default view. For more information, see Multicurrency fields in demand-related 
forms.

Quick start tests for multicurrency in Next Experience for Demand Management

Validate that multicurrency in Next Experience for Demand Management  works correctly after 
making configuration changes such as applying an upgrade or developing an application. Copy 
and customize these quick start tests to pass when using your instance-specific data.

Danger: 
By default, the system property that is used to run automated tests is disabled to prevent 
you from accidentally running these tests on a production system. To avoid data corruption 
or an outage, run tests only on development, test, and other non-production instances. See 
Enable or disable executing Automated Test Framework tests .

Activate the PPM Standard Multicurrency – ATF Tests plugin (com.snc.ppm_multicurrency.atf) to 
use demand currency quick start tests.

Demand currency test suites tests

Test Description

Verify cost in demand currency on cost plan Validates the calculation of cost plan 
breakdown with budget reference rate and 
verifies the roll up to cost plan in demand 
currency.

Verify benefit in demand currency on benefit 
plan

Validates the calculation of benefit plan 
breakdown with budget reference rate and 
verifies the roll up to benefit plan in demand 
currency.

Related topics

Quick start tests

Upgrade existing demands

Execute scheduled jobs to upgrade your existing active and inactive demands after activating 
the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin
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About this task
Run these scheduled jobs on demand to upgrade your existing active and inactive demands in 
demand currency only when necessary.

Note: 
The jobs can impact performance depending on the number of demands and cost plans. 
Run the jobs only when necessary.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Execute the appropriate scheduled job for your demands.

Create and customize playbooks

Configure playbooks to customize demand workflows or create playbooks for your organization.

Before you begin
Role required: admin

About this task
Next Experience for Demand Management  includes two predefined playbooks available in 
Workflow Studio:

• Demand default

• AI playbook

Note: 
The AI playbook is available only when the AI Control Tower plugin is installed and the 
investment type of the demand is set to artificial intelligence.

These playbooks are ready to use without any additional configuration. Configure playbooks 
only when you must customize an existing playbook or create one for your organization's specific 
demand workflows.

In Next Experience for Demand Management, playbooks are triggered by record creation. A 
playbook is associated with demand records, and the Playbook page appears in the L-2 (level 2) 
menu when a demand meets the trigger condition.

For more information on how to create or customize playbooks, see Configuring playbooks

Procedure

1. Navigate to Workflow Studio  > Playbooks.

2. To customize an existing playbook or create one, create and configure the playbook according 
to your requirement.

◦ To activate a predefined playbook, select the required playbook and define an appropriate 
trigger condition. For more information, see Activate playbooks  and Triggers .

◦ To create a playbook, select New. For more information, see Create and configure 
playbooks .

◦ Multiple playbooks can be enabled at a time. Define trigger conditions so that each 
demand maps to only one playbook type. For more information, see Create and configure 
playbooks .
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Related topics

Building playbooks

Designing playbooks

Playbooks in Next Experience for Demand Management

Use Playbooks

Demand default playbook stages and activities

Managing demands in Next Experience for Demand Management

Next Experience for Demand Management  features support end-to-end planning and 
management of your demands.

All Demands list view

When you navigate to the Next Experience for Demand Management, you land on the All 
Demands  home page. This page displays the demands in a list view. You can create a demand, 
edit a demand, or export demands from this page. For more information, see Demands list 

view.

Access demands

Learn how to navigate to the Next Experience for Demand Management  and open a demand 
from the All Demands  page.

Before you begin
Role required: it_demand_user, it_demand_manager, sn_ppm_read, demand_approver, 
apw_read
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Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Demands.
Demands on the All Demands  home page are displayed 
in a list view. For more information, see Demands list 

view.

2. Select a demand to open it.

◦ If a playbook is available for the demand, the Playbook  page is displayed.

◦ If there are no playbooks associated with the demand, the Details  page is displayed.
If you select the short description of a demand, it opens the demand details in a side panel, 
enabling you to edit them. For more information, see Update the demand details.

3. Optional:  Select Personalize fields  from More Actions to customize the All Demands  page 

view.

4. Optional:  Select Apply.

Note: 
You can also increase or reduce the area occupied by the columns in the data grid by 
dragging the line that separates them.
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Related topics

Demands list view

Create a demand

Create demands to capture your strategic and operational requirements and centralize 
information for stakeholder assessment and prioritization.

Before you begin
Role required: it_demand_manager, it_demand_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Demands  > 

New.

2. On the Demand form, fill in the fields.

Demand form

Field Description

Name Name of the demand.

Start date The preliminary or estimated date when the 
work is initially planned to begin. This date 
helps outline the intended timing for early 
demand planning and prioritization. You can 
set this date during initial demand creation or 
anytime in the planning phase when a rough 
idea forms. This date can be updated until 
the demand is officially approved.

For example, you’re planning for a database 
upgrade to start on 2025-11-01.

This date is changed to Planned start date 
when the demand is converted to a project.
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Field Description

Note: 
When you change the planned start 
date of a demand or project, the 
associated cost plans and resource 
assignments also change. The Change 
Resource Plan and Cost Plan Start 
Date with Demand or Project Start 
Date Change  property controls the 
behavior for a demand date change. 
This property isn’t enabled by default. 
For more information, see Properties 
installed with Project Management.

Due date The preliminary or estimated date when the 
planned work is expected to be completed. 
This date provides an expected completion 
window for planning and stakeholder 
communication. You can set this date 
anytime in the planning phase when a rough 
idea forms and can be updated until the 
demand is officially approved.

For example, you’re planning to complete the 
database upgrade by 2025-12-31.

Note: 
This date is changed to Planned end 
date  when the demand is converted to 
a project.

3. Select Create.
The created demand opens in the Playbook 

page.
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What to do next

• Review and refine the demand details and progress the demand using the playbook stages. 
For more information, see Use Playbooks.

• Review and refine the demand details using the forms and tabs in the Details  page. For more 
details, see Update the demand details.

Related topics

Use Playbooks

Update the demand details

Customize the demand new record form

You can customize the fields displayed on the demand new record form in Next Experience for 
Demand Management  by modifying the APW New view.

Before you begin
Role required: admin

About this task
By default, the demand new record form in Next Experience for Demand Management  displays a 
predefined set of fields. Modifying the APW New view allows you to add, remove, or reorder fields 
to meet your organization's requirements.

Procedure

1. Navigate to All  > Demands  > Demand  > All  > New.

2. Select Additional actions  and navigate to Configure  > Form 

Layout.

3. In the View name  field, select APW New.

4. Add, remove, or reorder fields as needed.

5. Select Save.

Result
The updated field layout is applied to the demand new record form for all users.
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Use Playbooks

Use a playbook to guide a demand through each stage of its life-cycle, from creating the initial 
brief to final approval and completion. Playbooks provide step-by-step activities within each 
stage, ensuring that all required information is captured and governance processes are followed.

Before you begin

• Role required: it_demand_user, it_demand_manager

• As an administrator, ensure that either the default or custom playbooks are activated.

About this task
A playbook defines the standard stages of a demand (for example, Initiation, Planning, 
Execution, Monitoring, and Closure) and includes activities or action items to complete at each 
stage.

Note: 
The playbook presents demand information in a guided, stage-based workflow. The same 
fields and lists are also available in the Details  page of the demand record. You can update 
demand information from either location, and changes made in one are reflected in the 
other.

This task topic follows the demand AI playbook. It’s a standard playbook comprising the following 
seven stages:

• Create demand brief

• Define demand alignment

• Estimate demand cost and effort

• AI checkpoint

• Confirm demand readiness for review

• Approve and finalize demand

• Complete demand
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Note: 
The AI checkpoint stage is available if the AI Control Tower plugin is installed and the 
investment type of the demand is set to artificial intelligence.

Each stage consists of activities, action items, or steps that guide the demand manager in 
successfully completing the demand. You can view the Playbook  menu only if the demand 
matches the trigger condition defined for that playbook.

Note: 
A demand created in Next Experience for Demand Management  opens in the playbook 
page.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Demands.

2. Open an existing demand or create a demand.
For more information on creating demands, refer to Create a demand.

3. Use the default playbook or create or customize one.

◦ To use the default playbook:

a. Select Playbooks  from the L-2 (level 2) navigation menu.

b. Select a stage to view its activities. Each activity displays its status (In Progress, Pending, 
or Complete) and the fields or lists to update.

Note: 
The default playbook is a stage-gate playbook, that is, a stage is unlocked only when 
its prior stages are marked as completed or skipped.

c. Complete the activities within each stage. For more information, see Demand default 
playbook stages and activities.

d. For each activity, perform one of the following actions:

▪ Select Mark Complete  to mark the activity as done and move to the next activity.

▪ Select Save  to save your progress without completing the activity.

▪ Select Skip  to bypass the activity and move to the next one.

Note: 

▪ An activity becomes read-only when you select Mark Complete  or Skip.

▪ A stage is marked as completed once all activities within it are either completed or 
skipped.

▪ Use the Restart  option (available at both the activity and stage levels) to revisit or 
edit completed or skipped activities.

▪ Some stages include an automated task that advances the demand state when all 
activities in the stage are completed. These automated tasks don’t require manual 
action.

◦ To create a playbook, define the trigger condition in Workflow Studio. For more information, 
see Triggers .

For more information on how to create and use playbooks, see Building playbooks  and 
Designing playbooks .

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

819

https://www.servicenow.com/docs/access?context=process-automation-designer-triggers&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer-triggers&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer-triggers&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=building-a-process&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=building-a-process&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=building-a-process&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=playbook-experience-admins&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=playbook-experience-admins&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=playbook-experience-admins&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US


Related topics

Running playbooks

Playbooks reference

Create and customize playbooks

Playbooks in Next Experience for Demand Management

Demand default playbook stages and activities

Update the demand details

Update the details of a demand record in Next Experience for Demand Management  to reflect 
any changes in scope, priority, or capacity.

Before you begin
Role required: it_demand_user, it_demand_manager

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Demands.

2. Update the demand record details in any of the following ways.
For a description of the field values, see Demand form.

Related topics

Use Playbooks

Demand form

Demand default playbook stages and activities

Create and manage demand tasks

Create tasks for a demand to delegate cost, effort, risk, and benefit assessment activities. Assign 
a resource or group to the demand task to track the actual time and effort spent on performing 
the specified activities.

Before you begin
Role required: it_demand_manager

About this task
You create demand tasks to plan the work for demands rather than for the target work entity such 
as a project, change, defect, or enhancement. The resources assigned to a demand task can 
submit the time spent on it using a time card.

Note: 
If you’re creating a demand task with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and Demand Currency view enabled, 
additional fields are available. For more information about the fields that are available 
only in the Demand Currency view, see Multicurrency in Next Experience for Demand 
Management reference.

For more information about demand tasks, see Demand tasks.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.
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3. Select Demand 

Tasks.

Note: 
If the Demand Tasks  tab isn’t visible, select More  and then select Demand Tasks.

4. Add or edit a demand task from the Demand Tasks  tab:

◦ To add a demand task, select New.

◦ To update the details of an existing demand task, select the record.

5. On the Create New Demand Task form, fill in the fields.
For a description of the field names, see Create demand task form.

6. Select Save.

Note: 

◦ To delete a demand task, select the record and select Delete  from the More Actions 
option.

◦ Alternatively, you can create, edit, or delete demand tasks using the Add demand 
tasks  playbook activity. For more information, see Use Playbooks.

After completing your work on the demand task, use the breadcrumb navigation to return to 
the Demand Tasks  tab.

Note: 
Team members can access demand tasks assigned to them from Collaborative Work 
Management. For more information, see Managing SPM work in Collaborative Work 
Management.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create demand task form

Submit a time card for a demand task

The resources assigned to a demand task create and submit a time card or time sheet to record 
the time spent on a demand task. The reported hours are used to calculate the actual cost and 
effort for a demand task.

Before you begin
Role required: timecard_user
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About this task
The resource submits the time card or time sheet to record and track the work performed on 
a demand task. An appropriate approver then has to approve the submitted time card or time 
sheet.

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Create a time card.

3. Fill in the hours for each day spent working on the demand task.

4. Select Submit.

Add and manage stakeholders

Add and manage stakeholders for a demand to delegate assignments and progress the demand 
in its life cycle.

Before you begin
Role required: it_demand_manager

About this task
When a demand is submitted, the demand stakeholder list is populated automatically from the 
associated portfolio. You can also add stakeholders.

A demand can have multiple stakeholders and a stakeholder can be associated with multiple 
demands.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Stakeholders.

Note: 
If the Stakeholders  tab isn’t visible, select More  and then select Stakeholders.

4. Add or edit a stakeholder record:

◦ To add a stakeholder, select New.

◦ To update the details of an existing stakeholder, select the record.

5. On the Create New Demand Stakeholder form, fill in the fields.
For a description of the field names, see Create stakeholder form  form.

6. Select Save.
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Note: 

◦ To delete a stakeholder record, select the record and select Delete  from the More 
Actions option.

◦ Alternatively, you can create, edit, or delete stakeholder records using the Add 
stakeholders  playbook activity. For more information, see Use Playbooks.

After completing your work on the stakeholder record, use the breadcrumb navigation to return 
to the Stakeholders  tab.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create stakeholder form

Add and manage goal/target relationships

Track and manage the relationship between demands and organizational goals or targets 
directly from the Next Experience for Demand Management. Linking demands to goals or targets 
helps ensure alignment with strategic priorities and provides visibility into how each demand 
contributes to broader organizational objectives.

Before you begin
Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the Goal/Target Relationships 

tab.

Note: 
If the required Goal/Target Relationships  tab isn’t visible, select More  and then select 
the required Goal/Target Relationships  tab.

4. Add or edit a goal/target relationship record:

◦ To add a goal/target relationship record, select New.

◦ To update the details of an existing goal/target relationship record, select the record.

5. On the form, fill in the fields.
For field information, see Create goal/target relationship form.

6. Select Save.
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Note: 

◦ To remove a goal/target relationship record:

▪ Select a record from the Goal/Target Relationships  tab and select Remove.

▪ Select Remove  from the More Actions option in the goal/target relationship form.

◦ Alternatively, you can add, edit, or remove goal/target relationship records using the 
Add secondary goals  playbook activity. For more information, see Use Playbooks.

After completing your work on the goal/target relationship record, use the breadcrumb 
navigation to return to the Goal/Target Relationships  tab.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create goal/target relationship form

Add and manage requirements

Define and manage requirements for a demand to capture the functional and technical 
specifications needed for its fulfillment. Keeping requirements up to date within the demand 
record ensures clarity for stakeholders and reduces ambiguity during the demand evaluation and 
approval process.

Before you begin
Role required: it_demand_user, it_demand_manager

About this task
Typically, the stakeholders associated with a demand request have insights into what the 
requirements are for a demand request to be completed. The demand manager can create 
requirements from their inputs.

Demand managers use the Requirement form to describe the requirement and assign an owner 
who is responsible for making sure that the requirement is met. When a requirement is complex, 
demand managers can associate planned tasks, such as project tasks, with the requirement. The 
demand manager assigns and tracks the tasks until they’re complete.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select 

Requirements.
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Note: 
If the Requirements  tab isn’t visible, select More  and then select Requirements.

4. Add or edit a requirement record from the Requirements  tab:

◦ To add a requirement, select New.

◦ To update the details of an existing requirement record, select the record.

5. On the Create New Requirement form, fill in the fields.
For a description of the field names, see Create requirement form  form.

6. Select Save.

Note: 
To delete a requirement record, select the record and select Delete  from the More 
Actions option.

After completing your work on the requirement record, use the breadcrumb navigation to 
return to the Requirements  tab.

Add and manage RIDAC records

Add a Risk, Issue, Decision, Action, or Request Change (RIDAC) record to your demand in the 
Next Experience for Demand Management. Adding RIDAC records enables you to keep a track of 
risks or issues during the demand life cycle and help in analyzing the outcome of a demand.

Before you begin
Role required: it_demand_user, it_demand_manager

About this task
You can select the type of record you want to create, fill in the required details, and associate it to 
your demand. You can use the RIDAC page in Next Experience for Demand Management  to view, 
add, manage, and evaluate all the RIDAC records.

For information about RIDAC records for demand management, see RIDAC (Risk, Issue, Decision, 
Action, and Request Changes) records for a demand.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the required RIDAC tab.

Note: 
If the required RIDAC tab isn’t visible, select More  and then select the required RIDAC 
tab.

4. Add or edit a RIDAC record from the required RIDAC tab:

◦ To add a RIDAC record, select New.

◦ To update the details of an existing RIDAC record, select the record.

5. On the form, fill in the fields.
For field information, see:
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◦ Create risk form

◦ Create issue form

◦ Create action form

◦ Create decision form

◦ Create request change form

6. Select Save.

Note: 
To delete a RIDAC record, select Delete  from the More Actions option in the RIDAC record 
form.

After completing your work on the RIDAC record, use the breadcrumb navigation to return to 
the required RIDAC tab.

Submit a demand

Submit the demand record once the necessary details are provided for a demand.

Before you begin
Role required: it_demand_manager, it_demand_user

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Submit 

demand.

Note: 
The submit option is available only when the demand is in the Draft state.

The demand moves to the Submitted state.

Manage assessment instances and questions

Add and manage assessment instances and questions for a demand to evaluate its feasibility 
and gather structured feedback from relevant stakeholders.
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Before you begin
Role required: admin

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Assessment 

Instances.

Note: 
If the Assessment Instances  tab isn’t visible, select More  and then select Assessment 
Instances.

4. Add or edit an assessment instance record:

◦ To add an assessment instance record, select New.

◦ To update the details of an assessment instance record, select the record.

5. On the assessment instance form, fill in the fields.
For a description of the field names, see Assessment instance form  form.

6. Select Save.

7. Select Assessment Instance Questions.

8. To add a question, select New.

9. On the Create New Assessment Instance Question form, fill in the fields.
For a description of the field names, see Create assessment instance question form  form.

10. Select Save.

Note: 
To delete an assessment instance record, select the record and select Delete  from the 
More Actions option.

After completing your work on the assessment instance question and record, use the 
breadcrumb navigation to return to the Assessment Instances  tab.

Create and manage resource assignments

Create and manage resource assignments for a demand to find the availability of the resources 
and allocate them to the demand tasks. Effective resource assignment ensures that demands 
are adequately staffed and helps demand managers track resource availability and utilization.

Before you begin
Role required: it_demand_manager

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

827



Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Resource 

Assignments.

Note: 
If the Resource Assignments  tab isn’t visible, select More  and then select Resource 
Assignments.

4. Add or edit a resource assignment record:

◦ To add a resource assignment record, select New.

◦ To update the details of an existing resource assignment record, select the record.

5. On the Create New Resource assignment form, fill in the fields.
For a description of the field names, see Create resource assignment form  form.

6. Select Save.

Note: 

◦ To delete a resource assignment record, select the record and select Delete  from the 
More Actions option.

◦ Alternatively, you can create, edit, or delete resource assignment records using the 
Estimate resource requirements  playbook activity. For more information, see Use 
Playbooks.

After completing your work on the resource assignment record, use the breadcrumb navigation 
to return to the Resource Assignments  tab.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create resource assignment form

Recalculate costs of resource assignments of a demand

Recalculate the costs of all active resource assignments of a demand whenever the hourly rates 
change in the associated rate model. This feature helps keep the plan costs are up to date.

Before you begin

• The demand must be active.

• The demand must have an active rate model assigned.
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Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the Resource assignments  tab.

Note: 
If the required Resource assignments  tab isn’t visible, select More  and then select the 
required Resource assignments  tab.

4. Select the resource assignment record that you want to recalculate the costs for.

5. Select the More Actions option and select Recalculate Resource 

Cost.

6. On the Recalculate Resource Cost form, fill in the fields.

Field Description

Start date Start date of the time period for which the 
costs are recalculated.

By default, the field shows the current date.

End date End date of the time period for which the 
costs are recalculated.

By default, the field shows the due date of the 
demand. If the due date isn’t specified for the 
demand, the field is empty.

7. Select OK.

Note: 
Alternatively, you can recalculate the resource costs using the Estimate resource 
requirements  playbook activity. For more information, see Use Playbooks.
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Result

• Recalculates the selected resource costs of all the applicable resource assignments in the 
demand based on the latest hourly rates. The hourly rates are derived from the rate model 
associated with the demand.

• Updates the recalculated resource costs on the respective cost fields on the resource 
assignment form and the Resource assignments  tab.

• Reflects the revised values in the respective cost fields of the demand.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create resource assignment form

Realign resource assignments for demands

Planning and execution of your roadmap involves change in priority or timelines of your work. In 
such cases, you can adjust the resource assignment dates to match with the latest dates of your 
demands.

Before you begin
Migrate resource plans to resource assignments

Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Change the Approved start date  and Planned start date  to meet your organizational priorities.

4. Select Save.

5. Select the More Actions option and select Realign assignments to demand.

Result
In the Resource assignments tab, you can see the Start date of the resource assignments 
aligned with the demand start dates.

View assessment results

View assessment results for a demand to evaluate its feasibility, priority, and alignment with 
organizational objectives. Assessment results provide demand managers with the insights 
needed to make informed decisions on whether to approve, defer, or reject a demand.

Before you begin
Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Assessment Results.
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Note: 
If the Assessment Results  tab isn’t visible, select More  and then select Assessment 
Results.

4. Select an assessment result record to view the details.

Approve demands

Review and approve demands in Next Experience for Demand Management  to move them 
forward in the demand life cycle.

Before you begin
Role required: demand_approver, it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.

Note: 
Users with the demand_approver role only see demands that are in the Qualified state.

For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select 

Approve.

Note: 
The Approve  option is available only when a demand is in the Qualified state.

Create an entity from a demand

Create an entity, such as a work item, from a demand so that you can track work on the demand.

Before you begin
A demand must have been created. For more information, see Create a demand.

The category and type of a demand and the applications you have installed determine the entity 
you can create from it. The available entity types and the applications you must have installed to 
be able to create them are listed in the following table.
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Entity Required application

Enhancement, change, or defect Project Portfolio Suite

Agile Development  entities (story or epic) Agile Development 2.0

Enterprise Agile Planning  (EAP) entities (epic, 
feature, or capability)

Strategic Planning

Role required: it_demand_manager

Note: 
The sn_apw_advanced.eap_user role is required to convert a demand to EAP  entities.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Verify that the values in the Category  and Type  fields are appropriate for the entity you want to 
create.
The options in the Type list change according to the category that you select. For more 
information, see Demand form.

Note: 
The Category  and Type  fields are set to read only when an entity is created from a 
demand. If you delete the created entity, these fields become editable again.

3. Select Save.

4. Create the entity by selecting the appropriate option from the More Actions 

option.
Depending on the category and type of the demand, options related to the entity you can 
create become available.
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Related topics

Use Playbooks

Demand default playbook stages and activities

Reset a demand to draft state

Move a demand back to the Draft state, if necessary.

Before you begin
Role required: it_demand_manager

About this task
A demand can be reset to Draft from the Completed, Approved, Screening, or Submitted states, 
or until an entity such as a project is created from it. The Reset to Draft  option is unavailable if 
the demand is in the Qualified state.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Reset to 

Draft.
A confirmation message appears, if there are:

◦ Active assessments pending with stakeholders, or

◦ Resource assignments are created for the demand

4. Select the check box to replan the allocated resource plans that have no actual hours 
reported.

5. Select OK.
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Result

• The demand is moved to the Draft state.

• All the score values in Assessment Data  tab are reset to default.

• All active assessments for the demand are canceled. New assessments are triggered when the 
demand moves to the Screening state and if the Assessment Required  field on the demand 
form is set to true.

Defer demands

Defer demands in Next Experience for Demand Management  to move them to the backlog. You 
can review them and move them back to any other demand state.

Before you begin
Role required: it_demand_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select 

Defer.

Note: 
You can defer the demands that are not in the Draft or Completed states.

Delete demands

Delete demands to remove them from Next Experience for Demand Management. Demands can 
be deleted only while in the Pending state.

Before you begin
Role required: it_demand_manager, it_demand_user

About this task
When you delete a demand, all data related to the demand, such as risks, demand tasks, 
requirements, and decisions are deleted. However, the stakeholders aren’t deleted from the 
Stakeholder Register [dmn_stakeholders_register] table.

If a project is already created from a demand, its reference is removed from the project along 
with the data related to the demand. However, the project isn’t deleted from the database.
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Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Delete  from the More Actions 

option.

4. Select OK  to delete the demand.

Export demands

Export demand records from the Next Experience for Demand Management  to share data with 
stakeholders or perform further analysis outside the platform.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Demands.

2. Select the demands that you want to export.
You can export all demands on the record page by selecting the check box in the column 
header.

3. Select Export.

4. Select the File Type  as Excel, CSV, JSON, or PDF.
The export file is created in the selected format.
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5. Select the Delivery Type  as Download or 

Email.

6. Provide your preferred email address if you selected Email as the delivery type.

7. Select Export.
The export file is downloaded on your system or mailed to your provided email addressed.

Create AI systems

Create AI systems from directly within the demand workflow and associate them with your 
demands.

Before you begin

• The AI Control Tower  plugin must be installed. For more information, see Activation and 
installation of AI Control Tower .

• The investment type of the demand is set to artificial intelligence.

• Role required: sn_ai_steward

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select a demand record from the All Demands  list.

3. Select Details  from the L-2 (level 2) navigation menu.
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4. Select the Create AI System  button to create an AI system in the AI Control Tower  workspace.
For more information on creating AI systems, see Create AI system 

assets .

What to do next
Associate your demands with the created AI systems:

• Using the AI checkpoint stage in your demand playbook. For more information, see Use 
Playbooks.

• Using the AI Associations  section in the Details  tab.

Summarize demands with demand summarization skill

Summarize demand records using the demand summarization skill. The skill reviews the demand 
fields and related lists and helps create a clear summary of the demand.

https://player.vimeo.com/video/1174987769?
h=cc74855ef5&badge=0&autopause=0&player_id=0&%E2%80%A6

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: it_demand_user, it_demand_manager, sn_ppm_read

If you have custom roles that require access to this skill, update the ACLs (access control lists) 
for those roles that require access. For more information, see Implement access control in Now 
Assist AI agents .

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Demands.

2. Select a demand from the All Demands  list.

3. Navigate to the Details  tab.

4. Select the Summarize  button to generate a summary of the demand.
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Result
The summary generated by Now Assist  is displayed in the summary card.

Note: 
Select the copy icon to copy the generated summary for further use.

Managing financials for demands

Manage budget, cost plans as forecasts, actual expenses as expense lines, generate labor 
costs, and create financial baselines at a required cadence in Next Experience for Demand 
Management.

The following features help you to manage your financials.

• Manage cost plans for your demands. For more information, see Add, edit, or delete demand 
cost plans.

• Add or edit expense lines for your demands to record any planned or unplanned expenses. 
For more information, see Add or edit expense lines.

• Generate labor costs for the fiscal period. For more information, see Generate labor costs.

• Create baselines to capture the financial snapshot of your demands. For more information, see 
Create financial baselines.

Multicurrency

The multicurrency feature enables you to manage the financials of your demands in two different 
currencies, Functional currency and Demand currency. Functional currency is typically defined 
by the admin based as the primary currency, which is used for planning, budgeting, and tracking 
the financials of your planning items.

You can perform the following financial activities in Demand currency.

• Select the Demand currency.

• Track the planned and actual expenses.

• Allocate and manage the budget.

• View simple financials data.

Using this feature, you can work on financial reporting at a global level and see the real-time 
currency conversions of your financial records.
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Organizations operate at a global or multinational level, the work is planned and financed at one 
location and executed at a different location. Each might use a different currency from what was 
used in the planning phase. Multicurrency makes it easy to manage and track your planning 
items using any currency.

You can monitor and track the financials in one currency, and capture the costs in a different 
currency. For more information, see Multicurrency in Next Experience for Demand Management.

Note: 
Once a cost plan, benefit plan or expense line or an investment budget gets created, you 
can't change the Demand currency. You can change the Demand currency as long as there 
are no financial records captured against the demand.

Baselines

Create a baseline to capture a snapshot of the financial changes for your demands. You can 
create on-demand baselines or at a cadence using a scheduler job. For more information, see 
Create a baseline.

Budget allocation

Portfolio managers can manage and approve the budget for demands. The approved budget 
helps demand managers to plan and meet the expenses to execute work. For more information, 
see Allocate budget to a demand.

Benefit plans

Monetary benefit plans capture potential benefits accrued while executing a demand. Non-
monetary benefit plans capture the potential non-financial benefits accrued while executing a 
demand. You can create and manage monetary and non-monetary benefit plans and to capture 
the potential benefits of your planning items. For more information, see Create and manage 
benefit plans.

Add, edit, or delete demand cost plans

Create a cost plan for a required duration to track your planned and actual expenses. Edit cost 
plans to adjust your planned expenses and delete any descoped forecasts.

Before you begin
Role required: it_demand_manager

About this task
The application automatically creates cost plan breakdown records when you save the cost 
plan. The cost plan breakdowns are records that specify the estimated and actual costs and 
the budget at a granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The 
demand cost plans are added to the parent program and portfolio.

If you want to use multiple currencies, create a cost plan for another currency.

If you’re creating a cost plan for a demand with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and Demand Currency view enabled, the fields in 
the Financials  section differ from the Default view. For more information about the fields that are 
available only in the Demand Currency view, see Multicurrency in Next Experience for Demand 
Management reference.
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Note: 
For projects, the cost plan breakdowns specify the estimated cost and actual cost at 
a granular level for a fiscal period of the demand cost plan. These breakdowns are 
recalculated in the project currency. Similarly, the estimated breakdown amounts of the 
planned benefit and actual benefit of the demand benefit plans are recalculated in the 
project currency. The project currency amounts are then rolled up to the cost plan, benefit 
plan, and the project records.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Cost Plans.

Note: 
If the Cost Plans  tab isn’t visible, select More  and then select Cost Plans.

Tip: 
Create financial baselines  immediately after capturing the initial planned costs to have 
a snapshot of your planned costs. Use this baseline to compare it against the baselines 
from later dates, as the work progresses, to identify the variance between initial planned 
costs and actual expenses.

This step helps you to plan for the future expenses and re-forecast the planned costs.

Alternatively, you can create, edit, or delete cost plans and cost plan breakdowns using the 
Estimate financial cost  playbook activity. For more information, see Use Playbooks.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create cost plan form

Create cost plan breakdown form

Create and manage benefit plans

Create a monetary or non-monetary benefit plan to specify the estimated monetary or non-
monetary benefit in a category for a fiscal period. Demand benefit plans capture the potential 
benefits accrued by the demand when the demand is executed.

Before you begin
Role required: it_demand_manager

About this task
The monetary benefit plan breakdown records are automatically created when you save the 
benefit plan. The monetary benefit plan breakdown records specify the estimated and actual 
benefits at a granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The 
Monetary Benefit Plan Breakdowns  tab shows the aggregated benefits for estimated and actual 
benefits for each fiscal period for the demand.

The non-monetary benefit plan breakdown records are automatically created when you save the 
benefit plan by selecting Automatic  or Manual  in the Breakdown Type  field. The non-monetary 
benefit plan breakdown records specify the estimated and actual non-financial benefits at a 
granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The Non-monetary 
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Benefit Plan Breakdowns  tab shows the aggregated benefits for estimated and actual non-
financial benefits for each fiscal period of the demand.

Note: 
Converting a demand to a project or EAP  entity transfers the benefit plan from the demand 
to the target project or EAP  entity.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Add, edit, or delete a benefit plan.

Note: 
When you move the demand dates, the associated benefit plans also change 
accordingly based on whether the benefit plan is tied to the demand start date, or end 
date. The project property  Change Resource Plan, Cost Plan and Benefit Plan Start 
Date with Demand or Project Start Date Change  controls the behavior for demand date 
changes.

Related topics

Use Playbooks

Demand default playbook stages and activities

Associate monetary and non-monetary benefit plans

Monetary benefit plan form

Monetary benefit breakdown form

Non-monetary benefit plan form

Non-monetary benefit plan breakdown form

Associate monetary and non-monetary benefit plans

Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the demand.

Before you begin
Role required: it_demand_manager

About this task
You can associate a monetary benefit plan with a non-monetary benefit plan and vice versa.

Note: 
When you delete a benefit plan, its relationship with the associated benefit plan (if any) is 
also removed.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select the Monetary Benefit Plans  or Non-monetary Benefit Plans  tab.
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Note: 
If the Monetary Benefit Plans  or Non-monetary Benefit Plans  tabs aren't visible, select 
More  and then select the Monetary Benefit Plans  or Non-monetary Benefit Plans  tab.

4. Select the benefit plan that you want to associate.

5. On the Benefit Plan form, fill in the Associated benefit  field with the benefit plan that you want 
to associate.

6. Select Save.
The selected benefit plan is associated with this benefit plan.

Note: 
Alternatively, you can associate benefit plans with each other from the Benefit estimate 
playbook activity. For more information, see Use Playbooks.

Related topics

Use Playbooks

Demand default playbook stages and activities

Create and manage benefit plans

Monetary benefit plan form

Non-monetary benefit plan form

Create financial baselines

Create a financial baseline of a demand, which captures benefit and financial metric information 
(snapshot of cost plan, benefit plan, and demand-level financial metrics) at a particular moment 
in time.

Before you begin
Role required: it_demand_manager

About this task
You can create as many financial baselines as necessary and review the financials changes 
that have been made to the demand since the previous baseline. Any financial baseline doesn’t 
capture the actual cost component of the demand.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. To create a financial baseline of a demand, use either of the options.

4. On the Create New Demand Baseline form, fill in the fields.

Demand form

Field Description

Name Name of the demand baseline.

Demand Demand to which the baseline belongs.
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Field Description

Description Description of the demand baseline.

5. Select Save.

Note: 
To delete a demand baseline, select the record and select Delete  from the More Actions 
option.

After completing your work on the demand baseline, use the breadcrumb navigation to return 
to the Demand Baselines  tab.

Allocate budget to a demand

Set the capital expense (Capex) and operating expense (Opex) budgets in demand or functional 
currency according to the fiscal years. The sum of the Capex and Opex budgets is calculated as 
the total budget in demand currency.

Before you begin
Role required: portfolio_manager

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Demand Budget.

Note: 
If the Demand Budget  tab isn’t visible, select More  and then select Demand Budget.

4. Add or edit a demand budget record:

◦ To add a demand budget record, select New.

◦ To update the details of a demand budget record, select the record.

5. On the Create New Project Funding form, fill in the fields.

Tip: 
You can work on allocating lean budgets at the fiscal period level using the Investment 
Budget. For more information, see Enable lean budgeting for demands.

For a description of the field names, see Create project funding form.

6. Select Save.
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Note: 

◦ To delete a demand budget record:

▪ Select a demand budget record from the Demand Budget  tab and select Delete.

▪ Select Delete  from the More Actions option in the project funding record form.

◦ If the demand doesn’t have a cost plan, start date, and due date, then demand budget 
is distributed from the current month until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan, start date, and due date, then demand budget 
is distributed from the current month until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan and a due date but has a start date, then the 
demand budget is distributed from either:

▪ Start date (if the start date falls in the given budget fiscal year) until the end of the 
demand budget fiscal year.

▪ Start of the demand budget fiscal year until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan and a start date but has a due date, then the 
demand budget is distributed from either:

▪ Current month until due date (if the due date falls in the given budget fiscal year).

▪ Current month until the end of demand budget fiscal year.

◦ If the demand has a cost plan associated, then demand budget is distributed by 
honoring the cost plan fiscal periods.

After completing your work on the demand budget record, use the breadcrumb navigation to 
return to the Demand Budget  tab.

Result
The demand budget for the selected year appears in the Demand Budget  tab. You can select the 
amounts in the list to revise them.

Enable lean budgeting for demands

Enable the Investment Budget option to allocate budgeting for demands at a fiscal period level.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Demands  > Demand  > All.

2. Open the required demand.

3. Select the Additional actions and navigate to View  > APW Default.
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4. Select the Additional actions and navigate to Configure  > Related 

Lists.
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5. Select Investment Budget  from the Available column and add it to Selected column.

6. Select Save.

Manage lean budgeting for demand

Allocate budget for demands at each fiscal period instead of the entire fiscal year to reduce the 
overhead costs associated with traditional approach.

Before you begin

• Lean budgeting is enabled. For more information, see Enable lean budgeting for demands.

• Role required: sn_invst_pln.sn_spm_funding_user

Any user role with this specific role attached can add or manage the investment budgets.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Investment Budget.

Note: 
If the Investment Budget  tab isn’t visible, select More  and then select Investment 
Budget.

4. Add or edit an investment budget record:

◦ To add an investment budget record, select New.

◦ To update the details of an investment budget record, select the record.

5. On the Create New Investment Budget form, fill in the fields.

Investment Budget form details

Field Description

Amount Investment budget amount.

Fiscal period Fiscal period to allocate the budget.

Investment Planning item to allocate this budget to.

Note: 
The current demand is selected by 
default.

Expense type Type of the expense.

◦ Capex  - Budget for capital expenses.

◦ Opex  - Budget for operational expenses.

6. Select Save.
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Note: 
To delete an investment budget record:

◦ Select a demand budget record from the Investment Budget  tab and select Delete.

◦ Select Delete  from the More Actions option in the investment budget record form.

After completing your work on the demand budget record, use the breadcrumb navigation to 
return to the Investment Budget  tab.

Add or edit expense lines

Create an expense line to capture the cost associated with a specific source, such as a user or a 
fixed asset. Expense lines are part of demand cost plans.

Before you begin
Role required: it_demand_manager

About this task
Expense lines on a demand record track the costs incurred during the demand evaluation 
process. You can add multiple expense lines to a single demand, but they can only be used for 
evaluation costs and can’t be linked to cost plans. Only processed expense lines are counted, 
and their total automatically rolls up to the Demand actual costs  field on the demand record.

Note: 
When a demand is converted to a project, the expense lines remain with the demand, while 
the cost plans and budget are moved over to the project.

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Details  from the L-2 (level 2) navigation menu.

3. Select Expense Lines.

Note: 
If the Expense Lines  tab isn’t visible, select More  and then select Expense Lines.

4. Add or edit an expense line:

◦ To add an expense line, select New.

◦ To update the details of an existing expense line, select the record.

5. On the Create New Expense Line form, fill in the fields.
For a description of the field names, see Create expense line form.

6. Select Save.

Note: 
To view the expense allocations associated with the expense line, select Expense 
Allocations.

After completing your work on an expense line, use the breadcrumb navigation to return to the 
Expense Lines  tab.

Generate labor costs

Generate labor costs to view the expenses of resources using resource assignments and cost 
plans.
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Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the Generate labor costs for demands and projects  scheduled job.

3. Select Active.

4. On the Scheduled Script Execution form, fill the fields.
For a description of the field names, see Scheduled Script Execution Form.

5. Select Update.

Tip: 
Alternatively, as an admin, you can activate and define a scheduled job to generate labor 
costs at the required frequency. For more information, see Activate a scheduled job to 
generate labor costs.

Docs for demands in Next Experience for Demand Management

Store and manage documentation for demands from a centralized location in Next Experience for 
Demand Management.

Docs overview

Demand managers can store information for demands using the Docs feature.

• Each demand can have a separate doc page to capture related information. For example, 
create a doc page for business objectives or technical requirements.

• Each demand can have multiple doc pages to help you effectively organize key artifacts.

• Predefined templates such as Project Brief, Product Requirements, Brainstorming Ideas, and 
Meeting Notes are available. Create doc pages using one of these templates or start with an 
empty page.

Features of Docs

The following are the key features of Docs:

• Auto-save content.

• See who is viewing or working on a doc page using the feature of live user presence.

• Create documents using pre-defined templates.

• Use rich text paragraph formatting, which includes headings, lists, alignment, and others.

• Move text blocks to change their placement using block-level editing.

• Tag team members inline or insert tables using the /  command.

• Add reference to other ServiceNow AI Platform  tables to connect work across teams.

• Insert images by uploading files or using web URLs.

Note: 
The experience of inserting Google  Images links might not work.
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Real-time collaboration in Docs

With the feature of real-time collaboration, edit a doc page concurrently with multiple other 
editors. Colored cursors denote the current location of each editor on the page. You can choose 
to show or hide these live presence indicators based on your preference while working on or 
reviewing the content of the page.

Note: 
A huge number of users editing the same block of content simultaneously might result in 
issues with application performance.

Dynamic data linking in Docs

Keep record information in your documentation always current and reduce manual effort with the 
Dynamic data linking feature in Docs. You can now reference any ServiceNow  application record 
and Docs will automatically reflect the latest updates from those records.

For example, if you add a reference to a Project record, the reference shows the latest field 
information of the project in Docs without requiring manual edits. Selecting the project reference 
opens up the project form so that you can view the full details of the project and make any 
necessary changes.

A hover popover displays the details of the mentioned record, providing quick access to 
additional information without leaving the current context.
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Dynamic linking also enables adding references to a particular field of a record, such as 
Assigned to of a Project record.

You can add references from any ServiceNow  table you have access to, with no setup or 
configuration needed.

This feature reduces the need to switch between multiple ServiceNow  applications within your 
instance and helps maintain a single, reliable source of truth for collaborative work, making it 
easier for teams to stay aligned and informed.

Images in Docs

Insert images into your Docs by uploading a file from your device or adding a web URL. Note that 
inserting Google  Images links might not work.

Save images from your CWM documents directly to your device, making it easier to share or use 

them outside of the Docs environment. Click an image to access the download icon ( ), then 
click the icon to save it to your device. Alternatively, right-click the image and use your browser's 
built-in save option.
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Create and manage pages and subpages for demands

Flexibly organize information for your planning items by creating, duplicating, and deleting pages 
and subpages in Next Experience for Demand Management.

Before you begin
Role required:

• Create and manage pages and subpages - it_demand_user, it_demand_manager, 
demand_approver

• Read pages and subpages - apw_read, ppm_read

Procedure

1. Open a demand from the home page of Next Experience for Demand Management.
For more information, see Access demands.

2. Select Docs  from the L-2 (level 2) navigation menu.

3. Create or manage docs in any of the following ways.

Next Experience for Demand Management  reference

Reference information to provide additional details about Next Experience for Demand 
Management  such as the fields, user roles, tables, and multicurrency.

Actual cost and effort calculation for a demand and demand task

Actual cost and effort represent the realized cost and time spent working on demands and 
demand tasks during a specific time period. These values are calculated based on approved 
time cards and hourly rates for resources.

Overview of calculation

Working on demands and demand tasks involves cost and time that add to the overall 
expenditure of converting a demand to a product, feature, or enhancement. Demand managers 
must track the actual cost and effort incurred in assessment and planning activities.
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• The actual cost is calculated by multiplying the hours reported in the time card by the hourly 
rate of the resource.

• The actual effort for a demand task is calculated based on the hours reported in the time card.

• The actual effort and cost for demand tasks roll up to calculate the actual effort and cost for the 
demand.

Hourly rate calculation

The hourly rate for calculating actual cost is derived in the following order:

1. If a rate model is associated with the demand, the actual cost is calculated based on the hourly 
rate defined in the rate model.

2. If a rate model is absent or if an hourly rate isn’t found in the rate model, the hourly rate is 
derived from the default labor rate.

3. If an hourly rate isn’t found in the default labor rate, the hourly rate is derived from the default 
system property.

Resource assignments and Time cards

Don’t create resource assignments for allocating resources or groups to a demand task. 
Resource assignments created in the demand are used for resource estimation of the work entity 
created from the demand. These resource assignments automatically move to the resulting work 
entity when a demand is qualified and converted.

When you submit a time card for a demand, the actual effort and cost aren’t reflected in the 
resource assignment. Resource assignments aren't associated with the demand by default. 
The actual cost and actual effort remain with the demand and aren't transferred to the created 
projects, even if you manually associate a resource assignment.

If a resource spends extra hours working on a demand that aren’t associated with demand tasks, 
this time must also be recorded. The resource submits the time card for recording extra hours 
using the Time Sheet Portal. This extra cost and effort is added to the demand but isn’t reflected 
in the actual cost and effort for the demand tasks.

Demand-level calculations

The actual cost and actual effort for the demand are calculated as follows:

• Demand Actual Cost = actual cost of all demand tasks + actual cost of extra activities

• Demand Actual Effort = actual effort of all demand tasks + actual effort of extra activities

If a demand has no task or assigned resource, you can capture the actual cost by submitting a 
time card against the demand. Once the time card is approved, an expense line is created on the 
demand. The expense line is processed and the actual cost of work for that time card rolls up to 
the demand in the Demand Actual Cost column.

This example demonstrates actual cost and effort calculation for demand tasks and rollup to the 
demand.

Scenario setup - For demand D1, the demand manager creates three demand tasks (DT1, DT2, 
and DT3) and assigns resources R1, R2, and R3 to each task respectively.
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Hourly resource rates

Resource
Hourly rate in the rate 
model

Hourly rate in the 
default labor rate

Hourly rate in the 
system property

R1 $200 $150 $50

R2 $250 $200 $50

R3 $150 $100 $50

Each resource spends eight hours on the assigned demand task and submits a time card.

Scenario 1: Rate derived from the rate model

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 200 * 8 = $1600 250 * 8 = $2000 150 * 8 = $1200

Demand rollup:

• Demand Actual Cost = $4,800

• Demand Actual Effort = 24 hours

Rate derived from default labor rate
(Rate model not associated with demand.)

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 150 * 8 = $1200 200 * 8 = $1600 100 * 8 = $800

Demand rollup:

• Demand Actual Cost = $3,600

• Demand Actual Effort = 24 hours

Rate derived from default system property
(Rate model not associated with demand and hourly rate not found in default 
labor rate.)

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 50 * 8 = $400 50 * 8 = $400 50 * 8 = $400

Demand rollup:

• Demand Actual Cost = $1,200

• Demand Actual Effort = 24 hours

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

853



Data migrated from demands to created entities

Data fields that are migrated from a demand to an entity when the selected entity is created from 
the demand.

Data migrated from a demand to a created project

Data fields are migrated from a demand to a project when the project is created from the 
demand.

Field type Description

Demand The following demand fields are migrated to a 
project:

• Description

• Business case

• Investment Class

• Investment Type

• Risk of performing

• Risk of not performing

• Enablers

• Barriers

• In scope

• Out of scope

• Assumptions

• Business Unit

• Department

• Impacted Business Units

• Business Capabilities

• Priority

• Impact

• Rate Model

• Approved start date

• Approved end date

• Short description

• Program

• Domain

• Goals

• Strategies

• Impacted Business Applications

• Configuration item

• Company

• Urgency

• Project Manager
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Field type Description

• Project currency

• Project calculation

Resource assignments Resource assignments are migrated to a 
project by updating the task reference from 
the demand to project.

Requirements Demand requirements.

Financial records Financial records such as cost plans and 
breakdowns, benefit plans and breakdowns 
(monetary and non-monetary), and demand 
budgets are migrated to a project. This 
process updates the task reference from 
demand to project.

RIDAC RIDAC entities are migrated to a project by 
updating the task reference from demand to 
project. The migrated entities include the risks, 
issues, decisions, project actions, request 
changes, and RIDAC_m2m records.

Assessment The following assessment data fields are 
migrated to a project:

• Risk

• Value

• Score

• T-Shirt size

Stakeholders Stakeholder records.

Project Currency Financial If the multicurrency feature is active, the 
project financial fields are calculated 
according to the project currency and 
reference rate.

Data migrated from demands to Enterprise Agile Planning  (EAP) entities

Data fields are migrated from a demand to an EAP  entity when the entity is created from the 
demand.

Data fields migrated from demand to EAP entity

Field type Description

Demand The following demand fields are migrated to 
the created entity:

• Business Capabilities

• Product

• Primary target

• Team

• Demand manager
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Data fields migrated from demand to EAP entity  (continued)

Field type Description

• Description

• Department

• Priority

• Approved start date

• Approved end date

• Short description

• Primary goal

• Strategic program

• Service offering

• Business service

• Business applications

• Score

• Requested by

• Capital expense

• Operating expense

• Start date

• Program

• Total planned cost

• Investment Class

• Portfolio

• Investment Type

• ROI %

• Rate Model

• Model ID

• Expense type

• Financial benefit

Resource assignments The resource assignments of a demand are 
migrated to the created entity.

Financial records Cost plans and breakdowns, benefit plans and 
breakdowns (monetary and non-monetary), 
and investment budgets are migrated to the 
created entity.

Attachments Demand attachments.

Goal/target relationships Goal/target relationships of the demand.
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Demands list view

The All Demands  home page displays demands in a list view and contains specific UI 
components to create, edit, and export demands.

Actions

The actions available on the home page are listed in this 

table.

All Demands UI

Feature Description

Search Option to search for demands by name.

Filter Option to apply filters on the list. The filter preferences that you 
choose are retained in the filter criteria.

Sort by Option to sort the demand list in ascending or descending order 
based on a selected field.

Group by Option to group the demands by a selected field, such as state 
or stage, for better organization and visibility.

Refresh Option to reload the list.

New Option to create a demand.

Edit Option to edit the selected demands.

Assign to me Option to assign the selected demand to the logged-in user.

Export Option to export the demand list to an external file format such 
as Excel or CSV.

More Actions Option to see more features available in the All Demands  list.

Personalize fields Option to customize the columns displayed in the demand list to 
show only the fields relevant to you.
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Data grid

The data grid shows the list of demands in rows, and the following options to perform actions on 
the rows.

Option Description

Column actions
Group the demands by a column field using 
the action on the header. Point your mouse 
device to a column header to see the context 

menu icon ( ).

Rearrange columns
Enables the dragging of the columns to a 
position of your choice on the grid.

Select row ( ) Choose to select multiple demand rows at 
once.

Cell actions
Show matching or filter out demands by 

selecting the cell context menu ( ) or select 
and hold (or right-click) a cell.

Demand default playbook stages and activities

The default demand playbook includes certain predefined stages and activities. These activities 
guide you through the demand life-cycle, from capturing the initial brief to completing the 
demand.
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Create demand brief

In this stage, capture the foundational information for the demand including the business 
justification, risks, and assumptions.

Create demand brief stage details

Activity Type Description

Define demand details Form Enter the demand name, 
description, and business 
case. For more information, 
see Demand form.

Document risks and 
assumptions

Form Document the risk of not 
performing the demand and 
any assumptions. For more 
information, see Demand 
form.

The demand state will be 
moved to submitted

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

Define demand alignment

In this stage, align the demand with organizational goals, stakeholders, and team members.

Define demand alignment stage details

Activity Type Description

Define business alignment Form Define the business 
classification for the demand. 
For more information, see 
Demand form.

Define strategic alignment Form Define how the demand 
aligns with the organization's 
strategic objectives. For more 
information, see Demand 
form.

Add secondary goals Related list Associate secondary goals 
and targets with the demand.

• You can also add a goal or 
target relationship.

• You can view the details of 
an entry by selecting it from 
the list.

For more information, see 
Demand form.

Update demand dates Form Specify or update the planned 
dates for the demand. 
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Define demand alignment stage details  (continued)

Activity Type Description

For more information, see 
Demand form.

Add collaborators Form Add collaborators to the 
demand and indicate whether 
an assessment is required. 
For more information, see 
Demand form.

Add stakeholders Related list Add stakeholders associated 
with the demand.

You can view the details of an 
entry by selecting it from the 
list. For more information, see 
Create stakeholder form.

Add demand tasks Related list Create demand tasks to break 
down initial planning activities. 
For more information, see 
Create demand task form.

Update EAP  details Form Update the Team  field for the 
Enterprise Agile Planning 
(EAP) entity, to which the 
demand is converted.

Note: 
This activity is available if 
the Type  field is an EAP 
entity.

The demand state will be 
moved to screening

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

Estimate demand cost and effort

In this stage, evaluate the financial and resource requirements for the demand.

Estimate demand cost and effort stage details

Activity Type Description

Update assessment details Form Update the assessment 
information for the demand. 
For more information, see 
Demand form.

Estimate financial cost Related list View and manage cost plans 
associated with the demand.
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Estimate demand cost and effort stage details  (continued)

Activity Type Description

• You can add a cost plan or 
delete an existing one.

• You can view the details of 
an entry by selecting it from 
the list.

For more information, see 
Create cost plan form.

Estimate resource 
requirements

Related list View and manage resource 
assignments for the demand.

You can view the details of an 
entry by selecting it from the 
list.

For more information, see 
Create resource assignment 
form.

Define benefit estimates Related list View and manage benefit 
plans for the demand.

• You can add a benefit plan 
or delete an existing one.

• You can view the details of 
an entry by selecting it from 
the list.

For more information, see 
Monetary benefit plan form 
and Non-monetary benefit 
plan form.

Cost estimates Form Review or update the cost 
estimate details for the 
demand.

The demand state will be 
moved to qualified

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

AI checkpoint

In this stage, associate AI systems with the demand to identify potential AI impacts.

Note: 
If the AI Control Tower plugin is installed and the investment type of the demand is set to 
artificial intelligence, the AI checkpoint stage is available for playbooks.
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AI checkpoint stage details

Activity Type Description

Associate AI systems Form Add AI systems to the demand 
by creating one or selecting 
from the existing systems.

• To create an AI system, 
select the Create new AI 
system  link.

• To link existing systems, use 
the Product  and Impacted 
AI systems  fields.

For more information on creating AI systems, see Create AI system assets .

Confirm demand readiness for review

In this stage, verify that the demand is complete and ready for approval.

Confirm demand readiness for review stage details

Activity Type Description

Align demand and assign 
portfolio/program

Form Review the demand details 
and confirm readiness for the 
approval process.

The demand state will be 
moved to approved

Automated Completing the previous 
activities advances the 
demand to the next state in its 
life-cycle.

Approve and finalize demand

In this stage, confirm the demand details and convert the demand to a work entity.

Approve and finalize demand stage details

Activity Type Description

Confirm details and convert to 
selected entity

Form Review the selected work 
entity type, such as project 
or enhancement, and the 
approved timeline.

Complete demand

This stage is the final stage of the demand workflow.
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Complete demand stage details

Activity Type Description

Review the converted entity Form Review the work entity created 
from the demand to verify that 
the conversion is complete.

Related topics

Create and customize playbooks

Playbooks in Next Experience for Demand Management

Use Playbooks

Demand tasks

A demand task is a unit of work created within a demand to break down initial planning activities 
before converting the demand into an entity.

Demand tasks overview

You can create a demand task from the Demand Tasks  related list to delegate activities that help 
assess demand feasibility.

Demand tasks differ from project tasks in the following ways:

• Planned dates, actual dates, and original dates aren’t supported in demand tasks.

• The due date indicates when the task is targeted for completion and doesn’t affect the 
demand workflow. Project tasks affect project completion dates when planned dates and 
actual dates are changed.

• Nested demand tasks aren’t supported.

• Task constraints such as Start ASAP and Start on a specific date aren’t supported.

• Execution types such as Agile, Waterfall, or Hybrid aren’t supported.

Resource assignment

Resources for a demand task can be assigned using the Assigned to, Additional Assignee 
list, and Assignment Group  fields. Don’t create resource assignments to allocate resources 
or groups to a demand task or submit time spent on the demand. If you associate a resource 
assignment with a demand task, the associated resource plan isn’t transferred to the work entity 
created from that demand.

Resource assignments aren’t associated with the demand by default. Don’t use the resource 
assignments you created for the future work entity to submit time spent on a demand. When you 
submit a time card for a demand, the time and cost incurred aren’t transferred to the work entity 
created from the demand. The time and cost remain within the demand as the demand cost and 
effort. Resources assigned to a demand task can submit the time spent on it using a time card.

Actual cost and effort

The actual effort for work performed on the demand task is derived from the time card. The actual 
cost is derived from the hourly resource rate defined in the rate model, default labor rate, or 
default system property. The actual cost and effort for a demand task roll up to derive the actual 
cost and effort for the associated demand. For more information, see Actual cost and effort 
calculation for a demand and demand task.
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Multicurrency in Next Experience for Demand Management  reference

The multicurrency features in Next Experience for Demand Management  enable you to manage 
and track demand financials in multiple currencies. This section provides field references and 
explains how cost and benefit plan updates recalculate values in demand currency.

Multicurrency fields in demand-related forms

When you enable the Demand Currency  view in Demand, Cost Plan, and Cost Plan Breakdown 
forms, multicurrency fields appear in the Financials section of these forms.

Financials tab of the Demand form

Field Description

Demand currency Currency for managing and tracking the 
demand. The available currency options 
depend on your selection in Preferences-
Project  under Project Administration. 
For more information, see Select demand 
currency preference.

This field becomes read only once you create 
a cost plan, cost plan breakdown, benefit plan, 
or benefit plan breakdown.

Project currency Currency for implementing the project when 
this demand is converted to a project. This 
value carries over to the Project form in Project 
Management.

Capital expense in demand currency Capital expenditure (Capex) for the demand.

Capital budget in demand currency Total capital budget allocated to the demand 
across all fiscal years. Rolled up from the 
Capex budget of the demand.

Operating expense in demand currency Operational expenditure (Opex) for the 
demand in the selected demand currency.

Operating budget in demand currency Total operational budget allocated to the 
demand across all fiscal years in the selected 
demand currency. Rolled up from the Opex 
budget of the demand.

Total planned cost in demand currency Estimated cost of the demand in demand 
currency.

Financial return in demand currency Estimated revenue based on the Total 
planned costs in demand currency  and 
Financial benefit in demand currency  fields.

Financial benefit in demand currency Estimated revenue if the demand is approved 
in the selected demand currency. Rolled up 
from the benefit breakdown of the demand.

Net present value in demand currency Present value of future cash based on the 
given annual interest rate in the selected 
demand currency. A measure for comparing 
money spent today against future expected 
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Financials tab of the Demand form  (continued)

Field Description

financial benefits, helping evaluate overall 
investment performance.

Actual cost in demand currency Total cost incurred while working on a demand 
and demand tasks in the selected demand 
currency.

Multicurrency fields of the Demand Task form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Actual cost in demand currency Total cost incurred while working on the 
demand tasks in the selected demand 
currency. Actual cost populates after the 
assignee creates and submits a time card. 
When the time card is approved, the resource 
rate from the rate card, labor rate, or system 
properties populates this field.

Financials section of the Cost Plan form

Cost Plan form

Field Description

Demand currency Currency specified in the Demand 
currencyDemand currency field of the 
Demand form.

Cost in demand currency Value that is rolled up from the Entered cost 
field of all cost plan breakdowns.

Note: 
Any change to the unit cost, quantity, or fiscal period of a cost plan recalculates the 
amounts in demand currency. See Cost plan updates and cost recalculation in demand 
currency.

Multicurrency fields in the Cost Plan Breakdown form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Cost in demand currency Breakdown amount in demand currency.

Demand currency exchange rate Rate in effect for the period corresponding 
to the cost plan breakdown in the demand 
currency.
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Multicurrency fields in the Cost Plan Breakdown form  (continued)

Field Description

Demand currency exchange rate date Reference date on which the currency 
exchange rate is applied for conversion.

Financials section of the Benefit Plan form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Benefit in demand currency Benefit incurred from demand in demand 
currency.

Actual benefit in demand currency Actual benefit value rolled up from the actual 
benefit in the benefit breakdown.

Multicurrency fields in the Benefit Plan Breakdown form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Benefit in demand currency Benefit incurred from demand in demand 
currency.

Demand currency exchange rate Rate in effect for the period corresponding 
to the benefit plan breakdown in demand 
currency.

Demand currency exchange rate date Reference date on which the currency 
exchange rate is applied for conversion.

Multicurrency fields in the Expense Line form

Field Description

Demand currency Currency specified in the Demand currency 
field of the Demand form.

Amount in demand currency Expense cost in demand currency. Amount 
entered in the Amount field is converted to 
demand currency.

Multicurrency fields in the Demand Budget form

Field Description

Capex budget in Demand Currency Planned expense amount allocated for capital 
expenditure in the selected currency.

Opex budget in Demand Currency Operating expense amount in the selected 
currency.
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Multicurrency fields in the Demand Budget form  (continued)

Field Description

Total Budget in Demand Currency Sum of Capex and Opex amounts in the 
selected currency.

Cost plan updates and cost recalculation in demand currency

Updating the unit cost, quantity, or fiscal period of a cost plan updates all related amount fields in 
the cost plan and its breakdowns. The amounts in the related demand fields are recalculated and 
reflected in the demand currency.

Unit cost, Quantity, and Recurring field changes

When you modify these fields in the Cost Plan form with multicurrency view enabled, the 
following values are recalculated:

• Total planned cost  in demand currency.

• Cost in demand currency  in the Cost Plan Breakdown.

• Capital expense in demand currency, Operating expense in demand currency, and Total 
planned cost in demand currency  fields in the demand.

Fiscal period changes

When you change the fiscal period (start date or end date) in the Cost Plan form, the following 
values are recalculated:

• Total planned cost  and Cost in demand currency  of the cost plan. Cost Plan Breakdown 
records can be added or removed.

• If the Recurring  check box isn’t selected, the Cost in demand currency  value of each Cost 
Plan Breakdown record is recalculated.

• Capital expense in demand currency, Operating expense in demand currency, and Total 
planned cost in demand currency  fields in the demand.

Cost plan breakdown changes

When you change the entered cost in an individual Cost Plan Breakdown record or manually add 
cost plan breakdowns to a cost plan, the following values are recalculated:

• Total planned cost  of the cost plan in demand currency.

• Capital expense in demand currency, Operating expense in demand currency, and Total 
planned cost in demand currency  fields in the demand.

Benefit plan updates and recalculation in demand currency

Updating the entered currency, entered benefit, offset type, or fiscal period of a benefit plan 
updates all related amount fields in the benefit plan and its breakdowns. The amounts in the 
related demand fields are recalculated and reflected in demand currency.

Entered currency, Entered benefit, and Recurring field changes

When you modify these fields in the Benefit Plan form with multicurrency view enabled, the 
following values are recalculated:
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• Total planned cost  in demand currency.

• Benefit in demand currency  in the Benefit Plan Breakdown.

• Financial benefit in demand currency  field in the demand.

Offset type changes

When you change the offset type (start date or end date) and specify the offset period and 
duration in the Benefit Plan form, the following values are recalculated:

• Total planned benefit  and Benefit in demand currency  of the benefit plan. Benefit Plan 
Breakdown records can be added or removed.

• If the Recurring  check box isn’t selected, the Benefit in demand currency  value of each 
Benefit Plan Breakdown record is recalculated.

• Financial benefit in demand currency  field in the demand.

Fiscal period changes

When you change the fiscal period (start date or end date) in the Benefit Plan form, the following 
values are recalculated:

• Benefit in demand currency  and Total planned benefit  of the benefit plan. Benefit Plan 
Breakdown records can be added or removed.

• If the Recurring  check box isn't selected, the Benefit in demand currency  of each Benefit Plan 
Breakdown record is recalculated.

• Financial benefit in demand currency  field in the demand.

Benefit plan breakdown changes

When you change the entered benefit in an individual Benefit Plan Breakdown record, the 
following values are recalculated:

• Benefit in demand currency  of the benefit plan.

• Financial benefit in demand currency  field in the demand.

Form field information

Field information for forms used in Next Experience for Demand Management.

Assessment instance form

The assessment instance form information is used to create and edit an assessment instance for 
a demand.

Assessment Instance

Field Description

Number Auto-generated unique identifier for the 
assessment instance.

State Status of the assessment instance. Defaults to 
Ready to take.

Metric type Type of metric used to define the evaluation 
criteria for the assessment.
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Assessment Instance  (continued)

Field Description

Assessment group Group responsible for completing the 
assessments.

Due date Date by which the assessment must be 
completed.

Assigned to Users responsible for completing the 
assessment instance.

Expiration date Date after which the assessment instance is 
no longer valid.

Signature Signature associated with the assessment 
instance on completion.

Preview Indication of whether a preview of the 
assessment before it’s submitted is available.

Signature result Outcome or status of the signature collected 
for the assessment instance.

Create action form

The action form information is used to create an action for a demand.

Create New Action form

Field Description

Number System-generated number with a configurable 
prefix.

State Current state of the action. All new action 
records are created with the state set to Open.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency for implementing or approving the 
action based on impact.

Estimated Cost Estimated cost generated by the action.

Impact The impact on the outcome of the demand if 
you don’t implement the action.

Approval Status of approval from the stakeholders for 
the action. The available options are:
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Create New Action form  (continued)

Field Description

• Not Yet Requested

• Requested

• Approved

• Rejected

Assigned to Primary resource assigned to implement the 
action.

Due date Requested date on which the action must be 
approved or implemented.

Parent The demand to which this action belongs.

Short description Brief description of the action such as what 
the action involves, how to implement the 
action, who it affects, and the action outcome.

Description Details of the action and its potential impact.

Work notes Information about the action. Add work notes 
to communicate about the status of action 
approval, rejection, or implementation with 
other users.

Create assessment instance question form

The assessment instance question form information is used to create and edit an assessment 
questions for a demand.

Assessment Instance Question

Field Description

Source table Table from which the assessment instance 
question originates.

Category Category used to classify the assessment 
instance question.

Source Source record associated with the assessment 
instance question.

Domain Domain to which the assessment instance 
question belongs. Defaults to global.

Metric Assessment metric that defines the criteria 
being evaluated.

Instance Assessment instance to which this question 
belongs. Auto-populated with the instance 
number.

Value Numeric or scored value assigned to the 
assessment question response.
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Assessment Instance Question  (continued)

Field Description

String value Text-based response or value entered for the 
assessment question.

Reference id Unique identifier of the referenced record 
associated with this question.

Additional information Any supplementary details or context relevant 
to the assessment instance question.

Create cost plan breakdown form

The cost plan breakdown form information is used to create and edit a cost plan breakdown 
record for a cost plan of a demand.

Cost plan breakdown

Field Description

Cost plan Name of the cost plan to which the breakdown 
is associated.

Fiscal period Fiscal period for the cost plan breakdown.

Entered currency Currency to capture the unit cost value.

If the selected currency is different from 
the default currency configured in the 
Financial Management  application, the budget 
reference rate is used to calculate the cost of 
the demand.

Entered cost Breakdown amount in entered currency.

Task Task to which the cost plan breakdown 
belongs.

Functional cost Functional cost obtained by multiplying 
exchange rate with entered cost.

Exchange rate Rate in effect for the period corresponding to 
the cost plan breakdown. When the period 
corresponding to the cost plan break down 
has multiple rates, the rate in effect on the first 
date of that period is used.

Exchange rate is used to convert entered cost 
into functional cost. It is obtained from the 
itfm_fx_rate [budget_reference_rates] table.

Exchange rate date First date of the fiscal period corresponding to 
the cost plan breakdown.

Create cost plan form

The cost plan form information is used to create a cost plan for a demand.
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Cost plan section

Field Description

Name Name of the cost plan.

Project/Demand The demand to which this cost plan belongs.

Start fiscal period Starting month in a fiscal period for the cost 
plan.

When you change the start fiscal period, 
the associated cost breakdown values also 
change.

End fiscal period Ending month in a fiscal period for the cost 
plan.

When you change the end fiscal period, 
the associated cost breakdown values also 
change.

Financials section

Field Description

Entered currency Currency to capture the unit cost value.

If the selected currency is different from 
the default currency configured in the 
Financial Management  application, the budget 
reference rate is used to calculate the cost of 
the demand.

Total planned cost Total planned cost value of the cost plan. If the 
cost is recurring, the calculation is Quantity x 
Unit cost x number of fiscal periods.

If the cost is non-recurring, the calculation is 
Quantity x Unit cost.

This value is rolled up from the cost 
breakdown.

Unit cost Cost of single unit of the resource.

Functional currency The default currency configured in the 
Financial Management  application and used 
for managing the demand.

Quantity Quantity of cost plans.

Cost in functional currency The total planned cost for the demand in 
functional currency. The value in this field 
changes if the entered currency is different 
from the functional currency.

Recurring Indicates if the cost is recurring for each fiscal 
period.
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Financials section  (continued)

Field Description

Quantity x Unit cost value is incurred for every 
fiscal period.

Total actual cost Total actual costs of the cost plan. This value is 
rolled up from cost breakdown.

Cost type Cost type of the plan.

Source Funding entity value from which you request 
fund.

The field is available when you select a value 
in the Source type field.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Investment Name of the investment created for the 
project.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Source type Funding entity type from which you request 
fund.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Create decision form

The decision form information is used to create a decision for a demand.

Decision form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the decision. All new decision records are created with the Open 
state.

The available states are:

• Pending

• Open
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Decision form  (continued)

Field Description

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency of approving or implementing the decision based on the possible impact.

Decision 
status

Status of the decision. The available options are:

• Pending

• Approved

• Rejected

Impact Impact on the outcome of the demand if you don’t implement the decision.

Approval 
required

Option for determining whether approval of the decision is required.

Estimated 
Cost

Estimated cost of implementing the decision in the selected currency.

Due date Requested date on which the decision must be approved or implemented.

Assigned 
to

Primary resource assigned to work on the decision. The default value is the name 
of the user creating the decision record.

Parent Demand number to which this decision belongs.

Short 
description

Brief description of the decision such as what the decision is about, who made it, 
what it affects, and the decision outcome.

Description Details of the decision and its potential impact.

Work notes Information to record and track the status of decision implementation or 
approvals.

Create demand task form

The demand task form information is used to create a demand task for the demand.

Demand Task form

Field Description

Short description A brief summary of the task, which helps 
quickly identify the purpose or nature of the 
work.

Assignment group Team or group responsible for handling the 
task.

Number System-generated ID number with a 
configurable prefix.
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Demand Task form  (continued)

Field Description

Assigned to Primary resource responsible for executing or 
progressing the task. The following conditions 
apply:

• If an assignment group is defined, users in 
the assignment group are listed.

• If skills are defined, users with those skills 
are listed.

• If no assignment groups or skills are 
defined, users with one of the Project 
Management application user roles are 
listed.

• Users with the timecard_user role are also 
listed.

Priority Indicates the urgency and importance of the 
task. Determines how quickly it should be 
addressed.

Additional assignee list Users assigned to the demand task in addition 
to the single primary resource defined in the 
Assigned to  field.

State Current state of the demand task. All new 
demand task records are created in the Open 
state.

The states include:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Category Category of the demand task.

The categories include:

• Initial review

• Effort estimate

• Cost estimate

• Benefit estimate

• Risk assessment

Due date The expected completion date and time for 
the task.
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Demand Task form  (continued)

Field Description

Actual effort The actual time spent working on the demand 
task, which is derived from the approved time 
card for this demand task.

You must add this field by personalizing the 
Create New Demand Task form as this field 
doesn’t appear by default on the form.

Actual cost The actual cost of the demand task derived 
from the number of hours worked and hourly 
rate of the resource as defined in the rate card. 
In the absence of a rate card, the hourly rate 
is derived from the default labor rate card or 
default system property.

Description Brief description of the demand task.

Work notes Information about the demand task. Work 
notes are added throughout the demand 
management life cycle to communicate with 
other users associated with the demand.

Create expense line form

The expense line form information is used to create an expense line for your actual expenses.

Expense Line section

Field Description

Number Auto-generated number for the expense line.

Amount Expense cost in the selected currency.

Date Date on which the expense was generated.

Process date Date on which the expense line was 
processed.

Rate card Name of the rate card.

Inherited Indicates if the expense line is inherited from 
another expense line.

Parent The parent expense line from which this 
expense line is inherited.

Rate type Rate type for the expense line.

State State of the expense line. Only processed 
expense lines are considered for an 
investment entity.

Source ID Record that generated the associated cost.

Summary type Business purpose of the expense line.

Cost plan Associated cost plan name for recording the 
expense line.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

876



Expense Line section  (continued)

Field Description

Expense type Defines the expense type, internal or external.

By default, the expense type is considered 
from the cost type field entry.

Cost type Cost type of the expense.

By default, the cost type of the cost plan is 
selected.

Short description Short description of the expense.

Mention unique and specific details to identify 
the expense line.

Source Sources of the expense line. These sources 
include:

• Asset

• Configuration item

• Fixed asset

• Task

• Contract

• Cost center

• User

Create goal/target relationship form

The goal/target relationship form information is used to create a relationship between a goal and 
a demand.

Create New Goal/Target Relationship form

Field Description

Goal Name of the goal.

Demand Demand with which a goal relationship is 
created with the goal.

Target Name of the target.

Primary Indicates that this goal is the primary goal 
associated with a demand. Although multiple 
goals can be linked to a demand, only one of 
them must be designated as the primary goal.

Parent goal Name of the parent goal that this goal 
contributes to.

Status Status of the goal. Status can be Red, Yellow, 
Green, or None.
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Create New Goal/Target Relationship form  (continued)

Field Description

State State of the goal. The state can be Draft, In 
progress, Approved, Complete, Pending, 
Achieved, or Not Achieved.

End date End date for the goal. By default, the end 
date of the current quarter is populated. For 
a subgoal, the end date of its parent goal is 
populated.

Start date Start date for the goal. By default, the start 
date of the current quarter is populated. 
For a subgoal, start date of its parent goal is 
populated.

Progress Percentage completion for the goal. If the goal 
has subgoals or/and targets, the progress 
value is calculated automatically.

For more information on how the progress 
value is calculated, see Progress value 
calculation.

Category Category of the goal. The available options 
are:

• Total Applications

• Total Cost

• Opex

• Capex

• Cloud Applications

• Homegrown Applications

• Support Cost

• Labor Cost

• Standards Compliance

• Strategic

• Operational

• Tactical

• Artificial Intelligence

Create issue form

The issue form information is used to create an issue for the demand.

Issue form

Field Description

Number System-generated ID number with a configurable prefix.
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Issue form  (continued)

Field Description

State Current state of the issue. All new issue records are created in the Open state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency of resolving or managing the issue based on possible impact.

Estimated 
cost

Estimated cost generated by the issue.

Impact Impact on the outcome of the demand if the issue remains unresolved.

Due date Requested date for one of the following situations:

• If the issue has an assigned resource, then the due date is the date for 
resolving the issue.

• If the issue isn’t assigned to any resource, then the due date is the date when 
the issue must be closed or addressed.

Assigned 
to

Primary resource assigned to work on the issue resolution.

Parent Demand to which this issue belongs.

Short 
description Brief description of the issue and its potential impact on the success of the 

demand.

Description Details of the issue and its potential impact.

Work notes Information to record and track the work accomplished for resolving the issue.

Create request change form

The request change form information is used to create a request change for a demand.

Request change form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the request change. All new request change records are 
created in the Open state.

The available states are:

• Pending

• Open
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Request change form  (continued)

Field Description

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency for approving the requested changes based on impact.

Estimated Cost Estimated cost generated by the requested changes.

Impact Impact on the outcome of the demand if you don’t approve the requested 
changes.

Approval Status of approval from the stakeholders for the requested changes.

Assigned to Primary resource assigned to work on the request change.

Due date Requested date to complete the request change.

Category Entity for which you’re creating the request change. The options are:

• Resource

• Scope

• Cost

• Schedule

Parent Demand number to which this request change belongs.

Title Title for the change request.

Description Details of the request change and its potential impact.

Business 
Justification

Reason for requesting the proposed change in the demand. The change's 
impact on the business.

Work notes Additional information to indicate progress on the demand request change.

Create requirement form

The requirement form information is used to create a requirement for a demand.

Requirement form

Field Description

Number Unique identification number for the requirement. Automatically generated when 
a new requirement record is created.

Source User requesting the requirement. This field automatically populates with the name 
of the person filling out the form, but the source can be a different person who 
identified the requirement.

Owner User responsible for managing the requirement or ensuring that the requirement 
is met.

Estimated 
effort

Approximate amount of time to complete the requirement and any associated 
tasks.
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Requirement form  (continued)

Field Description

Priority Importance of the requirement as it applies to the overall demand.

State Status of the requirement such as Pending, Approved, or Rejected.

Note: 
The requirement state is independent of the demand state and the states 
of any planned tasks associated with the requirement. The demand can be 
closed without the requirement state being closed. Closing the demand 
doesn’t change the state of the requirement.

Type Type of requirement such as Business, Solution (Functional), Solution (Non-
Functional), Quality, Stakeholder, or Transition.

Short 
description

Brief description of the requirement.

Description Detailed description of the requirement and any associated tasks. For example, 
describe an expected outcome or result.

Create resource assignment form

The resource assignment form information is used to create a resource assignment record for a 
demand.

Resource assignment

Field Description

Assignment type Select an assignment type from the list.

• User - to create a resource assignment for a 
user.

• Group - to crate a resource assignment for a 
group.

Resource Name of the resource.

This field is turned off for Group assignment.

Group Name of the group to create resource 
assignment.

If a resource is selected, the primary group 
name is populated by default.

Role Primary role for the employee.

• If a resource is selected, the primary role is 
populated by default.

• This field is turned off for Group assignment.

Skill Primary skill of the resource.
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Resource assignment  (continued)

Field Description

• If a resource is selected, the primary role is 
populated by default.

• This field is turned off for Group assignment.

Effort type Select the effort type to request a resource.

• Hours - to request a resource or group by 
hourly basis.

• FTE - to request a resource or group by FTE.

By default, one FTE is 8 hours.

• Person days - to request a resource or group 
by Person days.

Effort Enter the required effort count.

Task Select the task from the list to associate the 
resource assignment.

Start date Select the start date of the assignment using 
the calendar palette.

End date Select the end date of the assignment using 
the calendar palette.

Resource status Select the state of the resource assignment.

• Pending

• Approved

• Unapproved

• Unassigned

Rate override Select this option to override the resource rate 
to match with your organization requirements.

Ready for review Select an option from the list so that the 
resource manager can review the request for 
allocation.

• Yes - if the resource assignment request is 
finalized and ready for resource manager's 
review for allocation.

• No - if the resource assignment details are 
still being updated.

Notes Enter details about the assignment to help 
resource manager or project manager with 
insights and additional information.
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Create risk form

The risk form information is used to create a risk for the demand.

Risk form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the risk. All new risks are created in the Pending state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Risk status Status of the risk. All new risks are created in the Pending risk status. The 
available options are:

• Pending

• Achieved

• Not Achieved

• Avoid

• Mitigate

• Transfer

• Accept

Probability The likelihood that the event described in the risk can occur. All new risks are 
created in the Low probability. The available options are:

• Absolute

• High

• Moderate

• Low

Impact Impact of the risk event on the outcome of the demand.

Estimated 
cost

Estimated cost generated by the risk event.

Risk rank A value and color assigned to the risk. This value is calculated using risk 
probability and impact. You can configure the color and value using the Risk Value 
Lookup. For more information, see Configure a custom risk rank and risk value.

Risk owner Primary resource who is responsible for monitoring and managing the risk.

Assigned 
to

Primary resource assigned to work on the risk.
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Risk form  (continued)

Field Description

Risk value A value calculated from the Risk Value Lookup. For more information, see 
Configure a custom risk rank and risk value.

Due date Requested date for one of the following situations:

• If the risk has an assigned resource, then the due date is the date for resolving 
the risk.

• If the risk isn't assigned to any resource, then the due date is the date when the 
risk must be closed or addressed.

Task Demand to which this risk belongs.

Short 
description

Brief description of the event and its potential impact on the success of the 
demand.

Description Details of the event and its potential impact.

Mitigation 
plan

Brief description of the efforts taken to mitigate the risk.

Work notes Information to record and track the work accomplished for resolving the risk.

Create stakeholder form

The stakeholder form information is used to create a stakeholder record for the demand.

Stakeholder register form

Field Description

Stakeholder Name of the stakeholder being added to the demand.

Demand Demand to which the stakeholder is assigned.

Level of Interest Level of interest that the stakeholder has in pursuing the demand.

Assessment 
recipient

Indication of whether the stakeholder is authorized to receive assessment 
questionnaires for a demand.

Approver Indication of whether the stakeholder has authority to approve demands.

Influence Level of influence the stakeholder has over the group assessing the demand.

Engagement Indication of the way the stakeholder is engaged with the demand.

Function Function of the stakeholder in the demand process.

Create project funding form

The project funding form information is used to create a project funding budget for the demand.

Project Funding

Field Description

Fiscal Year The fiscal year for which you want to set the 
budget for the demand.
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Project Funding  (continued)

Field Description

Capex target Planned target amount allocated for capital 
expenditure.

Opex target Planned target amount allocated for operating 
expenditure.

Target Sum of capex and opex target amounts.

Demand/Project Demand to which the budget belongs.

Capex budget Planned expense amount allocated for capital 
expenditure.

Operating budget Operating expense amount.

Budget Sum of capex and opex amounts.

Selected for execution Indication of whether the demand is planned 
for execution.

Demand form

The demand form information is used to create a demand.

Demand form fields

Field Description

Name Name of the demand.

Category Category of the demand:

• Strategic: For demands for plans, such as projects or stories.

• Operational: For demands for operational work, such as changes or defects.

Type The Category  field selection determines the selections available in the Type 
field.

• The following demand types are available if the demand category is Strategic:

◦ Enhancement

◦ Project

◦ Epic

◦ Story

◦ EAP Epic

◦ EAP Feature

◦ EAP Capability

◦ No Conversion

• The following demand types are available if the category is Operational:

◦ Change

◦ Defect

◦ No Conversion
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Demand form fields  (continued)

Field Description

If the Agile Development 2.0  application is active, the Story, Epic, 
Enhancement, and Defect options are available.

If the Strategic Planning  application is active, the EAP Epic, EAP Feature, and 
EAP Capability options are available.

The No Conversion option enables you to use your demand to fund a large 
project that includes one or more projects, epic, or programs.

The selections in the Category  and Type  field also determine the fields that are 
displayed in the Assessment Data section.

Project Name of the project created from this demand.

This read-only field is visible only when you convert the demand into a project.

Enhancement Number of the enhancement created from this demand.

This read-only field is visible only when you convert the demand into an 
enhancement.

Epic Name of the epic created from this demand.

This read-only field is visible only when you convert the demand into an epic.

Story Name of the story created from this demand.

This read-only field is visible only when you convert the demand into a story.

Number Unique, auto-generated identification number for the demand.

Approved 
start date

The formal date approved by stakeholders for starting the demand. This date is 
set after prioritization and stakeholder approval and represents the committed 
and authorized timeline for execution. It’s used for governance and traceability.

For example, the approved date to start the database upgrade is 2026-01-10.

This field is carried forward to the Approved start date  field of the Project form 
if the demand is converted to a project and remains unchanged, even if the 
project starts later.

This field is highlighted in red if the date is different than the value in the Start 
date  field.

Note: 
If this field is empty while creating a demand, the date from the Start date 
field is inserted.

Approved 
end date

The formal date approved by stakeholders for completing the demand. This 
date is set after prioritization and stakeholder approval and defines the 
approved execution window and supports historical tracking.

For example, the approved end date to complete the demand is 2026-02-15.
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Demand form fields  (continued)

Field Description

This field is carried forward to the Approved end date  field of the Project form 
if the demand is converted to a project and remains unchanged, even if the 
project ends later.

This field is highlighted in red if the date in this field is different than the value in 
the Due date  field.

Note: 
If this field is empty while creating a demand, the date from the Due date 
field is inserted.

Start date The preliminary or estimated date when the work is initially planned to begin. 
This date helps outline the intended timing for early demand planning and 
prioritization. You can set this date during initial demand creation or anytime in 
the planning phase when a rough idea forms. This date can be updated until 
the demand is officially approved.

For example, you’re planning for a database upgrade to start on 2025-11-01.

This date is changed to Planned start date  when the demand is converted to a 
project.

Note: 
When you change the planned start date of a demand or project, the 
associated cost plans and resource assignments also change. The 
Change Resource Plan and Cost Plan Start Date with Demand or Project 
Start Date Change  property controls the behavior for a demand date 
change. This property isn’t enabled by default. For more information, see 
Properties installed with Project Management.

Due date The preliminary or estimated date when the planned work is expected to be 
completed. This date provides an expected completion window for planning 
and stakeholder communication. You can set this date anytime in the planning 
phase when a rough idea forms and can be updated until the demand is 
officially approved.

For example, you’re planning to complete the database upgrade by 2025-12-31.

Note: 
This date is changed to Planned end date  when the demand is converted 
to a project.

Description Description of the demand.

Details section of the Demand form

Field Description

Portfolio Portfolio indicating the business focus of the 
demand.

Program Name of the program to which the demand 
belongs.
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Details section of the Demand form  (continued)

Field Description

Investment Class Type of investment class category assigned to 
the demand:

• Run: Investment made to sustain the 
existing business.

• Change: Investment made to implement a 
change in the business.

Investment Type Investment type of the demand:

• Cost Reduction

• End User Experience

• Legal and Regulatory

• Revenue Generating

• Service Sustaining

• Strategic Enabler

• Artificial Intelligence

Demand manager Name of the demand manager.

Collaborators Users who can edit or contribute to the 
demand. A demand requester can select any 
user as a collaborator.

Expense type The type of the expense, either capex (capital 
expense) or opex (operational expense).

Priority The priority of the demand.

Department Department in a business unit to which the 
demand submitter belongs.

Note: 
If you don’t select a department, 
the default value is the name of the 
department to which the submitter 
belongs.

Project Manager Project manager that would be assigned to 
the project created from this demand. When 
a project is created, this field becomes read 
only. This field appears if the Category  field 
is set to Strategic and the Type  field is set to 
Project. If you delete the project created from 
this demand, this field becomes editable.

Business Unit Business unit to which the demand submitter 
belongs.

Impacted Business Units Business units affected by the submitted 
demand. The selected units could experience 
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Details section of the Demand form  (continued)

Field Description

operational impact, process changes, 
technology adoption, and so on.

For example, if a demand is submitted by the 
procurement business unit, it can impact the 
finance, legal, and IT business units.

Idea Unique identification number of the idea from 
which the demand was created.

Business Capabilities Business capabilities associated with 
the demand that links the demand to 
organizational goals and value. Business 
capabilities are defined in the Enterprise 
Architecture  (formerly Application Portfolio 
Management) module.

Impacted Business Applications If the demand is to change, enhance, or 
add one or more business applications, the 
applications associated with the demand. 
Business applications are defined in 
the Enterprise Architecture  (formerly 
Application Portfolio Management) module. 
For more information, see Exploring business 
applications .

You can select any business application 
in your enterprise regardless of whether 
it’s related to a capability selected in the 
Business Capabilities  field.

Business Applications If the demand is to change, enhance, or 
add one or more business applications, the 
applications associated with the demand. 
Business applications are defined in 
the Enterprise Architecture  (formerly 
Application Portfolio Management) module. 
For more information, see Exploring business 
applications .

You can select any business application 
in your enterprise regardless of whether 
it’s related to a capability selected in the 
Business Capabilities  field.

Business Case section of the Demand form

Field Description

Strategic priority Strategic objectives of the organization that 
the demand fulfills. A demand can fulfill 
multiple strategic objectives.
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Business Case section of the Demand form  (continued)

Field Description

If a business unit has been selected in 
the Details  tab, the business strategies 
for the selected business unit along with 
other enterprise strategies are available for 
selection.

Primary goal The primary goal associated with the strategy 
selected in the Strategic priority  field.

If a strategy hasn’t been selected, all goals are 
available for selection.

Business case Business arguments that support the demand.

Risk of performing Risks if the demand is approved and 
implemented.

Risk of not performing Risks if the demand isn’t approved, for 
example, risk of loss of opportunity.

Enablers Key enablers for the demand that would aid 
the demand to be completed. For example, 
clearly defined resource and cost plans.

Barriers Major barriers to the demand that would 
obstruct the demand's completion. For 
example, incomplete or unclear demand 
details.

In scope Scope of the demand, which is the set 
of boundaries that define the extent of a 
demand.

Out of scope Activities or deliverables not in the scope 
of the demand. Anything not defined in the 
scope is out of scope.

Assumptions Assumptions made for the demand. 
Assumptions help to define the scope and 
risks, and fine-tune the estimates for time and 
cost.

Financials section of the Demand form

Field Description

Rate Model Rate model assigned to the demand. This 
setting is used to derive hourly rates for the 
associated resource assignments and time 
cards. For more information, see Rate Models.
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Financials section of the Demand form  (continued)

Field Description

Note: 
If the rate model assigned to the demand 
is changed or removed, the cost fields 
on the associated resource assignments 
aren’t recalculated.

Project Currency Currency used to execute the project once the 
project is created from this demand.

You can select any active currency from the 
values listed in the Currency [fx_currency] 
table.

After you create a project in the selected 
project currency, you can't change the project 
currency in the Project form if the demand 
contains a cost plan, a benefit plan, or a 
project budget. If the demand has no attached 
plan or budget, you can change the project 
currency in the Project form.

Note: 
The value of this field defaults to 
the Project currency  field of the 
Financials  tab in the project currency 
view of the Project form as well. 
This field is available only when 
the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) feature 
is activated and the Demand Currency 
view is enabled.

Capital expense Capital expenditure (capex) for the demand.

Operating expense Operational expenditure (opex) for the 
demand.

Total planned cost Result calculated based on the values in the 
Capital expense  and Operating expense 
fields.

Financial return Result calculated based on the values in the 
Total costs  and Financial benefit  fields.

Financial benefit Estimate of revenue if the demand is 
approved.

This value is rolled up from the benefit 
breakdown of the demand.

You can also enter the value manually by 
selecting a currency icon and entering a value.

ROI % ROI calculated based on the values in the 
Total costs  and Financial return  fields.
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Financials section of the Demand form  (continued)

Field Description

The value in this field is updated when a cost 
plan, benefit plan, or resource assignment 
is created or updated for the demand in the 
Qualified or Approved state.

Capital budget Total capital budget allocated to the demand 
across all fiscal years.

The value is rolled up from the capex budget 
of the demand.

Operating budget Total operational budget allocated to the 
demand across all fiscal years.

The value is rolled up from the opex budget of 
the demand.

Discount Rate % Demand discount rate, which is the interest 
rate to determine the present value of future 
cash flows.

Net present value Present value of future cash based on the 
given annual interest rate, a measure for 
comparing money spent today against future 
expected financial benefits. This value is 
useful when evaluating the overall investment 
performance.

For example, at a 12% discount rate, $1.00 
today is worth $0.80 in two years. Therefore, 
receiving $1.00 in two years is the same as 
receiving $0.80 today.

Net present value (NPV) is calculated from 
total costs according to year, financial 
benefit per year, and the discount rate for the 
demand.

Internal rate of return % Annual interest rate required to achieve an 
NPV of zero.

Internal rate of return (IRR) helps to determine 
which demands can deliver a higher rate of 
return in terms of revenue.

Demand Actual Cost Total cost incurred while working on a demand 
and demand tasks. Demand actual cost is 
calculated after the assignee of the demand 
task creates and submits a time card. When 
the time card is approved, the resource rate, 
which is derived from the rate card, labor rate, 
or system properties, is used to populate this 
field.
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Financials section of the Demand form  (continued)

Field Description

Demand Actual Effort Time accrued or spent by a resource while 
working on a demand or a demand task as 
derived from the submitted and approved time 
cards. This field isn’t available on the Demand 
form by default.

Note: 
If you’re creating a demand with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and the Demand Currency  view enabled, 
then the fields in the Financials  tab differ from the Default  view. For more information about 
the fields that are available only in the Demand Currency view, see Multicurrency fields in 
demand-related forms.

Assessment Data section of the Demand form

Field Description

Impact Level of business impact created by the 
demand.

Risk Risk value calculated from the demand 
assessment.

Value Business value of the demand calculated from 
the Impact  and Financial return  fields.

T-Shirt size Size of the demand.

Before using this value as an indicator 
of demand size, consider creating and 
publishing definitions for each option outside 
the application. That process ensures that 
the values are interpreted correctly and 
consistently across the organization or 
department.

Score The demand score is calculated based on 
the risk, value, and size  attributes in the 
base system.

The value of the risk, value, and size 
attributes are derived from the assessment 
metric category results. For more information, 
see assessment categories  and assessment 
category results .

• When the risk  and size  values are high, 
the score of the demand is low.

• When the value  setting is high, the score 
of the demand is high.

Assessment Required Option for enabling the assessments for the 
demand. This option is active by default.
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Assessment Data section of the Demand form  (continued)

Field Description

Only a demand manager can update this value 
when the demand is in the Draft or Submitted 
state.

Note: 
If this option isn’t selected and you reset 
the demand to the Draft state, the option 
remains unselected.

Note: 
The values in the Value  and Score  fields are updated when a cost plan, benefit plan, 
or resource assignment is created or updated for the demand in the Qualified or 
Approved state. The values in the fields are updated only until an artifact such as project, 
enhancement, defect, or change is created from the demand.

Notes section of the Demand form

Field Description

Watch list The groups and users subscribed to the 
demand who can view the information in the 
Additional comments  field.

Work notes list The groups and users subscribed to the 
demand who can view the information in the 
Work notes  field.

Work notes Information about the demand. This 
information isn’t visible to customers. Work 
notes are added throughout the demand 
management life cycle to communicate with 
other users associated with the demand.

Preferences section of the Demand form

Field Description

Close Demand
Determines when to close the demand 
automatically if it’s converted to a project.

• None: Keeps the demand in the Open state 
after it’s converted to a project.

• On creation of project: Closes the demand 
when the demand is converted to a project.

• On closure of project: Closes the demand 
when the project created from the demand 
is closed.
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Preferences section of the Demand form  (continued)

Field Description

Note: 
The On creation of project  and On 
closure of project  options appear 
when the value for the Type  field is 
set to Project. If the Type  field is set 
to Enhancement, the default setting is 
None.

Project calculation Determines the calculation to use for task 
dependencies for the project when the 
demand is converted to a project. The default 
value is Automatic.

• Manual: Task dates don’t reflect any 
changes made to dependencies.

• Automatic: Task dates are automatically 
updated to reflect any changes made to 
dependent or child tasks.

EAP Details section of the demand form
This section appears only if the selected type is an EAP entity.

Field Description

Team The planning team to which the created EAP 
entity is assigned. This field becomes read 
only once the EAP entity is created. This value 
is an optional value.

Converted to The name of the created EAP entity. This field 
is read-only.

AI Associations section of the demand form
This section appears only if the AI Control Tower plugin is installed and the 
investment type of the demand is set to artificial intelligence.

Field Description

Product Product or system that the demand relates to.

Impacted AI systems Impacted AI systems associated with the 
demand. You can select existing AI systems 
from the list or remove systems that are no 
longer relevant.

Monetary benefit breakdown form

The monetary benefit breakdown form information is used to create and edit a monetary benefit 
breakdown record for the demand.
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Monetary Benefit Breakdown form

Field Description

Task Task to which the benefit plan breakdown 
belongs.

Portfolio Portfolio to which the benefit plan breakdown 
belongs.

Entered currency Currency specified in the benefit plan.

Exchange rate Rate in effect for the period corresponding to 
the benefit plan breakdown. When the period 
corresponding to the benefit plan breakdown 
has multiple rates, the rate in effect on the first 
date of that period is used.

Exchange rate is used to convert the entered 
benefit into the functional benefit. It’s obtained 
from the itfm_fx_rate [budget_reference_rates] 
table.

Actual benefit Actual benefit that is incurred from the project 
or demand.

Benefit plan Benefit plan to which the benefit plan 
breakdown belongs.

Fiscal period Fiscals generated at the period level. For 
information on periods, see fiscal calendars .

Entered benefit Benefit in entered currency.

Functional benefit Functional benefit obtained by multiplying the 
exchange rate with the entered benefit.

Exchange rate date First date of the fiscal period corresponding to 
the benefit plan breakdown.

Monetary benefit plan form

The benefit plan form information is used to create monetary and non-monetary benefit plans for 
a demand.

Create New Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Demand number to which the benefit plan belongs.

Sponsor Sponsor for the demand.

Category Type of benefit:

• Hard: Benefits measured in terms of revenue.

• Soft: Benefits measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.
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Create New Benefit Plan form  (continued)

Field Description

The selection in the Category  field determines the available options in this field.

Benefit 
type

Type of the benefit: monetary or non-monetary.

Offset type Indicates when the benefits start realizing. If the value in the selected offset type 
changes, the benefit plan start date shifts accordingly.

For example, if the offset type is set to End Date and the demand due date 
changes, the benefit plan start date shifts to align with the new due date.

Start fiscal 
period

Starting fiscal period. Populated based on values in the Offset field relative to the 
selected Project or Demand start date or Project or Demand end date, and the 
Duration in period values.

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.

End fiscal 
period

Ending fiscal period.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Benefits associated with this benefit plan.

Description Description of the benefit plan.

Financials section

Field Description

Entered benefit Estimated amount of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods.

Entered currency Currency for the benefit plan. If the selected 
currency differs from the default currency 
configured in the Financial Management 
application, the budget reference rate is 
used to calculate the financial benefit of the 
demand. For more information, refer to budget 
reference rate.

Functional currency Default currency configured in the Financial 
Management  application and used for 
managing the demand or project.

Total planned benefit Total benefit value rolled up from the benefit 
breakdown.
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Financials section  (continued)

Field Description

Benefit in functional currency Benefit incurred from demand in functional 
currency. The value in this field changes if the 
Entered currency  differs from the functional 
currency.

Actual benefit Actual benefit value rolled up from the actual 
benefit in the benefit breakdown.

Recurring Indicates if the benefit is recurring for each 
fiscal period in the benefit breakdown.

Non-monetary benefit plan breakdown form

The non-monetary benefit breakdown form information is used to create and edit a non-
monetary benefit breakdown record for the demand.

Non-monetary Benefit Plan Breakdown form

Field Description

Task Task to which the benefit plan breakdown 
belongs.

Portfolio Portfolio to which the benefit plan breakdown 
belongs.

Measure Measure type specified in the benefit plan.

Actual benefit Actual benefit that is incurred from the 
demand.

Benefit plan Benefit plan to which the benefit plan 
breakdown belongs.

Fiscal period Fiscals generated at the period level. For 
information on periods, see fiscal calendars .

Entered benefit Benefit in entered value.

Variance The difference between the estimated and 
actual benefit.

Non-monetary benefit plan form

The benefit plan form information is used to create monetary and non-monetary benefit plans for 
a demand.

Create New Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Demand number to which the benefit plan belongs.

Sponsor Sponsor for the demand.

Category Type of benefit:
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Create New Benefit Plan form  (continued)

Field Description

• Hard: Benefits measured in terms of revenue.

• Soft: Benefits measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The selection in the Category  field determines the available options in this field.

Benefit 
type

Type of the benefit: monetary or non-monetary.

Offset type Indicates when the benefits start realizing. If the value in the selected offset type 
changes, the benefit plan start date shifts accordingly.

For example, if the offset type is set to End Date and the demand due date 
changes, the benefit plan start date shifts to align with the new due date.

Start fiscal 
period

Starting fiscal period. Populated based on values in the Offset field relative to the 
selected Project or Demand start date or Project or Demand end date, and the 
Duration in period values.

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.

End fiscal 
period

Ending fiscal period.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Benefits associated with this benefit plan.

Description Description of the benefit plan.

Non-monetary Details section

Field Description

Non-monetary entered benefit Estimated amount of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods.

Measure Type of measure for the non-monetary 
benefit plan. The measure types are Count, 
Percentage, Hours, Days, and Score.

The Yes/No options are used to track the 
benefits that aren’t quantifiable. When this 
option is selected, the only field available 
is Benefits achieved. You can select the 
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Non-monetary Details section  (continued)

Field Description

Benefits achievedcheck box to indicate that 
the benefits have been achieved.

Benefits achieved Option to indicate if the benefit is achieved.

Non-monetary planned benefit Estimated value of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods 
only.

Breakdown type Type of breakdown creation when you save 
the benefit plan.

• None: No breakdowns are created.

• Automatic: A non-monetary benefit plan 
breakdown record is created automatically 
with data. The breakdown is calculated 
linearly.

• Manual: A non-monetary benefit plan 
breakdown record is created automatically 
but without data in the entered benefit 
column.

Non-monetary actual benefit Actual benefit value rolled up from the actual 
benefit in the benefit breakdown.

Aggregation mode Determines how the roll-up happens from 
breakdowns to the benefit plan and updates 
the values in the Non-monetary planned 
benefit  and Non-monetary actual benefit 
fields.

• Sum: Aggregates data from all breakdowns.

• Average: Average value from all 
breakdowns.

• Most recent: Recent breakdown value.

• Max: Maximum value among the 
breakdowns.

• Min: Minimum value among the 
breakdowns.

Risk value lookup form

The risk value lookup form information is used to rate the impact and probability of a risk.
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Risk Value Matcher form

Field Description

Impact Impact value of the risk.

The default values are:

• 1 = High

• 2 = Medium

• 3 = Low

Application The application to which these risk values 
belong.

Risk Rank Color Color to indicate the severity of the risk.

Tip: 
You can enter variations of a color to 
differentiate between risks with similar 
impact and probability values. For 
example, you could enter light green to 
indicate a low-severity risk.

Risk Value The value for the specified risk impact and 
probability combination.

The options are: High, Medium, and Low.

This value is displayed in the Risk value  field 
of the Risk form.

Probability Risk probability value is associated with the 
impact value of the risk. The options are: 
Absolute, High, Moderate, and Low.

Probability Number Numerical value to indicate the probability. 
This value is multiplied by the value of the 
Impact  field for calculating risk rank.

The default values are:

• 1 = Absolute

• 1 = High

• 2 = Moderate

• 3 = Low

The calculated risk rank and the risk rank color 
are displayed in the Risk rank  field of the Risk 
form.

Stakeholder register form

The stakeholder register form information is used to add users to the stakeholder registry.
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Stakeholder register form

Field Description

Number Unique identification number for the stakeholder. This number is automatically 
generated when a new entry is created.

User Name of user being added to the stakeholder registry.

Portfolio Portfolio to which the user is assigned. A group of activities managed to align to 
business or operational objectives constitutes a portfolio. Typically, portfolios are 
named according to the business units of an organization.

Level of 
Interest

Level of interest that the stakeholder has in pursuing the demand.

Assessment 
recipient

Indication of whether the user is authorized to receive assessment 
questionnaires for a demand.

Approver Indication of whether the user has authority to approve demands.

Influence Level of influence the user has over the group assessing the demand.

Engagement Indication of the way the user is engaged with the demand.

Function Function of the user in the demand process.

Next Experience for Demand Management  key terms

Important terms in Next Experience for Demand Management  are listed in the table.

Next Experience for Demand Management  Key Terms

Term Description

Portfolio A collection of demands managed as a group to achieve strategic and 
operational objectives.

Assessable 
record

A demand record that you want to evaluate for metric type demand.

You evaluate the assessable records with metric categories and metrics, which 
define traits and values to assess.

Metric A trait or value used to evaluate assessable records.

A metric can measure subjective values in an assessment questionnaire or 
gather objective values in a database query run by a script.

Examples of metrics include perceived value of demands and return on 
investment for a demand.

Metric type A characteristic that defines a set of records you want to evaluate.

Demand management comes with the metric type demand, which uses records 
from the Demand [dmn_demand] table.

Metric 
category

A theme for evaluating assessable records. Categories contain one or more 
individual metrics, which define specific traits or values that comprise the theme.
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Next Experience for Demand Management  Key Terms  (continued)

Term Description

Examples of categories include return on investment and cost. Set filter 
conditions to control which assessable records to evaluate for the metrics in a 
category.

Stakeholder A person affected by the demand or who has interest in the demand.

Scorecard A visual breakdown on performance of an assessable record based on 
assessment results.

Use scorecards to view various data summaries for one assessable record and 
to compare the ratings with other assessable records.

Requirement An extra item that must be present or an extra action item that must be finished 
before a demand request closes.

Demand 
Task

A unit of work, created within a demand, to break down initial planning activities 
before converting the demand into a project. A demand task isn’t a planned task 
like a project task.

Now Assist for Strategic Portfolio Management (SPM)
Use the ServiceNow®  Now Assist for Strategic Portfolio Management (SPM)  application to 
summarize feedback in Strategic Planning  or text in Docs, create a demand with a conversational 
experience, generate insights for projects, and generate stories from epics. Product, project, and 
demand managers can use the Now Assist  skills and AI agents to streamline their projects and 
workflows.

Get started

Explore

Learn more about 
Now Assist for SPM

Configure

Configure the application 
to get started with 

Now Assist for SPM

Use AI agents

Use the generative 
AI agents of Now 

Assist for SPM
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Use

Use the generative 
AI capabilities of 

Now Assist for SPM

Reference

Learn about forms 
and fields of Now 

Assist for SPM

Important: 

• Not all model providers are available for customers with in-country SKUs, and some Now 
Assist  products/features are currently unavailable for in-country customers. For more 
information, see the KB1584492  article in the Now Support Knowledge Base. Be sure to 
check for model provider availability updates in future releases.

• Some Now Assist  products/features are currently unavailable for customers in the 
FedRAMP, NSC DOD IL5, or Australia IRAP-Protected data centers, self-hosted 
customers, or in other restricted environments. For more information, see the 
KB0743854  article in the Now Support  Knowledge Base . Be sure to check for availability 
updates in future releases.

• Some Now Assist  products/features are currently available only for customers in some 
regions. Be sure to check for availability updates in future releases.

• Some AI products and skills are not available in Regulated Markets. For more information, 
see KB2593939: Regulated Markets AI Products/Skills Not Available . Be sure to check 
for availability updates in future releases.

You can use Now LLM Service, Azure OpenAI,  Google Gemini, or Anthropic Claude on AWS  as 
the AI model provider for Now Assist skills and AI agents. Use the Configuration Controls in AI 
Control Tower  to define which options are available, then you can set skill-level preferences in 
the Now Assist Admin  console .

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns 

in data. As a result, this application may not always produce accurate, complete, or appropriate information. Furthermore, there is no guarantee that this 

application has been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for 

accuracy, harm, and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-

making purposes. This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, 

employment, security, or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .
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Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to develop and improve ServiceNow  technologies including ServiceNow 

models and AI products. In addition, this application will collect  task data (for Case Assist) and chat transcripts (for Chat Assist). Customers can opt out of future 

data collection at any time, as described in the Now Assist  Opt-Out page .

For more information, see the Now Assist  documentation .

Exploring Now Assist for Strategic Portfolio Management (SPM)
Use ServiceNow®  Now Assist  skills and AI agents in multiple SPM  workspaces to transform 
Strategic Portfolio Management  (SPM) into a continuous value engine-embedding intelligence 
across every stage and to provide optimize resources and smarter investments resulting in 
delivering continuous value.

Skills

The Now Assist for SPM  application includes the generative AI skills and features that enable 
your product, project, portfolio, and demand managers to leverage Now Assist  skills so that they 
can streamline their processes and workflows.

Quick story generation

As a product manager or agile team member, generate complete user stories 
directly from an epic using the Quick story generation skill, without lengthy 
conversations or manual authoring. Available in both Agile Development 2.0  and 
EAP  applications, this Now Assist  feature removes the friction of story creation so 
your team can focus on delivery.

To generate a story, open an epic and select Generate Story  from the 
Stories related list. Enter one or two lines of context to guide Now Assist, 
then select Generate. Now Assist  generates a story title, description, 
and acceptance criteria based on the epic and your input. Review and 
refine all fields inline before saving the story directly to the epic's related 

list.

By using the Quick story generation skill, you can:

• Create well-structured stories instantly, reducing the time and effort spent on 
manual story authoring.

• Generate complete stories including title, description, and acceptance criteria, 
ensuring consistency across your backlog.
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• Maintain full control with inline editing of all AI-generated fields before saving, 
preserving human oversight throughout the process.

• Use a fast, non-conversational option in both Agile Development 2.0  and EAP. In 
EAP, you also have access to the conversational Agile story generation agent for 
creating multiple stories for an epic.

Goal insights skill

Generate insights for goals to gain predictive, actionable visibility into goal health 
using the Goal insights skill. The skill analyzes the goal, its targets, subgoals, and 
aligned work, then delivers concise, data‑driven  insights—including AI forecasted 
status, confidence of achieving the goal, targets at risk, delayed or stalled aligned 
work and recommendations—helping goal owners and contributors proactively 
manage risks and improve goal outcomes. You can trigger the skill by selecting 
the Goal insights  or Show insights  on the grid view or goals' full details page 
respectively.

Note: 
When you generate insights for a goal, insights are also generated individually 
for each of its targets.

Summarize demands with the demand summarization skill
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Generate a concise, structured summary of any demand using the demand 
summarization Now Assist  skill. The skill reviews the demand fields and related 
lists and helps create a clear summary of the demand. You can trigger the skill by 
selecting the Summarize  button on the demand form.

The generated summary is displayed in a summary card in the demand form.

Generate acceptance criteria skill

As a product manager, generate clear, comprehensive, and testable acceptance 
criteria for your user stories, instead of spending hours writing and refining them 
manually.

You can review and refine the suggested options to ensure they meet your story 
requirements without slowing down planning. By helping you streamline generating 
acceptance criteria as a process, this skill helps save time, improve quality, and 
speed up delivery with cleaner backlogs and better collaboration.

Target generation skill
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Generate measurable targets from goal's information and optional context with 
the Target generation skill in Strategic Planning Workspace. The skill automatically 
populates key fields in the target creation form, ensuring precision and alignment 
to the goal. This enables teams to define clear and measurable outcomes and 
accelerate the target creation process.

Identify similar records skill

Detect similar demand records using the identify similar records Now Assist  skill. 
The skill identifies similar demand records based on contextual similarity in the 
name, description, and business case content, with a minimum 85% similarity 
threshold. It also excludes the outdated and irrelevant records. You can trigger the 
skill by selecting the Identify similar demands  button on the demand record page.

The similar demand records identified by Now Assist  are displayed in the Similar 
Demands related list as well as in a message banner at the top of the record page.

Refine records
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Improve record quality by enabling AI assistance in the rich and long fields of 
Product idea, Demands, Epic, Projects, Capability, Features, Stories, Project tasks, 
Risks, Strategic priorities, Goals, Targets, Initiatives, Feedback, Milestones, and 
Story forms. You can enable text refinement with the Elaborate  and Shorten  options 
on the records to support portfolio, project, product, demand managers and agile 
team members in creating and editing records content more effectively.

Multi feedback summarization or Feedback summarization

Provides your product managers with a concise and informative summary of the 
lengthy customer feedback comments. The product managers can generate a 
summary from the name and description of one or multiple feedback records so 
that they can quickly understand the feedback context. The generated summary 
can be directly converted to an execution item. Now Assist  can generate a summary 
from the feedback only if the feedback has at least 60 words in the fields that 
are used for the input data. The 60-word minimum optimizes the experience by 
verifying that there’s enough information to make a summary.

The following example shows a summarization of multiple feedback records by 
using the multi feedback summarization skill.

Multi feedback summarization skill

Project doc summarization, Planning Item doc summarization, or EAP doc summarization

Provides your product managers with a concise and informative summary of the 
selected or complete text by using Now Assist  in Docs. Your product managers 
can summarize, elaborate, or shorten the selected or complete content on Docs 
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to quickly understand the key information by using the Project doc summarization 
(Project Workspace), Planning item doc summarization (Strategic Planning), or EAP 
doc summarization (Enterprise Agile Planning) skill.

Now Assist in Docs

Project insights generation

Monitor the progress and changes in each project through the Project insights 
generation skill. With minimal effort, your project managers can schedule a cadence 
for generating project insights and receive it via email. They can track key elements 
such as the project, project task, milestone, resource assignment, ridac, and 
financial. They can also prioritize key elements to focus on. They can also decide 
the cadence of receiving project insight emails.

Now Assist Project insights generation skill

Conversational experiences for demand creation

Simplify the process of creating a Demand within the Employee Service 
Management  (ESC) portal by using the Now Assist  conversational catalog creation 
capability.
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• Avoid searching through the list of catalog items to find the right item for demand 
creation.

• Answer contextual questions in the chat to auto-populate the relevant fields in the 
Demand form.

If Microsoft Teams  and Mobile are enabled as a display location for Now Assist  in 
Virtual Agent, users can use the conversational experience to create a demand in 
those applications too.

Note: 
This skill is available within the Platform category of the Now Assist Admin 
console.

Project status generation

Generate an AI‑assisted  project status report using project status generation skill.

With project status generation skill, Now Assist predicts overall and dimension‑level  project 
health (such as schedule, cost, resources, and scope), generates an executive summary using 
weekly project data, and provides a rationale for each prediction. Project Managers can generate 
a status report where AI pre-populates key fields:

• Overall project health

• Health by dimensions (schedule/cost/resources/scope)

• Executive summary

• Rationale/analysis for each predicted health value

This skill streamlines the process of status report creation in Project Workspace.

Now Assist Admin  console

An administrator can use the Now Assist Admin  console in Strategic Planning  Workspace to 
activate and manage Now Assist  features and skills in Workspace. For more information about 
the Now Assist Admin  console, see Overview tab in Now Assist Admin .

AI agents

The ServiceNow AI agents use LLMs (Large Language Models) to process tasks, from basic 
responses to complex problem-solving and optimize the live agent workflows. For more 
information on Now Assist AI agents, see Using AI agent or agentic workflows in Now Assist for 
Strategic Portfolio Management (SPM).

Related topics

Exploring Now Assist Admin

Configure Now Assist Admin features

Using Now Assist for Strategic Portfolio Management (SPM)

Using AI agent or agentic workflows in Now Assist for Strategic Portfolio Management (SPM)

Now Assist for SPM reference

AI Agent Studio
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Supporting information for Now Assist for Strategic Portfolio Management 
(SPM)

Get a quick overview of the important information that is related to the Now Assist for Strategic 
Portfolio Management (SPM)  application.

Supported versions

The Now Assist for SPM  application is supported starting with the Xanadu  patch 3 release.

Supported user interfaces

The Now Assist for SPM  application is supported for the Strategic Planning Workspace, Project 
Workspace, Demand Management, and Enterprise Agile Planning.

Licensing requirements

The Now Assist for SPM  application requires an SPM Pro plus license.

Application information

Activate the latest Now Assist for SPM  (sn_spm_gen_ai) store app to use the Now Assist  skills.

This store app has the following dependencies:

• Now Assist for Platform (sn_genai_platform)

• Strategic Planning

• Project Workspace

• Enterprise Agile Planning

• Demand workbench

For more information, see Configure Now Assist Admin features.

Related topics

Exploring Now Assist for Strategic Portfolio Management (SPM)

Using Now Assist for Strategic Portfolio Management (SPM)

Now Assist for SPM reference

Using AI agent or agentic workflows in Now Assist for Strategic Portfolio Management (SPM)

Configure Now Assist  Admin features
Use the Now Assist Admin  console to activate the various Now Assist  applications and skills that 
you’re entitled to.

Configuration overview

Install and activate the plugins, turn on the Now Assist  panel, and view the account settings. You 
must install at least one Now Assist  application before you can configure any skills.

The following example shows the Settings page with available plugins to install, including Now 
Assist for Strategic Portfolio Management (SPM).
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Now Assist Admin  settings page

To enable the Agile story generation skill and project insights generation skill, verify that Now 
assist panel is enabled. For more information, see Activate the Now Assist panel standard chat . 
For Agile story generation skill, verify AI Search is activated and ready to use by navigating to All 
> AI Search  > AI Search Status

Important: 
The Acceptance criteria generation skill also requires activating Refine Records skill.

Related topics

Using Now Assist for Strategic Portfolio Management (SPM)

Overview tab in Now Assist Admin

Configuring Now Assist Admin features

Install Now Assist  plugins

Install Now Assist  plugins to enable generative AI on your instance.

Before you begin
Role required: admin

Follow these instructions to get started with Now Assist Admin:

1. To get started with Now Assist, you must install at least one Now Assist  application on your 
instance.

2. Activate any Now Assist  plugin from the ServiceNow  Store to access Now Assist Admin.

3. Install additional plugins, from the Now Assist Admin  console.

4. The Now Assist Admin  console guides your implementation, starting with installation.

5. Check out the Now Assist  Journey Checklist for more information .
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Procedure

1. Navigate to All  > Now Assist Admin  > Settings.

If you’re already in Now Assist Admin, select the Settings  tab.

2. On the Settings  page, select Plugins.

Plugins appear as cards. Review all Now Assist  plugins on the Available for you  tab. Plugins 
that you have already installed appear on the Installed  tab.

3. Select Get plugins  on the card for the plugin that you want to install.

4. In the confirmation window, select Install Plugin  to open the ServiceNow Store  page for the 
plugin in a new browser tab.

5. Install the plugin from the ServiceNow Store  page.

Some applications may require you to request the app from the ServiceNow®  Store  first. After 
you've requested the application from the ServiceNow®  Store  page, navigate to All  > System 
Applications  > All Available Applications  > All  to finish the installation.

6. Return to the Now Assist Admin  console.

7. In the dialog box, select Refresh.

8. Either close the dialog box to review all of your plugins or select View all (Plugin) Assists and 
Skills  to review the features of your new plugin.

Result
Your plugin is successfully installed.

If you encounter issues installing or updating applications, see this knowledge article  for steps 
that may address your issue. Otherwise, you can make a Support case.

Related topics

Activate a Now Assist skill

Skill inputs for Now Assist for Strategic Portfolio Management (SPM)

Learn about the inputs of each skill for the Now Assist for Strategic Portfolio Management (SPM) 
application. By configuring the inputs for a skill, you can determine how and when a skill is used.

Now Assist for Strategic Portfolio Management (SPM)  Overview

Depending on the selected skill, you can configure inputs. These settings determine how a 
skill is used. An input identifies the data that is used for a skill, such as the table and fields that 
are used to generate a feedback summary. If you have the admin role and any input fields are 
editable, you can modify the input data for a skill.

Demand summarization skill inputs

The demand summarization skill includes the inputs that identify the table along with the fields 
and related lists that are used to generate the demand summary. The following table provides 
more details on the input data.
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Input data for the demand summarization skill

Input Description

Table Demand [dmn_demand]

Fields • Short description

• Category

• Type

• Description

• Investment Class

• Investment Type

• Submitted by

• Demand manager

• Expense type

• Priority

• Department

• Business Unit

• Business Capabilities

• Impacted Business Applications

• Risk of performing

• Risk of not performing

• Enablers

• Barriers

• In scope

• Out of scope

• Assumptions

• Capital expense

• Operating expense

• Total planned cost

• Financial return

• Financial benefit

• Capital budget

• Operating budget

• Impact

• Risk

• T-Shirt size

• Value

• Size

• Score

• Start date
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Input data for the demand summarization skill  (continued)

Input Description

• Due date

• Approved start date

• Approved end date

• Business case

Related lists • Work notes

• Demand tasks

• Cost plans

• Monetary benefit plans

• Non-monetary benefit plans

• Resource assignments

Feedback summarization skill inputs

The feedback summarization skill includes the inputs that identify the table and fields that are 
used when a feedback summary is generated. The data source contains the tables and fields 
that the skill relies on. The following table lists the inputs for the feedback summarization skill.

Inputs for the feedback summarization skill

Input Description

Table Feedback [sn_align_core_feedback]

Fields • Name

• Description

Acceptance criteria generation skill inputs

The Acceptance criteria generation skill includes the inputs that identify the fields that are used 
as context to generate acceptance criteria for a story. The following table provides more details 
on the input data.

These inputs are available to configure for both Enterprise Agile Planning  and Agile Development 
2.0  applications.

Story input data for Generate acceptance criteria skill

Input Description

Table Story [rm_story]

This value can't be changed.

Fields Short description, Description
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Story input data for Generate acceptance criteria skill  (continued)

Input Description

You can choose to add more fields to serve as 
context to generate acceptance criteria.

Acceptance criteria template A default template is provided.

You can choose to modify the existing 
template or define a new template based on 
your team's requirements.

Reference stories Tag a story as a reference when it contains 
ideal acceptance criteria. These tagged stories 
serve as examples for Now Assist, giving it 
additional context to generate well-structured 
acceptance criteria for new stories.

Refine records skill inputs

Input data for the writing planning item skill

Input Description

Planning item fields Description

Story fields • Description

• Acceptance criteria

Table
Product idea [sn_align_core_product_idea]

Demand [sn_align_core_demand]

Capability [sn_align_core_capability]

Epic [sn_align_core_scrum_epic]

Project [sn_align_core_project]

Feature [sn_align_core_feature]

Story [rm_story]

Related topics

Configure Now Assist Admin features

Exploring Now Assist for Strategic Portfolio Management (SPM)

Using AI agent or agentic workflows in Now Assist for Strategic Portfolio Management (SPM)

Using Now Assist for Strategic Portfolio Management (SPM)

Now Assist for SPM reference
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Enable conversational demand creation using Now Assist  in Virtual Agent

Activate the required skills and learn about required configuration to enable creating a demand 
through Agent assist  in Virtual Agent  using the conversational experience.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Assist Admin  > Skills.

2. Select the Platform  category.

3. On the Now Assist Multi-Turn Catalog Ordering skill card, select Turn on.

What to do next

• Ensure that AI Search is installed and provisioned for your instance. Navigate to All  > AI 
Search  > AI Search Status

• Set up Now Assist in Virtual Agent. See Configuring assistants overview .

• You can add or modify the question prompts to be asked by Agent assist  in Virtual Agent  while 
creating a demand for the user. See Configure the questions for demand creation in Now 
Assist for Strategic Portfolio Management (SPM).

Configure the questions for demand creation in Now Assist for Strategic Portfolio 
Management (SPM)

Add a new or modify an existing question for Now Assist  in Virtual Agent  while creating a demand 
in the Now Assist for Strategic Portfolio Management (SPM)  application.

Before you begin
Ensure that the following plugins are installed:

• Now Assist for Platform (v4.0.2)

• Now Assist for IT Service Management (ITSM)

• Now Assist in Conversational Catalog Request

Note: 
Installing Now Assist  in Conversational Catalog Request automatically installs all the 
other dependent plugins.

• Activate the Conversational experience skill.

• Configure Now Assist  in Virtual Agent. For more information, see Configure Now Assist in 
Virtual Agent .

Note: 
If Microsoft Teams  and Mobile are enabled as a display location for Now Assist  in Virtual 
Agent, your end user can use the conversational experience to create a demand in those 
applications too.

Role required: admin or catalog_admin
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Procedure

1. Navigate to All  > Service Catalog  > Catalog Administration  > Conversational catalog 
overview.

2. Select the Create a New Demand  catalog item.

3. Identify any unsupported conversational catalog item question types and suggestions to make 
them conversational by selecting Now Assist for Virtual Agent.
For information on unsupported fields, see Configure Now Assist in Conversational Catalog 
Request .

4. Review the existing questions in the Variables related list and add or modify questions by 
selecting Edit in advanced view.

Update the project summary header and footer of your email using script 
include

Use the script include to modifying the email template for project summary.

Before you begin
Ensure the Now Assist for SPM  is installed and email project summary skill is active.

Role required: admin

Procedure

1. Navigate to All  > System UI  > Script Includes.

2. Open the ProjectInsightsEmailTemplateCustomConstants  script include and 
update the 
ProjectInsightsEmailTemplateCustomConstants.EMAIL_HEADER_HTML 
constant for email's header.

This example demonstrates the script include for email's header as follows:

 ProjectInsightsEmailTemplateCustomConstants.EMAIL_HEADER_HTML 
 = `<p><span style="color: white;"><a 
 href="https://www.servicenow.com/" target="_blank" 
 rel="noopener noreferrer nofollow"><span style="color: 
 white; text-decoration: none;"><span style="color: 
 blue;"><img style="height: 30px; width: 150px; border: 
 none;" src="sn_spm_gen_ai.sn-logo-project-insights.png" 
 alt="servicenow logo" height="30px" 
 border="0" /></span></span></a></span></p>`;

3. Update the 
ProjectInsightsEmailTemplateCustomConstants.EMAIL_FOOTER_HTML 
constant for email's footer.

This example demonstrates the script include for email's footer as follows:

ProjectInsightsEmailTemplateCustomConstants.EMAIL_FOOTER_HTML 
 = `<p style="border-top: 1px solid #293e40; line-height: 
 0;"><span style="color: #999999;">&nbsp;</span></p><div 
 style="caret-color: #212121; color: #212121; font-family: 
 Aptos; font-size: 16px; width: 100%; margin: 0 auto; 
 padding: 0; background-color: #ffffff;">      <!-- Logo 
 Section -->      <div style="line-height: 0.8;">      
  <span>          <a href="https://www.servicenow.com/" 
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 target="_blank" rel="noopener noreferrer nofollow" 
 style="text-decoration: none;">            <img 
 src="sn_spm_gen_ai.sn-logo-project-insights.png" 
 alt="servicenow logo" style="height: 20px; width: auto; 
 border: none;" />          </a>        </span>      </div> 
      <!-- Address and Footer Information -->      <div 
 style="font-family: 'Century Gothic', CenturyGothic, 
 Helvetica, sans-serif; font-size: 12px; line-height: 
 0.8; color: #293e40; margin-top: 5px;">        <p 
 style="margin-bottom: 0; padding: 0; line-height: 0.8; 
 font-size: 10px;">          <span>2225 Lawson Lane, Santa 
 Clara, CA 95054, United States</span>        </p>       
 <p style="margin-bottom: 0; padding: 0; line-height: 0.8; 
 font-size: 10px; color: #293e40;">          <span>&copy; 2024 
 ServiceNow. All rights reserved</span>        </p>      </div> 
    </div>`;

On completion, the project summary email template is customized with the header and footer.

Configure the Monitor project tasks AI agent in AI Agent Studio

Monitor project tasks autonomously by configuring the AI agent in the AI Agent Studio.

Before you begin
Role required: admin or it_project_manager

Procedure

1. Navigate to All  > AI Agent Studio  > Create and manage.

2. From the Agentic workflows list, select Monitor project tasks AI agent.
From the Monitor project tasks agentic workflow, each AI agent is shipped as active by default.

Note: 
Only users with the Now Assist panel (NAP) role can access agents, even if the current 
agentic workflow doesn’t require that role.

3. Enable the Monitor project tasks AI agent:

a. From Define key requirements screen, select Continue.

b. From Define user access screen, select Continue.

c. From Define data access screen, select Continue.

d. From Add triggers screen, select the Project task update monitoring and turn on the Trigger. 
Select Save  and select Continue.

e. From the Select channels and status screen, select Save and test.

The agentic workflow trigger defines the events that invoke AI agents for this agentic workflow. 
The trigger ensures that the AI agents can only start working upon specific key updates to 
project tasks.

4. Navigate to Workspaces  > Project Workspace  and select the project.

The admin must enable the project insights generation skill for a specific project and set 
up a cadence for the project insights email. For more information on how to set up an email 
cadence, see the Schedule the project insights email.

5. Enable the AI agent for a specific project:
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a. Schedule the project insights email.

b. From the planning page, select the more actions icon ( ) and then select Enable critical 
task alerts.

Note: 
Enable critical task alerts option is only available when the email is scheduled. To 

disable the AI agent, select the more actions icon ( ) and then select Disable critical 
task alerts.

The Monitor project tasks agents are enabled for the selected project.

Related topics

Configure Now Assist AI agents

Install Now Assist AI agents

Using AI agent or agentic workflows in Now Assist for Strategic Portfolio Management (SPM)

Strategic Portfolio Management AI agents for the monitor project tasks agentic workflow

Configure Create stories agentic workflow with Now Assist for SPM

Using the AI Agent Studio, you can review and edit the configuration of the Create stories agentic 
workflow to modify the workflow description, steps, and agents included.

Before you begin
Ensure that the Application scope of your ServiceNow  instance is set to Now Assist for Strategic 
Portfolio Management (SPM).

Role required: admin

Procedure

1. Navigate to All  > AI Agent Studio  > Create and manage.

2. From the list of Agentic workflows, select Create stories.
Each AI agent included in this workflow is active by default.

Note: 
Only users with the Now Assist panel (NAP) role can access agents, even if the current 
agentic workflow doesn’t require that role.

3. Review and modify the Create stories AI workflow using the following sections:

a. From the Define key requirements section, review the workflow description, steps involved, 
and AI agents added.

b. From the Define user access section, select which user roles can access this agentic 
workflow

c. From the Define data access section, select the type of user who can access this agentic 
workflow.

d. From the Add triggers section, add triggers if you like this agentic workflow to be launched 
according to predefined triggers.

e. From the Select channels and status section, choose the ways in which your users can 
access this agentic workflow. The default selection for Create stories workflow is the Now 
Assist panel.
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4. Select Save and test.

The Create stories agentic workflow can only be tested in the Enterprise Agile Planning 
(EAP) workspace, from an epic or a feature record. To access EAP, navigate to Workspaces  > 
Strategic Planning Workspace  > Enterprise Agile Planning. For more information on how to 
use this agentic workflow in EAP, see Generate stories for work items in EAP using Now Assist 
for SPM.

After testing the workflow, you can come back to AI Agent Studio  to make any further changes.

Related topics

Configure Now Assist AI agents

Install Now Assist AI agents

Using AI agent or agentic workflows in Now Assist for Strategic Portfolio Management (SPM)

Strategic Portfolio Management AI agents for the monitor project tasks agentic workflow

Update severity scoring configuration for portfolio insights

Configure the severity thresholds and scoring factors that determine how planning items are 
classified as critical, medium, or low risk, so that Portfolio insights generates recommendations 
based on your organization's risk criteria.

Before you begin
Role required: sn_align_core.apw_admin

Note: 
Default severity thresholds and scoring factors are preconfigured for portfolio insights. 
Update these settings only if your organization's risk criteria differ from the defaults.

For example, the following default values apply to the Delayed planning items category:

• Default severityThresholds  configuration: { "severityThresholds": 
{ "critical": { "minScore": 10 }, "medium": { "minScore": 
5 }, "low": { "minScore": 1 } }

• Default scoringFactors  configuration: "scoringFactors": 
{ "scheduleDelay": { "enabled": true, "pointsPerDay": 0.5, 
"maxPoints": 10 }, "priority": { "enabled": true, "weights": 
{ "High": 3, "Medium": 1, "Low": 0 } }, "dependencyImpact": 
{ "enabled": true, "pointsPerDownstreamDependency": 1, 
"maxPoints": 6 }, "financialRisk": { "enabled": true, 
"benefitThreshold": 100000, "pointsIfAboveThreshold": 3, 
"maxPoints": 3 } } }

About this task
Severity scoring determines how the Portfolio insights skill classifies planning items and surfaces 
root causes and recommended actions. Each planning item receives an overall risk score based 
on weighted scoring factors — scheduled delay, priority, dependency impacts, and financial risk. 
The score is then evaluated against configurable thresholds to assign a severity level.

Severity levels are color-coded for quick identification: red for critical, yellow for medium, and 
green for low. The color assignments are fixed and cannot be changed.

Configuration is managed in the Insight topic configuration table using records with type set to 
Portfolio.
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The insights are generated for the following categories for a portfolio plan:

• Delayed planning items - Planning items delayed beyond planned end date

• Date misalignment - Planned vs Approved date misalignment

• Delayed start - Planning items with delayed starts

Note: 

• For Delayed planning items insights, root causes and recommendations are generated 
from the top 15 delayed planning items, ranked by severity score.

• For Delayed start insights, only planning items whose planned start date falls within the 
last 30 days are included.

Important: 
This topic covers severity scoring configuration for the Delayed planning items category. 
The same steps apply to the Delayed start and Date misalignment categories.

Procedure

1. Navigate to All  > sn_spm_gen_ai_insight_topic.list.
A list of Insight topic table records appear.

2. In the Type  column, right-click Portfolio  and select Show Matching  to show only records with 
the type set to Portfolio.

After applying the filter, the following three insight topic table records appear.

3. Next to an Insight topic record, select preview icon to open the record.
For example, select Preview Delayed Planning Item record icon to view the Delayed Planning 
Items record.

4. In the severityThresholds  section of the Default topic config  field, set the score range 
for each severity level according to your organization's risk criteria.
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Severity levels

Severity level Description

Critical Planning items whose risk score meets or exceeds the critical 
threshold. Displayed in red.

Medium Planning items whose risk score falls between the critical and 
low thresholds. Displayed in yellow.

Low Planning items whose risk score falls below the medium 
threshold. Displayed in green.

Default severityThresholds  configuration: { "severityThresholds": 
{ "critical": { "minScore": 10 }, "medium": { "minScore": 5 }, 
"low": { "minScore": 1 } }

5. In the scoringFactors  section of the Default topic config  field, set the weight for each 
factor that contributes to the overall risk score according to your organization's risk criteria.

Scoring factors

Scoring factor Description

Scheduled delay Contributes to the risk score based on the number of days a 
planning item is delayed beyond its planned end date. The 
score is calculated as 0.5 points per day delayed, up to a 
maximum of 10 points.

Priority Contributes to the risk score based on the priority assigned 
to the planning item: High (3 points), Medium (1 point), or Low 
(0 points).

Dependency impacts Contributes to the risk score based on the number of 
downstream dependent planning items affected by the delay, 
up to a maximum of 6 points.

Financial risk Contributes to the risk score based on the financial exposure 
associated with the planning item. Planning items with a 
benefit above the threshold receive additional points, up to a 
maximum of 3 points.
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Default scoringFactors  configuration: "scoringFactors": 
{ "scheduleDelay": { "enabled": true, "pointsPerDay": 0.5, 
"maxPoints": 10 }, "priority": { "enabled": true, "weights": 
{ "High": 3, "Medium": 1, "Low": 0 } }, "dependencyImpact": 
{ "enabled": true, "pointsPerDownstreamDependency": 1, 
"maxPoints": 6 }, "financialRisk": { "enabled": true, 
"benefitThreshold": 100000, "pointsIfAboveThreshold": 3, 
"maxPoints": 3 } } }

6. Save the configuration record.
The updated severity thresholds and scoring factor weights are applied when Portfolio insights 
next generates insights for planning items in the portfolio plan.

What to do next
To verify that the configuration is working as expected, open a portfolio plan that contains 
planning items with known delays and confirm that the severity classifications reflect the 
thresholds you set. For details, see View portfolio insights for a portfolio plan in Strategic 
Planning Workspace or Portfolio Planning Workspace using Now Assist for SPM.

Use Now Assist Admin
Use Now Assist Admin  to explore the various Now Assist  plugins, skills and associated 
Generative AI application  features you are entitled to.

Activate a Now Assist  skill

Configure the triggers, settings, and display locations for Now Assist  skills to enable generative 
AI capabilities.

Before you begin
Role required: sn_generative_ai.nsa_admin

About this task
Activate the skills that are most relevant to your use cases and business needs. For a full list of 
available skills, see Now Assist skills . After the skills have been activated, they’re accessible 
across the ServiceNow AI Platform  based on the availability and display settings you choose.

Procedure

1. Navigate to All  > Now Assist Admin Console  > Features.

If you’re already in the Now Assist Admin  console, select the Now Assist Features  tab.

2. On the navigation panel, select a workflow, such as Technology.

Each workflow contains feature sets.

3. On the feature card that is associated with the skill you'd like to activate, select View details.

4. In the All available skills section, select Activate Skill.

5. In the first step of the skill configuration, determine which inputs or triggers that you want to 
associate with the skill.

Each skill configuration has steps that are shown in the guided setup. The exact steps vary 
from skill to skill. A symbol next to each step indicates whether the step is completed, partially 
completed, or not completed. After configuring a step, select Save and continue  to go to the 
next step. Return to a previous step by selecting Back.
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Note: 
Some configuration options are read only.

6. After you've configured the current step, select Save and continue  to go to the next step.

7. Optional:  For some skills, the next step is to define the availability.

(Optional) You can select Skill is always available  if you do not want to place any restrictions 
on when the skill is available for use. If you want to add conditions, select Customize skill 
availability. Selecting this option opens up a condition builder for you to select fields and 
values that determines whether someone can use the skill.

8. In the next step of the skill configuration, select where you'd like to display the skill.

Options vary from skill to skill. Some options are only available for certain skills.

◦ In-product desktop: When selected, Now Assist  skills are displayed on forms and 
workspaces.

◦ Now Assist panel: When selected, Now Assist  skills are available in the Now Assist  panel. If 
you don't see this option, you must activate the Now Assist  panel. For more information, see 
Activate the Now Assist panel standard chat .

◦ Core UI: When selected, the Now Assist  skill will display as a UI action in the Core UI.
Select the down arrow next to the Display toggle to select the roles that can use the skill. Roles 
can be added by entering the name of the role in the User roles field. Existing roles can be 
removed by selecting the X icon in the role bubble. You must have at least one role specified, 
but you can add as many as you like.

9. Review your choices and select Activate  to complete the configuration.

What to do next
Use the Now Assist  applications and skills that you've activated.

Configure project insights generation skill in the Now Assist Admin  console

Define the triggers, inputs, and display location for project insights generation skill.

Before you begin
Role required: admin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Procedure

1. Navigate to All  > Now Assist Admin  > Features.

If you’re already in the Now Assist Admin  console, select the Now Assist Features  tab.

2. On the navigation panel, select Technology  and select SPM.

Each workflow contains feature sets.

3. On the Project insights generation feature card, select Turn on.
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4. In Add users access section, specify the user or roles.

5. Review the role restrictions to skill and select Turn on  to activate the skill.

New topics in project insights framework to support reuse across portfolio insights, project 
insights, and status report contextual data:

◦ Project delays

◦ Task dependency

◦ Budget fluctuations

Result
The skill is active on the instance.

What to do next
Analyze your skill performance and usage on the Now Assist Admin  console to help determine 
the success of the skill. Learn more about tracking your Now Assist  usage at Monitoring Now 
Assist usage in Subscription Management .

Configure project status generation skill in the Now Assist Admin  console

Configure the project status generation Now Assist skill to enable.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Now Assist Admin  > Now Assist Features.

If you’re already in the Now Assist Admin  console, select the Now Assist Features  tab.

2. On the navigation panel, select a workflow, such as Technology.

3. On the project status generation card that is associated with the skill you'd like to activate, 
select Activate skill.

Admin configurations: On Status report generation skill card, select Edit  to review settings. 
Review the dimension level configurations and update the skill. Select Save and continue 
to apply changes. Review and update the executive summary template according to your 
guidelines and select Save and continue  to proceed with next screens. This is one time admin 
configuration.

4. From Overall health screen, review health criteria for each project dimension and select Save 
and continue.
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Switch scope

5. Review the executive summary screen and select Save and continue.
Switch scope

6. From Define access screen, select Save and continue.
Roles can be added by entering the name of the role in the User roles field. Existing roles 
can be removed by selecting the X icon in the role bubble. You must have at least one role 
specified, but you can add as many as you like. In the next step of the skill configuration, select 
where you'd like to display the skill.

7. You can select in-product if you'd like to display the skill on forms and workspaces.

8. Review your choices and select Activate  to complete the configuration.

Using AI agent or agentic workflows in Now Assist for Strategic 
Portfolio Management (SPM)
Use the AI agents for SPM to monitor project tasks autonomously.

Available AI agents for SPM

Agentic workflow name Description Available AI agents

Monitor project tasks
Autonomously monitor project tasks 
on the critical path of a project. Detect 
key updates, such as a delay to 
planned end dates, status updates to 
red, or state updates to incomplete or 
skipped.

When these changes occur, the 
AI Agent autonomously triggers a 
project summary email to the project 
manager, highlighting the specific 
updates that triggered the alert.

• Project summarizer

• Project eligibility analyzer

Create stories Convert epics into actionable user 
stories quickly. Powered by an 
agentic workflow, Now Assist  analyzes 
epic details to recommend the 
optimal number of stories, enables 
adjustments, refines story content 
based on your feedback, and helps 
create relevant and accurate story 
records.

Validate the work item and 
generate stories

Looking for an AI agent?

• There might be AI agents installed with the Now Assist  application that are not used in agentic 
workflows. To learn how to see all agents that are available on your instance, see Find AI 
agents .

• To find agents that might not be installed on your instance, visit the AI Agent Marketplace  on 
the ServiceNow Store.
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Important: 

All agentic workflows and AI agent records are read-only by default.

To run the AI agents autonomously, you must do the following steps:

• Activate the agentic workflow.

• All AI agents in a agentic workflow are active by default.

Related topics

AI Agent Studio

Configure Now Assist AI agents

Configure the Monitor project tasks AI agent in AI Agent Studio

Strategic Portfolio Management  AI agents for the monitor project tasks 
agentic workflow

Use the Monitor project tasks agentic workflow to autonomously generate a project insights 
email by using AI agents. AI agents help project managers to manage risks, resolve issues, or 
take actionable decision on the projects.

Important: 
This agentic workflow is turned on by default. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Monitor project tasks overview

The Monitor project tasks agentic workflow can help to trigger a project insights email and 
provide real-time visibility into key project updates. Use the project insights generation skill to 
generate a project summary and send it as an email to the project managers.

This proactive monitoring and alert system saves time and effort for project managers, ensuring 
that they can respond promptly to keep project schedules on track. By leveraging these AI 
agents, project managers can optimize their operations and enhance the overall project 
efficiency.

The email summary includes the following sections:

• Overall project insights

• Top insights needing attention

• Milestone insights

• Resource insights

• Project task insights

If you want to change this agentic workflow, you can duplicate it , adjust the settings to suit your 
specific needs, and activate the duplicated version of the agentic workflow instead.

Monitor project tasks agentic workflow

Autonomously generate a project insights email using AI agents. To use Monitor project tasks, 
make sure that the project insights generation skill is active. For more information on how to 
activate the skill, see Configure Now Assist Admin features.

To access the Monitor project tasks agentic workflow:
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1. Navigate to All  > AI Agent Studio  > Create and manage.

2. Select Monitor project tasks.

To configure the Monitor project tasks agentic workflow and associated AI agents, see Configure 
the Monitor project tasks AI agent in AI Agent Studio.

AI agents used in the Monitor project tasks agentic workflow

The following AI agents are used for the Monitor project tasks agentic workflow:

• Project summarizer

• Project eligibility analyzer

Other agentic workflow

For more information on other agentic workflow that are associated with the Platform workflow, 
see Platform agentic workflows .

Related topics

Now Assist AI agents

Install Now Assist AI agents

AI Agent Studio

Create stories agentic workflow using Now Assist for Strategic Portfolio 
Management (SPM)

Use the Create stories agent to generate high-quality stories for planning items in Enterprise 
Agile Planning  (EAP).

Important: 
This agentic workflow is turned on by default. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Create stories overview

Product managers often spend excessive time manually converting epics into user stories. This 
process is not only time-consuming but also prone to gaps in detail, leading to confusion, rework, 
and delays in planning and delivery. Missed or unclear requirements can compromise the quality 
of the final product.

Create stories AI agentic workflow addresses these challenges by automating story generation 
from epics and features through an intelligent, conversational process:

• Analyze and generate: The agent reviews the epic description and creates relevant, detailed 
user stories.

• Interactive refinement: The agent engages in a free-flow conversation with you, presenting 
story recommendations, accepting feedback, and iterating based on your input.

• Decision and action: The agent manages successful flows such as saving validated stories and 
feedback loops such as removing unwanted stories and learning from corrections to ensure 
that accurate, high-quality stories are finalized.

The key benefits of this workflow are:
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• Time savings: Automatically generates stories from epics and features, reducing manual effort.

• Improved quality: Produces clear, validated stories aligned with requirements.

• Faster execution: Creates cleaner backlogs and better alignment for planning.

Unlike rigid AI templates, this workflow emphasizes flexibility and collaboration, enabling 
dynamic input and refinement to deliver precise, actionable user stories.

If you want to change this agentic workflow, you can duplicate it , adjust the settings to suit your 
specific needs, and activate the duplicated version of the agentic workflow instead.

Create stories agentic workflow

To access the Create stories agentic workflow:

1. Navigate to All  > AI Agent Studio  > Create and manage.

2. Select Create stories.

To configure the Create stories agentic workflow and associated AI agents, see Configure the 
Monitor project tasks AI agent in AI Agent Studio.

AI agents used in the Create stories agentic workflow

Validate the work item and generate stories: Responsible for the end-to-end process of 
transforming Enterprise Agile Planning work items (epics and features) into a set of well-formed, 
actionable user stories.

Using the Create stories agentic workflow

See Generate stories for work items in EAP using Now Assist for SPM.

Using Now Assist for Strategic Portfolio Management (SPM)
With the Now Assist for Strategic Portfolio Management (SPM)  application, you can summarize 
feedback, create demands, generate document summaries, and refine planning item 
descriptions for clarity and alignment. You can also quickly produce and share project insights 
via email and use the AI agents to monitor project tasks autonomously.

Related topics

Using AI agent or agentic workflows in Now Assist for Strategic Portfolio Management (SPM)

Summarize the feedback by using Now Assist for Strategic Portfolio 
Management (SPM)

Generate a summary from the name and description of the feedback records so that you can 
analyze a large volume of feedback quickly without reading each feedback record manually. You 
can do this task by using the multi feedback summarization skill in the Now Assist for Strategic 
Portfolio Management (SPM)  application.

https://player.vimeo.com/video/1016235687?
h=c41764ac08&badge=0&autopause=0&player_id=0&app_id=58479
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Before you begin

Important: 
This Now Assist  skill is now turned on by default. The skill will be automatically available to 
appropriate role users for the application. This change simply activates the skill and does 
not touch the roles that are needed to use the skill. The new default behavior works as 
follows:

New customers

When you install a Now Assist  product, designated skills will turn on 
automatically.

Existing customers who are upgrading

Any previously unconfigured skill will turn on automatically (the skill was never 
turned on, then off again).

There is no change to Now Assist  skills that are currently enabled and 
customized.

Previously configured skills that were turned on, then off, will remain inactive.

If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles and also add those custom roles to the In product role.

Role required: pf_user

About this task
With the feedback or multi feedback summarization skill, you can get enough details about 
the feedback that you received on your product so that you can improve the product features, 
usability, and performance.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and select Feedback.

2. From the Feedback page, select any feedback filter card.

3. From the feedback list, select one or multiple feedback records.

View a loader for the side panel while the summary content loads for a more engaging loading 
experience.

If you want to generate a summary for one feedback record, you can either generate it from the 
list level or at the record level. At the record level, the feedback summary is displayed in the 
Now Assist  component. The component is collapsed by default and expands to display the 
summary.

4. Select Summarize.

View an animation for the Now assist icon when you hover over it.

You can generate a summary of a single feedback record by using the feedback summarization 
skill. This image shows the AI-generated summary for a single feedback record.
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You can use the multi feedback summarization skill to generate summaries of one or multiple 
feedback records. For example, you can analyze the high-priority feedback, filter them, 
summarize the records, and gain insights into the requirements.

Note: 
Because the information in these fields is automatically generated, it's a good idea to 
review the text and make sure it's accurate.

The feedback or multi feedback summarization skill uses the name and description 
information of the feedback record to generate a paragraph or bullet-point summary from the 
feedback.

View the hover animation for the Now Assist icon on the Summarize button in the feedback list 
and Docs.

5. Optional:  When you're finished summarizing the feedback, you can expand or collapse the 
summary, provide feedback, copy it, or view information about it.
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Note: 
The feedback summarization or multi summarization skill checks the feedback records to 
determine if enough information is available to generate a summary. If there isn't enough 
feedback content to summarize, you can add more content and retry.

On the side panel, you can select the preview record icon ( ) to view the additional details or 

select preview generated summary icon ( ) to view the summarization output.

6. Optional:  Select Copy and create epic  to copy the generated summary and create a planning 
item.

(Optional) Save time and streamline your work flow by linking the feedback with planning 
items, which eliminates the need to copy summaries. You can quickly create work items in 
Feedback  and view them in the roadmap.

Create demands by using the conversational experience

Use the conversational experience of Now Assist  in Virtual Agent  to create a demand from any 
application that supports Virtual Agent.

Before you begin
Ensure that the following tasks are completed:

• Install an application that supports Virtual Agent.

• Complete configuring the conversational experiences for demand creation. For more 
information, see Configure Now Assist Admin features.

Role required: none

About this task

https://player.vimeo.com/video/986004158?
h=d45fb142d9&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

In the application that supports Virtual Agent, for example Employee Service Center, start with 
a prompt to create a demand in the chat. Through a series of questions, Virtual Agent  prompts 
you to provide information for the questions that you configured for a catalog item. Now Assist  in 
Virtual Agent  understands the context and maps the information that you provide in response to 
a question to an appropriate catalog item, in this case, a demand.

Procedure

1. Navigate to All  > Self-Service  > Employee Center.

2. Select Open chat window.

3. Enter an instruction to start the conversation with Virtual Agent.

You can start with a basic instruction such as Create demand  or an elaborate instruction that 
includes the demand's information. The following examples show how each instruction is 
handled in the chat.

Instruction Description

Short: Create demand Virtual Agent  starts a conversation to ask 
more information from you about the demand 
through a series of questions:
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Instruction Description

◦ What is the name of your demand?

◦ What is the reason for this demand?

◦ What are the risks associated with 
performing this demand?

The information you provide is used to fill in 
the fields of the Demand form. You can skip 
answering a question that is related to non-
required fields by entering skip.

Elaborate: Create a demand with the name 
Upgrade MyApp and business justification 
as upgrade and risk of not performing as 
milestones will be missed.

Using the context that you provided, Virtual 
Agent  automatically matches it to the relevant 
field on the Demand form.

It then instructs you to enter information of 
only those fields that you haven't provided, 
such as the risk associated with performing 
the demand, assumption, and others.

You can skip answering a question that is 
related to non-required fields by entering 
skip.
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Instruction Description

4. Review the information that Virtual Agent  filled in for the Demand form fields.
You can choose to make changes or submit.

5. Optional:  Add attachments for the demand.
The information that you provided is submitted to create a demand. Virtual Agent  creates a 
demand and provides the information such as its number, short description, and state.

The conversation is now complete.

Related topics

Using Now Assist in Virtual Agent

Identify similar records using Now Assist for Strategic Portfolio Management 
(SPM)

Detect similar demand records using the identify similar records Now Assist  skill. The skill 
detects similar demand records based on contextual similarity in the name, description, and 
business case content.
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Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

If you have custom roles that require access to this skill, update the ACLs (access control lists) 
for those roles that require access. For more information, see Implement access control in Now 
Assist AI agents .

Role required: it_demand_user

Procedure

1. Navigate to All  > Demand  > Demands  > Create New.
Alternatively, you can create a demand from Self-Service  > Demands  > Create New.

2. On the Demand form, fill in the Name, Description, and Business case  fields.
For a description of the field names, see Demand form.

3. Save Save.

4. Select the Identify similar demands  button to detect similar demand records.

Result
The similar demands identified by Now Assist  are displayed in the top banner and the Similar 
Demands related list.

Note: 

• If any similar records are present on the demand record, the related list is updated to 
display the list of identified similar records.

• If there are no identified similar records for a demand, a message is displayed to convey 
the same and the related list remains empty.
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What to do next
View the full details of the identified similar demand records by selecting the demand number 
link from the Similar Demands related list.

Summarize demands with the demand summarization skill

Summarize demand records using the demand summarization skill. The skill reviews the demand 
fields and related lists and helps create a clear summary of the demand.

https://player.vimeo.com/video/1174987769?
h=cc74855ef5&badge=0&autopause=0&player_id=0&%E2%80%A6

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: it_demand_user, it_demand_manager

If you have custom roles that require access to this skill, update the ACLs (access control lists) 
for those roles that require access. For more information, see Implement access control in Now 
Assist AI agents .

Procedure

1. Access a demand record in one of the following ways.

2. Select the Summarize  button to generate a summary of the demand.

Result
The summary generated by Now Assist  is displayed in the summary card.

Note: 
Select the copy icon to copy the generated summary for further use.
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Generate targets for a goal in Strategic Planning Workspace  using Now Assist 
for SPM

Generate measurable targets for your goals in Strategic Planning Workspace  using Now Assist 
for SPM.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_apw_advanced.spw_goal_user and (sn_align_core.apw_user or 
sn_gf.goal_admin)

About this task
The Target generation skill leverages the goal’s details and provided context to create a precise 
target for the goal. The more specific the input, the stronger the recommendations.

The skill automatically populates key fields in the Target form, ensuring accuracy and alignment 
with the goal. This helps teams define clear, measurable outcomes and speeds up the target-
setting process.

Note: 
Only the owner or contributors of the goal can create targets for the goal.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select the required portfolio plan that the goal belongs to.

3. In the Goals view, select the Goals and targets  tab.

4. Next to the goal that you want to create a target for, select the row context menu icon ( ) and 
select Generate target.

5. On the Provide context to generate a target window, enter a context to generate a desired 
target and then select Generate.
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Tip: 
The more specific the input, the stronger the recommendations.

6. On the form, verify the filed values and update them as needed.
For a description of the field values, see Target form.

7. Select Save.

Result
A target is created based on the goal’s details and any context that you provide.

The target progress records are automatically created when you save the target post populating 
the Actuals to date  field. The target progress records specify the progress of each target for the 
goal.

Note: 
When you delete a goal, its associated targets (if any) and their progress records are also 
deleted even though the Allow the deletion of targets  property is set to No.

What to do next
Update the progress of the target  manually if the target isn’t enabled for target automation.

Related topics

Add targets for a goal in Strategic Planning

Generate insights for a goal in Strategic Planning Workspace  using Now 
Assist for SPM

Review AI-generated insights to identify at-risk goals, assess forecasted statuses, and act on 
recommendations before goals fall off track.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_apw_advanced.spw_goal_user and (sn_align_core.apw_user or 
sn_gf.goal_admin)

About this task
The Goal insights skill analyzes the goal, its targets, subgoals, and aligned work, then delivers 
concise, data‑driven  insights—including AI forecasted status, confidence of achieving the goal, 
targets at risk, delayed or stalled aligned work and recommendations.

Note: 
When you generate insights for a goal, insights are also generated individually for each of 
its targets.

The skill analyzes the real-time data — including check-in patterns, comments, and planned 
versus actual progress — to forecast goal status and surface proactive recommendations.

Tip: 
For better reviews and recommendations, use the Goal insights skill with the AWS Claude 
model.
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Note: 
Only the owner or contributors of the goal can generate insights for the goal.

Note: 
If the Goal insights generation job is enabled, it automatically generates insights for 
each goal based on the job's run frequency. Before manually regenerating, check the 
timestamp on the goal insights summary card to confirm when insights were last generated 
— regenerating unnecessarily increases token consumption. You can also view the last 
generated insights in the AI rationale  column of the goal list. If goal or target data has 
changed since the last run, select the refresh icon on the goal insights summary card to 
regenerate the insights.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Strategy and Goals.

2. Select Favorites, Shared with me, Created by me, or Public, depending on where the board is 
located.

3. Select the board that contains the goal for which you want to generate insights.

4. From the list of goals, select Goal insights icon next to the goal.

Alternatively, you can select Show insights  on the goal's full details page.

The Goal insights side pane appears processing the insights for the goal. After a while, 
the Insights by Now Assist pane shows the insights for the goal including AI forecasted 
status, confidence of achieving the goal, targets at risk, delayed or stalled aligned work and 
recommendations.

5. Review AI-generated insights to identify risk, assess forecasted statuses, and act on 
recommendations before goals fall off track.

Related topics

Update the progress of an automated target

Update the progress of a manual target
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View portfolio insights for a portfolio plan in Strategic Planning Workspace  or 
Portfolio Planning Workspace  using Now Assist for SPM

View AI-generated insights for a portfolio plan in Strategic Planning Workspace  or Portfolio 
Planning Workspace  to identify planning items at risk of schedule delays, analyze root causes, 
and review recommended actions.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_align_core.apw_user

About this task
Use Portfolio Insights to identify prioritized planning items that are at risk of schedule delays. The 
insights are categorized by impact severity and include root cause analyses and AI-generated 
recommended actions to help you address identified risks.

The insights are generated for the following categories for a portfolio plan:

• Delayed planning items — Planning items delayed beyond the planned end date

• Date misalignment — Planned versus approved date misalignment

• Delayed start — Planning items with delayed starts

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Portfolio Planning.

2. From the list of portfolio plans, select the portfolio plan to view insights.

3. From the portfolio plan header, select Portfolio insights.
Portfolio Insights displays risk signals across the following areas: delayed planning items, 
projects at risk of schedule delay, start delays, and approved versus planned misalignments.

4. On the Portfolio insights modal, review the insight categories displayed.
Insights are grouped by impact severity — critical, medium, and low — to help you prioritize 
which items require immediate attention.
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5. Select an insight to view the root cause analysis.
The system displays detailed root cause information, including compounding risks such as 
resource overallocation across multiple planning items.

6. Review the AI-generated recommended actions for each root cause.
Recommended actions provide specific steps to mitigate delays and resolve misalignments 
within the portfolio plan.

7. Take corrective action based on the recommendations, as needed.

Result
Portfolio Insights identifies prioritized planning items at risk, along with root cause analyses and 
recommended actions to help you maintain portfolio health.

Generate stories for work items in EAP  using Now Assist for SPM

Breakdown epics and features into stories using the Now Assist  panel in the Enterprise Agile 
Planning  (EAP) workspace. Based on the work item details, Now Assist  generates stories.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_apw_advanced.eap_user or sn_apw_advanced.eap_read_only, with 
now_assist_panel_user

If you have custom roles that require access to this skill, update the ACLs for those roles that 
require access. For more information, see Implement access control in Now Assist AI agents .

About this task

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. From the Agile structure section of the navigation panel, choose your EAP  team that has an 
epic or feature as its work item type.

3. From the Backlog or Planning board pages, select an epic or a feature for which you want to 
create stories.
The work item details are displayed in the side panel.

4. From the side panel, select Full details.

5. From the work item header, select Create stories  to open the Now Assist  panel and trigger the 
Create stories agentic workflow.
The AI agent generates story recommendations based on the context available within the epic 
or feature.

6. Go through the story recommendations and choose to confirm, combine, split, remove any of 
the stories, suggest modifications, or create more stories.

Tip: 
While Now Assist  is working on the story recommendations for the current work item, you 

can start a new chat to create stories for another epic or feature. Select New chat  ( ) 
from the Now Assist  panel header. You can switch between chats by selecting All chats 

( ).
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7. You can iterate on any of these actions and when you’re satisfied with the recommendations, 
enter Save.
Now Assist  creates stories with the confirmed recommendations. The newly created stories are 
displayed in the Stories tab of the epic or feature details page.

Related topics

Configure Create stories agentic workflow with Now Assist for SPM

Create stories agentic workflow using Now Assist for Strategic Portfolio Management (SPM)

Generate a story from an epic using Now Assist for SPM  in EAP

Generate a complete user story directly from an epic using Quick story generation feature in EAP. 
Provide brief context, and Now Assist  generates a story title, description, and acceptance criteria 
that you can review and edit before saving.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Important: 
Quick story generation is only available if the following two skills are active:

• Agile story generation

• Generate acceptance criteria

Role required: sn_apw_advanced.eap_user

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile 
Planning.

2. From the Agile structure section of the navigation panel, choose your EAP  team that has an 
epic as its work item type.

3. From the Backlog, Hierarchy, or Planning board tabs, open your epic in its full details page.

4. Navigate to the Stories related list.

5. Select Generate Story.

6. In the context field, enter one or two lines describing the focus of the story.

For example, enter context such as "progress tracking for onboarding steps to help users 
visualize their journey and reduce abandonment rates" to direct Now Assist  toward a specific 
area of the epic.

7. Select Generate.
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Now Assist  generates a story title, description, and acceptance criteria based on the epic 
context and the input you provided.

8. Review and edit any of the generated fields inline to refine the story before saving.

All fields are editable. You can modify, add to, or remove generated content in the title, 
description, and acceptance criteria fields.

9. Select Save story.
The new story is added to the Stories list of the epic.

What to do next
To further refine the story after saving, open the story record and select Generate acceptance 
criteria  to regenerate or update the acceptance criteria using Now Assist. For more information, 
see Generate acceptance criteria for EAP stories using Now Assist for Strategic Portfolio 
Management (SPM).
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Related topics

Generate stories for work items in EAP using Now Assist for SPM

Generate acceptance criteria for EAP stories using Now Assist for Strategic Portfolio 
Management (SPM)

Generate a story from an epic using Now Assist for SPM  in Agile Development 
2.0

Generate a complete user story directly from an epic using the Quick story generation feature in 
Agile Development 2.0. Provide brief context, and Now Assist  generates a story title, description, 
and acceptance criteria that you can review and edit before saving.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Important: 
Quick story generation is only available if the following two skills are active:

• Agile story generation

• Generate acceptance criteria

Role required: scrum_story_creator

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the epic for which you want to generate a story.

3. Navigate to the Stories related list.

4. Select Generate Story.

5. In the context field, enter one or two lines describing the focus of the story.

For example, enter context such as "progress tracking for onboarding steps to help users 
visualize their journey and reduce abandonment rates" to direct Now Assist  toward a specific 
area of the epic.

6. Select Generate.
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Now Assist  generates a story title, description, and acceptance criteria based on the epic 
context and the input you provided.

7. Review and edit any of the generated fields inline to refine the story before saving.

All fields are editable. You can modify, add to, or remove generated content in the title, 
description, and acceptance criteria fields.

8. Select Save story.
The new story is added to the Stories list of the epic.

What to do next
To further refine the story after saving, open the story record and select Generate acceptance 
criteria  to regenerate or update the acceptance criteria using Now Assist. For more information, 
see Generate acceptance criteria for stories in Agile Development 2.0.
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Related topics

Generate a story from an epic using Now Assist for SPM in EAP

Generate acceptance criteria for EAP stories using Now Assist for Strategic Portfolio 
Management (SPM)

Generate acceptance criteria for EAP stories using Now Assist for Strategic 
Portfolio Management (SPM)

Create clear, comprehensive, and testable acceptance criteria for user stories without writing 
them manually in Enterprise Agile Planning  (EAP). Review and refine suggested options to 
ensure they meet your requirements.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Ensure that Now Assist for SPM  is installed in your instance and that the following two skills are 
active:

• Acceptance criteria generation

• Refine records

For more information, see Configure Now Assist Admin features.

Role required: sn_apw_advanced.eap_user

About this task
For an EAP story, you can generate acceptance criteria by selecting Generate acceptance 
criteria  from the story header or using the Now Assist context menu in the Acceptance criteria 
field.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. Navigate to your story using one of the following options from the left navigation menu:

◦ Enterprise Agile Planning: Select a team from the Agile structure and navigate to your story.

◦ Lists: Select Planning items  > Stories  and navigate to your story.

3. Ensure that the story record is open in the Full details page.

4. Generate acceptance criteria for the story using one of the following options:

◦ From the story form header: Select Generate acceptance criteria.

◦ From the Acceptance criteria field:

a. Place your mouse cursor in the field.

b. Select the Refine with Now Assist  menu ( ).

c. Select Generate acceptance criteria.
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5. Review the generated acceptance criteria.

6. You can choose to further refine the generated content using the Now Assist context menu 

( ) or generate a new criteria.

7. Save the Story form.

Generate acceptance criteria for stories in Agile Development 2.0

Create clear, comprehensive, and testable acceptance criteria for user stories without writing 
them manually in Agile Development 2.0. Review and refine suggested options to ensure they 
meet your requirements.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Ensure that Now Assist for SPM  is installed in your instance and that the following two skills are 
active:

• Acceptance criteria generation

• Refine records

For more information, see Configure Now Assist Admin features.

Role required: scrum_story_editor

About this task
For an Agile 2.0 story, you can generate acceptance criteria by selecting Generate acceptance 
criteria  from the story header or using the Now Assist context menu in the Acceptance criteria 
field.
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Procedure

1. Navigate to All  > Agile Development  > Stories.

2. Open your story record.

3. Generate acceptance criteria for the story using one of the following options:

◦ From the story form header: Select Generate acceptance criteria.

◦ From the Acceptance criteria field:

a. Place your mouse cursor in the field.

b. Select Refine with Now Assist  menu ( ).

c. Select Generate acceptance criteria.

4. Review the generated acceptance criteria.

5. You can choose to further refine the generated content using the Now Assist context menu 

( ) or generate a new criteria.

6. Save the Story form.

Related topics

Skill inputs for Now Assist for Strategic Portfolio Management (SPM)

Generate and improve Docs content with Now Assist for Strategic Portfolio 
Management (SPM)

Generate content with Now Assist for SPM  directly in your Docs using custom prompts. In 
addition, summarize existing sections, elaborate where needed, and refine drafts to help improve 
your productivity.

Before you begin
Role required: sn_align_core.ap_read_only, sn_align_core.pf_read, 
sn_apw_advanced.eap_read_only, sn_apw_advanced.pf_user, sn_align_core.apw_user, or 
sn_align_core.ap_read_only

About this task
You can interact with Now Assist directly in your Doc to create new content, add context, or 
improve existing sections. This helps you draft faster, refine ideas, and keep your work relevant 
without leaving the page.

The Generate and Improve Content feature is available in Strategic Planning Workspace, 
Portfolio Planning Workspace, and Project Workspace.
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This task will be explained using Project Workspace  as the example.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open the required project.

2. From your Doc, open the page you want to work with and use Now Assist  for any of your use 
cases.
Now Assist  analyzes the text and generates an output in a separate pop-up.

3. Optional:  Based on the output generated, you can further refine the result.

4. Optional:  Copy the generated output by selecting the copy to clipboard icon ( ) to use it for 
purposes such as sending an email, saving to notes, and others.

Important: 
Because the output is AI-generated, review it to ensure accuracy.

Summarize and refine Docs content in EAP  using Now Assist for SPM

Use Now Assist  capabilities to elaborate, shorten, and summarize selected content in Docs, or to 
get a summary of the whole document in Enterprise Agile Planning  (EAP).

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

• Create a Doc in EAP.

• Activate the EAP  doc summarization Now Assist  skill. See .

Role required: sn_apw_advanced.eap_user

If you have custom roles that require access to this skill, update the ACLs for those roles that 
require access. For more information, see Implement access control in Now Assist AI agents .

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  > Enterprise Agile Planning.

2. Navigate to your Doc.

3. From your Doc, open the page you want to summarize or refine.

4. Choose to summarize the selected text on the page or the whole page.

◦ To refine the selected text:

a. Select a single block or multiple blocks of content on the page.

b. Select Now Assist  and choose an option.
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i. Summarize  to summarize the selected text.

ii. Elaborate  to lengthen the selected text based on the existing context.

iii. Shorten  to make the selected text concise.

◦ To summarize the entire content on the page, select Now Assist  from the Doc header and 
select Summarize.

Tip: 
If there’s more content to summarize, you can remove some text and retry.

Now Assist  analyzes the text and generates an output in a separate pop-up.

5. Optional:  Based on the output generated, you can further refine the result or insert the 
generated content into the Doc.

(Optional)
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6. Optional:  Copy the generated output by selecting the Copy to clipboard icon ( ) to use it for 
purposes such as sending an email, saving to notes, and others.

Important: 
Because the output is AI-generated, review it to ensure accuracy.

Generate the summary for selected or complete content with Planning item 
doc summarization skill in Strategic Planning

Quickly learn the details of the documents from the summary that is generated by Now Assist  in 
Strategic Planning.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles and also add those custom roles to the In product role.

Role required: sn_align_core.ap_read_only, sn_align_core.pf_read, 
sn_apw_advanced.eap_read_only, sn_apw_advanced.pf_user, sn_align_core.apw_user, or 
sn_align_core.ap_read_only

About this task
Minimize the time that you spend reading documents, meeting notes, project reports and so on 
by using a summary that is generated by Now Assist. You can also copy-and-paste the source 
materials that meet your learning needs in Docs and generate a quick summary.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace  and open any planning item 
records such as product idea from Feedback.

2. From the Docs  tab, perform one of these actions according to your requirements.

Note: 
Summarization of the entire content is also permitted for users with the read role.

3. Optional:  When you're finished summarizing the content in Docs, you can provide feedback, 
copy, or view information about it.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

953

https://www.servicenow.com/docs/access?context=now-assist-skills-on-by-default&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=now-assist-skills-on-by-default&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=now-assist-skills-on-by-default&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=now-assist-skills-on-by-default&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US


(Optional)

Note: 
Because the information in these fields is AI generated, it's a good idea to review the text 
and make sure it's accurate.

Only an administrator can activate the Now Assist  skills. For more information, see Configure 
Now Assist Admin features.

The Planning item doc summarization skill checks the doc content to determine if enough 
information is available to generate a summary. If there isn't enough content to summarize, you 
can add more content and retry.

Note: 
The Summarize  button is visible only if the Planning item doc summarization skill is 
active. If the selected text exceeds the token limit for Now Assist, the Planning item doc 
summarization skill can't be executed. If there is more content to summarize, you can 
remove some content and retry.

Generate the summary for selected or complete content with Project doc 
summarization skill in Project Workspace

Quickly learn the details of the documents from the summary that is generated by in Project 
Workspace.

https://player.vimeo.com/video/1038147968?
h=9451c75819&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles.

Role required: project_manager, it_project_user
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Procedure

1. Navigate to Workspaces  > Project Workspace  and open the required project.

2. From the Docs, perform one of these action according to your requirements.

Note: 
Summarization of the entire content is also permitted for users with the read role.

3. Optional:  When you're finished summarizing the page in Docs, you can provide feedback, 
copy, or view information about it.

Note: 
Because the information in these fields is AI generated, it's a good idea to review the text 
and make sure it's accurate.

Only an administrator can activate the Now Assist  skills. For more information, see Activate a 
Now Assist skill.

The Project doc summarization skill checks the doc content to determine if enough information 
is available to generate a summary. If there isn't enough content to summarize, you can add 
more content and retry.

Note: 
The Summarize  button is visible only if the Project doc summarization skill is active. If the 
selected text exceeds the token limit for Now Assist, the Project doc summarization skill 
can't be executed. If there is more content to summarize, you can remove some content 
and retry.

Schedule the project insights email

Schedule the project insights email to prioritize and track the most important changes in the 
project in Project Workspace.

https://player.vimeo.com/video/1156994852?
h=fc02bd8ee8&badge=0&autopause=0&player_id=0&app_id=58479%22

Before you begin

Important: 
This Now Assist  skill is now turned on by default. The skill will be automatically available to 
appropriate role users for the application. This change simply activates the skill and does 
not touch the roles that are needed to use the skill. The new default behavior works as 
follows:

New customers

When you install a Now Assist  product, designated skills will turn on 
automatically.

Existing customers who are upgrading

Any previously unconfigured skill will turn on automatically (the skill was never 
turned on, then off again).

There is no change to Now Assist  skills that are currently enabled and 
customized.

Previously configured skills that were turned on, then off, will remain inactive.
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Role required: it_project_manager

About this task
By using the Project insights generation skill, you can generate a concise project insights. The 
project insights are shared through email. Project managers can monitor key elements such 
as project, project task, milestone, resource assignment, ridac, and financial. They can also 
prioritize their projects and decide the cadence of receiving these project insights email.

When a project is created in the work in progress state, the project insight generation skill 
is automatically enabled. This ensures that projects begin generating insights early in the 
execution phase without requiring manual setup. In addition, all existing projects in the work in 
progress state are automatically enabled for email‑based  project insights.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open any project.

2. From the planning page, select the more actions icon ( ) and then select Configure project 
insights.

From Project insights generation skill card, select Edit  to modify the email conditions. 
From project insights configuration screen, select Switch scope  and then select Edit 
conditions. Administrators can control insight generation through admin‑level  configuration. 
For more information on configurations, see Configure Now Assist Admin features. From Email 
condition modal, admins can define which projects should generate insights and trigger email 
notifications, providing flexibility over when and for which projects insights are sent.

3. From the Configure project insights modal, in Choose topics step, select Next.
You can select or deselect the project, project task, milestone, resource assignment, ridac, and 
financial card to customize what information is displayed in the Project insights email.

4. In Personalize content step, add your requirements and select Next.
You can define your tone, writing style, and priority entities. For example, identify risks of this 
project. Please provide a formal summary in bullet points.

5. In Set frequency step, select the Cadence  as Weekly, Bi-weekly, or Monthly according to your 
requirement.

6. Select On this day, as days for weekly or bi-weekly or dates for monthly cadence.

7. Select Users  from the list.

◦ The project manager is automatically set as the default email recipient for the project.

◦ You can select one or multiple users. Only users with sn_ppm_read role or have read or view 
access to project information appear for selection in the users list.

◦ When an email is sent to recipients, the project manager is placed in the To list, while all 
other recipients are included in the Cc list.

◦ For confidential projects, recipients are required to be included in the list of users authorized 
to view the project.

8. Optional:  Select Send preview  to generate and send a preview of the insights email instantly.
When you select Send preview, you receive a project insights instantly and also receive 
insights based on the selected cadence. The email would go to the recipients selected along 
with the Project Manager.

9. Select Schedule  to schedule insights email for the project.

Note: 
Because the information in these fields is AI generated, it's a good idea to review the text 
and make sure it's accurate.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

956



This skill automatically generates and sends project insight emails based on project data 
and activity. These emails provide a consolidated view of project health, including schedule 
variance, RIDAC (risks, issues, decisions, actions, and change requests), resources, 
milestones, projects, project tasks, and financial insights. Project items are automatically 
grouped into RIDAC categories and classified by impact level: high, medium, or low, while 
financial insights highlight potential risks and variances. This automated insight delivery helps 
stakeholders stay informed about project health, risks, and financial status without manual 
reporting effort.

This skill generates insights and emails them to the project manager and other stakeholders 
based on the cadence. For instance, when a resource is over allocated, the project manager 
receives an alert without having to review it manually. When scheduling the email, managers 
can pick or unpick the topics they want, customize the insights with their own prompt 
instructions, add more stakeholders, and choose whether to schedule the email or instantly 
send a preview.

You can pause email by selecting Pause cadence  check box.

Example: Schedule a project insight email

Let's assume that you have selected a weekly cadence and chosen Monday (which falls on 
2025-07-07). After adding recipients:

• If you select Schedule, the project insights are emailed to you and the recipients weekly on 
Mondays, starting from 2025-07-07 and continues until the project is inactive.

• If you select Send preview, you will receive an initial insights email immediately and will also 
receive insights according to the selected cadence and day.

Generate a project status report with Now Assist

Generate an AI‑assisted  project status report with predicted health indicators. Now assist pre-
populates project health, an executive summary, and supporting rationale based on weekly 
project data.

Before you begin
Ensure project status generation skill is active.

Role required: it_project_manager

About this task
When the Project status generation skill is enabled, project managers can generate a status 
report pre‑populated  by Now Assist. Now Assist predicts overall and dimension‑level  project 
health (such as schedule, cost, resources, and scope), generates an executive summary using 
weekly project data, and provides a rationale for each prediction.

After generation, project managers can review:

• Predicted overall health

• Predicted dimension statuses

• Explanation/rationale text for each prediction in analysis sections

• Executive summary text generated from the project’s recent data

After submission, the same information appears in the report view, including rationale text (for 
example, a rationale/status explanation column).
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Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Status reports page of the project by selecting Status Reports  from the list.

3. From the Pages section, select Generate status report.
The system invokes LLM to pre-populate the form with predicted fields and an executive 
summary.

4. Review the AI-generated fields:
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◦ Overall health (predicted)

◦ Dimension health such as schedule/cost/resources/scope (predicted)

◦ Executive summary (generated from project data for the reporting period)

◦ Rationale/analysis sections explaining each prediction (for example, schedule health 
analysis, cost health analysis).

5. Edit any fields as needed.

6. Select Submit.

7. Optional:  Verify the submitted report.

8. Optional:  Select Now Assist  to ask more questions on the generated status report or select 
Summarize  to generate a short summary of generated report.

(Optional) You can export and edit the AI‑generated  status report. You cannot duplicate an 
AI‑generated  status report.

Result
An AI-assisted status report is generated with predicted health values, an executive summary, 
and rationale text.

Improve efficiency and quality using refine records skill with Now Assist 
Context Menu

Improve record quality by enabling AI-assisted text refinement in the text fields of Product idea, 
Demands, Epic, Projects, Capability, Features, Stories, Project tasks, Risks, Strategic priorities, 
Goals, Targets, Initiatives, Feedback, Milestones, and Story forms.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles and also add those custom roles to the In product role.

Role required: You only need the roles required for the record type you want to refine.

About this task
Use the refine records skill and Now Assist Context Menu to simplify record creation and 
updates, reduce effort, and improve record quality. Within the rich or long text field of these 
records, you can use the now assist context menu to shorten or elaborate the text. For example, 
you can type a short sentence in the rich or long text field or select the existing text and then 
expand or shorten it. The skill considers other fields in the form to generate meaningful content 
that improves the record quality. You can also enter a long paragraph in the text field and shorten 
it without losing key information.

Enable portfolio, project, product, demand managers and agile team members to refine record 
content efficiently using the Elaborate and Shorten options and create records with sufficient 
information. The refine records skill helps in improving clarity and completeness of your records 
and reduces the rework due to missing or unclear information.

The refine records skill and Now Assist Context Menu is available in Strategic Planning 
Workspace, Portfolio Planning Workspace, Demand Workbench, Agile Development 2.0 and 
Project Workspace.
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This task is explained using Strategic Planning Workspace  as the example.

Procedure

1. Navigate to Workspaces  > Strategic Planning Workspace.

2. From Strategic Planning Workspace, open any record that you want to refine.

3. Select the text to refine in the text field of your record.
For example, you can select Description  text for Feedback record text. You can refer to context 
menu configuration table to view the forms and text fields which includes Now Assist context 
menu.

4. Select the Refine with Now assist  menu and then select Shorten  or Elaborate  based on your 
requirement.

5. Select Replace  to replace the content in the text field.

6. Optional:  From the Refined by Now Assist window, select Refine  and then select Shorten  or 
Elaborate  to improve the generated text.

7. When you're finished refining the content, you can replace the existing content with generated 
content, provide feedback, or copy it.

Note: 
The refine records skill and Now Assist context menu is available in the text fields of 
Product idea, Demands, Epic, Projects, Capability, Features, Stories, Project tasks, Risks, 
Strategic priorities, Goals, Targets, Initiatives, Feedback, Milestones, and Story forms.

You can configure the Now Assist context menu for these forms and long text fields.
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Context Menu Configuration

Table name Roles

dmn_demand demand_user

pm_project project_manager

pm_project_task project_manager

rm_story scrum_story_editor

sn_align_core_project sn_align_core.apw_user

sn_gf_strategy sn_gf.strategy_planner

sn_gf_goal sn_gf.goal_user

sn_gf_goal_target sn_gf.goal_user

sn_align_core_initiative sn_align_core.apw_user

risk project_manager

sn_align_core_feedback sn_align_core.pf_user

sn_milestones_milestone sn_align_core.apw_user

sn_align_core_product_idea sn_align_core.pf_user

sn_align_core_capability sn_align_core.apw_user

sn_align_core_scrum_epic sn_align_core.apw_user

sn_align_core_feature sn_align_core.apw_user

sn_align_core_demand sn_align_core.apw_user

Related topics

Exploring Now Assist for Strategic Portfolio Management (SPM)

Configure Now Assist Admin features

Skill inputs for Now Assist for Strategic Portfolio Management (SPM)

Generate and track project details from AI insights page

Generate and monitor project insights directly from AI insights page in Project Workspace.

Before you begin
Ensure that the Project insights generation skill is active.

Role required: it_project_manager

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open AI insights page by selecting AI insights  from the list.

3. Select Generate insights  to generate AI insights of your project.
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Project insights are generated using the same Project insights generation skill used for email 
insights. Insights are displayed directly in the in‑app  AI insights experience.

4. Review the generation project insights.

Result
The project insights are generated from the AI insights page with access to current project 
insights in a single in‑app  view.

What to do next

• View and reuse stored insights:

◦ Generated insights are stored and reused based on a defined date threshold.

◦ When you revisit the AI Insights page, previously generated insights are displayed if they are 
still within the threshold.

• Regenerate project insights:

◦ From the AI insights page, select Regenerate  icon.

◦ Now Assist generates updated project insights.
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Generate a project plan using project plan generation skill

Use Project plan generation skill to generate a project plan from natural language input, 
uploaded files, or both.

Before you begin
Role required: it_project_manager

• Install Now Assist for Strategic Portfolio Management (SPM)  plugin.

• To use attachments to generate a project, activate the document intelligence skill. The default 
LLM is Azure OpenAI. Switching to a different model may affect accuracy.

• The project plan generation skill is activated by default. For more information on how to 
activate the skill if it isn't automatically activated or if you want to change the skill configuration, 
see Configure Now Assist Admin features.

About this task
Now Assist  scans your project and task details to generate content. Review and edit the output 
before creating the project. Supported file types are word, pdf, excel, and powerpoint, with a 5 
MB file size limit. Only the first five attachments are processed.

For project and task supported column configurations, see Supported columns for project and 
task generation.

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. Select Generate project  to use Now Assist to generate a project.

To create a project without using Now Assist, use New project from template  or New project 
options.

3. Provide your project input using one or more of these methods.

◦ In the text field, describe your project using natural language. If you provide only natural 
language input, the document intelligence skill is not required.

◦ Select Attach files and upload a word, pdf, excel, or powerpoint document. To use file 
attachments, activate the document intelligence skill. For more information, see Activate a 
Now Assist in Document Intelligence skill .
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Note: 
Attach a file or enter context as free-form text before proceeding. No input returns an 
error. Insufficient context may also trigger an error.

4. Select Next  to generate the project.

5. Select Create project.

6. Review the pre-populated project name, approved start date, approved end date, or business 
case.

Edit the fields as needed and add a description.

Note: 
Because the information in these fields is automatically generated, it's a good idea to 
review the text and make sure it's accurate.

Result
The project is created with the generated tasks, including task hierarchy and dates derived from 
your input.

Example: Generate a project plan from an Excel file

Input: An excel file with two sheets:

• Sheet 1: Project details such as project name, start and end dates, budget, and key objectives.

• Sheet 2: 18 tasks with task name, phase, start date, end date, and duration.

Output AI reads the file and creates the following:

• Project record with: Name, description, start and end dates, and business case derived from 
the key objectives.

• 18 task records with: Task name, description, start and end dates, duration, and state. Fields 
not present in the file, such as key milestone and time constraint, are auto-populated with 
default values.

Generate tasks for a project using project plan generation skill

Use project plan generation skill to populate an empty project with tasks by providing text input, 
uploading files, or both.

Before you begin
Role required: it_project_manager
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• Install Now Assist for Strategic Portfolio Management (SPM)  plugin.

• To use attachments to generate a project, activate the document intelligence skill. The default 
LLM is Azure OpenAI. Switching to a different model may affect accuracy.

• The project plan generation skill is activated by default. For more information on how to 
activate the skill if it isn't automatically activated or if you want to change the skill configuration, 
see Configure Now Assist Admin features.

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. Create a project or open any project without tasks.

3. Select Generate tasks  to use Now Assist  to generate tasks.

To create a project task without using Now Assist, use Add Task  option.

4. Provide your project task input using one or more of these methods.

◦ In the text field, describe your project tasks using natural language. If you provide only 
natural language input, the document intelligence skill is not required.

◦ Select Attach files and upload a word, pdf, excel, or powerpoint document. A preview of the 
attachment appears before you proceed. To use file attachments, activate the document 
intelligence skill. For more information, see Activate a Now Assist in Document Intelligence 
skill .

Note: 
Attach a file or enter context as free-form text before proceeding. No input returns an 
error. Insufficient context may also trigger an error.

5. Select Submit  to generate the project.

6. Review the task details for a project on the planning page.
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Note: 
Because the information in these fields is automatically generated, it's a good idea to 
review the text and make sure it's accurate.

Result
The project is created with the generated tasks, including task hierarchy and dates derived from 
your input.

Example: Generate tasks for an empty project

Input: A project manager types the following in the text input: Create tasks for a website redesign 
project starting May 1, 2026 and ending July 31, 2026. Tasks include requirements gathering, UI 
design, and user acceptance testing.

Output AI creates three task records: Requirements gathering, UI design, and user acceptance 
testing. Each task is populated with a name, description, start and end dates, and duration. 
Fields not present in the input are auto-populated with default values.

Generate, accept, and reject risks using risk generation skill

Use generative AI to identify, generate, and manage potential risks in your project based on 
insights, resources, financials, and milestones.

Before you begin
Role required: it_project_manager

• Install Now Assist for Strategic Portfolio Management (SPM)  plugin.

• Verify risk generation skill is active.

• The risk generation skill is activated by default. For more information on how to activate 
the skill if it isn't automatically activated or if you want to change the skill configuration, see 
Configure Now Assist Admin features.

About this task
AI analyzes project data to identify potential risks and presents them for project manager review. 
AI-suggested risks are generated as part of the project insights cadence and appear in the AI 
Risks menu for project managers to accept or reject. AI generates risks by analyzing data from 
project insights, resources, financials, and milestones.

The AI Identified Risks menu is visible only to project managers when the risk generation skill is 
active. If no risks are identified during generation or regeneration, the AI Identified Risks page 
displays an empty state where you can generate risks again.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

967



Procedure

1. Navigate to Workspaces  > Project Workspace.

2. From Project Workspace, Create a project  or open an existing project.

3. Select AI Identified Risks  from the navigation menu.

4. Review the AI-suggested risks in the list and perform one of these actions:

◦ Regenerate: When you select regenerate option, the risk is generated again and added to 
the AI identified risks list. AI-generated risks appear in AI draft state.

◦ Accept: When you accept a risk, the approved risk appear in the RIDAC list and its state 
moves from AI Draft to Pending.

◦ Reject: When you reject a risk, the rejected risk is removed or hided from the AI identified 
risks list and its state moves to Closed skipped. The rejected risks are retained so that AI 
does not generate the same risk again.

If no risks are identified during generation or regeneration, the AI identified risks page displays 
an empty state. In this case, you cannot regenerate risks immediately and are advised to revisit 
the page later as the project evolves.

5. Optional:  Select Generate AI Risks  if no risks are identified for the project.

Assign a resource using AI resource finder

Use AI resource finder to identify and assign a resource to an unassigned resource assignment.

Before you begin
Role required: it_project_manager or resource_manager

To use AI rationale, verify that resource fit analysis skill is active.

About this task
The AI resource finder uses generative AI to calculate AI rationale for available resources. 
Review the fit scores and availability before assigning a resource. Selecting a resource opens 
the existing assign resources modal where you can review allocations and distributions before 
confirming the assignment.
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AI resource finder helps resource and project managers identify the best-fit resources for 
unassigned resource assignments in a project. The fit score indicates how well a resource 
matches a task based on the availability, past experience, similar kind of work and working on 
same projects. Resource managers review the AI-generated fit scores and rationale and decide 
which resource to assign to an unassigned assignment. The resource finder modal displays the 
following information for each resource:

• Fit score: Percentage match of a resource for the task. The Fit score is deterministic and is not 
generated using AI.

• Rationale: AI-generated explanation for the fit score.

• Availability: The availability of the resource for a task.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments toggle button.
If the sn_pw.enable_resource_planning property is set to true, then the Resource assignment 
toggle button and resource assignment pane are displayed in Project Workspace. The default 
value is false. You must have the pps_admin role to enable this property.

3. Create a unassigned resource assignment by selecting Add resource  and selecting an 
attribute.

4. From unassigned tasks pane, select the context menu row ( ) for any task and select 
Resource finder.

5. From Resource finder modal, select Show monthly availability  toggle or weekly.

6. Select the resource assignee and select Assign resources.

7. From Assign resources modal, review the allocations and distributions and select Assign.
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The resource is assigned to the task.

Now Assist for SPM  reference
Reference information to provide additional information about tables, roles, and properties 
installed with Now Assist for SPM.

Related topics

Exploring Now Assist for Strategic Portfolio Management (SPM)

Configure Now Assist Admin features

Using AI agent or agentic workflows in Now Assist for Strategic Portfolio Management (SPM)

Using Now Assist for Strategic Portfolio Management (SPM)

Additional information on Project insights generation skill

View the additional information about project insights generation skill such as column 
restrictions, date criteria, and so on.

Column restrictions

The columns that are considered for generating the project insights for each table are listed in 
the following table.

Column restrictions for tables

Tables Columns

Milestone • Short description

• State

• Status

• Planned start date

• Planned end date

• Actual end date

• Milestone

• Assigned to
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Column restrictions for tables  (continued)

Tables Columns

• Resource assignees

• Additional assignees list

• Assignment group

Project task • Short description

• State

• Status

• Planned start date

• Planned end date

• Percent complete

• Assigned to

• Resource assignees

• Additional assignees list

• Assignment group

• Priority

Resource assignments • Resource

• Start date

• End date

• Resource status

• Group

• Role

• Skill

• Employment type

• Resource allocation (Weekly/Monthly)

• Project Workspace planning columns

Supported columns for project and task generation

Now Assist extracts project and project task details from uploaded documents (e.g., excel 
workbooks). Recognized data is mapped to pm_project and pm_project_task columns. Columns 
not present in the document are initialized with valid defaults internally.

Supported Project Columns (Auto-extracted)

Column Description

short_description Project name/title

description Detailed project description
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Supported Project Columns (Auto-extracted)  (continued)

Column Description

approved_start_date Project start date

approved_end_date Project end date

business_case Business case/objectives

Supported Project Task Columns (Auto-extracted)

Column Extracted from/Default behavior

short_description Task name: mandatory, extracted from 
document

description Task details/deliverables. If only a name 
exists, a brief description is generated from 
context.

start_date Task start date

end_date Task end date

duration Task duration (derived or explicit)

work_start Work start date/time

work_end Work end date/time

work_duration Actual work duration

state Task state (defaults internally if absent)

milestone Whether the task is a milestone

key_milestone Whether it is a key milestone

constraint_date Date constraint for scheduling

time_constraint Type of time constraint applied

Note: 

If a column value is not present in the excel document, it is handled internally and 
initialized with a valid default.

Collaborative Work Management
ServiceNow®  Collaborative Work Management  (CWM) provides a central hub to plan, visualize, 
manage, and collaborate on work with your teams. Save time and improve the efficiency of your 
team by avoiding switching between multiple tools to manage the progress of work and goals.

https://player.vimeo.com/video/1172272081?
h=dd564e11a2&badge=0&autopause=0&player_id=0&app_id=58479

CWM  enables planning tasks in detail, organizing unplanned work and its resources, and 
collaborating with cross-functional teams.
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Get started

Explore

Learn the key features and 
business value of CWM

Configure

Set up CWM

Use

Start collaborating on work with CWM

Reference

Learn about roles, tables, and 
system properties of CWM.

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community .

• Search the Known Error Portal for known error articles .

• Contact Customer Service and Support .

Exploring Collaborative Work Management
Collaborative Work Management  (CWM) is a work management tool that centralizes tasks, 
documentation, and planning in a single workspace, helping knowledge workers, project 
managers, and agile teams manage work without switching between applications.

Collaborative Work Management  overview

Teams managing work across disconnected tools often lose context, duplicate effort, and 
struggle to maintain a clear picture of progress. Tasks live in one tool, documentation in another, 
and sprint planning in a third, with dependencies tracked in spreadsheets and status updates 
shared over email or chat.

CWM  solves this by bringing tasks, documentation, and planning into a single workspace 
organized around Spaces. Each Space contains Boards for task and project management and 
Docs for documentation, so everything related to a team's work stays connected and accessible 
from one place.

Teams can choose how they work within CWM. Use a custom workflow for general task 
management, or run sprints end-to-end using the built-in Agile capabilities, including sprint 
planning, scrum tasks, and cross-team dependencies. Boards are highly configurable without 
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admin involvement, and generative AI features help reduce manual overhead on task creation 
and content generation.

CWM  integrates with the broader ServiceNow AI Platform, connecting to other ServiceNow 
applications, records, and the Strategic Planning  workspace so that team-level execution stays 
aligned with organizational goals.

Collaborative Work Management  users

Users

User Description

Knowledge worker/Team 
member

Creates and manages tasks on Boards, collaborates on Docs, 
and tracks personal work in My Space. Uses Now Assist for 
Collaborative Work Management (CWM)  to reduce manual 
overhead in task creation and content generation.

Project manager Organizes work into Spaces and Boards, tracks progress 
across teams, and connects work to business goals and the 
Strategic Planning  workspace.

Agile practitioner Plans and runs sprints, manages backlogs, generates scrum 
tasks from user stories, and tracks cross-team dependencies.

SPM  team member Views and updates project and demand tasks from Project 
Workspace  and Next Experience for Demand Management 
directly in CWM  using the team member read or team member 
read-write role.

Collaborative Work Management  benefits

Benefit Feature Users

Keep all team work in one place by organizing 
Boards and Docs into shared Spaces. Your 
team gets a single location to find tasks, 
documentation, and status without switching 
between tools.

Use My Space  as a personal space to manage 
any work assigned to you.

Spaces All users

Get started without admin involvement by 
configuring your own workflow and organizing 
work the way your team needs it.

• Create custom fields for task records.

• Switch between List, Gantt, and Kanban 
views.

• Create custom work item types.

• Add a list of additional assignees to a task.

Boards All users

Create and collaborate on meeting 
notes, technical specifications, or feature 

Docs Knowledge worker/
Team member
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Benefit Feature Users

requirements directly within your workspace, 
keeping documentation connected to the work 
it supports.

• Create rich text docs and add action items 
to users from within and outside the team.

• Collaborate on docs in real-time with 
multiple concurrent editors.

• Use AI to summarize page content for quick 
insights, generate and refine content using 
custom prompts, or generate tasks directly 
from the information in your Doc and add 
them to Boards.

Reduce repetitive setup and ensure 
consistency across your team by starting from 
predefined templates for Spaces, Boards, and 
Docs.

Templates for Spaces, 
Boards, and Docs

All users

Run sprints end-to-end in CWM  without 
switching to a separate Agile tool. Plan work 
into sprints, manage backlogs, track progress 
through the sprint lifecycle, and conduct 
retrospectives, all within your Board.

Sprint planning in 
CWM

Agile practitioner

Break user stories into granular scrum tasks 
to improve sprint execution and estimation. 
Assign tasks to team members and track daily 
progress through a sprint.

Using Now Assist  to accelerate sprint 
preparation, you can generate acceptance 
criteria for your stories from the story 
description, then generate an initial set of 
scrum tasks based on that description and 
criteria. Review and refine both before adding 
them to your sprint, or create scrum tasks 
manually from the story form.

Scrum tasks Agile practitioner

Link work items as prerequisites, dependents, 
or related to surface dependencies directly in 
CWM  without tracking them in spreadsheets 
or notes. Blocked items are visible at a 
glance on the Kanban board to help teams 
spot bottlenecks and plan work in the right 
sequence.

Task dependencies 
and relationships

Agile practitioner

Switch between List, Gantt, and Kanban view 
modes to visualize work in the format that fits 
your team's workflow. Save personalized views 

Board views All users
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Benefit Feature Users

or create shared views to give the whole team 
a consistent starting point.

Reduce manual overhead by automating 
repetitive processes such as sending 
notifications, reassigning tasks, or updating 
task priority when conditions are met, without 
involving an admin.

Automations Project manager

Bring work from across your ServiceNow AI 
Platform  applications onto a single CWM 
Board, giving your team one place to plan 
and manage cross-functional work without 
switching between applications.

Connected work in 
CWM

Project manager, SPM 
team member

Access and update project and demand tasks 
directly in CWM  without requiring access to 
Project Workspace  or Next Experience for 
Demand Management. View assigned work 
in My Work  or pull tasks into a Board using 
Connected Work.

Team member roles 
for project work

SPM  team member

Connect team execution to organizational 
strategy by surfacing CWM  Boards in Strategic 
Planning  portfolio plans, where work can be 
prioritized and roadmapped alongside other 
investments.

Connecting CWM with 
Strategic Planning or 
Portfolio Planning

Project manager

Reference live ServiceNow AI Platform  records 
such as Incidents, Risks, or Issues directly in 
CWM  Docs. References update automatically 
to reflect the latest record data, keeping 
documentation accurate without manual 
updates.

Enable ServiceNow 
AI Platform records in 
CWM Docs

Knowledge worker/
Team member

Share Board data with stakeholders outside 
CWM  or prepare for offline analysis and 
presentations by exporting to CSV or Microsoft 
Excel.

Export Board as CSV 
or Excel

Project manager

Share Doc content with stakeholders who 
don't have access to CWM  by exporting pages 
to PDF.

Export Doc as PDF Knowledge worker

What to explore next

To learn more about configuring and using Collaborative Work Management, see:
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• Configuring Collaborative Work Management

• Using Collaborative Work Management

• Collaborative Work Management reference

Configuring Collaborative Work Management
Plan and configure how your team can implement Collaborative Work Management.

Configuration overview

Use the following steps as guidelines to set up Collaborative Work Management. Steps 3–5 
are optional and provide additional configuration options to make your CWM experience more 
connected with the ServiceNow AI Platform.

1. Install Collaborative Work Management.

2. Assign CWM  roles to the relevant users. See Components installed with Collaborative Work 
Management.

3. Configure Strategic Planning  to include CWM Boards for Prioritization, Roadmap, and Goals. 
See Connecting CWM with Strategic Planning or Portfolio Planning.

4. Add other ServiceNow AI Platform  tables that can be referenced in the Docs.

See Enable ServiceNow AI Platform records in CWM Docs.

5. Enable the Request access  button for non-CWM  users to request access to the CWM 
workspace.

See Properties installed with Collaborative Work Management.

Install Collaborative Work Management

You can install the Collaborative Work Management  (CWM) application (sn_cwm) if you have 
the admin role. The application includes demo data and installs related ServiceNow®  Store 
applications and plugins if they are not already installed.

Before you begin

• Confirm that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Collaborative Work Management  application listing in the ServiceNow Store 
for information on dependencies, licensing or subscription requirements, and release 
compatibility.

Role required: admin

About this task
The following items are installed with Collaborative Work Management:

• Roles

• Tables

• System properties

For more information, see Components installed with Collaborative Work Management  and 
Properties installed with Collaborative Work Management.
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Collaborative Work Management  application (sn_cwm) using the filter criteria and 
search bar.

You can search for the application by its name or ID (sn_cwm). If you cannot find the 
application, you might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are the sample records that describe application features for common use cases. 
Load the demo data when you first install the application on a development or test instance.

6. Select Install.

Connecting CWM  with Strategic Planning  or Portfolio Planning

Configure Strategic Planning  or Portfolio Planning  to include CWM  Boards so that you can plan, 
roadmap, and associate goals to Boards in a portfolio plan.

By adding CWM  Boards to a lens configuration, you can access them in the Prioritization, 
Roadmap, and Goals pages of a portfolio plan as planning items.

Note: 
This functionality requires installing the Strategic Planning  or Portfolio Planning  application 
from ServiceNow Store.

To successfully enable planning with CWM Boards in Strategic Planning  or Portfolio Planning, 
complete the following tasks.

Add CWM  Boards to lens configuration

For the lens that you want to use to build portfolio plans, update the configuration to include 
CWM Board as a planning item in Strategic Planning  or Portfolio Planning.

Before you begin
Role required: admin

Ensure that the Application scope of your instance is set to Portfolio Planning Core.

About this task
All default lenses support CWM  Board as a planning item. For example, if you are building 
portfolio plans using Organization lens, then you can add CWM Board as a planning item in the 
Organization lens configuration.

Procedure

1. Navigate to All  > Strategic Planning  > Lenses.

2. Select a lens.
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3. From the Available list of planning items, move CWM Board  to the Selected list.

Note: 
If you don't see CWM Board in the Available list, update the system property 
sn_align_core.planning_item_types_allow_list  to allow it.

4. SelectUpdate.

What to do next
Configure CWM Board form layout.

Configure CWM  Board form layout

Add the lens entity field to the CWM  Board form so users can link Boards and have them appear 
in the right portfolio plan in Strategic Planning  or Portfolio Planning  workspaces.

Before you begin
Role required: admin

Ensure that the Application scope of your instance is set to Collaborative Work Management.

About this task
Include the field for your lens entity in the CWM  Board form. This allows CWM  users to link their 
Boards to the lens entity so that the Boards appear in the corresponding portfolio plan. For 
example, using the project Portfolio lens, you could create a portfolio plan for the Technology 
portfolio. When CWM  users associate their Boards with the Technology portfolio, those Boards 
will automatically show up in the Technology portfolio's portfolio plan.

Similarly, you can associate Boards to goals or portfolios. To ensure that your CWM  users can 
perform this association, configure the Board form to include these fields.

Procedure

1. Navigate to System Definition  > Tables.

2. From the list of tables, search for and select sn_cwm_board.

3. From the Related Links section, select Layout Form.

4. From the list of fields in the Available section, move your desired field to the Selected section.
For example, move the Portfolio  field to the Selected section.
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5. Repeat this step for other fields that you want to add to the CWM Board form.

6. Select Save.

Result
The CWM Board form now shows the new fields added to its layout.

Your CWM users can add details of their departments, portfolios, or primary goals depending on 
the portfolio plans they want these Boards to show up in.

What to do next
Associate Boards with portfolio plan entities.

Associate Boards with portfolio plan entities

Link CWM  Boards to a lens entity so that these Boards appear in the corresponding portfolio 
plans in Strategic Planning  or Portfolio Planning  workspaces.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board.

3. From the Board header, select the Edit icon ( ).

4. In the Board form, select a department, primary goal, strategic program, or portfolio to 
associate with this Board.
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5. Select Update.

Result

• If a primary goal is added, this Board will show up in the aligned work for the selected goal in 
Strategic Planning workspace.

• If you add a department, and the Board's dates align with that department’s portfolio plan, the 
Board will automatically appear as a planning item on the roadmap.
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• If a portfolio is added, and the Board’s dates align with the portfolio plan, the Board will appear 
as a planning item in that portfolio plan’s roadmap.

If there are no dates added to your CWM Board, you can check for 
Unscheduled items on the Roadmap side panel and add the Board to your 

roadmap.

Enable ServiceNow AI Platform  records in CWM  Docs

Facilitate connecting work across ServiceNow AI Platform  by enabling CWM  users to add a 
reference to records of any ServiceNow  table in CWM Docs.

Before you begin
Verify that Application Scope  of your instance is set to Collaborative Work Management.

Role required: admin

About this task
By default, the sn_cwm.record_mention_config  property is configured to include only 
CWM  task records. To include any other ServiceNow AI Platform  record, update the Value  field of 
this property.

Watch this video for information about enabling ServiceNow AI Platform  records.

Video explaining how to enable Now platform records in CWM. Approximately one minute and 4 
seconds long.
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Procedure

1. Navigate to sys_properties.list.

2. From the Name column, search for and open the sn_cwm.record_mention_config  property.

3. Update the Value  field of the property.
Include the table name, its label, and the fields that you want displayed for its record in a CWM 
Doc. For example, you want to include Incident table details. The updated contents of the 
Value  field would be:

[{"sourceTable":"sn_cwm_task","label":"CWM 
 Task","fields":["short_description","number"]},
{"sourceTable":"incident","label":"Incident","fields":["short_d
escription","number"]}]

4. Repeat step 3 to include other ServiceNow  tables.

5. Select Update  to save your changes to the property.

Result
Tables included in the property can now be referenced in CWM  Docs of any space.

Using Collaborative Work Management
Use the different features of Collaborative Work Management  (CWM) to collaborative with teams 
across your organizations and manage work in the way your teams want.

Collaborating with Spaces in CWM

Create collaborative Spaces for teams to work together on projects, goals, or assignments.

CWM  provides two kinds of Spaces: A personal Space that can be accessed only by you and 
shared Spaces to collaborate with other users in your organization.

Navigation within the CWM  workspace

Navigation panel

The CWM navigation panel provides a simpler and cleaner user interface. At a 
given time, the navigation panel shows the contents of just one Space to provide a 
distraction-free experience while you work.

Use the Spaces menu to choose a different Space. The Spaces you are part of are 
sorted by alpha in the Spaces dropdown menu.  Additionally, you can also choose to 
resize the navigation panel or collapse it altogether to increase the working area for 
your Boards or Docs.
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When you expand or collapse the Spaces menu, it's saved as your user preference 
and will remain so until you change it.

Search

Use the Search option to quickly find and open any Space, Board or Doc.

Also, the Search bar displays all the recent Spaces, Boards, and Docs that you've 
navigated to within the CWM  workspace so that you can quickly select from the 
recent items without having to search for them again.

Keyboard shortcuts

Use the following keyboard shortcuts to quickly perform actions within the 
workspace.
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Keyboard shortcuts for CWM

Action macOS shortcut Windows OS shortcut

Search for a Space, 
Board, or Doc

Option + F Alt + F

Create Space Option + S Alt + S

Create Board Option + B Alt + B

Create Doc Option + D Alt + D

Navigate to My Work Option + M Alt + M

My Space

By default, a Space and a sample Board are created for you so that you can get familiar with the 
features and options in the workspace. From your personal Space, you can browse through the 
Intro to Docs  and Welcome to CWM  documents for a high-level overview of what you can do 
with CWM.

Create more task Boards, docs, and organize them into folders to manage the work assigned to 
you.

Shared Spaces

Collaborating with Spaces

Shared spaces act as a central location for cross-functional teams to come together 
and collaborate toward common goals. Plan for the next big release, prepare for 
a presentation, organize a conference, and do much more using task Boards and 
collaborative Docs.

With the capability to connect to any record across the ServiceNow AI Platform, 
avoid the risk of having information scattered across multiple apps and missing 
unplanned tasks.

Managing access in the Share permissions modal
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As a Space owner or editor, you can manage access for existing users of your Space 
and review access requests from other users using the Share permissions modal.

• People with Access section: Manage the access level of existing collaborators to 
Editor, Viewer, or Owner, or remove them from the Space.

• Pending Access section: Review requests from users and choose to grant or deny 
them access to your Space.

Managing Space permissions for task assignees and other users

As a Space owner or editor, while assigning tasks to your team members, you can 
identify users who don’t have access to the workspace through a lock icon next to 
the user name. This icon is visible in the List view of the Board in the columns of 
type People such as Assigned to, Additional Assignee, and Assignment group.

You can either use the workspace prompt to grant assignees Viewer access or 
choose to manage their access level later from the Share permissions modal. For 
more information on managing sharing permissions, see Share a Space in CWM 
and manage sharing permissions.
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Requesting to elevate user access role to Editor

The Viewing mode indicator in the Board header indicates that you have only the 
Viewer role to the Space that you're in. As a Space viewer, you can send a request 
to Space owners and editors to request elevating your role to Editor by selecting the 
indicator.

Space owners and editors receive an email request from which they can choose to 
grant or deny access to the user.

Using the following sections, get started with shared Spaces in the workspace.

Create a Space in CWM

Create Spaces in Collaborative Work Management  to enable cross-functional teams to come 
together and manage work tasks and documentation.

Before you begin
Install Collaborative Work Management.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the left side panel, select + Create  > New Space.
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3. In the Space name  field, enter a name for the Space.

4. Select Create.

Result
A new Space is created and added right below the My Space  section. You can add as many 
Spaces as you need for each of your projects, teams, or other assignments.

What to do next

• Create a Board to organize and manage work for your team or projects. See Create a Board in 
CWM.

• Share the Space with others on your team. See Share a Space in CWM and manage sharing 
permissions.

Share a Space in CWM  and manage sharing permissions

Invite cross-team members to Collaborative Work Management  Spaces to collaborate on tasks or 
projects. You can also manage permissions for users with existing access to your Space.

Before you begin
Create a Space in CWM.

Role required: sn_cwm.cwm_user

About this task
Sharing a Space with a user results in them gaining access to all Boards, Docs, and folders 
within that Space. Use the Share permissions modal from the Space or Board header to manage 
sharing permissions and access levels to your Space for your team.
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Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the left side panel, select a Space.

3. From the header of the Space, select Share.
My Space  is personal to you cannot be shared.

4. Add new users to the Space.

a. In the Members or Groups  field, enter the names of individual users or groups.

You can search for users and groups by email along with their name so that you choose the 
right collaborator.
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b. From the Access level  field, set the access required for these users.

Type of access levels for a CWM Space

Access level Description

Owner
This role is typically assigned to the creator 
of the space.

They have the create, read, update, and 
delete access to Boards, Tasks, Columns, 
and Docs in the Space.

Editor
They have the create, read, update, and 
delete access to tasks in the Board and 
Docs in the Space. They can share the 
Board but can’t delete it.

Viewer
They can view the data in the Space but 
can’t update or delete it.

c. Select Share.

5. From the People with Access  tab, manage permissions for existing users by changing their 
access level or removing a user from the Space.
As the Owner or Editor of a Space, you can remove access for existing users of the Space or 
yourself at anytime. As a viewer, you can only remove access for yourself.
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6. From the Pending Access  tab, you can review the list of users who have requested access to 
your Space and choose to grant or deny them the access.

Before granting access to a user, you can modify their access level to Editor or View as 
necessary.

Result
An email invite is sent to the users that you shared this Space with.
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What to do next
Start working on tasks for your team using Boards. See Managing work using Boards in CWM.

Create a folder in CWM

Organize Boards and Docs of a Space into folders in Collaborative Work Management 
Workspace.

Before you begin
Create a Space in CWM.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Open a Space that you want to create a folder in.

3. From the More options menu of the Space ( ), select New folder.

4. In the Folder name  field, enter a name for the folder.

5. Select Create.

Result
A new folder is created in the Space that you selected.
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What to do next

• Create subfolders, Boards, and Docs in this new folder.

• Move any existing Boards, Docs, or folders into this new folder.

Managing work using Boards in CWM

Use Boards in Collaborative Work Management  to define and organize tasks. With views such as 
List, Kanban, and Gantt, configure your workspace based on the way you and your team work.

https://player.vimeo.com/video/1049444492?
h=672bbda3a0&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Using the following sections, get started with Boards in the CWM  workspace.

Create a Board in CWM

Manage work assigned to your team as tasks and track them to completion using customizable 
Boards for your shared Spaces in Collaborative Work Management.

Before you begin
Create a Space in CWM.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the Spaces menu, open a Space that you want to add a Board to.
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3. From the More options menu of the Space ( ), select New Board

s

4. In the Board name  field, enter a name for the Board.

5. Select Create.

Result
A Board is created within the Space that you selected and an empty Board is shown in the 
workspace. You can add unlimited Boards to a Space, based on how you choose to manage your 
workflows.

What to do next

• Add tasks to the Board. See Add tasks to a CWM Board.

• Rename or edit other details of the Board using the Edit icon ( ) on the Board header.

Duplicate a Board in CWM

Save time by duplicating an existing Board to copy all the task and collaborator details without 
having to copy the information manually in the Collaborative Work Management  workspace.

Before you begin
Create a Board in CWM.
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Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Navigate to the Space that your Board is in.

3. From the More actions  menu of the Board, select Duplicate.

4. Provide a name for the new Board in the Board name  field.
The default name given is in the format of (Copy) <Original Board name>.

5. Select Duplicate.

Result

• The new Board is added to the same Space as the original Board.

• If your original Board was in a folder, the new Board is added to the same folder.

• If necessary, you can move it to a different Space or a different position in the same Space.

• The states of all the copied tasks are reset to the default (open) state in the new Board.

• All the assigned tasks are reset to unassigned.

• The start date for the tasks shift to the current date.

• Any custom columns in the original Board are copied to the new Board.

Add tasks to a CWM  Board

Start planning work on your Board by adding tasks and assigning them to team members in 
Collaborative Work Management  workspace.

Before you begin
Create a Board in CWM.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to add tasks to.

3. From the Board footer, select + Add item.
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4. Fill in details such as the Type, Short description, Assigned to, dates, and others.

The default work item types available in CWM  are Task and Defect. If you want to create other 
work items such as Milestones or Events, you can create your own task type. See Create and 
manage custom work item types in CWM.

What to do next

• Add more tasks to the Board and assign them to yourself or members of your team.

• Edit the information of your task from the side panel by clicking the short description to open it 
or directly from the grid through inline editing by double-clicking a cell.

• Rearrange your tasks on the Board by using the drag-and-drop feature.

• Share tasks by their URL using the Copy task link  option from the row context menu of the 
task. This way, when a user clicks the shared URL, the task opens in the side panel in the 
context of the Board that it belongs to.

Additionally, to enhance the planning and management of tasks, you can:

• Create additional columns for a task to add other details. See Add custom columns for tasks in 
a CWM Board

• Choose the columns to be displayed for the tasks on the Board. See Personalize List, Gantt 
and Kanban display for CWM Boards.

Create and manage custom work item types in CWM

Create custom item types for Boards in Collaborative Work Management, so that you can 
organize and manage multiple types of tasks from a single location, regardless of the workflow.
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Before you begin
Create a Board in CWM.

Role required: sn_cwm.cwm_user

About this task
Watch this video for information about creating a work item type.

Create custom work item type in CWM video. Approximately forty nine seconds long.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Navigate to the Board that you want to add custom tasks to.

3. From the Board header, select the More actions icon ( ) and select Manage item types.

4. From the Default item types section, enable or disable Task or Defect to be available for your 
Boards.

5. From the Custom work item types section, add a new item type.

a. Select Add new item type.

b. In the Item type name field, enter a name for the work item type.'

c. Select an icon to represent the item type.

d. Select the check box to make this item type available for use in the Board.

e. Select + Add new item type  to repeat adding another item type.

6. After adding all required work item types, select Save.

What to do next

Add tasks of the new item type to your Board using the More actions menu ( ) on the Board 
header.

Add custom columns for tasks in a CWM  Board

Create custom fields in a Board so that you can organize all details of tasks at a single location, 
thereby improving task management and saving time by reducing dependency on system admin.

Before you begin
Create a Board in CWM.

Role required: sn_cwm.cwm_user

You need to have either Editor or Owner access to the Space to add a custom column.

About this task
Watch this video for guidance on adding custom columns for tasks in a CWM  Board.

Video for add custom columns for tasks in a CWM board. Approximately one minute and twelve 
seconds long.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to add tasks to.

3. In the List view of the Board, select Add column  from the column header and select a data 
type.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

997



4. In the Field name  field, enter the name for this new column and other details, if asked.

◦ If you select the type as Label  or Dropdown, you're prompted to enter the options for this 
field.

◦ If you select People, you're prompted to select the type of users available for this field. Also, 
choose to allow input of single or multiple users in this field.

◦ If you select Reference, you're prompted to select a table that you want to add as reference 
to the tasks.

5. Select Add column.

Result
The new column is added to the task and you can start entering the values for this column.

Note: 
Custom columns added for a task are local to the Board that they're created in and are not 
applicable to other Boards and Spaces in the workspace.

If you have the Owner access for this Space, you can delete any custom columns based on your 
changing requirements.

Add a goal to CWM  Board

Associate a goal to your Board so that you can plan and track all the tasks and activities that 
contribute to this goal directly from the Collaborative Work Management  workspace.

Before you begin
Create a Board in CWM.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to add a goal to.

3. Edit the Board by selecting the Edit icon ( ) from the Board header.

4. In the Board form on the side panel, select a goal from the Primary goal  field.

5. Select Update.

Result

• Within CWM  workspace: The current Board is associated with the selected goal, and is shown 
in the Board details page.

• Within Strategic Planning  workspace: If the goal that you selected is part of a portfolio plan 
within Strategic Planning  Workspace, you can see that this CWM  Board is added to the goal as 
a planning item.
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Note: 
CWM  Board must be configured as a planning item for the lens that is used to create the 
portfolio plan. For more information, see Connecting CWM with Strategic Planning or 
Portfolio Planning.

Board views in CWM

Create, customize, and switch seamlessly between Board display preferences such as column 
display, sorting, and filtering based on the audience and purpose in Collaborative Work 
Management  (CWM).

https://player.vimeo.com/video/1036476020?
h=6a4e66d756&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

With Board views, you can save your preferred data views or create shared views to ensure 
a consistent experience across sessions and for the entire team. Saved preferences include 
column display, column order, sorting, filters, view mode display, Kanban vertical lane selection.

You can create multiple views for Board display personalization and come back to the view of 
your choice, without having to rearrange columns on the Board every time. The following are 
some more advantages of Board views:

• Save Board display preferences as personal or shared views.

• Create shared views for the team so that all the team members consuming the data have the 
same experience.

• Create multiple views for the same Board so that you can display data in a way that is fit for 
your audience.

• Quickly switch between views to avoid manually updating display preferences each time the 
audience is changed.

• Update the view preferences anytime to adapt to changing processes.

Board views in CWM can be classified as personal and shared:

My views

The Board display settings that are personal to you and are only available for you 
to access are grouped into My views. You can create multiple personal views and 
switch between them depending on your workflow patterns.
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Any display personalization settings that you have already applied to your Boards 
before upgrading to CWM version 4.0.1 are saved as your personal view, with the 
name <Your name>'s view.

Shared views

Shared views are available to all members that have access to the Board or Space. 
You can create multiple shared views for a Board so that each type of audience has 
a view that is customized for them.

Note: 
Shared views cannot be created in My Space  because it's your personal 
Space.

When you save a Board with shared views as a template, the shared views are also 
saved as part of the template. For more information on templates, see Templates in 
CWM for Boards and Docs.

The view that you last visited for a Board is saved as your user preference and is selected the 
next time you reload the Board.

Use the following sections to learn more on how to make the most out of Board views and their 
customizations for your team.

List, Gantt, and Kanban views in CWM

Switch between List, Gantt, and Kanban views to manage and visualize work on a CWM  Board in 
the way that best fits your team's workflow.

Each CWM  Board supports three views: List, Gantt, and Kanban. You can switch between views 
at any time without losing data, and each view can be personalized to show the columns and 
attributes most relevant to your team. For more information, see Personalize List, Gantt and 
Kanban display for CWM Boards.

List view

The List view displays all work items on a Board in a grid format. Use this view to review the status 
of work items at a glance, update fields inline, or assign items to team members quickly. The List 
view displays up to 1,000 work items by default.
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Gantt view

The Gantt view displays work items in a grid alongside a calendar timeline, making it easy to 
visualize schedules and reschedule items based on changing priorities. The Gantt view displays 
up to 1,000 work items by default.

Kanban view

The Kanban view organizes work items into columns and rows based on attributes you choose, 
such as State  and Assigned to. Vertical lanes represent one attribute and horizontal swimlanes 
represent another, giving teams a visual overview of work distribution and status. Each axis 
supports up to 50 lanes by default.
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Quick filters

Use quick filters to focus the Kanban board on a specific sprint, state, or other 
column attribute. Multiple filters can be active at the same time, and a counter at the 
top of the board shows the number of active filters. For example, use quick filters for 
sprint-specific information during daily standups or sprint reviews.

You can save these filters to a Board view of your choice and when you save this 
Board as a template, these filters get saved in the template.

Work item indicators on Kanban cards

Kanban cards display indicators that give teams at-a-glance visibility into scrum 
tasks and relationships associated with a work item, without opening the item.

• Scrum task indicator:  Appears on a story card when the story has one or more 
scrum tasks. Selecting the indicator opens the right side panel showing the scrum 
tasks for that story. For more information, see Scrum tasks for stories in CWM.

• Relationship indicator:  Appears on a work item card when the item has one or 
more linked relationships, such as a prerequisite, dependent, or related-to item. 
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Selecting the indicator opens the right side panel showing the related work items 
and their relationship types. For more information, see Task dependencies and 
relationships in CWM.

Kanban card layout options

Personalize Kanban cards to surface the information most relevant to your team 
using card layout settings. Select up to five fields to display on each card. Use the 
Compact layout to show only the work item name for a focused view, or the Full 
layout to show all selected fields for more context directly on the card.

Kanban view with Connected work

If the Board includes Connected work items, you can use vertical and horizontal 
lane combinations to group and filter them. For example:

• Set the vertical lane to State  and the horizontal lane to Task type  to view all epics 
grouped by state, then filter to show only epics.

• Set the vertical lane to Sprint  and the horizontal lane to Task type  to view 
connected stories grouped by sprint.

Related topics

Personalize List, Gantt and Kanban display for CWM Boards

Scrum tasks for stories in CWM

Task dependencies and relationships in CWM

Personalize List, Gantt and Kanban display for CWM  Boards

Show, hide, or rearrange columns and apply sorting or filters to personalize the way data is 
displayed in Collaborative Work Management  Boards based on your workflow.

Before you begin
Create a Board in CWM.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1003



Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to personalize.

3. Select List, Gantt, or Kanban for the Board and select the Personalize icon ( ).

4. Update the display of the view on the Board or hide views.

5. For List and Gantt, use column actions ( ) such as pinning a column to the left of the grid, 
filtering the data from a column, and resetting the column size to default.

What to do next
After changing the way data is displayed on your Board, you have the option of saving it as 
a personal view for your reference or a shared view for your team or stakeholders. For more 
information, see Board views in CWM.

Create a custom view for CWM  Boards

Modify Board display preferences and save them as custom personal or shared views that suit 
the working preferences for you and your team members in Collaborative Work Management 
(CWM).

Before you begin
Create a Board in CWM.

Role required: sn_cwm.cwm_user

About this task
Use the personalization settings to change how the data is presented on a CWM  Board and save 
the changes as a new view. You can create a different custom view for each of the List, Gantt, and 
Kanban view modes or save them all into a single view.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to create a view for.

3. Modify the display preferences of the Board data using the personalization settings, sorting, 
filtering, and adding custom columns.
For more information, see Personalize List, Gantt and Kanban display for CWM Boards.

4. Select the More actions icon ( ) of the Save view menu and choose Save as new view.

5. Enter a name for this view and choose to make it a shared view or keep it a personal view.
Shared views are available for all members who have access to this Board. Not selecting this 
option saves this view as a new personal view that's only available to you.
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6. Select Create.

Result
The new view is available in the view switcher.

Update a CWM  Board view

Modify the display preferences of your Collaborative Work Management  (CWM)Boards and 
update the existing personal or shared views.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board for which you want to update a view.

3. From the view switcher, select a view that you want to modify.
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4. Modify the display preferences of the Board data using the personalization settings, sorting, 
filtering, and adding custom columns.
For more information, see Personalize List, Gantt and Kanban display for CWM Boards.

5. Select Save view.

6. Select Save to current view.

Note: 
If you select the Don't show this again  checkbox, this dialog box doesn't appear the next 
time.

Result
The current view is updated with the changes that you made.
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Delete a custom CWM  Board view

Delete the custom personal or shared views for your CWM Boards and keep your Board views 
current for your workflow.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board for which you want to delete a view.

3. From the view switcher, select a view that you want to delete.

4. From the More view options menu ( ), select Delete view.

5. Select Delete  to confirm.

Result
The view is deleted and no longer available in the view switcher for this Board.

CWM  Board preferences

Reduce cognitive load and focus on the most relevant and actionable tasks by filtering work 
items on Boards in Collaborative Work Management  (CWM).

Use the Board Preferences  menu on the Board header to show items that are your current focus.

Show items based on their last updated date

Filter work items based on their last updated date. You can choose to show items 
last updated within 7 days, 30 days, 90 days, 120 days, or 1 year.
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Show or hide completed items

Choose to show or hide the work items that are marked as Closed complete.

The Board preferences that you set are applied across the List, Gantt, and Kanban 
views.

Export a CWM  Board to CSV or Microsoft Excel

Export the list view of Collaborative Work Management  (CWM) Boards to CSV or Microsoft Excel 
so that you can use the data to obtain insights, share with stakeholders, and prepare for analysis 
or presentations.

Before you begin
Create a Board in CWM

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select the Board that you want to export.
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3. From the Board header, select the More options icon ( ), and then select Export.

4. In the Export dialog, select the Board view that you want to export and the file type.

5. Select Export.

Note: 
The exported file doesn't retain the hierarchy of the tasks from the Board and all links, 
including URLs, references to records and assigned users, are converted to plain text.

Result
The file is downloaded and saved in your local system.

Work item automations in CWM

Boost team efficiency by automating monotonous actions such as sending notifications and 
emails, monitoring key dates, or reassigning tasks based on the conditions that suit the team's 
workflow.

When teams work together, they often spend much time and manual effort on workflow activities. 
To address this issue and help improve the overall team efficiency, team members can create 
automations for tasks in CWM  Boards.

Automations in CWM  are actions that are triggered when certain conditions are met. Once 
created, these automations are applicable to all work items in the Board that they’re created in. 
Some examples of automated actions are:
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• Sending an email when a task assignment is changed.

• Updating task priority when the due date is moved.

• Reassigning tasks when the priority is changed.

• Sending a notification when a task is complete.

• Notifying a task assignee dynamically when the priority is changed.

Six predefined templates are provided in the application to help you build multiple simple or 
complex conditions and automate actions for your work items.

Based on the changing conditions of your team's workflow, you can edit, disable, or delete 
automations anytime later. For a Board, a maximum of 10 automations can be created, which 
includes all the active and inactive ones.

In this example automation, when the Priority  of a task on this Board changes to High, the 
people in the Assigned to  column of the task and the owners of this Space are notified of it.

Going forward, when the priority of any item of this Board changes to High, a notification is sent 
to the user assigned to that task and the Space owners. Thus this automation saves the time that 
it takes to perform this action manually instead.

Note: 
You can also send notifications to any user if you've added a custom people column in 
addition to the default Assigned to or Additional Assignee.
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Get started with automations in CWM. See Create automations in CWM.

Create automations in CWM

Add conditions to build task automations for CWM  Boards and help your team save time from 
manual task updates.

Before you begin
Create a Board in CWM.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to create automations for.

3. From the Board header, select Automations.

4. Choose a predefined template.

◦ If it's your first automation, choose a template to get started.

◦ If automations exist already, select New automation  and then choose a template.
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5. Add conditions for automating the activities of updating a field, sending an email, or sending 
notifications.

You can add multiple conditions to act as triggers to an automation. For example, an 
automation can be created to send a notification to everyone in the Space when it meets the 
following conditions:

◦ Task priority is high.

◦ The start date is three weeks away.

6. Select Add automation.

7. Repeat the steps to add more automations.

Note: 
You can create up to 10 automations for a Board and the automations are applied only to 
CWM tasks and not any connected work items on the Board.

What to do next
Manage or delete automations in CWM.

Manage or delete automations in CWM

Edit, disable, or delete automations for your Boards in Collaborative Work Management  based on 
the changing conditions of your team's workflow.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1012



Before you begin
Create automations in CWM.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to edit the automations for.

3. From the Board header, select Automations.

4. Choose to enable, disable, edit, or delete an automation.

◦ To disable an active automation, switch the toggle off.

◦ To enable a disabled automation, switch the toggle on.

◦ To edit an automation:

a. Select More actions  and select Edit.

b. Update the conditions.

c. Select Save automation.

◦ To delete an automation:

a. Select More actions  and select Delete.

b. Confirm by selecting Delete.
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Connected work in CWM

Streamline task management for teams by bringing in various work items from across 
ServiceNow  applications into Boards in Collaborative Work Management.

https://vimeo.com/1142605644/a4e1a19040?share=copy&fl=sv&fe=ci

The Connected work feature in CWM  enables bringing in all types of work items from 
applications across the ServiceNow AI Platform, thereby helping streamline collaboration, 
planning, and execution for all teams. Here’s how it works:

Centralized view

Teams can connect various types of work from different ServiceNow  applications 
to a single CWM board. By defining conditions for the work items, the teams can 
bring in only those work items that they need. This consolidation ensures that all 
relevant work is visible in one place, reducing the need to switch between multiple 
workspaces. For more information, see Connect work from other ServiceNow apps 
to CWM Boards.

Only those tables that you have access to and from the applications that are already 
installed and active in your ServiceNow  instance are available for you.

Flexible planning

Once the work is connected, teams can plan and manage it efficiently. They 
can plan them into sprints for agile execution, or follow a free-flow methodology, 
ensuring that tasks are prioritized and tracked in the way that the teams choose to.

For sprint planning, the connected work items are automatically displayed in 
the Backlog pane of the Board's Sprint planning view. From here, the team can 
schedule work into sprints and proceed with execution. For more information, see 
Plan work items into sprints in CWM.

Real-time updates

Teams can update the status and other details of connected work items directly 
from the side panel within the CWM board. This real-time updating capability 
enhances transparency and keeps everyone involved on the same page. For more 
information, see Update details of connected work items in CWM Boards.

Deleting a connected work item record only removes it from the Board in CWM  but 
doesn't delete the original record.

Improved efficiency

By centralizing work and providing a unified environment, Connected work helps 
teams stay focused and reduces the time spent navigating between different 
workspaces. This can help lead to increased productivity and collaboration.

Connect work from other ServiceNow  apps to CWM  Boards

Enable a consolidated view of all relevant work by connecting work items from different 
ServiceNow  applications to a Board in Collaborative Work Management.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you want to connect work for.
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3. From the Board header, select the Board more options icon ( ) and select Connect work.

If you already have connected any work items, then this label is displayed as Connected work.

4. In the Manage connected work modal, select + Add new.

5. Choose a table and define the conditions to filter the records from the selected table.

a. From the Table  field, select a table.
For example, to bring in all the incidents, select the Incident [incident] table.

Note: 
Only those tables that you have access to and from the applications that are already 
installed and active in your ServiceNow  instance are available for you.

b. Change the value in the Name  field according to your requirement.

c. Use the condition builder to add conditions and filter the records from the table you 
selected.
For example, you'd like to bring in incidents that are active and belong to certain categories. 
Then, your condition set would be similar to the following:
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Active is true  and Category is Inquiry / Help  or Category is Software.

d. Select the Update count icon ( ) to check the number of records that exist which match 
the filter criteria that you defined.

Note: 
Ensure that the number of records available for your filter criteria are not more than 100. 
You can change this number by default to 500 by working with your admin to update 
the system property sn_cwm.connect_work_import_limit.

6. Select Save.

7. Repeat steps 4 through 6 to connect work items of other types.
You can connect up to 10 work item types to a Board and you can add only one connected 
work configuration per table.

8. Select Save.

Result

• The Board is refreshed to load and display all the connected work items.

• Any existing information such as Assigned to, State, and Start and End dates is also shown on 
the Board.

• With the Sprint planning view enabled, you can see all these connected work items in the 
Backlog list. For more information about performing sprint planning, see Sprint planning in 
CWM.
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What to do next
To enable additional fields from any connected work table, change the form layout configuration 
for the Default view of the table. You can then surface these fields as columns in CWM. For more 
information, see Show or hide fields on a form .

Related topics

Manage connected work item types in CWM

Update filter conditions for connected work in CWM

Manage connected work item types in CWM

Enable, disable, refresh data, or delete the connected work item types on your CWM  Board to 
keep the work items up to date based on changing requirements.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select the Board that you want to manage the connected work item types for.

3. From the Board header, select Connected work.

4. From the Manage connected work modal, disable or enable any existing work item type.
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5. Update the filter conditions for a work item type by selecting Edit  from the More actions menu 

( ).
For more information, see Update filter conditions for connected work in CWM.

6. Select Refresh data  from the More actions menu ( ) to fetch any latest records for the work 
item type that you defined.

7. If the work item type is no longer necessary, you can delete it.

a. From the More actions menu ( ) of a work item type configuration, select Delete.

b. From the Delete configuration modal, select Confirm.

8. After you have done all the required changes, select Save.

Result
The Board is refreshed to load the work items based on your changes.

Update filter conditions for connected work in CWM

Update the filter conditions for connected work item types in Collaborative Work Management 
Boards so that the work items displayed in the Board reflect your team's current workload.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select the Board that you want to manage the connected work item types for.

3. From the Board header, select Connected work.
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4. From the More actions menu ( ) of a connected work item type, select Edit.

5. Use the condition builder to edit the defined conditions.

6. Select the Update count icon ( ) to check the number of records that exist which match the 
filter criteria that you updated.

Note: 
Ensure that the number of records available for your filter criteria are not more than 100.

7. Select Save.

8. Repeat steps 4 through 7 to update conditions of any other connected work item type.

9. After all required changes are made, select Save  in the Manage connected work modal.
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Result
The Board is refreshed to load the work items based on your changes.

Update details of connected work items in CWM  Boards

Learn how to update the status, assigned to, and other details for the work items that are brought 
into your Collaborative Work Management  Board through Connected work.

Before you begin
Role required: sn_cwm.cwm_user

About this task
The details of connected work items can be updated only from the side panel and not through 
in-line editing in the grid. However, deleting the connected work items from the Board will only 
remove them from the Board but won't delete the original record.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select the Board with connected work items that you want to update.

3. From the List, Gantt, Kanban, or Sprint planning view, open the item details in the side panel.

4. Update the required details.
You can also choose to open the original record form and update the details from there using 

the Detailed form view icon ( ).

5. If you've edited the details in CWM, select Update  or Save.

Result
The updated information is available on the work item both in CWM and in its parent application.
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Agile work management in CWM

Run your agile workflow in Collaborative Work Management  (CWM), from building and refining 
a backlog to planning sprints, executing work as stories and scrum tasks, and collaborating with 
your team.

CWM  is a unified workspace where agile teams can manage their delivery cycle. Teams 
transitioning to CWM  can continue to run the Scrum workflow they’re familiar with, which 
includes managing a backlog, planning and executing sprints, and tracking daily progress, while 
also benefiting from CWM's flexible work item model, AI assistance, and broader collaboration 
features.

Agile workflow in CWM

The following end-to-end workflow shows how agile teams use CWM  to plan and execute work.

Set up your workspace

Create a Space and a Board for your team. The Space is where all your work lives. 
CWM provides Stories, Scrum tasks, and CWM Tasks as default work item types. 
You can also define custom work item types to reflect your team's terminology, for 
example, Bugs. For more information, see Create a Board in CWM  and Create and 
manage custom work item types in CWM.

Build and maintain your backlog

Add work items to your Board through the Sprint Planning view. All unscheduled 
work appears in the Backlog pane, giving your team a single place to groom, 
prioritize, and reorder items before pulling them into a sprint. For more information, 
see Add work items to Sprint planning Backlog in CWM.

Plan sprints

Create sprints by setting a duration, start and end dates, and story point capacity. 
Drag items from the Backlog into a sprint, or add them directly. Capacity indicators 
in each sprint section help teams avoid over-committing. For more information, see 
Create a sprint in CWM  and Plan work items into sprints in CWM.

Execute and track work

Start the sprint and use the Kanban board to track work in progress. Team members 
move story cards across state lanes to update status. Use quick filters to focus the 
board on a specific sprint, state, or other columns to stay on top of what matters 
during the current sprint. For more information, see Start or complete a sprint in 
CWM.

Break stories into scrum tasks

For more granular daily execution, break user stories into scrum tasks. Scrum tasks 
are subtasks linked to a story, which help teams estimate effort, distribute work, and 
track daily progress. Create them manually from the story's Scrum tasks tab, or use 
Now Assist  to generate them automatically based on the story context. When a story 
has scrum tasks, an indicator appears on the Kanban card so teams can quickly 
see stories that have been decomposed. For more information, see Scrum tasks for 
stories in CWM.
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Track dependencies

Link work items to show how they relate to each other using three relationship 
types: prerequisite, dependent, and related to. These are informational 
relationships and don’t block task progress. You can link work items across boards 
and spaces, enabling visibility into cross-team dependencies without needing to be 
on the same board. For more information, see Task dependencies and relationships 
in CWM.

Hold retrospectives

At the end of each sprint, create a retrospective board to capture what went 
well and what to improve for the next sprint. For more information, see Create a 
retrospective board for a sprint in CWM.

Bringing in work from other ServiceNow  applications

Agile teams often work on more than just stories. Incidents must be resolved, defects must be 
fixed, and enhancement requests must be delivered. The Connected work feature in CWM  lets 
you bring records from any ServiceNow  application into your Board by defining filter conditions. 
Once connected, you can plan those records into sprints and manage them alongside your 
stories from a single backlog.

Teams who previously used the Unified Backlog and triage boards in Agile Development 2.0  to 
manage defects, incidents, and other work records can use Connected work to achieve a similar 
centralized view in CWM. For more information, see Connected work in CWM.

Comparing CWM  to Agile Development 2.0

CWM covers the core Scrum workflow, but approaches some functional areas differently. The 
following describes how key Agile Development 2.0  concepts map to CWM.

Functional area In Agile Development 2.0 In CWM

Work item hierarchy Fixed hierarchy of Products, Epics, 
Stories, and Scrum Tasks. Create custom work item types to 

build a hierarchy that fits your team. 
There are no built-in Products, 
Releases, or Themes.

You can use Spaces to separate 
product areas and Goals to 
connect work to business 
objectives.

Unified backlog and 
triage

Triage boards filtered records 
from other apps and automatically 
created stories for triaged items.

The Connected work feature brings 
source records directly into the 
board backlog. So, no separate 
triage step required. Teams can 
plan them into sprints and update 
their status directly from the CWM 
Board. See Connected work in 
CWM.

Multi-team and 
program planning

Scrum Programs enabled 
coordination across multiple teams.

CWM  is optimized for team-level 
execution. For program-level 
planning such as PI planning, use 
EAP. EAP teams can connect to 
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Functional area In Agile Development 2.0 In CWM

CWM  so teams execute sprint 
work in CWM while program-
level visibility remains in EAP. See 
Connecting EAP with Collaborative 
Work Management.

Related topics

Sprint planning in CWM

Scrum tasks for stories in CWM

Task dependencies and relationships in CWM

Connected work in CWM

Connecting EAP with Collaborative Work Management

Sprint planning in CWM

Plan, track, and manage work for your teams in the Agile methodology using Sprint planning in 
Collaborative Work Management.

Within the Sprint Planning view of your CWM Board, you can manage your team's backlog, create 
sprints, plan work into sprints, and execute them seamlessly. All existing work items on your 
CWM Board are automatically added to the Backlog pane in the Sprint Planning view. This means 
that whether the work items are old or new, they will all be visible in the Backlog. From this pane, 
you can easily schedule these items into sprints for execution.

You have the flexibility to create work items of various types, such as Stories, or use any other 
default and custom work types that are available on your CWM Board. This flexibility ensures that 
you can tailor your sprint planning to fit the specific needs of your team and projects.

Enabling Sprint planning view

From the Views section of the Personalize ( ) side panel, select Sprint planning to enable the 
display of Sprint planning view on your CWM Board.

Note: 
Save your Board view to ensure that the Sprint planning view is always displayed on your 
Board.
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Backlog

The Backlog pane displays all unplanned work items, including both newly added and older 
incomplete tasks. Completed work items are not shown, keeping your focus on what needs to 
be done. You can add work items directly to the Backlog from this view and use the personalize 
side panel to show or hide columns within the Backlog pane, customizing the display to suit your 
needs.

Within the Backlog pane, you can do the following:

• Move work items to the top or bottom of the backlog based on the priority.

• Move items to the currently ongoing sprint.

• Move work items within the list by rearranging rows.

• Delete work items.

• Apply filters on any column. However, filters can't be applied on custom columns within 
Backlog.

• Change the number of items displayed per page.

• Duplicate work items by using Copy row.

Note: 
You can duplicate only CWM tasks and Stories but not other connected work records.

• Drag and drop a single or multiple work items from Backlog to one of the sprints.

Sprints

The Sprints section in your CWM Board displays the list of active sprints. If you haven’t created 
any sprints yet, this section will show a form to help you get started. You can create a sprint by 
selecting the sprint duration, start and end dates, and story points capacity. To create additional 
sprints with the same settings, use the Add another Sprint  option. For sprints with different 
durations or capacities, select Create Sprint. For more information, see Create a sprint in CWM.
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Each sprint is a collapsible section where you can add work items directly and customize the 
view using the personalize side panel. Each sprint section also shows the percentage of utilized 
capacity and the remaining story points, helping you manage your team's workload effectively.

Personalizing Sprint Planning view

You can customize the columns displayed in the Backlog and Sprint panes using the Personalize 

( ) side panel, allowing you to see the most relevant information. Any changes you make can 
be saved to the current Board view or as a new view, depending on your needs.

If you require more working area for the Backlog or Sprints within the Sprint planning view, you 
can toggle between the Backlog, Sprints, and Backlog and Sprints  options.
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Add work items to Sprint planning Backlog in CWM

Create and add new work items to the Backlog directly from the Sprint planning view of 
Collaborative Work Management.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning  tab.

4. From the Backlog pane, select the Add item ( ) icon.
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5. Select the work item type from the Item type  drop-down list.
The default work item type available is Task. You can enable other types such as Story or 
create a custom type. See Create and manage custom work item types in CWM.

6. On the form, fill in the details for the item such as short description, start and end dates, story 
points, and others.

7. Select Submit.

Result
The newly created work item is added to the Backlog.

What to do next
You can plan this item into one of the active sprints by dragging and dropping it into the Sprint 
section. See Plan work items into sprints in CWM.

Create a sprint in CWM

Create a sprint with custom duration and capacity to enable your team to plan and execute their 
work in an Agile methodology in Collaborative Work Management.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning tab.

4. If there are no sprints in your CWM Board, you can use the Plan a Sprint  form in the Sprints 
section.
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5. If there are existing sprints, choose an option to create a new sprint.

What to do next
Plan work items into sprints in CWM.

Update sprint details in CWM

Modify the duration, capacity, and dates for a sprint in Collaborative Work Management.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning tab.

4. From the sprint header, select the More options icon ( ) and select Edit.

5. Make the necessary edits to the sprint details.

6. Select Save.

Related topics

Plan work items into sprints in CWM

Create work items for sprints in CWM

Delete a sprint in CWM

Delete a sprint in CWM

Delete individual sprints from Sprint planning in Collaborative Work Management  so that your 
Board reflects the changes in your planning priorities.
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Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning tab.

4. From the sprint header, select the More options icon ( ) and select Delete.

5. In the Delete Sprint confirmation modal, select Delete.

Result
The sprint is deleted and any active incomplete work items that were scheduled into this sprint 
are moved to the backlog.

Create work items for sprints in CWM

Create and add new work items to a sprint directly from the Sprint planning view of Collaborative 
Work Management.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning tab.

4. From the sprint header, select the Add item ( ) icon.
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5. Select the work item type from the Item type  drop-down list.
The default work item type available is Task. You can enable other types such as Story or 
create a custom type. See Create and manage custom work item types in CWM.

6. On the form, fill in the details for the item such as short description, start and end dates, story 
points, and others.

7. Select Submit.

Plan work items into sprints in CWM

Schedule stories and other CWM tasks from the backlog into sprints or move work across sprints 
in Collaborative Work Management.

Before you begin
Role required: admin

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning tab.

4. From the Backlog, select the work items that you'd like to schedule into a sprint.
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5. Drag and drop them into the sprint of your choice.
You can drag and drop the work items into sprints even when the sprint sections are collapsed.

6. To move the work items from one sprint to another, select them and drop them in the sprint of 
your choice.

Here's a gif showing the drag and drop action between the backlog and sprint sections, and 
across 

sprints.

Related topics

Start or complete a sprint in CWM

Create work items for sprints in CWM

Update sprint details in CWM

Start or complete a sprint in CWM

Start a sprint so that your team can start work on the planned items. After your team finishes the 
assigned work, you can mark this sprint complete, all directly from the Sprint planning view in 
Collaborative Work Management.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning tab.

4. To start a sprint, select Start  from the sprint header.
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5. Complete a sprint.

a. From the sprint header, select Complete Sprint.

b. Review the details of completed and open items for this sprint.

c. Move the incomplete items to the next sprint or the backlog.

d. Choose to create a retrospective Board for this sprint to perform a sprint retrospective with 
your team.
For more info, see Create a retrospective board for a sprint in CWM.
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e. Select Complete Sprint.

The sprint is marked as complete and is no longer displayed on the Sprint planning view 
anymore. All the open items are moved into the next sprint or to the backlog based on your 
selection.

Create a retrospective board for a sprint in CWM

When marking a sprint complete, choose to create a sprint retrospective board for your team to 
collaborate and reflect on the recent sprint in Collaborative Work Management.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board that you're performing sprint planning for.

3. Select the Sprint planning tab.

4. From the sprint header, select Complete Sprint.

5. Review the details of completed and open items for this sprint.

6. Move the incomplete items to the next sprint or the backlog.

7. Select the option create a retrospective Board for this sprint.

8. Provide a name for your Board.
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9. Select a template to apply to this Board.
By default, the Agile Retrospective template is applied. If you want to create a different 
template depending on your requirements, see Templates in CWM for Boards and Docs.

10. Select Complete Sprint.

Result
A new retrospective Board is created for the sprint that is just marked complete within the same 
Space. You can navigate to the new board from the success message or from the left navigation 

panel.

Scrum tasks for stories in CWM

Extend your agile workflow in CWM  by breaking user stories into scrum tasks, giving your team 
the granularity needed to estimate effort, distribute work, and track daily progress through a 
sprint.

In CWM, scrum tasks represent the individual units of work that make up a user story. While 
stories capture a feature or requirement from the user's perspective, scrum tasks break that story 
into steps that team members can pick up and complete independently during a sprint. Scrum 
tasks are always associated with a parent story and aren't a standalone work items on the board.

Creating scrum tasks

You can create scrum tasks manually or use Now Assist  to generate them based on the story 
content.
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Manual creation

After a story is saved, a Scrum Tasks tab is available on the story form. From this tab, 
you can add tasks by entering a title and any relevant details directly on the story. 
You can also create scrum tasks for stories inline from the List and Sprint planning 
views. For more information, see Add scrum tasks to a story in CWM.

AI-generated scrum tasks

Now Assist  can analyze the story description and context to suggest a set of 
scrum tasks. The Create with Now Assist  button on the story form and the inline 
sparkle button on the Scrum tasks  tab both trigger generation. You can review the 
suggestions, regenerate if the results don’t fit the story, and then insert the tasks. 
AI-generated tasks serve as a starting point and can be edited after they're created. 
For more information, see Generate scrum tasks for a story with Now Assist for 
CWM.

Scrum tasks on the Kanban board

When a story has one or more scrum tasks, a scrum task indicator icon appears 
on the story's Kanban card. Selecting the icon opens a side panel that shows the 
scrum tasks for that story, so team members can view task details without leaving the 

board.

Quick filters on the Kanban board let teams focus on specific sprints, states, or other columns. 
Multiple filters can be active at the same time, and a counter at the top of the board shows how 
many filters are currently applied. This makes it easier to track sprint-specific work during daily 
stand-ups and sprint execution.
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Scrum task considerations and limitations

• Scrum tasks belong to a parent story and can’t exist independently as standalone work items 
on the board.

◦ When a story is moved from one sprint to another, the child scrum tasks also move to the 
new sprint.

◦ You can reorder scrum tasks only within its parent story.

◦ Scrum tasks can't be moved (drag and drop) or copied outside its parent story.

• Percent complete isn’t rolled up from scrum tasks to the parent story. Percent complete is 
tracked only for CWM tasks.

• When a story is imported through Connected work, its associated scrum tasks are brought in 
automatically along with it. Scrum tasks can’t be imported directly through Connected work.

• Scrum tasks can’t be assigned to a sprint independently. They inherit the sprint of their parent 
story. When you change the sprint for a story, all associated scrum tasks move to the new 
sprint automatically.

• Scrum tasks aren’t displayed in the Backlog section of the Sprint planning view. They’re shown 
only in the sprint section.

• Sprint information can't be edited on a scrum task record.

• Deleting a scrum task in CWM  doesn’t delete the underlying record. It’s only removed from 
viewing in CWM.

• You can’t add scrum tasks if the scrum task work type is disabled in your ServiceNow  instance.

• You can’t add scrum tasks if you have just the Viewer access to the CWM  Board.

• If scrum tasks were previously imported through Connected work before upgrading to v9.0.0, 
and stories are then imported through Connected work after the upgrade, duplicate scrum 
tasks may appear on the board. To resolve this, remove the existing configuration for scrum 
tasks in Connected work for your Board.

Related topics

Agile work management in CWM

Task dependencies and relationships in CWM

Add scrum tasks to a story in CWM

Break down a user story into scrum tasks in Collaborative Work Management  (CWM) to distribute 
work across team members and track daily progress during a sprint.

Before you begin
Role required: sn_cwm.cwm_user

About this task
Scrum tasks are added one at a time from the Scrum tasks  tab on a story form. To generate 
multiple scrum tasks at once based on the story description using Now Assist, see Generate 
scrum tasks for a story with Now Assist for CWM.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board.

3. Open a story by selecting it from one of the views (List, Gantt, Kanban, or Sprint planning).
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4. Select the Scrum Tasks  tab on the story form.

5. Select Add new.

6. Enter a name for the scrum task.

7. Select the Save icon ( ).

8. Select + Add new  to add more scrum tasks.

What to do next
To add more scrum tasks, repeat the previous steps. You can 
also add scrum tasks inline from the List and Sprint planning 

views.

To generate scrum tasks automatically based on the story content without manual work, see 
Generate scrum tasks for a story with Now Assist for CWM.

Related topics

Scrum tasks for stories in CWM

Generate scrum tasks for a story with Now Assist for CWM
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Task dependencies and relationships in CWM

Increase visibility into how work is connected by linking work items directly in Collaborative Work 
Management  (CWM), eliminating the need to track dependencies in spreadsheets or notes 
fields.

In CWM, you can link any task-type work item to another to show how pieces of work relate to 
each other. Relationships are informational and team members can progress on a work item 
regardless of the state of its linked items. Relationships can be created across Boards and 
Spaces, giving teams visibility into cross-team dependencies for their work.

Relationship types

Work items in CWM  support three relationship types.

Prerequisite

Indicates that another work item must be completed before this item can begin. Use 
this relationship to communicate sequencing and upstream dependencies to your 
team. Only task-type work items extending the Task [task] table and CWM tasks can 
be added as prerequisites. Planning items such as Epics aren’t supported.

Dependent

Indicates that this work item must be completed before work on another item 
can begin. This is the inverse of a prerequisite relationship and communicates 
downstream impact to your team.

Related

Indicates a general connection between two work items without implying a specific 
order of execution. Use this relationship when items share context, overlap in scope, 
or are otherwise connected without one blocking the other.
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Linking work items across boards and spaces

You can link any task-type work item to another across the ServiceNow AI Platform, regardless 
of which Board or Space it belongs to. To create a relationship, search for the work item by name 
and attach it. The search covers all task type work items that you have permission to view.

Note: 
Work items brought onto a Board through the Connected work feature don’t display 
relationships on their original source record unless the relationship is added directly on 
that record.

Relationships on the Kanban board

When a work item has one or more relationships, a relationships indicator icon appears on its 
Kanban card. Selecting the icon opens the right side panel showing the related work items and 
their relationship types, so team members can view dependency details without leaving the 
board.

Task dependency considerations and limitations

• Planning items such as Epics can’t be added as prerequisites because they aren’t derived 
from the Task [task] table.

• You can add a work item as a dependency on if you have permission to view that item.

• Relationships have no effect on percent complete calculations for CWM Tasks or Boards in 
Strategic Planning Workspace.

• If a story in the Story [rm_story] table already has prerequisite and dependent stories 
associated to it, those details are shown in CWM.

• Adding a story-type work item as a relationship to another story syncs with the prerequisite 
and dependent fields in the Story [rm_story] table.

• Adding a non-story-type work item as a relationship to a story does not sync with the Story 
[rm_story] table.

Related topics

Agile work management in CWM

Scrum tasks for stories in CWM
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Add a dependency to a work item in CWM

Link a work item to another in Collaborative Work Management  (CWM) to show how they relate, 
whether one is a prerequisite for another or they are generally connected.

Before you begin
Role required: sn_cwm.cwm_user

About this task
Relationships are added from the Relationships  tab on the work item form in the side panel. 
You can link work items across Boards and Spaces, and a single work item can have multiple 
relationships. For an overview of the available relationship types, see Task dependencies and 
relationships in CWM.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board.

3. Select a work item to open it in the side panel.

4. Select the Relationships  tab.

5. From the Prerequisite, Dependent, or Related to  section, select Add more.

6. Search for the work item by name and select it.

7. Select the Save icon ( ) to save the relationship.
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What to do next
After adding a relationship, a relationships indicator icon appears on the work item's 
Kanban card. Select the icon to view all relationships for that work item from the 

board.

If a relationship doesn't apply to your task anymore, you can remove it. For more information, see 
Remove a dependency from a work item in CWM.

Related topics

Task dependencies and relationships in CWM

Remove a dependency from a work item in CWM

Remove a dependency from a work item in CWM

Unlink a relationship between work items in Collaborative Work Management  (CWM) when it is 
no longer relevant or was added incorrectly.

Before you begin
Role required: sn_cwm.cwm_user

About this task
Relationships are removed from the Relationships  tab on the work item form. Removing a 
relationship does not affect the work items themselves or their progress, it only removes the link 
between them.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board.

3. Select a work item to open it in the side panel.

4. Select the Relationships  tab.
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5. Select the remove icon on the relationship card you want to remove.

Result
The relationship is removed from both work items.

What to do next
To add a new relationship, see Add a dependency to a work item in CWM.

Related topics

Task dependencies and relationships in CWM

Add a dependency to a work item in CWM

Connecting EAP  with Collaborative Work Management

Enhance visibility and streamline planning for your Agile teams by connecting Enterprise Agile 
Planning  (EAP) with Collaborative Work Management  (CWM).

Overview of EAP-CWM  connection

The EAP-CWM integration enables organizations to connect strategic program planning with 
team-level execution in a single system, eliminating silos and improving delivery predictability.

Using EAP, program managers and release train engineers can define Program Increment (PI) 
objectives, align Epics, Features, and Stories, create sprints for teams, and manage cross-team 
dependencies. After completing a PI, they can conduct PI retrospectives and update roadmaps 
for the next cycle. These capabilities ensure that enterprise priorities are clearly structured and 
traceable across all levels.

By linking EAP  to CWM, product owners and team members can plan and execute sprints, 
manage agile stories alongside operational tasks such as incidents, track progress, and hold 
team-level retrospectives, all within the same workspace.
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This connection between the applications reduces context switching and ensures that both 
planned and unplanned work is accounted for, without losing alignment to strategic goals. The 
result is end-to-end transparency where leadership can track progress against PI goals through 
EAP, while teams maintain flexibility to adapt to changing priorities.

Workflow of EAP-CWM  integration

1. EAP admin connects an EAP  team to CWM. See Connect an EAP team with CWM.

2. A new Space and Board are created for this EAP  team in the CWM  workspace.

3. Existing work items assigned to this EAP  team are brought over to the newly created CWM 
Board through Connected Work filters.

4. Sprint planning view is enabled for this CWM  Board where the existing work items and sprints 
are automatically shown.

5. Check team's access to CWM and provide the CWM user [sn_cwm.cwm_user] to all team 
members.

6. EAP  team can start creating more work, manage current work, and update progress directly 
from the CWM  Board. See Sprint planning in CWM.

7. The team's progress and work status is reflected back on the Team dashboard in the EAP 
workspace. See EAP Agile Team dashboard

Creating or managing sprints for EAP  teams in CWM

For EAP  teams integrated with CWM, existing sprints and their scheduled work automatically 
sync to CWM. These details are displayed in the Sprint Planning view on the CWM  Board.

As the team progresses through assigned work, they can update the work status directly in the 
Sprints section. The sprint can be marked Complete  from this view and any incomplete work 
items can be moved either to the backlog or the next sprint, if it exists.

New sprints for the team must be created in EAP. After creating new sprints in EAP, they will sync 
to CWM, allowing the team to schedule work into these sprints from CWM.

Note: 
Sprints for EAP  teams are not created directly at the Agile team level. Sprints are created 
automatically when a Planning Interval (PI) is defined for the parent Agile Release Train 
(ART) in EAP  and sync to CWM  automatically.
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My Work in CWM

Manage your work from all ServiceNow  applications from a centralized view in the Collaborative 
Work Management  workspace.

My Work provides a centralized view of all your assigned tasks, including project tasks, problems, 
and incidents. It also offers visualizations that group items by state, priority, and status, such as 
open or overdue.

Work items from all ServiceNow  applications assigned to you’re displayed in My Work. If you 
receive a work item on the CWM Board via Connected Work, those items appear here as well. 
This ensures you have a single source for all assigned work without the need to switch between 
applications.

Note: 

• Any task record created in a table that doesn’t extend the Task [task] table, such as 
VTask, won't show up in My Work.

• If you’re added as Additional assignee  to a task, work with your admin to enable the 
display of such tasks in My Work. See Properties installed with CWM.

Overview tab of My Work

The following are the filters available on My Work:

• Task type filter displays a list of all task types that are assigned to you currently.

• Date filter lets you select predefined or custom date ranges.

• You can choose to include open items that don't have start or end dates.

My Work page has two views, Overview and List.
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• Overview tab shows multiple widgets that provide information related to the progress of your 
work. It also enables you to apply filters on the type of tasks that you want to view.

• List tab shows all open work items assigned to you in a list or grid format, where you can apply 
the group by and filter options on the columns.

List view also provides a link back to the source of the work item. For example, if your work item 
is a Risk, the Source column in the List view provides a navigation to the RIDAC page of the 
Project Workspace  application.

Overview tab of the My Work page in CWM

Widget or option Description

Work item type filter Choose the type of work items that you want to 
view in My Work.

For example, if your current assignments 
consist of CWM tasks, Projects, and Incidents, 
then the Task type filter only shows these 
three options to select from.

Also, CWM tasks of all types, including custom 
CWM tasks, will be grouped as CWM Tasks 
type.

Date Filter the tasks by their start and end dates.

Include open items with no dates Enable display of work items that have no start 
date, end date, or both.

Overall Progress Percentage of work that is completed

My Open Items Number of work items that are pending.

SelectingClicking the number opens a list view 
of all work items assigned to you and are in the 
Pending  state.

My Overdue Items Number of work items that are overdue.

Clicking the number opens a list view of all 
work items assigned to you that are past their 
due date.

Completed Number of work items that are complete.

Clicking the number opens a list view of all 
work items assigned to you that are in the 
Closed Complete  state.

Task by State Bar chart that groups all work items assigned 
to you by their current state. Clicking a bar 
opens a list of tasks that meet the filter criteria 
for the corresponding bar.

For more information on how the tasks are 
grouped by state, see Grouping of tasks in 
status reports of CWM My Work.
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Overview tab of the My Work page in CWM  (continued)

Widget or option Description

Task by Priority Bar chart that groups all work items assigned 
to you by their priority. Clicking a bar opens a 
list of tasks that meet the filter criteria for the 
corresponding bar.

For more information on how the tasks are 
grouped by priority, see Grouping of tasks in 
status reports of CWM My Work.

List tab of My Work

The List view shows all open work items assigned to you. Select the Short description  of a work 
item to view its details in a modal pop-up. Select the Source  of a work item to open the work item 
in a new tab.

Note: 

• The list view displays all the tasks with start or end dates that fall within the range of the 
date filter.

• Any closed task that doesn't have dates populated isn’t shown in My Work.

• You can't perform bulk editing of state, priority, or date values of the tasks through My 
Work.

Managing SPM  work in Collaborative Work Management

Team members can view and update project tasks and demand tasks directly in Collaborative 
Work Management  (CWM) using team member roles, without requiring access to Project 
Workspace  or Next Experience for Demand Management.

Collaborative Work Management  application provides roles that give team members access to 
project tasks and demand tasks within CWM. Using these roles, team members can manage 
their assigned work through CWM  features such as My Work and Connected Work ad submit 
time card against the project tasks and demand tasks.
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Team member roles

The following roles are available for team members:

Team member read [sn_stm.team_member_read]

Allows users to view project tasks and demand tasks, and leave comments on them.

Team member read-write [sn_stm.team_member_read_write]

Allows users to view and edit project tasks and demand tasks.

For the full list of access permissions for each role, see Team member role access permissions in 
CWM.

Note: 
Assigning one of these team member roles automatically grants the CWM  user role 
[sn_cwm.cwm_user] and Time card user role [timecard_user].

Accessing project and demand tasks in CWM

After a team member role is assigned, users can view and manage project and demand tasks in 
CWM  through the following features:

• My Work: View all project and demand tasks assigned to you in one place. For more 
information, see My Work in CWM.

• Connected Work: Pull project and demand tasks into CWM  Boards using flexible filters, such 
as tasks assigned to you, your assignment group, or other criteria. You can edit and update 
tasks directly from the board.

For more information, see Connected work in CWM

By default, team member roles provide broad access to the tasks assigned to them. 
Administrators can configure additional ACLs to restrict access to specific tasks.

Accessing My Calendar

Users assigned these team member roles can access My Calendar and perform the following 
actions:

• View My calendar

• Edit My calendar

• Create Events on calendar

• Delete their own events

Note: 
Users can see only events that they created.

Considerations

The following limitations apply to team member roles in this release:
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• Team member roles don't grant access to Project Workspace  or Next Experience for Demand 
Management.

• The SPM  applications such as Project Workspace  and Next Experience for Demand 
Management  must be present in your ServiceNow AI Platform  instance for team members to 
be able to access those work items from CWM.

• The Timecard Management application must be installed to for team members to create 
timecards against their project tasks or demand tasks.

Related topics

Team member role access permissions in CWM

Team member role access permissions in CWM

Access permissions for the team member read and team member read-write roles in 
Collaborative Work Management  (CWM), covering projects, project tasks, demands, demand 
tasks, ideas, and calendar events.

Permissions by role

The following table lists the access permissions granted to the team member read and team 
member read-write roles for each object type in CWM. Permissions marked as applying to own 
records are restricted to records that the user created.

Team member role permissions

Object Team member read Team member read-write

Project Read Read

Project task • Read

• Write (work notes only)

• Read

• Write (all fields)

Demand • Create

• Read

• Write (own records)

• Delete (own records)

• Create

• Read

• Write (own records)

• Delete (own records)

Demand task • Read

• Write

• Read

• Write

Idea • Create

• Read

• Write (own records)

• Delete (own records)

• Create

• Read

• Write (own records)

• Delete (own records)
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Team member role permissions  (continued)

Object Team member read Team member read-write

Calendar event • Create

• Read

• Write (own records)

• Delete (own records)

• Create

• Read

• Write (own records)

• Delete (own records)

Note: 
In My Calendar, only events that you created are visible.

Related topics

Managing SPM work in Collaborative Work Management

Collaborative documentation using CWM

Manage all kinds of documentation for work such as meeting notes, project requirements, or 
technical specifications using rich text Docs with real-time collaboration.

Overview of collaboration within Docs for CWM workspace. Approximately two minutes long.

Docs can be created within a Space, and organized into folders. Within a Space, you can create 
multiple Docs and within each Doc, you can create unlimited pages to help you effectively 
organize your information.

Key features of Docs

• Auto-save content.

• Live user presence: See who is viewing or editing the document in real time.

• @-mention notifications: Get notified when someone @-mentions you in a Doc.

• Templates: Create and apply document templates.

• Rich text formatting: Headings, lists, alignment, and other paragraph styles.

• Block-level editing: Move text blocks to change placement.

• Cross-references: Add references to other ServiceNow AI Platform  tables to connect work 
across teams.

• Slash command (/) for more options:

◦ Insert tables quickly

◦ Mention a record. See Dynamic data linking.

◦ Insert a list.

◦ Choose formatting options.

• Copy and paste within Docs: Transfer text, images, lists, and tables between Docs pages.

• Table features:

◦ Resize column width

◦ Add color to single or multiple cells

◦ Select multiple cells using mouse or Shift + arrow  keys
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◦ Delete content from multiple cells using Backspace  or Delete  keys.

◦ Copy and paste cell content:

▪ Copy from one cell and paste into multiple cells

▪ Copy from n number of cells and paste into another set of n number of cells

▪ Copy multiple cells and paste as a new table in an empty block

Images in Docs

Insert images into your Docs by uploading a file from your device or adding a web URL. Note that 
inserting Google  Images links might not work.

Save images from your CWM documents directly to your device, making it easier to share or use 

them outside of the Docs environment. Click an image to access the download icon ( ), then 
click the icon to save it to your device. Alternatively, right-click the image and use your browser's 
built-in save option.

Inline comments

Add comments to specific text in documents to collaborate with other users, provide feedback, 
or track discussions without modifying the document content.

Visual indication

Commented text displays with a yellow highlight and underline. Clicking the text 
darkens the highlight and opens a popover showing the comment thread.

Add a comment

Select text and click Comment  from the selection toolbar. You can include 
hyperlinks by typing or pasting URLs directly into your comment and these links are 
automatically converted to a clickable format when you post the comment.

Mention users

Type @  followed by a name to mention someone in your comment. Select the user 
from the lookup that appears. Mentions are highlighted in the posted comment, and 
the system can trigger notifications to alert mentioned users.

Edit your comments
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If you're the owner of the comment, you can modify your comment text. Edited 
comments display an Edited  indicator to show they have been updated.

Comments on dynamic data

Add comments to dynamic data elements such as references and links. Click once 
to open the comment popover, or click again while the popover is open to navigate 
to the referenced content.

Comment restrictions

Overlapping comments on the same text are not supported—reply to existing 
threads instead. Comments cannot be added to non-text elements such as images 
and table cells.

Show or hide highlights

Toggle comment highlights on or off to switch between a marked-up view and a 
clean reading view.

Export behavior

Comments and highlights are excluded when you export a document to PDF or 
duplicate it.

Read-only access

Users with read-only document access can still add and view comments.

Dynamic data linking in Docs

Keep record information in your documentation always current and reduce manual effort with the 
Dynamic data linking feature in Docs. You can now reference any ServiceNow  application record 
and Docs will automatically reflect the latest updates from those records.

For example, if you add a reference to an Incident record, the reference shows the latest field 
information of the incident in Docs without requiring manual edits. Selecting the incident 
reference opens up the incident form so that you can view the full details of the incident and 
make any necessary changes.

A hover popover displays the details of the mentioned record, providing quick access to 
additional information without leaving the current context.

Dynamic linking also enables adding references to a particular field of a record, such as 
Assigned to of an Incident record.
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You can add references from any ServiceNow  table you have access to, with no setup or 
configuration needed.

This feature reduces the need to switch between multiple ServiceNow  applications within your 
instance and helps maintain a single, reliable source of truth for collaborative work, making it 
easier for teams to stay aligned and informed.

Real-time collaboration within CWM  Docs

With the feature of real-time collaboration, edit a Doc page concurrently with multiple other 
editors. Colored cursors denote the current location of each editor on the page. You can choose 
to show or hide these live presence indicators based on your preference while working on or 
reviewing the content of the page.
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Note: 
Application performance may degrade with a large number of concurrent editors.

Draft content using Now Assist for CWM

Generate content with Now Assist for CWM  directly in your Docs using custom prompts. In 
addition, summarize existing sections, elaborate where needed, and refine drafts to help improve 
your productivity.

You can interact with Now Assist  directly in your Doc to create content, add context, or improve 
existing sections. This helps you draft faster, refine ideas, and keep your work relevant without 
leaving the page.

Work with the content of the whole page

Some examples are:

• For Marketing teams: Create a compelling product launch announcement 
highlighting the key benefits and emotional appeal for our target audience.

• For Legal teams: Write a plain-language summary of the privacy policy in this 
doc, that customers can easily understand.

• For product teams: Analyze the customer feedback comments in this Doc, group 
into top 5 themes, and suggest top 3 enhancements for highest impact.

Now Assist  uses the context from your Doc page to generate a response.

Refine, elaborate, or improve the existing content within the page

Some examples are:

• If you have a list of stakeholders, you can ask Elaborate on the scope of these 
roles.

• Rewrite this in a casual tone.

Take assistance on a empty page

Some examples are:

1. Generate 5 icebreaker questions for a virtual team-building session.

2. Write a 3-paragraph blog post explaining why [industry trend] is changing how 
businesses operate.
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3. Generate an outline for the Instagram campaign tasks for a Hackathon 
initiative.

Answer questions in the context of this Doc

Whether the content in the Doc is added manually or generated using Now Assist, 
you can ask questions to find anything in the page's context.

For example, if you have a project charter document, you can try asking What is the 
total budget of this project and which part is the most expensive?

Generate tasks from Docs and add them to Board using Now Assist for CWM

Use the generative AI capabilities of Now Assist  to create tasks from the context of your Docs. 
From the Doc header, select Create Tasks  and Now Assist  generates task recommendations for 
you and walks you through to add them to the required Board in CWM  workspace.
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Create a Doc in CWM

Store information related to your tasks, reference users and task records, and collaborate in real-
time using Docs in Collaborative Work Management  workspace.

Before you begin
Create a Space in CWM.

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Open a Space that you want to create a document in.

3. From the Spaces menu, open a Space that you want to add a Board to.
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4. From the More options menu of the Space ( ), select New Doc

s

5. In the Doc name  field, enter the name for the document.
For example, Meeting notes.

6. Select Create.

Result
A new Doc is created for the current Space, and an untitled page is opened for you to start 
drafting your content.

What to do next
Utilize the rich-text formatting options of the Doc to draft information relevant for your team or 
type /  to explore other options.

Note: 
To reference ServiceNow AI Platform  records other than CWM  tasks, work with your 
admin to update the sn_cwm.record_mention_config  system property. For more 
information, see Enable ServiceNow AI Platform records in CWM Docs.
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Add comments to Docs in CWM

Streamline collaboration by turning your documents into living conversations. Highlight any 
passage, add a comment, and watch the discussion through threads, all without leaving the page 
or switching applications.

Before you begin
Role required: admin

Procedure

Navigate to All  >  > .

Manage pages and subpages in CWM  Docs

Flexibly organize information for your teams and work items by creating, duplicating, and deleting 
pages and subpages within a Doc in Collaborative Work Management  (CWM) workspace.

Before you begin
Create a Doc in CWM

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the Spaces menu, navigate to the Space where your Doc is located and open it.

3. To create a page, you can create a blank page or start with a predefined template.

◦ For a blank page, select Create page.

◦ To create from templates:

a. Select Create Page from template.
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b. From a template card that you want to use, select Use.

The new page is created and added to your Doc.

4. To create a subpage, select the Page Actions  menu ( ) and select Create Subpage.

5. To delete a page or a subpage, select the Page Actions  menu ( ) and select Delete.

Only a user with Editor or Owner access to the Space can delete Doc pages. If there's only one 
page left in the Doc, it can't be deleted by any user.

Duplicate a Doc in CWM

Save time by duplicate an existing Doc to copy all its pages and content without having to copy 
the information manually in the Collaborative Work Management  workspace.

Before you begin
Create a Doc in CWM.

Role required: sn_cwm.cwm_user
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Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Navigate to the Space that your Doc is in.

3. From the More actions  menu of the Doc, select Duplicate.

4. Provide a name for the new Doc in the Doc name  field.
The default name given is in the format of (Copy) <Original Doc name>.

5. Select Duplicate.

Result
The new Doc is added to the same Space as the original Doc. If necessary, you can move it to a 
different Space or a different position in the same Space.

Export a Doc in CWM  to a PDF file

Use the Docs offline, and share with teams or stakeholders outside Collaborative Work 
Management  (CWM) by exporting Docs as PDF.

Before you begin
Create a Doc in CWM

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select the Doc that you want to export.
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3. From the Doc header, select the More actions icon ( ), and then select Export as PDF.

Result
The Doc is exported and saved in your local system as a PDF file.

Templates in CWM  for Boards and Docs

By enabling creation of Boards and Docs from predefined or custom templates, Collaborative 
Work Management  (CWM) helps improve efficiency, save time, and reduce inconsistencies in 
format.

https://player.vimeo.com/video/1054556151?
h=84dc648b21&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Creating Boards and Docs from scratch across similar processes often consumes time and 
effort, and could also lead to differences in their structure. With templates in CWM, you get 
a predefined format for Boards and Docs, which you can use as-is or customize to suit your 
workflow. You can use templates for new Boards and Docs or apply them to existing ones. You 
can also save an existing Board or Doc in its current format as templates.

Template Center provides a centralized space where you can manage all templates for Boards 
and Docs. From the Template Center, you can:

• Explore predefined templates for Boards and Docs.

• Filter for available templates by Owner or Type.

• Search for templates using its title.

• View details for all available templates where you can see a preview of the Board or Doc 
format.

• Delete templates that you own.

Templates for Boards

When you use a template for a Board, any template tasks, custom columns, and 
shared columns that the template contains are applied to the Board. The Board data 
is displayed with all the custom columns available as part of the template.

Templates for Docs

When you use a template for a Doc, any template pages and content formatting is 
applied to the Doc.

To access templates, you can choose one of the following ways:
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• For creating a Board or Doc from template, use these options:

◦ Explore templates  from the main Create menu.

◦ Use templates  from the New Board or New Doc modal.

◦ Apply template  from the More actions menu or in the header of the Board or Doc.

• For saving a Board or Doc as a template: Use the Save as template  option from the More 
actions menu or in the header of the Board or Doc.

The following sections help you get started with templates in CWM.

Create a Board or Doc from a template in CWM

Create Boards or Docs using predefined or custom templates from the Template Center.

Before you begin
Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Select +Create.

3. Open the Template Center by selecting Explore templates.

4. Locate the template that you want to use.

◦ Filter the available templates by Owner or Type

◦ Search for the template using its title or keyword.

5. From the template card that you want to apply, select Use.

6. Enter the Board or Doc name.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1061



7. Select the Space that you want to create this Board or Doc in.

8. Select Save.

Result
The Board or Doc is created in the Space that you selected.

• For a Board, any template tasks and custom columns that the template contains are applied to 
the Board. To learn more about Board views, see Board views in CWM.

• For a Doc, any template pages and content formatting is applied to the Doc.

Apply a template to existing Board or Doc in CWM

Apply predefined or custom templates to existing Boards or Docs in Collaborative Work 
Management  workspace so that you can avoid inconsistencies in structure and format across 
your processes.

Before you begin

• Create a Board in CWM

• Create a Doc in CWM

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Open the Board or Doc that you want to apply a template to.

3. You can apply template to a Board, Doc, or a single page in a Doc.

4. Locate the template that you want to use.

◦ Filter the available templates by Owner. The Type filter is automatically set based on your 
choice in the earlier steps.

◦ Search for the template using its title.

5. Optional:  Check the details of the template by selecting View details  from the Template 

actions menu ( ).
For a Board template, you can view the details of the number of Board views and custom task 
types that you get if you apply this template. You can also review the information on which of 
the List, Gantt, Kanban, and Sprint planning views are enabled in this template.

(Optional) Only those custom columns that are part of these views are brought over when you 
apply this template.
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6. From the template card that you want to apply, select Use.

Result
The selected template is applied to your Board, Doc, or page and the data is displayed according 
to the template.

Save a CWM  Board or Doc as a template

Save a Board or Doc, which you created or personalized, as a template so that you can reuse the 
same structure and format for other Boards and Docs in the future.

Before you begin

• Create a Board in CWM

• Create a Doc in CWM

Role required: sn_cwm.cwm_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Open the Board or Doc that you want to save as a template.

3. You can save a Board, a Doc, or a single Doc page as a template.

4. Enter a name and description for the template.

5. From the Share with selection, select the access level for the template.

6. From the Board Views to Save selection, choose to include all shared views or just the current 
view of the Board.

7. Review the number of Board views and custom task types that will be included into this 
template.

8. Select Save.

Result
The saved template is added to the Template Center.
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Update a template in CWM

Update sharing permissions for a Board template or edit the format of a Doc template using the 
Template Center in Collaborative Work Management  (CWM).

Before you begin
Role required: sn_cwm.cwm_user

You must be the owner of the template to update its details.

About this task

Updating Board templates

You can only modify the sharing permissions, template name, and the description 
of a Board template. The tasks, column order, sorting, custom columns, or any other 
preferences within the template can't be updated.

Updating Doc templates

You can modify sharing permissions along with the format, structure, and pages for 
a Doc template.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Select +Create.

3. Open the Template Center by selecting Explore templates.

4. Locate the template that you want to edit.

◦ Filter the available templates by Owner or Type

◦ Search for the template using its title or keyword.

5. From the template card, select the Template actions menu ( ) and select View details.

6. Modify the template title, the Share with  access, or the description.
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Editing a Board template

7. For a Doc template, select Edit  to edit the content of the template.

Editing a Doc template
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8. After making your changes, select Done  to close the template editor.
The changes are automatically saved to the template and they are applied to any Docs that 
you create from this template in the future.

Delete a Board or Doc template in CWM

Delete any custom templates that are no longer necessary for your workflows using the Template 
Center in Collaborative Work Management  (CWM).

Before you begin
Role required: sn_cwm.cwm_user

You must be the owner of the template to delete it.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. Select +Create.

3. Open the Template Center by selecting Explore templates.

4. Locate the template that you want to use.

◦ Filter the available templates by Owner or Type

◦ Search for the template using its title or keyword.

5. From the template card, select the Template actions ( ) menu and select Delete.

6. Select Delete  to confirm.

Result
The template is deleted and is no longer available for you or your team to use.

Collaborative Work Management  reference
Reference topics provide details on the roles, tables, and properties installed with Collaborative 
Work Management  (CWM).

Components installed with Collaborative Work Management

Several types of components are installed with activation of the Collaborative Work Management 
application, including tables and user roles.
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Roles installed

Role title [name] Description Contains roles

CWM user

[sn_cwm.cwm_user]

The basic role required 
to access the CWM 
workspace.

spm_agile_common_user

CWM admin

[sn_cwm.cwm_admin]

Admin role to modify 
and update any system 
properties for functionality 
across CWM.

sn_cwm.cwm_user

Docs admin

[sn_docs.docs_admin]

Admin role to modify 
and update any system 
properties for functionality in 
Docs.

None

Team member read

[sn_stm.team_member_read]

Allows users to view project 
tasks and demand tasks, 
and add comments to them.

• sn_cwm.cwm_user

• timecard_user

Team member read-write

[sn_stm.team_member_read_write]

Allows users to view and 
edit project tasks and 
demand tasks.

sn_stm.team_member_read

Tables installed

Table Description

CWM Automation

[sn_cwm_automation]

Stores data of automation conditions for Boards.

CWM Board​

[sn_cwm_board]

Contains all tasks, views, and column 
configuration.​

CWM Column Choice

[sn_cwm_col_choice]

Stores data for choices and labels created for 
custom columns.

CWM Column Usage

[sn_cwm_columns_usage]

Stores usage of custom columns and its type.

CWM Content Tree Preference
Stores user preference of left navigation menu in 
the expanded or collapsed state.
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Table Description

[sn_cwm_content_tree_preference]

CWM Document

[sn_cwm_doc]

Stores the information of all Docs created within 
CWM.

CWM Document page

[sn_cwm_doc_page]

Stores the information of pages and subpages 
created for a Doc within CWM.

CWM Document relationship

[sn_cwm_doc_m2m]

Stores relation between Docs and Doc pages

CWM Import Configuration

[sn_cwm_import_config]

Stores the configuration of tasks imported into My 
Work.

CWM Menu Item

[sn_cwm_menu_item]

Stores the content hierarchy for Boards, Docs, and 
folders within a Space.​

CWM Notification Digest

[sn_cwm_notification_digest]

Stores information of notifications sent to CWM 
users.

CWM Permission

[sn_cwm_permission]

Stores different level of permissions for the users 
and groups for the Spaces.

CWM Space

[sn_cwm_space]

Stores information of all CWM Spaces.​

CWM Space Access Request

[sn_cwm_space_access_request]

Stores the list of users who requested access to 
the Space.

CWM Sprint

[sn_cwm_sprint]

Stores information of sprints created in CWM.

CWM Task

[sn_cwm_task]

Stores tasks data.

CWM Task Relationship

[sn_cwm_m2m]

Stores information of the relationships for the 
CWM tasks such as prerequisites, dependencies, 
and related tasks.

CWM Template
Stores information of Board and Doc templates 
within CWM workspace.
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Table Description

[sn_cwm_template]

CWM Template Board Metadata

[sn_cwm_template_board_metadata]

Stores metadata of CWM Board templates such as 
work types, automations, and others.

CWM Template Board Views

[sn_cwm_template_board_view]

Stores information of views within Board templates.

CWM Template Column Choice

[sn_cwm_template_column_choice]

Stores information of column choices within Board 
templates.

CWM Template Custom Column Label

[sn_cwm_template_custom_column_label]

Stores information of custom column labels within 
Board templates.

CWM Template Document Page

[sn_cwm_template_doc_page]

Stores information of pages within Doc templates.

CWM Template Task

[sn_cwm_template_task]

Stores information of tasks within Board templates.

CWM User Preference

sn_cwm_user_preference

Stores user preferences such as last selected 
Board, Agile preferences, and others.

CWM View Preferences

[sn_cwm_view_preference]

Stores information of view preferences for Boards.

CWM Views

sn_cwm_view

Stores information of all Board views within CWM.

CWM Work Type

[sn_cwm_work_type]

Stores work types for task allowed within a Space.

MyWork Table Mapping

[sn_cwm_mywork_table_mapping]

Stores information of tasks shown in My Work such 
as dates, states, and assigned users.
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Properties installed with Collaborative Work Management

System properties that you can configure to include other ServiceNow AI Platform  records in 
CWM  Docs and modify the way non-CWM  users request access to the workspace.

These properties are available for Collaborative Work Management.

Note: 
To open the System Properties [sys_properties] table, enter sys_properties.list  in 
the navigation filter.

Properties for Collaborative Work Management

Property Description

sn_cwm.request_role_access Property to show or hide the Request Access  button for 
non-CWM  users in the workspace.

By default, the button is hidden. When this property is set to 
true, an event sn_cwm.REQUEST_ROLE_ACCESS  is raised. 
Admins can configure this event to trigger one of the following 
workflows, allowing the non-CWM  user to request access to the 
workspace.

• Raising a Service Catalog  request.

• Sending an email.

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] table

• Role needed: sn_cwm.cwm_admin

sn_cwm.record_mention_config
Property to configure mentioning any ServiceNow AI Platform 
record within Docs pages of CWM  workspace.

• Type: string

• Default value: 
[{"sourceTable":"sn_cwm_task","label":"CWM 
Task","fields":
["short_description","number"]}]

By default, this property is configured to include CWM  task 
records.

• Location: System Property [sys_properties] table

• Role needed: sn_cwm.cwm_admin

To include any other ServiceNow AI Platform  record, update the 
property.

For example, to reference the Incident records in the Docs 
pages, update the Value  field of this property to include the 
Incident table.
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Properties for Collaborative Work Management  (continued)

Property Description

The updated Value  field would include the configuration for 
CWM  task records and Incident records:

[{"sourceTable":"sn_cwm_task","label":"CWM 
 Task","fields":["short_description","numb
er"]},
{"sourceTable":"incident","label":"Inciden
t","fields":["short_description","number"
]}]

sn_cwm.include_additional_assignee Property to display tasks assigned to the user in My Work, when 
the user is added to the Additional assignee  field.

By default, My Work displays only tasks where the user is 
listed in the Assigned to  field. When this property is set to true, 
it includes all tasks assigned to the user through either the 
Assigned to  field or the Additional assignee  field.

• Type: true | false

• Default value: false

• Location: System Property [sys_properties] table

• Role needed: sn_cwm.cwm_admin

sn_cwm.connect_work_import_limit
Property to configure the maximum number of items that can 
be imported to a CWM  Board for the first time when using the 
Connected work feature.

• Type: integer

• Default value: 100

• Location: System Property [sys_properties] table

• Role needed: sn_cwm.cwm_admin

sn_cwm.agile_enabled
Property to control Agile-related features for CWM. If set to true, 
then agile items like Story and Epic can be created in a CWM 
Board and Sprint planning feature will be enabled.

• Type: true | false

• Default value: true

• Location: System Property [sys_properties] table

• Role needed: sn_cwm.cwm_admin

sn_docs.is_live_presence_enabled
Property to enable live presence indicators of users on a Doc 
page.

• Type: true | false

• Default value: true
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Properties for Collaborative Work Management  (continued)

Property Description

• Location: System Property [sys_properties] table

• Role needed: sn_docs.docs_admin

Grouping of tasks in status reports of CWM  My Work

Learn how various tasks assigned to you are grouped based on their State and Priority in My 
Work reports of Collaborative Work Management  (CWM).

State buckets

State buckets represent the lifecycle stage of different tasks. Existing state values from different 
task types are automatically mapped into these buckets based on meaning and also internal 
value of any task type. In My Work, all states are automatically grouped into three standard State 
Buckets.

• Open: Represents tasks not yet started. For example, states of Draft, Pending, and Ready.

• Work in Progress: Represents tasks currently being worked on. For example, states of In 
Progress, Implement, and Testing.

• Closed: Represents tasks that are finished or no longer active. For example, states of are 
Complete, Cancelled, and Closed Skipped.

Priority buckets

Priority buckets provide a unified way to understand the urgency of tasks. Priority buckets are 
created by mapping existing priority values from the Task table. All tasks are automatically 
grouped into five Priority Buckets.

• Planning: Not yet prioritized.

• Low: Minimal urgency.

• Moderate: Medium priority tasks.

• High: Important tasks that require attention soon.

• Critical: Most urgent tasks.

Custom State and Priority values

Your ServiceNow  instance may have some extended task types that have custom state or priority 
values. These custom values may not align with the default values of the Task table. These work 
items with these non-default State or Priority values appear as Others  in the bar graphs in My 
Work. This method ensures reporting accuracy instead of forcing a state/priority into the wrong 
bucket.
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Related topics

My Work in CWM

Now Assist for Collaborative Work Management  (CWM)
The Now Assist for CWM  application uses generative AI skills to improve time to value for the 
tasks you perform in the CWM  workspace.

Get started

Explore

Learn the features and key benefits

Configure

Set up the implementation

Use

Start using generative 
AI capabilities in CWM

Reference

Learn about roles, tables, 
and system properties
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Important: 

• Not all model providers are available for customers with in-country SKUs, and some Now 
Assist  products/features are currently unavailable for in-country customers. For more 
information, see the KB1584492  article in the Now Support Knowledge Base. Be sure to 
check for model provider availability updates in future releases.

• Some Now Assist  products/features are currently unavailable for customers in the 
FedRAMP, NSC DOD IL5, or Australia IRAP-Protected data centers, self-hosted 
customers, or in other restricted environments. For more information, see the 
KB0743854  article in the Now Support  Knowledge Base . Be sure to check for availability 
updates in future releases.

• Some Now Assist  products/features are currently available only for customers in some 
regions. Be sure to check for availability updates in future releases.

• Some AI products and skills are not available in Regulated Markets. For more information, 
see KB2593939: Regulated Markets AI Products/Skills Not Available . Be sure to check 
for availability updates in future releases.

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI,  Google 
Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist  skills and 
AI agents. Use the Configuration Controls in AI Control Tower  to define which options are 
available, then set the skill-level preferences in the Now Assist Admin  console . For more 

information, see Large language models on the ServiceNow AI Platform® .

AI limitations

This application uses artificial intelligence (AI) and machine learning, which are rapidly evolving fields of study that generate predictions based on patterns 

in data. As a result, this application may not always produce accurate, complete, or appropriate information. Furthermore, there is no guarantee that this 

application has been fully trained or tested for your use case. To mitigate these issues, it is your responsibility to test and evaluate your use of this application for 

accuracy, harm, and appropriateness for your use case, employ human oversight of output, and refrain from relying solely on AI-generated outputs for decision-

making purposes. This is especially important if you choose to deploy this application in areas with consequential impacts such as healthcare, finance, legal, 

employment, security, or infrastructure. You agree to abide by ServiceNow’s AI Acceptable Use Policy , which may be updated by ServiceNow.

Data processing

This application requires data to be transferred from ServiceNow  customers' individual instances to a centralized ServiceNow  environment, which may be located 

in a different data center region from the one where your instance is, and potentially to a third-party cloud provider, such as Microsoft Azure. This data is handled 

per ServiceNow's internal policies and procedures, including our policies available through our CORE Compliance Portal .

Data collection

ServiceNow  collects and uses the inputs, outputs, and edits to outputs of this application to develop and improve ServiceNow  technologies including ServiceNow 

models and AI products. In addition, this application will collect  task data (for Case Assist) and chat transcripts (for Chat Assist). Customers can opt out of future 

data collection at any time, as described in the Now Assist  Opt-Out page .

For more information, see the Now Assist  documentation .

Exploring Now Assist for Collaborative Work Management  (CWM)
Learn more about the generative AI capabilities of Now Assist for CWM  and how they can 
help you save time and improve efficiency for the actions your team performs within the CWM 
workspace.

Skills

Generate scrum tasks for stories

Accelerate your sprint planning by using Now Assist  to generate scrum tasks based 
on user story descriptions and acceptance criteria. Instead of manually creating 
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each task, you receive a relevant set of scrum tasks as a starting point for further 
refinement.

Generate scrum tasks from the story form or create them inline from the List 
or Sprint planning views. Now Assist  analyzes the user story description and 
acceptance criteria to propose tasks that align with the required work. For stories 
that already have scrum tasks, Now Assist  considers existing tasks when generating 
new ones to avoid duplication and maintain continuity.

You can review and edit AI-generated tasks before adding them to your story. 
There is no limit on the number of tasks generated, giving you flexibility to capture 
all necessary work breakdown items. This capability reduces the time spent on 
repetitive task creation and helps teams establish a consistent starting point for 
sprint execution.

Generate formulas from natural language

Create formula columns faster by describing your calculation in natural language 
and letting Now Assist  generate the formula for you.

Instead of manually building complex formulas, type what you want to calculate in 
the Formula Builder panel. For example, enter descriptions like days between 
start date and end date  or total estimated hours for all 
subtasks. Now Assist  analyzes your description and generates a valid formula 
using the available columns in your List view.

Review the generated formula to verify that it matches your intent. Insert the 
formula into the editor with a single click, then make any adjustments if needed. 
This capability removes the need to memorize formula syntax, making calculated 
columns accessible to team members of all technical skill levels.

Generate acceptance criteria for stories

As a product manager, generate clear, comprehensive, and testable acceptance 
criteria for your user stories, instead of spending hours writing and refining them 
manually.

You can review and refine the suggested options to ensure they meet your story 
requirements without slowing down planning. By helping you streamline generating 
acceptance criteria as a process, this skill helps save time, improve quality, and 
speed up delivery with cleaner backlogs and better collaboration.
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CWM Doc generation and insights

Generate content with Now Assist for CWM  directly in your Docs using custom 
prompts. In addition, summarize existing sections, elaborate where needed, and 
refine drafts to help improve your productivity.

You can interact with Now Assist  directly in your Doc to create new content, add 
context, or improve existing sections. This helps you draft faster, refine ideas, and 
keep your work relevant without leaving the page.

Work with content of the whole page

Some examples are:

• For Marketing teams: Create a compelling product 
launch announcement highlighting the key 
benefits and emotional appeal for our target 
audience.

• For Legal teams: Write a plain-language summary of 
the privacy policy in this doc, that customers 
can easily understand.

• For product teams: Analyze the customer feedback 
comments in this Doc, group into top 5 themes, 
and suggest top 3 enhancements for highest 
impact.

Now Assist  uses the context from your Doc page to generate a 
response.

Refine, elaborate, or improve the existing content within the page

Some examples are:

• If you have a list of stakeholders, you can ask Elaborate on the 
scope of these roles.

• Rewrite this in a casual tone.
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Take assistance on a blank page

Some examples are:

1. Generate 5 icebreaker questions for a virtual 
team-building session.

2. Write a 3-paragraph blog post explaining why 
[industry trend] is changing how businesses 
operate.

3. Generate an outline for the Instagram campaign 
tasks for a Hackathon initiative.

Answer questions in the context of this Doc

Whether the content in the Doc is added manually or generated using 
Now Assist, you can ask questions to find anything in the page's 
context.

For example, if you have a project charter document, you can try asking 
What is the total budget of this project and 
which part is the most expensive?

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1077



Doc summarization

Gain insights into the contents of the page by summarizing it in CWM  Docs. 
Whether you're reviewing long documents or preparing for meetings, Doc 
summarization skill helps you stay informed and efficient.

With the Doc summarization skill, you can also elaborate and shorten content, 
resulting in improved content quality in the CWM  Doc pages. Quickly shorten 
lengthy paragraphs, paraphrase bullet points, or expand on key points ensuring that 
your content is tailored to specific needs.

Generate CWM Tasks from Docs

Creating tasks with detailed descriptions for your CWM  Board requires significant 
time and manual effort. If the tasks aren’t detailed enough, it can lead to confusion 
and misalignment within the team, affecting their understanding of the expected 
outcomes. To avoid this manual effort and improve time to value, Now Assist  can 
generate tasks for your Board using the information in your Docs. This way, you can 
ensure clear and comprehensive task descriptions, allowing you to focus more on 
execution and less on the administrative work.

Based on the recommendations, you can ask Now Assist  to perform one of the 
following:
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• Generate task according to its original recommendations.

• Split a task recommendation into multiple tasks.

• Combine multiple task recommendations into one task.

• Remove any task recommendation.

Thus, by using the Task generation skill within CWM, you can:

• Remove initial roadblocks to create tasks for a CWM  Board.

• Save time and increase productivity by automating the task creation process.

You can use Now LLM Service, Now LLM Long Term Stable models (LTS), Azure OpenAI,  Google 
Gemini  or Anthropic Claude on AWS  as the AI model provider for all Now Assist  skills and 
AI agents. Use the Configuration Controls in AI Control Tower  to define which options are 
available, then set the skill-level preferences in the Now Assist Admin  console . For more 

information, see Large language models on the ServiceNow AI Platform® .

Now Assist Admin  console

An administrator can activate and manage Now Assist  features and skills for the CWM 
workspace using the Now Assist Admin  console. For more information, see Overview tab in Now 
Assist Admin .

Now Assist  panel in CWM  workspace

A knowledge worker can use the Now Assist  panel in CWM  workspace. This conversational 
interface enables the user to generate CWM  tasks from the context of a Doc page. For more 
information about the Now Assist  panel, see Now Assist panel .
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What to explore next

To learn more about configuring and using Now Assist for CWM, see:

• Configure Now Assist for Collaborative Work Management (CWM)

• Generate tasks from Docs in Collaborative Work Management (CWM)

• Now Assist for Collaborative Work Management (CWM) reference

Supporting information for Now Assist for Collaborative Work Management 
(CWM)

Learn about supported versions, user interfaces, and application dependencies of Now Assist 
for CWM.

Compatible versions

The Now Assist for CWM  application is compatible with Yokohama  Patch 3 release and later.

Supported user interfaces

The Now Assist for CWM  application is supported for Collaborative Work Management  version 
6.0.0 and later.

Application information

Installing the latest Now Assist for Collaborative Work Management  (CWM) store app 
(sn_cwm_ai) also installs Now Assist for Platform (sn_genai_platform).

Related topics

Configure Now Assist for Collaborative Work Management (CWM)

Configure Now Assist for Collaborative Work Management  (CWM)
If you have the admin role, you can configure the implementation for the Now Assist for CWM 
application so that your team members can utilize generative AI skills in the CWM  workspace.

Before you begin

• The minimum version of CWM  application that is required to support Now Assist for CWM 
features is v6.0.0 and later. If you're on earlier versions, upgrade your app through Application 
Manager. See Update an application or plugin .

• Install the Now Assist for Collaborative Work Management  (CWM) plugin (sn_cwm_ai). See 
Install Now Assist plugins .

• Activate the Now Assist panel standard chat .

Role required: admin

About this task
Use the Now Assist Admin  console to configure Now Assist for SPM. All Now Assist for SPM 
skills are activated by default. If a skill isn't automatically activated or you want to update its 
configuration, follow the steps below.

Use the Now Assist Admin  console to activate the following skills of Now Assist for CWM.

• CWM Doc generation and insights

• Acceptance criteria generation
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• Tasks generation

• CWM Scrum tasks generation

Note: 
Now LLM Service  is the default provider for this Now Assist  application's skills.

Procedure

1. Navigate to All  > Now Assist Admin  > Skills.
The Now Assist Skills  tab of the Now Assist Admin  console is displayed.

2. From the Technology  grouping, select CWM.
The skills for CWM  are displayed as tiles.

3. For the skill that you want to activate, select Activate skill.

4. Review the skill configuration settings from the following sections.

To edit the inputs, switch your application scope to Now Assist for Collaborative Work 
Management (CWM). For more information on these inputs, see Skill inputs for Now Assist for 
Collaborative Work Management (CWM).

Note: 
The display options are available based on the skill.

a. Choose inputs: These are the skill settings for summarizing and refining selected content 
within a CWM  Doc page.

This section is not available for the Tasks generation skill.

b. Select Save and continue.

c. Define access: Review who has access to skills.

▪ Configure ACLs or role-based permissions to ensure who can view or edit the skills.

▪ Review role restrictions to skill.

d. Page inputs: These are the skill settings for summarizing the whole content of a CWM  Doc 
page.

e. Select Save and continue.

f. Select display:

▪ In-product desktop: Enabling this option shows the skill within the CWM  workspace.

▪ Now Assist panel: Enabling this option shows the skill within the Now Assist  panel.

▪ Now Assist context menu: Enabling this option shows the skill within a form field in the 
CWM  workspace.

g. Select Save and continue.

h. Review and activate: Review your selections for the skill.

5. Select Activate.

Result
The skill is successfully activated.

What to do next
Return to the CWM  skill grouping and repeat the process to activate any remaining skills.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1081



If you have custom roles that require access to a skill, update the ACLs for those roles that 
require access. For more information, see Implement access control in Now Assist AI agents .

Related topics

Supporting information for Now Assist for Collaborative Work Management (CWM)

Skill inputs for Now Assist for Collaborative Work Management (CWM)

Skill inputs for Now Assist for Collaborative Work Management  (CWM)

Learn about the inputs of each skill of Now Assist for CWM. By configuring inputs for a skill, you 
can determine how and when a skill is used within the CWM  workspace.

Acceptance criteria generation skill inputs

The Acceptance criteria generation skill includes the inputs that identify the fields that are used 
as context to generate acceptance criteria for a story. The following table provides more details 
on the input data.

Story input data for Generate acceptance criteria skill

Input Description

Table Story [rm_story]

This value can't be changed.

Fields Short description, Description

You can choose to add more fields to serve as 
context to generate acceptance criteria.

Acceptance criteria template A default template is provided.

You can choose to modify the existing 
template or define a new template based on 
your team's requirements.

Reference stories Tag a story as a reference when it contains 
ideal acceptance criteria. These tagged stories 
serve as examples for Now Assist, giving it 
additional context to generate well-structured 
acceptance criteria for new stories.

Related topics

Configure Now Assist for Collaborative Work Management (CWM)

Using Now Assist for Collaborative Work Management  (CWM)
Save time, reduce manual effort, and improve overall efficiency by using the generative AI 
capabilities of Now Assist for CWM.

The following tasks provide guidance on using Now Assist  skills within the CWM  workspace. 
Navigate to the task that suits your use case.
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• Summarize and refine content of a Doc page in Collaborative Work Management (CWM).

• Generate and improve Docs content with Now Assist for Collaborative Work Management 
(CWM).

• Generate tasks from Docs in Collaborative Work Management (CWM).

• Generate acceptance criteria for stories in CWM.

Summarize and refine content of a Doc page in Collaborative Work 
Management  (CWM)

Gain insights into the page content by summarizing it or improve content quality by refining it in 
CWM  Docs.

Before you begin
Create a Doc in CWM.

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_cwm_ai.cwm_ai_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the Spaces menu, navigate to the Space where your Doc is located and open it.

3. From your Doc, open the page you want to summarize or refine.

4. Choose to summarize the selected text on the page or the whole page.

◦ To refine the selected text:

a. Select a single block or multiple blocks of content on the page.

b. Select Now Assist  and choose an option.
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▪ Summarize  to summarize the selected text.

▪ Elaborate  to lengthen the selected text based on the existing context.

▪ Shorten  to make the selected text concise.

◦ To summarize the entire content on the page, select Now Assist  from the Doc header and 
select Summarize.

Tip: 
If there’s more content to summarize, you can remove some text and retry.

Now Assist  analyzes the text and generates an output in a separate pop-up.

5. Optional:  Based on the output generated, you can further refine the result.

6. Optional:  Copy the generated output by selecting the copy to clipboard icon ( ) to use it for 
purposes such as sending an email, saving to notes, and others.

Important: 
Because the output is AI-generated, review it to ensure accuracy.

Generate and improve Docs content with Now Assist for Collaborative Work 
Management  (CWM)

Generate content with Now Assist for CWM  directly in your Docs using custom prompts. In 
addition, summarize existing sections, elaborate where needed, and refine drafts to help improve 
your productivity.
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Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: sn_cwm_ai.cwm_ai_user

About this task
You can interact with Now Assist  directly in your Doc to create new content, add context, or 
improve existing sections. This helps you draft faster, refine ideas, and keep your work relevant 
without leaving the page.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the Spaces menu, navigate to the Space where your Doc is located and open it.

3. From your Doc, open the page you want to work with and use Now Assist  for any of your use 
cases.
Now Assist  analyzes the text and generates an output in a separate pop-up.

4. Optional:  Based on the output generated, you can further refine the result.

5. Optional:  Copy the generated output by selecting the copy to clipboard icon ( ) to use it for 
purposes such as sending an email, saving to notes, and others.

Important: 
Because the output is AI-generated, review it to ensure accuracy.

Generate tasks from Docs in Collaborative Work Management  (CWM)

Use the generative AI capabilities of Now Assist  to create tasks from the content of your Docs 
and help you add them to the required Board in CWM  workspace.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Create a Doc in CWM
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Role required: sn_cwm_ai.cwm_ai_user

About this task

https://player.vimeo.com/video/1079861522?
h=a6bccdb612&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the Spaces menu, navigate to the Space where your Doc is located and open it.

3. From the header of the Doc, select Create Tasks.
The Now Assist  panel opens up. Now Assist  generates recommendations for tasks based on 
the information on your Doc page. So, to experience an easier interaction within the panel, you 
can pin it.

4. Optional:  Go through the task recommendations and choose to refine or modify any task 
recommendation.

5. You can iterate on refining or modifying the tasks and when you’re satisfied with the 
recommendations, select Add to Board.

6. Select the Space of the CWM  Board to which you want to add these tasks to.

7. Select the Board to add these tasks to.

Now Assist  adds all the generated task recommendations to the selected Board. You can 
navigate to the Board through the link provided in the Now Assist  message to review them.
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Note: 
If the Space you selected in Step 6 has just one Board, then you won't be asked to select 
a Board. The tasks are added to the Board directly.

Generate acceptance criteria for stories in CWM

Create clear, comprehensive, and testable acceptance criteria for user stories without writing 
them manually in Collaborative Work Management  (CWM). Review and refine suggested options 
to ensure they meet your requirements.

Before you begin
Role required: sn_cwm_ai.cwm_ai_user

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From the Spaces menu, navigate to the Board containing your story.

3. Select the story to open its details in the side panel.

4. From the Acceptance criteria field in the side panel, select the Use Now Assist to...  menu ( ).

5. Select Generate acceptance criteria.
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6. Review the generated acceptance criteria.

7. You can choose to further refine the generated content using the Now Assist context menu 

( ) or generate a new criteria.

8. Select Update  to save the acceptance criteria in the Story form.

Generate scrum tasks for a story with Now Assist for CWM

Use Now Assist  to automatically generate scrum tasks for a story in Collaborative Work 
Management  (CWM) based on the story's description and context, saving time on manual task 
breakdown.

Before you begin
Role required: sn_cwm_ai.cwm_ai_user

About this task
https://player.vimeo.com/video/1173343785?
h=1ff2048afb&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Now Assist  generates scrum tasks by analyzing the story's description and context. You can 
generate scrum tasks in two ways: with review, where you evaluate and approve the suggestions 
before they are added to the story, or without review, where suggestions are generated and 
added to the story immediately using the inline Now Assist  icon from the Board.

Procedure

1. Navigate to Workspaces  > Collaborative Work Management.

2. From a Space, select a Board.

3. Open the story you want to generate scrum tasks for.

You can open a story from any board view: List, Gantt, Kanban, or Sprint planning.

4. On the story form, select the Scrum Tasks  tab.

5. Select Create with Now Assist.
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Now Assist  analyzes the story description and context and generates scrum task 
recommendations.

6. Review the generated recommendations.

If the suggestions don't match the story, select Refine  > Regenerate  to produce a new set of 
recommendations.

7. Select Insert  to add the scrum tasks to the story.

Result
The generated scrum tasks are added to the story and appear in the Scrum Tasks  tab. You can 
edit any of the generated tasks after they're added.
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What to do next
Tip: 

For a quicker path that skips the review step, hover your cursor over the story's short 
description in the List, Gantt, or Sprint planning views to reveal the Now Assist  scrum tasks 

icon ( ) and select it. The scrum tasks are generated and added to the story immediately 
without a review step.

To add scrum tasks manually instead, see Add scrum tasks to a story in CWM.

Related topics

Scrum tasks for stories in CWM

Add scrum tasks to a story in CWM

Now Assist for Collaborative Work Management  (CWM) reference
Reference topics provide details on the roles installed with Now Assist for CWM.

Roles installed with Now Assist for Collaborative Work Management  (CWM)

The CWM  AI user role (sn_cwm_ai.cwm_ai_user) enables users to use the generative AI skills 
that are available with the Now Assist for CWM  application.

Contains Roles

Roles contained within the sn_cwm_ai.cwm_ai_user role: sn_cwm.cwm_user

Groups

Groups this role is assigned to by default: None.

Special considerations

None.

Goal Framework  and Goal Framework for SPM
Create goals, set targets for them, and evaluate the progress of the goals and targets to 
accomplish your organizational plans and drive business outcomes using ServiceNow®  Goal 
Framework.

The ServiceNow®  Goal Framework for Strategic Portfolio Management (SPM)  application 
(formerly known as Advanced Goal Framework) enables you to automate the actual value of 
your targets. The Goal Framework for SPM  application is an extension to the Goal Framework 
application. When you install the Goal Framework for SPM  application, you get all the features of 
Goal Framework  as well as the target automation feature.

Using Goal Framework, you can define strategic priorities and associated goals for your 
organization as part of strategic plans. After goals are created, you can then associate work, 
planning items, and strategic items such as demand, project, epic, program, and initiative.

The ServiceNow®  Strategic Planning  users can define personalized portfolio plans using lenses 
for your organization and use them to align your goals according to your organization's portfolio 
plans. For information on how a portfolio plan is defined using a lens, see Lens and portfolio 
plans. You can also create strategic plans, capturing the vision, mission, and values for your 
organization.
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Key benefits of Goal Framework:

• Helps ensure that the entire organization focuses efforts on the same strategic priorities.

• Makes goals that align and focus effort visible.

• Enables the association of work or planning items with goals so that the work being done to 
accomplish goals and meet targets is easily visible.

• Provides real-time checkpoints for goals over weekly, monthly, and quarterly durations.

• Provides an end-to-end view of goal performance to users with the 
sn_gf.epmo_strategy_planner role.

Key benefits of Goal Framework for SPM:

• Enables you to automate the actual value of your targets by collecting the actuals from different 
target sources such as benefit plans, cost plans, assessments/surveys, and PA Indicators.

• Enables you to configure any table or combination of tables that are present on the 
ServiceNow AI Platform®  as a target source.

Get started

Explore

Learn about Goal 
Framework and 
Goal Framework 
for SPM features

Compare

Compare capabilities 
of Goal Framework with 

Goal Framework for SPM

Configure

Learn how to configure 
Goal Framework and 

Goal Framework for SPM

Use

Learn how to define 
goals to accomplish your 
organizational plans and 
drive business outcomes

Reference

Get details about 
components like 

fields, tables, roles, 
and properties.
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Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community.

• Search the Known Error Portal for known error articles. For more information, see Search the 
Known Error Portal for known error articles .

• Contact Customer Service and Support. For more information, see Contact Customer Service 
and Support.

Exploring Goal Framework  and Goal Framework for SPM
The Goal Framework  application helps you create goals, set targets for them, and evaluate the 
progress of the goals and targets to accomplish your organizational plans and drive business 
outcomes.

The Goal Framework for Strategic Portfolio Management (SPM)  application enables you to 
automate the actual value of your targets by collecting the actuals from different target sources 
such as benefit plans, cost plans, assessments/surveys, and PA Indicators.

Goal Framework  key components:

• Strategic priorities: Actions of a strategic plan that help to orient your 
organizational strategic plan toward your goal.

• Goals: Objectives that you want to reach based on your strategic plans.

• Targets: Targets for goals to track and measure the progress of the goals.

Goal Framework for SPM  key component:

Target source is the key component of Goal Framework for SPM. Target source is a 
configuration for a target that is used to auto-update the actual value of the target, 
so that the progress of the target and its goal is auto-updated.

Strategic priorities

Strategic priorities are the objectives of your organizational plans. Strategic priorities help 
you to achieve your goals over a designated time period. The strategic priorities are also 
known as focus areas or long-term strategies. Defining strategic priorities helps to orient your 
organizational strategic plans toward your goals.

Goals

Goals refer to objectives that an organization sets for itself to accomplish their organizational 
plans. Goals are typically qualitative in nature. Goals should be ambitious and are expected to 
motivate and challenge your teams. Some examples of goals are as follows:

• Using renewable energy by the end of the year 2022.

• Increase diversity in the workplace by 50 percent.

A goal can also have sub-goals. You can also associate work and planning items to a goal so that 
you can track who is responsible for fulfilling the goal.

If you use Goal Framework  with other products, you can also do the following:
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• If you're a ServiceNow®  Project Portfolio Management  user, you can associate demands, 
projects, and programs with a goal to capture the work being done to meet your goal.

• If you're a ServiceNow®  Agile Development 2.0  user, you can associate scrum epics with a goal 
to capture the work being done to meet your goal.

• If you're a ServiceNow®  Scaled Agile Framework (SAFe)  user, you can associate SAFe epics 
and SAFe features with a goal to capture the work being done to meet your goal.

• If you're a Strategic Planning  user, you can associate planning items - Demand, Project, and 
Epic, and strategic items - Program and Initiative - with a goal to capture the work being done to 
meet your goal.

Targets

Targets help you to measure your goal. For example, to meet the goal of increasing diversity in 
the workplace by 50 percent, the target can be to hire a 30 percent-diverse workforce by the first 
quarter of 2022.

Targets can be set as a quantitative or qualitative by defining the unit of measure for the target. 
Quantitative targets are numbers-based, countable, and measurable. Qualitative targets are 
interpretation-based, descriptive, typically yes or no type.

You can also breakdown a target into smaller periods (example, Quarterly) which helps you set a 
target for each quarter and focus on the specific breakdown targets. The target breakdowns are 
automatically created based on the breakdown interval set for the target. For details on how the 
target breakdowns feature works, see Target breakdowns.

Qualitative targets

Qualitative targets are typically non-measurable but can be tracked whether the 
target has been achieved. The available unit of measure for qualitative targets is 
Yes/No. You can also define a custom unit of measure (for the available choice set) 
for qualitative targets as per your need and set qualitative targets for your goals.

For example, to achieve a target of conducting hackathon in Q2-2023, the target 
can be set as conduct hackathon in Q2-2023 with the unit of measure Yes/No. Base 
and target value of the target can be No and Yes respectively. After the target is 
successful with the hackathon event, the target value can be updated to Yes.

Target sources

Target source is a configuration for a target that is used to auto-update the actual value of the 
target, so that the progress of the target and its goal is auto-updated. Any table or a combination 
of tables (for example, benefit plans, cost plans, surveys, incidents, and PA indicators) present 
on the ServiceNow AI Platform®  can be configured as a target source.

The following target source types are supported for automating the actual value of a target.

• PA Indicator: Updates the Actual value  field on the target form by fetching the required data 
from the PA Indicator.

• Assessment/Survey: Updates the Actual value  field on the target form by fetching the required 
data from the Assessment metric type and Assessment metric category records.

• Custom script: The Custom script fetches the required data from any ServiceNow AI Platform 
table that is configured. With the Custom script option, any table or a combination of tables 
present on the ServiceNow AI Platform  can be configured as a target source.
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Predefined target automation script for benefit plans: The predefined, default script is a target 
source that updates the Actual value  field on the target form by fetching the value from the 
Actual benefit  field or Non-monetary actual benefit  field from the monetary or non-monetary 
benefit plans of relevant work items.

Context variable

The context variable is an additional configuration for the target source. The context 
variable provides information that can be used on the target form to fetch the 
required data and update the Actual value  field on the Target form. The context 
variable is required for target source types Assessment/Survey and PA Indicator. If 
the Goal Framework for SPM  scope is selected while creating a target source, the 
context variable is automatically created for the target source (of type Assessment/
Survey and PA Indicator). For more information on context variables, see Context 
variable in target source.

Benefits and workflow

Use the Goal Framework  or Goal Framework for SPM  application to do the following activities:

• Create a strategic plan for your organization (If Strategic Planning  is installed). For more 
information, see Create a strategic plan.

• Create a strategic priority to orient your organization strategic plan toward your goal. For more 
information, see Create a strategic priority for a strategic plan.

• Create a goal. For more information, see Create a goal.

• (For Goal Framework  users) Set targets for a goal to track and measure the progress of the 
goal. For more information, see Set targets for a goal.

• (For Goal Framework for SPM  users) Set targets and automate the actual value of the 
targets. For more information, see Configuring target source for target automation using Goal 
Framework for SPM.

• Create a goal relationship with a work, planning, strategic, or any other item to identify and 
associate your current or future work and achieve your goals. For more information, see 
Associate a work or planning item with goals or targets.

• Associate the primary goal for a work and planning item. For more information, see Associate 
the primary goal for work and planning items.

For an example of the structure of a strategy from the strategic plan level down to targets, see 
Enterprise strategy example.

Comparing Goal Framework  with Goal Framework for SPM

• Goal Framework: Create goals, set targets for them, and evaluate the progress of the goals and 
targets to accomplish the organizational plans and drive business outcomes.

• Goal Framework for SPM: Automate the actual value of your targets by collecting the actuals 
from different target sources such as benefit plans, cost plans, assessments/surveys, and PA 
Indicators.

Comparison of Goal Framework  and Goal Framework for SPM  features

Feature Goal Framework Goal Framework for SPM

Create strategic plans
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Comparison of Goal Framework  and Goal Framework for SPM  features  (continued)

Feature Goal Framework Goal Framework for SPM

Create strategic priorities

Create goals

Set targets

Set target breakdowns

Associate work with goals

Automate actual value of 
targets

Monitor goals and strategies 
in ServiceNow  AI Control 
Tower

Note: 
The Goal Framework for SPM  application is an extension to the Goal Framework 
application. When you install the Goal Framework for SPM  application, you get all the 
features of Goal Framework  as well as the target automation feature.

Enterprise strategy example

For defining an enterprise strategy, you can start by creating a strategic plan that captures your 
organization's mission, vision, and values. You then define strategic priorities that align with 
your mission and vision of your organization, and create goals under each priority to establish 
what your organization wants to achieve. For each goal, you can set targets to track and measure 
progress toward achieving it.

The following illustration provides an example of a strategic plan, including its strategic priorities, 
goals, and targets.
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Better together with other ServiceNow  applications

The integration of Goal Framework  or Goal Framework for SPM  with other ServiceNow 
applications helps portfolio, product, and program managers to optimize planning and track 
goals for their products.

Goal Framework  with AI Control Tower  workspace

The ServiceNow®  AI Control Tower  workspace enables you to track and monitor all your strategic 
priorities, goals, and targets categorized as Artificial Intelligence in Goal Framework.

Populate the Type  field for strategic priorities and the Category  field for goals with the Artificial 
Intelligence  option to monitor their progress in the AI Control Tower  workspace. For more 
information, see Create a strategic priority  and Create a goal.

When AI Control Tower  is installed, the AI strategy  tab appears in the AI Control Tower 
workspace, featuring different widgets for AI strategies, goals, and targets details. For more 
information, see AI strategy tab in AI Control Tower .

Goal Framework  with Operational Sustainability Workspace

With the integration of ServiceNow  Operational Sustainability Workspace  with Goal Framework, 
you can create environmental, social, and governance (ESG) goals to track your progress toward 
your chosen material topics. You can also create an environmental, social, and social (ESG) 
target to help track the progress toward your ESG goal. For more information, see Create an 
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Operational Sustainability Management (formerly ESG Management) goal  and Create an 
Operational Sustainability Management (formerly ESG Management) target .

Goal Framework for SPM  with Strategic Planning

Use the ServiceNow  Strategic Planning Workspace  to visualize the progress of your targets 
graphically and update the target actuals with ease.

You can create a goal or target relationship with a planning item or any other item to identify and 
associate your current or future work and achieve your goals and targets. You can also associate 
a primary goal or target for the planning items where the items contribute to achieving the goal or 
target. For more information, see Managing portfolio plan goals in Strategic Planning Workspace.

Note: 
When you install Strategic Planning, you get all the features of the Goal Framework  and 
Goal Framework for SPM  applications.

Configuring Goal Framework  and Goal Framework for SPM
As an administrator, use this section to set up the Goal Framework  and Goal Framework for SPM 
applications.

Install Goal Framework  and Goal Framework for SPM

You can install the Goal Framework  (sn_gf) and Goal Framework for SPM  (sn_gfa) applications if 
you have the admin role.

Before you begin
Ensure that the applications and all associated store applications have valid ServiceNow 
entitlements. For more information, see Get entitlement for a ServiceNow  product or 
application .

When you install the Goal Framework for SPM  application, you get all the features of Goal 
Framework  as well as the target automation feature.

Role required: admin

Important: 
You can install the Goal Framework for SPM  application only when you own the Strategic 
Portfolio Management  (SPM) Pro license.

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the Goal Framework  or Goal Framework for SPM  application using the filter criteria and 
search bar.
You can search for the application by its name or ID (sn_gf or sn_gfa). If you can’t find an 
application, you may have to request it from ServiceNow  store. Visit the ServiceNow Store
website to view all the available apps and for information about submitting requests to the 
store. For cumulative release note information for all released apps, see the ServiceNow Store 
version history release notes .

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.

If your application requires other applications, install them first if they aren’t already installed.
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Installing your application also automatically installs the dependent applications or plugins if 
they aren’t installed already.

5. Click Install.

Result
The following components are installed with installation of the Goal Framework  or Goal 
Framework for SPM  application:

• Roles

• Tables

• Scheduled jobs

• Target automation script for benefit plans (installed with Goal Framework for SPM)

As part of Goal Framework for SPM  installation, components of both Goal Framework  and Goal 
Framework for SPM  are installed. See Components installed with Goal Framework and Goal 
Framework for SPM  for more information.

Migrate existing goals data to Goal Framework  tables

With the admin role, you can migrate the existing goals data to the Goal Framework  tables by 
running the scheduled job.

Before you begin
Role required: admin

About this task

Note: 
Migrating data to the Goal Framework  tables is a one-time job, and not meant to be on a 
schedule.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and click the Migrate Goal, Strategy, and Work item data to the Goal Framework 
and related Planning item tables  scheduled job.

3. On the Scheduled Script Execution form:

a. Ensure that the frequency is selected as On Demand  in the Run  field.

b. Set the value to true  for the required parameters in the Run this script  field.
For parameters information, see Migrate Goal, Strategy, and Work item data to the Goal 
Framework and related Planning item tables.

4. Click Execute Now.

Configure goal preferences

Configure goal preferences to manage goals such as the calendar type used for goal setting, 
weighted average calculation for goal progress, and deletion of goals and targets.

Before you begin
Role required: sn_gf.goal_admin
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Procedure

1. Navigate to All  > Enterprise Goal Management  > Preferences.

2. On the Goal Preferences form, configure the properties.
For properties information, see Goal Preferences form.

3. Click Save.

Configure a table for an assigned entity

Configure a table for an assigned entity type so that the goal user can associate goals with the 
required assigned entity.

Before you begin

• By default, with the installation of Goal Framework, the assigned entities, Business Unit 
[business_unit], Department [cmn_department], and Company [core_company] are installed.

• With the activation of PPM Standard (Project Portfolio Management), the Portfolio 
[pm_portfolio] assigned entity is installed.

• With the installation of Strategic Planning, the assigned entities, Product Model [cmdb_model], 
Value Stream [cmn_value_stream], Initiative [sn_align_core_initiative], and Strategic Program 
[sn_align_core_program] are installed.

Role required: sn_gf.goal_admin

About this task
An assigned entity is an organizational unit or structure that a goal can be associated with, such 
as a business unit or department. Assigned entities provide context for goals by linking them to 
the relevant part of your organization, making it easier to track and manage goals at any level.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Assigned Entities.

2. Click New.

3. On the form, fill in the fields.
For a description of the field values, see Goal Assigned Entity Configuration form.

4. Click Submit.

Import goals and targets data from a spreadsheet

With the admin role, you can import your existing goals and targets data from a spreadsheet to 
the Goal Framework  tables.

Before you begin

• On a successful job run, the goals data from your spreadsheet is imported to the Goal 
[sn_gf_goal] table.

• On a successful job run, the targets data from your spreadsheet is imported to the Target 
[sn_gf_goal_target] table.

Note: 
Because the targets are associated to a goal, you should import the goals first and then the 
targets.
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Important: 
Goals and targets data in the spreadsheet must be in the supported format. For details on 
the supported data format to import goals and targets data from a spreadsheet, see Import 
goals and targets data [KB1191233] .

Role required: admin

Procedure

1. Navigate to All  > System Import Sets  > Load Data.

2. From the Import set table drop-down list, select Goal Import Set [imp_sn_gf_goal]  or Target 
Import Set [imp_sn_gf_goal_target].

3. From the Source of the import  option, select File.

4. In the File  option, click Choose  and select your spreadsheet to import the data.

Important: 

◦ Goals and targets data in the spreadsheet must be in a specific format. For details on 
the supported data format, see Import goals and targets data [KB1191233] .

◦ Don't modify the names in the header row of the spreadsheet because the data is 
imported to the respective fields in the goal and target tables based on the header title 
of each column.

5. Click Submit.

6. On the Progress page, click Run Transform.

7. On the Specify Import set and Transform map page, click Transform.

8. Click Transform history  and verify that the State column is set to Complete  in the Import Set 
Runs related list.
Depending on the option that you selected from the Import set table drop-down list, your goals 
or targets data is imported to the Goal [sn_gf_goal] or Target [sn_gf_goal_target] tables.

If the job is failed, click Transform history  and refer to the details.

Note: 
The Import operation can be used for inserting new data or updating the existing data 
in the tables. By default, the Name and Owner values are the primary keys used for 
updating the existing records. You can also add additional fields as primary key for 
inserting new data or updating the existing data. For details on how to add additional 
fields as primary key, see Import goals and targets data [KB1191233] .

Update a scheduled job to automate the Actual value of the targets

Use the Goal Framework for SPM  application to modify the run time for the scheduled job 
according to your preference to auto-update the actual value of the targets for which a target 
source has been configured.

Before you begin
Role required: admin

About this task
By default, the scheduled job runs daily at 00:00:00 AM (System Time Zone).
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Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and click the Update Actual value of the targets using Goal Framework for SPM 
scheduled job.

3. Ensure that the Active  check box is selected to run the job at a scheduled time.

4. Edit the details of the Run  and Time  fields according to your preference.

5. Click Update.
To learn more about scheduled jobs, see Scheduled jobs .

Configuring target source for target automation using Goal Framework for 
SPM

Configure target sources for target automation so that the goal user can define a target source 
when setting a target for the goal. Defining a target source for a target updates the actual value of 
the target automatically.

Use the following steps as guidelines for setting targets and automating the actual value of the 
targets using Goal Framework for SPM. Some of these steps require the sn_gf.goal_user role and 
some require the sn_gf.goal_admin role.

1. Create a target source for a target to configure it as a source to update the actual value of the 
target. For more information, see Create a target source.

The context variable is required for target source types Assessment/Survey and PA Indicator. 
The mandatory context variables are automatically created while creating a target source with 
the type selected as Assessment/Surveys or PA Indicator. For more information on when the 
mandatory context variables are created, see Context variable in target source.

2. If required, create context variables for the target source so that the required data is fetched 
from the context variables to update the actual value of the target. For more information, see 
Create context variables for a target source.

Context variable in target source

The context variable is an additional configuration for the target source that can be used on the 
Target form to fetch the required data and auto-update the Actual value  field on the Target form. 
A context variable is required for target source types Assessment/Survey and PA Indicator.

The context variable is automatically created (with the Mandatory  field set to true  on the context 
variable form) for the target source (of type Assessment/Survey and PA Indicator) when the Goal 
Framework for SPM  scope is selected before creating a target source. The context variables 
created automatically are also known as mandatory context variables.

The mandatory context variables are created when you've selected the Goal Framework for SPM 
scope and you've met one of the following conditions:
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• (For target source type, Assessment/Survey) On the Target Source form, the Type  field is set to 
Assessment/Survey  and the Assessment Metric Types  field is populated with a metric type 
of Evaluation method = Assessment.

• (For target source type, PA Indicator) On the Target Source form, the Type  field is set to PA 
Indicator  and the value populated in the Breakdown  field isn't of Choice list type.

To create a context variable for the target source type, PA Indicator, where the Breakdown field 
is of Choice list type, see Create a context variable for the target source type PA Indicator.

Note: 
Mandatory context variables can't be deleted.

You can also create context variables manually for a target source and use them to configure for 
fetching the required data and auto-updating the Actual value  field on the Target form. For more 
information on how to create a context variable manually, see Create context variable for a target 
source.

Create a target source for automating the Actual value of the targets

Create a target source so that the goal user can configure it for the targets to automate the Actual 
value of the targets.

Before you begin
Select the Goal Framework for SPM  scope for the application.

Role required: sn_gf.goal_admin

About this task
The context variable is required for target source types Assessment/Survey and PA Indicator. 
The mandatory context variables are automatically created while creating a target source with 
the type selected as Assessment/Surveys or PA Indicator. For more information on when the 
mandatory context variables are created, see Context variable in target source.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Target Sources.

2. Click New.

3. On the form, fill in the fields.
For a description of the field values, see Target Source form.

4. Click Submit.
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Create context variable for a target source

Create a context variable manually if you want to configure more context variables for a target 
source.

Before you begin
Select the Goal Framework for SPM  scope for the application.

Role required: sn_gf.goal_admin

About this task
The Context variable provides information that can be used to fetch the required data and auto-
update the Actual value on the target form. After a context variable is created for the target 
source, the goal user can configure the Actual Value Source Configuration section on the Target 
form so that the Actual value gets auto-updated.

Creating a context variable is similar to creating a column on a table.

To create a context variable for the target source type PA Indicator and the breakdown is of 
Choice list type, see Create a context variable for the target source type PA Indicator.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Target Sources.

2. Open the required target source that you want to create a context variable for.

3. In the Context Variables related list, click New.

4. On the form, fill in the fields.
For a description of the field values, see Context Variable form.

5. Click Submit.

Create a context variable for the target source type PA Indicator

Create a context variable manually for the target source type PA Indicator if the breakdown is of 
Choice list type.

Before you begin
Select the Goal Framework for SPM  scope for the application.

Role required: sn_gf.goal_admin

About this task
The context variable provides information that can be used to fetch the required data and auto-
update the Actual value on the Target form. After a context variable is created for the target 
source, the goal user can configure the Actual Value Source Configuration section on the Target 
form for the Actual value to get auto-updated.

Creating a context variable is similar to creating a column on a table.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Target Sources.

2. Open the required target source that you want to create a context variable for.

3. In the Context Variables related list, click New.

4. On the form, fill in the Type  field as Choice and the other fields as needed.
For a description of the field values, see Context Variable form.

5. Click Submit.
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A context variable of choice type is created.

6. In the Choices related list of the context variable you created, click New.

Note: 
If you don’t see the Choices related list on the Context Variable form, add it by navigating 
to Configure  > Related Lists  on the form.

7. On the form, fill in the fields.

Choice form

Field Description

Table Name of the context variable for which the choice is created.

Element Column name in the context variable form for which the choice is created.

Label Name of the choice.

Value Sys_id of the choice value for which the context variable is created.

You can copy the sys_id from the Choices related list of the Dictionary Entry 
[sys_dictionary] table.

8. Click Submit.

9. Optional:  Repeat the steps 6 through 8 to create more choices for the context variable.

What to do next
The goal user can configure these choices as context variables on the Target form for which the 
target source is configured.

Migrate target breakdowns

After upgrading to Goal Framework for SPM  v2.3.0 or later, run the Migrate BreakdownInterval 
To Checkinfrequency  scheduled job to migrate the existing values from the Review frequency 
field to the Check-in frequency  field in the target records.

About this task
After running the job, the value in the Check-in frequency  field for a target is populated based 
on the existing value in the Review frequency  field of the target. If the existing value in the 
Review frequency  field was set to any option other than None, then target breakdowns will be 
created for such targets based on the value in the existing check-in frequency of the target. For 
more information on how these values are migrated for targets with different values, see Target 
breakdowns migration.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and select the Migrate BreakdownInterval To Checkinfrequency  scheduled job.

3. On the Scheduled Script Execution form, ensure that the frequency is selected as On Demand 
in the Run  field.

4. Select Execute Now.
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Target breakdowns migration

As an administrator, when you run the Migrate BreakdownInterval To Checkinfrequency 
scheduled job, the existing values in the Review frequency  and Breakdown interval  fields are 
migrated to the Check-in frequency  field in the target records.

The value in the Actual to date  field for the target and values in the Planned target value  and 
Actual  fields for the target breakdowns are populated based on the current actual value of the 
target and values in the existing target breakdowns.

Target breakdowns migration for targets with breakdown interval set to None

After running the job, the value in the Check-in frequency  field for a target is populated based on 
the existing value in the Review frequency  field of the target. If the existing value in the Review 
frequency  field was set to any option other than None, then target breakdowns will be created 
for such targets based on the existing review frequency of the target. Even though Breakdown 
interval  was set to None  for a target, target breakdowns will be created for the target based on 
the existing review frequency of the target.

The following table describes how the check-in frequency value is populated for targets with 
different values in the Review frequency  and Breakdown interval  fields.

Target breakdowns migration with breakdown interval set to None

Review frequency (Before 
upgrade)

Breakdown interval (Before 
upgrade)

Check-in frequency (After 
upgrading and running the job)

Yearly None Yearly

Quarterly None Quarterly

Monthly None Monthly

Fortnightly None Fortnightly

The Fortnightly option is 
retained and no target 
breakdowns will be created 
because the Fortnightly option 
is no longer supported.

After the owner or a 
contributor of the target 
updates the check-in 
frequency for the target, the 
target breakdowns will be 
created accordingly.

Weekly None Weekly

Daily None Daily

None None None

In this case, no target 
breakdowns will be created.

For example, consider a scenario where details of a target are as follows before upgrade:
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• The base value and target value of the target is 0 and 100, respectively

• The review frequency is set to Monthly  and Breakdown interval was set to None

• The start date and end date of the target are 2024-01-01 and 2024-12-31, respectively

• The current actual value of the target is 60 and the current month is August

In this case, after running the scheduled job 12 monthly target breakdowns are created for the 
target and the current actual value as 60 is populated in the August monthly breakdown. Also, 
the planned target value is populated for each breakdown.

Target breakdowns migration for targets with breakdown interval set to 
Quarterly or Yearly

After running the job, the value in the Check-in frequency  field for a target is populated based 
on the existing value in the Review frequency  field of the target. Then, target breakdowns are 
created for the targets based on the existing review frequency of the target.

The following table describes how the check-in frequency value is populated for targets with 
different values in the Review frequency  and Breakdown interval  fields.

Target breakdowns migration with breakdown interval set to Quarterly or Yearly

Review frequency (Before 
upgrade)

Breakdown interval (Before 
upgrade)

Check-in frequency (After 
upgrading and running the job)

Quarterly Quarterly Quarterly

Quarterly Yearly Quarterly

Note: 
For targets with breakdowns interval set to Yearly, irrespective of the target is of type 
cumulative or non-cumulative, after running the scheduled job quarterly target breakdowns 
will be created and the Target value distribution is set to Spread linearly across the time 
period (cumulative)  for the target.

For example, consider a scenario where details of a target are as follows before upgrade:

• The base value and target value of the target is 0 and 80, respectively

• The review frequency is set to Quarterly  and Breakdown interval was set to Yearly

• The start date and end date of the target are 2023-01-01 and 2024-12-31, respectively

• The target is of type non-cumulative

• The actual value achieved in each quarter is 10 starting from Q1-2023 till Q2-2024

• The current total actual value of the target is 60 and the current quarter is Q2-2024

In this case, after running the scheduled job 8 quarterly breakdowns are created and the Target 
value distribution is set to Spread linearly across the time period (cumulative)  for the target. The 
current actual value for Q1-2023, Q2-2023, Q3-2023, Q4-2023, Q1-2024, and Q2-2024 quarterly 
target breakdowns are populated as 10, 20, 30, 40, 50, and 60, respectively. Also, the planned 
target value is populated for each breakdown.

Defining a custom unit of measure

Defining a custom unit of measure helps the goal users to set the unit of measure for targets as 
per their choice. Unit of measures are two types, quantitative and qualitative.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1106



By default, the available unit of measures for quantitative targets are #, $, %, Days. By default, 
the available unit of measure for qualitative targets is Yes/No.

As an administrator, you must create custom unit of measures so that the goal user can use them 
for setting a unit of measure for their targets:

• For quantitative targets, you can define a custom unit of measures from the Unit [sn_gf_unit] 
table.

• For qualitative targets, you must first create a choice set and then create a choice list for the 
choice set.

Managing goals using Goal Framework  or Goal Framework for 
SPM
Understand the process required to define goals using Goal Framework.

Managing goals using Goal Framework or Goal Framework for SPM

Use the following steps as guidelines for defining your goals. Some of these steps require 
the sn_gf.strategy_planner role and some require the sn_gf.goal_user role. If you're an Goal 
Framework for SPM  user, you need the sn_gf.goal_admin role to configure the target automation 
feature. All steps are the same for defining goals using either Goal Framework  or Goal Framework 
for SPM.

1. Create a strategic plan to define the purpose - vision, mission, and values - of your 
organization. For more information, see Create a strategic plan.

You can create strategic plans only when Strategic Planning  is installed. Creating a strategic 
plan isn't required to define goals.

2. Create a strategic priority to orient your organization's strategic plan to your goal. For more 
information, see Create a strategic priority.

3. Create a goal. For more information, see Create a goal.

4. Create targets for goals to track and measure the progress of the goals. For more information, 
see Set targets for a goal using Goal Framework.

5. (For Goal Framework for SPM  users only) Set targets for goals and configure the target sources 
for the targets to auto-update the actual value of the targets. After the progress of a target is 
updated, the target's progress is rolled up to its goal. For more information, see Configuring 
target source for target automation using Goal Framework for SPM .

6. Create a goal or target relationship with a work or strategic item. For more information, see 
Associate work or strategy with goals or targets.

7. Set a goal or target as primary for the work and planning items where the items contribute to 
achieving the goal. For more information, see Associating the primary goal or target for work 
and planning items.

Create a strategic plan

As a strategy planner, you can create and manage strategic plans for your organization. Create 
a strategic plan to define the purpose of your organization, its strategic priorities, and the 
associated goals.

Before you begin
Install Strategic Planning  on your ServiceNow  instance.

Role required: sn_gf.strategy_planner
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Procedure

1. Navigate to All  > Strategy  > Strategic Plans.

2. Click New.

3. On the form, fill in the fields.
For field information, see Strategic Plan form.

4. Click Submit.

What to do next
From the Values related list, capture values for your organization such as Integrity, Commitment 
to customers, and Trust.

Create a strategic priority for a strategic plan

As a strategy planner, you can create and manage the strategic priorities for the strategic plans 
for your organization. Create a strategic priority to orient your organization strategic plan toward 
your goal.

Before you begin
Role required: sn_gf.strategy_planner

About this task
The strategic priorities are also known as focus areas or long-term strategies.

Procedure

1. Create a strategic priority for a strategic plan using one of the following options.

2. On the form, fill in the fields.
For field information, see Strategic Priority form.

3. Click Submit.

What to do next
Define goals and set targets for them to accomplish the strategic priorities.

Create a goal

Create goals and set targets to measure overall goal progress and evaluate them to align with the 
organizational strategic priorities.

Before you begin
Role required: sn_gf.goal_user  or sn_gf.goal_admin

About this task
Goals are typically qualitative in nature. Goals should be ambitious and are expected to motivate 
and challenge the teams.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Goals.

2. Click New.

3. On the form, fill in the fields.
For field information, see Goal form.

4. Click Submit.
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1108



What to do next
Set targets for the goals.

Create targets for a goal using Goal Framework  or Goal Framework for SPM

Create SMART targets for goals to track and measure the progress of the goals.

Before you begin
Role required: sn_gf.goal_user  or sn_gf.goal_admin

About this task
A SMART target can be defined as S = Specific, M = Measurable, A = Attainable, R = Relevant, 
and T = Time-bound.

• Only the owner or contributors of the goal can create targets for the goal.

• You can also restrict the access for a target record to the specific users by enabling the 
Confidential  field on the target form if the ESG Management  application is installed.

Procedure

1. Create a target for a goal using one of the following options.

2. On the form, fill in the fields.
For field information, see Target form.

3. Click Submit.

Result
The target progress records are automatically created when you save the target post populating 
the Actuals to date  field. The target progress records specify the progress of each target for the 
goal.

Note: 
When you delete a goal, its associated targets (if any) and their progress records are also 
deleted even though the Allow the deletion of targets  property is set to No.

What to do next
Update the progress of the targets.

Update the progress of a manual target

Update the progress of a target when its status is changed.

Before you begin
Role required: sn_gf.goal_user  or sn_gf.goal_admin

About this task

Note: 
Only the owner or contributors of the goal can update targets of the goal.

Procedure

1. Open the target record of the goal using one of the following options.

2. On the Target form, update the Actuals to date  field and add a business justification in the 
Remark  field.
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For field information, see Target form.

3. Click Update.

Result
Once the Actuals to date  field is updated, the progress value for the target is auto-updated. For 
information on how the progress value is calculated, see progress value calculation.

Related topics

Update the progress of a target using Goal Framework for SPM

Update the actual value of a target breakdown

Update the progress of a target using Goal Framework for SPM

Update the progress of a target using the Update Actual value  related link on the Target form.

Before you begin
Role required: sn_gf.goal_user  or sn_gf.goal_admin

About this task

Note: 
Only the owner or contributors of the goal can update targets for the goal.

Procedure

1. Open the target record of the goal using one of the following options.

2. On the Target form, click the Update Actual value  related link.
For a description of the field values, see Target form.

Result
After the Actuals to date  field is updated, the progress value for the target and its goal are auto-
updated. For information on how the progress value is calculated, see progress value calculation. 
For information on how the progress value is calculated for a target that has target breakdowns, 
see Target breakdowns.

Related topics

Update the progress of a manual target

Update the actual value of a target breakdown

Target breakdowns

Breaking down a target into smaller periods (for example, Monthly) helps you set a target 
value for each month and focus on that specific monthly target. The target breakdowns are 
automatically created based on the Check-in frequency and Target value distribution set for the 
target.

The check-in frequency for a target can be set to Daily, Weekly, Monthly, Quarterly, or Yearly. 
Based on the Check-in frequency of the target, the corresponding target breakdowns are 
created. For example, if the Check-in frequency is set to Monthly for a target spanning for a year, 
12 monthly target breakdowns are created. Planned target values are automatically set for each 
target breakdown based on the Target value distribution setting of the target.

Note: 
The target breakdowns feature isn’t supported for qualitative targets.
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The following examples help you understand how the target progress is calculated for targets 
with different target distribution type.

Example 1: Acquire 1200 new customers in the calender year 2025 (Track non-
cumulatively)

In this example, you want to achieve a target of acquiring 1200 new customers in 
the calender year 2025 and track the progress monthly (non-cumulatively), then you 
can set the target as the following:

• Set the start date and end dates to 2025-01-01 and 2025-12-31, respectively

• Set the start value and final target values to 0 and 1200, respectively

• Set the Check-in frequency for the target to Monthly

• Set the Target value distribution to Split equally across the time period (non-
cumulative)

This Target value distribution means that the final target value is divided into 12 
equal values (planned target value for each target breakdown) which aggregates 
to the final target value. You can edit the planned target value later from the 
respective target breakdown record as needed.

In this case, the application creates 12 target breakdowns (January, February,
………, and December) for calender year 2025 and sets the Planned target value for 
each target breakdown to 100 (Final target value divided by the number of target 
breakdowns).

Because the application sums up the actual value entered in each monthly target 
breakdown, you must enter the actual value that is achieved in the particular month 
for the target breakdown. For example, you acquired 100 customers in January, 
then enter 100 as the actual value in the January target breakdown. And, you 
acquired another 100 customers in February, then enter 100 as the actual value in 
the February target breakdown. Similarly, if you acquired another 100 in March and 
100 in April, then enter 100 as the actual value in both the March and April target 
breakdowns.

The application sums up the actual values entered in each monthly target 
breakdown and rolls up the sum value to the actual value of the main target. Then, 
the progress of the target and its goal are auto-updated.

Example 2: Acquire 1200 new customers in the calender year 2025 (Track cumulatively)

In this example, you want to achieve a target of acquiring 1200 new customers in the 
calender year 2025 and track the progress monthly (cumulatively), then you can set 
the target as the following:

• Set the start date and end dates to 2025-01-01 and 2025-12-31, respectively

• Set the start value and final target values to 0 and 100, respectively

• Set the Check-in frequency for the target to Monthly

• Set the Target value distribution to Spread linearly across the time period 
(cumulative)

This Target value distribution means that the final target value is divided linearly 
into 12 planned target values (such a way that the value for the last monthly 
breakdown is equal to the final target value). You can edit the planned target value 
later from the respective target breakdown record as needed.
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In this case, the application creates 12 target breakdowns (January, February,………, 
and December) for calender year 2025 and sets the Planned target value for the 
January, February,………, and December breakdowns to 100, 200,…….., and 1200 
respectively.

Because the application considers only the actual value entered in the latest 
monthly target breakdown, you must enter the cumulative actual value in the latest 
monthly target breakdown. For example, you acquired 100 customers in January, 
then enter 100 as the actual value in the January target breakdown. And, you 
acquired another 100 customers in February, then enter 200 as the actual value 
in the February target breakdown. Similarly, if you acquired another 100 in March 
and 100 in April, then enter 300 and 400 as the actual value in the March and April 
target breakdowns, respectively.

The application considers the actual value entered in the latest monthly target 
breakdown and rolls up to the actual value of the main target. Then, the progress of 
the target and its goal are auto-updated.

Benefits of target breakdowns

The target breakdowns feature helps you when you want to set a target for a period but want to 
track the progress of the target in smaller periods such as daily, weekly, monthly, quarterly, and 
yearly. For example, you have set a target for a year with start value and final target values of 0 
and 1200, respectively. Also, you want to set monthly targets of 100 for each quarter. In this case, 
you can break down the target into monthly targets and set a target value for each month so that 
you can focus on the specific monthly target and update your actuals against those monthly 
targets.

The target breakdowns feature has the following benefits:

• Break down the long-term targets into short-term intervals such as Daily, Weekly, Monthly, 
Quarterly, and Yearly for a better tracking or reporting of your progress

• Set or modify a planned target value for each target breakdown as needed

• Update the actual value for each target breakdown and track the progress of the main target

• Focus on the specific short-term target (target breakdown) rather than the whole target

• Track the progress of your short-term and long-term targets cumulatively or non-cumulatively

How the actual value is calculated when the check-in frequency set to None

When the check-in frequency is set to None for a target, the actual value must be entered in 
the Actuals to date  field in the main target record. The actual value entered must be cumulative 
irrespective of the time period of the target. Target breakdowns aren’t created when the check-in 
frequency is set to None.

Target breakdowns in target automation

If you’ve enabled the target automation feature for a target and set the check-in frequency and 
Target value distribution, the target automation feature automatically updates the actual value 
in the respective target breakdown based on the check-in due date. After the actual value of 
a target breakdown is updated, the value is rolled up to rolls up to the actual value of the main 
target. Then, the progress of the target and its goal are auto-updated.

Update the actual value of a target breakdown

Update the actual value of a target breakdown when its status is changed. Updating the actual 
value of a target breakdown automatically updates the actual value of its target. After the Actual 
field of the target is updated, the progress value for the target and its goal is auto-updated.
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Before you begin
Role required: sn_gf.goal_user

About this task

Note: 
Only the owner or contributors of the goal can update the target breakdowns.

Procedure

1. Open the target record of the goal using one of the following options.

2. On the Target form, update the Actual  field and add a business justification in the Remark 
field.
For field information, see Target Breakdown form.

3. Select Update.

Result
After the Actual  field is updated, the progress value for the target and its goal is auto-updated. 
For information on how the progress value is calculated, see Progress value calculation. For 
information on how the actual value of the target breakdown is rolled up to its target, see Target 
breakdowns.

Related topics

Update the progress of a manual target

Update the progress of a target using Goal Framework for SPM

Associate a work or planning item with goals or targets

Create a goal or target relationship with a work, planning, strategic, or any other item to identify 
and associate your current or future work and achieve your goals and targets.

Before you begin
Role required: sn_gf.goal_user

About this task
You can associate a goal or target with only one of the work items (Project, Demand, Program, 
Scrum Feature, Scrum/SAFe Epic), or SAFe Feature, planning items (Project, Demand, or Epic), 
or strategic items (Program or Initiative) at a time. To associate more than one item with a goal or 
target, create one goal or target relationship record for each item.

• You can associate a goal or target with the Project, Demand, and Program work items only 
when PPM Standard  (Project Portfolio Management) is installed.

• You can associate a goal or target with the Scrum Feature and Scrum Epic work items only 
when Agile Development 2.0  is installed.

• You can associate a goal with the SAFe Epic and SAFe Feature work items only when Scaled 
Agile Framework (SAFe)  is installed.

• You can associate a goal or target with the planning items (Project, Demand, and Epic) and 
strategic items (Program and Initiative) only when Strategic Planning  is installed.
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Note: 

• Depending on the plugin that is installed - PPM  or Strategic Planning  - the respective 
related list appears on the Goal and Target form. If PPM is installed, the Project, Demand, 
and Program work item related lists appear on the Goal and Target form. If only Strategic 
Planning  is installed or both PPM and Strategic Planning  are installed, the Planning items 
and Other items related lists appear on the Goal and Target form respectively.

• When a goal or target relationship is created with a work item (Project, Demand, Program, 
Scrum Feature, Scrum/SAFe Epic, or SAFe Feature), the record appears on the respective 
related list on the Goal or Target form. When a goal or target relationship is created with 
a planning item (Project, Demand, or Epic), the record appears in the Planning items 
related list on the Goal or Target form. When a goal or target relationship is created with 
a strategic item (Program or Initiative) or any other item, the record appears in the Other 
items related list on the Goal or Target form respectively.

Procedure

1. Navigate to All  > Enterprise Goal Management  > Goals.

2. Open the required goal or target.

3. Create a goal or target relationship with a work or planning item using the following options.

4. Click Submit.

Associating the primary goal or target for work and planning items

You can associate a goal or target as the primary for the work and planning items where the items 
contribute to achieving the goal or target. You need different roles to set a goal or target as the 
primary for work and planning items.

You can associate a goal or target as primary to work and planning items by populating the 
Primary goal  and Primary target  fields on the Project, Demand, Program, Feature, Epic, and 
Planning item forms.

You can also associate non-primary goals or targets to work and planning items from the Goal/
Target Relationships related list on the Project, Demand, Program, Feature, Epic, and Planning 
item forms.

Once you associate work and planning items to goals or targets, you can check these 
relationships directly in the goal's or target's related list or in the respective work or planning 
item’s related list.

The following table describes how the primary goal or target can be set for each work and 
planning item.

Work / 
Planning item

Plugin 
required

Role required Steps to associate the primary goal

Project PPM 
Standard

project_manager 1. Open the required project.

2. On the form, enter the goal or target 
that you want to associate to the 
project in the Primary goal  and 
Primary target  fields respectively.
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Work / 
Planning item

Plugin 
required

Role required Steps to associate the primary goal

Demand PPM 
Standard

demand_manager 1. Open the required demand.

2. On the form, enter the goal or target 
that you want to associate to the 
demand in the Primary goal  and 
Primary target  fields respectively.

Program PPM 
Standard

program_manager 1. Open the required program.

2. On the form, enter the goal that you 
want to associate to the program 
in the Primary goal  and Primary 
target  fields respectively.

Feature Agile 
Development 
2.0

rm_feature_admin 1. Open the required feature.

2. On the form, enter the goal or target 
that you want to associate to the 
feature in the Primary goal  and 
Primary target  fields respectively.

SAFe Feature Scaled Agile 
Framework

safe_art_user or 
safe_admin

1. Open the required feature.

2. On the form, enter the goal or target 
that you want to associate to the 
feature in the Primary goal  and 
Primary target  fields respectively.

Scrum Epic Agile 
Development 
2.0

scrum_story_creator 1. Open the required epic.

2. On the form, enter the goal or 
target that you want to associate to 
the epic in the Primary goal  and 
Primary target  fields respectively.

SAFe Epic Scaled Agile 
Framework

safe_art_user 1. Open the required epic.

2. On the form, enter the goal or 
target that you want to associate to 
the epic in the Primary goal  and 
Primary target  fields respectively.

Planning 
item (Project, 
Demand, and 
Scrum/SAFe 
Epic)

Strategic 
Planning

sn_align_core.apw_user 1. Open the required planning item.

2. On the form, enter the goal or 
target that you want to associate to 
the planning item in the Primary 
goal  and Primary target  fields 
respectively.
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Goal Framework  and Goal Framework for SPM  reference
Reference information to provide additional details about Goal Framework  and Goal Framework 
for SPM  such as the fields, user roles, and tables.

Components installed with Goal Framework  and Goal Framework for SPM

Several types of components are installed with the installation of the Goal Framework  and 
Goal Framework for Strategic Portfolio Management (SPM)  applications, including user roles, 
scheduled jobs, tables, and scripts.

Roles installed

Role Description Contains roles

sn_gf.goal_user_read Can view the goals. This role can be 
given to users such as the project 
user and demand user.

None

sn_gf.goal_user • Can create, view, edit, and delete 
goals, sub-goals, and associated 
targets.

Note: 

◦ A goal or sub-goal can 
be deleted only by the 
owner and contributors of 
the goal or its immediate 
parent goal when the 
sn_gf.allow_goal_deletion 
system property is set to 
Yes.

◦ An associated target 
can be deleted only 
by the owner and 
contributors of the target 
or its goal when the 
sn_gf.allow_goal_deletion 
system property is set to 
Yes.

◦ A goal can be edited 
only by the owner and 
contributors of the goal or 
its immediate parent goal.

◦ A target can be edited 
only by the owner and 
contributors of the target 
or its goal.

• Can remove the existing 
goal relationships between 
work item and goal, from 

sn_gf.goal_user_read

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1116



Role Description Contains roles

the Goal Relationship 
[sn_gf_goal_m2m_relationship] 
table.

sn_gf.goal_admin • Create goals and targets.

• Edit goals and targets created by 
other users.

• Can update the goal preferences.

• Can create target sources and 
context variables as part of 
enabling the target automation 
feature.

Note: 
Creating target sources and 
context variables is available 
when Goal Framework for 
SPM  is installed.

• sn_gf.goal_user_read

• sn_gf.goal_user

sn_gf.strategy_planner_read Can view all strategic plans and 
strategic values.

None

sn_gf.strategy_planner Can create, view, edit, and delete 
strategic plans and strategic values.

Note: 

• A strategic plan can be 
edited only by the owner 
and sponsor of the strategic 
plan.

• A strategic value can be 
edited only by the sponsor 
of the strategic plan.

sn_gf.strategy_planner_read

sn_gf.epmo_strategy_planner Can create, view, edit, and delete 
any goal.

• sn_gf.goal_user_read

• sn_gf.goal_user

• sn_gf.goal_admin

• sn_gf.strategy_planner

Scheduled jobs installed

Goal Framework scheduled jobs

Scheduled job Description

Migrate Goal, 
Strategy, and Work 
item data to the 

Migrates the existing goals data to the Goal Framework  tables. For 
information on what data is migrated and how the data can be migrated, 
see goal data migration.
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Goal Framework scheduled jobs  (continued)

Scheduled job Description

Goal Framework and 
related Planning item 
tables

Migrate goal 
relationships for 
assigned entities

(For Strategic Planning  users) Populates the fields, Assigned entity 
type  and Assigned entity  on the Goal form  based on the data in the 
Goal Relationship [sn_gf_goal_m2m_relationship] table if you have 
created m2m relationship with lens entities other than Company, 
Business Unit, Department, and Portfolio.

Goal Framework for SPM  scheduled jobs

Scheduled job Description

Update Actual value of the targets using Goal 
Framework for SPM

Updates the actual value of the targets by 
collecting the data from the respective target 
sources, so that the progress of the targets 
is updated and then the targets' progress is 
rolled up to the goals.

Tables installed

Goal Framework tables

Display name [Table name] Description

Goal

[sn_gf_goal]

Stores the goal details.

Goal Core

[sn_gf_core_goal]

Stores the core (basic) details for the goal. The Goal 
[sn_gf_goal] table extends the Goal Core [sn_gf_core_goal] 
table.

Target

[sn_gf_goal_target]

Stores the target details for the goal.

Units

[sn_gf_units]

Stores the available units for measuring the progress of 
targets.

Target Progress

[sn_gf_goal_target_progress]

Stores the target progress details for the goal.

Goal Relationship

[sn_gf_goal_m2m_relationship]

Defines the relationship between a goal and items (Project, 
Demand, Program, Scrum Epic, Scrum Feature, and Planning 
item).

Strategic Plan

[sn_gf_strategic_plan]

Stores the strategic plans defined for each planning 
organization hierarchy.
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Goal Framework tables  (continued)

Display name [Table name] Description

Note: 
This table is visible only when Alignment Planner 
Workspace  (APW) is installed.

Strategic Priority

[sn_gf_strategy]

Stores the strategic priorities defined for the organization.

Strategy Value

[sn_gf_strategy_value]

Stores the strategic values for strategic plans.

Note: 
This table is visible only when APW  is installed.

Goal Framework for SPM  tables

Display name [Table name] Description

Context Variable

[sn_gfa_context_variable]

Stores the context variable details for the 
target source.

Target Breakdown

[sn_gfa_target_breakdown]

Stores the target breakdown details for 
the target that were created based on the 
breakdown intervals specified for the target.

Target Source

[sn_gfa_target_source]

Stores the target source configuration details 
for automating the actual value of the targets.

Custom scripts installed

Goal Framework for SPM  custom scripts

Name Description

Benefit 
Plans

A target 
source 
with 
predefined 
script.

Predefined script that updates the Actual value  field on the target form by fetching 
the required value from the Actual benefit  field or Non-monetary actual benefit 
field from the monetary or non-monetary benefit plan records. For the script 
template, see Target automation script for benefit plans.

Note: 
You can use the Benefit Plans custom script only when PPM Standard 
(Project Portfolio Management) is installed.
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System properties installed

Goal Framework  system properties

Name Description

glide.ui.sn_gf_goal_target_activity.field Option to enable activity stream for fields of the 
targets.

sn_gf.allow_goal_deletion Option to enable deletion of goals. The default value is 
true.

sn_gf.allow_target_deletion Option to enable deletion of targets. The default value 
is true.

sn_gf.goal_calendar_type Option to set calender type for setting goals. The 
available calendar types are Gregorian Calendar and 
Fiscal Period. The default value is Gregorian Calendar.

sn_gf.weighted_average_enabled Option to enable the weighted average logic to 
calculate the progress of goals from their subgoals and 
targets.

Goal Framework for SPM  system properties

Name Description

sn_gfa_disable_target_breakdown Option to enable the target breakdowns feature at the 
instance level. The default value is false.

sn_gfa.target_breakdown_decimals Option to define the number of decimals to show for 
target values while generating the target breakdowns. 
The default value is 2.

sn_gfa.weeklyCheckInDayToMapMonth Option to define end day of the week for weekly target 
breakdowns mapping to month. The default value is 
Friday.

Context Variable form

Use the Context Variable form to create a context variable for a target source for calculating the 
actual value of the target based on the configured input values.

Context Variable form

Field Description

Type Context variable type.

For information about the different field types, see Field types .

Application Name of the application scope.

Label Name of the label that the context variable type is created for.

Column name ID of the context variable for which the context variable type is created.

Choice List 
Specification

Option to display the context variables on the Target form in the Actual 
Value Source Configuration section.

Default value Default value to consider for updating the actual value of the target.
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Goal Assigned Entity Configuration form

Use the Goal Assigned Entity Configuration form to configure a table for an assigned entity type 
so that the goal user can associate goals with the required assigned entity.

Goal Assigned Entity Configuration form

Field Description

Assigned entity table Entity table that a goal is assigned to.

Application Name of the application scope.

Assigned entity field Reference field on the goal form.

Goal form

Use the Goal form to create goals for your organizational strategic priorities.

Note: 
For Operational Sustainability Workspace  and Strategic Planning  users, to view the 
other fields (that aren’t added to the default or your custom form view) on the form in the 
workspace, configure the default/custom form layout. For information on how to configure 
the form layout, see Configuring the form layout .

Goal form

Field Description

Name Name of the goal.

State State of the goal. The state can be Draft, In progress, Approved, Complete, 
Pending, Achieved, Not Achieved, or Cancelled.

Parent goal Name of the parent goal that this goal contributes to.

Strategic 
priority

Name of the strategic priority that this goal is created for.

Start date Start date for the goal. By default, the start date of the current quarter is 
populated. For a subgoal, start date of its parent goal is populated.

End date End date for the goal. By default, the end date of the current quarter is 
populated. For a subgoal, the end date of its parent goal is populated.

Owner Owner of the goal. By default, the name of the user creating the goal is 
populated.

Category Category of the goal. The available options are:

• Total Applications

• Total Cost

• Opex

• Capex

• Cloud Applications

• Homegrown Applications

• Support Cost

• Labor Cost
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Goal form  (continued)

Field Description

• Standards Compliance

• Strategic

• Operational

• Tactical

• Artificial Intelligence

Status Status of the goal. Status can be Red, Yellow, Green, or None.

Contributors Users who contribute to the achievement of the goal.

Team Assignment group responsible for different activities in achieving the goal.

Impact on 
parent goal

A numerical value that represents the importance of this goal relative to sibling 
goals or other goals under its parent goal. By default, the value is (1) Neutral.

The available options are:

• (0) No impact

• (1) Neutral

• (2) Moderate

• (3) High

• (4) Very high

• (5) Maximum

Note: 
This field is available only when the sn_gf.weighted_average_enabled 
system property is set to Yes.

Progress Percentage complete for the goal. The progress value is calculated 
automatically if the goal has sub-goals or/and targets.

For more information on how the progress value is calculated, see Progress 
value calculation.

Assigned 
entity type

Entity type to which the goal is assigned. For example, Business Unit, 
Department, Company, or Portfolio.

Assigned 
entity

Entity to which the goal is assigned.

Comments Detailed comments for the goal to facilitate collaboration.

Classification Goal classification type. The available options are Environmental, Social, and 
Governance. This field is applicable only for the Operational Sustainability 
Workspace  users.

Goal/Target Relationship form

Use the Goal/Target Relationship form to create a relationship between a goal and planning item, 
strategic item, or any other item.
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Note: 
If Goal Framework for SPM  is not installed, the form name appear as Goal Relationship.

Goal/Target Relationship form - Fields for planning and strategic item

Field Description

Planning item type Type of planning item.

Planning item Planning item with which a goal relationship is created with the goal.

Goal/Target Relationship form - Fields for planning and strategic item - Fields for an item 
(that is of entity type, Product Model)

Field Description

Table Name of the reference table.

Document 
ID

Document ID of the column from the selected reference table.

The suggested values in this field depend on the reference table selected in the 
Table  field.

Goal Preferences form

Use the Goal Preferences form to manage goals such as the calendar type used for goal setting, 
weighted average calculation for goal progress, and deletion of goals and targets.

Goal Preferences form

Property Description

Enable the weighted 
average logic to calculate 
the progress of goals 
from their sub-goals and 
targets.

When enabled, the fields, Impact on parent goal  andImpact 
on goal  appear in the Goal [sn_gf_goal] and Target 
[sn_gf_goal_target] tables respectively. The progress value of the 
parent goal is calculated by applying the Weighted Average logic.

The default value is Yes.

The progress value of a parent goal is calculated based on the 
progress value and the value defined in the Impact on parent goal 
andImpact on goal  fields for sub-goals and targets respectively.

For more information on how the progress value is calculated, see 
progress value calculation.

Allow deletion of goals. Can delete the goals.

The default value is Yes.

Allow deletion of targets. Can delete the targets.

The default value is Yes.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1123



Goal Preferences form  (continued)

Property Description

Note: 
When you delete a goal, its associated targets (if any) are 
also deleted even though the Allow the deletion of targets 
property is set to No.

Calendar type used for 
setting goals.

Calendar type that is used for setting goals. The available 
calendar types are Gregorian calendar and Fiscal period.

The default value is Gregorian calendar.

Disable target breakdowns 
at the instance level.

Can disable the target breakdowns feature. When the feature is 
enabled, target breakdowns are automatically created based on 
the breakdown interval set for the target.

The default value is false.

Progress value calculation

The progress or percentage complete value of goals is auto-calculated using different formulas. 
The formula depends on whether the goal has only targets, a combination of sub-goals and 
targets, and if it has weighted average calculation enabled.

Scenario Formula used to calculate the progress value of the goal

• The goal has targets.

• The goal doesn’t have sub-goals.

• The Impact on goal  field is 
defined for targets.

Progress value of the goal = Sum of 
progress values of its associated 
targets / number of targets

• The goal has sub-goals and 
targets.

• The Impact on parent goal 
and Impact on goal  fields are 
defined for sub-goals and targets 
respectively.

Progress value of the goal = Sum of 
progress values of its sub-goals and 
associated targets / number of sub-
goals and targets

• The goal has two targets (target 1 
and target 2).

• The goal doesn’t have sub-goals.

• The Impact on goal  field is 
defined for targets and the 
sn_gf.weighted_average_enabled 
system property is set to Yes.

Progress value of the goal = 
[(Progress of target 1 * Weight scale 
of target 1) + (Progress of target 2 
* Weight scale of target 2)] / (Weight 
scale of target 1 + Weight scale of 
target 2)
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Scenario Formula used to calculate the progress value of the goal

• The goal has two targets (target 1 
and target 2).

• The goal has two sub-goals (sub-
goal 1 and sub-goal 2).

• The Impact on parent goal 
and Impact on goal  fields are 
defined for sub-goals and 
targets respectively and the 
sn_gf.weighted_average_enabled 
system property is set to Yes.

Progress value of the goal = 
[(Progress of sub-goal 1 * Weight 
scale of sub-goal 1) + (Progress of 
sub-goal 2 * Weight scale of sub-
goal 2) + (Progress of target 1 * 
Weight scale of target 1) + (Progress 
of target 2 * Weight scale of target 
2)] / (Weight scale of sub-goal 1 + 
Weight scale of sub-goal 2 + Weight 
scale of target 1 + Weight scale of 
target 2)

Consider a scenario where a goal (G1) has two targets (T1 and T2) and the Impact on goal  field 
for T1 and T2 is set to 2 and 3 respectively. The current Progress values of T1 and T2 are 40% and 
20% respectively. In this case, the progress value for G1 is calculated as follows:

• Contribution of T1 towards G1 progress = 2/(2+3)*40 = 16%

• Contribution of T2 towards G1 progress = 3/(2+3)*20 = 12%

• Therefore, Progress of G1 = 16% +12% = 28%

Scheduled Script Execution form

Scheduled Jobs are automated pieces of work that can be performed at a specific time or on a 
recurring schedule.

Migrate Goal, Strategy, and Work item data to the Goal Framework and related 
Planning item tables

Use the Migrate Goal, Strategy, and Work item data to the Goal Framework and related 
Planning item tables  job to migrate the existing goals data to the Goal Framework  tables.

Scheduled Script Execution form

Parameter Description

migrateGoalData • Migrates all existing goal records from the Goal [goal] 
table to the Goal [sn_gf_goal] table. The sys_id remains 
the same. The corresponding target records will be 
created in the Target [sn_gf_goal_target] table.

• Creates the existing relationship between the goal and 
work items (Project, Demand, Program) in the Goal 
Relationship [sn_gf_goal_m2m_relationship] table 
with the first goal (from the order in the glide list) as the 
primary goal.

migrateStrategyData Migrates all existing strategy records from the Enterprise 
Strategy [enterprise_strategy], Business Unit Strategy 
[business_unit_strategy], and Strategic Objective 
[strategic_objective] tables to the Strategic Priority 
[sn_gf_strategy] table. The sys_id remains the same.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1125



Scheduled Script Execution form  (continued)

Parameter Description

migratingGoalStrategyM2Mdata In Goal Framework, a goal can be mapped to only one 
strategy. If an existing goal has two strategies mapped to it, a 
clone of the goal will be created (one as a generic goal and 
another as a sub-goal) with the same strategy populated for 
both. And, for the sub-goal, the first goal will be set as the 
parent goal.

For example, consider a scenario where an existing goal 
(G1) is mapped to five strategies (S1, S2, S3, S4, and S5). 
Then, four clones of G1 will be created as sub-goals (G2, G3, 
G4, and G5) and the parent goal is populated as G1. For the 
parent goal (G1) and the sub-goals (G2, G3, G4, and G5), the 
Strategy  field is populated respectively (S1, S2, S3, S4, and 
S5).

Note: 
The name of the cloned sub-goal will be prefixed with 
Cloned SubGoal:, followed by the parent goal 
name.

migrateStrategyWorkItemRelData • Migrates the existing relationship of strategy and work 
items (Project, Demand, Program) to the Goal Relationship 
[sn_gf_goal_m2m_relationship] table.

• If a goal doesn't have an association between the 
strategy (as current strategy) and the work item in the 
Goal Relationship [sn_gf_goal_m2m_relationship] table, 
a dummy goal will be created with a strategy value of 
current strategy. And, a goal relationship is created 
with the dummy goal and the work item in the Goal 
Relationship [sn_gf_goal_m2m_relationship] table.

Note: 
The name of the dummy goal will be prefixed with 
Goal:, followed by the strategy name.

Migrate goal relationships for assigned entities

Use the Migrate goal relationships for assigned entities  job to populate the fields, Assigned 
entity type  and Assigned entity  on the Goal form  based on the existing values in the legacy 
fields, Business Unit, Department, Company, Portfolio, and any customized entity field.

Scheduled Script Execution form

Parameter Description

Migrate goal 
relationships 
for assigned 
entities

(For Strategic Planning  users) Populates the fields, Assigned entity type  and 
Assigned entity  on the Goal form  based on the data in the Goal Relationship 
[sn_gf_goal_m2m_relationship] table if you've created an m2m relationship with 
lens entities other than Company, Business Unit, Department, and Portfolio.
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Scheduled Script Execution form  (continued)

Parameter Description

If users had already created m2m relationship, they may use this script to move 
those relationships from the m2m table to the goals table to access and manage 
those goals in the respective portfolio plans.

If the goal has only one relationship with an assign entity table type, the Assign 
entity type  and Assign entity  fields are populated on the Goal [sn_gf_goal] 
table based on the Goal Relationship [sn_gf_goal_m2m_relationship] table.

If the goal has multiple relationships with an assign entity table type, number of 
relationships (n) cloned sub-goals will be created and the Assign entity type 
and Assign entity  fields are populated on the Goal [sn_gf_goal] table based on 
the data in the Goal Relationship [sn_gf_goal_m2m_relationship] table for each 
cloned sub-goal.

Strategic Plan form

Use the Strategic Plan form to define the purpose of your organization, its strategic priorities, and 
the associated goals.

Strategic Plan form

Field Description

Name Name of the strategic plan.

Sponsor Sponsor for the strategic plan.

Start date Start date for the strategic plan.

End date End date for the strategic plan.

Description A detailed description of the strategic plan.

Vision A brief description about where your organization’s business will be at some point 
in the future, based on its strategies and associated goals.

Mission A brief description about what your organization’s objectives are and its approach 
to reach those objectives.

Related topics

Enterprise strategy example

Strategic Priority form

Use the Strategic Priority form to orient your organization strategic plan toward your goal.

Strategic Priority form

Field Description

Name Name of the strategic priority.

Parent Name of the parent strategic priority that this strategic priority contributes to.

Owner Owner of the strategic priority. By default, the name of the user creating the 
strategy is populated.
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Strategic Priority form  (continued)

Field Description

Start date Start date for the strategic priority.

End date End date for the strategic priority.

Type Strategic priority type categorizes the strategic priority by its nature and 
organizational intent. Classifying priorities by type helps your organization 
distinguish different focus areas within a strategic plan and align goals across 
different dimensions of your strategy.

The available options are:

• Key Initiative

• Shared Vision

• Strategic Target

• Operating Principle

• Relationship Strategy

• Environmental

• Social

• Governance

• Artificial Intelligence

Status Status of the strategic priority. Status can be Red, Yellow, Green, or None.

Strategic 
Plan

Name of the strategic plan for which this strategic priority is created.

Description A detailed description of the strategic priority.

You can refine strategic priority description using the Refine records skill, if the 
Now Assist for SPM  application is installed.

Related topics

Enterprise strategy example

Target automation script for benefit plans

Use the predefined Benefit Plans script as a target source to automate the actual value of your 
targets from the benefit plans of relevant work items.

Use the following predefined benefit plans script to configure the target source for your targets. 
The script fetches the required data for monetary or non-monetary benefit plans and updates 
the actual value for the target. You can use this script as is or you can also modify it according to 
your requirement. You can also create context variables and configure them for this target source 
(Benefit Plans).

result = '';
var benefitPlans = new 
 GlideRecord(sn_gfa.GFAdvancedConstants.BENEFIT_PLAN_TABLE);
benefitPlans.addQuery('sys_id', 'IN', benefit_plan);
benefitPlans.query();
 
var nonMonetaryBenefitSum = 0;
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var monetaryBenefitSum = 0;
var hasMonetary = false;
var hasNonMonetary = false;
while (benefitPlans.next() && !(hasMonetary && hasNonMonetary)) 
 {
    if (!gs.nil(benefitPlans.getValue('currency'))) {
        monetaryBenefitSum += 
 parseInt(benefitPlans.getValue('actual_benefit'));
        hasMonetary = true;
    } else {
        nonMonetaryBenefitSum += 
 parseInt(benefitPlans.getValue('nm_actual_benefit'));
        hasNonMonetary = true;
    }
}
 
if (hasMonetary && hasNonMonetary)
    gs.addErrorMessage(gs.getMessage('The Benefit Plan list can 
 contain either monetary or non-monetary benefit plans.'));
else
    result = hasMonetary ? monetaryBenefitSum : 
 nonMonetaryBenefitSum;

Target Breakdown form

Use the Target Breakdown form to track and measure the progress of the target and its goal.

The form is available when the Goal Framework for SPM  application is installed.

Target Breakdown form

Field Description

Breakdown 
period

Period of the target breakdown.

Parent 
breakdown

Year of the target breakdown.

Target Parent target of the target breakdown.

Status Status of the target breakdown. The status can be Red, Yellow, or Green.

Breakdown Breakdown interval specified in the parent target.

Planned target Target value for the target breakdown.

Actual Actual value for the target breakdown.

Remark Remark entered by the user for business justification when updating the 
actuals.

Target form

Use the Target form to track and measure the progress of the goals.

Some of the fields on the form is available when the Goal Framework for SPM  application is 
installed.
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Note: 
For Operational Sustainability Workspace  and Strategic Planning  users, to view the other 
fields that aren't added to the default view or your custom form view on the form in the 
workspace, configure the default or custom form layout. For information on how to configure 
the form layout, see Configuring the form layout .

Target form

Field Description

Name Name of the target.

Goal Name of the associated goal. This field is auto-populated when creating a target 
from the Targets related list on the Goal form.

Description Brief description of the target.

You can refine target description using the Refine records skill, if the Now Assist 
for SPM  application is installed.

State State of the target. The state can be Draft, In progress, Approved, Complete, 
Pending, Achieved, Not Achieved, or Cancelled.

Status Status of the target. The status can be Red, Yellow, or Green.

Progress Percentage of target execution that is complete. The value is calculated 
automatically.

If the Type  field is set to Maximize, the progress value is calculated using the 
following formula.

Progress = (Actual value - Base value) / (Target 
 value - Base value) x 100

If the Type  field is set to Minimize, the progress value is calculated using the 
following formula.

Progress = (Base value - Actual value) / (Base value 
 - Target value) x 100

For more information on how the progress value is calculated when weight scale 
is defined, see progress value calculation.

Impact on 
goal

A numerical value that represents the importance of the target relative to 
the other targets of the goal. If there are any sub-goals present, they are also 
considered for relative weights and consequent progress calculation. By default, 
the value is (1) Neutral.

The available options are:

• (0) No impact

• (1) Neutral

• (2) Moderate

• (3) High

• (4) Very high

• (5) Maximum
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Target form  (continued)

Field Description

Note: 
This field is available only when the sn_gf.weighted_average_enabled 
system property is set to Yes.

Assigned 
entity type

Entity type to which the target is assigned. For example, Business Unit, 
Department, Company, or Portfolio.

Assigned 
entity

Entity to which the target is assigned.

Owner Owner of the target. By default, the name of the user creating the target is 
populated.

Contributors Users who contribute to the achievement of the target. By default, the 
contributors of the associated goal are populated.

Duration section of the Target form

Field Description

Start date Start date for the target. By default, the start 
date of its associated goal is populated.

End date End date for the target. By default, the end 
date of its associated goal is populated.

Metrics section of the Target form

Field Description

Unit of measure Measure type for the specified value. Usage 
of the measure such as cost, time, and rate. 
The available measure types are stored in 
the Units [sn_gf_units] table. Unit of measure 
defines the type of the target as qualitative or 
quantitative. The available unit of measures for 
quantitative target are #, $, %, and Days. The 
available unit of measure for qualitative target 
is Yes/No.

Type Target type that signifies the direction of 
achievement.

• Maximize: The direction of the progress is 
toward the target value from the base value 
where the base value must be less than the 
target value.

• Minimize: The direction of the progress is 
toward the target value from the base value 
where the target value must be less than the 
base value.

• Milestone: Fixed type. Only the qualitative 
target values are allowed (that are set in 
the Unit of measure  field for the target) 
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Metrics section of the Target form  (continued)

Field Description

to capture the achievement of the target. 
The Milestone  option is applicable only for 
qualitative targets.

The Type  field becomes read-only with the 
value populated as Milestone  for qualitative 
targets (when the Unit of measure  field is set 
to a qualitative target value).

Start value Start value of the target. The start value can 
also be considered as the present or current 
value.

This field becomes read-only when a value 
is entered in the Actual value  field. Clear the 
Actual value  field to update a value in the 
Base value  field.

This field is available when the Type  field is set 
to Maximize  or Minimize.

Final target value Final target value of the target. The target 
value should be aspirational and should 
challenge the teams.

This field is available when the Type  field is set 
to Maximize  or Minimize.

Baseline reference Past achievement of the target to provide 
reference for future performance. This value is 
only for reference purpose and not considered 
for target progress calculation.

Actuals to date Actual value of the target at a given time.

This field is available when the Type  field is set 
to Maximize  or Minimize.

Check-in frequency Option to specify breakdown intervals for 
the target and how frequently the owner or 
contributor should update the actual value 
of the target. Breaking down the target into 
smaller periods helps you set a target for 
smaller periods and focus on the specific 
breakdown targets. The available options 
are Daily, Weekly, Monthly, Quarterly, and 
Yearly. Target breakdowns are automatically 
created when you set this field to any of the 
available options other than None. For more 
details on target breakdowns, see Target 
breakdowns in Strategic Planning.
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Metrics section of the Target form  (continued)

Field Description

Note: 
The target breakdowns feature isn’t 
supported for qualitative targets.

Target value distribution Option to specify the target to be calculated 
cumulatively or non-cumulatively. The 
available options are Split equally across the 
time period (non-cumulative)  and Spread 
linearly across the time period (cumulative).

This field is available only when the Check-in 
frequency  field is set to any of the available 
options other than None.

Remark Remark entered by the user for business 
justification when updating the actuals.

Check-in due date Due date that the owner or contributor of the 
target must update the actual value of the 
target to.

Confidential Option to restrict the access for this target 
record to the specific users populated in the 
Allowed groups  and Allowed users  fields.

This field is available when the ESG 
Management  application is installed and the 
sn_grc.enable_record_confidentiality 
property is enabled. This field is applicable 
only when the Classification  field in the 
goal form of the target is populated as 
Environmental, Social, or Governance. 
The required role to configure this field is 
sn_esg.reader.

Note: 
Irrespective of the target record set to 
confidential or not, the target progress 
value rolls up to its goal for calculating 
the progress value of the goal.

Allowed groups User groups who can access the target record. 
This field is applicable only for the Operational 
Sustainability Workspace  users.

Even though a user group is populated 
in this field, the users can access the 
confidential record only if the user group has 
the sn_esg.reader role.

This field is available when the Confidential 
field is set to true.
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Metrics section of the Target form  (continued)

Field Description

Allowed users Users who can access the target record. This 
field is applicable only for the Operational 
Sustainability Workspace  users.

Even though a user name is populated in this 
field, the user can access the confidential 
record only if the user has the sn_esg.reader 
role.

This field is available when the Confidential 
field is set to true.

Comments Detailed comments for the target to facilitate 
collaboration.

Target Automation section of the Target form

Field Description

Automate actual value Option to enable the target automation feature 
for the target.

Actual value source Target source table that the data is fetched 
from to auto-update the actual value of the 
target on the target's review due date.

This field is available when the Automate 
actual value  field is set to true.

Variables section of the Target form

This section appears based on the context variables available in the target source that is 
selected in the Actual value source  field.

When you select Actual value source as Benefit Plans (predefined target automation script for 
benefit plans), the Benefit Plan  field appears in this section, from which you can select the 
required benefit plans for automating the actual value of the target.

Note: 
You can use the Benefit Plans custom script only when PPM Standard (Project Portfolio 
Management) is installed. If you can't find the benefit plan that you want to select, you can 
find and select the same from Heisenberg UI by navigate to Enterprise Goal Management 
> Targets  and opening the Target form.

Target Source form

Use the Target Source form to create and configure a source for your targets so that the actual 
value of the target is auto-updated.
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Target Source form

Field Description

Name Name of the target source.

Active Option to activate this target source for use.

Type Type of target source. Available options:

• Assessment/Survey

• PA Indicator

• Custom script

Advanced Enables the Custom script  option for the target source type Assessment/
Survey  with the pre-defined script.

This field is available when the Type  field is set to Assessment/Survey.

Assessment 
metric type

Assessment metric type for the target source.

Tip: 
A context variable is automatically created for the target source if the field 
is populated with a metric type of Evaluation method = Assessment.

This field is available when the Type  field is set to Assessment/Survey.

Assessment 
metric 
category

Assessment metric category for the assessment metric type.

This field is available when the Type  field is set to Assessment/Survey.

Description Brief description of the target source.

PA Indicator PA Indicator for the target source.

This field is available when the Type  field is set to PA Indicator.

Breakdown Breakdown for the PA Indicator.

This field is available when the Type  field is set to PA Indicator.

Custom script Custom script to fetch the required data from any ServiceNow AI Platform  table 
for the target source.

This field is available when the Type  field is set to Custom. Or, when the Type 
field is set to Assessment/Survey  and the Advanced  field is set to true.

Domain separation and Goal Framework

Domain separation is supported for Goal Framework  and Goal Framework for SPM. Domain 
separation enables you to separate data, processes, and administrative tasks into logical 
groupings called domains. You can control several aspects of this separation, including which 
users can see and access data.

Support level: Basic
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• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

How domain separation works in Goal Framework  and Goal Framework for SPM

After you enable domain separation on your ServiceNow  instance, the Goal Framework  and 
Goal Framework for SPM  data is automatically domain separated. The goals and targets data of 
portfolio plans for different domains are visible to only those users who have access to these 
domains.

Data Separation
The ServiceNow®  Data Separation  application helps organizations restrict access to sensitive 
data based on a lens hierarchy and its leaf node.

Note: 
This application is no longer deployed, enhanced, or supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

Alternatively, you can use Data Filters and access control lists (ACLs) to configure data 
separation for your use cases. For details on how to enable data separation for different use 
cases using data filters and ACLs, see the Managing data separation using data filters and 
ACLs [KB0558290]  article in the Now Support Knowledge Base.

Data separation supports records, related items, planning consoles, workbenches, and reports.

Note: 
Currently, data separation is supported only for ServiceNow®  Project Portfolio 
Management.

Alternatively, you can define data filters along with other configurations to restrict access to 
sensitive data (enable data separation). For details on how to enable data separation for different 
use cases using data filters and ACLs, see the Managing data separation using data filters and 
ACLs [KB1772519]  article in the Now SupportKnowledge Base.
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Get started

Explore

Learn about Data 
Separation features.

Configure

Learn how to configure 
Data Separation
for restricting the 

sensitive data.

Reference

Get details about 
components like 

fields, tables, roles, 
and properties.

Supported tables

See the list of tables 
that are supported 

for Data Separation.

Limitations

See the limitations 
of Data Separation.

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community.

• Search the Known Error Portal for known error articles. For more information, see Search the 
Known Error Portal for known error articles .

• Contact Customer Service and Support. For more information, see Contact Customer Service 
and Support.

Exploring Data Separation
Learn about the features, configuration, and benefits that Data Separation  provides.

Data Separation  overview

Data Separation  helps you restrict data in ServiceNow®  Strategic Portfolio Management  based 
on a lens hierarchy and its leaf node. The leaf node is the bottom-level entity in a lens hierarchy. 
For example, if the Organization lens is used for data separation, the leaf node would be 
Department for the base system lens.

You can enable Data Separation  on select Demand, Project, Resource Plan, and Cost Plan 
entities, as needed. Also, you can enable Data Separation  on select Cost Plan Breakdown and 
Project Task related entities.

Data Separation  supports records, related items, planning consoles, workbenches, and reports.
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Note: 
Access control list (ACL) and query Business Rule (BR) limitations apply even when Data 
Separation  is enabled. For example, reports with aggregate numbers may not be data 
separated.

Data Separation  applies even on child projects and sub-tasks based on the Data Separation  that 
is configured for the parent project or task.

Data Separation  key components

• Hierarchy: Defines the hierarchy for enabling Data Separation  using a lens and its leaf node.

• Supported Entities: Enables Data Separation  on select entities and related entities, as needed.

• Entity-Group Mapping: Defines entity-group mappings between a business area and user 
group.

Features

You can use the Data Separation  features to do the following:

• Configure a data separation hierarchy using a lens hierarchy and its leaf node.

• Enable data separation on select entities and related entities, as needed.

• Create as many entity group mappings as required to restrict data to specified user groups.

• Grant access for the users who always need access to sensitive data by assigning the data 
separation privileged user (sn_ds.ds_privileged_user) role.

How Data Separation  works

The following is the process flow for restricting access to the sensitive data in Strategic Portfolio 
Management  using Data Separation.

• A lens is selected for defining a hierarchy for Data Separation. The Data Separation  admin can 
modify the hierarchy of the lens for data separation as needed.

• The required entities and related entities are enabled for Data Separation.

• An entity group mapping is created for each business group (where the business group could 
be a business unit, department, or company) that defines the set of users that the access is 
restricted to.

• The data of the business group is then restricted for the enabled entities only to the users that 
are part of the user group populated in the entity-group mapping record.

Examples data separation

Example 1

Consider a scenario where:

• The Data Separation  hierarchy is defined using the Organization lens and the lens 
structure is Company, Business Unit, and Department (from top-to-bottom).

• The entity mapping is created for the HR department (Department : HR) with the 
group HR leads.

• Data Separation  is enabled for the Demand and Project entities.

In this case, no user can access the project and demand records of the HR 
department except the users that are part of the HR leads group. However, all users 
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(based on the ACLs that the user currently has) can access other records (for 
example, the resource plan and cost plan) of the HR department.

Example 2

The Company XYZ has a data separation-enabled lens structure as shown 
in the following image and wants to restrict data to specific groups based 
on different use cases. Also, all the supported entities are enabled for 
Data Separation. The following use cases help you understand how Data 
Separation  works and how to configure Data Separation  for different use 

cases.

• Case 1: Restrict data of the Payroll department to the Payroll managers

You can restrict data for this case by configuring Data Separation  as follows:

◦ Create a Payroll managers user group.

◦ Create an entity-group mapping for the Payroll department with the lens entity 
record (Department : Payroll) and the Payroll managers user group.

• Case 2: Restrict data of the HR business unit (both the Onboarding and L&D 
departments) to the HR leads

You can restrict data for this case by configuring Data Separation  as follows:

◦ Create an HR leads user group.

◦ Create an entity-group mapping for the HR business unit with the lens entity 
record (Business Unit : HR) and the HR leads user group.

• Case 3: Restrict data of the entire organization to the Organization leads

You can restrict data for this case by configuring Data Separation  as follows:

◦ Create an Organization leads user group.

◦ Create an entity-group mapping for the Company XYZ with the lens entity 
record (Company : XYZ) and the Organization leads user group.

Configuring Data Separation
As an administrator, you can install Data Separation  and assign the Data Separation  roles to the 
required users.
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Configuration workflow

A Data Separation  administrator can define Data Separation  hierarchy, enable entities, and map 
user groups for Data Separation.

Guided setup to configure Data Separation

Guided setup provides a sequence of tasks to help you with the required configuration on your 
ServiceNow  instances. After installing Data Separation, navigate to All  > Data Separation  > 
Guided Setup  to configure Data Separation.

Install Data Separation

You can install the Data Separation  application (sn_ds) if you have the admin role.

Before you begin

• Confirm that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Data Separation  requires the following plugin and store application. Ensure that the following 
plugin and application is activated before you install Data Separation.

Required ServiceNow  plugin

PPM Standard plugin (com.snc.financial_planning_pmo)

Activate the PPM Standard plugin (com.snc.financial_planning_pmo) 
in your ServiceNow  instance before you install Data Separation. 
For more information see, Activate PPM Standard (Project Portfolio 
Management).

Required ServiceNow Store  application

Portfolio Planning (sn_align_ws)

Install the Portfolio Planning (sn_align_ws) application in your 
ServiceNow  instance before you install Data Separation. For more 
information see, Install Portfolio Planning.

Role required: admin

About this task
The following items are installed with Data Separation:

• Plugins

• Roles

• Tables

For more information, see Components installed with Data Separation.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Data Separation  application (sn_ds) using the filter criteria and search bar.

You can search for the application by its name or ID. If you can’t find the application, you might 
have to request it from the ServiceNow Store.
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Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they’ll be installed, are currently installed, or 
need to be installed. If any plugins or applications need to be installed, you must install them 
before you can install Data Separation.

4. Select Install.

Assign roles for managing Data Separation

Assign Data Separation  roles to user groups and to individual users based on user activities and 
responsibilities.

Before you begin
Role required: admin

About this task
You can assign roles to individual users or groups. Applying roles to a group gives access to all 
the members of the group. For more information on roles installed with Data Separation, see the 
Roles installed table in Components installed with Data Separation.

Procedure

1. Navigate to All  > Data Separation  > Guided Setup.

2. Select Get Started.

3. Select Assign roles  from the tasks list.

4. Select the required role (sn_ds.ds_admin or sn_ds.ds_privileged_user), select Configure, and 
assign the role to a user or user group.

What to do next
Configure a data separation hierarchy for enabling Data Separation. For more information, see 
Configure a lens for enabling Data Separation.

Configure a lens for enabling Data Separation

Configure a data separation hierarchy for enabling Data Separation  using a lens hierarchy and its 
leaf node.

Before you begin
Role required: sn_ds.ds_admin

About this task

Note: 
Only one lens can be enabled for Data Separation  at a time.

Procedure

1. Navigate to All  > Data Separation  > Hierarchy.
The Lenses list view opens with the available lenses for data separation.

2. Open the lens record that you want to use as a hierarchy for configuring Data Separation.
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3. On the Lens form, select Data separation enabled.
For a description of the field values, see Lens form.

4. Select Update  to save the configuration.

5. Navigate to All  > Data Separation  > Hierarchy.

6. From the Lenses list view, select Sync data separation  to synchronize the lens configuration 
for Data Separation.

What to do next
Enable Data Separation  on select entities as needed. For more information, see Enable entities 
for Data Separation.

Enable entities for Data Separation

Enable Data Separation  on select entities as needed.

Before you begin
Role required: sn_ds.ds_admin

About this task
You can enable Data Separation  on the following entities and related entities.

• Entities:

◦ Demand [dmn_demand]

◦ Project [pm_project]

◦ Resource Plan [resource_plan]

◦ Cost Plan [cost_plan]

• Related entities:

◦ Cost Plan Breakdown [cost_plan_breakdown]

◦ Project Task [pm_project_task]

Procedure

1. Navigate to All  > Data Separation  > Supported Entities.
The list opens the entities supported for Data Separation.

2. Open each Supported Entity record that you want to enable Data Separation  for.

3. On the form, fill in the fields.

Supported Entity form

Field Description

Entity Name of the entity table.

Enable data separation Option to enable Data Separation  for the 
entity.

4. Select Update  to save the configuration.

5. Navigate to All  > Data Separation  > Supported Entities.
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6. From the Supported Entities list view, select Sync data separation  to synchronize the entity 
configuration for Data Separation.

Note: 
The related Cost Plan Breakdown and Project Task entities can be enabled only if the 
Cost Plan and Project parent entities are enabled respectively.

What to do next
Map a user group for Data Separation. For more information, see Map a user group for Data 
Separation.

Map a user group for Data Separation

Map a user group for Data Separation  to restrict data only to the specified users of a group and 
sub-groups.

Before you begin
Role required: sn_ds.ds_admin

About this task
You can create only one entity-group mapping per lens entity record.

For example, the following image shows that the leaf node is a Department and that IT is one 
of the departments. You want to restrict the data of the IT department to a specific group. Then, 
create an entity-group mapping for the IT department with the required user group.

If you want to grant access to the data of the IT department for more than one group, create a 
parent user group and add all the other groups as sub-groups under the parent group. Then you 
can map the parent group in the entity-group mapping record of the IT department.

Note: 
If you want to grant access to the data of all departments for a user group, create an entity-
group mapping with the parent entity of the department entity. Alternatively, you can also 
create one entity-group mapping per department for the user group.

Procedure

1. Navigate to All  > Data Separation  > Entity-Group Mappings.

2. Select New.

3. On the Enity-Group Mapping form, fill in the fields.
For a description of the field values, see Entity Group Mapping form.

4. Select Submit  to save the record.
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5. Navigate to All  > Data Separation  > Entity-Group Mappings.

6. From the Entity-Group Mappings list view, select Sync data separation  to synchronize the 
entity-group mappings for Data Separation.

Result
The data is restricted to the user group populated in the entity-group mapping record for the 
enabled entities.

Synchronize Data Separation

Synchronize Data Separation  when the configuration is changed in the lens, supported entities, 
or entity-group mappings tables.

Before you begin
Role required: sn_ds.ds_admin

About this task
The Is data synced  field value must be true  for all records of the Data Separation  configuration 
(lens, entities, entity-group mappings) to restrict the data according to the Data Separation 
configuration. If the Is data synced  field value for any part of the configuration record is false, the 
data separation isn’t synchronized.

The Is data synced  field value is false  only when any of the configurations for Data Separation 
are changed.

Procedure

Perform the following steps to synchronize data separation depending on the type of 
configuration change made in Data Separation.

For this configuration change Perform these steps

• Data Separation  is turned off on the existing 
lens and then enabled again on the same 
lens

• Data separation is turned off on the existing 
lens and then enabled again on another 
lens

a. Navigate to All  > Data Separation  > 
Hierarchy.

b. From the Lenses list view, select Sync 
data separation  to synchronize the lens 
configuration for Data Separation.

Data Separation  is enabled or turned off for an 
entity

a. Navigate to All  > Data Separation  > 
Supported Entities.

b. From the Supported Entities list view, select 
Sync data separation  to synchronize the 
entity configuration for Data Separation.
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For this configuration change Perform these steps

A group is added, removed, or updated for an 
entity-group mapping record

a. Navigate to All  > Data Separation  > Entity-
Group Mappings.

b. From the Entity-Group Mappings list 
view, select Sync data separation  to 
synchronize the entity-group mappings for 
Data Separation.

Data Separation  reference
Reference information to provide additional details about Data Separation  such as the fields, 
user roles, tables, guidelines, and Data Separation  information.

Components installed with Data Separation

Several types of components are installed with activation of the Data Separation  plugin, 
including user roles and tables.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role Description Contains roles

sn_ds.ds_admin Can create/update/delete records in 
the tables required to configure the 
Data Separation  feature.

sn_align_core.ap_read_only

sn_ds.ds_privileged_user Can create/update/delete records 
of any business function in Strategic 
Portfolio Management, even when 
Data Separation  is enabled.

None

Tables installed

Display name [Table name] Description

Supported Entity

[sn_ds_data_separation_config]

Stores the entity details (Demand, Project, Resource Plan, 
Cost Plan, Cost Plan Breakdown, and Project Task) for 
enabling Data Separation.

Entity-Group Mapping

[sn_ds_entity_group_mapping]

Stores the lens entity and user group details for Data 
Separation.

Data Separation  limitations

There are some types of data that Data Separation  doesn’t work for even when Data Separation 
is enabled.
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The Data Separation  limitations are as follows:

• Data Separation  supports only Project Portfolio Management  and a subset of the Project 
Portfolio Management  tables.

• Access control list (ACL) and query business rules (BR) apply even when Data Separation  is 
enabled. For example, reports with aggregate numbers may not be data separated.

• Data Separation  may have performance impacts to some extent.

Entity Group Mapping form

Learn about the fields of the Entity Group Mapping form. Use this form to define an entity group 
mapping that enables Data Separation  for the selected entity group and user group.

Entity-Group Mapping form

Field Description

Lens entity table Name of the lens entity table. For example, 
Business Unit, Department, or Company.

Active Indicates if the entity-group mapping is active.

Lens entity record Brief description of the lens.

Entity group on which Data Separation  is 
enabled.

Group User group that the data of the selected entity 
is restricted to.

Lens form

Learn about the fields of the Lens form. Use this form to enable data separation based on the 
lens hierarchy and its leaf node.

Lens form

Field Description

Name Name of the lens.

Active Indicates if the lens is active.

Description Brief description of the lens.

You can indicate the business purpose of this 
lens and the planning managers that would 
use this lens.

Planning items Type of work that can be planned using this 
lens.

Move the desired planning item types from the 
Available list to the Selected list.

Bottom entity on planning item Bottom entity in the lens hierarchy.

Data separation enabled Option to enable data separation using the 
lens hierarchy.
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Supported tables for Data Separation

Several types of tables are supported for Data Separation, including direct and indirect related 
tables for each entity.

You can enable data separation on the following entities and related entities.

• Entities:

◦ Demand [dmn_demand]

◦ Project [pm_project]

◦ Resource Plan [resource_plan]

◦ Cost Plan [cost_plan]

• Related entities:

◦ Cost Plan Breakdown [cost_plan_breakdown]

◦ Project Task [pm_project_task]

Domain separation and Data Separation

Domain separation is supported for Data Separation. Domain separation enables you to separate 
data, processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Project Portfolio Management
ServiceNow®  Project Portfolio Management  (PPM) provides a simplified, team-oriented 
approach to managing projects, portfolios, their resources and financials by combining several 
individual applications.

Customers who already have Project Portfolio Management can upgrade to PPM Standard. New 
customers must purchase PPM Standard.
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Get started

Innovation Management Demand Management Project Management

Resource Management Portfolio Management Program Management

Timecard Management PPM Analytics 
and Reporting

PPM reference

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Explore Project Portfolio Management
Learn more about Project Portfolio Management  (PPM) with a sample workflow and review the 
benefits it can provide for different users in your organization.

Project Portfolio Management  overview

PPM is a collection of multiple applications that help you analyze and approve ideas and 
demands, convert them to projects and manage them through completion. You can manage 
resources and financials of individual projects or the ones that are rolled up to a program or 
portfolio. PPM enables your teams to plan and execute work in traditional waterfall methodology 
or combine an Agile approach to execute using a hybrid methodology.

Project Portfolio Management  workflow
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Project execution in a Waterfall, Agile, or Hybrid approach using PPM

The project manager (project_manager role) includes all the manager roles for the applications 
included in the PPM suite.

Project Portfolio Management  benefits

Benefit Feature Users

Gather and evaluate of ideas and promote 
accepted ideas to demand, story, epic, or 
project.

Innovation 
Management

Project Teams, 
Demand Manager

Assessing, approve, and promote demands to 
strategic and operational demands.

Demand Management Demand Manager

Manage projects, tasks, and resources. Project Management Project Manager, 
Project Team

Manage programs, the projects under a 
program and its tasks.

Program Management Program Manager

Manage your projects and programs of 
different portfolios.

Portfolio Management Portfolio Manager

Create resource plans and request resources. Resource 
Management classic

Resource Manager

Track time on a daily basis against tasks Time Card 
Management

Gain visibility into the status and health of 
programs, projects, and demands.

Project Portfolio 
Management Platform 
Analytics Solutions

Project, Program, or 
Portfolio Manager or 
Business stakeholder

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1149



Integration with Digital Portfolio Management

Digital Portfolio Management  (DPM) provides a unified workspace for owners to view and 
collectively manage their services and applications through the full life cycle. Installing DPM  and 
Project Portfolio Management  enables the integration with Project Management  and Demand 
Management. With this integration, DPM  managers can view project data that may impact a 
business application and create demands on a business application in DPM.

For more information, see Exploring Digital Portfolio Management .

Domain separation

Domain separation provides complete data isolation for domain-specific users. Project Portfolio 
Management supports domain separation with a few limitations. For more information, see 
Domain separation and Project Portfolio Management.

PPM Standard (Project Portfolio Management)

The ServiceNow®  PPM Standard, earlier known as Project Portfolio Suite with Financials, 
application integrates Financial Management and Project Portfolio Management.

PPM Standard automatically activates Financial Management if it is not already active.

The integration enables project and portfolio managers to perform the following activities:

• Determine overall cost requirements for all demands and projects in portfolios

• Establish resource requirements and track costs for demands and projects

• Track actual amounts spent compared to an approved budget

Upgrades and new customers

Customers who already have Project Portfolio Suite with Financials can upgrade to PPM 
Standard. New customers must purchase PPM Standard.

PPM Standard applications

The PPM Standard plugin installs Financial Management and Project Portfolio Suite. The 
following diagram illustrates the applications that are available.
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Applications installed with PPM Standard

PPM Standard additions

PPM Standard adds the portfolio workbench, that you can use to perform all aspects of financial 
planning. You can also perform financial planning and budgeting using UI actions on related lists.

Get started with project management

PPM Standard provides comprehensive capabilities for project planning and execution. Use the 
following topics to get started:

• Project creation and planning:  Create projects, define work breakdown structures, set 
milestones, and plan timelines. See the Project Management documentation.

• Resource management:  Allocate resources to projects, manage capacity, and track utilization. 
See Resource Management Workspace.

• Financial planning:  Create cost plans, track budgets, and manage investment funding.

• Portfolio management:  Prioritize demands, manage portfolios, and track portfolio 
performance. See Portfolio Management.

• Installed components:  Review the roles, tables, and configurations installed with PPM 
Standard. See Roles installed with PPM Standard.

Related topics

Portfolio Management

Project Portfolio Management

Activate Investment Funding  for projects and demands

Activate the Investment Funding (com.snc.investment_funding) plugin if you have the admin role. 
This plugin includes demo data and activates related plugins if they are not already active.
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Before you begin
Ensure that the PPM Standard (com.snc.financial_planning_pmo) plugin is installed.

Role required: admin

About this task
The Investment Funding (com.snc.investment_funding) plugin enables you to request or allocate 
funds for your projects and demands.

The plugin activates the related plugins if they are not already active. It also adds the 
sn_invst_pln_investment_user role to the following roles:

• project_manager

• demand_manager

• portfolio_manager

• program_manager

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

Install Investment Funding

List of plugins (Zurich)

Currencies and budget reference rates

The support for use of multiple currencies provides conversions for budget items in different 
currencies.

Currency support

The application can use a base currency, also called the reporting currency that you specify with 
system properties . You can also specify other currencies for budgets and budget items.

Currency usage

Item Currency used

Budget 
plan

A currency that you specify on the Budget Plan form. When the plan is converted to 
a forecast, the application converts the currency to the reporting currency.
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Currency usage  (continued)

Item Currency used

Budget 
plan 
items

A currency that you specify on the Budget Item form.

If the budget plan item has currency different from the budget plan currency, the 
budget plan item amount is converted to the budget plan currency.

Budget 
forecast

The reporting currency.

Budget reference rates

Budget reference rates are exchange rates between currencies. Each reference rate is valid for 
a specified time period. The application uses budget reference rates when budget items are in 
a different currency from the budget plan and forecast. The application automatically converts 
budget item currency values to a global system currency value when it calculates the Budget 
Amount on a Budget Plan, and when it shows values on budget forecasts.

Note: 
Currency support is for budgets only. You cannot create allocations in multiple currencies.

Test Management 2.0 integration with Project Portfolio Management

Test Management 2.0  integration with Project Portfolio Management  enables you to carry out 
testing activities on projects.

After activating both the Test Management 2.0  and Project Portfolio Management  applications, 
you can:

• Add a test phase to a project.

• Assign a test execution suite to the test phase.

• View the tests associated with the test execution suite.

• Assign tests to testers.

• Perform tests and record results.

• Track the progress using the Percentage complete  field in the timeline.

As testers perform tests and record results, the information is updated to the test, test phase, 
and then to the project.

Note: 
If you're an existing user, the integration between Project Portfolio Management  and Test 
Management 1.0  continues to work the same. You can still create test phases, associate test 
phases to a test plan, and perform testing activities.

Agile Development 2.0 integration with Project Portfolio Management

Project Portfolio Management  leverages the Agile Development 2.0  application to combine the 
Scrum methodology with project-based IT development.

IT organizations typically work on multiple projects with shorter time schedules. The project 
planning and tracking is done using waterfall, but the group prefers scrum methodologies to 
carry out their work. It then becomes a challenge to track project status when there is an agile 
development phase. This integration between Agile Development 2.0  with Project Portfolio 
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Management  facilitates a combination of waterfall and agile methods for project management 
and development.

The flow described below is applicable when Agile Development 2.0  is activated along with 
Project Portfolio Management.

• Create a group to represent a Scrum team.

• Add members to the group.

• Create sprints.

• Assign groups to projects from the Project Workbench.

• Maintain group and project backlogs. Multiple projects can be under development and groups 
can be assigned to multiple projects. Each project and each group has its own backlog. The 
project backlog includes all stories related to a project. The group backlog includes stories 
from multiple projects that have been assigned to the group.

• Perform group sprint planning. The group refines the combined backlog, ranks the stories and 
assigns points, and adds stories to sprints based on priority.

• Create stories, including one-off stories that are not related to projects.

• Track progress in stories, phases, and projects.

Create and manage agile projects

An overview of the tasks involved in creating an agile project.

The following tables, arranged by task group, list the tasks involved in creating an agile project.

Set up a development group

Task How do I do this?

Define an Agile 
group

Navigate to Agile Development  > Create Agile Group  and click New.

Add group 
members

Navigate to the Group members  related list on the Group form and click 
Edit.

Decide the 
capacity of a group

Navigate to Agile Development  > Groups, select the desired group, and 
enter a number in the Group capacity (points)  field.

Create sprints

Task How do I do this?

Create a 
sprint

Use the Create Sprints  related link on the Group form to create multiple sprints 
or use the Sprints  related list to create individual sprints.

View the 
created 
sprints

Use the Sprints  related list on the Group form.
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Create a new project

Task How do I do this?

Create a project • Navigate to Project  > Projects  > Create New.

• Navigate to Project  > Projects  > Project Workspace  and click New 
Project.

Open an existing project

Task How do I do this?

Open an 
existing project

• Click the Project Workspace  related link on the Project form.

• Navigate to Project  > Projects  > Project Workspace  and select the project 
from the Select Projects  choice list in the workspace header.

Add phases to a project from the project workbench

Task How do I do this?

Create an agile 
phase for a project

Click the Add phase icon ( ) and select Agile  from the Phase Type 
choice list.

Note: 
This option appears only when both the Project Portfolio 
Management  and Agile Development 2.0  applications are installed.

Create a test 
phase for a project

Click the Add phase icon ( ) and select Test  from the Phase Type 
choice list.

Note: 
This option appears only when both the Project Portfolio 
Management  and Test Management 2.0  applications are installed.

Add details to a project phase from the project workbench

Task How do I do this?

View phase 
details in list 
view or VTB

Click the List  or VTB  button in the project workbench header.

Assign a group 
to an agile 
phase

Edit the Agile phase and select a group in the Group  field.

Select sprints 
for an agile 
phase

Edit the Agile phase, ensure that a group has been assigned, and select a 
Start Sprint  and End Sprint.
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Add details to a project phase from the project workbench  (continued)

Task How do I do this?

Create stories 
for an agile 
phase

Click the Agile phase in the project workbench and click New  in the detail 
view header.

Refine stories 
for one project

Click the Manage Stories  button to open the Manage Stories dialog box.

Note: 
You can also use the Agile Planning & Tracking  related link on the 
Project form  to view your backlog, assign stories to the projects, or 
create new stories for the project.

Refine stories 
across multiple 
projects

Click the Manage Stories  related link on Group form.

Assign a group 
to an agile 
phase

Click the Agile phase edit icon and select the group from the Group  choice 
list.

Add milestones to a project from the project workbench

Task How do I do this?

Add milestones to a 
project

Click the Add phase icon ( ) and then click Milestone  at the top of the 
Add Phase pop-up window.

Plan sprints

Task How do I do this?

Start sprint 
planning

Navigate to Agile Development  > Groups, open the desired group, and click 
the Sprint Planning  related link.

Add stories to 
the sprint

Navigate to Agile Development  > Groups, open the desired group, click the 
Sprint Planning  related link, and click Create story.

Testing process ( Only when Test Management 1.0  is activated)

Task How do I do this?

Create a test plan Navigate to Test Management  > Test Execution  > Test Plans  > 
New.

Add test cases to a test 
plan

Click the Add Test Cases from Test Suite  related link on the Test 
Plan form.

Assign test cases to 
testers

Select a user in the Assigned to  field on the Test Case form.

Notify testers to start 
testing

Click the Notify testers  to start testing related link on the Test Plan 
form.

Tester performs tests and 
submits results

Navigate to Self-Service  > My Tests  or Self-Service  > My 
Assessments.
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Testing process ( Only when Test Management 1.0  is activated)  (continued)

Task How do I do this?

Monitor the testing 
progress

The Test Plans list, Test Plan form, and Test Case form all display 
results for test cases and individual tests.

Testing sign-off Click the Sign-off Test Plan  related link on Test Plan form.

Testing process (Only when Test Management 2.0  is activated)

Task How do I do this?

Create a test 
execution suite

Navigate to Test Management 2.0  > Test Execution Suites, and click 
New.

Add tests to a test 
execution suite

Open a test execution suite, and click Add tests. From the Tests  list, 
select the required tests and click Add to Execution Suite.

Assign tests to testers Open a test execution suite. In the Test execution assignments  related 
list, assign tests to testers.

Note: 
Only the tests in the Ready state can be assigned.

Tester performs tests 
and submits results

Navigate to Test Management 2.0  > Tests Assigned to me. Select the 
required tests and click Run.

Define an Agile group

Create an agile assignment group to later assign the work of an agile project.

Before you begin
Role required: admin

About this task
Assignment groups in Agile Development 2.0

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Click New.

3. On the form, fill in the fields:

Group form

Field Description

Name Enter the name of the group.

Manager Select the manager of the group.

Group capacity 
(points)

Enter the projected capacity of the group in story points for each 
sprint.

Group email Email address of the group.

Description A brief description of the group.
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Related links of the Group form

Field Description

Create Sprints Access the Create Sprints for Team  dialog 
box. Fill in the fields and then click OK  to 
create multiple sprints for the current group. 
The new sprints are added to the Sprints 
related list.

Sprint Planning Access the Sprint Planning  tab on the Agile 
Board.

Group Velocity Access a chart which shows how the story 
points in a project are allotted across sprints.

4. Click Submit.

Add group members

Add members to the group who are later assigned tasks of an agile project.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Open the desired group.

3. Click New  in the Group Members  related list.

4. Add the name of the group member in the Name  field.

5. Select a Scrum Role  for the group member.

6. Click Submit.

Decide the capacity of a group

Decide the capacity of a group based on the historical velocity of the group for each sprint.

Before you begin
Role required: scrum_master

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Open the desired group.

3. Decide the group capacity in points and enter the number in the Group capacity (points)  field.

4. Click Update.

Convert a release team to an agile group

Convert a release team to an agile group to later assign the work of an agile project.

Before you begin
Role required: project_manager
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About this task
This section is applicable only if you have upgraded from Agile Development 1.0 to Agile 
Development 2.0.

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Click the Convert Release Teams to Groups  related link.

3. Select the team that you want to convert to an agile group.

4. Click Convert to Group.

Create a sprint

Create a sprint to plan the work for an agile phase of a project.

Before you begin
Role required: none.

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Open the desired group.

3. Click New  in the Sprints related list.

4. Fill in the following fields on the Sprint form:

◦ Short description: Name or a brief description of the sprint

◦ Planned start date: Start date for this sprint

◦ Planned end date: End date for this sprint

◦ Group capacity (points): Projected capacity of the group in story points

5. Click Submit.

Create multiple sprints

Create multiple sprints to plan the work for an assignment group.

Before you begin
Role required: none.

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Open the desired team.

3. Click the Create Sprints  related link to open the Create Sprints for Team dialog box.

4. In the Sprint form, fill in the fields:

◦ Name: the name of the sprint.

◦ Starting Number: the number of the first sprint to be created.

◦ Start date: the start date for the first sprint to be created.

◦ Duration: the number of days in a sprint.

◦ Number of sprints: the number of sprints to be created.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1159



5. Click OK.
The new sprints are added to the Sprints  related list on the Team form.

Assign a group to a project

Assign a group to a project so that the group later works on the tasks of the assigned project.

Before you begin
Role required: it_project_manager

Procedure

1. NavNavigate to All  > Project  > Projects  > All.

2. Select your project to open its form.

3. From the Assignment group  field, select a group to assign this project.
If you don't see the group that you need, work with your admin to create it. See Define an Agile 
group.

4. Save the project form.

Add stories to a project

Create stories and associate them to a project or add existing stories to your project.

Before you begin
Role required: it_project_manager

About this task

• The stories list displays current active stories. You can create a story from this list or view the 
story form for a current story. You can also add scrum tasks from the story form and view the 
story and task progress boards.

• Stories can be associated to projects, but is not mandatory. While creating a story, if a project 
has only one phase then the story automatically gets tagged to the only phase.

• One-off stories can be created without a link to a product or a project. One-off stories are 
created with only a short description, and can be assigned to a group.S

• Stories can be added to only those projects that have the Execution type  field set to Hybrid  or 
Agile.

Procedure

1. Navigate to All  > Projects.

2. Open a project that you want to add stories.

3. From the Stories related list, select one of the following:

◦ Add Existing  to add existing stories to this project.

◦ New  to create a story and add it to this project.

For information on the form fields, see the descriptions in Story form.

4. Save the project form.
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What to do next

• Create scrum tasks for this story. See Create a scrum task for Agile Development 2.0 stories.

• Use the related links and lists of the story for more actions that you can perform. See Related 
links and lists for a Story in Agile Development 2.0.

• Add dependencies for Agile Development 2.0 stories

• You can create a story with the same details as this story by using the Insert  or Insert and Stay 
options from the story additional actions ( ).

When you use Insert and Stay, the form of the newly created story stays open. You can modify 
the details of the story or create more stories with these details. On the Agile board, the 
new story is positioned right below the original story. The global rank of the new story is set 
accordingly.

Note: 
Set the glide.ui.task.insert  and glide.ui.advance  properties to true  to 
access these actions. These actions are not allowed on stories added from the triage 
board.

Plan sprints

Streamline your sprint planning and completion activities using the Sprint Planning  tab.

Before you begin
Role required: scrum_admin, scrum_master, or scrum_sprint_planner

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Open the desired group.

3. Click the Plan Sprints  related link.
The Agile Board, Sprint Planning  tab appears.

4. Use either of options to view all the active stories assigned to the team, but not assigned to any 
sprint in the Backlog section.

Note: 

◦ If the backlog contains more than 50 stories, then pagination control appears at the 
bottom of the list enabling you to navigate to the previous, next, first, or last pages in 
the list.

◦ Rearranging stories in the backlog changes the ranking of stories. Ranks are stored in 
the global_rank column in the Story [rm_story] table. When you move a story within a 
backlog, its rank changes relative to the stories within the same backlog. Thus, if the 
story exists in some other backlog, its ranking might change but position in the backlog 
would remain the same.

5. To start a sprint, click Start  that appears at right-corner of the first or top sprint.
TheSprint Tracking  tab appears.

6. To complete a sprint, click Complete Sprint  that appears at right-corner of the first or top 
sprint.
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a. Move incomplete stories, if any, to the backlog or a future sprint.

b. Click Complete.
The sprint disappears from the Sprint Planning  tab and appears in the Sprint list as 
complete.

Track progress

Track the progress of an agile phase from the Project Workbench timeline.

Before you begin
Role required: none

About this task
Stories are assigned to a project and are tied to an agile development phase in the Project 
Workbench. As stories are completed, the story points and the story status get rolled up to the 
sprint and project phase. In turn, the phase gets rolled up to the project.

Procedure

1. Navigate to the Project Workbench timeline.

2. The color in the phase bar increases to show progress and the Percentage complete  field is 
updated.

Activate PPM Standard (Project Portfolio Management)
Activate the PPM Standard plugin (com.snc.financial_planning_pmo) if you have the admin role. 
This plugin installs the Project Portfolio Management  applications.

Before you begin
Role required: admin

About this task
The PPM Standard is the basic plugin for the PPM (Project Portfolio Management) applications.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .
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Result
All PPM applications are installed in your ServiceNow  instance, along with their user roles and 
tables. For more information, see Components installed with Project Portfolio Management 
(PPM) Standard.

Innovation Management
The Innovation Management  enables you to gather and evaluate ideas efficiently, and to quickly 
identify and process the ideas with the greatest potential for implementation.

Get started

Explore Configure Use

Integrate Reference

The Idea Portal accelerates and organizes idea gathering, evaluation, selection, and execution. 
The idea manager or demand manager evaluates submitted ideas and promotes accepted ideas 
to demands, epics, features, or stories.

Exploring Innovation Management

The Innovation Management  application is a central repository to gather and evaluate ideas to 
determine which ideas are most likely to be implemented.

Innovation Management  overview

The process of innovation management includes managing an organization's innovation 
from the initial ideation phase to the final implementation. It includes the decisions, activities, 
and practices involved in devising and implementing an innovation strategy. The Innovation 
Management  application enables you to submit, track, view, discuss, filter, and vote on ideas.

Innovation Management  workflow

The image explains the idea workflow from submitting the idea to completing it.
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Idea workflow

Innovation Management  benefits

Innovation Management  benefits

Benefit Feature Users

Collect new ideas for a product, 
feature in Idea Portal to vote on.

Submit an idea Users with access to 
the application.

View, filter, and organize ideas to 
work upon.

View, filter, and sort ideas Users with access to 
the application.

Collaborate through interactive 
comment boards to exchange 
information about ideas in a central 
location.

Collaborate on ideas idea_manager

Create a task to plan and develop an 
accepted idea.

Create a task for an idea idea_manager or 
idea_manager_professional

Create an Idea module to store and 
group ideas.

Create an Idea module idea_admin

Create new idea categories to 
associate with a submitted idea.

Define new idea categories idea_admin

Use the Idea Dashboard manager to 
analyze and review your ideas.

Analyzing idea metrics using 
Idea Manager dashboard

idea_manager or 
idea_manager_professional

Create an idea from a universal 
request and manage your ideas.

Create an Idea from Universal 
Request

idea_admin
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Innovation Management  benefits  (continued)

Benefit Feature Users

Transfer an idea to another 
department if the idea is rejected or 
can't be implemented.

Transfer an Idea to another 
department

Agent to whom the 
idea is assigned or is 
a part of the assigned 
work group.

What to explore next

To learn more about configuring and using Innovation Management, see:

• Configuring Innovation Management

• Managing ideas using Innovation Management

• Managing Idea Portal

• Analyzing idea metrics using Idea Manager dashboard

• Integrating Innovation Management with Universal Request

• Innovation Management reference

Predictive Intelligence  for Innovation Management

The Predictive Intelligence  for Innovation Management  capability uses machine-learning 
algorithms to search and display similar ideas while submitting a new idea.

The PPM Predictive Intelligence Workbench includes a prebuilt use case template that 
systematically guides you through the process of creating and training new predictive models, 
evaluating and testing them, and finally adding them to your business process to add value to 
your Idea, Demand, and Project Management.

Once you train your custom use cases, they are usable immediately. No prior knowledge or 
experience with artificial intelligence or machine learning is required when you use the PPM 
Predictive Intelligence Workbench.

The application includes templates with prebuilt guidance to assist you in creating, training, 
evaluating, testing, and producing your unique predictive models.

Predictive Intelligence  for Innovation Management  has the following benefits:

• Improves the quality of your idea database by avoiding duplicate ideas.

• Suggests related ideas to help you identify similar ideas and merge duplicate ideas.

Activation information

Activate the following plugins before using the Predictive Intelligence Workbench:

• Predictive Intelligence for PPM (com.snc.ppm_ml) plugin

• Predictive Intelligence for Ideation (com.snc.innovation_management_ml) plugin

Solution definitions for Predictive Intelligence  for Innovation Management

The solution definitions for Predictive Intelligence  for Innovation Management  capability are 
available in the Predictive Intelligence for Ideation plugin (com.snc.innovation_management_ml). 
For more information about Predictive Intelligence, see Predictive Intelligence .
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Solution Definition for Innovation Management

Solution Definition Solution Type Description

Similar Ideas

Note: 
This solution definition is 
available as a template 
on instances where the 
following plugins are 
active:

• Predictive Intelligence

• PPM Standard 
(com.snc.financial_planning_pmo)

• Predictive Intelligence 
for Ideation 
(com.snc.innovation_management_ml)

Similarity Suggests related ideas based 
on the Title  and Description 
fields. You can see the results 
in the following places:

• The Related Ideas section 
on the Create an Idea form 
when creating an idea in the 
Idea Portal.

• The Related Ideas section 
on the Ideas page in the 
Idea Portal.

Related topics

Predictive Intelligence

Train the similarity solution for Innovation Management to find similar ideas

Submit an idea using the supplier catalog

Configuring Innovation Management

Configure Innovation Management  application to analyze, track, and promote ideas to a task, 
demand, or project. This application is available with Strategic Portfolio Management.

Install Idea Manager dashboard

You can install the Idea Manager dashboard application from ServiceNow Store  if you have the 
admin role. This application includes demo data and installs the related plugins if they are not 
already installed.

Before you begin
Note: 
Starting with version 2.0.0, the Idea Manager dashboard is available in the Next experience 
UI Framework which can be accessed from Analytics Idea Manager.

• Ensure that the application and all of its associated store applications have valid ServiceNow 
entitlements. For more information, see Get entitlement for a ServiceNow  product or 
application .

• If the application requires plugins or other store applications, install them first if they are not 
already installed. For the Idea Manager dashboard application, the following plugins are 
required:

◦ PPM Standard plugin (com.snc.financial_planning_pmo)

For information on activation steps, see Activate PPM Standard (Project Portfolio 
Management).

Role required: admin
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find an application, you may 
have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are the sample records that describe application features for common use cases. 
Load the demo data when you first install the application on a development or test instance.

6. Select Install.

Result
You can access the Idea Manager dashboard by navigating to Ideas  > Idea Manager Dashboard.

What to do next
Run the following Performance Analytics data collector jobs before using the Idea Manager 
dashboard.

• [PA PPM IMD] Historic Data Collection: Collects historical data related to ideas 
and runs on demand to update data for dashboard.

• [PA PPM IMD] Daily Data Collection: Collects data for daily indicators and runs 
daily to update data for dashboard.

Related topics

List of plugins (Zurich)

Configure idea categories

Map an idea category table with an Idea module to specify the category options listed on the 
Idea Portal and the create an idea form.

Before you begin

• Role required: idea_admin

• Identify the Idea module and idea category table that you want to use.

About this task
Configuring idea category with the Idea module is required to fetch the list of categories in the 
Idea Portal. If you have created static categories, use the Idea Category [im_category] table to 
configure the mapping between the idea module and idea category table.
Use your existing product or department table to define dynamic idea categories. The dynamic 
categories are derived from specific columns and fields of the parent table.
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Note: 
You can map only one category table with an Idea module.

Procedure

1. Navigate to All  > Ideas  > Idea Category Config  > New.

2. On the form, fill in the fields.
For more information, see Idea Category Configuration form.

3. Optional:  Create filter conditions to determine the idea categories to be listed on the Idea 
Portal.

4. Select Submit.

Configure idea categories for transferring a request as an Idea

Configure idea states to use when directly transferring an HR case, incident, or a custom task 
from your department as an idea.

Before you begin
Role required: admin

About this task
When an idea is created in the Idea Portal, it must be associated with at least one or multiple 
categories. Create mapping between your department-specific primary ticket and idea category 
to be used when a service ticket is transferred as an idea to another department.

Procedure

1. Navigate to All  > Universal Request  > Administration  > Direct Transfer Configuration.

2. Follow the steps as described in Direct transfer mapping .

3. Select Submit.

Migrating from the legacy Ideas application to Idea Portal

If you are upgrading to the Zurich  release, complete the migration tasks after the upgrade to start 
using the new Idea Portal.

Review the following information and make any necessary changes to your configuration:

Idea States

The new Idea Portal provides new idea states such as Completed, Under Review, and In Backlog, 
which are mapped with your existing idea states. The following tables provide a comparison to 
the existing idea states and the equivalent new states with their values.

Legacy Ideas application

Idea State Value

Draft -5

Submitted 1

NA NA

NA NA

Accepted 2
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Legacy Ideas application  (continued)

Idea State Value

NA NA

NA NA

Closed complete 3

Closed skipped 7

NA NA

NA NA

Idea Portal

Idea State Value

Draft -5

Submitted 1

Under Review -1

Need more information -2

In Backlog 2

Planned 4

In Development 5

Completed 3

Unlikely to Implement 7

Duplicate 8

Already Exists 9

Starting with the Zurich  release, idea states are stored in and retrieved from the Idea 
[im_idea_core] table. You can continue to use your existing idea states along with the new idea 
states. However, if you want to use only these new states for managing your ideas, navigate to 
the Choice [sys_choice] table and delete the old idea states.

Idea categories

Organize your ideas using categories, for example, to group ideas that are relevant to a particular 
product, department, or business unit. If your existing ideas are not associated with any category, 
create new categories  or select an existing table to define categories  to which you can map 
your ideas. The Ideas application also installs a set of default new categories to which you can 
associate your existing ideas.

If your ideas are already associated with categories and you want to use the new categories, you 
can map your existing idea categories to the default new categories. You then write and use a 
script to create m2m mapping between existing ideas and categories.

Note: 
You must map an existing idea with appropriate categories for your ideas to appear in the 
Idea Portal.
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Converting ideas to demands or project, stories, initiatives, and epics

You can convert an idea into work entities other than demands. The Create Task  button enables 
you to convert an idea into a project, epic, or story as well as a demand becomes available in the 
Idea form.

You must have the required Agile plugins Agile Development 2.0  and Scaled Agile Framework 
(SAFe)  and Continual Improvement Management installed to view these options.

If you want to allow conversion of ideas only to a demand, disable the Create Task  button and 
continue using the Accept  button or disable the Accept  and Defer  buttons to use other options. 
For more information see, Using the form designer .

Business rules

Review the existing business rules in the idea table. Set the business rules that you don't want to 
apply as False.

Navigation for legacy Idea application

To encourage your users to submit ideas through the new Idea Portal, remove navigation for old 
Idea application from the application menu and deactivate the Submit an Idea option from the 
Service Catalog. For more information see, Enable or disable an application menu or module .

Managing ideas using Innovation Management

Use the features and capabilities of Innovation Management  to capture, analyze, and 
manage your ideas. As an idea manager, manage submitted ideas by reviewing them, making 
modifications, or deleting outdated ones, identifying duplicates, and updating and tracking their 
state.

Related topics

Innovation Management reference

Submit an idea

Submit an idea for a product, feature, enhancement, or change in the Idea Portal for others to 
vote on. Select categories relevant to the idea and, if useful, attach files to add details.

Before you begin
Role required: None

About this task
The Idea Portal is where you share your product, feature, change, or enhancement ideas. 
Submit your ideas, view, and subscribe to the ideas of other users, and track the progress of a 
subscribed idea. For more information, see View, filter, and sort ideas  and Collaborate on ideas. 
New ideas are created in the Submitted  state. You can edit your submitted idea in the Idea Portal 
after it has been submitted until the state is changed to Completed.

Procedure

1. Navigate to All  > Ideas  > Idea Portal  > Create an Idea.

2. On the form, fill in the fields.
For more information on fields and description, see Create an Idea form.

3. Optional:  If you have attachments related to the idea, select Add attachments  and attach 
them.

4. Select Create.
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What to do next

• View, filter, and sort ideas

• Collaborate on ideas

• Manage ideas

• Evaluate an idea

• Create a task for an idea

View, filter, and sort ideas

View ideas submitted by you or all submitted ideas. Filter and sort the ideas based on idea state, 
category, or date.

Before you begin
Role required: None

About this task
You can view the following information for an idea:

• Title

• Number of votes

• Name of the submitter

• Age

• Current state

• Category to which the idea belongs.

Procedure

1. Navigate to All  > Ideas  > Idea Portal.

2. Perform the following tasks on My Ideas and All Ideas tab.

My Ideas and All Ideas tab

Task Steps

View your own submitted ideas. Navigate to Idea Portal  > My Ideas.

View all submitted ideas. Navigate to Idea Portal  > All Ideas.

View details of an idea. Select the title of the idea.

Filter the ideas based on the idea state. Select a state from the State list.

Filter the ideas based on idea categories. Select a category from the Category list.

Sort the ideas based on the most recent 
ideas, the number of votes, or the date of 
creation.

Select an option from the Sort by list.

Collaborate on ideas

Use the comment option to discuss ideas and exchange information about ideas. Up-vote or 
down-vote an idea to register your level of interest and support for an idea. Subscribe to an idea 
to track its progress.

Before you begin
Role required: None
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About this task
You cannot comment and vote for ideas that are in the Completed, Unlikely to implement, 
Duplicate, or Already exists  state.

Procedure

1. Navigate to All  > Ideas  > Idea Portal.

2. Select the title of an idea to view its details.

3. Review the idea details and then choose which action to perform on the idea.
For more information on actions and steps, see Collaborate on idea.

Manage ideas

As an idea manager, manage submitted ideas by reviewing them, making modifications, or 
deleting outdated ones, identifying duplicates, and updating and tracking their state.

Before you begin
Role required: idea_manager

About this task
The idea manager reviews submitted ideas and, if necessary, requests more information, and 
then chooses to accept or reject the idea. The number of votes on an idea helps in assessing the 
popularity and demand for the idea. Change the state of the idea to reflect its status. Changing 
the state helps in notifying the idea submitter and subscribers about the progress of the idea.

Note: 
The idea submitter and all the subscribers receive a notification email whenever there is a 
change in the state of an idea. A notification email is also sent whenever a user comments 
on an idea or replies to a comment.

Procedure

1. Navigate to All  > Ideas  > Idea Portal.

2. Select the title of an idea to view its details.

3. Select the more options icon ( ), and then select the Open in platform  option to open the 
idea in the form view.

4. Review the idea details and then choose which action to perform on the idea.
For more information on actions and steps, see Manage ideas.

5. Select Update.

What to do next
Convert selected ideas into tasks such as demand, project, stories, and epics.

Evaluate an idea

Review submitted ideas and then accept or reject them.

Before you begin
Role required: idea_manager

About this task
As an idea manager, evaluate an idea and then decide whether to accept or reject an idea. If an 
idea cannot be implemented right away, move the idea to the backlog and pick it up later.
Accept the ideas that are feasible for implementation and create a task such as a demand, 
project, or story from it. Plan and work on these tasks to develop an idea into a new feature, 
product, or enhancement.
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Procedure

1. Navigate to All  > Ideas  > Idea Portal.

2. Select the title of an idea to view its details.

3. Open the idea in form view by selecting the more options ( ) icon, and selecting the Open in 
platform  option.

4. Review the idea details and then choose which action to perform on the idea.
For more information, see Evaluate ideas.

5. Select Update.
Convert the accepted ideas to a demand, epic, story, or feature based on how you would like 
to execute your idea. Use relevant options such as Epic, SAFe epic, or Improvement initiative 
based on the plugins installed such as PPM Standard, Agile Development 2.0  and Scaled Agile 
Framework (SAFe). After creating a demand or a project, change the state of the idea to track 
its status during different stages of development.

Create a task for an idea

Create a task for planning and developing an accepted idea.

Before you begin
Role required: idea_manager or idea_manager_professional

About this task
Create a task such as a demand, project, story, SAFe epic, SAFe feature, or SAFe story for an 
accepted idea. Plan and work on these tasks to develop an idea into a new feature, product, or 
enhancement.

Procedure

1. Navigate to All  > Ideas  > Idea Portal.

2. Select the title of an idea that you want to create a task for.

3. Open the idea in form view by clicking the more options ( ) icon, and selecting the Open in 
platform  option.

4. Select an appropriate state for the idea from the State list based on the priority of the idea.
For more information about different idea states, see Manage ideas.

5. Select Create Task.

6. In the Convert Idea to task  dialog box, select a task type from the Select task type list.
The available task types are:

◦ Demand

◦ Project

◦ Epic

◦ Story

◦ SAFe epic

◦ SAFe feature

◦ SAFe story
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These task options are based on the installed plugins such as PPM Standard, Agile 
Development 2.0, and Scaled Agile Framework (SAFe).

Note: 
You must also have the appropriate role based on the plugins to create these task types.

Train the similarity solution for Innovation Management  to find similar ideas

Train the Similar Ideas solution definition included within the Predictive Intelligence for Ideation 
capability to find related ideas when submitting an idea or viewing ideas in the Idea Portal.

Before you begin
Ensure that the Predictive Intelligence plugin (com.glide.platform_ml), PPM Standard 
plugin (com.snc.financial_planning_pmo), and Predictive Intelligence for Ideation plugin 
(com.snc.innovation_management_ml) are activated. For more information about Predictive 
Intelligence, see Predictive Intelligence .

Role required: admin

Procedure

1. Navigate to All  > Predictive Intelligence  > Similarity  > Solution Definitions.

2. In the Similarity Definitions list, search for and select the Similar Ideas solution definition 
(ml_sn_global_similar_ideas).

3. On the Similarity Definition form, verify the default field values for ideas.
For more information about the Similarity Definition form fields, see Create and train a similarity 
solution .

4. Click Update & Retrain.

5. Open the Similarity Definition form for the Similar Ideas solution definition 
(ml_sn_global_similar_ideas).

6. In the ML Solutions related list, view the training solution progress in the Progress  column.

Note: 
Alternatively, you can click the link for the solution in the Active  column. On the ML 
Solution form, click the Show training progress  related link to check the training solution 
progress.

Result
When the solution is complete, the similar ideas appear in the Related Ideas section on the 
Create an Idea form and Related Ideas section on the Ideas page in the Idea Portal.

What to do next

• Review similarity examples: On the Similarity Definition form, in the ML Solutions related list, 
when Progress  is 100%, in the Active  column, click the link for the solution. On the ML Solution 
form, click the Similarity Examples  related link to view the Similarity Examples list.

• Update the similarity score threshold: On the ML Solution form, on the Solution Statistics  tab, 
enter the required value in the Similarity Score Threshold  field. Right-click the ML Solution 
form and click Save.

• Test the prediction output for the records: On the ML Solution form, on the Test solution  tab, 
enter your text in the Short description  field and the maximum number of expected results in 
the Top N  field, and then click Run test. The results above the similarity score threshold value 
are displayed.
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Related topics

Predictive Intelligence

Predictive Intelligence for Innovation Management

Submit an idea

Managing Idea Portal

The Idea Portal is your central location to collect, curate, and promote ideas into demand, 
project, epic, or story. It enables integration of key feedback and requests into your product 
planning and development process.

The Idea Portal enables you to do the following:

• View, submit, vote, and subscribe to ideas.

• Collaborate using comments to discuss and exchange information on ideas.

• Users who submit, comment, or subscribe to an idea receive a notification for any state 
change, comment, or reply to that idea keeping them informed about its status and progress.

• View the details of an idea and ask or answer questions and exchange information about 
an idea using comments. Comments maintain a trail of discussion and help to identify key 
contributors for an idea or reasons for its success and failure.

Idea and demand managers use the Idea Portal to do the following:

• Manage submitted ideas.

• Review and evaluate the submitted ideas and select the ideas that meet their requirements.

• Assess the popularity and demand of an idea from the number of votes.

The selected ideas are converted into tasks for planning and then developed into a new product, 
feature, or enhancement.

Maintain separate data storage and control access

You can use the Idea module to do the following:

• Store ideas and categories belonging to different departments, products, or business units 
separately.

• Store and organize ideas, enable voting, and, if your organization is large, you can configure 
different portal pages with unique sets of categories, for example, for HR, IT, and Support.

• Control access, allowing only the users of a specific business unit or department to submit and 
view ideas belonging to a specific category through the Idea Portal by creating access-control 
lists in the table that you want to use for categories. For example, if you do not want users 
outside the Payroll department to view the ideas associated with the category Salary, create 
ACLs with read access, at least, to the employees of Payroll department in the parent table 
that is used to derive the category Salary. The ACLs restrict the employees outside the Payroll 
department from viewing the ideas associated with the category Salary. For more information, 
see Create an Idea module.

Note: 
Innovation Management  supports basic level of domain separation. For more information 
about domain separation, see Application support for domain separation  and Domain 
separation and Project Portfolio Management.
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Idea Portal administration

Idea Portal enables end users to view, submit, filter, sort, comment, and vote on ideas. Idea 
managers use the Idea Portal to review, evaluate, collaborate on, and manage ideas. An idea 
admin configures an Idea module, maps idea categories to the Idea module, and adds navigation 
for the Idea Portal page.

The Managing Idea Portal  retrieves data from the Idea module, therefore, you must configure an 
Idea module first. Consider configuring separate Idea modules for your product, department, or 
business unit. Review, plan, and identify the following items before configuring an Idea Portal:

• Idea table

• Idea module

• Idea categories

• Navigation to the Idea Portal page

Complete the following tasks to set up and configure an Idea Portal for your product, department, 
or business unit:

Idea Portal navigation

Configure the Idea Portal URL to enable access to the Idea Portal from the application navigator.

Before you begin
Role required: idea_admin

About this task
Enable access to the Idea Portal module using the Application Menus module.

Procedure

1. Open the Ideas  application menu record and add the Idea Portal to the navigation menu.
For information about how to add Idea Portal to the navigation menu, see Create a module .

2. In the Module form, set the value of the Link type  field as URL (from arguments).

Use the Module Id as a parameter in the URL to specify the Idea module that you want to 
associate with the Idea Portal.

For example, if you created an Idea module for your HR department and used hr  as 
the Module Id, the URL to access the Idea Portal would be as follows: /idea/?
id=ideas_list&sysparm_module_id=hr.

Create an Idea module

An Idea module defines the ideas and categories that are displayed in the Idea Portal. Create an 
Idea module to store and group ideas, and define categories based on product, department, or 
business unit.

Before you begin

• Identify an idea table to store your ideas. Use an existing table or create a new table to extend 
the Idea [im_idea_core] table.

Use a different idea table for each Idea module. Separate idea tables ensure that ideas for 
different modules are stored separately.

• Role required: idea_admin
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Procedure

1. Navigate to All  > Ideas  > Settings  > Idea Module  > New.

2. On the form, fill in the fields.
For more information on fields and description, see Idea module form.

3. Select Submit.

What to do next
Define new idea categories or use an existing table to derive the categories from specified 
columns and map it with your idea module. For more information, see Configure idea categories.

Define new idea categories

Create new idea categories that a user can select to associate with a submitted idea. You can 
also add custom idea categories.

Before you begin
Role required: idea_admin

About this task
The default Idea Category [im_category] table stores the user-defined idea categories.
Define new idea categories if you do not want to use an existing table or if you want to use 
custom idea categories. Create nested idea categories for defining a hierarchy of the idea 
categories.

You can use multiple idea categories with an Idea module, however, you can map only one 
category table with an Idea module.

Procedure

1. Navigate to All  > Ideas  > Idea Category  > New.

2. On the form, fill in the fields.
For more information, see Idea category form.

3. Select Submit.
An idea category represents a theme for organizing idea submissions. All ideas submitted 
through the Idea Portal must be associated with at least one idea category. You can use values 
from an existing table or create new idea categories for organizing your idea. Users select one 
or more idea categories, configured by an admin, to associate with their idea when they submit 
it. For more information, see Create an Idea module, and Idea category configuration.

What to do next
Map idea categories with your idea module. For more information see, Configure idea categories.

Adding Idea Portal to Employee Center

Improve engagement experience for your employees by enabling navigation to Idea Portal from 
Employee Center.

On the Employee Center  portal, add the following links to Idea Portal so that employees can 
easily navigate to it.

Header menu item on the Employee Center  portal

Configure a menu item for the Idea Portal page on the Employee Center  portal 
header. Follow steps 1 through 5 in Create employee forum menu item in the 
Employee Center menu .

Quick link on the Employee Center  portal
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Create a quick link to the Idea Portal page using the quick links module in Employee 
Center. Follow the procedure in Create a quick link .

Related topics

Managing ideas using Innovation Management

Managing Idea Portal

Analyzing idea metrics using Idea Manager dashboard

Integrating Innovation Management with Universal Request

Analyzing idea metrics using Idea Manager dashboard

Review, analyze, and manage your ideas effectively by using the Idea Dashboard manager.

The Idea Manager dashboard provides summary of idea metrics and trends such as ideas in 
different states, age of ideas, categories, and ideas converted to different work entities.

Note: 
Starting with version 2.0.0, the Idea Manager dashboard is available in the Next experience 
UI Framework which can be accessed from Analytics Idea Manager. The Ideas pane in 
Analysis  tab is not supported in the Next experience.

Idea Manager dashboard in Next experience UI

The Idea Manager dashboard provides comprehensive reports to the idea manager and users 
with read-only roles for ppm (sn_ppm_read). The dashboard uses Performance Analytics to 
provide a trend of historical data as well as regular reports. It provides you an overview of ideas, 
number of ideas converted into work entities, and trends based on categories, idea submitters, 
and votes. It helps you to review and analyze ideas and enables you to take required actions for 
managing your ideas effectively.

End user and roles

End user and goal Required role

Idea Manager - Needs visibility into ideas in 
different states, number of ideas created, and 
age of ideas.

idea_manager
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End user and goal Required role

Read only roles for PPM - Needs visibility 
into ideas in different states, number of ideas 
created, and age of ideas.

sn_ppm_read

Use case

The dashboard displays ideas related to Project Portfolio Management.

Only ideas associated with categories are displayed in the dashboard. Ideas marked for deletion 
are not displayed. By default, the dashboard displays one-year data. Use the interactive date 
filter to view monthly, quarterly, or yearly data.

You can drill down within an idea indicator data for further analysis by navigating to Idea Portal 
from the dashboard. For example, to view individual records of Open ideas in the Idea Portal, 
click the Open ideas  indicator value to open the Analytics Hub. In the Analytics Hub, click Show 
Records  to view the list of open ideas, open an idea in the form view, and then click the Idea 
Portal  related link to view the idea record in the Idea Portal.

Indicators

The Summary and Analysis tabs in the dashboard contain the following indicators. The data for 
ideas is collected from the [idea] table.

Open Ideas

Count of the ideas that are in Submitted, Need more information, or Under Review 
state for the current month.

Average Age of Open Ideas

The average age of ideas that are in Submitted, Need more information, or 
Under Review state since their creation, in days, as calculated by the formula 
[[PPM:Total Age of Open Ideas]]/[[PPM:Open Ideas]]/24.

Ideas Converted

Count of ideas converted into different work entities such as demand, project, story, 
or epic based on other plugins.

% of Ideas Converted

The percentage of ideas converted into different work entities such as demand, 
project, story, or epic based on other plugins, as calculated by the formula 
[[PPM:Ideas Converted]/[PPM:Active Ideas]] *100.

Ideas

Count of ideas that are in different states. You can view the count of ideas, in 
different states, created in week, month, quarter, and year.

Active Ideas

Count of ideas in Submitted, Need more information, Under review, in backlog, 
planned and in development state. This indicator is not displayed in dashboard but 
is used in formula.

Total Age of Open Ideas

Total number of days an idea is in state Submitted, Need more information, and 
Under review before conversion to a work entity. This indicator is not displayed in 
dashboard but is used in formula.
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Breakdowns

• PPM - Idea Category

• PPM - Idea State

Data visualizations

The dashboard includes the following visualizations:

Title Type Description

Ideas by state

Pie chart 

Breakdown of the number of 
ideas in each of the different 
states.

Ideas converted

Pie chart 

Breakdown of the number 
of ideas converted into work 
entities such as demand and 
project.

Top 10 ideas by votes Horizontal bar chart Top 10 ideas based on the 
total number of up-votes.

Top 10 idea creators Horizontal bar chart Top 10 users based on the 
number of ideas submitted.

Ideas trended by categories Line chart Trend of the total number 
of ideas submitted under 
various categories. The trend 
is displayed on a monthly 
basis.

Top 10 categories by ideas Horizontal bar chart Top 10 categories based 
on the number of ideas 
submitted under each 
category.

Integrating Innovation Management  with Universal Request

Integration of Innovation Management  with Universal Request  extends the capabilities of 
Universal Request  and enables your employees and agents to create an idea from a universal 
request.

Integrate Innovation Management  with the Universal Request  application to provide a consistent 
ticketing experience and facilitate inter-department request transfers.

A Universal Request is created from an Interaction Record or New Call record when an agent 
determines that a new task record must be created for any of the following reasons:
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• Resolve the Universal Request immediately without assigning it to a specific department.

• Transfer the Universal Request to a different department by assigning it to a Tier 1 assignment 
group.

Universal Request serves as a parent record for other records created as child records, such as 
INC, HRC, and custom task types. It is also used for all cross-departmental reporting. For more 
information about universal request, see Exploring Universal Request .

Features

The integration provides the following functionalities:

• Create an idea from a universal request: When a universal request is created, an agent 
analyses the request. If the request can result in a new product, feature, or change, the agent 
creates an idea from that universal request.

The idea manager then reviews submitted ideas and, if necessary, requests more information, 
and then chooses to accept or reject the idea. Accepted ideas are then converted to a 
demand, epic, story, or feature.

The relevant information of the universal request such as details from the Short description 
and Description  fields are copied to the Title  and Idea Description  fields of the idea.

Also, the idea created from the universal request becomes the primary ticket for the universal 
request and the Primary Ticket  field is populated with the idea number.

• Transfer the idea to another department with or without resolution: If the idea is rejected or 
cannot be implemented, the routing agent can transfer the idea to another department.

When an idea is transferred to another department, the idea is closed and a new record 
is created. For example, a universal request related to HR process improvement can be 
converted to an idea and then transferred to the HR department as an HRC when the idea is 
deemed not feasible.

Note: 
When the idea created from a universal request is transferred to another department, the 
resulting INC, HRC, or custom task becomes the primary ticket for the parent universal 
request.

Plugin requirements

Activate the following plugins if you have the admin role. These plugins are not active by 
default, and you must install them to integrate Innovation Management  with Universal Request 
applications.

• PPM Standard plugin (com.snc.financial_planning_pmo).

• Universal Request plugin (com.snc.universal_request). For activation information, see Activate 
Universal Request .

Activate other related plugins such as Human Resources Scoped App: Core (com.sn_hr_core), 
and Employee Center  (com.snc.employee_center) plugins to facilitate inter-department transfers 
of ideas.

Create an Idea from Universal Request

Create an idea from a universal request after initial evaluation for a new product, feature, 
enhancement, or change.
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Before you begin
Role required: sn_uni_req.request_write or ITIL

• Activate the Universal Request (com.snc.universal_request) and PPM Standard 
(com.snc.financial_planning_pmo) plugins

About this task
New idea is created in the Submitted  state. You can edit your submitted idea in the Idea Portal 
after it has been submitted until the state is changed to Completed.

Procedure

1. Navigate to Universal Requests  > All.

2. Open the universal request record from which you want to create an idea.

3. Select Create Idea.

4. On the form, fill in the fields.
For more information, see Create an Idea form.

5. Optional:  If you have attachments related to the idea, select Add attachments  and attach 
them.

6. Select Create.
The universal request number from which the idea is created appears in the header of the Idea 
form. The idea number appears in the Primary Ticket  field on the Universal Request form.

What to do next
Evaluate an idea  and create a task from an idea, if selected for execution. If the idea cannot be 
implemented, transfer the idea to the relevant department as an INC, HRC, or custom task.

Idea state mapping

Map your idea states to the Universal Request states to provide a better user experience during 
the idea state transition and to track the progress of the idea.

Before you begin
Role required: admin

About this task
Mapping the states of the idea to the universal request state ensures that the status of idea is 
also reflected on the state of universal request. As the idea moves through different stages of the 
life cycle, the state of the universal request also gets updated to reflect the change.

For example, consider a universal request that has an idea attached to it as a primary ticket. 
When the state of idea changes from Submitted  to Need more information, the state of the 
universal ticket state is also updated to Awaiting Response.

The following image is an example of a default state mapping. The Submitted, Under Review, In 
Backlog, Planned  and In Development  states of an idea are mapped to In Progress  state of a 
Universal Request.

The following table lists the default mapping of different idea states with the universal request 
states.

Default mapping of Idea states with universal request states

Idea state Universal Request state

Submitted In Progress
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Default mapping of Idea states with universal request states  (continued)

Idea state Universal Request state

Under Review In Progress

In Backlog In Progress

Planned In Progress

In Development In Progress

Unlikely to implement Closed

Duplicate Closed

Already exists Closed

Completed Closed

Need more information Awaiting Response

Procedure

1. Navigate to All  > Universal Request  > Administration  > State Mapping.

2. Select New.

3. On the form, fill in the fields.
For more information, see State mapping form .

Transfer an Idea to another department

Transfer an idea to another department with or without resolution if the idea is rejected or cannot 
be implemented.

Before you begin
Confirm that the following requirements are met:

• The idea is created from a universal request.

• The idea is associated with a category.

• Personalize the Create an Idea form to add the Assigned to  field.

• The idea is assigned to an agent.

• Additional plugins required for transfer are active. For example, if the idea is being transferred 
as an HR case (HRC), activate the Human Resources Scoped App: Core (com.sn_hr_core), and 
Employee Center  (com.snc.employee_center) plugins.

Role required: Agent to whom the idea is assigned or is a part of the assigned work group.

About this task
If the idea is rejected or cannot be implemented, transfer the idea to another department as an 
HRC, incident, or a custom task.
When an idea is transferred to another department, the idea is closed and a new record is 
created. For example, a universal request related to HR process improvement can be converted 
to an idea and then transferred to the HR department as an HRC when the idea is deemed not 
feasible.
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Procedure

1. Navigate to All  > Ideas  > Idea Portal.

2. Select the title of an idea to view its details.

3. Select the more options icon ( ), and then select the Open in platform  option to open the 
idea in the form view.

4. Select Transfer.

5. In the Transfer Ticket  dialog box, provide the following details.

◦ Department: Select the department from the list.

◦ Transfer reason: Select the reason from the list.

◦ Transfer notes: A brief description for transferring the idea that you want to pass to the UR 
Routing agent.

◦ Copy additional comments and attachments: Clear the check box if you do not want to 
transfer the idea with additional comments and attachments.

6. Select Transfer.
The idea is transferred to the selected department and the state of the idea is changed to 
Unlikely to implement.

7. Provide information about why the idea was rejected or closed in the Close notes  field.

8. Select Update.

Result
The idea is transferred to the selected department. The Primary Ticket  field of the parent 
universal request is updated with the INC, HRC, or custom task number created as a result of the 
transfer.

Innovation Management  reference

Reference information to provide additional details about Innovation Management  such as the 
fields, user roles, tables, and guidelines.

Form field information for Innovation Management

Field information for forms used in the Innovation Management.

Create an Idea form

Learn about the fields of the Idea form. Use this form to create or edit the details of an idea in 
Innovation Management.

Create an Idea form fields

Field Description

Title Brief description of the idea. As you start 
typing the title for your idea, the Related Ideas 
section appears and displays existing ideas 
that potentially match your idea.

Category The category to associate with your idea. You 
can select multiple categories for an idea. 
Categories are also visible to other users in 
the Idea Portal when viewing submitted ideas.
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Create an Idea form fields  (continued)

Field Description

Description Detailed description of the idea. Consider 
including details such as why is it useful, who 
would benefit from it, and how it would work. 
You can use the formatting toolbar to format 
text and add images or web links.

Related topics

Create an Idea module

Submit an idea

View, filter, and sort ideas

Idea Category Configuration form

Learn about the fields of the idea category configuration form. Use this form to create or edit the 
details of an idea category configuration in Innovation Management.

Idea Category Configurations form fields

Field Description

Category table
The parent table to derive idea categories 
from.

To use static idea categories, select the 
default Idea Category [im_category] table.

To use dynamic idea categories, select an 
existing table. For example, to use department 
names as idea categories, select the table that 
contains details of all the departments.

Category Field Field from the category table from which to 
derive the idea category. The corresponding 
value of this field in the category table is listed 
in the Category  field on the Idea Portal.

For example, to list department names as 
category options, set the value of this field to 
Name. The system searches for and fetches 
the department names from the parent table 
and lists all the department names as category 
options.

Parent Field If you are using nested idea categories, 
specify the field in the category table to be 
used to fetch the parent category.

Note: 
Leave this field blank if you are not using 
nested idea categories.
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Idea Category Configurations form fields  (continued)

Field Description

For example, to list Department 1 and 2 as 
subcategories of Department A, set the value 
of this field as Parent. The system searches for 
and fetches values from the parent table and 
lists Department 1 and 2 as subcategories of 
Department A.

Module The Idea module to which this idea category 
belongs.

Related topics

Configure idea categories

Idea category form

Learn about the fields of the Idea category form. Use this form to create or edit the details of an 
idea category in Innovation Management.

Idea Category form fields

Field Description

Category name Name for the idea category. Use a name that 
clearly identifies the entity for which you 
are creating the category list. For example if 
you are creating a category option for your 
departments, use the department name such 
as HR, Support, and IT.

Active Option for activating the idea category. If 
activated, the idea category appears in the 
Create an Idea form and the Category list of 
the Idea Portal.

Default: Selected

Module The module to which this idea category 
belongs.

Parent The parent idea category for which this 
category is a subcategory.

For example, to list Department 1 and 
2 as subcategories of Department A, 
select Department A in the Parent  field for 
Department 1 and 2.

Domain The domain to which the idea category 
belongs.

Collaborate on idea

Learn about the actions of the collaborate on an idea form. Review the idea details and then 
choose which action to perform on the idea. Collaborate on an idea with other submitters and 
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stakeholders. Add comments or reply to comments to request more information or answer 
questions. Vote for the ideas you would like to see developed.

Collaborate on an idea

Action Steps

Post a comment

1. Select the comment ( ) icon and enter your 
comment.

2. Select Comment  to post your comment.

Reply to a comment

1. Select the reply (  ) icon and enter your reply.

2. Select Reply  to post your reply.

Edit or delete your comment You can edit or delete your comment until the idea 
reaches the Completed  state.

1. Navigate to the comment.

2. Select the more options ( ) icon, and then select 
Edit  or Delete.

Vote on an idea Votes help in assessing the popularity of and demand 
for an idea.

• Select the up-vote icon ( ) to indicate support for 
the idea.

• Select the down-vote icon ( ) to indicate 
dislike of the idea.

Subscribe to an idea
Select Subscribe.

Related topics

Collaborate on ideas

Manage ideas

Learn about the actions of the manage ideas form. Review the idea details and then choose 
which action to perform on the idea.

Manage ideas

Action Steps

Change the state Change the state of an idea as it moves 
through different stages of the life cycle. 
Changing the state of an idea also helps keep 
the submitter and subscribers of the idea 
informed.

In the State list, select an appropriate state 
based on the status and priority of the idea.
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Manage ideas  (continued)

Action Steps

The following options are available:

• Submitted: Default state when the idea is 
submitted.

• Under Review: Pending review from the 
idea or demand manager.

• Need more information: More information 
is required before the idea is promoted and 
prioritized for development.

• In Backlog: Accepted but put on hold for 
possible development in the future.

• Planned: Accepted, and a project, demand, 
epic, feature, or story is created from the 
idea for current implementation.

• In Development: Work has started on the 
task created from the idea.

• Unlikely to implement: Does not meet 
requirements, is not feasible, or is not 
popular. The idea is set to inactive and 
closed for comments and votes.

• Duplicate: A similar idea exists in the 
database. The duplicate idea is associated 
with the original idea and is inactive and 
closed for comments and votes.

• Already exists: Already developed at the 
time of idea submission or is close to being 
developed.

Mark as a duplicate
When you mark an idea as a duplicate, one 
idea is marked as the Original idea  and the 
other as a Duplicate idea. A comment is 
logged in both the ideas with this information. 
The idea marked as a duplicate is set to 
inactive and closed for comments or votes.

1. In the State list, set the status of the idea to 
Duplicate.

2. Search for and select the idea that you want 
to mark as original in the Duplicate  field.

3. Enter a justification in the Close notes  field.

Delete an idea Remove an idea from the database when it is 
no longer relevant or is set to old. Deleting an 
idea removes all its details such as comments, 
attachments, and votes from the database.

To delete an idea and all the details 
associated with it:
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Manage ideas  (continued)

Action Steps

• Select the idea.

• Select Delete.

Related topics

Manage ideas

Evaluate ideas

Learn about the actions of the evaluate ideas form. Review the submitted ideas and then choose 
which action to perform on the idea. You can analyze the submitted ideas and then accept or 
reject them.

Evaluate ideas

Action Steps

Accept If the idea seems interesting with the potential 
for developing into a new feature, product, or 
enhancement, accept the idea. It then moves 
to the backlog, from which you can pick it up at 
an appropriate time.

To accept an idea, set the status of the idea to 
In Backlog  from the State list.

If you want to implement the idea relatively 
soon, create a task for it. For more information, 
see Create a task for an idea.

Request more information If the information provided with the idea at 
the time of submission is insufficient request 
more information about the idea by setting the 
status Need more information  from the State 
list.

Reject If an idea is not feasible or has been already 
implemented, reject the idea by setting its 
state to Unlikely to implement  or Already 
exists. The idea becomes inactive and is 
closed for comments and votes.

Close an idea when implemented When an idea is implemented successfully, 
mark the idea as completed and close the 
idea for further comments and vote.

To mark an idea as completed:

1. Set the status of the idea to Completed  from 
the State list.

2. Provide information about how the idea was 
implemented in the Close notes  field.
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Related topics

Evaluate an idea

Idea module form

Learn about the fields of the Idea module form. Use this form to create or edit the details of an 
idea in Innovation Management.

Idea module form fields

Field Description

Module name Name for the module. Use a name that clearly 
identifies the entity for which you are creating 
the module. For example if you are creating 
a module for your departments, use the 
department name such as HR, Support, and IT.

Module Id Unique identifier for the module used 
as a parameter in the Idea Portal URL 
to direct users. For example, if you 
use hr  as the Module Id, the URL to 
access the Idea Portal would look 
like the following example: /idea/?
id=ideas_list&sysparm_module_id=hr

Idea table The table to be used to store ideas. This table 
must extend the Idea [im_idea_core] table.

Enable downvote Option for activating the ability to down-vote 
an idea.

Default: Selected

Active Option for activating the idea module.

Default: Selected

Category Limit The maximum number of categories a user 
can select while submitting an idea. Default: 5

This field does not appear by default on 
the Idea module form so you must add it by 
personalizing the form.

Related topics

Create an Idea module

Demand Management
The Demand Management application consists of tools for capturing, centralizing, and assessing 
strategic and operational demands. It also provides a single location for managing all the 
demand information.
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Demand Management overview

Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

Get started

Explore

Learn the features and business 
value of Demand Management

Configure

Learn how to configure 
Demand Management

Use

Create and manage demands 
with Demand Management

Reference

Learn about the forms and 
fields of Demand Management

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

A typical workflow for you as the demand manager is as follows:

• Work on a demand to assess the feasibility, effort, and cost of the demand and create a 
business case for approval of the demand.

• Create demand tasks, such as an initial feasibility review, cost estimate, and effort estimate, 
to delegate activities to specialized resources or groups. For example, a demand manager 
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can create demand tasks for assessing the cost associated with a software upgrade and the 
resources required.

• Assign demand tasks to a business analyst, resource user, or an appropriate group. The 
assigned resource or group then creates a cost plan and resource assignment to help the 
demand manager assess and qualify the demand. For more information, see Demand tasks.

Basics of Demand Management

• Set up the application: Plan, create stakeholders and assessment categories, and create 
bubble charts.

• Assess ideas: Review and analyze submitted ideas before promoting ideas to demands.

• Create and add details to the demands: Create demands and add demand tasks, stakeholders 
and assessments, and evaluate and qualify demands.

• Use the Demand Management application or the demand workbench to compare and assess 
demands, and promote demands to projects, enhancements, changes, or defects.

Exploring Demand Management

Learn more about Demand Management  and its process flow, and reviewing its benefits to your 
organization.

Demand Management  overview

In Demand Management  assess the ideas submitted through the Idea Portal or ideation module 
and promote the feasible ideas to demands. Track the progress of an accepted idea as it moves 
through the demand life cycle (idea to a demand, to a project, enhancement, change, or defect).

Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.
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Demand Management  workflow

In demand management, a demand can be in any of the following 

states.
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The demand states are Draft, Submitted, Screening, Approved, and Completed. For more 
information, see Use Demand Management.

Demand Management  benefits

Benefit Feature Users

View and assess ideas that have been 
approved to be demands in a central location.

Demand workbench Demand Manager

Track the progress of an accepted idea as it 
moves through the demand life cycle (idea to 
a demand, to a project, enhancement, change, 
or defect).

Manage and track the financials of your 
demands in corporate, regional currency, or 
the same currency that you want to use for 
managing the project

Multicurrency in 
Demand Management

Demand Manager

Add users to the stakeholder registry so 
that demand and project management can 
automatically populate the stakeholder list 
when a user creates a demand or project.

Populate the 
stakeholder registry

Demand Manager

Demand Management process flow

The Demand Management process flow consists of the following tasks.

Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

Demand Management Process Flow

Task Description

Submitting 
ideas Any user can submit ideas from the following locations:

• Service Catalog  > Can We Help You  > Submit Idea.

• Self-Service  > Ideas  > Create New.
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Demand Management Process Flow  (continued)

Task Description

Note: 
Submitters or collaborators can edit their ideas as long the idea is in the 
Submitted state.

Creating 
demands

Demand managers and demand users can create demands using the Demand 
Management application.

Alternatively, any user can create demands from the following locations:

• Service Catalog  > Can We Help You  > Create a new demand.

• Self-Service  > Demands  > Create New.

Note: 
Requesters or collaborators can edit their demands as long as the demand 
is in the Draft state.

Adding 
details to 
demands

Demand managers can add details to a demand request by adding demand 
tasks, stakeholders, requirements, risks, decisions, and resource assignments.

Assessing 
demands

Decision makers can use assessment results and the demand backlog when 
determining which demands to approve or reject.

Demand managers can decide if the assessment should be triggered for the 
demand using the Assessment Required  field on the demand form.

Completing 
demands

Demand managers can set a demand to Completed when work on the demand 
is complete.

Demand workbench

The demand workbench provides a central location for viewing and assessing business 
demands.

The demand workbench makes it easy to manage demands by presenting multiple interactive 
views of demand information on one page. The workbench is split into two panes: the top pane 
presents an interactive bubble chart for assessing demands and the bottom pane displays the 
demand details in a list view.

The demand workbench provides real-time interaction between the two panes. Modifying a 
demand in the bubble chart automatically updates the values in the demand record. Similarly, 
changes made to a demand record are automatically reflected in the bubble chart.

By default, the workbench displays demands screened by stakeholders or qualified by the 
demand manager. With the demand manager role, you can use the workbench to:

• View, evaluate, and update demands

• Create demands

• Create artifacts from demands, including projects, enhancements, changes, and defects

With the demand manager role, you can view and evaluate demands.
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Demand Workbench

The demand workbench includes the following components:

• The top pane displays demands in a bubble chart.

• The bottom pane displays demands in a list view.

• The header includes a back button ( ) that opens the Demands list.

Demand workbench bubble chart

The interactive bubble chart on the demand workbench is a dynamically updated graph that 
plots metrics for multiple demand records.

Demand managers can use bubble charts to visualize, compare, and evaluate the relative 
standing of demands in three categories: risk, value, and size. The X-axis represents the risk 
of a demand, the Y-axis represents the value, and the Z-axis represents the size. Demands 
are plotted as circles, or bubbles, which vary in size according to the size of the demand. All 
three measurements are based on values between 0 through 10. This scale enables demand 
managers to see how one demand compares to other demands in the chart.

The bubble chart contains four quadrants, with each quadrant representing the value versus 
risk tradeoff for the demand. The quadrants are labeled along the edges of the bubble chart 
to represent this combination of value versus risk. The color of the bubbles displayed in each 
quadrant also represents the value versus risk tradeoff.

• The upper left quadrant, labeled Resource, contains demands with high value and low risk. 
Green bubbles represent demands in this quadrant.

• The lower left and upper right quadrants, labeled Consider, contain demands that require 
further evaluation. The lower left quadrant contains demands with low risk but low value while 
the upper right quadrant contains demands with high value but high risk. Orange bubbles 
represent demands in these quadrants.

• The lower right quadrant, labeled Re-evaluate, contains demands with low value and high risk. 
Red bubbles represent demands in this quadrant.

Each bubble also includes a label with the name of the demand.

From the demand workbench bubble chart, you can perform the following actions:

• Hover over a bubble to view a summary of the demand, including the demand name and the 
risk, value, and size.

• Select a bubble to open a sizing window and change the size of the demand.
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• Select and drag a bubble to increase or decrease the risk or value of the demand.

• Right-click a bubble to view the demand, create an artifact, or view an artifact  that has been 
created from a demand.

Note: 
If Agile Development 2.0  isn’t activated, you won’t find the options to create an 
enhancement or a defect

Changes made to a demand in the bubble chart are automatically updated in the demand 
record.

Demand workbench list view

The lower pane of the demand workbench displays a list of the demands shown in the bubble 
chart.

The bubble chart list view displays up to 20 demands at a time. Page forward and back through 
the list to display additional demands.

The Demand  column displays the demand number, which provides a link to the Demand form. 
The Stage  column displays the status or progress of the demand. For more information, see 
Stage Fields.

The interactive bubble chart is updated whenever you change a demand in the list view. If you 
create a demand from the demand workbench, it’s created in a qualified state and appears on 
the bubble chart. When a demand is promoted to a project, enhancement, change request, 
defect, or Enterprise Agile Planning  (EAP) entity, it’s removed from the bubble chart.

Performing the following tasks in the list view affects the demands displayed in the bubble chart:

• Searching or filtering the records in the list view displays the bubbles for those demands that 
meet the search or filter criteria.

• Adding or deleting records in the list view adds or deletes the corresponding bubbles.

• Paginating the list view by selecting any of the page arrow icons displays the bubbles for the 
demands that appear on the current page.

Predictive Intelligence  for Demand Management

The Predictive Intelligence  for Demand Management  capability uses machine-learning 
algorithms to search and display similar demands while creating a demand in the Demand form.

The PPM Predictive Intelligence Workbench includes a prebuilt use case template that 
systematically guides you through the process of creating and training new predictive models, 
evaluating and testing them, and finally adding them to your business process to add value to 
your Idea, Demand, and Project Management.

Once you train your custom use cases, they’re usable immediately. No prior knowledge or 
experience with artificial intelligence or machine learning is required when you use the PPM 
Predictive Intelligence Workbench.

The application includes templates with prebuilt guidance to assist you in creating, training, 
evaluating, testing, and producing your unique predictive models.

Predictive Intelligence  for Demand Management  has the following benefits:

• Improves the quality of your database by avoiding duplicate demands.

• Helps you in planning your demand. You can view details of similar demands that were 
submitted and executed in the past.
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Activation information

Activate the following plugins before using the Predictive Intelligence Workbench:

• Predictive Intelligence for PPM (com.snc.ppm_ml) plugin

• Predictive Intelligence for Ideation (com.snc.innovation_management_ml) plugin

Solution definition for Predictive Intelligence  for Demand Management

The solution definition for Predictive Intelligence  for Demand Management  capability is available 
in the Predictive Intelligence for PPM plugin (com.snc.ppm_ml). For more information about 
Predictive Intelligence, see Predictive Intelligence  and Contextual search .

Solution Definition for Demand Management

Solution Definition Solution Type Description

Similar Demands

Note: 
This solution definition is 
available as a template 
on instances where the 
following plugins are 
active:

• Predictive Intelligence 
for Contextual 
Search plugin 
(com.snc.contextual_search_ml)

• PPM Standard plugin 
(com.snc.financial_planning_pmo)

• Predictive Intelligence 
for PPM plugin 
(com.snc.ppm_ml)

Similarity View similar demands based 
on the Demand Name  and 
Description  fields. You can 
see the results in the Similar 
demands  section on the 
Demand form.

Related topics

Predictive Intelligence

Train the similarity solution for Demand Management to find similar demands

Create a demand

Now Assist  skills for Demand Management

Now Assist for Strategic Portfolio Management (SPM)  provides AI-powered skills for demand 
records that help you quickly understand demand details and identify related records. These 
skills improve planning efficiency and support informed decision-making.

Similar record identification

The identify similar records skill enables you to find demand records that are contextually similar 
to your demand. This skill helps reduce duplicate demands and improves planning efficiency.

This skill uses the name, description, and business case content of a demand to look for 
contextual similarity with other demand records using AI search. The skill identifies demands 
with a minimum 85% similarity threshold, excluding outdated and irrelevant records.
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The similar demand records are displayed in a top banner and in the Similar Demands related 
list. This skill improves visibility into related initiatives, and enhances decision-making for 
demand users.

For more information, see Identify similar records using Now Assist for Strategic Portfolio 
Management (SPM).

Demand summarization

The demand summarization skill reviews the fields and related lists of a demand record and 
helps generate a clear summary. Use this skill to quickly understand the key details of a demand 
without reviewing individual fields, comments, and work notes.

The generated summary is displayed in a summary card on the demand record. You can copy the 
summary for further use.

For more information on, see Summarize demands with demand summarization skill.

Related topics

Now Assist for Strategic Portfolio Management (SPM)

Configuring Demand Management

Configure your Demand Management  application to assess and promote demands to projects, 
enhancements, changes, defects, or Enterprise Agile Planning  (EAP) entities.

Configuration overview

Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

Multicurrency in Demand Management

Manage and track the financials of your demands in the corporate currency, regional currency, or 
the same currency that you want to use for managing the project using the multicurrency feature. 
The corporate policy typically governs the choice of this preference.
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Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

In global or multinational organizations, demands are often managed and tracked at one 
geographic location and executed at a different geographic location. As each location might use 
a different currency to spend the budget, this difference in geographic location makes it difficult 
to monitor and track financials for such demands.

The multicurrency feature in Demand Management  makes it easier for you to manage and track 
your demands from any geographical location in any currency. You can monitor and track the 
financials of your demands in one currency and spend the budget in a different currency such as 
the functional currency, regional currency, or the currency that you want to later use to manage 
your projects. You can also choose to manage your demands in one currency and specify a 
different currency for managing your future projects.

Activation information

Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin to enable the 
multicurrency features in Demand Management. Activating the plugin enables the demand 
currency view in demand, cost plans, and benefit plans forms. With the demand currency view, 
you can manage your simple demand financials, cost plans, benefit plans, and budgets in the 
demand currency.

Note: 
Activating this plugin automatically activates the PPM Standard 
(com.snc.financial_planning_pmo) plugin and therefore you get the option to switch 
between the default view and the demand currency view.

Currency Preferences

After activating the multicurrency plugin, specify your currency preference for managing your 
demand financials. You can select your functional currency, a regional currency, or a local 
currency. For more information, see Select demand currency preference.

Demand currency view

In addition to the default view in the Demand form, the Demand Currency view enables you to 
view the multicurrency fields. You can enable this view from the form context menu.

You can designate a currency other than the functional currency as the processing Demand 
Currency for a demand. The Financials  tab of the Demand form has the Demand currency  field. 
You can select an active currency from the Currencies [fx_currency] table.
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Note: 

The Demand currency  field of a demand becomes read only once you create a cost plan, 
cost plan breakdown, benefit plan, or benefit plan breakdown for the demand.

Multicurrency in Demand Tasks

Track the expenses incurred while performing the demand tasks in demand currency. When the 
time card for a demand task is submitted and processed, the actual cost is calculated based on 
the rate model, the default labor rate, or the rate defined in the system property. You can view 
this actual cost in the Demand Task form in the Demand currency  and Actual cost in demand 
currency  fields. For more information, see Demand tasks.

Multicurrency in Demand Baseline

Compare the financial baselines of your demands to track the performance of a demand over 
time. Baseline comparison enables you to identify and review the financial changes made to the 
demand at various stages of the demand life cycle. With the multicurrency feature, you can view 
the financial information in the demand currency when you compare the baselines. You can also 
configure the baseline view to add additional fields and view details in demand currency. For 
more information, see Compare financial baselines of a demand.

Select demand currency preference

Set your currency preference to use for managing and tracking the financials of your demands 
from the functional currency, regional currency, or local currency.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Preferences-Project.

2. Select a currency option for managing your demands from the Demand currency setup list.

3. Select Save.

What to do next
Enable the multicurrency view in the Demand and other demand-related forms. For more 
information, see Enable demand currency view.

Enable demand currency view

Switch to the demand currency view to track the planned costs of a demand in the selected 
currency.
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Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin or it_demand_manager

About this task
To manage your demands in a currency different than the functional currency, the demand 
currency fields are added in the following tables that have the cost details and financials tab:

Tables with demand currency fields

Table name Description

Demand [dmn_demand] table Track a demand in a different currency. Create 
a demand and select another currency by 
navigating to the Financial  tab and selecting 
a currency in the Demand Currency  field. To 
create a demand, see Create a demand.

Demand Task [dmn_demand_task] table Demand tasks are used to delegate the 
cost, effort, risk, and benefit assessment 
activities. To create a demand task, see Create 
a demand task.

Cost Plans [cost_plan] table Cost plans capture the costs of demands. To 
navigate to the Cost Plan form, see Create a 
demand cost plan.

Cost Plan Breakdown [cost_plan_breakdown] 
table

Cost plan breakdowns specify the estimated 
cost and actual cost at a granular level for 
a fiscal period. To navigate to the Cost Plan 
Breakdown form, see Create a demand cost 
plan.

Benefit Plan [benefit_plan] table If you open the demand form in Demand 
Currency  view, then by default the fields 
related to the demand currency appear in the 
Benefit Plans related list. To create a demand 
benefit plan, see Create a monetary benefit 
plan for a demand.

Benefit Plan Breakdowns 
[benefit_plan_breakdown] table

Benefit plans capture the potential benefits 
accrued by the demand when the demand is 
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Tables with demand currency fields  (continued)

Table name Description

executed. To update a benefit plan breakdown, 
see Create a monetary benefit plan for a 
demand.

Expense Line [fm_expense_line] table Expense lines are part of the demand cost 
plans and stores cost associated with a 
specific resource. To navigate to the Expense 
line form, see Create an expense line for a 
demand.

Project Funding [project_funding] table Stores the demand target and budget 
expense values for both capital and operating 
expenses for a single fiscal period. To allocate 
the budget for a demand, see Allocate budget 
to a demand.

Procedure

1. Navigate to the respective form.

2. Right-click the context menu of the form.

3. Select View.

4. Select Demand Currency  from the list.

What to do next
Refer to the form fields that are exclusive to the Demand Currency  view that you have selected. 
All the other form tabs and fields remain the same both for the default view and the demand 
currency view. Continue to enter values in the fields as you would for the default view.

Multicurrency fields in demand-related forms

When you enable the Demand Currency  view in a Demand, Cost Plan, and Cost Plan Breakdown 
forms, you can observe the multicurrency fields in the Financials section of the forms.

Financials tab of the demand form

Demand form

Field Description

Demand currency Currency in which you want to manage and 
track the demand.
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Demand form  (continued)

Field Description

Note: 

The ability to select a demand currency 
depends on the currency option you 
selected in Preferences-Project  under 
Project Administration. For more 
information, see Select demand currency 
preference.

The Demand currency  field of a demand 
becomes read only once you create a 
cost plan, cost plan breakdown, benefit 
plan, or benefit plan breakdown.

Project currency Currency in which you want to implement the 
project when this demand is converted to a 
project.

Note: 

The Project currency  field in the 
Project form of Project Management is 
carried over from the demand when it’s 
converted.

Capital expense in demand currency Capital expenditure (Capex) for the demand.

Capital budget in demand currency Total capital budget allocated to the demand 
across all fiscal years.

The value is rolled up from the capital 
expenditure (Capex) budget of the demand.

Operating expense in demand currency Operational expenditure (Opex) for the 
demand in the selected demand currency.

Operating budget in demand currency Total operational budget allocated to the 
demand across all fiscal years in the selected 
demand currency.

The value is rolled up from the Opex budget of 
the demand.

Total planned cost in demand currency Estimated cost of the demand in demand 
currency.

Financial return in demand currency Estimate of the revenue based on the Total 
planned costs in demand currency  and 
Financial benefit in demand currency  fields.

Financial benefit in demand currency Estimate of revenue if the demand is approved 
in the selected demand currency.
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Demand form  (continued)

Field Description

This value is rolled up from the benefit 
breakdown of the demand.

Net present value in demand currency Present value of future cash based on the 
given annual interest rate in the selected 
demand currency.

It’s a measure for comparing money spent 
today against future expected financial 
benefits. It helps when evaluating the overall 
investment performance.

Actual cost in demand currency Total cost incurred while working on a demand 
and demand tasks in the selected demand 
currency.

Multicurrency fields of the Demand Task form

Demand Task form

Field Description

Demand currency Currency that you specified in the Demand 
currency  field of the Demand form.

Actual cost in demand currency Total cost incurred while working on a demand 
tasks in the selected demand currency.

Actual cost comes after the assignee of the 
demand task creates and submits a time card. 
When the time card is approved, the resource 
rate, derived from the rate card, labor rate, or 
system properties, is used to populate this 
field.

Financials section of the Cost Plan form

Cost Plan form

Field Description

Demand currency Currency that you specified in the Demand 
currency  field of the Demand form.

Cost in demand currency Value that is rolled up from the Entered cost 
field of all cost plan breakdowns.

Note: 
Any change that you make to the unit cost, quantity, or fiscal period of a cost plan has the 
amounts recalculated in demand currency. See Cost plan updates and cost recalculation in 
demand currency.
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Multicurrency fields in the Cost Plan Breakdown form

Cost Plan Breakdown form

Field Description

Demand currency Currency that you specified in the Demand 
currency  field of the Demand form.

Cost in demand currency Breakdown amount in demand currency.

Demand currency exchange rate Rate in effect for the period corresponding 
to the cost plan breakdown in the demand 
currency.

Demand currency exchange rate date The reference date on which the currency 
exchange rate is applied for conversion.

Financials section of the Benefit Plan form

Benefit Plan form

Field Description

Demand currency Currency that you specified in the Demand 
currency  field of the Demand form.

Benefit in demand currency Benefit incurred from demand in demand 
currency.

Actual benefit in demand currency Actual benefit value rolled up from the actual 
benefit in the benefit breakdown.

Multicurrency fields in the Benefit Plan Breakdowns form

Benefit Plan Breakdowns form

Field Description

Demand currency Currency that you specified in the Demand 
currency  field of the Demand form.

Benefit in demand currency Benefit incurred from demand in demand 
currency.

Demand currency exchange rate Rate in effect for the period corresponding 
to the benefit plan breakdown in demand 
currency.

Demand currency exchange rate date The reference date on which the currency 
exchange rate is applied for conversion.
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Multicurrency fields in the Expense Line form

Expense Line form

Field Description

Demand currency Currency that you specified in the Demand 
currency  field of the Demand form.

Amount in demand currency Expense cost in demand currency. Amount 
entered in the Amount field is converted to 
demand currency.

Multicurrency fields in the Demand Budget form

Demand Budget form

Field Description

Capex budget in Demand Currency Planned expense amount allocated for capital 
expenditure in the selected currency.

Opex budget in Demand Currency Operating expense amount in the selected 
currency in the selected currency.

Total Budget in Demand Currency Sum of Capex and Opex amounts in the 
selected currency.

Allocate demand budget in demand currency

Set the capital expense (Capex) and operating expense (Opex) budgets in demand or functional 
currency according to the fiscal years. The sum of the Capex and Opex budgets is calculated as 
the total budget in demand currency.

Before you begin
Role required: it_demand_manager

About this task
Allocate the budget in a similar manner as you do with functional currency. For more information, 
see Allocate budget to a demand.

Enable the Demand Currency  view in the Demand form to allocate the budget in demand 
currency.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand to which you want to allocate the budget.

3. Select the Create Demand Budget  related link of the Demand form.

The Demand Budget  dialog box opens.

4. On the Demand Budget dialog box, fill in the fields.
For detailed description of the field names, see Demand Budget form.

5. Select OK.
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Result
The demand budget for the selected year appears in the Demand Budget related list. Select the 
amounts in the list to revise them.

Cost plan updates and cost recalculation in demand currency

Updating the unit cost, quantity, or fiscal period of a cost plan updates all the related amount 
fields in the cost plan and its breakdowns. Also, the amounts in the related fields of the demand, 
to which the cost plan is rolling up, are recalculated and reflected in the demand currency.

Changes in Unit cost, Quantity, and Recurring check box of a cost plan

When you change the values of any of these fields in the Cost Plan form with 
multicurrency view enabled, the following values are recalculated:

• When you modify the Unit cost  field, Quantity  field, or Recurring  check box of the 
Cost Plan form, the total planned cost is recalculated in demand currency.

• The Cost in demand currency  in the Cost Plan Breakdown is also recalculated.

• The values in the Capital expense in demand currency, Operating expense in 
demand currency, and the Total planned cost in demand currency  fields of the 
demand are recalculated.

Changes in the fiscal period of a cost plan

When you change the fiscal period, either the start date or end date in the Cost Plan 
form, the following values are recalculated:

• The Total planned cost  and the Cost in demand currency  of the cost plan are 
recalculated. Therefore, the Cost Plan Breakdown records may be added or 
removed.

• If the Recurring  check box isn’t selected, then the Cost in demand currency  of 
each Cost Plan Breakdown record is recalculated.

• The values in the Capital expense in demand currency, Operating expense in 
demand currency, and the Total planned cost in demand currency  fields of the 
demand are recalculated.

Changes in the entered cost of a cost plan breakdown or manual addition of a breakdown

When you change the entered cost in an individual Cost Plan Breakdown record 
or manually add cost plan breakdowns to a cost plan, the following values are 
recalculated:

• The Total planned cost  of the cost plan is recalculated in demand currency.

• The values in the Capital expense in demand currency, Operating expense in 
demand currency, and the Total planned cost in demand currency  fields of the 
demand are recalculated.

Benefit plan updates and recalculation in demand currency

Updating the entered currency, entered benefit, offset type, or the fiscal period of a benefit plan 
also updates all related amount fields in the benefit plan and its breakdowns. Also, the amounts 
in the related fields of the demand, to which the benefit plan is rolling up, are recalculated and 
reflected in demand currency.

Changes in entered currency, entered benefit, and recurring check box of a benefit plan

When you change the values of any of these fields in the Benefit Plan form with 
multicurrency view enabled, the following values are recalculated:
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• When you modify the Entered currency  field, Entered benefit  field, or Recurring 
check box of the Benefit Plan form, the total planned benefit is recalculated in 
demand currency.

• The Benefit in demand currency  in the Benefit Plan Breakdown is recalculated.

• The value in the Financial benefit in demand currency  field of the demand is 
recalculated.

Changes in the offset type of a benefit plan

When you change the offset type for the benefit plan, either the start date or end 
date and specify the offset period and duration of such periods in the Benefit Plan 
form, the following values are recalculated:

• The Total planned benefit  and the Benefit in demand currency  of the benefit 
plan are recalculated. Therefore, the Benefit Plan Breakdown records may be 
added or removed.

• If the Recurring  check box isn’t selected, then the Benefit in demand currency  of 
each Benefit Plan Breakdown record is recalculated.

• The value in the Financial benefit in demand currency  field of the demand is 
recalculated.

Changes in the fiscal period of a benefit plan

When you change the fiscal period, either the start date or end date in the Benefit 
Plan form, the following values are recalculated:

• The Benefit in demand currency  and the Total planned benefit  of the benefit 
plan are recalculated. Therefore, the Benefit Plan Breakdown records may be 
added or removed.

• If the Recurring  check box isn’t selected, then the Benefit in demand currency  of 
each Benefit Plan Breakdown record is recalculated.

• The value in the Financial benefit in demand currency  field of the demand is 
recalculated.

Changes in the entered benefit of a benefit plan breakdown

When you change the entered benefit in an individual Benefit Plan Breakdown 
record, the following values are recalculated:

• The Benefit in demand currency  of the benefit plan is recalculated in demand 
currency.

• The value in the Financial benefit in demand currency  field of the demand is 
recalculated.

Quick start tests for Multicurrency in Demand Management

Validate that the multicurrency in Demand Management  still works after you make any 
configuration change such as applying an upgrade or developing an application. Copy and 
customize these quick start tests to pass when using your instance-specific data.

Danger: 
By default, the system property that is used to run automated tests is disabled to prevent 
you from accidentally running these tests on a production system. To avoid data corruption 
or an outage, run tests only on development, test, and other non-production instances. See 
Enable or disable executing Automated Test Framework tests .
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Demand currency quick start tests require activating the PPM Standard Multicurrency – ATF 
Tests plugin (com.snc.ppm_multicurrency.atf).

Demand currency test suite tests

Test Description Release version

Verify cost in demand 
currency on cost plan

Validate the calculation of cost 
plan breakdown with budget 
reference rate and verify the 
roll up to cost plan in demand 
currency.

Quebec

Verify benefit in demand 
currency on benefit plan

Validate the calculation of 
benefit plan breakdown with 
budget reference rate and 
verify the roll up to benefit 
plan in demand currency.

Quebec

Related topics

Quick start tests

Upgrade existing demands

Execute scheduled jobs to upgrade your existing active and inactive demands, respectively, after 
activating the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Before you begin
Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Role required: admin

About this task
Run these scheduled jobs on demand to upgrade your existing active and inactive demands in 
demand currency only when necessary.

Note: 
The jobs may have a performance impact depending on the number of demands and cost 
plans, therefore run the jobs only when necessary.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Execute a scheduled job to upgrade your existing active and inactive demands.

Set up Demand Management

Perform these tasks to set up Demand Management.
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Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

Before using Demand Management, PPS admin performs several setup tasks.

Planning for Demand Management

Plan the listed items before setting up Demand Management.

Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

Demand Management Planning

Name Description

Roles Determine who has the demand manager [it_demand_manager] and demand 
user [it_demand_user] roles.

Portfolios Determine how you want to group or categorize demands, and then have a user 
with the project manager [it_project_manager] role create portfolios based on 
those groupings.

Stakeholders Identify individuals who have the appropriate domain knowledge to evaluate 
demands related to each portfolio.

Then make them stakeholders for that portfolio.

Assessments Consider using assessments to facilitate the information gathering process.
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Demand Management Planning  (continued)

Name Description

Define metric categories and assessment metrics to develop and distribute 
assessments to the appropriate audience.

Bubble chart 
definitions

Identify metrics that are important to stakeholders, departments, and the 
organization.

Use these metrics to create bubble charts that visually compare demands.

For example, when considering which projects to undertake many 
organizations compare metrics such as risk rating, return on investment, and 
cost.

Resource 
assignments

Consider creating resource assignments to help the organization understand 
the time and resource costs associated with the demand. Any resource 
assignment attached to the demand propagates to the project.

Resource assignments require that the Resource Management Workspace 
application is active.

Enhancement 
and defect 
requests

Determine if you need the ability to manage enhancement and defect requests 
as demands.

This functionality requires that the Agile Development application is active.

Populate the stakeholder registry

Add users to the stakeholder registry so that demand and project management can 
automatically populate the stakeholder list when a user creates a demand or project.

Before you begin
Role required: it_pps_admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Stakeholders.
You can also scroll to the Stakeholders  related list on the Demand or Project form and select 
New  to create a record.

2. Select New  to create a record.

3. On the stakeholder register form, fill in the fields.

For a description of the field names, see Stakeholder Register Form.

Note: 
When adding a user to the stakeholder registry, the combination of the user and the 
assigned portfolio must be unique. However, there can be more records for the same user 
but with a different portfolio.

View an assessment metric category

View assessment metric categories that are used with assessment metric types and assessment 
metrics in generating the bubble charts on the Demand Workbench. The bubble charts help the 
demand managers to assess the demands visually.
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Before you begin
Role required: it_pps_admin

About this task
The Demand Management  application comes with an assessment metric type named Demand, 
five default assessment metric categories, and assessment metrics.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Assessments Metric Categories.

2. Open an assessment metric category to review it.
The following default assessment metric categories are available with the Demand 
Management.

Demand assessment metric categories

Assessment 
metric 
category

Data source Description

Size T-Shirt size  field on the Demand  form. Assesses demand size relative to the 
size of other demands.

Strategic 
Alignment

View an assessment category result
field in the assessment category result 
for the Strategic Alignment metric 
category.

Assesses how closely the demand 
aligns with strategic goals of the 
organization compared to other 
demands.

Risk Rating  field in the assessment category 
result for the Risk metric category.

Assesses demand risks compared to 
other demands.

ROI Impact  and Financial return  fields on 
the Demand form.

Assesses demand return on 
investment compared to other 
demands.

Cost Labor costs, Capital expense, and 
Operating expense  fields on the 
Demand form.

Assesses demand cost compared to 
other demands.

Configure a widget for the financial metrics of a demand

Configure a widget to view and track the financial metrics of a demand on the Demand Financials 
page.

Before you begin
Role required: pps_admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. Select New.

3. On the Widget form, fill in the fields.
For a description of the field names, see Widget form.

What to do next
Associate the widget to the Demand table.
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Associate a widget to the Demand table

After you configure a widget, associate it with the Demand table to show the financial data of a 
demand.

Before you begin
You must configure a widget  before you can associate it with the Demand [dmn_demand] table.

Role required: pps_admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. Open a widget to associate with the Demand table.

3. In the Widget associations related list, select New.

4. On the Widget Association form, fill in the fields.
For a description of the field names, see Widget Association form.

Configure demand workbench

Update the demand workbench to configure parameters such as bubble chart.

Before you begin
Role required: it_pps_admin

About this task
You can configure the parameters of the demand workbench provided with the base system.
Bubble charts are useful for comparing demands based on common metrics such as risk rating, 
return on investment, and cost. Decision makers can use bubble charts when considering which 
demands to approve or reject.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Workbench Config - Demand.

2. Open the Demand Workbench  record.

3. Update the required settings and select Update.

Use Demand Management

Users with the demand manager role can create, view, and modify demands using the Demand 
Management application.
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Important: 

Demands are available in the Next Experience for Demand Management. For more 
information, see Next Experience for Demand Management.

The workspace provides additional value beyond the legacy experience, including 
Playbook, Docs, and the ability to define different governance processes using playbooks.

If you have Portfolio Planning Workspace  or Strategic Planning Workspace, you can use the 
Next Experience for Demand Management  to create and manage your demands.

• New customers: Use Next Experience for Demand Management  to create and manage 
your demands.

• Existing customers: If you already have demands in the classic UI, you can continue using 
it. However, we recommend moving to the Next Experience for Demand Management, as 
your existing demands are automatically available there.

You can also approve demands and create the following artifacts from the approved demands:

• Project

• Change

• Enhancement

• Defect

• Enterprise Agile Planning  (EAP) entities (epic, feature, and capability)

The type of artifact created from a demand depends on the selections in the Category  and Type 
fields on the Demand form.

Note: 

• Enhancements and defects can be created when the administrator has activated the 
SDLC-SCRUM plugin.

• EAP  entities can be created when the Strategic Planning  plugin is activated.

Demand Management Life Cycle

The demand management life cycle can be simplified as follows:

• Creating a demand: The user submits an idea and the demand manager approves the idea, 
automatically creating a demand from that idea.

• Viewing a list of demands: The demand manager views demands on the demand workbench 
or from a list view.

• Enhancing a demand: The demand manager can send the demand to screening, which sends 
assessments to stakeholders.

• Assessing a demand:

◦ The demand manager can screen the demand and send surveys to stakeholders to 
complete assessments.

◦ The demand manager can set the state of the demand to qualify, defer, or incomplete.

◦ Demands can be analyzed and approved using the demand workbench.

• Creating an artifact: The demand manager creates a project, enhancement, change, defect, or 
EAP  entities.

The demand management application uses the following simplified demand states.
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Demand States

State Description

Draft The demand manager accepts a submitted idea.

After reviewing or editing the record, select one of these buttons:

• Update: The demand record is updated, but the demand remains in the current 
state.

• Submit demand: The demand is moved to the submitted state.

• Delete: The demand record is deleted.

Submitted An accepted idea creates a demand record and the demand manager submits the 
demand.

After reviewing or editing the record, select one of these buttons:

• Update: The demand record is updated, but the demand remains in the current 
state.

• Screen: The demand is moved to the screening state.

• Qualify  The demand is moved to the qualified state.

• Defer: The demand is moved to the deferred state.

• Incomplete: The demand is moved to the incomplete state.

• Reset to Draft: The demand is moved back to the draft state.

• Delete: The demand record is deleted.

Screening Stakeholder assessments are initiated for the demand.

After reviewing or editing the record, select one of these buttons:

• Update: The demand record is updated, but the demand remains in the current 
state.

• Qualify  The demand is moved to the qualified state.

• Defer: The demand is moved to the deferred state.

• Reset to Draft: The demand is moved back to the draft state.

• Delete: The demand record is deleted.

Qualified The demand has been qualified and is ready for review.

After reviewing the record, select one of these buttons:

• Update: The demand record is updated, but the demand remains in the current 
state.

• Approve: The demand is moved to the approved state.

• Defer: The demand is moved to the deferred state.

• Delete: The demand record is deleted.

Deferred The demand has been put on hold. The demand can be revisited in future and 
reviewed.

After reviewing the record, select one of these buttons:
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Demand States  (continued)

State Description

• Update: The demand record is updated, but the demand remains in the current 
state.

• Approve: The demand is moved to the approved state.

• Delete: The demand record is deleted.

Approved The demand is approved

After reviewing or editing the record, select one of these buttons:

• Update: The demand record is updated, but the demand remains in the current 
state.

• Close: The demand is moved to the closed state.

• Reset to Draft: The demand is moved back to the draft state.

• Delete: The demand record is deleted.

Completed The demand is moved to the completed state.

After reviewing the record, select one of these buttons:

• Update: The demand record is updated, but the demand remains in the current 
state.

• Reset to Draft: The demand is moved back to the draft state.

• Delete: The demand record is deleted.

These states appear in the process flow indicator at the top of the Demand form. The process 
flow indicator:

• Highlights the current state of the demand.

• Checks off the states that a demand has passed through.

• Leaves empty the states that have been skipped.

Assess demands

The Demand Management application comes with two demand visualization tools that can aid 
decision makers with demand assessment.

The demand workbench  provides a single point of engagement for assessing and approving 
demands and creating projects, enhancements, changes, or defects. This page combines 
multiple views of demand information, including an interactive bubble chart and a detail area 
that displays the list of current demands. The demand roadmap is a visual representation of 
demands over time for an organization.

Using the Demand Workbench

A bubble chart is a graph that plots multiple demands based on three categories: risk, value, and 
size. Each demand is represented on the bubble chart by a circle, which varies in size and color 
depending on the average of the scores for these categories. The bubble chart in the demand 
workbench displays all qualified demands and is dynamically updated as demands are created 
and assessed. This chart makes a useful tool for demand managers, stakeholders, and decision 
makers to assess visually and compare demands.
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The list view on the demand workbench displays a list of the qualified demands that appear in 
the bubble chart. Selecting a demand from this list highlights the demand in the bubble chart 
and displays the demand form. The list view is also integrated with Live Feed so users can see 
current activity for a demand.

To access the demand workbench, navigate to All  > Demand  > Demands  > 

Workbench.

Using the Roadmap

The roadmap is an interactive visualization tool that shows all demands that are currently in an 
active state. You can modify the look of the backlog using the Settings pane. The Settings pane 
enables you to change between the two-dimensional (2D) and three-dimensional (3D) view, filter 
demands by portfolio, or open the demands in a list view. While in list view, you can reassign 
panel colors, create filters to limit the records that are used for lanes and panels, and apply 
sorting. To use the roadmap, navigate to All  > Demand  > Roadmap.

Create a demand

Create demands to capture your strategic and operational requirements and centralize 
information for stakeholder assessment and prioritization.

Before you begin
Role required: snc_internal

Procedure

1. Access the Demand New record form in one of the following ways.

◦ Navigate to All  > Demand  > Demands  > Create New.

◦ Navigate to Self-Service  > Demands  > Create New.

◦ If you have the it_demand_manager role, navigate to All  > Demand  > Demands  > 
Workbench  > New.

Note: 
Demands created from the Demand Workbench are in the Qualified state.

2. On the Demand New record form, fill in the fields.
For a description of the field values, see Demand form.
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3. Select Save.

Note: 
Requesters or collaborators can edit their demand as long as the demand is in the Draft 
state.

What to do next

• Review and refine the demand details.

• When all required information is complete, move the demand to the Submitted state by 
selecting Submit demand. The demand then enters the formal evaluation workflow involving 
the demand manager and stakeholders.

Create a qualified demand

The demand manager can create a qualified demand from the demand workbench list view.

Before you begin
Role required: it_demand_manager

About this task
Saving the demand adds it to the Demands list and adds a bubble representing the demand in 
the bubble chart.

Procedure

1. Navigate to All  > Demand  > Demands  > Workbench.

2. Select New  at the top of the list view.

3. Fill in the fields on the Demand form.
For information about the fields, see Creating Demands.

Create a demand task

Create tasks for a demand to delegate cost, effort, risk, and benefit assessment activities. Assign 
a resource or group to the demand task to track the actual time and effort spent on performing 
the specified activities.

Before you begin
Role required: it_demand_manager

About this task
You create demand tasks to plan the work for demands rather than for the target work entity such 
as a project, change, defect, or enhancement. For more information, see Demand tasks.

• Planned dates, actual dates, and original dates are part of project tasks not demand tasks.

• The due date indicates the date on which the task is targeted for completion and doesn’t 
affect the demand workflow. Project tasks, however, affect the project completion dates if the 
planned dates and actual dates are changed.

• Don’t support the creation of nested demand tasks.

• Don’t support task constraints such as the settings Start ASAP and Start on a specific date.

• Don’t support an execution type such as Agile, Waterfall, or Hybrid.

• You assign resources for a demand task use the Assigned to  field, Additional Assignee  list, 
and Assignment Group  fields.

Resources assigned to a demand task can submit the time spent on it using a time card.
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If you’re creating a demand task with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and Demand Currency view enabled, additional 
fields become available in addition to the Default view. For more information about the fields that 
are available only in the Demand Currency view, see Multicurrency in Demand Management  and 
Multicurrency fields in demand-related forms.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand to which you want to add tasks.

3. Add or edit a demand task from the Demand Tasks  related list:

◦ To add a demand task, select New.

◦ To update the details of an existing demand task, select the record and then select Edit.

4. On the Demand Task form, fill in the fields.
For a description of the field names, see Demand task form.

5. Select Save.
After completing your work on the demand task, select Update  to return to the demand page.

Note: 
Team members can access demand tasks assigned to them from Collaborative Work 
Management. For more information, see Managing SPM work in Collaborative Work 
Management.

What to do next
Create resource assignments and add cost plans, benefit plans, and risks to the demand 
depending on your role. Use the following related links to access these tasks.

Demand Task form related links

Related Links Description

Add Cost Plan to Demand Add a cost plan to capture the costs of 
demands. Create a cost plan to specify 
the unit cost of a cost type for a fiscal 
period. This link appears if the Category 
value is set to Cost estimate and the user 
has the it_project_manager  or 
it_demand_manager  role. Select the 
link to open the cost plan form and fill in the 
details. For more information, see create a cost 
plan.

Add Resource Plan to Demand Create a resource plan to find the availability 
of resources and add the resource plan to the 
demand. This link appears if the Category 
value is set to Effort estimate and the user has 
the it_resource_user  role. Select the link 
to navigate to the Resource Plans page and 
request resources. For more information, see 
Create and manage resource assignments for 
a demand.

Add Benefit Plan to Demand Create a benefit plan to capture the potential 
benefits accrued by the demand when the 
demand is executed. This link appears if the 
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Demand Task form related links  (continued)

Related Links Description

Category  value is set to Benefit estimate and 
the user has it_project_manager  or 
it_demand_manager  role. Select the link 
to open the benefit plan form and fill in the 
details. For more information, see Create a 
monetary benefit plan for a demand.

Add Risk to Demand Add risks that can potentially impact the 
success or outcome of the execution 
of the demand. This link appears if the 
Category  value is set to Risk estimate and 
the user has it_project_manager  or 
it_demand_manager  role. Select the link 
to open the risk form and fill in the details. For 
more information see, add a risk.

Submit a time card for a demand task

The resources assigned to a demand task create and submit a time card or time sheet to record 
the time spent on a demand task. The reported hours are used to calculate the actual cost and 
effort for a demand task.

Before you begin
Role required: timecard_user

About this task
The resource submits the time card or time sheet to record and track the work performed on 
a demand task. An appropriate approver then has to approve the submitted time card or time 
sheet.

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Create a time card.

3. Fill in the hours for each day spent working on the demand task.

4. Select Submit.

Create an artifact from a demand

Create an artifact, such as a work item, from a demand so that you can track work on the 
demand.

Before you begin
A demand must have been created. For more information, see Create a demand.

The category and type of a demand and the applications you have installed determine the 
artifact you can create from it. The available artifact types and the applications you must have 
installed to be able to create them are listed in the following table.
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Artifact Required application

Enhancement, change, or defect Project Portfolio Suite

Agile Development  entities (story or epic) Agile Development 2.0

Scaled Agile Framework (SAFe)SAFe  entities 
(story, feature, or epic)

Essential SAFe  or Portfolio SAFe

Enterprise Agile Planning  (EAP) entities (epic, 
feature, or capability)

Strategic Planning

Role required: it_demand_manager

Note: 

• The sn_apw_advanced.eap_user role is required to convert a demand to EAP  entities.

• The safe_art_user role is required to create a SAFe story.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the demand for which you want to create an artifact.

3. Verify that the values in the Category  and Type  fields are appropriate for the artifact you want 
to create.
The options in the Type list change according to the category that you select. For more 
information, see Demand form.

Note: 
The Category  and Type  fields are set to read only when an artifact is created from a 
demand. If you delete the created artifact, these fields become editable again.

4. Select Update.

5. Create the artifact by selecting the appropriate related link.
Depending on the category and type of the demand, links related to the artifact you can create 
become available.

Create an Enterprise Agile Planning  (EAP) entity from a demand

Create an Enterprise Agile Planning  (EAP) entity, such as an epic, feature, or capability, from a 
demand so that you can start to work on these entities in Enterprise Agile Planning.

Before you begin
The Strategic Planning  application must be installed.

Role required: sn_apw_advanced.eap_user

Note: 
A demand manager requires the sn_apw_advanced.eap_user role to convert a demand to 
an EAP  entity.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the demand that you want to convert into an artifact.
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3. Set the demand category and type for EAP entities.

a. From the Category list, select Strategic.

b. From the Type list, select EAP Epic, EAP Feature, or EAP Capability.

4. Optional:  In the EAP Details section, select the team that you want the EAP entity to be 
assigned to in the Team  field.
This field becomes read-only once the entity is created.

5. Save the demand by selecting Save.

6. Create an entity that will be associated with this demand by selecting the appropriate related 
link.

Note: 
The related links aren’t available once the demand is converted to the selected entity.

The available related links are:

◦ Create EAP Epic

◦ Create EAP Feature

◦ Create EAP Capability

Result
The EAP  entity is created successfully and the demand is moved to the Completed state. A 
message with a link to the created entity in Strategic Planning Workspace  that enables you to 
immediately view or work on the entity is displayed.

For information about the data migrated from the demand to the EAP entity, see Data migrated 
from demands to Enterprise Agile Planning (EAP) entities.

What to do next
View and work on the new entity in Strategic Planning Workspace  right away by selecting the link 
to the entity in the message that is displayed when the entity creation is successful.

Note: 
To access the entity at a later time, in the demand form, select the entity name in the 
Converted to  field in the EAP Details section.

For more information, see Strategic Planning  and Enterprise Agile Planning in Strategic Planning.

Create a monetary benefit plan for a demand

Demand benefit plans capture the potential benefits accrued by the demand when the demand 
is executed. Create a monetary benefit plan to specify the estimated benefit in a category for a 
fiscal period.

Before you begin
Role required: it_demand_manager

About this task
The monetary benefit plan breakdown records are automatically created when you save the 
benefit plan. The monetary benefit plan breakdown records specify the estimated and actual 
benefits at a granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The 
Monetary Benefit Plan Breakdowns related list shows the aggregated benefits for estimated and 
actual benefits for each fiscal period for the demand.
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Note: 
Converting a demand to a project or EAP  entity transfers the benefit plan from the demand 
to the target project or EAP  entity.

If you’re creating benefit plan for a demand with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and Demand Currency view enabled, the fields in 
the Financials  section differ from the Default view. For more information about the fields that are 
available only in the Demand Currency view, see Multicurrency fields in demand-related forms.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand form.

3. Select the Monetary Benefit Plans related list.

4. To create a monetary benefit plan, select New.

Note: 
To create a monetary benefit plan from the Financials Summary  page, select Manage.

5. On the Monetary Benefit Plan form, fill in the fields.

For a description of the field names, see Monetary Benefit Plan form.

Note: 
When you move the demand dates, the associated benefit plans also change 
accordingly based on whether the benefit plan is tied to the demand start date, or end 
date. The project property  Change Resource Plan, Cost Plan and Benefit Plan Start 
Date with Demand or Project Start Date Change  controls the behavior for demand date 
changes.

6. Select Submit.

What to do next
On the Benefit Plan form, view the benefit breakdown by fiscal period in the Monetary Benefit 
Plan Breakdowns related list.

Update a monetary benefit plan breakdown for a demand

Update a monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand.

3. Select the Monetary Benefit Plans related list.

4. Open the required monetary benefit plan.

5. In the Monetary Benefit Plan Breakdowns related list, select the information icon  for a 
monetary benefit plan breakdown.

6. Select Open Record.
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7. On the Monetary Benefit Plan Breakdown form, view and update the enabled fields.
For a description of the field names, see Monetary Benefit Breakdown form.

8. Select Update.

Create a non-monetary benefit plan for a demand

Create a non-monetary benefit plan to specify the estimated benefit in a category for a fiscal 
period. Demand benefit plans capture the potential non-financial benefits accrued by the 
demand when the demand is executed.

Before you begin
Role required: it_demand_manager

About this task
The non-monetary benefit plan breakdown records are automatically created when you save the 
benefit plan by selecting Automatic  or Manual  in the Breakdown Type  field. The non-monetary 
benefit plan breakdown records specify the estimated and actual non-financial benefits at a 
granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The Non-monetary 
Benefit Plan Breakdowns related list shows the aggregated benefits for estimated and actual 
non-financial benefits for each fiscal period for the demand.

Note: 
Converting a demand to a project or EAP  entity transfers the benefit plans from the demand 
to the target project or EAP  entity.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand form.

3. Select the Non-Monetary Benefit Plans related list.

4. To create a non-monetary benefit plan, select New.

5. On the form, fill in the fields.

For a description of the field names, see Non-monetary Benefit Plan form.

Note: 
When you move the demand dates, the associated benefit plans also change 
accordingly based on whether the benefit plan is tied to the demand start date, or end 
date. The project property  Change Resource Plan, Cost Plan and Benefit Plan Start 
Date with Demand or Project Start Date Change  controls the behavior for demand date 
changes.

6. Select Submit.

What to do next

• On the Benefit Plan form, view the benefit breakdown by fiscal period in the Non-monetary 
Benefit Plan Breakdowns related list.

• Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the demand for the hybrid benefit plans.

Update a non-monetary benefit plan breakdown for a demand

Update a non-monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.
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Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand.

3. Select the Non-monetary Benefit Plans related list.

4. Open the required non-monetary benefit plan.

5. In the Non-monetary Benefit Plan Breakdowns related list, select the information icon ( ) 
against a non-monetary benefit plan breakdown.

6. Select Open Record.

7. On the Non-monetary Benefit Plan Breakdown form, view and update the enabled fields.
For a detailed description of the field names, see Non-monetary Benefit Plan Breakdown form.

8. Select Update.

Associate monetary and non-monetary benefit plans

Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the demand.

Before you begin
Role required: it_demand_manager

About this task
You can associate a monetary benefit plan with a non-monetary benefit plan and vice versa.

Note: 
When you delete a benefit plan, its relationship with the associated benefit plan (if any) is 
also removed.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand form.

3. Select the Monetary Benefit Plans or Non-monetary Benefit Plans related list.

4. Select the name of a benefit plan that you want to associate.

5. Associate a monetary or non-monetary benefit plan.

6. Select Save.

Result
The selected benefit plan is associated with another plan.

What to do next
Select the View Associated benefit plan  related link to view the associated benefit plan.

Create a demand cost plan

Demand cost plans capture the costs of demands. Create a cost plan to specify the unit cost of a 
cost type for a fiscal period.
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Before you begin
Role required: it_demand_manager

About this task
The application automatically creates cost plan breakdown records when you save the cost 
plan. The cost plan breakdowns are records that specify the estimated and actual costs and 
the budget at a granular level for specific fiscal periods, such as FY16: M04 and FY16: M05. The 
demand cost plans are added to the parent program and portfolio.

The cost plan breakdowns that specify the estimated cost and actual cost at a granular level for 
a fiscal period of the demand cost plan are recalculated in the project currency. Similarly, the 
estimated breakdown amounts of the planned benefit and actual benefit of the demand benefit 
plans are recalculated in the project currency. The project currency amounts are then rolled up to 
the cost plan, benefit plan, and the project records.

If you want to use multiple currencies, create a cost plan for another currency.

If you’re creating benefit plan for a demand with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and Demand Currency view enabled, the fields in 
the Financials  section differ from the Default view. For more information about the fields that are 
available only in the Demand Currency view, see Multicurrency fields in demand-related forms.

Procedure

1. Navigate to All  > Demand  > Demands  > All  and open the required demand form.

2. In the related links, select Cost Plans.

3. To view the Financials Summary page in a grid, select Manage.

4. Add or edit a cost plan from the Cost Plans related list:

◦ To add a cost plan, select New.

◦ To update the details of an existing cost plan, select the record and then select Manage.

5. In the cost plan form, fill in the fields.

For a description of the field names, see Cost plan form.

Note: 
When you change the planned start date of a demand, the associated cost plans and 
resource assignments also change. The project property  Change Resource Plan and 
Cost Plan Start Date with Demand or Project Start Date Change  controls the behavior 
for demand date change.

6. Select Submit.

What to do next

• On the Demand form, view the breakdowns by fiscal period in the Cost Breakdown  related list.

• To recalculate the value in the Forecast  field, use the Calculate Forecast Amount  related link.

View financial summary of cost and monetary benefit plans

View a breakdown of the cost and benefit components of a demand to track the financials of your 
demands. The financial summary enables you to assess the progress of the demand and track 
financial changes and their impact on the demand over a period.

Before you begin
Role required: it_demand_manager
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About this task
View a detailed breakdown of the cost components of a demand using the Financial Summary 
tab. The total planned cost, budget cost, actual cost, and planned returns with their breakdowns 
are displayed in the form of read-only cards. The cost plans, benefit plans, and their breakdowns 
are provided in an editable grid view.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open a demand.

3. On the Demand form, select the Cost Plans  or Monetary Benefit Plans  related list.

4. Select Manage.

5. Optional:  Add additional fields, view plan details, or reorganize the financial data.

Create an expense line for a demand

A demand expense line is the cost associated with a specific source, such as a user or a fixed 
asset. Expense lines are part of demand cost plans.

Before you begin
Role required: it_demand_manager
Application required: Project Portfolio Management  with Financials

About this task
Only processed expense lines are considered for demands. You can create multiple expense 
lines for a project or demand.

Expense lines on the demands are used to record any expense incurred during demand 
evaluation only. You can’t associate expense lines to cost plans on demands. The actual cost 
incurred from the expense lines tied to the demand rolls up to the Demand actual costs  field.

When a demand is converted to a project, the expense lines remain with the demand, while the 
cost plans and budget are moved over to the project.

Procedure

1. Navigate to All  > Demand  > Demands  > All  and open the demand form.

2. In the Expense Lines related list, select New.

3. On the expense line form, fill in the fields.
For a description of the field names, see Expense line form.

4. Select Submit

Create and manage resource assignments for a demand

As a resource requester, find the availability of the resources, and create and manage the 
resource assignments for a demand.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand form.
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3. Select the Resource assignments  related list and select New.

4. On the Resource assignment new record form, fill in the fields.
For a description of the field names, see New Resource Assignment form.

5. Select Submit.

Recalculate costs of resource assignments of a demand

Recalculate the costs of all active resource assignments of a demand whenever the hourly rates 
change in the associated rate model so that the plan costs are up to date.

Before you begin
Confirm the following setup:

• The demand must be active.

• The demand must have an active rate model assigned.

Role required: demand_manager

About this task
This option recalculates the costs of all resource assignments of the demand at once. You can 
also open a resource assignment from the Resource assignments  related list to recalculate the 
resource costs of an individual resource assignment.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open a demand.

3. On the Demand form, right-click on the header bar and select the Recalculate Resource 
Costs.

4. In the Recalculate Resource Cost form, fill in the fields.
For a description of the field names, see Recalculate resource costs form.

5. Select OK.

Result

• Recalculates the selected resource costs of all the applicable resource assignments in the 
demand based on the latest hourly rates. The hourly rates are derived from the rate model 
associated with the demand.

• Updates the recalculated resource costs on the respective cost fields on the resource 
assignment form and the Resource assignments related list.

• Reflects the revised values in the respective cost fields of the demand.

Generate labor costs

Generate labor costs to view the expenses of resources using resource assignments and cost 
plans.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the Generate labor costs for demands and projects  scheduled job.
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3. Select Active.

4. On the Scheduled Script Execution form, fill the fields.
For a description of the field names, see Scheduled Script Execution Form.

5. Select Update.

Tip: 
Alternatively, as an admin, you can activate and define a scheduled job to generate labor 
costs at the required frequency. For more information, see Activate a scheduled job to 
generate labor costs.

Migrate budget of active demands to Next Experience

Migrate your demand budget to Next Experience  to manage the financials using Project 
Workspace.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Migrate baselines using one of the following options.

Note: 
After migration, you won't be able to view the budget on Classic UI. You're encouraged to 
manage budget using the Financials in Next Experience.

Migrate financial baselines of demands to Next Experience

Migrate the financial baselines of demands to Next Experience  to manage the financial using 
Project Workspace.

About this task
Next Experience  uses new data model that has two new tables Investment Baselines 
(sn_invst_pln_invst_investment_baseline)  and Investment Baseline Header 
(sn_invst_pln_invst_investment_baseline_header)  which are used to 
capture financial baselines. The financial baselines created for demands in classic experience 
aren’t visible in Next Experience. You can migrate the existing baselines from classic to Next 
Experience  as an on-demand activity for the required demands, or as bulk by activating and 
running a scheduled job.

Baselines view in the Next Experience  provides better insights to view and analyze the financial 
performance of your demands.

Unlike the financial baselines created using Next Experience, the financial baselines created in 
the Classic UI don’t capture the actual expenses along with planned costs as a default behavior. 
To have relevant information for baselines comparison, the actual costs are captured as part of 
the baseline migration using the processed expense lines as of the baseline creation date of the 
financial baseline.

For detailed information and use cases on using financials in Next Experience, see Managing 
financials for planning items in Portfolio Planning.
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Note: 
Starting March 2026 release, for customers using multicurrency, migration of financial 
baselines updates the baseline data in project currency to investment currency.

1. Existing demands that have only financial baselines but no investment baselines. With 
the migration, financial baseline will be migrated to investment baseline and you can view 
the migrated baseline from the sn_invst_pln_invst_investment_baseline 
table list view.

2. Existing demands that have both project and investment baselines, you need to run 
the scheduled job to populate the fields for investment currency in the baselines with 
the values from project currency. For more information, see Activate scheduled job to 
populate to multicurrency fields.

Before you begin
The data in project currency fields will be migrated to investment currency fields on migrating 
baselines for customers using multicurrency.

Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Migrate baselines using one of the following options.

Tip: 
After migration, you're encouraged to create financial baselines using the Financials in 
Next Experience.

Result
Financial baselines for the selected demands are migrated to Next Experience  and you can view 
them in the Baselines view.

What to do next

View and compare the migrated baselines  with any existing baselines or current baseline ( ).

Allocate budget to a demand

Set the budget of a demand according to the fiscal years.

Before you begin
Role required: it_portfolio_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All  and open the demand form.

2. In the related links, select Demand Budget.
The Demand Budget  dialog box opens.

3. Select the fiscal year for which you want to set the budget for the demand.

Tip: 
You can work on allocating lean budgets at the fiscal period level using the Investment 
Budget. For more information, see Enable lean budgeting for demands.

4. Enter the amounts for Capex Budget  and Opex Budget.
The Total Budget  is updated with the sum of capex and opex amounts.
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5. Select OK.

Note: 

◦ If the demand doesn’t have a cost plan, start date, and due date, then demand budget 
is distributed from the current month until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan and a due date but has a start date, then the 
demand budget is distributed from either:

▪ Start date (if the start date falls in the given budget fiscal year) until the end of the 
demand budget fiscal year.

▪ Start of the demand budget fiscal year until the end of the demand budget fiscal year.

◦ If the demand doesn’t have a cost plan and a start date but has a due date, then the 
demand budget is distributed from either:

▪ Current month until due date (if the due date falls in the given budget fiscal year).

▪ Current month until the end of demand budget fiscal year.
If the demand has a cost plan associated, then demand budget is distributed by 
honoring the cost plan fiscal periods.

Result
The demand budget for the selected year appears in the Demand Budget  related list. You can 
select the amounts in the list to revise them.

Enable lean budgeting for demands

Enable the Investment Budget option to allocate budgeting for demands at fiscal period.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Demands  > Demand  > All.

2. Open the required demand.
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3. Select the Additional actions and navigate to Configure  > Related 

Lists.

4. Select Investment Budget  from the Available column and add it to Selected column.

5. Select Save.

Manage lean budgeting for demand

Allocate budget for demands at each fiscal period instead of the entire fiscal year to reduce the 
overhead costs associated with traditional approach.

Before you begin

• Enable lean budgeting for demands

• Role required: sn_invst_pln.sn_spm_funding_user

Any user role with this specific role attached can add or manage the investment budgets.

Procedure

1. Navigate to All  > Demands  > Demand  > All.

2. Open the required demand.

3. In the Investment Budget related list, select New.

4. On the Investment Budget form, fill in the fields.
For more information about the fields and their description, see Investment Budget form.

5. Select Submit.
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Result
The allocated budget for a fiscal period is displayed in the Investment Budget related list.

Create a baseline of a demand

Create a financial baseline of a demand, which captures benefit and financial metric information 
(snapshot of cost plan, benefit plan, and demand-level financial metrics) at a particular moment 
in time.

Before you begin
You can create as many financial baselines as necessary and review the financials changes 
that have been made to the demand since the previous baseline. Any financial baseline doesn’t 
capture the actual cost component of the demand.

Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the required demand.

3. To create a financial baseline of a demand, use either of the options.

Compare financial baselines of a demand

You can compare baselines to review the variances in the financial data of a demand and see 
what changed.

Before you begin
Role required: it_demand_manager

About this task
You can create  multiple baselines at various stages of a demand's life cycle. For example, at the 
end of each phase or after every calendar month or quarter. Each baseline captures the financial 
data of the demand at a particular moment, providing a basis from which you can identify and 
review the changes made to the demand. Having multiple baselines and comparing them helps 
you track the performance of your demand.

If you’re creating demand with the PPM Standard Multicurrency (com.snc.ppm_multicurrency) 
plugin activated and Demand Currency view enabled, you can view and compare the financial 
details of the demand in baselines in the demand currency. For more information about the fields 
that are available only in the Demand Currency view, see Multicurrency in Demand Management.

Procedure

1. To compare financial baselines of a demand, perform one of the following options.

2. On the Financial Baseline form, select the baselines you want to compare from the two lists.
By default, the current and the most recent baselines are selected.

3. Select Compare.
The comparative data of the baselines are displayed in the following two sections:
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◦ The Financial Baseline Summary  section displays three widgets: the first two widgets 
contain the financial data of the two baselines, and the third widget contains their variance.

◦ The Financial Baseline Details  section displays the cost plans and benefit plans of the two 
baselines in two different grids. Each plan type has two rows corresponding to each baseline 
data.

Note: 
To see the color code of rows representing each baseline, select the baseline legend 

icon ( ).

4. Optional:  Add additional fields or reorganize the comparative data on the Financial Baseline 
Summary  section of the form.

◦ To toggle viewing the Financial Baseline Summary  section, select the Collapse  icon  or 

Expand  icon .

◦ To show or hide additional fields on the widgets in the Financial Baseline Summary  section, 

select the configuration icon  and select the field names.

Note: 
If the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin is activated, 
you can add additional fields to the baseline such as Total planned cost in demand 
currency, Operating budget in demand currency, and Financial return in demand 
currency.

(Optional) The selected field preferences are saved and are available when you reopen 
the Financial Baseline form.

◦ To reset to the default widget layout, select Reset to defaults.

◦ To view the financial information of the baselines in demand currency, toggle the Show 
Widgets in Demand Currency  button.

Note: 
This button is available only when the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin is activated.

5. Optional:  View details of financial data of the cost and benefit plans on the Financial Baseline 
Details  section of the form.

◦ To view a cost plan or benefit plan comparative data in yearly, quarterly, or monthly format, 
select the Year  or Quarter  or Month  views respectively.

◦ To view details of a fiscal year, select the Expand  icon  or Collapse  icon .

Realign resource assignments with demand

Planning and execution of your roadmap involves change in priority or timelines of your work. In 
such cases, you can adjust the resource assignment dates to match with the latest dates of your 
demands.

Before you begin
Migrate resource plans to resource assignments

Role required: it_demand_manager
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Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand.

3. Change the Approved start date  and Planned start date  to meet your organizational priorities.

4. Select Save.

5. Select the Realign assignments to demand  related link.

Result
In the Resource assignments related list, you can see the Start date of the resource assignments 
aligned with the demand start dates.

View demands

You can view existing demands at any time.

Before you begin
Role required: it_demand_manager

About this task
The Project  field displays the project name after the demand manager creates a project from 
the demand. The Risk, Value, and Size  fields display assessment metrics for the demand. This 
information appears on the Demands list.

Procedure

1. View demands using one of the following options.

a. All  > Demand  > Workbench.
The bubble chart and the list view on the demand workbench display all qualified demands.

b. All  > Demand  > Demands  > All.
Displays the Demands list.

2. Select the Number  field on the Demands list to view the Demand form.

3. View the status of the demand using the Stage  field.

This field is updated as the demand moves through the life cycle, from an idea to a demand to 
the resulting project, enhancement, change, defect, or planning item. At a glance, users can 
use this field to track the progress of a demand.

4. Hover over the Stage  field on the Demands list to view the progression of the idea along with 
the value of the State  field for each step in the progression:
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◦ Idea: If an idea is being evaluated, the pop-up window displays the current state of the idea.

◦ Demand: if an idea is promoted to a demand, the pop-up window displays the current state 
of the demand as well as the idea.

◦ Project, Enhancement, Change, or Defect: If a demand is accepted, the pop-up 
window displays the current state of the resulting artifact in addition to the demand and 

idea.

View an artifact created from a demand

As the demand manager, you can view an artifact created from a demand.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > Workbench.

2. Right-click a bubble that has an associated artifact.

3. Select View <artifact>.
This action displays the artifact form for the selected demand in a new tab.

View a demand summary

Hover over a bubble in the demand workbench bubble chart to display a summary of the 
demand information.

Before you begin
Role required: it_demand_manager

Procedure

1. Hover over a demand in the bubble chart to highlight the bubble and its label.

A bubble summary window also shows the demand name and the risk, value, and size data. 
Hovering over the bubble also highlights the corresponding demand row in the list view. 
Hovering over a demand in the list view highlights the corresponding bubble in the bubble 
chart.

Bubble Summary Window

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1237



Note: 
When hovering over a bubble, scroll down in the list view to see the corresponding 
highlighted demand row. If necessary, adjust the height of the list view or the bubble 
chart.

2. For multiple demands, some bubbles or labels overlap and are difficult to see.

Hover over a label to highlight the corresponding bubble.

Use when:

◦ Two or more bubbles have the same metrics and overlap directly.

◦ Several bubbles intersect and overlap.

◦ A bubble is only partially visible on the edge of the bubble chart.

Add details to demands

The demand manager typically works with a business relationship manager to identify 
stakeholders and elicit requirements, risks, and other important information.

The Demand Management application streamlines the stakeholder identification process. 
Auto-populating the list of stakeholders from the portfolio the user selects when filling out the 
demand form in the service catalog or in the Demand Management application. The Demand 
Management application also enables you to use assessments to automate some of the 
information gathering process.

Add demand tasks

Demand managers analyze business demands, approve demands, and create projects and 
enhancements. Many times activities such as effort, cost, risk, and benefit estimates are 
required to analyze a demand and create a business case for approval of the demand. A demand 
manager can create demand tasks and assign these tasks to individual resources or a group to 
perform these activities.

The resources assigned to the demand tasks then post time spent while working on a demand 
or demand task using a time card. The time card data is used to calculate actual effort and cost 
incurred on the demand task as well as demand.

To create demand tasks, scroll to the Demand Tasks  related list on the Demand form and select 
New  to create a record.

Add stakeholders

When a demand is submitted, the demand stakeholder list is populated automatically from the 
associated portfolio. You can also add stakeholders. To add a person to the stakeholder list, 
scroll to the Stakeholders  related list on the Demand form, select Create new  to create a record, 
and fill in the form. To add existing stakeholders to the demand, select Add existing.

When adding a stakeholder from the demand form, the Portfolio  field displays the portfolio that 
was selected on the Demand form.

A demand can have multiple stakeholders and a stakeholder can be associated with multiple 
demands.

The newly added stakeholder is automatically associated with the current demand and any other 
demands that use the same portfolio.
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Add requirements

Demand managers can create as many requirements as needed, but requirements aren’t 
required. Typically, the stakeholders associated with a demand request have insights into what 
the requirements are for a demand request to be completed.

Demand managers use the Requirement form to describe the requirement and assign an owner 
who is responsible for making sure that the requirement is met. When a requirement is complex, 
demand managers can associate planned tasks, such as project tasks, with the requirement. The 
demand manager assigns and tracks the tasks until they’re complete.

To add a requirement to a demand, follow these steps:

1. Open a Demand form and select New  from the Requirements related list.

2. On the Requirement form, fill in the fields. For a description of the field names, see 
Requirement form.

Add resource assignments

Resource assignments are another source of information that decision makers can use 
when evaluating demands. You can create resource assignments for a demand from the 
Resource assignments  related list, which appears only if the Resource Management Workspace 
application is activated.

To add a resource assignment to the demand, scroll to the Resource assignments  related list on 
the Demand form and select New  to create a record.

Add and recalculate strategy and goal allocations

The Strategy Allocations related list displays the percentage of the demand's total cost and 
benefits allocated toward the achievement of the associated strategies. The Goal Allocations 
related list displays the percentage of demand's total cost and benefits allocated toward 
achievement of goals associated with the demand. For more information, see Allocate or modify 
the strategy and goal percentage for a demand.

Recalculate and update cost field values in the Strategy and Goal Allocation tabs. Use the 
Recalculate Strategy and Goal Allocation related link to update the demand's total cost and 
benefits when strategy and goal allocations for the demand are changed. For more information, 
see Strategic Spend Tracking for PPM.

Note: 
These related lists and related links appears only when Strategic Spend Tracking for PPM 
is installed. This application is available on ServiceNow Store. You must switch to the 
Strategic Alignment  view to see them. If these lists and links aren’t available on the form 
view that you’re using, ask your administrator to configure the demand form to add them. 
For more information, see Install Strategic Spend Tracking for PPM.

Add goal/target relationships

The Goal/Target Relationships related list displays the relationship between a goal and a 
planning item, strategic item, or any other item such as a demand.

Allocate funds

If your demand represents a significant, multi-year investment and you must distribute funding 
across related work, you can allocate funds from your demand. By allocating funds, you can 
directly support one or more projects, epics, or programs linked to the approved demand.
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This link appears only if you have the Investment Funding  plugin activated, an existing 
corresponding investment record for this demand, and the investment_user role.

RIDAC (Risk, Issue, Decision, Action, and Request Changes) records for a demand

RIDAC is an acronym for Risk, Issue, Decision, Action, and Request Changes records. Create a 
risk for your demand that you can convert to other records during the demand life cycle. Track 
issues and avoid manual copying of relevant details in related records.

As a demand progresses through the demand life cycle, a risk might result in an issue or a new 
issue might occur. Once you have a risk record, you convert that record into related records such 
as issues, actions, or decisions. This conversion and association of records helps you analyze 
and identify patterns, trends, and probable resolution for planning future demands. The ability to 
convert records provides you with the following advantages:

• Ability to create related records without having to enter the relevant information manually.

• Helps you analyze and identify patterns, trends, and probable resolution for planning future 
demands.

• Enables you to view a consolidated list of all converted RIDAC records using the View RIDAC 
related link on the Demand form.

Consider the following points before converting or associating RIDAC records:

• You can convert one record to another only in the RIDAC sequence. For example, you can 
convert a risk to an issue, decision, action, or request change but you can’t convert an issue to 
a risk or a decision to an issue. The following diagram illustrates the RIDAC process flow.

RIDAC flow
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• You can convert one record into multiple RIDAC records. For example, you can create multiple 
issue records from one risk record.

• You can associate one record with multiple different records. For example, you can link one 
issue record to multiple different risk, decision, action, or request change records. For more 
information, see Associate existing RIDAC (risks, issues, actions, decisions, and request 
changes) records for a demand.

Add risks for a demand

Add a risk to a demand to identify, analyze, prioritize, plan, and track a risk during any phase 
of the demand life cycle. Assess potential problems and the severity of their impact to take 
informed decisions about the demand.

Before you begin
Role required: it_demand_manager

About this task
A risk is any uncertain event that can potentially impact the success or outcome of a demand. 
For example, an incorrect estimate of factors like financial outlay or resource assignments 
can cause schedule slippage. Another example of a risk is a change in demand requirements. 
Recording risks ensures that decision makers have all relevant information when assessing a 
demand's progress. The demand risks are added to the parent program and portfolio.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand to which you want to add risks.

3. From the Risks related list, select New.

4. On the Risk form, fill in the fields.
For a description of the field names, see Risk form.

5. Select Submit.

What to do next

• Convert an existing risk to an issue, decision, action, or request change and close the risk. For 
more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) 
record to another for a demand.

• Associate the risk with existing issues so you can track dependencies and recognize trends 
for the future. For more information, see Associate existing RIDAC (risks, issues, actions, 
decisions, and request changes) records for a demand.

Configure a custom Risk rank and Risk value for a demand

Configure custom risk rank and value scores (such as High-Medium, Medium-Low, or Absolute-
Low) to rate the impact and probability factors for a risk.

Before you begin
Role required: pps_admin

About this task
Use the Risk Value Lookup module to set up the risk rank and risk value for a specific 
combination of risk impact and probability. The system uses these values to determine the 
degree of risk (Absolute, High, Medium, Low) based on the impact and probability factors of a 
risk.
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The value in the Probability  field is multiplied by the value of the Impact  field to generate the 
values for the Risk rank  and corresponding Risk value  in the Risk form.

By default, you can use the following impact, value, and probability scores for a risk to create a 
risk rank and risk value score:

• Absolute

• Low

• Medium or Moderate

• High

For example, a risk might have high probability and medium impact but you might want to 
consider it as an overall low risk for the demand. In that case, you would configure the Risk Value 
Matcher form with the following values:

• Impact = 2 Medium

• Risk Rank Color = Green

• Probability = High

• Probability Number = 1

• Risk Value = 3 Low

The following image illustrates a Risk 

form.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Risk Value Lookup.

2. Select New.

3. On the risk value matcher form, fill in the fields.
For a description of the field names, see Risk value matcher form.

4. Select Submit.

Add issues for a demand

Add an issue to a demand to escalate a risk or to track an unexpected problem. For example, a 
technical malfunction or resource unavailability that occurs during any phase of the demand life 
cycle. If the issue remains unresolved, unnecessary conflicts, delays, or even a failure can occur.

Before you begin
Role required: it_demand_manager
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Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand to which you want to add an issue.

3. From the Issues related list, select New.

4. On the Issue form, fill in the fields.
For a description of the field names, see Issue form.

5. Optional:  Search in the knowledge base for any article related to the issue.

a. Select the search knowledge icon .

b. If you find relevant articles, select the title of an article to view its content.

c. If you want to include the content of the article in the issue, select Attach to Issue.
The article content is copied in to the Description  field of the Issue form. You can modify the 
text if necessary.

6. Select Submit.

What to do next

• Convert an existing issue to a decision, action, or request change and close the issue. For 
more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) 
record to another for a demand.

• Associate the issue with your existing risks so you can track dependencies and recognize 
trends for the future. For more information, see Associate existing RIDAC (risks, issues, actions, 
decisions, and request changes) records for a demand.

Add decisions for a demand

As a demand manager, develop a plan to manage risks and issues proactively with solutions. 
Add the solution for a risk or issue to a demand in the form of a decision. You can also convert a 
risk or an issue to a decision or a decision to an action or a request change.

Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand to which you want to add a decision.

3. From the Decisions related list, select New.

4. On the Decision form, fill in the fields.
For a description of the field names, see Decision form.

5. Optional:  Search in the knowledge base for any article related to the decision.

a. Select the search knowledge icon .

b. If you find relevant articles, select the title of an article to view its content.
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c. If you want to include the content of the article in the issue, select Attach to Decision.
The article content is copied in to the Description  field of the Decision form. You can modify 
the text if necessary.

6. Select Submit.

What to do next

• Convert a decision to an action or request change and close the decision. For more 
information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) 
record to another for a demand.

• Associate the decision with your existing issues and risks so you can track dependencies 
and recognize trends for the future. For more information, see Associate existing RIDAC (risks, 
issues, actions, decisions, and request changes) records for a demand.

Add actions for a demand

Add actions that are required for resolving an issue or risk for a demand. You can also convert 
a risk, issue, or decision to an action based on your analysis and plan for resolution of a risk or 
issue.

Before you begin
Role required: it_demand_manager

About this task
After analyzing the risks and issues and taking a decision on how to manage those risks and 
issues, add an action for resolving the risk or issue.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand to which you want to add an action.

3. From the Actions related list, select New.

4. On the Action form, fill in the fields.
For a description of the field names, see Action form.

5. Optional:  If the action requires approval from other stakeholders, request approval with a due 
date using the Approval  and Due date  fields.

6. Select Submit.

What to do next

• Convert an action to a request change and close the action. For more information, see Convert 
one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for a 
demand.

• Associate the action with your existing risk, issue, and decision records so you can track 
dependencies and recognize trends for the future. For more information, see Associate 
existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand.

Add Request Changes to a demand

As a demand manager, you might create a request change as the outcome of the action taken 
to resolve an issue or mitigate a risk. The request change might result in changing the demand's 
scope, resource requirement, cost, or schedule to minimize the impact of a risk or issue.
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Before you begin
Role required: it_demand_manager

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand to which you want to add a request change.

3. From the Request Changes related list, select New.

4. On the Request Change form, fill in the fields.
For a description of the field names, see Request change form.

5. Select Submit.

What to do next
Associate the request change with your existing risk, issue, decision, and action records so you 
can track dependencies and recognize trends for future. For more information, see Associate 
existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand.

Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for 
a demand

Convert one RIDAC record (risk, issue, action, decision, and request changes) to another, in that 
order to retain the record information instead of having to create a record manually and to track 
the issue more easily.

Before you begin
Role required: it_demand_manager

About this task
When you convert a RIDAC record to another record, the values for the Short description, 
Requester, and Assigned to  fields are carried forward.

You can also specify to close the parent record on creation of the new record instead of manually 
closing the parent record.

You can also view the consolidated list of all the converted RIDAC records using the View RIDAC 
related link on the Demand form and View RIDAC  in the application navigator of the Demand 
module.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand for which you want to convert a risk, issue, decision, action, or request 
change record to another RIDAC record.

3. From the Demand form related list, select the risk, issue, decision, action, or request change 
record to open the form view.

4. Select the Convert to RIDAC  related link on the form.

5. Optional:  On the Convert dialog box, from the select task type list, select the RIDAC record to 
which you want to convert the selected record.
For example, if you wanted to convert a risk to an issue, you would select Issue.

6. Optional:  Modify the text in the Short description  field, which is copied from the parent 
record.

7. Optional:  Change the default assignment copied from the parent record in the Assigned to 

field by selecting the lookup icon  and selecting a different user.
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8. Optional:  If you want to close the parent RIDAC record on creation of the new record, select 
the close parent record option.
The label of the close parent record option changes depending on the parent record type. 
For example, if the parent record is Risk and you’re converting it to an issue record, the close 
record option would appear as Close Risk.

9. Select OK.

Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for 
a demand

Link existing RIDAC records (risks, issues, actions, decisions, and request changes) to one 
another for your demand. Associating RIDAC records with each other enables you to keep a 
record of risks or issues and their outcome for analysis at demand closure and planning. It also 
helps to track the risks and issues throughout the demand life cycle.

Before you begin
Role required: it_demand_manager

About this task
You can associate one record with multiple different records. For example, you can link one issue 
record to multiple risk, decision, action, or request change records. Additionally, you can view the 
converted RIDAC records such as risks converted to issues, decisions, actions, and changes, 
using the View RIDAC related link.

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select the demand for which you want to associate one RIDAC entry to another.

3. In the Demand form related list, select the RIDAC record.

4. On the form, select the Associate RIDAC  related link.

5. In the Associate dialog box, from the Select type list, select the RIDAC record to which you 
want to associate the selected record.
For example, if you wanted to associate a risk to an issue, you would select Issue.

6. Select the record number to which you want to associate the selected record from the 
Associate to list.
For example, if you wanted to associate the selected risk to issue (ISU0010003), you would 
select ISU0010003.

7. Select OK.

Reset a demand to Draft state

A demand can be moved back to the Draft state, if necessary.

Before you begin
Role required: it_demand_manager

About this task
A demand can be reset to Draft from the Completed, Approved, Screening, or Submitted states, 
or until an artifact such as a project or enhancement is created from it. The Reset to Draft  option 
is unavailable if the demand is in the Qualified state.
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Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Open the required demand form.

3. Select Reset to Draft.
A confirmation message appears if there are:

◦ Active assessments pending with stakeholders, or

◦ Resource assignments are created for the demand

4. Select the check box to replan the allocated resource plans that have no actual hours 
reported.

5. Select OK.

Result

• The demand is moved to the Draft state.

• All the score values in Assessment Data  tab are reset to default.

• All active assessments for the demand are canceled. New assessments are triggered when the 
demand moves to the Screening state and if the Assessment Required  field on the demand 
form is set to true.

Delete demands

Demands can be deleted only while in the Pending  state.

Before you begin
Role required: it_demand_manager or it_demand_user

About this task
When you delete a demand, all data related to the demand, such as risks, demand tasks, 
requirements, and decisions are deleted. However, the stakeholders aren’t deleted from the 
Stakeholder Register [dmn_stakeholders_register] table.

If a project is already created from a demand, its reference is removed from the project along 
with the data related to the demand. However, the project isn’t deleted from the database.

To delete a demand:

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Do:

◦ Select the demand to open the demand form and then select Delete.

◦ Select the check box next to the demand and then select Delete  from the Actions  list.

Move and resize a demand

As the demand manager, you can move and resize bubbles in the bubble chart.

Before you begin
Role required: it_demand_manager

About this task
Moving and resizing bubbles in the bubble chart updates the corresponding values for the 
demands in the list view.
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Procedure

1. Select and drag a bubble left or right along the horizontal axis to decrease or increase the risk 
of the demand.
The new risk for the demand is updated in the Risk  column.

2. Select and drag a bubble up or down along the vertical or Y axis to increase or decrease the 
value of the demand.
The new value for the demand is updated in the Value  column.

3. Select a bubble to open a sizing window where you can increase or decrease the size of the 
bubble.

The new size of the demand is updated in the Size  column.

Train the similarity solution for Demand Management  to find similar demands

Train the Similar Demands solution definition is included within the Predictive Intelligence for 
PPM capability to find related demands when creating a demand.

Before you begin
Confirm that the Predictive Intelligence for Contextual Search plugin 
(com.snc.contextual_search_ml), PPM Standard plugin (com.snc.financial_planning_pmo), and 
Predictive Intelligence for PPM plugin (com.snc.ppm_ml) are activated. For more information 
about Predictive Intelligence, see Predictive Intelligence .

Role required: admin

Procedure

1. Navigate to All  > Predictive Intelligence  > Similarity  > Solution Definitions.

2. In the Similarity Definitions list, search for and select the Similar Demands solution definition 
(ml_sn_global_global_similar_demands).

3. On the Similarity Definition form, verify the default field values for demands.
For more information about the Similarity Definition form fields, see Create and train a similarity 
solution .

4. Select Update & Retrain.

5. Open the Similarity Definition form for the Similar Demands solution definition 
(ml_sn_global_global_similar_demands).

6. In the ML Solutions related list, view the training solution progress in the Progress  column.

Note: 
Alternatively, you can select the link for the solution in the Active  column. On the ML 
Solution form, select the Show training progress  related link to check the training 
solution progress.

Result
When the solution is complete, the similar demands appear in the Similar demands section on 
the Demand form.
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What to do next

• Review similarity examples: On the Similarity Definition form, in the ML Solutions related 
list, when Progress  is 100%, in the Active  column, select the link for the solution. On the ML 
Solution form, select the Similarity Examples  related link to view the Similarity Examples list.

• Update the similarity score threshold: On the ML Solution form, on the Solution Statistics  tab, 
enter the required value in the Similarity Score Threshold  field. Right-click the ML Solution 
form and select Save.

• Test the prediction output for the records: On the ML Solution form, on the Test solution  tab, 
enter your text in the Short description  field and the maximum number of expected results in 
the Top N  field, and then select Run test. The results above the similarity score threshold value 
are displayed.

Related topics

Predictive Intelligence

Predictive Intelligence for Demand Management

Create a demand

Identify similar records using Now Assist for Strategic Portfolio Management (SPM)

Detect similar demand records using the identify similar records Now Assist  skill. This skill 
detects similar demand records based on contextual similarity in the name, description, and 
business case content.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

If you have custom roles that require access to this skill, update the ACLs (access control lists) 
for those roles that require access. For more information, see Implement access control in Now 
Assist AI agents .

Role required: it_demand_user

Procedure

1. Navigate to All  > Demand  > Demands  > Create New.
Alternatively, you can create a demand from Self-Service  > Demands  > Create New.

2. On the Demand form, fill in the Name, Description, and Business case  fields.
For a description of the field names, see Demand form.

3. Select Save.

4. Select the Identify similar demands  button to detect similar demand records.

Result
The similar demands identified by Now Assist  are displayed in the top banner and the Similar 
Demands related list.
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Note: 

• If any similar records are present on the demand record, the related list is updated to 
display the list of identified similar records.

• If there are no identified similar records for a demand, a message is displayed to convey 
the same and the related list remains empty.

What to do next
View the full details of the identified similar demand records by selecting the demand number 
link from the Similar Demands related list.

Associate AI systems with demands

Add and manage AI system associations directly from the AI Associations  tab in Demand 
Management.

Before you begin

• The AI Control Tower  plugin must be installed. For more information, see Activation and 
installation of AI Control Tower .

• The investment type of the demand is set to artificial intelligence.

• Role required: it_demand_user, it_demand_manager

About this task
Add and manage AI system associations directly from the AI Associations tab in a demand form.

You can select the impacted AI systems for the demand. If the required AI systems aren’t 
available, you can create AI systems using the Create AI System  related link directly within the 
demand workflow. You’re navigated to the AI Control Tower  to create the AI system. The created 
AI system is then available for selection in the Impacted AI Systems  list on the demand form.
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Procedure

1. Access the demand form in one of the following ways.

◦ Navigate to All  > Demand  > Demands  > Create New.

◦ Navigate to All  > Demand  > Demands  > All  and select a demand.

2. Navigate to the AI Associations  section of the demand form and fill in the 

fields.

AI Associations section

Field Description

Product Product or system that the demand relates to.

Impacted AI systems Impacted AI systems associated with the 
demand. You can select existing AI systems 
from the list or remove systems that are no 
longer relevant.

3. Save the demand by selecting Save.

4. Optional:  Select the Create AI System  related link to create an AI system in the AI Control 
Tower.

Note: 
This related link is available for users with the sn_ai_steward role.

For more information on creating AI systems, see Create AI system assets .

Summarize demands with demand summarization skill

Summarize demand records using the demand summarization skill. The skill reviews the demand 
fields and helps create a clear summary of the demand.

Before you begin

Important: 
This Now Assist  skill is turned on by default. The skill will be automatically available to 
appropriate role users for the application. For more information, see Now Assist skills, 
agents, and agentic workflows on by default .

Role required: it_demand_user, it_demand_manager
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If you have custom roles that require access to this skill, update the ACLs (access control lists) 
for those roles that require access. For more information, see Implement access control in Now 
Assist AI agents .

Procedure

1. Navigate to All  > Demand  > Demands  > All.

2. Select a demand from the All Demands  list.

3. Select the Summarize  button on the demand form to generate a summary of the demand.

Result
The summary generated by Now Assist  is displayed in the summary card.

Note: 
Select the copy icon to copy the generated summary for further use.

Demand Management  reference

Reference information to provide additional details about Demand Management  such as the 
fields, user roles, tables, guidelines, and domain separation information.

Demand tasks

A demand task is a unit of work, created within a demand, to break down initial planning activities 
before converting the demand into a project, change, enhancement, or defect.

You can create a demand task  from the Demand Tasks  related list to delegate activities that are 
helpful for assessing demand feasibility. Demand tasks differ from project tasks in the following 
aspects:

• Planned dates, actual dates, and original dates are part of project tasks not demand tasks.

• The due date indicates the date on which the task is targeted for completion and doesn’t 
affect the demand workflow. Project tasks, however, affect the project completion dates if the 
planned dates and actual dates are changed.

• Don’t support the creation of nested demand tasks.

• Don’t support task constraints such as the settings Start ASAP and Start on a specific date.

• Don’t support an execution type such as Agile, Waterfall, or Hybrid.
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Resource assignment

Assign resources for a demand task using the Assigned to, Additional Assignee list, and 
Assignment Group  fields. Don’t create and use resource assignments to allocate resources or 
groups to a demand task or submit the time spent on the demand. If you associate a resource 
assignment with a demand task, the associated resource plan isn’t transferred to the work entity 
created from that demand.

The resource assignments aren’t associated with the demand by default. Make sure that you 
don’t use the resource assignments that you created for the future work entity created from the 
demand to submit the time spent on a demand.

When you submit a time card for a demand, the time and cost incurred aren’t transferred to 
the work entity created from the demand. The time and cost remain within the demand as the 
demand cost and effort.

Resources assigned to a demand task can submit the time spent on it using a time card. For 
more information, see Submit a time card for a demand task.

Actual cost and effort for a demand task

The actual effort of the work performed on the demand task is derived from the time card. The 
actual cost is derived from the hourly resource rate defined in the rate model, default labor rate, 
or default system property. The actual cost and effort for a demand task are then rolled up to 
derive the actual cost and effort for the associated demand. For more information, see Actual 
cost and effort calculation for a demand and demand task.

Add work items to a Demand

Based on the selected demand task category and role assigned to you, you can use the demand 
task form to:

• Add a cost plan to a Demand

• Add a resource assignment to a Demand

• Add a benefit plan to a Demand

• Add risks to a Demand

Actual cost and effort calculation for a demand and demand task

The actual cost and effort are realized cost incurred and time spent for the work performed on 
a demand and demand task during a specific time period. Actual cost and effort are calculated 
based on the approved time cards and hourly rate for the resources and vary based on how the 
hourly rate for the resource is derived.

Working on a demand task and demand involves cost and time, which add to the overall 
expenditure of converting a demand to a product, feature, or enhancement. Demand managers 
must therefore know the actual cost and effort incurred in assessing and planning activities for a 
demand. The calculation for actual cost is derived by multiplying the hours reported in the time 
card by the hourly rate of the resource. The actual effort for a demand task is calculated based on 
the hours reported in the time card.

The actual effort and cost for the demand tasks are then rolled up for calculating the actual effort 
and cost for the demand. The calculation of the actual cost and hourly rate for a resource is 
derived as follows:
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• If a rate model is associated with the demand, the actual cost is calculated based on the hourly 
rate defined in the rate model.

• If a rate model is absent or if an hourly rate isn’t found in the rate model, then the hourly rate is 
derived from the default labor rate.

• If an hourly rate isn’t found in the default labor rate, then the hourly rate is derived from the 
default system property.

Don’t create and use resource assignments for allocating resources or groups to a demand task. 
The resource assignments that you create in the demand are used for the resource estimation 
of the work entity that would be created from the demand. These resource assignments are 
automatically moved to the resulting work entity when a demand is qualified and converted.

When you submit a time card for a demand the actual effort and cost aren’t reflected in the 
resource assignment, as the resource assignments aren’t associated with the demand by 
default. The actual cost and actual effort for the demand remains with the demand and aren’t 
transferred to the project created from the demand even if you manually associate a resource 
assignment with the demand.

If a resource spends extra hours working on a demand that aren’t associated with demand tasks, 
then this time must also be recorded. The resource submits the time card for recording the extra 
hours spent on the demand using the Time Sheet Portal. This extra cost and effort is added to 
the demand but isn’t reflected in the actual cost and effort for the demand tasks.

The actual cost and actual effort for the demand as derived from the time card data is added to 
the total actual cost and effort for the demand tasks. The values in the Demand Actual Cost  and 
Demand Actual Effort  fields are calculated as follows:

• Demand Actual Cost: actual cost of all the demand tasks + actual cost of extra activities

• Demand Actual Effort: actual effort of all the demand tasks + actual effort of extra activities

If a demand has no task or assigned resource, you can capture the actual cost by submitting a 
time card against the demand. Once the time card is approved, an expense line is created on 
the demand. The expense line is then processed and the actual cost of work for that time card is 
rolled up to the demand into the Demand Actual Cost column.

The following example demonstrates the actual cost and effort calculation for a demand task and 
its rollup to the demand.

Example: Actual cost and effort calculation based on the demand tasks

For a demand (D1), the demand manager delegates activities such as initial assessment, cost 
estimate, and effort estimate. To delegate these activities, the demand manager creates three 
demand tasks (DT1, DT2, and DT3) and assigns resources R1, R2, and R3 to each demand task 
respectively.

The hourly rate defined for the resources in the rate model, default labor rate, and default system 
property are listed in the following table.

Hourly resource rate

Resource
Hourly rate in the rate 
model

Hourly rate in the 
default labor rate

Hourly rate in the 
system property

R1 $200 $150 $50

R2 $250 $200 $50
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Hourly resource rate  (continued)

Resource
Hourly rate in the rate 
model

Hourly rate in the 
default labor rate

Hourly rate in the 
system property

R3 $150 $100 $50

Each resource spends a total of eight hours while working on the assigned demand task and 
submits a time card.

Actual cost and effort calculation for demand task: The demand task actual cost and effort are 
calculated and displayed on the Demand Task  form. The totals differ depending on the method 
used to derive them.

Scenario 1 shows how the total is calculated if the resource hourly rate is derived from the rate 
model.

Rate derived from the rate model

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 200 * 8 = $1600 250 * 8 = $2000 150 * 8 = $1200

Scenario 2 shows how the total is calculated if the rate model isn’t associated with the demand 
and the resource hourly rate is derived from the default labor rate.

Rate derived from the default labor rate

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 150 * 8 = $1200 200 * 8 = $1600 100 * 8 = $800

Scenario 3 shows how the total is calculated if the rate model isn’t associated with the demand 
and the resource hourly rate is derived from the default system property.

Rate derived from the default system property

Actuals Demand task DT1 Demand task DT2 Demand task DT3

Actual effort 8 hours 8 hours 8 hours

Actual cost 50 * 8 = $400 50 * 8 = $400 50 * 8 = $400

Example: Actual cost and effort roll up to a demand

The Demand Actual Cost  and Demand Actual Effort  fields on the Financials tab of the Demand 
form are populated with the sum of actual costs and actual effort of all the demand tasks.
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1. If the resource rate for the demand task is derived from the rate model (Scenario 1), the value 
in the Demand Actual Cost field is displayed as $4800. The value in the Demand Actual Effort 
field is displayed as 24 hours.

2. If the resource rate for the demand task is derived from the default labor rate (Scenario 2), the 
value in the Demand Actual Cost field is displayed as $3600. The value in the Demand Actual 
Effort field is displayed as 24 hours.

3. If the resource rate for demand task is derived from the default system property (Scenario 3), 
the value in the Demand Actual Cost field is displayed as $1200. The value in the Demand 
Actual Effort field is displayed as 24 hours.

Demand Management key terms

Important terms in Demand Management  are listed in the table.

Demand Management  Key Terms

Term Description

Portfolio A collection of demands managed as a group to achieve strategic and 
operational objectives.

Assessable 
record

A demand record that you want to evaluate for metric type demand.

You evaluate the assessable records with metric categories and metrics, which 
define traits and values to assess.

Metric A trait or value used to evaluate assessable records.

A metric can measure subjective values in an assessment questionnaire or 
gather objective values in a database query run by a script.

Examples of metrics include perceived value of demands and return on 
investment for a demand.

Metric type A characteristic that defines a set of records you want to evaluate.

Demand management comes with the metric type demand, which uses records 
from the Demand [dmn_demand] table.

Metric 
category

A theme for evaluating assessable records. Categories contain one or more 
individual metrics, which define specific traits or values that comprise the theme.

Examples of categories include return on investment and cost. Set filter 
conditions to control which assessable records to evaluate for the metrics in a 
category.

Stakeholder A person affected by the demand or who has interest in the demand.

Scorecard A visual breakdown on performance of an assessable record based on 
assessment results.

Use scorecards to view various data summaries for one assessable record and 
to compare the ratings with other assessable records.

Requirement An extra item that must be present or an extra action item that must be finished 
before a demand request closes.
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Demand Management  Key Terms  (continued)

Term Description

Demand 
Task

A unit of work, created within a demand, to break down initial planning activities 
before converting the demand into a project. A demand task isn’t a planned task 
like a project task.

Stage fields

The Stage field on the Ideas list displays the current state of an idea as it moves through the 
demand life cycle. The current state includes from an idea to a demand and then to the resulting 
project, enhancement, change, or defect.

The result of an idea depends on the initial settings in the Category  and Type  fields on the 
Demand form. The Stage  field also appears on the Demands list. The Stage  field is a display only 
field and can’t be searched or sorted.

Important: 
The Stage  fields are no longer available starting from the New York  release. Any instance 
provisioned in New York  or later won’t have a Stage field on the Idea table. However, the 
Stage  fields are available if you’re upgrading from an older release to New York  or later.

A new idea is created in the Submitted  state. An accepted idea is updated to the Accepted  state 
and a deferred idea is updated to the Skipped  state. When a demand is closed, the associated 
idea is marked as Complete.

Hovering over the Stage  field displays a pop-up window that shows the progression of the idea 
along with the value of the State  field for each step in the progression.

• Idea:  if an idea is being evaluated, the pop-up window displays the current state of the idea.

• Demand:  if an idea is promoted to a demand, the pop-up window displays the current state of 
the demand as well as the idea.

• Project, Enhancement, Change, or Defect: if a demand is accepted, the pop-up window 
displays the current state of the resulting project, enhancement, change, or defect in addition 
to the demand and idea.

Composite Fields

A composite field combines information from two fields in a table to form a single field.

For example, the Task  field on the Project Tasks list displays the short description and the project 
task number. The short description appears above the project task number. The project task 
number appears and is a link to the Project Task form.
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Composite field

Use a composite field

• Editing a composite field changes the short description. Editing the short description changes 
the composite field.

• Sorting on a composite field is based only on the short description and not the number.

• Searching on a composite field is enabled for both the short description and the number:

◦ To search by the number using the list header, enter an asterisk (*) before the search term. 
For example, *PRJTASK0010016.

◦ To search by the number using the filter, create a condition similar to: [Task] [contains] 
[PRJTASK0010016].

Domain separation and Demand Management

Domain separation is supported in Demand Management. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Data migrated from demands to artifacts

Data fields that are migrated from a demand to an artifact when the artifact is created from the 
demand.
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Data migrated from a demand to a created project

Data fields are migrated from a demand to a project when the project is created from the 
demand.

Field type Description

Demand The following demand fields are migrated to a 
project:

• Description

• Business case

• Investment Class

• Investment Type

• Risk of performing

• Risk of not performing

• Enablers

• Barriers

• In scope

• Out of scope

• Assumptions

• Business Unit

• Department

• Impacted Business Units

• Business Capabilities

• Priority

• Impact

• Rate Model

• Approved start date

• Approved end date

• Short description

• Program

• Domain

• Goals

• Strategies

• Impacted Business Applications

• Configuration item

• Company

• Urgency

• Project Manager

• Project currency

• Project calculation
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Field type Description

Resource assignments Resource assignments are migrated to a 
project by updating the task reference from 
the demand to project.

Requirements Demand requirements.

Financial records Financial records such as cost plans and 
breakdowns, benefit plans and breakdowns 
(monetary and non-monetary), and demand 
budgets are migrated to a project. This 
process updates the task reference from 
demand to project.

RIDAC RIDAC entities are migrated to a project by 
updating the task reference from demand to 
project. The migrated entities include the risks, 
issues, decisions, project actions, request 
changes, and RIDAC_m2m records.

Assessment The following assessment data fields are 
migrated to a project:

• Risk

• Value

• Score

• T-Shirt size

Stakeholders Stakeholder records.

Project Currency Financial If the multicurrency feature is active, the 
project financial fields are calculated 
according to the project currency and 
reference rate.

Data migrated from demands to Enterprise Agile Planning  (EAP) entities

Data fields are migrated from a demand to an EAP  entity when the entity is created from the 
demand.

Data fields migrated from demand to EAP entity

Field type Description

Demand The following demand fields are migrated to 
the created entity:

• Business Capabilities

• Product

• Primary target

• Team

• Demand manager

• Description

• Department
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Data fields migrated from demand to EAP entity  (continued)

Field type Description

• Priority

• Approved start date

• Approved end date

• Short description

• Primary goal

• Strategic program

• Service offering

• Business service

• Business applications

• Score

• Requested by

• Capital expense

• Operating expense

• Start date

• Program

• Total planned cost

• Investment Class

• Portfolio

• Investment Type

• ROI %

• Rate Model

• Model ID

• Expense type

• Financial benefit

Resource assignments The resource assignments of a demand are 
migrated to the created entity.

Financial records Cost plans and breakdowns, benefit plans and 
breakdowns (monetary and non-monetary), 
and investment budgets are migrated to the 
created entity.

Attachments Demand attachments.

Goal/target relationships Goal/target relationships of the demand.

Demand Management forms

Field information for forms used in the Demand Management application.

Action form

Use an action form to add an action to a demand.
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Action form

Field Description

Number System-generated number with a configurable prefix.

State Current state of the action. All new action records are created with the state set to 
Open.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped

Priority Urgency for implementing or approving the action based on impact.

Estimated 
Cost

Estimated cost the action generates.

Impact The impact on the outcome of the demand if you don’t implement the action.

Approval Status of approval from the stakeholders for the action. The available options are: 
Not Yet Requested, Requested, Approved, and Rejected.

Assigned 
to

Primary resource assigned to implement the action.

Due date Requested date on which the action must be approved or implemented.

Parent The demand to which this action belongs.

Short 
description

Brief description of the action such as what the action entails, how to implement 
the action, who it affects, and the action outcome.

Select the Suggestion icon  to select a description from the list of predefined 
actions.

Description Details of the action and its potential impact.

Work notes Information about the action. Add work notes to communicate about the status of 
action approval, rejection, or implementation with other users.

Cost plan form

Use the cost plan form to capture the costs of demands.

Cost plan form

Field Description

Name Descriptive name for the cost plan.

Project/
Demand

Demand number to which the cost plan belongs.

Start fiscal 
period

Starting fiscal period.

When you change the start fiscal period, the associated cost breakdown 
values also change.

End fiscal 
period

Ending fiscal period.

When you change the end fiscal period, the associated cost breakdown values 
also change.
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Cost plan form  (continued)

Field Description

Group This field is a read-only field.

Financials section of the Cost plan form

Field Description

Entered currency Currency for the cost plan.

If the selected currency is different from 
the default currency configured in the 
Financial Management application, the budget 
reference rate  is used to calculate the cost of 
the demand.

Unit cost Cost of single unit of the resource.

Quantity Quantity of resource required.

Recurring Indicates if the cost is recurring for each fiscal 
period.

Quantity  x Unit cost  value is incurred for every 
fiscal period.

Cost type Cost type of the plan. See Create a cost type 
definition.

Investment Name of the investment created for the 
project.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Source type Funding entity to associated with the project 
investment for funding.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Source Funding entity value from which you request 
fund.

The field is available when you select a value 
in the Source type field.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
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Financials section of the Cost plan form  (continued)

Field Description

is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Total planned cost Total planned costs of the cost plan. If the cost 
is recurring, the calculation is Quantity  x Unit 
cost  x number of fiscal periods.

If the cost is non-recurring, the calculation is 
Quantity  x Unit cost.

This value is rolled up from cost breakdown.

Functional currency The default currency configured in the 
Financial Management application and used 
for managing the demand or project.

Cost in functional currency The total planned cost for the demand in 
functional currency. The value in this field 
changes if the Entered currency  is different 
from the functional currency.

Total actual cost Total actual costs of the cost plan. This value is 
rolled up from cost breakdown.

Decision form

Use a decision form to add a decision to a demand.

Decision form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the decision. All new decision records are created with Open 
state.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped

Priority Urgency of approving or implementing the decision based on possible impact.

Decision 
status

Status of the decision. The available options are: Pending, Approved, and 
Rejected.

Impact Impact on the outcome of the demand if you don’t implement the decision.

Approval 
required

Option for determining whether approval of the decision is required.

Estimated 
Cost

Estimated cost of implementing the decision.

Due date Requested date on which the decision must be approved or implemented.

Assigned 
to

Primary resource assigned to work on the decision. The default value is the name 
of the user creating the decision record.

Parent Demand number to which this decision belongs.
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Decision form  (continued)

Field Description

Short 
description

Brief description of the decision such as what the decision is about, who made it, 
what it affects, and the decision outcome.

As you start entering the title for your decision, related decisions that potentially 
match your decision are displayed.

Select the Suggestion icon ( ) to select a description from the list of predefined 
decision descriptions.

Description Details of the decision and its potential impact.

Work notes Information to record and track the status of decision implementation or 
approvals.

Demand Budget form

Use the Demand Budget form to allocate a budget to your demand.

Demand Budget form

Field Description

Fiscal Year The fiscal year for which you want to set the 
budget for the demand.

Currency Currency in which you want to allocate the 
budget for the demand.

If the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin is active, 
then you can allocate the budget in demand 
currency or functional currency.

Capex Budget in Demand Currency Planned expense amount allocated for capital 
expenditure in the selected currency.

Opex Budget in Demand Currency Operating expense amount in the selected 
currency.

Total Budget in Demand Currency Sum of Capex and Opex amounts.

Demand form

The demand form information is used to create a demand.

Demand form fields

Field Description

Name
Name of the demand.

Category Category of the demand:
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Demand form fields  (continued)

Field Description

• Strategic: For demands for plans, such as projects or stories.

• Operational: For demands for operational work, such as changes or defects.

Type The Category  field selection determines the selections available in the Type 
field.

• The following demand types are available if the demand category is Strategic:

◦ Continual Improvement Management

◦ Enhancement

◦ Project

◦ Epic

◦ Story

◦ EAP Epic

◦ EAP Feature

◦ EAP Capability

◦ SAFe Epic

◦ SAFe Story

◦ SAFe Feature

◦ No Conversion

• The following demand types are available if the category is Operational:

◦ Change

◦ Defect

◦ No Conversion

If the Agile Development 2.0  application is active, the Story, Epic, 
Enhancement, and Defect options are available.

If the Strategic Planning  application is active, the EAP Epic, EAP Feature, and 
EAP Capability options are available.

If the Essential SAFe  or Portfolio SAFe  features are active, the SAFe Story, SAFe 
Feature, and SAFe Epic options are available.

The No Conversion option enables you to use your demand to fund a large 
project that includes one or more projects, epic, or programs.

The selections in the Category  and Type  field also determine the fields that are 
displayed in the Assessment Data section.

Project Name of the project created from this demand.

This read-only field is visible only when you convert the demand into a project.

Enhancement Number of the enhancement created from this demand.
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Demand form fields  (continued)

Field Description

This read-only field is visible only when you convert the demand into an 
enhancement.

Epic Name of the epic created from this demand.

This read-only field is visible only when you convert the demand into an epic.

Story Name of the story created from this demand.

This read-only field is visible only when you convert the demand into a story.

Number Unique, auto-generated identification number for the demand.

Approved 
start date

The formal date approved by stakeholders for starting the demand. This date is 
set after prioritization and stakeholder approval and represents the committed 
and authorized timeline for execution. It’s used for governance and traceability.

For example, the approved date to start the database upgrade is 2026-01-10.

This field is carried forward to the Approved start date  field of the Project form 
if the demand is converted to a project and remains unchanged, even if the 
project starts later.

This field is highlighted in red if the date is different than the value in the Start 
date  field.

Note: 
If this field is empty while creating a demand, the date from the Start date 
field is inserted.

Approved 
end date

The formal date approved by stakeholders for completing the demand. This 
date is set after prioritization and stakeholder approval and defines the 
approved execution window and supports historical tracking.

For example, the approved end date to complete the demand is 2026-02-15.

This field is carried forward to the Approved end date  field of the Project form 
if the demand is converted to a project and remains unchanged, even if the 
project ends later.

This field is highlighted in red if the date in this field is different than the value in 
the Due date  field.

Note: 
If this field is empty while creating a demand, the date from the Due date 
field is inserted.

Start date The preliminary or estimated date when the work is initially planned to begin. 
This date helps outline the intended timing for early demand planning and 
prioritization. You can set this date during initial demand creation or anytime in 
the planning phase when a rough idea forms. This date can be updated until 
the demand is officially approved.

For example, you’re planning for a database upgrade to start on 2025-11-01.
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Demand form fields  (continued)

Field Description

This date is changed to Planned start date  when the demand is converted to a 
project.

Note: 
When you change the planned start date of a demand or project, the 
associated cost plans and resource assignments also change. The 
Change Resource Plan and Cost Plan Start Date with Demand or Project 
Start Date Change  property controls the behavior for a demand date 
change. This property isn’t enabled by default. For more information, see 
Properties installed with Project Management.

Due Date The preliminary or estimated date when the planned work is expected to be 
completed. This date provides an expected completion window for planning 
and stakeholder communication. You can set this date anytime in the planning 
phase when a rough idea forms and can be updated until the demand is 
officially approved.

For example, you’re planning to complete the database upgrade by 2025-12-31.

Note: 
This date is changed to Planned end date  when the demand is converted 
to a project.

Description Description of the demand.

Similar 
demands

Demands that have similar values for the Short description  fields using 
predictive intelligence and machine-learning algorithms. For more information, 
see Predictive Intelligence for Demand Management.

Related 
Search

Search results matching the specified term. The default is the value in the 
Name  field.

Details section of the Demand form

Field Description

Portfolio Portfolio indicating the business focus of the 
demand.

Program Name of the program to which the demand 
belongs.

Investment Class Type of investment class category assigned to 
the demand:

• Run: Investment made to sustain the 
existing business.

• Change: Investment made to implement a 
change in the business.

Investment Type Investment type of the demand:
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Details section of the Demand form  (continued)

Field Description

• Cost Reduction

• End User Experience

• Legal and Regulatory

• Revenue Generating

• Service Sustaining

• Strategic Enabler

• Artificial Intelligence

Demand Manager Name of the demand manager.

Collaborators Users who can edit or contribute to the 
demand. A demand requester can select any 
user as a collaborator.

Expense type The type of the expense, either capex (capital 
expense) or opex (operational expense).

Priority The priority of the demand.

Department Department in a business unit to which the 
demand submitter belongs.

Note: 
If you don’t select a department, 
the default value is the name of the 
department to which the submitter 
belongs.

Project Manager Project manager that would be assigned to 
the project created from this demand. When 
a project is created, this field becomes read 
only. This field appears if the Category  field 
is set to Strategic and the Type  field is set to 
Project. If you delete the project created from 
this demand, this field becomes editable.

Business Unit Business unit to which the demand submitter 
belongs.

Impacted Business Units Business units affected by the submitted 
demand. The selected units could experience 
operational impact, process changes, 
technology adoption, and so on.

For example, if a demand is submitted by the 
procurement business unit, it can impact the 
finance, legal, and IT business units.

Idea Unique identification number of the idea from 
which the demand was created.

Business Capabilities Business capabilities associated with 
the demand that links the demand to 
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Details section of the Demand form  (continued)

Field Description

organizational goals and value. Business 
capabilities are defined in the Enterprise 
Architecture  (formerly Application Portfolio 
Management) module.

Impacted Business Applications If the demand is to change, enhance, or 
add one or more business applications, the 
applications associated with the demand. 
Business applications are defined in 
the Enterprise Architecture  (formerly 
Application Portfolio Management) module. 
For more information, see Exploring business 
applications .

You can select any business application 
in your enterprise regardless of whether 
it’s related to a capability selected in the 
Business Capabilities  field.

Business Applications If the demand is to change, enhance, or 
add one or more business applications, the 
applications associated with the demand. 
Business applications are defined in 
the Enterprise Architecture  (formerly 
Application Portfolio Management) module. 
For more information, see Exploring business 
applications .

You can select any business application 
in your enterprise regardless of whether 
it’s related to a capability selected in the 
Business Capabilities  field.

Business Case section of the Demand form

Field Description

Strategic priority Strategic objectives of the organization that 
the demand fulfills. A demand can fulfill 
multiple strategic objectives.

If a business unit has been selected in 
the Details  tab, the business strategies 
for the selected business unit along with 
other enterprise strategies are available for 
selection.

Primary goal The primary goal associated with the strategy 
selected in the Strategic priority  field.

If a strategy hasn’t been selected, all goals are 
available for selection.
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Business Case section of the Demand form  (continued)

Field Description

Business case Business arguments that support the demand.

Risk of performing Risks if the demand is approved and 
implemented.

Risk of not performing Risks if the demand isn’t approved, for 
example, risk of loss of opportunity.

Enablers Key enablers for the demand that would aid 
the demand to be completed. For example, 
clearly defined resource and cost plans.

Barriers Major barriers to the demand that would 
obstruct the demand's completion. For 
example, incomplete or unclear demand 
details.

In scope Scope of the demand, which is the set 
of boundaries that define the extent of a 
demand.

Out of scope Activities or deliverables not in the scope 
of the demand. Anything not defined in the 
scope is out of scope.

Assumptions Assumptions made for the demand. 
Assumptions help to define the scope and 
risks, and fine-tune the estimates for time and 
cost.

Financials section of the Demand form

Field Description

Rate Model Rate model assigned to the demand. This 
setting is used to derive hourly rates for the 
associated resource assignments and time 
cards. For more information, see Rate Models.

Note: 
If the rate model assigned to the demand 
is changed or removed, the cost fields 
on the associated resource assignments 
aren’t recalculated.

Project Currency Currency used to execute the project once the 
project is created from this demand.

You can select any active currency from the 
values listed in the Currency [fx_currency] 
table.

After you create a project in the selected 
project currency, you can't change the project 
currency in the Project form if the demand 
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Financials section of the Demand form  (continued)

Field Description

contains a cost plan, a benefit plan, or a 
project budget. If the demand has no attached 
plan or budget, you can change the project 
currency in the Project form.

Note: 
The value of this field defaults to 
the Project currency  field of the 
Financials  tab in the project currency 
view of the Project form as well. 
This field is available only when 
the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) feature 
is activated and the Demand Currency 
view is enabled.

Capital expense Capital expenditure (capex) for the demand.

Operating expense Operational expenditure (opex) for the 
demand.

Total planned costs Result calculated based on the values in the 
Capital expense  and Operating expense 
fields.

Financial return Result calculated based on the values in the 
Total costs  and Financial benefit  fields.

Financial benefit Estimate of revenue if the demand is 
approved.

This value is rolled up from the benefit 
breakdown of the demand.

You can also enter the value manually by 
selecting a currency icon and entering a value.

ROI % ROI calculated based on the values in the 
Total costs  and Financial return  fields.

The value in this field is updated when a cost 
plan, benefit plan, or resource assignment 
is created or updated for the demand in the 
Qualified or Approved state.

Capital budget Total capital budget allocated to the demand 
across all fiscal years.

The value is rolled up from the capex budget 
of the demand.

Operating budget Total operational budget allocated to the 
demand across all fiscal years.
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Financials section of the Demand form  (continued)

Field Description

The value is rolled up from the opex budget of 
the demand.

Discount Rate % Demand discount rate, which is the interest 
rate to determine the present value of future 
cash flows.

Net present value Present value of future cash based on the 
given annual interest rate, a measure for 
comparing money spent today against future 
expected financial benefits. This value is 
useful when evaluating the overall investment 
performance.

For example, at a 12% discount rate, $1.00 
today is worth $0.80 in two years. Therefore, 
receiving $1.00 in two years is the same as 
receiving $0.80 today.

Net present value (NPV) is calculated from 
total costs according to year, financial 
benefit per year, and the discount rate for the 
demand.

Internal rate of return % Annual interest rate required to achieve an 
NPV of zero.

Internal rate of return (IRR) helps to determine 
which demands can deliver a higher rate of 
return in terms of revenue.

Demand Actual Cost Total cost incurred while working on a demand 
and demand tasks. Demand actual cost is 
calculated after the assignee of the demand 
task creates and submits a time card. When 
the time card is approved, the resource rate, 
which is derived from the rate card, labor rate, 
or system properties, is used to populate this 
field.

Demand Actual Effort Time accrued or spent by a resource while 
working on a demand or a demand task as 
derived from the submitted and approved time 
cards. This field isn’t available on the Demand 
form by default.

Note: 
If you’re creating a demand with the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin activated and the Demand Currency  view enabled, 
then the fields in the Financials  tab differ from the Default  view. For more information 
about the fields that are available only in the Demand Currency view, see Multicurrency in 
Demand Management.
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Assessment Data section of the Demand form

Field Description

Impact Level of business impact created by the 
demand.

Risk Risk value calculated from the demand 
assessment.

Value Business value of the demand calculated from 
the Impact  and Financial return  fields.

T-Shirt size Size of the demand.

Before using this value as an indicator 
of demand size, consider creating and 
publishing definitions for each option outside 
the application. That process ensures that 
the values are interpreted correctly and 
consistently across the organization or 
department.

Score The demand score is calculated based on 
the risk, value, and size  attributes in the 
base system.

The value of the risk, value, and size 
attributes are derived from the assessment 
metric category results. For more information, 
see assessment categories  and assessment 
category results .

• When the risk  and size  values are high, 
the score of the demand is low.

• When the value  setting is high, the score 
of the demand is high.

Assessment Required Option for enabling the assessments for the 
demand. This option is active by default.

Only a demand manager can update this value 
when the demand is in the Draft or Submitted 
state.

Note: 
If this option isn’t selected and you reset 
the demand to the Draft state, the option 
remains unselected.

Note: 
The values in the Value  and Score  fields are updated when a cost plan, benefit plan, 
or resource assignment is created or updated for the demand in the Qualified or 
Approved state. The values in the fields are updated only until an artifact such as project, 
enhancement, defect, or change is created from the demand.
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Notes section of the Demand form

Field Description

Watch list The groups and users subscribed to the 
demand who can view the information in the 
Additional comments  field.

Work notes list The groups and users subscribed to the 
demand who can view the information in the 
Work notes  field.

Work notes Information about the demand. This 
information isn’t visible to customers. Work 
notes are added throughout the demand 
management life cycle to communicate with 
other users associated with the demand.

Preferences section of the Demand form

Field Description

Close Demand
Determines when to close the demand 
automatically if it’s converted to a project.

• None: Keeps the demand in the Open state 
after it’s converted to a project.

• On creation of project: Closes the demand 
when the demand is converted to a project.

• On closure of project: Closes the demand 
when the project created from the demand 
is closed.

Note: 
The On creation of project  and On 
closure of project  options appear 
when the value for the Type  field is 
set to Project. If the Type  field is set 
to Enhancement, the default setting is 
None.

Project Calculation Determines the calculation to use for task 
dependencies for the project when the 
demand is converted to a project. The default 
value is Automatic.

• Manual: Task dates don’t reflect any 
changes made to dependencies.

• Automatic: Task dates are automatically 
updated to reflect any changes made to 
dependent or child tasks.
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EAP Details section of the demand form
This section appears only if the selected type is an EAP entity.

Field Description

Team The planning team to which the created EAP 
entity is assigned. This field becomes read 
only once the EAP entity is created. This value 
is an optional value.

Converted to The name of the created EAP entity. This field 
is read-only.

AI Associations section of the demand form
This section appears only if the AI Control Tower plugin is installed and the 
investment type of the demand is set to artificial intelligence.

Field Description

Product Product or system that the demand relates to.

Impacted AI systems Impacted AI systems associated with the 
demand. You can select existing AI systems 
from the list or remove systems that are no 
longer relevant.

Demand task form

Use the demand task form to create tasks for a demand.

Demand Task form

Field Description

Short description Name of the demand task.

Assignment group Group assigned to the demand task.

Assigned to Primary resource assigned to the demand 
task. The following conditions apply:

• If an assignment group is defined, only 
users in the assignment group are listed.

• If skills are defined, only users with those 
skills are listed.

• If no assignment groups or skills are 
defined, only users with one of the Project 
Management application user roles are 
listed.

• Users with timecard_user  role are also 
listed.
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Demand Task form  (continued)

Field Description

Additional assignee list Users assigned to the demand task in addition 
to the single primary resource defined in the 
Assigned to  field.

Category Category of the demand task:

• Initial review

• Effort estimate

• Cost estimate

• Benefit estimate

• Risk assessment

The Category  field selection determines the 
links available in the related links. For example, 
the Add Resource Plan to Demand  related 
link appears when you set the Category 
value to Effort estimate. Users must have the 
appropriate role to use these related links.

Actual effort The actual time spent working on the demand 
task, which is derived from the approved time 
card for this demand task.

Because this field doesn’t appear by default 
on the Demand Task form, you must add it by 
personalizing the form.

Description Brief description of the demand task.

Number System-generated ID number with a 
configurable prefix.

Priority Sequence in which the task must be 
completed based on impact and urgency.

State Current state of the demand task. The states 
include Pending, Open, Work in Progress, 
Closed Complete, Closed Incomplete, and 
Closed Skipped.

Due date The date by which the task is targeted for 
completion.

Actual cost The actual cost of the demand task derived 
from the number of hours worked and hourly 
rate of the resource as defined in the rate card. 
In the absence of a rate card, the hourly rate 
is derived from the default labor rate card or 
default system property.

Work notes Information about the demand task. Work 
notes are added throughout the demand 
management life cycle to communicate with 
other users associated with the demand.
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Demand Task form  (continued)

Field Description

Note: 
Users with the business stakeholder 
role for PPM can view this field. For more 
information, see Business stakeholder 
role for PPM.

Expense line form

Use the expense line form to associate specific costs to a demand.

Expense line form

Field Description

Number Auto-generated number.

Amount Select a currency type and enter the expense cost.

Date Date of the expense generated.

Process 
date

Date on which the expense line was processed.

Source ID Record that generated the associated cost.

State State of the expense line. The state can be Pending or Processed. The cost roll-up 
happens only if the expense line is processed.

Cost plan Name of the cost plan against which you want to create the expense line.

Summary 
type

Select the category that you want to group the expense under.

Cost type Select the cost type.

Expense 
type

Select Capex  for a capital expense or Opex  for an operating expense.

Short 
description

Enter a short description of the expense type.

Sources Select the records for the sources of the expense line. These sources include:

• Assets

• Fixed assets

• Contracts

• Users

• Configuration items

• Tasks

• Cost centers

Investment Budget form

Use the Investment Budget form to allocate budget for a demand for each fiscal period.
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Investment Budget form details

Field Description

Amount Enter the budget amount.

Fiscal period Select the fiscal period to allocate the budget.

Investment Select the planning item to allocate this 
budget.

The existing budget is selected by default.

Expense type Select expense type from the list.

• Select Capex  to allocate your budget to 
capital expenses.

• Select Opex  to allocate your budget to 
operational expenses.

Issue form

Use the issue form to add an issue to a demand.

Issue form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the issue. All new issue records are created in the Open state.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped

Priority Urgency of resolving or managing the issue based on possible impact.

Estimated 
cost

Estimated cost the issue generates.

Impact Impact on the outcome of the demand if the issue remains unresolved.

Due date Requested date for the assigned resource to resolve the issue or the date on 
which the issue must be closed or addressed if not assigned to any resource.

Assigned 
to

Primary resource assigned to work on the issue resolution.

Parent Demand to which this issue belongs.

Short 
description Brief description of the issue and its potential impact on the success of the 

demand.

As you start entering the title for your issue, related issues that potentially match 
your issue are displayed.

Select the suggestion icon ( ) to select from the list of predefined issue 
descriptions.
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Issue form  (continued)

Field Description

Description Details of the issue and its potential impact.

Work notes Information to record and track the work accomplished for resolving the issue.

Monetary Benefit Breakdown form

Use the Monetary Benefit Breakdown form to update the estimated and actual financial benefits 
for a specific fiscal year.

Monetary Benefit Breakdown form

Field Description

Task Task to which the benefit plan breakdown 
belongs.

Portfolio Portfolio to which the benefit plan breakdown 
belongs.

Entered currency Currency specified in the benefit plan.

Exchange rate Rate in effect for the period corresponding to 
the benefit plan breakdown. When the period 
corresponding to the benefit plan breakdown 
has multiple rates, the rate in effect on the first 
date of that period is used.

Exchange rate is used to convert the entered 
benefit into the functional benefit. It’s obtained 
from the itfm_fx_rate [budget_reference_rates] 
table.

Actual benefit Actual benefit that is incurred from the project 
or demand.

Benefit plan Benefit plan to which the benefit plan 
breakdown belongs.

Fiscal period Fiscals generated at the period level. For 
information on periods, see fiscal calendars .

Entered benefit Benefit in entered currency.

Functional benefit Functional benefit obtained by multiplying the 
exchange rate with the entered benefit.

Exchange rate date First date of the fiscal period corresponding to 
the benefit plan breakdown.

Monetary Benefit Plan form

Use the Monetary Benefit Plan form to specify the estimated benefit accrued by a demand for a 
fiscal period.
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Monetary Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Demand number to which the benefit plan belongs.

Sponsor Sponsor for the demand.

Category Type of benefit:

• Hard: Benefits that can be measured in terms of revenue.

• Soft: Benefits that are measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The selection in Category  field determines the selections available in this field.

Benefit 
type

Type of benefit. Select Monetary benefits.

Offset type Offset type field indicates when the benefits start realizing.

If the value in the selected offset type changes, the benefit plan start date shifts 
accordingly. For example, if the offset type is set to End Date  and the due date of 
the demand changes, the benefit plan start date shifts to align with the new due 
date of the demand.

Work start 
date

Start date of the demand. The field appears if you select Start Date  in the Offset 
type  field.

Work end 
date

End date of the demand. The field appears if you select End Date  in the Offset 
type  field.

Offset Number of periods before or after the offset type when the benefit plan starts. For 
example, if the offset type is set to End Date  and the offset is -2, the benefit plan 
is two periods before the demand end date. If the demand end date shifts, the 
benefit plan start date shifts to two periods before the new demand due date.

Duration in 
periods

The length, in periods, of the benefit plan.

Start fiscal 
period

Starting fiscal period. Populated based on values in the Offset field relative to the 
selected Project or Demand start date or Project or Demand end date, and the 
Duration in period values.

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.

End fiscal 
period

Ending fiscal period.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Non-monetary benefit that is associated with this monetary benefit plan.

Description Description of the monetary benefit plan.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1281



Financials section of the Monetary Benefit Plan form

Field Description

Entered benefit Estimated amount of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods.

Entered currency Currency for the benefit plan.

If the selected currency is different from 
the default currency configured in the 
Financial Management application, the budget 
reference rate  is used to calculate the financial 
benefit of the demand.

Functional currency The default currency configured in the 
Financial Management application and used 
for managing the demand or project.

Total planned benefit Total benefit value that is rolled up from the 
benefit breakdown.

Benefit in functional currency Benefit incurred from demand in functional 
currency. The value in this field changes if 
the Entered currency  is different from the 
functional currency.

Actual benefit Actual benefit value that is rolled up from the 
actual benefit in the benefit breakdown.

Recurring Check box to indicate if the benefit is 
recurring for each fiscal period in the benefit 
breakdown.

Non-monetary Benefit Plan Breakdown form

Use the Non-monetary Benefit Breakdown form to update the estimated and actual non-financial 
benefits for a specific fiscal year.

Non-monetary Benefit Plan Breakdown form

Field Description

Task Task to which the benefit plan breakdown 
belongs.

Portfolio Portfolio to which the benefit plan breakdown 
belongs.

Measure Measure type specified in the benefit plan.

Actual benefit Actual benefit that is incurred from the project 
or demand.

Benefit plan Benefit plan to which the benefit plan 
breakdown belongs.
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Non-monetary Benefit Plan Breakdown form  (continued)

Field Description

Fiscal period Fiscals generated at the period level. For 
information on periods, see fiscal calendars .

Entered benefit Benefit in entered value.

Variance The difference between the estimated and 
actual benefit.

Non-monetary Benefit Plan form

Use the Non-monetary Benefit Plan form to specify the potential non-financial benefits accrued 
by the demand, when it's executed.

Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Demand number to which the benefit plan belongs.

Sponsor Sponsor for the demand.

Category Type of benefit:

• Hard: Benefits that can be measured in terms of revenue.

• Soft: Benefits that are measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The selection in the Category  field determines the selections available in this 
field.

Benefit 
type

Type of benefit. Select Non-monetary benefits.

Offset type Field to indicate when the benefits start to be realized.

If the value in the selected offset type changes, the benefit plan start date shifts 
accordingly. For example, if the offset type is set to End Date  and the due date of 
the demand changes, the benefit plan start date shifts to align with the new due 
date of the demand.

Work start 
date

Start date of the demand. This field appears only when Start Date  is selected from 
the Offset type  field.

Work end 
date

End date of the demand. This field appears only when End Date  is selected from 
the Offset type  field.

Offset Number of periods before or after the offset type when the benefit plan starts. For 
example, if the offset type is set to End Date  and the offset is -2, the benefit plan 
is two periods before the demand end date. If the demand end date shifts, the 
benefit plan start date shifts to two periods before the new demand due date.

Duration in 
periods

The length, in periods, of the benefit plan.
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Benefit Plan form  (continued)

Field Description

Start fiscal 
period

Starting fiscal period. Populated based on the value in the Offset  field relative to 
the selected Project/Demand start date  or Project/Demand end date, and the 
Duration in periods  field values.

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.

End fiscal 
period

Ending fiscal period.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Monetary benefit that is associated with this non-monetary benefit plan.

Description Description of the non-monetary benefit plan.

Non-monetary Details section of the Benefit Plan form

Field Description

Measure Type of measure for the non-monetary 
benefit plan. The measure types are Count, 
Percentage, Hours, Days, and Score.

Select the option Yes/No  to track the benefits 
that aren’t quantifiable. When this option is 
selected, the only field available is Benefits 
achieved. You can select the check box to 
indicate that the benefits have been achieved.

Non-monetary entered benefit
Estimated value of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods 
only.

Non-monetary planned benefit Benefit value that is rolled up from the benefit 
breakdown.

Benefits achieved Option to indicate if the benefit is achieved.

Breakdown type Type of breakdown creation when you save 
the benefit plan.

• None: No breakdowns are created.

• Automatic: A Non-monetary Benefit Plan 
Breakdown record is created automatically 
with data. The breakdown is calculated 
linearly.
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Non-monetary Details section of the Benefit Plan form  (continued)

Field Description

• Manual: A Non-monetary Benefit Plan 
Breakdown record is created automatically 
but without data in the entered benefit 
column.

Aggregation mode Determines how the roll-up happens from 
breakdowns to the benefit plan and updates 
the values in the Non-monetary planned 
benefit  and Non-monetary actual benefit 
fields.

• Sum: Aggregates data from all breakdowns.

• Average: Average value from all 
breakdowns.

• Most recent: Recent breakdown value.

• Max: Maximum value among the 
breakdowns.

• Min: Minimum value among the breakdown

Non-monetary actual benefit Actual benefit value that is rolled up from the 
actual benefit in the non-monetary benefit 
plan breakdown.

Recalculate resource costs form

Use the recalculate resource costs form to make sure that the resource assignment costs are up 
to date.

Recalculate Resource Costs dialog box

Field Description

Start date Start date of the time period for which the 
costs are recalculated.

By default, the field shows the current date.

End date End date of the time period for which the costs 
are recalculated.

By default, the field shows the due date of the 
demand. If the due date isn’t specified for the 
demand, the field is empty.

Planned costs for Requested Resource plans Option for recalculating the planned cost of 
Requested resource plans.

Confirmed/Allocated costs for Confirmed/
Allocated resource plans

Option for recalculating the confirmed or 
allocated cost of confirmed or allocated 
resource plans.
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Recalculate Resource Costs dialog box  (continued)

Field Description

Planned costs for Confirmed/Allocated 
resource plans

Option for including the planned cost of a 
confirmed or allocated plan.

The option is enabled if the Confirmed/
Allocated costs for Confirmed/Allocated 
resource plans  option is selected.

By default, the option isn’t selected.

Request change form

Use the request change form to change the metrics of a demand, such as demand scope, 
resource requirement, cost, or schedule.

Request Change form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the request change. All new request change records are 
created in the Open state.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped

Priority Urgency for approving the requested changes based on impact.

Estimated 
Cost

Estimated cost the requested changes generate.

Impact Impact on the outcome of the demand if you don’t approve the requested 
changes.

Approval Status of approval from the stakeholders for the requested changes.

Assigned to Primary resource assigned to work on the request change.

Due date Requested date to complete the request change.

Category Entity for which you’re creating the request change. The options are: Resource, 
Scope, Cost, and Schedule.

Parent Demand to which this request change belongs.

Title Title for the change request.

Description Details of the request change and its potential impact.

Business 
Justification

Reason for requesting the proposed change in the demand and its impact on 
the business.

Work notes Additional information to indicate progress on the demand request change.

Requirement form

Use the requirement form to add a new requirement to a demand.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1286



Requirement form

Field Description

Number Unique identification number for the requirement. This number is automatically 
generated when a new requirement record is created.

Source User requesting the requirement. This field is automatically populated with the 
name of the person filling out the form, but the source could be a different person 
who identified the requirement.

Owner User who is responsible for managing the requirement or making sure that the 
requirement is met.

Estimated 
effort

Approximate amount of time to complete the requirement and any associated 
tasks.

Priority Importance of the requirement as it applies to the overall demand.

State Status of the requirement can be Pending, Approved, or Rejected.

Note: 
The request state is independent of the demand request state and of the 
states of any planned tasks associated with the requirement. The request 
can be closed without the requirement state being closed. Likewise, closing 
the request doesn’t change the state of the requirement.

Type Type of requirement can be: Business, Solution (Functional), Solution (Non-
Functional), Quality, Stakeholder, or Transition.

Short 
description

Brief description of the requirement.

Description Detailed description of the requirement and any associated tasks. For example, 
you can use this field to describe an expected outcome or result.

Risk form

Use the risk form to add a risk to a demand.

Risk form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the risk. All new risks are created in the Pending state.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped

Risk status Status of the risk. The available options are: Pending, Achieved, Not Achieved, 
Avoid, Mitigate, Transfer, and Accept.

Probability The likelihood that the event described in the risk occurs. The available options 
are: Absolute, High, Moderate, and Low

Impact Impact of the risk event on the outcome of the demand.

Estimated 
cost

Estimated cost the risk event generates.
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Risk form  (continued)

Field Description

Risk rank A value and color assigned to the risk. This value is calculated using risk 
probability and impact. You can configure the color and value using Risk Value 
Lookup. For more information, see Configure a custom Risk rank and Risk value for 
a demand.

Risk owner Primary resource who is responsible for monitoring and managing the risk.

Assigned 
to

Primary resource assigned to work on the risk.

Risk value A value calculated from Risk Value Lookup. For more information see,Configure a 
custom Risk rank and Risk value for a demand.

Due date Requested date for the assigned resource to resolve the risk or the date on which 
the risk must be closed or addressed if not assigned to any resource.

Task Demand to which this risk belongs.

Short 
description

Brief description of the event and its potential impact on the success of the 
demand.

Description Details of the event and its potential impact.

Mitigation 
plan

Brief description of the efforts taken to mitigate the risk.

Work notes Information to record and track the work accomplished for resolving the risk.

Risk value matcher form

Use the risk value matcher form to rate the impact and probability of a risk.

Risk Value Matcher form

Field Description

Impact Impact value of the risk.

The default values are:

• 1 = High

• 2 = Medium

• 3 = Low

Application The application to which these risk values 
belong.

Risk Rank Color Color to indicate the severity of the risk.

Tip: 
You can enter variations of a color to 
differentiate between risks with similar 
impact and probability values. For 
example, you could enter lightgreen  to 
indicate a low-severity risk.
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Risk Value Matcher form  (continued)

Field Description

Risk Value The value for the specified risk impact and 
probability combination.

The options are: High, Medium, and Low.

This value is displayed in the Risk value  field 
of the Risk form.

Probability Risk probability value is associated with the 
impact value of the risk. The options are: 
Absolute, High, Moderate, and Low.

Probability Number Numerical value to indicate the probability. 
This value is multiplied by the value of the 
Impact  field for calculating risk rank.

The default values are:

• 1 = Absolute

• 1 = High

• 2 = Moderate

• 3 = Low

The calculated risk rank and the risk rank color 
are displayed in the Risk rank  field of the Risk 
form.

Stakeholder Register Form

Use the Stakeholder Register form to add users to the Stakeholder Registry.

Stakeholder Register Form fields

Field Description

Number Unique identification number for the stakeholder. This number is automatically 
generated when a new entry is created.

User Name of user being added to the stakeholder registry.

Portfolio A group of activities managed to align to business or operational objectives. 
Typically, portfolios are named according to the business units of an 
organization.

Level of 
Interest

Level of interest that the stakeholder has in pursuing the demand or project.

Assessment 
recipient

Indication of whether the user is authorized to receive assessment 
questionnaires for a demand.

Approver Indication of whether the user has authority to approve demands or change 
requests in projects.

Influence Level of influence the user has over the group assessing the demand or project.

Engagement Indication of the way the user is engaged with the demand or project.
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Stakeholder Register Form fields  (continued)

Field Description

Function Function of user in the demand or project process.

Widget Association form

Use the Widget Association form to associate your widget to a demand.

Widget association form

Field Description

Association 
ID

Record to associate with the widget.

To access the relevant records, you must select the Tables [sys_db_objects] table 
in the Table name  list and the Demand [dmn_demand] table in the Document  list.

Association 
table

Table to associate with the widget.

You must select the Tables [sys_db_objects] table from the list.

Widget Unique name of the widget.

Order Position of the widget in relation to other widgets on the Demand Financials page.

Widgets appear in numeric order, with the smallest number listed first.

Display on 
card

Option to display the widget on the Demand Financials page.

Include by 
default

Option to show the widget by default on the Demand Financials page.

Widget form

Use the widget form to configure a new widget.

Widget form

Field Description

Name Unique name for the widget.

Scripted Option for indicating the value on the widget is from a code script.

By default, this option is selected and is read-only.

Show 
Label

Option for displaying either the label or the color indicator.

If you clear the check box, the Color  field appears and you can set the color.

Active Option for indicating the status of the widget.

Only active widgets are shown on the Demand Financials page.

Parent 
widget

Widget that is the parent of the current widget.

The current widget displays in the Child widgets related list of the selected widget.
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Widget form  (continued)

Field Description

You can add a maximum of three child widgets for a parent widget.

Formatter 
required

Option for specifying whether a currency formatter is required for the widget.

Script
Code script that returns a requested metric value that is displayed on the widget.

In the script, use the context and filter objects. The context object contains all the 
demand financial fields, such as total_costs, irr_value, and capital_budget.

The following sample script returns the capital budget metric value of a demand to 
appear on the widget.

var context = JSON.parse(context);
var filter = context.filters;
 
var now_GR = new GlideRecord('dmn_demand');
gr.addEncodedQuery(filter['dmn_demand']);
gr.query();
if(gr.next())
 gr.getValue('capital_budget');
Collapse

Short 
description

Description of the widget.

Project Management
The ServiceNow®  Project Management  application is a suite of tools that aids in managing 
projects, tasks, and resources. You can create and manage small projects with a few tasks to 
large portfolios that contain complex tasks with various relationships and dependencies.

Introduction to Project and Program Management including the purpose of Project Management, 
the project workspace and template, baseline, project considerations, and viewing the project.

Get started

Explore Learn the features and 
business value of Project Management

Configure Set up the core 
configuration

Use Manage projects with Project 
Management

Reference Learn about forms and 
fields of Project Management
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Exploring Project Management

Create, view, and manage projects using Project Management  (PM) application.

Project Management  overview

A project is any planned, collaborative effort that is designed to achieve an objective. The Project 
Management  application not only helps you plan and track projects, it integrates with other 
applications.

There are several paths available to manage a project. The best path usually depends on 
business needs. The phases in the graphic are designed to get a project up and running with the 
minimum amount of effort.

Project phases

Project Management  benefits

Project Management  benefits

Benefit Feature Users

Starting a project Start a project after setting 
up the project, populating 
it with tasks, and assigning 
resources.

it_project_manager

Create a project task from a project Create project tasks from 
project form.

it_project_manager

Create baseline of a project Capture planned dates of 
all tasks and milestones of a 
project using baseline.

pps_admin

Create a milestone Use milestones to mark 
key dates in your project, 
such as key decision points, 
approvals, and holidays.

it_project_manager

Create a monetary benefit plan for a 
project

Capture the benefits accrued 
by the project when the 
project is executed by creating 
monetary benefit plan.

it_project_manager

Create a non-monetary benefit plan 
for a project

Capture the non-financial 
benefits accrued by the 
project when the project is 
executed by creating non-
monetary benefit plan.

it_project_manager
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Project Management  benefits  (continued)

Benefit Feature Users

Create a project cost plan Create a cost plan to specify 
the unit cost of a cost type for 
a fiscal period.

it_project_manager

Adding RIDAC (Risks, Issues, Actions, 
Decisions, and Request Changes) 
records for a project

Create Risk, Issue, Decision, 
Action, and Request Change 
records (RIDAC) and identify 
issues or risks for your project.

it_project_manager

Applying templates to projects Create, save, and reuse 
project structure using project 
templates.

it_project_manager

Adding external dependencies for 
projects

Use an external dependency 
to set up a dependency from a 
task in one project to a task in 
another project.

it_project_manager

Importing and exporting projects Import or export projects from 
Microsoft  Project to Project 
Management.

it_project_manager

Project Diagnostics Detect corrupt data in 
a project such as task 
validity, dependencies, and 
relationships using Project 
Diagnostics.

it_pps_admin, 
adt_admin

Investment Portal Create an investment board 
and share it with other 
stakeholders using Investment 
Portal.

it_project_manager or 
it_project_user

Manage status of your projects using 
Project Status application

Track the status of your 
projects, collaborate with 
stakeholders to resolve 
exceptions, and take timely 
actions regardless of your 
location using project status 
application.

portfolio_manager or 
project_manager or 
program_manager

Using Project workbench - Legacy The Project Workbench 
supports hybrid project 
models by combining 
waterfall, agile, and test 
phases in a single project 
framework.

it_project_manager

Using Teamspaces in Project 
Management

Use teamspaces to centralize 
key PPM modules in one 
location and to improve 
accessibility and team 
productivity.

it_pps_admin, admin

Collaborate with your project teams 
using PPM Collaboration application

Enhance team collaboration 
on Slack or Microsoft Teams 

it_project_manager
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Project Management  benefits  (continued)

Benefit Feature Users

with the PPM Collaboration 
application.

Virtual Agent for PPM Obtain business-related 
information by interacting with 
a virtual agent via messaging 
platforms using Virtual Agent 
for PPM.

admin, 
virtual_agent_admin

Integration with Project Portfolio Management

You can use Project Management  as a separate application or it can be activated as part of the 
PPM.

This application provides a simplified, team-oriented approach to IT development by combining 
several individual applications and integrating the different components of the project 
development life cycle.

What to explore next

To learn more about configuring and using Project Management, see:

• Configuring Project Management

• Using Project Management

• Project Management reference

Basics of Project Management

Learn about the basic terms used in Project Management.

Bottom-up Tasking

Bottom-up (tactical) tasking means that you plan small, individual units of work that are required, 
then build a project up to include larger phases. Take this approach when you know what 
individual tasks are required to be accomplished and you are more flexible about overall project 
duration and estimated cost. Use this approach to see how much a project costs and how long 
it takes if you include every task. Project management supports tactical tasking by using rollup 
calculations on several project fields, such as project duration, so that the project adjusts to the 
tasks it contains. It is the recommended approach for the Project Management  application.

Top-down Tasking

Top-down (strategic) tasking means that you plan high-level tasks first, then break down the work 
into smaller units. Take this approach when you want to build a project with fixed or inflexible 
time and budgetary constraints and well-defined phases. Establish well-defined milestones 
and dependencies between tasks that you consider from the beginning. Gradually add smaller 
tasks to the project later. This approach avoids including all possible tasks in a project and stays 
flexible with what tasks are included.
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Note: 
When you use this method, the Project Management  application still rolls up several values, 
such as task duration. Creating a task with a longer duration than the project, expands 
to cover the entire duration of the task, and defeats the purpose of using this approach. 
Values are not rolled down from parent tasks, nor are there any restrictions on creating child 
tasks that are longer than specified duration of the parent.

Project relationships and dependencies

The Project Management  application enables you a create parent-child relationships between 
tasks and dependencies, such as finish-to-start and finish-to-finish, between tasks. A task 
dependency is created when one task is prevented from starting or finishing based on its 
relationship with the preceding and succeeding tasks.

Project relationships and dependencies

Concept Description

Finish-
to-start 
dependency

A dependency that indicates that a task must not be started until its predecessor 
finishes.

Start-to-start 
dependency

A dependency that indicates that a successor task must not be started until the 
predecessor task has started.

Start-to-
finish 
dependency

A dependency that indicates that a successor must not be finished until the 
predecessor task starts.

Finish-
to-finish 
dependency

A dependency that indicates that a task must not be finished until another task 
finishes.

Lag time A manually specified time break between predecessor and successor tasks.

Parent task A project task with smaller tasks, referred to as child tasks, underneath it. Child 
tasks break down the work of a parent task into more manageable subsets. 
Certain fields for child tasks, such as planned end date, roll up and affect the 
same field in the parent task.

Child task A project task that is a subset of a larger task. Child task start dates cannot occur 
before the start date of the parent task.

Rollup task Another term for a parent task in the context of aggregating child task items, 
such as effort or resources, into a larger parent task calculation. All fields on 
rollup task forms are read-only.

Roll down State changes roll down from the project to project tasks, and from parent tasks 
to child tasks.

Note: 
Only one relationship can exist between two tasks.

The Project Management  application provides several properties that control how tasks are 
calculated and behave. See Project property  for more information.

Task time constraints

The Project Management  application supports several types of dependencies.
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The Project Task form includes a Time Constraint  field, which can be one of the following values:

• If a task is set to Start ASAP: The task appears on the Gantt chart as starting when the 
dependency allows it. However, a task can start on a later date when a lag value is set for the 
relationship.

• If a task is set to Start on specific date: The task appears on the Gantt chart as starting on the 
constraint date. The start date of such a task is not impacted even after you put the task in a 
relation to another task, for example, FS relation.

• If a task is set to Start no earlier than: The task appears on the Gantt chart as starting on or 
after the constraint date. If the task has no predecessor, the task starts on the specified date. 
The start date changes to a later date based on the predecessor task end date or if the task is 
in a relation to another task, for example, FS relationship.

• If a task is set to Start no later than: The task appears on the Gantt chart as starting on or 
before the constraint date. If the task has any predecessor task, the dependency on the 
predecessor task determines when the task can start. A scheduling conflict occurs if the 
predecessor task attempts to move the task beyond the date specified in the Constraint date 
field.

Note: 
The project property  Retain start on constraint on tasks after adding relations  controls 
the behavior for Start on  selection. The property is set to True by default and is not 
editable.

• A task that is not honoring dependency is indicated with a red calendar icon  on the 
Planning Console. If you want the task to honor the dependency and adjust the start 
accordingly, change the constraint type of the task to Start ASAP.

Parent-child task relationships

If a task is relatively large and requires several users with different skills to manage, break the 
task into subtasks and create parent-child relationships. A child task is a relatively smaller, 
manageable size of work.

When you group child tasks together under a parent, values such as Estimated cost  aggregate 
and roll up to the parent task. So the parent task takes on the form of a summary task or rollup 
task for its child tasks. Planned start date  and Planned end date  rollup occurs when you create 
child tasks: the duration of the parent automatically adjusts to cover its child tasks.

A parent-child relationship is different from a dependency relationship. In a dependency, one 
task must finish before another begins. In a parent-child relationship, any number of tasks can be 
nested under a parent task with or without any dependencies. When you create a parent-child 
relationship, the parent task number is saved in the Parent  field in the Project Tasks table. All 
project management tasks have a parent: either another project task or the project itself.

Unlike a dependency, a parent-child relationship is not saved as a record in any table. The only 
modification that takes place when a parent-child relationship is modified is the Parent  field in 
the child task record.

You can create predecessor-successor relationships between child tasks with different parents, 
between two different parent tasks, or between a child task and another parent task. However, if 
the predecessor task finishes after the successor task starts, creating a dependency between 
child tasks that have different parents is not allowed.

Note: 
On the Gantt chart, you can drag-and-drop the parent task to move the entire hierarchy to a 
new location on the schedule.
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Time constraints in parent-child relationships

Parent-child task relationships have several effects on task time constraints.

When a child task is set to Start ASAP

The child task starts at the same time as the parent task. If Project itself is set as a 
parent, the Start ASAP  tasks starts on the same date as set in the Constraint Date 
field, as long as it does not have dependencies with other child tasks.

When a parent task is set to Start ASAP  and child tasks are set to Start on specific date:

• The earliest child task start date determines the start date of the parent, assuming 
no other dependencies.

• In this case, the Time constraint  field of the parent remains Start ASAP, but the 
actual start date is changed to the start date of the earliest child task.

When a parent task is set to Start ASAP  and child tasks are set to Start on specific date:

Child precedence also applies to end dates. If the estimated end date of the child 
task is later than the end date of the parent task, the estimated end date extends to 
cover the child. For actual values, a parent has the same start date as the earliest 
start date of its children. The latest actual end date is the latest end date of its 
children. Assuming the child tasks are Closed Complete. If the child tasks are not in 
the Closed Complete  state, the actual end date of the parent is empty.

For the planned start date of the parent task:

• The planned start date is the earliest planned start date of all the children that do 
not have an actual start date.

• If all child tasks have actual start dates, the planned start date of the parent task is 
set to the actual start date.

For the planned end date of the parent task: The latest planned end date or actual 
end date of the child tasks determines the planned end date of the parent.

A task with Start no later than  or Start on specific date  time constraint cannot be 
a parent task. When a new child task is added to a task with these time constraints, 
the time constraint for the parent task is changed to Start ASAP.

Top-down and bottom-up planning

• For top-down planning, create a task that you already know includes several child tasks. Then 
create the child tasks and specify that they are child tasks of the first task you created.

• For bottom-up planning, create tasks for the smallest units of work first. Then you can create 
intermediary parent tasks that cover a group of related child tasks. For example, if there are 
five sequential tasks that comprise a phase of a project called install database, create the five 
tasks first. Then create another task called Database installation and make it the parent task of 
the five tasks. Rollup calculations, such as Planned duration, for the Database installation task 
are automatically calculated based on the child tasks.

It is easiest to build task relationships and dependencies while creating sets of tasks.

• A dependency means that a task relies on other tasks to be performed (completely or partially) 
before it can be performed.

• A relationship means a parent-child relationship whereby several subtasks are configured 
under a parent task or phase, which rolls up fields like Planned duration  and Estimated cost.
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Use the Gantt chart  with task forms and related lists to build relationships. Add milestones 
based on the major events of a project and create dependencies between milestones and 
tasks, if necessary.

Also set up notifications to alert project task assignees when their tasks move to the Work in 
Progress  state. See Creating Project Tasks for more information on creating tasks.

Related topics

Parent-child rollup task calculations

Create a parent-child relationship on the Project Task form

Parent-child rollup task calculations

Date changes, stage changes, and value calculations roll up from child tasks to parent tasks.

• Date changes involve modifying the planned start or end date of a parent task based on those 
values in child tasks.

• State changes involve modifying the state of the project record or parent task records when all 
child records are set to a certain state.

• Calculations involve summing the values of child tasks and then automatically updating the 
parent to reflect a new total.

The following fields change on rollup tasks:

• Planned Start date: Set to read only for parent tasks. Remains editable for the project record 
(also considered the top-level task).

• Planned End Date: Becomes read only.

• Planned Duration: Becomes read only.

• Actual Start Date: Becomes read only.

• Actual end date: Becomes read only.

• State: Becomes read only.

Duration Rollups
Rollups are calculated for the following items:

• Planned duration and planned effort: the sum of all planned duration and planned effort 
values for all child tasks.

• Actual duration and actual effort: the sum of all actual duration and actual effort values. 
Actual duration and actual effort values are calculated when all child tasks are in the Closed 
Complete  state. Actual effort values can include rollups from time cards.

Note: 
Verify that the time card property com.snc.time_card.update.effort  is enabled. Navigate to 
System Properties  > All Properties  to enable this property.

Cost Rollups
Cost calculations roll up when the costing add-on is active.

• Estimated cost: The sum of all cost estimates at the beginning of a project. Estimated costs of 
child tasks roll up to parent tasks and to the project.

• Actual cost: By default for the project, the sum of all costs of all the expense lines, and are 
typically associated with a time card and a labor rate. To track costs, you can derive rates using 
any of the following options:
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◦ Associate a rate model  to the project.

◦ Define rate cards for the task and labor expenses.

◦ Associate rate at the resource plan level.

These rates automatically generate expense lines showing actual expenditures, which are 
associated with the projects. If rate cards are defined, the task expense lines are generated 
as each project task closes, and labor expense lines are generated when time cards are 
approved. Expense lines are visible in the Expense Lines  related list, which requires the 
Advanced view  on both Project and Project Task forms.

To ensure actual costs of child tasks correctly roll up to the project and added to project expense 
lines, the following must be true:

• The com.snc.project.rollup.cost  property must be set to true. To enable this 
property, navigate to Project Administration  > Settings  > Preferences - Project  and select the 
Enable project cost rollup  check box.

• The glide.cost_mgmt.process_task_top_task  property must be set to false. Go to 
the costing properties in the Cost Management application. Check the When creating a task 
expense line should the system also create expense lines for the task's top task box  is not 
checked.

• The glide.cost_mgmt.calc_actual_cost  property must be set to true. Go to the 
costing properties in the Cost Management application. Check the For planned tasks types, 
calculate the actual cost field using the total of expense lines for the task  box.

Project State Rollups and Roll Downs
Project task states roll up. The state of parent tasks becomes read only, and changes 
automatically when you change the states of child tasks.

Project task states can roll up if:

• The state of the child task is manually changed and there are no other conditions on the 
parent task.

• The state of the child task is changed to Work in Progress  or Closed. These states roll up to 
the parent. Pending  and Open  do not roll up to the parent task.

Project states can also roll down. If you change the state of a project to closed, all tasks under 
it change to the default closed value (Closed Complete). If a closed project or closed task is 
reopened, all tasks under it change as follows:

• Project or parent changed from closed to Pending  or Open: Child tasks change to Open.

• Project or parent changed from closed to Work in Progress:

◦ Child tasks with a Start on  date that has passed are changed to start ASAP  and the state is 
changed to Work in Progress.

◦ Child tasks with a Start on  date that has not yet passed retain the same start on date but the 
state is changed to Open.

Related topics

Create a parent-child relationship on the Project Task form

Project tasks

Create project tasks in several ways, even from other applications in the instance.
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Before you begin
Role required: it_project_manager

About this task
You can create a project task using any of the following options.

Procedure

• Use the Project Tasks related list.
This related list is available from both a project record and a project task record. You can use 
the New  UI action  or insert a new row in the related list.

• Use the planning console.

• Use the project task creator.
Use a dialog box to create multiple tasks at one time. The project task creator is available from 
both a project record and a project task record.

• By copying an existing project or task.
This option copies a selected task, or even a whole project, including all child tasks.

• From an incident, problem, or change request.
The Project Task related list is also available from the Incident, Problem, and Change Request 
forms. The tasks you create from these forms makes the project task a child of the incident, 
problem, or change, rather than a project.

Related topics

Link change requests to a project task

Schedule conflicts between project tasks

Scheduling conflict helps you to identify project tasks that are not honoring dependencies. 
A scheduling conflict occurs when one project task prevents other task from starting on the 
specified date because of dependencies or constraint types.

A scheduling conflict occurs when any action such as applying a dependency, changing 
constraint type, or constraint date causes the task start date to violate the project's constraint 
date.

When a scheduling conflict occurs, the system warns you about the conflict. You can choose 
to cancel the action that is causing the conflict or continue with the conflict. If you choose 
to continue with the conflict, the constraint date is given highest precedence and dates are 
recalculated. The start date is moved till allowed by the task constraint date, but dependency is 
not honored.

For example, consider the following scenario:

For a project with project task's Constraint date  set as 20 January, there are two tasks:

• T1 with constraint type set to As soon as possible and start date of 20 January.

• T2 with constraint type set to Start no later than and start date of 20 January.

If you add an FS dependency between tasks T1 and T2, the task T2 should start on 21 January, 
but due to Start no later than constraint, task T2 cannot start on 21 January. This inability of 
starting task T2 on the specified date is an example of conflict.

In this example, if you choose to proceed with the conflict, the start date of task T2 is moved to 
20 January which is the constraint date.

Scheduling conflict between tasks is shown for tasks with Start no later than  and Start on 
specific date  time constraints.
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If you want the task to honor the dependency and adjust the start accordingly, change the 
constraint type of the task to Start ASAP.

When a scheduling conflict is identified, you can identify such tasks in the planning console.

• The client-side planning console displays a pop-up message with an option to proceed with 
the conflict or cancel the action. If you proceed with the conflict, the constraint type is applied 
or date is changed appropriately to the next feasible date.

• The calendar icon ( ) on the client side planning console changes to red ( ) to indicate the 
conflict.

• The calendar icon on the server side planning console changes to red ( ) to indicate the 
conflict.

Change requests and project tasks

Large-scale changes approved by your change approval board (CAB) require new or existing 
projects to be implemented.

To bridge the gap between change management and project management, the instance allows 
you to link one or more change requests to a project task. You can link an existing change 
request to a project task or create a new change request directly from a project task.

When you link a project task to a change request record, a new project task link record is created. 
It provides the actual link between the project task record and the change request record. The 
project task link copies all attributes of the change request record. It then becomes a child task 
of the project task that you linked to the change request. The rules that govern the relationship 
between the project task and the project task link are the same as the rules for all parent and 
child tasks.

Project tasks linked to change requests

Note: 
A project task cannot have both task link records and child project tasks. When a project 
task is linked to a change request, you cannot also create child tasks for that project task. 
Likewise, when a project task has child tasks, you cannot link the parent project task to a 
change record.

The project task link record is read only. You can view the project task links from a related list on 
the Project Task form.
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You can also link multiple change requests to a single project task. In this case, a project task 
link record is created for each link and all the project task link records become child tasks of the 
project task.

Project tasks links

Change request project task relationship

The rules that apply to all parent-child tasks also govern the relationship between project task 
and the project task link. The project task link inherits start and end dates from the change 
request. However, the Project Management  application adjusts the dates when these situations 
occur:

Start and end dates:

• If the project task and the change request have different planned start dates, the project task 
link uses the later of the two dates. For example, if the project task starts on October 1 but the 
change request starts on October 2, the project task link changes to October 2.

• If the change request has an earlier start date, the Time constraint  value for the project task 
link becomes Start ASAP  when the link is created. The end date remains the same as the end 
date specified in the change request record.

• If the change request starts and ends before the project start date, the project task link has a 
duration of zero (0). It also appears as a milestone that occurs when the project starts.

• If a change request is scheduled to start during non-work time according to the project 
schedule, the planned start date of the project task link ignores the schedule. It also starts at 
the time specified by the change request. However, the duration of the project task link does 
take the schedule into consideration. For example: the project uses the default schedule, 
which specifies that work hours are Monday to Friday from 08:00 to 17:00 with an hour break 
from noon to 13:00. A change request with a 13-hour duration starts at midnight. The project 
task link starts at midnight and continues through the start of the schedule at 08:00. It stops at 
noon for one hour, and continues from 13:00 until 14:00. The total duration would be 13 hours.

Project Task Duration

The duration of the change request determines the duration of the project task link. That duration 
is rolled up to the parent project task just as all child task durations roll up to parent tasks. The 
Planned start date  and Planned end date  in the Change Request form Schedule  section are the 
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fields that determine the duration. If there are no planned dates on the Change Request form, 
the default duration is one project day. The project has a schedule or 24 hours when the project 
has no schedule.

Multiple Linked Change Requests

If you link additional change requests to a project task, additional project task links are created. 
All become child tasks of the project task. The dates roll up to the parent task. For example, if a 
linked project task is planned to finish on October 30. You link a new change request scheduled 
to finish on November 30, a new project task link is created. The parent task planned end date 
extends to November 30 to cover the duration of both project task links. A change request can 
only be linked to one project task. It cannot be linked to multiple tasks in the same project or 
across multiple projects. A project task that has one or more child tasks cannot also have a 
project task link connecting it to a change request.

Project Task State

If the state of a change request changes to Pending, Open, or Work in Progress, the state of the 
project task link changes accordingly. If the state of the change request changes to any of the 
closed states, the state of the project task link changes to Closed Complete.

How Modifications Propagate Between Change Requests and Project Tasks
Modifications to a linked change request propagate to the project task link. However, the 
reverse is not true. You cannot modify the change request record from the Project Management 
application.

Modifications to the following fields propagate from the change request to the project task link:

• Planned start date

• Planned end date

• State

These change request settings also roll up to the project task that is the parent of the project 
task link, and also up to the project record. Consider the following example: a project has not 
yet been started and all its tasks are in the Pending  state. If you changed the state of a linked 
change request record from Open  to Work in Progress, the project task link, its parent task, and 
the project itself all change to Work in Progress.

When you start a project, tasks that have Start ASAP  as the time constraint and have no other 
start dependencies start immediately. However, project tasks with linked change requests do not 
start automatically. The project manager must start the task manually by changing the State  field 
to Work in Progress.

Modifications made in the Project Management  application do not propagate to a linked change 
request record, so closing a project does not close a linked change. When you successfully 
implement a change and close the project it belongs to, you must go to the change request 
record and manually change the state to Closed.

Related topics

Link change requests to a project task

Project task checklists

A project task checklist gives you the ability to track activities that must be completed on a task.

For a project task to be considered complete, you can track activities that do not require separate 
subtasks. For example, you have a human resources-related project that includes a task for 
interviewing candidates. You can also track booking a meeting room or getting an interview 
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confirmation from the candidate. Create a checklist item for each and mark when they have been 
completed.

Checklist items do not have start or end dates, nor do they track effort or cost. By default, a 
checklist item record provides only a name and a Complete field, which can be set to true or 
false. The state of the project task is independent of the state of the Complete field on the 
checklist item.

Checklists, as well as tasks, are copied into a project template. You also have access to all 
checklist templates from any project task form.

Note: 
Checklists are available for any form that is based on a table extended from the Task table. 
Administrators can add or remove checklists as needed.

Related topics

Use a project task checklist

Save a checklist as a template

Task resources

Resources are the individuals or groups assigned to perform tasks and subtasks in Project 
Management.

You can use Resource Management to set up resource plans, which can be associated with 
projects. Activate Project Portfolio Management  to use Resource Management with Project 
Management.

Related topics

Resource Management classic

Resource Management Workspace

Project and project task states

In the base system, the states in project and project task inherit the states in Task table.

The states are grouped into different categories as shown below:

State Label Category

-5 Pending Pending

1 Open Open

2 Work in Progress Work in Progress

3 Closed Complete Closed

4 Closed Incomplete Closed

7 Closed Skipped Closed

The category information for the states is declared in dictionary override  of State column in 
Planned task (planned_task) table in Attributes  field. Planned task is the parent table for 
project and project task tables.

The start and end dates are displayed based on the project or task status:
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• Pending/Open: Planned start date is displayed.

• Open/Work in Progress: Actual start date is displayed.

• Closed: Actual end date is displayed.

Related topics

View default project and project task state categories

Customize a state for project or project task

Composite Fields

A composite field combines information from two fields in a table to form a single field.

For example, the Task  field on the Project Tasks list displays the short description and the project 
task number. The short description appears above the project task number. The project task 
number appears and is a link to the Project Task form.

Composite field

Use a composite field

• Editing a composite field changes the short description. Editing the short description changes 
the composite field.

• Sorting on a composite field is based only on the short description and not the number.

• Searching on a composite field is enabled for both the short description and the number:

◦ To search by the number using the list header, enter an asterisk (*) before the search term. 
For example, *PRJTASK0010016.

◦ To search by the number using the filter, create a condition similar to: [Task] [contains] 
[PRJTASK0010016].

Cost plan breakdown

A cost plan breakdown captures the estimated cost and actual cost for every fiscal period. Cost 
plan, project, demand, program, and portfolio are the breakdowns types that are available.

Requirement

Requirement corresponds to a single cost plan. For example, for a regular calendar 
and a cost plan spanning across one year, 12 breakdowns would appear.

Task

Task corresponds to a project or a demand. The cost across all the cost plans per 
period is rolled up to the project or demand level. These records have breakdown 
type set to Task. There would be only one record of type Task  per period. The 
number of records of type Task  that are created depends on the duration of the 
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project or demand, and the requirements planned in the project or demand. For 
example, for a regular calendar and a project with three cost plans, 12 breakdowns 
appear.

Program

If a project or a demand is part of a program, the breakdown type of Program 
provides the aggregate of program level costs per period.

Portfolio

If a project or a demand is part of a portfolio, the breakdown type of Portfolio 
provides the aggregate of portfolio level costs per period.

System-generated cost plans

When an expense line is created without populating the Cost Plan  field, system-generated cost 
plans are created automatically.

The orphan expense lines are associated to the system-generated cost plans. This association 
ensures that the project actuals shown on the widgets or the total actuals are the same as 
the aggregate of the cost plan actuals on the grid shown on the Project Financials page and 
Investment Portal.

Note: 
System-generated cost plans are created only when the project has a minimum of one cost 
plan.

System-generated cost plans are created for any of the following reasons:

• When you create an expense line without populating the Cost Plan  field.

• When you create a time card and approve it.

There are two system-generated cost plans, CapEx and OpEx. Depending on the type of 
expense selected while creating an expense line, the type of system-generated cost plan is 
created. The following are the name formats for the system-generated cost plans:

• <project number> System generated CapEx costplan

• <project number> System generated OpEx costplan

When you create a time card and approve it, an expense line of type CapEx is created and 
then the orphan expense line is associated to the system-generated cost plan of type CapEx. 
The system-generated cost plans are created to ensure that none of the expense lines are left 
without being associated to a cost plan. The system-generated cost plans are read-only.

For customers upgrading to Zurich, you can run the project diagnostics, Associate orphan 
expense lines to the system generated cost plan, to associate orphan expense lines to a 
system-generated cost plan. The diagnostic scan lists the expense lines that are not associated 
to any cost plan. When you run the fix script, system-generated cost plans are created, and the 
orphan expense lines are associated to the system-generated cost plans.

Actual project costs

Actual project costs come after you create expense lines for cost plans or after human resources 
use time cards to create expense lines.

The system captures actual project costs from expense lines:
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• Expense lines from cost plans: You can create expense lines from a cost plan. Allows you to 
specify the amount and date when the expense was incurred. The actual amount incurred is 
included in the cost plan after the expense line is processed.

• Expense lines from timecards: Human resources can record time for project work by using 
time cards. When time cards are approved, the system generates expense lines. After the 
expense lines are processed, the actual costs are recorded for the project. If you provide a 
resource plan when creating time cards, the cost plan name is derived from resource plan and 
cost is captured against the resource plan. If you do not provide a resource plan, the cost is 
captured against the project.

Related topics

View actual project costs

Types of external dependencies

The Project management application supports two types of external dependencies - hard and 
soft.

The type of external dependency can be set during adding a dependency  between two projects 
tasks on the planning console.

Hard dependencies

In a hard dependency, any changes made in the predecessor project are automatically 
propagated to the successor project. A notification  for the changes made is triggered in the 
successor project. The following image shows the process flow for a hard dependency type:

External hard dependency

Soft dependencies

In a soft dependency, any changes made in the predecessor project trigger a notification in the 
successor project. As the project manager of the successor project, you can choose to accept or 
reject the changes in the notification. If you accept the notification changes, the changes in the 
predecessor project are synced to the successor project and the project is recalculated. If you 
reject the notification changes, the changes are not propagated to the successor project. The 
following image shows the process flow for a soft dependency type:
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External soft dependency

Project and portfolio funding

Specify the amount of money that projects and portfolios are allowed to have.

You can fund projects and portfolios when you activate PPM Standard with Financials.

The funding process follows these steps:

1. Identify the costs for time, such as a financial year, by creating cost plans at the project 
or demand level. These costs roll up to the portfolio Cost Plans related list. Cost plans 
automatically include cost plan breakdowns for each fiscal period. See Create a project cost 
plan  and Create a demand cost plan.

2. Enter the target cost values for operational and capital expenses for the portfolio. See Create a 
portfolio.

3. Create budget plans for the projects in your portfolio and promote the plans to forecasts.

Multicurrency in Project Management

Use the multicurrency feature to execute a project or part of a project in a different geographic 
location that has a different local currency.

The feature helps you to view the cost details of the project in a currency that is different from 
your functional currency. The values in the project's cost plans, benefit plans, and corresponding 
cost fields of the project form are also converted to a currency that you specify as project 
currency. Therefore, you don't need to convert the project currency to the functional currency 
of the project when the project is executed at a location that uses a currency different than your 
functional currency.

Activation information

Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin to enable 
the multicurrency features in Project Management. Activating the plugin enables the project 
currency view in project, cost plans, and benefit plans forms. With the project currency view, you 
can manage your project financials and cost plans in multiple project currencies.
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Note: 
Activating this plugin automatically activates PPM Standard 
(com.snc.financial_planning_pmo) plugin and therefore you get the option to switch 
between the default view and the project currency view.

Project currency view

In addition to the default view in the Project form, there is Project Currency view, which you 
can optionally enable to view the multicurrency fields. You can enable this view from the form 
context menu. The view appears only when you activate the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin.

Unlike the Default view, the Project Currency view contains multicurrency-related fields.

You can designate a currency other than the functional currency as the processing Project 
Currency for a project. The Financials  tab of the Project form has the Project currency  field. You 
can select an active currency from the Currencies [fx_currency] table.

Note: 

The Project currency  field of a project becomes read-only field and locked down for 
updating the currency once you create a cost plan, cost plan breakdown, benefit plan, 
benefit plan breakdown, or an expense line for the project.

Specify project currency in Demand

You can specify the project currency that you want to use for managing a project when you 
convert a demand to a project. You can continue to manage the demand using your functional 
currency, project currency, or a local currency. For more information, see Multicurrency in 
Demand Management.

Projects in Project Workspace

Track your projects in project currency in the Project Workspace. Create and monitor the 
cost plans and benefit plans for a project in project currency. For more information on project 
workspace, see Project Workspace.

To view the cost component in project currency at the grid level and at the breakdown level, see 
Create and manage cost plans and benefit plans for a project.

Project status reports

To view the planned and actual cost status of your projects in project currency, open the 
overview and cost sections of project status reports.

Updates in cost plan and recalculation of cost in project currency

If the unit cost, quantity, or fiscal period of a cost plan are updated, then all the related amount 
fields in the cost plan, its breakdowns, and the project to which it is rolling up are recalculated in 
project currency.

Changes in Unit cost, Quantity, and Recurring check box of a cost plan

When you modify the Unit cost  field, Quantity  field, or Recurring  check box of the 
Cost Plan form, the Total planned cost is recalculated in project currency. Similarly, 
the Cost in project currency  in the Cost Plan Breakdown is also recalculated. 
Therefore, the values in the Planned capital in project currency, Planned operating 
in project currency, and the Total planned cost in project currency  fields of the 
project are also recalculated.
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Changes in the fiscal period of a cost plan

When you change the fiscal period, either the start or end dates in the Cost Plan 
form, the Total planned cost  and the Cost in project currency  of the cost plan 
are recalculated. Therefore, the Cost Plan Breakdown records may be added or 
removed. If the Recurring  check box is not selected, then the Cost in project 
currency  of each Cost Plan Breakdown record is recalculated. In line with this, the 
values in the Planned capital in project currency, Planned operating in project 
currency, and the Total planned cost in project currency  fields of the project are 
also recalculated.

Changes in the entered cost of a cost plan

If you change the Entered cost  in an individual Cost Plan Breakdown record, 
then the Total planned cost  of the cost plan is recalculated in project currency. 
Therefore, the values in the Planned capital in project currency, Planned operating 
in project currency, and the Total planned cost in project currency  fields of the 
project are also recalculated.

Addition of breakdowns to a cost plan

If you manually add cost plan breakdowns to a cost plan, then the Total planned 
cost  of the cost plan is recalculated in project currency. Therefore, the values in 
the Planned capital in project currency, Planned operating in project currency, 
and the Total planned cost in project currency  fields of the project are also 
recalculated.

Predictive Intelligence  for Project Management

The Predictive Intelligence  for Project Management  capability uses machine-learning algorithms 
to search and display similar projects while defining a new project using the project form. You 
can also search for existing projects and compare similar projects for project planning.

The PPM Predictive Intelligence Workbench includes a prebuilt use case template that 
systematically guides you through the process of creating and training new predictive models, 
evaluating and testing them, and finally adding them to your business process to add value to 
your Idea, Demand, and Project Management.

Once you train your custom use cases, they are usable immediately. No prior knowledge or 
experience with artificial intelligence or machine learning is required when you use the PPM 
Predictive Intelligence Workbench.

The application includes templates with prebuilt guidance to assist you in creating, training, 
evaluating, testing, and producing your unique predictive models.

Predictive Intelligence  for Project Management  has the following benefits:

• Improves the quality of your database by avoiding duplicate projects.

• Helps you in planning your project. You can view planning details of similar projects that were 
created and executed in the past.

Activation information

Activate the following plugins before using the Predictive Intelligence Workbench:

• Predictive Intelligence for PPM (com.snc.ppm_ml) plugin

• Predictive Intelligence for Ideation (com.snc.innovation_management_ml) plugin
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Solution definitions for Predictive Intelligence  for Project Management

The solution definition for Predictive Intelligence  for Project Management  capability is available 
in the Predictive Intelligence for PPM plugin (com.snc.ppm_ml). For more information about 
Predictive Intelligence, see Predictive Intelligence  and Contextual search .

Solution Definition for Project Management

Solution Definition Solution Type Description

Similar Projects

Note: 
This solution definition is 
available as a template 
on instances where the 
following plugins are 
active:

• Predictive Intelligence 
for Contextual 
Search plugin 
(com.snc.contextual_search_ml)

• PPM Standard plugin 
(com.snc.financial_planning_pmo)

• Predictive Intelligence 
for PPM plugin 
(com.snc.ppm_ml)

Similarity View similar projects based 
on the Project Name  and 
Description  fields. You can 
see the results in the Similar 
projects  section on the 
Project form.

Related topics

Predictive Intelligence

Train the similarity solution for Project Management to find similar projects

Starting a project

Configuring Project Management

Learn about the process required to set up and configure Project Management  to enable your 
project managers initiate and plan projects.

Configuration overview

With the Project Management application, you can plan, organize, and manage projects and 
resources more effectively, making it easier and faster to complete projects. To use the Project 
Management application, you need to install the PPM Standard plugin. For more information, see 
PPM Standard (Project Portfolio Management).

Upgrade existing projects on activating multicurrency plugin

Execute the PM upgrade project currency for active projects  and PM 
upgrade project currency for inactive projects  scheduled jobs to upgrade 
your active and inactive projects, respectively, after you activate the multicurrency plugin. Select 
the scheduled jobs and run them on demand to upgrade your projects in project currency only 
when necessary.
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Before you begin
Role required: admin or it_project_manager

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Click the PM upgrade project currency for active projects.

3. Click Execute Now  to upgrade all your existing active projects to project currency.

On execution of the job, all amounts in the cost-related fields of the Project, Project Task, 
Baseline, Cost Plan, Cost Plan Breakdown, Benefit Plan, Benefit Plan Breakdown forms are 
copied from functional currency to project currency fields. Once the values of functional 
currency fields are copied to the project currency fields project currency cannot be edited 
since the financial costs already exist.

4. To upgrade your inactive projects, click PM upgrade project currency for 
inactive projects.

5. Click Execute Now.

On executing the scheduled job, the project currency value for all existing projects is set to the 
functional currency. The project currency in the Project Tasks, Baselines, Cost Plans, Cost Plan 
Breakdowns, Benefit Plans, Benefit Plan Breakdowns, Expense Lines forms is set to functional 
currency.

Note: 
The jobs may have performance impact depending on the number of projects and cost 
plans, hence run the jobs only when necessary.

Using Project Management

Use Project Management  to plan, manage, and track projects effectively.

Plan the project

Before creating a project, consider the following questions and issues:

• Do you want a top-down or bottom-up approach to tasking?

Top-down tasking involves creating a project first, then identifying major project phases. 
Later on, phases can be broken down into tasks and subtasks. The emphasis is on creating 
estimates for high-level items such as phases and parent tasks and then building the project 
down from there toward a more detailed level. Use caution when creating tasks for top-down 
tasking. Creating a task under a project that has a start-on date later than the start date of the 
project, the project shifts to the later start date. The Project Management  application supports 
bottom-up tasking better.

Bottom-up tasking involves creating several sets of small tasks and estimating task items such 
as effort, cost, and duration. These estimations are then aggregated into high-level parent 
tasks (rollup tasks) and phases. The emphasis is on estimating smaller chunks of work as 
accurately as possible first, then letting those estimations roll up into parent tasks, phases, and 
the project itself.

• Is the project part of a larger portfolio of projects?

Also consider portfolio planning  and how the project relates to similar projects or initiatives.

• What types of dependencies do the tasks have with other tasks?
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The Project Management  application supports various dependencies.

• Can milestones and project baselines help manage a project?

A milestone is a project task with a duration of 0. Use milestones to indicate important dates in 
a project. If necessary, create dependencies between tasks and milestones so that a task does 
not start until a milestone has been reached.

A baseline is a snapshot of the current planned start and end dates at the time the baseline 
was created for each task. A line appears under each task on the Gantt chart for the original 
planned start and end dates. The line appears shifted to the left or right depending on whether 
the task was started early or late. If tasks slip to later dates, the baseline indicator provides an 
easy way to see how severe the delays are.

• Have the necessary skills, groups, and resources been created in ServiceNow?

If project tasks are assigned to different groups or individual resources with the required skills, 
create users and groups and configure the Skills Management application.

• Does an existing incident, problem, or change justify creating a project to track it?

Of these record types, a change is most likely to lead to activities that are tracked as a project.

• Do you want to track project costs?

Estimate group resource costs before starting the project. Then track the actual cost of each 
user resource from time cards. The Project Management  application can also calculate the 
costs of affected CIs in a project. The Project Management  Costing add-on is required to track 
costs.

• What goals do you want the project to achieve?

Every project has at least one goal. Project goals are saved in the Goal table and can link to 
any task. In a typical scenario, link one goal to each project and keep the State  field of the goal 
up to date.

Assign resources or assignment groups to the tasks
User resources are the individuals in an organization who are assigned to project tasks. You can 
manage your resources with resource plans in the Resource Management application.

Add the project to a portfolio

A portfolio is a group of related projects. If the project is related to other projects, create a 
portfolio and add the project. The Project Management  application provides a useful portfolio 
view that makes it easy to report on the status of all projects in a portfolio. Portfolios also include 
demands.

Starting a project

Initiate a project by changing the project state to Work in Progress. Define important aspects of 
your Agile, Waterfall, or Hybrid project such as the duration, estimated cost, and net value to your 
organization to efficiently track the project's progress.

Before you begin
Role required: it_project_manager
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About this task
When you change the State  field on the Project form to Work in Progress, the Actual start date of 
the project changes to the planned start date.

You can create a project from the Projects list or from the project planning console. You must 
have the Agile Development 2.0  plugin to create an Agile or Hybrid project and the Test 
Management  plugin to create a test phase for your project.

Note: 
You can also create a project from the demand workbench.

After you start the project:

• The read-only Actual start date  field of the project is populated with the planned date.

• If a task or set of tasks are scheduled to start immediately upon project start (meaning that 
their time constraints are set to Start ASAP  and they have no other start dependencies), the 
actual start dates of those tasks also get populated with the planned date.

• The planned start dates of all other tasks adjust accordingly based on the time you started 
the project. Their new planned start dates depend on several factors, including dependent 
relationships with other tasks and the duration for each task.

Note: 
Once a project is in the Work in Progress  state, it does not mean that the state of every 
task will start updating automatically based on planned start date. Other than the project 
tasks that you schedule to start ASAP  when the project starts, project tasks are not 
started automatically. Continue to manage the project and change the state of each task 
to Work in Progress.

You can also use the multi-currency feature to create a project in a local currency different 
from your functional currency. You must enable the PPM Standard Multicurrency plugin 
(com.snc.ppm_multicurrency) and switch to the Project Currency view for the additional fields 
in the Financials  tab of the Project form. For more information, see Multi-currency in project 
financials.

Procedure

1. Create a project in any of the following ways.

2. On the form, fill in the fields.
For field information, see  unique_1265.

3. Select Submit.

Related topics

 unique_1265

Project Portfolio Management

Create a project task from a project

Create tasks from the project form to break down project objectives into manageable units of 
work.

Before you begin
Role required: it_project_manager
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Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Select the project from the list.

3. In the Project Tasks  related list, select New.

4. On the form, fill in the fields.
For more information on project task form, see Project task form.

5. Select Submit.

Result
The new task appears in the Project Task  related list on the Project form. If time cards are in use, 
the application creates a time card for the resource.

What to do next
The value in the Percent complete  field is related to the State  field in the v3 application. If you 
change the percentage complete from 0  to any other value, the state of the task changes to 
Work in progress  when you save or update the record. Likewise, if you change the state of the 
task to Closed complete, the Percent complete  field is set to 100  and becomes read-only.

If you change the state of a project task from Work in progress  to Closed Skipped  or Closed 
Incomplete, the Percent complete  field retains the current value and becomes read-only.

The Percent complete  field appears in the Gantt chart for parent tasks as a light-colored bar (the 
part of the task that is complete). The bar overlaps the darker, underlying bar (the full task). For 
example, a Demo project is 5.41% complete as shown in a pop-up window. The Phase 1  task is 
about 50% complete (not shown in the pop-up window).

The Project Tasks list and the Project Tasks related list on the Project form include a Dependency 
field. Any dependencies for a task, such as a parent task, are displayed in this field. Click a 
dependency record. See Predecessor dependencies in the planning console  for a description of 
what you see in this column.

Create a task from an incident, problem, or change request

You can create a new project task from the Project Task related list on the Incident, Problem, and 
Change Request forms. The tasks you create from these forms makes the project task a child of 
the incident, problem, or change, rather than a project.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to the Incident, Problem, or Change Request form.

2. Configure the form to add Project Task  > Parent  if the related list is not already present.

3. In the Projects  related list, select New.

4. Fill in the project form.

The project task becomes a child task of the incident, problem, or change record.

Create tasks from project task creator

Use the project task creator to create multiple tasks at once.

Before you begin
Role required: it_project_manager
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Procedure

1. In the Project form, right-click the header bar and select Project task creator.

2. Enter the number of tasks to create.

3. Select the Create FS dependency  check box to create a finish-to-start dependency between 
these tasks (when the first task finishes, the next task starts).
Clear the check box to create the tasks with no dependencies.

4. Select OK.
The new tasks appear in the Project Tasks  related list. The application automatically creates 
a task Number  and a Short Description  that starts with Auto Created Task, followed by a 
number when more than one task is created.

Insert a row into the project tasks list

You can create a new project task from the Project Task related list on the Project form. 
Administrators must enable this task-creation feature.

Before you begin
Role required: it_project_manager

Procedure

1. In the Project form, navigate to the Project Tasks related list.

2. Double-click Insert a new row.

3. Select the green check mark.

4. Open the new task and edit the record as required.

Copy an existing task or project

Save time when building a project by copying tasks from other projects.

Before you begin
Role required: it_project_manager

About this task
The Copy partial project  option copies a selected task and its child tasks into the project, or all 
project tasks into a sub-project. It also preserves all dependencies and relationships among the 
copied tasks and their child tasks. Any relationships or dependencies that involve tasks outside 
of the scope of the copied task are not preserved.

Procedure

1. In the Project or Project Task form, right-click the header bar and select Copy partial project.

2. In the Task  field, select a project task or project to copy.
By default, projects begin with PRJ and project tasks begin with PRJTASK.

3. Enter a Name  for the new project or task.

4. Select OK.

The copied task is added to the current task or project. If a project was copied, then all the 
tasks are inserted into a new sub-project.
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Result
The copied tasks are inserted as a child of whatever task or project that you are currently 
viewing. Actual duration and the actual start and end dates are reset to null values. The state is 
set to New  and percent complete is set to 0.

By default only the short description, planned dates and duration fields are copied from source 
project to the target project. If additional columns must be copied, they should be declared in the 
project property  List of attributes that will be copied from the originating project task.

Related topics

Change default values of copied fields

Change default values of copied fields

Change the default values of in the new partial project.

Before you begin
Role required: admin

About this task
Actual duration and the actual start and end dates are reset to null values. The state is set to New 
and percent complete is set to 0. Administrators can modify UI pages to determine which fields 
are reset or to change the default values.

Procedure

1. Navigate to All  > System UI  > UI Pages.

2. Open the copy_partial_project record.

3. Use the following script if in the Processing script  field:

/* resetFields is the array containing the list of names of 
 fields that need to be erased from the copied project tasks
    * defaultFields is the array containing the key, value 
 pairs of field names and values that need to be set on the 
 copied tasks
    */var resetFields =new Array();var defaultFields ={};
   resetFields.push("work_start","work_end","work_duration");
   defaultFields["state"]="-5";
   defaultFields["percent_complete"]="0";

Related topics

Copy an existing task or project

Create a task from a project task template

You can save a project task as a template and reuse it when creating a task.

Before you begin
Role required: it_project_manager
You must have a template from an existing project task that has the required field values. See 
Templates  for more information on this platform feature.

Procedure

1. Navigate to All  > Project  > Tasks  > All.

2. Select New.
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3. If the templates do not appear at the bottom, select the ellipsis ( ) icon at the top of the form, 
and select Toggle Template Bar.

4. Select the template link in the template bar at the bottom of the form.

The template is applied to the project.

View default project and project task state categories

View category information for the default project and project task states. In the base system, the 
states in project and project task inherit the states in Task table.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Dictionary.

2. Update the filter with the following AND conditions:

a. [Table] [is] [task]

b. [Column name] [is] [state]

3. Run the filter.

4. Select the task table, and then choose planned_task  table in Dictionary Overrides  related list.

Result
The Attributes  field displays different states and the categories for a state as shown below. It 
also displays the default state value for each category.

close_states=3;4;7,default_close_state=3,default_work_state=2,default_open_state=1,default_skipped_state=7,default_pending_state=-5,pending_states=-5,open_states=1,work_in_progress_states=2

Related topics

Project and project task states

Customize a state for project or project task

Add or modify a state of project or project task using dictionary override.

Before you begin
Role required: admin

About this task
As an example, the steps for adding custom states for Work in progress  state category for 
Project task are described. In this example,

• the existing Work in Progress  state is removed and following three new states are added:

State Label Category

10 Design Work in Progress

11 Development Work in Progress
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State Label Category

12 Testing Work in Progress

• the default Work in Progress  is kept as 10  (Design).

Procedure

1. Define  a new dictionary override for pm_project_task  table under  Task - State  
dictionary.

2. Specify the override attributes for the dictionary override in Attributes  field as follows:
close_states=3;4;7,default_close_state=3,default_work_state=10,default_open_state=1,default_skipped_state=7,default_pending_state=-5,pending_states=-5,open_states=1,work_in_progress_states=10;11;12

Result

• As specified in Step 2, the default_work_state  is declared as 10 and the 
work_in_progress_states  as 10, 11, and 12. Now whenever a project task changes 
to any of the new Work in Progress  states, its parent also moves to corresponding Work in 
progress  state.

Suppose that a project task has two children records, and if the first child record moves 
to Development  state, the parent also moves to Development  state. Now if the second 
child record moves to Design  state, the two children records under the project task are 
in two different work in progress states. In such cases, the parent record moves to the 
default work in progress state. In this case, the parent record moves to Design  as the 
default_work_state  is specified as 10  (Design).

• The project states can also be customized using the same steps.

Related topics

Project and project task states

Link change requests to a project task

Link change requests to tasks on the Project Task form. You can link change requests only to 
project tasks that have no child tasks.

Before you begin
Role required: it_project_manager

About this task
You can link any change request record to a project task, regardless of the change request 
schedule or state. However, as a good practice, consider:

• Change Schedule:  The change request has a schedule that falls within the time frame of the 
project it links to. Or, it has no values in the Planned start date  and Planned end date  fields in 
the Schedule  section of the Change Request form.

• Change State:  An Open  or Pending  state is required when linking a change request. Changes 
that are already in progress or closed can be stopped and copied to a new change request.

Procedure

1. Open a project task that does not have any child tasks.
You can cannot link change request to the tasks that already have child tasks.

2. Select one of the following related links:
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◦ Link an Existing Change Request to Project Task:

In the dialog box that appears, enter or select the change that you want to link.

◦ Create Change and link from Project Task:

The Change Request form appears. Enter the information in the form. The short description 
of the change request is taken from the project task.

Note: 
These related links are available only when the project task type is waterfall.

Result
On the Project Task form, a notification appears at the top specifying that the task is linked to one 
or more change requests.

Related topics

Change requests and project tasks

Accept or reject project task notifications

Approve or reject the changes in a notification for an external soft dependency.

Before you begin
Role required: it_project_manager

About this task
The Notifications  related list on the project record lists the external dependency  related 
notifications raised in the successor project. The notifications  are triggered as a result of 
changes made in the predecessor project that can impact successor project or task.

• The notifications for the hard dependency have theState  set to Processed by default.

• The notifications for the soft dependency have the State  set to New by default. As the project 
manager of the successor project, you can choose to accept or reject the changes in the 
notification.

Procedure

1. Open the project form.

2. Select the Notifications  related list.

3. Select the reference icon to open the project task notification record for an external soft 
dependency.

4. Select Approve  or Reject.

Result

• The Status  of the notification record changes to Accept or Reject.

• The State  of the notification record changes to Processed.

Use a project task checklist

You can create a checklist in a project task to track items that must be completed in the task.

Before you begin
Role required: it_project_user, it_project_manager
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Procedure

1. Navigate to a project task.

2. To create a checklist for the project task, select Create new  in the Checklist  section and 
specify a name for the checklist.

3. To remove a checklist from the project task, select the down arrow next to Checklist  and select 
Remove Checklist.

4. Note: 
This option appears when there is at least one checklist in the Checklist  section.

To save a checklist as a template, select the down arrow next to Checklist  and select Save as 
Template.

Related topics

Project task checklists

Save a checklist as a template

Save a checklist as a template

After you create a checklist on a project task, you can save it as a template and reuse it on other 
tasks.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to a project task.

2. Select the down arrow next to Checklist.

3. Select Save as Template.

4. Enter a name for the checklist.

5. Select Save.

Related topics

Project task checklists

Use a project task checklist

Create a parent-child relationship on the Project Task form

Create a child task from any project task form.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to the parent task in the relationship.

2. In the Project Tasks  related list, select New.

3. Create the task and select Submit.
The newly created task becomes the child task in the relationship.
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What to do next
To help remember what the parent of any task is, view the breadcrumb at the top of the Project 
Task form. It is also helpful to configure the form layout to include the Parent  field. You can also 
change the parent task from this field.

Create a monetary benefit plan for a project

Create a monetary benefit plan to specify the estimated benefit in a category spanning one or 
more fiscal periods. Project benefit plans capture the potential benefits accrued by the project 
when the project is executed.

Before you begin
Role required: it_project_manager

About this task
The monetary benefit plan breakdown records are automatically created when you save the 
benefit plan.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open the required project.

3. In the Monetary Benefit Plans  related list, select New.

Note: 
To create a monetary benefit plan from the Financials  tab in Project Workspace, select 
Manage.

4. On the form, fill in the fields.

For field information, see Benefit Plan form.

Note: 
When you move the project or the milestone date, the associated benefit plans also 
change accordingly based on whether the benefit plan is tied to the project start date, 
end date, or one of the project milestones. The project property  Change Resource Plan, 
Cost Plan and Benefit Plan Start Date with Demand or Project Start Date Change 
controls the behavior for project date changes.

5. Select Submit.

What to do next
On the Benefit Plan form, view the benefit breakdown by fiscal period in the Monetary Benefit 
Plan Breakdowns related list.

Related topics

Update a monetary benefit plan breakdown for a project

Update a monetary benefit plan breakdown for a project

Update a monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.

Before you begin
Role required: it_project_manager
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Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open the required project.

3. Select the Monetary Benefit Plans related list.

4. Open the required monetary benefit plan.

5. In the Monetary Benefit Plan Breakdowns related list, select the information icon ( ) for a 
monetary benefit plan breakdown.

6. Select Open Record.

7. On the Monetary Benefit Plan Breakdown form, view and update the enabled fields.
For more information, see Monetary Benefit Plan Breakdown form.

8. Select Update.

Note: 
Changing benefit plan start and end date is not possible if the recorded actual benefits 
are outside of the date range.

Related topics

Create a monetary benefit plan for a project

Create a non-monetary benefit plan for a project

Create a non-monetary benefit plan for a project

Create a non-monetary benefit plan to specify the estimated benefit in a category spanning one 
or more fiscal periods. Project benefit plans capture the potential non-financial benefits accrued 
by the project when the project is executed.

Before you begin
Role required: it_project_manager

About this task
The non-monetary benefit plan breakdown records are automatically created when you save the 
benefit plan by selecting Automatic  or Manual  in the Breakdown Type  field. The non-monetary 
benefit plan breakdown records specify the estimated and actual non-financial benefits at a 
granular level for specific fiscal periods, such as FY16: April and FY16: May. The Non-monetary 
Benefit Plan Breakdowns related list shows the aggregated benefits for estimated and actual 
non-financial benefits for each fiscal period for the project.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open the required project.

3. Select the Non-monetary Benefit Plans related list.

4. To create a non-monetary benefit plan, select New.

5. On the form, fill in the fields.

For more information, see Non-monetary benefit plans form.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1323



Note: 
When you move the project or the milestone date, the associated benefit plans also 
change accordingly based on whether the benefit plan is tied to the project start date, 
end date, or one of the project milestones. The project property  Change Resource Plan, 
Cost Plan and Benefit Plan Start Date with Demand or Project Start Date Change 
controls the behavior for project date changes.

6. Select Submit.

What to do next

• On the Benefit Plan form, view the benefit breakdown by fiscal period in the Non-monetary 
Benefit Plan Breakdowns related list.

• Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the project for the hybrid benefit plans.

Related topics

Update a non-monetary benefit plan breakdown for a project

Update a non-monetary benefit plan breakdown for a project

Update a non-monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to AllProject  > Projects  > All.

2. Open the required project.

3. Select the Non-monetary Benefit Plans related list.

4. Open the required non-monetary benefit plan.

5. In the Non-monetary Benefit Plan Breakdowns related list, select the information icon ( ) for a 
non-monetary benefit plan breakdown.

6. Select Open Record.

7. On the Non-monetary Benefit Plan Breakdown form, view and update the enabled fields.

8. Select Update.

Related topics

Create a non-monetary benefit plan for a project

Associate monetary and non-monetary benefit plans

Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the project for the hybrid benefit plans.

Before you begin
Role required: it_project_manager
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About this task
You can associate a monetary benefit plan with a non-monetary benefit plan and vice versa.

Note: 
When you delete a benefit plan, its relationship with the associated benefit plan (if any) is 
also removed.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open the required project form.

3. Select the Monetary Benefit Plans or Non-monetary Benefit Plans related list.

4. Select the information icon ( ) for a benefit plan that you want to associate.

5. Select Open Record.

6. Associate a monetary or non-monetary benefit plan.

7. Select Save.

Result
The selected benefit plan is associated with another plan.

What to do next
Select the View Associated benefit plan  related link to view the associated benefit plan.

Related topics

Create a monetary benefit plan for a project

Create a non-monetary benefit plan for a project

Create a project cost plan

Create a cost plan to specify the unit cost of a cost type for a fiscal period. Project cost plans 
capture the costs of projects.

Before you begin
Role required: it_project_manager
Application required: Project Portfolio Management  with Financials

About this task
The application automatically creates cost plan breakdown records  when you save the cost plan. 
Cost plans can also have associated expense lines.

Note: 
Cost plans are automatically created for resource plans that are associated to projects and 
project tasks.

To use multiple currencies, create a new cost plan for another currency.

Procedure

1. Open the project form.

2. From the related links, select Cost Plans.

3. Select New.
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Note: 
To create a cost plan from the Financials  tab in Project Workspace, select Manage.

4. On the form, fill in the fields.

For field information, see Cost Plan form.

Note: 
When you change the planned start date of a project, the associated cost plans and 
resource plan also change. The project property  Change Resource Plan and Cost Plan 
Start Date with Demand or Project Start Date Change  controls the behavior for project 
start date change.

5. Select Submit.

What to do next
To recalculate the values in the Estimate at Completion  field, use the Calculate Estimate at 
Completion  related link. To view the cost plan breakdowns, select the Cost Plan Breakdowns 
related list.

Related topics

Cost plan breakdown

Update a cost plan breakdown

System-generated cost plans

Update a cost plan breakdown

Update a cost plan breakdown record that specifies the estimated and actual cost, at a granular 
level, for specific fiscal periods.

Before you begin
Role required: it_project_manager

Procedure

1. Open the required project.

2. Select the Cost Plan  related list.

3. Select the Cost Plan Breakdowns  related list.

4. Select the i  icon against a cost plan breakdown.

5. Select Open Record.

6. In the Cost Plan Breakdown form, view and update the enabled fields.
For more information, see Cost plan breakdown form.

Related topics

Cost plan breakdown

System-generated cost plans

Enable cost rollup calculations

Enable rollup calculations from the project properties.

Before you begin
Role required: it_project_manager
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Procedure

1. Navigate to All  > Project  > Settings  > Preferences.

2. Select Enable project cost rollup.

3. Select Save.

Result
Rollup values are read-only on forms. Point to the icon beside the field for a tooltip message.

Tooltip

Related topics

Create a project cost plan

Update a cost plan breakdown

View actual project costs

When you are using Project Portfolio Management  with Financials, you can view actual project 
costs on cost plans and projects.

Before you begin
Role required: it_project_manager

About this task
An expense line has to be processed to be considered for actual cost. The actual cost is 
recorded against the creation date of the expense line, not the processed date. The expense 
lines are created only for approved time cards.
Actual costs for projects also roll up to portfolios in the same way.

Procedure

1. Navigate to Project  > Projects  > All.

2. Open the project for which you want to view the actual costs.

3. Select the Cost Plans  related list.

Related topics

Actual project costs

Recalculating costs of all resource plans in a project

Recalculate the resource costs of all resource plans in a project whenever the hourly rates 
change in the associated rate model so that the plan costs are up to date.

Before you begin
Ensure the following setup:

• The project must be active.

• The project must have an active rate model assigned.

• The resource plans must be in the Planned, Requested, Confirmed, or Allocated state.

Role required: project_manager
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About this task
This option recalculates the costs of all resource plans of the project at once. You can also open 
a resource plan from the Resource Plans  related list to recalculate the resource costs of an 
individual resource plan.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open a project.

3. On the Project form, right-click on the header bar and select the Recalculate Resource Costs 
option.

4. In the Recalculate Resource Cost dialog box, fill in the fields.

Recalculate Resource Costs dialog box

Field Description

Start date Start date of the time period for which the 
costs are recalculated.

By default, the field shows the current date.

End date End date of the time period for which the 
costs are recalculated.

By default, the field shows the end date of the 
project.

Planned costs for Requested Resource plans Option for recalculating the planned cost of 
Requested resource plans.

Confirmed/Allocated costs for Confirmed/
Allocated resource plans

Option for recalculating the confirmed or 
allocated cost of Requested resource plans.

Planned costs for Confirmed/Allocated 
resource plans

Option for including the planned cost of a 
Confirmed or Allocated plan.

The option is enabled if the Confirmed/
Allocated costs for Confirmed/Allocated 
resource plans  option is selected.

By default, the option is not selected.

5. Select OK.

Result

• Recalculates the selected resource costs of all the applicable resource plans in the project 
based on the latest hourly rates. The hourly rates are derived from the rate model associated 
with the project.

• Updates the recalculated resource costs on the respective cost fields on the resource plan 
form and the Resource Plans related list.

• Reflects the revised values on the respective cost fields of the project.
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Create an expense line

A project expense line is cost associated with a specific source, such as a user, fixed asset, or a 
CI. Expense lines are part of project cost plans.

Before you begin
Role required: it_project_manager
Application required: Project Portfolio Management  with Financials

About this task
Only processed expense lines are considered for projects, project tasks, and demands. You can 
create multiple expense lines for a project or demand.

Procedure

1. Open the project form.

2. In the related lists, select Cost Plans.

3. Right-click on a cost plan.

4. Select Create Expense Line.

5. On the form, fill in the details.
For more information, see Expense line form.

6. Select Submit.

Note: 

◦ Imported processed expense lines are not rolled up to the Total actual cost field in Cost 
Plans.

◦ If you change the Amount  of a Pending expense line and change the state to 
Processed, the latest value is captured in expense line and the same is rolled up to 
Total actual costs in Cost Plans.

Result
Once the expense line is processed, the actual amount incurred becomes part of the cost plan.
The actual amount spent is recorded against the project cost plan under the appropriate 
expense type: Capex  or Opex. Not providing a cost plan reference when creating an expense 
line, the actual cost is recorded at the project level in the cost plan related list.

If you create an expense line without populating the Cost Plan  field, a system-generated cost 
plans  is created.

Create and manage waterfall projects

Plan, create, and manage projects using the Waterfall methodology.

The following tables, arranged by task group, list the tasks involved in creating a waterfall project.

Create a new project

Task Steps

Create a new project Navigate to All  > Project  > Projects  > Create New.
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Open an existing project

Task Steps

Open a project in the project 
workbench

Select the Project Workbench  related link on the Project 
form.

Add phases to a project from the project workbench

Task Steps

Create a waterfall phase for 
a project

Select the Add phase icon ( ) and select Waterfall  from the 
Phase Type choice list.

Create a test phase for a 
project

Select the Add phase icon ( ) and select Test  from the Phase 
Type choice list.

Edit a project phase from the project workbench

Task Steps

Edit a waterfall 
phase for a project

Select the Edit phase icon ( ) on a project phase and make the 
required changes in the details of the project phase.

Edit a test phase for 
a project

Select the Edit phase icon ( ) on the test phase and make the required 
changes in the details of the test phase.

Add milestones to a project from the project workbench

Task Steps

Add milestones to 
a project

Select the Add phase icon ( ) and then select Milestone  at the top of 
the Add Phase pop-up window.

Set up manual testing

Task Steps

Create a test plan Navigate to All  > Test Management  > Test Execution  > Test Plans  > New.

Add test cases to a 
test plan

Select the Add Test Cases from Test Suite  related link on the Test Plan 
form.

Create a test phase Select the Add Phase  button on the project workbench.

Add a test plan to a 
test phase

Select the Edit Phase icon ( ) for the test phase and enter the name of 
the Test Plan.

Assign test cases to 
testers

Select a user in the Assigned to  field on the Test Case form.

Notify testers to 
start testing

Select the Notify testers  to start testing related link on the Test Plan 
form.

Monitor the testing 
progress

The Test Plans list, Test Plan form, and Test Case form all display results 
for test cases and individual tests.

Testing sign-off Select the Sign-off Test Plan  related link on Test Plan form.
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Related topics

Create baseline of a project

Update a project

Update the project and make adjustments in fields to handle scope, cost, and schedule. While 
a project is underway, keep actual values as current as possible. Continue to measure actual 
values, analyze the impact of any potential project risks.

Before you begin
Role required: it_project_manager

Procedure

1. Open a project in the Work in Progress  state.

2. Keep the following fields up to date:
While the status of the project is Work in Progress, keep these fields up to date:

◦ Priority: the priority of the project, especially as it relates to other projects in the portfolio.

◦ Net value: the value of the project to the company expressed in expected revenue.

◦ Risk cost: the sum of all costs involved with potential project risks. Although this field is not 
related to cost management, you can use this field to estimate the costs of risks that arise 
during the project.

◦ Configuration item: the CI related to the project.

◦ Schedule: the type of work schedule.

◦ Work notes: a useful record of notes and comments related to the project.

◦ Live feed: a record of the collaboration between various project stakeholders.
For project tasks, keep these fields up to date:

◦ State: remember to change project task states to Work in Progress  when the task should 
begin (for tasks that have a specified start date) and Closed  when the task is finished. Task 
states do not change automatically except when the time constraint of the task is set to Start 
ASAP  and the state of the predecessor task is changed to one of the closed states.

◦ Assignment group: the group of resources currently working on the task.

◦ Assigned to: the individual assigned to the task.

◦ Time cards: the amount of time resources work on a project, which roll up into Actual effort. 
If a labor rate is configured for a time card, changes to the time cards affect theActual cost  of 
the project.

3. Select Update  to save the record.

Related topics

Track project comments and collaborate with stakeholders

Track project comments and collaborate with stakeholders

When a project is in progress, you can take advantage of two platform features that help project 
participants interact and collaborate: journal fields and live feed. Two useful journal fields are 
Comments and Work notes.

Before you begin
Role required: it_project_manager
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Procedure

• To add journal fields to a project form:

1. Configure  any project form to show Comments  and Work notes .

• To add live feed  to a project form:

1. Navigate to All  > System Definition  > Dictionary.

2. Select the pm_project  table name that has no corresponding Column name.

3. In the Attributes  field, enter live_feed=true.

4. Select Update.

5. Navigate to All  > System Definition  > UI Actions.

6. Open the Follow on Live Feed  list action.

7. In the Table  field, select the [pm_project] table.

8. Right-click the header and select Insert  to create a copy of the UI action for the [pm_project] 
table.

9. Repeat the steps for the UI actions for the Show Live Feed  form action.

10. Personalize the Project form and add Activities (filtered), which is the activity formatter, to 
the desired location on the Project form.

Related topics

Update a project

Copy a project

Another option for creating a project is to copy an existing project with all its tasks and 
relationships. After you specify the start date for the copy, the system adjusts all task start and 
end dates automatically.

Before you begin
Role required: it_project_manager

Procedure

1. On the Project form, select additional actions icon ( ) and select Copy Project.

2. On Copy the selected project modal, enter the New Project Name.

3. Select a Start date  and select OK.
Copy partial project, which is available from the Project Task form, provides similar 
functionality. It copies all task or project relationships and children from the selected project 
and inserts them into the current project. In this case, a new project record is not created.

Result
Actual duration and the actual start and end dates are reset to null values. The state is set to New 
and percent complete is set to 0.

By default only the short description, planned dates and duration fields are copied from source 
project to the target project. If additional columns must be copied, they should be declared in the 
project property  List of attributes that will be copied from the originating project task.

Related topics

Change default values of copied project
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Change default values of copied project

Reset or change the default values for copied fields in the new copied partial or complete 
project.

Before you begin
Role required: admin

About this task
Child tasks are defined with the same relationships, each lasting for the same duration as the 
original tasks. All project tasks are set to Pending. Actual duration and the actual start and 
end dates are reset to null values. The state is set to New  and percent complete is set to 0. 
Administrators can override the Script Include CopyProjectFieldOverride to determine which 
fields are reset or to change the default values.

Procedure

1. Navigate to All  > System UI  > Script Include.

2. Open the CopyProjectFieldOverride record.

3. Add the method to override the method defined in the CopyProjectFieldOverrideSNC script for 
resetting or defaulting the values.

For example, to copy partial project:

     /* getResetFieldsForCopyPartialProject method returns the 
 array containing the list of names of fields that need to be 
 erased from the copied project tasks
                    * getDefaultObjectForCopyPartialProject 
 method returns the object containing the key, value pairs of 
 field names and values that need to be set on the copied tasks
                    */var CopyProjectFieldOverride = 
 Class.create();
                    CopyProjectFieldOverride.prototype = 
 Object.extendsObject(CopyProjectFieldOverrideSNC, {
                    getResetFieldsForCopyPartialProject: 
 function() {
                    return ['work_start', ‘work_end’, 
 ‘work_duration’];
                    },
                    getDefaultObjForCopyPartialProject: 
 function() {
                    return {'state': -5,‘percent_complete: 0’};
                },
                type: 'CopyProjectFieldOverride'
                });

To copy complete project:

/* getResetFieldsForCopyProject method returns the array 
 containing the list of names of fields that need to be erased 
 from the copied project tasks
            * getDefaultObjectForCopyProject method returns 
 the object containing the key, value pairs of field names and 
 values that need to be set on the copied tasks
            */var CopyProjectFieldOverride = Class.create();
            CopyProjectFieldOverride.prototype = 
 Object.extendsObject(CopyProjectFieldOverrideSNC, {
            getResetFieldsForCopyProject: function() {
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                    return 
 ['work_start' ,"work_end","work_duration"];},
                    getDefaultObjForCopyProject: function()
                    {
                        return {'state': -5, ‘percent_complete: 
 0’};
                     },
                    type: 'CopyProjectFieldOverride'
                  });

4. Select Update.

Related topics

Copy a project

Assign a project schedule

Without an assigned schedule, a project calculates a day as a full 24 work hours. To schedule 
tasks by a more realistic work day, assign a schedule to the project. If the schedules provided in 
the base system do not suit your needs, define a new one.

Before you begin
Role required: it_project_manager

Procedure

1. Open a project.

2. If the Default  view is active, right-click the header bar and select View  > Advanced.

3. Select a schedule in the Schedule  field and select Save.

Create baseline of a project

Create a schedule baseline and financial baseline of a project. A schedule baseline captures 
planned dates of all tasks and milestones at a particular moment in time. A financial baseline 
captures benefit and financial metric information (snapshot of cost plan, benefit plan, and 
project-level financial metrics) at a particular moment in time.

Before you begin
Role required: it_project_manager

About this task
Schedule baseline

You can create as many schedule baselines as necessary and review the changes that have 
been made to the project since the previous baseline. If a project is not on schedule, you can 
create a schedule baseline to know how much schedule slippage has occurred. It also helps to 
view the real-time deviations between actual and planned values.

The baseline appears as a set of gray lines below the bars that represent the actual tasks on the 
Gantt chart. These baselines represent planned dates, while the task bars represent the actual 
dates. If the project tasks are shifted to the right of the baselines, the project is running behind 
schedule.

Financial baseline

You can create as many financial baselines as necessary and compare them  to review the 
financial changes that have been made to the project since the previous baseline. Any financial 
baseline does not capture actual cost component of the project.
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Note: 
Nested projects cannot have baselines. Baselines are allowed for the top-level projects 
only.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Select the required project.

3. To create schedule and financial baselines of a project, use any of the following options.

Note: 
In the Create Baseline pop-up, the Create Schedule Baseline  and the Create Financial 
Baseline  check boxes are selected by default. Clear a check box if you do not intend to 
create a specific baseline.

Related topics

Compare financial baselines of a project

Compare schedule baselines of a project

Compare financial baselines of a project

Compare baselines to review the variances in the financial data of a project and see what 
changed.

Before you begin
Role required: it_project_manager

About this task
You can create  multiple baselines at various stages of a project, for example, at the end of each 
phase or after every calendar month or quarter. Each baseline captures the financial data of 
the project at a particular moment, providing a basis from which you can identify and review the 
changes made to the project. Having multiple baselines and comparing them helps you track the 
performance of your projects.

Procedure

1. To compare the financial baselines of a project, use one of the following options.

2. On the Financial Baseline form, select the baselines you want to compare from the two choice 
lists.
By default, the current and the most recent baselines are selected.

3. Select Compare.
The comparative data of the baselines display in the following two sections:
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◦ The Financial Baseline Summary  section displays four widgets: the first two widgets contain 
the financial data of the two baselines, the third widget contains their variance, and the 
fourth widget contains the actual costs to date of the project.

◦ The Financial Baseline Details  section displays the cost plans and benefit plans of the two 
baselines in two different grids. Each plan type has two rows corresponding to each baseline 
data.

Note: 
Select the baseline legend icon ( ) to see the color code of rows representing each 
baseline.

4. Optional:  Review additional fields or reorganize the comparative data on the form.

◦ To show or hide additional fields on the widgets in the Financial Baseline Summary  section, 

select the configuration icon ( ) and select the field names.

The selected field preferences are saved and are available when you reopen the Financial 
Baseline form. To reset to the default widget layout, select Reset to defaults.

◦ To view cost plan or benefit plan comparative data in yearly, quarterly, or monthly format, 
select the Year  or Quarter  or Month  views respectively.

◦ To toggle viewing the Financial Baseline Summary  section, select the Collapse  icon ( ) or 

Expand  icon ( ).

Compare schedule baselines of a project

Compare baselines to review variance between tasks and identify which task has variance from 
the current planned end date and the baseline end date. The baseline variance column displays 
the amount of variance between the two date comparisons.

Before you begin
Role required: it_project_manager

About this task
Create schedule baselines  at various stages of a project, for example, at the end of each phase 
or after every calendar month or quarter. Each baseline captures the schedule information of 
project tasks at a particular moment. This snapshot provides a basis for comparison and helps 
you to identify and review the changes made to the project. Having multiple baselines and 
comparing them helps you track the performance of your projects.

Procedure

1. To compare the schedule baselines of a project, use one of the following options.
The Planning Console displays the selected schedule baseline.

2. On the Planning Console, select different baselines to view schedule variance information of 
project tasks.
The following columns display the baseline information:

◦ Baseline start date: The planned start date for the task.

◦ Baseline end date: The planned end date for the task.

◦ Baseline variance: The difference between the baseline end date and planned end date. 
The value of this field column if there are any changes made to the project tasks or project. 
If the planned end date for a task is prior to the baseline date, the variance is shown as 
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a negative value. For example, for a task with the planned end date of April 24 and the 
baseline created on April 17 means it is past due or late. The Baseline variance column in this 
case displays a value of -5 days.

Note: 
Use the show or hide columns in gantt icon () to add these columns to the Planning 
Console.

Related topics

Create baseline of a project

Create a milestone

A milestone is a project task with a duration of zero (0). Use milestones to mark key dates in your 
project, such as key decision points, approvals, and holidays. Milestones are treated like any 
other project task and you can create dependencies between tasks and milestones.

Before you begin
Role required: it_project_manager

About this task
Note: 
Milestones cannot be shared between projects unless one project is nested under another 
project.

Procedure

1. Create a project task and give the Duration  field a value of 0.

2. Open the planning console Gantt chart and verify that it appears as a diamond.
You can also convert a task to milestone through Planning console tasks.

Activate project task email notifications

The following email notifications for the Project Management  application are available by default, 
but are inactive. You must activate them manually.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Notification  > Email  > Notifications.

2. Activate the following notifications:

Email Notifications

Notification Table Field Condition Description

Project task 
assigned

pm_project_task Assigned 
to

Inserted 
or 
updated

Sends an email notification when a 
task is assigned to a resource or the 
assigned resource is changed.

Project task 
started

pm_project_task State Changes 
to 

Sends an email notification when the 
project task starts.
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Notification Table Field Condition Description

Work in 
Progress

Project task 
commented

pm_project_task Additional 
comments

Any 
changes 
occur

Sends an email notification when the 
comment field is updated.

Set up project notifications with the workflow tool

Use the workflow tool, for example, to set up a workflow that sends an email notification when the 
state of a project task becomes Work in Progress.

Before you begin
Role required: admin

Procedure

1. Create a workflow with the following attributes:

◦ Name:  Notify assignee

◦ Table:  Project task [pm_project_task]

◦ If condition matches:  Run if no other workflows matched yet

◦ Condition:  State is Work in Progress  and Assigned to  is not empty

Note: 
Do not modify other attributes in this example.

2. Add a single Notification activity between the Start and End activities.

Drag the activity onto the connector line until it changes color. The attributes of the activity are 
similar to the following example:

◦ Name:  Notify assignee

◦ To:  ${assigned_to}

◦ Subject:  Project task ${number} has been activated and is assigned to you

◦ Message:Project task ${number} has been activated and is assigned to you

▪ Number: ${number}

▪ Short description: ${short_description}

▪ Planned start date: ${start_date}
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▪ Planned end date: ${end_date}

▪ Planned duration: ${duration}

Related topics

Activate project task email notifications

Change the planned start date of a project

Adjust the schedule of a project by changing the planned start date of a project and shifting it 
later or earlier than the current planned schedule.

Before you begin
Role required: it_project_manager

About this task
Changing the planned start date of a project to a new date also moves all its tasks and 
subprojects relative to the updated start date of the project. You can change the planned start 
date of a project when the following conditions are true:

• The State  of the project is Pending or Open.

• To move the start date of a project in WIP state, set the Enable move project for WIP projects 
property (com.snc.project.move_project.wip) to true. The default value of this 
property is false.

• No project_funding records are selected for execution.

• The project actual dates are not populated.

Note: 

• The Move project  option is available for a project only when it has a task or subproject.

• If an agile phase with sprints is associated to the project, then changing the planned start 
date of the project also clears the start and end dates of the sprints.

Procedure

1. Change the planned start date of a project using either of the following options.

2. In the dialog box, pick a date.

3. Select or clear the Move all tasks regardless of constraint type  check box.
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◦ Clearing the check box moves the tasks with Start ASAP constraint only to the new project 
date.

◦ Selecting the check box moves all the project tasks irrespective of their constraints to the 
new project date with the same offset except the task with Start ASAP constraint.

This check box is selected by default.

Note: 
The tasks in WIP and Close states are not moved.

4. Select OK.

Result

• The planned start date of the project is updated to the new date.

• Program dates are updated relative to the project start date.

• If the Move all tasks regardless of constraint type  check box is selected, all project tasks with 
Start on specific date and Start no earlier than constraints are moved to a new start date by 
the same offset as from the earlier project start date. The constraint date is also moved by the 
same offset.

For example, say a project is starting on November 10 with a Start On task starting on 
November 15, giving an offset of five days. If you move the project start date to November 20, 
then the task start date will be moved to November 25, maintaining the five-day offset from the 
project start date.

• All project tasks with Start ASAP constraint are moved to the new start date based on the 
Constraint Date  field on the project form. The tasks must be in the Open or Pending state.

• If the Change Resource Plan and Cost Plan Start Date with Demand or Project Start Date 
Change  property is selected, all related entities like cost plan, resource plan, and benefit plans 
are moved relative to the project start date. For more information on how to set this property, 
see Properties installed with Project Management.

Related topics

Pre-date a project task

Starting a project

Pre-date a project task

Move the planned start date of a task prior to the planned start date of a project. Adding a pre-
dated task allows you to accommodate tasks which need to start before the planned start date of 
a project.

Before you begin
You should have created or added project tasks to your project.

Role required: it_project_manager

About this task
Before pre-dating a project task, note the following conditions:
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• The property project.rollup_project_start_date should be set to true.

• Pre-dating a task's planned start date also moves the project's planned start date.

• The start date of a child task cannot be moved prior to the parent task's start date. For 
example, if a parent task with Start no earlier than constraint starts on 20th and the child task 
starts on 30th, the start date of the child task can only be moved up to 20th.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Select the project from the list.

3. On the Project form, update the planned start date for a project task using either of the 
following options.

4. In the Move date dialog box, select OK.

Related topics

Change the planned start date of a project

Create a cost type definition

Create a cost type definition to associate a cost type, operating, or capital, to an account in the 
General Ledger from the Financial Management  application. Create a cost type definition if you 
are using Project Portfolio Management  with Financials.

Before you begin
Role required: it_pps_admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Cost Type Definitions.

2. Select New  and enter name.

3. Select an account from the General Ledger Account [itfm_gl_accounts] table.

4. Select Capex  if a capital expense or Opex  if an operating expense.

5. Select Submit.

Costing add-on in Project Management

The Project Management  costing add-on connects the Project Management  application to the 
Cost Management application to allow for estimating and tracking the costs associated with 
projects.

This plugin enables the following project costing features:

• Estimate group resource costs during project planning.

• Tracking the actual cost of each user resource for a project.

• Track actual project task costs from time cards and other project expenses.

• Allocate project costs to the business.

• Represent project costs to the CIs that the project affects.

• Rollups of actual task expenses to parent tasks and the project record.
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The Project and Cost applications work together as shown in the diagram:

Project and Cost applications

The following properties are available with this plugin:

Costing add-on properties

Description Property Name Notes

For planned 
tasks types, 
calculate the 
actual cost 
field using 
the total of 
expense lines 
for the task.

glide.cost_mgmt.calc_actual_cost Default: true. This property is 
from Cost Management. When an 
expense line is created against any 
task of planned_tasktype  and this 
property is true, the system gets a 
sum of the costs for all the expense 
lines and sets the total cost in the 
work_cost  field.

When creating 
a task expense 
line should the 
system also 
create expense 
lines for the top 
task?

glide.cost_mgmt.process_task_top_task Default: true

Enable project 
cost rollup 
(estimated 
and actual) 
- updating 
the cost of a 
project task 

com.snc.project.rollup.cost Default: true
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Costing add-on properties  (continued)

Description Property Name Notes

updates the 
cost of its 
parent.

The following business rules are added or modified with this plugin:

Costing add-on business rules

Name Table Description

Project 
Cost 
Rollup

Planned task 
[planned_task]

Default: true. This property is from Cost Management. When an 
expense line is created against any task of planned_tasktype 
and this property is true, the system gets a sum of the costs for all 
the expense lines and sets the total cost in the work_cost  field.

Process 
Top 
Task 
Parent

[fm_expense_line] Default: true

Generate labor costs

Generate labor costs based on the planning attributes configured for financials in the planning 
attributes page for the resource assignments in a project.

Before you begin

• Review the planning attributes enabled for financials. For more information, see Using the 
Planning attributes.

• Role required: it_project_manager

Procedure

1. Navigate to All  > Project  > Projects  > All  and select the required project.
Make sure that the resource assignments are finalized to generate cost plans. If there are no 
resource assignments for the project, migrate the resource plans to resource assignments. For 
more information, see Migrate resource plans and cost plans for projects and demands.

2. Generate labor costs using one of the following options.

3. Refresh the browser page to view attribute-based labor costs in the Cost Plans related list.

Result
Attribute-based labor costs are created for the unique combination of attributes that are 
reflected as the name of the cost plans.

Related topics

Activate a scheduled job to generate labor costs

Scheduled Script Execution Form
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Activate a scheduled job to generate labor costs

Activate and trigger a scheduled job to generate attribute-based labor costs for all the projects 
and demands at a required cadence.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the Generate labor costs for demands and projects  scheduled job.

3. Select Active  and on the Scheduled Script Execution form, fill the fields.
For a description of the field names, see Scheduled Script Execution Form.

4. Select Update.

Related topics

Scheduled Script Execution Form

Generate labor costs

Create a project status report

Create project status report from the related lists of the project form. The project status report 
created for the most recent status date updates the status of the project in portfolios.

Before you begin
Role required: it_project_manager

About this task
The project status report shows snapshot status of RIDAC (Risk, Issues, Decisions, Actions, and 
Request Changes) records, key milestones,and charts only.

To include RIDAC records in the status report, select the Show on project status report  option 
on individual RIDAC forms.

You can also print a project status report from project workspace. To print a report, select the 

print icon ( ) in the header of Status Report  tab.

Procedure

1. Create a project status report.

2. On the status report form, fill in the details.
For more information, see Status report form.

3. Select Submit.

Related topics

View project status reports

Status report form

View project status reports

Project status reports provide the most recent, at-a-glance progress of a project displayed in 
several categories.
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Before you begin
Role required: it_project_manager

About this task
The project status report acts as a snapshot, meaning the report preserves the status of various 
parameters for the date and time when the status report is generated and does not display the 
status of various parameters dynamically. For example, the project status report created last 
week retains the same status as it was for that week and does not update the status dynamically.
You can use the project status reports to compare the progress of your project. Generate a new 
project status report for your recent changes to reflect on the report.

The project status report shows snapshot status of RIDAC (Risk, Issues, Decisions, Actions, and 
Request Changes) records, key milestones, and charts only.

Procedure

1. Open a project status report.

2. Review project status in the following sections.

Project status report sections

Section Description

Overview Provides a general overview about the project such as:

◦ Project Name: Name of the project.

◦ Project Manager: Project manager assigned to the project.

◦ Portfolio: Primary portfolio to which the project belongs.

◦ State: Current state of the project.

◦ Phase: Current phase of the project such as Initiating, Planning, and 
Executing.

◦ % Complete: Percentage of the project completed.

◦ Planned Start Date: Intended date the project begins.

◦ Planned End Date: Intended date the project ends.

◦ Planned Cost: Estimated cost of the project.

◦ Actual Start Date: Date on which the project began.

◦ Actual End Date: Actual end date of the project.

◦ Actual Cost: Actual cost of the project.

This information is rolled up from the project form.

If you had set your preference as project currency in the Status report currency 
field of the Project form, then the Overview  tab displays the following project 
currency fields:

◦ Planned Cost in Project Currency: Estimated cost of the project in project 
currency.

◦ Actual Cost in Project Currency: Cost of the project in project currency.
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Section Description

Note: 
The above fields appear when you enable the PPM Standard 
Multicurrency plugin (com.snc.ppm_multicurrency) and switch to the 
Project Currency view. For more information, see Multi-currency in project 
financials.

Summary Provides information about the overall health of the project.

◦ Executive Summary: Brief summary and analysis of the project.

◦ Last Week's Achievements: Progress of the project in the previous week.

◦ Key Activities Planned: Next planned activities for the project.

Cost 
(Planned 
vs. Actual) 
chart

If you have enabled the Project Currency view, then the Cost in Project Currency 
(Planned vs. Actual) section provides information about the actual cost versus 
the planned cost in project currency.

This information is rolled up from the cost plan  for the project.

◦ Planned: Approved cost for the project.

◦ Actual: Actual cost for the project is derived from the expense line created for 
the project cost plan and from the time cards created for the project.

Resource 
(Allocated 
vs. Actual) 
chart

Provides information about the actual resource hours used versus the allocated 
hours. This information is rolled up from the resource plan  for the project.

◦ Allocated: Resource hours that have been allocated to execute the project.

◦ Actual: The actual time spent is taken from the processed time cards created 
for the project.

Current 
Status

Provides the status related to overall health, schedule, cost, resources, and 
scope of the project. This information is populated from the most recent status 
entered by the project manager for the project.

◦ Status: Color indicator to signify the status.

◦ Comments: Comments for the status.

Status 
History Provides the trend of overall health, schedule, cost, resources, and scope of 

the project. The Status reports can have maximum 9 entries in the status history 
tab. This information is populated up from the last 9 status report  created for the 
project.

Date: Status date of the status reports. The color indicators signify the status of 
the project on these dates.

Key 
Milestones

Provides information about key milestones in the project. This information is 
populated from the project tasks  identified as key milestones.

◦ Pending: List of key milestone tasks in the Pending, Open, and Work in 
Progress state.

◦ Completed: List of key milestone tasks in the Closed state.

Risks Provides information about risks concerning the project. This information is 
rolled up from the risks that are part of the project.

◦ Pending: List of risks in the Pending state.

◦ Completed: List of risks in the Achieved and Not Achieved state.
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Section Description

The following information from the Risk record is displayed:

◦ Short description

◦ Probability

◦ Risk status

◦ State

◦ Assigned to

◦ Due date

For more information, see Add risks for a project.

Issues Provides information about issues included in the project. This information is 
rolled up from the issues reported for the project.

◦ Pending: List of issues in the Open and Work in Progress state.

◦ Completed: List of issues in the Closed state.

The following information from the Issue record is displayed:

◦ Short description

◦ Priority

◦ State

◦ Assigned to

◦ Due date

For more information, see Add issues for a project.

Decisions Provides information about decisions included in the project. This information is 
rolled up from the decisions reported for the project.

◦ Pending: List of issues in the Open and Work in Progress state.

◦ Completed: List of issues in the Closed state.

The following information from the Decision record is displayed:

◦ Short description

◦ Priority

◦ Decision status

◦ State

◦ Assigned to

◦ Due date

For more information, see Add decisions for a project

Actions Provides information about action items for the project. This information is rolled 
up from the actions reported for the project.

◦ Pending: List of actions in the Open and Work in Progress state.

◦ Completed: List of actions in the Closed state.

The following information from the Action record is displayed:
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Section Description

◦ Short description

◦ Priority

◦ State

◦ Approval

◦ Assigned to

◦ Due date

For more information, see Add actions for a project.

Request 
Changes

Provides information about a change request  for the project. This information is 
rolled up from the change requests created for the project.

◦ Pending: List of project change requests in the Pending, Open, and Work in 
Progress state.

◦ Completed: List of project change requests in the Closed state.

The following information from the Request Change record is displayed:

◦ Title

◦ Priority

◦ State

◦ Category

◦ Approval

◦ Assigned to

◦ Due date

For more information, see Create a request change.

Related topics

Create a project status report

Allocate budget to a project

Set the budget of a project according to the fiscal years.

Before you begin
Role required: it_portfolio_manager

Procedure

1. Open the project form.

2. In the related links, select Project Budget.
The Project Budget  dialog box opens.

3. Select the fiscal year for which you want to set the budget for the project.

4. Enter the amounts for Capex Budget  and Opex Budget.
The Total Budget  is updated with the sum of capex and opex amounts.

5. Select OK.
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◦ If the project does not have any cost plan associated, then project budget is distributed by 
honoring planned start and end dates of the project.

◦ If the project has any cost plan associated, then project budget is distributed by honoring 
the cost plan fiscal periods.

Result
The project budget for the selected year appears in the Project Budget  related list. You can click 
the amounts in the list to revise them.

Migrate budget of active projects to Next Experience

Migrate the project budget to Next Experience  to manage the financials using Project Workspace.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Migrate baselines using one of the following options.

Note: 
After migration, you won't be able to view the budget on Classic UI. You're encouraged to 
manage budget using the Financials in Next Experience.

Related topics

Migrate financial baselines of projects to Next Experience

Migrate financial baselines of projects to Next Experience

Migrate the financial baselines of your project to Next Experience  to manage the financial using 
Project Workspace.

About this task
Next Experience  uses new data model that has two new tables Investment Baselines 
(sn_invst_pln_invst_investment_baseline)  and Investment Baseline Header 
(sn_invst_pln_invst_investment_baseline_header)  which are used to 
capture financial baselines. The financial baselines created for demands in classic experience 
aren’t visible in Next Experience. You can migrate the existing baselines from classic to Next 
Experience  as an on-demand activity for the required projects, or as bulk by activating and 
running a scheduled job.

Baselines view in the Next Experience  provides better insights to view and analyze the financial 
performance of your projects.

Unlike the financial baselines created using Next Experience, the financial baselines created in 
the Classic UI don’t capture the actual expenses along with planned costs as a default behavior. 
To have relevant information for baselines comparison, the actual costs are captured as part of 
the baseline migration using the processed expense lines as of the baseline creation date of the 
financial baseline.

For detailed information and use cases on using financials in Next Experience, see Managing 
financials for planning items in Portfolio Planning.
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Note: 
Starting March 2026 release, for customers using multicurrency, migration of financial 
baselines updates the baseline data in project currency to investment currency.

1. Existing projects that have only project baselines but no investment baselines. With the 
migration, project baseline will be migrated to investment baseline and you can view the 
migrated baseline from the sn_invst_pln_invst_investment_baseline  table 
list view.

2. Existing projects that have both project and investment baselines, you need to run 
the scheduled job to populate the fields for investment currency in the baselines with 
the values from project currency. For more information, see Activate scheduled job to 
populate to multicurrency fields.

Before you begin
The data in project currency fields will be migrated to investment currency fields on migrating 
baselines for customers using multicurrency.

Role required: it_project_manager

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Migrate baselines using one of the following options.

Tip: 
After migration, you're encouraged to create financial baselines using the Financials in 
Next Experience.

Result
Financial baselines for the selected projects will be migrated to Next Experience  and you can 
view them in the Baseline view.

What to do next

View and compare the migrated baselines  with any existing baselines or current baseline ( ).

Related topics

Migrate budget of active projects to Next Experience

Adding external dependencies for projects

As a project manager, you can use an external dependency to set up a dependency from a task 
in one project to a task in another project.

External dependencies help you to see the impact of changes in project schedules when a 
predecessor project changes.

How external dependencies work

To define the external dependency, select a project task from the predecessor project to be 
linked to the task in the successor project. When an external dependency is added, the system 
adds shadow tasks in both the successor and predecessor projects.

A shadow task is a read-only task in the respective project. It has the database attribute shadow 
set to true and orig_sys_id  pointing to the sys_id  of its original task. The shadow task is kept in 
sync with its original task whenever the relations are processed.
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In addition to the shadow tasks, two shadow relations are also added in the 
planned_task_rel_planned_task table. These relations are shadows of the original relations.

For example, for two projects, project P1 is the predecessor project, and P2 is the successor 
project. Project P1 has a task T1, and project P2 has a task T2.

If an external dependency is created from T1 to T2, the following tasks are added in the two 
projects:

Project Task

P1 Shadow of T2

P2 Shadow of T1

After adding the external dependency, the following shadow relation records are created in the 
planned_task_rel_planned_task table:

Parent Child Project External

T1 T2 True

Shadow of T1 T2 P2 False

T1 Shadow of T2 P1 False

Where:

• Parent  is the predecessor project.

• Child  is the successor project.

• Project  is the project where the relation is seen.

• External  is the external dependency.

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Create a risk record for your project that you can convert to other records during the project life 
cycle. Track issues and avoid copying relevant details in the related records.

As a project progresses through the project life cycle, a risk might result in an issue, or a new 
issue might occur. After you have a risk record, you can convert that record into related records 
such as issues, actions, or decisions. The conversion and association of records helps you 
analyze and identify patterns, trends, and probable resolution for planning future projects.

Plan and manage all RIDAC records on a single RIDAC page in Project Workspace. This page 
enables you to create, edit, convert, and associate RIDAC records on a central location. Navigate 
to the RIDAC page or Classic Project Workspace  from Project Workspace  interface.

Consider the following points before converting or associating RIDAC records in Project 
Workspace:
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• You can convert one record to another only in the RIDAC sequence. For example, you can 
convert a risk to an issue, decision, action, or request change but you can’t convert an issue 
to a risk or a decision to an issue. The following diagram illustrates the RIDAC process flow. 

• You can convert one record into multiple RIDAC records. For example, you can create multiple 
issue records from one risk record.

For converting RIDAC records in Classic Project Workspace, see Convert one RIDAC (Risk, 
Issue, Decision, Action, and Request Changes) record to another for a project. For converting 
RIDAC records in Project Workspace, see Convert one RIDAC record to another for a project in 
Project Workspace.

• You can associate one record with multiple different records. For example, you can link one 
issue record to multiple different risk, decision, action, or request change records.

For associating RIDAC records in Classic Project Workspace, see Associate existing RIDAC 
(Risks, Issues, Actions, Decisions, and Request Changes) records for a project. For associating 
RIDAC records in Project Workspace, see Associate existing RIDAC records for a project in 
Project Workspace.

Related topics

Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for 
a project

Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for 
a project
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Add risks for a project

Add a risk to a project to identify, analyze, prioritize, plan, and track a risk during any phase of 
the project life cycle. Assess potential problems and the severity of their impact to take informed 
decisions about the project.

Before you begin
Role required: it_project_manager

About this task
A risk is any uncertain event that can potentially impact the success or outcome of a project. For 
example, an incorrect estimate of factors like financial outlay or resource assignments can cause 
schedule slippage. Another example of a risk is a change in project requirements. Recording 
risks ensures that decision makers have all relevant information when assessing a project's 
progress. A project manager can add risks to a project and assess them. While adding risks, the 
project manager can add risks from an existing library of project risks that are applicable for their 
unique projects.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Select the project to which you want to add risks.

3. In the Risks related list, select New.

4. Alternatively, select Create from Library  if you have the Advanced Risk plugin activated.

a. Select the risk statements as required.

b. Select Create Risks.
Only the risks statements that belong to the Project category are displayed for the user.

5. On the Risk form, fill in the fields.

For more information, see Risk, issues, decisions, actions, and request change (RIDAC) form.

Note: 
The Risk Assessment Summary section only appears when the Enable Advanced 
Risk PPM Integration  property is enabled.

6. Select Submit.

What to do next

• Assess the risks that have been added. For more information, see Assign project risks to 
stakeholders for assessment

• Convert an existing risk to an issue, decision, action, or request change and close the risk. 
For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request 
Changes) record to another for a project.

• Associate the risk with existing issues so you can track dependencies and recognize trends 
for the future. For more information, see Associate existing RIDAC (Risks, Issues, Actions, 
Decisions, and Request Changes) records for a project.

Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Configure custom Risk rank and Risk value for a project
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Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for 
a project

Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for 
a project

Configure custom Risk rank and Risk value for a project

Configure custom risk rank and value scores (such as High-Medium, Medium-Low, or Absolute-
Low) to rate the impact and probability factors for a risk.

Before you begin
Role required: pps_admin

About this task
Use the Risk Value Lookup module to set up the risk rank and risk value for a specific 
combination of risk impact and probability. The system uses these values to determine the 
degree of risk (Absolute, High, Medium, Low) based on the impact and probability factors of a 
risk.

The value in the Probability  field is multiplied by the value of the Impact  field to generate the 
values for the Risk rank  and corresponding Risk value  in the Risk form.

By default, you can use the following impact, value, and probability scores for a risk to create a 
risk rank and risk value score:

• Absolute

• Low

• Medium or Moderate

• High

For example, a risk might have high probability and medium impact but you might want to 
consider it as an overall low risk for the project. In that case, you would configure the Risk Value 
Matcher form with the following values:

• Impact = 2 Medium

• Risk Rank Color = Green

• Probability = High

• Probability Number = 1

• Risk Value = 3 Low

Procedure

1. Navigate to All  > Project Administration  > Settings  > Risk Value Lookup.

2. Select New.

3. On the form, fill in the fields.
For more information, see Risk value matcher form.

4. Select Submit.
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Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for 
a project

Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for 
a project

Add issues for a project

Add an issue to a project to escalate a risk or to track an unexpected problem such as a technical 
malfunction or resource unavailability that occurs during any phase of the project life cycle. If the 
issue remains unresolved, unnecessary conflicts, delays, or even a failure can occur.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Select the project to which you want to add an issue.

3. In the Issues related list, select New.

4. On the Issue form, fill in the fields.

For more information, see Risk, issues, decisions, actions, and request change (RIDAC) form.

5. Optional:  Search in the knowledge base for any article related to the issue.

a. Select the search knowledge icon ( ).

b. If you find relevant articles, select the title of an article to view its content.

c. If you want to include the content of the article in the issue, select Attach to Issue.
The article content is copied in to the Description  field of the Issue form. You can modify the 
text if necessary.

6. Select Submit.

What to do next

• Convert an existing issue to decision, action, or request change and close the issue. For more 
information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) 
record to another for a project.

• Associate the issue with your existing risks so you can track dependencies and recognize 
trends for future. For more information, see Associate existing RIDAC (Risks, Issues, Actions, 
Decisions, and Request Changes) records for a project.

Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Add decisions for a project

As a project manager, develop a plan to manage risks and issues proactively with solutions. Add 
the solution for a risk or issue to a project in the form of a decision. You can also convert a risk or 
an issue to a decision or a decision to an action or a request change.
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Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Project  > Projects  > All.

2. Select the project to which you want to add a decision.

3. In the Decisions related list, select New.

4. On the Decision form, fill in the fields.

For more information, see Risk, issues, decisions, actions, and request change (RIDAC) form.

5. Optional:  Search in the knowledge base for any article related to the decision.

a. Select the search knowledge icon ( ).

b. If you find relevant articles, select the title of an article to view its content.

c. If you want to include the content of the article in the issue, select Attach to Decision.
The article content is copied in to the Description  field of the Decision form. You can modify 
the text if necessary.

6. Select Submit.

What to do next

• Convert a decision to an action or request change and close the decision. For more 
information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) 
record to another for a project.

• Associate the decision with your existing issues and risks so you can track dependencies and 
recognize trends for future. For more information, see Associate existing RIDAC (Risks, Issues, 
Actions, Decisions, and Request Changes) records for a project.

Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Add actions for a project

Add actions that are required for resolving an issue or risk for a project. You can also convert a 
risk, issue, or decision to an action based on your analysis and plan for resolution of a risk or 
issue.

Before you begin
Role required: it_project_manager

About this task
After analyzing the risks and issues and taking a decision on how to manage those risks and 
issues, add an action for resolving the risk or issue to a project.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Select the project to which you want to add an action.

3. From the Actions related list, select New.
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4. On the Action form, fill in the fields.

For more information, see Risk, issues, decisions, actions, and request change (RIDAC) form.

5. Optional:  If the action requires approval from other stakeholders, request approval with a due 
date using the Approval  and Due date  fields.

6. Select Submit.

What to do next

• Convert an action to a request change and close the action. For more information, see Convert 
one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for a 
project.

• Associate the action with your existing risk, issue, and decision records so you can track 
dependencies and recognize trends for future. For more information, see Associate existing 
RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project.

Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Create a request change

As a project manager, you might create a request change as the outcome of the action taken 
to resolve an issue or mitigate a risk. The request change might result in changing the project's 
scope, resource requirement, cost, or schedule to minimize the impact of a risk or issue.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Project  > Projects  > All.

2. Select the project to which you want to add a request change.

3. In the Request Changes related list and select New.

4. On the form, fill in the fields.

For more information, see Risk, issues, decisions, actions, and request change (RIDAC) form.

5. Select Submit.

What to do next

• Associate the request change with your existing risk, issue, decision, and action records 
so you can track dependencies and recognize trends for future. For more information, see 
Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for 
a project.

• Create tasks for working on the change request. For more information see, Create a task from 
an incident, problem, or change request.

Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project
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Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for 
a project

Convert one RIDAC record (risk, issue, action, decision, and request changes) to another, in that 
order, to retain the record information instead of having to create a new record manually and to 
more easily track the issue.

Before you begin
Role required: it_project_manager

About this task
When you convert a RIDAC record to another record, the values for the Short description, 
Requester, and Assigned to  fields are carried forward.

You can also specify to close the parent record on creation of the new record instead of manually 
closing the parent record.

You can also view the consolidated list of all converted RIDAC records using the View RIDAC 
related link on the Project form and View RIDAC  in the application navigator of the Project 
module.

Procedure

1. Navigate to Project  > Projects  > All.

2. Select the project for which you want to convert a risk, issue, decision, action, or request 
change record to another RIDAC record.

3. From the Project form related list, select the risks, issues, decisions, actions, or request 
changes record to open the form view.

4. Select the Convert to RIDAC  related link on the form.

5. Optional:  On the Convert dialog box, from the Select task type list, select the RIDAC record to 
which you want to convert the selected record.
For example, if you wanted to convert a risk to an issue, you would select Issue.

6. Optional:  Modify the text in the Short description  field, which is copied from the parent 
record.

7. Optional:  Change the default assignment copied from the parent record in the Assigned to 

field by selecting the lookup icon ( ) and selecting a different user.

8. Optional:  If you want to close the parent RIDAC record on creation of the new record, select 
the close parent record option.
The label of the close parent record option changes depending on the parent record type. 
For example, if the parent record is Risk and you are converting it to an issue record, the close 
record option would appear as Close Risk.

9. Select OK.

Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for 
a project

Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records 
for a project

Link existing RIDAC records (risks, issues, actions, decisions, and request changes) to one 
another for your project. Associating RIDAC records with each other enables you to keep a 
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record of risks or issues and their outcome for analysis at project closure and planning. It also 
helps to track the risks and issues throughout the project life cycle.

Before you begin
Role required: it_project_manager

About this task
You can associate one record with multiple different records. For example, you can link one issue 
record to multiple risk, decision, action, or request change records.

Procedure

1. Navigate to Project  > Projects  > All.

2. Select the project for which you want to associate one RIDAC entry to another.

3. In the Project form related list, select the RIDAC record.

4. On the form, select the Associate RIDAC  related link.

5. In the Associate dialog box, from the Select type list, select the RIDAC record to which you 
want to associate the selected record.
For example, if you wanted to associate a risk to an issue, you would select Issue.

6. Select the record number to which you want to associate the selected record from the 
Associate to list.
For example, if you wanted to associate the selected risk to issue (ISU0010003), you would 
select ISU0010003.

7. Select OK.

Related topics

Adding RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for 
a project

Applying templates to projects

A project template defines the basic structure of a project.

Project templates can include project tasks and subtasks, attachments, checklists, and other 
project information. Because projects often get repeated, templates enable you to create, 
save, and reuse project structure. You can also modify existing templates, create projects from 
templates, and apply templates to empty projects. A project is considered empty when it does 
not contain any subtasks.

With the project manager role, you can:

• Create project templates

• Use templates to create a project

With the PPS admin role, you can modify the project template configuration.

Create a project template

Create a template from an existing template or a project.

Before you begin
Role required: it_project_manager
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About this task
When you create a template from a project, all the project attachments and checklists are 
copied to the template. You can add or remove attachments from the template using the Project 
Template form. A project template created from an off-schedule project honors the off-schedule 
tasks.

Procedure

1. Create a template.

2. Fill in the following fields:

◦ Template name: enter a unique name for the new template.

◦ Description: enter a brief description of the new template.

3. Select OK.
The project template form opens for the newly created template.

4. Make any desired changes to the fields on the project template form.
The top section of the Project Template form includes basic template information, such as the 
template name and description. The middle section of the project template form defines the 
specific data included in the template. The information in this section is built from fields on the 
project [pm_project] table that the user selects and the values for those fields that the user 
defines.

5. Select Update.

Related topics

Applying templates to projects

Add an attachment to a project template

Attach a file to a project template just as you can attach a file to a project or task.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to All  > Project  > Projects  > Templates.

2. Open the desired template.

3. Select the Attachments  tab to open the related list.

4. Select New.

5. Select Browse  on the Attachments dialog box and select a file.

6. If desired, select Add Another Attachment  to select another file.

7. Select Attach.
The selected file appears in the Attachments related list.

Apply a template on the Project form

While creating a project using the Project form, you can apply a project template to include 
project tasks and subtasks, attachments, checklists, and other project information. You can apply 
a project template to a new project or an existing project.

Before you begin
Role required: it_project_manager
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About this task
A project created from the off-schedule project template honors the off-schedule tasks and 
adjusts the dates according to the given start date.
When applying a template to a project, the project state is set to the default state. Activate the 
default project state (pm_project.state = -5), and use it as the default value as it is Out Of The 
Box. You can update the label for the State  field to meet your requirements if Pending  doesn't fit 
well.

Procedure

• To apply a template on the blank project form:

1. Navigate to All  > Project  > Projects  > Create New.

2. Select the link next to To create project from a template.
The Apply Template  window appears.

3. Enter the project name, select the start date, and select a project template.

• To apply a template to an existing project without any project tasks or subprojects:

1. Navigate to All  > Project  > Projects  > All  and select a project.

2. Select the To apply template click here  link.
The Apply Template  window appears.

3. Select the start date and select a project template.

Apply template to an existing project

Apply one or multiple project templates to an existing project from the project form or Planning 
Console.

Before you begin
Role required: it_project_manager

About this task
A project created from the off-schedule project template honors the off-schedule tasks and 
adjusts the dates according to the given start date.
When applying a template to a project, the project state is set to the default state. Activate the 
default project state (pm_project.state = -5), and use it as the default value as it is Out Of The 
Box. You can update the label for the State  field to meet your requirements if Pending  doesn't fit 
well.

Important: 
Application of template on a project having project tasks does not apply header information 
and only appends project tasks after the last project task of the project.

Procedure

1. Apply project template to an existing project from any of the following locations.

2. In the Apply template dialog box, from the Project template list, select a project template.

3. Select Save.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1361



4. Optional:  To apply multiple project templates, repeat the steps 1 to 3.
Tasks from the template are added at the end of the last task.

Apply template to a blank project in project workspace

When you create a new project in the project workspace, you can apply a template.

Before you begin
Role required: it_project_manager

About this task
A project created from the off-schedule project template honors the off-schedule tasks and 
adjusts the dates according to the given start date.
When applying a template to a project, the project state is set to the default state. Activate the 
default project state (pm_project.state = -5), and use it as the default value as it is Out Of The 
Box. You can update the label for the State  field to meet your requirements if Pending  doesn't fit 
well.

Procedure

1. Navigate to All  > Project  > Projects  > Project Workspace.

2. In the project workspace header, select New.

3. Enter the project name, select the start date, and select a template in Create Project  dialog 
box.

4. Select OK.

Related topics

Starting a project

Project template configuration

The Project Template Configuration list defines the items that are included in a template.

Navigate to All  > Project Administration  > Settings  > Template Config  to display the Project 
Template Configuration list. Each item in this list has:

• A defined parent table. The exception is pm_project, which is the root or top-level object in the 
template.

• A link element. A field that links the parent table and the child table.

• A list of fields to include in the template. The fields defined in this column are the fields that are 
copied to a project template.

The Project Template Configuration list contains three default template configuration items: 
project, project task, and project subtask. You can modify these default items or create additional 
items from this list.

Default Project Template Configuration Items

Item Definition Parent Link Element

pm_project Project 
object

None. This object does 
not have a parent 
because it is the root 
level.

None. This object does not have a link 
element because it is at the root level.
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Default Project Template Configuration Items  (continued)

Item Definition Parent Link Element

pm_project_task Project 
task 
object

pm_project Parent. Because this task object is one 
level below the root level, it uses the 
parent table as a link element.

pm_project_task Project 
subtask 
object

pm_project_task Parent. Because this subtask object is 
two levels below the root level, it uses 
the parent table as a link element.

Select an item in the Project Template Configuration list to open the project Template 
Configuration form. For more information, see Project template configuration form.

Project Template Configuration form

Add a project template configuration item

Add a project template configuration item to include in a template.

Before you begin
Role required: it_pps_admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Template Config.

2. Select New.

3. Fill in the fields on the Project Template Configuration form.
For more information, see Project template configuration form.

4. Select Submit.
For example, to add a requirement object to the project template configuration, fill in the fields 
as follows:

◦ Table: Requirement [dmn_requirement]

◦ Parent table: Project [pm_project]

◦ Link element: Parent

◦ Active: Enable this check box

◦ Elements: short_description, description, priority, type, state

Related topics

Applying templates to projects

Project template configuration
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Modify a project template configuration item

Modify a project template configuration item included in a template.

Before you begin
Role required: it_pps_admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Template Config.

2. Select a configuration item from the list.

3. Make any desired changes to the fields on the Project Template Configuration form.

4. Select Update.
To delete a project template, select a configuration item from the list and select Delete. Do not 
delete any of the default template configuration items: project, project task, or project subtask. 
Doing so affects the ability to create project templates.

Related topics

Applying templates to projects

Project template configuration

Add a project template configuration item

Importing and exporting projects

You can manage projects using both Microsoft  Project and the ServiceNow  Project Management 
application.

Project Import

Users with it_project_manager role can import projects and project tasks from Microsoft  Project 
into ServiceNow  Project Management.

Create a project or update an existing project by importing the project data from Microsoft 
Project into your ServiceNow  instance. For more information, see Project import from Microsoft 
Project.

While importing a project into your ServiceNow  instance, you can also specify the calculation 
method for calculating project dates. You can import the project tasks with different constraint 
types using Manual or Automatic calculation. For information about supported constraints and 
their conversion, see Project import from Microsoft Project.

You can create custom fields in your ServiceNow  instance and map these fields with your 
Microsoft  Project while importing a project. For more information, see Create custom field 
mapping for Microsoft Project file import.

You can import project tasks for multiple projects in one time using data files and transform 
maps. For more information, see Import project tasks for multiple projects.

Some calendar elements are not imported from Microsoft  Project into Project Management. For 
information about calendar elements and schedules, see Calendars and schedules- Limitations.

Project Export

If you have the it_project_manager role, you can export project data. The project data, such as 
project tasks and task constraints, can be exported as an export file. Use this export file to import 
the projects into other ServiceNow  instances.
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If you are managing your projects using Microsoft  Project, you can export your ServiceNow 
projects using the export functionality.

You can choose to export the project data in MPP, XML, or CSV file formats. For more information, 
see Project export to Microsoft Project.

If your project in the ServiceNow  instance contains dates with any of the supported constraint 
types, then these constraints are also exported when you export the project and project tasks. 
For more information, see Project export to Microsoft Project.

Supported versions

Projects created in the following versions of Microsoft Project can be imported into the 
ServiceNow  Project Management  application.

• Microsoft Project 2003

• Microsoft Project 2007

• Microsoft Project 2010

• Microsoft Project 2013

• Microsoft Project 2016

Project field mapping

During an import, values from Microsoft Project overwrite fields in project records.

Project Field Mapping

Microsoft Project fields Project Management  fields

Task Name Short description. The field is overwritten only while you 
import the first time.

Note Description

Start Planned start date

Finish Planned end date

Duration Planned duration

Actual Start Actual start date

Actual Finish Actual end date

Actual Duration Actual duration

% Complete Percent complete (personalize the form to add this field)

Predecessor Lag Lag time between predecessor and successor

WBS WBS

Critical Critical path

Rollup Rollup

Text10 (Field used for syncing 
purposes)

Task Sys_Id

Project Header Title Project name

Project Header Subject (Field used 
for syncing purposes)

Top Task Sys_Id
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Project Field Mapping  (continued)

Microsoft Project fields Project Management  fields

Resource Assigned to [assigned_to]

Note: 
During import, if there are multiple resources 
assigned to a task in Microsoft Project:

• The first resource is added to the Assigned to 
field.

• The rest of the resources are added to the 
Additional assignee list  field.

Resource Group Assignment Group

Related topics

Importing and exporting projects

Create custom field mapping for Microsoft Project file import

Map custom fields from Microsoft  Project to ServiceNow  fields before importing a project.

Before you begin
Create custom fields in your ServiceNow  instance before mapping them with Microsoft  Project. 
For more information, see Add and customize a field in a table .

Role required: it_pps_admin

About this task
Map the custom fields that you create in your ServiceNow  instance with custom fields in the 
Microsoft  Project file you plan to import.

The supported data types for field mapping between Microsoft  Project and ServiceNow 
instances are:

• True/False

• Calendar

• Date/Time

• Choice

• Color

• Currency

• Decimal

• Due Date

• Floating Point Number

• Date

• Date/Time

• Duration

• List

• Time
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• HTML

• Integer

• Long

• Percent Complete

• Phone Number (E164)

• Reference

• Name -Value Pairs

• String

• Translated HTML

• Translated Text

• URL

• Wiki

Procedure

1. Navigate to All  > Project Administration  > Project - MSP Import Field Mappings.

2. Select New.

3. From the Table list, select the table in which you created the custom field.

4. In the Microsoft Project Column  field, enter the name of the custom field in your Microsoft 
Project file that you want to map.

5. In the Destination Column list, select the custom ServiceNow  field that you want to map to the 
Microsoft  Project field while importing a project.

6. Select Submit.

What to do next

• Import the Microsoft  Project file. For more information, see Import a Microsoft Project file with 
the Import module.

• Configure the Project form to add the custom fields that you want to see. For more information, 
see Form configuration .

Related topics

Importing and exporting projects

Project import from Microsoft  Project

Import Microsoft project files into the ServiceNow  Project Management  application.

Users with the project manager role can import a project using:

• Import module

• Project form

• Planning Console

When you import a project as a new project or into an existing project, the projects are updated 
as follows:
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• New project: A new record is created in the Project [pm_project] table. The tasks associated 
with the project are added to the Project Task [pm_project_task] table.

Only the common or mapped fields  are imported. Imported projects are brought into the 
instance with both Priority and Risk set to Low.

• Existing project: The instance checks the Text10 field in the top-level Microsoft  Project task. 
If the Text10 field contains a recognizable sys_id, it means that the project was previously 
exported from a ServiceNow  instance. In this case, the values from the project overwrite the 
values for the existing project.

You can also specify the schedule calculation type as Automatic  or Manual  for the imported 
tasks. When you import a project into the instance, project constraints are converted as follows:

• The time constraint for all imported tasks, when you select calculation type as Manual, is set to 
Start on specific date  irrespective of their constraint type in Microsoft  Project.

• The following constraint types are supported when you select calculation type as Automatic:

◦ Start on specific date

◦ As soon as possible

◦ Start no later than

◦ Start no earlier than
Tasks with other constraint types are converted to Start on specific date.

Note: 
The resource name in Microsoft  Project should map to the name of the user in the instance.

Related topics

Importing and exporting projects

Import a Microsoft Project file with the Import module

Use the Import module to import a Microsoft project file as a new project into the Project 
Management  application.

Before you begin
Role required: it_project_manager

About this task
Before importing a Microsoft  Project file into the ServiceNow  instance, consider the following 
information.

• Microsoft  Project project imported into a teamspace is only available to users who can access 
the teamspace.

• To import custom fields in your Microsoft  project, create those custom fields in your 
ServiceNow  instance first, and then create mapping between these fields before importing 
the project. For more information, see Create custom field mapping for Microsoft Project file 
import.

Note: 
You can also use the Scripted Extension Points for importing custom 
fields without creating and mapping the custom fields manually. Use the 
MSProjectImportTaskFormatter  Extension Point to create a script include and 
map custom fields in Microsoft  Project and ServiceNow. You can also use this Extension 
Point to modify the data while importing a project.
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• If the calculation type is set as Manual, recalculation does not happen on project tasks when 
they are imported from the Microsoft  Project file. Once the project is in the ServiceNow  system, 
it would be treated as a manual project.

• Importing a Microsoft  Project project with inter-project dependencies, does not import the 
shadow tasks.

• Only the subprojects (header and parent task) get imported into the ServiceNow  instance, the 
child tasks are not imported.

• While importing a Microsoft  Project file into ServiceNow, the import fails:

◦ If the project with tasks was created in ServiceNow  instance before the import.

◦ If you reimport a project that was imported from Microsoft  Project file earlier and you create 
and add tasks in ServiceNow  instance.

Note: 
To retain the project tasks that were created in the ServiceNow  instance, you must 
export that project first into the Microsoft  Project file. Then, reimport the file back into 
ServiceNow  instance.

◦ If the task being deleted due to import has any of the related entities: Cost plan, Benefit plan, 
Resource plan, Time card, or Expense lines.

◦ If the values for lag or lead time dependencies are not in the supported format.

▪ Positive lag time dependency values for days, hours, and minutes are allowed. Negative 
lag time dependencies are allowed only for days.

▪ All other elapsed duration types from Microsoft  Project such as emin, eday, eweek, emon, 
eyr, or % are not allowed for import.

Procedure

1. Navigate to All  > Project  > Projects  > Import.

2. Select Choose File  to select a Microsoft  Project (mpp) file.

3. To import the Microsoft  project as a new project, select the Create new project  option.

4. Optional:  In the Project name  field, specify a name for the new project.

5. To import the Microsoft  project as a subset of an active, existing project:

a. Select Update an existing project.

b. Select the reference lookup icon ( ) and select a project or task.
Only active projects appear in the list.

6. Select one of the following options to specify the method for calculating schedule:

◦ Automatic: Select this option to apply the scheduling engine while importing the project 
tasks. The supported constraint types are imported with same constraints applied to them 
while other constraint types are converted to Start on specific date.

◦ Manual: Select this option to import all project tasks with Start on specific date  constraint 
type irrespective of their constraint type in Microsoft  Project.

For more information about supported constraint types, see Project import from Microsoft 
Project.

7. Select Import.
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Result

• A project task that was imported in ServiceNow  instance earlier and has associated time cards, 
resource plans, cost plan, benefit plan, or expense lines is retained on reimport even if it is 
deleted from Microsoft  Project.

• Dates in the ServiceNow  project remain same as the dates in the Microsoft  Project file.

• In a ServiceNow  project with subprojects, the following details change:

◦ The WBS order of imported tasks is regenerated after import.

◦ The Planned Start Date  and Planned End Date  of the parent project are rolled up.

◦ The State  of the parent project and tasks are rolled up.

◦ The % Complete on the top task is rolled up.

Related topics

Importing and exporting projects

Update a project using a Microsoft Project file

Import project data, from a Microsoft  Project file, into an existing project in your ServiceNow 
instance using the Project form or Planning Console.

Before you begin
Create a project.

Role required: it_project_manager

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open the project which you want to update.

3. Import the Microsoft Project file to update the selected project from any of the following 
screens:

◦ In the Project form, select Import from MS Project  from the context menu.

◦ In the Planning Console, select the more actions icon ( ) and select the Import from MS 
Project  option.

4. In the Microsoft Project Import dialog box, select the Microsoft Project file and calculation type:

a. Select Choose File  to select a Microsoft  Project (mpp) file.

b. Select one of the following options to specify the method for calculating the schedule:

▪ Automatic: Select this option to apply the scheduling engine while importing the project 
tasks. The supported constraint types are imported with the same constraints applied to 
them while other constraint types are converted to Start on specific date.

▪ Manual: Select this option to import all project tasks with the Start on specific date 
constraint type irrespective of their constraint type in Microsoft  Project.

For more information about the supported constraint types, see Project import from 
Microsoft Project.

5. Select Import.
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Result

• A project task that was imported in the ServiceNow  instance earlier and has associated time 
cards, resource plans, cost plan, benefit plan, or expense lines is retained on reimport even if it 
is deleted from Microsoft  Project.

• Dates in the ServiceNow  project remain same as the dates in the Microsoft  Project file.

• In a ServiceNow  project with subprojects, the following details change:

◦ The WBS order of imported tasks is regenerated after import.

◦ The Planned Start Date  and Planned End Date  of the parent project are rolled up.

◦ The State  of the parent project and tasks are rolled up.

◦ The % Complete  on the top task is rolled up.

Related topics

Importing and exporting projects

Import project tasks for multiple projects

Import project tasks for multiple projects from an external file system or data source using import 
sets and transform maps.

Before you begin
Role required: import_transformer, import_admin, or admin

Procedure

1. Navigate to All  > System Import Sets  > Load Data.

2. Select the Existing table  option.

3. From the Import set table list, select the Import planned task [imp_planned_task]  option.

4. In the Source of the import  field, select File, and then select Choose File  to select the source 
Excel spreadsheet.

5. Optional:  If required, specify the Work sheet and Header row number.

6. Select Submit
The imported data is available in the selected Import Set table.

7. Optional:  Create field mappings for custom columns.
For more information, see Create field mappings .

8. Transform the data from the import set table to the target table.
For more information, see Run an import .

Related topics

Importing and exporting projects

Project export to Microsoft  Project

If you are using Microsoft  Project to manage project activities, you can export a project to 
Microsoft  Project (mpp) file, an XML file, or a CSV file.

Users with the project manager role can export a project using:

• Export module

• Project form

• Planning Console
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You can also specify the format in which you want to export project data, the available options 
are:

• XML: Suitable, if you want to import the project data into other ServiceNow  instance.

• CSV: Suitable for exporting project data from Planning Console as is and viewing project data 
using other applications.

• Microsoft Project: Suitable, if you want to import the project data into Microsoft  Project.

Note: 
The option for exporting project data in CSV and Microsoft Project format is available 
when exporting a project from Planning Console.

If tasks in your project contain any of the supported constraints, then the constraints are also 
exported when you export the project. This export of constraints helps you in maintaining project 
dates when you import the project to another ServiceNow  instance. The following constraints are 
supported:

• Start on specific date: Mapped with Must start on constraint when exported to Microsoft 
project.

• As soon as possible

• Start no later than

• Start no earlier than

Note: 
Shadow tasks and external dependencies are not exported when you export the project 
data.

Related topics

Importing and exporting projects

Export project data

Export the project data using the Export module, Project form, or Planning Console. Save the 
export file to a folder on your system in the Microsoft  Project (MPP), XML, or CSV format.

Before you begin
Role required: it_project_manager

About this task
Projects must use either the Project Management  Schedule or the Default MS Project schedule 
before they can be exported.

The option for exporting the project data in MPP and CSV format is available when exporting a 
project from the Planning Console. Only the columns which are visible in the Planning Console 
are exported.

Procedure

1. Export the project data from any of the following options.

2. Optional:  A dialog box might prompt you to save the export file.
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Save the file as an XML file. If you are exporting the project from the Planning Console and 
selected the CSV option, you can save the file in CSV format.

Note: 
Depending on your browser setting, the browser might automatically save the file to your 
Download folder.

What to do next

• Use the MPP file to import the project data into a Microsoft  Project.

• Use the XML file to import the project data into other ServiceNow  instances or Microsoft 
Project.

• Use the CSV file to view project data using other applications.

Related topics

Importing and exporting projects

Export project tasks

The task being exported must be associated with a project that uses either the Project 
Management  Schedule or the Default MS Project schedule.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Project  > Projects  > All.

2. Open the project.

3. Scroll to the Project Tasks  related list and select a task number to open the Project Task form.

4. Right-click the form header and select Export Task to MS Project  from the context menu.

The task is exported to a folder on your system.

5. Open Microsoft  Project to import the exported project task files.
Refer to Microsoft  product documentation for instructions.

Calendars and schedules- Limitations

Some calendar elements from Microsoft Project are not imported into the Project Management 
application.

• Project calendars

• User calendars

• Schedules

The imported project uses the default schedule of a Monday to Friday workday from 8 A.M. to 5 
P.M. with an hour break for lunch, starting with the v3 application.

Related topics

Importing and exporting projects
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Manage status of your projects using Project Status  application

The Project Status  mobile app enables you to track the status of your projects, collaborate with 
stakeholders to resolve exceptions, and take timely actions regardless of your location.

You can use the Project Status  features to do the following:

• View the latest status of your projects

• View the latest status report of your projects

• Review risks and decisions

• Collaborate with other stakeholders on a project

• Receive mobile notifications when the project status changes or other users add comments or 
notes

Activation information

The Project Status  mobile application runs on the ServiceNow®  mobile platform. To enable the 
Project Status  app, activate the PPM Mobile plugin (com.sn_ppm_mobile) if you have the admin 
role.

Related topics

Activate Mobile Project Status

Get started with Project Status app

View project details on the mobile app

View project status report

Create RIDAC (Risk, Issues, Decisions, Actions, and Request Changes) records

Collaborate with project stakeholders

Activate Mobile Project Status

Activate the MobilenProject Status application from ServiceNow Store, earlier known as PPM 
Mobile (com.sn_ppm_mobile), if you have an admin role. Installing this application also activates 
related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Mobile: Project Status activates the following related plugin if it is not already active.

Plugin for PPM Mobile

Plugin Description

Project Portfolio Suite with 
Financials

[com.snc.financial_planning_pmo]

Enables you to manage your demands, resources, 
portfolios and projects. It also helps you plan, track, and 
manage the cost and budget of projects and demands 
in a portfolio to strike a balance between investment and 
returns.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.
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You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

List of plugins (Zurich)

Get started with Project Status  app

Access project status and status reports on the Project Status  mobile app to review your project 
status and collaborate with stakeholders regardless of your location.

Before you begin

• Download the Mobile Agent  mobile application on an iOS platform from the Apple App Store or 
on an Android platform from the Google Play Store.

• Activate the PPM Mobile plugin.

Role required: admin

Procedure

1. Open the mobile app and tap the plus icon ( ).

2. Add a ServiceNow  instance and enter the credentials to login.
You do not need to include service-now.com  at the end of the instance name.

3. Optional:  You can give a Nickname  to your instance for easy identification.

4. Tap Project Status  ( ) to get started with tracking your projects.

Related topics

Agent mobile app

View project details on the mobile app

You can view the status of a project and other project details such as financial data, status 
reports, risks, and decisions through the mobile app.

Before you begin
Role required: portfolio_manager or project_manager or program_manager

Procedure

1. Navigate to the Project Status application on your mobile app.

2. Open a project for which you want to view the details using one of the following options.
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◦ Tap to open an applet and then tap on a project.

◦ Tap on the Search Projects  applet to find a specific project.

◦ In the Critical Projects  or the Project in Red  lists, tap on a project.

Related topics

Manage status of your projects using Project Status application

View project status report

You can view the status of a project such as overall progress, executive summary, financial data, 
and RIDAC records through the mobile app.

Before you begin
Role required: portfolio_manager or project_manager or program_manager
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Procedure

1. Navigate to the Project Status application on your mobile app.

2. Open a project for which you want to view the project status report using one of the following 
options.

◦ Tap My Projects  ( ) applet to view your projects.

◦ Tap on the Search Projects  ( ) applet to find a specific project.

◦ In the Critical Projects  or the Project in Red  lists, tap on a project.

3. Tap the project card to view its status report.

◦ The Status  tab displays the summary of project such as overall health of the project, 
executive summary, achievements, and key activities planned for the project.

◦ The Details  tab displays status and details of information related to schedule, scope, cost, 
and resources for the project.
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Related topics

Manage status of your projects using Project Status application

Create RIDAC (Risk, Issues, Decisions, Actions, and Request Changes) records

You can create Risk, Issues, Decisions, Actions, and Request Changes records for your project 
through the mobile app.

Before you begin
Role required: portfolio_manager or project_manager or project_user

About this task
Analyze the impact of the risks on the project and create RIDAC records to track risks, issues, 
and their probable resolution for planning future projects. For more information see, Adding 
RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project.

Procedure

1. Navigate to the Project Status application on your mobile app.

2. Open a project for which you want to create a RIDAC record using one of the following options.

◦ Tap to open an applet and then tap on a project.

◦ Tap My Projects  applet to view your projects.

◦ Tap on the Search Projects  applet to find a specific project.

◦ In the Critical Projects  or the Project in Red  lists, tap on a project.

3. Create a RIDAC record using one of the following options.

◦ Tap the more action icon ( ) and select one of the options:

▪ New Risk

▪ New Issue

▪ New Decision

▪ New Action

▪ New Request Changes
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4. Based on the option that you selected, fill in the fields on the form.

5. Alternatively, open a RIDAC record and create a new RIDAC record.

◦ a. Tap the RIDAC  tab.

b. Tap the right arrow for a RIDAC record to view its details, tap the more action icon ( ), and 
then tap New Risk, New Issue, New Decision, New Action, or New Request Changes 
option based on the selected record.

c. Fill in the fields on the form.

Related topics

Manage status of your projects using Project Status application
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Collaborate with project stakeholders

Collaborate with the project manager and other stakeholders on a project to provide project 
updates, share documents, or send emails through the mobile app.

Before you begin
Role required: portfolio_manager or project_manager or project_user

Procedure

1. Navigate to the Project Status application on your mobile app.

2. Open a project for which you want to view the details using one of the following options:

◦ Tap on the Search Projects  applet to find a specific project.

◦ In the Critical Projects  or the Project in Red  lists, tap on a project.

3. Collaborate with the project manager and other stakeholders on a project status report in any 
of the following ways:

◦ Add activities to a project status report such as the ability to add work notes or comments, 
select and upload a picture, or attach photos and files.

a. Tap the Activity  tab.

b. Tap the add activity icon ( ) and select one of the options:

▪ Add Work Notes

▪ Add Additional Comments

▪ Open Camera

▪ Open Library

▪ Attach File

◦ Send an email to the project manager for additional details of the project.

a. Tap the Details  tab.

b. Tap the send email icon ( ).

c. In the email application, compose the email, add addresses, and send.

By default, the To  field is populated with the email ID of the project manager. You can add 
other stakeholders.

Result
When you add an activity or change the status in a project, the project manager receives a 
mobile notification. The project manager should have installed the Project Status  app and 
enabled notifications to receive notifications on the mobile device.

Related topics

Manage status of your projects using Project Status application

Using the Planning attributes

Planning attributes are designed to define and work on attribute-based resource mapping in 
Resource Management  and to generate labor costs for these resources in financials.

An attribute is a property or a characteristic defined as a resource or a task type, which is 
considered for attribute-based planning. These attributes can be used for resource management 
and financial planning.
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After the planning attributes are identified, as an admin, you can create or edit planning 
attributes  based on project requirements and metadata available from the resource table. 
Working on creating planning attributes involves identifying and defining the attributes to use for 
a project planning process.

Role-based advantages of using planning attributes

Role Advantages

Resource Manager (Resource Management) • Add any resources to a planning level.

• Use the resource grid to plan any attribute or 
make the required detailed changes.

• Allocate a heatmap to view and manage 
weekly or monthly allocation conflicts.

Project Manager (Project Financials) • Attribute-based creation of labor costs 
based on the new Resource Management.

• Automatically generate labor costs for the 
external resources.

• View the labor costs by the expense 
type based on the tasks assigned to your 
resources.

• View the financial forecasts for split up labor 
costs.

The following attributes are enabled by default for attribute-based resource mapping and to 
generate labor costs using financials.

Planning attributes

Attribute name Resource Management Financials

Employee Type

Expense Type .

Group

Role

Skill

Related topics

Create or edit planning attributes

Create or edit planning attributes

Create or edit planning attributes to plan and forecast your resources and financials for a project.

Before you begin
Role required: pps_admin, sn_align_core.apw_admin
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Procedure

1. Navigate to All  > Project Administration  > Planning attributes.

2. Use the following options to create or edit a planning attribute.

3. Enter field names for the lookup table values in Planning attribute column configurations 
table.

4. Optional:  To add new configurations to the default column configuration list for any tables 
containing the financials or resource management attributes:

a. Select New.

b. Select a lookup table from the list.

c. Select a field name from the list and select Submit.
For example: If you want to create an attribute for the Location field, add the location-related 
columns to the selected lookup table.
The selected item is added to the column configuration list with an auto-generated field 
description.

5. Select Update.

Important: 
If you're creating an attribute for resource management, make sure that you add 
the Attribute field to the resource_allocation, resource_plan, and 
sn_plng_att_core_resource_assignment  lookup tables. Similarly, if you're 
creating an attribute for financials, add the Attribute field to the cost_plan  lookup table 
along with the resource management lookup tables.

Related topics

Using the Planning attributes

Using Teamspaces in Project Management

A teamspace appears as an application in the instance application navigator. The teamspace 
includes module links that come from the Project Portfolio Management applications, such as 
the Project, Idea, Demand, Program and Portfolio applications.

Use teamspaces to provide functional and data separation of these applications between 
different teams in your organization. The following is an example teamspace for a marketing 
team:
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Example teamspace

Teamspace activation

You must activate a teamspace plugin to use the teamspace feature. Following teamspace 
plugins are available:

• Project Management TeamSpace 1  (com.snc.ppm_teamspace_1)

• Project Management TeamSpace 2  (com.snc.ppm_teamspace_2)

• Project Management TeamSpace 3  (com.snc.ppm_teamspace_3)

• Project Management TeamSpace 4  (com.snc.ppm_teamspace_4)

• Project Management TeamSpace 5  (com.snc.ppm_teamspace_5)

The teamspaces loaded with these plugins contain the same components, but the components 
have different prefixes. For example, teamspace 1 includes a project table named Teamspace_1 
Project [tsp1_project]  and teamspace 5 includes a project table named Teamspace_5 Project 
[tsp5_project].

You can enable any or all of these teamspaces and assign the teamspace specific roles to 
relevant users in the group that should use the teamspace. Maximum five teamspaces can be 
created through plugins.

Teamspace customization

You can customize the Project and Demand portions of a teamspace without affecting other 
teamspaces. This table summarizes what you can customize:

Teamspace customization

Customization to Project or Demand within a teamspace Supported?

Data model changes, such as adding a field to the Project or Demand form. Yes

Changes to business rules, UI actions, UI policies, security rules, data policies, and 
workflows.

Yes

Changes to shared roles, such as project_manager, demand_manager, and so on. Yes

Form and list layouts, list controls, and related lists Yes

Dictionary overrides Yes

Related topics

Activate teamspaces

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1383



Activate teamspaces

You can activate one or all teamspace plugins to use the teamspaces feature.

Before you begin
Role required: admin

About this task
You must activate a teamspace plugin to use the teamspace feature. Following teamspace 
plugins are available:

• Project Management TeamSpace 1  (com.snc.ppm_teamspace_1)

• Project Management TeamSpace 2  (com.snc.ppm_teamspace_2)

• Project Management TeamSpace 3  (com.snc.ppm_teamspace_3)

• Project Management TeamSpace 4  (com.snc.ppm_teamspace_4)

• Project Management TeamSpace 5  (com.snc.ppm_teamspace_5)

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Installed with teamspaces

The tables and roles that are installed with project teamspaces are prefixed with an abbreviation 
based on the name of teamspace.

Tables
The tables are extended from the Project, Idea, and Demand base application tables.

Tables installed with teamspaces

Tables Description

Idea [prefix_idea] Stores ideas.

Demand [prefix_demand] Stores demands.

Project [prefix_project] Store projects.

Portfolio [prefix_portfolio] Stores portfolios.

Project Task 
[prefix_project_task]

Stores project tasks.
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Tables installed with teamspaces  (continued)

Tables Description

Portfolio Goal 
[prefix_portfolio_goal]

Stores portfolio goals.

Portfolio Issues 
[prefix_portfolio_issue]

Stores portfolio issues.

Portfolio Risk 
[prefix_portfolio_risk]

Stores portfolio risks.

Portfolio Project 
[prefix_portfolio_project]

Stores portfolio projects.

Project Template 
[prefix_project_template]

Stores project templates.

Note: 
Project templates that are created in a teamspace 
area are not available in the main Project Management 
application any longer. They are only available to the 
teamspace in which they were created.

Project Template Task 
[prefix_project_template_task]

Stores project template tasks.

Stakeholder Register 
[prefix_stakeholder_register]

Stores the stakeholders.

Program [prefix_pm_program] Stores programs.

Program Task 
[prefix_pm_program_task]

Stores program tasks.

Program Task 
[prefixpm_program_task 
project_status]

Stores program task project status.

Roles

Roles installed with teamspaces

Role Description

prefix_demand_manager Managers of the demand features for the teamspace.

prefix_demand_user Users of the demand features for the teamspace.

prefix_project_manager Managers of the project features for the teamspace.

prefix_project_portfolio_user Users of the project portfolios for the teamspace.

prefix_project_user Users of the project features for the teamspace.

prefix_program_manager Managers of the program features for the teamspace.

prefix_portfolio_manager Managers of the portfolio features for the teamspace.

The teamspace application uses the same views that are provided in the Project, Idea, and 
Demand base applications.
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Note: 
Default client scripts that these base applications use are inherited by the extended tables 
in the teamspace application. If you created custom client scripts for any of the base 
applications, select the Inherited  options on each Client Script form before you create the 
teamspace.

Related topics

Using Teamspaces in Project Management

Configure teamspace settings

Configure teamspace settings after you activate a teamspace plugin.

Before you begin
Role required: it_pps_admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > TeamSpaces.

2. Select a teamspace name.

3. Change the teamspace name if necessary.
Changing the name only changes the title that appears in the application menu. It does not 
modify the names of other components, such as table names or role names.

4. On the Tables, Roles, and Application Menu related lists, you can add or modify the tables, 
roles, and application modules for the teamspace.

Result
The teamspace becomes available in the menu. The records that are assigned to the teamspace, 
such as projects, portfolios, demands, are automatically added to the teamspace.

What to do next
Assign the teamspace roles to the users of that teamspace. Do not assign the general roles that 
come with the applications in the Project Portfolio Suite.

Related topics

Using Teamspaces in Project Management

Project reporting

Get an at-a-glance view of projects with reports, the portfolio dashboard, and project views. You 
can see information such as projects with slipped milestones, graphs of resources by project, 
and projects listed by percentage complete.

Note: 
Much of information available on reports, dashboards, and views is customizable. The 
examples below derive from default settings.

The application provides several global reports, both lists and charts, that show the status of 
projects at a glance. You can also create custom reports or create reports that can be viewed by 
certain groups. The following Project Management  reports are available in the base system:

• Active Project Unassigned Tasks 30 Days: list report: list report

• Projects (by priority): bar chart

• Projects (by priority): list report

• Projects (by risk): list report

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1386



• Projects (by risk): bar chart

• Projects (by state): list report

• Projects (by state): bar chart

• Active projects: list report

• Pending projects: list report

• Active Projects by Manager: bar chart

Related topics

Reporting

Enable project currency view in project-related forms

Switch over to the project currency view to track the planned costs of a project in the selected 
project currency.

Before you begin
Role required: it_project_manager

About this task
To manage your projects in local currency and to create a project from a demand, the project 
currency fields are added in the following tables that have cost details and financials tab:

Tables with project currency fields

Table name Description

Demand [dmn_demand] table To create a project from a demand in project 
currency. Specify the currency that you want 
to use to manage your project by navigating 
to the Financials  tab of the Demand form and 
selecting a currency in the Project Currency 
field.

Note: 
You can specify the project currency 
only when you switch to the Demand 
Currency view. For more information, see 
Multicurrency in Demand Management.

To create a demand, see Create a demand.

Project [pm_project] table To navigate to the Project form, see 
 unique_1265.

Cost Plans [cost_plan] table To navigate to the Cost Plan form, see Create a 
project cost plan.

Cost Plan Breakdown [cost_plan_breakdown] 
table

To navigate to the Cost Plan Breakdown form, 
see Update a cost plan breakdown.

Benefit Plan [benefit_plan] table If you open the project form in Project 
Currency view, then by default the project 
currency related fields appear in the Benefit 
Plans related list. To create a project benefit 
plan, see Create a project benefit plan.
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Tables with project currency fields  (continued)

Table name Description

Benefit Plan Breakdowns 
[benefit_plan_breakdown] table

To update a benefit plan breakdown, see 
Update a benefit plan breakdown.

Expense Line [fm_expense_line] table Expense lines are part of project cost plans 
and stores cost associated with a specific 
resource. To navigate to the Expense line form, 
see Create an expense line.

Project Funding [project_funding] table Stores the project target and budget expense 
values for both capital and operating 
expenses for a single fiscal period.

Procedure

1. Navigate to the respective form.

2. Right-click the context menu of the form.

3. Click View.

4. Select Project Currency  from the list.

What to do next
Refer to the form fields that are exclusive to the Project Currency view that you have selected. 
All the other form tabs and fields remain same both for the default view and the project currency 
view. Continue to enter values in the fields as you would for the default view.

Track project budget in project currency

Allocate budget to a project and enter amounts for capital expense budget (Capex) and 
operating expense (Opex) budget in project currency. The sum of the Capex and Opex budgets 
are calculated as total budget in project currency.

Before you begin
Role required: it_portfolio_manager

About this task
Allocate budget in a similar manner as you do with functional currency. For more information, see 
Allocate budget to a project.

Enable the project currency view of the Project form to allocate budget in project.

Procedure

1. Click the Project Budget related link of the Project form.

Project Budget form

Field Description

Currency Currency in which budget is allocated for a 
project.

If you activate multicurrency plugin, then you 
have the option to budget in project currency 
or functional currency.
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Field Description

Capex Budget in Project Currency Planned expense amount allocated for 
capital expenditure in the selected currency.

Opex Budget in Project Currency Operating expense amount in the selected 
currency.

Total Budget in Project Currency Sum of Capex and Opex amounts.

The total project funding budget amount rolls 
up to the Budget cost in project currency 
field.

2. Click OK.

3. Click the Project Budget related list to update or view the record.

What to do next
The project target and budget expense values for both capital and operating expenses for a 
single fiscal period is stored in the Project Funding [project_funding] table. When you update the 
project funding record, the amounts are converted to project currency.

Closing a project

Closing the project involves more than just changing the project state to closed.

Before you begin
Role required: it_project_manager

About this task
Post-project activities include viewing baselines and actual values to evaluate how much the 
project slipped from its original estimates. They also include following up on related incidents, 
problems, or changes that are linked to the project through the instance.

When you close a project, all project tasks and sub-projects associated with the project are 
closed automatically. Normally, you should not reopen a project after it is closed. Updating the 
project state from Closed to Work In Progress, Pending, or Open is not allowed. If you still need 
to reopen a closed project, reopen an existing project task or add a new task to the project. This 
action for a task moves the project from Closed to Work in Progress state without affecting the 
other closed tasks.

When a project is in the closed state, the Project Management  application calculates actual 
values like Actual duration. You can cancel the associated future resource plans and complete 
the allocated resource plans for a closed project.

Procedure

1. Verify that the work is completed for all tasks in the project.

2. On the Project form, change the State  field to one of the closed states:

◦ Closed Complete: The project is finished and all tasks are complete.

◦ Closed Incomplete: The project is finished, but tasks remain unfinished.

◦ Closed Skipped: The project was abandoned.
Alternatively, close every project task first, starting with the lowest-level child tasks. The 
closed states roll up to parent tasks, and when all highest-level parent tasks are closed, the 
project state changes to closed. However, the default closed states for parent tasks and for the 
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project is Closed Complete. Therefore, even if you change any or all project tasks to Closed 
Incomplete  or Closed Skipped, the project state is changed to Closed Complete.

Also, change the Phase  value to Closing. The project phase is for reference only and is not 
linked to or dependent on the State  field.

If your project contains sub-projects, you can close the sub-project without affecting the 
parent project. Change the State  of the sub-project to any closed state to close the sub-
project. Closing the sub-project closes or changes the state of all the tasks associated with 
the sub-project. Also, changing the state of the sub-project to Work in Progress, moves all the 
associated tasks to Work in Progress state.

If there are project tasks associated with the parent project that are not closed, the parent 
project remains in the Open, Work in Progress, or Pending state. If the tasks associated 
with the parent project are closed, the state of the parent project also changes to Closed 
Complete.

3. After the project is complete, create a final baseline to see how closely the project's actual 
values came to the estimated values.

Note: 
Baselines compare only planned start and end date values with actual start and end date 
values. Use reports to compare the effort and cost.

Result
For projects created from an incident, problem, or change, updating the project state does not 
automatically update the related incident, problem, or change request record. You must update 
the related record manually. For example, if the completion of a project also means that a related 
Change can be closed, go to the Change record and modify its State  field. It is also a good idea 
to update the work notes field on the related record to include any relevant information about the 
project. If the project was successful and can be used as a template for future projects, make a 
copy of it. If the project was created from a change, incident, or problem record, there are several 
other activities to perform in ServiceNow.

What to do next

• Cancel the resource plans  associated with the project in any of the following conditions:

◦ There is a corresponding resource plan in the Confirmed, Planning, or Requested state.

◦ There is a resource plan in the Allocated state with the start date later than the project end 
date.

• Complete the resource plans  associated with the project in the following conditions:

◦ There is a corresponding resource plan in the Allocated state.

◦ The start date of the resource plan is on or before the actual end date of the project or task.

Project Diagnostics

Project Diagnostics enables you to detect corrupt data in a project such as task validity, 
dependencies, and relationships using diagnostic scans that execute diagnostic scripts. You can 
also fix corrupt data using fix scripts.

Data might become corrupt or invalid for various reasons, such as:

• Incorrect field mapping during project import

• Incorrect scheduling of tasks

• Incorrect dependency and relationship definitions
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Project Diagnostics uses diagnostic scans and fix scripts to detect and fix corrupt data in your 
projects. It enables you to do the following action:

• Create and add diagnostic features

• Add diagnostic and fix scripts  to fix corrupt or invalid project data

• Create Diagnostic scans and map related scripts

• Define fields for users to create specific filter conditions. The diagnostic scripts use the results 
of these filter conditions as input for detecting any corrupt or invalid data.

Project Diagnostics page provides the default scans described in the following table.

Project Diagnostics default scans

Diagnostic Scan Name Description

Tasks with invalid top task Lists the tasks that have an invalid top task. A task is considered 
to have an invalid top task if the value for the top task is set to 
Null  or is mapped to a different task in the hierarchy.

Tasks with invalid top 
portfolio

Lists the tasks that have an invalid top portfolio. A task is 
considered to have an invalid top portfolio if it belongs to a 
different portfolio or is not associated with any portfolio.

Tasks with invalid top 
program

Lists the tasks that have an invalid top program. A task is 
considered to have an invalid top program if it belongs to a 
different program in the same portfolio or is not associated with 
any program.

Invalid relations Lists the invalid relations in a project.

A relation is considered to be invalid if the predecessor or 
successor is not a part of the project (unless it is an external 
relation), or if the predecessor or successor record does not exist 
in the system.

Validate parent tasks Lists the tasks that have empty or invalid parents.

Check for tasks with cyclic 
dependencies

Checks for any cyclic relations, which are not permitted, in a 
project. For example, suppose you have a project in which Task A 
is related to Task B. A reverse relation from Task B to Task A would 
be considered a cyclic dependency.

Recalculate project Recalculates task dates in a project.

Warning: 
Performing this action might change the dates in a project.

Check duplicate/redundant 
relationships

Lists tasks that have duplicate or redundant relations in the 
selected projects.

Cost plans with no start and 
end fiscal period

Checks and lists cost plans with no start and end fiscal period 
within the selected projects.

Validate project task 
constraints in project

Lists all tasks with invalid constraint types. For example, a task 
with Start no later than set as a parent or the Constraint date  field 
is empty for a task with Start no earlier than and Start no later 
than constraint.
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Project Diagnostics default scans  (continued)

Diagnostic Scan Name Description

Validate tasks with invalid 
state

Lists all tasks with invalid WIP or Closed state based on actual 
dates.

Identify projects with 
negative planned cost 
for any year where the 
budget was not allocated 
to the corresponding fiscal 
periods

Checks and lists the projects that have negative fiscal year 
project budgets.

Identify discrepancies in 
project budget

Checks and lists the projects for which project funding does not 
match with the sum of task type breakdown cost or fiscal year 
project budget.

Identify cost plan 
breakdowns with invalid 
fiscal periods

Checks and lists the cost plan breakdowns with invalid fiscal 
periods.

Identify duplicate task type 
breakdowns for an expense 
type and a fiscal period

Checks and lists the duplicate task type breakdowns.

Associate orphan expense 
lines to the system 
generated cost plan

Lists the expense lines that are not associated to any cost plan. 
When you run the fix script, these orphan expense lines are 
associated to a system-generated cost plan  and then to the 
respective breakdowns of the system-generated cost plan.

Use Project Diagnostics to detect corrupt project data

Project Diagnostics uses the Application Diagnostics Tool to detect corrupt data in a project, 
such as tasks with invalid parents, tasks without top tasks, and invalid or cyclic relations in a 
project.

Before you begin
Role required: it_pps_admin

About this task
Project Diagnostics can also detect whether date calculations in a project appear to be incorrect, 
the planning console does not open for a project, or a few tasks or relationships do not appear in 
the planning console.

Procedure

1. Determine whether you want to run a diagnostic scan on a single project or multiple projects.

2. On the Application Diagnostics Tool page, select a diagnostic feature.

3. Use the Feature Inputs fields to specify filter conditions.

4. From the Diagnostics  section, run a single diagnostic scan or multiple scans on the projects 
matching the filter criteria.

5. View the results of the scans.
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What to do next
Add your own diagnostic scans  and fix scripts.

Create and add diagnostic features

Create and add diagnostic features, which consist of single or multiple diagnostic scans that 
execute mapped scripts to detect data corruption or invalid data.

Before you begin
Role required: adt_admin

Procedure

1. Navigate to All  > Application Diagnostics Tool  > Features.

2. Select New.

3. On the form, fill in the fields.
For more information, see Diagnostics Feature form.

4. Define the fields available to users for specifying filter conditions in the Diagnostics Inputs 
section.

The fields that you configure in the Diagnostics Inputs  section appear in the Feature Inputs 
section of the Application Diagnostics Tool page.

5. Select Submit.

What to do next
Create diagnostic scripts and add fix scripts to use with the diagnostic feature. For more 
information, see Add diagnostic and fix scripts.

Add diagnostic and fix scripts

Add diagnostic scripts to scan the data in your application for any corruption. You can also attach 
fix scripts to rectify the corrupt or invalid data identified by the diagnostic script.

Before you begin
Role required: adt_admin

About this task
The results of the filter conditions that you specify in a diagnostic feature  are used as an input 
for the diagnostic script while executing. You can also use the result of one script in subsequent 
scripts.

Procedure

1. Navigate to All  > Application Diagnostics Tool  > Scripts.

2. Select New.

3. On the form, fill in the fields.
For more information, see Diagnostic Scripts form.

4. Optional:  Include a script for fixing the corrupt or invalid data identified by the diagnostic 
script.
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a. Select the Has Fix script  check box.

b. Select the Edit User Roles icon ( ) and choose the roles that can access the diagnostic 
script.

c. In the Fix script  section, add the code for the fix script.

5. Select Submit.

Related topics

Project Diagnostics

Create Diagnostic scans and map related scripts

Once you have created diagnostic features and scripts, map them to a diagnostic scan to check 
the health of data in your application. Use fix scripts to rectify any corrupt or invalid data that the 
diagnostic scan identifies.

Before you begin
In order to create a diagnostic scan, you must have already created diagnostic features and 
scripts For more information, see Create and add diagnostic features  and Add diagnostic and fix 
scripts.

Role required: adt_admin

About this task
You can map multiple scripts with each diagnostic scan and define the order of their execution.

Procedure

1. Navigate to All  > Application Diagnostics Tool  > Diagnostics.

2. Select New.

3. On the form, fill in the fields.
For more information, see Diagnostics form.

4. Select the Roles icon ( ) and move the desired roles to the Selected list.
The users with the selected roles can access the diagnostic script.

5. Search for and select diagnostic scripts to map with the diagnostic scan in the Diagnostics 
and Script Mappings  section.

6. Select Submit.

What to do next

• Create related link for navigating to the diagnostic features and scans in the application. For 
more information, see Create a UI action .

• Run diagnostic scan and view results. For an example of how the diagnostics scan work, see 
Use Project Diagnostics to detect corrupt project data.

Related topics

Diagnostics form

Using Work breakdown structure (WBS) - Legacy

The work breakdown structure (WBS) is a hierarchical representation of all the tasks in your 
project.
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Important: 

Work breakdown structure (WBS) is being prepared for future deprecation. It will be hidden 
and no longer available for installation but will continue to be supported. For details, see 
the Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use 
new Project Workspace  with enhanced UI to help you efficiently manage your projects.

Use the WBS to get a quick overview of the entire project, including the tasks and subtasks 
nested in the project. The Gantt chart gives you a similar overview using graphical elements 
like lines and bars to show dependencies and lengths of tasks. The WBS is more data-driven, 
presenting a wide variety of task information in expandable rows.

You can view the WBS on the planning console, or as a related list on the Project or Project Task 
form. See Open the project planning console  or Access the WBS as a related list.

When the WBS is viewed as a related list on the Project or Project task form, several important 
columns from the table appear by default.

Important columns

Column 
Name

Description

WBS The number of the task in the WBS hierarchy. The first task in the hierarchy is 
assigned the number 1. Subtasks increment the number in the tenth place, such as 1.1 
and 1.2. The numbers are read-only.

WBS 
Order

A number that represents the task in relation to its parent. The first subtask under 
a task has an WBS Order of 1, and the next task 2. If you edit a number, all tasks are 
moved accordingly after you refresh the list.

Number The task ID number, which should not be changed.

Other useful information also appears by default, such as the description and percentage 

complete. You can personalize the list like any other list by selecting the personalize list icon ( ) 
and selecting the columns you want to view.

Related topics

Access the WBS as a related list

Access the WBS as a related list

You can view the WBS as a related list on both the Project and Project Task forms.

Before you begin
Role required: it_project_manager

About this task
You can view the full WBS list by navigating to a Project form and selecting the Planning Console 
related link. See Planning console tasks  for a list of the things you can do with the WBS on the 
planning console.

You can also view the WBS as a related list on the Project or Project Task form.

Procedure

1. Navigate to a Project or Project Task form.

2. Right-click the header and select View > WBS.
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WBS List  appears as a related list.

3. On the WBS, select the arrow icon ( ) to expand a task and view child tasks.

Demo Project WBS

Related topics

Using Work breakdown structure (WBS) - Legacy

Using Project workbench - Legacy

The project workbench provides a central location for creating and managing projects.

Important: 

Project Workbench is being prepared for future deprecation. It will be hidden and no longer 
available for installation but will continue to be supported. For details, see the Deprecation 
Process [KB0867184]  article in the Now Support knowledge base. Use new Project 
Workspace  with enhanced UI to help you efficiently manage your projects.

The workbench supports the Project Management  and application life cycle management 
applications, allowing for a hybrid approach to project management. Project managers can 
create projects that combine both waterfall and agile methodologies and add waterfall, agile, and 
test phases to these projects.

The project workbench makes it easy to manage projects by presenting project information in 
two panes. The top pane displays a timeline with the project phases and milestones. The bottom 
pane displays details for the phase selected in the timeline. The project workbench provides 
real-time interaction between the timeline, the list view, and the visual task board.

The project workbench also supports the following features:

• Project templates: Project managers can quickly and easily create projects based on 
templates, which define the basic structure of a project.

• Manual project calculation: The workbench adds the capability of creating projects that 
use manual calculation. Project managers can also create auto calculation projects from the 
Project Management  application.

• Composite fields: The field type combines information from two fields in a table to form a 
single field.

With the project manager role, you can use the project workbench to:

• Manage projects.

• Create and update project phases and milestones.

• Assign a group to an agile phase.

• Create and update project tasks, stories, and test cases.

• Attach test plans to a test phase.

• View and manage project details from a list view or visual task board.
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The project workbench displays project information in two distinct areas. The top pane displays 
the project visualization, and the bottom pane displays phase details in a list view or visual task 
board. There is also a header above the workbench that includes several buttons and controls.

The project workbench scales to fit the available browser height. If necessary, scroll bars are 
added to display the workbench details.

Project Workbench

Access the project workbench

Access the project workbench from the Project form or from the application navigator.

Before you begin
Role required: it_project_manager

Procedure

Access the project workbench in one of the following ways.

Note: 
If the project workbench opens with no associated sys_id or an incorrect sys_id, an error 
message appears. Select a project from the project choice list in project workspace banner.

Related topics

Using Project workbench - Legacy

Components of project workbench

The project workbench displays project information in two distinct areas. The top pane displays 
the project visualization, and the bottom pane displays phase details in a list view or visual task 
board. There is also a header above the workbench that includes several buttons and controls.

The project workbench scales to fit the available browser height. If necessary, scroll bars are 
added to display the workbench details.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1397



Header

The header is a gray bar that runs across the top of the project workbench.

The first time a user accesses the project workbench from the Project menu, the header displays 
the following components:

After a project is opened, the header displays additional components, depending on the type of 
project selected.

• Back ( ): takes the user to the Project form to view the project details.

• Select Project: displays the current project name. Click the down arrow to select a new project.

• Add phase icon ( ): adds a phase or milestone to the timeline.

• Apply Template: opens a dialog box for setting a start date and adding a template to the 
project. This button appears for new or blank projects that have no phases.

• Manage Stories: under the Options icon ( ) displays the story backlog for this project.

• List: under the Options icon ( ) displays additional details in list view about the currently 
selected phase. This button appears if a project has one or more phases.

• VTB: under the Options icon ( ) displays additional details in the Visual Task Board about 
the currently selected phase. This button appears if a project has one or more phases.

Timeline

The top pane of the project workbench displays the project timeline. The timeline uses monthly 
or quarterly markers to represent time. If the duration of a project is less than 500 days, these 
markers represent months and if the duration is greater than 500 days, these markers represent 
quarters.

The project timeline displays the following project information:

• Project name: the name assigned to the project. Point to the project name to see a message 
about the project date calculation method used for this project.

• Percentage complete: the percentage of the project that has been completed. This percentage 
is based on the duration and the percentage complete of the individual phases.

• Project start and end dates: the dates specified in the Planned start date  and Planned end 
date  fields for this project.

• Project phases: colored bars that represent the different phases of the project.

• Milestones: colored and dynamic circles on the timeline that represent important dates in the 
project life cycle.

Phases in timeline

A project phase is represented in the timeline by a horizontal bar. The bar is connected to the 
timeline by a thin vertical line that indicates the phase start date. The name of the phase appears 
just above the horizontal bar. Project phases are stacked in the timeline by start date, phase, and 
the earliest start date appearing at the top. If there are phases than can fit on the timeline, a scroll 
bar appears on the right side.

The color of the horizontal bar changes incrementally to reflect the completion percentage of the 
phase. The percentage completion is calculated based on the phase type:
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• Waterfall: includes project tasks. The completion percentage is based on the number of 
project tasks that have been completed.

• Agile: includes stories. The completion percentage is based on the number of story points that 
have been completed.

• Test: includes test cases. The completion percentage is based on the number of test cases 
that have been completed.

The available phases depend on how Project Management  is installed. When Project 
Management  is installed as a standalone app, the project manager can only create and edit 
the Waterfall phase type. When Project Management  is installed as part of the Project Portfolio 
Management  (PPS), the project manager can create and edit all phase types (Waterfall, Agile, 
and Test).

When you point to a phase, the cursor changes from an arrow to a hand and a pop-up window 
displays the phase name and the start and end dates. Clicking a phase in the timeline displays 
the corresponding task information in the bottom pane of the project workbench.

Milestones in timeline

Milestones indicate important dates in a project and are represented along the timeline by 
colored circles. Three colors are available for milestones: green, yellow, and red. The project 
manager determines how the colors are used.

Pointing to a milestone changes the cursor from an arrow to a hand and displays a pop-up 
window with the short description and planned start date.

Select a milestone to update the milestone information. You can also drag a milestone along the 
timeline to change the date. Milestones can be dragged to any point on the timeline within the 
boundaries of the project start and end dates.

Detail view

The bottom pane of the project workbench displays detailed information for the phase currently 
selected in the timeline. The information displayed varies by the phase type selected:

• Waterfall: displays the project tasks associated with the phase.

• Agile: displays the stories assigned to the phase.

• Test: displays the test cases for the testing phase.

Information in the bottom pane can be displayed in list view or in a visual task board. The List 
and VTB  buttons in the Project Workbench header control how this information is displayed.

Project calculation

When creating a project, the project manager can select the type of calculation to use: manual or 
automatic (default).

The project workbench displays help text that explains whether the current project is calculated 
automatically or manually. The help text appears when the project workbench page loads and 
also when the user points to the project name in the upper left corner.

For manual calculation:

• Dates on tasks do not automatically reflect any changes from dependent tasks.

• New projects created from the project workbench and projects created from demands are set 
to manual calculation by default. Projects created as manual can be changed to automatic.
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• The project timeline reflects the earliest planned start date and latest planned end date based 
on the project tasks.

• The constraint type cannot be changed.

• Only Start on specific date  constraint type is allowed for project tasks.

For automatic calculation:

• A task automatically reflects any changes from its dependent and child tasks.

• New projects created from the Project Management  application are set to automatic 
calculation by default.

Note: 

• A project created as automatic with one or more tasks cannot be converted to manual.

• Percentage completion and states for phases are updated automatically for both manual 
and auto calculation.

Related topics

Using Project workbench - Legacy

Managing Project workbench

The project workbench allows project managers to manage all aspects of a project.

Open a project in the project workbench

The project manager can open an existing project in the project workbench.

Before you begin
Role required: it_project_manager

Procedure

1. In the project workspace banner above the project workbench header, select the down arrow 
in the project selector box.

2. Select a project from the choice list.
The selected project opens in the project workbench under Planning  tab in project workspace.

Related topics

Create a project task in the project workbench

Create a project task in the project workbench

Create a project task for a waterfall phase.

Before you begin
Role required: it_project_manager

About this task
While creating a project task in the project workbench, the time constraint type is defaulted 
based on the project type.

• For a manual project, the default constraint is Start On and cannot be changed.

• For an automatic project, the default constraint is Start ASAP and can be changed to Start On if 
required.
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• When the constraint is Start ASAP, the Planned start date  is disabled.

• When you create an agile phase and associate a sprint, the start date of the task is set from the 
sprint start date and the constraint becomes Start On automatically.

Procedure

1. Select a waterfall phase in the project workbench timeline.

2. Select New  in the detail view.

3. Fill out the Project Task form.

4. Select Submit.

Related topics

Managing Project workbench

Manage project stories in the project workbench

If Project Portfolio Management  and Agile Development 2.0  are activated, the project manager 
can manage the stories in a project from the project workbench.

Before you begin
Activate Project Portfolio Management  and Agile Development 2.0  plugins.

Role required: it_project_manager

About this task
Manage stories in your project using the Manage Stories  option in the Project Workbench.

Procedure

1. In the project workbench header, select the options icon ( ) and then select Manage Stories.
The Backlog section of the Agile Board opens in a new tab.

2. Select a story to open the Story form in the pop-up window, or select New  to create a new 
story.

3. Fill in the fields on the Story form.

4. Select Update  or Submit.

Related topics

Managing Project workbench

Create a story in the project workbench

Create a story for an agile phase.

Before you begin
Role required: it_project_manager

Procedure

1. Select an agile phase in the project workbench timeline.

2. Select New  in the detail view.

3. Fill out the Story form.

4. Select Submit.
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Related topics

Managing Project workbench

Create a test case in the project workbench

Specifying a test plan is optional when creating a test phase. However, before you add test cases 
to a test phase, you must specify a test plan.

Before you begin
Role required: it_project_manager

Procedure

1. Select a test phase in the project workbench timeline.

2. Select New  in the detail view.

3. Fill out the Test Case form.

4. Select Submit.

Related topics

Managing Project workbench

Using Planning console - Legacy

The planning console is a centralized interface for the Project Management  application.

Important: 

Planning console is being prepared for future deprecation. It will be hidden and no longer 
available for installation but will continue to be supported. For details, see the Deprecation 
Process [KB0867184]  article in the Now Support knowledge base. Use new Project 
Workspace  with enhanced UI to help you efficiently manage your projects.

The planning console gives project managers a comprehensive view of all aspects of a project, 
including a hierarchical list of sub-projects, if any, project tasks that appear in a work breakdown 
structure (WBS) list, and the project Gantt chart. The console also integrates with Live Feed so 
your users can collaborate on projects.

Sections in the planning console

The planning console is divided into the following sections:

• A list of the project tasks if you open the planning console for a project.

• The Gantt chart.

• Banner icons and lists for performing tasks on the console.
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Example planning console

For more information on the Gantt chart and the task relationships and dependencies that you 
can build, see Gantt chart  and Parent-child rollup task calculations.

Note: 
The resources in the Assigned to  column of the planning console can be constrained to be 
derived only from the allocated resource plans associated to the project or any of its tasks.

Business rules

By default, the business rules are not triggered during an operation in the planning console. You 
can enable the business rules using Enable firing of Business Rules  property.

Note: 
To enable this property, you must clear the Enable Client Side Planning  check box.

You can also enable business rules when defining the columns for planning console  using the 
Fire BR on Save  field.

Client side planning console

Build your project structure quickly on the client side without having to save details in the 
server for each interaction in planning console. Enabling Client side planning console  prevents 
any time lags that occur after you perform any actions in planning console, and improves the 
scheduling performance.

Automatic and manual projects

In an automatic  project, any change to the dates, duration, or relationships of a project task 
automatically updates all the tasks in the entire project, including the project record, as 

necessary. The automatic project icon ( ) appears adjacent to the project name.

In a manual  project, changes to the dates, duration, or relationships of a project task do 
not automatically update all tasks. So parent task dates do not reflect any changes made to 
dependents or child tasks. The only change that is made automatically is when a task date or 
duration change updates dates and duration of the project record. In a manual project, any 
update to actual start date does not update the planned end date of the project or project task. 
However, enabling the project property  Enable alter of planned date with Actual for Manual 
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Project  updates the planned end date from actual start date and planned duration. The manual 
project icon ( ) appears adjacent to the project name.

You can specify if a project is automatic or manual in the Calculation  field on the Project form. 
This field becomes read-only when the project starts.

Tutorial

A tutorial walk through is available in the console. It shows you all the features of the console and 

how to use them. Access the walk through within the help icon ( ).

Open the project planning console

Access the planning console to perform the planning for the project.

Before you begin
Role required: it_project_manager

Procedure

Open the planning console using any of the following methods.

Planning console tasks

You can perform several tasks on the planning console that you can perform on lists and forms, 
such as creating project tasks and copying projects. You can also perform several tasks unique 
to the console.

General console settings tasks

Task Steps

Display a project in the planning 
console

Select the project from the list in the project workspace 
banner.

WBS hierarchy tasks

Task Steps

Create a project task
Select the add task below icon on the row to 
create a new task.

You can also select an existing task to 
determine the insertion point for the new task, 
and then select the add task above icon or the 
add task below icon.

Move a task up or down in the hierarchy Select an existing task, and then select the 
move up or move down icons.

Indent or unindent a task in the hierarchy Select an existing task, and then select the 
unindent or indent icons.

Edit a task record Right-click a task and select Edit. The Project 
Task form appears in the overlay. You can also 
edit a field directly in one of the columns in the 
planning console. You can also edit project 
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WBS hierarchy tasks  (continued)

Task Steps

tasks that represent phases in the project 
workbench.

Edit the State  field Double-click the value in the State  column to 
select a new state. The value of the State  field 
also changes automatically when % complete 
is changed for a task.

View and modify task status View the status of the project task based on 
the difference of the planned end date of 
the task from the current date. The status of 
the task updates automatically from Green 
to Yellow to Red as the planned end date 
approaches.

You can manually update the task status 
by double-clicking the Status  column and 
selecting a different task status. For more 
information, see Status  field description in the 
Create a project task from a project  topic.

Add an agile phase or a test phase Right-click a project and select Add Agile 
Phase  or Add Test Phase. The agile phase 
icon or test phase icons appear next to the 
task in the Name  column. See phase icons.

Note: 

• The Add Agile Phase  option is 
available only for Agile and Hybrid 
projects. You must also have the Agile 
Development 2.0  plugin installed.

• You can add multiple agile phases and 
multiple test phases to a project.

• You can add only one test phase for a 
test plan in a project. You must have 
the Test Management  plugin installed 
to view the Add Test Phase  option.

• An agile phase cannot overlap another 
agile phase for an assignment group in 
a project.

• While creating a story, if a project 
has only one phase, then the story is 
tagged to the phase.

Open a test plan or story Right-click a task (a task that represents a 
phase in the workbench) and then select 
Manage Test Plan. Select View Stories 
to view the stories list. If you have the 
scrum_product_owner role, select View 
Stories  to navigate to the Backlog  tab of the 
Agile Board.
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WBS hierarchy tasks  (continued)

Task Steps

Note: 
The View Stories  option is available only 
for Agile and Hybrid projects. You must 
also have the Agile Development 2.0 
plugin installed.

Cancel a resource plan for a Closed project Right-click the project and select Cancel 
Resource Plans. All past and future allocations 
for the selected resource plan are canceled.

The option is available only for a project in any 
of the Closed states.

Complete a resource plan for a Closed project Right-click the project and select Complete 
Resource Plans. All the requested and 
resource allocations for the resource plan post 
the completion date are deleted.

The option to complete resource plans  is 
available only for a project in any of the Closed 
states.

Add an external dependency between tasks of 
different projects

Right-click a task and select Add External 
Dependency. Select the project and task to 
which the dependency is added.

View the project name of an external 
dependency

Point to the link icon beside the external 
dependency task to display a tooltip which 
shows the name of the project to which the 
external dependency is added.

Change the time constraint for a task Double-click a task under the Constraint type 
column and select an option: Start ASAP, 
Start on specific date, Start no earlier than, or 
Start no later than.

• You can change the Constraint type  for 
Automatic projects only.

• When you change the time constraint for 
a task from Start on specific date  to Start 
ASAP  or vice versa, the planned start 
date and planned end date of the task are 
recalculated accordingly.

• The Constraint date  column displays the 
start date for all the constraint types other 
than Start ASAP  tasks. This column is not 
available by default, you must add this 
column to the Planning Console from the 
Configuration menu.

• The option is not available for a parent 
task. If a task has child tasks, the option is 
available only for the child tasks.
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WBS hierarchy tasks  (continued)

Task Steps

• You cannot create a parent task with Start 
no later than  or Start on specific date 
time constraint. When a new child task is 
added to a task with these time constraints, 
the time constraint for the parent task is 
converted to Start ASAP.

• You cannot change constraint type for 
projects with Calculation  type set as 
Manual.

Allow task dates outside schedule Right-click a project task and select Allow 
outside schedule. The selected task is 
allowed to start and end on a non-schedule 
day (outside the regular project schedule) 
such as on a weekend. The off schedule task 
icon appears next to the task in the Short 
description  column.

For example, if you use the project schedule 
Monday to Friday, 8:00 to 17:00 and a project 
task of duration 2 days should start on 
Saturday, then an off-schedule task is allowed 
to be scheduled on Saturday and end on 
Sunday. Similarly, if a task of duration 3 days 
starts on Friday, then an off-schedule will end 
on Sunday as opposed to ending on Tuesday.

• The option is not available for a parent task. 
When a task is made off-schedule, its parent 
also becomes off-schedule. The project also 
operates as out of schedule if any of the 
children is set to out of schedule.

• Once a task is allowed outside the schedule, 
the Follow schedule  option is available 
for the task. Right-click the task and select 
Follow schedule  to follow the schedule for 
the task.

Note: 

• There is no difference between an off-
schedule and an on-schedule task if 
there is no schedule defined at the 
project level.

• 1 day is 8 hours for a task in a regular 
schedule and 24 hours for a task 
outside the schedule.

Convert a task to milestone Right-click a task and select Convert to 
milestone.
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WBS hierarchy tasks  (continued)

Task Steps

• You can convert a task to a milestone only 
until it is not in Work in Progress  state. 
Once work in progress, the option appears 
as greyed out for the task.

• The option is not available for a parent 
task. If a task has child tasks, the option is 
available only for the child tasks.

Show or hide external dependencies Select the more options icon, and then select 
the Hide External Dependencies  switch.

When this option is enabled, the external 
dependencies are not displayed when you 
add an external dependency between two 
projects. However, the Dependency  column in 
the WBS section of the successor project still 
shows the value of external dependency.

Show external dependency notifications Select the notification bell icon to display the 
notifications raised in the successor project. 
The notifications are triggered as a result of 
changes made in the predecessor project.

• For a soft dependency, select Accept  or 
Reject  to accept or reject the changes in the 
notification.

• For a hard dependency, view the displayed 
notification to review the changes in the 
notification.

Save changes to the server Select the save icon to commit changes 
made in the planning console. The option 
is available only when Client Side Planning 
Console  is enabled.

Expand or contract column width Select the side of the column and drag it right 
or left.

Show or hide columns in the planning console Select the show or hide columns in gantt 
icon, and then select or clear the check 
boxes for the columns available. Admin can 
customize  which columns appear in this list. 
The selection is saved in the user preference. 
The next time you open the planning console, 
the same columns you selected will appear.

Select WBS levels to show Select the show or hide columns in gantt icon, 
and then select the level from the WBS  Depth 
list.

Expand or collapse sublevels for any level Select the arrow to expand or collapse any 
task that has one or more subtasks.
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Gantt chart tasks

Task How to perform the task

View a summary of a task Point to a task.

Change the planned start or end dates of a 
task

Select the task, and then drag the left or right 
edge of the task bar.

Move a task to a new date Select the task, and then drag the whole task 
bar to a new location.

Create a dependency between tasks Find the successor task in the relationship 
and double-click the value in the Predecessor 
column and enter a value that specifies the 
relationship. See Predecessor dependencies 
in the planning console  for examples.

Alternatively, you can create a relationship 
between two tasks by connecting the ends of 
the corresponding task bars in the timeline 
view.

Select a baseline Select the more options icon, and then select 
a baseline from the baselines list.

Create a baseline Select the more options icon, and then select 
Create new baseline. See Create baseline of a 
project  for more information.

Compare schedule baselines Select the more options icon, and then select 
a schedule baseline from the baselines list. 
Select the show or hide columns in gantt 
icon, and then select the following columns to 
compare schedule baselines:

• Baseline start date

• Baseline end date

• Baseline variance

Display the critical path Select the critical path icon. For more 
information on the critical path, see Gantt 
chart.

Show date change Select the more options icon, and then select 
the Show Date Change  switch. When this 
option is enabled, the start and end dates of 
the task are displayed when you drag the task 
bar.

Show duration change Select the more options icon (), and then 
select the Show Duration Change  switch. 
When this option is enabled, the duration of 
the task is displayed when you drag either end 
of the task bar.

Show weekends on the calendar Select the more options icon, and then select 
the Show Weekends  switch. The weekends 
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Gantt chart tasks  (continued)

Task How to perform the task

appear as light-blue vertical bars in the Gantt 
chart.

Zoom the calendar in or out On the top of the calendar, select one of the 
time periods, such as the month or day. Then 
select a Zoom Level  from the calendar.When 
the zoom level in calendar is selected as Auto 
Fit, the Gantt view fits in one page to display 
the entire timeline for the project in one go 
without using the scrollbar.

Open the tutorial Select the more options icon (), and then 
select Walkthrough.

Open list of keyboard shortcuts Select the more options icon, and then select 
Keyboard Shortcuts.

Other features or applications tasks

Task How to perform the task

Open the project workbench Select the Planning Console  selection arrow 
on the banner and select Project Workbench. 
For more information, see Using Project 
workbench - Legacy.

Open live feed Select the more options icon, and then select 
Show live feed.

Export project data in MPP, CSV, or XML format Select the more options icon, and then 
select Export Planning Console. For more 
information, see Export project data.

Print the gantt timeline Select the more options icon, and then select 
Print.

Note: 

• Printing on a smaller paper size might 
result in the gantt chart image being 
cut off. You may either zoom out using 
the gantt chart calendar, or increase 
paper size to print the gantt timeline for 
projects and tasks.

• If the colored bars in gantt chart area 
are not visible in Print preview, then 
select the option for background 
graphics in the Print dialog.

Related topics

Using Planning console - Legacy
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Client side planning console

During calculation of project schedule in the planning console, it is possible to build your project 
structure quickly on the client side (browser) without having to save details in the server for each 
interaction. It prevents any time lags that occur after you perform any actions in the planning 
console, and improves the scheduling performance.

For example, when a project manager changes dates on a project task in the planning console, 
re-calculating the dates for the dependent tasks and the project can cause time lag if each 
interaction is saved to the server. Similarly, when a new task or a dependency is created, there 
can be a time lag before the new dates are displayed if they are saved on the server side each 
time.

When client side planning is enabled, the changes such as re-calculation of dates are not posted 
to the server immediately. All the changes in planning console are kept on client side until the 
user explicitly saves the changes to be committed to the server.

Exceptions

There are a few actions for which you must save your changes immediately to the server side 
before proceeding such as:

• Create baseline

• Copy project

• Copy partial project

• Add child tasks

• Add external dependency

• Edit Assigned to

• Edit Additional Assignees

In addition, if you enable custom business rules on any of the columns, those columns are also 
part of exceptions.

Related topics

Using Planning console - Legacy

Enable client side planning

Enable client side planning in planning console to enable project scheduling at the client side.

Before you begin
Role required: pps_admin

About this task
Build your project structure quickly on the client side without having to save details in the server 
for each interaction in planning console.

Procedure

1. Navigate to All  > Project Administration  > Settings  > Planning Console.

2. In the Planning Console list, expand Context: default  and select Project[pm_project].

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1411



3. Select the Enable Client Side Planning  check box to enable project scheduling at client side.

Note: 
To enable this check box, the project property  Enable firing of Business Rules on save 
from Planning Console  must be set to false.

Related topics

Using Planning console - Legacy

Gantt chart

A Gantt chart on the planning console is a visual representation of a project timeline that shows 
start and end dates of tasks, and the dependencies between tasks.

Use Gantt charts to add and delete tasks, change task dates and dependencies, and assess the 
progress of the overall project.

The critical path
The critical path is highlighted in red on the Gantt chart to differentiate critical path tasks from 
standard tasks in blue. Not all tasks are part of the critical path, only those tasks that directly 
affect the finish date. Use the critical path to determine which tasks are driving the finish date. If 
schedule adjustments are necessary, consider making resource or other changes to those tasks 
on the critical path.

The tasks that are not part of the critical path and can therefore be delayed are commonly called 
slack  or float  tasks. The Gantt chart shows the slack/float tasks by default, but calculations that 
deal with these tasks, such as how long they can be delayed without impacting the project, is not 
available.

Milestones
A milestone is a project task with a duration of 0. Use milestones to indicate important dates in a 
project. If necessary, create dependencies between tasks and milestones so that a task does not 
start until a milestone has been reached.

Color coding
The colors of the task bars on the Gantt chart are based on the percent complete and state of the 
task. The default color coding available for project and tasks is shown:

Color coding of project tasks

Color Explanation

Light blue 
bar

Task is pending or open.

Dark blue 
bar (full or 
partial)

The percentage complete is between 1% and 100%. The dark blue section 
indicates the percentage complete. The task can be in the Work in Progress state 
or Completed state.

Note: 
The colors of the task bars on the Gantt chart can be configured from program  workbench.

SDLC phases
Icons appear next to tasks to indicate what phase they belong to.
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Phase icons

Icon Phase

Agile phase icon Agile phase.

Testing phase icon Testing phase.

Note: 
Tasks in the waterfall phase do not display an icon.

Gantt chart options

Use the Gantt chart to quickly change task attributes, such as start and end time, rather than 
opening every Task form and modifying field values one by one.

From a Gantt chart, you can modify the following task attributes:

Modify tasks

Attribute Description

Planned 
start date for 
project tasks

Move the task along the timeline to change the start time and to impose a 
Time constraint  of Start on a specific date. You can also drag a task to change 
its start date if the task Time constraint  is set to Start on a specific date  (not 
Start ASAP) and the task has not yet started. The start date of a task cannot 
be modified if the task already started (has an actual start date), the task has 
already ended (has an actual end date), or the task time constraint is set to 
Start ASAP.

You can also modify the dates in the Planned start date  column on the 
console.

Planned start 
date for the 
project

Modify the dates in the Planned start date  column on the console.

You can add tasks that start earlier than the project's planned start date. By 
default, the planned start date shifts earlier or later when you add tasks to align 
with the earliest task start date. However, you can enable the project property 
Rollup project start date from tasks  to retain the planned start date of the 
project even if you add tasks with a planned start date that is earlier or later.

Planned end 
date Drag the right edge of the task bar to extend the planned end date. You can 

extend the planned of date only for tasks that are not parent tasks and that 
have not yet ended.

Dependencies To edit or delete a dependency, double-click an existing dependency 
connector line between two tasks and update the settings in the Planned Task 
Relationship popup. The relationship Type  for planned tasks is Predecessor 
of::Successor of  and should not be changed.

Lag time and 
lead time

Lag time is an interval of time between the end of a predecessor task and the 
start of a successor task. The lag time delays the predecessor by an amount 
that you specify.

Lead time is an interval of time that the predecessor task is allowed to start 
before it normally would. It is essentially a negative lag time. The value in the 
Lag  field specifies both lag and lead time.
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Modify tasks  (continued)

Attribute Description

To edit the Lag  value, double-click a connector and update the settings in the 
Planned Task Relationship form. Enter a negative value to specify a lead time.

Resources To change a user resource for an existing task or add a resource to a new task, 
double-click the task bar and edit the Assigned to  field in the Project Task 
form.

Note: 
The resources in Assigned to  column can be constrained to be derived 
only from the allocated resource plans associated with the project or any 
of its task.

The Project Management  application provides several properties that control how tasks are 
calculated and behave. See Project property  for more information.

Create a parent-child relationship on the planning console

The WBS section of the planning console allows you to create parent-child relationships for new 
tasks or move around existing tasks in a new parent-child relationship. The position of a task in 
the hierarchy and the level of indentation determine the parent-child relationship it has with the 
tasks above or below it.

Before you begin
Role required: it_project_manager

About this task
In this example, the System Readiness Assessment task is a child of the Planning task because it 
is one level below the Planning task and is indented.

Parent-child relation for tasks

Procedure

1. Select a task in the WBS section of the planning console to highlight it.

2. Select a combination of any of the following icons to create the task and move it or move the 
other tasks to create the required hierarchy:

Creating parent-child relationships

Icon Action

Add task above icon ( ) Create a task above the highlighted task.

Add task below icon ( ) Create a task below the highlighted task.

Indent icon ( ) Makes the highlighted task a child of the task above it.
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Related topics

Using Planning console - Legacy

Predecessor dependencies in the planning console

In the WBS section of the planning console, you can create dependencies between tasks by 
specifying a series of values.

The Predecessor  column on the planning console can specify dependencies between tasks. 
The values that you put in this column must be in the following format:

{WBS_number}{dependency_type}+{lag_time}

Where

• WBS_number  is the number of the predecessor task in the relationship.

• dependency_type  is one of the types of dependencies  that the application supports.

• lag_time  is the amount of time, in days, to delay the start of the dependent task. This value 
can be positive or negative integers.

The values are entered without the curly braces {}. See the examples in the table.

Note: 
You can also edit tasks from the Gantt chart by clicking the relationship line. See Gantt 
chart options  and Modify a project task dependency  for details.

Project task dependency values

Dependency type Example Additional information

Finish to start 1.1fs+0 The task you are editing starts when task 1.1 is finished.

Start to start 1.1ss+0 Task 1.1 cannot finish until the task you are editing finishes.

Start to finish 1.1sf+0 Task 1.1 cannot start until the task you are editing finishes.

Finish to finish 1.1ff+0 The task you are editing cannot finish until task 1.1 finishes.

Related topics

Using Planning console - Legacy

Custom columns in the planning console

In addition to the regular columns that are provided in the base system, as the PPS admin, you 
can configure which columns appear in the planning console.

You can define the columns that are available in the project planning console, program 
workbench, planning, and tracking views in portfolio workbench, and the release management 
Gantt chart. From this list of defined columns, you can select the columns that you want to view 
in these planning console UIs at any time.

These tables are used for custom column configuration:

• Planning Console [pm_console]: Stores the definition for planning consoles such as Project 
and Portfolio.

• Planning Console Display Column [pm_console_display_column]: Stores the planning 
console display columns such as Short Description, WBS, and Priority.
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A console stored in [pm_console]  has multiple display columns that are stored in 
[pm_console_display_column].

Note: 
You cannot edit list of column if the column refers to a table other than the [sys_user] 
table.

• Planning Console Table [pm_console_table]: Contains a list of tables which provide data to a 
console.

A console sources the data from multiple tables. For example, Project console 
[pm_project]  pulls data from pm_project  and pm_project_task  table. This list of 
tables is maintained in [pm_console_table].

• Planning Console Column [pm_console_columnn]: Maintains the columns that should be 
pulled from each table and the mapping of the column in pm_console_display_column.

Related topics

Using Planning console - Legacy

Add a custom column to the planning console

Define the columns that you want to make available in the project planning console, portfolio 
workbench, program workbench, and the release management Gantt chart.

Before you begin
Role required: it_pps_admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Planning Console.

2. Add a custom display column for planning console.

a. In the Planning Console list, select a console to which you want to add the custom column.
For example, select Project[pm_project]  to add a column to the project planning 
console.

b. To create a display column for the selected console, select New  in the Planning Console 
Display Column  related list.

c. On the Planning Console Display Column form, fill in the fields.

Planning Console Display Column form

Field Description

Label Label for the column to be displayed in the planning console.

Type Data type of the column.

JSON 
Column

The JSON column name used internally by the Gantt chart when data is 
sent.

Note: 
Leave blank. This field is auto-populated when you add a column for 
the display column in step 3.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1416



Field Description

Order Position at which the column appears in the planning console.

Include in 
Tooltip

Check box for the column to be shown in tooltip in timeline in the planning 
console.

Width Default width of the column in planning console.

Fire BR on 
Save

Option if the business rules should be triggered when the column is 
modified in the planning console.

Note: 
The field is not visible on the form by default. Configure the form to add 
this field.

Trigger 
recalculation

Option if the recalculation of date and duration should be triggered when 
the column is modified in the planning console.

Note: 
The field is not visible on the form by default. Configure the form to add 
this field.

d. Select Submit.

The column is added in the Planning Console Display Column 
[pm_console_display_column]  table.

3. Map the planning console display column created in step 2 to a column in a table defined in 
Planning Console Table [pm_console_table].

a. In the Planning Console Display Column  related list, open the display column record.

b. To create a record of actual column in the Planning Console Column 
[pm_console_column]  table, select New  in Planning Console Columns  related list.

c. On the Planning Console Column form, fill in the fields.

Planning Console Column form

Field Description

Display 
Column

Display column created in the Planning Console Display Column 
[pm_console_display_column]  table.

Console 
Table

Console table to be mapped to the display column.

Table Actual table from where the data is pulled in the display column. The field is auto-
populated when you select a Console Table.

For example, select a table from [pm_project]  or [pm_project_task] 
for a display column added in the Project planning console Project 
[pm_project].

Column Actual column in the Table  from where data comes for the display column.
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Field Description

Editable Check box to make the column editable in the planning console.

d. Select Submit.

Result

The display column appears in the column filter list ( ) in the planning console.

Related topics

Using Planning console - Legacy

Create a dependency from the planning console

Create a dependency between two tasks on the planning console.

Before you begin
Role required: it_project_manager

About this task
You can create any type of dependency. See Parent-child rollup task calculations  for an 
explanation of each type.

You can also create dependencies by using the Predecessor column on the Planning Console. 
See Predecessor dependencies in the planning console  for more information.

Procedure

1. Select a task on the Gantt chart portion of the planning console.
A white circle appears on either end of the task, one at the start of the task and the other at the 
end of the task.

2. To create a dependency, select one of the white circles and drag it to the start or end of 
another task.

3. Double-click the dependency line to see the dependency on the Planned Task Relationship 
form.

4. Confirm that your dependency is correct.
You can make changes to the dependency  as needed.

Related topics

Modify a project task dependency

Add an external dependency on planning console

Add an external dependency between two projects on the planning console. Use the work 
breakdown structure (WBS) column of the planning console to create a dependency between 
the different projects tasks.

Before you begin
Role required: it_project_manager

Procedure

1. Right-click a task in the WBS column of the planning console.

2. Select Add External Dependency.

3. On the Add dependency form, fill in the following fields:
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◦ Project: The predecessor project that the dependency is added from.

◦ Task: The task in the predecessor project that the dependency is added from.

◦ Dependency Type: The type  of external dependency: Hard  or Soft.

4. Select OK.

Result

• A shadow task corresponding to the predecessor task appears in the WBS section of the 
planning console of the successor project. A similar shadow task corresponding to the 
successor task appears in the WBS section of the planning console of the predecessor 
project.

A shadow task is shown as a grayed out task in WBS column.

• A shadow task corresponding to the predecessor task appears in the Project Tasks  related 
list on the successor project form. A similar shadow task for the successor task appears in the 
Project Tasks  related list on the predecessor project form.

• The Dependency  column in WBS column of the planning console of the successor project 
shows the external dependency value between the projects and tasks. The external 
dependency value has the following format:

{project_number}\{WBS_number}{dependency_type}+{lag_time}

Where

◦ project_number  is the number of the predecessor project.

◦ WBS_number  is the number of the predecessor task in the relationship.

◦ dependency_type  is the finish to start  dependency type that the application supports.

◦ lag_time  is the amount of time, in days, to delay the start of the dependent task. This 
value can be positive or negative integers.

Note: 
The external dependencies are displayed only when the Hide External Dependencies 
switch on the planning console  is turned off. However, the Dependency  column in the WBS 
section of the successor project still shows the value of the external dependency.

Example:
In the example below, an external dependency is created between two projects P1 and P2. P1T1 
is a shadow task of predecessor project P1, and PRJ0010127\1fs+0 is the external dependency 
value in the Dependency  column of the planning console of the successor project P2.

What to do next
Check for any external dependency related notifications  that may impact the project or its tasks.
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Modify a project task dependency

Modify a dependency when editing the tasks that are linked in the dependency, the dependency 
type, or the lag time.

Before you begin
Role required: it_project_manager

About this task
Project task dependencies are saved on the Planned Task Relationship 
[planned_task_rel_planned_task] table. You can access dependencies from the planning 
console.

Procedure

1. Double-click a dependency on the Gantt chart of the planning console.

2. On the form, fill in the details.

For more information, see Planned Task Relationship form.

Planned Task Relationship form

3. Select Update.

You can view dependencies in the Project Task related list on a Project or Project Task form 
and from the Project Tasks list on the workbench. These columns show the dependencies:

◦ The Dependency  column shows the successor task in the relationship.

◦ The Dependencies  column shows the dependency value. See Predecessor dependencies 
in the planning console  for a description of what you see in this column.

Related topics

Create a dependency from the planning console

Remove a dependency

Remove a dependency

Use the planning console to remove a dependency that is no longer necessary.

Before you begin
Role required: it_project_manager

About this task
Removing the dependency also deletes the dependency record in the Planned Task 
Relationship table.
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Procedure

1. Open the project in the planning console.

2. Do either of the following.

Option Description

On the Gantt chart

◦ Right-click the relationship and then select 
Delete Link.

◦ Double-click the relationship and then se­
lect Delete  on the Planned Task Relation­
ship  form that appears.

On the WBS list

◦ Delete the value in the Predecessor  col­
umn.

◦ Select the value in the Predecessor  col­
umn and then select Delete  on the Planned 
Task Relationship  form that appears.

Related topics

Modify a project task dependency

Create a dependency from the planning console

Train the similarity solution for Project Management  to find similar projects

Train the Similar Projects solution definition included within the Predictive Intelligence for PPM 
capability to find related projects when defining a project.

Before you begin
Ensure that the Predictive Intelligence for Contextual Search plugin 
(com.snc.contextual_search_ml), PPM Standard plugin (com.snc.financial_planning_pmo), and 
Predictive Intelligence for PPM plugin (com.snc.ppm_ml) are activated. For more information 
about Predictive Intelligence, see Predictive Intelligence .

Role required: admin

Procedure

1. Navigate to All  > Predictive Intelligence  > Similarity  > Solution Definitions.

2. In the Similarity Definitions list, search for and select the Similar Projects solution definition 
(ml_sn_global_global_similar_projects).

3. On the Similarity Definition form, verify the default field values for projects.
For more information about the Similarity Definition form fields, see Create and train a similarity 
solution .

4. Click Update & Retrain.

5. Open the Similarity Definition form for the Similar Projects solution definition 
(ml_sn_global_global_similar_projects).

6. In the ML Solutions related list, view the training solution progress in the Progress  column.

Note: 
Alternatively, you can click the link for the solution in the Active  column. On the ML 
Solution form, click the Show training progress  related link to check the training solution 
progress.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1421

https://www.servicenow.com/docs/access?context=predictive-intelligence&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=predictive-intelligence&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=predictive-intelligence&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-similarity-solution&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-similarity-solution&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-similarity-solution&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-similarity-solution&version=zurich&pubname=zurich-intelligent-experiences&ft:locale=en-US


Result
When the solution is complete, the similar projects appear in the Similar projects section on the 
Project form.

What to do next

• Review similarity examples: On the Similarity Definition form, in the ML Solutions related list, 
when Progress  is 100%, in the Active  column, click the link for the solution. On the ML Solution 
form, click the Similarity Examples  related link to view the Similarity Examples list.

• Update the similarity score threshold: On the ML Solution form, on the Solution Statistics  tab, 
enter the required value in the Similarity Score Threshold  field. Right-click the ML Solution 
form and click Save.

• Test the prediction output for the records: On the ML Solution form, on the Test solution  tab, 
enter your text in the Short description  field and the maximum number of expected results in 
the Top N  field, and then click Run test. The results above the similarity score threshold value 
are displayed.

Related topics

Predictive Intelligence

Predictive Intelligence for Project Management

Starting a project

Collaborate with your project teams using PPM Collaboration application

Collaborate with your project team on a common enterprise messaging platform such as 
Slack or Microsoft Teams using the PPM Collaboration application. Facilitate active and timely 
communication about the project among the project's team members, be involved in critical 
discussions on your project, and receive real-time updates on the project's status.

By using a project-specific channel on Slack, or a team on Microsoft Teams, decisions taken or 
updates made for the project would effectively reach all the team members. The team would 
have easy access to its past communication through the chat history and shared project 
documents all at one place. By doing so, the project manager and the team members can save 
the time spent on emails and other offline communication.

PPM Collaboration advantages

A project collaboration channel or team provides the following advantages for the project 
managers and the team members:

PPM Collaboration advantages for project managers and team members

Project Manager Team member

• Start your day with a detailed status of the 
project that you're managing

• Using the status details, choose to follow up 
with relevant team members through your 
preferred mode of communication

• Open the project directly from the 
collaboration channel or team to drill down 
into further details

• Communicate with the team members to 
resolve an issue you're facing

• Receive status updates from the team 
members

• Contribute to the discussions regarding the 
project
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• Real-time updates on changes to milestones, risks, issues, decisions, actions, and change 
requests (RIDAC), and project financials.

• Automatic addition and removal of members of the collaboration channel or team based on 
who the project tasks are assigned to.

Note: 
PPM Collaboration is not supported for teamspaces.

Related topics

Install PPM Collaboration

Install PPM Collaboration

Install the PPM Collaboration (sn_ppm_collab) application from ServiceNow Store.

Before you begin

• Complete the following setup checklist for a smooth installation and configuration.

Note: 
If you are enabling collaboration with Slack, the Slack spoke v2 plugin must be activated. 
If you are enabling collaboration with Microsoft Teams, the Microsoft Teams Graph and 
Microsoft Azure AD spokes must be activated. Collaboration cannot be enabled for both 
Slack and Microsoft Teams for the same project.

Setup checklist

Setup tasks Description

Verify that the PPM Standard 
(com.snc.financial_planning_pmo) plugin is 
activated.

Navigate to All  > Subscription Management 
> Subscriptions  in your instance. The 
list displays the subscriptions that your 
organization has purchased.

Verify that the Slack spoke v2 
(sn_slack_ah_v2) plugin is activated, for 
collaboration with Slack.

Navigate to All  > Subscription Management 
> Subscriptions  in your instance. The 
list displays the subscriptions that your 
organization has purchased.

Verify that the Microsoft Teams Graph spoke 
(sn_msteams_ahv2) plugin is activated, for 
collaboration with Microsoft Teams.

Navigate to All  > Subscription Management 
> Subscriptions  in your instance. The 
list displays the subscriptions that your 
organization has purchased.

Verify that the Microsoft Azure AD spoke 
(com.sn.azure_ad.spoke) plugin is activated, 
for collaboration with Microsoft Teams.

Navigate to All  > Subscription Management 
> Subscriptions  in your instance. The 
list displays the subscriptions that your 
organization has purchased.

Note: 
Activation of the PPM Standard, Microsoft Teams, and Slack spoke plugins on production 
instances may require separate licenses. Contact ServiceNow  Customer Support for 
details.

• Ensure that the PPM Collaboration application and all of its associated store applications have 
valid ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow 
product or application .
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Role required: admin

Procedure

1. Navigate to the ServiceNow Store .

2. In the ServiceNow Store, search for PPM Collaboration.

3. Select the application tile.
You can view detailed information about the application. Consider reading the Other 
Requirements and Dependencies sections, as applicable.

4. Select Get  and enter your Now Support  login credentials.

5. Select Request Install.

6. In the Instance Name  field, enter your details and select Validate Instance.

7. In the Reason for the Instance  field, enter your details and select Request.
You receive an email with detailed installation instructions.

8. Log in to the instance on which you want to install the PPM Collaboration application.

9. Select System Applications  > All Available Applications  > All.

10. Locate the application using the filter criteria and search bar, select it, and select Install.

Result
The following components are installed with installation of the application:

• Roles

• Tables

For more information, see Components installed with PPM Collaboration.

What to do next
Setting up PPM collaboration for Slack.

Components installed with PPM Collaboration

Roles and tables are installed with activation of the PPM Collaboration application.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role Description

Collaboration user

[SN_collab_common.collab_user]

Users with this role have read-only access to 
the Entity Channel table.

This role is automatically assigned to project 
managers and task assignees.

Collaboration owner

[SN_collab_common.collab_owner]

Users with this role have complete create, 
read, update, and delete access to the Entity 
Channel table.
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Role Description

This role is automatically assigned to project 
managers.

Tables installed

Table Description

Entity Channel

[sn_collab_common_entity_channel]

Stores the list of IDs and names of the Slack channels 
that are created for the projects.

Related topics

Install PPM Collaboration

Collaborate with your project teams using PPM Collaboration application

Setting up PPM collaboration for Microsoft Teams

Integrate your ServiceNow  instance with your organization's Microsoft Teams to enable 
collaboration of your projects in Microsoft Teams.

PPM Collaboration uses the Microsoft Teams Graph and Microsoft Azure AD spoke actions such 
as creating a team for your project, adding or removing your project team members, archiving 
the team when the project is closed, posting a message when a record is updated, and so on. To 
enable these spoke actions, you must integrate your ServiceNow  instance with Microsoft Teams 
Graph and Microsoft Azure AD to authenticate ServiceNow  requests. For more information, see 
the Set up Microsoft Teams Graph spoke  and Set up Microsoft Azure AD spoke  topics.

Important: 
When you activate the Microsoft Teams Graph and Microsoft Azure AD spokes, a 
Connection & Credential alias  for Microsoft Teams Graph and Microsoft Azure AD is 
created by default with the IDs sn_msteams_ahv2.Microsoft_Teams_Spoke  and 
sn_azure_ad_spoke.AzureAD  respectively. The connection that is active (the Active 
field is set to true) in Connections related list of this alias uses this default ID to connect 
your ServiceNow  instance to Microsoft Teams Graph and Microsoft Azure AD. Therefore, 
you can have multiple connections associated with this alias but ensure that only one 
connection is active at any given time.

Setting up PPM collaboration for Slack

Integrate your ServiceNow  instance with your organization's Slack to enable collaboration of your 
projects in Slack.

PPM Collaboration uses the Slack spoke actions such as creating a channel for your project, 
adding or removing your project team members, archiving the channel when the project is 
closed, posting a message when a record is updated, and so on. To enable these spoke actions, 
you must integrate your ServiceNow  instance with Slack to authenticate ServiceNow  requests. 
For more information, see Set up Slack spoke .

Important: 
When you activate Slack spoke, a Connection & Credential alias  for Slack is created 
by default with the ID sn_slack_ah_v2.Slack. The connection that is active (the 
Active field is set to true) in Connections related list of this alias uses this default ID to 
connect your ServiceNow  instance to Slack. Therefore, you can have multiple connections 
associated with this alias but ensure that only one connection is active at any given time.
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Related topics

Slack spoke v2

Setting up PPM collaboration for Microsoft Teams

Flows designed to synchronize projects with your collaboration tool

Understand the flows designed for the PPM Collaboration application so that you can edit the 
configurations as required.

PPM Collaboration flows

Slack Flow [Name]
Microsoft Teams Flow 
[Name]

Description

Action Slack

[action_slack]

Action Teams

[action_teams]

Posts a message to the project channel or team 
whenever an Action is created with priority 1-
Critical  or 2-High  or if the priority of an existing 
Action is updated to 1-Critical  or 2-High.

Add Assigned Users 
To Channel

[add_assigned_users_to_channel]

Add Assigned Users 
To MS Group

[add_assigned_users_to_ms_group]

Handles adding the users in the Assigned to 
or Additional Assignee list  fields of the project 
tasks to the project channel or team.

Archive Project 
Channel

[archive_project_channel]

Archive MS Group

[archive_group]

Handles archival of the project channel or team 
based on the count of number of days from 
which the project is moved to a closed state. This 
flow is set to run daily at 08:00 AM.

Change Request 
Slack

[cr_updated_slack]

Change Request 
Teams

[change_request_teams]

Posts a message to the project channel or team 
whenever a Change request with priority 1-
Critical  or 2-High  is created or if the priority of an 
existing Change request record is updated to 1-
Critical  or 2-High.

Daily Project Status 
Slack

[daily_project_status]

Daily Project Status 
Teams

[daily_project_status_teams]

Triggers a message about the overall status 
of the project to the project channel or team 
everyday at 08:00 AM.

Decision Slack

[decision_updated_slack]

Decision Teams

[decision_teams]

Posts a message to the project channel or team 
whenever a Decision with priority 1-Critical  or 
2-High  is created or if the priority of an existing 
Decision is updated to 1-Critical  or 2-High.

Issue Slack

[issue_updated_slack]

Issue Teams

[issue_teams]

Posts a message to the project channel or team 
whenever an Issue with priority 1-Critical  or 2-
High  is created or if the priority of an existing 
Issue is updated to 1-Critical  or 2-High.

Milestone/
KeyMilestone Slack

[milestonekeymilestone]

Milestone/
KeyMilestone Teams

[milestonekeymilestone_teams]

Posts a message to the project channel or team 
whenever a Milestone or a Key Milestone task is 
moved to the closed state.

Project Manager 
Changes Slack

[project_manager_changes]

Project Manager 
Changes MS Teams

[project_manager_changes_ms_teams]

Handles adding the new project manager as a 
member to the project channel or team. This flow 
also checks if the user who was the old project 
manager is assigned to any project tasks and if 
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PPM Collaboration flows  (continued)

Slack Flow [Name]
Microsoft Teams Flow 
[Name]

Description

not assigned to any task, removes the user from 
the channel.

Project Status Slack

[project_status_slack]

Project Status Teams

[project_status_teams]

Posts a message to the project channel or team 
in the following three scenarios:

• State  field is updated to Closed Complete, 
Closed Incomplete, or Close Skipped states

• Status  fields is updated

• Project manager changes for this project

Risk Flow Slack

[risk_created_slack]

Risk Flow Teams

[risk_created_teams]

Posts a message to the project channel or 
team whenever a Risk with probability High  or 
Absolute  is created or if the probability of an 
existing risk is updated to High  or Absolute.

All the flows, except the subflows, are inactive by default. Enable the collaboration between 
PPM and Slack or Microsoft Teams for a specific action by activating these flows. You can view 
all these flows by navigating to Flow Designer  > Designer  and filtering the flows by the PPM 
collaboration application. For more information, see Activate a flow .

If you want to update the configuration for any of these flows, you can edit them. For example, 
if you want to update the time of daily status update from 8:00 AM to 9:00 AM, you can 
edit the Daily Project Status Slack [daily_project_status] or Daily Project Status Teams 
[daily_project_status_teams] flow. For more information, see Edit a flow .

Related topics

Flow Designer

Flows

Create a Microsoft team for your project

Create a Microsoft team for your project to start collaborating with your team and receive timely 
updates of the project.

Before you begin
Ensure that the project for which you want to create a team is active and not in a closed state.

Role required: it_project_manager

Important: 
You must be the designated project manager for this project in addition to having the 
it_project_manager role.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open the project for which you want to create a team.
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Ensure that you are the project manager for the project you open.

3. Enable collaboration for the project by selecting the Enable MS Teams Collaboration  related 
link.

Result

• A Microsoft team is created for the project. You can see the team's name in the success 
message on your project form. You can also view a link in the project form to access your MS 
team group, selecting on the link will navigate you to the MS team group for your project.

• You and the administrator are added as owners in the team.

• Any assignees and additional assignees of active project tasks for this project are added as 
members to this team.

Assignees and additional assignees of project tasks that you create later will be automatically 
added as members to this team if you enable the Add Assigned Users To MS Group flow. 
However, new or existing stakeholders added to the project are not added as members to this 
channel.

Note: 
Users assigned to the tasks (assignee and additional assignee) from Planning Console 
will not be added automatically to the Microsoft team.

• Once a team is successfully created for a project, the Enable MS Teams Collaboration 
related link is removed from that project. Collaboration cannot be enabled for both Slack 
and Microsoft Teams for the same project. If you have selected on the Enable MS Teams 
Collaboration  related link for a project, and you select the Enable Slack Collaboration  related 
link before the MS team is created, a message will be displayed specifying that MS Teams 
creation is in progress.

If you are unable to create a team, retry the procedure after sometime. If the issue persists, 
contact your system administrator.

Related topics

Collaborate with your project teams using PPM Collaboration application

Create a Slack channel for your project

Create a Slack channel for your project to start collaborating with your team and receive timely 
updates of the project.

Before you begin
Ensure that the project for which you want to create a Slack channel is active and not in a closed 
state.

Role required: it_project_manager

Important: 
You must be the designated project manager for this project in addition to having the 
it_project_manager role.

Procedure

1. Navigate to All  > Project  > Projects  > All.

2. Open the project for which you want to create a Slack channel.
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Ensure that you are the project manager for the project you open.

3. Enable collaboration for the project by selecting the Enable Slack Collaboration  related link.

Result

• A channel in Slack is created for this project. You can see the channel's name in the success 
message on your project form. You can also view a link in the project form to access your Slack 
channel, selecting on the link will navigate you to the Slack channel for your project.

• You and any existing assignees and additional assignees of active project tasks for this project 
are added as members to this channel.

Assignees and additional assignees of project tasks that you create later will be automatically 
added as members to this channel if you enable the Add Assigned Users To Channel flow. 
However, new or existing stakeholders added to the project are not added as members to this 
channel.

Note: 
Users assigned to the tasks (assignee and additional assignee) from Planning Console 
will not be added automatically to the Slack channel.

• Once a channel is successfully created for a project, the Enable Slack Collaboration  related 
link is removed from that project. Collaboration cannot be enabled for both Slack and 
Microsoft Teams for the same project. If you have selected on the Enable Slack Collaboration 
related link for a project, and you select the Enable MS Teams Collaboration  related link 
before the Slack channel is created, a message will be displayed specifying that Slack channel 
creation is in progress.

If you are unable to create a channel, retry the procedure after sometime. If the issue persists, 
contact your system administrator.

Related topics

Collaborate with your project teams using PPM Collaboration application

Notifications for project updates in your collaboration tool

Receive updates related to your project on your Slack channel or Microsoft team. Analyze the 
delayed and overdue tasks, follow closure of milestones, and monitor changes to risk, issue, 
decision, action, and change request (RIDAC) items of your project.

Using the automatic project status updates on the project collaboration channel or team, 
project managers can take informed decisions about project planning, resource management, 
finance allocation. The team members can understand updates made to the project and actively 
collaborate on any delayed or overdue tasks.

Note: 
Project managers can reach out to their system administrators to configure the application 
settings for these notifications according to their preferences.

Daily notification on project status

A notification with the consolidated project status is sent to the project's channel daily at 8:00 
AM which consists of the following information.

Project overview

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1429



• A direct URL of the project. Selecting this URL opens the project in your 
ServiceNow  instance.

• Name of the project.

• Planned start and end dates of the project.

• State of the project, for example, Work in Progress.

• Status of the project, for example, Green.

• Percentage of project completion.

Project tasks due today

List of project tasks that have planned end date marked as today and are in the 
Work in Progress state. The list displays only five project tasks that are sorted 
alphabetically by their short description.

Overdue tasks

List of project tasks which have a planned start date before today but are not in 
either the Work in Progress or Closed states. The list displays only five project tasks 
that are sorted in an ascending order of the planned start dates so that you get high 
visibility into the tasks that are overdue for a longer period.

Delayed tasks

List of project tasks which have a planned start date before today and are in the 
Work in Progress state. The list displays only five project tasks that are sorted in 
ascending order of the planned end dates so that you get high visibility into the 
tasks that have been delayed for a longer period.

Project tasks due within seven days

List of five of the following project tasks that have a planned end date within seven 
days from today. All these tasks are displayed in ascending order of their due dates 
so that you get high visibility into the tasks that are due soon.

Note: 
Tasks that in Closed state are not displayed in the list.

• High priority risks, issues, and action items

• Milestone or key milestone tasks

Other updates

Notifications are sent to the project channel for the following scenarios.

• Cost estimate at completion (EAC) exceeds the planned cost of the project

• Planned end date is later than the approved end date

• Project did not start on the planned start date

• Project is not complete by the planned end date

Notification regarding change of project manager

When there is a change in the manager of your project, an update is made to the Project 
manager field of the project record.
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• A notification including the project URL is sent to your project channel on this update.

• New project manager is added as a member of the channel.

• If no project tasks are assigned to the old project manager, this user is removed as a member 
of the channel.

Notification for other updates to the project

Project's status

When an update is made to the Status field of the project, a notification including 
the project URL is sent to your project channel.

RIDAC records

You receive notifications in your project channel when a new RIDAC record is added 
to or an existing RIDAC record is updated in the project for the following scenarios. 
With every notification, you receive a direct URL to the corresponding record.

• Risk

◦ New risk is created with the priority field set to High  or Absolute

◦ Updates are made to the State or Risk status fields for an existing risk

• Issue, Decision, Action, and Change request

◦ New record is created with the priority field set to 1-Critical  or 2-High

◦ Priority of an existing record is updated to 1-Critical  or 2-High

Milestones

Whenever a key milestone is closed, you are notified about the closure and the user 
who closed it, with a direct URL to the milestone task.

Related topics

Collaborate with your project teams using PPM Collaboration application

Archiving your project collaboration channel or team

Understand how your project Slack channel or Microsoft team is archived when your project is 
moved to a closed state.

Moving the project to a closed state

When the project manager moves the project to Closed Complete, Closed Incomplete, or Closed 
skipped state, the following actions are triggered:

• A notification about project closure is sent to the channel or team immediately.

• The channel or team is archived within 15 days from the day the project is moved to a closed 
state.

This duration of 15 days helps the project members to bring any pending communication to 
closure or share any pending project documentation.

Project managers can contact their administrator to update this duration of 15 days to a value 
of their choice.
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Deletion of a project task

When a project task is deleted, the members in the corresponding Slack channel or Microsoft 
team are not removed automatically. To remove the members on deletion of a project task, you 
must enable the Remove Users From Slack/Teams Channel  business rule. This business rule 
is created on the Project Task table and is not enabled by default. For more information, see 
Business rules .

Deletion of the project channel or team

If the channel is deleted in the Slack application, or the team is deleted in the Microsoft Teams 
application, the PPM Collaboration application does not handle the deletion of the project's 
reference in the Entity Channel [sn_collab_common_entity_channel] table automatically. So, the 
project manager cannot see the Enable Slack Collaboration  or Enable MS Teams Collaboration 
related link on the project form again.

If the project manager wants to create a channel or team again for this project, administrator 
must manually delete the project's reference from the Entity Channel table. Then, the related link 
to enable collaboration appears on the project form.

Related topics

Collaborate with your project teams using PPM Collaboration application

Virtual Agent for PPM

ServiceNow®  Virtual Agent for PPM enables project managers to get quick answers to business-
related queries by interacting with a virtual agent through various messaging services.

Virtual Agent for PPM helps project managers view business-related information quickly in a 
single step rather than having to navigate through various lists. For example, you can get the list 
of all your project tasks that are overdue.

The base system provides the following predefined Virtual Agent  topics (chatbot conversations):

• Project and Task status

◦ All active projects

◦ Projects with status red

◦ Projects ending next week and % complete less than 60%

◦ Overdue milestones/ key milestones

◦ Overdue tasks

◦ Delayed tasks

• Resources

◦ Resource plans with actual hours greater than allocated hours

◦ Unallocated resource plans starting next week

◦ Unallocated resource plans with requested extension

• Financials

◦ My active projects

◦ Projects with EAC greater than planned cost

◦ Projects with EAC greater than budget

• RIDAC (Risk, Issue, Decision, Action, and Request Changes)
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◦ Absolute and high probability risks due this week

◦ Critical and high priority issues due this week

◦ Critical and high priority action items due this week

• Data quality

◦ Projects without business case

◦ Projects without strategy

◦ Projects without program or portfolio

A topic defines the dialog between the Virtual Agent (chat support bot) and user, which enables 
you to gather information for a specific business need. For more information, see Virtual Agent .

Integration with messaging applications

You can run Virtual Agent bot conversations for PPM using third-party messaging applications 
like Slack or Microsoft Teams.

Use the Virtual Agent integration app to configure the messaging apps for your instance.

For more information, see Virtual Agent integration with messaging apps .

For more information on integrating with Slack or Microsoft Teams, see Setting up Virtual Agent 
notifications .

Related topics

Install Virtual Agent for PPM

Enable Virtual Agent for PPM

PPM Virtual Agent conversation flows

Reusable PPM Virtual Agent topic blocks

Install Virtual Agent for PPM

Install Virtual Agent for PPM from the ServiceNow  store.

Before you begin
Role required: admin

About this task
To install Virtual Agent for PPM, activate the following plugins:

Name Description

PPM Standard 
(com.snc.financial_planning_pmo)

Activates the PPM Standard basic plugin 
for the PPM (Project Portfolio Management) 
applications.

Glide Virtual Agent (com.glide.cs.chatbot) Activates the Virtual Agent framework and 
other necessary plugins.

Virtual Agent for PPM (com.sn_ppm_va) Activates a conversational bot platform 
for providing user assistance through 
conversations within a messaging interface for 
PPM.
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Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find an application, you may 
have to request it from ServiceNow  store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. Select Install.

4. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If there are any plugins or applications that need to be installed, you must 
install them before you can install Virtual Agent for PPM.

5. Optional:  If demo data is available and you want to install it, selectLoad demo data.

(Optional) Demo data comprises sample records that describe application features for 
common use cases. Load demo data when you first install the application on a development or 
test instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

6. Select Install.

Related topics

Virtual Agent for PPM

Enable Virtual Agent for PPM

PPM Virtual Agent conversation flows

Reusable PPM Virtual Agent topic blocks

Enable Virtual Agent for PPM

Enable Virtual Agent for PPM to start chatting with the Virtual Agent.

Before you begin
Role required: admin, virtual_agent_admin
The base system provides predefined Virtual Agent  topics (chatbot conversations). To customize 
a topic, duplicate it and then edit it. See Virtual Agent Designer

Procedure

1. Navigate to All  > Collaboration > Virtual Agent > Designer > Topics.

2. Select the PPM Virtual Agent  card to open it.

◦ To use the provided topic with no changes, select Publish.

◦ To duplicate the topic so you can customize it, select Duplicate. Enter a name for the 
duplicate topic and select Save.
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Related topics

PPM Virtual Agent conversation flows

Reusable PPM Virtual Agent topic blocks

PPM Virtual Agent conversation flows

Virtual Agent for PPM provides several predefined topic conversations to enable project 
managers to gather information on their business-related tasks.

The following predefined topic conversations are available to view if you have the 
it_project_manager role.

Project and task status

Project and task-related information like active projects, projects that are in the red 
state, projects due to end in the near future, and projects with overdue tasks and 
milestones. This information helps you track and plan projects per set milestones.

Resources

Resource-related information such as resource plans containing actual hours 
greater than allocated hours, or unallocated resource plans that are due to start in 
the coming week or have an extension requested. You can then manage resources 
and act on resource plans that are not progressing as planned.

Financials

Finance-related information such as projects where the estimate at completion 
amount is greater than the planned cost or projects where the estimate at 
completion amount is greater than the budget amount. This information helps you 
understand the financial performance of your projects.

RIDAC

RIDAC (Risks, Issues, Decisions, Actions, and Request Changes) related information 
like projects with absolute or high probability risks due in the coming week, or 
projects with critical or high probability issues and actions due in the current week. 
This information helps you analyze and identify patterns, trends, and probable 
resolution for planning future projects.

Data quality

Quality-related information like projects that do not have a business case, strategy, 
program, or portfolio assigned to them. This information helps you evaluate projects 
that are not aligned to any strategy, business case, program, or portfolio.

Related topics

Install Virtual Agent for PPM

Enable Virtual Agent for PPM

Reusable PPM Virtual Agent topic blocks

Reusable PPM Virtual Agent topic blocks

Create and reuse topics blocks to simplify the topic authoring and maintenance process. Topic 
blocks enable you to reuse standard procedures across conversation topics.

The following predefined reusable topic blocks are available:

• Project Topic for PPM VA

• Specific Project Options

• Project Data Quality Topic for PPM VA

• Project Financials Topic for PPM VA
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• Resource Topic for PPM VA

• RIDAC Topic for PPM VA

To view just the reusable topic functions, access the Topics page in Virtual Agent Designer and 
select the Topic Blocks  tab. For detailed information, see Reusable topic blocks .

Related topics

Install Virtual Agent for PPM

Enable Virtual Agent for PPM

Project Management  reference

Reference information to provide additional details about Project Management  such as the 
fields, user roles, tables, and properties.

Properties installed with Project Management

There are several Project properties that you can configure.

You need the pps_admin role to access the Project properties.

Navigate to Project Administration  > Settings  > Preferences - Project  to configure the following 
properties.

Property Description

Enable firing of Business Rules on save from Planning Console. This 
property will be applicable only during insert and delete of tasks and 
relations.

com.snc.project.fire_brs_from_planning_console

If set to true, the project 
planning console 
triggers business rules.

Note: 
Reload the console 
if you make 
changes to this 
property.

Default value: false

Enable move project for WIP projects

com.snc.project.move_project.wip

If set to true, this 
property enables you to 
move the projects which 
are in WIP state.

Note: 
When a project 
is moved, only 
tasks in open and 
pending state are 
moved and the 
project takes the 
rolled up dates 
from all the project 
tasks.

Default value: false
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Property Description

Calculate ROI percentage based on a project's estimated cost and 
its net value

com.snc.project.calculate_roi

If set to true, this 
property calculates the 
return on investment 
using the (net value/
estimated cost) x 100 
formula. This field is 
only available from the 
Advanced view of the 
Project form.

Default value: true

Enable alter of planned date with Actual for Manual Project

com.snc.project.change_planned_date_from_actual_for_manual

If set to true, the 
property recalculates 
the planned end date of 
a manual project from 
actual start date and 
planned duration.

Default value: false

Enable project cost rollup (estimated and actual) – updating the cost 
of a project task will update the cost of its parent

com.snc.project.rollup.cost

If set to true, this 
property updates the 
cost of a parent project 
task if the cost of the 
child task is updated.

Default value: false

Roll up project start date from tasks

com.snc.project.rollup_project_start_date

If set to true, the project 
planned start date rolls 
up from the planned 
start date of the earliest 
task. Disable this 
property if you want the 
project planned start 
date to remain the same 
despite the start date of 
the earliest task.

Default value: true

Automatically close project milestone tasks when they change to 
work state

com.snc.project.auto_close_milestones

If set to true, this 
property closes 
milestones automatically 
so you do not have to 
close them manually.

Default value: false

Enable altering of planned date(s) for task in WIP/Closed

com.snc.project.enable_alter_of_planned_dates

If set to true, this 
property enables you 
to change the planned 
start date for tasks even 
if they are in the Work in 
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Property Description

progress state or any of 
the closed states.

Default value: false

Change Resource Plan, Cost Plan and Benefit Plan Start Date with 
Demand or Project Start Date change. Benefit Plan Start Date will 
change only if the offset type for the plan is not None

com.snc.project.date_change_cascade

If set to true, this 
property changes the 
start dates for a resource 
plan, cost plan, and 
benefit plan when 
there is a change in the 
project or demand start 
dates.

Note: 
The start date of 
benefit plans with 
the offset type 
None  does not 
change with the 
project or demand 
date change.

Default value: true

Retain users & resource plan state as confirmed / allocated when 
project moves

com.snc.project.date_change_cascade_persist_resource_plan_state

If set to true, this 
property retains the 
confirmed or allocated 
state of a resource plan, 
booked resources, and 
planned daily contour 
when a property is 
moved. On moving the 
project, the resource 
plan is reallocated or 
reconfirmed based on 
the availability of the 
resources in the future 
time period to which the 
project is moved.

Note: 
This property 
is enabled only 
when the Change 
Resource Plan, 
Cost Plan and 
Benefit Plan Start 
Date with Demand 
or Project Start 
Date Change 
property has been 
set to true.

Default value: true
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Property Description

Create project(s) on confirming demands from portfolio workbench

com.snc.project.portfolio_workbench.confirm_to_create_project

If set to true, this 
property converts all 
selected demands in a 
portfolio to projects.

Default value: false

List of attributes (comma-separated) that will be copied from the 
originating project task

com.snc.project.copy.additional_attributes

By default, the Copy 
Project  and Copy 
partial project  options 
only copy the short 
description, planned 
dates, and duration 
fields from source 
project to the target 
project. If additional 
columns must be 
copied, they should be 
declared in this property.

Default value: blank

Default the expense type for a new project.

sn_plng_att_core.default.expense_type

When a new project is 
created in the Project 
Workspace, expense 
type of the project is 
marked as Opex.

The following project properties are available in system property [sys_properties] table. Only 
pps_admin can edit these properties.

Property Description

Retain start on constraint on tasks after adding relations

com.snc.project.allow_start_on_relations

The property keeps the Start on 
selection of a task even after you 
put the task in a relation to another 
task, for example, FS relation.

Default value: true

Max duration (in days) allowed for a project/project task

com.snc.project.task.max_task_duration

The property governs the max 
duration of a project task or the 
overall project.

Note: 
If your project includes 
milestones, the duration is 
calculated taking holidays and 
weekends into account.

Default value: 2600
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Property Description

Warning: 
Increasing the value of 
the property to more than 
2600 will have an impact 
on memory usage of the 
platform. A very high value 
causes out of memory 
error, for example, if you 
try to create a project or a 
project task with 15000 days 
duration.

Max date span into future or past from the current date for 
the project/project task

com.snc.project.task.check_date_span_years

The property governs the max date 
in future when entering the planned 
dates of a project or a project task.

Default value: 10

Warning: 
Increasing the value of the 
property to more than 10 will 
have an impact on memory 
usage of the platform. A very 
high value causes out of 
memory error.

Synchronize the planned and original dates when 
creating or updating a project or task

com.snc.project.sync_original_dates_with_planned_dates

If set to true, this property 
synchronizes the planned and 
original dates.

Default value: true

Use a predefined template when generating a status 
report

sn_pw.project_status_report_default_templateId

The property specifies the default 
template used for generating 
project status reports. You can 
replace the existing default 
template with your desired 
template and set it as default by 
updating the sys id in value field 
of project status report default 
template property.

Generate the status report as read-only

sn_pw.doc_status_report_read_only

The property restrict edits in the 
status report. The property sets the 
status report to read-only.

Default value: true

Quick start tests for PPM Standard Multicurrency

Validate that PPM Standard Multicurrency still works after you make any configuration change 
such as apply an upgrade or develop an application. Copy and customize these quick start tests 
to pass when using your instance-specific data.

Project currency quick start tests require activating the PPM Standard Multicurrency – ATF Tests 
plugin (com.snc.ppm_multicurrency.atf).
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Product currency test suite tests

Test Description Release version

Verify cost in project currency 
on cost plan

Validate the calculation of cost 
line breakdown with budget 
reference rate and verify roll 
up to cost plan and also for 
the project in project currency.

Orlando

Verify benefit in project 
currency on benefit plan

Validate the calculation of 
benefit line breakdown with 
budget reference rate and 
verify roll up to benefit plan 
and also for the project in 
project currency.

Orlando

Related topics

Quick start tests

Form field information for Project Management

Field information for forms used in the Project Management.

Benefit Plan form

Learn about the fields of benefit plan form.

Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Project or demand to which the benefit plan belongs.

Sponsor Sponsor for the project.

Category Type of benefit:

• Hard: Benefits that can be measured in terms of revenue.

• Soft: Benefits that are measured in terms of value.

Sub 
category

Sub-categories of hard and soft benefits.

The selection in Category  field determines the selections available in this field.

Benefit 
type

Type of benefit. Select Monetary benefits.

Offset type Field to indicate when the benefits start realizing. Select any of the following 
options:

• None: The default value is None. When you select None, you need to manually 
enter the benefit plan start and end fiscal periods.

• Milestone: After completion of a milestone.

• Start Date: At the start of the project.

• End Date: After the project ends.
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Benefit Plan form  (continued)

Field Description

If the value in the selected offset type changes, the benefit plan start date shifts 
accordingly. For example, if the offset type is set to End Date  and the end date of 
the project changes, the benefit plan start date shifts to align with the new end 
date of the project.

Milestone
Note: 
The field appears if you select Milestone  in the Offset type  field.

Project milestones to which the benefit plan belongs.

Milestone 
start date Note: 

The field appears if you select Milestone  in the Offset type  field.

Start date of the selected milestone.

Work start 
date Note: 

The field appears if you select Start Date  in the Offset type  field.

Start date of the project or demand.

Work end 
date Note: 

The field appears if you select End Date  in the Offset type  field.

End date of the project or demand.

Offset Number of periods before or after the offset type when the benefit plan starts. For 
example, if the offset type is selected as End Date  and the offset is -2, the benefit 
plan is two periods prior to the project end date. If the project end date shifts, the 
benefit plan start date shifts to two periods prior to the new project due date.

Duration in 
periods

The length, in periods, of the benefit plan.

Start fiscal 
period

Starting fiscal period. Populated based on the value in the Offset field relative to 
the selected Milestone, Project or Demand start date, or Project or Demand end 
date, and Duration in period values.

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.

End fiscal 
period

Ending fiscal period. Populated based on the value in the Offset field relative to 
the selected Milestone, Project or Demand start date, or Project or Demand end 
date, and Duration in period values.

The field is editable if you select None  in the Offset type  field.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Non-monetary benefit that is associated to this monetary benefit plan.
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Financials details

Field Description

Entered benefit Benefit incurred from the project or demand 
specified in terms of entered currency.

If the selected currency is different from the 
functional currency, the corresponding budget 
reference rate  is used to calculate the Total 
planned benefit  of the project.

Entered currency Currency in which you want the benefit plan to 
be created.

Functional currency Currency that is obtained from the 
glide.system.locale  property .

For upgraded customers, if the selected 
currency is different from the functional 
currency configured in the Financial 
Management application, the corresponding 
budget reference rate  is used to calculate the 
Total planned benefit  of the project.

Total planned benefit Estimated amount of potential benefit of the 
project or demand.

Benefit in functional currency Benefit incurred from project or demand in 
terms of functional currency.

Actual benefit Actual benefit that is incurred from the project 
or demand. This value is rolled up from the 
Actual benefit  field of all the benefit plan 
breakdowns.

Recurring Check box to indicate that the benefit is 
recurring for all the fiscal periods in the benefit 
plan.

Related topics

Create a monetary benefit plan for a project

Cost Plan form

Learn about the fields of cost plan form.

Cost Plan form

Field Description

Name Descriptive name of the cost plan.

Project/
Demand

Project or demand to which the cost plan belongs.

Start 
fiscal 
period

Indicates the starting fiscal period.
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Cost Plan form  (continued)

Field Description

When you change the start fiscal period, the associated cost plan breakdowns also 
change. Start fiscal period also changes when you create cost plan breakdowns 
earlier than the start fiscal period.

End 
fiscal 
period

Indicates the ending fiscal period.

When you change the end fiscal period, the associated cost plan breakdowns also 
change. End fiscal period also changes when you create cost plan breakdowns later 
than the end fiscal period.

Financials section of the Cost Plan form

Field Description

Entered currency Currency in which you want the cost plan to be 
created.

If the selected currency is different from 
the functional currency, the corresponding 
budget reference rate  is used to calculate the 
total planned cost, planned capital, planned 
operating of the project.

Unit cost Cost of a single unit of the resource, which is 
in terms of entered currency.

Quantity Quantity of the resource that is required.

Recurring Option to indicate that the cost is recurring for 
each fiscal period.

Quantity  x Unit cost  incurred for every fiscal 
period.

Cost type Cost type definition.

Investment
Name of the investment created for the 
project.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Source type
Funding entity to associated with the project 
investment for funding.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
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Financials section of the Cost Plan form  (continued)

Field Description

is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Source
Funding entity value from which you request 
fund.

The field is available when you select a value 
in the Source type  field.

This field appears only if the 
legacy Investment Funding 
(com.snc.investment_funding) plugin 
is activated or the Investment Funding 
(sn_invst_pln) application is installed.

Total planned cost Total estimated cost of the cost plan.

If the cost is recurring, the calculation is 
Quantity  x Unit cost  x number of fiscal 
periods. If the cost is non-recurring, the 
calculation is Quantity  x Unit cost.

Functional currency Currency that is obtained from the 
glide.system.locale  property .

For upgraded customers, if the selected 
currency is different from the functional 
currency configured in the Financial 
Management application, the corresponding 
budget reference rate  is used to calculate the 
total planned cost, planned capital, planned 
operating of the project.

Note: 
If budget reference rates are not defined, 
then exchange rate is considered as 
1. For example, if functional currency 
is USD, entered cost is EUR, and no 
exchange rate is defined, then 1000 USD 
equals to 1000 EUR.

Cost in functional currency Value that is rolled up from the Functional cost 
field of all cost plan breakdowns.

Total actual cost Value that is rolled up from the Actual cost 
field of all cost plan breakdowns.

Estimate at Completion Sum of all actuals for past fiscal periods added 
to the functional cost for future fiscal periods.

For example, the duration of a project is 
from January 01 to December 31, and if you 
check the Estimate at Completion in the 
month of May, it is calculated as: Sum of 
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Financials section of the Cost Plan form  (continued)

Field Description

actuals from Jan to April + Sum 
of functional cost from May to 
December.

Related topics

Create a project cost plan

Cost plan breakdown form

Learn and update the enabled fields of cost plan breakdown form.

Cost plan breakdown form

Field Description

Task Task to which the cost plan breakdown 
belongs.

Portfolio Portfolio to which the cost plan breakdown 
belongs.

Entered currency Currency specified in the cost plan.

Exchange rate
Rate in effect for the period corresponding to 
the cost plan breakdown. When the period 
corresponding to the cost plan break down 
has multiple rates, the rate in effect on the first 
date of that period is used.

Exchange rate is used to convert entered cost 
into functional cost. It is obtained from the 
itfm_fx_rate [budget_reference_rates] table.

Actual Actual cost generated from processed 
expense lines.

Cost plan Cost plan to which the cost plan breakdown 
belongs.

Fiscal period Fiscals generated at period level. For 
information on periods, see fiscal calendars .

Entered cost Breakdown amount in entered currency.

Functional cost Functional cost obtained by multiplying 
exchange rate with entered cost.

Exchange rate date First date of the fiscal period corresponding to 
the cost plan breakdown.

Related topics

Update a cost plan breakdown

Diagnostics form

Learn about the fields of diagnostic form.
© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1446

https://www.servicenow.com/docs/access?context=c_FiscalCalendar&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_FiscalCalendar&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_FiscalCalendar&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Diagnostics form

Field Description

Name Name of the diagnostic scan. This 
name appears in the application 
to which this diagnostic scan 

belongs.

Active Option for activating the diagnostic scan.

Order Order in which this diagnostic scan appears in 
the application.

Feature Diagnostic feature with which you want to 
associate this diagnostic scan.

Roles Option for adding or removing user roles that 
can access the diagnostic scan.

Description Details of the diagnostic scan. The 
description is displayed in the 
application to which the diagnostic scan 

belongs.

Related topics

Create Diagnostic scans and map related scripts

Diagnostics Feature form

Learn about the fields of diagnostics feature form.

Diagnostics Feature form

Field Description

Name Name of the diagnostic feature. This 
name appears in the application 
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Diagnostics Feature form  (continued)

Field Description

to which the diagnostic feature 

belongs.

Active Option for activating the diagnostic feature.

Application Search for and select the application with 
which you want to associate this diagnostic 
feature.

Roles User roles that allow access to the diagnostic 
feature.

Description Details of the scans in the diagnostic 
feature. The description is displayed in the 
application to which the diagnostic feature 

belongs.

Diagnostics Input fields

Field Description

Label Name of the label for the input fields.

Field Type The Reference  field type.

Table Name of the table on which the query 
specified in the condition should run.

Key An identifier for the user input condition. If a 
user specifies multiple conditions, this key 
acts as a unique identifier for each condition. 
You can use this key as the input for the 
scanContext  section of the diagnostic 
script.

For example, if you specify projectFilter 
as a key, the scanContext  section 
of the diagnostic script would appear 
as follows: var encodedQuery = 
scanContext.input.projectFilter;
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Related topics

Create and add diagnostic features

Diagnostic Scripts form

Learn about the fields of diagnostic scripts form.

Diagnostic Scripts form

Field Description

Name Name of the diagnostic script. Use a name that clearly explains 
the objective of the script. The script name also enables you to 
identify the correct script while mapping the script to a feature 
when creating a diagnostic scan.

Description Details describing the actions of the diagnostic script.

Diagnostic script The code for the diagnostic script. The following example shows 
a diagnostic script to identify tasks with an invalid top portfolio.

/*
- Inputs can be accessed from 
 scanContext.input as per, the key 
 specified in feature input table.
 eg.  scanContext.input.projectSysID
- To pass variables from the one script 
 to another script use varSpace in 
 scanContext.
 eg.  scanContext.varSpace.variable1 = 
 '...';
*/
(function(scanContext) {
    try {
        var errorTasks = [];
        var encodedQuery = 
 scanContext.input.projectFilter;
        var now_GR = new 
 GlideRecord("pm_project");
        gr.addEncodedQuery(encodedQuery);
        gr.query();
        while (gr.next()) {
            var entitySysID = 
 gr.getValue("sys_id");
            var projectData = new 
 ProjectData(entitySysID);
            var projectTopTaskValidator = 
 new ProjectTopTaskValidator(projectData);
 
            if 
 (projectTopTaskValidator.tasksWithInvalid
TopPortfolioPresent()) {
                var failedTasks = 
 projectTopTaskValidator.getTasksWithInval
idTopPortfolio();
                if (failedTasks && 
 failedTasks.length) {
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Diagnostic Scripts form  (continued)

Field Description

                    for (var i = 0; i < 
 failedTasks.length; i++) {
                       
 errorTasks.push(failedTasks[i].sys_id);
                    }
                }
            }

Related topics

Add diagnostic and fix scripts

Expense line form

Learn about the fields of expense line form.

Expense line form fields

Field Description

Number Auto generated number.

Amount Select a currency type and enter the expense cost.

Date Date of the expense generated.

Process 
date

Date on which the expense line was processed.

Source ID Record that generated the associated cost.

State State of the expense line. The state can be Pending or Processed. The cost roll-up 
happens only if the expense line is processed.

Cost plan Name of the cost plan against which you want to create the expense line.

Summary 
type

Select the category you want to group the expense under.

Cost type Select the cost type.

Expense 
type

Select Capex  for a capital expense or Opex  for an operating expense.

Short 
description

Enter a short description of the expense type.

Sources Select the records for the sources of the expense line. These sources include:

• Assets

• Fixed assets

• Contracts

• Users

• Configuration items
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Expense line form fields  (continued)

Field Description

• Tasks

• Cost centers

Related topics

Create an expense line

Investment board form

Learn about the fields of investment board form.

Investment board form

Field Description

Name Name for the investment board.

Type Level to filter projects and demands.

• Portfolio: When selected, projects and 
demands matching that type are displayed.

• Program: When selected, projects and 
demands matching that type are displayed.

• Demands/Projects: When selected, 
demands and projects matching that type 
are displayed, and are not bound to any 
particular portfolio or program.

Portfolio
Name of the portfolio from which the projects 
and demands are filtered.

This option is available only when Type  is 
Portfolio.

Program
Name of the program from which the projects 
and demands are filtered.

This option is available only when Type  is 
Program.

Demand/Projects Option to specify filter criteria for projects and 
demands.
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Investment board form  (continued)

Field Description

Note: 

• If no filter criteria is specified for 
demand, then no demands are 
retrieved. Similarly, if no filter criteria is 
specified for project, then no projects 
are retrieved.

• You can view a CSM column in an 
Investment Portal board, but you 
cannot add a filter on such columns in 
the board.

Active projects and demands
Check box to filter only active projects and 
demands.

This option is available only when Type  is 
Portfolio  or Program.

Related topics

Create an investment board

Monetary Benefit Plan Breakdown form

Learn about the fields of monetary benefit plans form.

Monetary Benefit Plan Breakdown form

Field Description

Task Task to which the benefit plan breakdown 
belongs.

Portfolio Portfolio to which the benefit plan breakdown 
belongs.

Entered currency Currency specified in the benefit plan.

Exchange rate Rate in effect for the period corresponding to 
the benefit plan breakdown. When the period 
corresponding to the benefit plan break down 
has multiple rates, the rate in effect on the first 
date of that period is used.

Exchange rate is used to convert the 
entered benefit into the functional benefit. 
It is obtained from the itfm_fx_rate 
[budget_reference_rates] table.

Actual benefit Actual benefit that is incurred from the project 
or demand.

Benefit plan Benefit plan to which the benefit plan 
breakdown belongs.
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Monetary Benefit Plan Breakdown form  (continued)

Field Description

Fiscal period Fiscals generated at the period level. For 
information on periods, see fiscal calendars .

Entered benefit Benefit in entered currency.

Functional benefit Functional benefit obtained by multiplying the 
exchange rate with the entered benefit.

Exchange rate date First date of the fiscal period corresponding to 
the benefit plan breakdown.

Related topics

Create a monetary benefit plan for a project

Update a monetary benefit plan breakdown for a project

Non-monetary benefit plans form

Learn about the fields of non-monetary benefit plans form.

Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Project or demand to which the benefit plan belongs.

Sponsor Sponsor for the project.

Category Type of benefit:

• Hard: Benefits that can be measured in terms of revenue.

• Soft: Benefits that are measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The selection in the Category  field determines the selections available in this 
field.

Benefit 
type

Type of benefit. Select Non-monetary benefits.

Offset type Field to indicate when the benefits start to be realized. Select any of the following 
options:

• None: The default value is None. When you select None, you must manually 
enter the benefit plan start and end fiscal periods.

• Milestone: After completion of a milestone.

• Start Date: At the start of the project.

• End Date: After the project ends.

If the value in the selected Offset type  field changes, the benefit plan start date 
shifts accordingly. For example, if the Offset type  field is set to End Date  and the 
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Benefit Plan form  (continued)

Field Description

end date of the project changes, the benefit plan start date shifts to align with the 
new end date of the project.

Milestone Project milestones to which the benefit plan belongs. This field appears only when 
Milestone  is selected from the Offset type  field.

Milestone 
start date

Start date of the selected milestone. This field appears only when Milestone  is 
selected from the Offset type  field.

Work start 
date

Start date of the project or demand. This field appears only when Start Date  is 
selected from the Offset type  field.

Work end 
date

End date of the project or demand. This field appears only when End Date  is 
selected from the Offset type  field.

Offset Number of periods before or after the offset type when the benefit plan starts. For 
example, if the offset type is selected as End Date  and the offset is -2, the benefit 
plan is two periods prior to the project end date. If the project end date shifts, the 
benefit plan start date shifts to two periods prior to the new project due date.

Duration in 
periods

The length, in periods, of the benefit plan.

Start fiscal 
period

Starting fiscal period. Populated based on the value in the Offset  field relative 
to the selected Milestone, Project/Demand start date, or Project/Demand end 
date, and Duration in periods  field values.

The field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown values 
also change.

End fiscal 
period

Ending fiscal period. Populated based on the value in the Offset field relative to 
the selected Milestone, Project or Demand start date, or Project or Demand end 
date, and Duration in period values.

The field is editable if you select None  in the Offset type  field.

When you change the end fiscal period, the associated benefit breakdown values 
also change.

Associated 
benefit

Monetary benefit that is associated to this non-monetary benefit plan.

Non-monetary Details

Measure Type of measure for the non-monetary 
benefit plan. The measure types are Count, 
Percentage, Hours, Days, and Score.

Select the option Yes/No  to track the benefits 
that are not quantifiable. When this option is 
selected, the only field available is Benefits 
achieved. You can select the check box to 
indicate that the benefits have been achieved.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1454



Non-monetary Details  (continued)

Non-monetary entered benefit
Estimated value of the potential benefit.

Any change in the planned benefit on the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods 
only.

Non-monetary planned benefit Benefit value that is rolled up from the benefit 
breakdown.

Benefits achieved Option to indicate if the benefit is achieved.

Breakdown type Type of breakdown creation when you save 
the benefit plan.

• None: No breakdowns are created.

• Automatic: A Non-monetary Benefit Plan 
Breakdowns record is created automatically 
with data. The breakdown is calculated 
linearly.

• Manual: A Non-monetary Benefit Plan 
Breakdown record is created automatically 
but without data in the Entered benefit 
column.

Aggregation mode Determines how the roll-up happens from 
breakdowns to the benefit plan and updates 
the values in the Non-monetary planned 
benefit  and Non-monetary actual benefit 
fields.

• Sum: Aggregates data from all breakdowns.

• Average: Average value from all 
breakdowns.

• Most recent: Recent breakdown value.

• Max: Maximum value among the 
breakdowns.

• Min: Minimum value among the 
breakdowns.

Non-monetary actual benefit Actual benefit value that is rolled up from the 
actual benefit in the non-monetary benefit 
plan breakdown.

Related topics

Create a non-monetary benefit plan for a project

Update a non-monetary benefit plan breakdown for a project
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Project task form

Learn about the fields of project task form. The fields appear when the Project Portfolio 
Management  is active and the Project form is in the Basic  view. Configure the form to display the 
fields.

Project Task form

Field Description

Short 
description

Brief description of the project task.

Number System-generated number with a configurable prefix.

Status
Status of the project task.

The status updates automatically based on the difference of the planned end 
date of the task from the current date. The color of the status changes as the 
planned end date approaches:

• Green: The planned end date for the project task is more than the offset 
working days that you defined.

• Yellow: The planned end date for the project task is less than the offset working 
days that you defined.

• Red: The planned end date for the project task is past the offset working days 
that you defined.

The default offset for status calculation is 3 working days. You can update the 
com.snc.ppm.yellow_status_duration  property to change the offset 
duration. Your project schedule determines the working days.

Important: 
The status of the project task does not affect the overall status of the 
project, meaning the project task status does not roll up to the project. Also, 
the status of the child tasks does not affect the status of the parent task.

Execute the Update Active Project Task Status  scheduled job to 
update the status of your existing tasks. This scheduled job runs daily by default, 
however you can execute this job on demand also.

If you do not want the status of a task to update automatically, you can change 
the status of the task manually. Changing the status manually, overrides the 
automatic update and the execution of the scheduled job does not change the 
status of the project task.

Note: 
Configure the property 
com.snc.status_process_planned_task_entities  to include 
or exclude task types for automatic status updates.

Override 
status

Indicates if the project task status is updated manually. By default, this check 
box is deselected. When you change the Status  field manually, this check box 
becomes selected.

State Current state of the project. The states include: Pending, Open, Work in Progress, 
Closed Complete, Closed Incomplete, Closed Skipped.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1456



Project Task form  (continued)

Field Description

The state is automatically rolled up from the project tasks. For more information, 
see Project calculation  and Parent-child rollup task calculations.

Description Detailed description of the project task.

Assigned to User assigned to the project task. The following conditions apply:

• If an assignment group is defined, only users in the assignment group appear 
in the lookup list.

• If skills are defined, only users with those skills appear in the lookup list.

• If no assignment groups or skills are defined, only users with one of the Project 
Management  application user roles appear in the lookup list.

• Users with timecard_user  role also appear in the lookup list.

Assignment 
group

User group assigned to the project task.

Additional 
assignee 
list

Additional users assigned to the project task.

Percent 
complete

Percentage of the work that has been completed for the project task.

Details tab

Field Description

Milestone Option for converting the task to a milestone.

Key milestone Option for converting the task to a key 
milestone.

Allow dates outside schedule Indicates whether the project task is set 
to start and end on a non-schedule day 
(outside regular project schedule) such as 
on a weekend. An off-schedule task can start 
any time during the day and on any day of the 
week.

For example, if you use the project schedule 
Monday to Friday, 8:00 to 17:00 and a project 
task of duration 2 days should start on 
Saturday, then an off-schedule task is allowed 
to be scheduled on Saturday and end on 
Sunday. Similarly, if a task of duration 3 days 
starts on Friday, then an off-schedule will end 
on Sunday instead of ending on Tuesday.

The option is not enabled for a parent task. 
The value of this field on the parent task is 
derived from the child tasks.
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Details tab  (continued)

Field Description

Note: 

• There is no difference between an off-
schedule and an on-schedule task if 
there is no schedule defined at the 
project.

• 1 day is 8 hours for a task in regular 
schedule and 24 hours for a task 
outside schedule.

Dates tab

Field Description

Planned start date Estimated date and time for the project task 
to start. You can edit this date when the Time 
constraint  is Start on Specific Date, Start no 
earlier than, or Start no later than.

If the constraint type is Start ASAP  or Start no 
later than, changing the planned start date for 
a task changes the constraint type to Start no 
earlier than.

Planned end date Estimated date and time for the project task to 
end.

For a manual project, any update to the actual 
start date does not update the planned end 
date of the project task. Enable the project 
property Enable alter of planned date with 
Actual for Manual Project  to update planned 
end date from the actual start date and 
planned duration.

Planned duration Estimated length of time (from start time to end 
time) of the project task.

Planned effort Estimate of how much time it will take to 
complete this task. After you add child 
tasks, this field becomes read-only, rolls-up 
calculation and overwrites any earlier entry 
that you made.

Constraint date A read-only field that determines the start 
date for tasks with Start no earlier than, Start 
no later than, and Start on specific date 
constraints. Use the Move project  related link 
to change this date. For more information, see 
Change the planned start date of a project.

Original start date Original planned date and time for the task to 
start.
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Dates tab  (continued)

Field Description

Actual start date Date on which the project task started. The 
task is set to Work in Progress  when the 
actual start date is populated.

When you change the State  or Percent 
complete  of the task, the actual dates are 
auto-populated with the date component 
copied from the planned dates.

When you populate the actual start and end 
dates, the time component in actual dates is 
defaulted to the date component in planned 
dates when the derive time component from 
planned dates field on Project form is set to 
True.

Actual end date Date on which the project task ended. The 
task is set to Closed Complete  when the 
actual end date is populated.

Actual duration Duration of the task from task start to task 
closure. As with planned duration, the actual 
duration shows total task time.

Actual effort Actual number of hours charged from the 
resources on this project task. If you are using 
the Time Card  Management application, the 
value for the field comes from the application 
automatically. The application calculates the 
actual effort on the task by taking the total 
time worked from all approved time cards of all 
resources who worked on the task.

Time constraint When the project task begins:

• Start ASAP: The task starts as soon as 
possible as determined by the relationships 
and dependencies. The dates for these 
tasks are derived from the constraint date of 
the project.

• Start on specific date: The task starts 
on a date that you specify. The task 
dependencies are not considered for date 
calculation.

• Start no earlier than: The task starts on or 
after the constraint date.

• Start no later than: The task starts on or 
before the constraint date. The start date 
is determined by the relationships and 
dependencies.
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Dates tab  (continued)

Field Description

Note: 
If the Calculation  field on the Project 
form is set to Manual, you cannot change 
the constraint type for such projects. To 
change the constraint type, change the 
project to Automatic.

Original end date Original planned date and time for the task to 
end.

Notes tab

Field Description

Activity / Work notes / Additional comments Information about the milestones, 
impediments, or changes as the project 
progresses. Enter notes or comments in the 
Activity  field and click Additional comments 
or Work notes. The text appears in the feed.

Checklist tab

Field Description

Checklist Checklist  to track items that must be 
completed for the task.

Related topics

Create a project task from a project

Project Template Form

Learn about the fields of project template form.

Project Template Form Fields

Field Description

Name The name of the project template.

Table Display only. Templates are based on the Project table.

Description A brief description of the project template.

Template Includes columns of fields and field values to be included in the template. Select 
a field in the left column and select the desired field name, then select the field 
in the right column to enter the field value. If additional information for the field is 
required, a field appears in the third column. For example, to identify the currency 
in a money field.

• Select the X  to the right of a field to remove that field from the template.

• Use the blank field at the bottom of the list to add new fields.
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Related Links

Field Description

Create Project Creates a project from this project template.

Copy Template Creates a copy of this project template.

Related Lists

Field Description

Project Template Tasks The project template task list.

Attachments The files attached to the template.

Project Template Configuration form fields

Field Definition

Table The entity to be parameterized in the template.

Parent 
table

The parent table for this item.

Link 
element

The field that links the table with the parent table.

Active A check box that indicates this item is included in a template.

Elements A comma-separated list of fields from the table selected in the Table  field that are 
included in the template.

Planning attribute form

Use the Planning attribute form fields to modify a planning attribute.

Planning attribute form

Field Description

Attribute type Attribute type list.

• Resource: To use the attribute for resources 
or financials for your project.

• Task: To use the attribute to generate labor 
costs only.

Attribute name Name of the attribute.

Enable for resource management Option to enable the attribute for resource 
planning.

This option is selected by default.

Enable for financials Option to enable/disable the attribute for 
financial planning.
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Planning attribute form  (continued)

Field Description

Note: 

• To enable an attribute for financials, 
it should be enabled for resource 
management.

• To disable an attribute for financials 
for an ongoing project: Delete all the 
existing labor cost plans, disable the 
attribute for financials, and regenerate 
labor cost plans.

Attribute table The default attribute table is the Employee 
Profile from which the attribute sources the 
information.

Attribute field Element name from the Employee Profile table 
to define the attribute.

Relevant lookup tables for the selected field 
value are displayed in the Planning attribute 
column configurations table after saving the 
form.

Enter the respective field names of the 
columns to activate the attribute.

Active Option to activate and use the attribute for 
planning.

Task attribute table and field Table name and field value for a task attribute.

This field is visible only while creating a Task 
type attribute.

Related topics

Create or edit planning attributes

Planned Task Relationship form

Learn about the fields of planned task relationship form.

Planned Task Relationship form fields

Field Description

Predecessor The predecessor, or determiner, in the relationship. You can select a new 
task. However, it is a good practice to delete the relationship and create a new 
relationship between the correct tasks.

Successor The successor in the relationship. The successor depends on the predecessor. 
You can select a new task. However, it is a good practice to delete the 
relationship and create a new relationship between the correct tasks.
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Planned Task Relationship form fields  (continued)

Field Description

Type The type of relationship, which is always Predecessor of::Successor of. Do not 
change this value.

Sub Type The type of dependency.

Lag The lag time between the tasks. The Enter the days, hours, minutes, and seconds 
for the lag. Lag time can be positive or negative.

Related topics

Modify a project task dependency

Portal board widget form

Learn about the fields of portal board widget form.

Portal board widget form

Field Description

Name Unique name for the widget you are configuring.

Order
The order in which your widgets appear on both your Investment Board and the 
Investment Portal page. Lower numbers are placed ahead of higher numbers.

For example, a widget with an order set to 100 appears before a widget with an 
order set to 200.

Aggregate 
type

Type of aggregation applied for the investment widget calculation: Sum, Average, 
Minimum, Maximum, and Count.

For example, you are aggregating the actual cost of three projects, A, B, and C, 
surfaced by a filter. Actual costs are 1000 for project A, 2000 for project B, and 
3000 for project C.

If sum is selected as the aggregate type, then the actual cost metric value would 
be 6000. If average is selected as the aggregate type, then the actual cost metric 
value would be 2000. If minimum is selected as the aggregate type, then the 
actual cost metric value would be 1000. If maximum is selected as the aggregate 
type, then the actual cost metric value would be 3000. If count is selected as the 
aggregate type, then the actual cost metric value would be 3.

Scripted Check box to specify a script for the investment widget calculation.

Show 
Label

Check box to display either the label or the color indicator.

If you clear the check box, the Color  field displays, which allows you to set the 
color.

Active Check box to indicate that the investment widget is active.

Display on 
board

Check box to display the investment widget on your investment board.

Parent 
widget

Parent widget for this investment metric widget. A parent widget can have up to a 
maximum of three child widgets.
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Portal board widget form  (continued)

Field Description

Include by 
default

Check box to show an active investment widget by default on:

• new boards

• existing boards that do not have widget selection configured

The check box is selected by default.

For more information on configuring widgets on an investment board, see Widget 
Configuration.

Short 
description

Brief description about the investment widget.

Script Script written for the dynamic calculation of investment widget. This field is 
displayed only when the Scripted  check box is selected.

The following script returns a string containing the desired output to be displayed 
on widget. Five variables (which are programmatically introduced to the script) are 
available:

• projectFilter: Project filter of Investment Portal board.

• demandFilter: Demand filter of Investment Portal board.

• projectClass: Project class of Investment Portal board which is used during 
teamspaces value evaluation. It returns tsp1_project for Teamspace1 Portal 
Board.

• demandClass: Demand class of Investment Portal board which is used during 
teamspaces value evaluation. It returns tsp1_demand for Teamspace1 Portal 
Board.

• boardSysId: SysId of Investment Portal board. It provides access to more 
information on Investment Portal board when needed.

Sample scripted widget for project cost

totalProjectCost();
 
function totalProjectCost()
{
    var totalCost = 0;
 
    if(!JSUtil.nil(projectClass) 
 && !JSUtil.nil(projectFilter))
{
        var projectGa = new 
 GlideAggregate(projectClass);
        projectGa.addEncodedQuery(projectFilter);
        projectGa.setGroup(false);
        projectGa.addAggregate('SUM', 'cost');
 
        projectGa.query();
 
        if(projectGa.next())
{
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Portal board widget form  (continued)

Field Description

            if(projectGa.getAggregate('SUM', 'cost'))
            totalCost += 
 parseFloat(projectGa.getAggregate('SUM', 'cost'));
        }
    }
    return PPMCurrencyHelper.defaultCurrencySymbol() + 
 PPMCurrencyHelper.getFormattedAmount(totalCost);
}

Project section of the Portal board widget form

Field Description

Project aggregate column Aggregation is applied on the selected column 
of the Project [pm_project] table.

Project table Table from which projects are being filtered.

Project filter Criteria applied to filter projects from the 
Project table.

Demand section of the Portal board widget form

Field Description

Demand aggregate column Aggregation is applied on the selected column 
of the Demand [dmn_demand] table.

Demand table Table from which demands are being filtered.

Demand filter Criteria applied to filter demands from the 
Demand table.

Related topics

Configure your investment metrics as widgets

Risk, issues, decisions, actions, and request change (RIDAC) form

Learn about the fields of the RIDAC form.

Risk form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the risk. All new risks are created in the Pending state.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped.

Risk status Status of the risk. It provides information on current status of the risk, whether it is 
achieved or mitigated or accepted.
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Risk form  (continued)

Field Description

The available options are: Pending, Achieved, Not Achieved, Avoid, Mitigate, 
Transfer, and Accept.

Probability The likelihood that the event described in the risk will occur. The available options 
are: Absolute, High, Moderate, and Low

Impact Impact of the risk event on the outcome of the project.

Estimated 
cost

Estimated cost the risk event generates.

Risk rank A value and color assigned to the risk. This value is calculated using risk 
probability and impact. You can configure the color and value using Risk Value 
Lookup. For more information, see Configure custom Risk rank and Risk value for a 
project.

Risk owner Primary resource who is responsible for monitoring and managing the risk.

Assigned 
to

Primary resource assigned to work on the risk.

Risk value A value calculated from Risk Value Lookup. For more information, see Configure 
custom Risk rank and Risk value for a project.

Due date Requested date for the assigned resource to resolve the risk or the date on which 
the risk must be closed or addressed if not assigned to any resource.

Show on 
project 
status 
report

Option to specify whether the risk information should be included in the project 
status report.

Task Project to which this risk belongs.

Short 
description

Brief description of the event and its potential impact on the success of the 
project. If the risk is created from the risk library, then this field displays the Risk 
Statement name.

Description Details of the event and its potential impact. If the risk is created from the risk 
library, then this field displays the Risk Statement short description.

Actual cost Cost generated by the risk event. This information gets added when and if the 
event occurs.

Mitigation 
plan

Brief description of efforts taken to mitigate the risk.

Risk Assessment Summary section in the Risk form

Field Description

Inherent risk This field gets auto-populated with the risk 
scores when the risk assessor assesses the 
inherent risk.

Elevated to enterprise risk This option gets selected automatically when 
the risk is elevated to enterprise risk by the 
project manager.
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Risk Assessment Summary section in the Risk form  (continued)

Field Description

Residual risk This field gets auto-populated with the risk 
scores when the risk assessor assess the 
residual risk.

Enterprise inherent risk This field gets auto-populated with the risk 
scores when the risk assessor assesses the 
enterprise inherent risk.

Enterprise residual risk This field gets auto-populated with the risk 
scores when the risk assessor assesses the 
enterprise residual risk.

Issue form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the issue. All new issue records are created in the Open state.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped

Priority Urgency of resolving or managing the issue based on possible impact.

Estimated 
cost

Estimated cost the issue generates.

Impact Impact on the outcome of the project if the issue remains unresolved.

Due date Requested date for the assigned resource to resolve the issue or the date on 
which the issue must be closed or addressed if not assigned to any resource.

Assigned to Primary resource assigned to work on the issue resolution.

Parent Project to which this issue belongs.

Show on 
project status 
report

Option to specify whether the issue information should be included in the 
project status report.

Short 
description Brief description of the issue and its potential impact on the success of the 

project.

As you start typing the title for your issue, related issues that potentially match 
your issue are displayed.

Select the suggestion icon ( ) to select from the list of predefined issue 
descriptions.

Description Details of the issue and its potential impact.

Work notes Information to record and track the work accomplished for resolving the issue.
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Decision form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the decision. All new decision records are created with 
Open state.

The available states are: Pending, Open, Work in Progress, Closed 
Complete, Closed Incomplete, and Closed Skipped

Priority Urgency of approving or implementing the decision based on possible 
impact.

Decision status Status of the decision. The available options are: Pending, Approved, and 
Rejected.

Impact Impact on the outcome of the project if you do not implement the decision.

Approval 
required

Option for determining whether approval of the decision is required.

Estimated Cost Estimated cost of implementing the decision.

Due date Requested date on which the decision must be approved or implemented.

Assigned to Primary resource assigned to work on the decision. The default value is the 
name of the user creating the decision record.

Parent Project number to which this decision belongs.

Show on project 
status report

Option to specify whether the decision information should be included in 
the project status report.

Short description Brief description of the decision such as what the decision is about, who 
made it, what it affects, and the decision outcome.

As you start typing the title for your decision, related decisions that 
potentially match your decision are displayed.

Select the Suggestion icon ( ) to select a description from the list of 
predefined decision descriptions.

Description Details of the decision and its potential impact.

Work notes Information to record and track the status of decision implementation or 
approvals.

Action form

Field Description

Number System-generated number with a configurable prefix.

State Current state of the action. All new action records are created with the state 
set to Open.

The available states are: Pending, Open, Work in Progress, Closed Complete, 
Closed Incomplete, and Closed Skipped

Priority Urgency for implementing or approving the action based on impact.
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Action form  (continued)

Field Description

Estimated Cost Estimated cost the action generates.

Impact The impact on the outcome of the project if you do not implement the action.

Approval Status of approval from the stakeholders for the action. A user with approval 
administrator role can only change the status of approval.

Assigned to Primary resource assigned to implement the action.

Due date Requested date on which the action must be approved or implemented.

Parent The project to which this action belongs.

Show on 
project status 
report

Option to specify whether the action information should be included in the 
project status report.

Short 
description

Brief description of the action such as what the action entails, how to 
implement the action, who it affects, and the action outcome.

As you start typing the title for your action, the related actions that potentially 
match your action title appear.

Select the Suggestion icon ( ) to select a description from the list of 
predefined actions.

Description Details of the action and its potential impact.

Work notes Information about the action. Add work notes to communicate about the 
status of action approval, rejection, or implementation with other users.

Request Change form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the request change. All new request change records are 
created in the Open state.

The available states are: Pending, Open, Work in Progress, Closed 
Complete, Closed Incomplete, and Closed Skipped

Priority Urgency for approving the requested changes based on impact.

Estimated Cost Estimated cost the requested changes generate.

Impact Impact on the outcome of the project if you do not approve the requested 
changes.

Approval Status of approval from the stakeholders for the requested changes.

Assigned to Primary resource assigned to work on the request change.

Due date Requested date to complete the request change.

Category Entity for which you are creating the request change. The options are: 
Resource, Scope, Cost, and Schedule.
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Request Change form  (continued)

Field Description

Parent Project number to which this request change belongs.

Show on project 
status report

Option to specify whether the request change information should be 
included in the project status report.

Title Title for the change request.

Description Details of the request change and its potential impact.

Business 
Justification

Reason for requesting the proposed change in the project and its impact 
on the business.

Work notes Additional information to indicate progress on the project request change.

Risk value matcher form

Learn about the fields of risk value matcher form.

Risk Value Matcher form

Field Description

Impact Impact value of the risk.

The default values are:

• 1 = High

• 2 = Medium

• 3 = Low

Application The application to which these risk values 
belong.

Risk Rank Color Color to indicate the severity of the risk.

Tip: 
You can enter variations of a color to 
differentiate between risks with similar 
impact and probability values. For 
example, you could enter lightgreen  to 
indicate a low-severity risk.

Risk Value The value for the specified risk impact and 
probability combination.

The options are: High, Medium, and Low.

This value is displayed in the Risk value  field 
of the Risk form.

Probability Risk probability value to associate with the 
impact value of the risk. The options are: 
Absolute, High, Moderate, and Low.
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Risk Value Matcher form  (continued)

Field Description

Probability Number Numerical value to indicate the probability. 
This value is multiplied by the value of the 
Impact  field for calculating risk rank.

The default values are:

• 1 = Absolute

• 1 = High

• 2 = Moderate

• 3 = Low

The calculated risk rank and the risk rank color 
are displayed in the Risk rank  field of the Risk 
form.

Scheduled Script Execution Form

Use the scheduled script execution form to define a scheduled job.

Schedule Item form

Field Description

Name Name that identifies this scheduled job.

Active Option that indicates that scheduled job is active and should be executed at the 
specified date and time.

Run
Time interval to use for running the scheduled job:

• Daily: Runs daily, at a designated time.

• Weekly: Runs on a weekly basis, at a designated time and day of the week.

• Monthly: Runs on a monthly basis, at a designated time and day of the month.

• Periodically: Runs on a designated repeating interval.

• Once: Runs for a single occurrence only.

• On Demand: Runs immediately on demand.

• Business Calendar: Entry Start: Runs on the starting entry dates for the 
business calendar that you select in the Business Calendar  field. A scheduled 
job runs for the starting date of each of the business entries that you defined for 
the business calendar.

For example, if the business calendar represents a fiscal year, and the starting 
date of each entry is a fiscal month, the scheduled job runs on the first day of 
each month.

• Business Calendar: Entry End: Runs for the ending date for the business 
calendar that you select in the Business Calendar  field. This selection runs in 
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Schedule Item form  (continued)

Field Description

the same manner as Business Calendar: Entry Start, but for the end dates of 
the associated business calendar entries.

Note: 
When you select Business Calendar: Entry Start  or Business Calendar: 
Entry End, you can apply an offset factor to schedule the job to run before 
or after the time span of the selected business calendar. To learn more, 
see the Offset type  and Offset  fields.

To learn more about creating and using business calendars and defining 
business calendar entries, see Creating business calendars  and Define 
business calendar entries .

Time zone
Time zone to use with the Time  field entry when you specify the time at which the 
scheduled job should run. Select a time zone entry:

• -None-: Use the default time zone for the logged-in user who is creating the 
scheduled job.

For example, the scheduled job runs at 04:45 p.m. US/Pacific time if it is the 
user's assigned time zone, and you enter 16:45  into the Time  field.

• Use System Time Zone: Use the default system time zone that is specified for 
the instance in which it runs.

For example, the scheduled job runs at 10:15 p.m. London time if Europe/
London is the default system time zone for the instance, and you enter 22:15 
in the Time  field.

• Actual time zone.

For example, the scheduled job runs at 1:30 p.m. in the US Eastern time zone if 
you select US/Eastern, and enter 13:30  in the Time  field.

Day
Day on which the scheduled job should run.

• If Run  is set to Weekly, select the day of the week. For example, select 
Wednesday.

• If Run  is set to Monthly, select the day of the month. For example, select 25 for 
the 25th day of the month.

This field appears only if you select Monthly  or Weekly  in the Run  field.

Repeat 
Interval Duration of the repeat interval for each scheduled job execution. Enter the 

duration in the number of days, hours, or minutes. For example:

• To run the scheduled job every four days, enter 04  in the Days  field.

• To run it every 26 hours, enter 26  in the Hours  field.

• If it should repeat at an interval of 13:30:25, enter 13  in the Hours  field, and 
then enter 30  and 25  in the two unlabeled fields after it.

These fields appear only if you select Periodically  in the Run  field.
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Schedule Item form  (continued)

Field Description

Note: 
This setting does not account for Daylight Saving Time changes. For 
example, if you select a period of one day, the calculation adds 24 hours to 
the starting time of the job. If the start time is in a Daylight Saving Time (DST) 
period, the job runs with a one-hour offset when that time zone is not in DST.

Business 
Calendar Business calendar entry that you are using to determine the business calendar 

start or end date for the scheduled job. This field appears only if you select 
Business Entry: Start Date  or Business Entry: End Date  in the Time  field.

Offset Type
Type of time offset, if any, to apply to the business calendar that you selected for 
scheduling this job:

• Past: Apply an offset factor to schedule the job to run before the start of the 
time span of the selected business calendar.

• Future: Apply an offset factor to schedule the job to run after the end of the time 
span of the selected business calendar.

• --None--: Do not apply a time offset when scheduling this job.

Adding an offset factor enables you to schedule the job to run before, or after, the 
formal time span that is defined in the business calendar for the following use 
cases:

• Schedule a job at a certain time, outside of the time span for the selected 
business calendar.

• Arrange multiple jobs to run in sequence, around the time span of the selected 
business calendar.

The Offset type  and Offset  fields appear only if you select Business Calendar: 
Entry Start  or Business Calendar: Entry End  in the Run  field.

Offset
Amount of time offset, expressed in days, hours, minutes, and seconds, to apply 
to the business calendar that you selected for scheduling this job. For example, 
if you want to schedule the job to start three days, 14 hours, 10 minutes, and 45 
seconds before the business calendar start date, do the following actions:

• Select Past  in the Offset type  field.

• Enter 3  in the Days  field.

• Enter 14, 10, and 45  in the Hours  field.

The Offset Days  and Hours  fields appear only if you select Business Calendar: 
Entry Start  or Business Calendar: Entry End  in the Run  field, and Past  or Future 
in the Offset type  field.

Time Time of day at which the scheduled job should run, expressed in hours, minutes, 
and seconds on a 24-hour clock. The selection that you make in the Time zone 
field determines the time zone for this entry.
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Schedule Item form  (continued)

Field Description

Note: 
Time values are always saved in the ServiceNow AI Platform®  in UTC time 
and then translated into the proper time. This translation depends on the 
selected Time zone  and the entry in the Time  field.

This field appears only if you select Daily, Weekly, or Monthly  in the Run  field.

Starting Date and time of the first scheduled job generation. Select the calendar date and 
time. This field appears only if you select Periodically  in the Run  field.

Priority
Numerical priority for the scheduled job:

• Set essential jobs to a priority value below 100.

• Set nonessential jobs to a priority above 100.

• If 70 percent or more of all scheduled jobs are Overdue, any jobs that are 
marked with a value above 100 do not run.

Run as Name of the user who is creating and running the scheduled job. To assign the 
scheduled job to the system instead of the person creating the scheduled job, 
create a system or dummy user and add it to this field.

Conditional Option for enabling the running of the scheduled job if certain conditions are met 
in the associated script.

Condition Conditional script that determines if a scheduled job should run. The last 
expression of the script should evaluate to a Boolean (true/false) value. This text 
box appears only if you select Use conditions.

Starting Date and time of the first scheduled job generation. Select the calendar date and 
time. This field appears only if you select Periodically  in the Run  field.

Related topics

Generate labor costs

Activate a scheduled job to generate labor costs

Status report form

Learn about the fields on the status report form.

Status report form fields

Field Description

Project Name of the project.

Status Date Date until which you want to generate the status report.

Number A system generated number for the status report with a configurable prefix.

State Current state of the project.

Percent complete Percentage of the project that has been completed.

Planned start date Planned start date of the project.

Planned end date Planned end date of the project.
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Status report form fields  (continued)

Field Description

Actual start date Actual start date of the project.

Actual end date Actual end date of the project.

Estimated cost Estimated cost of the project.

Actual cost Actual cost of the project.

Overall status tab details

Field Description

Overall health Color to signify the status of the overall health 
of the project in the report.

Executive Summary Brief summary and analysis of the project.

Comments Comments for the overall status.

Last Week's Achievements Progress of the project in the last week.

Key Activities planned Next planned activities for the project.

Schedule tab details

Field Description

Schedule Color to signify the status of the schedule-
related information of the project in the report.

Comments on Schedule Comments related to the project schedule.

Cost tab details

Field Description

Cost Color to signify the status of the cost-related 
information of the project in the report.

Comments on cost Comments related to the project cost.

Resource tab details

Field Description

Resources Color to signify the status of the resources-
related information of the project in the report.

Comments on Resources Comments related to the project resources.

Scope tab details

Field Description

Scope Color to signify the status of the scope-related 
information of the project in the report.
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Scope tab details  (continued)

Field Description

Comments on Scope Comments related to the project scope.

Related topics

Create a project status report

Multicurrency fields in project-related forms

When you enable the Project Currency view in Project, Cost Plan, and Cost Plan Breakdown 
forms, you can observe multicurrency fields in the Financials section of the forms.

Financials tab of the Project form

Project form

Field Description

Project currency Currency in which the project is to be 
implemented.

Note: 

The Project currency  field defaults to 
the Functional Currency if you modify the 
currency field and save the Project form 
without selecting a currency.

The Project currency  field of a project 
becomes read-only field and cannot 
be modified once you create a cost 
plan, cost plan breakdown, benefit plan, 
benefit plan breakdown, or an expense 
line for the project.

Total planned cost in project currency Estimated cost of the project in project 
currency.

Planned capital in project currency Capital expenditure (Capex) for the project.

Planned operating in project currency Operational expenditure (Opex) for the project 
in project currency.

Budget cost in project currency Budgeted cost in local currency for the project.

Actual cost in project currency Actual cost of the project in local currency.

Estimate at completion in project currency Sum of all actuals for past fiscal periods added 
to the functional cost for future fiscal periods 
in project currency.

Planned benefit in project currency Planned benefit for the project in project 
currency.

Planned return in project currency Difference between Planned benefit and 
Planned cost values.
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Project form  (continued)

Field Description

Planned ROI % Percentage calculated based on the values in 
the Planned return and Estimated cost fields.

Net present value in project currency Present value of future cash in project 
currency based on the given annual interest 
rate.

Internal rate of return % Annual interest rate required to achieve the 
net present value (NPV) of zero.

Estimate to completion in project currency Sum of functional cost for all fiscal periods in 
project currency.

Preferences section of the Project form

Field Description

Status report currency Currency in which the project status report is 
generated.

If you have the Project currency view enabled 
in the Project form, then you have the choice 
to generate the project status report using any 
of the following currency options:

• Functional currency: Currency obtained 
from the glide.system.locale property in 
which the project status report is created.

• Project currency: Project status report 
is created in the local currency that is 
selected. If you select Project currency, you 
can view the planned cost and actual cost in 
the selected project currency.

To view the status report of the project, see 
View project status reports.

Financials section of the Cost Plan form

Cost Plan form

Field Description

Project currency Currency in which you can create the cost 
plan.

Cost in project currency Value that is rolled up from the Entered cost 
field of all cost plan breakdowns.

Total actual cost in project currency Value that is rolled up from the Actual cost 
field of all cost plan breakdowns in project 
currency.
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Cost Plan form  (continued)

Field Description

Estimate at completion in project currency Sum of all actuals for past fiscal periods added 
to the functional cost for future fiscal periods 
in project currency.

Estimate to completion in project currency Sum of functional cost for all fiscal periods in 
project currency.

Note: 
Any change that you make to the unit cost, quantity, or fiscal period of a cost plan has the 
amounts recalculated in project currency. See Updates in cost plan and recalculation of 
cost in project currency.

Multicurrency fields in the Cost Plan Breakdown form

Cost Plan Breakdown form

Field Description

Exchange rate for project currency Rate in effect for the period corresponding to 
the cost plan breakdown in project currency.

Project currency Local currency selected for the cost plan 
breakdown.

Cost in project currency Breakdown amount in project currency.

Actual cost in project currency Actual cost generated from processed 
expense lines in project currency.

Variance project currency Difference between Cost in project currency 
and Actual cost in project currency.

Budget Project budget amount entered for a fiscal 
year gets distributed equally into monthly 
breakdowns in functional currency.

Budget cost in project currency Project budget amount entered for a fiscal 
year gets distributed equally into monthly 
breakdowns in project currency.

Financials section of the Benefit Plan form

Benefit Plan form

Field Description

Project currency Project currency that was selected in the 
project is populated.

Benefit plan attached to a project inherits the 
same currency as that of the project.

Benefit in project currency Benefit incurred from project or demand in 
project currency.
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Multicurrency fields in the Benefit Plan Breakdowns form

Benefit Plan Breakdowns form

Field Description

Project currency Currency that is selected in the Project form.

Benefit in project currency Benefit incurred from project or demand in 
project currency.

Project currency exchange rate Rate in effect for the period corresponding 
to the benefit plan breakdown in project 
currency.

Project currency reference rate Rate at which the entered currency is 
exchanged for project currency.

Multicurrency fields in the Expense Line form

Expense Line form

Field Description

Project currency Currency inherited from the project if the 
project has a related expense line.

Amount in project currency Expense cost in project currency. Amount 
entered in the Amount field is converted to 
project currency.

Multicurrency fields in the Project Funding form

Project Funding form

Field Description

Capital budget in project currency Planned expense amount allocated for capital 
expenditure in the selected currency.

Operating budget in project currency Operating expense amount in the selected 
currency.

Budget in project currency Sum of Capex and Opex amounts.

The total project funding budget amount rolls 
up to the Budget cost in project currency 
field.

Project currency Currency in which the project is funded.

Exchange rate Currency conversion based on the exchange 
rates between currencies.

Exchange rate date Date on which the exchange rate is applied.

Exchange reference date Budget Reference Rate from where the 
exchange rate is retrieved.
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Cost rollup in project currency

Cost rollup calculation in projects and sub-projects with different currencies varies with the 
budget reference rate. The rate at which the amount is converted depends on the conversion 
rate.

Convert amount entered in functional currency fields to project currency

When you create a project in functional currency of the Default view, you can manually enter or 
update the amount in the Planned capital, Planned operating, Actual cost, and Planned benefit 
fields. As you enter values in these fields, the amount is converted to project currency and stored 
in the corresponding project currency fields such as Planned cost in project currency, Planned 
operating in project currency, Actual cost in project currency, and Planned benefit in project 
currency  fields.

Note: 
You can do so only if the project does not have a cost plan, benefit plan, or expense lines 
attached to it.

Roll up project financials from sub-projects to parent projects

Use the com.snc.project.multicurrency.rollup_if_different  property for 
financial rollups when the sub-projects and parent project have different project currencies.

Multicurrency cost rollup property behavior

Property flag Behavior

True If the property is set to True, then you can:

1. Associate a sub-project to a parent project, 
where both the projects have different 
project currencies.

2. Roll up the sub-project amounts to the 
parent project amounts. However, the 
accuracy of the rolled up amount in the 
parent project varies because of the 
currency variation.

◦ If the project currencies of the parent 
project and the sub-project are the same, 
then the project currency amounts from 
the sub-projects to its parent and the top 
project are rolled up by adding up the 
amounts in the sub-project, and the rolled 
up amount is accurate.

◦ If the project currencies of the parent 
project and the sub-project are different, 
then all the costs of the sub-projects are 
converted to the project currency of the 
parent or the top project, referencing the 
Budget Reference Rate. The rate at which 
the amount is converted depends on 
the exchange rates between the project 
currencies, and the specified time period 
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Multicurrency cost rollup property behavior  (continued)

Property flag Behavior

at which the conversion is made. Hence, 
the rolled up amount is only an estimate or 
an approximate value.

False If the property is set to False, then you can:

1. Associate any number of sub-projects to a 
parent project, where the project currencies 
are same or different.

2. Roll up only if the project currencies of the 
sub-project and the parent project match.

However, the behavior of 
com.snc.project.multicurrency.rollup_if_different  property is different 
when flagged along with com.snc.project.rollup.cost  property.

Multicurrency cost rollup property in combination with functional currency property

Properties flag Behavior

com.snc.project.rollup.cost 
property is false

You can associate any sub-projects with 
parent project that have same or different 
project currency but the costs of sub-projects 
do not roll up to the parent project.

com.snc.project.rollup.cost 
property is true and 
com.snc.project.multicurrency.rollup_if_different 
property is false

You can associate sub-projects with parent 
project that has the same project currency.

com.snc.project.rollup.cost 
property is true and 
com.snc.project.multicurrency.rollup_if_different 
is true

You can associate any sub-project that has 
the same or different project currency with the 
parent project.

Illegal association of properties and possible errors

Following are the possible errors that may occur while making an illegal association:

Property combinations for sub-project and parent project association

com.snc.project.rollup.cost com.snc.project.multicurrency.rollup_if_differentBehavior

False Either true or false Can associate sub-project to 
parent project even though 
project currency of sub-
project and parent project 
is different but costs from 
sub-project to parent project 
cannot be rolled up.
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Property combinations for sub-project and parent project association  (continued)

com.snc.project.rollup.cost com.snc.project.multicurrency.rollup_if_differentBehavior

True False Cannot associate sub-project 
to parent project if project 
currency of the sub-project 
and parent project is different.

In such case of an 
association, an error message: 
System policy does 
not allow parent 
and child projects 
to have different 
project currency  pops 
up.

Project currency in cost and benefit plans

The currency fields in cost and benefit plans defaults to the project currency of the project.

Entered currency field in cost and benefit plans

The Entered Currency  field of the cost plan defaults to the project currency of the project if 
multicurrency plugin is installed, irrespective of the views – default or functional currency. 
However, if multicurrency plugin is not installed, the Entered currency  field of the cost plan 
defaults to the functional currency of the project.

Similarly, the Entered Currency  field of the benefit plan defaults to the project currency of 
the project if multicurrency plugin is installed, irrespective of the views – default or functional 
currency. However, if multicurrency plugin is not installed, the Entered Currency  field of the 
benefit plan defaults to the functional currency of the project.

Related topics

Enable project currency view in project-related forms

Updates in cost plan and recalculation of cost in project currency

Multicurrency in Project Management

Project Workspace
ServiceNow®  Project Workspace  helps project managers to plan and manage projects from a 
central location.

The new Project Workspace  comes with a Planning, Details, Financials, RIDAC, Analytics, Docs, 
Status Reports, and Resources page.

Project Workspace  Overview

The Project Workspace  enables you to collaborate, plan, organize, and execute tasks in a single 
workspace. This application provides the ability to create and monitor projects, tasks, sub-
projects, dependencies, and timelines. Project managers can allocate and optimize resources 
within the Project Workspace  and make sure that the right individuals are assigned to the right 
tasks. With Project Workspace, you can plan and track your project finances, budgets, and cost 
plans. This project management application helps in making informed and timely decisions by 
providing relevant project information in one place.
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Use playbooks to deliver a guided, stage-based experience within the project workspace.

Create a status report for your projects and run analytics for your projects. Experience the Gen AI 
feature in Project Workspace. Summarize, elaborate, or shorten the selected content on Docs to 
quickly understand the key information in documents using Project Gen AI Docs skill.

Refine planning item descriptions using write items skill to improve the clarity and completeness 
of your work item and reduce the rework due to missing or unclear planning item information.

Get started

Explore

Learn the features and business 
value of Project Workspace

Configure

Set up the core configuration

Use

Manage projects with Project Workspace

Reference

Learn about forms and 
fields of Project Workspace

Troubleshoot and get help

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Project Workspace

The ServiceNow®  Project Workspace  application helps you to manage projects, resources, and 
financials in a single workspace.

Project Workspace  overview

Project Workspace  is a project management application that optimizes different workflows and 
enables planning and managing of projects or tasks, resources, and financials in one place. This 
application centralizes access to Projects, subprojects, project tasks, resources, and financials, 
reducing the need to navigate through various applications.

The Project Workspace  provides Project Managers with a comprehensive overview of the all 
projects and project-related information. This project management application enables better 
project planning by providing ways to define project scope, dependencies, and time lines.
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Project Workspace  benefits

Benefit Feature

Initiate a project and start planning your 
project tasks.

Create a project and initiate project planning

Add project tasks to your project and assign 
tasks directly to your team for successful 
project implementation.

Create project tasks and add them to your 
project

Add project task dependencies to establish a 
structured workflow within the project.

Create internal dependencies for your project

Add a dependency between tasks of 
different projects to align timelines between 
interrelated projects.

Connect tasks in different projects through 
external dependencies

Create and compare baselines for your project 
to capture the project's progress over time.

Set up a baseline for your project

Create a status report to monitor project 
health, metrics, risks, issues, and milestones.

Create a status report in Project Workspace

Tag stakeholders for their feedback or notes 
and add comments to collaborate on your 
project.

Collaborate with Stakeholders for your project

Generate a summary of selected text in Docs 
using Now Assist.

Generate the summary for selected 
or complete content with Project doc 
summarization skill in Project Workspace

Generate and schedule project summary 
emails for your projects.

Schedule the project insights email

Add Risk, Issue, Decision, Action, or Change 
request to your project to track and manage 
the RIDAC records throughout project 
development.

Add a RIDAC record to your project

Export your project as a PowerPoint file 
directly from the workspace without copying 
the project information in to slides.

Export a project to Microsoft PowerPoint

Create and track resource assignments at 
project or task level to optimize resource 
allocation throughout the project.

Create resource assignments and initiate 
resources planning

Create a cost plan for the required duration to 
monitor your projected and actual expenses.

Create a cost plan for your project

Add an expense line into project cost plans 
to establish a comprehensive and detailed 
financial framework for your project.

Add an expense line for a cost plan

Generate labor costs for attribute-based 
resource assignments to track expenses for 
your project.

Generate labor costs for your project

Collaborate with team members, save notes, 
generate project charters, and create project 
briefs using Docs.

Collaborate on projects using Docs
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Benefit Feature

Secure a project to ensure only authorized 
users can access the project.

Enable security for a project in Project 
Workspace

Configure and use playbooks in Project 
Workspace to guide project teams through 
standard project stages and activities.

Use Playbooks in Project Workspace

Related topics

Managing projects with Project Workspace

Managing financials for your projects

Resource planning with Project Workspace

Status reporting in Project Workspace

Project workspace classic - Legacy

Project planning in Project Workspace

Plan your projects with an intuitive Project Workspace  application to achieve successful project 
outcomes.

The Project Workspace  application enables Project Managers to define, plan, and prioritize 
projects, subprojects, project tasks within a single workspace.

The Project Workspace  structures the project planning phase from defining the project dates 
and milestones to allocating resources, scheduling tasks, and establishing dependencies.

Key benefits

Use the planning page to organize project tasks, allocate resources, and set project timelines. As 
a project manager, you can:

• Initiate new projects, define project details, objectives, and initial plans to provide a clear 
direction to the project team.

• Establish the project's structure within the workspace, including creating projects, subprojects, 
tasks, milestones, and dependencies.

• Define the planned start date and end date for your projects.

• Allocate resources and analyze resource availability and utilization for projects.

• Monitor the progress of projects, subprojects, tasks, and milestones. Track the project's overall 
advancement.

• Organize and manage project documentation and make sure that all relevant files, reports, and 
data are easily accessible.

• Engage in financial planning, tracking budget allocations, expenses, and financial metrics.

Project task checklist items

Track the activities that must be completed on a task using the project task checklist items.

For a project task to be considered complete, you can track activities that do not require separate 
sub tasks. For example, you have a human resources-related project that includes a task for 
interviewing candidates. You can also track booking a meeting room or getting an interview 
confirmation from the candidate. Create a checklist item for each and mark when they have been 
completed.
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Checklist items do not have start or end dates, nor do they track effort or cost. By default, 
a checklist item record provides only a name with a check box, which can be selected or 
unselected. The state of the project task is independent of the state of the checklist items.

Checklists, as well as tasks, are copied into a project template. You also have access to all 
checklist templates from any project task form.

Related topics

Create checklist items for a project task

Playbooks in Project Workspace

Organize and guide project teams with Playbooks to maintain consistency, streamline projects, 
and keep work on track.

Playbooks overview

A Playbook provides a guided framework that helps you follow a process step by step. It shows 
what to do, when to do it, and where to find the tools or information required to complete each 
task.

Playbooks provide a structured way to manage work by guiding teams through predefined 
steps. You can apply a playbook to processes such as managing a project, resolving an issue, 
launching a product, onboarding new employees, or define key steps of a process. For more 
information on playbooks, see Workflow studio playbooks .

Playbook benefits

Use playbooks in Project Workspace  to guide project teams through standard project stages and 
activities and ensure consistency across all projects. For example:

• Set up a new project using predefined stages and action items.

• Provide self-educating guidance for first-time users.

• Verify key steps such as defining objectives, assigning tasks, and tracking deliverables are 
completed on time.

• Support processes that require stage gating and control over each step.

• Combine with Flow Designer to set up different business logic for each playbook flow.

Types of Playbooks

• Project default

• Stage-gate default

Project default playbook is a free-form playbook where all stages and tasks are visible and 
accessible to the project manager. The project manager can navigate to any stage or task at any 
time. It serves as a standard framework playbook for managing project activities.

In a Stage-gate playbook, the stages and tasks must be completed in a linear order. Each stage 
must be finished before moving to the next one. The stages are visible only when all activities 
in the previous stage are completed or skipped. After completing a stage, project managers 
can still return to previous stages if needed. This playbook is commonly used in research and 
development projects.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1486

https://www.servicenow.com/docs/access?context=process-automation-designer&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US
https://www.servicenow.com/docs/access?context=process-automation-designer&version=zurich&pubname=zurich-build-workflows&ft:locale=en-US


Related topics

Playbooks configuration

Use Playbooks in Project Workspace

Resource planning in Project Workspace

Plan and allocate resources using the Project Workspace  application to enable optimal resource 
utilization and execution.

The Resource Management  application enables Project Managers to create resource 
assignments, allocate resources, and analyze resource availability in Project Workspace. The 
Resource Management  application can be used along with Project Workspace  for any project or 
project tasks.

Key benefits

The Resource Management  application provides visibility into resource assignments and 
allocations in Project Workspace  at any phase of the project.

With Resource Management  in Project Workspace, you can:

• Assign resources at any stage of project development. Resources can be planned at a granular 
level.

• Change resource assignment dates, resources, and efforts for resource availability at any 
phase of the project.

• Create an attribute-based resource assignment in Project Workspace.

• View availability in the heatmap and make allocations based on the resource availability. The 
allocations are color-coded to display the availability of the resources for a task.

• Request and allocate resources and verify resource availability on a single location in the 
Project Workspace.

Resource Management  workflow in Project Workspace

The Project Manager can create an attribute-based resource assignment in Project Workspace. 
Any type of project task can be added to the resource assignment.

After a resource assignment is created, the project manager verifies resource availability, and 
then assigns the resource to a resource assignment. If the resource isn’t available, then the 
Project Manager coordinates with the Resource Manager for resource availability. If all parties 
agree, the resources begin work. Project Managers can view the resource allocation in the 
heatmap.

Note: 
After the resource assignment is created and has any requested allocations, a resource 
plan is created automatically in the allocated state in the back-end. Either a new resource 
plan and resource allocation are created, or an existing resource plan is retrieved based 
on the attributes. As a result, its planned cost and allocated cost are matched, and its 
planned and allocated hours are also matched. These resource plans aren’t displayed in 
the Resource Allocation Workbench.

Financials in Project Workspace

Plan, re-forecast, track the financials, and create baselines for projects and demands.

The financials view provides a streamlined perspective, showcasing the actual and planned 
expenses for the entire fiscal period. You can view the latest estimated cost of completion by 
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displaying the Actual costs for the past fiscal periods, planned costs for the current and future 
fiscal periods, the totals for quarter, year, and total duration of work.

The interface gives you the ability to create cost plans, expense lines, and baselines. As a project 
manager or a financial user, you can:

• Enter high-level financial forecasts for planning items using the simple financials section in the 
Details tab.

• Work on high-level estimating for Planned opEx and Planned capEx.

• Create a detailed breakdown of the planned costs using the financials.

• Add, edit, or delete cost plans  from the side panel.

• Re-forecast your planned expenses using the in-line editing feature.

• View a streamlined perspective, showcasing your actual costs for the past and planned 
expenses for the future, for the entire time scope of the planning item.

• Get a better comprehensive solution by viewing the Forecast (previously EAC - Estimate at 
Completion), Remaining Estimates (previously ETC - Estimate to Completion), and Actuals of 
each cost plan for the total time scope and the yearly breakdowns.

• Re-forecast the planned cost for future fiscal periods by directly updating the quarterly and 
yearly totals using the in-line editing capability of the grid.

• Generate labor costs  depending on the resource assignments for the entire scope of the 
planning item broken down by the financial attributes configured for your organization. For 
more information on the planning attributes for attribute-based mapping, see Using the 
Planning attributes.

• Add or edit expense lines  against the cost plans from the side panel with the associated cost 
plan details pre-populated.

• Record unplanned expenses using the New expense line side panel.

• Create and compare financial baseline to track the financials of your projects while you 
execute them.

• Compare the latest costs (actual expenses for past fiscal periods and planned costs for 
current and future fiscal periods) with the initial forecasted planned costs by creating financial 
baseline and using the compare baselines capability.

• Analyze the cause of variance in costs and when did this occur over time by capturing the 
financial baselines manually or automatically.

Financials screen

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1488



You can view the following information on the financials screen.

• Time scope: duration of the planning item or a cost plan, whichever has a larger fiscal period 
range.

• Functional currency: currency defined and used to calculate the financials.

• Customizable widgets showing different financial information such as allocated budget, 
Forecast (previously EAC - Estimate at Completion), Variance (the difference between budget 
and Forecast), breakdown of planned costs, and actuals by cost type.

Note: 
Budget and Budget vs EAC Variance widgets are available for Demands and Projects 
only.

• Time scale: time period breakdowns to view the financials. Default value is set to Month/
Period, depending on the fiscal calendar type.

• Generate labor costs: one-click solution to generate or refresh the planned labor costs for the 
planning item depending on resource assignments.

Note: 
This option is enabled for the projects with resource assignments only.

• The pane gives you a tabulated view of the cost plan attributes displaying the Name, Cost type, 
Expense type, Stat fiscal period, End fiscal period, Total planned cost, Employee type, and 
Role. You can customize these fields. For more information, see Customize the left pane view 
for financials.

• In the right pane, you can view the total Actuals, Forecast, and Remaining Estimates for the 
selected Time scope duration. Actual expenses against a cost plan for the past fiscal periods, 
Actuals, Forecast, and Remaining Estimates for the current fiscal year, and planned costs for 
the current and future fiscal periods.

Note: 
The header rows of actuals and planned are color-coded differently to help you easily 
identify and differentiate between the expense types.

• New cost plan: opens a simplified side-panel to create a new cost plan for the entity.

• Personalize option to customize the columns in the left pane of the table.

• Export option to download Cost or Baselines comparison as Microsoft Excel or CSV file.

Status reporting in Project Workspace

A status report in Project Workspace  is a snapshot in time that gives an overview of your overall 
project health across key areas such as cost, resources, milestones, health, and more.

https://player.vimeo.com/video/1093765468?
h=414833d0a6&badge=0&autopause=0&player_id=0&app_id=58479

The Status reports in Project Workspace  provide a comprehensive, configurable, and 
customizable view of the current state of a project by capturing and displaying key project 
metrics such as overall health, schedule, scope, cost, and resource utilization. Status reports 
help project teams and stakeholders track progress, identify risks, and manage any project-
related issues in real-time.
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Status report main metrics

Metric Description

Overall health The general condition of the project (green, 
yellow, or red).

Completion status The percentage of project completion.

Schedule and scope Key milestones and any changes in scope.

Cost metrics Planned and actual costs, and budget 
variance.

Resource utilization Allocation and effort tracking for project 
resources.

Key benefits

The status report feature in Project Workspace  provides a clear view of the project’s overall 
health, progress, and key metrics, confirming effective communication and tracking throughout 
the project life-cycle.

With status reports in Project Workspace, you can:

• Gain improved project visibility by having a concise summary of key metrics such as schedule, 
cost, and resource utilization, enabling stakeholders to track the progress.

• Facilitate better decision-making by providing a snapshot of the project’s current state, helping 
project managers and stakeholders address potential challenges.

• Enhance risk management by highlighting any risks, issues, or variances, enabling teams to 
respond proactively to project concerns.

• Maintain consistent communication across teams and stakeholders by delivering regular, 
standardized updates, confirming everyone stays informed about the project's progress and 
health.

• Increase efficiency through the use of templates that streamline the creation of reports, saving 
time and confirming consistency across projects while enabling for customization as needed.

Status report templates

Status report templates simplify the process of generating project updates by providing pre-
defined structures, confirming consistency and saving time. Two default templates are available:

• One Page Status Report: This template provides a concise one-page summary of key project 
metrics, making it ideal for quick updates where a high-level overview is sufficient.

• Default Status Report: This template includes a more comprehensive range of data points, 
covering areas such as milestones, risks, issues, decisions, and change requests. It offers a 
detailed view of the project's progress and status, similar to a classic status report.

• You can create a status report using one of the existing templates: Create a status report in 
Project Workspace

• You can also create your own status report template from scratch: Create a status report 
template in Project Workspace
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Related topics

Analyze the status report in Project Workspace

Import old project status report to Project Workspace

Add dynamic content to status report in Project Workspace

Better together with other ServiceNow®  applications

Integrate Hardware Asset Management (HAM) with Project Workspace  to track which HAM 
requests or refreshes belong to an SPM project. Provide portfolio and project managers visibility 
into request status without leaving Project Workspace.

This integration enables Hardware Asset Management (HAM) requests and refreshes to be 
associated with Strategic Portfolio Management (SPM) projects in Project Workspace, allowing 
hardware-related tasks to be tracked within the context of a project.

Key capabilities

• Track HAM requests as part of an SPM project.

• View project-tagged asset requests from the project record.

• Create new asset project requests from the asset project request list.

Configuring Project Workspace

Set up and configure the Project Workspace  application to initiate and plan your projects, 
financials, and resources.

Related topics

Managing projects with Project Workspace

Managing financials for your projects

Resource planning with Project Workspace

Project Workspace reference

Configuring projects with Project Workspace

Set up the Project Workspace  application and start planning on your project.

• Confirm that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Project Workspace  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

• Install Project Workspace.

Install Project Workspace

You can install the Project Workspace application (sn_pw) if you have the admin role.
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Before you begin

• Confirm that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the Project Workspace  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

• Starting with Zurich  release, installing the PPM Standard plugin also installs the Project 
Workspace  application.

• Ensure you have activated the PPM Standard plugin (com.snc.financial_planning_pmo).

Role required: admin

About this task

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Project Workspace application (sn_pw) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are the sample records that describe application features for common use cases. 
Load the demo data when you first install the application on a development or test instance.

6. Select Install.

Result
Planning attributes dependency plug-in is installed along with Project Workspace.

Playbooks configuration

Configure playbooks to organize project workflows, maintain consistency, and keep projects on 
track.

Define a trigger condition in Workflow Studio to use a Playbook, either by selecting an existing 
one or creating a Playbook.

In Project Workspace, Playbooks are triggered by record creation, record update, or both. For 
example, a Playbook created for projects is associated with project records, and the Playbook 
tab appears when a project meets the trigger condition. For more information on how to 
configure a playbook, see Configuring playbooks .

There are two pre-defined project management playbooks available in the Workflow studio:
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• Project default

• Stage-gate default

To configure playbooks, perform these tasks:

1. Navigate to Workflow Studio  and select Playbooks.

2. Create and configure playbooks as per your requirement. For more information, see Create 
and configure playbooks .

3. Activate one of the two pre-defined playbooks for the Project Workspace  and define an 
appropriate trigger condition. For more information, see Activate playbooks  and Triggers .

Multiple playbooks can be enabled at a time, and the trigger should be defined in such a way 
that each project is mapped to only one type of playbook. To activate a playbook, see Activate 
playbooks .

Note: 

When a project template is applied or project is created from a demand, the project 
information is automatically copied into the project record and reflected in the Playbook.

Related topics

Building playbooks

Designing playbooks

Playbooks in Project Workspace

Use Playbooks in Project Workspace

Configuring resources with Project Workspace

Configure various aspects of Resource Management  based on your requirements in Project 
Workspace  to allocate resources for your project.

• Review the Project Workspace  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

• Install Project Workspace.

• Ensure you’ve activated the PPM Standard plugin (com.snc.financial_planning_pmo).

• Ensure you have enabled attributes for Resource Management. For more information, see 
Using the Planning attributes.

Configure financials for Project Workspace

Customize financials view, planning attributes, and activate scheduled jobs to work on the 
financial planning for your projects.

Before you begin
Role required: admin

Procedure

1. Configure the attributes to generate labor costs in financials based on the resource 
assignments on the work items.
For more information, see Using the Planning attributes  and Create or edit planning attributes.

2. Generate default mapping configurations to create table maps.
For more information, see Generate default mapping configurations.
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3. Enable the budget allocation for projects.
For more information, see Enable financial budget allocation for projects in Project Workspace.

4. Define the budget allocation attribute to allocate budget by cost type or expense type.
For more information, see Configure budget attribute at instance-level to allocate budget.

5. Enable the expense type attribute for resource assignments to capture relevant expenses for 
the work.
For more information, see Enable expense type on resource assignments.

6. Create new widgets to view the rolled up financial data at planning item level.
For more information, see Configure a widget and associate it with project.

7. Optional:  Customize the left pane in the financials screen to match the requirements of your 
organization.
For more information, see Customize the left pane view for financials.

8. Customize the Create cost plan form fields to match the requirements of your organization.
For more information, see Customise cost plan form.

9. Customize the default expense types to manage cost plans for your projects and demands.
For more information, see Change the default expense type for projects.

10. Activate and define scheduled job to create financial baselines for your planning items.
For more information, see Activate a scheduled job to create financial baselines for your 
projects.

11. Activate and define a scheduled job to generate labor costs for your projects based on the 
attribute-based resource assignments.
For more information, see Activate a scheduled job to generate labor costs for your projects.

Enable monetary benefit plans for projects

Enable the benefit plans property to create and manage benefit plans for planning items.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open 
sn_invst_pln.enable_benefit_plan_in_new_financials  property.

3. Enter true  in the Value field.

4. Select the Update  button.

Enable financial budget allocation for projects in Project Workspace

Enable allocation property after migrating to Next Experience  to work on budget allocation for 
your projects using Project Workspace.

Before you begin

• For new customers accessing financials in Next Experience, this property is enabled by 
default.

• Role required: admin
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Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open sn_invst_pln.enable_budget_allocation_v2 
property.

3. Update the Value field to True  and select Update.

What to do next
Configure budget attributes to work on managing budget of your planning items. For more 
information, see Configure budget attribute at instance-level to allocate budget.

Configure budget attribute at instance-level to allocate budget

Configure the budget attribute by expense type or cost type as an instance-level to work on 
budget allocations for your projects using Project Workspace.

Before you begin

• Enable the budget allocation property to work on budgeting for projects. For more information, 
see Enable financial budget allocation for projects in Project Workspace.

• Role required: admin

Important: 
Existing customers cannot change the budget attribute to cost_type.

Procedure

1. Navigate to All  > System Properties  > Properties.

2. Filter the Name column to locate and open sn_invst_pln.budget_allocation_attribute 
property.

3. Update the Value field to one of the following.

◦ cost_type  - view financials by cost types such as Hardware Opex, External labor Capex, 
Software Capex, Software Opex, and so on.

◦ expense_type  - view financials by expense types such as Capex and Opex.

4. Select Update.

Enable expense type on resource assignments

Resource assignments have the same expense type as the project or demand for which they’re 
created. Enabling expense type on resource assignments helps you to accurately expense 
different type of expenses for your work.

Before you begin
Role required: admin

Procedure

1. Active and execute the scheduled job.

a. Navigate to All  > System Definition  > Scheduled Jobs.

b. Filter the name field to locate and open Update task type planning attributes on resource 
assignments.

c. Select the Active  option to activate the schedule job.
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d. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.

For more information about the field description and scripts, see Automatically run a script of 
your choosing .

e. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

2. Enable expense type on resource assignments.

a. Navigate to All  > System Definition  > Tables.

b. Filter the name field to locate and open the sn_plng_att_core_resource_assignment  table 
for resource assignments.

c. Select the Show List  related link.

d. Select the Personalize List  ( ) icon.

e. In the Personalize List Column, add Expense type  from the Available list to the Selected list.

f. Select OK.

Result
Expense type  field is enabled on resource assignments for the projects and demands. You can 
expense different expense types to record different work types such as Capex or OpEx.

Configure a widget and associate it with project

Enable and associate a widget to view financial summary of your projects at high-level.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. Select New.

3. On the Widget New Record form, fill the fields.
For a description of the field names, see Widget New Record form.

4. Select the Additional actions menu  and select Save

5. In the Widget associations related list, select New.

6. On the Widget association New Record form, fill the fields.
For a description of the field names, see Widget association form.

7. Select Submit.

Customize the left pane view for financials

Customize the left pane for financials to view custom field information.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate and open the Cost Plan  table.

3. Select the Show List  related link.
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4. Select the financials view by navigating to List controls  > View  > Financials View.
The selected view is displayed on the header.

5. Select the header options to configure list layout.

6. Add or remove the fields in the Selected column to customize the left pane view in financials 
view.

7. Select Save.

Result
Cost plans table with customized fields for Financials View is displayed.

Customise cost plan form

Manage the fields required on the new cost plan form as per your organization needs.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field to locate and open the Cost Plan  table.

3. Select the Design Form  related link.

4. On the header row, select Cost Plan [cost_plan]  from the table list and Financials View  from 
the view list.

5. On the form, you can:

◦ Drag and drop the required fields from the Fields column.

◦ Remove the existing fields using the Remove field icon.

6. Select Save.

Change the default expense type for your projects

Configure the default expense type to create or edit cost plans for your projects.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Properties  > All properties.

2. Filter the name to locate and open the sn_plng_att_core.default.expense_type  table.

3. Change the Value field to the required expense type and select Save.
Opex is the default value.

Create a custom prefix for baseline

Modify the prefix to customize the name of the baselines for your projects.

Before you begin
Role required: admin
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Procedure

1. Navigate to All  > System Properties  > All Properties.

2. Filter the name filed to locate and open sn_invst_pln.baseline_prefix.

3. Modify the Value  field to create a custom prefix for your baselines.

If you’re working on a sales portfolio, you may change the Value  field to Sales baseline 
on.

4. Select Update.

Activate a scheduled job to migrate budget of your projects

Activate the Migrate budget for active demands and projects  scheduled job to migrate budget 
of active projects from Classic UI to Next Experience.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Migrate budget for active demands and projects.

3. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

4. Select Execute Now  to execute the scheduled job or select Update  to save your changes.

Configuring security for a project in Project Workspace

Configure security in a project to make the project confidential to ensure that only the authorized 
users can access the project and its sub projects and related entities.

You can make sensitive projects visible and accessible only to specified users and user groups. 
The security settings applied to a project also apply to sub projects, forms, and related entities 
of the project, ensuring that all project-related data remains protected and accessible only to the 
authorized personnel.

To enable these advanced security features, you need to install the Project Advanced Security 
plugin. The plugin requires the PPM Standard  plugin as a prerequisite.

Related topics

Activate the Project Advanced Security plugin

Enable security for a project in Project Workspace

Activate the Project Advanced Security plugin

Activate the Project Advanced Security plugin to enable project security settings on a project.

Before you begin
Role required: admin
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Procedure

1. Select All  > System Definition  > Plugins.

2. Search for Project Advanced Security  and install it.

Related topics

Configuring security for a project in Project Workspace

Enable security for a project in Project Workspace

Enable security for a project in Project Workspace

Enable security in a project to make the project confidential to ensure that only authorized users 
can access the project and its related sub projects and entities.

Before you begin
Install the Project Advanced Security plugin.

Role required: admin

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Details page of the project by selecting Details  from the list.

3. Scroll down all the way to locate Confidential  and select it.

4. In the following fields, specify the users and user groups that can access the project.

You need to specify at least one user or user group for access.

The confidential project can be accessed by Allowed users, Allowed groups, the Assigned to 
user, Additional assignee, the Project Manager, and the administrator.

5. Select Save.

Once you make the project confidential, the confidentiality setting is applied to the project, all 
sub projects, and entities such as cost plans, cost plan breakdowns, benefit plans, benefit plan 
breakdowns, expense lines, time cards, status reports, baselines, story, investment object, 
project tasks, resource plan, resource assignments, and RIDAC.

These will only be accessible to individuals who have been explicitly added to the project.

This setting applies to all associated workspaces. If the project is marked confidential in one 
workspace, it is automatically made confidential across all other workspaces, including:

◦ Project Management Workspace

◦ Resource Management Workspace

◦ Strategic Portfolio Workspace

Related topics

Configuring security for a project in Project Workspace

Managing projects with Project Workspace

Use the features of Project Workspace  to plan and manage your project.
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Access the new Project Workspace

Learn how to navigate to the new Project Workspace  and open a project in the planning page.

Before you begin
Install Project Workspace.

Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. Depending on the projects that you want to view, select My Projects  or All Projects.

Projects on the homepage can be viewed in card or list view.

3. Select a project to open it in the planning page.

What to do next
Create a project from Project Workspace

Create a project from Project Workspace

Use Project Workspace  to create a project and start planning for your project tasks.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. Select New  to create project from the homepage.

3. On the form, fill in the fields.

For field information, see Project form in Project Workspace.

4. Select Confirm.

What to do next

• Update the project details from Project Workspace

• Personalize the planning page view in Project Workspace

Update the project details from Project Workspace

Update the details of a project to reflect the updates or changed priorities using the details page 
from Project Workspace.

Before you begin
Role required: it_project_manager

About this task
You can edit the Project, project dates, business case, financials, score, notes, and preferences 
for a project. Use the related tabs on the details page to view and edit the Project tasks, Sub-
projects, Requirements, Resource Plans, Cost Plans, Monetary, and others.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1500



Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the details page of the project by selecting Details  from the left menu.

3. Edit the fields that you want to update.

In the Project Workspace, you can add stakeholders, extend or confirm a resource plan, and 
add new resource allocations daily. You can also view the status report of the program and 
save the project as a template with the Save as New Template  option.

From the Project Workspace, you can create an Agile phase or a Test phase. You can also 
create stories or add existing ones to the project, as well as add new epics.

You can refine project description using the write planning item skill if you have Now assist for 
SPM application installed.

4. Select Save.
You can view the project or project task details from the side panel. Select Open task in the 

new tab ( ) icon to open the project in a new tab. You can use the Full Details page to add 
work notes, attachments, and view related lists of a project or task.

Generate and track project details from AI insights page

Generate and monitor project insights directly from AI insights page in Project Workspace.

Before you begin
Ensure that the Project insights generation skill is active.

Role required: it_project_manager

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open AI insights page by selecting AI insights  from the list.

3. Select Generate insights  to generate AI insights of your project.
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Project insights are generated using the same Project insights generation skill used for email 
insights. Insights are displayed directly in the in‑app  AI insights experience.

4. Review the generation project insights.

Result
The project insights are generated from the AI insights page with access to current project 
insights in a single in‑app  view.

What to do next

• View and reuse stored insights:

◦ Generated insights are stored and reused based on a defined date threshold.

◦ When you revisit the AI Insights page, previously generated insights are displayed if they are 
still within the threshold.

• Regenerate project insights:

◦ From the AI insights page, select Regenerate  icon.

◦ Now Assist generates updated project insights.
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Generate a project plan using project plan generation skill

Use Project plan generation skill to generate a project plan from natural language input, 
uploaded files, or both.

Before you begin
Role required: it_project_manager

• Install Now Assist for Strategic Portfolio Management (SPM)  plugin.

• To use attachments to generate a project, activate the document intelligence skill. The default 
LLM is Azure OpenAI. Switching to a different model may affect accuracy.

• The project plan generation skill is activated by default. For more information on how to 
activate the skill if it isn't automatically activated or if you want to change the skill configuration, 
see Configure Now Assist Admin features.

About this task
Now Assist  scans your project and task details to generate content. Review and edit the output 
before creating the project. Supported file types are word, pdf, excel, and powerpoint, with a 5 
MB file size limit. Only the first five attachments are processed.

For project and task supported column configurations, see Supported columns for project and 
task generation.

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. Select Generate project  to use Now Assist to generate a project.

To create a project without using Now Assist, use New project from template  or New project 
options.

3. Provide your project input using one or more of these methods.

◦ In the text field, describe your project using natural language. If you provide only natural 
language input, the document intelligence skill is not required.

◦ Select Attach files and upload a word, pdf, excel, or powerpoint document. To use file 
attachments, activate the document intelligence skill. For more information, see Activate a 
Now Assist in Document Intelligence skill .
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Note: 
Attach a file or enter context as free-form text before proceeding. No input returns an 
error. Insufficient context may also trigger an error.

4. Select Next  to generate the project.

5. Select Create project.

6. Review the pre-populated project name, approved start date, approved end date, or business 
case.

Edit the fields as needed and add a description.

Note: 
Because the information in these fields is automatically generated, it's a good idea to 
review the text and make sure it's accurate.

Result
The project is created with the generated tasks, including task hierarchy and dates derived from 
your input.

Example: Generate a project plan from an Excel file

Input: An excel file with two sheets:

• Sheet 1: Project details such as project name, start and end dates, budget, and key objectives.

• Sheet 2: 18 tasks with task name, phase, start date, end date, and duration.

Output AI reads the file and creates the following:

• Project record with: Name, description, start and end dates, and business case derived from 
the key objectives.

• 18 task records with: Task name, description, start and end dates, duration, and state. Fields 
not present in the file, such as key milestone and time constraint, are auto-populated with 
default values.

Generate tasks for a project using project plan generation skill

Use project plan generation skill to populate an empty project with tasks by providing text input, 
uploading files, or both.

Before you begin
Role required: it_project_manager
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• Install Now Assist for Strategic Portfolio Management (SPM)  plugin.

• To use attachments to generate a project, activate the document intelligence skill. The default 
LLM is Azure OpenAI. Switching to a different model may affect accuracy.

• The project plan generation skill is activated by default. For more information on how to 
activate the skill if it isn't automatically activated or if you want to change the skill configuration, 
see Configure Now Assist Admin features.

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. Create a project or open any project without tasks.

3. Select Generate tasks  to use Now Assist  to generate tasks.

To create a project task without using Now Assist, use Add Task  option.

4. Provide your project task input using one or more of these methods.

◦ In the text field, describe your project tasks using natural language. If you provide only 
natural language input, the document intelligence skill is not required.

◦ Select Attach files and upload a word, pdf, excel, or powerpoint document. A preview of the 
attachment appears before you proceed. To use file attachments, activate the document 
intelligence skill. For more information, see Activate a Now Assist in Document Intelligence 
skill .

Note: 
Attach a file or enter context as free-form text before proceeding. No input returns an 
error. Insufficient context may also trigger an error.

5. Select Submit  to generate the project.

6. Review the task details for a project on the planning page.
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Note: 
Because the information in these fields is automatically generated, it's a good idea to 
review the text and make sure it's accurate.

Result
The project is created with the generated tasks, including task hierarchy and dates derived from 
your input.

Example: Generate tasks for an empty project

Input: A project manager types the following in the text input: Create tasks for a website redesign 
project starting May 1, 2026 and ending July 31, 2026. Tasks include requirements gathering, UI 
design, and user acceptance testing.

Output AI creates three task records: Requirements gathering, UI design, and user acceptance 
testing. Each task is populated with a name, description, start and end dates, and duration. 
Fields not present in the input are auto-populated with default values.

Create an Asset Project Request from Project Workspace

Create a new asset project request directly from Project Workspace  and associate it to a project 
for tracking and reporting purpose.

Before you begin
Role required: it_project_manager or asset manager or portfolio manager

About this task
Portfolio and project managers can create and track asset requests across multiple projects. 
Asset requests become part of the SPM project tracking and reporting workflow.

Procedure

1. Open a project from the home page of Project Workspace.
For information, see Access the new Project Workspace.

2. Open the details page of the project by selecting Details  from the list.

3. Select Asset Project Requests  related link and select New.

4. From the Create Asset Project Request form:

a. Select the appropriate Request item.

b. Verify that the Project  field.

5. Select Save.

Result
A new asset project request is created and linked to the project. The request appears in the 
Asset Project Requests list for the project.
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View asset project requests for a project

Analyze asset project requests associated with a project from Project Workspace, so you can 
track hardware requests and refresh activities linked to the project plan.

Before you begin
Role required: it_project_manager or asset manager or portfolio manager

About this task
This helps portfolio or project managers quickly understand which asset requests are tied to the 
project and track their current status.

Procedure

1. Open a project from the home page of Project Workspace.
For information, see Access the new Project Workspace.

2. Open the details page of the project by selecting Details  from the list.

3. Select Asset Project Requests  related link.

4. From asset project requests list, view the list of asset project requests tagged to the project.

Result
You can see all hardware asset requests and refresh requests associated with the project.

Use Playbooks in Project Workspace

Plan your project stages and assign specific actions to each stage using Playbooks.

https://player.vimeo.com/video/1156991435?
h=3b5cf5de67&badge=0&autopause=0&player_id=0&app_id=58479%22

Before you begin
Role required: admin or project_manager

As a system administrator, ensure that a playbook is activate or created before use.

About this task
A playbook defines the standard stages of a project (for example, Initiation, Planning, Execution, 
Monitoring, and Closure) and includes activities or action items to complete at each stage.

There are two playbooks for Project Workspace. This task topic follows the Project default 
playbook. It’s a PMBOK standard playbook comprising five stages: Initiation, Planning, Execution, 
Monitoring and Delivering, and Closure. Each stage consists of activities, action items, or steps 
that guide the project manager in successfully completing the project.

You can view the Playbook  menu only if a playbook is active and the project matches the 
trigger condition defined for that playbook. The playbook is displayed only when the project 
meets the defined trigger conditions. Two playbooks are available in Workflow Studio for Project 
Workspace.

Procedure

1. Navigate to Workspaces  > Project Workspace  and Create a project.

2. Use an existing playbook or create a new one.

◦ To create a new playbook, define the trigger condition in Workflow Studio. For more 
information, see Triggers .

◦ To use an existing playbook:
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a. From the menu, select Playbooks.

b. For each stage, select Mark complete, or Skip, or Save.

Note: 

▪ Select Save  to save the stage, or Skip  to skip the stage.

▪ When you select Mark Complete  or Skip, the activity becomes read-only.

▪ A stage is marked complete once all activities within it are either completed or 
skipped.

▪ Use the Restart  option (available at both the activity and stage levels) to revisit or 
edit completed or skipped activities.

For more information on how to use playbooks, see Building playbooks  and Designing 
playbooks .

Related topics

Running playbooks

Playbooks across ServiceNow AI Platform®

Playbooks reference

Playbooks configuration

Playbooks in Project Workspace

Analyze project analytics from Project Workspace

View the summary of a project in Analytics  tab of Project Workspace.

Before you begin
Note: 
The Project Summary Waterfall, Hybrid, and Scrum dashboards are available in the Next 
experience UI framework.

Role required: it_project_user

About this task
The Analytics tab is a dashboard that showcases preconfigured widgets and reports to monitor 
the progress of a project, including aspects like open risks, actual costs, and delayed milestones. 
The reports aggregate data from the fields in the project form. For details on the various widgets 
and reports available for different project types, see the Project analytics widgets and reports.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the analytics page of the project by selecting Analytics  from the list.

3. Review the displayed reports and take necessary actions, if required.

Widgets and reports for project analytics

Widgets and reports that provide information for the project summary in the Analytics page of 
the project workspace for Agile, Waterfall, and Hybrid projects.
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Project widgets and reports

Widgets and reports provide information that enables you to view and track the progress of your 
Agile, Waterfall, and Hybrid project.

Note: 
You must have the Agile Development 2.0  plugin installed to view the widgets and reports 
for your Agile and Hybrid projects. The Project Summary Waterfall, Hybrid, and Scrum 
dashboards are available in the Next experience UI framework.

Your system administrator can configure the widgets and reports in the dashboard to display 
project information on the Analytics  page. The following dashboards are available:

Project Execution Type Dashboard Displayed Description

Hybrid Project Summary – Hybrid Contains reports and widgets 
for hybrid projects.

Agile Project Summary – Scrum Contains reports and widgets 
for agile projects.

Waterfall Project Summary – Waterfall

Note: 
This dashboard was 
previously known 
as Project Manager 
Summary Dashboard.

Contains reports and widgets 
for waterfall projects.

The project execution type determines the dashboard displayed on the Analytics  page.

You can also embed a custom dashboard in the Analytics  page. Your system admin can 
modify the PMViewDataUtils  script include and configure the variable value for the 
dashboards_tabs  in the getDashboardUrl  method. As a result, you can view the custom 
dashboard in Project Analytics. For example:

var dashboards_tabs =
 
      {
             waterfall: {
                         dashboard_sysId: 
 '5d4959dd878003008b9b3a0548cb0bd0',
                         tab_sysId: 
 '1d99d5dd878003008b9b3a0548cb0bbd'
                             },
             hybrid: {
                         dashboard_sysId: 
 '96dc46c78700330047d84c2c59cb0bf1',
                         tab_sysId: 
 '520d4ac78700330047d84c2c59cb0bab'
                              },
             agile: {
                         dashboard_sysId: 
 'f3dd4ec78700330047d84c2c59cb0b93&tab',
                         tab_sysId: 
 '52fd8ec78700330047d84c2c59cb0bae'
                              },
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             any_other_executionType: {
                         dashboard_sysId: 
 'custom_dashboard_sys_id',
                         tab_sysId: 
 'custom_dashboard_tab_sys_id'
                              },
         };

The following widgets and reports for all project types are provided in the Analytics  page to help 
the project manager analyze the project.

Widgets and reports for Agile project

Name Description

Stories Missing Acceptance Criteria Number of stories in the project without 
acceptance criteria information.

Stories Missing Points Number of stories in the project with the 
Points  field blank.

Stories Acceptance Overdue Number of stories in the project that are not 
in the Completed or Cancelled state after the 
sprint end.

Team-wise Sprint Status Track the sprint-wise status of various scrum 
teams across the release. Click the team name 
to view sprint details.

Stories by State Donut chart showing the number of stories in 
different stages of development such as Draft, 
Ready, and WIP. Click the appropriate state to 
view details of the stories.

Progress by Points Track the progress of the project based on 
points. You can group and stack stories based 
on any combination of Epic, Assignment 
group, and State.

Progress by Stories Track the progress of the project based on the 
number of stories. You can group and stack 
stories based on Epic, Assignment group, and 
state.

Widgets and reports for Waterfall and Hybrid project

Name Description

Issues Number of issues in the Pending, Open, 
and Work In Progress states included in the 
project.

Actions Number of action items in the Pending, Open, 
and Work In Progress states for the project.

Change Requests Number of change requests in the Pending, 
Open, and Work In Progress states for the 
project.
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Widgets and reports for Waterfall and Hybrid project  (continued)

Name Description

Stories by State Pie chart showing the number of stories in 
different stages of development such as Draft, 
Ready, and WIP. Click the appropriate state to 
view the details for the stories.

Note: 
This widget is applicable for Hybrid 
projects only.

Tasks by State Donut chart showing the number of project 
tasks in different stages of development such 
as Pending, Open, Work In Progress, and 
Closed Complete. Click the appropriate state 
to view the task details.

Project Member Allocation Details (Hrs) Stacked bar chart showing allocated and 
actual hours of the resources assigned to the 
project.

Project Member Allocation Details — Monthly 
(Hrs)

Pivot chart showing the monthly allocated and 
actual hours for the resources assigned to the 
project.

Task Assignments Track the state of various project tasks across 
the release based on the assigned users or 
group. Click the user or group name to view 
the details of the assigned tasks.

Resource Plans by State Donut chart showing the number of resource 
plans grouped according to their current state.

Overdue Tasks and Milestones List of overdue project tasks and milestones, 
which are the tasks that satisfy either of 
the following conditions in the Project Task 
[pm_project_task] table:

• The value of the Planned start date  is 
before today's date and the State  value is 
Open or Pending.

• The value of the Shadow  field is set to false.

Upcoming Tasks (next 2 weeks) with no 
assignee

List of unassigned Open or Pending project 
tasks that are planned to start 14 days from the 
current date.

Common widgets

Name Description

Phase Current state of the project such as Initiating 
or Planning.

Status Color indicator that signifies the status of the 
project.
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Common widgets  (continued)

Name Description

Percent Complete Percentage of the project that has been 
completed.

Time Elapsed Amount of time that has passed while working 
on the project from the actual start date to the 
planned end date.

If the project is in the Open or Pending state, 
then the time elapsed is calculated based on 
the Planned start date and the current date.

Risks Number of risks in the Pending, Achieved, and 
Not Achieved states concerning the project.

Cost Trend Analysis Line graph showing a comparison between 
the planned costs and actual costs on a 
monthly basis.

Monetary Benefit Trend Analysis Line graph showing a trend of planned 
financial benefits on a monthly basis.

Non-monetary Benefit Plans Breakdown of the number of non-monetary 
benefit plans for active projects along with its 
associated benefit plans.

Non-monetary Planned vs Actual Benefits Comparison of total planned and actual non-
financial benefits for active projects grouped 
by fiscal period.

Confirmed vs Allocated vs Actual Hours Comparison of total confirmed, allocated, and 
actual hours for the project.

Time Cards — Pending Approval Time cards for the selected project that are 
submitted but not yet approved.

Time Card — Exception Report List of users who did not submit their time 
cards for the selected project, and time cards 
that are not yet approved for the selected 
project. The exception report is generated for 
users who are assigned to a task in progress, 
or hard-allocated to the project or task.

Personalize the planning page view in Project Workspace

Customize the display of the planning page. Choose the data you want to see on the data grid 
and the timeline.

Before you begin
Role required: it_project_manager

About this task
Steps 2 through 4 provide guidance on customizing various aspects of the workspace. Choose 
the options that you want to apply.
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Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Use the side panel to customize your planning page view.

a. Select the Settings icon ( ).
The Settings side panel opens.

b. From the Columns tab, select the columns that you want to see on the data grid of the 
planning console.
These columns provide information of the project tasks.

c. From the General tab, choose the attributes that you want to see on the timeline view, such 
as the dependency lines, critical path, or the project task names on the bars.
Use the Display summary task option to show all the project tasks grouped under one project 
summary task.

d. From the Advanced tab, choose to enable the auto-save option, change the date format for 
the planned date columns, and change the mode of calculation as Manual or Automatic.
You can change the calculation mode from Automatic to Manual, from the workspace, only if 
the project has no tasks.

3. View additional columns to the project tasks in the planning page view.

If you want additional columns to be displayed in the planning page view, other than those 
fields available in the side panel, you can do so by customizing the Project Workspace  view of 
the project task list (pm_project_task_list.do). See Add new columns to the planning page.

Note: 
You can personalize your settings for timescale, Displaying summary tasks, Bar labels, 
and Dependency lines. Any changes you make to the Display summary task settings and 
timescale view is saved in the preferences.

4. Reduce or increase the visibility of the project period on the timeline by changing the 
timescale.

Select the timescale icon ( ) and choose from Day, Week, Month, Quarter, Year, or Autofit.

Add new columns to the planning page

Display new columns on the planning page of the new project workspace so that your project 
managers can view custom fields for the project tasks on the planning page.

Before you begin
Role required: it_project_manager

About this task
The project tasks displayed in the planning page of the new project workspace show the fields 
according to the Project Workspace  view of the pm_project_task table. To display new fields, you 
must personalize this Project Workspace  view of the pm_project_task table.
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Procedure

1. Navigate to pm_project_task_list.do.

2. Change the view to Project Workspace.

a. Right-click the header and select View.

b. Select Project Workspace

3. Add the necessary columns to the list.

a. Select the personalize list icon ( ).

b. Move the required fields from available to selected.

c. Select OK.

Result
The Project Workspace  view of the pm_project_task table is updated according to your changes. 
The planning page of the new project workspace reflects these changes.

Create and assign project tasks from Project Workspace

Add new tasks for your projects and assign them to your team directly from the new Project 
Workspace.

Before you begin
Role required: it_project_manager

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Select Add Task.

A new row is added to the bottom of the data grid of the planning page, with New Task  as the 
default name for the task.

Alternatively, select a project task row and select the Add task below icon ( ). This action 
adds a new task right after the task that you selected.

3. Edit the details of the task.
For example, task name, planned dates, assigned to, and others.

4. Optional:  Press the Enter key to save the details and create a row for another task.

5. Select anywhere on the data grid outside the task fields to save the details.

6. Assign a task to a user by updating the Assigned to  field.

The user who is assigned this task to, is sent an email notification and is also notified in the 
ServiceNow®  instance when they log in.

For notifications to work, your admin must enable them by setting the Project task assigned to 
notification record as true  in Email Notifications and Provider Notifications.
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What to do next

• Make the new task a subtask of an existing task or a sub project by using the indent task 

icon( ).

• Update a project task from the Project Workspace.

Update a project task from the Project Workspace

Update the details of existing tasks from the planning page of the Project Workspace.

Before you begin
Role required: it_project_manager, it_project_user

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. From the list of tasks on the data grid, select a task that you want to update.
The task details open in the side panel.

3. Edit the fields.

4. Select Update.

Create checklist items for a project task

Create checklist items for a project task to track items to be completed in the task.

Before you begin
Role required: it_project_user, it_project_manager

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Navigate to a project task.

3. Select project tasks and then select the checklist icon ( ) from the side panel to add 
checklist items.
You can add, edit, organize, or remove checklist items as needed.

4. Create a checklist item by entering the checklist name and press enter.

5. Select Save  to save the checklist items.

To edit a checklist item for a task, select edit item icon ( ) in the checklist section. This option 
appears when there is at least one checklist in the Checklist side panel. To remove a checklist 

from the project task, select remove item icon ( ).

Related topics

Project task checklist items

Add internal project task dependencies from Project Workspace

Create dependencies between project tasks using the interactive UI of Project Workspace.
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Before you begin
Verify that you have the Dependency Lines toggle enabled on the settings of the timeline. For 
information on how to update the settings, see Personalize the planning page view in Project 
Workspace.

Role required: it_project_manager

Procedure

1. Select a project to open it from the planning page.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Create task dependencies in one of the following ways.
The created dependency is shown as a line between the two task bars, on the timeline view.

What to do next
You can edit the dependency. For more information, see Update the dependency details for 
tasks from Project Workspace.

Update the dependency details for tasks from Project Workspace

Update the details of the dependency including its type and lag time from Project Workspace.

Before you begin
Role required: it_project_manager

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the dependency side panel in one of the two ways.

3. Edit the fields.

4. Select Update.

Add external dependencies between projects from Project Workspace

Set up a dependency between tasks of different projects using the new Project Workspace.

Before you begin
Role required: it_project_manager

About this task
External dependencies help you understand the impact on project schedules when there 
is a change in the predecessor task. Use the row context menu of your project task to add a 
dependency from the task of a different project.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. From the data grid, select the project task to which you want to add the dependency.
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3. Select the row context menu ( ) of the task and select Add external dependency.

4. On the External Dependency form, select the Project  to which the external task belongs.

5. Select the Task  for which the dependency is added.

6. Select the Dependency type.

7. Select Submit.
The default selection is Hard. In a hard dependency, any changes made in the predecessor 
project are automatically propagated to the successor project.

Result

• Dependency is created for the tasks of the two projects.

• The short description of your project is greyed out and is renamed to indicate the external 
dependency in the format of External project name: External task name

• A link icon ( ) is added to the short description cell of the task, to indicate the dependency.

What to do next
You can navigate to the external project directly from the current project to view the status or 
update the details of the predecessor task. From the row context menu of the dependent task, 
select View project.

Related topics

Adding external dependencies for projects

Create and compare project baselines in Project Workspace

Create a schedule baseline and financial baseline of a project. A baseline is a snapshot of the 
project's progress at the particular moment of time.

Before you begin
Role required: it_project_manager

About this task
Create as many baselines as necessary to review the changes made to and progress of your 
project by comparing these baselines. Comparing baselines helps you understand the real-time 
deviations between planned and actual values of the project tasks.

Note: 
If your project has sub projects in it, you cannot create baselines for them from the planning 
page view.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Create a baseline for the project.

a. Select the Baselines icon ( ).

b. Select Create new.
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c. On the form, fill in the fields.
Provide the name and description for the baseline, and select Schedule baseline or 
Financial baseline, or both.

d. Select Save.

A baseline is created for the current day and is listed when you select Baselines ( ).

3. Compare baselines for the project.

a. Select the Baselines icon ( ).

b. From the list of available baselines, select the ones that you want to compare.
You can select up to two baselines.

c. Select Apply.

◦ On the timeline view, the baseline appears as a set of grey lines following the task bars. 
These grey lines represent the planned dates while the task bars represent the actual dates.

◦ On the grid view, you can add the columns related to baselines that show the following 
information of the selected baselines. You can select these columns from the Settings side 

panel ( )

▪ Start date

▪ End date

▪ Variance

Trouble? 
If you don't see the baseline columns on the data grid, refresh the workspace using the 

Refresh icon .

Create a status report template in Project Workspace

Create a custom template for status reporting in Project Workspace. Use the template to create 
status reports according to your specific requirements.

Before you begin
Role required: it_project_manager

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Select Doc Templates .

3. Select New.

4. On the Create new document template form, fill in the fields.

For a description of the field values, see Create new document template form.
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5. Select Save.

Note: 

In the Project Workspace, the it_project_manager role is required to create a document 
template. The option to create a document template from the Project Workspace  is 
available only to users with the Project Manager role.

If your role has create access to document templates at the platform level, you can still 
create a template even without the it_project_manager role. While it_project_manager 
controls visibility within the Project Workspace, the ability to create templates is 
ultimately governed by platform-level Access Control Lists (ACLs).

Result
The template you created appears as an option when you try to create a status report: Create a 
status report in Project Workspace.

Related topics

Status reporting in Project Workspace

Create a status report in Project Workspace

Analyze the status report in Project Workspace

Duplicate a status report in Project Workspace

Import old project status report to Project Workspace

Add dynamic content to status report in Project Workspace

Generate a project status report with Now Assist

Generate an AI‑assisted  project status report with predicted health indicators. Now assist pre-
populates project health, an executive summary, and supporting rationale based on weekly 
project data.

Before you begin
Role required: it_project_manager

About this task
When the Project status generation skill is enabled, project managers can generate a status 
report pre‑populated  by Now Assist. Now Assist predicts overall and dimension‑level  project 
health (such as schedule, cost, resources, and scope), generates an executive summary using 
weekly project data, and provides a rationale for each prediction.

After generation, project managers can review:
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• Predicted overall health

• Predicted dimension statuses

• Explanation/rationale text for each prediction in analysis sections

• Executive summary text generated from the project’s recent data

After submission, the same information appears in the report view, including rationale text (for 
example, a rationale/status explanation column).

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Status reports page of the project by selecting Status Reports  from the list.

3. From the Pages section, select Generate status report.
The system invokes LLM to pre-populate the form with predicted fields and an executive 
summary.

4. Review the AI-generated fields:
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◦ Overall health (predicted)

◦ Dimension health such as schedule/cost/resources/scope (predicted)

◦ Executive summary (generated from project data for the reporting period)

◦ Rationale/analysis sections explaining each prediction (for example, schedule health 
analysis, cost health analysis).

5. Edit any fields as needed.

6. Select Submit.

7. Optional:  Verify the submitted report.

8. Optional:  Select Now Assist  to ask more questions on the generated status report or select 
Summarize  to generate a short summary of generated report.

(Optional) You can export and edit the AI‑generated  status report. You cannot duplicate an 
AI‑generated  status report.

Result
An AI-assisted status report is generated with predicted health values, an executive summary, 
and rationale text.

Create a status report in Project Workspace

Create a status report in Project Workspace  for your projects. Your team can view the report and 
be updated on project health, metrics, risks, issues, and milestones.

Before you begin
Role required: it_pps_admin, it_project_manager

About this task

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Status reports page of the project by selecting Status Reports  from the list.

3. From the Pages section, select Create status report.

4. Optional:  To create status report from a template:

a. From the Pages section, select Create new from template  from the drop down.

b. From the "Welcome to your Template Center!" screen, select Use  for the template that you 
want to use.

5. On the Create status report form, fill in the fields.
For a description of the field values, see Create status report form.

6. Select Submit.
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Note: 
The status report appears with the data and information that you entered populated in 
the default status report template. You can replace the existing default template with 
your desired template and set it as default by updating the sys id in value field of system 
property (sn_pw.project_status_report_default_templateId).

7. Optional:  Select the More actions  icon and then perform these steps.

a. Select Export as PDF  to share and archive a PDF version of the report.

b. Select Keyboard shortcuts  to view keyboard shortcuts on status report

c. Select Hide Live Presence  to hide the live presence.

d. Select Edit status report  to open and edit the status report.

e. Select Duplicate status report  to create a copy of status report.

(Optional) You can’t edit the status report. To edit the status report, you can disable the 
status report read-only system property (sn_pw.status_report_doc_read_only). By default, it 
is set to true, and the status report is read only.

8. Make changes to the report by editing the data, formatting, organizing the content, and 
entering additional data.

The changes you make to the status report here are saved to the underlying status report 
record, which you access from the status report related list in Projects form.

9. Observe and monitor the report.

For more information on viewing and analyzing status reports, see Analyze the status report in 
Project Workspace.

If you don’t have old status reports, you can't see the import option. For more information on 
importing existing status report, see Import old project status report to Project Workspace.
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Related topics

Add dynamic content to status report in Project Workspace

Status reporting in Project Workspace

Analyze the status report in Project Workspace

Import old project status report to Project Workspace

Create a status report template in Project Workspace

Analyze the status report in Project Workspace

Observe a status report in Project Workspace  for your project to learn about project health, 
metrics, risks, issues, and milestones.

Before you begin
Role required: it_pps_admin, it_project_manager

About this task
The following are the headers in a report created using the Default status report template. A 
report created using the One-page status report template has fewer information headers.

Aspect Description

Overview View a high-level summary of the project, 
including key details such as phase, health, 
and % completion.

Key Milestones Track critical project milestones, comparing 
planned vs actual dates and identifying any 
variances.

Cost (Planned vs Actual) Compare planned project costs to actual 
expenditures over time, helping identify 
budget deviations.

Resources (Allocated vs Actual) Analyze planned resource allocation versus 
actual usage, helping identify resource over/
under-utilization.

Schedule Evaluate the project’s timeline, identifying 
delays and comparing planned vs actual task 
completion.

Risks Assess potential risks, their probability, 
impact, and current mitigation plans.

Issues Identify ongoing issues affecting the project, 
with ownership and target resolution dates.

Dependencies Assess external or internal factors that could 
impact the project’s progress or completion.

You can also compare two reports to compare and analyze the progress.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Status report page of the project by selecting Status Reports  from the list.
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3. From the Pages section, select the name of the status report you want to view.

4. Observe and monitor the report.

Related topics

Status reporting in Project Workspace

Create a status report template in Project Workspace

Create a status report in Project Workspace

Update status report in Project Workspace

Import old project status report to Project Workspace

Add dynamic content to status report in Project Workspace

Update status report in Project Workspace

Modify a status report in Project Workspace  for your project to update project health, metrics, 
risks, issues, and milestones.

Before you begin
Role required: it_pps_admin, it_project_manager

About this task
By default, the status report is read-only and the 
sn_pw.status_report_doc_read_only  system property is set to true. To edit the status 
report, you can disable this system property by setting it to false. Once you change the property 
to false, you can edit or update the report. You can also navigate to the Details page and set 
Allow edit status report  field to true.

Any updates made on the status report form are reflected in the status report, regardless of 
whether the property is set to true or false.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Status reports page of the project by selecting Status Reports  from the list.

3. From the Pages section, select the name of the status report you want to update.

4. Select the More actions  icon and select Edit status report  to edit the status report.

◦ When editing is disabled, all fields in the status report are read-only.

◦ When editing is enabled, only dynamic fields in the status report remain read-only and you 
can add any static or manual information in the report.

◦ You can still edit the dynamic fields in both the scenarios using Edit Status Report option.

5. Make changes to the report by editing the data, formatting, organizing the content, and 
entering additional data.

To edit the sn_pw.status_report_doc_read_only 
property, enter sys_properties.list. In the list, search for 
sn_pw.status_report_doc_read_only. You can modify the Value  field and select 
Update.

If the existing status reports are incompatible with the new changes, following actions are 
taken. These actions are applicable on both status report and project status form:
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◦ If a report is read-only, it automatically updates to the new format without notification.

◦ If a report is editable, a message appears prompting you to copy the static data and 
regenerate the report.

◦ A Regenerate button is provided, which allows you to regenerate the report and ensure 
compatibility with the new updates.

Related topics

Import old project status report to Project Workspace

Add dynamic content to status report in Project Workspace

Duplicate a status report in Project Workspace

Save time by duplicating an existing status report to copy all the project details without having to 
copy the information manually in the Project Workspace.

Before you begin
Role required: it_project_manager

Procedure

1. Create a status report in Project Workspace.
The status report appears with the data and information that you entered populated.

2. Optional:  Make changes to the report by editing the data, formatting, organizing the content, 
and entering additional data.

(Optional) The changes you make to the status report here are saved to the status report in the 
project workspace and also get saved to the underlying status report record, which you access 
from the status report related list in Projects form.

3. Select the More actions  icon and select Duplicate status report  to create a copy of status 
report.

◦ The duplicated report reflects the latest project status and metrics.

◦ Any static or manually added information from the original report is retained in the 
duplicated version.

◦ The dynamic data refreshes to the current date and shows the latest information.
The new status report is added to the same location as the original status report.

Related topics

Status reporting in Project Workspace

Analyze the status report in Project Workspace

Import old project status report to Project Workspace

Add dynamic content to status report in Project Workspace

Create a status report template in Project Workspace

Import old project status report to Project Workspace

Migrate your old status reports from the classic Project Workspace  to the new Project Workspace 
and optimize reporting process of your projects.

Before you begin
Role required: it_pps_admin, it_project_manager
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Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Status reports page of the project by selecting Status Reports from the list.

3. From the Pages section, select Create status report  and select Import existing status report.

By default, the create status report and create new from template options are visible, while the 
import existing status report option appears only if an old status report exists.

4. Select Import  to import old status report to new reporting tool.

You can export a status report at the project level from the classic Project Workspace  using 
the Export status reports to Next Experience  link. You can export a status report at the record 
level using the Export to Next Experience  link.

Related topics

Add dynamic content to status report in Project Workspace

Create a status report template in Project Workspace

Update status report in Project Workspace

Analyze the status report in Project Workspace

Duplicate a status report in Project Workspace

Add dynamic content to status report in Project Workspace

Add dynamic content to a status report in Project Workspace  for your projects. The dynamic 
content gets updated automatically in the status report as a change is made to the record.

Before you begin
Role required: it_pps_admin, it_project_manager

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the Docs template page of the project by selecting Docs template  from the list.

3. From Docs template  page, select the template to open it.

4. Select Doc  tab and select at the appropriate place and then type /  (forward slash) to open 
a list of actions, including Mention a user  or Mention a record  or Insert dynamic content  as 
required.

a. You can type in /  (forward slash) and select Mention a user  to tag a user.

b. You can type in /  (forward slash) and select Mention a record  to insert a record.
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Once you insert a record, it is embedded as a link, which you can click to open the related 
record and see its details.

c. You can type in /  (forward slash) and select Insert a dynamic content  to add insert dynamic 
content in the status report.

Using insert dynamic content option, you can configure and view the status date, project, 
and other dynamic data in your status report template. This option is only available if Is 
dynamic  field is selected in the Doc template form. You can select formatting options such 
headings, bullets, and others.

5. Observe and monitor the report.

For more information on viewing and analyzing status reports, see Analyze the status report in 
Project Workspace.

Related topics

Status reporting in Project Workspace

Create a status report template in Project Workspace

Create a status report in Project Workspace

Analyze the status report in Project Workspace

Duplicate a status report in Project Workspace

Import old project status report to Project Workspace

Collaborate with stakeholders from Project Workspace

Add comments and attachments to the project or a project task and share them with other users 
of your organization. Collaborate and verify that your project is in line with your organizational 
priorities.
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Before you begin
Role required: it_project_manager

About this task
Browse and upload files from your computer. Add comments and tag stakeholders for their 
feedback or notes.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Attach files to your project or project task.

3. Add comments or tag stakeholders to draw their attention to an attachment or information 
about the project.
You can add comments directly at the project level or for a project task.

Collaborate on projects using Docs

Collaborate with team members, save notes, create project charters, and project briefs using 
Docs.

Before you begin
Role required: it_project_user

Procedure

1. Open a project in Project Workspace.
For more information, see Access the new Project Workspace.

2. Open the docs page of the project by selecting Docs  from the list.

3. From the Pages section, select Create page  and then select Create Page from template  if you 
want to add a template for your document.

4. You can perform these tasks under the Docs  page:
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◦ Use the forward slash on the keyboard to open a list of actions, including Mention a user  or 
Mention a record  as required.

◦ Use the feature of live presence to see who is opening or working on a Doc.

◦ Create templates for documents such as project charters, project briefs, and meeting notes.

◦ Add meeting notes to record discussions, decisions, action items, and any relevant 
information discussed during meetings.

◦ Store information related to your tasks, add images, or tables and collaborate in real-time 
using Docs.

◦ Select the more actions menu to delete, duplicate, or create child pages in the pages 
section.

◦ Apply rich text paragraph formatting, which includes headings, lists, alignment, and other 
styling options.

Generate the summary for selected or complete content with Project doc summarization skill 
in Project Workspace

Quickly learn the details of the documents from the summary that is generated by Now Assist  in 
Strategic Planning.

https://player.vimeo.com/video/1038147968?
h=9451c75819&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Before you begin

Important: 
This Now Assist  skill is now turned on by default. The skill will be automatically available to 
appropriate role users for the application. This change simply activates the skill and does 
not touch the roles that are needed to use the skill. The new default behavior works as 
follows:

New customers

When you install a Now Assist  product, designated skills will turn on 
automatically.

Existing customers who are upgrading

Any previously unconfigured skill will turn on automatically (the skill was never 
turned on, then off again).

There is no change to Now Assist  skills that are currently enabled and 
customized.

Previously configured skills that were turned on, then off, will remain inactive.

Role required: it_project_user

If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles.

About this task
Minimize the time that you spend reading documents, meeting notes, project reports and so on 
by using a summary that is generated by Now Assist. You can also copy-and-paste the source 
materials that meet your learning needs in Docs and generate a quick summary.
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Procedure

1. Navigate to Workspaces  > Project Workspace  and open the required project.

2. From the Docs, perform one of these action according to your requirements.

Note: 
Summarization of the entire content is also permitted for users with the read role.

3. Optional:  When you're finished summarizing the page in Docs, you can provide feedback, 
copy, or view information about it.

Note: 
Because the information in these fields is AI generated, it's a good idea to review the text 
and make sure it's accurate.

Only an administrator can activate the Now Assist  skills. For more information, see Activate a 
Now Assist skill.

The Project doc summarization skill checks the doc content to determine if enough information 
is available to generate a summary. If there isn't enough content to summarize, you can add 
more content and retry.

Note: 
The Summarize  button is visible only if the Project doc summarization skill is active. If the 
selected text exceeds the token limit for Now Assist, the Project doc summarization skill 
can't be executed. If there is more content to summarize, you can remove some content 
and retry.

Schedule the project insights email

Schedule the project insights email to prioritize and track the most important changes in the 
project in Project Workspace.

https://player.vimeo.com/video/1156994852?
h=fc02bd8ee8&badge=0&autopause=0&player_id=0&app_id=58479%22

Before you begin

Important: 
This Now Assist  skill is now turned on by default. The skill will be automatically available to 
appropriate role users for the application. This change simply activates the skill and does 
not touch the roles that are needed to use the skill. The new default behavior works as 
follows:

New customers

When you install a Now Assist  product, designated skills will turn on 
automatically.

Existing customers who are upgrading

Any previously unconfigured skill will turn on automatically (the skill was never 
turned on, then off again).

There is no change to Now Assist  skills that are currently enabled and 
customized.

Previously configured skills that were turned on, then off, will remain inactive.
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If you have users with custom roles that need access to this skill, you must update ACLs for those 
roles.

Role required: it_project_manager

About this task
By using the Project insights generation skill, you can generate a concise project insights. The 
project insights are shared through email. Project managers can monitor key elements such 
as project, project task, milestone, resource assignment, ridac, and financial. They can also 
prioritize their projects and decide the cadence of receiving these project insights email.

When a project is created in the work in progress state, the project insight generation skill 
is automatically enabled. This ensures that projects begin generating insights early in the 
execution phase without requiring manual setup. In addition, all existing projects in the work in 
progress state are automatically enabled for email‑based  project insights.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open any project.

2. From the planning page, select the more actions icon ( ) and then select Configure project 
insights.

From Project insights generation skill card, select Edit  to modify the email conditions. 
From project insights configuration screen, select Switch scope  and then select Edit 
conditions. Administrators can control insight generation through admin‑level  configuration. 
For more information on configurations, see Configure Now Assist Admin features. From Email 
condition modal, admins can define which projects should generate insights and trigger email 
notifications, providing flexibility over when and for which projects insights are sent.

3. From the Configure project insights modal, in Choose topics step, select Next.
You can select or deselect the project, project task, milestone, resource assignment, ridac, and 
financial card to customize what information is displayed in the Project insights email.

4. In Personalize content step, add your requirements and select Next.
You can define your tone, writing style, and priority entities. For example, identify risks of this 
project. Please provide a formal summary in bullet points.

5. In Set frequency step, select the Cadence  as Weekly, Bi-weekly, or Monthly according to your 
requirement.

6. Select On this day, as days for weekly or bi-weekly or dates for monthly cadence.

7. Select Users  from the list.

◦ The project manager is automatically set as the default email recipient for the project.

◦ You can select one or multiple users. Only users with sn_ppm_read role or have read or view 
access to project information appear for selection in the users list.

◦ When an email is sent to recipients, the project manager is placed in the To list, while all 
other recipients are included in the Cc list.

◦ For confidential projects, recipients are required to be included in the list of users authorized 
to view the project.

8. Optional:  Select Send preview  to generate and send a preview of the insights email instantly.
When you select Send preview, you receive a project insights instantly and also receive 
insights based on the selected cadence. The email would go to the recipients selected along 
with the Project Manager.
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Example: Schedule a project insight email

Let's assume that you have selected a weekly cadence and chosen Monday (which falls on 
2025-07-07). After adding recipients:

• If you select Schedule, the project insights are emailed to you and the recipients weekly on 
Mondays, starting from 2025-07-07 and continues until the project is inactive.

• If you select Send preview, you will receive an initial insights email immediately and will also 
receive insights according to the selected cadence and day.

Related topics

Configure the Monitor project tasks AI agent in AI Agent Studio

Project financials and Source-to-Pay Operations  integration

Request, track, and manage procurement requests of assets for your projects.

Before you begin
Install Sourcing and Procurement Operations

Role required: it_project_manager

About this task
Project managers can navigate from Project Workspace  to procurement applications 
and create purchase requests for their projects. The ordered purchase requests are 
reflected in the Project Workspace. After the purchase request is processed, the purchase 
line, cost plan, and expense lines are automatically generated. For more information 
about the integration, see Sourcing and Procurement Operations integration with Project 

Management .

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. Open a project and select Details  from the left menu.
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Create purchase request

As a Project Manager, you can directly access the Source-to-Pay Operations  shopping hub 
portal to place a request to meet your project requirements.

Before you begin
Role required: it_project_manager

Procedure

1. In the project details page, select More Actions ( ) icon and select Create Purchase 
Requests.
The Source-to-Pay Operations  shopping hub portal opens in a new tab.

2. Place the request for an asset.
For more details on how to request a product using Source-to-Pay Common Architecture, see 
Order a product with quick checkout .

Note: 
While placing the request for the asset, enter the project number in the What project is 
this request for?  field.

Track purchase line and purchase order lines

After the purchase request is placed, you can track the request details such as Purchase line 
number, Purchased quantity, unit cost, tax, and state from Project Workspace.

Before you begin
Role required: it_project_manager

Procedure

1. Open the project selected while creating the purchase request.

2. Select Details  from the left menu.

3. Select the Purchase Lines  related list.
A procurement specialist from the Source-to-Pay Operations  approves the purchase 
requisition. Once the purchase order is created, purchase order line is automatically created in 
Project Workspace.

To view the purchase order in Project Workspace:

a. Open the project selected while creating the purchase request.

b. Select Details  from the left menu.

c. In the Details page, select the Purchase Order Line  related list.

Note: 
Every purchase order line creates a cost plan in the selected project.

Tracking financials of procurement requests

Once the requested purchase orders are approved and processed, a purchase order line 
and a cost plan is automatically created. You can view cost plans for the requisition in Project 
Workspace.

Before you begin
Role required: it_project_manager
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Procedure

1. Open the project selected while creating the purchase request.

2. Select Details  from the left menu.

3. Select the Cost Plans  related list.

Note: 
The cost plan is reflected in Financials along with additional details such as start and end 
fiscal period, planned cost plan breakdown for each fiscal period.

As next steps, a purchase order is processed and an invoice is generated. An invoice line is 
created which captures the actual expense of the purchase request. You can view the expense 
lines generated from the processed invoice from Project Workspace.

a. Open the project selected while creating the purchase request.

b. Select Financials  from the left menu.

c. Locate the cost plan created for the Purchase Order Line.

d. Scroll through the cost plan monthly breakdown, select the row options  for fiscal period 
in which the purchase order is created and select View expense lines.

e. In the Expense lines view, select the Auto generated expense line for cost plan:  option.

f. Total expense incurred while generating the purchase order are displayed in the Amount 
field.

Result
The processed purchase request is tagged to the selected project. Financials records such as 
cost plans and expense lines are automatically created and associated with the project expense.

Add a RIDAC record to a project in Project Workspace

Add a Risk, Issue, Decision, Action, or Request Change (RIDAC) record to your project in the 
Project Workspace. Adding RIDAC records enable you to keep a track of risks or issues during 
the project life cycle and help in analyzing the outcome of a project.

Before you begin
Role required: it_project_manager

About this task
You can select the type of record you want to create, fill in the required details, and associate 
it to your project. You can use the RIDAC page in Project Workspace  to view, add, manage, and 
evaluate all the RIDAC records.

For information about RIDAC records for project management, see Adding RIDAC (Risks, Issues, 
Actions, Decisions, and Request Changes) records for a project.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Open the RIDAC page of the project by selecting RIDAC  from the list.

3. From the More actions menu, select the type of RIDAC record that you want to create.

4. On the form, fill in the fields.
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For field information, see:

◦ Risk form of Project Workspace

◦ Issue form on Project Workspace

◦ Action form of Project Workspace

◦ Decision form on Project Workspace

◦ Request change form on Project Workspace

5. Select Submit.

What to do next

• Convert an existing project risk to an issue, decision, action, or request change and close the 
risk. For more information, see Convert one RIDAC record to another for a project in Project 
Workspace.

• Associate a project risk with existing issues so that you can track dependencies and recognize 
trends for the future. For more information, see Associate existing RIDAC records for a project 
in Project Workspace.

Associate existing RIDAC records for a project in Project Workspace

Link existing RIDAC records to one another for your project in Project Workspace. A RIDAC 
record stands for Risks, Issues, Actions, Decisions, and Request Changes. Keep a record of risks 
or issues and their outcome for analysis at project closure and planning.

Before you begin
Role required: it_project_manager

About this task
You can associate one record with multiple different records. For example, you can link one issue 
record to multiple risk, decision, action, or request change records.

Procedure

1. Select the project for which you want to associate one RIDAC entry to another.
For information on how to navigate to a Project in the Project Workspace, see Access the new 
Project Workspace.

2. Open the RIDAC page of the project by selecting RIDAC  from the list.

3. On the Project form, select Row context menu  for an individual risk, issue, decision, action, or 
request change record.

4. Select Associate RIDAC.

5. On the Associate dialog box, from the Select type list, select the RIDAC record to which you 
want to associate the selected record.
For example, if you wanted to associate an issue to a decision, you would select Decision.

6. From the Associate to list, select the record number to which you want to associate the 
selected record.
For example, if you wanted to associate the selected issue to a decision (DCSN0001005), you 
would select DCSN0001005.

7. Select OK.

Convert one RIDAC record to another for a project in Project Workspace

Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for a 
project in the Project Workspace. Keep a record of risks or issues and their outcome for analysis 
at project closure and planning. Track the risks and issues throughout the project life cycle.
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Before you begin
Role required: it_project_manager

About this task
When you convert a RIDAC record to another record, the values for the Short description, 
Requester, and Assigned to  fields are carried forward from the parent record.

You can also specify to close the parent record on creation of the new record instead of manually 
closing the parent record.

Procedure

1. Select the project for which you want to convert one RIDAC entry to another.
For information on how to navigate to a Project in the Project Workspace, see Access the new 
Project Workspace.

2. Open the RIDAC page of the project by selecting RIDAC  from the list.

3. On the Project form, select Row context menu  for an individual risk, issue, decision, action, or 
request change record.

4. Select Convert to RIDAC.

5. On the Convert dialog box, from the Select task type list, select the RIDAC record to which you 
want to convert the selected record.
For example, if you wanted to convert an issue to decision, you would select Decision.

6. Modify the text in the Short description  field, which is copied from the parent record.

7. Optional:  Change the default assignment copied from the parent record in the Assigned to 

field by selecting the search for record icon ( ) and selecting a different user.

8. Optional:  If you want to close the parent RIDAC record on creation of a new record, select the 
close parent record option.
The label of the close parent record option changes depending on the parent record type. For 
example, if the parent record is an issue and you’re converting it to decision record, then the 
close record option would appear as Close Issue.

9. Select OK.

Generate, accept, and reject risks using risk generation skill

Use generative AI to identify, generate, and manage potential risks in your project based on 
insights, resources, financials, and milestones.

Before you begin
Role required: it_project_manager

• Install Now Assist for Strategic Portfolio Management (SPM)  plugin.

• Verify risk generation skill is active.

• The risk generation skill is activated by default. For more information on how to activate 
the skill if it isn't automatically activated or if you want to change the skill configuration, see 
Configure Now Assist Admin features.

About this task
AI analyzes project data to identify potential risks and presents them for project manager review. 
AI-suggested risks are generated as part of the project insights cadence and appear in the AI 
Risks menu for project managers to accept or reject. AI generates risks by analyzing data from 
project insights, resources, financials, and milestones.
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The AI Identified Risks menu is visible only to project managers when the risk generation skill is 
active. If no risks are identified during generation or regeneration, the AI Identified Risks page 
displays an empty state where you can generate risks again.

Procedure

1. Navigate to Workspaces  > Project Workspace.

2. From Project Workspace, Create a project  or open an existing project.

3. Select AI Identified Risks  from the navigation menu.

4. Review the AI-suggested risks in the list and perform one of these actions:

◦ Regenerate: When you select regenerate option, the risk is generated again and added to 
the AI identified risks list. AI-generated risks appear in AI draft state.

◦ Accept: When you accept a risk, the approved risk appear in the RIDAC list and its state 
moves from AI Draft to Pending.

◦ Reject: When you reject a risk, the rejected risk is removed or hided from the AI identified 
risks list and its state moves to Closed skipped. The rejected risks are retained so that AI 
does not generate the same risk again.

If no risks are identified during generation or regeneration, the AI identified risks page displays 
an empty state. In this case, you cannot regenerate risks immediately and are advised to revisit 
the page later as the project evolves.

5. Optional:  Select Generate AI Risks  if no risks are identified for the project.

Export a project status report to Microsoft PowerPoint  from Project Workspace

Generate a status report of your project and export it as a Microsoft PowerPoint  file from Project 
Workspace. You can use this file to present the project status to stakeholders or to collaborate 
with them over risks and next steps. Save time by generating a Microsoft PowerPoint  file with the 
latest information and avoid copying information into slides.
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Before you begin

• Install the Export to PowerPoint for Strategic Portfolio Management  application from 
ServiceNow  store. For more information, see Install Export to PowerPoint for Strategic Portfolio 
Management.

• Create and upload a Microsoft PowerPoint  template to apply to your status report. For more 
information on how to create and upload a template, see Create a Microsoft PowerPoint 
template  and Upload your Microsoft PowerPoint template  respectively.

Role required: it_project_manager

Important: 
Export to PowerPoint  is currently unavailable for customers in the FedRAMP, NSC DOD 
IL5, or Australia IRAP-Protected data centers, self-hosted customers, or in other restricted 
environments. Please check for availability updates in future releases.

About this task
Create a status report or use an existing status report to download it as a Microsoft PowerPoint 
file.

Exporting the project is beneficial if your stakeholders prefer a slide deck rather than using a 
dashboard. It also helps the wider audience or external stakeholders who don't have access to 
the dashboards but are waiting for an update.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. From the More actions menu ( ), select Export status report.

3. On the Export status report form, fill in the fields for an existing project.
For field information, see Export status report form on Project Workspace.

4. Select Export.

5. When prompted, select the desired location, and save the file.

6. Optional:  On the Export status report form, create a status report for a project by selecting the 
Please create a status report to be able to export  link.

7. On the Status Report  Tab, create a status report by clicking Create New.

8. On the Status Report form, fill in the fields.
For field information, see Create a project status report.

9. Select Submit.

10. Select the Export to PowerPoint icon ( ).

11. From the Export to PowerPoint window, select the report date by clicking Status report date.
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12. From the Export to PowerPoint window, select a template by clicking Select a template.

13. Select Export.

Result
The project status report is downloaded as a Microsoft PowerPoint  file with the project number 
and status report date as the file name.

Export a project from Project Workspace

Export your project as a file from Project Workspace. Use this file to provide project updates to 
external stakeholders or a wider audience. Save time by generating an export file with the latest 
information and avoid copying information into different files.

Before you begin
For Microsoft PowerPoint:

• Install the Export to PowerPoint for Strategic Portfolio Management  application from the 
ServiceNow  store. For more information, see Install Export to PowerPoint for Strategic Portfolio 
Management.

• Create and upload a Microsoft PowerPoint  template to apply to your status report. For more 
information on how to create and upload a template, see Create a Microsoft PowerPoint 
template  and Upload your Microsoft PowerPoint template.

Important: 
Export to PowerPoint  is currently unavailable for customers in the FedRAMP, NSC DOD 
IL5, or Australia IRAP-Protected data centers, self-hosted customers, or in other restricted 
environments. Please check for availability updates in future releases.

Role required: it_project_manager

About this task
Create a project or use an existing project to download it in the required file format. You can 
choose to export the project data in Excel, CSV, PPT, MS Project (MPP), and XML file format.

Exporting the project is beneficial if your stakeholders prefer a file rather than using a dashboard. 
It also helps the wider audience or external stakeholders who don't have access to the 
dashboards but are waiting for an update.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. From the More actions menu ( ), select Export project.

3. Select the file format and then select a template if needed.

4. Select Export.
Only the columns that are visible in the Planning page of the project are exported.

Result
The project is downloaded in the selected file format.

Closing a project in Project Workspace

End the project when all tasks are completed. When you close a project, all project tasks, sub-
projects, and resource assignments associated with the project are closed automatically.
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Before you begin
Role required: it_project_manager

About this task
Ideally, you should not reopen a project after it is closed. Updating the project state from Closed 
to Work In Progress, Pending, or Open is not allowed. If you still need to reopen a closed project, 
reopen an existing project task or add a new task to the project. This action for a task moves the 
project from Closed to Work in Progress state without affecting the other closed tasks. You can 
cancel the associated future resource plans and complete the allocated resource plans for a 
closed project.

Procedure

1. Open a project from the planning page of Project Workspace.
For information on how to navigate to the planning page, see Access the new Project 
Workspace.

2. Verify that your work is completed for all the tasks in the project you want to close.

3. On the Project form, change the state field to one of the closed states:

◦ Closed complete

◦ Closed Incomplete

◦ Closed skipped

Note: 

▪ When you close a project, a notification is displayed, which enables you to view all 
resource assignments associated with the project. You can synchronize all resource 
assignment dates with project dates. The resource assignment ends on the exact 
date and time that the project ends.

▪ You can track, modify, and synchronize all resource assignments for a project from 
the Resource Assignment List page.

Alternatively, close every project task first, starting with the lowest-level child tasks. The 
closed states roll up to parent tasks, and when all highest-level parent tasks are closed, the 
project state changes to closed. However, the default closed states for parent tasks and for the 
project is Closed Complete. Therefore, even if you change any or all project tasks to Closed 
Incomplete  or Closed Skipped, the project state is changed to Closed Complete.

Also, change the Phase  value to Closing. The project phase is for reference only and isn’t 
linked to or dependent on the State  field.

If your project contains sub-projects, you can close the sub-project without affecting the 
parent project. Change the State  of the sub-project to any closed state to close the sub-
project. Closing the sub-project closes or changes the state of all the tasks associated with 
the sub-project. Also, changing the state of the sub-project to Work in Progress, moves all the 
associated tasks to Work in Progress state.

If there are project tasks associated with the parent project that are not closed, the parent 
project remains in the Open, Work in Progress, or Pending state. If the tasks associated 
with the parent project are closed, the state of the parent project also changes to Closed 
Complete.
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4. After the project is complete, create a final baseline to see how closely the project's actual 
values came to the estimated values.

Note: 
Baselines compare only planned start and end date values with actual start and end date 
values. Use reports to compare the effort and cost.

Result
For projects created from an incident, problem, or change, updating the project state does not 
automatically update the related incident, problem, or change request record. You must update 
the related record manually. For example, if the completion of a project also means that a related 
Change can be closed, go to the Change record and modify its State  field. It is also a good idea 
to update the work notes field on the related record to include any relevant information about the 
project.

Related topics

Export a project from Project Workspace

Add a RIDAC record to a project in Project Workspace

Managing financials for your projects

Manage budget, cost plans as forecasts, actual expenses as expense lines, generate labor 
costs, create financial baselines, and view, analyze, and compare the financial performance of 
your projects at required cadence in Project Workspace.

The comprehensive financials view helps you to understand planned and actual costs, Forecast 
(previously EAC - Estimate At Completion), Remaining Estimates (previously ETC - Estimate 
To Completion), Actual (previously Actuals to date), and so on, for the selected item. You can 
manage cost plans and associate the expense lines and process them to reflect the actuals for a 
planning item.

Export the financials data from Costs and benefits or Baseline comparison view as Microsoft 
Excel or a CSV file and share it with your stakeholders to review the financial performance of your 
projects and portfolio.

Cost view

Forecast your planned costs, create, and manage cost plans and expense lines to track the 
financial performance of your projects, review the latest costs and actuals.

In the Cost screen, you can:

• As a Project Manager, you have the enhanced visibility and ability to manage the financial data 
across multiple project levels. Cost view of financials shows cost plans and expense lines from 
sub-projects, allowing you to track the finances.

• The parent project widgets display the consolidated values of forecasted costs and expenses.

• Identify and manage costs using the Project/Demand  column for any sub project or demand 
directly from Cost view of the parent planning item.

• Re-forecast all the cost plan values for future fiscal periods by double-clicking to edit the value 
in the least time scale view, either by month or by period.

• Manage cost plans for your projects. For more information, see Add, edit, or delete cost plans.

• Add or edit expense lines for your projects to record any planned or unplanned expenses. For 
more information, see Add or edit expense lines.

• Generate labor costs for the fiscal period. For more information, see Generate labor costs.
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• Create and compare baselines to capture the financial snapshot of your projects. For more 
information, see Create and compare financial baselines for your projects.

• Configure widgets  to get a high-level overview of the financial data for your planning item.

• All financial details from sub-projects will be aggregated and displayed in the parent project's 
cost plans and widgets.

Tip: 
Cost view gives you enhanced user experience to customize the left pane columns 

by using the personalize icon ( ) and by saving user preferences to retain the 
customizations made to hide, view, or adjust columns, time scope viewing, and so on.

Multicurrency

The multicurrency feature enables you to manage the financials of your planning items in 
two different currencies, Functional currency and Investment currency. Functional currency 
is typically defined by the admin based as the primary currency that is used for planning, 
budgeting, and tracking the financials of your planning items.

Financial users can now perform the following financial activities in Investment currency.

• Ability to select the Investment currency.

• Track the planned and actual expenses.

• Allocate and manage the budget.

• View simple financials data.

Important: 
New customers should install the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin to enable multicurrency feature and Activate 
scheduled job to populate to multicurrency fields.

Using this feature, you can work on financial reporting at global level and see the real-time 
currency conversions of your financial records.

Organizations operation at global or multinational level, the work is planned and financed at 
one location and executed at a different location. Each might use a different currency from what 
was used in the planning phase, multicurrency makes it easy to manage and track your planning 
items using any currency.

You can monitor and track the financials in one currency, and capture the costs in a different 
currency.

Using multicurrency, you can see all the costs in the currency you choose for the planning item, 
instead of restricting to use Functional currency defined in your locale. For more information 
on how to choose investment currency of your planning items, see Configure multicurrency for 
projects.

Financial records and widgets will display the costs based on the currency selection.

Note: 
Once a cost plan, benefit plan or expense line or an investment budget gets created, you 
won’t be able to change investment currency. You can change the investment currency as 
long as there are no financial records captured against the planning item.
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Display modes

On the financials page for a planning item in Project Workspace, you have Display Mode drop-
down switch between different modes to view different formats of financial information of your 
planning items. These views provide the relevant and focused information which helps project 
managers and funding users to work on the financial planning.

• Forecast

• Budget vs forecast

• Planned vs actual

• Planned

Users with financial funding role [it_portfolio_manager] will see Budget allocation option instead 
of the Budget vs forecast.

Display modes value

Mode Value

Forecast View Actuals, Remaining estimates, and 
Forecast for the entire scope of the planning 
items.

Use the time scale to view the actuals for the 
past fiscal periods and planned costs for the 
current and future fiscal periods.

Budget vs forecast View the Budget, Actuals, and Variance for 
the fiscal periods and Forecast values for the 
entire scope of the planning items.

Using this mode, you can:

• Compare the latest forecasts with the 
approved budget at different time scales.

• View the budget vs actual for past fiscal 
periods and budget vs planned for current 
and future fiscal periods at fiscal period 
level.

Budget allocation (funding role) View the Budget, Actuals, and Variance for 
the fiscal periods and Forecast values for the 
entire scope of the planning items.

Using this mode, funding users can:

• View the latest forecast and enter the 
budget that can they be approved to the 
work item.

• Analyze the variance for the past fiscal 
periods and work on budget allocation for 
future fiscal periods.

• Compare latest forecast with approved 
budget and revise the budget, if necessary.

Planned vs actual Compare the planned costs with actual 
expense for the past and current fiscal 
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Display modes value  (continued)

Mode Value

periods, and view planned costs for the future 
fiscal periods.

Planned View only planned costs for the full range and 
manage the planned costs using the inline 
editing feature.

Note: 

• If you don’t see the Budget allocation or Budget vs forecast display options, enable the 
budget allocation property  and configure the budget attribute  at instance level.

• To work on budget allocation using the Next Experience, Activate a scheduled job to 
migrate budget of your planning items.

The last selected view is saved as user preferences.

Default display mode and access level for financial users

User role Default mode Role-level access

it_portfolio_manager Budget Allocation Allocate and approve budget, 
manage cost plans and 
expenses lines.

it_project_manager Forecast Manage cost plans and 
expense lines.

business_stakeholder Forecast View financial data.

Baseline view

Create a financial to capture a snapshot of the financial changes for your projects. You can 
create on-demand baselines manually or automatically at a required cadence using a scheduler 
job. For more information, see Create a baseline

Note: 
Baselines created on the parent project include cost plans and expense lines from all of the 
child projects to calculate and give you a better breakdown of the financial performance of 
the projects and sub-projects.

Compare baselines  to compare the difference in costs between latest status against a baseline 
or between any two baselines.

Note: 
Each baseline is tagged with a number based on the order that they’re created. The Current 
Financials baseline captures the financials details in real-time and is always represented 

with a flag icon ( ).

Financial baselines now capture the investment currency for customers using multicurrency.

A project baseline includes the following financial metrics in investment currency.

• Investment currency

• Total planned cost
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• Planned benefit

• Planned return

• Budget cost

At the investment baseline level, a corresponding investment baseline is automatically created. 
This baseline captures:

• Planned cost

• Actual cost

• Planned benefit

• Actual benefit

• Total budget

• Capex, Opex, and breakdown of these fields

• Benefits, and so on

All values are populated along with their respective investment currency.

Cost plan baselines now store actual cost values in investment currency, along with the 
investment currency field. Benefit plan baselines capture benefit values in the investment 
currency, along with the associated currency. At the breakdown level (for example, fiscal period 
or monthly breakdowns), actual cost and actual benefit values are populated in investment 
currency where actuals exist.

Note: 
Comparison of financial baselines using multicurrency is not yet supported.

You can view the planning item and investment baseline using the list view. 
Access the pm_project_baseline  list to view project baselines, and 
sn_invst_pln_invst_investment_baseline  to view the investment baselines.

The baselines comparison view helps you to understand the variances between the two 
baselines.

Use the widgets when you compare baselines to view:
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• Two dedicated widgets for each baseline displaying the EAC.

• The third widget displays the total variance between the EAC values of the selected baselines.

• The fourth widget displays the top three variances contributing to the overall variance by cost 
type.

The widgets and the header rows are color-coded to help you identify the selected baselines.

Tip: 
Switch between different baselines from the comparison view by selecting the name of a 
baseline from one of the widgets.

When you compare baselines, you get the list of cost plans with their associated costs types, 
EAC at full scope, and a breakdown view of actual expenses and planned costs.

By default, the time scale of the breakdown view is set to Month.

• Use the Time scale  option to view the comparison breakdown view at monthly, quarter, and 
yearly levels.

• Select Time scope  to filter fiscal periods, data in the widgets, and the comparison table.

The widgets and the header rows are color-coded to help you identify the selected baselines.

Tip: 
Select the name of a baseline from the first or second widget to compare different 
baselines.

Let's take an example of the comparison view of two baselines: 2023-10-01, Baseline A, and 
Current Financials, Baseline B.

Example: How actuals, planned, and EAC are compared between two baselines 
captured at different timestamps

For a selected baseline, based on the creation date, the table shows Actuals values for the past 
fiscal periods from the created date and Planned values for the current and future fiscal periods.

Consider a planning item scoped from July 2023 to June 2024. Baseline A is created on 
2023-10-01. If you compare the Current Financials baseline in December 2023 to the baseline 
captured in October 2023:

1. The baseline comparison view show Actuals vs Actuals columns from July 2023 to September 
2023.

2. Planned vs Actuals for October 2023 and November 2023.
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3. Planned vs Planned from December 2023 to June 2024.

Note: 
The columns are defined to calculate EAC, which is the sum of Actual costs until the last 
fiscal period and Planned costs from current to future fiscal periods.

Budget allocation

Portfolio managers can manage and approve the budget for projects. The approved budget 
helps project managers to plan and meet the expenses to execute work.

Plan and approve the budget for a shorter planning cycle at monthly, quarterly, or yearly level 
using the lean budgeting and funding feasibility. Lean budgeting helps Portfolio managers to 
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track the value in return for the approved budget and to better plan the budget for future fiscal 
periods.

Note: 
If the budget is allocated monthly, the total budget is rolled up to quarterly and yearly 
level. Similarly, if the budget is allocated at a quarterly or yearly level, the equal breakdown 
happens till monthly level.

For more information on how to allocate, approve, and handle budget for projects, see, Manage 
budget of your planning items in Strategic Planning.

Tip: 
In the budget allocation view, Portfolio managers review the EAC to understand the 
financial projections made by Project managers and use the Copy cost as budget  option to 
allocate the entire planned cost as budget.

Choose the cost type as the attribute to allocate and approve the budget for individual cost 
types such as labor, non-labor.

Project managers can view the approved budget at the required time scale by switching to the 
Budget vs planned display mode. As the work progresses and the actuals are captured, you can 
compare the budget and actual costs using Budget vs planned display mode and reforecast the 
planned costs where the actuals are exceeding the budget using the inline edit feature at the 
required time scale.

Product managers can compare the latest cost with the approved budget by Capex or Opex, cost 
types, and for the required time scale at monthly, quarterly, or yearly level. The comparison view 
provides insights to Product managers to locate any variance at expense type or cost type, and 
at which fiscal period. Product manager can leverage this information to request for additional 
budget from the Portfolio manager.

You can migrate the budget of existing active projects  from the Classic UI to Next Experience. 
Financials in the Next Experience  has new budget data model that facilitates to store the budget 
at a detailed level by monthly breakdowns and cost types. You can migrate the budget for active 
projects and demands individually or by bulk using the scheduled job.

Note: 
The migrated budget is captured in the sn_invst_pln_invst_budget  table to enable 
the lean budgeting for required time scope.

Budget distribution logic

The budget allocation approach introduces data‑aware  budget distribution, prioritizing 
actuals for completed periods and planned costs for future periods. The system uses different 
distribution strategies depending on whether actuals or Estimate at Completion (EAC) values are 
available, and whether the fiscal period falls in the past, present, or future.

Budget allocation logic is divided into three focus areas: past fiscal periods, current fiscal 
periods, and future fiscal periods.

1. Past fiscal periods that have already ended.

◦ If actuals exist, the budget is distributed proportionally to actual spending. If the total budget 
amount equals the total actuals, the distribution exactly matches the actual values.

◦ If there are no actuals, the budget is distributed evenly across the past fiscal periods.

2. The current fiscal year is like a mid‑year  scenario where both past and future fiscal periods are 
available.
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◦ For past or completed fiscal periods, the system distributes the budget proportionally 
matching the actual expenses. If there are no actual expenses, budget is allocated as zero 
(0).

◦ If planned costs exists for the current and future fiscal periods the remaining budget is 
distributed proportionally based on the planned costs.

◦ If planned costs doesn't exists for the current and future fiscal periods, budget is distributed 
evenly across the fiscal periods.

3. Future fiscal periods

◦ If planned costs exists, the remaining budget is distributed proportionally based on planned 
costs.

◦ If planned costs doesn't exists, the remaining budget is distributed evenly across the 
remaining fiscal periods.

Budget distribution based on financial records

Fiscal periods Available financial data Distribution method

Past fiscal Actual expenses Proportional to actuals

Past fiscal No financial records No budget allocation

Current year – past fiscals Actual expenses Allocate budget proportionate 
to actual values

Current year – remaining 
months

Planned costs exists Allocate budget proportionate 
to planned costs

Current year – remaining 
months

No planned costs Even distribution

Future fiscal periods Planned costs exists Allocate budget proportionate 
to planned costs

Future fiscal periods No financial records Even distribution

Benefit plans

Monetary benefit plans capture potential benefits accrued while executing a planning item. Non-
monetary benefit plans capture the potential non-financial benefits accrued while executing a 
planning item. You can create and manage monetary benefit plans  and non-monetary benefit 
plans  to capture the potential benefits of your planning items.

Instead of switching to and fro from the financials record page to benefit plan tabs, you now have 
a seamless experience to manage all the cost plans and benefit plans from the Cost and benefits 
view and can leverage the new financials experience with the side panel and grids for quick 
forecasting and tracking of monetary benefit plans.

Simple financials

Simple financials gives you the ability to enter the preliminary high-level planned capex, opex, 
benefit, and so on from the Details page without capturing the costs plans from the Cost view. 
You can update the simple financials values as required until you have the planned and actual 
costs captured.
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Using the baseline feature, you can capture these simple financial values in a baseline and 
compare them against any existing baseline. You can:

• Reforecast simple financials and compare the by selecting the Current Financials from the list 
of baselines.

• Capture the planned and actual expenses as the project progresses and compare any 
financial baseline with simple financials baseline to track the financial performance of the 
project.

Configure multicurrency for projects

Select investment currency as an additional currency, which can be different from your functional 
currency, to manage financial records of your projects.

Before you begin

• You can define investment currency for projects which do not have any financials records, 
such as cost plans, expense lines, benefit plans, and actual benefits. To define a investment 
currency for existing work, you should delete all the financial records and configure the 
investment currency.

• Enable monetary benefit plans for projects

• Role required: admin

About this task
Following are the current limitations for multicurrency.

• Multicurrency for cost plans that are bundled with project tasks. This feature is scheduled to be 
available starting with the January patch update.

• Financial baselines do not capture investment currency fields. This feature will be available 
with the March store release.

Procedure

1. Navigate to Workspaces  > Project Workspace  and select a project.

2. Select the Financials  tab.

3. Select Currency  field, and select the Edit investment currency option.
Edit investment currency modal is displayed with an option to select investment currency.
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4. Choose the suitable investment currency from the Investment currency  list.

5. Select Confirm  to save the investment currency selection.

Add, edit, or delete cost plans

Create a cost plan for a required duration to track your planned and actual expenses. Edit cost 
plans to adjust your planned expenses and delete any de-scoped forecasts.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Select Financials  from the left menu.

Tip: 
Create a financial baseline  immediately after capturing the initial planned costs to have 
a snapshot of your planned costs. Use this baseline to compare it against the baselines 
from later dates, as the work progresses, to identify the variance between initial planned 
costs and actual expenses.

This helps you to plan for the future expenses and re-forecast the planned costs.

Manage budget of your projects using Project Workspace

Allocate, manage, and approve budget for your projects. Lean budgeting enables you to allocate 
budget for short planning cycles for different fiscal periods such as monthly, quarterly, or yearly 
breakdown level rather than allocating the budget to the complete duration of the planning item.

Before you begin

• As an Admin, enable the property to work on budgeting. For more information, see Enable 
financial budget allocation for projects in Project Workspace.

• As an Admin, configure the attribute to allocate and approve budget by cost type or expense 
type. For more information, see Configure budget attribute at instance-level to allocate budget.

• Role required: it_portfolio_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Select Financials  from the left menu.

3. Enable the Budget allocation  toggle ( ).

4. You can manage the budget by one of the following ways for the selected time scale at 
monthly, quarterly, or yearly level.

◦ Double-click each cell in the Budget column to manually enter the value.

◦ Select Copy cost as budget  from the Budget column options to copy the EAC as budget.
You can always reforecast the budget for each cost type using the in-grid editing feature even 
if the EAC is copied as budget.

Note: 

Unapproved budget values are indicated with  icon.
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5. Select Approve budget  ( ).
Approve budget confirmation window is displayed. The Create a financial baseline for this 
budget approval  option is enabled by default which captures the latest budget and financial 
estimates.

Tip: 
The financial baseline created while approving the budget can be compared with the 
future baselines once the actual expenses are captured to track financial performance.

6. On the confirmation window, select Approve  ( ).

Result
Budget widget is updated to reflect the latest approved budget. Project Manager can view the 
approved budget and compare it with the planned costs using the budget vs cost  view by cost 
type.

Add or edit expense lines

Create or edit expense lines to capture the actual costs. You can associate the expense lines 
with a cost plan or create standalone expense lines to record unplanned expenses.

Before you begin
Role required: it_project_manager

About this task
An expense line is part of the project cost plans that can be associated with a specific source. 
You can create multiple expense lines for a cost plan. Only the expense lines that are in the 
processed state are considered for roll-ups on the work item.
For unplanned expense lines which aren’t associated with any cost plan, the system 
automatically creates a cost plan or associates with an existing system-generated cost plan of 
the same expense type.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Select Financials  from the left menu.

3. Add an expense line using one of the following options.

4. On the Create expense line form, fill the fields.
For a description of the field names, see Create expense line form.

5. Select Save.

Note: 
The expense lines created for sub-projects can be viewed in the Cost screen of the 
parent project.

Generate labor costs

Generate labor costs for projects and sub-projects based on the attribute-based resource 
assignments and the financial attributes configured in the planning attributes page.

Before you begin
When the distribution of effort for a resource assignment is adjusted without changing the 
total planned effort, the system automatically recalculates and generates labor costs to align 
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with the updated effort distribution. For example, consider a resource assignment of 100 hours 
distributed as 60 hours in January and 40 hours in February; now if you swap the efforts to make 
40 hours in January and 60 hours in February. Now the system automatically adjusts the labor 
costs so that January reflects the cost of 40 hours and February reflects the cost of 60 hours, 
ensuring that costs accurately correspond to the revised effort distribution.

Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Select Financials  from the left menu.

3. Select Generate labor costs  ( ).

4. Select Generate  on the Generate labor costs confirmation window.

Note: 
Alternatively, you can activate a scheduled job  to automatically create baselines at the 
required cadence.

Create and compare financial baselines for your projects

Create and compare financial baselines to get a snapshot of the project expenses and compare 
the planned costs with the actual expenses.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Select Financials  from the left menu.

3. Create or compare baselines.

Tip: 
You can migrate existing financials baselines of your projects or demands from Classic UI 
to Financials in Next Experience.

For more information on how to migrate financial baselines of demands, see Migrate financial 
baselines of demands to Next Experience.

For more information on how to migrate financial baselines of projects, see Migrate financial 
baselines of projects to Next Experience.

Create monetary benefit plans for your projects in Project Workspace

Create and manage monetary benefit plans to capture the potential benefits while executing 
your projects.

Before you begin

• Enable monetary benefit plans for projects

• Role required: sn_align_ws.spw_financial_user
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Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Create a monetary benefit plan using one of the options.

3. On the Benefit Plan form, fill the fields.
For a description of the field names, see Benefit Plan form.

4. Select Save.

Edit monetary benefit plan

Edit a planned monetary benefit plan to revise the benefits, dates, offset, and so on, to maintain 
the updated financial records as your work progresses.

Before you begin

• Create monetary benefit plans for your projects in Project Workspace

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Update a monetary benefit plan using one of the options.

Capture actual monetary benefits

Capture the actual benefit from the planned benefits to measure revenue and calculate the 
profits.

Before you begin

• Create monetary benefit plans for your projects in Project Workspace

• Role required: sn_align_ws.spw_financial_user

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Capture actual monetary benefits using one of the options.

3. Optional:  You can change the previously captured planned benefit from the Entered benefit 
field.

4. Enter the actuals benefits resulted from the work execution in the Actual benefit  field and 
select Save.

Manage non-monetary benefit plans for your planning items in Portfolio Planning

Create and manage monetary benefit plans to capture the potential benefits while executing 
your planning items.

Before you begin
Role required: sn_align_ws.spw_financial_user
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Procedure

1. Navigate to Workspaces  > Portfolio Planning Workspace  and select portfolio plan.

2. Select a planning item from the Planning module.

3. Select the Non-monetary Benefit Plans  related list.

4. On the Benefit Plan form, fill the fields.
For a description of the field names, see Non-monetary benefit plans form.

5. Select Save.

Export financials as Excel or CSV file

Export the costs or baseline comparison data of your projects to share them with your 
stakeholders.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Select Financials  from the left menu.

3. Select the Export option ( ).

4. In the Export side panel, select Excel  or CSV  from the File type list and select the Export 
button ( ).

The financials data is download as an Excel or CSV file with name_fin_mmddyy  naming 
convention. The breakdown of the naming convention:

a. name - fetches the first 10 characters from the name of the planning item.

b. fin - denotes that the file has financial data.

c. mmddyy - system date format when you're exporting this data.
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For example, if you're downloading financials data for a planning item named Documentation 
on January 26, 2024, then the file name reads documentat_fin_012624.

Note: 
You can export financials data from Cost view and Baselines comparison view.

Resource planning with Project Workspace

Use the Resource Management  application to allocate and manage your resources in the Project 
Workspace.

Key benefits

Using Resource Management, you can create, plan, track, and monitor resource assignments 
at a project or task level in the Project Workspace. With Resource Management  in Project 
Workspace, you can:

• Create an attribute-based resource assignment.

• Change the resource assignment dates, resources, efforts, and proposed allocations at any 
level of the project.

• View resource allocations using new heatmap modal. The allocations are color-coded to 
display the availability of the resources.

• View the primary attributes such as Group, Role, and Skill of each resource in the resource 
assignment pane. They are useful when you work on reassigning a task to a different user with 
the same primary attributes.

• Switch between Hours, FTE, or Person Days  effort types to view resource allocations.

Resource assignment pane

The resource assignment pane displays a interface where you add resource assignments for 
your projects or project tasks.

Resource allocations and heatmap

The Resource allocation view combines a hierarchical task structure by resource with time-based 
and effort-based allocation metrics, such as hours, FTE, or person-days over weekly or monthly 
intervals.

Note: 
Switch between different efforts such as hours, FTE, or person days to view a resource 
allocation heatmap based on the selected effort type.

Allocation heatmap modal gives you an overview of the resource utilization to identify the over 
allocated and the available resources. The allocations are color-coded to display the availability 
of the resources and help you to identify the availability of the resource for the filtered time frame. 
The new heatmap modal gives you the following insights for a resource such as the assigned 
tasks with their respective project owner, resource status, efforts for each task, total utilization 
percentage for the approved tasks, and the remaining capacity.
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Heatmap breakdown

Allocation heatmap breakdown

From the above example, you can see the breakdown of the approved work items along with the 
rolled up efforts, Utilization percentage, and the Remaining capacity for the month of January 
2025. The approved work is within the resource capacity as the remaining capacity is 120 hours. 
Resource manager can use these insights to decide and allocate the pending work items to 
another resource with available effort.

Within the Resource Allocation view, the Approved state is prioritized and listed first, followed 
by other statuses based on their order in the record list. Additionally, if a user has no capacity 
during a given period, the corresponding cell is displayed in red color.

Resource assignments in Project Workspace

Optimize project execution by assigning resources to tasks within the Project Workspace. You 
can create resource assignments for any project or project task, specifying the tasks to be 
performed and the resources to be allocated.

Resource assignments

Resource assignment is a process of allocating a resource or group of resources to a project 
task. When a resource assignment is initiated, a resource plan is auto-generated in the back-end 
of the project management system. This resource plan details the information of how resources 
would be allocated throughout the project. Resource assignments are approved by the resource 
manager to make sure that the allocation aligns with the overall resource strategy, considering 
factors such as availability, skills, and project priorities. Resource assignments remain dynamic 
and can be edited throughout the project life cycle. Resources can be assigned based on 
defined attributes such as skills, expertise, or other criteria relevant to the project or task.
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Note: 

Resource efforts calculations are driven by the 
com.snc.resource_management.exclude_status_from_capacity 
property. Admin can configure this property to calculate efforts for certain defined resource 
assignments only. For more information, see Resource Management properties.

Edit the child resource assignments directly using the inline editing from the resource 
assignment pane.

Key features

With resource assignments, you can:

• Determine the resource engagement timing and allocate resources for specified durations, 
contributing to the creation of a timeline for task completion.

• Align task execution with the project plan, ensuring tasks are carried out in accordance with 
specified timelines and resource requirements.

• Initiate an approval process that is conducted by a resource manager and make sure it aligns 
with project targets and resource availability.

Related topics

Create resource assignments using Project Workspace

Update resource assignment from Project Workspace

Resource plans

Create resource assignments using Project Workspace

Create an attribute-based resource assignment in the Project Workspace  application for any 
project or project task.

Before you begin
After a resource assignment is created, resources are allocated to the project and approved by 
the Resource Manager. You can edit the assignment throughout the project life cycle.

Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments  toggle button.

Note: 
If the sn_pw.enable_resource_planning  property is set to true, then the 
Resource assignment  toggle button and resource assignment pane are displayed in 
Project Workspace. The default value is false. You must have the pps_admin role to 
enable this property.

3. From the Planning pane, double-click the Resource assignees  field for a project task.

You can assign the resources from both planning and resource assignment pane.

4. From the resource assignee list, select a user or group and press Enter.
When you create a resource assignment, the user or group allocation is based on the selected 
effort type. For example, when you add a user and the effort type is selected as hours, the 
allocations are displayed in hours.
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A resource assignment record is created and auto-saved. The resource assignment form auto-
populates the project or task information.

5. Optional:  From the resource assignment pane, create a resource assignment for a project or 
task by selecting Add resource.
You can create a resource assignment for a project from the resource assignment pane only.

6. Select the expense type of the assignment based on the work as Opex  or Capex.
A resource can use this information while capturing efforts using the time sheet portal. Once 
the time sheet is approved, an expense line is created for the project capturing the expense as 
capex or opex, based on the selected expense type.

7. View the resource allocations in the heatmap by enabling the Allocation heatmap  toggle 
button.
You can switch from the week view to the month view based on your requirement.

What to do next
Update resource assignment from Project Workspace

Related topics

New Resource Assignment form

Delete a resource assignment from Project Workspace

Update the resource allocation in a heatmap

Realign resource assignment to project task

Create a resource assignment for a user in Project Workspace

Use Project Workspace to create a user-based Resource assignment. User records store 
information about individuals who access your instance or application. These records can 
be assigned to groups and roles to determine what records and actions can be accessed by 
individuals.

Before you begin
Role required: admin or it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments  toggle button.

Note: 
If the sn_pw.enable_resource_planning  property is set to true, then the 
Resource assignment  toggle button and resource assignment pane are displayed in 
Project Workspace. The default value is false. You must have the pps_admin role to 
enable this property.

3. From the Planning pane, double-click the Resource assignees  field for a project task.

You can assign the resources from both planning and resource assignment pane.

4. From the resource assignee list, select a user or group and press Enter.
When you create a resource assignment, the user or group allocation is based on the selected 
effort type. For example, when you add a user and the effort type is selected as hours, the 
allocations are displayed in hours.
A resource assignment record is created and auto-saved. The resource assignment form auto-
populates the project or task information.
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5. Optional:  From the resource assignment pane, create a resource assignment for a project or 
task by selecting Add resource.
You can create a resource assignment for a project from the resource assignment pane only.

6. Select the expense type of the assignment based on the work as Opex  or Capex.
A resource can use this information while capturing efforts using the time sheet portal. Once 
the time sheet is approved, an expense line is created for the project capturing the expense as 
capex or opex, based on the selected expense type.

7. View the resource allocations in the heatmap by enabling the Allocation heatmap  toggle 
button.
You can switch from the week view to the month view based on your requirement.

Related topics

Update resource assignment from Project Workspace

Extend a resource assignment

Create a resource assignment for a group in Project Workspace

Use Project Workspace to create a group and associate it to your resource assignment. You can 
associate a set of users who share a common purpose to a group.

Before you begin
Role required: admin or it_project_manager

About this task
Create group and assign roles to them. Users assigned to the group inherit the roles.

Procedure

1. Navigate to All  > User Administration  > Groups.

2. Create a group.

For more information on how to create a group, see Create a user group .

3. Assign the pps_resource role to a group required for group-based resource assignment.
For more information on how to assign a role to a group, see Assign a role to a group .

4. Add members to the group so that the users inherit all the roles assigned to the group.
For more information, see Add a user to a group .

5. Navigate to Workspaces  > Project Workspace  and open a project.

6. From the Planning pane, double-click the Resource assignees  field for a project task.

You can assign the resources from both planning and resource assignment pane.

7. In the Resource  field, select the group from step 2 and press Enter.

Result
A resource assignment record for the group is created and auto-saved.

Note: 
When you select a group in the Resource  field, the assignment is created in the Pending 
state. When an assignment type is set to group, an assignment is created for all the 
members of the group, and the allocation hours are split evenly for all the members of that 
group.
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Create an attribute-based resource assignment

Create an attribute-based resource assignment in Project Workspace. You can pre-define 
attributes based on your requirement.

Before you begin
Role required: pps_admin or it_project_manager

Procedure

1. Create a planning attribute.

Note: 
If the assignment is attribute-based, then the assignment is created in the Unassigned 
state. You should have the pps_admin role to configure the planning attributes.

2. Navigate to All  > Employee Profile  > Employee Profiles.

3. Create an employee profile.
For more information, see Activate Employee Profile .

4. Navigate to Workspaces  > Project Workspace  and open a project.

5. From the Planning pane, double-click the Resource assignees  field for a project task.

You can assign the resources from both planning and resource assignment pane.

6. From the resource assignee list, select a user or group and press Enter.
You can create new custom attributes, such as location, in addition to group, skill, and role, and 
can also leverage these custom attributes to create resource assignments.

Result
A resource assignment record for an attribute is created and auto-saved.

Note: 
The Primary group, Primary skill, and Primary role  attributes can be enabled for the 
Resource Management. You can create more attributes based on your requirement.

Update resource assignment from Project Workspace

Update a resource assignment that is associated with a project or project task.

Before you begin
Role required: it_project_manager

In resource assignments, any changes made to the status of group resource assignment roll 
down to all associated child resource assignments status. Similarly, any changes made to the 
status of child resource assignments automatically roll up to the corresponding group resource 
assignment status.

About this task
Before updating a resource assignment, verify the following to ensure accurate and effective 
resource allocation:

• Resource availability: Check that the resource has available capacity during the assignment 
period. Overallocated resources are indicated with a warning icon.

• Primary attributes: Verify the resource has the required primary attributes such as, skills or 
roles matching the project task requirements.

• Existing allocations: Review the resource's current assignments across all projects to avoid 
conflicts or overutilization.
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• Group vs. individual: If updating a group resource assignment, note that status changes roll 
down to all child (individual) resource assignments. Similarly, individual status changes roll up 
to the group assignment.

• Assignment status: Verify the assignment is in the correct state (Requested, Assigned, or 
Approved) before making changes.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments  toggle button.

3. On the resource assignment pane, double-click any cell to edit the entire row.

4. Edit the desired field, and select anywhere on the data grid to save the details.

The resource assignment is updated in the resource assignment pane.

Note: 
When a resource is added on an empty resource assignment, which has more than one 
Full-time equivalent (FTE) effort, then an additional row is created automatically and the 
resource assignment is auto-updated in both the rows.

Extend, edit, or delete the resource assignments using the row context menu in resource 
assignment pane.

Related topics

Extend a resource assignment

Delete a resource assignment from Project Workspace

Update the resource allocation in a heatmap

Realign resource assignment to project task

Assign a resource using AI resource finder

Use AI resource finder to identify and assign a resource to an unassigned resource assignment.

Before you begin
Role required: it_project_manager or resource_manager

To use AI rationale, verify that resource fit analysis skill is active.

About this task
The AI resource finder uses generative AI to calculate AI rationale for available resources. 
Review the fit scores and availability before assigning a resource. Selecting a resource opens 
the existing assign resources modal where you can review allocations and distributions before 
confirming the assignment.

AI resource finder helps resource and project managers identify the best-fit resources for 
unassigned resource assignments in a project. The fit score indicates how well a resource 
matches a task based on the availability, past experience, similar kind of work and working on 
same projects. Resource managers review the AI-generated fit scores and rationale and decide 
which resource to assign to an unassigned assignment. The resource finder modal displays the 
following information for each resource:
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• Fit score: Percentage match of a resource for the task. The Fit score is deterministic and is not 
generated using AI.

• Rationale: AI-generated explanation for the fit score.

• Availability: The availability of the resource for a task.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments toggle button.
If the sn_pw.enable_resource_planning property is set to true, then the Resource assignment 
toggle button and resource assignment pane are displayed in Project Workspace. The default 
value is false. You must have the pps_admin role to enable this property.

3. Create a unassigned resource assignment by selecting Add resource  and selecting an 
attribute.

4. From unassigned tasks pane, select the context menu row ( ) for any task and select 
Resource finder.

5. From Resource finder modal, select Show monthly availability  toggle or weekly.

6. Select the resource assignee and select Assign resources.

7. From Assign resources modal, review the allocations and distributions and select Assign.

The resource is assigned to the task.
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Manage resources from resource page in Project Workspace

View and manage all the resource assignments without navigating through individual tasks using 
the resource page in Project Workspace. Resources page show all project-associated resources 
and their assignments to support forecasting and visualization of resource demands.

Before you begin
Role required: it_project_manager, resource_user

About this task
When you select Resources  page from the left menu, you are redirected to a page that displays 
the project associated resources and their resource assignments for better resource planning. 
You can also view how many tasks are assigned to each resource.

For example, Simon is a resource who is allocated to two project tasks. When you select Simon 
from the resource page, you can view all the project tasks to which Simon is assigned for a 
project.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Open the resource page of the project by selecting Resources  page from the left menu.

3. Edit the resource status, task effort, start date, end date, or other attributes of the resource 
assignment as required.
You can edit the row, reassign, extend, or open a resource assignment. You can create a 
new resource assignment directly from the resource page in the Project Workspace. You can 
select the unassigned tasks toggle to view all the unassigned resources that are not currently 
assigned to any task in that project. For sub-projects, you can select a sub-project and then 
select Resources  to view the resources allocated to that sub-project.

Related topics

Create a resource card

Access, assign, and approve unassigned work in Project Workspace

View, assign and authorize resources directly from Project Workspace  without navigating to 
Resource Management Workspace.

Before you begin
Role required: it_project_manager

About this task
In Project Workspace, when you select Resources  page from the left menu, you are redirected 
to a page that displays the project associated resources and their resource assignments for 
better resource planning. By embedding the resource page through interoperability, the Project 
Workspace application supports these actions:

• View assigned and unassigned work from the resource page.

• Assign unassigned work using automatic or manual effort distribution.

• Preview real-time effort allocations before assignment.

• Identify resource availability and over-utilization using visual indicators.

• Approve, unapprove, or reprioritize assignments by changing the resource status directly from 
the resource page.

• Extend or update assignments without leaving Project Workspace.
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Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Open the resource page of the project by selecting Resources  page from the left menu.

3. Enable the Unassigned tasks toggle ( ) to view the unassigned work 
requests in the lower pane.

You can create resource assignments based on the primary attributes (Group, Skill, or Role). 
You can see a comprehensive view resource allocations and group them by primary group, 
skill, role, owner, and parent item.

4. From unassigned tasks pane, select the context menu row ( ) for any task and select Assign 
Work.

5. You can assign work using one of the following ways.

Note: 
Remaining efforts after equally distributing the work among the users is retained in the 
Unassigned tasks tray. Resource managers can again allocate these efforts.

6. Select the Preview  button to see the real-time allocations before assigning the work.

7. Select the Assign  button to assign work to the resources.
The assigned work is reflected in the top pane nested by resource view and will be in Pending 
state ( ).

8. Expand a resource row using the expand row icon ( ) to view assigned tasks.

9. Double-click in the Resource status column and select Approve  to confirm the assigned work 
so the resource can start working.

While assigning the work, you can easily identify if a resource is available ( ) or overutilized 

( ), even for the future periods, using the iconography.

10. You can change the status of any assigned assignments using one of the following options.

Result
The assigned work items are Approved ( ) or Unapproved ( ) and the status of the work 
assignments is rolled up to the resource level.
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What to do next

• Reassign or unassign any assigned work from the Project Workspace. For more information, 
see Reassign or unassign work using Resource Management Workspace.

• Split resource assignments at a specific date from the Project Workspace. For more 
information, see Split resource assignments using Resource Management Workspace.

Move a resource assignment in Project Workspace

Move the resource assignment to a new start and end dates to accommodate changes in task 
scheduling or resource allocation. Shift assignments to balance workloads across resources and 
avoid over-allocation.

Before you begin
Role required: resource_user, resource_manager

About this task

• When you move an assignment to a new start and end dates, the initial requested or approved 
efforts are retained for the latest duration.

• When an assignment is moved, the Ready for review state is retained and the assignment 
remains accessible to resource managers for work allocation.

• You cannot move a resource assignment if actuals efforts are entered for the work.

• New assignment dates should be within the task duration dates.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments  toggle button.

Note: 
If the sn_pw.enable_resource_planning  property is set to true, then the 
Resource assignment  toggle button and resource assignment pane are displayed in 
Project Workspace. The default value is false. You must have the pps_admin role to 
enable this property.

3. Select a project task to view the assignments associated to the task.

4. From the resource assignment pane, select the row context menu ( ) and then select Move.

5. From Move assignment modal, select a New start date  using the date picker modal.

6. Optional:  Change the assignment status using the New status  list to one of the following 
available statuses.
Changing the status is restricted to the resource_manager role.

7. Select Confirm.
When you move the resource assignment for a group, the assignments are moved for all 
members of that group. You cannot move assignments for individual users within the group or 
for child resource assignments.

Related topics

Extend a resource assignment

Update resource assignment from Project Workspace

Delete a resource assignment from Project Workspace
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Update the resource allocation in a heatmap

Realign resource assignment to project task

Extend a resource assignment

Extend the date of an allocated resource assignment and allocate resources for the extended 
period.

Before you begin
Role required: resource_manager

About this task
Assume that work on a project has started, but there’s a need to extend the date of an allocated 
resource assignment because the project has been extended. In this scenario, you can extend 
the date of the allocated resource assignment. The new date by which the resource assignment 
is extended doesn’t have any impact on the existing allocated hours. While extending the 
resource assignment, you can specify the new end date and the request type. Based on the 
request type selected, the required allocated hours are auto-filled.

For example, assume that you allocated 100 hours for 2 months, 50 hours for each month. Now, 
you want to extend the resource assignment by one month. For the extended month, allocation 
records are created based on the request type selected.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Extend the resource assignment using one of the following options.

Result

• The assignment end date is updated and allocation is created based on resource's availability.

• The extended FTE or hours or person days is divided equally for the extended resource period.

Related topics

Resource assignments in Project Workspace

Create resource assignments using Project Workspace

Update resource assignment from Project Workspace

Delete a resource assignment from Project Workspace

Update the resource allocation in a heatmap

Realign resource assignment to project task

Delete a resource assignment from Project Workspace

Delete a resource assignment from Project Workspace. Deleting an assignment also deletes all 
associated resource allocations.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Enable the Resource assignments  toggle to view the resource assignment pane.
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3. From the resource assignment pane, create a resource assignment for a project or task by 
selecting Add resource.

4. From the resource assignment pane, select the row context menu ( ) and then select 
Delete row.
The resource assignment is deleted from the resource assignment pane.

Update the resource allocation in a heatmap

Use the allocation heatmap capability in Project Workspace  to view and update the resource 
allocation.

Before you begin
Role required: it_project_manager

About this task
The Allocation heatmap  toggle button provides a detailed breakdown of the allocation of an 
individual resource. The allocation heatmap represents the total utilization of a resource for a 
week or month. By default, allocation information is displayed for the week. This information 
helps project managers to plan their resources effectively at the project or task level.

Integrate your ServiceNow®  instance with your organization's Microsoft Teams  to enable 
collaboration of your projects and resource allocations in Microsoft Teams. With the Microsoft 
Teams  integration, you can communicate with the project team members and share real-time 
updates on the project and resource allocation status. For more information, see Setting up PPM 
collaboration for Microsoft Teams.

Procedure

1. Create resource assignments using Project Workspace.

2. View the resource allocations in the heatmap by enabling the Allocation heatmap  toggle 
button.
You can switch from the week view to the month view based on your requirement.

3. Edit the desired field and select anywhere on the data grid to save the details.
Work allocation is based on capacity. The allocations are color-coded to display the availability 
of the resources as shown here. These colors help to identify the availability of the resource for 
a particular task.

4. Edit the resource allocation window by selecting the allocation hours cell.
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Enable the Show actuals  toggle to view the actuals of each resource. The actuals can't be 
edited from Project Workspace.

5. From the resource allocation window, view and track the assigned Project, Owner,Task, and 
Task effort  of a resource.

The resource allocation is made according to the schedule of the resource, provided that the 
resource has a schedule.

The Allocation heatmap modal provides the Resource status, Remaining capacity, and 
Utilization  columns to support resource managers in evaluating task efforts.

6. Send a direct message to the project owner on Microsoft Teams  by selecting the Project 
Owner  field.

Note: 
The Project Owner  field can only be selected if your ServiceNow®  instance is integrated 
with your organization's Microsoft Teams. Resource assignments on demands are visible 
in the allocation window both before and after they become projects.

Related topics

Create resource assignments using Project Workspace

Realign resource assignment to project task

Realign or synchronize the resource assignment dates with the project task dates. This 
synchronization helps to schedule and align the resource assignments with the timeline of 
project task.
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Before you begin
Role required: it_project_manager

Procedure

1. Navigate to All  > Workspaces  > Project Workspace  and open a project.

2. From the project planning pane, double-click the Planned start date  or Actual start date  of a 
project task.

3. Edit the field and select Ok.

4. From the project task row, select the row context menu and then select Realign assignments 
to task.

Alternatively, use the Resources not synced icon  to synchronize the resource assignments 
dates with the project dates at a project level. Realign assignments to task related link is 
available to perform the same action while using forms.

Result
The resource assignments dates are synchronized with the project task dates.

Related topics

Resource assignments in Project Workspace

Project Workspace reference

Project Workspace  reference

Reference information to provide additional details about Project Workspace, such as the fields, 
user roles, tables, scheduled jobs, system properties, and custom scripts.

The components and properties installed with Project Workspace  are the same as mentioned in 
the Project Management. For more information, see these reference topics:

• Properties installed with Project Management

• Resource Management properties

Form field information for Project Workspace

Field information for forms used in the Project Workspace  application.

Action form of Project Workspace

Learn about the fields on the Action form of the Project Workspace. Use this form to add an 
action to your projects.

Action form

Field Description

Number System-generated number with a configurable prefix.

State Current state of the action. All new action records are created with the state 
set to Open.

The available states are:

• Pending

• Open

• Work in Progress
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Action form  (continued)

Field Description

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency for implementing or approving the action based on impact.

Estimated Cost Estimated cost generated by the action.

Impact The impact on the outcome of the project if you don’t implement the action.

Approval Status of approval from the stakeholders for the action. The available options 
are:

• Not Yet Requested

• Requested

• Approved

• Rejected

Assigned to Primary resource assigned to implement the action.

Due date Requested date on which the action must be approved or implemented.

Parent The project to which this action belongs.

Show on 
project status 
report

Option to specify whether the action information should be included in the 
project status report.

Short 
description

Brief description of the action such as what the action involves, how to 
implement the action, who it affects, and the action outcome.

As you start entering the title for your action, the related actions that 
potentially match your action title appear.

Description Details of the action and its potential impact.

Work notes Information about the action. Add work notes to communicate about the 
status of action approval, rejection, or implementation with other users.

Create cost plan form

Use this form to create cost plans for your planning items.

Create cost plan form

Field Description

Name Name of the cost plan.

Entered currency Currency to capture the unit cost value.

Unit cost Planned cost for the cost plan.

Quantity Quantity of cost plans.

Total planned cost Total planned costs value of the cost plan.
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Create cost plan form  (continued)

Field Description

Start fiscal period Starting month in a fiscal period for the cost 
plan.

End fiscal period Ending month in a fiscal period for the cost 
plan.

Cost distribution Allocate planned cost by fiscal period or 
duration.

Select a value from the list.

• Split equally across fiscal periods  - 
Distributes the cost equally among all the 
fiscal periods across the duration.

• Recurring per fiscal period  - Recurs the 
cost for each fiscal period across the 
duration.

Cost type Cost type of the cost plan.

Select a cost type form the list.

Note: 
Based on the selected cost type, the 
Role  and Product model  fields appear.

Employee type Read-only field.

• External  if Cost type is External labor Capex 
or External labor Opex.

• Internal  if Cost type is Labor Capex or Labor 
Opex.

Role Name of the role to expense the cost plan.

Product model Available if the Cost type is Software, 
Hardware, or Other Capex or Opex.

Select a model from the list to expense the 
cost plan.

Model name of a hardware expenditure to 
expense the cost plan.

Create expense line form

Use this form to create expense lines for your actual expense.

Create expense line form

Field Description

Number Auto-generated number for the expense line.

Amount Expense incurred.

Short description Short description of the expense.
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Create expense line form  (continued)

Field Description

Mention unique and specific details to identify 
the expense line.

Date Date of the expense.

Process date Processed date of the expense.

Cost plan Associated cost plan name for recording the 
expense line.

Cost type Cost type of the expense.

by default, the cost type of the cost plan is 
selected.

State State of the expense line.

Only processed expense lines are considered 
for an investment entity.

Expense type Defines the expense type, internal or external.

By default, the expense type is considered 
from the Cost type  field entry.

Rate card Name of the rate card.

Summary type Business purpose of the expense line.

Create status report form

Learn about the fields on the Create status report form of the Project Workspace. Use this form to 
create a new status report according to your requirement. The following are the heads in a report 
created using the Default status report template. A report created using the One-page status 
report template has fewer information heads.

Create status report form

Field Description

Status report name Unique name for the report that describes its 
purpose clearly.

Status Date Date of the report.

Overall health Current overall health and status of the 
project.

Executive summary Concise summary of the project’s status, 
highlighting key accomplishments, challenges, 
and decisions.

Comments Additional information or observations that are 
important for tracking.
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Create status report form  (continued)

Field Description

Last week's achievements List of key milestones or tasks that were 
completed in the previous week to show 
progress.

Key activities planned Main tasks or milestones planned for the 
upcoming week to provide visibility into future 
efforts.

Schedule Indication for whether the project is on track 
according to its planned timeline.

Comments on schedule Comments about any deviations from the 
planned schedule.

Cost Current project costs.

Comment on cost Comments about any deviations from the 
planned budget, such as overspending or cost 
savings.

Resources Resources allocated to the project. 
Confirming if the resources are sufficient and 
appropriately utilized.

Comments on resources Comments about the use of resources, 
including any shortages, excesses, or 
adjustments needed.

Scope Indication for whether the project scope is 
undergoing any changes.

Comments on scope Observations or explanations about changes 
to the project’s scope, including how they 
might affect the project.

Related topics

Create a status report in Project Workspace

Create new document template form

Learn about the fields on the Create new document template form of the Project Workspace. Use 
this form to create a new status report template according to your requirement.

Create new document template form

Field Description

Name Unique name for your template.

Category Category for the template. Search and select 
Project status report.

Description Type in a description for your template.

Visibility Visibility of the template.

Owner Owner of the template.
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Create new document template form  (continued)

Field Description

Icon Icon for the report. Select an icon file, which 
appears in the window along with the template 
you’re creating. This file appears in the header 
of the status report.

Is dynamic Option to insert dynamic project data in the 
status reports created using this template.

Attachments Attachments to the template.

Related topics

Create a status report template in Project Workspace

Decision form on Project Workspace

Learn about the fields on the Decision form of the Project Workspace. Use this form to add 
decisions to your projects.

Decision form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the decision. All new decision records are created with 
Open state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency of approving or implementing the decision based on possible 
impact.

Decision status Status of the decision. The available options are:

• Pending

• Approved

• Rejected

Impact Impact on the outcome of the project if you don’t implement the decision.

Approval 
required

Option for determining whether approval of the decision is required.

Estimated Cost Estimated cost of implementing the decision.

Due date Requested date on which the decision must be approved or implemented.
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Decision form  (continued)

Field Description

Assigned to Primary resource assigned to work on the decision. The default value is the 
name of the user creating the decision record.

Parent Project number to which this decision belongs.

Show on project 
status report

Option to specify whether the decision information should be included in 
the project status report.

Short description Brief description of the decision such as what the decision is about, who 
made it, what it affects, and the decision outcome.

As you start entering the title for your decision, related decisions that 
potentially match your decision are displayed.

Description Details of the decision and its potential impact.

Work notes Information to record and track the status of decision implementation or 
approvals.

Export status report form on Project Workspace

Learn about the fields on the export status report form on the Project Workspace. Use this form to 
export status of your projects.

Export status report form

Field Description

Report to export Existing project status report that you want to 
export as PowerPoint.

PowerPoint template PowerPoint template to apply for your status 
report.

Issue form on Project Workspace

Learn about the fields on the Issue form of the Project Workspace. Use this form to add an issue 
to your projects.

Issue form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the issue. All new issue records are created in the Open 
state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete
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Issue form  (continued)

Field Description

• Closed Incomplete

• Closed Skipped

Priority Urgency of resolving or managing the issue based on possible impact.

Estimated cost Estimated cost generated by the issue.

Impact Impact on the outcome of the project if the issue remains unresolved.

Due date Requested date for one of the following situations:

• If the issue has an assigned resource, then the Due date  is the date for 
resolving the issue.

• If the issue is not assigned to any resource, then the Due date  is the date 
when the issue must be closed or addressed.

Assigned to Primary resource assigned to work on the issue resolution.

Parent Project to which this issue belongs.

Show on project 
status report

Option to specify whether the issue information should be included in the 
project status report.

Short description
Brief description of the issue and its potential impact on the success of the 
project.

As you start entering the title for your issue, related issues that potentially 
match your issue are displayed.

Description Details of the issue and its potential impact.

Work notes Information to record and track the work accomplished for resolving the 
issue.

Project form in Project Workspace

Learn about the fields on the project form of the Project Workspace. Use this form to create a 
project.

Project form

Field Description

Project Name Preferred name of the project.

Planned start date The date that you plan to start the tasks for this 
project.

Project class Select the type of project that you want 
to create. For example, a regular project, 
customer project, or TeamSpace project.

Project template Template to apply for your project.
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Field Description

If the template you need is not available in the 
list, you can create it later and apply to your 
project.

Request change form on Project Workspace

Learn about the fields on the Request change form of the Project Workspace. Use this form to 
add a change request to your projects.

Request change form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the request change. All new request change records are 
created in the Open state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Priority Urgency for approving the requested changes based on impact.

Estimated Cost Estimated cost generated by the requested changes.

Impact Impact on the outcome of the project if you do not approve the requested 
changes.

Approval Status of approval from the stakeholders for the requested changes.

Assigned to Primary resource assigned to work on the request change.

Due date Requested date to complete the request change.

Category Entity for which you are creating the request change. The options are:

• Resource

• Scope

• Cost

• Schedule

Parent Project number to which this request change belongs.

Show on project 
status report

Option to specify whether the request change information should be 
included in the project status report.

Title Title for the change request.

Description Details of the request change and its potential impact.
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Request change form  (continued)

Field Description

Business 
Justification

Reason for requesting the proposed change in the project and its impact 
on the business.

Work notes Additional information to indicate progress on the project request 
change.

Risk form of Project Workspace

Learn about the fields on the Risk form of the Project Workspace. Use this form to add risk to your 
projects.

Risk form

Field Description

Number System-generated ID number with a configurable prefix.

State Current state of the risk. All new risks are created in the Pending state.

The available states are:

• Pending

• Open

• Work in Progress

• Closed Complete

• Closed Incomplete

• Closed Skipped

Risk status Status of the risk. The available options are:

• Pending

• Achieved

• Not Achieved

• Avoid

• Mitigate

• Transfer

• Accept

Probability The likelihood that the event described in the risk may occur. The available 
options are:

• Absolute

• High

• Moderate

• Low

Impact Impact of the risk event on the outcome of the project.
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Risk form  (continued)

Field Description

Estimated 
cost

Estimated cost generated by the risk event.

Risk rank A value and color assigned to the risk. This value is calculated using risk 
probability and impact. You can configure the color and value using the Risk Value 
Lookup. For more information, see Configure custom Risk rank and Risk value for a 
project.

Risk owner Primary resource who is responsible for monitoring and managing the risk.

Assigned 
to

Primary resource assigned to work on the risk.

Risk value A value calculated from the Risk Value Lookup. For more information, see 
Configure custom Risk rank and Risk value for a project.

Due date Requested date for one of the following situations:

• If the risk has an assigned resource, then the Due date  is the date for resolving 
the risk.

• If the risk is assigned to any resource, then the Due date  isn’t the date when the 
risk must be closed or addressed.

Show on 
project 
status 
report

Option to specify whether the risk information should be included in the project 
status report.

Task Project to which this risk belongs.

Short 
description

Brief description of the event and its potential impact on the success of the 
project. If the risk is created from the risk library, then this field displays the Risk 
Statement  name.

Description Details of the event and its potential impact. If the risk is created from the risk 
library, then this field displays the Risk Statement short description.

Actual cost Cost generated by the risk event. This information gets added when and if the 
event occurs.

Mitigation 
plan

Brief description of efforts taken to mitigate the risk.

Note: 
The Risk Assessment Summary section only appears when the Enable Advanced 
Risk PPM Integration  property is enabled.

Risk Assessment Summary section of the Risk form

Field Description

Inherent risk This field gets auto-populated with the risk 
scores when the risk assessor evaluates the 
inherent risk.
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Risk Assessment Summary section of the Risk form  (continued)

Field Description

Elevated to enterprise risk This option gets selected automatically when 
the risk is elevated to enterprise risk by the 
project manager.

Residual risk This field gets auto-populated with the risk 
scores when the risk assessor evaluates the 
residual risk.

Enterprise inherent risk This field gets auto-populated with the risk 
scores when the risk assessor assesses the 
enterprise inherent risk.

Enterprise residual risk This field gets auto-populated with the risk 
scores when the risk assessor evaluates the 
enterprise residual risk.

Resource assignment form

Use this form to create resource assignments from Project Workspace.

Resource assignment form

Field Description

Resource Category of resource. To request any member of group or user, select the name 
from the resource list.

Effort Type Type of effort selected during the creation of resource assignment. If you select 
any of the following choices, then a field is displayed for that choice.

• Hours

• FTE

• Person days

For example, if you select Hours, then the Hours  field is displayed.

Effort Effort of the resource assignment.

• If you select Hours, the number of allocated hours for a selected resource is 
displayed.

• If you select FTE, the number of units for the full-time equivalent value for a 
selected resource is displayed. By default resource assignment is created with 
1 FTE (1FTE=8 hours) effort.

• If you select Person days, the number of days for the selected resource is 
displayed.

Start date Start date for the resource assignment. By default, this field shows the Planned 
start date  of the associated project record or task record. If both planned 
and actual start dates are available on the project tasks, the actual dates are 
considered by default for resource assignment start date.

End date End date for the resource plan. By default, the date is derived from the Planned 
end date  of the associated project record or task record. Edit the default date, 
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Resource assignment form  (continued)

Field Description

if necessary. If both planned and actual end dates are available on the project 
tasks, the actual end dates are considered by default for resource assignment.

Role Role associated with a role resource assignment.

Note: 
You can define project-specific roles for the team members based on their 
skills and competencies.

Group Group associated with the resource assignment.

Note: 
When you select a group in the resource field, the assignment is created for 
all the members of the group. You can associate roles, skills, locations, and 
other attributes to groups, which then apply to users within a group. Groups 
can also be assigned as primary groups based on your requirements.

Skill Skills that the requested resources possess to allocate the resources to the 
resource assignment.

Resource 
status

State of the resource assignment.

Note: 
If the resource assignment is for a user or group, then the assignment is 
created in the Pending state.

If the assignment is attribute-based, then the assignment is created in the 
Unassigned state.

Employee 
Type

Type of employee. For example, internal or external resources.

Allocation 
status

Status of the resource allocation. This field is automatically set to Allocated.

Task Task to which the assignment applies. If the resource assignment was created 
from a project task, the task number appears here.

Top task Parent task for which the assignment is created.

Resource 
allocation

Allocation number of the resource.

Assignment 
type

Type of resource assignment.

• Group

• User

Allocation 
type

Type of allocation.

• Monthly

• Weekly
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Resource assignment form  (continued)

Field Description

For example, if you select Monthly, the allocation hours are split evenly for the 
month and if you select Weekly, the allocation hours are split evenly for the week.

Offset Difference between actual or planned start date of project or task and resource 
assignment start date.

Project workspace classic - Legacy
Define, plan, track, and monitor your projects from a single location. View status reports and KPIs 
to take further actions for the project.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Projects in the My Projects Space page

The project workspace overview page — My Projects Space  — displays projects as cards based 
on filter criteria. A maximum of the 200 most recently updated projects appear on the page. 
Clicking a card opens the project in the project workspace. You can configure  the information 
that is displayed on a card.

Project cards on the My Projects Space page

The components of the workspace are:

Banner icons

The following banner icons are available in project workspace:

Home

The home icon ( ) enables you to return to the list of project cards on My Projects 
Space  page.

Project choice list
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The choice list displays the projects that you can select to open in project 
workspace. The projects in the choice list appear based on the filter criteria applied 
in My Projects Space  page.

Project checklist

The checklist icon ( ) helps you to build the checklist of activities that must be 
completed in a project.

Tabs in the project workspace

The project workspace comprises of the following tabs described at a high level:

Analytics

The Analytics  tab provides analytics on project aspects such as open risks, open 
issues, and delayed milestones.

Details

The Details  tab opens the project form and enables you to define important aspects 
of the project.

Planning

The Planning  tab opens the project in the planning console. The tab also enables 
you to navigate to Project workbench and track your project in the workbench.

Resources

The Resources  tab enables you to find resources, and create and manage the 
resources plans for the project and project tasks. The tab is available only to a 
project manager.

Financials

The Financials  tab displays breakdowns of cost components of a project: planned 
cost, estimated returns, allocated budget, cost plans, and benefit plans. You can 
create baselines and compare baselines from this tab to track changes occurring 
during execution of project or demand.

Status Report

The Status Report  tab displays the project status reports.
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Project workspace example

Access the classic Project Workspace

Open the project workspace to display all your projects at a single location.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_user or it_project_manager

Procedure

1. Navigate to All  > Project  > Projects  > Project Workspace  to open My Projects Space  page.

2. In the My Projects Space  page, add filter criteria to display the required projects as cards.

Note: 
You can configure  the information which is displayed on a card.

3. Click a project to open it in project workspace.

4. Click the required tab in project workspace to work in it.

Configure parameters displayed on project cards in classic Project Workspace

Configure the parameters that are displayed on a project card in My Projects Space  page of 
classic Project Workspace. A card shows the project summary so that project managers can 
quickly gauge project status and health by looking at the card.
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Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_pps_admin

About this task
The project workspace overview page My Projects Space  displays the projects as cards based 
on the filter criteria. The cards have a color band at the top. The color of the band is based on the 
Status  field in the respective project record. Each card further displays the following information 
about the project in three rows:

• Row 1 displays project name, state, project manager name, and important project dates. The 
displayed project dates are based on the current state of the project:

◦ If the project state is Pending or Open, planned start date and planned end date are 
displayed.

◦ If the project state is Work in Progress, actual start date and planned end date are displayed.

◦ If the project state is Closed, actual start date and actual end date are displayed.

• Row 2 displays Status, Percent complete, and Phase columns from project [pm_project] table. 
The number of displayed columns in this row is fixed to 3, but the columns to be displayed can 
be configured in [pm_home_page_config] table.

• Row 3 displays the following project information based on the current state of the project.

◦ Open risks, open issues, actions, and overdue tasks of the project under Updates  heading.

◦ Date and short description of the last missed milestone task under Last missed milestone 
heading.

The parameters displayed are derived from the records in [pm_home_page_card] table. In 
[pm_home_page_card] table, each project state is assigned some parameters to be displayed.

You can configure the information which is displayed in row 2 and row3 on a card.

Procedure

1. Navigate to All  > Project Administration  > Project Workspace.

2. Select a table for which you want to change the card configuration, for example, select 
Project[pm_project].

3. Set the display columns for row 2 of the card in PM Home Page Configuration 
[pm_home_page_config] table.

a. Select the columns to be displayed in Column-1, Column-2, and Column-3  fields.

b. Click Update.
The selected columns appear in row 2 of the project cards.

4. Set the parameters for row 3 of the card in PM Home Page Card [pm_home_page_card] table.
In [pm_home_page_card] table, each project state is assigned the parameters that are 
required to be displayed on a project card in third row.

a. Click New  in PM Home Page Card  related list.

b. On the form, fill in the fields.
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PM Home Page Card form

Field Description

Order Position at which the parameter appears in row 3 of the card.

State Project state for which the parameter needs to be added.

Value Section to be displayed for the selected state in row 3 such as Updates  and Last 
missed milestone.

Content JSON field to add the parameters to be displayed under the selected section for 
the selected state.

The following screenshot shows a JSON example of adding Risks, Issues, Actions, and 
Overdue tasks parameters under Updates  heading for Open state.

c. Click Submit.

Note: 
Use the same steps to change a display parameter assigned to a state.

The parameter is added or updated for the selected state. It appears under selected section in 
row 3 on the project cards for the state it was added.

View project analytics in classic Project Workspace

View the summary of a project in Analytics  tab of classic Project Workspace.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_user

About this task
The Analytics  tab is a PA dashboard which displays preconfigured widgets and reports to 
track the progress on various aspects of a project such as open risks, actual cost, and delayed 
milestones. The information in the reports is rolled up from the project form fields. For information 
about various widgets and reports for different project types, see Project analytics widgets and 
reports

Procedure

1. Open  the required project in Project Workspace.

2. Click the Analytics  tab to display its contents.

3. Review the displayed reports and take necessary actions, if required.

Project analytics widgets and reports

Widgets and reports that provide information for the project summary in the Analytics  tab of the 
project workspace for Agile, Waterfall, and Hybrid projects.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1588

https://hi.service-now.com/kb_view.do?sysparm_article=KB0867184
https://hi.service-now.com/kb_view.do?sysparm_article=KB0867184
https://hi.service-now.com/kb_view.do?sysparm_article=KB0867184


Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Project widgets and reports

Widgets and reports provide information that enables you to view and track the progress of your 
Agile, Waterfall, and Hybrid project.

Note: 
You must have the Agile Development 2.0  plugin installed to view the widgets and reports 
for your Agile and Hybrid projects.

Your system administrator can configure the widgets and reports in the dashboard to display 
project information on the Analytics  tab. The following dashboards are available:

Project Execution Type Dashboard Displayed Description

Hybrid Project Summary – Hybrid Contains reports and widgets 
for hybrid projects.

Agile Project Summary – Scrum Contains reports and widgets 
for agile projects.

Waterfall Project Summary – Waterfall

Note: 
This dashboard was 
previously known 
as Project Manager 
Summary Dashboard.

Contains reports and widgets 
for waterfall projects.

The project execution type determines the dashboard displayed on the Analytics  tab.

You can also embed a custom dashboard in the Analytics  tab. Your system admin can 
modify the PMViewDataUtils  script include and configure the variable value for the 
dashboards_tabs  in the getDashboardUrl  method. As a result, you can view the custom 
dashboard in Project Analytics. For example:

var dashboards_tabs =
 
      {
             waterfall: {
                         dashboard_sysId: 
 '5d4959dd878003008b9b3a0548cb0bd0',
                         tab_sysId: 
 '1d99d5dd878003008b9b3a0548cb0bbd'
                             },
             hybrid: {
                         dashboard_sysId: 
 '96dc46c78700330047d84c2c59cb0bf1',
                         tab_sysId: 
 '520d4ac78700330047d84c2c59cb0bab'
                              },
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             agile: {
                         dashboard_sysId: 
 'f3dd4ec78700330047d84c2c59cb0b93&tab',
                         tab_sysId: 
 '52fd8ec78700330047d84c2c59cb0bae'
                              },
             any_other_executionType: {
                         dashboard_sysId: 
 'custom_dashboard_sys_id',
                         tab_sysId: 
 'custom_dashboard_tab_sys_id'
                              },
         };

The following widgets and reports for all project types are provided in the Analytics  tab to help 
the project manager analyze the project.

Widgets and reports for Agile project

Name Description

Stories Missing Acceptance Criteria Number of stories in the project without 
acceptance criteria information.

Stories Missing Points Number of stories in the project with the 
Points  field blank.

Stories Acceptance Overdue Number of stories in the project that are not 
in the Completed or Cancelled state after the 
sprint end.

Team-wise Sprint Status Track the sprint-wise status of various scrum 
teams across the release. Click the team name 
to view sprint details.

Stories by State Donut chart showing the number of stories in 
different stages of development such as Draft, 
Ready, and WIP. Click the appropriate state to 
view details of the stories.

Progress by Points Track the progress of the project based on 
points. You can group and stack stories based 
on any combination of Epic, Assignment 
group, and State.

Progress by Stories Track the progress of the project based on the 
number of stories. You can group and stack 
stories based on Epic, Assignment group, and 
state.

Widgets and reports for Waterfall and Hybrid project

Name Description

Issues Number of issues in the Pending, Open, 
and Work In Progress states included in the 
project.
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Widgets and reports for Waterfall and Hybrid project  (continued)

Name Description

Actions Number of action items in the Pending, Open, 
and Work In Progress states for the project.

Change Requests Number of change requests in the Pending, 
Open, and Work In Progress states for the 
project.

Stories by State Pie chart showing the number of stories in 
different stages of development such as Draft, 
Ready, and WIP. Click the appropriate state to 
view the details for the stories.

Note: 
This widget is applicable for Hybrid 
projects only.

Tasks by State Donut chart showing the number of project 
tasks in different stages of development such 
as Pending, Open, Work In Progress, and 
Closed Complete. Click the appropriate state 
to view the task details.

Project Member Allocation Details (Hrs) Stacked bar chart showing allocated and 
actual hours of the resources assigned to the 
project.

Project Member Allocation Details — Monthly 
(Hrs)

Pivot chart showing the monthly allocated and 
actual hours for the resources assigned to the 
project.

Task Assignments Track the state of various project tasks across 
the release based on the assigned users or 
group. Click the user or group name to view 
the details of the assigned tasks.

Resource Plans by State Donut chart showing the number of resource 
plans grouped according to their current state.

Overdue Tasks and Milestones List of overdue project tasks and milestones, 
which are the tasks that satisfy either of 
the following conditions in the Project Task 
[pm_project_task] table:

• The value of the Planned start date  is 
before today's date and the State  value is 
Open or Pending.

• The value of the Shadow  field is set to false.

Upcoming Tasks (next 2 weeks) with no 
assignee

List of unassigned Open or Pending project 
tasks that are planned to start 14 days from the 
current date.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1591



Common widgets

Name Description

Phase Current state of the project such as Initiating 
or Planning.

Status Color indicator that signifies the status of the 
project.

Percent Complete Percentage of the project that has been 
completed.

Time Elapsed Amount of time that has passed while working 
on the project from the actual start date to the 
planned end date.

If the project is in the Open or Pending state, 
then the time elapsed is calculated based on 
the Planned start date and the current date.

Risks Number of risks in the Pending, Achieved, and 
Not Achieved states concerning the project.

Cost Trend Analysis Line graph showing a comparison between 
the planned costs and actual costs on a 
monthly basis.

Monetary Benefit Trend Analysis Line graph showing a trend of planned 
financial benefits on a monthly basis.

Non-monetary Benefit Plans Breakdown of the number of non-monetary 
benefit plans for active projects along with its 
associated benefit plans.

Non-monetary Planned vs Actual Benefits Comparison of total planned and actual non-
financial benefits for active projects grouped 
by fiscal period.

Confirmed vs Allocated vs Actual Hours Comparison of total confirmed, allocated, and 
actual hours for the project.

Time Cards — Pending Approval Time cards for the selected project that are 
submitted but not yet approved.

Time Card — Exception Report List of users who did not submit their time 
cards for the selected project, and time cards 
that are not yet approved for the selected 
project. The exception report is generated for 
users who are assigned to a task in progress, 
or hard-allocated to the project or task.

Define a project in classic Project Workspace

Define important aspects of the selected project such as duration, estimated cost, and the net 
value to the organization in classic Project Workspace.
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Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_user

About this task
The Details  tab in project workspace displays the project form  for the selected project.

Procedure

1. Open  the required project in Project Workspace.

2. Click the Details  tab to display the project form.

3. Edit the project record as required.

Plan a project using planning console in classic Project Workspace

Perform the project planning such as create project schedule, make resource assignments, 
create baselines, and view critical path, using planning console in the classic Project Workspace.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_user or it_project_manager

About this task
The Planning  tab in project workspace displays the selected project in planning console.

Procedure

1. Open  the required project in project workspace.

2. Click the Planning  tab to display the project in planning console.

Note: 
If project workbench is already open in Planning  tab, click the Project Workbench 
selection arrow on the banner and select Planning Console.

3. Plan the project using planning console features such as WBS hierarchy and Gantt chart.
You can also perform several tasks on the planning console  that you can perform on lists and 
forms, such as creating project tasks.

Track a project using project workbench in classic Project Workspace

As a project manager, track and manage a project in Project Workbench.
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Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_manager

About this task
You can use the Planning  tab in project workspace to displays the selected project in project 
workbench.

Procedure

1. Open  the required project in project workspace.

2. Click the Planning  tab.

3. To display the project in project workbench, click the Planning Console  selection arrow on the 
banner and select Project Workbench.

4. Track and manage all aspects of the project using project workbench.

Create and manage resource plans for a project in classic Project Workspace

As a resource requester, find the availability of the resources, and create and manage the 
resource plans for the project and project tasks in the project workspace.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_manager

About this task
The Resources  tab in project workspace shows the resource plans for the selected project in an 
editable grid view. The tab consists of the following sections:

Resource grid

It is the top section on the page that enables you to:

• Create resource plans for the project or its tasks. You can create a resource plan 
at a group, role, or user level.

• View and manage all the resource plans for the open project and its tasks in one 
place.

• View resource allocations for each resource plan in a grid view.

Use the grid view in the tab to:

• Edit the planned and allocated hours inline without opening the record in a form.

• Group, hide, or show columns as per your requirement.

• Hide cancelled or completed resource plans.
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• Request, confirm, or allocate a resource plan.

• Move a resource plan and its allocations to a future date for a group, role, or user 
resource plan.

• Replace a user with another user for a group, role, or user resource plan to 
accommodate situations like a user taking leave during a project.

• Request extension of an allocated resource plan.

• Shift allocation of a user to a future date for a group or role resource plan.

• Identify the resource plans created with specific members preference by viewing 

the Resource plan created with specific members  icon ( ) next to the resource 
plans.

Resource Finder

The section is available at the bottom of the page. The section is hidden by default. 

It can be made visible by clicking the resource finder icon (  ) in the top right of 
the page. It enables you to:

• Search the resources and view their availability. You can search the resources by 
group, role, or user.

• Add resource plans for the searched resources to the project and its tasks.

• Search for resources and view their availability and utilization. You can search 
resources by group, role, or user.

• Add or confirm resource plans for the current resources.

• Configure the Actuals column using Detailed View.

• Filter resources in the Resource Finder by available, overallocated, or all 
resources.

• Identify resources that are created as specific members for a resource plan 

by viewing the Member specified in the resource plan  icon ( ) next to the 
resources.

• View the Resource Availability and Resource Capacity grids by clicking on a 
capacity or availability column.

You can view the user and resource allocation details in a pop-up window by 
selecting the User  and Allocated Hours  columns respectively in the Resource 
Availability  grid.

When you select a resource plan in the resource grid section, the availability details of that 
resource are displayed in the resource finder section. For example, if a group resource plan 
is selected, the availability details of the group and its members are displayed in the Finder 
section. When you change the selection, the finder is automatically updated based on the 
current selection.

Procedure

1. Open  the required project in project workspace.

2. Click the Resources  tab.
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◦ To create a resource plan, click New.

◦ To view the allocations in weekly or monthly format in the grid, click Week  or Month  button. 
The selected option changes the grid view in both the resource grid and resource finder 
sections.

The time duration in the grid is displayed based on the earliest start date of the project or 
resource plans, and the last end date of the project or resource plans.

◦ To view the allocations in hours, FTE, or person days format in the grid, click Hours, FTE, 
or Person Days  option in the list. The selected option changes the grid view in both the 
resource grid section and resource finder section.

◦ To search the resources and create a resource plan for them, click the resource finder icon ( 

 ).

◦ To show or hide certain columns from the grid view, click the configuration icon ( ). Hiding 
or displaying an item column does not update the table. Grouped columns cannot be 
hidden.

◦ To view the resource allocations at user level, expand a resource plan in the grid. The user 
level allocations are listed only for Group and Role resource plans.

◦ To edit the planned and allocated hours inline in the grid, double-click a row. You can 
update the planned hours for future period for resource plans in Requested, Confirmed, and 
Allocated state.

◦ To view and update resource plan details in a form, click the information icon (  ) in the 
beginning of the resource plan row.

◦ To request a resource plan in the Actions  column, click the actions icon (  ) and select 
Request.

◦ To delete a resource plan in the Actions  column, click the actions icon (  ) and select 
Delete.

◦ To request all the resource plans created for the project in the Actions  column, click the 

actions icon ( ) in the project row and select Request All. The icon is enabled when at 
least one of the listed resource plans for the project is in the Planning or Rejected state.

View forecasts and manage financial plans for a project in classic Project 
Workspace

Use the Financials  tab in Project Workspace to capture the costs and benefits of a project.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_manager

About this task
The Financials  tab provides a detailed breakdown of the cost components of a project. The total 
planned cost, budget cost, actual cost, and planned returns with their breakdowns are displayed 
in the form of read-only cards, while the cost plans, benefit plans, and their breakdowns are 
provided in an editable grid view. Using the grid view, you can:
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• Group the plan level columns; configure, sort, expand, collapse, and freeze both the plan level 
and breakdown columns.

• Inline edit the breakdown values of a cost plan or benefit plan without opening the plan in a 
form. Inline edit is available only in the Monthly view.

• Create a cost plan and benefit plan for the project.

Procedure

1. Open  the required project in project workspace.

2. Click the Financials  tab.

3. To create a cost plan:

a. Select Cost Plans  from the list.

b. Click New.

4. To create a monetary benefit plan:

a. Select Monetary Benefit Plans  from the list.

b. Click New.

5. To view the project costs and financial breakdown summary of a project for the selected fiscal 
year, select Overview  from the list.
The Overview  tab gives the financial summary for Planned Cost, Actual Cost, Variance 
(Planned vs Actual cost), Estimate At Completion, and Estimate To Completion.

Note: 
If a project has a sub-project with a cost plan, the financials overview breakdown view is 
not enabled by default. To enable this view, a user with the it_pps_admin role should set 
the value of the com.snc.project.rollup.cost  property to true.

◦ You can manage the financial summary view on the Overview  tab.

a. Navigate to All  > System Definitions  > Script Includes.

b. Search for and select the PmOverviewTabConsts  script.

c. Rearrange or remove the code from the Script  and click Update.

You can drag the headers and drop them at the required position to rearrange the financial 
summary columns on the Overview  tab. This arrangement resets after the current session 
ends or expires.

◦ The admin can configure the level at which the financials overview data is displayed for the 
fiscal year in the Project related properties  page by navigating to Project Administration 
> Settings  > Preferences - Project. If no value is specified, by default, the financials are 
displayed at the quarterly breakdown.

6. Optional:  Review additional fields, view plan details, or reorganize the comparative data on 
the form.

◦ To create a baseline or compare the available baselines, click the baseline information icon 

( ) and then select Create New Baseline  or Compare Baselines  option, respectively.

In the Financial Baseline comparison screen, the top two rows show all the values in either 
functional currency or project currency. To display the values in project currency, click the 

configuration icon ( ) and toggle the Show Widgets in Project Currency view.
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The Financial Baseline Details pane indicates the Functional Currency and the Project 
Currency that has been selected.

The Financial Baseline grid shows the Functional cost, Cost in Project currency, Actuals, and 
Actuals in Project Currency. You can view the Project currency at the grid level. This view is 
helpful when there are cost plans of sub-projects that are in different project currency.

◦ To view a cost plan or benefit plan details on a form, click the information icon ( ) available 
in the Name column of the grid.

◦ To view a cost plan or benefit plan details in yearly, quarterly, or monthly format, click the 
Year, Quarter  or Month  views respectively.

◦ To toggle viewing the widgets in the Financial Summary section, click the widgets icon ( ) 
and then select the Show Widgets  option.

Select an individual widget name to display the widget. Clear the selection to hide the 
widget.

The selected field preferences are saved and are available when you reopen the Financial 
tab.

◦ To show or hide columns in the grid, click the configuration icon ( ) and select the field 
names.

You cannot hide the grouped columns. To reset to the default grid column layout, select the 
Reset to defaults  option.

◦ To view the project costs in project currency, click the configuration icon ( ) and select the 
five widgets to show project currency amounts. The widgets are Total Planned Cost in Project 
Currency, Budget Cost in Project Currency, Actual Cost in Project Currency, Planned Return 
in Project Currency, and Benefit in Project Currency.

You can view both the functional and project currencies in the currency indicator.

In the Financial Summary grid view of the Cost Plans  and Benefit Plans  tabs, all items 
related to project currencies are configured in the column heads such as Cost in project 
currency, Project currency, and Total actual cost in project currency.

By default, you can view only the functional currency columns. To view the project currency 

columns, click the configuration icon ( ) and select the project currency column check 
boxes in the item columns.

The aggregated amount in the Cost in project currency  field is clear if there are cost plans of 
sub-projects with different project currency.

Configure a widget for project financial metrics

Configure a widget to view and track the financial metrics of a project on the Financials  tab of the 
Project Workspace page.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.
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Before you begin
Role required: pps_admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. Click New.

3. On the form, fill in the fields.

Widget form

Field Description

Name Unique name for the widget.

Scripted Option for indicating the value on the widget is from a code script.

By default, this option is selected and is read-only.

Show 
Label

Option for displaying either the label or the color indicator.

If you clear the check box, the Color  field appears and you can set the color.

Active Option for indicating the status of the widget.

Only active widgets can be shown on the Financials  tab of the Project 
Workspace.

Parent 
widget

Widget that is the parent of the current widget.

The current widget displays in the Child widgets related list of the selected 
widget.

You can add a maximum of three child widgets for a parent widget.

Formatter 
required

Option for specifying whether a currency formatter is required for the widget.

Script
Code script that returns a requested metric value that is displayed on the 
widget.

In the script, use the context and filter objects. The context object contains all of 
the project financial fields, such as capex_costs, opex_costs, and budget_cost.

The following sample script returns the Estimate At Completion metric value of a 
project to appear on the widget.

var context = JSON.parse(context);
var filter = context.filters;
 
var now_GR = new GlideRecord('pm_project');
gr.addEncodedQuery(filter['pm_project']);
gr.query();
if(gr.next())
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Field Description

 gr.getValue('forecast_cost');
Collapse

Short 
description

Description of the widget.

What to do next
Associate the widget to the Project table.

Associate a widget to the Project table

After you configure a widget, associate it with the Project table to show the financial data of a 
project.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
You should configure a widget  before you can associate it with the Project [pm_project] table.

Role required: pps_admin

Procedure

1. Navigate to All  > Project Administration  > Widgets.

2. Open a widget to associate with the Project table.

3. In the Widget associations related list, click New.

4. On the form, fill in the fields.

Widget association form

Field Description

Association 
ID

Record to associate to the widget.

To access the relevant records, you must select the Tables [sys_db_objects] 
table in the Table name  list and the Project [pm_project] table in the Document 
list.

Association 
table

Table to associate to the widget.

You must select Table [sys_db_objects] from the list.

Widget Unique name of the widget.

Order Position of the widget in relation to other widgets in the Financials  tab of the 
Project Workspace.

Widgets appear in numeric order with the smallest number listed first.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1600

https://hi.service-now.com/kb_view.do?sysparm_article=KB0867184
https://hi.service-now.com/kb_view.do?sysparm_article=KB0867184
https://hi.service-now.com/kb_view.do?sysparm_article=KB0867184


Field Description

Display on 
card

Option to display the widget in the Financials  tab.

Include by 
default

Option to show the widget by default in the Financials  tab.

Request funds for a project in classic Project Workspace

Request funds for your project investment to work on project activities and meet the business 
goals.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
You can request funds for your project if the following conditions are true:

• The Investment Funding (com.snc.investment_funding) plugin is activated.

• The funding entity for Project is available and is active.

Role required: it_project_manager

About this task
If you have added cost plans to your project, you can refer the total planned cost displayed on 
the column header of each period to determine the amount to request.

Procedure

1. Navigate to All  > Project  > Projects  > Project Workspace.

2. Click a project for which you want to review or manage funds.

3. On the Project Workspace, click the Financials  tab.

4. Click the Funds  tab.
The Funds list shows funding sources if you have previously requested funds from them for 
your project.

5. Click the Add New Source  link to select the funding source.

6. In the Select a Source  pane, select one or more source investments from the list, and then 
click Add Selected.
The specified funding source is added in the Request Funds grid.

7. In the Request Funds grid, specify the amount in the CapEx  and OpEx  columns under New/
Modify Request  of the funding sources from which you want to request funds.
The state of all updated funding sources changes to Draft or Planning, which is indicated by 
highlighted cells.

8. Click Request.

9. In the Confirm request dialog box, verify your requests and add a comment if required.

10. Click Request
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Enter actuals spent in a project in classic Project Workspace

Enter actual spends in your project to track the fund utilization.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_manager

About this task
When you spend funds allocated to your project to complete your project activities, record that 
amount as actuals to review and track your project finances.

Note: 
The actuals in the project record, that is calculated from the expense lines, does not reflect 
into the actuals of the Funds automatically. Since your actual spends might include labor 
costs and other expenses, you should enter it manually against the corresponding funding 
source in the Funds list.

Procedure

1. Navigate to All  > Project  > Projects  > Project Workspace.

2. Click a project for which you want to review or manage funds.

3. On the Project Workspace, click the Financials  tab.

4. Click the Funds  tab.

5. In the Funds list, enter the actual amount spent in the project under the Actual CapEx  and 
Actual OpEx  columns for the corresponding funding source.

Note: 
If you do not see the Actual CapEx  and Actual OpEx  columns in the list, select them from 

the configuration icon ( ).

Result
The entered amount is updated as actuals for the project.

View a project status report in classic  Project Workspace

As a project manager, view the project status reports for a project using Status Report  tab in 
classic  Project Workspace.

Important: 

Classic Project Workspace  is being prepared for future deprecation. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base. Use new 
Project Workspace  with enhanced UI to help you efficiently manage your projects.

Before you begin
Role required: it_project_manager
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About this task
From the Status Report  tab, you can:

• View and print the status reports available for a project.

• Create a status report.

• Save time when creating a status report by copying fields from existing status reports of the 
project.

Procedure

1. Open  the required project in project workspace.

2. Select the Status Report  tab.
The most recent status report created for the project is displayed.

3. To create a status report, click Create new  button in the top right.

4. To copy an existing status report:

a. Select a status report from the choice list that you want to copy.

b. Select Copy  from the choice list next to Create new.
The option copies the selected status report including all fields into the new report.

c. Select Save.

5. Select a status report from the choice list to view the contents of a status report  available for 
the project.
The reports are listed in the choice list by their creation date.

Investment Portal
Completing projects and demands on time within budget is a challenge. Investment Portal gives 
you a comprehensive view of project and demand financials, deadlines, and other important 
metrics in an intuitive user interface that makes project and demand management more efficient.

Tracking and managing your investments (both projects and demands) and then creating 
investment reports and sharing them through email is time consuming and inefficient. To 
generate a report you must obtain the status of projects and demands from project and demand 
managers, produce the report, and then email it.

With Investment Portal you can create an investment board through filter definition, and share 
it with other stakeholders. You can save time on new investments by creating, cloning, or 
modifying boards as needed. Filtering makes it easy to surface information on the fly and for 
reporting.

Here are a few examples showing how Investment Portal can make managing and reporting more 
efficient:

• If you are launching an application store, you can monitor overall program progress and 
surface projects that are creating bottlenecks.

• For a new business application you can review and edit the investment roadmap for the next 
few weeks, months, or years.

• For a key strategic initiative, you can review what was accomplished in the previous year and 
plan for the next eighteen months.

Investment Portal is divided into the following sections:
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Banner icons

You can edit, copy, delete, bookmark, and share your investment board with other 
members and groups using the banner icons on the header of Investment Portal. 
See Track your key investments  for more information.

Investment widgets

You can view important metrics like total cost, actual cost, and budget with 
investment widgets that can be configured.

Key tabs

You can track important aspects of your projects and demands in one location using 
the following tabs.

• Overview: A high-level summary of your projects and demands. The information 
in the grid is based on the project and demand form fields.

• Timeline: Key milestones in a Gantt view. Gantt view provides an overview of 
projects using graphical elements such as lines and bars to show dependencies 
and lengths of tasks.

The Work Breakdown Structure (WBS) in the tab displays only milestones and key 
milestones.

• Financials: A detailed breakdown of project and demand costs in yearly, monthly, 
and quarterly formats, and based on cost plans associated to your projects and 
demands.

The tab is displayed only to the user who has the it_project_manager role.

Note: 

Investment Portal’s loading time directly depends on number of demands or projects and 
their related entities like cost plans and breakdowns, that match with the defined query. 
Typically, the board's performance is optimal with approximately 50 projects or demands, 
with each project containing 10 to 15 cost plans.

The application doesn't restrict the number of records being fetched. So, users are 
recommended to define the query in such a way that optimal number of records are fetched 
to ensure that the performance is not affected.

View all your investment boards in one location

Display all your important investment boards in a single location using the My Investment views 
page.

When you open the Investment Portal module, you start in the My Investments Views page where 
you can:

• Create investment boards using filter conditions.

• View widgets on an investment board.

• Search for an investment board by the name or owner.
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• View boards in different color bands based on the applied filter, such as portfolio or program. 
For example, the green color band on the card, in the following screen shot, indicates that the 
projects and demands are filtered by a portfolio.

• Drill down an investment board to review its projects and demands in terms of cost, schedule, 
and scope.

Tabs

Access investment boards more quickly by using tabs.

• Recent: Recently accessed investment boards.

• Bookmarked: Bookmarked investment boards.

• Created by me: Investment boards you own.

• Shared to me: Investment boards that are shared with you.

Investment board
Key details of an investment board include:

• Row 1: Name, owner, and type of the board.

• Row 2: Some out-of-box investment metrics. The number of metrics displayed in this row is 
fixed, but you can configure  which metrics are displayed,

Example of an investment board

Related topics

Investment Portal

Create an investment board

View the projects and demands that are important to you by creating a personalized investment 
board using filter criteria you define.

Before you begin
Role required: it_project_manager, it_project_user, or sn_ppm_finance_read

Procedure

1. Navigate to All  > Project  > Investment Portal.

2. On the My Investment Views page, select New.

3. In the Create new window, fill in the fields
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For more information, see Investment board form.

Note: 
Using Tags  as a filter criteria might not fetch all the required tabs to work on investments.

4. Select Create  to create the form.

Result
Once your investment board is created, it opens up in the Investment Portal page.

Note: 
By default, the investment board contains those widgets that have Include by default 
check box selected. You can add or remove widgets from your investment board by using 
Widget Configuration.

Related topics

Investment Portal

Track your key investments

Track and analyze the cost, schedule, and scope of your investments in one place using 
Investment Portal.

Before you begin
Role required: it_project_manager or it_project_user

Procedure

1. Navigate to All  > Project  > Investment Portal.

2. From the My Investment Views page, create an investment report  and navigate to Investment 
Portal.

3. Use the following banner icons.

4. Perform the following actions in the Overview, Timeline, and Financials  tabs.

Related topics

Investment Portal

Configure your investment metrics as widgets

Configure investment metrics based on your business requirements. These metrics appear as 
widgets on the Investment Portal page.

Before you begin
Role required: pps_admin

Procedure

1. Navigate to All  > Project Administration  > Investment Portal Widgets.

2. Select New.

3. On the form, fill in the fields.
For more information, see Portal board widget form.

4. Select Submit.
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Related topics

Investment Portal

Resource Management Workspace
The ServiceNow®  Resource Management Workspace  helps Resource Managers have a 
centralized view of all work across all resources.

Get started

Explore

Learn the key features and 
business value of Resource 

Management Workspace

Configure

Install the application, 
dependent 

applications or plugins

Use

Plan and allocate 
resources across 

planning items

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Resource Management Workspace

Learn about the features, functionalities, and business value that the Resource Management 
Workspace  provides.

This provides a centralized view of the resource allocation and requests. As a Resource manager, 
you get a dedicated workspace to view the team's allocation and breakdown of the work 
assigned to the resources.

Resource Management Workspace  provides a centralized view of the resource allocations and 
resource requests. This workspace eases resource management problems and is designed to 
cover a wider set of use cases.
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Features and benefits

Feature Benefit

Persistent card view Create focused view to view and work on 
resource allocations.

Resource allocation view Breakdown view of resource allocations at 
weekly or monthly level.

Allocate the unassigned work Filter the unassigned tasks to view and 
allocate the work.

Integration with Microsoft Teams Effortlessly collaborate with the task owner for 
additional insights.

Approve work for resources Move the assigned work status to Approved, 
Unapproved, or Pending to allocate the 
prioritized work.

Iconography Identify overallocated resources and reassign 
to maintain allocations within the resource 
bandwidth.

Heatmap modals Breakdown view of the assigned work and 
efforts.

Resource Management Workspace  overview

The Resource Management Workspace  provides a centralized view for managing resource 
allocations and work assignments.

Resource Management Workspace  main interface

The workspace is organized into the following areas:
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• Resource board: Create filtered views to focus on specific teams, roles, or skills. For more 
information, see Create a resource card.

• Resource allocation view (top tray): Displays assigned work for each resource with weekly or 
monthly allocation breakdown and availability indicators.

• Unassigned tasks (bottom tray): Shows pending resource requests that needs to be assigned. 
For more information, see Assign unassigned work.

Resource finder

Resource managers often spend significant time manually searching for the right person to staff 
an unassigned assignment. The AI Resource Finder removes this guesswork by using Now Assist 
skills to analyze your resource pool and recommend the best-fit candidates, ranked by a fit score 
and accompanied by a plain-language rationale explaining each recommendation.

Resource finder uses the Resource fit analysis skill, which considers multiple dimensions 
simultaneously: whether the resource's planning attributes (such as role and skills group) align 
with what the assignment demands, how much capacity the resource has during the assignment 
period, and how the resource's historical allocation patterns compare to the requested effort.

The output of this matching process is two-fold:

• Fit score - a percentage that represents how closely a resource matches the requirements 
of an assignment. The score blends attribute alignment, temporal availability, and workload 
balance into one number so you can compare candidates at a glance.

• Rationale - a short explanation of why the Resource fit analysis considers them a good fit. 
The rationale references specific factors like availability windows, complementary pairing 
opportunities, and attribute matches.

a expressed as a percentage, and a rationale that explains the reasoning in plain language. 
For example, a resource might receive a 30% fit score with a rationale noting that the person is 
available only in April and July, and suggesting they be paired with another resource to cover the 
May and June gap. The score gives you a quick ranking; the rationale gives you the context to act 
on it.

The Resource finder lets you compare each resource's available capacity against the requested 
effort for the assignment. Effort values respect the unit and cadence based on user preference 
such as hours, FTE, or person days on a weekly or monthly basis.

The availability heatmap uses color coding to make this comparison instant. A green cell means 
the resource has enough capacity to meet the requested effort for that period. A red cell means 
they fall short. For example, if the requested effort is 1 FTE per month and a candidate shows 1 
for April and 0 for May, April appears green and May appears red helping you to immediately see 
the gap without doing any mental math.

Advantages of using Resource finder

• Quickly staff an unassigned assignment: Resource managers use the Resource finder option 
from the unassigned assignment's three-dot menu. The AI insights presents a ranked shortlist 
which the resource manager can reviews the rationale, confirm availability, and assigns the 
best fit within a single modal flow.
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• Handle partial availability with resource pairing: Resource Finder surfaces the real-time 
availability through its rationale, which suggests pairing two resources to cover the complete 
period. For example, one resource covers April and July while another covers May and June.

• Balancing workloads: resource board indicator in the Resource finder highlights which 
candidates already belong to the manager's boards, making it easier to redistribute work within 
the existing team before pulling in resources from other groups.

Getting started

Follow these steps to begin using the workspace.

1. Configure the workspace  to enable the required features and permissions.

2. Create a resource card  to define your filtered view of resources.

3. View and assign unassigned work  to available resources.

4. Manage resource allocations  to adjust and approve assignments.

Configure Resource Management Workspace

Configure Resource Management Workspace.

Configuration workflow

1. Install the Resource Management Workspace  product from ServiceNow Store.

For more information, see Install Resource Management Workspace.

2. Define custom statuses for resource assignments.

For more information, see Define custom statuses for resource assignments

Guided setup for Resource Management Workspace

Guided Setup provides a sequence of tasks to help you with the required configuration on your 
ServiceNow instances. After installing Resource Management Workspace, navigate to All  > 
Resource  > Resource Management Guided Setup.

Install Resource Management Workspace

Install the Resource Management Workspace  application from the ServiceNow Store.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the Resource Management Workspace  application using the filter criteria and search bar.

You can search for the application by its name or ID (sn_rm_ws). If you cannot find an 
application, you may have to request it from ServiceNow  store .

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.
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If your application requires other applications, install them first if they are not already installed. 
Installing your application also automatically installs the dependent applications or plugins if 
they are not installed already.

5. If you want to install demo data, select Load demo data.
Demo data includes sample records that describe application features for common use cases. 
Load demo data when you first install the application on a development or test instance.

Note: 
If you don't install the demo data for a store application during installation, you cannot 
request it later.

6. Click Install.

Result
The Resource Management Workspace  application is installed in your instance.

Define custom statuses for resource assignments

Define and assign custom statuses for resource assignments to mark the assignments based on 
your organization requirements.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Filter the Label field and open the Resource Assignment 
[sn_plng_att_core_resource_assignment] table.

3. Select the Show List  Related Link.

4. Open any resource assignment from the list.

5. Right-click on the Resource status label and select Show Choice List.

6. Select a status field to open the record.

7. Enter the custom status label in the Label  field and enter the value in the Value  field.

Tip: 
Following the naming convention (capitals) displays a consistent format in the UI.
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8. Right-click on the header and select Insert and stay.

Important: 
Selecting Save  or Update  overwrites the selected resource status in Step 4.

Use resource assignments

The Resource Management Workspace  is presented as a new approach to assigning resources 
to outcomes. Resource Management Workspace  integrates with Project Workspace, Strategic 
Planning, and Portfolio Planning  enabling the portfolio stakeholders to create resource 
assignments for their work.

Advantages and benefits of Resource Management Workspace

• Assigning resources to outcomes: facilitates the process of allocating people to achieve 
specific outcomes for a task.

• Planning attributes: acts as a common currency between capacity planning, resource 
assignments, and financials.

• Diversified handling: manage the inevitable changes to support your organization and priority 
changes during your planning cycle.

• Granular allocation: split or move an assignment to effectively handle the granular changes for 
your work.

• Allocation spread: toggle between the monthly or weekly view of resource allocation which 
caters to various planning and reporting needs.

• Grouping of assignments: group the resource board view using primary attributes such as 
group, role, or skill to reassign any existing work to a different user.

• Enhanced insights: get a deeper, informative, and more insightful details into the allocation 
details using the heatmap view.

• Better integration: prevent errors and ensure better practices by locking down resource 
assignments with recorded actuals, preventing modifications or deletions to maintain historical 
work data.

• Clear alerts: notify a stakeholder or a resource user using the alert icons which indicate any 
over allocations or change in assignment status.

• Streamline communication: capture the required or additional information in the notes to 
establish a seamless communication between resource manager and resource requester.

Using Resource Management Workspace

Create custom resource board views of persistent portfolios to view the current resource 
allocation and resource requests for all of your resources and work.

Resource assignments from different planning workspaces are pulled into this dedicated view 
for Resource Managers to give you an overall work view. Resource Managers can access the 
dashboard to view the assignment details at high level and create resource cards  to build 
persistent portfolios and view the resource allocations.

Quickly create multiple portfolios using resource cards and navigate between these cards to 
work on the resource requests. Use the advanced condition builder to customize these portfolios 
based on the teams, attributes, groups, and so on, to view the resource allocation.

Tip: 
Save the filter query and the conditions that you build to revisit and work on the resource 
allocations.
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Overview dashboard

Resource Management Workspace  overview dashboard provides a high-level interactive 
resource assignment details that help Resource managers to focus on where to prioritize 
the efforts, identify conflicts, and review the upcoming or pending assignments. Using this 
dashboard, Resource managers can view the data around their resources and work for efficient 
resource forecast planning.

The Overview dashboard is crafted to reduce the effort of navigate between different resource 
boards to view the unassigned work, pend activities, and prioritize day-today tasks.

Note: 
When you navigate to Resource Management Workspace, the Overview dashboard is the 
landing page. You can navigate to resource cards using the side navigation menu.

You can edit the dashboard based on:

• Primary attributes and date range selection.

• Add and edit widgets to the dashboard.
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The interactive dashboard creates a resource board for any selected data helping you to 
directly access the customized board view from the dashboard. For example, if you select the 
Unassigned tasks widget, this creates and navigates you to a resource board view with the list of 
unassigned tasks from the widget.

On the board view, you can get the drill down view of all the assigned assignments to the users. 
The timeline range in the board view matches with the date range of the dashboard.

By accessing these custom boards, Resource managers can assign and approve the 
assignments in reduced turn-around time, and enhancing productivity.
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Dashboard widget details

Widget title Description

Resources over allocated Number of over-allocated users.

Resources under utilized Number of users with available bandwidth.

Unassigned assignment requests Number of unassigned tasks.

Pending resource requests Total number of requests in Pending state.

Upcoming pending assignments Number of assignments starting by next 
month.

There are two views for this widget. A pie chart 
and a list view.

Selecting Pie chart navigates you to the 
resource board view.

Selecting the table values.

• Start date - opens resource assignment 
record view.

• Resource - opens to resource details page.

• Task - opens project task details in record 
view.

• Top task - opens the top task details in 
record view.

Select View all  to see the simple list view of 
assignments.

Assignments ending soon Number of assignments ending from current 
date to next month.

Ready for review Number of assignments that are in ready for 
review state.

Overdue assignments Number of assignments with past end dates.

Unapproved assignments Number of unapproved assignments.

Utilization percentage Average of the utilization % of the users based 
on the selected primary attributes.
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Dashboard widget details  (continued)

Widget title Description

Example: You can select a primary group 
to view the average utilization % of the 
entire group. This helps Project Managers to 
better plan the resource requests. Resource 
Managers can use this data while approving 
the assignments.

Assignments status Breakdown view of the resource assignments 
based on the status.

Total efforts Bar chart displaying the monthly breakdown 
view of allocated hours vs capacity. Select the 
chart to get the drill down view of the resource 
allocations in the resource board.

Total resource work by type Displays the allocated hours based on the task 
type.

Example: Operation work, Project Task, and so 
on.

Role allocation Bar chart displaying monthly breakdown view 
of the total number of allocated hours based 
on the user roles. Select the chart to get the 
drill down view of the resource allocations in 
the resource board.

Resource board

Using this intuitive workspace, Resource Managers can:

• View the number of tasks assigned to a resource.

• Understand the type or state of the assignment, and track the changes made to assignments.

Indicator Description

Indicates that the resource allocation is 
within the available bandwidth.

Indicates that the resource is over allocated 
for the available bandwidth.

Indicates the work assignment is made for a 
group.

Indicates changes to start or end date, 
allocated hours, and so on, to the approved 
resource assignments.
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Indicator Description

Note: 
When these changes are made, the 
status of the assignment is moved to 
pending, indicating resource manager 
about the review required for the 
changes made. Once the changes are 
reviewed and the assignment is either 
approved or unapproved, this icon is no 
longer displayed.

• Understand of the status of the assigned tasks rolled up to resource level using the Resource 
status column.

• View the primary attributes such as Group, Role, and Skill of each resource in the top tray. 
These come in handy while working on reassigning a task to different user with the same 
primary attributes.

• View the priority and state of the project, demand, or epic in the Priority and State columns in 
the resource board and allocate resources to priority or high-risk planning items.

• View the actual hours vs allocated hours for a task.

Enable the Show actuals  toggle ( ) from the settings side panel ( ) to view 
the efforts captured for a task via time cards. Approved time cards are reflected in the resource 
board view as actual hours.

• Get insights about the resource allocations using the new heatmap modal.

• View or hide requested work in the lower tray using Unassigned tasks  toggle.

• Filter unassigned work to view the custom requests.

• Edit the task effort for any group allocations and approve it in the top-tray using the inline 
editing feature.

Note: 
If you edit the allocations for any approved group assignment, a confirmation window 
appears. Once approved, the state is changed to Pending.

• Assign the unassigned  tasks.

• Approve or unapprove  the assigned tasks.

• Split a resource assignment  into two for one resource at the required date.
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Once you access these resource cards, you get a similar view as the following example with 
extensive 

insights.

Tip: 
You can filter out or add required columns in the top and bottom tray of the resource board 

view using Column config  ( ) settings.

Personalize your resource board view

You can customize the resource board to personalize your view. These user preferences are 
saved to give you the same view every time.

• View or hide unassigned tasks

Use the Unassigned tasks  ( ) toggle to view or hide the unassigned 
tasks in the bottom tray.

The Unassigned tasks view, in the bottom tray, facilitates you to build a custom filter condition 
to view unassigned requests with details such as duration, breakdown view of requested 
efforts, requested work item and its parent item, owner or requester of the task. Use the filter 
condition builder to get a custom or focused view of the unassigned tasks.

• Change effort type

Switch between Hours, FTE, or Person Days  effort types to view resource allocations based on 
the required effort type.
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• Group By

Customize the view of your resource boards using the Group By  feature to regroup the 
resources depending on your organization needs. You can group by Primary Group, Primary 
Role, Primary Skill, Owner, or Project.

• View or hide columns

Use the column config option ( ) to view or hide any columns on the top tray or bottom tray of 
the resource board.

Data grid filtering

Quick filters help you filter and build a personalized view to narrow down datasets instantly 
without refreshing the page or running complex queries on your resource board. You can filter 
lists, reference fields, strings, dates, and boolean values.

Resource allocations and heatmap view

The resource allocation view in the top tray provides you with a nested view of the assigned work 
items rolling up to resource level and the resource allocation breakdown view based on the time-
frame (weekly or monthly) and by work efforts (hours, FTE, or person days).

Select the arrow ( ) icon to get details at the individual task level (epics, demands, and so on) 
assigned to the resources. This helps you to get a breakdown view to understand:

• Work assigned to a specific resource.

• The amount of time a resource is allocated to an individual task.

Tip: 
Switch between different efforts such as hours, FTE, or person days to view a resource 
allocation heatmap based on the selected effort type.

You can edit the resource assignments using the inline editing feature in the top-tray.

The Resource status  column helps you to easily identify any Pending ( ) or Unapproved ( ) 
work items assigned to a resource.

Note: 
The status of the assigned work is rolled up to the resource level and the resource card 
level. If there are any pending or unassigned work items in the top tray, the rolled up status 
at resource level and card level shows Pending.

Define custom statuses to calculate and view resource capacity in the allocation heatmap modal.

Allocation heatmap modal gives you an overview of the resource utilization to identify the over 
allocated and the available resources. The allocations are color-coded to display the availability 
of the resources and help you to identify the availability of the resource for the filtered time frame.

The new heatmap modal gives you the following insights for a resource such as the assigned 
tasks with their respective project owner, resource status, efforts for each task, total utilization 
percentage for the approved tasks, and the remaining capacity.
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Allocation heatmap breakdown

From the preceding example, you can see the breakdown of the approved work items along with 
the rolled up efforts, Utilization percentage, and the Remaining capacity for the month of January 
2025. The approved work is within the resource capacity as the remaining capacity is 120 hours. 
A Resource manager can use these insights to decide and allocate the pending work items to 
another resource with available effort.

Important: 
Resource efforts calculations are driven by the 
com.snc.resource_management.exclude_status_from_capacity 
property. Admin can configure this property to calculate efforts for certain defined resource 
assignments only. For more information, see Resource Management properties.

Using the com.snc.resource_management.exclude_status_from_capacity 
property, Resources managers can customize to view the resource assignments with a specific 
state in their workspace and what to view in the total allocation modal. For example, you can view 
resource assignments in either Approved, Unapproved, and Pending resource assignments, or 
the ones in Approved and Pending states only.

Once the property is set up, work items in a specific states to show up in the full capacity and full 
allocation rollup of a resource. The new allocation modal displays the allocation breakdown and 
the rollup values of the work items for the configured states.

When you group a resource board using the Group by option, the heatmap allocation modal for a 
group gives the following insights.
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For example, when you group a resource board by Primary Group to view the allocation heatmap 
modal of a group for January 2025, the following modal is displayed. This modal gives insights 
into the total overall allocation of different types of Resource statuses.

Note: 
The efforts in the allocation modal are displayed in Hours.

Group resources on resource board

The resource board provides a comprehensive list of resources, which are fetched depending on 
various resource attribute types, projects, and work items. You can group these resources to gain 
an accurate perspective on specific attributes, owner, or the parent items associated with the 
projects. You can group the resources by Primary Group, Primary Role, Primary Skill, Owner  of 
the task, or Parent Item  of the work.

If you group the resource board by Primary Group, you see the list of primary groups that the 
resources are associated with and a drop-down of the list of resources in that group and the work 
item they're working on. In this view, you also get the rolled up values of the efforts at resource 
level and group level. The rolled up values can be viewed at a monthly or weekly breakdown.

Resource Managers can use this information to plan the resources and manage assignments.

Tip: 
Grouping the resources based on the primary attributes helps Resource Managers to 
easily reassign the work as the primary attributes should match to reassign work. For more 
information on how to reassign a work, see Reassign or unassign work using Resource 
Management Workspace.
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Create a resource card

Create a custom resource card to view resources and unassigned tasks, and work on resource 
mapping for your persistent and focused portfolios.

Before you begin
Role required: resource_user, resource_manager, it_project_manager

Procedure

1. Navigate to Workspaces  > Resource Management Workspace.

2. Select the Resource cards icon ( ) from the menu.

3. Select the New Resource Card  button ( ).

4. Enter the following details.
By default, the date range is set to six months from today's date. Maximum date range is 3 
years from the selected start date.

5. Select Next.

6. Create filter condition to view a custom set of resources.
The default condition is set to show all active users.

Tip: 
Save a filter condition using the Save filter  option ( ) and name the filter to easily 
identify it later. Next time you create a resource card, you can select one of your saved 
filters from the Use existing filter  list and customize it further.

7. Select Confirm.
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Note: 

You can edit the card details and filter condition using the edit icon ( ) on the resource 
board.

Result
A resource board view with the list of resources matching the filter condition with their work 
allocations, projects they're working on, and the assignment status is displayed.

What to do next
Enable the Unassigned tasks  toggle and build a filter condition to view unassigned tasks in the 
Unassigned tasks bottom tray.

For more information on how to filter and view unassigned work, and handle resource 
assignments, see Assign and approve unassigned work using Resource Management 
Workspace.

Create resource assignments and operation resource assignments in Resource Management 
Workspace

Create and assign resource assignments and operation resource assignments from Resource 
Management Workspace.

Before you begin
Role required: resource_user, resource_manager, It_project_manager
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Procedure

1. Navigate to Workspaces  > Resource Management Workspace.

2. Select the Resource cards icon ( ) from the menu and open a resource card.

3. Create resource assignments using one of the following options.

4. Select Submit.

Result
Resource assignment is created. You can filter and view this assignment in the lower tray of 
Unassigned tasks.

If an assignment is made for a resource from the resource board and if it's within the selected 
date range, the assignment shows up nested under the selected resource in real-time.

View unassigned tasks using Resource Management Workspace

Filter unassigned tasks to view custom requests to match with your organization's priorities and 
planning, and assign them to resources.

Before you begin

• Create resource assignments, or migrate your existing resource plans from Classic to 
Next Experience. For more information, see Create resource assignments using Resource 
Management Workspace, Create resource assignments using Project Workspace, or Migrate 
resource plans to resource assignments.

• Role required: resource_user, resource_manager

Procedure

1. Navigate to Workspaces  > Resource Management Workspace

2. Select the Resource cards icon ( ) from the menu and open a resource card.

3. Enable the Unassigned tasks toggle ( ) to view the unassigned work 
requests in the lower tray.
Project Managers create resource requests based on the primary attributes (Group, Skill, or 
Role).

4. In the bottom tray, select Filter  ( ) to filter the unassigned work and get a custom view of 
what you want to see.

You can use the attributes such as resource groups, teams, roles, skills, projects, time frame, 
and so on, to work with advanced filters.

Tip: 
Use the condition builder to build a filter and work on priority requests.

Example: This is a condition to filter the unassigned work requests created for a specific user.
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5. Select Filter.
The unassigned work matching the filter condition is displayed in the Unassigned tasks tray.

Assign unassigned work using Resource finder

Assign resource using the AI suggestions which match the skill-set and primary attributes 
requirements.

Before you begin
Role required: resource_user, resource_manager

About this task
The AI resource finder uses generative AI to calculate AI rationale for available resources. 
Review the fit scores and availability before assigning a resource. Selecting a resource opens 
the existing assign resources modal where you can review allocations and distributions before 
confirming the assignment.

AI resource finder helps resource and project managers identify the best-fit resources for 
unassigned resource assignments in a project. The fit score indicates how well a resource 
matches a task based on the availability, past experience, similar kind of work and working on 
same projects. Resource managers review the AI-generated fit scores and rationale and decide 
which resource to assign to an unassigned assignment. The resource finder modal displays the 
following information for each resource:
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• Fit score: Percentage match of a resource for the task. The Fit score is deterministic and is not 
generated using AI.

• Rationale: AI-generated explanation for the fit score.

• Availability: The availability of the resource for a task.

For more information regarding how the Resource finder works and the resources are mapped, 
see Resource finder.

Procedure

1. Navigate to Workspaces  > Resource Management Workspace.

2. Select the Resource cards icon ( ) from the menu and open a resource card.
Alternatively, you can view unassigned tasks using the Unassigned assignment requests 
widget from the overview dashboard.

3. From unassigned tasks pane, select the context menu row ( ) for any task and select 
Resource finder.

4. From Resource finder modal, select Show monthly availability  toggle or weekly.

5. Select the resource assignee and select Assign resources.

6. From Assign resources modal, review the allocations and distributions and select Assign.

The resource is assigned to the task.
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Assign and approve unassigned work using Resource Management Workspace

Filter the unassigned work to view priority requests and assign them to resources. Quickly 
connect with the requester via Microsoft Teams  to get additional insights and approve the 
assigned work using the inline editing feature.

About this task
The assign logic provides you with the flexibility and control for users when assigning work to 
resources. It addresses the following goals:

• Efficiency: Quickly allocate unassigned tasks to available resources.

• Personalization: Enables users to configure how effort is distributed—either automatically or 
manually.

• Transparency: Get a preview of the real-time breakdown of effort allocation before assigning 
the work to resources.

• Flexibility: Manual distribution supports custom selection of resources, which helps Resource 
managers manage work allocations based on the availability and remaining capacity of the 
resources.

• Fairness: Distributes work equally among the resources maintaining a balanced work.

Before you begin

• Create an active employee definition  for resources to view their allocation details on the 
Resource Management Workspace.

• Create a resource card.

• Role required: resource_user, resource_manager

Procedure

1. Navigate to Workspaces  > Resource Management Workspace

2. Select the Resource cards icon ( ) from the menu and open a resource card.
Alternatively, you can view unassigned tasks using the Unassigned assignment requests 
widget from the overview dashboard.

3. In the Unassigned tasks tray, select the Row context menu for any task ( ) and select Assign 
Work.

4. You can assign work using one of the following ways.

Note: 
Remaining efforts after equally distributing the work among the users is retained in the 
Unassigned tasks tray. Resource managers can again allocate these efforts.

5. Select the Preview  button to see the real-time allocations before assigning the work.

6. Select the Assign  button to assign work to the resources.
The assigned work is reflected in the top tray nested by resource view and will be in Pending 
state ( ).

7. Expand a resource row using the chevron icon ( ) to view assigned tasks.

8. Double-click in the Resource status column and select Approve  to confirm the assigned work 
so the resource can start working.

While assigning the work, you can easily identify if a resource is available ( ) or overutilized 

( ), even for the future periods, using the iconography.
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9. You can change the status of any assigned assignments using one of the following options.

10. Optional:  You can select the owner's name to collaborate with them over Microsoft Teams  to 
get additional insights regarding the work.

Result
The assigned work items are Approved ( ) or Unapproved ( ) and the status of the work 
assignments is rolled up to the resource level.

What to do next
If no tasks appear in the Unassigned tasks tray, verify the following:

1. Verify the resource requests exist. Project Managers must create resource requests (resource 
assignments with status Requested) on project tasks. Navigate to the project and verify 
resource requests exist on the Resource Assignments related list.

2. Check if primary attributes match. The resource card filter must match the primary attributes 
(Group, Skill, or Role) defined in the resource requests. Open your resource card and verify the 
filter criteria aligns with existing requests.

3. Check if the employee profiles are generated. Ensure employee profile definitions  have been 
generated for the resources in your view.

4. Request state is correct. Only resource requests in Requested  state appear as unassigned. 
Requests that are already Assigned, Approved, or Cancelled don't show.

5. Check the date range. Verify the resource card's date range overlaps with the resource request 
dates. Requests outside the visible time frame will not display.

6. Confirm the permissions. Confirm you have the resource_manager role, which is required to 
view and manage unassigned work.

Move a resource assignment

Move a resource assignment to a different start and end dates depending on the availability of 
the resource.

Before you begin
Role required: resource_user, resource_manager

About this task

• The resource assignment dates honor the task dates. The start and end dates of the resource 
assignments should be within the task start and end dates.

• When a resource assignment is moved beyond the task dates, the allocations outside the 
dates are cleared.

• You cannot move a resource assignment if actual efforts are captured for the work.

Use the Show actuals  toggle ( ) from the settings ( ) side panel to view the 
efforts captured for an assignment via time cards.

Procedure

1. Navigate to Workspaces  > Resource Management Workspace.

2. Select the Resource cards icon ( ) from the menu and open a resource card.
Alternatively, you can access a resource board by accessing a widget from the overview 
dashboard.
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3. Select the chevron icon ( ) for drill down view of the tasks assigned to resources.

4. In the top tray, select the row context menu ( ) for the required task and select Move.

5. In the move assignment modal, you can either enter or select the new start date using the date 
picker modal from the New start date  field.

6. Optional:  Change the assignment status using the New status  list.

7. Select Confirm.

Example: Moving a resource assignment
Let's consider a resource assignment for Website Overhaul task is assigned to Grace Lee. The 
task duration is from August 01, 2025 to August 31, 2025. The assignment duration is from August 
01, 2025 to August 20, 2025. Now, when you move the assignment start date to August 15, 2025; 
the new assignment dates will honor the task dates and will auto-assign the work from August 
15, 2025 to August 31, 2025. The remaining efforts of the resource are cleared and the cleared 
capacity is shown as available.

Reassign or unassign work using Resource Management Workspace

Reassign or unassign any assigned work from the Resource Management Workspace. You can 
group the resource board by primary attributes to identify the resources with same primary 
attributes.

Before you begin

• When you reassign work, the primary attributes of both the resource should match. For more 
information about mapping primary attributes to resources, see Map primary attributes to 
resources.

• You can reassign a work item for the period for which actual hours are not captured.

• You cannot reassign a work item if it has associated actual hours captured for the entire 
duration.

• You cannot unassign a work item if it has any associated actual hours captured.

• You cannot unassign an assignment if it has any associated actual hours captured.

• You cannot reassign or unassign group resource assignments.

Role required: resource_user, resource_manager

Procedure

1. Navigate to Workspaces  > Resource Management Workspace

2. Select the Resource cards icon ( ) from the menu and open a resource card.

3. Select the chevron icon ( ) to expand the resource view in the top tray.

4. To reassign any assigned work:

a. Select the row context menu ( ) for the required work item.

b. Select Reassign work.

Tip: 
Group the resource board  by the primary attributes to drag and drop the resource 
assignments to another resource to completely reassign work.
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c. On the Reassign work window, enter the name of the resource in the User  field to whom you 
want to reassign the work and duration using the Start month  and End month  date picker.

5. Select Update.

Note: 
Use the reassign feature to assign a partial or fraction of a task among resources without 
overlapping the assignment dates.

The selected work item will be reassigned to the selected resource.

6. To unassign any assigned work:

a. Select the row context menu ( ) for the required work item.

b. Select Unassign work.
The selected work item will be moved to Unassigned task tray.

Result
The reassigned tasks are assigned to the selected resource and unassigned tasks are moved to 
the Unassigned tasks tray.

Example: Reassigning work

Consider a development task spanning from January 1, 2024 to September 30, 2024 which is 
assigned to Tom, a developer who has the following primary attributes.

• Primary Group - Development

• Primary Skill - Java

• Primary Role - Java Developer 1

Tom has actual hours captured from January 1, 2024 through March 31, 2024 and will be 
unavailable for next 2 months.

As a resource manager, you can either reassign this task in it's entirety starting from April 1, 2024 
till September 30, 2024 to Raj, who has the same primary attributes. Or reassign the task from 
April 1, 2024 to May 31, 2024 to Raj, leaving the rest of the assignment to Tom.
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The actual hours captured by Tom are retained even though the task is reassigned. Raj can 
capture the actuals hours for the assigned period after completing the work.

What to do next
You can allocate the unassigned work and approve the reassigned work. For more information, 
see Assign and approve unassigned work using Resource Management Workspace.

Split resource assignments using Resource Management Workspace

Splitting a resource assignment at a specific date creates a resource assignment for the same 
user.

Before you begin

• When you split a resource assignment, a new assignment is created from the selected date. 
Both the assignments are assigned to the same user retaining the state of the assignment.

• When you split a resource assignment, a new assignment is created from the selected date. 
Both the assignments are assigned to the same user with Approved state.

• If a resource assignment has actuals captured for a certain duration, you can split the work 
only at the dates where there are no actuals captured.

• Role required: resource_user, resource_manager

About this task
When to use split or reassign for assignments.

Use Split when you need to divide a single resource's assignment into two time periods with 
different allocation levels, effort distributions, or tracking granularity. For example, split an 
assignment when a resource needs to reduce their allocation after a project milestone. Use 
Reassign (Reassign or unassign work using Resource Management Workspace) when you need 
to transfer work from one resource to another.

Procedure

1. Navigate to Workspaces  > Resource Management Workspace.

2. Select the Resource cards icon ( ) from the menu and open a resource card.

3. Select the chevron icon ( ) to expand the resource view in the top tray.

4. In the top tray, select the row context menu ( ) for the required work item and select Split.
Split modal appears providing you with the insights related to the task such as name of the 
task, name of the resource, start date, and end date.

5. On the Split modal, select a date to split the resource assignment using the date picker.

6. Select Split.

Result
The resource assignment is split at the selected date and a copy of the resource assignment with 
new dates are displayed under the assignments of the selected resource.

Example: Split resource assignment
Consider a resource assignment named Implement GenAI in docs  assigned to Abel 
Tuter from July 16 through December 02. If you split the resource assignment at September 09, 
there will be two resource assignments with the same name and state assigned to Abel Tuter.

One resource assignment ranges from July 16 to September 09, and the other assignment 
ranges from September 10 to December 02.
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Here, you can see an overlap of efforts for Implement GenAI in docs  in month of 
September because the split is happening from September 10.

Manage resource allocations in Resource Management Workspace

Manage resource allocations to change efforts, start and end dates, extend and so on to adjust 
resources based on their availability and the priority of the tasks.

Before you begin
Role required: resource_user

Date handling for allocation changes

When you extend or modify resource allocations, the system uses the following date logic:

• Projects: The allocation dates are bounded by the project task's planned start and end dates. If 
the task has actual dates, those take precedence over planned dates.

• Demands: The allocation dates are bounded by the demand's planned start and end dates. If 
no end date is set on the demand, the allocation can be extended indefinitely.

You cannot extend an allocation beyond the parent record's end date without first updating the 
project task or demand dates. If the allocation dates exceed the parent boundaries, the system 
may truncate the allocations or display a warning.

Procedure

1. Navigate to Workspaces  > Resource Management Workspace.

2. Select the Resource cards icon ( ) from the menu and open a resource card.

3. Select the chevron icon ( ) to expand the resource view in the top tray.

4. Edit the following allocation details in the resource board drill-down view.

Export resource portfolio view to Excel or CSV format

Export your resource portfolio view in Resource Management Workspace  as Microsoft  Excel 
or CSV format to review or share the resource status with stakeholders, even if they don't have 
access to your instance.

Before you begin
Role required: resource_user, resource_manager, it_project_manager

Procedure

1. Navigate to Workspaces  > Resource Management Workspace.

2. Select the Resource cards icon ( ) from the menu and open a resource card.

3. Select the More Actions menu ( ) and select Export.

4. In the Export resource board window, select a required format from the File type  list to export 
the resource portfolio.
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◦ Excel  - Exports the resource portfolio in Microsoft  Excel format.

◦ CSV  - Exports the resource portfolio in CSV format.

5. Select the Export  ( ) button.

Result
The resource portfolio view is exported with export_file  as the file name in the selected 
format.

Manage resource assignments from Project Workspace

Optimize project execution by assigning resources to tasks within the Project Workspace. You 
can create resource assignments for any project or project task, specifying the tasks to be 
performed and the resources to be allocated.  Use the Resource Management  application to 
allocate and manage your resources in the Project Workspace.

Resource assignments

Resource assignment is a process of allocating a resource or group of resources to a project 
task. When a resource assignment is initiated, a resource plan is auto-generated in the back-end 
of the project management system. This resource plan details the information of how resources 
would be allocated throughout the project. Resource assignments are approved by the resource 
manager to make sure that the allocation aligns with the overall resource strategy, considering 
factors such as availability, skills, and project priorities. Resource assignments remain dynamic 
and can be edited throughout the project life cycle. Resources can be assigned based on 
defined attributes such as skills, expertise, or other criteria relevant to the project or task.

Note: 

Resource efforts calculations are driven by the 
com.snc.resource_management.exclude_status_from_capacity 
property. Admin can configure this property to calculate efforts for certain defined resource 
assignments only. For more information, see Resource Management properties.

Edit the child resource assignments directly using the inline editing from the resource 
assignment pane.

Using Resource Management, you can create, plan, track, and monitor resource assignments 
at a project or task level in the Project Workspace. With Resource Management  in Project 
Workspace, you can:

• Create an attribute-based resource assignment.

• Change the resource assignment dates, resources, efforts, and proposed allocations at any 
level of the project.

• View resource allocations using new heatmap modal. The allocations are color-coded to 
display the availability of the resources.

• View the primary attributes such as Group, Role, and Skill of each resource in the resource 
assignment pane. They are useful when you work on reassigning a task to a different user with 
the same primary attributes.

• Switch between Hours, FTE, or Person Days  effort types to view resource allocations.
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Important: 
Resource efforts calculations are driven by the 
com.snc.resource_management.exclude_status_from_capacity 
property. Admin can configure this property to calculate efforts for certain defined resource 
assignments only. For more information, see Resource Management properties.

Key features

With resource assignments, you can:

• Determine the resource engagement timing and allocate resources for specified durations, 
contributing to the creation of a timeline for task completion.

• Align task execution with the project plan, ensuring tasks are carried out in accordance with 
specified timelines and resource requirements.

• Initiate an approval process that is conducted by a resource manager and make sure it aligns 
with project targets and resource availability.

Key benefits

Using Resource Management, you can create, plan, track, and monitor resource assignments 
at a project or task level in the Project Workspace. With Resource Management  in Project 
Workspace, you can:

• Create an attribute-based resource assignment.

• Change the resource assignment dates, resources, efforts, and proposed allocations at any 
level of the project.

• View resource allocations using new heatmap modal. The allocations are color-coded to 
display the availability of the resources.

• View the primary attributes such as Group, Role, and Skill of each resource in the resource 
assignment pane. They are useful when you work on reassigning a task to a different user with 
the same primary attributes.

• Switch between Hours, FTE, or Person Days  effort types to view resource allocations.

Create resource assignments using Project Workspace

Create an attribute-based resource assignment in the Project Workspace  application for any 
project or project task.

Before you begin
After a resource assignment is created, resources are allocated to the project and approved by 
the Resource Manager. You can edit the assignment throughout the project life cycle.

Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments  toggle button.

Note: 
If the sn_pw.enable_resource_planning  property is set to true, then the 
Resource assignment  toggle button and resource assignment pane are displayed in 
Project Workspace. The default value is false. You must have the pps_admin role to 
enable this property.
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3. From the Planning pane, double-click the Resource assignees  field for a project task.

You can assign the resources from both planning and resource assignment pane.

4. From the resource assignee list, select a user or group and press Enter.
When you create a resource assignment, the user or group allocation is based on the selected 
effort type. For example, when you add a user and the effort type is selected as hours, the 
allocations are displayed in hours.
A resource assignment record is created and auto-saved. The resource assignment form auto-
populates the project or task information.

5. Optional:  From the resource assignment pane, create a resource assignment for a project or 
task by selecting Add resource.
You can create a resource assignment for a project from the resource assignment pane only.

6. Select the expense type of the assignment based on the work as Opex  or Capex.
A resource can use this information while capturing efforts using the time sheet portal. Once 
the time sheet is approved, an expense line is created for the project capturing the expense as 
capex or opex, based on the selected expense type.

7. View the resource allocations in the heatmap by enabling the Allocation heatmap  toggle 
button.
You can switch from the week view to the month view based on your requirement.

What to do next
Update resource assignment from Project Workspace

Related topics

Delete a resource assignment from Project Workspace

Update the resource allocation in a heatmap

Realign resource assignment to project task

Update resource assignment from Project Workspace

Update a resource assignment that is associated with a project or project task.

Before you begin
Role required: it_project_manager

In resource assignments, any changes made to the status of group resource assignment roll 
down to all associated child resource assignments status. Similarly, any changes made to the 
status of child resource assignments automatically roll up to the corresponding group resource 
assignment status.

About this task
Before updating a resource assignment, verify the following to ensure accurate and effective 
resource allocation:

• Resource availability: Check that the resource has available capacity during the assignment 
period. Overallocated resources are indicated with a warning icon.

• Primary attributes: Verify the resource has the required primary attributes such as, skills or 
roles matching the project task requirements.

• Existing allocations: Review the resource's current assignments across all projects to avoid 
conflicts or overutilization.
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• Group vs. individual: If updating a group resource assignment, note that status changes roll 
down to all child (individual) resource assignments. Similarly, individual status changes roll up 
to the group assignment.

• Assignment status: Verify the assignment is in the correct state (Requested, Assigned, or 
Approved) before making changes.

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. View the resource assignment pane by enabling the Resource assignments  toggle button.

3. On the resource assignment pane, double-click any cell to edit the entire row.

4. Edit the desired field, and select anywhere on the data grid to save the details.

The resource assignment is updated in the resource assignment pane.

Note: 
When a resource is added on an empty resource assignment, which has more than one 
Full-time equivalent (FTE) effort, then an additional row is created automatically and the 
resource assignment is auto-updated in both the rows.

Extend, edit, or delete the resource assignments using the row context menu in resource 
assignment pane.

Delete a resource assignment using Project Workspace

Delete a resource assignment from Project Workspace. Deleting an assignment also deletes all 
associated resource allocations.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to Workspaces  > Project Workspace  and open a project.

2. Enable the Resource assignments  toggle to view the resource assignment pane.

3. From the resource assignment pane, create a resource assignment for a project or task by 
selecting Add resource.

Update resource assignments using Project Workspace

Use the allocation heatmap capability in Project Workspace  to view and update the resource 
allocation.

Before you begin
Role required: it_project_manager

About this task
The Allocation heatmap  toggle button provides a detailed breakdown of the allocation of an 
individual resource. The allocation heatmap represents the total utilization of a resource for a 
week or month. By default, allocation information is displayed for the week. This information 
helps project managers to plan their resources effectively at the project or task level.

Integrate your ServiceNow®  instance with your organization's Microsoft Teams  to enable 
collaboration of your projects and resource allocations in Microsoft Teams. With the Microsoft 
Teams  integration, you can communicate with the project team members and share real-time 
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updates on the project and resource allocation status. For more information, see Setting up PPM 
collaboration for Microsoft Teams.

Procedure

1. Create resource assignments using Project Workspace.

2. View the resource allocations in the heatmap by enabling the Allocation heatmap  toggle 
button.
You can switch from the week view to the month view based on your requirement.

3. Edit the desired field and select anywhere on the data grid to save the details.
Work allocation is based on capacity. The allocations are color-coded to display the availability 
of the resources as shown here. These colors help to identify the availability of the resource for 
a particular task.

4. Edit the resource allocation window by selecting the allocation hours cell.

Enable the Show actuals  toggle to view the actuals of each resource. The actuals can't be 
edited from Project Workspace.

5. From the resource allocation window, view and track the assigned Project, Owner,Task, and 
Task effort  of a resource.

The resource allocation is made according to the schedule of the resource, provided that the 
resource has a schedule.

The Allocation heatmap modal provides the Resource status, Remaining capacity, and 
Utilization  columns to support resource managers in evaluating task efforts.

6. Send a direct message to the project owner on Microsoft Teams  by selecting the Project 
Owner  field.
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Note: 
The Project Owner  field can only be selected if your ServiceNow®  instance is integrated 
with your organization's Microsoft Teams. Resource assignments on demands are visible 
in the allocation window both before and after they become projects.

Related topics

Create resource assignments using Project Workspace

Realign resource assignment to project task using Project Workspace

Realign or synchronize the resource assignment dates with the project task dates. This 
synchronization helps to schedule and align the resource assignments with the timeline of 
project task.

Before you begin
Role required: it_project_manager

Procedure

1. Navigate to All  > Workspaces  > Project Workspace  and open a project.

2. From the project planning pane, double-click the Planned start date  or Actual start date  of a 
project task.

3. Edit the field and select Ok.

4. From the project task row, select the row context menu and then select Realign assignments 
to task.

Alternatively, use the Resources not synced icon  to synchronize the resource assignments 
dates with the project dates at a project level. Realign assignments to task related link is 
available to perform the same action while using forms.

Result
The resource assignments dates are synchronized with the project task dates.

Related topics

Resource assignments in Project Workspace

Project Workspace reference
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Resource Management Workspace  references

Reference fields and form details for Resource Management Workspace.

New Resource Assignment form

Fill in the following fields to create a resource assignment using Resource Management 
Workspace.

New Resource Assignment form

Field Description

Assignment type Select an assignment type from the list.

• User - to create a resource assignment for a 
user.

• Group - to crate a resource assignment for a 
group.

Resource Name of the resource.

This field is disabled for Group assignment.

Group Name of the group to create resource 
assignment.

If a resource is selected, the primary group 
name is populated by default.

Role Primary role for the employee.

• If a resource is selected, the primary role is 
populated by default.

• This field is disabled for Group assignment.

Skill Primary skill of the resource.

• If a resource is selected, the primary role is 
populated by default.

• This field is disabled for Group assignment.

Effort type Select the effort type to request a resource.

• Hours - to request a resource or group by 
hourly basis.

• FTE - to request a resource or group by FTE.

By default, one FTE is 8 hours.

• Person days - to request a resource or group 
by Person days.

Effort Enter the required effort count.

Name Enter a custom name for resource assignment.
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New Resource Assignment form  (continued)

Field Description

Task Select the task from the list to associate the 
resource assignment.

Start date Select the start date of the assignment using 
the calendar palette.

End date Select the end date of the assignment using 
the calendar palette.

Resource status Select the state of the resource assignment.

• Pending

• Approved

• Unapproved

• Unassigned

Rate override Select this option to override the resource rate 
to match with your organization requirements.

Resource rate Select the required currency and enter the 
resource rate.

Ready for review Select an option from the list so that the 
resource manager can review the request for 
allocation.

• Yes - if the resource assignment request is 
finalized and ready for resource manager's 
review for allocation.

• No - if the resource assignment details are 
still being updated.

Notes Enter details about the assignment to help 
resource manager or project manager with 
insights and additional information.

New Operational Assignment form

Fill in the following fields to create a operational assignment using Resource Management 
Workspace.

New Operational Assignment form

Field Description

Resource Name of the resource.

Group Name of the group to create resource 
assignment.

If a resource is selected, the primary group 
name is populated by default.

Role Primary role for the employee.
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New Operational Assignment form  (continued)

Field Description

If a resource is selected, the primary role is 
populated by default.

Skill Primary skill of the resource.

If a resource is selected, the primary role is 
populated by default.

Effort type Select the effort type to request a resource.

• Hours - to request a resource on hourly 
basis.

• % Capacity - to request a certain percentage 
of capacity towards operational work.

Effort Enter the required effort count.

Name Enter a custom name for resource assignment.

Operational work type Select the kind of operational work from the 
list.

• KTLO

• Admin

• Meeting

• Training

• Out of office

• External labor

• Time off

• Appointment

• Phone call

Rate model Select existing rate model to calculate planned 
and actual resource costs.

Start date Select the start date of the assignment using 
the calendar palette.

End date Select the end date of the assignment using 
the calendar palette.

Resource status Select the state of the resource assignment.

• Pending

• Approved

• Unapproved

• Unassigned
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New Operational Assignment form  (continued)

Field Description

Ready for review Select an option from the list so that the 
resource manager can review the request for 
allocation.

• Yes - if the resource assignment request is 
finalized and ready for resource manager's 
review for allocation.

• No - if the resource assignment details are 
still being updated.

Notes Enter details about the assignment to help 
resource manager or project manager with 
insights and additional information.

Resource Management classic
The ServiceNow®  Resource Management  application enables resource requesters, such as 
project managers or change managers, to create resource plans, request resources, and analyze 
resource availability and utilization.

Important: 

Resource plans in Resource Management will no longer be available for new customers 
from future releases. Existing customers are encouraged to work on resource assignments 
which offers more flexibility in assigning and managing the work.

• New customers: Use Resource Management Workspace  or Project Workspace  to request 
resources for any work. Resource managers can use Resource Management Workspace 
to assign, approve, and manage the resource assignments.

• Existing customers:

◦ If you already have resource management and working with resource plans, you 
can continue using it, but we encourage you to migrate and start using resource 
assignments.

◦ For more information on migrating from resource plans to resource assignments, see 
migrate your resource plans and operational resource plans to resource assignments 
and starting using the Resource Management Workspace  to continue managing your 
work.

Resource Managers are encouraged to use the Resource Management Workspace  to 
assign, approve, and manage resource assignments. Resource Management Workspace 
is a dedicated workspace view for Resource Managers where you get insights about 
unassigned tasks, heatmap view of resource bandwidth, custom view to handle priority 
resource assignment requests, and so on.

Resource Management will not be enhanced for performance or functionality.

Resource managers use the application to allocate resources to tasks. The Resource 
Management  application can be used in conjunction with any task on the platform, including 
project tasks, incidents, problems, or changes.
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Watch this four-minute video to learn about the purpose of Resource Management  application, 
creating resource plans, requesting and allocating resources, and analyzing resource availability 
and capacity for maximum resource utilization.

Introduction to Resource Management  including the purpose, resource planning, resource 
request and allocation, and resource availability and capacity analysis for maximum resource 
utilization.

With the Resource Management  application:

• Resource requesters can create resource plans that specify group or user resources required 
by tasks. They can verify resource availability and change their resource plans prior to 
requesting resources.

• Resource managers can view availability, existing allocations, and utilization for the requested 
resources and make allocations based on resource availability.

• Resource managers can change resource plan dates, resources, requested hours and 
proposed allocations for resource utilization and availability.

The Resource Management  application is activated as part of the PPM Standard.

Resource management process

The resource plan is the key to understanding how resource management works.

Important: 
Resource plans in Resource Management  will no longer be available for new customers 
from future releases.

You're encouraged to work on resource assignments which offers more flexibility using 
Resource Management Workspace  or Project Workspace.

For more information about migrating from resource plans to resource assignments, see 
Migration of resource plans, operational resource plans, and cost plans.

Which approach applies to you?

Resource Plans vs. Resource Assignments

Criteria Resource Plans (classic) Resource Assignments (current)

When to use You're an existing customer who 
has not yet migrated to resource 
assignments.

You're a new customer, or an 
existing customer who has 
migrated or is migrating to 
resource assignments.

Workspace Classic Resource Management 
modules (Resource > Resource 
Plans)

Resource Management 
Workspace  or Project Workspace

Key features Group-based allocation, request/
confirm/allocate workflow

Direct resource assignment, 
auto/manual distribution, inline 
approval, heatmap views

Documentation Resource Plans topics in this 
section

Resource Management 
Workspace  documentation

For detailed migration guidance, see Migrate from resource plans to resource assignments.
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A user with the resource_user role can be a resource requester. Project managers are used as 
resource requesters in many examples because they typically have the resource_user role and 
work on the planning for a project's execution.

A resource requester creates a resource plan  to request user or group resources for tasks. Any 
type of task, such as a change request, a task in the Agile scrum process, or a project task can be 
added to a resource plan.

After a resource plan is submitted, a resource manager reviews the plan, confirms the resources, 
and finally allocates resources for the plan. Once the resource plans are approved, the resources 
begin work.

Resource plans

Resource plans are the key element in resource management.

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged to work on resource assignments which offers more flexibility Create 
resource assignments and operation resource assignments in Resource Management 
Workspace  using Resource Management Workspace  or Project Workspace.

Resource requesters, such as project managers, create resource plans  to ask for resources, track 
effort, and track costs. Resource managers modify and approve resource plans before the plans 
are used.

All resource plans for a task appear on the Resource Plan  related list of the Project task form, 
where resource requesters can access them.

Resource plans progress through several states.

Resource plan states

State Description

Planning
Planning is the default state when a resource requester creates a resource plan. 
Any plan in this state can be edited. Requested Allocations  are created when a 
resource plan is in Planning state.

When a resource requester asks for a change to a plan that was already 
submitted, the plan reverts to the Planning state.

Requested Resource requester submits a resource plan for resource managers review 
by selecting Submit. The resource plan then moves into the Requested state. 
Resource managers confirm and allocate resources or reject the plan, and finally 
close the plan.

The resource requester can request a group, specific users in a group, or a 
specific user to work on the selected task. After you submit the plan for review, a 
resource manager can confirm, and then allocate some or all the requested users.

If the task requires more than one user or groups, multiple resource plans can be 
created for the given task.
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Resource plan states  (continued)

State Description

Rejected Resource manager can reject a resource plan by selecting Reject. The resource 
plan then moves into the Rejected state. Rejected plans stay in that state until 
changes are made and the requester can re-request the resources.

Confirmed
After the plan is requested, the resource manager can block/confirm the 
resources for future projects and demands. The resource plan then moves into 
the Confirmed state. Only a resource manager can modify the plans in Confirmed 
state.

Soft allocations are created when the resource plan moves to the Confirmed state.

Allocated
After the plan is confirmed, the resource manager can review the plans, view 
availability, change resource preferences and perform the resource allocation. 
The resource plan moves into the Allocated state. A resource manager can only 
cancel, complete, or modify it.

Soft allocations are converted to hard allocations when the resource plan moves 
to the Allocated state.

Note: 
You can also set a plan to the Allocated state directly from the Requested 
state using Confirm and Allocate  option.

Completed After all associated tasks and projects are complete or canceled, an Allocated 
resource plan can be completed. This deletes all the resource allocations for the 
resource plan post the completion date.

Canceled A plan can be canceled if the allocations are no longer required. This removes all 
past and future allocations. A canceled resource plan can be brought back to the 
Planning state if it has no past allocations.

Resource plans in Planning, Requested, Confirmed, or Allocated state can be 
canceled.

Note: 
When a resource requester wants to change a plan that was already submitted for review 
(in Requested or Confirmed state but not yet allocated), the requester can request a 
change. The plan then moves back to the Planning state.

Resource Management  supports time zones, which are important in the My Calendar and 
Resource Workbench modules.

Modifications in Confirmed or Allocated state

Only a resource manager can modify a resource plan in the Confirmed or Allocated state.

The effects of modification in header area on a resource plan form in Confirmed state are:

• All soft allocations  are deleted.

• Requested allocations are re-created with changed values.

• Resource plan moves back to the Requested state.
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The effects of modification in header area on a resource plan form in Allocated state are:

• All resource allocations (soft and hard) are deleted.

• Requested allocations are re-created with changed values.

• Resource plan moves back to the Requested state.

The resource manager can also modify or delete the past dated resource allocations for 
Allocated resource plans if no actual hours are recorded for those resource allocation records. 
When a user submits a time card, upon approval of the time card, actual hours are updated for an 
allocation record.

Note: 
The resource plan does not move back to the Requested state if the changes are made to 
allocation records only.

Request type

You can request a resource plan using one of the following options:

• Hourly: The request is in terms of the number of hours the resources are necessary.

• FTE: The request is in terms of an equivalent value that represents full-time work. When the 
request type is FTE, planned hours are calculated as: Average Daily FTE * number 
of working days in resource plan * the FTE value. The average daily FTE 
hours are specified in User and Group records. If there is no value specified at User or Group 
record, the average daily FTE hours is taken from the Default Average Daily FTE 
property.

The number of working days is calculated based on the users schedule for a user resource 
or the default schedule for group resources. The default schedule is taken from the Default 
Schedule Name property.

For example, say that the average daily FTE for a group is 40 hours, the resource plan period is 
from September 1 to September 10, and the FTE is 0.5.

Assuming 8 working days during the plan period, planned hours = 40 * 8 * 0.5  =160 
hours.

Note: 
Capacity is not derived from FTE, but from schedules. Both FTE and schedules must be in 
synchronization with each other.

• Person days: The request is in terms of person days. When the request type is person days, 
planned hours are calculated as: Total number of person days * Average 
Daily FTE Hours/Hours Per Person Day.

For example, say the Average Daily FTE Hours/Hours Per Person Day for a group is 8 hours, 
and the person days is 3. Then, planned hours = 8 * 3  = 24 hours.

Resource plan costs

Resource plan costs can be tracked directly in the resource plan  record. Resource plan costs are 
divided into planned, allocated, and actual.

If the Rate override  option in a resource plan is selected, the hourly rate for calculating the 
corresponding resource plan cost is derived from the rate specified in the Resource rate  field.
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If a rate model  is associated to the project or demand, the hourly rate is derived from the rate 
model. Whenever the hourly rates in the associated rate model change, you must recalculate the 
resource costs  of the resource plan to reflect the new rates.

If rate model is not available, the hourly rate for calculating the corresponding resource plan cost 
is derived from labor rate card.

Projects and Demands can have multiple resource plans. The aggregated costs for all resources 
plans roll up to the Planned Cost  and Allocated Cost  fields and the Resource Cost  section of 
both projects and demands.

Create a resource plan

You can create a resource plan from the Resource Management  application for any task such 
as demand, project, project task, incident, problem, or change. You can edit and adjust the plan 
until you submit it for approval.

Before you begin

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged migrate your existing resource plans  to work on resource assignments 
which offers more flexibility Create resource assignments and operation resource 
assignments in Resource Management Workspace  using Resource Management 
Workspace  or Project Workspace.

Role required: resource_user, resource_manager, it_project_manager, demand_manager, admin

Procedure

1. Create a resource plan using one of the following options.

Option Description

From Resource tab in project workspace

a. Open a project record in project work­
space. See Access the new Project Work­
space.

b. On the Resources  tab, click New.

From a project form

a. Navigate to Project  > Projects  > Project 
Workspace.

b. Open a project record.

c. In the Resource Plan  related list, click New.

From a demand form

a. Navigate to Demand  > Demands  > All.

b. Open a demand.

c. In the Resource Plans  related list, click 
Manage.

d. On the Resource Plans page, click New.

From a project task
a. Navigate to Project  > Projects  > Project 

Workspace.

b. Open a project record.
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Option Description

c. Click the Details  tab.

d. In the Project Tasks  related list, open a 
task.

e. In the Resource Plan  related list, click New.

From an existing resource plan

a. Open the resource plan record that you 
want to copy.

b. In the related links, click Copy Resource 
Plan.

Note: 
When you create a resource plan from 
an existing resource plan, all fields are 
copied to the new resource plan. The 
new plan is created in the Planning 
state.

2. On the Resource Plan form, fill the fields.
For a field descriptions of the field names, see Resource Plan form.

3. Click Save  on the form header.
The resource plan is saved and placed in the Planning state.

4. Review update the values in the Resource Plan form tabs.
For a field description of the field names, see Resource Plan form tabs.

Note: 
If the assigned rate model is removed or replaced, or the hourly rates in the rate model 
are changed, the cost fields on the associated resource plans are not recalculated 
automatically. You must recalculate the resource costs  of the resource plan to reflect new 
rates from the rate model.

However, if any of the fields affecting the cost are updated on the resource plan, the rate 
model is invoked for getting the hourly rates. For example, extending a resource plan by 
modifying the end date of the resource plan invokes the rate model as there can be new 
rates available.

Result

• The resource plan is saved and placed in the Planning state.

• When the resource plan is created from resource grid, the plan appears as top row in the 
resource plan list of the project or demand. The plan has one of the following prefixes:

◦ [G] for a resource plan created for a group.

◦ [R] for a role resource plan created for a role.

◦ [U] for a user resource plan created for a user.

The prefix is based on the type of resource selected in the Resource type  field.

• The resource plan which is created last appears at the top in the resource plan list of the 
project or demand.
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What to do next
Use the Resource Plan related links and lists  to work on the resource plans, workbenches, or to 
modify the existing request allocations.

Use Resource Finder to analyze resource availability

Search and analyze resource availability using the Resource Finder, so that you can create 
resource plans for a project or demand.

Before you begin
Role required: it_project_manager, it_demand_manager, or resource_manager

About this task
In the Resource Finder, search for the resources that you need, and create a plan for the 
selected resources.

• Steps 1 and 2 take you to the resource finder.

• Step 3 provides guidance on different options to filter and analyze the resources availability. 
Choose the options that suit your needs.

• Step 4 shows how to create resource plan for the selected resources.

Procedure

1. Open the Resource Plans page for a project or demand.

2. Select the project or demand in the resource grid section and click the resource finder icon .

The resource finder section opens at the bottom of the page. A list of up to 50 records are 
displayed initially. If you have more than 50 resources, you can load them by clicking Get 
More.

3. Use the following options to filter and analyze the capacity of the resources.

Option Description

Display available or over allocated resources Using the Show/Hide menu to filter resources 
by available or over allocated.

Perform a simple search
Search the resources by group, role, or user 
attributes, by selecting the search criteria.

Build your own search criteria
Use the advanced search to add your filter 
conditions.

For example, select Search by group, click 
Advanced, then click the Advanced search 
filter icon . Here you can add conditions to 
filter this group further.

Note: 
While adding filters, ensure that you 
do not add an AND condition for 
different values of the same attribute. 
For example, do not filter the user group 
with conditions for Skill X  AND Skill Y.
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Option Description

View the availability of the resources for an 
extended duration Use the options from the date range selector.

From the Zurich  release onwards, you can 
select a custom date range.

The value of the property Maximum time 
duration in Resource Finder in 
months  determines the maximum duration 
for which the resource details are displayed 
in the resource finder.

Analyze the resources list
Use the Configuration menu to analyze 
different constraints such as the capacity, 
availability, actual hours, and others for 
different time periods.

By default, only the Availability hours are 
displayed. To view other details, select 
Detailed View , and select the required 
columns from the Configuration menu .

Displaying the requested hours for a 
user group or role helps you understand 
immediately if you need to fulfill any resource 
requests and to do so, if you have enough 
capacity for that user group or role.

The Requested  column would not be 
available in the Configuration menu under 
the following conditions.

◦ Filtering the resource list further using 
simple or advanced filters

◦ Using the resource finder in the availability 
view

◦ Using the show available or show over 
allocated options from the Show/Hide 
menu

Even if the column is already enabled, but 
any of the above conditions are later met, the 
Requested  column is disabled automatically.

All non-project events created for a user from 
the calender appear as Operational Work for 
the user in Resource Finder.

Update the capacity of a resource
Right-click on the user and select Update 
Capacity.

4. Select the resources you want to create resource plans for and select Add New Plan.
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Result

• The resource plan is created in the Planning state with zero planned hours.

• The resource plan appears as a row at the top in the resource plan list of the project or 
demand. Based on the type of resource selected in finder, the resource plan has one of the 
following prefixes:

◦ [G] for a resource plan created for a group.

◦ [R] for a role resource plan created for a role.

◦ [U] for a user resource plan created for a user.

Note: 
The resource plan that is created last appears at the top in the resource plan list of a 
project or demand.

What to do next

• Update the planned hours for the resource plan using the resource grid.

• To view and update more details for the resource plan, click the information icon in the 
beginning of the resource plan row.

• You can now request the resource plan.

Create an operational resource plan

Create an operational resource plan and allocate a certain portion of your team capacity for 
operational work, such as administration, meeting, or training.

Before you begin

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged migrate your existing resource plans  to work on resource assignments 
which offers more flexibility and Create resource assignments and operation resource 
assignments in Resource Management Workspace  using Resource Management 
Workspace  or Project Workspace.

Role required: resource_user, resource_manager, it_project_manager, demand_manager, admin

About this task
Create a resource plan for an operational work type such as Meeting, Training, Admin work, or 
Phone call.

For more information on operational resource plans, see Operational Resource Plan - All That 
You Need to Know .

Procedure

1. Navigate to All  > Resource  > Resource Plans  > Create New Operational Plan.

2. On the Resource form, fill in the fields.
For a description of the field names, see Resource form.

3. Select Save.

Related topics

Map a time card category with operational work types
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Request resources

After you create a resource plan, request resources from the resource manager.

Before you begin
Role required: it_project_manager, resource_user

About this task
Note: 
If the resource type in the resource plan is a group, you can request resources only if that 
group has active members.

Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open a resource plan that is in the Planning state.

3. Select Request.

Result
The resource plan moves to the Requested state and is ready for review by the resource 
manager.

Confirm a resource plan

As a resource manager, you can confirm or block the resources after a resource plan is 
requested. The resource plan must be in the Requested state to be confirmed.

Before you begin

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged migrate your existing resource plans  to work on resource assignments 
which offers more flexibility and Create resource assignments and operation resource 
assignments in Resource Management Workspace  using Resource Management 
Workspace  or Project Workspace.

Resource managers can view and assign the unassigned resource assignments  using 
Resource Management Workspace.

Role required: resource_manager

About this task
You can modify or cancel a resource plan  that is in the Confirmed state.

For a resource plan with the resource type as group, you can confirm resources only if the 
specified group has active members.

Procedure

1. Navigate to All  > Resource  > Resource Plans  > Requested.

2. Open the resource plan that you want to confirm and select Confirm.

Result
The resource plan moves to the Confirmed state and soft allocations  are created.
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Confirm and allocate a resource plan

After the resource plan is requested, as a resource manager, you can directly allocate the 
resources. To confirm and allocate, the resource plan must be in the Requested state.

Before you begin

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged migrate your existing resource plans  to work on resource assignments 
which offers more flexibility and Create resource assignments and operation resource 
assignments in Resource Management Workspace  using Resource Management 
Workspace  or Project Workspace.

Resource managers can assign and approve the unassigned resource assignments  using 
Resource Management Workspace.

Role required: resource_manager

About this task
Modify or cancel  a resource plan that is in the Allocated state.

If the resource type in a resource plan is a group, you can request resources only if that group 
has active members.

Procedure

1. Navigate to All  > Resource  > Resource Plans  > Requested.

2. Open the resource plan (Requested) that you want to confirm and allocate, and select Confirm 
and Allocate.

Result
The resource plan automatically moves to the Allocated state from the Requested state. Soft 
allocations are converted to hard allocations  when the resource plan moves to the Allocated 
state.

Any errors or warnings during allocations are logged in the Resource Plan Logs related list on the 
Resource Plan form. The log is generated if a resource is allocated over 24 hours for a given day. 
You can review these logs to take correct actions for further resource allocation.

Request a change to a resource plan

Request a change to the resource plan to modify a resource plan after you’ve submitted it for 
review.

Before you begin
Role required: resource_user

About this task
You can change the resource plans that are in the Requested or Confirmed state. To change 
the form fields of the plan, you first must request a change to the resource plan. However, you 
can adjust the requested allocations directly on the plan without requesting for a change. These 
adjustments are rolled-up to the resource plan.
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Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open a resource plan that is in the Requested or Confirmed and select Request Change.

Result
The resource plan moves back to the Planning state and has the form fields enabled to make the 
required changes.

Recalculate costs of a resource plan of a project or demand

Recalculate the resource costs of an individual resource plan for a project or demand whenever 
the hourly rates change in the associated rate model.

Before you begin
Ensure the following setup:

• The project or demand must have an active rate model assigned.

• The resource plan must be in either Planned, Requested, Confirmed, or Allocated states.

Role required: resource_manager

About this task
To update the costs of all the resource plans of a project or demand in one go, you can use the 
Recalculate Resource Costs  option from the project form  or demand form.

Procedure

1. To open a resource plan of a project or demand, perform one of the following actions.

◦ Navigate to Project  > Projects  > All, and open a project.

◦ Navigate to Demand  > Demands  > All, and open a demand.

2. From the Resource Plans  related list, open a resource plan for which you want to recalculate 
the costs.

3. On the Resource Plan form, select the Recalculate Resource Cost  related link.

4. In the Recalculate Resource Costs dialog box, specify the recalculation period in the Start 
date  and End date  fields.
By default, the Start date  field has the current date and the End date  field has the end date of 
the resource plan.

5. To recalculate the planned cost, select the Include planned costs  option.
The Include planned costs  option is available for a resource plan in the Confirmed or 
Allocated state. The option isn’t selected by default.

6. Select OK.

Result

• Recalculates the selected resource costs based on the latest hourly rates derived from the rate 
model associated with the project or demand.

• Updates the recalculated resource costs on the respective cost fields on the resource plan 
form and the Resource Plans  related list of the associated project or demand.

• Reflects the revised values on the respective cost fields of associated project or demand.
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Update cost plan related to a resource plan

If a resource plan is associated to a project, project task, or demand and has a related cost plan, 
then a requester or a resource manager can update the related cost plan after updating the 
resource plan.

Before you begin
Role required: resource_user or resource_manager or it_project_manager or 
it_demand_manager

About this task
If a resource plan does not have a related cost plan, the Update Cost Plan  related link is not 
displayed for the resource plan.

Procedure

1. Save the updates to the resource plan.

2. Click the Update Cost Plan  related link.

The cost plan associated to a resource plan is automatically updated as soon as the Planned 
cost  in the resource plan is updated. The planned cost on resource plan gets updated when 
there is a change in:

◦ Planned hours

◦ User

◦ State

◦ Start and end dates

Result
The cost plan associated to the resource plan is updated as follows:

• If the resource plan is in Planning or Requested state, planned hours is updated in the cost 
plan.

• If the resource plan is in Confirmed/Allocated state and the Confirmed/Allocated hours are 
less than planned hours, then the higher of the planned cost and Confirmed/Allocated cost is 
updated in the cost plan.

• If the resource plan is in Confirmed/Allocated state and the Confirmed/Allocated hours are 
equal to or more than planned hours, then the Confirmed/Allocated cost is updated in the cost 
plan.

Cost from resource plan will be interfaced to the unit_cost field on the Cost Plan [cost_plan] 
table.

Complete a resource plan

After all associated tasks and projects are complete or canceled, a resource manager can move 
the resource plan to the Complete  state, which closes it.

Before you begin
The resource plan to be completed must be in the Allocated state.

Role required: resource_manager

About this task
Project and demand managers can complete resource plans from a project, project task, 
planning console, or demand.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1655



Procedure

1. Navigate to All  > Resource  > Resource Plans  > Allocated.

2. Open the resource plan that you want to complete.

3. Verify all the information on the form.

Note: 
The Actual Hours  and Actual Cost  fields show the time spent on plan tasks and the 
resource costs. These fields are derived from time card information and can’t be edited 
on the resource plan.

4. Optional:  Add notes.

5. Select Complete.

6. In the Confirm  dialog box, select the completion date of the resource plan and select Yes.

By default, the system date or resource plan end date, whichever is earlier, is populated in 
Completion Date.

Note: 
The Completion Date  can’t be earlier than the resource plan start date.

Result

• The resource plan moves to the Completed state.

• If the completion date is earlier than the resource plan end date, the end date of the resource 
plan is updated with the completion date. If the completion date was entered later than the 
resource plan end date, the resource plan end date is retained.

• All the requested and resource allocations for the resource plan post the completion date are 
deleted. If there are any actual hours logged against an allocation, that allocation record isn’t 
deleted. But the allocated hours become zero and the actual hours are retained. The available 
and allocated hours for the resources are also updated in the aggregate tables.

Example:
Example 1: A resource plan of Allocation type Monthly  from 1 November to 31 January is 
completed on 15 December. On completion,

• the resource allocation entry for January is deleted from the [Resource_Allocation] table.

• the resource allocation end date for December is updated to the completion date of the 
resource plan.

• the entries in the [Resource_Allocation_Daily] table for the December month post the 
completion date are deleted.

Example 2: If the same resource plan has Allocation type as Planned Duration, no allocations are 
deleted, and the end date of the allocation is updated to the completion date.

Complete a resource plan from a project, planning console, or demand record

If a project or a project task is marked Closed, the project manager can complete the associated 
Allocated resource plans. Similarly, the demand manager can complete the resource plans for a 
Closed or Deferred demand.

Before you begin
The resource plan to be completed must be in the Allocated state.

Role required: it_project_manager or it_demand_manager
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About this task
When a project or a project task moves to Closed Complete, Closed Incomplete or Closed 
Skipped state, the system prompts a message on the project and project task forms, and in the 
planning console for completing the Allocated resource plans if the following conditions is met.

• Corresponding resource plan is in the Allocated state.

• Resource plan start date is less than or equal to the project or task actual end date.

A similar message for completing the resource plans appears on the Demand form when a 
demand moves to Closed or Deferred state.

Procedure

1. Open a project, task, or demand record in the Closed state.

Option Description

Open a Closed project record

a. Navigate to Project  > Projects  > Project 
Workspace.

b. Open the project record in the Closed 
state.

c. Select the Details  tab to display the project 
form.

Open a Closed project task record

a. Navigate to Project  > Projects  > Project 
Workspace.

b. Open the required project record.

c. In the Project Tasks  related list, open the 
project task record in the Closed state.

Open a Closed project in Planning Console

a. Navigate to Project  > Projects  > Project 
Workspace.

b. Open the project record in the Closed 
state.

c. Select the Planning  tab to display the 
project in planning console.

Open a Closed or Deferred demand record
a. Navigate to Demand  > Demands  > All.

b. Open the demand record in the Closed or 
Deferred state.

The message for completing the associated resource plans appears at the top of the record.

Message for completing a resource plan

Note: 
In the Planning Console, irrespective of the Closed state of the project tasks, the 
message appears only when the project is in Closed state.

2. To open the list of resource plans to be completed, select the link in the message.
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Note: 
In Planning Console, alternatively right-click the project and select Complete Resource 
Plans.

◦ The list contains only those resource plans for the record that should be completed.

◦ If the list is opened from the message link on a Project form, the resource plans for the 
project and project task are listed.

◦ If the list is opened from the message link on a Project task form, only the resource plans for 
the project task are listed.

3. In the list, select the resource plan to be completed, and select Complete.

4. In the Confirm  dialog box, select the completion date of the resource plan and select Yes.

By default, the system date or resource plan end date, whichever is earlier, is populated in 
Completion Date.

Note: 
The Completion Date  cannot be earlier than the resource plan start date.

Result

• The selected resource plan moves to the Completed state.

• If the completion date is earlier than the resource plan end date, the end date of the resource 
plan is updated with the completion date. If the completion date was entered later than the 
resource plan end date, the resource plan end date is retained.

• All the requested and resource allocations for the resource plan that are past the completion 
date are deleted. If there are any actual hours logged against an allocation, that allocation 
record is not deleted. But the allocated hours become zero and the actual hours are retained. 
The available and allocated hours for the resources are also updated in the aggregate tables.

Cancel a resource plan

If a resource plan is no longer needed, you can cancel it which also cancels its past and future 
allocations.

Before you begin
The resource plan to be canceled must be in the Planning, Requested, Confirmed, or Allocated 
state.

Role required: resource_user, resource_manager

About this task
Project and demand managers can also cancel resource plans from a project, project task, 
planning console, or demand.

Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open the resource plan record that you want to cancel.

3. On the form header, select Cancel.
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Result

• The resource plan moves into the Cancelled state.

• All past and future allocations for the resource plan are also canceled. If there are any actual 
hours logged against an allocation, that allocation isn’t deleted. But the allocated hours 
become zero and the actual hours are retained.

What to do next
If you want to make changes and use the plan again, edit a canceled plan. To move the resource 
plan back to Planning state, select Re-plan.

Note: 
The state of a resource plan can be changed back from Cancelled to Planning, only if it has 
no past allocations.

Cancel a resource plan from a project, planning console, or demand record

If a project or a project task is marked Closed, the project manager can cancel the associated 
future resource plans. Similarly, the demand manager can cancel the future resource plans for a 
Closed or Deferred demand.

Before you begin
The resource plan to be canceled must be in Confirmed, Planning, or Requested state. An 
Allocated resource plan can be canceled if the resource plan start date is later than the project, 
task, or demand end date.

Role required: it_project_manager or it_demand_manager

About this task
When a project or a project task moves to Closed Complete, Closed Incomplete or Closed 
Skipped state, the system prompts a message on the project and project task forms, and in the 
planning console for canceling the resource plans if one of the following conditions is met.

• Corresponding resource plan is in Confirmed, Planning, or Requested state.

• Resource plan is in Allocated state with start date later than the project or task end date.

A similar message for canceling the resource plans appears on the demand form when a 
demand moves to Closed or Deferred state.

Procedure

1. Open a project, task, or demand record in the Closed state.

Option Description

Open a Closed project record

a. Navigate to All  > Project  > Projects  > 
Project Workspace.

b. Open the project record in the Closed 
state.

c. Click the Details  tab to display the project 
form.
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Option Description

Open a Closed project task record

a. Navigate to All  > Project  > Projects  > 
Project Workspace.

b. Open the required project record.

c. In the Project Tasks  related list, open the 
project task record in the Closed state.

Open a Closed project in Planning Console

a. Navigate to All  > Project  > Projects  > 
Project Workspace.

b. Open the project record in the Closed 
state.

c. Click the Planning  tab to display the project 
in planning console.

Open a Closed or Deferred demand record
a. Navigate to All  > Demand  > Demands  > All.

b. Open the demand record in the Closed or 
Deferred state.

The message for canceling the associated resource plans appears at the top of the record.

Message for canceling a resource plan

Note: 
In the Planning Console, irrespective of the Closed state of the project tasks, the 
message appears only when the project is in Closed state.

2. To open the list of resource plans to be canceled, click the link in the message.

Note: 
In the Planning Console, alternatively right-click the project and select Cancel Resource 
Plans .

◦ The list contains only those resource plans for the record that can be canceled.

◦ If the list is opened from the message link on a Project form, the resource plans for the 
project and project task are listed.

◦ If the list is opened from the message link on a Project task form, only the resource plans for 
the project task are listed.

3. In the list, select the resource plan to be canceled, and click Cancel.

Result

• The selected resource plan moves to the Canceled state.

• All past and future allocations for the resource plan are canceled. If there are any actual hours 
logged against an allocation, that allocation is deleted. In this case, Allocated hours become 
zero and the actual hours are retained as is.

Delete a resource plan

Deleting a plan also deletes all associated resource allocations.
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Before you begin
Role required: resource_user or resource_manager

Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open a resource plan and select Delete  on the form header.
A confirmation message appears.

Delete confirmation message

3. Select Delete.
The resource plan and all the associated allocations are removed.

Extend a resource plan

You can extend the date of an allocated resource plan and allocate resources for the extended 
period.

Before you begin

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged migrate your existing resource plans  to work on resource assignments 
which offers more flexibility and start using Resource Management Workspace.

Resource requester can extend an assigned or unassigned resource assignment  using 
Resource Management Workspace.

Role required: resource_manager

About this task
Assume that work on a project has started, but there is a need to extend the date of an allocated 
resource plan because the project has been extended. In this scenario, you can extend the date 
of the allocated resource plan. The new date by which the resource plan is extended does not 
have any impact on the existing allocated hours. While extending the resource plan, you can 
specify the new end date and the request type. Based on the request type selected, the required 
allocated hours are auto-filled.

For example, assume that you allocated 100 hours for 2 months, 50 hours for each month. Now, 
you want to extend the resource plan by one month. For the extended month, allocation records 
are created based on the request type selected.
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Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open a resource plan and select Extend Resource Plan.

3. Select OK.

4. In the Extend resource plan dialog box, fill in the fields.
For a description of the field names, see Extend resource plan form.

Result

• The end date of the resource plan is updated.

• The Extension  field displays the state as Allocated.

• For the extended period, allocation records are created based on the request type selected.

• Number of requested FTE or hours or person days is divided equally for each allocation period 
and is pre-filled in each allocation record.

• Extending the resource plan invokes the rate model for getting the hourly rates.

Request extension of an allocated resource plan

As a project manager, you can request the extension of an allocated resource plan.

Before you begin

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged migrate your existing resource plans  to work on resource assignments 
which offers more flexibility and start using Resource Management Workspace.

Resource requester can extend a resource assignment  using Resource Management 
Workspace.

Role required: it_project_manager, resource_user

About this task
Assume that a project, which has resources allocated, gets delayed by one month. As a project 
manager, you can request for the extension of the resource plan if you need resources for the 
period. This option is available only when the resource plan is in the Allocated state.

Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open a resource plan and select Request Extension.

3. On the Request Extension from, fill the fields.
For a description of the field values, see Request Extension form.

Result
The end date of the resource plan is updated and the Extension  field is set to Requested.

What to do next
Allocate resources for the extended period.
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Allocate resources for the extended period

As a resource manager, you can allocate resources for the extended period.

Before you begin
Role required: resource_manager

About this task
After a project manager submits a request to extend the allocated resource plan, the resource 
manager receives a message at the top of the resource plan. The resource manager then reviews 
and allocates resources for the extended period.

Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open the resource plan.

3. Confirm the extension in one of the following ways.

◦ From the Resource Allocation related list, review and update the value for the Requested 
Hours, FTE, or Person Days  fields.

◦ Select Allocated  in the Extension  field.

Result
Resources are allocated for the extended period.

Any errors or warnings during allocations are logged in the Resource Plan Logs related list on the 
Resource Plan form. The log is generated if a resource is allocated over 24 hours for a given day. 
You can review these logs to take correct actions for further resource allocation.

Reduce the duration of a resource plan

Reduce the duration of an allocated or confirmed resource plan and deallocate resources in one 
action without having to do it individually for each resource.

Before you begin

Important: 
Resource plans in Resource Management will no longer be available for new customers 
from future releases.

You're encouraged migrate your existing resource plans  to work on resource assignments 
which offers more flexibility and start using Resource Management Workspace.

Resource requester can move an assigned or unassigned resource assignment  using 
Resource Management Workspace.

Role required: resource_manager

About this task
You can reduce an allocated or confirmed resource plan only if the resource plan's end date is 
later than the current date.

You can reduce the duration of an operational resource plan only if its state is allocated.

Procedure

1. Navigate to All  > Resource  > Resource Plans  > All.

2. Open a resource plan and select Reduce.
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Reducing the resource plan end date releases all resources by deleting resource allocations 
after the new end date.

If no actuals are posted for the future in the resource plan, then all the allocated or confirmed 
hours of the resources will be released when you reduce the resource plan.

If actuals are posted for the future, then the resource plan end date is updated to the future 
date on which actuals are present, and all allocated or confirmed hours of all the resources 
from the date on which actuals are present to the original end date are released.

3. Enter the new end date of the resource plan in the End date  field.

4. Select Yes  in the confirmation message.

Result

• The end date of the resource plan is updated to the new reduced end date.

• The state of the resource plan remains the same.

• If no actuals are posted for the future in the resource plan, all allocated or confirmed hours of 
the resources are released.

• If actuals are posted for the future, then the resource plan end date is updated to the future 
date on which actuals are present, and all the allocated or confirmed hours of all the resources 
from the date on which actuals are present to the original end date are released.

Example: Resource allocation concerning actuals
Say a resource plan was created for 1 FTE from January 1, 2021, to December 31, 2021, and on 
March 1, 2021, the resource plan end date was updated to March 1, 2021. Then, all the allocated 
or confirmed hours of the resources on this plan between March 1, 2021, to December 31, 2021, 
would be released. If actuals are posted for the future, for example, May 25, 2021, then the 
resource plan end date will be updated to May 25, 2021, and all confirmed or allocated hours 
between March 1, 2021 to December 31, 2021 will be released.

Time zones in resource plans

Time zones are important in resource management when the users and groups doing the 
resource tasks are located in different locations.

Users maintain their time in the My Calendar  module and resource managers use the resource 
workbench or resource plan to assign tasks to various users.

All users are assigned a schedule. If a user schedule changes, all time calculations change 
automatically. The schedules can be floating or time zone-specific.

• A floating schedule is the same in any time zone. For example, if a resource manager in 
Amsterdam sets a floating schedule for 08:00–17:00, a user in San Jose sees the schedule as 
08:00–17:00.

• When a schedule is defined in a specific time zone, users in different time zones see the 
schedule with their own time zone applied. For example, if the resource manager sets a time 
zone-specific schedule for 08:00–17:00 in Amsterdam, the San Jose user sees the schedule 
as 23:00 of the previous day to 07:00 on the current day because the San Jose time zone is 
nine hours behind the Amsterdam time zone.

Associate a time card with a resource plan

If one resource is allocated to identically named tasks in two resource plans, use the following 
procedure to specify the resource plan the time card should be allocated to.
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Before you begin
Role required: resource_manager

About this task

• A resource plan can be associated with a time card only if the resource plan contains hard 
allocations  for the user.

• If a resource plan isn’t associated manually to a time card, then a resource plan is auto-
associated. The auto-association is done based on the selected Task  in the time card.

Procedure

1. Navigate to the All  > Time Cards  > All.

2. Select a time card.

3. Configure the form to add the Resource plan  field.

4. In the Resource plan  field, select the plan to which the time card should be allocated.

Only resource plans that contain the selected task are listed.

Time Card with Resource Plan

5. Select Update.

Migration of resource plans, operational resource plans, and cost plans

Migrate resource plans to resource assignments and the associated cost plans to attribute-
based labor costs of your projects or demands and easily work on resource allocations using 
Project Workspace.

Tip: 
Resource Managers are encouraged to view the Resource Management Workspace  boot 
camp  to learn about Resource Management Migration to the Next Experience.

Resource plans to resource assignments

Migrate all the resource plans of a project or demand to attribute-based resource assignments 
depending on the planning attributes  to easily manage your projects on Next experience using 
Project Workspace  and Capacity Planning.
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Group, Skill, and Role are the primary attributes enabled for Resource Management depending 
on which the resource plans are migrated to resource assignments.

Important: 
Resource plans in Planning, Requested, Confirmed, Allocated, Rejected, and Completed 
states are only migrated to Resource assignments. Resource plans in Canceled and In-
progress states aren’t migrated.

Let us see how the status of the resource plans is mapped to the status of resource assignments.

Status mapping between resource plans and resource assignments

Resource plan status Resource assignments status

Planned or Requested Unassigned

Allocated Approved

Confirmed Approved

Completed Approved

Canceled or In-progress Resource plan isn’t migrated

Rejected Unapproved

Migrating requested efforts of resource plans

When a resource plan is migrated, a corresponding resource assignment is created based on the 
primary attributes from the resource plan. Resource assignments don’t support custom selection 
of allocation type and allocation spread.

Resource assignments only support even spread of resource allocations by default.

The efforts of the resource plan in requested state are also migrated to resource assignments. 
For example, if a resource plan is in Requested state with 20 additional hours requested, but not 
yet approved, the new migration flow accounts for these requested 20 hours and the total efforts 
are reflected in the migrated resource plan. See the following screenshots for more details.

Existing resource plan in requested state

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1666



Monthly aggregates of migrated resource plan with requested allocations

With the migration of resource plans:

• Resource plans in Planning or Requested states, resource assignments are created based on 
the planned dates and planned duration with their default state as Unassigned.

• Allocation type is set to planned duration.

• Allocation spread is always Even.

• Existing resource allocations are deleted and created again to accommodate resource 
allocations with the resource name and planned duration.

• The allocated costs and allocated hours are copied to planned costs and planned hours.

• Actual hours for the resource plan in Confirmed and Allocated states are retained with the 
resource plans.

Note: 
Only one resource assignment is created for every unique combination of primary 
attributes, Group, Skill, and Role, and one for every user if the resource plans are created 
with selected member preferences. After migration, if you create resource assignments with 
any of the existing combinations, the available resource assignments are updated with the 
new requests.

Allocation contour while migrating to resource assignments

The existing contour of allocations in resource plans is maintained while migrating to resource 
assignments.

Maintaining the existing contour ensures that the planned effort, timing, and effort distribution 
remain consistent before and after migration. By carrying forward the same allocation contours, 
you can continue managing ongoing work without disruption, maintaining accurate capacity and 
utilization insights, and trust that financial and resource plans reflect your original intent. This 
seamless transition helps you adopt the workspace experience confidently, without the need to 
replan or manually adjust allocations.

Example: Migration of Resource plans to Resource assignments

Resource plans in different states.
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Resource plans migrated as resource assignments.
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Operational resource plans to operational resource assignments

Operational resource plans also follow the same logic to migrate operational resource plans to 
operational resource assignments.

Important: 
Operational resource plans in Allocated and Completed states are only migrated as 
Operational resource assignments.

After migration, the Request type of operational resource plans is changed to Hours.
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Example: Migration of Operational resource plans to Operational resource 
assignments

Operational resource plan in Allocated state created for Demo GroupA.

After migration, we will have the following Operational resource assignments for every member 
of the group.

Note: 
The parent-child mapping is retained and you may see an additional resource assignment 
with an empty resource.

Migration of cost plans to attribute-based cost plans

When resource plans of a project or demand are migrated to resource assignments, the 
corresponding financial cost plans based on the resource plans will be migrated to new attribute-
based labor costs. Migrate resource plans related link trigger migrates the cost plans along with 
resource plans migration.

Every resource plan has an associated a cost plan with Labor capex as the cost type. While 
migrating, the planning attributes  of the resource plans are analyzed to create attribute-
based cost plans for the unique combination of the three planning attributes enabled for 
financials  (Employee type, Expense Type, and Role). After migration, there will be no one-to-one 
association between resource assignments and attribute-based cost plans.

Note: 
If a resource plan isn’t associated with either Employee Type or Role, the migrated cost 
plans costs are consolidated into a single cost plan.
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The planned costs are moved to the new attribute-based cost plans while the actual costs 
remain on the existing cost plan records. The rate model  values associated with project or a 
demand are considered to generate attribute-based labor costs.

Example: Migration of cost plans to attribute-based cost plans

Cost plans associated with a resource plan.

Attribute-based cost plan Resource_Internal_Capex  is created after migration.

Migrate resource plans and cost plans for projects and demands

Migrate resource plans and cost plans of your projects or demands to resource assignments 
and attribute-bases cost plans and work on the resource allocations and project financials using 
Project Workspace.

Before you begin

• Learn more about Migration of resource plans, operational resource plans, and cost plans.

• Ensure the project or demand have resource plans and cost plans.

• Role required: resource_user

Procedure

1. Use one of the following options to open a project or a demand.

◦ To open a project, navigate to All  > Project  > Projects  > All  and open a project.

◦ Too open a demand, navigate to All  > Demand  > Demands  > All  and open a demand.

2. Select the Migrate resource plans  related link.

Note: 
This selection triggers the migration of resource plans and cost plans simultaneously.

3. In the Migrate Resource Plans confirmation window, select OK.
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Tip: 
You can Activate a scheduled job to migrate resource plans and cost plans.

Result
Resource plans are migrated to resource assignments, cost plans are migrated to attribute-based 
cost plans. Refresh the project page to view the resource assignments in Resource assignments 
related list.

What to do next
Create resource assignments to manage resource efforts.

Enable attribute-based resource assignments

Enable the property to work on attribute-based resource assignments to request efforts for your 
planning items.

Before you begin

• If a project, demand, or a task has at least one attribute-based resource plan, Resource plans 
related list is hidden.

• If a project, demand, or a task has at least one resource plan without any attribute-based 
resource assignments, Resource plans related list is visible.

• If a project, demand, or a task has no resource plans and the 
sn_pw.enable_resource_planning  property is enabled, Resource assignments 
related list is available, else, Resource plans related list will be available.

• If a project, demand, or a task has at least one attribute-based resource assignment, New  and 
Manage  options are hidden for Resource plans.

• If a project, demand, or a task has at least one resource plan without any attribute-based 
resource assignments, New  and Manage  options are available for Resource plans.

• If a project, demand, or a task has no resource plans and the 
sn_pw.enable_resource_planning  property is enabled, New  and Manage  options 
are hidden for Resource plans, else, they will be available.

Role required: admin

Procedure

1. Navigate to All  > System Properties  > All.

2. Filter the name field to locate and open sn_pw.enable_resource_planning.

3. Change the scope of the instance to Project Workspace.

4. Clear the Value field and enter true.

5. Select Update.
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Create resource assignments

Create resource assignments to request a portion of team or resource capacity for project or 
demand.

Before you begin

• Migrate resource plans and cost plans for projects and demands

• Set the resource planning property to true to create work with only resource assignments. For 
more information, see Enable attribute-based resource assignments.

• Role required: resource_user, resource_manager, it_project_manager, demand_manager, 
admin

Procedure

1. Use one of the following options to open a project or a demand.

◦ To open a project, navigate to All  > Project  > Projects  > All  and open a project.

◦ To open a demand, navigate to All  > Demand  > Demands  > All  and open a demand.

2. On the Resource assignments  related list, select New.

3. On the Resource assignment form, fill the fields.
For a description of the field names, see Resource assignment form.

4. Select Submit.

Tip: 
You can edit the child resource assignments from the list view.

Migrate operational resource plans

Migrate the required Operational resource plans to attribute-based Operational resource 
assignments.

Before you begin
Role required: resource_manager, it_project_manager, demand_manager, admin

Procedure

1. Navigate to All  > Resource  > Resource Plans  > All Operational Plans.

2. Select the list of operational resource plans to migrate.

3. Select Migrate resource plans  from the Actions on selected rows...  list.
Operational resource plans are migrated to Operational resource assignments. You can view 
the list of Operational resource assignments at All  > Resource  > Resource Assignment  > 
Operational Resource Assignments.

Tip: 
You can Activate a scheduled job to migrate resource plans and cost plans.

Create operational resource assignments

Create operational resource assignments to allocate a portion of team or resource capacity for 
operational work such as administration work, meetings, trainings, and so on.

Before you begin
Role required: resource_user, resource_manager, it_project_manager, demand_manager, admin
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Procedure

1. Navigate to All  > Resource Assignment  > Create Operational Resource Assignments.

2. On the Resource Assignment form, fill in the fields.
For a description of the field names, see Resource assignment form.

3. Select Submit.

Result
Operational resource assignment is created. You can navigate to All  > Resource Assignment  > 
Operational Resource Assignments  view the list of operational resource assignments.

Activate a scheduled job to migrate resource plans and cost plans

Activate the Migrate Resource Plans scheduled job to migrate resource plans, operational 
resource plans, and cost plans of your projects and demands to resource assignments and 
attribute-based cost plans.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Filter the name field to locate and open Migrate Resource Plans  scheduled job.

3. Select Active  option to activate and schedule the job.

4. Edit the fields on the Scheduled Script Execution form to customize the job and meet your 
requirements.
For more information about the field description and scripts, see Automatically run a script of 
your choosing .

5. Select Execute Now  to execute the scheduled job or select Update  to save your changes.
Alternatively, you can migrate resource plans  and migrate operational resource plans  for 
required projects and demands.

Create requested allocations for a resource plan

Requested Allocations are automatically created when a resource plan is submitted and is 
in Planning state. If required, the resource requester can create new requested allocations 
for a resource plan in Planning or Rejected state. Resource managers can create requested 
allocations for the plans in Requested state.

Before you begin
Role required: resource_user

About this task
A requested allocation doesn’t have an allocation for a named resource. It only details the start 
date, end date, and the planned hours.

To specify the breakup of resource requirements for monthly or weekly Allocations types, you 
can modify the requested allocations. For example, if you've requested 100 hours of a resource 
from January to February, but you want 20 hours in January and 80 hours in February. You can 
specify these details on the Requested Allocations form.
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Procedure

1. Navigate to All  > Resource  > Resource Plans  > Planning  or Rejected.

2. Open a resource plan.

3. In the Requested Allocations  related list, select New.

4. On the Requested Allocation form, fill in the fields.
For a description of the field values, see Requested Allocation form.

5. To save the record and return to the resource plan, select Submit.

Example:
If a resource is requested from September 1 to Nov 30 for 360 hours, requested allocation 
records are created as follows:

Case 1: Plan duration allocation type

For a plan duration allocation type, the following requested allocation records would 
be created:

Start date End date
Planned 
hours

Sep 01 (Resource plan start 
date)

Nov 30 (Resource plan end 
date)

360

Case 2: Monthly allocation type

For a monthly allocation type, hours are proportionally distributed based on working 
days as follows:

• Total working days for the planned duration = 65 days

• Hours to allocate per working day = 360/65  = 5 hours

The following requested allocation records would be created:

Start date End date No. of working days Planned hours

Sep 01 Sep 30 22 22 * 5 = 110

Oct 01 Oct 31 21 21 * 5 = 105

Nov 01 Nov 30 22 22 * 5 = 110

For a weekly allocation, requested allocation records created similar to monthly. Three allocation 
records, one for each month are created.

Resource allocation

After resource requesters create a resource plan, resource managers can confirm the resources 
to move the plan to the Confirmed state. Resource managers can then allocate resources to the 
plan and move it to the Allocated state.

Based on calendar and schedule information, resource managers view resource availability and 
select the resources under their management that can be confirmed and allocated to specific 
tasks.
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Soft and hard allocations

When a resource plan moves to the Confirmed state, resource allocations corresponding to 
requested allocations  are created automatically. The Booking type  for these allocations is Soft. 
Soft allocations are like temporary allocations for the requested users and do not create any 
calendar events.

When the plan is moved to the Allocated state, the Booking type  changes from Soft  to Hard. 
For a hard booking, the resource is assigned to the plan and is not available for other plans 
during the allocated times. The booked time also appears on the user calendar. If the requested 
resource cannot be allocated for the entire allocation duration, the allocation record booking 
type remains as soft.

Any errors or warnings during allocations are logged in the Resource Plan Logs related list on 
the Resource Plan form. You can review these logs to take correct actions for further resource 
allocation.

Note: 
The resource property 
com.snc.resource_management.allocation_interval_minutes  enables 
the creation of soft and hard allocations with a decimal value.

Calculation of hours for soft allocations

Case 1: Proportional distribution

For example, the requested allocation for a group with two resources when the 
Members preference  value is set to All members  or Specific members  is as 
follows:

Start date End date Planned hours

October 03 October 07 40

The planned hours  on the Resource Plan form are proportionally distributed among 
all the requested allocations based on number of working days for each requested 
allocation record.

Resource Resource time-off
Available capacity 
(hours)

Soft Allocation hours

Resource 1 2 days 3 * 8 = 24 24 * 0.625 = 15

Resource 2 5 * 8 = 40 40 * 0.625 = 25

The following calculations are used:

• Total available capacity = Available capacity User 1 + 
Available capacity User 2 = 24 + 40 = 64 hours

• Hours to allocate per hour of available capacity = 
Planned hours/total available capacity = 40/64 = 0.625 
hours

Note: 
Multiple soft allocations could be created for one requested allocation for 
group resource plans.
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Case 2: Most available resource requested first

For example, the requested allocation for a group with three resources when the 
Members preference  value is set to Any member  is as follows:

Start date End date Planned hours

October03 October 07 40

The system finds the most available resources in the specified time frame and 
creates soft allocations for these resources.

Resource Available hours Soft Allocation hours

Resource 1 24 10

Resource 2 30 30

Resource 3 20

Resource 2 is the most available resource. The system creates soft allocations for 
resource 2 first until it consumes all available hours from resource 2. The system 
then moves to the next most available resource, and so on. Once available hours for 
all resources are consumed, and the planned hours are still left over after allocating 
across all members (from most available to least available), the remaining hours are 
equally distributed among all resources.

Calculation of hours for hard allocations

Case 1: Even spread

Selecting Even  as hard allocation spread type creates resource events for the 
resource by splitting the hours evenly across all working days. The Smart Even Load 
allocation spread takes the availability of resources into account while allocating 
and only applies hours evenly where possible. If a resource is over-allocated for 
a day, it bypasses that day and resumes allocations to succeeding days until the 
resource plan is fulfilled.

For example, for a resource requested for 20 hours in a week, the even spread hard 
allocation is as follows:

Day of the week Monday Tuesday Wednesday Thursday Friday

Available hours 6 6 6 6 Time-off

Allocated hours 5 5 5 5 0

Case 2: Front load

Selecting Front load  as the hard allocation spread type fills up all available resource 
slots from the start date of the allocation. Once the resource is fully allocated 
between start and end dates, the remaining hours are filled from the start date up to 
24 hours.

For example, for a resource requested for 20 hours in a week, the front load spread 
hard allocation is as follows:
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Day of the week Monday Tuesday Wednesday Thursday Friday

Available hours 6 6 6 6 Time-off

Allocated hours 6 6 6 2 0

Event creation during hard allocation

You can control the minimum unit for an event by modifying the Calendar Event Duration 
(minutes) (com.snc.resource_management.allocation_interval_minutes 
property). The default is 60 minutes.

Resource allocations use this property to create allocations with a decimal value.  Use the 
following table to verify you set the property value correctly.

Scheduled hours of the user Calendar Event Duration value

0.5 30

0.25/0.5/0.75 15

0.2/0.4/0.6/0.8 12

0.1, 0.2, and so on 6

Example: 4 hours for 1 week, with an allocation interval of 60 minutes

Creates a 60-minute block from Monday through Thursday.

Monday Tuesday Wednesday Thursday Friday

60 mins 60 mins 60 mins 60 mins

Example: 4 hours for 1 week, with an allocation interval of 30 minutes

If the value of this property is set to  30  minutes, and  1  hour needs to be allocated 
to the user, the allocation is divided into the two 30-minute blocks when the user is 
available.  This setting creates a 60-minute block from Monday through Wednesday 
and 30-minutes blocks for Thursday and Friday.

Monday Tuesday Wednesday Thursday Friday

30 mins+30 
mins

30 mins+30 
mins

30 mins+30 
mins

30 mins 30 mins

Note: 
If the scheduled  hours are not divisible by  the Calendar Event Duration property, then 
there will be  a  loss  of few hours for each day.  For example, the per day scheduled  hours
  per day are  8.5  and the property value is set to 60. Then, the  maximum  allocated  hours
  for  each  day  will  be  8,  resulting  in  a  loss  of  0.5  hours  per  day.

Time-off handling

Resource events from a resource plan are not created for the days where the resource 
has marked time-off or engaged in other events (such as training and meetings). An 
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administrator can manage the resource capacity and allocation with the property, 
com.snc.resource_management.exclude_events_from_schedule, to specify:

• Which events must be excluded for capacity calculations. For example, if a resource has time-
off between Monday and Wednesday, the weekly capacity for the resource is calculated as 16 
hours (as opposed to 40 hours).

• When the system must not create allocations. For example, if a resource is in training on Friday, 
the resource is not allocated for a task on Friday.

Over-allocation

Over-allocated resources are allowed. Over-allocating resources creates overlapping events 
in the user calendar within the user's scheduled hours. However, a maximum of 24 total hours 
can be allocated in any given day. Overlapping events appear overlapped in the calendar in the 
weekly view. In the monthly view, overlapping events appear above or below another event.

For example, a user has a schedule that specifies the daily work day from 08:00 to 17:00. Event 
1 is in the user's calendar from 08:00 to 14:00. If an additional five hours are added for the 
same day for Event 2, an event is created for the three hours of free time (14:00 to 17:00). An 
overlapping event is also created for the remaining two hours, starting at the beginning of the 
day (08:00 to 10:00).

Create a resource role

Define project-specific roles for team members based on their skills and competencies.

Before you begin
Role required: resource_manager

Procedure

1. Navigate to All  > Resource  > Resources  > Resource Roles.

2. Select New.

3. On the Resource Role form, fill the fields.
For a description of the field names, see Resource Role form.

4. Select Submit.

User resources and group resources

When allocating resources, a resource manager might need to work with an administrator to add 
users to a group with pps_resource role.

Resource Manager view

The Resource Manager view in Resource  > Resources  > Users  lists only the users who have 
the pps_resource role. In addition to some of the fields displayed in the User Administration > 
Users  form, the Resource Manager View > Users form also displays the following fields, which 
are editable only by a user with resource_manager role:

• Location

• Schedule

• Timesheet Policy
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• Average Daily FTE Hours/Hours Per Person Day

Note: 
Use the Update Resource Capacity related link to specify a date range. User capacity is 
populated in all aggregate tables based on the schedule of the user.

The Resource Manager view in Resource  > Resources  > Groups  lists only the groups with 
the pps_resource role. When a resource manager creates a new group from this view, the 
pps_resource role is added by default to the group record. Although resource managers have 
write access to several fields, the only fields that they should edit are Average Daily FTE Hours/
Hours Per Person Day  and Hourly rate.

Update the resource capacity

From the Resource Manager view, update the capacity of a user for a specific duration. Based 
on the schedule of the user and the specified duration, the capacity of the user is accordingly 
populated in all resource aggregate tables.

Before you begin
Role required: resource_manager

About this task
Use the Update resource capacity  related link in the following scenarios:

• If a user is newly added and you want to update the capacity for the user.

• If the schedule of an existing user is changed and you want to update the capacity of the user.

The scheduled job that is used for this action is Update resource capacity.

Capacity is generated for only the date range between employment start date and employment 
end date specified in the employee profile in the HR application. This information is available 
when the Employee Profile plugin is installed. If the start and end date are unavailable for an 
employee, manually specify these dates.

Also, if an employee is available after the year has begun, then the capacity is generated from 
the current year's beginning, to ensure that missing capacity is accounted for. For example, if the 
employee's capacity is available from March 1, 2022 to June 1, 2022, then the updated capacity is 
generated from January 1, 2022 to June 1, 2022.

Capacity and availability for terminated resources is automatically updated to 0 when you run 
the Resource Termination Handler job when the termination date is after the date on which the 
job is run. If resources are booked for a time period beyond the user's termination dates, those 
bookings are also updated to 0 in the resource plan.

Use the Update resource capacity  related link in the following scenarios:

• If a user is newly added and you want to update the capacity for the user.

• If the schedule of an existing user is changed and you want to update the capacity of the user.

The scheduled job that is used for this action is Update resource capacity.

Before updating capacity for a new hire: Ensure the following are configured for the user before 
running the capacity update:
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1. Employment dates: Set the employment start date (and optionally end date) in the user's 
employee profile. Capacity is only generated within these dates. If the Employee Profile plugin 
is not installed, manually specify these dates on the user record.

2. Schedule: Assign a work schedule to the user. The capacity calculation is based on the user's 
schedule (for example, a standard 8-hour workday schedule). Without a schedule, capacity 
values may be incorrect.

3. PPS resource role: Ensure the user has the pps_resource  role so they appear in resource 
plans and capacity views.

Capacity is generated for only the date range between employment start date and employment 
end date specified in the employee profile. If an employee is available after the year has begun, 
capacity is generated from the current year's beginning to ensure missing capacity is accounted 
for.

Capacity and availability for terminated resources is automatically updated to 0 when you run the 
Resource Termination Handler job.

Procedure

1. Navigate to All  > Resource Management  > Resources  > Users.

2. Select a User ID.

3. Select the Update Resource Capacity  related link.

4. In the window, provide a start date and end date.

Note: 
You can’t select a start date that is before the employment start date or an end date that 
is after the employment end date when the Employee Profile plugin is installed.

5. Select OK.

Update the resource aggregates

From the Resource Manager view, you can update the resource aggregates for a specific time 
frame.

Before you begin
Role required: admin

About this task
You can use the Update Resource Aggregates  related link in the following scenarios:

• If you notice a discrepancy in aggregates and want to generate correct data.

• If you want to synchronize aggregates with the Resource Allocation Daily 
[resource_allocation_daily] entries for a specific time frame.

Procedure

1. Navigate to All  > Resource Management  > Resources  > Users.

2. Select a User ID.

3. Select the Update Resource Aggregates  related link.

4. In the window, provide a start date and end date.

5. Select OK.
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Create allocations

Resource managers can create allocations using the Resource Allocations related list.

Before you begin
Role required: resource_manager

Procedure

1. Navigate to All  > Resource  > Resource Plans  > Requested.

2. Open a resource plan.

3. In the Resource Allocations  related list, select New.

4. On the Resource Allocation form, fill the fields.
For a description of the field values, see Resource Allocation form.

5. Select Submit  to save the record and return to the resource plan.

What to do next
In the resource plan form, select Confirm  or Confirm and Allocate  to move the resource to the 
Confirmed  or Allocated  state.

Reject a resource plan from the Resource Plan form

Resource managers can reject plans from the Resource Plan form or from the Resource 
Workbench.

Before you begin
Role required: resource_manager

Procedure

1. Navigate to All  > Resource  > Resource Plans  > Requested.

2. Open the plan to reject.

3. Optional:  Add a description of the reason for the rejections in the Notes  field.

4. Select Reject.

Resource schedules

Understand the default schedules used in Resource Management and learn how to create your 
own custom schedules.

Resource management uses a default schedule named Resource Management Schedule. The 
Resource Management Schedule has the following characteristics:

• Weekly on Weekdays

• Monday through Friday 08:00-12:00

• Monday through Friday 13:00-17:00

While planning a resource request for a resource plan, the user's schedule is considered to 
calculate planned and requested hours, if all users in that resource plan have the same schedule 
and that schedule is different from the resource management schedule.

Default schedule

The schedule assigned to each user can be understood using the following information on the 
user profile.
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• Value provided in the Schedule  field.

• Schedules provided in the Schedules related list, with the Context  field set to Resource 
Management.

This related list can be seen in the Resource Manager view of the user profile.

If there are no entries in the Schedules related list, the value provided for the 
Schedule  field is used to determine the resource schedule. If the Schedule field 
is empty too, then the schedule specified in the Default Schedule Name 
(com.snc.resource_management.default_schedule)  property is applied as the 
resource schedule. To understand how to modify this property value, see Specify the default 
resource management schedule.

Custom schedules for resources

Check the default schedule associated to a resource and apply custom schedules to those 
resources who require it.

If custom schedules are necessary, work with your administrator to create them. An administrator 
can create a schedule as per your requirements and assign it to the user. This custom schedule 
can also be assigned to other users as appropriate.

The value specified for the Schedule  field on a user profile overrides the schedule specified in 
the Default Schedule Name  property.

Note: 
The Time zone  field of a schedule is recommended to be set to Floating.

If necessary, the administrator can create a hierarchy of schedules. This is useful if you want 
users to have a primary schedule such as Monday-Friday 8:00-17:00 and a secondary schedule 
such as Saturday-Sunday 12:00-16:00. See Custom schedule hierarchy.

Custom schedule hierarchy

To create a schedule hierarchy for any user, use the Schedules related list. Create a schedule 
and within the new schedule, define the type, dates, and repeat schedule using the Schedule 
Entries related list.

For example, Alene's usual schedule is 8-5 weekdays, which is specified in the Schedule  field of 
their user profile. On top of the usual work, Alene also has to attend a site check every Saturday. 
The schedule for this appointment can be created from the Schedules related list.
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Custom schedule hierarchy example

Schedule entry within a custom schedule

Specify the default resource management schedule

Choose the default schedule to be applied to your resources.

Before you begin
Role required: it_pps_admin

About this task
The base system uses Resource Management  Schedule. You can change the default schedule at 
any time by using the Default Schedule Name  property.

Procedure

1. Navigate to All  > System Scheduler  > Schedules  > Schedules.

2. Review the schedules and copy the Name of the schedule that you want to use.

3. Navigate to Project Administration  > Settings  > Properties - Resource.

4. In the Default Schedule Name  property field, paste the name of the schedule that you 
identified in step 2.
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Resource events

A resource event is a block of time that a resource spends on a task.

Each time a resource manager makes an allocation, the system creates one or more resource 
events for that resource. The resource events appear on the user's personal calendar.

When a booking changes from soft to hard, resource events are created for the resource.

Resource events and schedules

Schedules classify time as work time and non-work time and can be associated with resources 
and with projects.

The My Calendar  module shows the user's work schedule and non-work time.

When a resource manager makes an allocation, the following takes place automatically:

• The schedule associated with the specified resource is analyzed.

• The allocation type changes to Hard  and calendar events are created for individual resources 
within the users' schedule. The hours are spread depending upon the hard allocation spread 
type.

Use the Calendar Event Duration property to control the default minimum unit for an event. See 
Resource Management properties  for examples.

Note: 
Over-allocation is allowed, starting with the Geneva release. However, no more than 24 
hours can be allocated to a user during a given day. See Resource allocation  for more 
information.

Resource event modifications

Resource events that aren’t part of a resource plan can be modified.

You can only modify events you created for yourself in the "My Calendar" module. If a resource 
manager added an event to your calendar, then only the resource manager can modify the event.

Resource managers can modify an event that is part of a resource plan by deleting the event and 
creating a one. For example, a resource manager allocates a resource to a task on a resource 
plan and then wants to change the task work type to Phone Call. The resource manager must 
delete the event and then create another event with the work type set to Phone Call.

Modify a resource event that is part of a resource plan

You can modify a resource event that is part of a resource plan.

Before you begin
Role required: resource_manager

Procedure

1. Navigate to Resource  > Resource Plans  > All.

2. Select a plan Number.

3. In the Resource Allocations  related list, select an allocation Number.

4. On the Resource Event form, update the fields.
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For a description of the field names, see Resource Event form.

A resource event

Modify a self-created resource event

You can modify a resource event that you created.

Before you begin
Role required: none

Procedure

1. Navigate to All  > Resource  > Calendar  > My Calendar.

2. Double-click an event that has not been assigned to a resource plan.

3. Modify the event, as necessary.

4. Select Update.

Change the resource event color

Each event type is represented with a color. PPS admin can change the colors at any time.

Before you begin
Role required: it_pps_admin

Procedure

1. Navigate to All  > Project Administration  > Settings  > Resource Event Colors.

2. Click an Event Type.

3. Specify a different Color.

4. Click Update.

Resource Management  reports

Resource Management reports provide the resource requester and resource managers with 
resource allocations, availability, and utilization.
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Important: 
Resource Management  reports is deprecated starting Zurich  release. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

Alternatively, resource managers are encouraged to use the interactive Overview 
Dashboard in the Resource Management Workspace. For more information about 
dashboards, see Overview dashboard in Resource Management Workspace.

You can generate reports for the following types of information:

Availability

Total time that the resources are available after both Soft and 
hard allocations. Availability is capacity minus allocation. 

Forecasted Utilization

Percentage of forecasted resource time utilization. It is calculated as 
sum of allocated and confirmed hours, divided by the total capacity. 

Committed Utilization

Percentage of committed resource time utilization. It is 
calculated as allocated hours divided by the total capacity. 

Allocation
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Resource capacity, allocations, availability, and utilization. 

Allocation details

A tabular breakdown of all allocation requests (soft bookings), committed 
allocations (hard bookings), availability, capacity, and actual hours.

If the actual hours for a resource is greater than the allocated hours, the actual 
hour's cell is highlighted and a message is displayed on mouse hover.

View availability, utilization, and allocation reports

You can view resource reports that focus on resource availability, utilization, and allocations.

Before you begin
Role required: admin, resource_user, or resource_manager

Important: 
Resource Management  reports is deprecated starting Zurich  release. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

Alternatively, resource managers are encouraged to use the interactive Overview 
Dashboard in the Resource Management Workspace. For more information about 
dashboards, see Overview dashboard in Resource Management Workspace.
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Procedure

1. Navigate to All  > Resource  > Resource Reports  > Resource Reports.

2. On the Resource Reports form, Fill the fields.
For a description of the field names, see Resource Reports form.

3. Select Run  to view the report.

Edit a resource management report

Resource management reports show resource allocation details in different formats for different 
time periods. Configure and use these reports according to your business requirements.

Before you begin
Role required: resource_user or admin

Important: 
Resource Management  reports is deprecated starting Zurich  release. It will be hidden and 
no longer available for installation but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

Alternatively, resource managers are encouraged to use the interactive Overview 
Dashboard in the Resource Management Workspace. For more information about 
dashboards, see Overview dashboard in Resource Management Workspace.

About this task
You can update the report settings like the aggregation type, request type, and calendar type 
for new reports. For example, you can edit the Resource - Group Allocation Details Monthly (Hrs) 
report to view the allocation details in terms of FTE instead of hours. You can also choose to view 
the charts associated with the reports by group bars or stack bars.

Procedure

1. Navigate to All  > Resource  > Resource Reports   > Reports-New.
The following reports are displayed.

a. Select the Edit  button.

b. Configure the report by updating the field values in the Configuration  tab.

c. Select Run  to run the report, or select Save  to run it later.

2. Optional:  Select Create a report  to create report.

My Calendar

Any user with the resource_user role can open My Calendar to view, add, and modify their 
planned work, actual work, operational work, administrative tasks, and personal activities.

After a user adds an event to the calendar, the time blocks for that event appear as red, 
indicating busy, on the resource console and the resource availability dashboard.

Resource managers view users' calendars to determine who has open time to complete tasks, 
and can add tasks to any resource's personal calendar. For every event that is created on a 
user's calendar, a record is created in the User Calendar Event [user_calendar_event] table. 
Resource events are chunks of busy time for the user. Users and resource managers can 
sometimes modify these records. See Resource event modifications.
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The calendar uses time zones. Time is displayed to users in their local time zone according to 
user preferences. See Time zones in resource plans.

Each resource event is represented with a specific color. PPS admin can change these colors. 
See Change the resource event color

Note: 
Although a user can add tasks, such as incidents, to their calendar, the user isn’t added to 
the task's Assigned to  field.

Add events to your calendar

Add tasks, events, and appointments to your calendar.

Before you begin
Role required: pps_resource or resource_manager

About this task
To create an event that repeats daily, weekly, or monthly, see Create repeatable events.

Procedure

1. Navigate to All  > Self-Service  > My Calendar.

The calendar appears in the week view by default, highlighting today's schedule. The user's 
off-duty schedule in gray.

2. Change the view as necessary.

◦ Select Day, Week, or Month.

◦ Use the forward or back arrows to navigate between days, weeks, and months.

◦ Select a date using the calendar icon .

◦ Select Today  to reset your calendar view to show today's calendar.

3. Open the Add Event form by double-clicking an empty cell on the calendar.

4. On the New event form, fill the fields.

For a description of the field names, see New event form.

5. Select Submit.

Result

• When you add a calender event, the resource aggregate daily, weekly, and 
monthly tables are updated. The resource aggregate daily table isn’t enabled 
by default. To generate daily aggregates and store them in this table, create the 
com.snc.resource_management.generate_daily_aggregates  property and 
set its value to true.

• All the non-project events created for you from the calender appear as Operational Work for 
you in Resource Finder.

Create repeatable events

Events can be set to repeat on a regular schedule, such as every day, week, or month.
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Before you begin
Role required: resource_manager

About this task
You can create events even if the timeslot is booked by some other event.

Procedure

1. Navigate to All  > Self-Service  > My Calendar.

2. Double-click an empty cell on the calendar.

3. On the New event form, fill the fields.
For a description of the field names, see New event form.

Note: 
Dates in the When and To field should the same.

4. Click Submit.

View a user calendar

View the calendar of a user to check availability.

Before you begin
Role required: resource_manager

About this task
You can view a calendar for a specific user, and not for all users in a group.

Procedure

1. Navigate to All  > Resource  > Resources  > Users.

2. Do one of the following options.
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Option Description

From the User list
Right-click a user name in the Users list and 
select View Calendar.

From the User form
Select a User record to open the User form, 
and then select the View Calendar  related 
link.

Add events to a user calendar

Resource managers can add events to user calendars.

Before you begin
Role required: resource_manager

Procedure

1. Navigate to All  > Resource  > Resources  > Users.

2. Do one of the following.

Option Description

From the User list
Right-click a user name in the Users list and 
select View Calendar.

From the User form
Select a User record to open the User form, 
and then select the View Calendar  related 
link.

The calendar for that user opens in a new window or tab.

3. Open the Add Event  form by selecting an empty white cell on the calendar.

4. On the form, fill the fields.
For description of the field names, see Add events to your calendar.

Result

• When you add a calender event, the resource aggregate daily, weekly, and 
monthly tables are updated. The resource aggregate daily table isn’t enabled 
by default. To generate daily aggregates and store them in this table, create the 
com.snc.resource_management.generate_daily_aggregates  property and 
set the value to true.

• All the non-project events created for a user from the calender appear as Operational Work for 
the user in Resource Finder.

Delete events

You can delete events you created at any time.

Before you begin
Role required: resource_user

About this task
You can’t delete any events added to your calendar by a resource manager.
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Procedure

1. Navigate to All  > Self-Service  > My Calendar.

2. Find the event to delete.

Use the icons above the calendar to locate the appropriate day, week, or month.

3. Double-click the event.

4. Select Delete.

5. Select OK.

Result
When you delete a calender event, the resource aggregate daily, weekly, and monthly 
tables are updated accordingly. The resource aggregate daily table isn’t enabled 
by default. To generate daily aggregates and store them in this table, create the 
com.snc.resource_management.generate_daily_aggregates  property and set 
the value to true.

Use Resource Diagnostics to detect corrupt resource data

The Resource Diagnostics feature uses the Application Diagnostics Tool to detect corrupt data 
for a resource, such as duplicate aggregates for users, or dailies without a top task.

Before you begin
Role required: pps_admin

Procedure

1. Navigate to All  > Resource  > Resource Diagnostics.

2. On the Application Diagnostics Tool page, select Resource Management.

3. Select one or multiple diagnostic scans.

4. Select Run Diagnostics.

5. View results of the scan.
It lists the duplicate aggregate for users or project-related resource allocation dailies without a 
top task, if any.

What to do next
Add your own diagnostic scans  and fix scripts.

Add diagnostic features for resource

Create diagnostic features to evaluate an application feature and organize various diagnostic 
scans for an application. The diagnostic features appear in the target application and list all the 
diagnostic scans associated with the diagnostic feature for that application.

Before you begin
Role required: adt_admin

About this task
A diagnostic feature can consist of a single or multiple diagnostic scans. These diagnostic scans 
execute the scripts, that they’re mapped with, to detect data corruption or invalid data. You can 
then create diagnostic scans with scripts and execute these scans to check resources for any 
corrupt or invalid data. If a fix script is associated with a scan, you can use it for fixing the corrupt 
or invalid data.
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You can also define fields for users to create a specific filter condition. The diagnostic scripts use 
the results of these filter conditions as inputs for detecting any corrupt or invalid data.

You can check for the existing features under the Features  module. If you don't find one 
matching your needs, create a diagnostic feature and associate it with an application.

Procedure

1. Navigate to All  > Application Diagnostics Tool  > Features.

2. Select New.

3. On the Diagnostics Feature form, fill the fields.
For a description of the field names, see Diagnostics Feature form.

4. Define user input values for specifying filter conditions in the Diagnostics Inputs  section.

The fields in this section are displayed in the application as condition builder. For a description 
of the field names, see Diagnostics Inputs form.

5. Select Submit.

What to do next
Create diagnostic scripts and add fix scripts to use with the diagnostic feature. For more 
information, see Add diagnostics and fix scripts for resource.

Add diagnostics and fix scripts for resource

Add existing or new diagnostic scripts to scan the data in your application for any corruption. You 
can also attach fix scripts to rectify the corrupt or invalid data identified by the diagnostic script.

Before you begin
Role required: adt_admin

About this task
You can create multiple diagnostic scripts to check various aspects of data. The results of the 
filter conditions, that you specify in a diagnostic feature, is used as an input for the diagnostic 
script while executing. You can also use the result of one script in subsequent scripts.

Procedure

1. Navigate to All  > Application Diagnostics Tool  > Scripts.

2. Select New.

3. On the Diagnostics Scripts form, fill the fields.
For a description of the field names, see Diagnostics Scripts form.

4. Optional:  If you want to include a script for fixing the corrupt or invalid data identified by the 
diagnostic script, select the Has Fix script  check box.

5. Use Fix script Access Roles  to move required roles to the Selected list.
The users with the selected roles can access the diagnostic script.

6. In the Fix script  section, add the actual code for the fix script.

7. Select Submit.

Create diagnostic scan and map scripts for resource

Create a diagnostics scan and map diagnostic feature with diagnostic and fix scripts. You 
can create a diagnostic scan to execute diagnostic scripts to check the health of data in your 
application. Use the fix scripts to rectify any corrupt or invalid data that the diagnostic scan 
identifies.
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Before you begin

• Role required: adt_admin

• Create diagnostic features. For more information, see Add diagnostics features for resource.

• Create diagnostic and fix scripts. For more information, see Add diagnostics and fix scripts.

About this task
After creating diagnostic features, diagnostic scripts, and fix scripts, map the diagnostic features 
and scripts to create a diagnostic scan. You can map multiple scripts with each diagnostic scan 
and define the order of their execution.

Procedure

1. Navigate to All  > Application Diagnostics Tool  > Diagnostics.

2. Select New.

3. On the Diagnostics form, fill the fields.
For a description of the field names, see Diagnostics form.

4. Search for and select diagnostic scripts to map with the diagnostic scan in the Diagnostics 
and Script Mappings  section.

5. Select Submit.

Resource Management  reference

Reference information to provide additional details about Resource Management  such as the 
fields, user roles, tables, and guidelines.

Resource Management properties

The Resource Management  application provides several properties to control allocations, 
schedules, and other settings.

You need the PPS admin role to access the Resource properties.

To manage resource properties, navigate to Project Administration  > Settings  > Properties – 
Resource.

Resource management properties

Property Description Default value

Maximum number 
of daily resource 
allocation records 
that should be 
considered in 
synchronous mode 
for confirmation 
and allocation.
(com.snc.resource_management.plan.auto_async_threshold)

Determines the maximum number of daily resource 
allocation records that should be considered 
in synchronous mode during confirmation and 
allocation. The property improves the system 
performance when the number of daily allocation 
records is more than the value set in the property.

The default value is 2600 which implies that the 
number of daily records considered for confirmation 
or allocation in synchronous mode is 2600. The value 
is equivalent to confirming or allocating 10 users on a 
group resource plan for 1-year duration (260 working 
days) or 5 users for 2-year duration, and so on. If 
the group resource plan contains 11 users for 1-year 
duration, the number of daily records are 2860. Thus 

2600

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1695



Resource management properties  (continued)

Property Description Default value

the confirmation and allocation of the resource plan 
in this case is in asynchronous mode.

If you always want to confirm and allocate the 
resource plan in synchronous mode, set the value 
of the property to a higher number based on your 
requirements.

Note: 
If the property 
com.snc.resource_management.run_state_changes_async 
is set to true, the confirmation and allocation 
of resource plans is always considered in 
asynchronous mode.

Show Week/Month 
toggle on resource 
grid interface 
(com.snc.resource_management.show_week_month_toggle)

Shows the toggle button for switching between week 
and month in the resource grid.

Yes

Maximum time 
duration in 
Resource Finder in 
months(com.snc.resource_management.max_dur_resource_finder)

The maximum duration for which the resource details 
should be shown in the resource finder.

24

Use budget reference 
rates to calculate the 
Resource requested/
allocated cost to 
derive hourly rate 
from Labor rate cards 
(com.snc.resource_management.use_budget_reference_rates)

• When the property is set to Yes, the budget 
reference rates [itfm_fx_rate] are used to calculate 
the resource requested or allocated cost.

• When the property is set to No, exchange rates 
[fx_rate] are used to calculate the resource 
requested or allocated cost. For upgraded 
customers, the property is by default set to No.

Yes

Maximum number 
of days for which 
a resource plan 
can be created 
(com.snc.resource_management.plan.max_duration)

Restricts the maximum number of days for which a 
resource plan should be created.

3660

Default 
Schedule Name 
(com.snc.resource_management.default_schedule)

The schedule on the instance that the Resource 
Management  application uses by default.

Resource 
Management 
Schedule

If 
resource_management 
reporting for a 
resource/group 
has value of 

The value that determines when the availability of the 
resource is shown as green on the resource report. 
Green signifies that the resource is not being fully 
utilized and is probably available to have the work 
allocated.

50
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Resource management properties  (continued)

Property Description Default value

percentage_allocation 
less than this 
value the color is 
shown as green. 
(com.snc.resource_management.percentage_allocation_normal)

If 
resource_management 
reporting for a 
resource/group 
has value of 
percentage_allocation 
less than this value 
and greater than the 
com.snc.resource_management.percentage_allocation_normal, 
then color is 
shown as orange. 
(com.snc.resource_management.percentage_allocation_warning)

The value that determines when the availability of the 
resource is shown as orange on the resource report. 
Orange signifies the resource does not have much 
availability.

90

Average Daily 
FTE Hours/Hours 
Per Person Day 
(com.snc.resource_management.average_daily_fte)

The average daily full-time equivalent in hours or 
number of hours per person day. This value is used 
as the equivalent of a full-time day if no value is 
specified in the Average Daily FTE Hours/Hours 
Per Person Day  field on the user or group resource 
record.

Note: 
Capacity is not derived from FTE, but from 
schedules. Both FTE and schedules must be in 
synchronization with each other.

8 (hours)

Calendar Event 
Duration (Minutes) 
(com.snc.resource_management.allocation_interval_minutes)

The default duration for a calendar event.

Resource allocations use this property to create 
allocations with a decimal value.

For example, a user is available for three blocks of 
time: two 30-minute blocks and one 60-minute block.

• If the value of this property is set to 30 minutes, 
and 1 hour needs to be allocated to the user, the 
allocation is divided into the two 30-minute blocks 
when the user is available.

• If the value of this property is set to 60 minutes, the 
allocation is given to the 60-minute block.

Note: 
When you are changing the default value, enter 
a value which results a finite value when divided 
by 60. For example, 6, 12, 15, 30 and so on.

60 (minutes)
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Resource management properties  (continued)

Property Description Default value

First Day of 
Week (Monday 
= 1, Sunday = 7) 
(com.snc.resource_management.first_day_of_week)

Determines which day of the week is the first day. The 
resource workbench uses this value to calculate the 
week number.

For example, a resource is requested from October 14 
(Wednesday) to October 21 (Wednesday).

If the value of this property is set to 2 (Tuesday), the 
allocation is made and presented in the workbench 
in two blocks:

• From Wednesday October 14 to Saturday October 
15.

• Tuesday October 20.

1 (Monday)

Perform Resource 
Confirmation/
Allocation/
Cancellation in 
asynchronous mode 
(com.snc.resource_management.run_state_changes_async)

Uses asynchronous mode when confirming, 
allocating, or canceling resource plans to improve 
application performance.

Because resource confirmation and allocation 
create calendar events for each resource in a group, 
and also consider each resources schedule, the 
confirmation, and allocation process can take an 
excessively long time to complete.

In asynchronous mode, the application uses an 
event manager to handle errors that might occur 
when processing the state of the resource plan. If the 
property is enabled:

• The state of the resource plan changes to 
Confirmation in Progress / Allocation in Progress / 
Cancellation in Progress.

• If the confirmation, allocation, or cancellation does 
not work, the Confirm, Allocate, or Cancel  UI 
actions appear so you can reprocess the action. 
If an allocation is only partially completed, you 
can click the Allocate  UI action again to remove 
all previously created events for the plan and 
reprocesses the action.

Enable this property if you encounter errors or longer 
processing times when handling confirmations, 
allocations, or cancellations. This might occur if 
there are more than 25 members in a group or if the 
duration of the resource plan exceeds 6 months.

No

Comma-separated 
list of resource event 
types which will 
be excluded from 

Specifies which events must be excluded for capacity 
calculations of the resources and when the system 
must not create events.

time_off
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Resource management properties  (continued)

Property Description Default value

user's schedule to 
calculate available 
capacity and to avoid 
making resource 
allocations on the 
days having these 
events (time_off, 
meeting, and so on) 
(com.snc.resource_management.exclude_events_from_schedule)

The events to be entered must be from the Category 
field in the time card table.

Show soft allocations 
in calendar for 
(com.snc.resource_management.calendar_show_soft_allocations)

Shows the following options:

• Resource Managers: When selected, soft 
allocations can be seen in the calendar by the 
resource managers only.

• Everyone: When selected, soft allocations can be 
seen in the calendar by all users who have the PPS 
Resource role.

Resource 
Managers

Number of records 
fetched at a time 
in Resource 
Grid(com.snc.resource_management.number_of_records_to_fetch_at_a_time)

The number of records that are fetched in resource 
grid in one server call.

For example, if there are 100 projects in an allocation 
board, only 30 are fetched in the first call. When the 
user scrolls down, a call is made to fetch the next 30 
projects. Similarly, when the user expands a project 
containing, say 100 resource plans, only 30 resource 
plans are fetched in the first call. Upon scrolling, the 
next 30 plans are fetched, and so on.

30

Do not allow resource 
plan dates to be 
outside the Project/
Demand dates 
(com.snc.resource_management.do_not_allow_resource_plan_dates_outside_project_demand_dates)

Restricts the entry of resource plan dates that 
go beyond the project or demand dates to avoid 
discrepancies between project or demand dates and 
resource plan dates.

If this property is enabled, the resource plan start 
and end dates must be within the project or demand 
dates when you create, extend, shift, move, or 
change the state of a resource plan from requested to 
confirm or allocate.

No

Limit the number 
of users retrieved 
for a group or 
role in Resource 
Finder search 
(com.snc.resource_management.number_of_users_to_fetch_in_finder_at_once)

Sets the maximum number of users that must be 
displayed for a group or role while searching for users 
in Resource Finder

50

Allocate more than 
24 hours of effort 

Allocates more than 24 hours of efforts for a resource 
per a day.

No
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Resource management properties  (continued)

Property Description Default value

a day per resource 
(com.snc.resource_management.allocate_more_than_24hours_per_day)

Exclude resource 
assignments in 
specific states from 
capacity calculation 
(com.snc.resource_management.exclude_status_from_availability)

Excludes the resource assignments with defined 
statuses from calculating resource availability and 
aggregates.

You can enter comma separated values such as 
Pending, Unapproved, and so on.

This field is left 
empty.

Resource Plan form

Field descriptions for the resource plan form fields.

Resource Plan form

Field Description

Number Automatically generated identification number for the plan.

Resource 
type

Category of resource. To select a group, select Group. To select an individual user, 
select User. To select a resource by role, select Role.

Group Specific group resource to associate with the plan.

If you select Role  in the Resource type  field, then the Group  list contains groups 
only for the selected role.

User Specific user resource to associate with the plan.

This field appears if you select User  in the Resource type  field.

Role Specific resource role  that you want to associate with the plan.

This field appears if you select Role  in the Resource type  field.

Members 
preference

Specific members, any member, or all members from the selected group or role. 
The default is All members.

This field appears only when the Group  or Role  option is selected in the Resource 
type  field.

• To request all members of a group or role, select All members. The requested 
time gets split among all members of the selected group or role proportionally 
depending on their capacity. Before making the hard allocation, if all members 
are not required, the resource manager can select only the desired members of 
the group or role.

• To request specific members of a group or role, select Specific members, and 
then select members from the Members list. The requested time gets split 
among the selected members of the selected group or role proportionally 
depending on their capacity.

• To select any member of a group or role, select Any member. Resources that 
are most available during the plan duration are requested first. Soft allocation is 
created only for these resources on confirmation.
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Resource Plan form  (continued)

Field Description

For more information about the effect of members preference on the calculation of 
hours for soft and hard allocations, see Resource allocation.

Note: 
This field is not available by default on the form when opened from the 
resource grid. If required, you can configure these fields. If the resource plan 
is created from the list view, the fields are already available.

Skills Specific skills the requested resources should possess to allocate them to the 
resource plan.

This field appears if you select Group  or Role  in the Resource type  field, and All 
members  or Any member  in the Members preference  field.

For more information, see Skills Management .

Request 
type

Type of request. To specify a request in hours, select Hours. To specify a request 
in full-time equivalents, select FTE.

FTE Number of units for the full-time equivalent selection.

This field appears if you select FTE  in the Request type  field.

For more information, see Resource plans.

Planned 
hours

Estimated number of work hours required to complete all resource plan work.

Note: 
If all users in a resource plan have the same schedule and that schedule is 
different from the resource management schedule, then the user's schedule 
is considered to calculate planned hours,

Name Descriptive name for the plan. If you do not enter a name, the name becomes the 
Number  + Short description. If the short description for the task is empty, the plan 
number is used.

Task Task to which the plan applies. If the resource plan was created from a project 
task, the task number appears here.

Start Date Start date for the resource plan. By default, this field shows the Planned start date 
of the associated project record or task record. Edit the default date, if necessary.

Note: 
The start date of the resource plan cannot be before the project or demand 
start date if the Do not allow resource plan dates to be outside the Project/
Demand dates  property is enabled.

End Date End date for the resource plan. By default, the date is derived from the Planned 
end date  of the associated project record or task record. Edit the default date, if 
necessary.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1701

https://www.servicenow.com/docs/access?context=skills-management&version=zurich&pubname=zurich-servicenow-platform&ft:locale=en-US
https://www.servicenow.com/docs/access?context=skills-management&version=zurich&pubname=zurich-servicenow-platform&ft:locale=en-US
https://www.servicenow.com/docs/access?context=skills-management&version=zurich&pubname=zurich-servicenow-platform&ft:locale=en-US


Resource Plan form  (continued)

Field Description

Note: 
The end date of the resource plan cannot be after the project or demand 
start date if the Do not allow resource plan dates to be outside the Project/
Demand dates  property is enabled.

Allocation 
spread

Type of hard allocation. The value in this field determines the manner in which the 
allocated hours are spread while creating hard allocations. Select either option:

• Even: Create resource events for the resource by splitting the hours evenly 
across all working days for the allocation duration.

• Front load: Create resource events for the resource by filling up all available 
slots of the resource from the start date of the allocation.

For example, if a resource is requested for 30 hours in Week 10:

• Selecting Even  equally divides 30 hours to all weekdays, that is, 6 hours per day 
for a five-day work week.

• Selecting Front load  first consumes all available hours on Monday, then move 
on to Tuesday, and so on, until all 30 hours are allocated. If the resource is not 
available for 30 hours in Week 10, Front load over-allocates by filling up the 
remaining hours from start date up to 24 hours per day.

Note: 
This field is not available by default on the form when opened from the 
resource grid. If required, you can configure these fields. If the resource 
plan is created from the list view, the fields are already available.

State
State of the resource plan. The plan starts in the Planning state.

Note: 
This field is not available by default on the form when opened from the 
resource grid. If required, you can configure these fields. If the resource plan 
is created from the list view, the fields are already available.

Rate 
override Option for overriding the hourly rate derived from the rate model or the labor rate 

card.

When the option is selected,

• The planned, confirmed, and allocated costs of the resource plan is derived 
from the rate specified in the Resource Rate  field.

• When the user submits the time card for the resource plan, the rate specified in 
the Resource Rate  field is used to calculate the actual cost of the resource plan.

The option is enabled only if the resource plan is in the Planned state.

By default, the option is not selected.

Resource 
rate

Hourly rate of resource that overrides the hourly rate returned from the rate model 
to calculate the planned and actual costs of the resource plan.
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Resource Plan form  (continued)

Field Description

This field appears when the Rate override  option is selected. If you clear the Rate 
override  check box, the resource rate value is also cleared and removed from 
all calculations. On selecting the Rate override  check box again, the previous 
resource rate is not retrieved.

Note: 
The Members Preference, Allocation spread, and State  fields are not available by default 
on the form when opened from the resource grid. If required, you can configure these fields. 
If the resource plan is created from the list view, the fields are already available.

Resource Plan form tabs

Use the resource plan form tabs to create a resource plan.

Resource details tab fields

Field Description

Resource type Type of resource selected during the creation 
of resource plan.

Group Group associated with the resource plan.

Role Role associated with a role resource plan.

User User associated with a user resource plan.

Skills Skills that the requested resources possess to 
allocate them to the resource plan.

Note: 
This field is only available for resource 
plans with all or any members 
preference.

Members preference Specific members, any member, or all 
members from the selected group or role.

Members list Resources selected as specific members for 
specific members preference resource plan.

Confirmed/Allocated users Resources that are confirmed/allocated by 
the resource manager for resource plans. 
By default, this field is displayed for specific 
members preference type of resource plans.

Request Details tab fields

Field Description

Request type Type of request selected during the creation of 
resource plan.
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Request Details tab fields  (continued)

Field Description

• If you select FTE  in the Request Type  field, 
the FTE  field is displayed.

• If you select Person Days  in the Request 
Type  field, the Person days  field is 
displayed.

Planned hours Estimated number of work hours required to 
complete all resource plan work.

Confirmed/Allocated hours Confirmed or allocated hours rolled up from 
resource allocations.

Actual hours Actual hours rolled up from time card entries.

FTE Number of units for the full-time equivalent 
selection.

Demand currency Type of currency associated with the demand 
task when the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin is 
activated and Demand Currency view is 
enabled. For more information, see the 
Multicurrency in Demand Management  topic.

Project currency Type of currency associated with the project 
or project task when the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) 
plugin is activated and Project Currency view 
is enabled. For more information, see the 
Multicurrency in Project Management  topic.

Planned cost Amount in Planned hours  multiplied by the 
hourly rate of the specified user or group 
resource. This amount is a first-draft estimate 
of the resource plan cost.

The hourly rate is derived from one of the 
following sources:

• If the Rate override  option is selected, the 
hourly rate specified in the Resource rate 
field is used.

• If a rate model  is populated on the project 
or demand to which the resource plan is 
associated, the hourly rate is derived from 
the rate model.

• If the resource plan is assigned to a specific 
user and the time sheet policy of the user 
is set for multiple rate types, the planned 
cost is determined using the labor rate card 
with the default rate type. If the default rate 
type is inactive, the system rate is used to 
determine the planned cost.
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Request Details tab fields  (continued)

Field Description

• If the resource plan is assigned to a specific 
user and the time sheet policy of the user is 
not set for multiple rate types, the planned 
cost is determined using the labor rate card 
with no rate type. Otherwise, the system rate 
is used.

• If the hourly rate is in non-functional 
currency, budget reference rates are used.

Note: 
Setting up rates for resources would 
provide more accurate forecast and plan 
costs for resource plans.

Planned cost is rolled up from Requested 
Allocations for plans in the Planning or 
Requested state and from Resource 
allocations for plans in the Confirmed or 
Allocated state. While requesting resources 
from a group, if a resource role is specified, the 
planned cost is calculated from the hourly rate 
of the specified role.

Planned cost in demand currency Planned cost of a resource plan associated 
to a demand or demand task in the 
demand currency when the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) 
plugin is activated and the Demand Currency 
view is enabled. The Planned cost in demand 
currency value is derived by multiplying 
planned hours with the hourly rate of the 
specified user or group resource, and then 
converting the result to the demand currency 
based on the budget reference rates.

Planned cost in project currency Planned cost of a resource plan associated to 
a project or project task in the project currency 
when the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin is 
activated and the Project Currency view is 
enabled. The Planned cost in project currency 
value is derived by multiplying planned hours 
with the hourly rate of the specified user or 
group resource, and then converting the result 
to the project currency based on the budget 
reference rates.

Confirmed/Allocated cost Amount of confirmed or allocated hours 
multiplied by the hourly rate of the confirmed 
or allocated resources. Provides a more 
accurate estimation of the cost of the plan that 
is confirmed or allocated.
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Request Details tab fields  (continued)

Field Description

• If the Rate override  option is selected, the 
hourly rate specified in the Resource rate 
field is used.

• If a rate model is populated on the project 
or demand to which the resource plan is 
associated, the hourly rate is derived from 
the rate model.

• If rate model is not available, labor rate card 
determines the hourly rate.

• If no labor card is found for the user, the 
hourly rate is taken from the following time 
card property: Default hourly rate used 
when processing time cards if we can't 
get a rate from labor rate cards (in system 
currency).

Confirmed/Allocated cost in demand currency Confirmed or allocated cost of a resource plan 
associated to a demand or demand task in 
the demand currency when the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) 
plugin is activated and the Demand Currency 
view is enabled. The Confirmed/Allocated 
cost in demand currency value is derived 
by multiplying the confirmed or allocated 
hours with the hourly rate of the confirmed or 
allocated resources, and then converting the 
result to the demand currency based on the 
budget reference rates.

Confirmed/Allocated cost in project currency Confirmed or allocated cost of a resource 
plan associated to a project or project task in 
the project currency when the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) 
plugin is activated and the Project Currency 
view is enabled. The Confirmed/Allocated 
cost in project currency value is derived 
by multiplying the confirmed or allocated 
hours with the hourly rate of the confirmed or 
allocated resources, and then converting the 
result to the project currency based on the 
budget reference rates.

Actual cost Based on the same time cards used for the 
Actual hours, the actual cost is calculated 
using the hourly rate of each user and the 
hours worked. Used to inform resource 
requesters and resource managers of actual 
costs based on the actual hours that user 
resources added on their approved time 
cards.
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Request Details tab fields  (continued)

Field Description

The hourly rate is derived as:

• If the Rate override  option is selected, the 
hourly rate specified in the Resource rate 
field is used.

• If a rate model is populated on the project 
or demand to which the resource plan is 
associated, the hourly rate is derived from 
the rate model.

• If the time sheet policy of a user is set 
for multiple rate types, the actual cost is 
determined using the labor rate card with 
the default rate type.

• If the default rate type is inactive, the system 
rate is used to determine the actual cost.

• If the time sheet policy of a user is set 
for multiple rate types, the actual cost is 
determined using the labor rate card with 
no rate type. Otherwise, the system rate is 
used.

Actual cost in demand currency Actual cost of a resource plan associated 
to demand or demand task in the demand 
currency when the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) 
plugin is activated and the Demand Currency 
view is enabled. The Actual cost in demand 
currency value is derived by multiplying the 
hourly rate of each user with the hours worked, 
and then converting the result to the demand 
currency based on the exchange rates.

Actual cost in project currency Actual cost of a resource plan associated to a 
project or project task in the project currency 
when the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin is 
activated and the Project Currency view is 
enabled. The Actual cost in project currency 
value is derived by multiplying the hourly rate 
of each user with the hours worked, and then 
converting the result to the project currency 
based on the exchange rates.

Allocation Config tab fields

Field Description

Allocation type Type of resource distribution across the 
project that determines the type of allocation 
records. The value in this field determines 
how the planned hours are distributed across 
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Allocation Config tab fields  (continued)

Field Description

resource plan duration among requested 
resources:

• Weekly: Create week-long allocations up to 
the end of the planned end date.

• Monthly: Create month-long allocations up 
to the end of the planned end date. (Default 
value.)

• Plan Duration: Create one allocation for 
each user for the entire duration of the 
resource plan.

For example, if a resource is requested from 
January 1 to March 31, the following records 
would be created for each type:

• Monthly: 3 allocation records, one for each 
month.

• Weekly: 14 allocation records, one for each 
week with Monday being the first day of the 
week.

• Plan duration: Only 1 record for the entire 
duration of the resource plan.

Allocation spread Type of hard allocation selected during the 
creation of the resource plan.

Notes tab field

Field Description

Notes Other correspondence and notes about the 
resource plan.

Resource assignment form

Description for the resource assignment form fields.

Resource assignment form

Field Description

Resource Specific user resource to associate with the 
plan.

Note: 
If you select a specific resource, the 
Group, Role, and Skill planning attributes 
associated to the resource are auto 
populated.

Group Group of resources to associate with the plan.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1708



Resource assignment form  (continued)

Field Description

Role Role of the resources to associate with the 
plan.

Skill Skill of the resources to associate with the 
plan.

Effort type Type of the effort to associate with the plan.

Select Hours  to request defined set of hours 
or select % Capacity  to request certain 
percentage of the resource capacity.

Effort Amount of effort type required.

Operational work type Type of operational work: KTLO, Admin, 
Meeting, Training, Out of office, External labor, 
Time off, Appointment, and Phone call.

Rate model Rate model assigned to the operational 
resource plan. The rate model  is used to 
derive hourly rates for the resource plan.

If you change or remove the rate model 
assigned to an operational resource plan, the 
cost fields on the plan are re-calculated.

Start date Date when the operational resource plan 
starts.

End date Date when the operational resource plan ends.

Resource status Status of the resource assignment.

Resource Plan related links and lists

Use the resource plan related links and list to clone the resource plan details, view resource 
workbench, update cost plans, recalculate resource costs, or work on the modifying the request 
allocations.

Related Links

Field Description

Copy 
Resource Plan Copies the opened resource plan into a new resource plan.

Update Cost 
Plan If you are using Project Portfolio Management, resource plans automatically 

create cost plans for a project  or demand.

Whenever you update the resource plan, click Update Cost Plan  to keep the 
cost plan up-to-date.

Note: 
The cost plan associated to a resource plan is also automatically 
updated when the resource plan is updated.
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Related Links  (continued)

Field Description

Recalculate 
Resource Cost Recalculates the resource costs of the resource plan  whenever the hourly 

rates change in the rate model to keep the costs up-to-date.

Related Lists

Requested Allocations List of requested allocations  for the resource 
plan.

The number of requested allocation records 
created depends on the value of the 
Allocation type  field. For example, if a 
resource is requested from January 1 to March 
31, the following requested allocation records 
are created for each type:

• Monthly: 3 allocation records, one for each 
month.

• Weekly: 14 allocation records, one for each 
week with Monday being the first day of the 
week.

• Plan duration: Only 1 record for the entire 
planned duration.

Resource Allocations List of resources allocated  to the plan.

Resource Plan Logs Lists any error or warnings that might occur 
during resource allocation.

Resource form

Use the resource form to create an operational resource plans.

Resource form

Field Description

Number Automatically generated identification number for the operational resource plan.

Resource 
type

Resource category. To select a group, select the Group  option. To select an 
individual user, select the User  option. To select a resource by role, select Role.

Group Group for which the operational resource plan is created.

If you select Role  in the Resource type  field, then the choice list displays the 
groups for the selected role.

User User for whom the operational resource plan is created. This option appears if 
you select User  in the Resource type  field.

Role Specific resource role  that you want to associate with the plan. This option 
appears if you select Group  or Role  in the Resource type  field.
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Resource form  (continued)

Field Description

If you select Group  in the Resource type  field, then the choice list displays the 
roles for the selected group.

Members 
preference

Specific members or all members from the selected group or role. The default 
is set to All members. This field appears only when the Group  or Role  option is 
selected in the Resource type  field.

• If the All members  option is selected, the resource plan includes all members 
of the selected group or role. Time is proportionally divided among the selected 
group or role members, depending upon their capacity. Before making the hard 
allocation, if all members are not required, as a resource manager, you can 
select only specific members from the group or role.

• If the Specific member  option is selected, a request is made for the specified 
members. The requested hours are proportionately split among specified users 
of the group or role, based on their available capacity.

Skills Specific skill(s) that you want to associate with the plan. This field appears only 
when the All members  option is selected in the Members preference  field.

For more information on skills management, see Skills Management .

Request 
type

Type of request: Hourly  or % Capacity. To estimate the work in hours, select 
the Hourly  option. To estimate the work in percentage of capacity, select the 
%Capacity  option.

Planned 
hours

Estimated number of hours required to complete the operational work.

Confirmed/
Allocated 
hours

Hours of a resource confirmed or allocated for operational work.

Actual 
hours

Hours spent on a planned operational task.

Note: 
When you submit a time card, upon approval of the time card, actual hours 
are updated for an allocation record of an operational resource plan.

Name Descriptive name for the operational resource plan.

Operational 
work type

Type of operational work: KTLO, Admin, Meeting, Training, Out of office, External 
labor, Time off, Appointment, and Phone call. The default is KTLO.

Rate model Rate model assigned to the operational resource plan. The rate model  is used to 
derive hourly rates for the resource plan.

If you change or remove the rate model assigned to an operational resource plan, 
the cost fields on the plan are re-calculated.

Start date Date when the operational resource plan starts.

End date Date when the operational resource plan ends.

Allocation 
type

Resource distribution type that determines the type of allocation records. The 
value in this field determines how the planned hours are distributed across the 
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Resource form  (continued)

Field Description

resource plan duration, among requested resources. Select any of the following 
options:

• Weekly: Creates week-long allocations up to the end of the planned end date.

• Monthly: Creates month-long allocations up to the end of the planned end 
date. Monthly is the default value.

• Plan Duration: Creates one allocation for each user for the entire duration of 
the resource plan.

For example, if a resource is requested from Jan. 1st to Mar. 31st, the following 
records are created for each type:

• Monthly: 3 allocation records, one for each month.

• Weekly: 14 allocation records, one for each week with Monday being first day 
of the week.

• Plan Duration: Only 1 record for the entire duration of the resource plan.

Allocation 
spread

Type of allocation spread. The value in this field determines the manner in which 
the allocated hours are spread while creating hard allocations:

• Even: Creates resource events for the resource by splitting the hours evenly 
across all the working days for the allocation duration.

• Front Load: Creates resource events for the resource by filling up all the 
available slots of the resource from the start date of the allocation.

For example, if a resource is requested for 30 hours in week 10, then:

• Selecting Even  equally divides 30 hours between all weekdays, which is 6 
hours per day for a five-day work week.

• Selecting Front Loadconsumes all the available hours on Monday, moves on 
to Tuesday, and so on, until all the 30 hours are allocated. If the resource is not 
available for 30 hours in week 10, it over-allocates by filling up the remaining 
hours from the start date up to 24 hours per day.

State A plan starts in the Planning  state. The plan moves to the Requested state after 
its submission.

Planned 
cost

Amount, in Planned Hours, multiplied by the hourly rate of the specified user 
or group resource. Planned cost is a first draft estimate of the resource plan cost.

Planned cost is rolled up from Requested Allocations for plans in the Planning or 
Requested states and from resource allocations for plans in the Allocated state.

The hourly rate is derived from one of the following sources:

• Rate model, if it is populated on the operational resource plan.

• Labor rate card, if rate model is not available.

• System property com.snc.time_card.default_rate  if all the other 
conditions fail.
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Resource form  (continued)

Field Description

Note: 
When requesting resources from a group, if a resource role is specified, the 
planned cost is calculated from the hourly rate of the specified role.

Confirmed/
Allocated 
cost

Amount of confirmed or allocated hours multiplied by the hourly rate of the 
confirmed or allocated resources. Provides a more accurate estimation of the cost 
of the plan that is confirmed or allocated.

The hourly rate is derived from one of the following sources:

• Rate model, if it is populated on the operational resource plan.

• Labor rate card, if rate model is not available.

• System property com.snc.time_card.default_rate  if all the other 
conditions fail.

Actual cost Amount of actual hours multiplied by the hourly rate of the specified resource.

Note: 
When you submit a time card, upon approval of the time card, actual cost is 
updated for an allocation record of an operational resource plan.

Notes Additional correspondence and information.

Related Links

Field Description

Copy Resource Plan Copies the opened resource plan to create a 
new resource plan.

Related Lists

Field Description

Requested Allocations List of requested allocations  for the resource 
plan.

The number of requested allocation records 
created depends on the value in the 
Allocations type  field. For example, if a 
resource is requested from Jan first to Mar. 
31st, the following requested allocation 
records are created for each type:
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Related Lists  (continued)

Field Description

• Monthly: 3 allocation records, one for each 
month.

• Weekly: 14 allocation records, one for each 
week with Monday being the first day of the 
week.

• Plan Duration: Only 1 record for the entire 
planned duration of the resource plan.

Resource Allocations List of resources allocated  to the plan.

Extend resource plan form

Use the Extend resource plan fields to extent a resource plan for a project.

Extend resource plan fields

Field Description

New end date Date until which you want to extend the 
resource plan.

Request type Type of request. Options include: FTE, Person 
Days, or Hours.

FTE or Person Days or Hours Number of units to request resources.

The field appears when you select one of the 
options in the Request type  field. Based on 
the selected request type, specify the unit.

For more information, see Request type.

Request Extension form

Use the Request Extension form to request extension of an allocated resource plan.

Request Extension form

Field Description

Extend until Date until which you want to extend the resource plan and request for 
resources.

Request type Type of request. Options include: FTE, Person Days, or Hours.

FTE or Person 
days or Hours

Number of units to request resources.

The field appears when you select one of the options in the Request type 
field. Based on the selected request type, specify the unit.

For more information, see Request type.

Notes Other correspondence and information about the resource plan that the 
project manager wants to communicate with the resource manager.
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Requested Allocation form

Use Requested Allocation form to create a request for resource plans in Planning or Rejected 
state.

Requested Allocation form

Field Description

Start date Start date for the requested allocation record.

End date End date for the requested allocation record.

FTE Number of units for the full-time equivalent selection for the requested allocation 
record.

If a resource is requested as FTE, then the planned hours for each requested 
allocation record are calculated first. A total of all hours is then rolled up as planned 
hours on the resource plan. See Resource plans  for an explanation of FTEs.

Note: 
Capacity isn’t derived from FTE, but from schedules. Both FTE and schedules 
must be in synchronization with each other.

Resource 
plan

Resource plan number to which the requested allocation record is attached. This 
field automatically populates if the requested allocation record is accessed from a 
resource plan.

Planned 
hours

Number of hours to allocate to the requested allocation record.

By default, the Resource Plan form  on the resource plan form are proportionally 
distributed among all the requested allocations based on the number of working 
days for each requested allocation record. However, it’s possible to override the 
planned hours or the FTE.

Planned 
cost

Estimated cost of resource.

Planned cost = Planned hours * hourly rate

The hourly rate is derived from one of the following sources:

• Resource rate  from the resource plan, if the Rate override  option is selected.

• Rate model, if it’s populated on the project or demand to which the resource plan 
is associated.

• Labor rate card for user resource plans.

• Role rate when resource is requested by resource role, if the role has a rate.

• Group hourly rate if role doesn’t have a rate or if the role is null.

• System property com.snc.time_card.default_rate  if all the other 
conditions fail.

Planned costs roll up to the Planned cost  field on the resource plan.

Planned 
cost in 
project 
currency

Planned cost of a project task in project currency when the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) plugin is activated and the Project 
Currency view is enabled.
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Requested Allocation form  (continued)

Field Description

Planned 
cost in 
demand 
currency

Planned cost of a demand task in demand currency when the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) plugin is activated and Demand 
Currency view is enabled.

Resource Role form

Use the Resource Role form to create roles for project team members.

Resource Role form

Field Description

Name Name of the resource role.

Note: 
The resource role name must be unique. Do not create duplicate roles.

Hourly rate Hourly rate for the resource role used for calculating the task cost based on time 
worked.

Description Detailed description of the resource role.

Resource Allocation form

Use the Resource Allocation form to resource allocations.

Resource Allocation form

Field Description

Start date
Start date for the resource allocation. The start and end dates must fall within 
the dates of the resource plan.

End date
End date for the resource allocation.

Resource
Resource to be allocated. The lookup results are filtered by the group, role, or 
user selected on the resource plan.

Confirmed/
Allocated 
hours

Number of hours that the system confirms or allocates to the resource when 
the resource plan is confirmed or allocated. Confirmed and allocated hours 
roll up to the Confirmed/Allocated hours  field on the resource plan.

FTE
Number of units for the full-time equivalent selection.

This option appears if you selected FTE  for the Request type  field on the 
resource plan.

Person Days
Number of units for the person days selection.
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Resource Allocation form  (continued)

Field Description

This option appears if you selected Person Days  for the Request type  field on 
the resource plan.

Planned cost
Planned cost of the resource.

Planned Cost = Planned hours * hourly rateThe hourly rate 
is derived from one of the following sources:

• Resource rate  from the resource plan, if the Rate override  option is 
selected.

• Rate model, if it is populated on the project or demand to which the 
resource plan is associated.

• Labor rate card, if rate model is not available.

• System property com.snc.time_card.default_rate  if all the other 
conditions fail.

Planned costs roll up to the Planned cost  field on the resource plan.

The field is not visible on the form by default. Configure the form to add this 
field if it is not visible.

Confirmed/
Allocated cost Cost of the resource.

Confirmed/Allocated Cost = Confirmed/Allocated hours 
* hourly rate

The hourly rate is derived from one of the following sources:

• Resource rate  from the resource plan, if the Rate override  option is 
selected.

• Rate model, if it is populated on the project or demand to which the 
resource plan is associated.

• Labor rate card, if rate model is not available.

• System property com.snc.time_card.default_rate  if all the other 
conditions fail.

Confirmed and allocated costs roll up to the Confirmed/Allocated cost  field 
on the resource plan.

The field is not visible on the form by default. Configure the form to add this 
field if it is not visible.

Confirmed/
Allocated cost 
in demand 
currency

Confirmed/Allocated cost of a demand task in demand currency when the 
PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin is activated 
and Demand Currency view is enabled.

Confirmed/
Allocated 
cost in project 
currency

Confirmed/Allocated cost of a project task in project currency when the PPM 
Standard Multicurrency (com.snc.ppm_multicurrency) plugin is activated and 
Project Currency view is enabled.
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Create New form

Use the Create New form to create allocation boards.

Create new form

Field Description

Name Unique name for the allocation board.

Type Level from which you want to filter resources.

• Demands/Projects: When selected, 
resources are filtered from demands and 
projects.

• Group: When selected, resources are 
filtered from a group.

• Group manager: When selected, all 
resources with pps_resource role are 
filtered.

• Portfolio: When selected, resources are 
filtered from a portfolio.

• Program: When selected, resources are 
filtered from a program.

• Resource Plan: When selected, resources 
are filtered through the filter criteria and 
are not bound to any particular group, role, 
manager, portfolio, or program.

• Role: When selected, resources are filtered 
from a role.

• User manager: When selected, all resources 
with pps_resource role are filtered.

Depending on the value in Type  field, a field 
appears to select the name of the record. 
For example, if Type  is Group, a field Group 
appears where you can select the name of the 
group.

Resource Event form

Use the Resource Event form to update resource even which is part of resource plan.

Resource Event form

Field Description

Name The name of the event.

Type The type of event:

• Time off

• Appointment

• Meeting
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Resource Event form  (continued)

Field Description

• Phone call

• Task

When/To The start and end date of event.

All day If the event is an all-day event as specified by the schedule.

Repeats If the event repeats Daily, Weekly, Monthly, or Does not repeat.

Task The task associated with this event.

User The user associated with the event.

Resource Reports form

Use the Resource Reports form to generate the resource reports.

Resource Reports form

Field Description

Report Type The type of report that you want to view. You 
can select from the following options:

• Availability  - view the availability of an entity 
for selected time period.

• Forecasted Utilization  - view the forecast 
utilization of an entity for selected time 
period.

• Committed Utilization  - view the confirmed 
utilization of an entity for selected time 
period.

• Allocation  - view allocations for selected 
time period.

• Allocation Details  - view the allocation 
details of the entity for selected time period.

Entity Type The entity that you want to view the report for. 
You can select from the following options:

• User

• Group

• Demand

• Project

• Program

• Portfolio

• Other Task
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Resource Reports form  (continued)

Field Description

Note: 
If you select Allocation  in the Report 
Type  field, only User  and Group  are 
available.

User The user that you want to view the report for. 
This field is displayed only if you select User  in 
the Entity Type  field.

Group The group that you want to view the report for. 
This field is displayed only if you select Group 
in the Entity Type  field.

Group by The option to filter the report for the selected 
group by Roles  or Members. This field is 
displayed only if you select Availability 
or Forecasted Utilization  or Committed 
Utilization  in the Report Type  field, and Group 
in the Entity Type  field.

Members The group member from the selected group 
that you want to view the report for. This field 
is displayed only if you select Group  in the 
Entity Type  field and Members  in the Group 
by  field.

Role The resource role  from the selected group 
that you want to view the report for. This field 
is displayed only if you select Group  in the 
Entity Type  field and Roles  in the Group by 
field.

Demand The demand that you want to view the report 
for. This field is displayed only if you select 
Demand  in the Entity Type  field.

Project The project that you want to view the report for. 
This field is displayed only if you select Project 
in the Entity Type  field.

Program The program that you want to view the report 
for. This field is displayed only if you select 
Program  in the Entity Type  field.

Portfolio The portfolio that you want to view the report 
for. This field is displayed only if you select 
Portfolio  in the Entity Type  field.

Other Task The task (other than a demand, project, 
program, or portfolio) that you want to view 
the report for. This field is displayed only if you 
select Other Task  in the Entity Type  field.

Resource Plan The resource plan that you want to view the 
report for. This field is not displayed if you 
select User  or Group  in the Entity Type  field.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1720



Resource Reports form  (continued)

Field Description

Start Date and End Date The start and end dates time frame to view the 
report.

Zoom level The zoom level that you want to view the report 
for. You can select from the following options:

• Weekly: Displays data for each week during 
the selected time period.

• Monthly: Displays data for each month 
during the selected time period.

Report Unit The unit in which capacity, availability, or 
allocation of a resource is displayed.

• Hours: Displays the capacity, availability, or 
allocation of a resource in hours.

• FTE: Displays the capacity, availability, or 
allocation of a resource in FTE.

• Person days: Displays the capacity, 
availability, or allocation of a resource in 
person days.

This field is displayed only when the Report 
Type  field value is Availability, Allocations, or 
Allocation Details.

New event form

use the New event form to add tasks, events, and appointments to your calendar.

New event form

Field Description

Name Enter a descriptive name for the event.

Type Select a type from list.

• Time off:  Personal time off.

• Appointment:  A type of administrative task.

• Meeting:  A work-related meeting.

• Phone call:  A work-related phone call.

• Task work:  A task in the ServiceNow 
system, such as an incident or a change that 
you're assigned to.

Task
Select the reference lookup icon and select 
the task that needs to be done.
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New event form  (continued)

Field Description

This field appears only if you selected Task  as 
the type of activity.

Note: 
This action does not add you to the 
Assigned to  field on the task form.

When
Choose the start and end date and time, or 
select the All day  option.

Important: 

When you select All day  for a Time off 
event, the system allocates 24 hours for 
that day, not the standard 8-hour work 
schedule. To book time off for only your 
working hours (for example, 8 hours), 
specify the exact start and end times 
instead of selecting All day.

The allocated hours for an event are 
calculated based on the duration between the 
start and end times you specify. To align time 
off with your work schedule, see Resource 
schedules.

Do not use this field to set repeatable events.

Repeats
Select the frequency that the activity repeats, 
such as Daily, Weekly, Monthly, or select 
Does not repeatif this event is a non-repeating 
event.

For example, if you have a task that you want 
to work on Monday and Friday, set a weekly 
repeatable event for Monday and Friday. See 
Create repeatable events.

Repeat every
Enter a number that represents the frequency.

This field appears only if you selected Daily, 
Monthly, or Yearly  in the Repeats  field.

Repeat on
Select the days of the week to repeat the 
activity.

This field appears only if you selected Weekly 
in the Repeats  field.

Repeat until
Select an end date.
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New event form  (continued)

Field Description

This field appears only if you select Daily, 
Monthly, or Yearly  in the Repeats  field.

Diagnostics Feature form

Use the diagnostics Feature form to create a new diagnostic feature for a resource.

Diagnostics Feature form

Field Description

Name Name of the diagnostic feature. This name 
appears in the application to which this 
diagnostic feature belongs.

Active Option for activating the diagnostic feature.

Application Search for and select the application with 
which you want to associate this diagnostic 
feature.

Roles Move desired roles to the Selected list. The 
users with the selected roles can access the 
diagnostic feature.

Description Details of the diagnostic feature. The 
description is displayed in the application 
to which the diagnostic feature belongs. It 
enables the user to understand the diagnostic 
scans executed in the feature.

Diagnostics Inputs form

Use the Diagnostics Inputs form fields to specify a filter condition for a user.

Diagnostics Input fields

Field Description

Label Name of the label for the input fields.

Field Type Select Reference  field type.

Table Name of the table on which the query 
specified in the condition should run.

Key An identifier for the user input condition. If a 
user specifies multiple conditions, this key 
acts as a unique identifier for each condition. 
You can use this key as the input for the 
scanContext  section of the diagnostic 
script.

Diagnostics Scripts form

Use the Diagnostic Scripts form to scan the data in your application for any corruption.
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Diagnostics Scripts form fields

Field Description

Name Name of the diagnostic script. Use a name that 
clearly explains the objective of the script. The 
script name also enables you to identify the 
correct script while mapping the script to a 
feature when creating a diagnostic scan.

Description Details of the diagnostic script. The 
description enables the user to understand 
the functions of the script.

Diagnostic script The actual code for the diagnostic script.

Diagnostics form

Use the Diagnostic form to create a diagnostics scan and map diagnostic feature with diagnostic 
and fix scripts.

Diagnostics form fields

Field Description

Name Name of the diagnostic scan. This name 
appears in the application to which this 
diagnostic scan belongs.

Active Option for activating the diagnostic scan.

Order The order in which this diagnostic scan 
appears in the application.

Feature Search for and select the diagnostic feature 
with which you want to associate this 
diagnostic scan.

Roles Move desired roles to the Selected list. The 
users with the selected roles can access the 
diagnostic scan.

Description Details of the diagnostic scan. The description 
is displayed in the application to which the 
diagnostic scan belongs. It enables the user to 
understand the diagnostic scans.

Portfolio Management
With the ServiceNow®  Portfolio Management application, you can create portfolios which are 
collections of related programs, projects, and demands. You can then perform financial planning 
and monitor the status and progress of these portfolios.

Watch this four-minute video to learn about the portfolio structure, creating a portfolio and 
program, setting up a stakeholder registry.  Information about the portfolio structure, creating a 
portfolio and program, setting up a stakeholder registry, and the portfolio workbench.

You must have the it_portfolio_manager role  to manage a portfolio. The Portfolio Management 
application provides these capabilities to the portfolio manager:
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• Create a portfolio by adding related programs, projects, and demands.

• Perform annual portfolio planning by selecting demands, projects, and programs.

• Track the progress and status of all the programs, projects, and demands that are part of the 
portfolio. You can track the costs, resources, schedules, risks, and issues.

The following diagram provides an overview of Portfolio Management.

Overview of Portfolio Management

Scenario-based Portfolio Planning

Install the Scenario Planning for PPM  application from ServiceNow Store  to help the portfolio 
managers do a scenario-based portfolio planning with different combinations of demands and 
projects. You can Compare multiple scenarios in a portfolio and fund only those demands and 
projects that add financial value to the organization.

Create a portfolio

Create a portfolio to manage related programs, projects, and demands.

Before you begin

• Create demands, programs, and projects to include as part of the portfolio.

• Role required: it_portfolio_manager or admin

Procedure

1. Navigate to All  > Project  > Portfolios  > Create New.

2. Enter a unique Name  that summarizes the programs, projects, and demands included in this 
portfolio.

3. Enter a Description  for the portfolio that adequately explains the various programs, projects, 
and demands attached to it.

4. Enter the name of the Portfolio Manager.

5. Select Create Portfolio.
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Result
The portfolio is created and the form reopens with additional fields, related links, and related 
lists.

What to do next
Fill in the following related links and lists to complete the portfolio:

Portfolio form Related links

Field Description

Demand 
Workbench

Link to open Demand Workbench.

Portfolio 
Target

Link to open the Portfolio Target dialog box for you to enter the CAPEX and OPEX 
target for each fiscal year. This target amount is split equally among the fiscal 
periods.

The portfolio target is included in the Portfolio Target related list.

Portfolio 
Planning

Link to open Portfolio Planning Workbench for scenario planning. This related 
link is available when Scenario Planning for PPM  is installed in your instance. For 
more information, see Scenario Planning for PPM.

Analytics 
Portfolio

Link to open the PMO Dashboard. The dashboard generates graphical reports for 
the portfolio.

Portfolio form Related lists

Field Description

Demands List of demands that are part of the portfolio.

To create a demand, select New.

To add existing demands to the portfolio, 
select Edit.

Projects List of projects that are part of the portfolio. To 
add existing projects to the portfolio, select 
Edit.

Programs List of programs that are part of the portfolio.

To create a program, select New.

To add existing programs to the portfolio, 
select Edit.

Risks List of risks that are part of the portfolio. The 
program, project, and demand risks are also 
displayed in this list.

To create a risk, select New.

Issues List of issues that are part of the portfolio. The 
portfolio, program, project, and demand issues 
are also included in this list.

To create an issue, select New.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1726



Portfolio form Related lists  (continued)

Field Description

Cost Plans List of cost plans of projects  and demands  that 
are part of the portfolio.

Monetary Benefit Plans List of monetary benefit plans of projects  and 
demands  that are part of the portfolio.

To create a monetary benefit plan, open the 
project or demand record and select New  in 
the Monetary Benefit Plans related list.

Non-monetary Benefit Plans List of non-monetary benefit plans of projects 
and demands  that are part of the portfolio.

To create a non-monetary benefit plan, open 
the project or demand record and select New 
in the Non-monetary Benefit Plans related list.

Portfolio Target List of portfolio capital and operational 
expense target for different fiscal years. The 
values are displayed from the project_funding 
table. Set these values in the Portfolio Target 
window on the portfolio form. You can create 
targets for different financial periods.

Note: 
The PPS admin can also set the 
portfolio target by navigating to Project 
Administration  > Enter Portfolio Target.

Planning & Budgeting According to the fiscal years, lists projects and 
demands that are part of the portfolio. You can 
include or exclude a project or demand from 
the portfolio budget plan.

Open a portfolio status list

Open the status list of a portfolio to see the projects that are included in it.

Before you begin
Role required: it_portfolio_manager

Procedure

1. Navigate to Project  > Portfolios  > All.

2. Open a portfolio.

3. Select the Portfolio Status  related link.
The list of portfolio status records opens.

4. If necessary, you can select a different project associated with the current portfolio.
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Scenario Planning for PPM

The Scenario Planning for PPM  application provides a central location for portfolio managers to 
create and track the roadmap for project execution for a given fiscal year. Optimize your budget 
and resource usage by creating and comparing different scenarios for your project and demand 
roadmap or resources.

A scenario is a collection of demands and projects that serves as a planning instance for the 
selected fiscal year to support funding decisions.

Eligible demands and projects in the portfolio are collected into a default or existing scenario 
of the planning cycle. You use the default or existing scenario as a basis to create additional 
scenarios. A demand or project can belong to more than one scenario in the current planning 
cycle but it cannot belong to more than one portfolio. For more information, see Create planning 
scenarios.

Features

The Scenario Planning for PPM  provides the following capabilities to portfolio managers:

• Plan your portfolio based on resource capacity for a single year or multiple years.

• Break down your multiple year portfolio planning in smaller planning windows for continuous 
tracking and planning adjustment.

• Allocate budget to demands and projects in your portfolio from Investment Funding.

• Create scenario-based plans for portfolios.

• Apply filters to refine your list of selected demands and projects in your portfolio.

• Experiment with different combinations of demands and projects in planning scenarios.

• View details of demands and projects that are not aligned with your strategic goals.

• Edit the way demands and projects are funded for each scenario.

• Compare different scenarios to assess outcomes of various project and demand 
combinations.

• Confirm a planning scenario that best aligns with your organizational objectives as your current 
portfolio plan.

• Override a previously confirmed planning scenario based on changing priorities and 
environment.

• View budget details such as actual and planned costs, projects, and demands not aligned to 
goals and strategies, and actual costs for the projects.

• View resource utilization and allocation.

• View demands and projects with over-allocated resources.

Install Scenario Planning for PPM

Install the Scenario Planning for PPM  application from ServiceNow  Store applications. Visit the 
ServiceNow Store  website to view all the available apps and for information about submitting 
requests to the store. For cumulative release notes information for all released apps, see the 
ServiceNow Store  version history release notes .

Before you begin
Complete the following setup checklist for a smooth installation and configuration.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1728

https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://store.servicenow.com/sn_appstore_store.do#!/store/home
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html
https://docs.servicenow.com/bundle/store-release-notes/page/release-notes/store/sn-store-release-notes.html


Setup checklist

Setup tasks Description

Verify that the PPM Standard plugin 
(com.snc.financial_planning_pmo) is 
activated.

Navigate to Subscription Management 
> Subscriptions  in your instance. The 
list displays the subscriptions that your 
organization has purchased.

Verify that the Investment Funding for PPM 
(com.snc.investment_planning_pmo) plugin is 
activated.

Note: 
This plugin needs to be activated only 
when you want to retrieve the target 
amount for a portfolio for annual type of 
planning from Investment Funding.

Navigate to Subscription Management 
> Subscriptions  in your instance. The 
list displays the subscriptions that your 
organization has purchased.

Role required: admin

About this task
Activate the PPM Standard plugin (com.snc.financial_planning_pmo) in your ServiceNow 
instance before you install Scenario Planning for PPM. For more information see, Activate PPM 
Standard (Project Portfolio Management).

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.
You can search for the application by its name (Scenario Planning for PPM) or ID 
(sn_pw_scenario). If you cannot find an application, you may have to request it from 
ServiceNow  store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or 
need to be installed. If there are any plugins or applications that need to be installed, you must 
install them before you can install Scenario Planning for PPM.

5. Optional:  If demo data is available and you want to install it, click Load demo data.

(Optional) Demo data comprises sample records that describe application features for 
common use cases. Load demo data when you first install the application on a development or 
test instance.

Important: 
If you don't load the demo data during installation, it's unavailable to load later.

6. Click Install.
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Related topics

List of plugins (Zurich)

Components installed with Scenario Planning for PPM

Several types of components are installed with the installation of the Scenario Planning for PPM 
application, including tables and demo data.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Tables installed with Scenario Planning for PPM

Table Description

Portfolio Scenario

[sn_pw_scenario_pm_portfolio_scenario]

Stores portfolio planning scenario 
information such as name of the 
scenario, state of the scenario, fiscal 
year, and name of the portfolio to 
which the scenario belongs.

Portfolio Scenario Funding

[sn_pw_scenario_pm_portfolio_scenario_funding]

Stores the funding information about 
the portfolio planning scenarios. 
The funding information includes 
the name of the scenario, operating 
budget, capital budget, total budget, 
and whether a demand or project is 
selected for execution.

Scenario Planning Configuration

[sn_pw_scenario_pm_portfolio_scenario_configuration]

Stores the portfolio planning 
configuration information such as 
planning type and scope.

Portfolio Planning Window

[sn_pw_scenario_pm_planning_window]

Stores the planning window 
information of a portfolio for multi-
year and resource capacity-based 
planning.

Annual and multi-year resource capacity-based planning

Plan your portfolios using scenarios for a single fiscal year or multiple years after analyzing 
utilization of resources against available capacity. Include demands and projects in all portfolios 
or a single portfolio to evaluate, prioritize, and select demands and projects that match your 
business objectives.

Plan your portfolio and select demands and projects that you want to execute within the target 
budget. Create scenarios to analyze your portfolio's alignment with the organization's business 
objectives. The Scenario Planning for PPM  application enables you to evaluate multiple sets of 
forecast scenarios and analyze investments consistently.

Annual financial and resource capacity-based planning

Plan your portfolio for a single fiscal year. You can select all your portfolios or a single portfolio 
for planning. After selecting your portfolio, you can create multiple scenarios to evaluate 
the demands and projects based on total cost, resource usage and capacity, and strategic 
objectives.
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In the annual planning, you create scenarios with different combinations of demands and 
projects from a specific portfolio or all portfolios for a specific financial year. Based on your 
selection of demands and projects, analyze the resource allocation for the selected demands 
and projects derived from the associated resource plans. After analyzing the resource availability 
and capacity, modify your selection of demands and projects in different scenarios and confirm a 
scenario that maximizes your returns and add financial value to the organization.

Important: 
The default configuration is Annual Financial and Resource Capacity Based Planning 
and single selected portfolio  for new installation or upgrade. You can change the planning 
configuration to plan for multiple years and all portfolios.

Investment funding integration

Integrate Scenario Planning for PPM  with Investment Funding  to retrieve the target amount for 
a portfolio or all portfolios from a top-level investment fund for annual financial and resource 
capacity-based planning. If you are planning for a single portfolio, the target amount of that 
portfolio is retrieved from the New Fund  column for that portfolio investment and fiscal period in 
a top-level investment. If you are planning for all portfolios, you can configure the funding entity 
for which the organization must be funded, and then the investment planner can add funds for 
that particular entity in a top-level investment. For example, if your organization is a business 
unit, you can enable that business unit as the funding entity, and all the funds allocated to that 
business unit are set as the target for your organization.

Note: 
When you upgrade Scenario Planning for PPM  to 2.3.0 or later version, the legacy 
Investment Funding  must be upgraded to ServiceNow Store  for the integration to work. 
For detailed instructions on upgrading from legacy Investment Funding  to the ServiceNow 
Store  application, see Upgrading legacy Investment Funding to Store application.

Multi-year, resource capacity-based planning

Multi-year planning enables you to plan your portfolio using a planning window ranging from 
three to 24 months. If your portfolio consists of demands and projects spanning more than one 
year or if you are planning for a longer duration, you can plan your portfolio in smaller planning 
windows. The multi-year planning enables you to analyze resource usage for different demands 
and projects during the selected planning window and adjust your priorities to accommodate 
any changes to budget, resources, or business environment.

In the multi-year planning, you create scenarios similar to the annual planning, but for a specified 
planning window for a specific portfolio or all portfolios. Based on your selection of demands and 
projects, analyze the resource allocation for the selected planning window. After analyzing the 
resource availability and capacity, modify your selection of demands and projects in different 
scenarios and confirm a scenario that maximizes your returns and add financial value to the 
organization.

Configure the scenario planning type and scope

Configure the scenario planning type and select the scope of portfolios to determine the way 
you want to plan and work on your portfolios. You can also specify using Investment Funding  for 
funding demands and projects in your portfolios.

Before you begin
Important: 
Modifying the planning type and scope deletes all your existing scenarios and confirmed 
plans.

Role required: it_pps_admin
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About this task
The option to use Investment Funding  for funding your portfolios is available only when you 
activate the Investment Funding plugin.

Procedure

1. Navigate to All  > Project  > Portfolios  > Configure Planning.

2. Open the scenario planning configuration record.

3. Configure the planning type and scope.

4. Optional:  If you want to enable selection of demands and projects that are in completed or 
inactive state, select Allow Selection of Completed Projects.

5. Optional:  If you want to retrieve the target amount from Investment Funding, select 
Investment Funding Integration.

Note: 
This option is available only when the Investment Funding for PPM 
(com.snc.investment_planning_pmo) plugin is active and planning type is selected as 
Annual Financial and Resource Capacity Based Planning.

◦ If the planning scope is Single Selected Portfolio, the target amount of that portfolio 
is retrieved from the New Fund  column for the selected portfolio investment. For more 
information, see Allocate funds to an investment.

◦ If the planning scope is All Portfolios, specify a source to retrieve the target amount.

a. Select a funding entity from the Funding Entity list from which your demands and projects 
will be funded.

b. Select the transaction table for the selected funding entity from the Funding Record list.

6. Click Update.

Result
The scenario planning configuration is updated and all scenario plans and confirmed plans are 
deleted. The configuration changes also updates the Portfolio Planning Workbench to enable 
you to do scenario planning based on the updated planning type and scope.

Impact of modifying the scenario planning type and scope

Modifying the planning type and scope impacts the demands and project selection in your 
planning scenarios and portfolio planning. You can change the planning type and scope at any 
time during portfolio planning.

Changing the planning type

Changing the planning type affects your portfolio planning regardless of whether the portfolio 
has any confirmed plan or planning scenarios in it at the time of this change.

From annual financial planning to multi-year, resource capacity based planning

This change in the planning type has the following impact on your confirmed plans 
and planning scenarios:

• Deletes all scenarios and scenario funding records.

• A default scenario is created with the current month as starting month and a 
default of 3-month planning window.
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From multi-year, resource capacity based planning to annual financial planning

This change in the planning type has the following impact on your confirmed plans 
and planning scenarios:

• Deletes all scenarios and scenario funding records.

• If you were previously using annual planning, the target budget is retrieved. If not, 
the current fiscal year is set as default and you must set the target budget.

Changing the planning window

Changing the planning window effects all the users involved in planning and has the following 
impact on your portfolio planning:

• The new planning window applies to all scenarios and the confirmed plan of every portfolio.

• A demand or project outside of the selected planning window cannot be selected or 
deselected. However, the value of Planned  check box for the project or demand will not 
change. These demands and projects continue to be related to the scenario.

• When you confirm a scenario, only the demands and projects that fall in the planning window 
are confirmed, the demands and projects outside the planning window are not confirmed.

Changing the planning scope

Changing the planning scope from a single selected portfolio to all portfolios has the following 
impact on your confirmed plans and planning scenarios:

• In case of annual planning, creates a portfolio planning record in the Tracking state if a 
confirmed plan exists for any of the portfolios.

• In case of annual planning, creates a confirmed plan for all the fiscal years with at least one 
confirmed plan for any of the portfolios.

• In case of multi-year planning, your confirmed plans for the portfolios are retained.

• Deletes all existing scenarios and scenario funding records.

Set target budget for a fiscal year

When planning for a portfolio or all portfolios, start by selecting the fiscal period for the demands 
and projects that you want to work with. You then set the target amounts for both operating and 
capital expenses of portfolios when Scenario Planning is not integrated with Investment Funding.

Before you begin
Role required: it_portfolio_manager or it_pps_admin

About this task
Internal groups typically provide the target amount for a fiscal year. The target for the planned 
fiscal year can be 110% of the amount spent in the last year based on actual expenditure. The 
target is the starting point for planning projects for the next fiscal year.

Note: 
The PPS admin can set the portfolio target by navigating to Project Administration  > Enter 
Portfolio Target.

If Scenario Planning is integrated with Investment Funding, the target amount is retrieved from 
the top investment fund allocated for a single portfolio or all portfolios.

For information on how to configure the investment funding settings for a single portfolio or all 
portfolios, see Configure the scenario planning type and scope.
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For information on creating a top level investment and allocating funds, see the Create a top-
level investment  topic.

Procedure

1. Navigate to Portfolio Planning Workbench from either of two starting points.

2. In the Portfolio Planning Workbench Fiscal Year  choice list, select the year that you want to 
perform the planning for.
You can perform financial planning for only one fiscal period at a time.

3. Set or update the target budget amount.

◦ If you're planning for the selected fiscal year for the first time, select Set Target.

◦ If you have already set the target budget amount for the selected fiscal year and you want to 
change the amount, select Edit Target.

4. In the Set Target dialog box, enter the amounts for Capex Target  and Opex Target.

5. Select Save.

Result
The portfolio capital and operational expense target for different fiscal years are updated in the 
Portfolio Target  related list on the portfolio record.

What to do next
Start creating scenarios for portfolio planning. For more information, see Create planning 
scenarios.

Create planning scenarios

Create planning scenarios with different combinations of projects and demands in your portfolio. 
Experiment with different scenarios to plan your budget expenditure for a fiscal year.

Before you begin
Ensure that you have set the target budget for the fiscal year for which you want to create a 
planning scenario for annual type of planning. For more information, see Set target budget for a 
fiscal year. Setting of target is not required for multi-year resource capacity type of planning.

Role required: it_portfolio_manager

About this task
You can create up to four planning scenarios with different combinations of projects and 
demands for execution. For example, you might create a scenario A and select all the projects 
and demands with your standard resource allocation. If you’re aware that a risk might affect the 
business outcome, you can create a scenario B with a reduced number of projects and demands 
to see whether that strategy might mitigate or avoid the risk. For more information about defining 
scenarios, see Scenario Planning for PPM.

Procedure

1. Navigate to the Portfolio Planning Workbench from either of two starting points.

2. In the Planning Portfolio Workbench, create a scenario for annual financial and resource 
capacity based planning or multi-year resource capacity based planning.

◦ For annual planning, perform the following steps:
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a. Select the fiscal year for which you want to create a planning scenario.

b. Click the Start Planning  button on the Welcome page.
A default planning scenario is created with all active demands and projects for the selected 
fiscal year.

Note: 
If a portfolio plan exists for the selected fiscal year, the Portfolio Planning Workbench 
displays it as the current plan.

c. Click the create scenario icon ( ).

d. In the Create Scenario dialog box, enter a name and short description for the scenario.

e. In the Copy Data From list, select the source for copying data.

The available options are:

▪ None: Creates a scenario with no projects or demands selected.

▪ Ongoing projects funded last year: Creates a scenario using projects funded during the 
previous year and continuing in the current year selected. This option is available only if 
an existing approved plan for the previous year exists. This is the default option when you 
create an initial scenario for a given fiscal year.

▪ A list of other scenarios: Creates a scenario using projects and demands selected from 
another existing scenario. This option is available if other scenarios exist for the same 
portfolio for the same fiscal year.

▪ Confirmed Plan: Creates a scenario with projects and demands selected from the existing 
approved plan. This option is available only if a confirmed plan exists for the current fiscal 
year.

f. Click Save.

◦ For multi-year planning, a default plan is automatically created with the current month as 
the starting month, and the planning window period as configured in the Scenario Planning 
Configuration page. To create a new scenario, perform the following steps:

a. Click the create scenario icon ( ).

b. In the Create Scenario dialog box, enter a name and short description for the scenario.

c. In the Copy Data From list, select the source for copying data.

The available options are:

▪ None: Creates a scenario with no projects or demands selected.

▪ Ongoing projects funded last year: Creates a scenario using projects funded during the 
previous year and continuing in the current year selected. This option is available only if 
an existing approved plan for the previous year exists. This is the default option when you 
create an initial scenario for a given fiscal year.
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▪ A list of other scenarios: Creates a scenario using projects and demands selected from 
another existing scenario. This option is available if other scenarios exist for the same 
portfolio for the same fiscal year.

▪ Confirmed Plan: Creates a scenario with projects and demands selected from the existing 
approved plan. This option is available only if a confirmed plan exists for the current fiscal 
year.

d. Click Save.

Result
The planning scenario is created and displayed in a new tab.

What to do next
Select projects and demands for execution  in the planning scenario.

Select demands and projects for portfolio planning

After you create a planning scenario, select the demands and projects to include in budget 
planning. You can view all the demands and projects for the selected fiscal year or planning 
window with their planned cost and priorities to finalize them for execution.

Before you begin
You should have at least one planning scenario. For more information, see Create planning 
scenarios.

Role required: it_portfolio_manager

About this task
You can perform a what-if analysis by including or excluding demands or projects and their 
planned cost for annual type of planning. The planned cost is derived from all the cost plans 
created for a project or demand. It is the total of all the costs from all cost plans for a given 
project or demand in the fiscal year or planning window.

You can perform a what-if analysis by including or excluding demands or projects and their 
planned cost, budget, and utilization for multi-year resource capacity type of planning.

Procedure

1. Navigate to Portfolio Planning Workbench from either of two starting points.

2. In the Portfolio Planning Workbench, click the scenario for which you want to include or 
exclude demands and projects.
The projects and demands from the selected portfolio appear on the Timeline View.

3. Optional:  Compare and evaluate the relative standing of demands using the Bubble Chart 
tab.

(Optional) Right-click a demand and select Select for execution  from the context menu to 
include a demand in portfolio planning. For more information, see Demand workbench bubble 

chart. You can search for specific demands by applying filters using the Filter( ) icon.

Note: 
The Bubble Chart  tab is not available for Multi-year Resource Capacity Based Planning 
configuration.
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4. Include or exclude demands and projects from planning in the Timeline View  tab by selecting 
or clearing the check boxes next to each project or demand.
You can search for specific demands and projects in the timeline by applying filters using the 

Filter( ) icon.
The number of selected project and demands is updated in the Selected Items  section of the 
Overview  tab.

5. Optional:  Review the external dependencies between the selected projects in your portfolio.
For more information, see Review external dependencies between projects.

6. Review the information in the Overview section on the right, and the Resources  tab to evaluate 
and adjust your selection of the demands and projects to be included in the plan.
Review the following sections in the Overview  tab:

◦ Total budget versus the targets that you entered in the Set Target  stage in the Budget vs. 
Target  section for annual type planning. If the total budget is more than the target cost, an 
exception icon ( ) is shown with the total planned cost.

◦ Total planned cost for all the projects and demands for multi-year type planning in the Total 
Planned Cost  section.

◦ Potential benefit amount that would accrue on execution of the selected demands and 
projects in the Benefit Amount  section.

Note: 
For multi-year resource capacity type planning, the total value of planned cost and 
benefit for the entire duration of the projects or demands is displayed irrespective of 
the selected planning window.

◦ Strategic alignment of your portfolio by viewing the number of demands and projects that 
are not associated with any organizational strategy or goal in the Unaligned  section.

◦ Number of assignment groups where, for any quarter of the selected fiscal year, the number 
of requested hours is greater than the total hours capacity in the Overallocated Groups 
section.

◦ Review how much in actuals have been spent on the projects selected for execution and the 
rest of the projects in your portfolio in the Actuals  section.

Note: 
For multi-year resource capacity type planning, the actuals value is displayed in the 
widget without the selected and unselected project actual legends.

The following image shows an example of how the portfolio information is displayed in the 
Overview section for annual type planning.
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The following image shows an example of how the portfolio information is displayed in the 
Overview section for multi-year type planning.
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Review the following sections of the Resources  tab:

View percentage of utilization for all the resources requested by the selected demands and 
projects of the portfolio in a heat map. You can view the percentage utilization of all resource 
groups or overallocated resource groups in months or quarters.

Tip: 
Click any cell in the heat map to view the project or demand associated with the selected 
resource group.

The following image shows an example of how the resource information is displayed in the 
heat map.
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Tip: 
To bring the planned cost within the target budget and the resource utilization within 
100%, consider deselecting a few low-priority demands or projects. Deselected demands 
and projects could then be moved over to a different fiscal period

7. Optional:  Review the capex and opex budget for individual projects and demands directly 
using Capex Budget  and Opex Budget  columns and revise it if necessary.

Note: 

Click the Show or hide columns ( ) in the Timeline View  tab and add the Capex 
Budget  and Opex Budget  columns if these columns are not visible.

8. Optional:  Update the name and short description by clicking the edit icon ( ) and making 
the modifications.

9. Optional:  Delete the scenario by clicking the delete icon ( ).

10. Optional:  Convert the selected scenario to become the current plan by clicking Confirm.

11. Optional:  Create more planning scenarios to compare them.

12. Optional:  Manually refresh the cost and resource widgets after a demand or a project is 

selected or cleared for execution by clicking the Refresh icon ).

What to do next
Compare planning scenarios to analyze different combinations of projects and demands and 
select a scenario that best aligns with your organizational goals. For more information, see 
Compare planning scenarios.
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Review external dependencies between projects

Review the external dependencies between projects in a portfolio to track projects that are 
dependant on each other more closely.

Before you begin
Role required: it_portfolio_manager
Open demands and projects in the timeline view of the Portfolio Planning Workbench.

About this task
As a portfolio manager, you may want to know the projects which are dependent on each other 
so that these projects can be tracked more closely.
For example, project B is dependent on project A (external soft dependency) and you want to 
make sure that project A is executed on time so that the schedule of project B is not affected. The 
Dependencies  column shows that there is an outgoing external dependency from project A and 
an incoming external dependency to project B. You can the use the incoming dependency to 
determine whether a delay in project A will affect project B.

Procedure

1. Click the show or hide columns in gantt icon ( ) in the timeline view and add the 
Dependencies  column if it is not visible.
The number of incoming and outgoing external dependencies are displayed, if any.

2. Click the external dependency in Dependencies  column for the project.

3. In the Dependencies  pop-up dialog, click a tab to review the dependency:

Inbound tab

Tasks that have an incoming dependency from a project are listed.

Outbound tab

Tasks with an outgoing dependency to the project are listed.

Example of external dependencies between projects

4. Click the project number in a tab to open and review the linked project in the planning console 
view.
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Rank demands and projects

Rank demands and projects to prioritize demands and projects for their approval and execution 
within a portfolio.

Before you begin
Role required: it_portfolio_manager

About this task
By default, the Rank By Score list ranks demands and projects based on system-generated 
scores. Rank of a demand or project is specific to a fiscal year. A project can be ranked as third in 
FY17 but ranked sixth in FY18.

Procedure

1. Navigate to Portfolio Planning Workbench from either of two starting points.

2. Optional:  Adjust the rank automatically or manually.

Example:
The following table explains manual adjustment of ranks.

Scenario for edit rank Rank update Rank before manual edit Rank after manual edit

If initial rank is 0 or 
blank and other ranks 
are present, then after 
edit, the successive 
ranks get incremented 
by 1.

• Initial rank: 0

• Edited rank: 2

• Task_1: 0

• Task_2: 1

• Task_3: 2

• Task_4: 3

• Task_2: 1

• Task_1: 2

• Task_3: 3

• Task_4: 4

If initial rank > edited 
rank, then after edit, 
the successive ranks 
get incremented by 1.

• Initial rank: 4

• Edited rank: 1

• Task_1: 1

• Task_2: 2

• Task_3: 3

• Task_4: 4

• Task_4: 1

• Task_1: 2

• Task_2: 3

• Task_3: 4

If initial rank < edited 
rank and there is no 
gap in rank sequence, 
then after edit, the 
previous ranks get 
decremented by 1.

• Initial rank: 1

• Edited rank: 3

• Task_1: 1

• Task_2: 2

• Task_3: 3

• Task_4: 4

• Task_2: 1

• Task_3: 2

• Task_1: 3

• Task_4: 4

If initial rank < edited 
rank and there is a 
gap in rank sequence, 
then after edit, the 
successive ranks get 
incremented by 1.

• Initial rank: 1

• Edited rank: 4

• Task_1: 1

• Task_2: 2

• Task_3: 4

• Task_4: 5

• Task_2: 2

• Task_1: 4

• Task_3: 5

• Task_4: 6
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Compare planning scenarios

Compare various planning scenarios with your current or default plan to assess different 
combinations of projects and demands in your portfolio for execution. You can perform a what-if 
analysis and determine the planning scenario that optimally achieves the target budget and uses 
your resources.

Before you begin
Ensure that you have created up to four planning scenarios and selected projects and demands 
for execution. For more information, see Create planning scenarios  and Select demands and 
projects for portfolio planning.

Role required: it_portfolio_manager

Procedure

1. Navigate to Portfolio Planning Workbench from either of two starting points.

2. In the Plan  tab of the Portfolio Planning Workbench, click Compare Scenarios.
The Compare Scenarios page displays all the planning scenarios.

3. Compare different aspects of the scenarios such as costs, number of projects and demands, 
benefit amount, and actuals for the selected projects and demands.

4. Compare the variance between the scenarios for costs, number of projects and demands, 
benefit amount, actuals for the selected projects and demands, and so on.
The variance value for different fields is displayed in red or green color. For example, if the 
planned cost of a scenario is greater than the planned cost of the confirmed plan, the planned 
cost variance is displayed in red. Or if the benefit amount of a scenario is greater than the 
benefit amount of the confirmed plan, the benefit amount variance is displayed in green.

What to do next
Confirm a scenario that best aligns with your organizational objectives, optimally achieves your 
target budget, and uses your resources. For more information see, Confirm a planning scenario.

Confirm a planning scenario

Select and confirm a scenario to allocate budget and resources for executing the selected 
demands and projects in a fiscal year.

Before you begin
Ensure that you have created up to four planning scenarios and selected projects and demands 
for execution. For more information, see Create planning scenarios  and Select demands and 
projects for portfolio planning.

Role required: it_portfolio_manager

Procedure

1. Navigate to Portfolio Planning Workbench from either of two starting points.

2. In the Project Planning Workbench, confirm a scenario as your current plan for the fiscal year 
using one of the following options:

◦ Select a scenario and click Confirm.

◦ Click Compare Scenarios  and, in the Compare Scenarios page, click Confirm Scenario.

◦ If you are overriding an already confirmed plan , click Override.
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3. In the Confirm dialog box, set additional options to be performed on the selected demands 
and projects after the planning scenario is saved.

Note: 
When a confirmed plan exists, the name of the dialog box is Override Selection rather 
than Confirm.

◦ If the project property  Create project(s) on confirming demands from portfolio workbench 
is set to false, you can choose to approve all the selected demands after the save by 
selecting Approve all selected demands (if not approved already).

◦ If the project property  Create project(s) on confirming demands from portfolio workbench 
is set to true, you can choose to convert the selected demands to projects after the save by 
selecting Convert all the selected demands to projects.

◦ Confirm the resources for selected demands and projects by selecting Confirm resources 
for selected demands or projects.

◦ If the confirmed and allocated resource plans associated with the demands and projects 
that are newly unselected do not have any actual hours associated with them, then select 
Unconfirm the resources for the unselected demands and projects (only those resources 
where there is no actual hours/cost captured will be unconfirmed)  to change the state 
of such resource plans to requested. If the confirmed and allocated resource plans have 
actuals associated with them, a notification is send to the project or demand managers 
specifying that they need to manually release such resources.

◦ Delete all the unconfirmed working scenarios after confirmation of the selected scenario by 
selecting Delete all working scenarios. This option is selected by default.

4. Click Save.

Result
Budget is allocated to selected demands and projects. The remaining demands and projects are 
removed from execution. However, resources already confirmed for the unselected demands and 
projects are not removed automatically.

Track the progress of a portfolio

After confirming a scenario to complete planning of your portfolio, track the progress of the 
portfolio. You can also monitor the status of cost, resource, schedule, and scope for the selected 
fiscal period or planning window for the portfolio.

Before you begin
Role required: it_portfolio_manager

Procedure

1. Navigate to Portfolio Planning Workbench from either of two starting points.

2. In the Portfolio Planning Workbench, click the Track  tab.
The status of projects and demands is displayed in the Timeline View  tab with a Gantt chart 
over time and a KPIs  tab.

3. Track the progress of your portfolio by reviewing the status of key parameters in the Timeline 
View  tab.
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◦ Details such as planned and actual costs, variance, planned and end dates, and priorities for 
the selected demands and projects.

◦ Identify the projects that are dependent on each other by viewing external dependencies 
between projects in a portfolio. For more information, see Review external dependencies 
between projects.

◦ Track the current status of an individual project by viewing the latest project status report by 
selecting the Status Report  option.

◦ Track the progress of project tasks in an individual project in your portfolio using the 
Planning Console  option. This option is available in the context menu for a project.

4. Check status information such as the overall health, schedule, cost, resources, and scope of 
all selected projects in the portfolio in the Project KPIs  tab.
The most recent status report created for a project populates this information. Point to a status 
indicator to view comments entered by the project manager for that KPI.

Note: 
A grey X icon ( ) next to any project KPI indicates that the project manager has not 
entered any comments for that aspect in the status report.

5. Review cost and resource-related information in the Cost (Budget vs. Actual)  and Resource 
(Allocated vs. Actual)  charts.

◦ View the comparison of actual costs from all selected projects in the portfolio with the 
planned cost shown in the Cost (Budget vs. Actual)  chart. The actual cost for projects is 
derived from the expense lines.

Note: 
The Cost (Budget vs. Actual)  graph is not available for multi-year type planning.

◦ You can view only Capex or Opex or both by selecting the respective option from the list.

◦ Check how the allocated resources are being used by viewing the comparison of actual 
resource time spent on all project tasks with the resource hours allocated to execute the 
selected projects and demands in the portfolio shown in the Resource (Allocated vs. 
Actual)  chart. The actual time spent is taken from processed time cards for the projects.

6. Track the risks, issues, decisions, actions, and the project change requests across all selected 
projects in the portfolio by going to the Risks, Issues, Decisions, Actions, and Changes  tabs.

Portfolio Dashboard

Portfolio Dashboard provides a central location to a portfolio manager to generate different 
graphical reports of the portfolios.

From Madrid release onward, the portfolio manager dashboard has been deprecated and 
replaced with the PMO dashboard. Use the PMO dashboard to gain insights about your 
portfolios. For more information, see PMO Dashboard.

Access the Portfolio Dashboard

View different graphical reports on the PMO Dashboard.

Before you begin
Role required: it_portfolio_manager
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Procedure

Navigate to Project  > Portfolios  > Portfolio Dashboard.
The PMO Dashboard is displayed.

Program Management
A program helps you to logically group related projects or demands under a single entity. The 
ServiceNow®  Program Management  application helps you to manage related projects and 
demands in coordinated way which is not possible when projects and demands are managed 
independently.

The it_program_manager role  is essential to be able to manage programs. The Program 
Management  application provides the following capabilities to the program manager:

• Create a program by adding related projects and demands.

• Create tasks specific to the program. These tasks are essential for completion of the program 
but are outside the scope of projects.

• Define key milestones, anticipated risks, and issues for the program.

• Monitor the progress and status and of all the projects and demand that are part of the 
program. Program manager can track the costs, resources, and schedules.

When you create a program, consider:

• A program can be part of a portfolio or can be a generic standalone program that is not part of 
any portfolio.

• A program cannot be part of multiple portfolios.

• A project or demand cannot be part of multiple programs.

• You can have projects and demands that can directly be part of a portfolio and not part of a 
program.

The following diagram illustrates how you can implement programs.

Program implementation
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Basics of Program Management
When you create a program, you can add multiple projects or demands to it. If you have created 
cost plans for the projects and demands, certain values are rolled up from the cost breakdown 
of program. At the same time, the risk and issues of the projects and demands are also included 
with the program. The following diagram illustrates how information in the program is related to 
the projects and demands that are part of the program.

Information population in program

Project workbench provides graphical charts to view and monitor the progress of the program 
and the projects and demands that are part of it. You can also view the progress of a program, 
projects, and demands against a timeline with the details of milestones and key milestones.

The project manager dashboard provides a central location to a program manager to generate 
different graphical reports of programs and the program financials.

Creating programs: approval and business case workflow

Programs in ServiceNow®  follow a different creation pattern than projects:

Why programs don't typically come from demands

• Demand workflow: demand → approval → convert to project

• Program workflow: strategic initiative → executive approval → create program 
directly

• Programs are strategic multi-project containers decided at executive/portfolio 
level, not operational demands. They represent multi-year transformations such 
as digital transformation and cloud migration, rather than single deliverables.

Recommended program approval workflow

1. Strategic planning phase: Create Initiative planning item in Strategic Planning  for 
the strategic program

2. Business case development: Attach business case document to Initiative; define 
scope, budget ($1M+), timeline (2-5 years)

3. Executive approval: Present Initiative with business case to steering committee or 
executive sponsor for approval
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4. Program creation: After approval, create Program record in PPM with reference to 
approved Initiative

5. Project breakdown: Create constituent projects under the program (these can 
come from demands)

Alternative: Demand-based program creation (if needed)

If your organization requires formal demand intake for programs:

1. Create Demand with Category  as Program Request.

2. Attach program business case to Demand.

3. Route through demand approval workflow.

4. After approval, manually create Program (no automatic conversion like 
demand→project).

5. Link Program to source Demand via reference field.

Program vs Project decision criteria:

• Use Program when: Multi-project initiative, $1M+ budget, 2+ year duration, cross-organizational 
scope

• Use Project when: Single deliverable

Create a program to manage projects and demands

Create a program to manage related projects and demands. Define the duration, estimated cost, 
benefits, and ROI to the organization.

Before you begin
Role required: it_program_manager

Procedure

1. Navigate to All  > Project  > Programs  > Create New.

2. On the Program form, fill in the fields.

Program form

Field Description

Program 
Name

Name of the program.

Program 
manager

Program manager assigned to the program.

Number System-generated number with a configurable prefix.

Portfolio Portfolio to which the program belongs.

If you do not select a portfolio for the program, the program becomes a global 
program. You can associate the projects and demands in a global program with 
any portfolio.

Priority Priority associated with the program.
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Field Description

Status Status of the program. This information rolls up from the status of all the projects 
that are part of this program.

State Current state of the program.

Default states: Pending, Open, Work in Progress, Closed Complete, Closed 
Incomplete, Closed Skipped.

Note: 
Set the state of the program to Closed manually. The program state does 
not roll up to a Closed state when program tasks, projects, and demands 
move to Closed state.

Phase Current phase of the program such as Initiating, Planning, and Executing.

Business 
Unit

The business unit to which this program belongs.

Investment 
Type

Investment type of the program.

The default available options are Cost Reduction, End User Experience, Legal 
and Regulatory, Revenue Generating, Service Sustaining, and Strategic 
Enabler.

Impacted 
Business 
Units

Business units of the organization that this program affects.

Strategies Strategic objectives of the organization that the program fulfills. A program can 
fulfill multiple strategic objectives.

Note: 
Leave this field empty if the program does not fulfill any strategic objective.

Goals Goals associated to the selected strategy. A program can fulfill multiple goals.

If you do not select a strategy, then the Goals list displays all goals in the 
system.

Note: 
Leave this field empty if there are no goals associated with the program.

Description Detailed description of the program.

Dates section of the Program form

Field Description

Planned start date Intended program start date. If the start date 
of associated program tasks, projects, and 
demands is earlier than the program start 
date, the start date is adjusted to an earlier 
date.

Removal of a demand or project from the 
program does not affect the planned start 
date of the program.
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Field Description

Planned end date Intended program end date. The end date 
extends based on the end date of the 
program tasks, projects, and demands.

Removal of a demand or project from the 
program does not impact the planned start 
date of the program.

You can adjust the program end date 
manually, based on the start and end date 
of the associated program tasks, projects, or 
demands.

Note: 
If a demand with end date later than the 
program end date is added, the Planned 
end date field becomes read only.

Planned duration Expected duration of this program. The 
planned duration changes based on the 
changes in planned start or end date of the 
program.

Actual start date Date on which the program actually starts.

Actual end date Date on which the program actually ends.

Actual duration Actual duration of the program from program 
start to program closure.

Financials section of the Program form

Field Description

Total planned cost Estimated cost of the program.

If there is operational expenditure and capital 
expenditure associated to the program, 
then planned cost is sum of operational 
expenditure and capital expenditure, which is 
in functional currency.

Planned capital Capital expenditure (Capex) for the program. 
If there are no cost plans associated to 
the program, the Capital expense  field is 
editable. Select a currency type and enter a 
value.

Planned operating Operational expenditure (Opex) for the 
program. If there are no cost plans associated 
to the program, the Operational expense 
field is editable. Select a currency type and 
enter a value.

Budget cost Budgeted cost for this program.

Actual cost Actual cost of the program.
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Field Description

The value rolls up from the cost plan 
breakdowns from projects and demands in 
the program.

Planned benefit Planned benefit value for the program.

This value rolls up from the benefit plan 
breakdowns of the program.

You can also enter the value manually. Select 
a currency from the Currency Type list and 
enter a value.

Planned returns Planned returns is based on the difference 
between planned benefit and planned cost.

Planned ROI% The result is derived from the values in the 
Planned return  and Planned cost  fields.

The formula is: planned return / planned cost 
x 100.

Score The program score is based on the individual 
scores of the following attributes: risk score, 
value score, and size score, which in turn 
are calculated based on risk, planning ROI%, 
and estimated cost attributes (on a program) 
respectively.

Note: 
You can configure the formula for score 
calculation.

Risk Risk associated with the program.

3. Click Submit.

What to do next
Use the following related links and lists:

Program form related links

Field Description

PMO 
Dashboard

Access the PMO dashboard  to view comprehensive reports of the projects and 
demands in the program.

Program 
Budget

Allows you to allocate the budget  to the program.

Program 
Workbench

Access the Program workbench  to view details of the projects, demands, and 
program tasks associated with the program.

Status 
Report

View the most recent program status report  or create a new program status 
report.
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Program form related lists

Field Description

Program Tasks View the list of all associated program tasks.

To create a new program task, click the New 
button. For more information, see Create a 
program task.

Projects View the list of projects included in the 
program.

To create a new project, click New. For more 
information, see Define a project.

To add existing project to the program, click 
Edit.

If you want to create parent-child relationships 
between projects to establish project 
hierarchies select the parent project in 
the Parent  field. This organizes large 
initiatives into manageable subprojects while 
maintaining consolidated visibility.

The subproject now rolls up to the parent 
project. Progress, costs, and timelines 
contribute to parent project metrics.

Tip: 

Use project hierarchies when large 
initiatives require multiple work streams. 
Parent project = program-level view; 
subprojects = tactical execution.

Demands View the list of demands included in the 
program.

To create a new demand, click New. For more 
information, see Create a demand.

To add existing demand to the program, click 
Edit.

Risks View the list of risks associated with the 
projects and demands of the program or the 
program itself.

To create a new risk, click New.

Issues View the list of issues associated with the 
projects and demands of the program or the 
program itself.

To create a new issue, click New.
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Program form related lists  (continued)

Field Description

Cost plans View the list of all cost plans for projects and 
demands that are part of the program.

Benefit Plans View the list of all benefit plans for projects 
and demands that are part of the program.

Program Budget View the program budget according to fiscal 
years. Click the amounts in the list to revise 
them.

Program Status Reports View the list of status reports for the program.

To generate a new status report, click New. For 
more information, see Create a program status 
report.

Create a program task

You can create program tasks from the Program form related lists.

Before you begin
Role required: it_program_manager

About this task

Procedure

1. Navigate to Project  > Programs  > All.

2. Select the program from the list.

3. In the Program Tasks related list, click New.

4. Fill out the form fields (see table).
There are a few fields that are populated after the task is created.

5. Click Submit.

Result
The new task appears in the Program Task  related list on the Program form.

Program Task form

Field Description

Short 
description

[Required] A brief description of the program task.

Number A system generated number with a configurable prefix.

State The current state of the program. The states include: Pending, Open, Work in 
Progress, Closed Complete, Closed Incomplete, Closed Skipped.

Planned start 
date

The estimated date and time for the program task to start.

Planned end 
date

The estimated date and time for the program task to end.
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Program Task form  (continued)

Field Description

Planned 
duration

The estimated length of time (from start time to end time) of the program task.

Assigned to The user assigned to the program task.

Milestone A milestone is a program task with a duration of zero (0). Use milestones to mark 
key dates in your program, such as key decision points or approvals.

Key 
milestone

You can define a milestone as a key milestone to track the program progress. 
For example, you can create key milestone for completion of deliverables such 
as a program plan. A key milestone is visible on the program timeline.

Description A detailed description of the program task.

Additional 
comments 
(Customer 
visible)

Enter information that you want the users to see.

Work notes Enter work notes about the milestones, impediments, or changes as the 
program progresses.

Note: 
Users with the business stakeholder role for PPM can view this field. For 
more information, see Business stakeholder role for PPM.

Fields populated and updated after the task is created

Field Description

Actual 
start 
date

The date that this program started. This date is populated after you update the 
program state to Work in Progress.

Actual 
end date

The date that this program ended. This date is populated after you update the 
program state to Closed Complete.

Actual 
duration

The actual duration of the program from program start to program closure. As with 
planned duration, the actual duration shows total program time.

Allocate budget to a program

Set the budget of a program according to the fiscal years.

Before you begin
Role required: it_portfolio_manager

Procedure

1. Open the program form.

2. In the related links, click Program Budget.
The Program Budget  dialog box opens.

3. Select the year for which you want to set the budget for the program.

4. Enter the amounts for Capex Budget  and Opex Budget.
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The Total Budget  is updated with the sum of capex and opex amounts.

5. Click OK.

Result
The program budget for the selected year appears in the Program Budget  related list. You can 
click the amounts in the list to revise them.

Create a program status report

Create a program status report periodically to view a status rollup of the projects in the program. 
When you create a status report, the status for different aspects of the program is rolled up from 
the project status reports of all projects.

Before you begin
Ensure that the Show on Program Status Report  option in the Project form for all the projects 
that you want to include in the status report is selected.

Role required: it_program_manager

Procedure

1. Navigate to Project  > Programs  > All.

2. In the program list, open a program record.

3. In the Program Status Reports  related list, click New.

4. On the form, fill in the fields.

Note: 

Changing the status for any aspect in the Program Status Report form also updates the 
corresponding fields in the Program form.

Program Status Report form

Field Description

Program Name of the program.

Status Date Date until which you want to generate the status report.

Default value is the current date.

Number System-generated ID number for the status report with a configurable prefix.

Read-only fields rolled up from the Program form

Field Description

State Current state of the program such as 
Pending, Open, or Work in Progress.

Percent complete Percentage of the program completed.

Planned start date Planned start date of the program.

Planned end date Planned end date of the program.

Actual start date Actual start date of the program.

Actual end date Actual end date of the program.
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Field Description

Planned cost Estimated cost of the program.

Actual cost Actual cost of the program.

Overall Status section of the Program Status Report form

Field Description

Overall health Overall health of the program rolled up from 
the latest status report of each project in the 
program. The status is indicated using red, 
green, and yellow colors as the default.

Executive Summary Brief summary and analysis of the program.

Comments Comments about the overall status.

Last Week's Achievements Description of key tasks completed or any 
significant progress in the program in the last 
week.

Key Activities planned Next planned activities for the program.

Schedule section of the Program Status Report form

Field Description

Schedule Status of the program schedule rolled up 
from the latest project status report of each 
project in the program. The status is indicated 
using red, green, and yellow colors by default.

Comments on Schedule Information related to the program schedule.

Cost section of the Program Status Report form

Field Description

Cost Status of the program cost rolled-up from the 
latest project status report of each project 
in the program. The status is indicated using 
red, green, and yellow colors by default.

Comments on cost Information related to the program cost.

Resources section of the Program Status Report form

Field Description

Resources Status of resources rolled-up from the latest 
project status report of each project in the 
program. The status is indicated using red, 
green, and yellow colors by default.

Comments on Resources Additional information related to program 
resources.
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Scope section of the Program Status Report form

Field Description

Scope Status of the program scope rolled up from 
the latest project status report of each project 
in the program. The status is indicated using 
red, green, and yellow colors by default.

Comments on Scope Information related to the program scope.

5. Optional:  Select a different status color to override the rolled-up color for various aspects of 
the program or select None  if you do not want the status of an aspect to appear in the program 
status report.

(Optional) Selecting None  displays a grey X icon ( ) for that program aspect on the program 
status report.

The override color that you set is not retained from one report to next. When the next program 
status report is generated, it takes the color from the associated projects.

6. Select Submit.

View program status reports

Program status reports provide the up-to-date at-a-glance progress of all the projects in the 
program in several categories.

Before you begin
Role required: it_program_manager

About this task
Use the Program Status Report  related list to view the program status reports created for the 
program. If no report is listed, create a program status report.

Procedure

1. Navigate to Project  > Programs  > All.

2. In the program list, open a program record.

3. Select the Status Reports  related link.

4. Select a status report from the top-left corner of the page to view its contents.

5. Review the program status in the report.

Program status report

Section Description

Overview Provides general overview information about the program:

◦ Program Name: Name of the program.

◦ Program Manager: The program manager.

◦ Portfolio: The portfolio to which the program belongs.

◦ Business Unit: The business unit to which the program belongs.

◦ Investment Type: Investment type of the program.
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Section Description

◦ Impacted BU: Business units of the organization that this program affects.

◦ State: Current state of the program.

◦ Phase: Current phase of the program, for example, Initiating, Planning, and 
Executing.

◦ % Complete: Percentage of the program completed.

◦ Planned Start Date: Planned start date of the program.

◦ Planned End Date: Planned end date of the program.

◦ Planned Cost: Estimated cost of the program.

◦ Actual Start Date: Actual start date of the program.

◦ Actual End Date: Actual end date of the program.

◦ Actual Cost: Actual cost of the program.

This information rolls up from the Program form.

Summary Information about the overall health of the program from the most recent status 
entered by the program manager for the project.

◦ Executive Summary: Brief summary and analysis of the program.

◦ Last Week's Achievements: Progress of the program in the previous week.

◦ Key Activities Planned: Next planned activities for the program.

Current 
Status

Status of program related to overall health, schedule, cost, resources, and scope 
that is rolled up from the latest project status reports of all projects in the program.

If there are multiple project status reports for each of these projects, the values 
from the latest project status report of each project are aggregated and rolled up 
to the program status. For more information, see Program Status Report form.

Different colors indicate the status of above aspects. The rolled-up color for the 
final status is in the order red, yellow, and green by default. If there are projects in 
red, yellow, and green, then the program status is red. If there are projects only in 
yellow and green, then the program status is yellow.

The following image illustrates the color codes for the program status rolled up 

from the project.

Note: 
A grey X icon ( ) for any program aspect means that the program manager 
has excluded that aspect from the status report.

Project 
KPI Status of the Key Performance Indicators for overall health, schedule, cost, 

resources, and scope for each project in the program. Only projects for which the 
Show on Program Status Report  option in the project form is selected are listed.

The value of these KPIs roll up and are shown in the Current Status section of the 
program status report.
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Section Description

Note: 
A grey X icon ( ) next to any project KPI means that the project manager 
has excluded that aspect from the status report.

6. Optional:  If you need a printed copy of the report, click the print icon ( ) in the header of 
Status Report  tab.

Example: Program status report

Program workbench

The program workbench is a central location for viewing details of a program and the projects 
and demands that are part of the program.

The program manager role can use the program workbench to view and monitor the progress of 
the program and the projects and demands. Program workbench provides information for only 
tracking the program.

You can track the progress of demands and projects, and monitor the status of cost, resource, 
schedule, and scope for the selected fiscal period for the program.
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Note: 

• Program workbench is based on Service Portal which means that you can configure, 
customize, and extend it as per your requirements and organizational workflow. For more 
information, see Service Portal  documentation.

• Program workbench does not support mobile device.

The program workbench comprises of the following components:

Fiscal period: A choice list on the top-right to select the fiscal year for which you monitor the 
program.

Timeline View: Shows a list of all the selected demands and projects that are part of the 
program, and a Gantt chart of all projects and demands over time.

You can:

• configure the colors of the program items in Gantt chart with Dashboard Configuration  settings.

• select the zoom level in Gantt chart calender to Auto Fit. The Gantt view fits in one page to 
view entire timeline in one go without using the scrollbar.

• review the external dependencies between projects in a program.

• select the show/hide icon ( ) to show or hide columns.

Note: 

• A demand is included in the timeline view only if the Expected Start  and Due Date  fields 
are populated and if the demand is in qualified or approved state.

• Admin can customize  which columns appear in the column filter list when the show/hide 

columns icon ( ) is clicked in the timeline view.

Project KPI: The tab displays the most recent status of project KPIs such as overall health, 
schedule, cost, resources, and scope of all the projects in the program. This information is 
populated from the most recent status report  created for the projects.

You can:

• click the name of a project in the tab to open the latest status report created for the project.

• point to a status indicator for a project KPI to view the comments entered for the KPI for that 
project.

Cost (Planned vs. Actual): The chart displays the actual costs from all projects in the program 
compared to the approved budget. The actual cost for projects is derived from the expense lines.

Note: 
An expense line can be created manually for a project when a specific expense is incurred. 
For example, if hardware is procured for a project, an expense line can be created for 
the amount spent on procuring the hardware. If you receive an item using ServiceNow 
Procurement, an expense line is created automatically. For resource hours, the expense 
lines are created automatically when the time cards for the project are approved.

The display settings for the chart can be modified by selecting any of the following from the 
choice list:
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• Capex: Displays the cost chart for capital expense only.

• Opex: Displays the cost chart for operating expense only.

• All: Displays the cost chart for both capital and operating expenses.

Resource (Allocated vs. Actual): The chart displays the actual resource time spent on all project 
tasks versus the resource hours allocated to execute the projects and demands in the program. 
The actual time spent is taken from processed time cards for the projects.

Program Workbench Example 1

Program Workbench Example 2

Access the program workbench

When you access the program workbench, it displays a list of all the programs.

Before you begin
Role required: it_program_manager
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About this task
You can access the program workbench in one of the following ways.

Procedure

1. Click the Program Workbench  related link on the Program form.

2. Navigate to Project  > Programs  > Workbench  and click the configuration icon ( ) and select 
the colors for projects, tasks, programs, and so on.
The workbench uses these colors to display the items in the program in the Gantt chart in 
timeline view.

3. Click the program that you want to open.
The programs that are displayed in the workbench depend on how you launched the program 
workbench.

◦ All programs are available in the workbench using the navigation menu option.

◦ Only the associated program displays using the program form.

Program Dashboard

The PMO dashboard provides a central location to a program manager to generate different 
graphical reports.

From Madrid release onward, the program manager dashboard has been deprecated and 
replaced with the PMO dashboard. Use the PMO dashboard to gain insights about your 
programs. For more information, see PMO Dashboard.

Access the Program Dashboard

View different graphical reports for your programs on the PMO Dashboard.

Before you begin
Role required: it_program_manager

Procedure

Navigate to Projects  > Programs  > Program Dashboard.
The PMO Dashboard is displayed.
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Rate Models
Use a rate model to derive date-effective, criteria-driven hourly rates for calculating planned and 
actual resource costs for a project or demand.

Unlike labor rates, which are based on the user attribute only, a rate model can derive hourly 
rates based on up to ten attributes. These attributes can be selected from predefined entities 
such as projects, demands, users, and roles.

Starting March 2026 release, you can create rate models for resource assignments based on the 
primary attributes mapping to meet with the organizational requirements.

Rate lines

A rate model is a collection of multiple rate lines. A rate line is a unique combination of different 
criteria values that defines the hourly rate for a resource, group, or role for a specific date range. 
For the same set of criteria, you can create multiple rate lines with different rates for different date 
ranges provided that the dates don't overlap.

Rate model processing

To derive hourly rates from a rate model for the resource plans and time cards of a project or 
demand, associate the rate model with the project or demand.​

Note: 
A project or demand without a rate model uses the labor rate cards associated with rate 
type to find a rate for the time cards.

The rate model associated with a project or demand evaluates the rate lines to find and return 
the hourly rate that matches the requested criteria. The rates are derived from the rate model 
during resource planning or allocation, and during time card processing.

The rate is returned in the functional currency specified in the matching rate line.

Rate model processing flow diagram

The following video describes how to set up a rate model and the evaluation method to find and 
return the hourly rate for a request.  Video explaining how to work with rate models

When a rate is requested, the rate model uses the following process.
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1. Finds the rate lines in the requested date range and discards the remaining rate lines.

2. Evaluates the identified rate lines to find values matching the requested value in the first 
criteria column and discards the remaining rate lines.

If the requested value is empty, it checks for rate lines containing NULL.

If no exact match is found, it checks for the rate line having the value All other (*).

The evaluation is repeated for the other criteria columns in order of priority until all criteria 
columns are processed.

3. Returns the rate if one or more rate lines match the request.

◦ If a single rate line is found, the corresponding rate is returned.

◦ If multiple rate lines are found, the system determines the number of hours in the request 
that applies to each rate.

◦ For example, say the rate requested is for resource allocation from July 1 to July 30. The rate 
model has one rate from July 1 to July 15 and a different rate from July 16 to July 30 for the 
same set of criteria. The rate model applies the first rate to the requested hours for July 1–15 
and the second rate to the requested hours for July 16–30.

If no rate lines match the request, then the request uses the default rate card.

Create or modify a rate model

Create or modify a rate model that can be linked to a project or demand to determine planned 
costs and actuals for their resource. The rate model provides date-effective, criteria-driven hourly 
rates for these investments.

Before you begin

• Choose the attributes to define the criteria in a rate model to derive hourly rates.

• Define the budget reference rates  for the non-functional currency for the required time 
periods.

• Role required: pps_admin or it_rate_model_admin

Procedure

1. Create a rate model.

2. On the form, fill in the fields.

Rate Model form

Field Description

Name Unique name for the rate model.

Active Option for indicating the status of the rate 
model.

Only active rate models can be assigned to a 
project or demand.
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Field Description

Default Option for setting the rate model as the 
default.

You can set only one rate model as default.

A default rate model is automatically 
associated to new projects and demands.

Rate model context Context set for the rate model.

Read-only system field.

Currency Default currency for the rate lines in the rate 
model.

Rate type Option for enabling the rate type attribute on 
rate lines in the rate model.

When selected, Rate type  is added as one 
of the attributes along with other defined 
attributes. For more information, see Rate 
type in labor rate card.

Description Short description for the rate model.

3. Click Submit.

What to do next
Add attributes from a set of predefined entities  to define the criteria for rate model to derive 
resource cost.

Define criteria of a rate model

Set the criteria of a rate model by adding attributes from a set of predefined entities to derive 
resource hourly rates based on the criteria.

Before you begin
Role required: pps_admin or it_rate_model_admin

About this task
A rate model consists of one or more rate lines. Each line contains a unique combination of 
criteria values and the hourly rate of a resource. You define the criteria by adding up to 10 
attributes from the following entities:

• Demand

• Group

• Project

• Project task

• Resource

• Resource Assignment

• Resource plan

• Role
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You can select attributes of type String, Reference, Number, Boolean, and Choice.

Procedure

1. Open a rate model by performing one of the following actions:

◦ Navigate to All  > Project Administration  > Rate Model  > All.

◦ Navigate to All  > Time Sheets  > Rate Model  > All.

2. In the Rate Model Attributes  related list, click New.

3. On the form, fill in the fields.

Rate Model Attributes form

Field Description

Entity Entity from which the attribute is used to 
define the criteria.

Attribute List of attributes from the selected entity to 
define the criteria.

Priority Unique number that determines the order in 
which attributes in a rate model are evaluated 
to derive the hourly rate.

An attribute with the lowest priority is 
evaluated first.

Note: 
Two attributes cannot have the same 
priority.

Name User-friendly name for identifying the 
attribute.

The default name populated is based on the 
selected entity and attribute. For example, 
if you select Resource in the Entity  field 
and Location in the Attribute  field, then the 
default name is Resource/Location.

4. Click Submit.

What to do next
Create rate lines to define the hourly rates for resources.

Create a rate line

In a rate model, create a rate line to define an hourly rate based on a set of criteria for a given 
date range.

Before you begin

• Define criteria and add rate model attributes

• Role required: pps_admin or it_rate_model_admin

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1766



About this task
Before creating or updating a rate line, note the following points:

• Rate lines with the same set of criteria values cannot have overlapping dates.

• A criteria field can be empty.

• All criteria fields on the form have a value All other (*)  that, if selected, is considered by 
the rate model if no exact match exists for that criteria.

• To use a non-functional (non-default) currency in a rate line, ensure that the corresponding 
budget reference rate  is available.

Procedure

1. Open a rate model by performing one of the following actions:

◦ Navigate to All  > Project Administration  > Rate Model  > All.

◦ Navigate to All  > Time Sheets  > Rate Model  > All.

2. On the Rate Model form, click the View Rate Lines  related link.

3. On the Rate Lines form, click New.

4. On the form, fill in the fields.

Rate Lines form

Field Description

Rate Model Rate model the rate line belongs to.

Start date Start date of the time period in which the rate 
is applicable.

End date End date of the time period in which the rate 
is applicable.

Criteria fields Fields corresponding to the rate model 
attributes added to define the criteria. The 
number of fields may vary.

For example, if you have added Group and 
Location as rate model attributes, they are 
available as fields on the form where you can 
specify their values.

Rate Applicable rate and currency of the rate line.

By default, the currency of the rate model to 
which the rate line belongs is selected as 
the currency. You can select a rate currency, 
which can be different from the rate model 
currency. Rate lines with the same set of 
criteria values and currency must not have 
overlapping dates.

A project or demand manager can track 
the resource cost for projects or demands 
in the corresponding project or demand 
currency by installing the PPM Standard 
Multicurrency (com.snc.ppm_multicurrency) 
plugin and enabling the Project Currency 
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Field Description

view or Demand Currency view for resource 
plans. For more information, see the Create a 
resource plan  topic.

Rate Type Labor rate type applicable for the rate line.

The field appears if the Rate type  check box 
on the Rate Model form is selected.

Rate in functional currency Rate in the default currency configured in the 
Financial Management application. This field 
is not editable.

5. Click Submit.

Result
Rate lines that represent resource hourly rates based on defined attributes are created.

Export rate lines to a file

Export rate lines to a Microsoft Excel  or CSV file to quickly update or add new rate lines and 
import them back into the rate model.

Before you begin
Before exporting rate lines, define the criteria of the rate model by adding attributes to it. The 
downloaded export file includes columns corresponding to the selected attributes and the 
following default columns:

Role required: pps_admin or it_rate_model_admin.

About this task
Besides creating rate lines  one at a time, you can add multiple rate lines into a rate model using 
the export and import rate lines functions.

• Rate Model

• Number

• Start Date

• End Date

• Currency

• Rate

• Rate Type

Note: 
The Rate Type  column is available only if the Rate type  check box is selected for the rate 
model.

The number of criteria columns depends on the number of attributes added in the rate model.
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Procedure

1. Open a rate model by performing one of the following actions:

◦ Navigate to All  > Project Administration  > Rate Model  > All.

◦ Navigate to All  > Time Sheets  > Rate Model  > All.

2. On the Rate Model form, select the View Rate Lines  related link.

3. Select the more actions icon ( ) and then select the Export to CSV  option.
A dialog box might prompt you to save or open the export file. By default, the file has the same 
name as the rate model. However, you can specify a different file name. Save the file either as a 
CSV file or Microsoft Excel (.XLSX) file.

Note: 
Depending on your browser setting, the browser might automatically save the file to your 
Download folder.

4. Open the downloaded file using your preferred application.
Enter new rate lines or update the existing ones and save the file either as a CSV file or 
Microsoft Excel (.XLSX) file.

Result
All rate lines in the rate model are exported to the file. If there is no rate line in the rate model, the 
file is an empty template containing only the column names in the first row.

What to do next
Import rate lines  from the file into a rate model.

Import rate lines into a rate model

Use the import rate lines function to quickly add multiple rate lines from an export file into a rate 
model.

Before you begin
Set the glide.import_set_row.dynamically_add_fields  system property to true.

Role required: pps_admin or it_rate_model_admin

About this task
After adding or updating rate lines in a file created using the export function, you can import the 
rate lines from the file into the rate model.

Note: 
Rate lines fail to import in the following circumstances:

• Overlapping effective dates for the same set of criteria values.

• Criteria values with no matching data in the system. For example, a rate line might have 
Business Analyst as the Role  criteria but that role does not exist in the system.

• Rates in non-functional (non-default) currency but no corresponding budget reference 
rates  for the required period exist in the system.
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Procedure

1. Import rate lines from an import file into the rate model in one of the following ways:

◦ Navigate to All  > Project Administration  > Rate Model  > Import Rate Line.

◦ Navigate to All  > Time Sheets  > Rate Model  > Import Rate Line.

◦ Navigate to All  > Time Sheets  > Rate Model  > All, open a rate model record, and click the 
Import Rate Line  related link.

2. Click Choose File  to select the import file.

3. Optional:  If you are importing from an Excel file containing multiple sheets, enter the sheet 
number that contains the data to import in the Sheet number  field.

Note: 
If you are importing from a CSV file, then the data from the last saved CSV file is 
considered for import irrespective of the specified sheet number.

4. Optional:  If the import file has a header row, enter the row number that has the header 
information in the Header row  field.

5. Click Submit.

6. Click Run Transform  to import the data.
For more information, see Run an import .

Result

• New rate lines are appended to the rate lines list in the rate model.

• Existing rate lines in the rate model are updated with the latest values.

Time Card  Management
The Time Card  Management feature enables time card users such as task assignees to report 
and track their time for the assigned tasks.

https://player.vimeo.com/video/1107432259?
h=08347ba78f&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Watch this three-minute video to learn about setup of the time tracking feature, entering time and 
approvals.

Time Card  Management works with the Task table to record time worked on various task types, 
such as projects, incidents, problems, and change requests.

With the Time Card  Management feature:

• The time card users can record the time worked on a task using time cards  and time sheets. 
They can submit their time cards and time sheets for approval.

• Time cards and time sheets are routed for approval based on the Non-project time approver 
and Project time approver  fields in the user time sheet policy. User managers with time card 
approver role can also log time and submit the time sheet of their resources

• The time card approvers can perform the following tasks:

◦ Review and approve or reject the time cards in a submitted time sheet.

◦ Recall the approved time sheets or time cards to return them to the users for corrections.
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◦ Use dashboards to view reports of time card and time sheet exceptions, and categorize time 
reported by the users.

◦ Delegate another time card approver to process time sheets from your resources when you 
might not have time or will be unavailable. Note the following points for delegation:

▪ You cannot delegate approval only for an individual resource.

▪ The delegated time card approver cannot further delegate your time sheet approvals.

The project_manager and the resource_manager roles contain the timecard_approver role 
in the base system. However, the timecard_approver role can also be used independently 
without these roles.

• The time card admin can create and manage time sheet policies, and can also approve or 
reject by exception and process the time sheets. Time card admin can also create or edit time 
cards of any users if the time cards are in Pending or Rejected state.

Note: 
The Time Card  Management plugin  is required to use time cards. Some of the procedures 
require the project management feature, which activates time cards automatically. For more 
information, see Project Management  (com.snc.financial_planning_pmo).

Domain separation in Time Card  Management

Domain separation  provides complete data isolation for domain-specific users. Time card 
Management is domain separation compliant at the Data only  level.

Activate Time Card Management

Administrators can activate the Time Card  Management plugin (com.snc.time_card). The plugin 
also activates the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards 
plugin (com.snc.pa.time_card). However, you need a Performance Analytics  license to use the 
dashboards.

Before you begin
Role required: admin

About this task
Note: 
The Time Card  Management plugin also gets activated as part of PPM Standard  plugin 
(com.snc.financial_planning_pmo).

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.
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Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Time sheet policies

Time sheet policies contain the policies to which a time sheet, or a time card must adhere.

By default, the Default time sheet policy is available with the system. As a Time card admin, you 
can create multiple time sheet policies based on different requirements and workflows in your 
organization. For example, specify a time sheet policy for each department or team and assign 
appropriate users to them.

Time sheet policies also provide an ability to specify appropriate approval workflow for project 
and non-project tasks.

A time sheet policy can be set as a default policy. The default policy is a global time sheet policy 
which applies to all the users who are not assigned to any other time sheet policy. Only one time 
sheet policy can be set as a default policy.

Navigate to Time Sheets  > Administration  > Time Sheet Policies  to view the list of timesheet 
policies.

Create a time sheet policy

As a time card administrator, you can create a time sheet policy to define the requirements for 
time card users to record their time worked. The time card approvers must review and process 
time sheets under the applicable time sheet policy.

Before you begin
Role required: timecard_admin

Procedure

1. Navigate to All  > Time Sheets  > Administration  > Time Sheet Policies.

2. Click New.

3. On the form, fill in the fields.

Time Sheet Policy form

Field Description

Name
Unique name of the policy.

Allow blank 
time cards Option to enable submission of blank time cards for approval.

By default, this option is not selected.

Auto create 
time card on Option to create a time card automatically when you update a planned task, 

if the following conditions are true:
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Field Description

planned task 
update

◦ You are a time card user

◦ You are assigned to the task through Assigned to  or Additional assignee 
list  field

◦ The task is not in a pending state.

By default, this option is not selected.

Auto fill time 
card with time 
worked entries

Option to fill in time cards automatically when you enter time in the Time 
worked  field on the Task form.

If a time card does not exist for the task, one is created when the time 
worked is updated if the following conditions are true:

◦ You are a time card user.

◦ You are assigned to the task through the Assigned to  or Additional 
assignee list  field.

By default, this option is not selected.

Auto create 
time cards 
every week

Option to generate time cards automatically  every week through a 
scheduled job for all users assigned to the time sheet policy. The time 
cards are generated based on the planned task assignments and hard-
allocated resource plans of the users.

By default, this option is selected.

Update actual 
hours and cost 
in resource 
plan/reports

Option to update actual hours and actual cost of the associated resource 
plan based on the hours entered in the approved time card.

When selected, you can associate a resource plan related to the selected 
task with the time card in the following ways:

◦ If the task has multiple resource plans, you can select the appropriate 
plan.

◦ If the task has one resource plan, that plan is selected by default.

The hours from the time card entry and the hourly resource rate are used to 
update the Actual hours  and Actual cost  values of the associated resource 
plan.

Note: 
If the task has no resource plan, the associated records update the 
corresponding project.

By default, this option is not selected.

Allow recall
Option to enable the recall action on a time sheet or time card after it is 
approved and processed.

By default, this option is selected.
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Field Description

Recall period 
allowed (days) Number of days within which you can recall a time sheet or time card.

This field appears when the Allow recall  option is selected.

The default value is 30.

Week starts on
Start day of the week for the time sheet.

The default value is Sunday.

Note: 
For more information on filtering Time Sheets using this field, see 
KB0852458  article in Now Support  Knowledge Base.

Maximum 
hours per day Maximum number of hours that can be entered each day in a time sheet.

The default value is 24.

Setting this field to -1 enables the resource to enter:

◦ A value from 0 through 24 for the hours worked each day

◦ A negative value, to correct the previously entered timecards.

Maximum 
hours per week Maximum number of hours allowed in a week in a time sheet.

The value for total hours for a week in a time sheet is the sum of hours 
entered per day of that week. If set to -1, the total hours per week allowed is 
up to 168 (24 x 7) hours.

The default value is 40.

Non-project 
time approver Type of approval required when you submit a time card that has a non-

project task assigned.

◦ Auto: Time card is auto-approved when submitted.

◦ User Manager: Time card is routed to the user manager for approval 
when submitted.

The user manager has the time card approver role and is also selected as 
the manager of the time card user on the User form.

◦ None: A user with the timecard_admin role can approve time cards when 
submitted.

Project time 
approver Type of approval required when you submit a time card that has the project 

task.

◦ Auto: Time card is auto-approved when submitted.

◦ Project Manager: Time cards for a project task are routed to the 
respective project manager for approval when submitted. The project 
manager is picked from the task against which you are submitting time.
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Field Description

◦ User Manager: Time cards are routed to the user manager for approval 
when submitted.

◦ Both: Time cards are routed to both the user manager and project 
manager for approval when submitted.

A time card remains in the Submitted state when only one of the 
approvers approves the time card.

◦ None: A user with the time_card admin role can approve time cards.

Note: 

◦ The project manager and the user manager can view only those 
time cards that are routed to them for approval.

◦ If the user manager or the project manager changes while the time 
card is still not approved, the system automatically updates the 
approver of the time card.

◦ If the name of the project manager or the user manager is not 
populated on the respective form, a user with the time_card admin 
role can approve time cards.

Allow multiple 
rate types

Option to provide a rate type in a time card to be used during expense line 
generation.

When this option is selected, the Rate type  field displays on the Time Card 
form to enable the selection of a rate type.

For more information, see Rate type in labor rate card.

Default rate 
type

Rate type used by default for the time card.

If you select none, the Standard rate type option is used.

This field appears when the Allow multiple rate types  check box is 
selected.

Default Policy
Option to set the time sheet policy as the default. The default policy is a 
global time sheet policy that applies to all users who are not assigned to 
any other time sheet policy.

Only one time sheet policy can be set as the default.

A time sheet policy set as the default policy cannot be deleted. You must 
first set another policy as the default policy.

4. Click Submit.

What to do next

• Set the time sheet policy as the default policy, if required.

• Assign the time sheet policy to users.
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Set a time sheet policy as default policy

As a time card administrator, you can set a time sheet policy as the default policy. The default 
policy is a global time sheet policy which applies to all the users who are not assigned to any 
other time sheet policy.

Before you begin
Role required: timecard_admin

About this task
Only one time sheet policy can be set as a default policy.

Procedure

1. Navigate to All  > Time Sheets  > Administration  > Time Sheet Policies.

2. Open the time sheet policy record.

3. Click the Set as default  related link.

Note: 
The related link appears only for a time sheet policy which is not already set as the 
default policy.

Result
The Default Policy  option on the record form  is selected to indicate that the current time sheet 
policy is set as the default policy. The Default Policy  option on the earlier default time sheet 
policy is cleared.

You cannot delete a default time sheet policy. You must first mark another policy as the default 
policy to delete the current default policy.

Assign a time sheet policy to a user

As a time card administrator, you can assign a time sheet policy to a user.

Before you begin
Role required: timecard_admin

About this task
You can assign only one time sheet policy to a user.

Procedure

1. Navigate to All  > Time Sheets  > Administration  > Time Sheet Policies.

2. Open the time sheet policy record.

3. In the Users  related list, click Edit.

4. On the Edit Members form, move the users to the User List.

5. Click Save.

Result
The selected users appear on the Users  related list. The time sheet policy is assigned to the 
selected users.
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Create a project time category

A time card admin or a project manager can create subcategories to define specific activities 
in the projects. The time card users can use these project subcategories to report time for a 
specific activity in a project.

Before you begin
Role required: timecard_admin, it_project_manager

Procedure

1. Navigate to All  > Time Sheets  > Administration  > Project Time Categories.

2. Click New.

3. Fill in the fields.

Project time category form fields

Field Description

Name Unique name for the project time category.

Description A description of the type of project activity.

4. Click Submit.

Create a rate type

You can create rate types using the Rate Types feature.

Before you begin
Role required: timecard_admin

About this task
The rate type functionality is used to categorize different types of work. For example, Standard 
versus Overtime. It can also instruct down-stream, third-party product about the nature of the 
work performed.

For example:

• A user works extra time during the day and must differentiate standard time from overtime.

• A technician may be paid at a higher rate based on different types of work involved in the 
execution of a task.

• An appliance repair task may be billed at one rate for the first hour and a different rate for the 
remaining hours.

• A service call may last four hours during which specialized equipment is used for one hour. 
The company must capture the use of the specialized equipment for purposes ranging from 
additional billing to legal compliance or warranty tracking.

Procedure

1. Navigate to All  > Time Sheets  > Administration  > Rate Types.

2. Click New  and fill the form.

3. Click Submit.
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Result

• The rate type is displayed in the Rate Types  list.

• The rate type if active is also displayed in the Rate Type  field in the Labor Rate Cards form, 
Time Worked form, Time Card form, and Time Sheet Portal.

Time Sheet Portal

Time Sheet Portal categorizes and displays all your assigned tasks in a single view for a given 
week. The portal enables you to record time spent on tasks on a day-to-day basis and submit the 
time sheet in a single action.

Time Sheet Portal works with the Task table to record the time that you spend on various task 
types, such as projects, incidents, problems, and change requests. It provides a complete 
breakdown of the time you enter for the task, task categories, and days in a week. It enables you 
to:

• Generate time cards for assigned projects or project tasks.

• Copy time cards from a previous time sheet.

• Search and create a time card for a task that is not displayed in the assigned tasks list.

• Edit, delete, or add notes to a time card.

• Submit, approve, reject, and recall a time sheet.

• View notifications for the submitted, rejected, and recalled time sheets or time cards.

Time Sheet Portal comprises of the following sections:

Header

The Time Sheet Portal header:

• Displays a date range of the time sheet for the selected week and provides options to navigate 
to the time sheet of previous or next week.

• Provides a calendar along with the date range. Clicking a date in the calendar displays the time 
sheet for the week of the selected date.

• Provides a link to navigate to the time sheet for the current week when a different time sheet is 
being viewed.

• Provides an option under My Time Sheet  that enables you to open and edit the time sheets of 
your resources. The option is available only for a user manager.

• Provides an option to view the time sheet in the Form view using time sheet form view icon 

( ).
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• Displays the notifications for the submitted, rejected, and recalled time sheets under the show 

notifications icon ( ). Each entry displays the number of time cards and their state. Click on a 
notification item to open the time sheet.
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Tasks

The Tasks  tab displays your assigned tasks as cards. Each card provides information about a 
task, such as short description, state, last updated date and time, and priority. Tasks are derived 
from the following filter conditions:

• All your assigned incidents, problems, or change requests that are active.

• All your assigned incidents, problems, or change requests that are closed in the selected 
week.

• All tasks for which you are hard-allocated during the selected week.

• All your assigned projects or project tasks that are active during the selected week. Project or 
project tasks are derived from the following conditions:

◦ A project or project task that has started and its actual start date is before the end of the 
selected week.

◦ A project or project task has closed and its actual end date is after the week has begun.

◦ When there are no actual dates for a project, planned dates of the project must occur within 
the selected week.

• All active stories assigned to you.

• All active scrum tasks assigned to you or closed in the selected week.

• All active test plans assigned to you.

• All active defect and enhancements assigned to you or closed in the selected week.
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Note: 
If the Customer Service Management  plugin (com.sn_customerservice) is activated, your 
assigned tasks that are active and closed in the selected week are also derived from the 
following tables:

• Case [sn_customerservice_case]

• Work Order [wm_order]

• Work Order Task [wm_task]

On the Tasks  tab, you can perform the following operations:

• Type a keyword in the search field to view only cards with details that match the keyword.

• Sort cards in ascending or descending order based on priority, irrespective of the task type.

• View cards based on a category, such as projects, project tasks, incident, problem, change, 
defect, enhancement, test plans, and scrum tasks.

• Create time cards for assigned tasks. See Create time cards and log time through Time Sheet 
Portal.

Note: 
Time sheet policies  apply when you create or edit a time card.

Group Tasks

The Group Tasks  tab displays the tasks assigned to your Assignment group. The group tasks 
are displayed as cards in the tab. A card provides information about the task, such as short 
description, state, last updated date and time, and priority.
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Other

The Other  tab displays cards used to log time for operational work, such as administration, 
meeting, and KTLO.

Note: 
The list of categories in the time card controls the list of cards displayed on the Other  tab. If 
an administrator marks any of the categories as inactive in the time cards, those categories 
are not displayed on the Other  tab.

Time Sheet

Starting Zurich  release, time cards and time sheet portal supports resource assignments. Users 
can select a specific resource assignment while creating time cards and submitting a time card 
via time sheet portal. Your system administrator can enable the resource assignment column 
in time sheet portal. For more information on how to add resource assignment column to time 
sheet, see the Knowledge Base  for KB1649389 .
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The Time Sheet section:

• Displays the date range of the time sheet for the selected week.

• Indicates the state of the time sheet being viewed.

• Displays the total number of tasks and hours that you have entered for each day in a week. 
When you click a day in the time sheet, the column for that day is highlighted in both the Time 
Sheet  and Logged Time Cards  sections. The first day displayed in the Time Sheet section is 
based on the value specified in the Week starts on  field in the users Time Sheet Policy. For 
example, if the Week starts on  field is set to Friday, the Time Sheet section starts with Friday.

• Indicates the total number of hours that you entered in the time sheet. Time Sheet breakdown 
also displays a breakdown of user-entered hours in different work categories, such as project 
tasks, admin, meeting, follow on tasks, or change requests.

• Provides options that enable you to submit a time sheet  and copy time cards from a previous 
time sheet. For an approver, options to approve or reject a submitted time sheet and recall a 
processed time sheet are available.

Logged Time Cards

Each row in the Logged Time Cards section represents a time card entry for a given week. It has 
details such as icon for state of the time card, short description of the task, project time category, 
rate type, resource plan, and logged time. Each row of the time card contains options that enable 
you to edit, delete, or add notes to a time card. For more information, see Create time cards and 
log time through Time Sheet Portal.

Note: 

• The Rate type  column is visible only when the Allow multiple rate types  option in the 
time sheet policy of the user is selected.

• The Resource plan  column is visible only when the Update actual hours and cost in 
resource plan/reports  option in the time sheet policy of the user is selected.

The icon beside the short description of a row indicates a time card state. The merge icon ( ) in 
a time card row indicates that a duplicate time card for the same task exists in the time sheet and 
provides option to merge them into a single time card.

When there are no time cards, the Logged Time Cards section displays the Generate Time 
Cards  and Copy from previous time sheet  buttons to create time cards.
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Note: 
Time Sheet Portal is not designed for use on mobile devices, and may not appear as shown 
in this document.

Add columns to the logged time card list

Add columns in the logged time card list on the Time Sheet Portal to show additional information 
that you might require to log your time cards.

Before you begin
Role required: admin or sp_admin

About this task

Procedure

1. Navigate to All  > Service Portal  > Widget Instances.

2. Search the Widget column for Time Card Portal Main Container  and open the record.

3. On the Instance form, update the code by providing values for the following column 
configurations in the Additional options, JSON format  field.

Instance form

Column configuration Description

name Name of the column in a table.

label
Column name to display in the logged time 
card list on the Time Sheet Portal.

The configuration is mandatory if you are 
adding a column of a table other than the 
Time Card [time_card] table.

width_in_percent Column width in percentage in the logged 
time card list.

Note: 
To add more than one column, separate each column configuration with a comma. The 
columns are added in the same order as you add them in the code.

4. Click Update.

Example:
The following sample code adds the category  column of the Time Card [time_card] table with the 
column name Category  and width of 10% in the logged time card list on the Time Sheet Portal.

{
  "tm_grid_options": {
    "displayValue": "Time card grid options",
    "value": {
      "header_fields": [
        {name:"category",label:'Category', width_in_percent: 10}
      ]
    }
  }
}
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Create time cards and log time through Time Sheet Portal

After you create time cards in Time Sheet Portal, log time in the time cards.

Before you begin

• Time sheet portal supports resource assignments created using Project Workspace. Once 
the time cards are approved, Project Managers can view the planned vs actual hours for an 
assignment in Project Workspace  and Resource Management Workspace  heatmap view.

• Role required: timecard_user

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Create time cards in the Logged Time Cards  section using any of the following options.

Based on the Allow time card reporting on  field settings in the Preferences  tab of a project, 
the Add to Time Sheet  and Add selected to Time Sheet  options are displayed in Time Sheet 
Portal.

If a duplicate time card exists for a time card, you can merge both time cards to become a 
single one, except for time cards in the processed, approved, or recalled state. A duplicate 
time card is identified by comparing the values in the Short description, State, Task, 
Category, Rate Type, Resource Plan, or Project Time Category  fields in the time card.

3. In the Logged Time Cards  section, log time in a time card.

Result
Your time cards are created and time is logged for the selected week.

What to do next
If you encounter issues with time card creation or time logging, try the following:

• Time cards not generating: Verify that your project tasks are in progress or planned for the 
selected week, and that the Allow time card reporting on  field is configured on the project.

• Missing tasks in the portal: Ensure you are assigned to the project tasks and that the task 
dates overlap with the selected time sheet week.

• Duplicate time cards: Use the merge option to combine duplicate time cards. Duplicates are 
identified by matching Short description, State, Task, Category, Rate Type, Resource Plan, or 
Project Time Category fields.

• Incorrect rate type: Verify your default rate type on your user profile. Contact your time card 
administrator (timecard_admin role) to update rate type settings.

For issues you cannot resolve, contact your system administrator or the user with the 
timecard_admin role in your organization.

Submit time sheet through Time Sheet Portal

Once you update the time sheet with time worked for a given week, submit it for approval.

Before you begin
Role required: timecard_user
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About this task
When you submit a time sheet, time cards are verified against the assigned time sheet policy. 
If there is no time sheet policy assigned, time cards are verified against the default time sheet 
policy. Business rules prevent you from submitting a time sheet in case any violation is found.

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Click Submit.
The time sheet moves to the Submitted state.

Approve or reject a time sheet through Time Sheet Portal

Review, approve, or reject a time sheet submitted by a time card user that you manage.

Before you begin
Role required: timecard_approver or timecard_admin

About this task
A user manager can review, approve, or reject the time sheets or time cards submitted by the 
time card users. The user manager has either of the required roles and is the one listed as the 
manager of the time card users.

During out-of-office time, the user manager can delegate another user  with the required roles as 
the time sheet approver. For the specified time period, the delegated user also receives all the 
time sheets submitted by the time card users to process.

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Click the My Time Sheet  list and select a time card user under My Resources.
The My Time Sheet  list is available only for a user manager.

3. Select the appropriate time sheet period by navigating through the calendar.

4. Click Approve  or Reject.

Log time and submit time sheets of your resources

As a user manager, you can log time and submit the time sheet of your resources.

Before you begin
A user manager must have time card approver role to create and edit time cards, and submit the 
time sheet of other time card users. The user manager has either of the required roles and is the 
one listed as the manager of the time card users.

Role required: timecard_approver

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Click My Time Sheet  choice list and select the user for whom you want to approve or reject 
time sheet for under My Resources.

The My Resources  section lists the time card users reporting to you.

Note: 
The choice list with My Time Sheet  is available only for a user manager.
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3. Create time cards and log time through Time Sheet Portal  as required.

4. Click Submit.

Result

• The time sheet of the selected user moves to the Submitted state. The time sheet policy 
assigned to the time card user is used for validation when you submit the time sheet.

• All the time cards associated with the time sheet are also submitted automatically and move to 
the Submitted state.

• The Approve  and Reject  buttons appear in the Time Sheet section. The two buttons appear 
only for a user manager.

What to do next
Once you have submitted the time sheet for your resource, you can click Approve  or Reject  to 
approve or reject it. Only the time cards that are routed to the user manager, are approved or 
rejected. The routing for approval happens based on the Non-project time approver  and Project 
time approver  fields in the time sheet policy of the time card user.

Time Sheets

A time sheet groups all the time cards for a user for the given week.

With time sheets:

• Time card users can submit all the time for their work week in a single step by using a time 
sheet.

• Time card approvers can approve all the time cards in a time sheet for a user in a single step 
by approving the time sheet. They do not need to approve multiple time cards for a given user 
individually.

• Track the activities of a time sheet, such as who submitted or approved a time sheet, in the 
Activities section on the Time Sheet form. This time sheet activity audit is useful for tracking 
when you delegate responsibility for your time card processing to another user. To track 
the activities, enable the State  field of the Time Card [time_card] table for auditing the time 
card activities, if it is not already enabled. For more information, see Include a table field in 
auditing .

A time sheet can have any of the following states:

Pending

A time sheet has been created, but the user is still making changes before 
submitting it.

Submitted

A time sheet has been submitted for approval. The approver can approve or reject it.

Approved

A time sheet has been approved. If the time sheet isn't automatically updated to 
Processed, this means there was no task associated with the time sheet.

Processed

A time sheet has been processed by the system. After a time sheet is approved, 
the after business rule Create expense from approved time card is triggered. This 
business rule creates an expense line for the associated task, and then updates the 
state to Processed.

Rejected
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A time sheet has been sent back to the submitter for changes.

Recalled

A time sheet has been recalled by the submitter for modification.

Create a time sheet

As a time card user, you can create a time sheet to group all your time cards for the given week 
and submit them in a single step.

Before you begin
Role required: timecard_user

About this task
A user can create only one time sheet per week.

Note: 
When a user creates a time card for a week, a time sheet is also automatically created for 
that week.

Procedure

1. Create the time sheet with one of these options.

2. On the form, fill in the fields.

Time Sheet form

Field Description

Week 
starts on

Starting date of the week for which the time sheet is created.

Note: 
The time sheet policy  Week starts on  controls the start day of the week.

Total 
Hours

Number of hours the user has worked in that week. This field is automatically 
populated from the hours recorded for the associated time cards.

User Name of the user for which time sheet is created.

State Current state of the time sheet. All new time sheets begin as Pending.

Default states: Pending, Submitted, Approved, Processed, and Rejected, 
Recalled.

Comments Comments related to the time sheet.

Notes Any additional information.

3. Click Submit.

What to do next
Add time cards to the time sheet. You can use the related links and related list to add time cards. 
You can also add time cards using the Time Sheet Portal.
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Time sheet form related links

Field Description

Generate Time Cards Link to generate time cards for the assigned project tasks.

Copy from previous 
time sheet

Link to open the Copy Time Sheet  window for you to copy the time 
cards  from previous time sheets.

Time Sheet Portal Link to open the Time Sheet Portal to view and manage the time sheet.

Time sheet form related lists

Field Description

Time Cards List of the time cards that are part of the time 
sheet.

To create a time card, click New.

Submit a time sheet

Once the time sheet is updated with time worked, you can submit the time sheet for the week to 
submit all the time cards for the week together.

Before you begin
Role required: timecard_user

About this task
When a user submits a time sheet, the time sheet policy  assigned to the user is used for 
validation. If there is no time sheet policy assigned to the user, the default time sheet policy is 
used. Business rules prevent a user from submitting a time sheet in case any violation is found.

Note: 
You can also perform this task from the Time Sheet Portal.

Procedure

1. Navigate to the time sheet using one of the following options:

◦ To submit a time sheet in the Pending state, navigate toTime Sheets  > My Time Sheets  > 
Pending.

◦ To submit the time sheet for the current week, navigate to Time Sheets  > My Time Sheets  > 
Current Time Sheet.

◦ To submit a time sheet in the Rejected state, Time Sheets  > My Time Sheets  > Rejected. You 
can make required changes as suggested in the rejection comments to resubmit a rejected 
time sheet.

2. To submit in the Time Sheets list, open the time sheet.

3. Add comments, if required.

4. Click Submit Time Sheet.

Result

• The time sheet moves to the Submitted state.

• All the time cards associated with the time sheet are also submitted automatically and move to 
the Submitted state.
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Approve or reject a time sheet

View, approve, or reject time sheet or time cards for your user, for the given week, in a single step.

Before you begin
Role required: timecard_approver or timecard_admin

About this task
A user manager is the one who has either of the required roles and is selected in the Manager 
field on User form of the time card user.

During out-of-office time, the user manager can Delegate time sheet approvals to another user 
with the required roles as the time sheet approver. For the specified time period, the delegated 
user also receives all the time sheets submitted by the time card users to process.

Note: 

• You can also approve or reject the time cards within a time sheet selectively by selecting 
one or more time cards and approving or rejecting them.

• If a time sheet is rejected, all the associated time cards in the Submitted state are also 
rejected automatically. The time cards in the Approved and Processed state for the time 
sheet remain unaffected.

• If all the time cards in a time sheet are approved, the time sheet automatically moves to 
the Approved state.

• If a time card in a time sheet is in the Rejected state, then irrespective of the state of other 
time cards in the time sheet, the time sheet also moves to the Rejected state.

Procedure

1. Navigate to All  > Time Sheets  > Time Sheets  > Pending Approval.

2. In the Time Sheets list, open the time sheet to approve or reject.

3. If required, add comments.

4. Click Approve  or Reject.

Result
The time sheet moves to the Approved or Rejected state.

• If a time sheet is rejected, it gets listed in the notifications for the rejected time sheets under 

the show notifications icon ( ) on Time Sheet Portal  and is moved back to the submitter to 
adjust the corrections and resubmit it. For more information, see Submit a time sheet.

• Once a time sheet is approved, all the time cards associated with the time sheet are also 
approved or rejected automatically.

• If any time cards in the time sheet are pending approval by one of the approvers as defined by 
the time sheet policy, the time sheet remains in the Submitted state.

Recall a processed time sheet

You can recall an incorrect time sheet in the Approved or Processed state to return it to the 
submitter. The submitter can then make the necessary changes and resubmit the time sheet.

Before you begin
Role required: timecard_approver or timecard_admin
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About this task
The recall option is available only if the Allow recall  option is selected on the associated time 
sheet policy.

Procedure

1. Navigate to the approved or processed time sheet you want to recall using one of the following 
options.

2. Click Recall.

Result

• Changes the state of the time sheet and associated time cards to Recalled.

• Reverts the actual effort and resource hours in a project or demand created when time cards 
that have task types were approved.

• Creates negative expense lines to zero out the corresponding expense lines created when the 
time sheet was approved.

• Returns the time sheet to its submitter for modifications.

Delegate time sheet approvals to another user

You can delegate the responsibilities to process the time sheets of your resources to another 
user when you might not have time or will be unavailable.

Before you begin
Role required: timecard_admin or timecard_approver

About this task
The delegate must have the timecard_approver role.

Procedure

1. Navigate to All  > Time Sheets  > Delegate.

2. In the Delegates list, click New.

3. On the form, fill in the fields.

Delegate form

Field Description

User User from whom the approvals and tasks are 
delegated to another user.

Delegate User to whom the approvals and tasks are 
delegated.

Starts Start date of the delegation period.

Ends End date of the delegation period.

Approvals Option that enables time card approval 
delegation.
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Note: 
The other options on the form (Assignments, CC notifications, and Meeting invitations) 
are not applicable for time sheet approval delegation.

4. Click Submit.

Result
The approval delegation has the following effects during the specified period:

• Both you and the delegate receive notifications regarding approval activity.

• On the Time Sheet Portal, the delegate can see your resources under Delegates  in the My 
Time Sheet  list.

• Delegates can perform all the functions that you can do for your resources in the Time Sheet 
Portal: Create and submit their time sheets, approve or reject the submitted time sheets, and 
recall the processed time sheets.

Time cards

Time cards are used to record the time worked on a task by a task assignee.

The time card management feature works with the Task table to record time worked on Projects, 
Incidents, Problems, and Change Requests.

Task assignees can record time worked in the Time worked  field on a task record or enter hours 
directly into their time card. Some tables support automatic time card creation based on start 
and end date fields.

Track the activities of a time card, such as who submitted or approved a time card, in the 
Activities section on the Time Card form. This time card activity audit is useful for tracking when 
you delegate responsibility for your time sheet processing to another user. To track the activities, 
enable the State  field of the Time Card [time_card] table for auditing the time card activities, if it 
isn't already enabled. For more information, see Include a table field in auditing .

You can associate time cards for the project tasks and other task categories, such as meeting 
and training, with relevant resource plans.

When you approve a time card, the time logged in the time card is saved day-wise in the Time 
Card Daily [time_card_daily] table. Using daily time logged data, you can generate time card 
reports by days for any period irrespective of the time sheet period to which the time cards 
belong. For example, you can create a monthly time card report that includes time cards from the 
first day to the last day of the month.

Time cards also have an optional approval mechanism for project managers to approve the time 
cards. Administrators and time card approvers can see all the time cards for the week. All users 
who are in a role that is responsible for working on tasks also can access their personal time 
cards. A time card can have any of the following states:

Time Card states

State Description

Pending A Time card that isn’t submitted for approval.

Submitted A time card submitted for approvals.

Approved An approved time card.
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Time Card states  (continued)

State Description

Processed An approved time card with an expense line for the associated 
task.

Rejected A rejected time card.

Recalled An approved time card recalled for any required adjustments.

Create a time card

You can create time cards to log time against the work you have done.

Before you begin
Role required: timecard_user

About this task
Starting Zurich  release, users can select a resource assignment to associate it with time cards to 
calculate the actual efforts and tag them to the respective projects.

The Allow time card reporting on  field on the project form  determines the level at which the time 
cards for the project tasks can be created.

Note: 
Time Cards created from Project form do not populate Resource plans automatically 
to avoid random allocations. For more information, see KB0814884  article in the Now 
Support  Knowledge Base.

Time cards can be created automatically or manually.

• Automatic: Use the following options to automatically generate the time cards:

◦ By updating task:

Auto create time card on task update

Configure time cards to be created when a user updates a task record. The 
Auto create time card on task update  setting in the assigned time sheet policy 
controls this behavior and is set to false by default.

Auto fill time card with time worked entries

Configure time cards to be created when a user records Time worked. A time 
card is created if a time card does not exist for the task. The time sheet policy 
Auto fill time card with time worked entries  controls this behavior and is set to 
false by default.

In Project Task, Incident, Problem, and Change  records, the Time worked  field 
does not appear by default and must be configured on the form.

◦ By scheduled job: Configure time cards for the project tasks to be generated automatically 
for users through a scheduled job. Only the admin can configure a scheduled job.

Note: 
Time cards cannot be created automatically when you use the mobile interface. Use the 
desktop interface if you want to use the automatic time card feature.

• Manual: Create a time card for each task and enter the time manually.
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Procedure

1. Create the time card using one of the following options.

2. On the form, fill in the fields.

Time card form

Field Description

Week 
starts on

Starting date of the week of the time sheet.

Note: 
The time sheet policy  Week starts on  controls the start day of the week. 
A message is displayed when you try to associate a resource plan with 
a time card when the week on which the time card starts is outside the 
resource plan dates.

State Current state of the time card. All new time cards begin in the Pending state.

Different states of a time card are Pending, Submitted, Approved, Processed, 
Rejected, and Recalled.

Category Type of task for which the time card is created.

Task Task that is associated to the time card.

Project 
time 
category

Type of activity in the project that time is reported for.

This field appears when you select Project/Project Task  or Task work  in the 
Category  field.

User Name of the user that the time card is created for.

Resource 
assignment

Select a resource assignment assigned to the user. When the time card is 
approved, the actual hours are used to view the planned vs actual hours in the 
heatmap view in Project Workspace  and Resource Management Workspace.

A resource assignment is associated with the time card in the following ways:

◦ If the user has multiple resource assignments, you can select the appropriate 
assignment.

◦ If the user has only one resource assignment, that plan is selected by default.

3. Click Submit.

Result

• The time card is created for the selected time card period.

• If the time sheet for the week does not exist, a time sheet is created for the time card week.

What to do next
After the time card is created, the hours for that task can be incremented automatically from the 
Time worked  field in the task record. The time sheet policy Auto fill time card with time worked 
entries  controls the way the time is updated in time cards. The policy is set to false  by default. If 
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automatic updates for time worked are not configured, the user must manually update the time 
card.

Related topics

Map a time card category with operational work types

Copy time cards from a previous time sheet

Another option for creating time cards is to copy them from an existing timesheet, which copies 
all the time cards (for project as well as non-project tasks) from a selected time sheet.

Before you begin
Role required: timecard_user

About this task
You can also perform this task from the Time Sheet Portal.

Procedure

1. Open the time sheet record that you want to create the time cards for.

2. Click the Copy from previous time sheet  related link.

3. In the Select Time Sheet  field, select a previous time sheet that you want to copy the time 
cards from.

4. Optional:  You can copy the time logged for the tasks in the previous time sheet, select the 
Copy time logged  check box.

5. Click OK.

Result

Time cards for project tasks

Time cards for all the project tasks that are in progress or planned in the current 
week are copied from the selected time sheet. If a time card for a project task exists, 
a duplicate time card is not created during copying.

Time cards for non-task category

Time cards for all non-task category such as meetings and trainings are copied from 
the selected time sheet. If a time card for a non-task category exists, a duplicate 
time card is created during copying.

Note: 

• If the previous time sheet has rate types and the time sheet policy of the user allows rate 
types, then rate types are also copied into the current time sheet.

• If the previous time sheet has rate types, but the time sheet policy of the user no longer 
allows rate types, then rate types are not copied to the current time sheet.

• If the previous time sheet has a rate type that is inactive, that rate type is not copied. If 
necessary, the user can enter a different rate type before saving the individual time cards.

Auto-generate time cards

As an admin, you can configure a scheduled job to generate time cards automatically for project 
tasks assigned to time card users.

Before you begin
Role required: admin
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About this task
In addition to the manual option Generate Time Cards, a scheduled job can be run to 
automatically generate the time cards for project tasks. A job can be scheduled to run every 
week, for example, on every Sunday to generate time sheets for all users for the next week. 
You can configure when to run the scheduled job based on the business process of the 
organization. By default, the scheduled job is turned off. For more information, see Schedule a 
script execution  .

Note: 
The scheduled job auto-generates time cards only for those users who have the Auto 
create time cards every week  option set to true in their assigned time sheet policy.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. In the Scheduled Jobs list, select Auto Generate Time Cards.

3. Configure the following parameters in the script as per the business requirements:

◦ run for (CURRENT_WEEK, NEXT_WEEK, LAST_WEEK)

◦ Group Name (includeGroups, excludeGroups)

Note: 

◦ If a time card exists for a project task for the time card week, a duplicate time card is not 
created.

◦ Time cards are generated only for those project tasks that are in progress or planned in 
that week.

◦ The Allow time card reporting on  field on the project form  determines the level that the 
time cards for the project tasks are created at.

Example:
The following example script is executed when a scheduled job is run to generate time cards for 
the Current week  for the Database  and Hardware  groups:

// Clone this schedule job to run separately for different 
 groups at different times
// One of the following values
// TimeCardConstants.CURRENT_WEEK
// TimeCardConstants.NEXT_WEEK
// TimeCardConstants.LAST_WEEK
var runFor = TimeCardConstants.CURRENT_WEEK;
 
// Comma separated group sys ids or group names. 
 TimeSheet/TimeCards will be auto generated for time card users 
 in the given groups.
var includeGroups = [Database,Hardware];
var excludeGroups = [];
 
var generator = new TimeCardGenerator();
generator.generateFromConfig(runFor, includeGroups, 
 excludeGroups);

Submit a time card

As a time card user, once a time card for the week is updated with the time worked, you can 
submit the time card individually.
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Before you begin

• A time card in the Pending or Rejected state can be submitted.

• Role required: timecard_user

About this task
When a user submits a time card, the time sheet policy  assigned to the user is used for 
validation. If there’s no time sheet policy assigned to the user, the default time sheet policy is 
used. Business rules help prevent a user from submitting a time card in case any violation is 
found.

Procedure

1. Navigate to All  > Time Sheets  > My Time Sheets  > All.

2. Select the time sheet that you want to submit the time card for.

3. In the Time Card related list, open the time card to submit.

4. Select Submit Time Card.

Note: 
Submit multiple time cards by selecting Submit Time Card  from the actions on selected 
rows menu.

Result

• The time card moves to the Submitted state.

• The time card is submitted to an approver based on the Project time approver  and Non-
project time approver  field values in the assigned time sheet policy.

Note: 
If the project or user manager is changed after submitting the time card, the time card is 
automatically redirected to the new project or user manager for approval.

Approve or reject a time card

As a time card approver, you can view and approve or reject a submitted time card.

Before you begin
Role required: timecard_approver or timecard_admin

About this task
You can view only those time cards that are submitted to you for approval or you have been 
delegated as the time card approver by one of the other user managers. The time sheet policy 
assigned to the user governs the approval process.

Procedure

1. Navigate to All  > Time Sheets  > Time Cards  > Pending Approval.

2. Select the time card to approve or reject.

3. Click Approve  or Reject.

Result

• The time card moves to the Approved or Rejected state.

• Expense line is created for an approved time card.

• For an approved time card, a Time Card Daily record is created.
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Note: 

• A user manager can also approve the time cards within a time sheet by selecting one 
or more time cards and approving them. When all the time cards in a time sheet are 
approved, the time sheet automatically moves to the Approved state.

A user manager is one who is selected in the Manager  field on User form of the time card 
user.

• If a time card is in the Rejected state, the associated time sheet also moves to the 
Rejected state irrespective of the state of other time cards in the time sheet.

Note: 
If a time sheet is rejected, it gets listed in the notifications for the rejected time 

sheets under notifications icon  on Time Sheet Portal.

• If Project time approver  is set to Both  in the assigned time sheet policy, the time card is 
in the Submitted state only if both approvers approve it. If one of the approver rejects, the 
time card state is set to Rejected and the Approved by  field is cleared, requiring approval 
of both approvers on resubmission.

Recall a processed time card

You can recall an incorrect time card in the Approved or Processed state to return it to the 
submitter. The submitter can then make the necessary changes and resubmit the time card.

Before you begin
Role required: timecard_approver or timecard_admin

About this task
The recall option is available only if the Allow recall  option is selected on the associated time 
sheet policy.

Procedure

1. Navigate to All  > Time Sheets  > Time Sheet Portal.

2. Click the My Time Sheet  list and select a user under My Resources.

3. Navigate through the Calendar  widget to select the time sheet.
The time sheet must be within the recall period specified in the time sheet policy.

4. To recall a time card, click the more actions icon ( ) and select Recall.
If the cost type for a cost plan is updated before recalling a time card, the expense line of the 
recalled time card will have the new expense type. For example:

a. A Time card is processed with Cost Plan=Labor Opex, an expense line is generated for $500 
with Expense type=Labor Opex.

b. If the cost type of cost plan is updated to Cost type=Labor Capex.

c. If a time card is recalled, the recalled expense linewill have Expense type=Labor Capex.

Result

• Changes the state of the time card to Recalled. The state of the associated time sheet also 
changes to Recalled  until all time cards in the time sheet are approved or processed again.

• Reverts the actual effort and resource hours in a project or demand created when the time 
card for a task type was approved.
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• Creates negative expense lines to zero out the corresponding expense lines created when the 
time card was approved.

• Returns the associated time sheet to its submitter for modifications.

Map a time card category with operational work types

Map custom time card categories with operational work types so you can select only the 
operational resource plans that are associated with the user for a specific time card period and 
category while posting time.

Before you begin
Role required: pps_admin

About this task
By default, all base system time card categories are mapped with the base system operational 
work types. If mapping is not done for custom categories, the Resource Plan  field displays all the 
operational resource plans associated with the user for that time period when you create a time 
card.

During time card creation, after you select a time card category and task or during time sheet 
submission for other category time cards, operational resource plans are populated for that 
category and task as described in the following table.

Operational resource plans for tasks and categories

Category Task Resource Plan

• Admin

• External labor

• Meeting

• Phone call

• Training

• Out of office

• Appointment

• Time off

• KTLO

Task, project, demand, project 
task, or demand task, or no 
value is selected in the Task 
field.

Displays the resource plans 
associated with the task, 
project, demand, project task, 
or demand task when a task is 
selected.

If no resource plans are 
associated with the selected 
task, or no task is selected, 
then the mapped operational 
resource plan for that 
operational work type for that 
category is displayed.

Custom Any of the task/project/
demand/ project task/
demand task

Displays the resource plans 
associated with the task, 
project, demand, project task, 
or demand task when a task is 
selected.

If no resource plans are 
associated with the selected 
task, or no task is selected, 
then the mapped operational 
resource plan for that custom 
operational work type for that 
category is displayed.
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Operational resource plans for tasks and categories  (continued)

Category Task Resource Plan

If mapping is not done, then 
all the operational resource 
plans are displayed.

Other category (custom and 
OOTB) from Time Sheet Portal

N/A
Displays the mapped 
operational resource plans.

If mapping is not done, then 
all the operational resource 
plans are displayed.

Procedure

1. Navigate to All  > Project Administration  > Time Card Category Mapping.

2. Click New.

3. From the Time card category  menu, select the required time card category.

4. From the Operational work type  menu, select the operational work type you want to map to 
the time card category you selected in the previous step.

5. Click Submit.

Record time worked

The time card retrieves time accrued on a project or spent working on any record in the Task 
table from the Time worked  field.

This field does not appear by default on the Project Task, Incident, Problem, and Change forms 
and must be added by personalizing the form. Time recorded in this field is used to populate an 
existing time card or to create a new time card if one does not exist. A time sheet policy  controls 
this behavior.

Note: 

When time worked is updated, a time card is created only if:

• the user is a time card user, AND

• the user is assigned to the task through Assigned to  or Additional assignee list  field.

The Time worked  field has a counter that acts like a stopwatch for the duration of the time spent 
in the record. A button in the field can stop and start the counter. By default, the Time worked 
counter is enabled and begins recording the elapsed time when the record is opened. Stop the 
counter with the stop button and restart it with the play button.

If you are creating time cards from time worked entries, you can ask your admin to add the Time 
Worked  related list to display the time worked records on the time card form. You will also notice 
an informational message on the time card to let you know that changes to time worked records 
overrides values in the time card. This is displayed using a Create a formatter and add it to a 
form , which can be added or removed by configuring the form.
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Manage costs

When the cost management feature is enabled, time cards can be used to manage the cost of 
labor in the Cost Management application.

When a time card for a project task is approved, an expense line is generated for the 
corresponding labor cost associated with the project. If the project has a Rate Models 
associated, then the hourly rate for calculating labor cost for the expense lines is derived 
from the rate model. If no rate model is associated to the project, the rate listed in 
the Labor Rate Card  is considered. If no Labor Rate Cards is applicable, the property 
com.snc.time_card.default_rate  defines the default hourly rate.

Roles

The timecard_admin role enables users to approve, modify, and delete the time cards of other 
users.

Related topics

Activate Cost Management

Analytics Project manager

The Analytics Project manager provides the project managers with quick reports of time card 
exceptions, and category wise time reported for their projects. The dashboard displays time card 
reports only for the projects managed by a project manager.

Important: 
Starting with Xanadu  release, Project Manager Dashboard  is renamed to Analytics Project 
manager  for new customers.

The dashboard can be activated using the Performance Analytics - Content Pack - Project 
Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). You require Performance Analytics 
license to use this dashboard.

The reports in the dashboard are filtered based on Project, and Date  selected.

The Analytics Project manager consists of these components:

Project time card exception count

It displays the total count of entries in Project time card exceptions  report.

Project time card exception count

Project time card exceptions report

The Project time card exceptions report lists the users who did not submit their time cards, and 
the time cards which are not yet approved for the selected project and time range. The exception 
report is generated for the users who are assigned to a task in progress, or hard allocated to the 
project/task in that time range. The report displays the following data:
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• User: The time card user assigned to the selected project, or hard allocated to the resource 
plan associated with the project. If there are more than one time cards for a user in a given 
date range which are not submitted or require approval, then multiple entries are listed for the 
user.

• Week starts on: Starting date of the time card week in the selected time range.

• State: State of the time card. Time card entries with state as Not Submitted  are also listed if a 
time card is not created for the week.

The report is generated from the project_timecard_exception table. It requires the schedule job 
Project Time Card Exceptions  to be running to get the up-to-date information.

Total approved hours for project(s)

It displays the total approved hours in all project categories displayed in Time by Project Time 
Category  report.

Total approved hours for projects

Time by Project Time Category report

The bar chart report displays the time approved against each project category for the users 
allocated to the selected project.

Use the Analytics Project manager

The Analytics Project manager shows the time card reports for the selected projects.

About this task

Important: 
Starting with Xanadu  release, Project Manager Dashboard  is renamed to Analytics Project 
manager  for new customers.

Before you begin
Role required: it_project_manager, timecard_admin

Procedure

1. Navigate to All  > Time Sheets  > Analytics Project manager.

2. Select a project and date range from the Project  and Date  choice lists.

3. Review the displayed reports and take necessary actions, if required.

4. Click the more actions icon ( ) to duplicate, share or export the selected report, if required.

Analytics User manager

The Analytics user manager provides the user managers with reports of time sheet exceptions, 
and category wise time reported by the users.
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Important: 
Starting with Xanadu  release, User Manager Dashboard  is renamed to Analytics User 
manager  for new customers.

The dashboard can be activated using the Performance Analytics - Content Pack - Project 
Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). You require Performance Analytics 
license to use this dashboard.

The dashboard displays time sheet reports only for those time card users who have the Manager 
field on User form  set to the current user.

The reports in the dashboard are filtered based on Date  range, and User  selected.

The Analytics user manager consists of these components:

Time sheet exception count

It displays the total count of entries in Time sheet exceptions  report.

Time sheet exception count

Time sheet exceptions report

The Time sheet exceptions report lists the users who did not submit/create their time sheets, 
and the time sheets which are not yet approved for the selected user, and time range. The report 
displays the following data:

• User: The time card user whose manager in User profile is the current user. If there are more 
than one time sheets for a user in a given date range which are not submitted or require 
approval, then multiple entries are listed for the user.

• Week starts on: Starting date of the time sheet week in the selected time range.

• State: State of the time card. Time sheet entries with state as Not Submitted  are also listed if a 
time sheet is not created for the week.

The report is generated from the time_sheet_exception table. It requires the schedule job Time 
Sheet Exceptions  to be running to get the up-to date information.

Total approved hours

It displays the total approved hours in all categories displayed in Time by category  report.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1803

https://www.servicenow.com/docs/access?context=t_CreateAUser&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_CreateAUser&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=t_CreateAUser&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Total approved hours

Time by category report

The bar chart report displays the time approved against each category for the selected users 
whose manager in User profile is the current user.

Use the Analytics User manager

The Analytics User manager shows the time sheet reports for the users.

Before you begin
Role required: resource_manager, timecard_admin

About this task

Important: 
Starting with Xanadu  release, User Manager Dashboard  is renamed to Analytics User 
manager  for new customers.

The dashboard displays time sheet reports only for those time card users who have the Manager 
field on User form  set to you.

Procedure

1. Navigate to All  > Time Sheets  > Analytics User manager.

2. Select a date range and user from the Date  and User  choice lists.

3. Review the displayed reports and take necessary actions, if required.

Performance Analytics dashboard for Time Card  Management

This Platform Analytics Solution  contains preconfigured dashboards. These dashboards contain 
actionable data visualizations that help you improve your business processes and practices.

The Time Card Management and Time Sheet dashboards are included in the Project Portfolio 
Suite with Financials Dashboards. For more information, see Project Portfolio Management 
Platform Analytics Solutions.

Domain separation and Time Card

Domain separation is supported in Time Card. Domain separation enables you to separate data, 
processes, and administrative tasks into logical groupings called domains. You can control 
several aspects of this separation, including which users can see and access data.

Support level: Basic
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• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

For more information about using domain separation with Time 
Card, see https://community.servicenow.com/community?
id=community_article&sys_id=616d706edbb318d066f1d9d9689619c1 .

Related topics

Domain separation for service providers

Mobile Time Sheets

The ServiceNow®  Mobile Timesheets app enables time sheet users and managers to access 
their time sheets from a mobile device. Mobile Time Sheets is available on the Now Mobile app 
and is supported on iOS and Android devices.

Time sheet users can use Mobile Time Sheets to create, view, edit, enter notes, and submit 
their time cards from a mobile device. Time sheet project managers or user managers can view, 
approve, reject, or recall a time sheet or time card from a mobile device.

To access time sheets from your mobile device, you must first download the Now Mobile 
application on an iOS platform from the Apple App Store or on an Android platform from the 
Google Play Store.

Features

The Mobile Time Sheets app provides the following capabilities to time sheet users:

• Create a time sheet

• Create a time card

• Log hours on the time card

• Update hours for the week for a specific time card

• Add notes to your time cards

• Submit a time sheet

• Submit a time card
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The Mobile Time Sheets app provides the following capabilities to resource or project managers:

• Approve or reject a time sheet

• Approve or reject a time card

• Recall a time sheet or time card
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Install Mobile Time Sheets

Install the Mobile Time Sheets application from the ServiceNow Store website.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find an application, you may 
have to request it from the ServiceNow  store.

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.

If your application requires other applications, you need to install them first if they are not 
already installed.

Installing your application also automatically installs dependent applications or plugins if they 
are not installed already.
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5. If demo data is available and you want to install it, click Load demo data.
Some applications include demo data, which are sample records that describe application 
features for common use cases. Load demo data when you first install the application on a 
development or test instance.

6. Click Install.

Enabling the mobile experience for Mobile Time Sheets

Enable the mobile experience for Mobile Time Sheets so users can fill out time sheets and user 
managers can approve or reject them from their mobile device.

Before you begin
Role required: admin

Procedure

1. Install the Mobile Time Sheets application  on your instance.

2. Download the Now mobile application on an iOS platform from the Apple App Store or on an 
Android platform from the Google Play Store.

For more information on using this mobile app, see the Now Mobile app  topic.

3. Add the instance that has Mobile Time Sheets installed to the Now Mobile application and log 
in to access the application data on your mobile device.

What to do next
Log in to an instance with a mobile app .

Use Mobile Time Sheets in Now Mobile

You can configure your platform system to use Mobile Time Sheets in the Now Mobile 
application. By default, Mobile Time Sheets can be viewed in the Now Mobile application.

Before you begin
Role required: admin
The Mobile Time Sheets app must be installed in your system.

Procedure

1. Navigate to All  > System Mobile  > Navigation Bar.

2. Click Now Mobile Nav.

3. From the Navigation Tabs  related list, delete the time sheet record.

4. Navigate to System Mobile > Navigation Bar.

5. Click Now Agent.

6. Create a new record for the time sheet in the Navigation Tabs  related list.

7. Download and enable the Now Mobile app.
For more information, see the Now Mobile app  topic.

Create a time sheet from your mobile device

Create a time sheet to group all your time cards for the given week and submit them in a single 
step from the Now Mobile application.

Before you begin
Role required: timecard_ user
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Procedure

1. Log in to your instance using the Now Mobile application.

2. Tap the plus icon located on the top-right corner.

3. In the Select a day to create a time sheet  field, select the starting date of the week for which 
the time sheet is being created.

4. Tap the forward icon.

What to do next
Add time cards to the time sheet.

Search for a time sheet from time sheet lists

Search for a specific time sheet from the time sheet lists by applying filters.

Before you begin
Role required: timecard_user

About this task
You can apply filters on the time sheet lists to search for a specific time sheet in the All, 
Rejected, and Recalled  groups, or while copying time cards from a previous time sheet. You can 
apply one or more filters while searching for a time sheet.

Procedure

1. Log in to your instance using the Now Mobile application.

2. Open the Rejected, Recalled, or All  list.

3. Tap the Filters  icon located on the top-right corner to specify your filter criteria.

4. From the State  menu, select the state of the time sheet, and tap the Back  icon.

5. Select the user assigned to the time sheet in the Name  field.

6. Select the week on which the time sheet starts.

7. Tap Apply.

Add a time card and log time through the Mobile Time Sheets application

Create time cards to log time from your mobile application for the work you have done.

Before you begin
Role required: timecard_user

About this task
The Allow time card reporting on  field on the project form  determines the level at which time 
cards for the project tasks can be created. For example, at the project level, if a user is assigned 
to multiple tasks in a project, then the time spent on all the tasks is recorded under one time 
card only; and at the project task level, separate time cards are created corresponding to each 
planned task.

Procedure

1. Log in to your instance using the Now Mobile application.

2. Open a time sheet from the Time Sheets  tab.

3. Tap the action icon.

4. Add task-related or non-task related time cards.
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5. Log time in a time card:

◦ Tap a task on the time sheet and enter the hours worked for applicable days.

6. Tap Save.

Update time card hours for a task

Update hours in a time card for a particular day.

Before you begin
Role required: timecard_user

About this task
You can update the hour field for a specified day for a particular time card. The existing value is 
overwritten with the new value in the time card.

Procedure

1. Log in to your instance using the Now Mobile application.

2. Open a time sheet from My active time sheets.

3. Select the day for which you want to update hours.

4. Tap the task for which you want to update hours.

5. Update the hours in the text box.

6. Save the changes using your device's keyboard.

Manage your time cards

View, edit, or delete your time cards from your mobile device.

Before you begin
Role required: timecard_user

About this task
Manage your time cards by performing actions such as submitting the time card, viewing the 
notes, adding notes, editing resource plan, or deleting the time card using your mobile device.

Procedure

1. Log in to your instance using the Now Mobile application.

2. Open a time sheet from the Time Sheets  tab.

3. In the All Week  tab, tap the action menu for a task.

4. Manage your time cards.

Submit a time card from your mobile device

Once a time card for the week is updated with the time worked, you can submit the time card 
from your mobile application.

Before you begin
Role required: timecard_user
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Procedure

1. Log in to your instance using the Now Mobile application.

2. Open a time sheet.
Cards that have not yet been submitted are in the Pending state. You can also submit cards 
that are in the Rejected state once you have fixed the issues that caused the rejection.

3. Tap the actions menu for a time card on the time sheet and select Submit time card.

Result

• The time card moves to the Submitted state.

• The time card is submitted to an approver based on the values set in the Project time 
approver  and Non-project time approver  fields in the time sheet policy assigned to the user.

Note: 
If the project or user manager is changed after submitting the time card, the time card is 
automatically redirected to the new project or user manager for approval.

Submit a time sheet from your mobile device

Once you have updated the time sheet with the time you worked, you can submit the time sheet 
for the week to submit all the time cards for the week together from your mobile application.

Before you begin
Role required: timecard_user

Procedure

1. Log in to your instance using the Now Mobile application.

2. Open the time sheet you want to submit.

3. Submit the time sheet using one of the following options.

◦ Tap the action icon and tap Submit Time sheet.

◦ Tap Submit time sheet  at the bottom of the screen.

The time sheet is validated against the time sheet policy assigned to you or, if no time sheet 
policy is assigned, against the default time sheet policy.

◦ If the time sheet meets the time sheet policy requirements, the time sheet is submitted. All 
the time cards associated with the time sheet are also submitted automatically and move to 
the Submitted state.

◦ If the time sheet does not meet the time sheet policy requirements, a validation error is 
displayed. Resolve the issue indicated by the error message and resubmit the time sheet.

Approve or reject a time sheet or time card from your mobile device

As a user manager, you can approve or reject from your mobile device all time cards for a user in 
a given week in a single step by approving or rejecting a time sheet.

Before you begin
Role required: timecard_approver or timecard_admin

About this task
A user manager is the one who has either of the required roles. The manager who can accept or 
reject the time sheet is selected in the Manager  field on the User form of the time card user.
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A manager can delegate another user  with the required roles as the time sheet approver. For the 
specified time period, the delegated user also receives all the time sheets submitted by time 
card users to process.

Procedure

1. Log in to your instance using the Now Mobile application.

2. In the Time Sheets list, open the time sheet you want to approve or reject.

3. Approve or reject the time sheet or time card.

◦ To approve time sheet of your team, from the Team approval requests section, tap the 

approve ( ) icon.

◦ To reject time sheet of your team, from the Team approval requests section, tap the reject 

( ) icon.

◦ To approve the time sheet, tap the action icon, and select Approve time sheet  or tap the 
Approve time sheet  button at the bottom of the screen.

◦ To reject the entire time sheet, tap the action icon, and select Reject time sheet  or tap the 
Reject time sheet  button at the bottom of the screen.

◦ To approve a specific time card, tap the action menu and tap Approve time card.

◦ To reject a specific time card, tap the action menu and tap Reject time card.

Result

• The time sheet moves to the Approved or Rejected state.

• All time cards associated with the time sheet are also approved or rejected automatically.

• Time cards that are of non-task type are in moved to the processed state.

• If any time cards in the time sheet are pending approval by one of the approvers, the sheet 
remains in the Submitted state.

• If a time card in a time sheet is in the Rejected state, the time sheet also moves to the Rejected 
state regardless of the state of any other time cards in the time sheet.

Track your time sheets

View and track the time sheets grouped according to the date of submission such as the current 
week, last week, or older.

Before you begin
Role required: timecard_approver or timecard_admin

Procedure

1. Log in to your instance in the Now Mobile application.

2. From the time sheets list, navigate to the All  section and tap the forward icon.

3. View the time sheets in different states such as submitted, pending, approved, or recalled 
during the current or previous weeks.

◦ To view the time sheets for the current week, tap This week  tab.

◦ To view the time sheets for the last week, tap Last week  tab.

◦ To view the time sheets for previous weeks, tap Older  tab.
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Recall a processed time sheet or time card from your mobile device

As a user manager, you can recall an incorrect time sheet or time card that is in the Approved 
or Processed state to return it to the submitter. The submitter can then make the necessary 
changes and resubmit the time sheet or time card.

Before you begin
Role required: timecard_approver or timecard_admin

Procedure

1. Log in to your instance using the Now Mobile application.

2. From the time sheets list in the Team approvals requests section, open the time sheet you 
want to recall or the one that contains the time card you want to recall.

3. Recall the time sheet or time card.

◦ To recall an approved time sheet, navigate to All  time sheets section, and select a time sheet 

from the This week, Last week, or Older  tab, and then tap the Recall ( ) icon

◦ To recall the entire time sheet, tap the action icon, and select Recall Time sheet  or tap the 
Recall time sheet  button at the bottom of the screen.

◦ To recall a specific time card, tap the action icon, and select Recall time card.

Monetary and non-monetary benefit plans
Benefit plans capture the potential benefits accrued by the work item when the work item is 
executed. You can create benefit plans to specify the estimated benefits in a category for a fiscal 
period.

Monetary and non-monetary benefit plans capture the financial and non-financial benefits 
respectively. You can also associate monetary and non-monetary benefit plans with each other, 
so that you can capture the potential benefits (financial and non-financial) accrued by the work 
item for the hybrid benefit plans.

Benefit Plans in Project Management

• Create a monetary benefit plan for a project

• Create a non-monetary benefit plan for a project

• Associate monetary and non-monetary benefit plans of a project

Benefit Plans in Demand Management

• Create a monetary benefit plan for a demand

• Create a non-monetary benefit plan for a demand

• Associate monetary and non-monetary benefit plans of a demand

Benefit Plans in Agile Development 2.0

• Create a monetary benefit plan for an agile development epic

• Create a non-monetary benefit plan for an agile development epic

• Associate monetary and non-monetary benefit plans of an agile development epic
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Benefit Plans in Scaled Agile Framework (SAFe)

• Create a monetary benefit plan for an SAFe epic

• Create a non-monetary benefit plan for an SAFe epic

• Associate monetary and non-monetary benefit plans of an SAFe epic

Strategic Spend Tracking for PPM
Strategic Spend Tracking for PPM  enables project or demand managers to evaluate the strategic 
value of organization’s projects and demands. You can identify the purpose and benefits of 
executing demands and projects and how they contribute to achieving company's strategies and 
goals.

Strategic Spend Tracking for PPM  enables demand and project managers to determine how and 
where funding is being spent during the execution of a demand or project.

Organizations generally determine and approve investment budgets that represent the funds 
allocated to achieve their goals. Strategic Spend Tracking for PPM  focuses on allocating your 
investment budget through demands and projects, and tracking the expenditure to achieve your 
organizational goals.

Each demand and project contributes to achieving one or multiple organizational goals. You can 
use the Strategic Spend Tracking for PPM  to perform the following tasks:

• Associate multiple strategies and goals with a demand or project.

• Allocate a percentage of the demand or project's total cost and benefits towards achieving one 
or more strategies and goals.

• Generate strategy and goal allocation breakdowns for a demand or project for the fiscal year.

• View the roll up of strategy and goal breakdowns from different demands and projects in the 
strategy and goal record.

• Use the Strategic Spend Tracking for PPM  dashboard to view how the planned costs, actuals 
costs, and benefits for projects aligned to the organization's goals and strategies trend over 
time in order to accurately understand the financial performance of your organization.

Install Strategic Spend Tracking for PPM

Install the Strategic Spend Tracking for PPM  application from ServiceNow  Store applications. 
Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Before you begin
Complete the following setup checklist for a smooth installation and configuration.

Setup checklist

Setup tasks Description

Verify that PPM Standard plugin 
(com.snc.financial_planning_pmo) is 
activated.

Navigate to Subscription Management 
> Subscriptions  in your instance. The 
list displays the subscriptions that your 
organization has purchased.

Role required: admin
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About this task
Activate the PPM Standard plugin (com.snc.financial_planning_pmo) in your ServiceNow 
instance before you install Strategic Spend Tracking for PPM. For more information see, Activate 
PPM Standard (Project Portfolio Management).

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the application using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find an application, you may 
have to request it from the ServiceNow Store.

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released 
apps, see the ServiceNow Store  version history release notes .

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are the sample records that describe application features for common use cases. 
Load the demo data when you first install the application on a development or test instance.

6. Select Install.

Related topics

List of plugins (Zurich)

Components installed with Strategic Spend Tracking for PPM

Several types of components are installed with activation of Strategic Spend Tracking for PPM, 
including tables and scheduled jobs.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Scheduled jobs installed

Scheduled job Description

PPM Strategic Spend Tracking - Generate 
Strategy/Goal Allocation Breakdowns for Projects 
and Demands

Generates breakdown of strategy and goal 
allocation for the associated projects and 
demands.

PPM Strategic Spend Tracking - Update projects 
and Demands with strategy and goal allocations

Updates strategy and goal allocations for 
the associated projects and demands.
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Tables installed

Table Description

BO Job Execution Log

[sn_ppm_sst_run_log]

Stores information about execution of the 
scheduled jobs such as time of execution and 
tasks there were included.

Goal Allocation

[sn_ppm_sst_task_goal]

Stores goal allocation details for a project or 
demand. The details include project or demand 
number, strategy name, % allocated towards 
the strategy, budget, planned cost, actual cost, 
and benefit amount.

Goal Allocation Breakdown

[sn_ppm_sst_goal_allocation_breakdown]

Stores goal breakdown details for a project 
or demand. The details include fiscal year, 
strategy allocation amount, cost details 
(planned and actual), and capex and opex 
amounts (planned and actual).

Strategy Allocation

[sn_ppm_sst_task_strategy]

Stores strategy allocation details for a project or 
demand. The details include project or demand 
number, strategy name, % allocated towards 
the strategy, budget, planned cost, actual cost, 
and benefit amount.

Strategy Allocation Breakdown

[sn_ppm_sst_strategy_allocation_breakdown]

Stores strategy breakdown details for a project 
or demand. The details include fiscal year, 
strategy allocation amount, cost details 
(planned and actual), and capex and opex 
amounts (planned and actual).

Allocate or modify the strategy and goal percentage for a project

Allocate the percentage of a project's total cost, benefit, and budget to help achieve the strategic 
objectives that the project fulfills. You can also view the breakdown of the project's financial data 
based on the allocated percentage.

Before you begin
You should have an existing project.

Execute the following scheduled jobs:

• PPM Strategic Spend Tracking - Update projects and demands with 
strategy and goal allocations

• PPM Strategic Spend Tracking - Generate Strategy/Goal Allocation 
Breakdowns for Projects and Demands

Role required: it_project_manager

Procedure

1. Navigate to Project  > Projects  > All.

2. Select the project to which you want to add or update allocation percentages.

3. In the Business Case  tab, add or update the strategies and goals with which the project is 
associated.
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For more information, see the Business Case field descriptions in the Create a project 
documentation topic.

4. Click Save.
The selected strategies and goals appear in the Strategy Allocations and Goal Allocations 
related lists.

5. Update strategy and goal allocations.

a. In the Strategy Allocations related list, click the % Allocation  field and enter the percentage 
that this project contributes towards the selected organizational strategy.

b. In the Goal Allocations related list, click the % Allocation  field and enter the percentage that 
this project contributes towards the selected organizational goal.

Note: 
The sum of strategy or goal allocations for a project must not exceed 100%.

6. Click the Recalculate Strategy and Goal Allocation  related link to update cost field values in 
the allocation tabs.

7. Click Update.

8. Optional:  In the Strategy or Goal Allocations related list, click the preview icon ( ), and then 
click Open Record  to view the breakdown of the strategy or goal allocation.

9. Optional:  View the trends for planned costs, actual costs, and benefits over time using the 
Strategic Spend Tracking for PPM dashboard.

Allocate or modify the strategy and goal percentage for a demand

Allocate the percentage of a demand's total cost, benefit, and budget towards achievement of 
strategic objectives that the demand fulfills. You can also view the breakdown of the demand's 
financial data based on the allocated percentage.

Before you begin
You should have an existing demand.

Execute the following scheduled jobs:

• PPM Strategic Spend Tracking - Update projects and demands with 
strategy and goal allocations

• PPM Strategic Spend Tracking - Generate Strategy/Goal Allocation 
Breakdowns for Projects and Demands

Role required: it_demand_manager

Procedure

1. Navigate to Demand  > Demands  > All.

2. Select the demand to which you want to add or update allocation percentages.

3. In the Business Case  tab, add or update the strategies and goals with which the demand is 
associated.
For more information, see the Business Case field descriptions in the Demand form 
documentation topic.

4. Click Save.x
The selected strategies and goals appear in the Strategy Allocations and Goal Allocations 
related lists.
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5. Update strategy and goal allocations.

a. In the Strategy Allocations related list, click the % Allocation  field and enter the percentage 
that this demand contributes towards the selected organizational strategy.

b. In the Goal Allocations related list, click the % Allocation  field and enter the percentage that 
this demand contributes towards the selected organizational goal.

Note: 
The sum of strategy or goal allocations for a demand must not exceed 100%.

6. Click the Recalculate Strategy and Goal Allocation  related link to update cost field values in 
the allocation tabs.

7. Click Update.

8. Optional:  In the Strategy or Goal Allocations related list, click the preview icon ( ), and then 
click Open Record  to view the breakdown of the strategy or goal allocation.

9. Optional:  View the trends for planned costs, actual costs, and benefits over time using the 
Strategic Spend Tracking for PPM dashboard.

Strategic Spend Tracking for PPM  dashboard

The Strategic Spend Tracking for PPM  dashboard provides comprehensive visualization to the 
business planners to help them understand how the planned costs, actual costs, and benefits 
for projects aligned to the organization's goals and strategies trend over time. It helps you to 
accurately understand the financial performance of your organization.

Note: 
Starting with version 1.1.0, the Strategic Spend Tracking for PPM  dashboard is available in 
the Next experience UI Framework which can be accessed by navigating to All  > Strategic 
Spend Tracking for PPM  > Analytics.

You can analyze the total expenses, and drill down to what is contributing to the cost, and which 
departments and business units are spending.
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Strategy Overview tab

Strategy Detail tab

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1819



Goal Overview tab

Goal Detail tab

End user and roles

End user and goal Required role

Business Planner: Needs visibility into 
strategies and goals for projects and demands 
in the organization.

business_planner

Indicators

The dashboard contains the following indicators for strategies:

Projects

Comparison of aligned and unaligned projects for strategies.

Aligned Projects

Count of the projects aligned to strategies.
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Unaligned Projects

Count of the projects not aligned to strategies.

Planned Cost

Comparison of aligned and unaligned planned cost for strategies.

Planned Cost - Aligned Projects

Total planned cost for all projects aligned to strategies.

Planned Cost - Unaligned Projects

Total planned cost for all projects not aligned to strategies.

Total Benefit

Comparison of aligned and unaligned benefit amount for strategies.

Total Benefit - Aligned Projects

Total benefit amount for all projects aligned to strategies.

Total Benefit - Unaligned Projects

Total benefit amount for all projects not aligned to strategies.

Actuals

Comparison of aligned and unaligned actual cost for strategies.

Actuals - Aligned Projects

Total actual cost for all projects aligned to strategies.

Actuals - Unaligned Projects

Total actual cost for all projects not aligned to strategies.

The dashboard contains the following indicators for goals:

Projects

Comparison of aligned and unaligned projects for goals.

Aligned Projects

Count of the projects aligned to goals.

Unaligned Projects

Count of the projects not aligned to goals.

Planned Cost

Comparison of aligned and unaligned planned cost for goals.

Planned Cost - Aligned Projects

Total planned cost for all projects aligned to goals.

Planned Cost - Unaligned Projects

Total planned cost for all projects not aligned to goals.

Total Benefit

Comparison of aligned and unaligned benefit amount for goals.

Total Benefit - Aligned Projects

Total benefit amount for all projects aligned to goals.

Total Benefit - Unaligned Projects

Total benefit amount for all projects not aligned to goals.

Actuals
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Comparison of aligned and unaligned actual cost for goals.

Actuals - Aligned Projects

Total actual cost for all projects aligned to goals.

Actuals - Unaligned Projects

Total actual cost for all projects not aligned to goals.

Breakdowns

The dashboard includes the following breakdowns:

• Strategy

• Goal

• Project Cost

• Project Benefit

• Actuals

Data visualizations

The dashboard includes the following visualizations for strategies:

Title Type Description

Project Cost

Bar chart 

Comparison of total planned 
and actual costs for all 
projects grouped by fiscal 
period for strategies.

Project Benefit

Bar chart 

Comparison of total planned 
and actual benefits for all 
projects grouped by fiscal 
period for strategies.

Project Distribution

Pie chart

Breakdown of the distribution 
of projects by strategy.

Planned Cost Distribution

Pie chart

Breakdown of the distribution 
of planned cost of projects by 
strategy.

Planned Benefit Distribution

Pie chart

Breakdown of the distribution 
of planned benefit of projects 
by strategy.

The dashboard includes the following visualizations for goals:
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Title Type Description

Project Cost

Bar chart 

Comparison of total planned 
and actual costs for all 
projects grouped by fiscal 
period for goals.

Project Benefit

Bar chart 

Comparison of total planned 
and actual benefits for all 
projects grouped by fiscal 
period for goals.

Project Distribution

Pie chart

Breakdown of the distribution 
of projects by goals.

Planned Cost Distribution

Pie chart

Breakdown of the distribution 
of planned cost of projects by 
goals.

Planned Benefit Distribution

Pie chart

Breakdown of the distribution 
of planned benefit of projects 
by goals.

Project Portfolio Management  Platform Analytics Solutions
Platform Analytics Solutions  contain preconfigured dashboards. These dashboards contain 
actionable data visualizations that help you improve your business processes and practices.

Platform Analytics  data visualizations use Performance Analytics  indicator  data to show you data 
over time, helping you analyze your business processes and identify areas of improvement. With 
Platform Analytics Solutions, you can get value from Performance Analytics  for your application 
with minimal setup. You can always create your own objects as well.

To enable the solution for Project Portfolio Management, log in as an admin and navigate to 
Performance Analytics  > Guided Setup. Click Get Started, then scroll to the section for PPM 
Standard Dashboards. The guided setup takes you through the entire setup and configuration 
process.

Alternatively, activate the Performance Analytics – Content Pack – PPM Standard plugin 
(com.snc.pa.pmo_dashboards).

Activation of com.snc.pa.pmo_dashboards plugin also activates the following plugins:

• PPM Standard (com.snc.financial_planning_pmo)

• Performance Analytics – Content Pack – Project Portfolio Suite Dashboards 
(com.snc.pps_dashboards)

Access the PMO dashboard using either of the following navigation links:

• Project  > Portfolios  > Portfolio Dashboard.

• Project  > Programs  > Program Dashboard.

• Self-Service  > Dashboards. Search for PMO Dashboard  using the search field.

• Time Sheets  > Time Sheet Portal  > Time Sheet Dashboard.
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The dashboard displays the data based on the navigation link used to open it.

Domain separation and 'Run As' user

In some solutions, System Administrator is the Run As  user for data collection jobs in the 
Platform Analytics Solutions. In other solutions, the Run As  user for data collection jobs is left 
blank. Verify that the Run As  user exists on the instance, and that this user has the appropriate 
level of access. An inappropriate Run As  user can cause errors or limit the data that is collected. 
This setting only has an effect if domain separation is enabled.

Older version of this solution

This solution replaces the Project Portfolio Suite (com.snc.pa.ppm) Solution. If you activated an 
earlier version of the solution and then upgraded your instance, you still have and can still use 
the earlier solution. You can also activate the newer version without losing data from existing 
indicators and breakdowns. If you activate the newer version, run a historical data collection job 
to populate new indicators and breakdowns for the Time Sheet dashboard.

Related topics

Activate your Performance Analytics subscription

PMO dashboard

The PMO dashboard provides comprehensive reports to the portfolio and program managers. 
The dashboard uses Platform Analytics  to provide a trend of historical data as well as regular 
reports. It gives an overview of your investments, provides a pipeline view of upcoming intake 
and a calendar view of upcoming dates.

Note: 
The PMO dashboard is available in the next experience UI framework which can be 
accessed through Analytics Portfolio. In the next experience, these features are not 
supported:

• Pipeline details  pane in the Pipeline  tab.

• Highlight based on  list and View all records  link in the Calender  tab.

PMO dashboard in Next experience UI

This animation shows all of the data visualizations in the PMO dashboard tab by tab. They are 
described in the Data Visualizations section of this topic.
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End user and roles

End user and goal Required role

Portfolio manager: Needs visibility into 
programs, projects, and demands in their 
portfolio and actions that should be taken.

it_portfolio_manager

Program manager: Needs visibility into 
projects and demands in their programs and 
actions that should be taken.

it_program_manager

Project manager: Has access to the 
dashboards.

it_project_manager

Indicators

The Summary, Pipeline, and Project Health tabs in the dashboard contain widgets with the 
following indicators. The data for projects is collected from the [pm_project] table, the data for 
demands is collected from the [dmn_demand] table, and the data for ideas is collected from the 
[idea] table.

PPM – Number of Active Projects

Count of active projects. Projects are considered active where actual end date is 
<after today> or <empty>.

Note: 
If the Actual End Date for a project is in the future but the project is in Closed 
state, the reports still pick up the project as active.

PPM – Allocated Hours less than Planned Hours

Count of active projects that have resource plans where the allocated hours is less 
than the planned hours.

PPM – Active Projects in Open, Pending, Work in Progress state

Count of active projects in Open, Pending, or Work in Progress state.

PPM – Number of Active Red Projects

Count of active projects that have an overall red status.

PPM – Total age of Open Project

Total age of all active projects in days. It is the difference between the planned start 
date of the active project and the date when the indicator score is collected. The 
indicator is used to calculate the average age of open projects.

PPM – Planned Cost

Total planned cost for all the active projects.

PPM – Actual Cost

Total actual cost for all the active projects.

PPM – Number of Active Projects with negative ROI

Count of active projects with a negative Return on Investment.

PPM – Estimate at Completion

Total estimated cost at completion for all active projects.

PPM – Number of Projects with High Risks
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Count of active projects that have a Risk in Pending state and Probability as 
Absolute or High.

PPM – Number of Projects with Critical Issues

Count of active projects that have an Issue with state Open or Work in Progress and 
priority as Critical.

PPM – Number of Projects with Missed Milestones

Count of active projects that have a milestone with planned end date due before 
today.

PPM – Number of Active Overdue Projects

Count of active projects that have Planned end date  before today.

PPM – Unallocated Resources

Count of projects in state Work in Progress that have resource plans in Planning, 
Requested, or Confirmed state.

PPM – Allocated Hours less than Actual Hours

Count of active projects that have resource plans where the actual hours is greater 
than the allocated hours. 

PPM – Planned Benefits

Total planned benefit for all active projects.

PPM – Actual Benefits

Total actual benefit for all active projects.

PPM – Number of Projects with critical Change Requests

Count of active projects that have a Project Change Request with state as Open and 
priority as Critical.

PPM – Number of Total Demands this Month

Count of demands in the given month with state other than Draft.

PPM – Number of Demands with Projects this Month

Count of demands that are converted to projects in the given month.

PPM – Open Demands Submitted, Screening, Qualified or Approved

Count of demands in Submitted, Screening, Qualified, or Approved state.

PPM – Total Age of Open Demand in Submitted, Screening, Qualified, Approved state

Total age (in days) of active demands in Submitted, Screening, Qualified, or 
Approved state. It is the difference between the creation date of the demand and 
the date when the indicator score is collected. The indicator is used to calculate the 
average age of open demands.

PPM – Total Age of Demand to Project this Month

Total age (in days) of all demands that are converted to projects in the given month. 
It is sum of the difference between the creation date of demands and the creation 
date of corresponding projects. The indicator is used to calculate the average age of 
Demand to Project.

PPM – Number of Open Ideas

Count of ideas in Submitted state and no Demand associated.

PPM – Total Age of Open Idea

Total number of days an idea is in state Submitted before conversion to demand.

PPM – Number of Total Ideas this Month
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Count of ideas other than Draft state and created in the given month.

PPM – Number of Ideas with Demands this Month

Count of ideas converted to demands in the given month.

The dashboard also uses the following formula indicators. The formula indicators are based on 
few of the preceding indicators.

PPM – Average age open project

Average number of days a project is in state Pending, Open, or Work in 
Progress. The indicator is calculated using the PPM – Total Age of Open Project 
and PPM – Number of Active Projects  indicators.

PPM – Percentage of Ideas to Demands last 12 months

Percentage of ideas converted to demands in last 12 months.

PPM – Average age Demand to Project last 12 months

Average number of days before a demand has been converted to a project.

PPM – Percentage of Demand to Project last 12 months

Percentage of demands converted to projects in last 12 months.

PPM – Average age open demand

Average number of days a demand is in state Submitted, Screen, Qualified, or 
Approved and has not been converted to project.

PPM – Average age open idea

Average number of days an idea is in state Submitted before conversion to demand.

PPM – Portfolio Health

Percentage of portfolio health based on active projects in overall red status, active 
projects that are overdue, and active projects with critical issues.

Breakdowns

• Business Unit

• Demand Category

• Demand Manager

• Demand State

• Demand Type

• Department

• Impact

• Portfolio

• Portfolio Manager

• Priority

• Program

• Program Manager

• T-Shirt Size

• Execution Type

• Investment Class

• Investment Type
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• Project Manager

• Project Phase

• Project State

• Project Status

• Overall Health

Data visualizations

The dashboard includes the following visualizations:

Title Type Description

Benefit Plans by Category

Pie chart 

Breakdown of the number of 
benefit plans in each category 
for active projects.

Projects Planned Benefits by 
Category (Monetary)

Horizontal bar chart Total planned financial 
benefits in each category for 
active projects.

Projects by Business Unit

Pie chart 

Breakdown of the number 
of active projects in each 
business unit.

Projects by Investment Type

Pie chart 

Breakdown of the number of 
active projects grouped by 
investment type.

Projects by Investment Class

Pie chart 

Breakdown of the number of 
active projects grouped by 
investment class.

Projects by Priority Horizontal bar chart Breakdown of the number of 
active projects grouped by 
priority.

Hours by Project Time 
Category

Line chart

Trend of total hours reported 
in time cards for each Project 
Time Category. The trend is 
displayed from the beginning 
of last quarter until the end of 
next quarter.

Active Demands

Single score 

Number of demands in 
Submitted, Screened, 
Qualified, and Approved state 
with no project associated.
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Title Type Description

Demands – No Manager

Single score 

Number of active demands 
with no associated demand 
manager.

Demands – No Business Case

Single score 

Number of active demands 
with no business case.

Demands – No Planned Cost

Single score 

Number of active demands 
with zero total planned cost.

Demands – No Start Date

Single score 

Number of active demands 
with no start date.

Demands – No Investment 
Class

Single score 

Number of active demands 
with no associated investment 
class.

Demands – No Budget Cost

Single score 

Number of active demands 
with zero capital and zero 
operating budget.

Demands – No Due Date

Single score 

Number of active demands 
with no due date.

Demands – No Investment 
Type

Single score 

Number of active demands 
with no associated investment 
type.

Demands – No Financial 
Benefits

Single score 

Number of active demands 
with no or zero financial 
benefit.

Demands – No Portfolio

Single score 

Number of active demands 
with no associated portfolio.

Demands – No Program

Single score 

Number of active demands 
with no associated program.

Demands – No ROI

Single score 

Number of active demands 
with no Return on Investment.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1829



Title Type Description

Active Projects

Single score 

Number of projects with actual 
end date <after today> or 
<empty>.

Projects – No Manager

Single score 

Number of active projects 
with no associated project 
manager.

Projects – No Business Case

Single score 

Number of active projects with 
no business case.

Projects – No Planned Cost

Single score 

Number of active projects with 
zero total planned cost.

Projects – No Task

Single score 

Number of active projects with 
no associated project tasks.

Projects – No Investment 
Class

Single score 

Number of active projects with 
no associated investment 
class.

Projects – No Budget Cost

Single score 

Number of active projects with 
zero budget cost.

Projects – No Description

Single score 

Number of active projects that 
have no description.

Projects – No Investment Type

Single score 

Number of active projects with 
no associated investment 
type.

Projects – No Planned Benefit

Single score 

Number of active projects with 
zero planned benefit.

Projects – No Portfolio

Single score 

Number of active projects with 
no associated portfolio.

Projects – No Program

Single score 

Number of active projects with 
no associated program.
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Title Type Description

Projects – No ROI

Single score 

Number of active projects 
with no planned Return on 
Investment.

Planned vs Budget vs Actual 
Cost

Bar chart 

Comparison of total planned, 
budget, and actual costs for 
active projects grouped by 
fiscal period.

Allocated vs Actual Hours

Step line chart

Monthly trends of total 
allocated and actual hours 
for resource plans associated 
with active projects.

Monetary Planned vs Actual 
Benefits

Bar chart 

Comparison of total planned 
and actual financial benefits 
for active projects grouped by 
fiscal period.

Non-monetary Planned vs 
Actual Benefits

Bar chart 

Comparison of total planned 
and actual non-financial 
benefits for active projects 
grouped by fiscal period.

Monetary Planned vs Actual 
Benefits by Category

Bar chart 

Comparison of total planned 
and actual financial benefits in 
each benefit plan category for 
active projects.

Project Completion Calendar

Calendar

Calender view of planned 
end dates of projects, project 
tasks, and milestones.

Analytics Time sheet

The Analytics Time sheet provides comprehensive time sheet activities and reports to the time 
card approvers and time card users. The dashboard uses Performance Analytics to provide a 
trend of historical data and regular reports. It gives an overview of the time sheet activities of 
resources, time sheet approval and rejection rate, over-allocated and under-allocated resource 
counts.

Important: 
Starting with Zurich  release, Time Sheet Dashboard  is renamed to Analytics Time sheet  for 
new customers.
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Overview tab

Delinquent Activity tab
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Analysis tab

End user and roles

End user and goal Required role

Portfolio manager: Needs visibility into time 
sheet activities of resources and actions that 
should be taken.

it_portfolio_manager

Program manager: Needs visibility into time 
sheet activities of resources and actions that 
should be taken.

it_program_manager

Project manager: Has access to the 
dashboards.

it_project_manager

Time card approver: Needs visibility into time 
sheet activities of resources and actions that 
should be taken.

timecard_approver

Business stakeholder for PPM: Needs visibility 
into time sheet activities of resources and 
actions that should be taken.

sn_ppm_read

Indicators

The Overview, Delinquent Activity, and Analysis tabs in the dashboard contain widgets with the 
following indicators. The data for time sheets and time cards is collected from the [time_sheet] 
table and the data for users is collected from the [users] table.

PPM – Active Time Sheet Users

Count of active users with the timecard_user role.

PPM – % Late This Year
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Percentage of time sheets late this year.

PPM – % Late This Week

Percentage of time sheets late this week.

PPM – % Late This Quarter

Percentage of time sheets late this quarter.

PPM – % Late This Month

Percentage of time sheets late this month.

PPM – Late Time Sheets This Month

Count of late time sheets this month. The indicator includes time sheets of the 
current month until the past week that are not in the Approved or Processed state.

PPM – Late Time Sheets This Quarter

Count of late time sheets this quarter. The indicator includes time sheets of the 
current quarter until the past week that are not in the Approved or Processed state.

PPM – Late Time Sheets This Week

Count of late time sheets this week. The indicator includes time sheet of the past 
week that are not in the Approved or Processed state.

PPM – Late Time Sheets This Year

Count of late time sheets this year. The indicator includes time sheets of the current 
year until the past week that are not in the Approved or Processed state.

PPM – Total Time Sheets Last Week

Total number of time sheets for the past week.

PPM – Total Time Sheets This Month

Total number of time sheets for the weeks in the current month.

PPM – Total Time Sheets This Quarter

Total number of time sheets for the weeks in the current quarter.

PPM – Total Time Sheets This Year

Total number of time sheets for the weeks in the current year.

PPM – Time Sheets Approved This Week

Count of time sheets approved this week. The indicator includes time sheets in the 
Approved or Processed state.

PPM – Time Sheets Missing This Week

Count of users with the timecard_user role who did not submit time sheet for the 
current week.

PPM – Time Sheets Pending This Week

Count of time sheets pending this week. The indicator includes time sheets for the 
current week in the Pending state.

PPM – Time Sheets Recalled This Week

Count of time sheets recalled this week. The indicator includes time sheets for the 
current week in the Recalled state.

PPM – Time Sheets Rejected This Week

Count of time sheets rejected this week. The indicator includes time sheets for the 
current week in the Rejected state.

PPM – Time Sheets Submitted This Week
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Count of time sheets submitted this week. The indicator includes time sheets for the 
current week in the Submitted state.

Breakdowns

• User

• Manager

• Department

• Cost Center

• Portfolio

• Program

• Project

Data visualizations

Title Type Description

Rejected

Single score 

Number of time cards that are 
in the Rejected state for the 
last 30 days.

Late

Single score 

Number of time cards that 
were submitted late in the last 
30 days.

Pending Approvals

Single score 

Number of time cards that 
have approval pending in the 
last 30 days.

By State

Bar chart 

Number of time cards in the 
last 30 days, grouped by their 
state.

By Category

Heat map 

Breakdown of time spent 
(hours) by a resource 
across different project time 
categories in the last 30 days.

By Resource

List 

The list of time cards 
submitted by a resource in 30 
days.

Total Hours

Bar chart 

Total time (hours) spent on by 
different categories.
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Title Type Description

Total Hours by Week Starts On Time series line Weekly trend of the total time 
(hours) spent on different 
categories over a period of 
time.

Time Sheets Over 40 Hours

Bar chart 

Count of time sheets over 
40 hours indicating over-
allocated resources.

This report does not refresh 
when you select portfolio, 
program, or project.

Allocated vs Actual Hours Time series step Monthly trend comparing the 
total allocated hours versus 
actual hours for all time card 
users.

Time Cards By Expense Type

Bar chart 

Time cards grouped by 
expense types: Capital 
Expense (Capex) and 
Operating Expense (Opex).

Project Portfolio Management  reference
Reference topics provide information about domain separation, quick start tests, business 
stakeholder role access, and others related to Project Portfolio Management.

Components installed with Project Portfolio Management  (PPM) Standard

Several components are installed with the activation of the PPM Standard plugin.

Demo data is available with PPM Standard. The demo data provides sample projects, demands, 
programs, portfolios, expense lines. The demo data also provides sample cost plans and budget 
plans for the sample projects and demands.

Plugins installed with PPM Standard (Project Portfolio Management)

Multiple plugins are installed with activation of PPM Standard plugin, if they are not already 
active.

PPM Standard plugins

PPM Standard adds the following plugins.

Plugin Name Description

Project Portfolio Suite

[com.snc.project_portfolio_suite]

Activates an integrated set of applications for 
project portfolio management and IT software 
development.

Financial Planning

[com.snc.financial_planning]

Enables financial analysts to assemble spending 
data, build cost models, and generate reports to 
show how funds are being allocated.
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Plugin Name Description

Rate Model

[com.snc.rate_model]

Delivers date-effective hourly rates for a specific set 
of criteria coming from the project, demand, or time 
card being processed.

Ideation with PPM

[com.snc.ppm_innovation_management]

Enables your organization to collect new ideas, 
collaborate on ideas, and identify great ideas 
for implementation. Convert selected ideas to 
demands, stories, projects, and epics.

Project Portfolio Suite plugins

Project Portfolio Suite adds the following plugins.

Plugin Name Description

Demand Management

[com.snc.demand_management]

Enables capturing the demands and provide tools to 
screen, assess and prioritize them.

Project Management

[com.snc.project_management_v3]

Enables planning, organizing and managing projects 
and resources in order to setup, execute, and complete a 
project faster and easier.

Resource Management

[com.snc.resource_management]

Enables resource requesters and resource managers to 
plan, organize, and manage resources for both planned 
and operational work.

Demand management plugins

Demand management adds the following plugins.

Plugin Name Description

Process Flow Formatter

[com.snc.process_flow_formatter]

Summarize multiple pieces of information about a process 
and display the stages graphically at the top of a form.

Assessment

[com.snc.assessment_core]

Evaluate, score, and rank records from tables in the system. 
Evaluate results using unique graphical views designed to 
highlight key performance information.

Timeline Visualization

[com.snc.timeline_visualization]

Provide a high-level graphical representation of your 
strategic and operational activities for your organization 
such as incidents, problems, changes, and projects.

Project management plugins

Project management adds the following plugins.

Plugin Name Description

Checklist Checklists for tasks.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1837



Plugin Name Description

[com.glide.ui.checklist]

Cost Management

[com.snc.cost_management]

Enables the definition and tracking of configuration item 
costs. Uses rate cards with CIs, contracts, and projects.

Process Flow Formatter

[com.snc.process_flow_formatter]

Displays the different stages in a linear process flow across 
the top of a record.

Skills Management

[com.snc.skills_management]

Enables an administrator to assign configured 
competencies, called skills, to groups or individual users.

Timeline Visualization

[com.snc.timeline_visualization]

Enables graphical representation of activities over time.

Time card management

[com.snc.time_card]

Enables the creation of linear timelines for any activity that 
is bounded by two dates, such as the actual start and end 
dates on a project task.

Resource management plugins

Project management adds the following plugins.

Plugin Name Description

Cost Management

[com.snc.cost_management]

Enables the definition and tracking of configuration item 
costs. Uses rate cards with CIs, contracts, and projects.

Process Flow Formatter

[com.snc.process_flow_formatter]

Displays the different stages in a linear process flow across 
the top of a record.

Tables installed with PPM Standard (Project Portfolio Management)

Tables are added with activation of PPM Standard plugin.

PPM Standard tables

PPM Standard adds the following tables.

Table Description

Cost Plan

[cost_plan]

Cost plan for the resources required for the project.

Cost Plan Breakdown

[cost_plan_breakdown]

Cost breakdown of resources based on project, 
program, or portfolio. These records are rollups of all 
costs. Project task cost plans are not rolled up to the 
project.
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Table Description

Cost Type Definition

[resource_type_definition]

Definitions of cost types, which specify either an 
operating expense or capital expense, and can link 
accounts in the General Ledger [itfm_gl_accounts] 
table. The General Ledger table is installed with the 
Financial Management application.

Project Funding

[project_funding]

Project or demand target and budget expense values 
for both capital and operating expenses. The records 
in this table are for a single fiscal year.

Benefit Plan

[benefit_plan]

Benefit plan for the potential benefits that the project 
or demand can accrue.

Benefit Breakdown

[benefit_plan_breakdown]

Benefit breakdown for the project or demand. These 
records are rollups of all benefits.

Budget Reference Rates

[itfm_fx_rate]

The exchange rates that budgets use.

Inbound Actuals Configuration

[sn_invst_pln_inbound_actuals_config]

Import and map project codes from ERP systems to 
SPM.

Incoming Expense Lines

[sn_invst_pln_inbound_actuals]

Import expense lines from ERP systems to SPM.

Project Portfolio Suite tables

Project Portfolio Suite adds the following tables.

Table Description

Project Stakeholder

[pm_m2m_project_stakeholder]

Stores all stakeholders who are associated with one or more 
projects.

Project Time Card Exception

[project_timecard_exception]

Stores time card information such as Week starts on, User, 
Project, and State of the time cards.

Project Time Category

[project_time_category]

Stores project sub-categories created for time cards.

Time Sheet Exception

[time_sheet_exception]

Stores time sheet information such as Week starts on, User, 
and State of the time sheets.

Demand management tables

Demand management adds the following tables.
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Table Description

Demand

[dmn_demand]

Stores all demands.

Decision

[dmn_decision]

Stores all decisions.

Stakeholder Register

[dmn_stakeholder_register]

Stores all stakeholders.

Requirement

[dmn_requirement]

Stores all requirements.

Demand Stakeholder

[dmn_m2m_demand_stakeholder]

Stores all stakeholders who are associated with one or 
more demands.

Demand Stage Config

[dmn_stage_config]

Stores the images displayed in the demand stage pop-up 
window.

Idea

[idea]

Stores all ideas.

Demand Task

[dmn_demand_task]

Stores tasks associated with demands. Extends the 
planned_task table to support demand-level task tracking 
and resource allocation.

Project management tables

Project management adds the following tables.

Table Description

Goal

[goal]

Project goals.

Issue

[issue]

Project issues.

Personalize Workbench

[workbench_config_user]

Configuration settings for each user that utilizes the 
workbench.

Portfolio

[pm_portfolio]

Portfolios.

Portfolio Project Portfolio projects.
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Table Description

[pm_portfolio_project]

Portfolio Project Goal

[pm_portfolio_goal]

Portfolio project goals.

Portfolio Project Issue

[pm_portfolio_issue]

Portfolio project issues.

Portfolio Project Relationships

[pm_m2m_portfolio_project]

All relationships between a portfolio and each 
project in the portfolio.

Portfolio Project Risk

[pm_portfolio_risk]

Portfolio project risks.

Project

[pm_project]

All projects.

Project Task

[pm_project_task]

All tasks used in projects.

Project Task Link

[pm_project_task_link]

All records for linked changes (installed with the v3 
plugin).

Project Template

[project_template]

Project templates.

Project Template Configuration

[project_template_config]

Configuration settings for project templates.

Project Template Task

[project_template_task]

Tasks in project templates.

Risk

[risk]

Project risks.

Project Change Request

[project_change_request]

Project change requests.

Status Report

[project_status]

Project status reports.

Teamspace

[pm_app_config]

All teamspaces, which refer to the tables that are 
created for the teamspaces. See Installed with 
teamspaces  for a list of teamspace tables.
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Table Description

Planned task Relationship

[planned_task_rel_planned_task]

Predecessor and successor tasks in a dependent 
relationship, including task lag values.

Baseline

[planned_task_baseline]

All baselines.

Baseline Item

[planned_task_baseline_item]

All tasks that are part of baselines.

Task Relationship

[task_rel_task]

Predecessor and successor tasks in a dependent 
relationship.

Planned task Recalculation Exclusions

[planned_task_recalculation_exclusions]

Defines tables that are excluded from recalculation 
(start and end dates). For example, the table is used 
for all sub tables under planned_task to exclude 
tables from being recalculated.

This table allows you to configure the tables from 
which you would not like to perform the recalculation 
from.

Program management tables

Program management adds the following tables.

Table Description

Program Task

[pm_program_task]

All the tasks in program

Program

[pm_program]

All programs

Resource management tables

Resource management adds the following tables.

Table Description

Group Resource Roles

group_has_resource_role

Stores the resource roles for the groups with pps_resource_role. 
The roles in this table are populated from the User Resource Role 
[user_has_resource_role] table of the users that are part of a group.

The table is read-only.

Requested Allocation Daily

[requested_allocation_daily]

Stores day-level breakdown for requested allocations.

The table is read-only.
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Table Description

Resource Allocation

[resource_allocation]

Allocations for resources.

Resource Allocation Daily

[resource_allocation_daily]

On a day-to-day basis, stores the events that are created through a resource 
plan. Also stores:

• User created calendar events as records.

• Actual hours that a user has spent on a task, project, or any other type of 
activity, such as meeting or admin work.

Resource Aggregate Daily

[resource_aggregate_daily]

On a day-to-day basis, stores aggregated values, such as capacity, allocated 
hours in a project, confirmed hours in a project, non-project time, actual 
hours, and availability of every user.

This table is not enabled by default. To generate daily 
aggregates and store them in this table, create the 
com.snc.resource_management.generate_daily_aggregates 
property and set the value to true.

Resource Aggregate Weekly

[resource_aggregate_weekly]

On a weekly basis, stores aggregated values, such as capacity, allocated 
hours in a project, confirmed hours in a project, non-project time, 
actual hours, and availability of every user. The values in the table are 
asynchronously updated on every insert/update/delete to the Resource 
Allocation Daily [resource_allocation_daily] table.

Resource Aggregate Monthly

[resource_aggregate_monthly]

On a monthly basis, stores aggregated values, such as capacity, allocated 
hours in a project, confirmed hours in a project, non-project time, 
actual hours, and availability of every user. The values in the table are 
asynchronously updated on every insert/update/delete to the Resource 
Allocation Daily [resource_allocation_daily] table.

Requested Allocation

[requested_allocation]

Allocations for resource plans.

Resource Event

[resource_event]

Stores events that are created for a user.

Resource Event Color

[resource_event_color]

The colors that the application displays for each event type.

Resource Plan

[resource_plan]

All resource plans. These columns were added for Helsinki: top_task, 
program, portfolio.

Resource Plan Logs

[resource_plan_logs]

Stores errors and warning that might occur during the resource allocation for 
a resource plan.

Resource Report

[resource_report]

Resource reports that you can generate and save.

Resource Report Chart This table is not used.
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Table Description

[resource_report_chart]

Resource Report Daily

[resource_report_daily]

Daily resource reports that you can generate and save.

Resource Report Export

[resource_report_export]

Saves JPG and PNG exports of resource management reports.

Resource Report Monthly

[resource_report_monthly]

Monthly resource reports that you can generate and save.

Resource Role

[resource_role]

Stores project specific roles.

User Resource Role

[user_has_resource_role]

Stores the resource roles for a user.

User Calendar Event

[user_calendar_event]

Stores events that are created in the calendar of a user.

User Schedule

[user_has_schedule]

Stores the schedule for a user.

Innovation management tables

Innovation Management  adds the following tables.

Table Description

Idea

[im_idea_core]

Default table which stores all the information 
related to the Idea portal. Extends the Task 
table.

Idea Category

[im_category]

Stores the list of static idea categories.

Idea Category Configuration

[im_category_config]

Stores idea category definition information 
such as the table to use, field name, and 
hierarchy of the idea category. Also stores 
mapping information between idea categories 
table and the Idea module.

Idea Categories

[im_m2m_idea_category]

Stores mapping information between idea 
categories and ideas.

Idea Module Configuration for the Idea portal such as 
module name, module id, and idea table to 
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Table Description

[im_module]
use. Create a separate table for each Idea 
module.

Time card management tables

Time card management adds the following tables.

Table Description

Time Card

[time_card]

Stores time logged by the user against a category such as a task, meeting, 
or training.

Time Sheet

[time_sheet]

Groups all time cards for the user for a week.

Time Sheet Policy

time_sheet_policy

Stores all time sheet policies.

Time Card Daily

[time_card_daily]

Stores the time logged in a time card on daily basis.

Rate model tables

Rate model add the following tables.

Table Description

Rate Model

[rate_model]

Stores rate model definition.

Rate Model Entity

[rate_model_entity]

List of entities from which the attributes can be 
selected.

Rate Model Entity Attribute

[rate_model_entity_attribute]

List of attributes in the entities.

Rate Model Line

[rate_model_line]

Stores rate line values.

Rate Model Line Attribute

[rate_model_line_attribute]

Stores rate line attributes that are added from 
the entities.

Rate Line Import Set

[imp_rate_model_line]

Stores import sets that you imported into the 
instance.
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Roles installed with PPM Standard (Project Portfolio Management)

Roles are added with activation of PPM Standard plugin.

Project Portfolio Suite roles

Project Portfolio Suite adds the following roles.

Role title [name] Description Contains roles

Portfolio manager

[it_portfolio_manager]

Has access to all portfolios. Has the same 
access permissions as a project user and a 
demand user. Also has budget owner role 
is added as part of Financial Management.

• it_demand_user

• it_project_manager

• it_project_user

• portfolio_manager

• it_demand_manager

• it_project_portfolio_user

PPS admin

[it_pps_admin]

Can view and modify the preferences, 
configurations, and settings for projects, 
demands, programs, portfolios, resources, 
time cards, agile development, and 
timeline visualization.

• it_program_manager

• it_portfolio_manager

• it_project_manager

• it_demand_manager

• pps_admin

• timeline_admin

• rate_model_admin

Demand management roles

Demand management adds the following roles.

Role title [name] Description Contains roles

Demand manager

[it_demand_manager]

Can access all the modules of the Demand 
Management application.

• it_project_user

• resource_user

• timeline_user

• demand_manager

• it_demand_user

• rate_model_user

Demand user

[it_demand_user]

Can access the Demand and Stakeholders 
modules of the Demand Management 
application.

• demand_user

• pps_resource
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Project management roles

Project management adds the following roles.

Role title [name] Description Contains roles

Portfolio user

[it_project_portfolio_user]

User who can view IT Portfolio Project 
records.

project_portfolio_user

Project user

[it_project_user]

Can only view Project form fields. Can 
modify additional fields on the Project 
Task form, such as Time constraint  and 
State.

• it_project_portfolio_user

• project_user

Project manager

[it_project_manager]

Has access to all Project Management 
application features and functionality. 
This role enables project managers 
to create and manage projects, tasks, 
and resource plans. For configuration 
access to modify application settings 
and preferences, use the PPS admin 
[it_pps_admin] role instead.

• resource_user

• it_demand_manager

• it_project_user

• project_manager

The project_manager 
role also contains the 
timecard_approver role.

• timeline_user

• rate_model_user

Program management roles

Program management adds the following roles.

Role title [name] Description Contains roles

Program manager

[it_program_manager]

Program managers have access to all programs. • resource_user

• it_project user

• program_manager

• it_demand_user

Resource management roles

Resource management adds the following roles.

Role title [name] Description Contains roles

Resource manager

[resource_manager]

Users with this role can: • resource_user

• timecard_approver
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Role title [name] Description Contains roles

• Review resource plans, confirm, and allocate 
resources to tasks.

• Create skills and view them in the User Skills list.

• Read schedules.

• Create a group of type pps_resource.

• Add users to or remove them from any groups.

• Update group name, group email, parent, 
description, manager, average daily FTE hours/
hours per person day, and hourly rate.

• skill_admin

• rate_model_user

Resource user

[resource_user]

Users with this role can create resource plans and 
request resources. Project managers are typically 
given this role. Resource users cannot make 
changes to plans in the Confirmed or Allocated 
state.

None

PPS resource

[pps_resource]

Only users with the PPS Resource role are 
considered for resource planning, and only users 
or groups with the PPS resource role appear in 
resource plans.

None

Innovation management roles

Innovation Management  adds the following roles:

Role title [name] Description Contains roles

Idea admin

[idea_admin]

• Creates idea module.

• Defines idea categories.

• Configures mapping of idea categories with 
idea module.

• Manages ideas and creates tasks such as 
story, epic, feature, project, or demand from 
an idea.

idea_manager

Idea manager

[idea_manager]

Manages ideas and creates tasks such as 
project or demand from an idea.

None

Idea manager professional

[idea_manager_professional]

Manages ideas and creates tasks such as story, 
epic, feature, project, or demand from an idea.

None

Time card management roles

Time card management adds the following roles.
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Role title [name] Description Contains roles

Time card admin

[timecard_admin]

Has write access to all time cards. • timecard_user

• timecard_approver

Time card approver

[timecard_approver]

Approves or rejects time cards for time card users. timecard_user

Time card user

[timecard_user]

Creates time cards for self. None

Rate model roles

Role title [name] Description Contains roles

Rate model admin

[it_rate_model_admin]

Manages rate models and 
rate lines. Has all privileges 
within rate model, including 
configuring attributes, export 
and import of rate lines, and 
administration.

• rate_model_user

• import_set_loader

• import_transformer

• import_admin

Rate model user

[rate_model_user]

View rate model and rate lines. None

Business stakeholder role for PPM

For PPM users, the Business Stakeholder (com.snc.business_stakeholder) plugin contains 
the business stakeholder roles for Enterprise Architecture  (formerly APM), ITFM, and PPM. 
Users with this role can read records of the tables that are used to retrieve data for reports and 
dashboards and can approve demands and timecards. You can assign this role to any user who 
is a business stakeholder.

Upgrade information

If you have upgraded, the business stakeholder role for PPM is available only when you activate 
Read only roles for PPM Standard plugin (com.snc.pmo_read_roles).

If you are a new customer, the Read only roles for PPM Standard plugin 
(com.snc.pmo_read_roles) is activated on zBoot. However, the business stakeholder role for PPM 
is available only when you install the PPM Standard plugin.

Demand and Timecard approver roles

The Read only roles for PPM Standard plugin (com.snc.pmo_read_roles) installs the 
sn_ppm_read role. The sn_ppm_read role provides read-only access to the Portfolio, Program, 
and Timecard dashboards along with the Resources report to the assigned users. The 
sn_ppm_read role also contains the timecard_approver and demand_approver roles, which 
allow the assigned users to approve demands and timecards. Commenting is enabled, when a 
business stakeholder role is added as collaborator in demands.
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PPM tables accessible to users with the business stakeholder role

Users with the business stakeholder role for PPM can access the following tables that store 
the data to load the widgets in the Portfolio dashboard, Program dashboard, and Time Sheet 
dashboard, and Resource reports:

PPM tables

Label Table name

Action project_action

Decision dmn_decision

Demand dmn_demand

Demand Task dmn_demand_task

Fiscal period fiscal_period

Idea im_idea_core

Issue issue

Program pm_program

Project pm_project

Project Task pm_project_task

Program Task pm_program_task

Project Time Card Exception project_timecard_exception

Requirement dmn_requirement

Resource Aggregate Daily resource_aggregate_daily

Resource Aggregate Monthly resource_aggregate_monthly

Resource Aggregate Weekly resource_aggregate_weekly

Resource Plan resource_plan

Risk risk

Status Report project_status

Time Card time_card

Time Sheet time_sheet

Time Sheet Exception time_sheet_exception

Domain separation and Project Portfolio Management

Domain separation is supported in Project Portfolio Management. Domain separation enables 
you to separate data, processes, and administrative tasks into logical groupings called domains. 
You can control several aspects of this separation, including which users can see and access 
data.
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Support level - Basic*

• There is business logic to ensure data goes into the proper domain for the application’s 
service provider use cases.

• In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, 
all consider domain at run time.

• The owner of the instance needs to be able to set up the application to function normally 
across multiple tenants.

Use case: As a service provider when I use chat to respond to a tenant-customer’s message, the 
client must be able to see my response.

How domain separation works in Project Portfolio Management

Project Portfolio Management is domain separation-compliant with the following limitations:

• All PPM entities such as ideas, project, demand, resource plan, and allocations are expected 
to be in the same domain. A project entity having tasks or resources from multiple domains is 
not supported.

• A parent entity and all child entities, such as a project record and its project tasks, are 
expected to be in the same domain.

• When you change the domain of a parent record, for example a project record, the domain of 
the child records are not changed.

• Only users belonging to the same domain, parent domain, or the top domain have the visibility 
into PPM entities of a domain.

• All system properties are in the global domain and are not specific to a domain. Planning 
console settings, however, are still domain-specific.

Related topics

Domain separation for service providers

Quick start tests for Project Portfolio Management

Validate that Project Portfolio Management  still works after you make any configuration change 
such as applying an upgrade or developing an application. Copy and customize these quick start 
tests to pass when using your instance-specific data.

Project Portfolio Management  quick start tests require activating the PPM Standard - ATF Tests 
plugin (com.snc.financial_planning_pmo.atf).

PMO: Financial Tests for verifying cost rollups and demand to project conversion test suite

Test Description Release version

PMO: Verify cost plan roll 
up to project/demand and 
program

Validate the total planned 
cost rollup from project and 
demand to program.

Madrid

PMO: Verify cost plan roll up 
to project/demand, program 
and portfolio

Validate the total planned 
cost rollup from project and 
demand to portfolio.

Madrid
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PMO: Financial Tests for verifying cost rollups and demand to project conversion test suite 
(continued)

Test Description Release version

PMO: Verify financials of 
Project created from Demand - 
Simple Financials

Validate the financial tab fields 
of a project created from a 
demand.

Madrid

PMO: Verify financials of 
Project created from Demand 
- With budget, cost plans, 
benefit plans

Validate the budget, cost plan, 
and benefit plan of a project 
created from a demand.

Madrid

PMO: Verify ETC/EAC at cost 
plan breakdown and project 
level

Validate the EAC and ETC 
values at cost plan breakdown 
and project level.

Tokyo

PMO: Innovation Management Tests for verifying idea life cycle

Test Description Release version

Validate state changes of Idea Validate that the state of idea 
is changed when an idea is 
accepted, rejected, or any 
other task is created from an 
idea.

San Diego

PMO: Project Management tests for validating basic life cycle and project rollups test suite

Test Description
Release 
version

Validate PPM Cycle 
from Ideation to 
demand to project 
closure

Validate the flow of creating an idea, converting the idea to 
a demand, and then converting the demand to a project.

Note: 
This test fails if the PPM Standard Multicurrency 
(com.snc.ppm_multicurrency) plugin is active.

Madrid

Validation of State 
and Date Rollup for 
Automatic Project

Validate the date and state rollup from tasks for a project of 
type Automatic.

Madrid

Validation of State and 
Date rollup for Manual 
Project

Validate the date and state rollup from tasks for a project of 
type Manual.

Madrid

Validation of project 
percent complete when 
all tasks are Closed 
Incomplete

Validate the project percent complete when all the tasks are 
closed as Closed Incomplete.

Orlando

Validate Project is not 
100 percent complete 
if it has atleast one task 
as closed incomplete

Validate the project percent complete is not 100% when at 
least one of the tasks is closed as Closed Incomplete or 
Closed Skipped with task % complete less than 100%.

Orlando
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PMO: Project Management tests for validating basic life cycle and project rollups test suite 
(continued)

Test Description
Release 
version

Validate waterfall 
project does not show 
Agile Planning Board

Validate that the waterfall projects cannot use the following:

• Add stories or epics

• Add agile phase

• Access Agile board from the project

Orlando

Validate dates are 
rolled up from existing 
projects to program

Validate that the start and end dates of the project are 
rolled up to the program to which the project belongs.

Paris

Validate dates are 
rolled up from new 
projects to program

Validate that the start and end dates of a new project are 
rolled up to the program to which the project belongs.

Paris

Add projects and 
demands with risks or 
issues to program

Validate that the projects and demands with risks or issue 
records associated with them are added to the program.

Paris

Add projects and 
demands with benefit 
plans to program

Validate that the projects and demands with benefit plans 
associated with them are added to the program.

Paris

Add projects and 
demands with cost 
plans to program

Validate that the projects and demands with cost plans 
associated with them are added to the program.

Paris

Validate program dates 
on addition of existing 
demands

Validate that the start and end date of the program are 
adjusted on addition of an existing demand.

Paris

Validate program dates 
on addition of new 
demands

Validate that the start and end date of the program are 
adjusted on addition of a new demand.

Paris

Validate program state 
rollup

Validate that the program state is rolled up from state of all 
the projects in the program.

Paris

Verify Demand task due 
date column field value 
empty

Validate that the Due date  field is empty for a new demand 
task.

Rome

Verify baseline is 
created on Project & 
Demand when demand 
is converted to project

Validate that a project and demand baseline is created 
when a demand is converted to a project.

Rome

Verify timecard 
financial appears on 
Demand when time 
card submitted against 
demand task

Validate that the actual cost of the demand is updated 
when a time card is processed for a demand task.

Rome

Validate demand 
approved date

Validate that the approved dates for demand and the 
project created from the demand are the same.

Tokyo
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PMO: Project Management tests for validating basic life cycle and project rollups test suite 
(continued)

Test Description
Release 
version

Validate project 
preference "close 
project milestone tasks 
when they change to 
work state"

Validate that the milestone tasks are closed when their 
state is changed to Work in Progress after setting the 
project preference to "close project milestone tasks when 
they change to work state".

Tokyo

Validate project 
preference "Enable 
move project for WIP 
projects"

Validate that the project start date is changed appropriately 
for a project in WIP state when the project start date is 
changed after setting the project preference to "Enable 
move project for WIP projects".

Tokyo

Validate project 
preference "Rollup 
project start date from 
tasks"

Validate that the start date of a project task does not roll up 
to the project when the project planned dates are different 
than the project task start date after deselecting the project 
preference "Rollup project start date from tasks".

Tokyo

Child Test Suite: Validation of Move Project Action

Test Description Release version

Validate Planned start date 
of a project can be shifted by 
using the Move project action

Validate that the Planned start 
date of a project in Planning 
or Open state can be updated 
to a later or earlier date than 
the current planned start date 
using the Move project related 
link.

Orlando

Validate Move Project is 
disabled when Project is 
selected for execution

Validate that the Move Project 
option is not available if the 
Project is in Execution phase.

Orlando

Validate Move Project 
functionality with sprint dates 
populated for an agile phase

Validate that the sprint start 
and end dates are cleared 
when the project is moved 
using the Move Project related 
link.

Note: 
This test is available 
only when Agile 
Development 2.0  plugin 
(com.snc.sdlc.agile.2.0) 
is activated.

Orlando

Validate Move Project 
functionality with external 
dependencies and related 
entities

Validate that the external 
dependencies and related 
entities are also shifted and 
redrawn when the project is 
moved using the Move Project 
related link.

Orlando

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1854



Child Test Suite: Validation of Move Project Action  (continued)

Test Description Release version

Validate Move Project 
functionality with different 
project states

Validate that the Move Project 
does not work when the 
project is in Work In Progress 
or Closed Complete state.

Orlando

Child Test Suite: Verify RIDAC flow of a Project

Test Description Release version

Verify RIDAC flow for Risk Validate the RIDAC flow for a 
risk associated with a project.

Quebec

Verify RIDAC flow for Issue Validate the RIDAC flow for 
an issue associated with a 
project.

Quebec

Verify RIDAC flow for Decision Validate the RIDAC flow for 
a decision associated with a 
project.

Quebec

Verify RIDAC flow for Action Validate the RIDAC flow for 
an action associated with a 
project.

Quebec

Verify changes in fields of risk 
form

Validate that any change 
is the Risk form fields 
such as Risk rank, Risk 
value, and Probability is 
updated successfully upon 
submission.

Quebec

Child Test Suite: Verify RIDAC flow of a Demand

Test Description Release version

Verify RIDAC flow for Risk Validate the RIDAC flow 
for a risk associated with a 
demand.

Quebec

Verify RIDAC flow for Issue Validate the RIDAC flow for 
an issue associated with a 
demand.

Quebec

Verify RIDAC flow for Decision Validate the RIDAC flow for 
a decision associated with a 
demand.

Quebec

Verify RIDAC flow for Action Validate the RIDAC flow for 
an action associated with a 
demand.

Quebec

Verify changes in fields of risk 
form

Validate that any change 
is the Risk form fields 
such as Risk rank, Risk 
value, and Probability is 

Quebec
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Child Test Suite: Verify RIDAC flow of a Demand  (continued)

Test Description Release version

updated successfully upon 
submission.

PMO: Resource Management tests for verifying the resource plan flows test suite

Test Description
Release 
version

Verify user 
resource plan flow 
from Planned to 
Canceled state

Validate that the resource plan of a project can be moved to 
canceled state from planned state.

Madrid

Verify group 
resource plan flow 
from Planned to 
Complete state

Validate that the resource plan of a project can be moved to 
complete state from planned state.

Madrid

Verify role resource 
plan flow from 
Planned to 
Allocated state

Validate that the resource plan of a project can be moved to 
allocated state from planned state.

Madrid

Verify aggregated 
cost of all resource 
plans roll up to the 
corresponding 
project or demand 
fields

Validate that the aggregated cost of all resource plans on a 
project or demand roll up to the Planned Cost and Allocated 
Cost fields and the Resource Cost section of respective 
projects and demands.

Orlando

Verify Copy 
Resource plan 
option

Validate that the Copy Resource plan option creates an exact 
copy of the source resource plan in the Planning state

Orlando

Verify resource 
plan aggregate roll 
up from project/
demand to program

Validate that the aggregated cost of all resource plans on 
a project or demand roll up to the total planned cost of the 
associated program.

Orlando

Verify records on 
completion of a 
resource plan

Validate the changes in a resource plan on completion:

• The state of the resource plan is updated to Completed.

• If the completion date is earlier than the resource plan end 
date, the end date of the resource plan is updated with the 
completion date. If the completion date entered is later than 
the resource plan end date, the resource plan end date is 
retained.

• All the requested and allocation records for the resource 
plan for the period after the completion date are deleted. 
If there are any actual hours logged against an allocation, 
that allocation is not deleted. For those allocation records, 

Orlando
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PMO: Resource Management tests for verifying the resource plan flows test suite 
(continued)

Test Description
Release 
version

the allocated hours become zero and the actual hours are 
retained.

• The available and allocated hours for resources are updated 
in the aggregate tables.

Verify records on 
completion of a 
resource plan with 
Planned Duration 
as allocation type

Validate the following on completion of a resource plan with 
Planned Duration as allocation type:

• The state of the resource plan is updated to Completed.

• Allocations are not deleted.

• End date of the allocation is updated to the completion date.

Orlando

Verify the RP replan 
Capability

Validate that when a cancelled resource plan is re-planned, the 
state of the resource plan changes to Planning.

Orlando

Verify whether 
change in resource 
plan is reflected in 
corresponding cost 
plan

Validate that when a resource plan is updated, the 
corresponding cost plan is updated accordingly. For example, if 
the total planned cost is 500 USD, and the planned hours is 10, 
and you change the planned hours to 20, the total planned cost 
is updated to 1000 USD.

Paris

Resource-Test the 
default population 
of resource plan 
start & end date

Validate the following on creating a user or group resource plan 
from the related list of a demand:

• If a demand is created without a start date and end date, the 
user or group resource plan has task as demand and no start 
and end date.

• If a demand is created with a start date and end date, the user 
resource plan has task as demand and the start date and end 
date as added for the demand.

Paris

Validate that 
actual hours 
in operational 
resource plan and 
time card are equal

Validate that when a time card category is mapped with an 
operational work type, on submitting the time card for the 
operational resource plan associated with that work type, the 
actual hours in the resource plan and the time card are equal.

Quebec

Verify Resource 
plan auto 
population for 
Operational plans

Validate that the operational resource plans associated with 
a time card are automatically retrieved on the time card when 
time is logged.

Rome

Verify resource 
plan auto 
population for 
non-operational 
resource plans

Validate that the resource plans associated with a project, 
project task, or demand for a time card are automatically 
retrieved on the time card when time is logged.

Rome
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Related topics

Quick start tests

Related lists added for financials

PPM Standard adds several related lists to both the Project and Portfolio forms.

Portfolio related lists

Portfolio related lists for financials

This table explains the related lists and how to create or use the records in these lists in the 
portfolio workbench.

Portfolio form related lists Description

Cost Plans Lists the cost plans of projects and demands 
that are part of the portfolio.

Monetary Benefit Plans Lists the financial benefit plans of projects and 
demands that are part of the portfolio.

Portfolio Target Lists the portfolio capital and operational 
expense target for different fiscal years. The 
values are displayed from the project_funding 
table. You can create targets for different 
financial periods.

Planning & Budgeting Planning & Budgeting of the project. For more 
information, see  unique_1265.

Project related lists for financials

This table explains the related lists for financials in a project record.

Project form 
related lists

Description

Cost Plans Costs of the project for a specific fiscal period. Cost plans can also have an 
associated expense line.

Monetary 
Benefit Plans

Potential financial benefits which can be accrued by the project spanning one 
or more fiscal periods, if the project is executed.

Project 
Budget

Budget of the project. For more information, see  unique_1265.

Expense 
Lines

Aggregated actual costs associated with a specific source, such as a user, fixed 
asset, or a CI.
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SPM Benchmarks
The ServiceNow®  SPM Benchmarks  application provides you with an insight into the 
industry averages of your peers. Use your key performance indicators (KPIs) to compare your 
performance with global benchmarks, which contributes to improved performance for your 
organization.

Getting started with SPM Benchmarking  This video provides an overview of how you can get 
started with SPM Benchmarks.

Exploring SPM Benchmarks
The SPM Benchmarks  application provides clear visibility into your key performance indicators 
(KPIs) and trends, providing comparative insights relative to the industry averages of your peers. 
It enables you to gain deeper insights by comparing your performance with your peers based on 
industry, size, or region.

Key features

• 15 available KPIs (6 Strategic, 5 Alignment, and 4 Execution).

• Ability to change KPI definitions to match customizations.

• ServiceNow®  Benchmarks  dashboard in ServiceNow®  Service Portal  (mobile friendly).

• Ability to download KPI reports.

• Email notification when new aggregate monthly data is available.

• Filter data by industry, number of users, or geographical region.

• Percentile ranking to indicate your standing within your participating peer group.

• Product category-based roles to limit data access.

• Integration with ServiceNow®  Performance Analytics  for daily data collection and drill-down on 
KPI data.

SPM Benchmarks  dashboard

View and learn about the SPM Benchmarks  dashboard features.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1859



SPM Benchmarks  dashboard

The SPM Benchmarks  dashboard enables you to do the following.

View KPIs

You can view the KPIs in the following categories.

• The All  tab shows the list of all the KPIs that you've opted in to.

• The Strategic  tab shows the list of all the strategic KPIs that you've opted in to.

• The Alignment  tab shows the list of all the alignment KPIs that you've opted in to.

• The Execution  tab shows the list of all the execution KPIs that you've opted in to.

Change the KPI view

You can change the way that the KPIs are displayed on the dashboard.

• Click the card view icon ( ) to view your KPIs in a card view.

• Click the list view icon ( ) to view your KPIs in a list view.

Select comparative data

You can select the area in which you want to compare your data using the Compare 
with drop-down list.

• Industry- Select this option to compare your data based on industries.

• Number of users- Select this option to compare your data based on the number 
of users.

• Region- Select this option to compare your data based on the region.

Benefits of SPM Benchmarks

The SPM Benchmarks  application provides you with an overall understanding of your 
performance compared to your peers.
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Global anonymity

Viewers in your organization have access to SPM Benchmarks  for your organization. 
However, the global benchmarks are anonymous and don't include any company 
information.

Industry comparison

Using the Compare with drop-down list on the SPM Benchmarks  dashboard, filter 
the benchmarks results by industry, ServiceNow  user size, or geographical region to 
make the results more relevant to your organization.

• Industry is determined based on the standard industry code in the account 
record for the company.

• Number of users is determined by the number of ServiceNow  active users within 
the company. You can compare your company to similar-sized ServiceNow 
implementations to gain an understanding about your company.

• Region is determined based on the Region  field in the company table.

If a filter category includes fewer than 20 participants, the corresponding data is 
shown in the Other category.

Trends

You can see the results of all published KPIs as well as the last six months of history.

Use the trend data to determine what is working well and what needs improvement.

Reports

SPM Benchmarks  reports get refreshed monthly that can be downloaded in PDF 
format. An email notification is sent to the customer when new data is available.

Configuring SPM Benchmarks
Learn about the process required to set up SPM Benchmarks  to view the comparative 
understandings on your key performance indicators (KPIs).

Use the following steps as guidelines for your SPM Benchmarks  setup process.

1. Install SPM Benchmarks. For more information, see Install SPM Benchmarks.

2. Enable SPM Benchmarks. For more information, see Enable SPM Benchmarks.

Install SPM Benchmarks

As an admin, you can install the SPM Benchmarks  application (sn_spm_bm) from the 
ServiceNow®  Store.The application includes demo data and installs related ServiceNow®  Store 
applications and plugins if they are not already installed.

Before you begin

• Confirm that the application and all of its associated ServiceNow Store  applications have valid 
ServiceNow  entitlements. For more information, see Get entitlement for a ServiceNow  product 
or application .

• Review the SPM Benchmarking  application listing in the ServiceNow Store  for information on 
dependencies, licensing or subscription requirements, and release compatibility.

Role required: admin
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About this task
The following items are installed with SPM Benchmarks:

• Roles

• Scheduled jobs

For more information, see Components installed with SPM Benchmarking.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the SPM Benchmarks  application () using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Select Install.

Enable SPM Benchmarks

Opt in to SPM Benchmarks  to participate in SPM Benchmarks  data collection for Strategic 
Portfolio Management  KPIs.

Before you begin
Role required: sn_bm_client.benchmark_admin

About this task
You can opt out of the SPM Benchmarks  at any time.

Procedure

1. Navigate to All  > Benchmarks  > Setup.

2. Click Opt-In Agreement  and read the agreement.

3. Click Done.

4. Select the Yes, I have read and accept the Opt-In Agreement  check box, and click Opt-In.
You can choose to opt out of SPM Benchmarks  at any time. To opt out of benchmarks as a 
whole, including but not limited to SPM Benchmarks, navigate to All  > Benchmarks  > Setup 
and click Opt-out of ServiceNow Benchmarks.

Customize the SPM Benchmarks  KPIs
You can customize the KPI information you would want to see in your SPM Benchmarks 
dashboard.

You can use the SPM Benchmarks  application to do the following:
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• Choose your KPIs  from the list of available KPIs, based on your organizational requirement.

• Change a KPI formula  to adjust the details pertaining to your organizational need.

Choose your KPIs

Based on your requirement, you can choose the key performance indicators (KPIs) that you want 
to use in the SPM Benchmarks  application.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Benchmarks  > Administration  > Setup.

2. Select Strategic Portfolio Management  to view the list of SPM Benchmarks  KPIs.

3. Select the KPIs that you need for your organization.

Change a KPI formula

View and change the key performance indicators (KPIs) formula according to your requirement 
and analysis criteria.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Benchmarks  > Administration  > Category.

2. From the Benchmark Indicator Categories list, select Strategic Portfolio Management.

3. Select a group that contains the KPI that you want to edit from the Benchmark Indicator 
Groups.

4. Click and open the KPI that you want to edit.

5. Click and open the indicator field to view and edit the formula.

SPM Benchmarks  reference
Reference information to provide additional details about SPM Benchmarks  such as the fields, 
user roles, and scheduled job information.

Components installed with SPM Benchmarking

Several types of components are installed with activation of the SPM Benchmarks  plugin, 
including tables, user roles, and scheduled jobs.
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Roles installed

Role title [name] Description
Contains 
roles

Benchmarking admin

[sn_bm_client.benchmark_admin]

• Set up Benchmarks from an instance

• Opt in or out of the Benchmarks program

• Enable, disable, or modify indicators 
(including changing Performance 
Analytics indicator source, script, and 
conditions for those KPIs not requiring 
application-specific roles)

• Receive email notification when new 
aggregate monthly data is available

• All functions of the Benchmarks viewer 
and Benchmarks recommendations roles

None

Benchmarking data viewer

[sn_bm_client.benchmark_data_viewer]

• View full benchmark reports in Service 
Portal

• View data visualizations and drill-downs 
for analyzing trends (not PA scorecards)

• Download visualizations

• View industry category or size 
comparisons

• Receive email notification when a new 
aggregate monthly benchmark score is 
available.

None

Scheduled jobs installed

Scheduled job Description

SPM 
Benchmark 
Agile Data 
Collection

Collects scores for indicators related to Agile Development 2.0, as specified 
in the Relative start  and Relative end  fields. The collection time is for a month 
based on the GMT timezone.

SPM 
Benchmark 
Data Collection

Collects scores for indicators related to APW  and PPM, as specified in the 
Relative start  and Relative end  fields. The collection time is for a month 
based on the GMT timezone.

SPM Benchmarks  KPIs

The Strategic Portfolio Management  KPIs are performance analytic indicators that collect the 
usage count data. Strategic, Alignment, and Execution KPIs are available by default in the SPM 
Benchmarks  application.
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Strategic KPIs

KPI Formula

% of spend on grow and innovate the business 
for the last 12 months

(Sum of Actual cost spent on Projects & 
Demands that belong to innovate & grow in the 
last 12 months / Sum of Actual cost spent on 
all Projects & Demands in the last 12 months ) 
* 100

% of spend on run the business for the last 12 
months

(Sum of Actual cost spent on Projects & 
Demands that belong to run in the last 12 
months / Sum of Actual cost spent on all 
Projects & Demands in the last 12 months ) * 
100

% of work focused on grow & innovate the 
business

(Count of all Projects, Demands & Epics 
that belong to grow & innovate / Count of all 
Projects, Demands & Epics ) * 100

% of work focused on run the business (Count of all Projects, Demands & Epics that 
belong to run / Count of all Projects, Demands 
& Epics ) * 100

Planned % spend on grow & innovate the 
business for next 12 months

(Sum of Planned cost on Projects & Demands 
that belong to innovate & grow in next 12 
months / Sum of Planned cost on all Projects 
& Demands in next 12 months ) * 100

Planned % spend on run the business for next 
12 months

(Sum of Planned cost on Projects & Demands 
that belong to run in the next 12 months / Sum 
of Planned cost on all Projects & Demands in 
the next 12 months ) * 100

Alignment KPIs

KPI Formula

% of project, demands, and epics aligned to 
one or more goals

(Count of Projects, Demands & Epics that are 
aligned to one or more goals / Count of all 
Projects, Demands & Epics) * 100

% of project, demands, and epics aligned to 
one or more strategies

(Count of Projects, Demands & Epics that are 
aligned to one or more strategies / Count of all 
Projects, Demands & Epics) * 100

% of work delivered using traditional projects (Total count of open Project planning items 
that are having execution type as Waterfall / 
Total count of open Project planning items and 
Epic planning items) * 100

% of work delivered using agile (Total count of open Epic planning items / 
Total count of open Project planning items and 
Epic planning items) * 100

% of work delivered using hybrid projects (Total count of open Project planning items 
that are having execution type as Hybrid or 
Agile / Total count of open Project planning 
items and Epic planning items) * 100
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Execution KPIs

KPI Formula

% of demands converted to projects or epics (Count of Demands that are converted to 
Projects or Epics in last 12 months / Count of 
Demands that are created in last 12 months) * 
100

% of story points completed vs planned with 
the sprint, in last 12 month

(Total story points completed in the sprint 
that falls in last 12 months / Total story points 
planned in the sprint that falls in last 12 
months) * 100

Average number of scrum teams per ART Total number of teams in ARTs / Total number 
of ARTs

Average scrum team size Total number of members in scrum teams / 
Total number of scrum teams

Investment Funding
ServiceNow®  Investment Funding  enables you to plan and manage investments by allocating 
funds to investment entities such as Business Units, Products, Teams, and the like. Prioritize your 
investments based on business needs and strategic objectives of your organization.

You can use the Investment Funding  (sn_invst_pln) application to do the following:

• Create investments for entities.

• Allocate funds to an investment to meet a business requirement or strategic objective.

• Request funds from one or more funding sources to achieve business goals.

Note: 
Starting with the Rome  release, Investment Funding  will be found in the ServiceNow Store. 
The legacy plugins (com.snc.investment_planning, com.snc.investment_planning_pmo) 
will be prepared for future deprecation in September 2022. The plugins will be hidden and 
no longer activated on new instances but will continue to be supported. For details, see the 
Deprecation Process [KB0867184]  article in the Now Support knowledge base.

Investment entities and investments

An investment contains information about funds, costs, benefits, business case, and goals. 
Use investments to allocate or request funds to meet defined business goals. An investment is 
associated to an investment entity.

An investment entity is a transaction table for funding. For example, you can create investment 
entities for records such as Projects, Teams, Business Units, Epics, and Portfolios.

Keeping the investment and investment entity separate provides the following advantages:

• Your work activities are separate from the funding.

• You can fund the same entity for different periods until the investment goals are met.

Generic investments

A generic investment is an investment that is tied an owner without being associated to any 
entity. You can fund any entity or other generic investment from a generic investment.
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For example, as the CEO of a company you might want to set aside some funds for a training or 
research initiative and there might not be a transaction table to enable such an entity. You could 
then create a generic entity to fund the investment.

Top-down and bottom-up funding

In top-down funding, you distribute funds to investments based on business goals or as part of a 
business strategy.

In bottom-up funding, you request funds for your investments from one or more funding sources.

Investment Funding  enables you to manage funds for both funding approaches.

Domain separation in Investment Funding

Domain separation  provides complete data isolation for domain-specific users. Investment 
Funding  is compliant with domain separation at the Data only  level.

Install Investment Funding
You can install the Investment Funding  application (sn_invst_pln_v2) from ServiceNow Store  if 
you have the admin role.

Before you begin
Ensure that the application and all of its associated store applications have valid ServiceNow 
entitlements. For more information, see Get entitlement for a ServiceNow  product or 
application .

Role required: admin

About this task
Investment Funding  activates these related plugins if they are not already active.

Plugins for Investment Funding

Plugin Description

Fiscal Calendar

[com.snc.fiscal_calendar]

Enables you to generate and manage different kinds of fiscal 
calendars that are used in various financial applications.

Widgets

[com.snc.app.widgets]

Enables widgets on the dashboard pages.

Ag-Grid Components 
Plugin

[com.snc.app.grid]

Enables grid view.

Planned Task_v2

[com.snc.planned_task_v2]

Enables task entities.

If the PPM Standard (com.snc.financial_planning_pmo) plugin is also installed, you can use the 
Investment Funding  features to request or allocate funds for your projects and demands.
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Procedure

1. Navigate to System Applications  > All Available Applications  > All.

2. Find the Investment Funding  application using the filter criteria and search bar.
You can search for the application by its name or ID (sn_invst_pln_v2). If you cannot find an 
application, you may have to request it from ServiceNow  store. Visit the ServiceNow Store
website to view all the available apps and for information about submitting requests to the 
store. For cumulative release note information for all released apps, see the ServiceNow Store 
version history release notes .

3. Click Install.

4. In the Application installation dialog box, review the application dependencies.

If your application requires other applications, install them first if they are not already installed.

Installing your application also automatically installs the dependent applications or plugins if 
they are not installed already.

5. Click Install.

Result
The following components are installed with installation of the Investment Funding  application:

• Roles

• Tables

See Components installed with Investment Funding  for more information.

Components installed with Investment Funding

Several types of components are installed with activation of the Investment Funding 
(sn_invst_pln) plugin, including tables and user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Roles installed with Investment Funding

Role title [name] Description Contains roles

Investment admin

[sn_invst_pln_v2.investment_admin]

Creates investment entities 
and sets up preferences and 
fiscal calendar.

fiscal_calendar_admin

Investment planner

[sn_invst_pln_v2.investment_planner]

Manages top investment, 
investment entities, and 
records associated with 
investment entities.

investment_user

Investment user

[sn_invst_pln_v2.investment_user]

Manages investments and 
funds.

fiscal_calendar_user
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Role title [name] Description Contains roles

Note: 
Users with this role can 
perform create, read, 
update, and delete 
operations on all cost and 
benefit plans.

Tables installed with Investment Funding

Table Description

Business Case

[business_case]

Stores business cases for investments.

Fund Request

[sn_invst_pln_invst_funding_base_request]

Stores fund request details.

Funding

[sn_invst_pln_invst_funding_base_fund]

Stores fund details.

Funding Base

[sn_invst_pln_invst_funding_base]

Base table for funding and requests.

Funding Base Breakdown

[sn_invst_pln_invst_funding_base_breakdown]

Stores the breakdown of funding base 
records.

Funding Configuration

[sn_invst_pln_invst_funding_configuration]

Stores funding configuration details.

Investment Entity

[sn_invst_pln_invst_funding_entity]

Stores investment entity types.

Funding State

[sn_invst_pln_invst_funding_state]

Stores different states of a funding.

Investment

[sn_invst_pln_invst_investment]

Stores investment details.

Upgrading legacy Investment Funding  to Store application
If you are upgrading from the legacy Investment Funding, post installation of the Investment 
Funding  application, you can migrate your existing data to the ServiceNow Store  application 
tables. Also, you must update the reference tables for the Investment  and Funding Entity  fields 
to the ServiceNow Store  application tables.
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Migrate data from legacy Investment Funding  to Store application

With the admin role, you can migrate your existing data from the legacy Investment Funding 
tables to the new ServiceNow Store  application tables by running the scheduled job.

Before you begin
Role required: admin

Note: 
Migrating data to the ServiceNow Store  application tables is a one-time job, and not meant 
to be on a schedule.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Search for and click the Migrate Investment Funding To Store  scheduled job.

3. On the Scheduled Script Execution form, ensure that the frequency is selected as On Demand 
in the Run  field.

4. Click Execute Now.

Update references from legacy Investment Funding  tables to Store tables

Post migration of your legacy Investment Funding  data, you must update the reference tables 
for the Investment  and Funding Entity  fields from the legacy Investment Funding  tables to the 
ServiceNow Store  application tables in the required tables.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definition  > Tables.

2. Update the reference tables from the legacy Investment Funding  tables to the Store 
application for the Investment  and Funding Entity  fields for the following tables.

Table Column label (Field)
Reference table for 
the legacy Investment 
Funding plugin

Reference table for the 
Store application

Cost Plan Investment invst_investment sn_invst_pln_invst_investment

Cost Plan Funding Entity invst_investment_entitysn_invst_pln_invst_funding_entity

Benefit Plan Investment invst_investment sn_invst_pln_invst_investment

Goal Investment invst_investment sn_invst_pln_invst_investment

Investment Funding  administration
The Investment Funding  application requires you to do some initial administrative tasks for it to 
be fully functional.

Fiscal calendar setup for Investment Funding

The Fiscal calendar setup you choose determines the fiscal periods used by your organization to 
request or allocate funds.
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Based on the fiscal calendar setup, you can then set the funding frequency  that aligns with 
the funding cycles your organization uses, such as monthly or quarterly, for fund requests and 
allocations.

Note: 
Once you allocate or request funds for investments for a fiscal period, you cannot change 
to another fiscal calendar type.

For information about fiscal calendars, see Defining fiscal calendars .

For information about how to generate a fiscal calendar, see Generate a fiscal calendar .

Set Investment Funding  preferences

As an administrator, you can set global defaults for Investment Funding  preferences, which affect 
the funding behavior.

Before you begin
Role required: sn_invst_pln_investment_admin

Procedure

1. Navigate to All  > Investment Funding  > Setup  > Preferences.

2. In the Funding frequency  list, select a frequency of periods in which you can request or 
allocate funds to an investment.

The list shows options based on the configured fiscal calendar.

For example, if you set up the Standard fiscal calendar and you want to fund your investments 
quarterly, select Quarter.

The default value is Quarter for the Standard fiscal calendar setup or Period for any other fiscal 
calendar setup.

3. Optional:  In the Number of editable past periods  field, enter a number to specify the number 
of past periods enabled for you to modify the allocated or requested fund.

(Optional) For example, if the funding frequency is Quarter and you enter 2 in the field, you can 
edit funds for the previous two quarters.

The default value is 0 (editing of past period funding is not enabled).

4. Optional:  Select the Hide actuals in tree view  check box to hide the actual amount of an 
investment in the tree view cards.

5. Optional:  Select the Allow fund overallocation  check box to enable allocation of funds in 
addition to the received funds.
The Fund overallocation percent (%)  and Allow fund overallocation at investment level 
fields are enabled.

6. Optional:  In the Fund overallocation percent (%)  field, enter the percentage by which funds 
can be allocated in addition to the received funds.

(Optional) For example, if the received fund amount is $200,000, and you enter 10% in the 
Fund overallocation percent  field, a total of $220,000 can be used for funding.

7. Optional:  Select the Allow fund overallocation at investment level  check box to enable 
source investment owners who have funded the investment and are not removed from the 
allocation to override the fund overallocation percent at investment level.
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8. Click Save.

9. Select an option from the confirmation window that is displayed:

◦ Update the overallocation preferences at the investment level for all existing investments

◦ Update the overallocation preferences at the investment level for existing investments that 
have not overridden the overallocation percentage

◦ Update the overallocation preferences at the investment level only for new investments

10. Click Confirm.

Create an investment entity

Create an entity for investments through which you can receive or allocate funds.

Before you begin
Role required: sn_invst_pln_v2.investment_admin

Procedure

1. Navigate to All  > Investment Funding  > Setup  > Investment Entities.

2. Click New.

3. On the form, fill in the fields.

Note: 
The Entity  tab in the form is replaced by the Owner  tab when the Generic  option is 
selected.

Investment Entity form

Field Description

Name
Unique name of the investment entity.

Active
Option for indicating the status of the investment entity.

You can create investments only for active investment 
entities.

Description
Short description of the investment entity.

When the Generic  option is not selected:

Entity tab

Field Description

Table Transaction table on which funding is 
enabled.

Condition
Condition to filter data from the table enabled 
for funding.
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Field Description

For example, you could enable funding for 
the Project table and add a filter condition to 
list only projects that are in the Ready state.

Owner field
Any user field in the transaction table 
mapped to the investment owner field.

The user on the mapped field is automatically 
assigned as the investment owner when you 
are creating an investment.

For example, for a Project investment entity, 
you could map the Project manager field as 
the investment owner field.

When the Generic  option is selected:

Owner tab

Field Description

Owner table
User table mapped as the investment owner 
field.

Owner filter
Condition to filter users that are listed in the 
Owner  field in the Investment form to select 
the investment owner.

For example, for a Project investment entity, 
you could create a filter to list only users with 
the Project manager role.

By default, the Active is true  filter is set, 
which means that only active users are listed 
for selection.

4. Optional:  Click the Unlock fundable entities  icon to enable the selection of entities that can 
be funded by the current entity.

(Optional) For example, a portfolio entity can fund a program, a program can fund a project, a 
project can request from a program, and a program can request from a portfolio.

5. Optional:  Add the entities to the Fundable entities  list.

(Optional) If no value is selected, all entities are considered to be enabled for funding.

6. Click Submit.

What to do next

• Create funding artifacts to create a business rule to synchronize investment and investment 
entity owners  or to add a related link on the investment target form.

• Create a top-level investment  or an investment  for an investment entity.
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Enable synchronization of investment and investment entity owners

Create a business rule for an investment entity that synchronizes the investment owner with the 
investment entity owner. If you update the name of the investment entity owner, the owner of the 
corresponding investment and the Viewable by  field for the investment is automatically updated.

Before you begin
Role required: sn_invst_pln_v2.investment_admin

Procedure

1. Navigate to All  > Investment Funding  > Setup  > Investment Entities.

2. Open an entity for which you want to enable synchronization of owners.

3. On the form, click the Create Funding Artifacts  related link.

4. In the dialog box, select the Create business rule to sync investment owner with investment 
entity owner  option, and click OK.

Result
A business rule is created for the investment entity that synchronizes the owner of the 
investment with the associated investment entity owner when you update the investment entity 
owner.

Access investments directly from an investment target

Create a related link to go directly to the My Funds page from an investment target.

Before you begin
Role required: sn_invst_pln_v2.investment_admin

Procedure

1. Navigate to All  > Investment Funding  > Setup  > Investment Entities.

2. Open an investment entity for which you want to create a related link.

3. On the form, click the Create Funding Artifacts  related link.

4. In the dialog box, select the Create related link for requesting/funding on the form  option, 
and click OK.

5. Click OK.

Result
The Add/View Investments  related link appears on the form of the investment target for direct 
navigation to the My Funds page.

Create a top-level investment
Create a top-level investment for the investment entity record for which you want to receive and 
allocate funds.

Before you begin
Role required: sn_invst_pln_v2.investment_planner

About this task
A top-level investment does not have a source investment or source investment entity. Once 
created, a top-level investment cannot be converted to a normal investment later.
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Procedure

1. Navigate to All  > Investment Funding  > Top level Investments.

2. Click New.

3. On the form, fill in the fields.

New Top level Investment form

Field Description

For
Investment entity record to associate with the 
investment. To access the records associated 
with an entity, select an investment entity in 
the list on the left. The list on the right then 
displays the records associated with the 
selected entity.

You can create only one top-level investment 
for an investment entity type-investment 
entity value pair.

Note: 
When you select the Generic Bucket 
entity option, the list to select the 
associated entity record is disabled.

Owner
User who will own the top-level investment.

This field is set to the Owner field  value 
determined while creating the selected 
investment entity.

Name Unique name of the investment.

Top investment Option that indicates that this is a top-level 
investment. This setting cannot be changed.

4. Click Create.

What to do next

• Fund a top-level investment  to meet the business goals.

• Create a business case  to define the business need of the investment.

Fund a top-level investment

Allocate funds to a top-level investment so that the investment owner can distribute funds 
further.

Before you begin
Role required: sn_invst_pln_v2.investment_planner
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Procedure

1. Navigate to All  > Investment Funding  > Top level Investments.

2. Open an investment to which you want to allocate funds.

3. On the Details  tab, click Add fund.

4. On the form, fill in the fields.

Add fund form

Field Description

Fiscal period
Fiscal period for which the fund is allocated 
to the investment.

Funded capex
Amount funded as a capital expense.

Funded opex
Amount funded as an operating expense.

5. Click Submit.

Result
The top-level investment is funded with the specified amount for the selected period.

Create an investment
Create an investment to fund a target.

Before you begin
Role required: sn_invst_pln_v2.investment_user

Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Click New.

3. On the form, fill in the fields.

Investment form

Field Description

For
Investment entity record to associate with the 
investment. To access the records associated 
with an entity, select an investment entity in 
the list on the left. The list on the right then 
displays the records associated with the 
selected entity.
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Field Description

Note: 
You can create only one top-level 
investment for an investment entity 
type-investment entity value pair.

Name Unique name of the investment.

4. Click Submit.

What to do next

• Add a business case  to define the business needs of the investment.

• Request funds  from a funding source.

• Allocate funds  from your available funds.

Add a business case for an investment

Add a business case for an investment to define its business needs and goals.

Before you begin
Role required: sn_invst_pln_v2.investment_user

About this task
An investment can have only one business case.

When a business case is created on a demand or project record, the same is mapped to the 
corresponding investment record. And when a business case is created on an investment 
record, the same is mapped to the corresponding demand or project record. Cost plans and 
benefit plans associated with project or demand records are also mapped to the investment 
records.

Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Open an investment to add the business case.

3. On the Details  tab, click the Create Business case  related link.
The related link is available only if a business case does not exist for the investment.

4. In the Add Business case dialog box, provide information in the fields based on your business 
needs and goals for the investment.

Add Business case form

Field Description

Name Unique name of the business case.

Investment type Type of the investment.

Investment class Investment class category assigned to the investment:

◦ Run: Investment made to sustain the existing business.

◦ Change: Investment made to implement a change in the 
business.
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Business case tab section of the Add Business case form

Field Description

Description Description of the business case supporting 
the investment.

Enablers Key enablers for the investment.

Barriers Major barriers to the investment.

Assumptions Assumptions made for the investment that 
help to determine the scope and risks, and 
fine-tune the time and cost estimates.

Scope section of the Add Business case form

In scope Scope of the investment, which includes a 
set of boundaries that define the extent of the 
investment.

Out of scope Activities that are not in the scope of the 
investment.

Risk of performing Risks associated with the investment if it is 
carried out.

Risk of not performing Risks associated with the investment if it is 
not carried out.

5. Click Submit.

Co-owners for an investment
Investment co-owners manage, request, and allocate funds on your behalf to the investments 
that you own. The co-owner has the same rights and permissions as the owner.

• Co-owners have the same capabilities and access rights as the owner for the investments, 
which include:

◦ Add funds to top-level investments.

◦ Add child investments and fund them.

◦ Add and request source and funds from a top-level investment.

◦ See, request, and allocate funds to child investments.

◦ Add others as co-owners.

◦ Delete any unfunded investments.

◦ See who funded an investment.

• Co-owners are added to the Viewable by  field for all the child investments.

• An investment can have multiple co-owners. There is no maximum limit for the number of co-
owners for an investment.

• In the Active Investments page, you can see the access level for the investments.
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◦ Owned investments are marked with an owned icon ( ).

◦ Co-owned investments are marked with a co-owner icon ( ).

◦ Viewable investments are marked with a view only icon ( ).

Manage co-owners for an investment

Add co-owners to your investments to request, approve, and manage the funds on your 
behalf. You can remove the existing co-owners when you no longer need them to manage your 
investments.

Before you begin
Role required:

• For managing co-owners in top-level investments: sn_invst_pln_v2.investment_planner

• For managing co-owners in My funds: sn_invst_pln_v2.investment_user, 
sn_invst_pln_v2.investment_planner

Procedure

1. Open a top-level investment or My fund.

2. Click the Details  tab.

3. Click the unlock co-owner icon ( ).

◦ To add a user as a co-owner, use the select target record search field to search for and select 
the users.

◦ To remove an existing co-owner, select the name and click the remove selected item icon 

( ).

4. Click Update.

Request funds for an investment
Request funds from a funding source for your investment.

Before you begin
Role required: sn_invst_pln_v2.investment_user

About this task
You cannot request funds for a generic investment from any other generic investment.

You can request funds only from generic source investments that have allocated funds to your 
investment in the past.

You can request funds only in the funding frequency configured in the Investment Funding 
Preferences.

You can request funds from only those entities that were added in the Fundable entities  field 
while creating the entity.

You can withdraw funding requests that are in the requested and planning state and are for past 
funding periods or non-editable funding periods.
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Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Click an investment card to open the investment for which you need funds.

If you want to open a different investment, access the drop-down menu next to the name of the 
currently displayed investment. Either search for another investment by entering its name in 
the Search My Investments  field or choose it from the five most recently visited investments.

3. Click the View/Request Funds  tab.

4. Select a working period and click Apply.
The Request Funds list displays only funding sources that you previously requested funds 
from for your investment.

5. Click the Add New Source  link to select the funding source.

6. In the Select a Source  pane, select one or more source investments from the list, and then 
click Add Selected.
The specified funding source is added in the Request Funds grid.

7. In the Request Funds grid, specify the amount in the CapEx  and OpEx  columns under New/
Modify Request  of the funding sources from which you want to request funds.
The state of all updated funding sources changes to Draft or Planning, which is indicated by 
highlighted cells.

8. Click Request.

9. In the Confirm request dialog box, verify your requests and add a comment if required.

10. Click Request.

11. Optional:  Right-click on a column on the New/Modify Request  field and select Withdraw  to 
withdraw a funding request.

Result

• Funds are requested from the source investments sources for the specified period.

• The state of the fund request record changes to Requested.

Plan fund allocations for investments
Plan your fund allocations if you are not yet ready to finalize the allocation of your funds.

Before you begin
Role required: sn_invst_pln_v2.investment_user

About this task
Keep investments in the planning stage if you are not yet ready to allocate the funds. For 
example, you might want to wait to determine whether you require additional funds to meet the 
needs of all your investments.

If you plan to allocate funds to an investment that are in addition to the received funds, a warning 
message is displayed in the Totals  row indicating that you are overallocating, and the additional 
fund amount will be deducted from the buffer amount set in your funding preferences. For more 
information on setting up overallocation of funds, see the Set Investment Funding preferences 
topic. If you plan to allocate beyond the available fund plus the buffer amount, an error message 
indicates that new funds cannot be submitted for allocation.

You can plan fund allocations only according to the funding frequency configured in the 
Investment Funding Preferences.
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Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Click an investment card to open an active investment that has funds that you plan to allocate 
to other investments.

If you want to open a different investment, access the drop-down menu next to the name of the 
currently displayed investment. Either search for another investment by entering its name in 
the Search My Investments  field or choose it from the five most recently visited investments.

3. Click the Allocate Funds  tab.

4. Select a working period and click Apply.

◦ If you have allocated funds earlier or there are incoming fund requests, those investments 
are listed in the Allocate Funds  list.

◦ You can filter for pending (planning and requested) investments by clicking the filter icon 

( ).

5. In the Allocate Funds  list, select the incoming requests to which you are planning to allocate 
funds.

6. Click Plan.

Result

• Funds allocations are planned for the selected investments for the specified period.

• The state of all updated investments changes to Planning, which is indicated by highlighted 
cells.

• The amount remaining after planning your allocations is displayed in the Left after planning 
row.

What to do next
Allocate funds to planned investments

Allocate funds to an investment
Allocate funds to investments based on your business goals and available funds.

Before you begin
Role required: sn_invst_pln_v2.investment_user

About this task
You can allocate funds only in the funding frequency configured in the Investment Funding 
Preferences.

If you allocated funds to an investment earlier, you can increase or decrease the funded amount 
by entering an amount greater or lesser than the existing amount. Entering a lesser value 
unfunds the investment by the difference amount.

If you allocate funds to an investment that are in addition to the received funds, a warning 
message is displayed in the Totals  row indicating that you are overallocating, and the additional 
fund amount will be deducted from the buffer amount set in your funding preferences. For more 
information on setting up overallocation of funds, see the Set Investment Funding preferences 
topic. If you try to allocate beyond the available fund plus the buffer amount, an error message 
indicates that new funds cannot be submitted for allocation.
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You can allocate funds to only those entities that are added in the Fundable entities  field while 
creating the entity.

Note: 
For generic investments, you can allocate funds to investments that you own.

Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Click an investment card to open an active investment that has sufficient funds to allocate to 
another investment.

If you want to open a different investment, access the drop-down menu next to the name of the 
currently displayed investment. Either search for another investment by entering its name in 
the Search My Investments  field or choose it from the five most recently visited investments.

3. Click the Allocate Funds  tab.

4. Select a working period and click Apply.

◦ If you have allocated funds earlier or there are incoming fund requests, those investments 
are listed in the Allocate Funds  list.

◦ You can filter for pending (planning and requested) investments by clicking the filter icon 

( ).

5. Optional:  Add more investments to the Allocate Funds  list for allocating funds.

a. Click Add.

b. Optional:  Click New  to create a new entity record if you have sufficient privileges for the 
source entity.

c. In the Add  pane, select one or more investments from the list, and then click Add Selected.

(Optional) To include all the listed investments, click Add All.

6. In the Allocate Funds  list, enter the amount under the CapEx  and OpEx  columns under New 
Fund  for all investments to which you want to allocate funds.

Note: 
For an incoming request, take into account the amount in the New Request  column while 
entering amounts in the CapEx  and OpEx  columns under New Fund.

The state of all updated investments changes to Planning, which is indicated by highlighted 
cells.

7. Click Fund.

8. In the Confirm Allocate Funds dialog box, verify your allocations and click Fund.

While confirming fund allocations, you can view all the details of the quarters where funds 
are available for funding in one section, and the details of the quarters where funds are not 
available for funding in another section.

9. Optional:  Right-click on a column on the grid and select View Past Funding Details  to view 
the funding details of your child investments for the past fiscal periods.

(Optional) For more information, see the View past funding details  topic.
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Result

• Funds are allocated to selected investments for the specified period.

• The state of funded investments changes to Funded.

Enter actual spends for an investment
Enter actual spends for your investments to track fund utilization.

Before you begin
Role required: sn_invst_pln_v2.investment_user

About this task
You can use funds in your investments to execute business activities or allocate funds to 
other investments to meet business goals. You can record the amount spent as actual spends 
("actuals") in the respective investment. Tracking actuals enables you to do the following:

• Track where and how you spent your funds.

• Add up to the parent investment actuals.

Actual cost incurred for projects or demands will be summed up and displayed in the Investment 
Funding grid automatically if there is a single funded source. If there are multiple sources, you 
need to perform the following steps to enter the actuals manually.

Note: 

• (For customers upgraded from legacy Investment Funding plugin to the ServiceNow Store 
application) If you have entered actuals manually prior to upgrade, then the same does 
not match with the actuals posted in the project post-upgrade.

• If the Budget  field on the cost plan breakdown of a project or demand has been edited 
post funding, the CapEx and OpEx budgets do not match the amount funded from the 
Investment Funding flow.

Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Open an investment for which you want to enter actuals.

If you want to open a different investment, access the drop-down menu next to the name of the 
currently displayed investment. Either search for another investment by entering its name in 
the Search My Investments  field or choose it from the five most recently visited investments.

3. Click the View/Request Funds  tab.

4. Select a working period and click Apply.

5. In the Request Funds list, specify the actual amount spent under the Actual CapEx  and Actual 
OpEx  columns for your investments.

Note: 
If you do not see the Actual CapEx  and Actual OpEx  columns in the list, click the 

configuration icon ( ) and select them.
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Result

• The entered amount is updated as actual funds spent through the investment.

• The amount rolls-up to its parent investment, which in turn rolls-up until the top-level 
investment.

Reject a fund request
You can reject an incoming fund request based on your business priorities or if you do not have 
sufficient funds.

Before you begin
Role required: sn_invst_pln_v2.investment_user

Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Open an active investment.

If you want to open a different investment, access the drop-down menu next to the name of the 
currently displayed investment. Either search for another investment by entering its name in 
the Search My Investments  field or choose it from the five most recently visited investments.

3. Click the Allocate Funds  tab.

4. Select a working period and click Apply.

5. Select an investment from the Allocate Funds  grid.

6. Click the Allocate Funds  drop-down list and select Reject.

7. Optional:  Select an investment, and click Clear  from theAllocate Funds  drop-down list to 
remove the planning state funding requests that are for past funding periods or non-editable 
funding periods from your list.

Review the use of your funds
Review the flow of your funds from your investment to other investments to make an informed 
decision when you allocate or request funds.

Before you begin
Role required: sn_invst_pln_v2.investment_user

About this task
Reviewing the use of your funds enables you to see when an investment has not used funds, or 
whether the funds are still meeting the priorities of your business goals.

Note: 
The actual amount in your investment is the sum of the direct spends you entered and the 
total from all investments to which you had allocated funds. The correct actual amount is 
reflected only if the owners of those investments have entered the actual spends in their 
investments.

You can view the difference between funds received and actuals (underspent or overspent 
amount) in the tree view cards. If the funds received amount is greater than the amount in the 
fund, the underspent amount is displayed in green. If the funds received amount is lesser than 
the amount in the fund, the overspent amount is displayed in red.
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You can configure which information should be displayed on the cards in the list view of Allocate 
Funds  or View/Request Funds. For example, you can configure the list view to display only the 
Total Actuals  amount.

Users that the investment owner adds in the Viewable by  field can also review the investment 
details. The owner of an investment that funds a particular investment is automatically added 
to the field list for that investment. For example, if a program investment receives funds from a 
portfolio investment, then the owner of the portfolio investment is added to the Viewable by  field 
for the program investment.

Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Click an investment card to open an active investment to review fund allocations.

If you want to open a different investment, access the drop-down menu next to the name of the 
currently displayed investment. Either search for another investment by entering its name in 
the Search My Investments  field or choose it from the five most recently visited investments.

3. On the Allocate Funds  tab, click the tree view icon ( ).
Your investment and the investments that you funded directly display as cards in a hierarchical 
view. The number of child investments is displayed in the parent investment card. If there are 
more than 10 investment cards, you can access a compact card view.

4. Click an investment to view its fund allocation to other investments.

As you drill down to child investment cards, the clickable menu in the top-right corner displays 
the current level of the hierarchy.

5. Optional:  Click the Actions  menu and select View Investment  to navigate to the investment 
grid.

View past funding details
View the past funding details of your investments.

Before you begin
Role required: sn_invst_pln_v2.investment_user

Procedure

1. Navigate to All  > Investment Funding  > My Funds.

2. Click an investment card to open the investment for which you want to view the past funding 
details.

If you want to open a different investment, access the drop-down menu next to the name of the 
currently displayed investment. Either search for another investment by entering its name in 
the Search My Investments  field or choose it from the five most recently visited investments.

3. Click the Allocate Funds  tab.

4. Right-click on a column on the grid, and select View Past Funding Details  to view the funding 
details of your investments for past fiscal periods.

If you are not the owner of the investment but have been added in the Viewable by  field of the 
investment, you can view the investments in read-only mode.

The graph displays the comparison between the total funds received and the total actuals for 
the fiscal periods in the past one year.
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Domain separation and Investment Funding
Domain separation is supported in Investment Funding. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Handling domain separation for Financials in Workspace

Defining funding entity is an important configuration to create Investment Object (IO) for any 
entity. The accessibility of the Funding entity definition configuration record is important to 
determine whether IO can be created for the entity. Let's consider example of Project as entity. 
Similar process is applicable for any entities configured through Funding Entity definition.

1. Define funding entity in Global domain.

This helps users to access projects from any specific domain or global domain.

2. If a project is required to access from a specific domain to meet your organization 
requirements, define the funding entities in that specific domain only.

3. Always create Investment Object in the same domain of the respective Project’s domain.

When a user in a parent domain accesses the financials of a project in a child domain, the 
system creates the investment object in the child domain. This ensures that users in the child 
domain can access the financials and the investment object.

Related topics

Domain separation for service providers

Export to PowerPoint for Strategic Portfolio Management
The ServiceNow®  Export to PowerPoint for Strategic Portfolio Management  add-in helps you to 
generate and download project status reports from your instance as a Microsoft PowerPoint  file. 
You can use this file to share it across the stakeholders or teams for collaboration.

Export to PowerPoint  overview

Export to PowerPoint overview video. Approximately two minutes long.
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Get started

Explore

Learn about Export to 
PowerPoint add-in features.

Configure

Install and configure the 
Export to PowerPoint add-in.

Use

Use Export to PowerPoint to generate 
and download your project status report.

Reference

Get details about components 
installed, form fields, tables, 

roles, and general guidelines.

Important: 

• For more information about the data processing required to generate a project status 
report within the ServiceNow  servers based on your location, see the KB1170323  article 
in the Now Support  Knowledge Base.

• Export to PowerPoint  is currently unavailable for customers in the FedRAMP, NSC DOD 
IL5, or Australia IRAP-Protected data centers, self-hosted customers, or in other restricted 
environments. Please check for availability updates in future releases.

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

Exploring Export to PowerPoint
The Export to PowerPoint  application helps you generate and download your project 
status report. Use this file to present your project status report to stakeholders or teams for 
collaboration and to identify the next steps.

Use the following data types to create a Microsoft PowerPoint  template.
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Report template types

Report type Description

Text Generates a text format report.

Table Generates a table format report.

Line Generates a line chart report.

Bar Generates a bar graph report.

Repeater A token used to generate data for all the 
entries in a record by retaining the template 
format.

Configuring Export to PowerPoint
Learn about the process and prerequisites used to install the Export to PowerPoint  application in 
your instance and configure it in Microsoft PowerPoint.

Configuration workflow

Use the following steps as guidelines to configure and install the ServiceNow  add-in for Microsoft 
PowerPoint  after you download the Export to PowerPoint  application from the ServiceNow Store.

1. Install Export to PowerPoint for Strategic Portfolio Management  from the ServiceNow Store. For 
more information, see Install Export to PowerPoint for Strategic Portfolio Management.

2. Manage the related tables and scripted elements components. For more information, see 
Manage Related Tables and Scripted Elements forms.

3. Download the manifest file from your instance to and share it with your Microsoft Office 365 
account manager. For more information, see Download the manifest file from your instance.

4. Configure the Export to PowerPoint  add-in for your Microsoft PowerPoint. For more information, 
see Configure the Export to PowerPoint add-in for Microsoft PowerPoint.

Install Export to PowerPoint for Strategic Portfolio Management

You can install the Export to PowerPoint for Strategic Portfolio Management  application (sn_ppt) 
if you have the admin role. The application includes demo data and installs related ServiceNow® 

Store  applications and plugins, if they are not already installed.
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Before you begin

• Review the application listing in the ServiceNow Store  for information on dependencies, 
licensing or subscription requirements, and release compatibility.

• Role required: admin

• Important: 
For more information about the data processing required to generate a project status 
report within the ServiceNow  servers based on your location, see the KB1170323  article 
in the Now Support  Knowledge Base.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the  Export to PowerPoint for Strategic Portfolio Management   application 
(sn_ppm_ppt_export) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you 
might have to request it from the ServiceNow Store.

In the list next to the Install  button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application 
are listed.

4. If you're prompted, follow the links to the ServiceNow Store  to get any additional entitlements 
for dependencies.

5. Optional:  If demo data is available and you want to install it, select the Load demo data  check 
box.
Demo data are the sample records that describe application features for common use cases. 
Load the demo data when you first install the application on a development or test instance.

6. Select Install.

Result
The following components are installed with installation of the Export to PowerPoint for Strategic 
Portfolio Management  application.

• Roles

• Tables

See Components installed with Export to PowerPoint for Strategic Portfolio Management  for more 
information.

Manage Related Tables and Scripted Elements forms

Manage the Related Tables  and Scripted Elements  components that are required to create a 
Microsoft PowerPoint  template.

Before you begin
Role required: sn_ppt_export.ppt_admin
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Procedure

1. Navigate to All  > PowerPoint Management  > PowerPoint Report Types.

2. Select a parent table record, for example, Project report pm_project.

Option Description

To manage Related Tables

You can add a custom remote table or a child 
from the parent table.

a. In the Related Tables  related list, select 
New.

On the Related tables form, fill the fields. 
For a description of the field values, see Re­
lated Tables form.

b. To add a custom remote table:

i. .

ii. Select the required remote table from list.

iii. Select the Enable custom script  option.

iv. In the Custom script box, write the code 
to establish a connection between the re­
mote table and main table.

c. To select a child table from the main table:

i. Select a child table from list.

ii. Set the Parent relation column  to the 
field that links the child table to the par­
ent table.

d. Select Submit.

The selected table and its relation to the par­
ent table is displayed in the Related tables 
section.

To manage Scripted Elements

a. In the Scripted Elements  component, se­
lect New.

b. On Scripted Elements form, fill the fields. 
For a description of the field values, see 
Scripted Elements form.

c. Select Submit.

3. To configure a Script  component, specify the script logic to generate dynamic content in the 
template.

Script components allow you to include calculated or dynamically generated content in your 
PowerPoint template. Use scripts when the built-in Field, Table, or Text component types do not 
meet your requirements.

Example: To display a formatted project health status:
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(function() {
                  var gr = new GlideRecord('pm_project');
                  gr.get(current.getValue('sys_id'));
                  var health = gr.getValue('health');
                  if (health == 'green') return 'On Track';
                  else if (health == 'yellow') return 'At 
 Risk';
                  else return 'Off Track';
                  })()

Note: 
Verify the available scripting API and context variables with your ServiceNow 
administrator. Script components execute server-side and have access to the current 
record context.

4. Select Update.

Download the manifest file

Configure the user roles and download the add-in manifest file to use the Export to PowerPoint 
add-in for Microsoft PowerPoint.

Before you begin
Role required: sn_ppt_export.ppt_admin

Procedure

1. Navigate to All  > ServiceNow Add-Ins for Office  > Office Add-In Manifests.

2. Click Templates for ServiceNow.

Note: 
Check the Templates for ServiceNow  description to match with PowerPoint plugin for 
ServiceNow  to ensure that the correct manifest file is selected.

3. Click Download Manifest  to download the add-in file.
The manifest file you download is specific to your instance. It contains the instance URL and 
configuration details that apply only to your environment. Using a manifest from one instance 
on another instance does not work and may cause errors.

If you work with more than one ServiceNow instance, for example, a development instance and 
a production instance — you have two options:

◦ Install a separate manifest for each instance. Download and install the manifest individually 
from each instance you need to connect to.

◦ Use the sideload option. If installing multiple manifests is not practical, use the sideload 
option to temporarily load the manifest for a different instance without installing it 
permanently.

What to do next

• Share the manifest.xml  file with Microsoft Office 365  account manager to upload the 
manifest file for Microsoft Office 365 users  to enable the Export to PowerPoint  add-in for 
Microsoft PowerPoint.

Alternatively, you can sideload the add-in for testing purposes using one of the following 
processes.
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◦ For Windows  machines: https://learn.microsoft.com/en-us/office/dev/add-ins/testing/
create-a-network-shared-folder-catalog-for-task-pane-and-content-add-ins

◦ For macOS  machines: https://learn.microsoft.com/en-us/office/dev/add-ins/testing/
sideload-an-office-add-in-on-mac

• For more information about the additional configuration steps required to enable the Export to 
PowerPoint  add-in for browser version of Microsoft PowerPoint, see the KB1171422  article in 
the Now Support  Knowledge Base.

Configure the Export to PowerPoint  add-in for Microsoft PowerPoint

Configure the Export to PowerPoint  add-in in your Microsoft PowerPoint  to interact with your 
instance and fetch the data required to generate and download your project status reports.

Before you begin

• Role required: sn_ppt_export.ppt_admin or sn_ppt_export.ppt_user.

• The Export to PowerPoint  add-in must be deployed to your Microsoft PowerPoint. If the add-in 
icon does not appear on the Home tab, verify the following.

1. Download the add-in manifest file  from your ServiceNow  instance.

2. Contact your Microsoft Office 365  administrator to deploy the manifest using the Microsoft 
365  admin center (Settings  > Integrated apps  > Upload custom apps).

3. After deployment, restart Microsoft PowerPoint  and verify the ServiceNow  add-in icon 
appears on the Home tab.

• For the Export to PowerPoint  plugin configuration on your instance, see Configure the Export to 
PowerPoint add-in for Microsoft PowerPoint.

Tip: 

If you do not see the add-in icon after deployment, check Insert  > My Add-ins  in Microsoft 
PowerPoint  to verify the add-in is installed. You may need to select it manually to add it to 
your ribbon.

Procedure

1. Open your Microsoft PowerPoint  application and select the ServiceNow  add-in icon 

( ) on the Home  tab.
A panel appears with a login option to access your ServiceNow  instance.

2. Select Log in.

3. Enter your ServiceNow  instance credentials and select Log in.
A prompt requesting access to your instance with details such as the instance name is 
displayed.

4. Check your instance details and select Allow.
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Result
The landing page of the add-in appears as the right panel.

Note: 
For more information about the additional configuration steps required to enable the Export 
to PowerPoint  add-in for the browser version of Microsoft PowerPoint, see the KB1171422
article in the Now Support  Knowledge Base.

What to do next
Create a Microsoft PowerPoint template.

Using Export to PowerPoint
Use the Export to PowerPoint  add-in for Microsoft PowerPoint  to create a template to generate 
reports.

Note: 
While creating a template, any formatting options that you use such as font style, font size, 
background color, and so on, are retained while generating a report.

1. Create a Microsoft PowerPoint  template. For more information, see Create a Microsoft 
PowerPoint template.

2. Upload a Microsoft PowerPoint  template to your ServiceNow  instance. For more information, 
see Upload your Microsoft PowerPoint template.

3. Download a project status report using the created template. For more information, see 
Download a project status report.

Create a Microsoft PowerPoint  template

Configure the Export to PowerPoint  add-in in your Microsoft PowerPoint  to interact with your 
instance and fetch the data required to generate and download your status reports. Create your 
own custom template with the required data to generate a report, based on the reporting needs 
of your organization.

Before you begin

• Let us connect your instance to the Microsoft PowerPoint  using the add-in login and create a 
template Portfolio Planning  to generate a report for epic details.

• Role required: sn_ppt_export.ppt_user
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Procedure

1. Open your Microsoft PowerPoint  application and select the ServiceNow  add-in icon 

( ) on the Home  tab.
A side panel appears with a login option to access your ServiceNow  instance.

2. Select Log in.

3. Enter your ServiceNow  instance credentials and select Log in.
A prompt with your instance details is displayed.

4. Check your instance details and select Allow.
The landing page of the add-in appears on the side panel.

5. Select Personal portfolio report  from the Type list.

Select the data type you want to populate.

◦ Text – Text entries from the parent table. Example: Portfolio name, owner name, and so on.

◦ Table – Table entries mapped using related tables.

◦ Repeater – To populate additional details for each of the selected records.

◦ Line and Bar chart – Graph entries mapped using scripted elements.

Note: 
While creating a template, you can:

◦ Change the font size and color for the token values to reflect the same in your status 
report.

◦ Move around the token to place them in a required format.

◦ Add your custom or organization logos on the slides.

◦ Resize the chart tokens according to the requirement.

You can customize data retrieval for template tokens by appending link attributes. The 
following attributes are available:
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Template token link attributes

Attribute Description Example

orderByColumnName Sorts the data by the specified 
column name in ascending or 
descending order.

orderByColumnName=priority^orderByDirection=asc

filterQuery Applies an encoded query to 
filter the data populated in the 
template token.

filterQuery=state=2^priority=1

maxRows Limits the maximum number 
of rows returned for a table or 
repeater token.

maxRows=10

Apply these attributes by appending them to the token URL in the template field properties. For 
details on configuring related tables and scripted elements, see Manage components.

6. To populate the Portfolio name on the first slide:

a. Select Text  from the data type.

b. Filter the Column list to locate Name and select it. A token value representing the portfolio 
name is generated in the subsequent empty text box.

c. Select the Copy text  button to copy the token.

d. Paste the token on the slide.

Add a new slide to Microsoft PowerPoint, insert a table with three columns and two rows to 
generate the Epics with their numbers, status, and due date.

7. To populate Epics details such as numbers, status, and due date:

a. From the add-in landing page, select Table  from the Data list.

Use the Back  ( ) button to go back to the add-in landing page.

b. Select Epic  from the Related table list.

c. From the Related table (optional) list, select a related table to the Epic.

d. Select the number of rows that you want to populate and By default, five rows are selected.
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You can select a minimum of one row and a maximum of 10 rows.

e. Use the filter icon to see any existing filter or to define a condition to populate the data.

Here, we’re picking Epics which are in either Ready or Work in progress state with a deadline 
on April 30.

f. Select Next.

g. Select Number  from the Column list.

h. Copy the token value and paste it in the table.

i. Similarly, copy and paste the token values of State  and Assigned to  fields from the Column 
list.

Add slide to Microsoft PowerPoint.

8. To populate the required details of each of the selected records:

a. From the add-in landing page, select Table  from the Data list.

Use the Back  ( ) button to go back to the add-in landing page.

b. Select Repeater  from the Data list.

c. Select Epic  from the Related table list.

d. Add the required filter using the filter option and select Next.

e. Select the required fields to copy and paste the token on the slide.

f. Copy and paste the repeater token to the slide

Note: 
The repeater token doesn’t generate any values in the status report.
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Add a new slide to Microsoft PowerPoint.

9. To populate a line or bar chart:

a. From the add-in landing page, select Line Chart  or Bar Chart  from the Data list.

Use the Back  ( ) button to go back to the add-in landing page.

b. From the Select a chart (defined using scripted elements) list, select a chart you want to 
populate for your report and select Next.

c. Select the Copy to clipboard  button to copy the chart token.

d. Paste the token on a slide.

10. Save the Microsoft PowerPoint  file in the .pptx  format with a maximum of 50 slides and file 
size not exceeding 15 MB.

Note: 
The Export to PowerPoint for Strategic Portfolio Management  application comes with 
default templates which you can use to generate reports and consider as a reference to 
create templates.

Upload your Microsoft PowerPoint  template

Upload the latest template to your instance to generate and download the status report as a 
Microsoft PowerPoint  file.
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Before you begin
Role required: sn_ppt_export.ppt_user

Procedure

1. Navigate to All  > PowerPoint Management  > PowerPoint Templates.

2. Select a record to attached the latest template.

3. Select the manage attachments icon ( ).

4. Select Choose file  to browse and upload the template.

Note: 
You can use only one template (.pptx) at a time with a maximum file size of 15 MB. 
Delete the existing template to upload and use a new one.

5. Close the dialog box, and select Update  on the form.

What to do next
Download a project status report.

Download a project status report

Download your projects and project status reports as a Microsoft PowerPoint  file to share it with 
the stakeholders.

Before you begin
Role required: sn_ppt_export.ppt_user

Important: 
Export to PowerPoint  is currently unavailable for customers in the FedRAMP, NSC DOD 
IL5, or Australia IRAP-Protected data centers, self-hosted customers, or in other restricted 
environments. Please check for availability updates in future releases.

Procedure

1. To download your status report for Enterprise Architecture  (formerlyApplication Portfolio 
Management), see Export data to Microsoft PowerPoint - Legacy .

2. To download your status report for Project Workspace, see Export a project status report to 
Microsoft PowerPoint from Project Workspace.

3. To download your project from Project Workspace, see Export a project from Project 
Workspace.

4. To download your status report for Strategic Planning, see Export the portfolio plan status or 
roadmap to Microsoft PowerPoint.

5. To download your status report for Portfolio Planning, see Export the portfolio plan status or 
roadmap to Microsoft PowerPoint.

Result
Your report is downloaded as a Microsoft PowerPoint  file with the project number and status 
report date as the file name.

Export to PowerPoint  Reference
Reference topics provide additional details about Export to PowerPoint  such as fields, tables, 
roles, and some guidelines.
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Components installed with Export to PowerPoint for Strategic Portfolio 
Management

Several types of components are installed with activation of the Export to PowerPoint for 
Strategic Portfolio Management  (sn_ppt) add-in, including user roles and tables.

Roles installed

Role title [name] Description Contains roles

Export to PowerPoint 
for Strategic Portfolio 
Management  admin

[sn_ppt_export.ppt_admin]

• Create, edit, and manage 
the attributes required 
to generate Microsoft 
PowerPoint  templates.

• Assign this role in 
confidence because it 
is a high security role for 
the Export to PowerPoint 
application with access to 
modify the source code for 
Scripted Elements.

sn_ppt_export.ppt_user

Export to PowerPoint 
for Strategic Portfolio 
Management  user

[sn_ppt_export.ppt_user]

• Create a template, upload it 
to the ServiceNow  instance, 
generate, and download the 
project status report.

• By default, users with 
the project_user role are 
assigned this role.

None

Tables installed

Table Description

PowerPoint Cell Formatter

[sn_ppt_export_ppt_cell_formatter]

Stores the color properties for text, text 
background, table cell, and shape fill.

PowerPoint Element

[sn_ppt_export_ppt_element]

Stores the required elements to generate 
aMicrosoft PowerPoint  template.

PowerPoint Formatter

[sn_ppt_export_ppt_formatter]

Stores the text formatting options.

PowerPoint Formatter Mapping

[sn_ppt_export_ppt_formatter_mapping]

Stores the format mapping for the tokens.

PowerPoint Report Type Stores report types that can be used to 
generate a report.
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Table Description

[sn_ppt_export_ppt_report_type]

PowerPoint Template

[sn_ppt_export_ppt_template]

Stores the metadata required for the 
templates.

PPT Service Request Log

[sn_ppt_export_ppt_poi_service_request_log]

Stores service requests logs.

Related Table

[sn_ppt_export_ppt_related_table]

Stores related tables for a report.

Scripted Element

[sn_ppt_export_ppt_scripted_element]

Stores the supported chart types, such as line 
chart and bar chart.

Default templates installed

Template name Description and use case Data included

Project Report Template - 
Default

A comprehensive project report 
template designed for detailed project 
reviews. Use this template for in-depth 
project status meetings with project 
teams and stakeholders.

Project details, task 
breakdown, milestone 
status, resource 
allocations

Project Status  Report 
Template - default

A concise executive summary template 
designed for high-level status updates. 
Use this template for portfolio reviews, 
steering committee meetings, and 
executive dashboards.

Project overview, key 
metrics, status indicators, 
high-level timeline

Tip: 

To view and manage all available templates, navigate to All  > PowerPoint Management  > 
PowerPoint Templates.

Related Tables form

Use the Related Tables form to define the child tables for the configured parent table. This 
Related Tables helps in fetching data to export the project status report as Microsoft PowerPoint.

Related table form

Field Description

Name
Name of the child table to include in the 
export.

Parent relation column
The column that defines the relationship 
between the parent and child tables. This field 
determines how the child table data is joined 
to the parent record.
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Related table form  (continued)

Field Description

For more information on how to manage 
Related Tables, see Manage Related Tables 
and Scripted Elements forms.

Enable custom script Select this option to enable custom scripting 
for the related table data. When enabled, you 
can write server-side JavaScript to customize 
how child table data is fetched, filtered, 
or transformed before it is included in the 
PowerPoint export.

Important: 
Custom scripts run with the permissions 
of the current user. Test scripts 
thoroughly on a non-production instance 
before deploying to production.

Advanced Expand this section to access advanced 
configuration options for controlling how 
the related table data is rendered in the 
PowerPoint export, including field mappings, 
sort order, and display formatting.

Scripted Elements form

Use the Scripted Elements form to define the data script to fetch data for a complex report type 
such as line chart or bar chart.

Scripted Elements form

Field Description

Name Name for the element.

Type Chart type (Line chart or Bar chart) that you want to generate.

After the required chart type is selected, the suggested format of the scripted 
elements code format is displayed in the Data Script  field.

Description Description for the report. (Example: Comparison of planned vs. Actual costs.)

Data Script Script used to fetch data for the report.

For more information on how to manage Scripted Elements, see Manage Related 
Tables and Scripted Elements forms.

Line chart parameter

Following are the basic parameters used to define the properties and formatting of a line chart.
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Line chart parameters

Parameter Description Reference value

@property {String} 
seriesArray.properties.color 
- Color of Line

Color of the line. Use Hex code values to define 
a color of the line.

For example, use the hex code 
#FF0000  for red color.

@property {String} 
seriesArray.properties.type 
- type of Line

Type of line. For more information about 
reference line formats, see 
https://poi.apache.org/
apidocs/dev/org/apache/
poi/xddf/usermodel/
PresetLineDash.html DASH .

@property {String} 
seriesArray.properties.markerStyle 
- style of marker

Style of the marker to identify 
key points on the chart.

For more information about 
reference marker formats, 
see https://poi.apache.org/
apidocs/dev/org/apache/
poi/xddf/usermodel/chart/
MarkerStyle.html .

@property {Number} 
seriesArray.properties.markerSize 
- size of style

Size of the marker on the 
chart.

Minimum inclusive: 2, 
maximum inclusive: 72

@property {String} 
legendPosition - 
Position of legend 
in chart. This is 
optional

Legend position of the chart. For more information about 
legend position, see https://
poi.apache.org/apidocs/
dev/org/apache/poi/
xddf/usermodel/chart/
LegendPosition.html .

Bar chart parameters

Following are the basic parameters used to define the properties and formatting of a bar chart.

bar chart parameters

Parameter Description Reference value

@property {String} 
barProperties.directionThe direction of plotting the 

bars in the chart.
For more information about 
defining a bar direction, 
see https://poi.apache.org/
apidocs/dev/org/apache/
poi/xddf/usermodel/chart/
BarDirection.html .

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1902

https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/PresetLineDash.html#DASH
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/PresetLineDash.html#DASH
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/PresetLineDash.html#DASH
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/PresetLineDash.html#DASH
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/PresetLineDash.html#DASH
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/PresetLineDash.html#DASH
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/MarkerStyle.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/MarkerStyle.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/MarkerStyle.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/MarkerStyle.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/MarkerStyle.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/MarkerStyle.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/LegendPosition.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/LegendPosition.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/LegendPosition.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/LegendPosition.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/LegendPosition.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/LegendPosition.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/LegendPosition.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarDirection.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarDirection.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarDirection.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarDirection.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarDirection.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarDirection.html


bar chart parameters  (continued)

Parameter Description Reference value

@property {String} 
barProperties.grouping 
- grouping of bars

Grouping style of the bar in 
the chart.

Use options such as standard, 
clustered, stack. For more 
information about bar 
grouping properties, see 
https://poi.apache.org/
apidocs/dev/org/apache/
poi/xddf/usermodel/chart/
BarGrouping.html .

@property {Number} 
barProperties.overlay Size of overlapping among the 

bars in the chart.
Accepted numeric value range 
is from 0 to 100.

Agile Development 2.0
ServiceNow  Agile Development 2.0  provides an agile software development environment for 
product-based or project-based efforts, using the Scrum framework. Implement a pure agile 
approach over the entire life cycle of a product, or a hybrid approach using agile methods within 
a traditional project structure.

This video provides an introduction to development in the ServiceNow SPM Agile 2.0 application 
including creating stories, planning backlogs and sprints, and tracking progress

Get started

Explore

Learn the key features and 
business value that Agile 
Development 2.0 offers

Set up

Activate the required 
plugins, migrate data 

from Agile Development 
1.0, and verify custom 
configuration settings

Integrate

Integrate Agile 
Development with third-
party execution systems

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1903

https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarGrouping.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarGrouping.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarGrouping.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarGrouping.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarGrouping.html
https://poi.apache.org/apidocs/dev/org/apache/poi/xddf/usermodel/chart/BarGrouping.html


Use

Learn how to manage your 
product development with 

Agile Development 2.0

Reference

Get details about 
components, form fields, 
and general guidelines

Troubleshoot and get help

• Ask or answer questions in the Strategic Portfolio Management  forum on the ServiceNow 
Community

• Search the Known Error Portal for known error articles

• Contact Customer Service and Support

• Enhance your learning with courses from developer training

• Refer to the developer documentation

• Find the Strategic Portfolio Management  package that works best for you

Exploring Agile Development 2.0
Learn about the Scrum methodology framework, typical activities, and artifacts that are used in 
ServiceNow®  Agile Development 2.0.

Overview of product based and project based approaches inAgile Development 2.0. 
Approximately three minutes long.

Agile Development 2.0  supports both product-based and project-based development efforts. For 
a quick overview of these approaches, watch the video.

Use the information in the following sections for a deeper understanding of Agile Development 
basics, its process, and the scenarios in which Agile Development  is used. Also, learn about the 
features of the Agile Development 2.0  application.

Basics of Agile Development

Scrum is one of the popular methodologies of Agile Development, which includes a fixed sprint 
schedule and regular requirements testing. These activities are performed by common roles 
such as product owner, scrum master, and group members. Learn about the basics of Agile 
Development  process.

Scrum framework

Familiarize yourself with the terminology and artifacts used in Agile Development.

Assignment group or Agile team

Group of users who are involved in working on and completing the development 
for an Agile product. In Agile Development 2.0, this team is called as an assignment 
group.
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In an assignment group, a user is designated as the scrum master, who is 
responsible to ensure that all the scrum activities are properly performed for a 
release. For more information, see Assignment groups in Agile Development 2.0.

Epic

High-level definition of a requirement that provides value to the business, such as a 
new feature or a significant enhancement. Epics are broken down into Agile stories 
and can be worked on by a single or multiple teams.

Story

Short, manageable pieces of work that are related to an epic. Stories capture 
the who, what, and why of a requirement in a simple and concise way. Using the 
description and criteria mentioned in the stories, teams can accurately estimate the 
effort required to implement the work in it.

Scrum task

Distinct tasks that are required to complete a story. A task might require from 4 
through 12 hours to complete.

Backlog

List of work that must be implemented, as part of achieving specific outcomes. 
Backlog contains work related to new features, enhancements to existing features, 
and other activities of product development.

Backlog is considered as the single source of work for a product or team. Anything 
that is not included in the backlog would not be prioritized for development.

Personal Backlog

Product owners define a personalized work pipeline called personal backlog, 
by applying relevant filter criteria. In Agile Development 2.0, product owners can 
define as many personalized backlogs as necessary. The criteria used to create the 
personalized backlog is flexible and can be modified at any time.

Sprints

Short, fixed periods, in which team members pick and complete a set number of 
stories. These short, time-boxed cycles provide the teams the flexibility to adapt to 
changing priorities.

The cadence of recurrence for a sprint is decided by the development teams and 
the product owners. For example, a 10-day sprint, or a 1-week sprint.

Sprint backlog

Scope of work for a sprint. Product owners and their development teams use the 
sprint planning activity to review their backlog and decide on the stories to be 
picked up for a sprint.

Theme

Area of focus with an associated business value. A theme is related to one or more 
of the company's goals. Themes help you prioritize your work at a high level and can 
be associated with multiple epics.

Product

Entity to organize themes, epics, and stories of similar functionality into a single 
context. A product represents an item or a feature that is to be developed and 
released to the market.
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Release

A release has a start and end date during which several development iterations 
are completed. Releases are created by a product owner and contain user stories, 
sometimes from multiple products and can also involve multiple teams. The stories 
associated to a release form its release backlog.

Note: 
In Agile Development 2.0, ensure that you create a product before you create 
themes, epics, or stories. You cannot submit these records without attaching 
them to a product.

After creating stories and scrum tasks for your products, you can create a 
personalized backlog containing the stories from one or more of these products.

Defects

Defects can be used to report and track the resolution of issues that are noticed 
during the development of a new feature, or as a feedback for existing features. 
Product owners then review these defects and decides on creating stories for them, 
which are assigned to the relevant assignment groups.

Using the Agile Development — Unified Backlog, you can set up a triage board to 
maintain a centralized backlog for records of different task types, such as defects, 
stories, and enhancements. For more information, see Agile Development — Unified 
Backlog.

Enhancements

Enhancement requests can be used to log feature enhancements for a product. 
These requests can arise from internal requirements or customer feedback. Product 
owners review these logged requests and decides on creating stories for them 
based on priority. These stories are then assigned to the relevant assignment 
groups for development.

Using the Agile Development — Unified Backlog, you can set up a triage board to 
maintain a centralized backlog for records of different task types, such as defects, 
stories, and enhancements. For more information, see Agile Development — Unified 
Backlog.

Scrum activities

The Scrum process usually consists of the following activities.

Sprint planning

Assignment group members meet to decide on the stories that they can commit to 
deliver in the sprint. Typically, they commit to the top ranked stories first. The group 
decides which scrum tasks are necessary for each story. The product owner should 
be present to answer any questions.

Daily standup

Assignment group members meet to discuss the progress of their work from the 
previous day, work planned for the current day, and any blockers. The daily standup 
keeps the group members focused on completing the stories for the current sprint 
and informs the scrum master of any blockers.

At the end of the sprint, all its stories should be complete. Any incomplete stories 
are moved back into the backlog, or a future sprint.
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Sprint reviews

Sprint review meetings are held at the end of each sprint. In these meetings, the 
assignment group reviews the work that they completed and demonstrate the newly 
developed features to their product owner.

Sprint retrospectives

A retrospective meeting is conducted at the end of each sprint, to facilitate 
discussion between the group members on what went well and what did not. The 
goal of a sprint retrospective is to discuss ways to improve the execution of future 
sprints.

For details on how Agile Development 2.0  can help you manage your efforts of 
product development, see Agile Development process flow.

Scrum reports

Scrum reports help you analyze the performance and progress of your agile team. These reports 
can be related to an epic, sprint or release, and provide historical data of your team's work 
velocity. Performance Analytics  Content Pack for Agile 2.0 provides pre-configured dashboards 
with data visualizations to help you improve your Agile practices.

For more information, see Performance Analytics Content Pack for Agile 2.0.

Agile Development  process flow

Learn the process that is used to manage product development efforts in Agile Development 2.0, 
such as creating a product or tracking a sprint or release.

Note: 
The flow explained here represents the common practice for managing agile development 
efforts using the functionality available in the Agile Development 2.0  application. This flow 
does not represent the only possible process.

Define products

A product can be a set of features or functionality offered to users. Each product 
can have an owner that maintains the work pipeline, such as epics and stories, for 
the product. These work items can be associated to a theme, which is related with a 
business goal.

See Create a product in Agile Development 2.0.

Create epics and stories

Epics contain high-level requirements for your products, which you can use to 
break down into manageable stories. While creating epics and stories in Agile 
Development 2.0, you can associate them with a product.

See Create an epic in Agile Development 2.0  and Create a story in Agile 
Development 2.0.

Create releases

Some organizations have a fixed time frame to make their products available to the 
market, which is referred to as a release. A release has a start and end date, during 
which several development iterations are completed. For example, you can have 
quarterly or half-yearly schedules to release new applications or enhancements to 
existing applications.
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After you create a release in Agile Development 2.0, you can associate products, 
epics, and stories to it. See Create a release in Agile Development 2.0.

Create personalized backlogs

A personalized backlog can be created by defining filter criteria. For example, one 
personalized backlog can be a combination of stories, defects, and incidents while 
the other personalized backlog can be a combination of stories and incidents. In 
this way, you can create as many personalized backlogs as necessary.

See Create a personalized backlog in Agile Development 2.0

Create assignment groups

Create an assignment group add members to it. For each group member, define 
the number of story points that they can complete in a sprint. At the group level, the 
sum of the story points of all the group members determines the group capacity.

See Create an assignment group in Agile Development 2.0

Create sprints

A sprint is the time frame in which the development team delivers one or more 
stories. A sprint can be of any length, but typically takes between one and four 
weeks to finish. The scrum master creates the number of sprints required for the 
group, and these sprints are used by the group members to complete the work 
required for an upcoming release. However, all sprints within a release must be 
within the release start and end dates.

Plan sprint activities

Before a sprint starts, the group and scrum master decide on what stories from the 
backlog they can commit to complete within a sprint. Stories for a sprint can be 
selected based on priority. The scrum master must ensure that the effort (total story 
points) required to complete the stories matches the capacity of the group.

While planning your sprints, you can use the velocity reports as guidance to 
estimate how much work the group can complete in the next sprint. The Agile 2.0 
Team dashboard  provides Velocity history report and Velocity by type report.

• Velocity History: Gain an insight on the overall velocity of the team for the past 
10 sprints. Analyze if the team is achieving a stable, predictable velocity, and is 
meeting the commitments.

• Velocity by Type: Analyze the way your team's velocity changes over time 
and compare the team's strategic workload with operational or other types of 
workload.

For more information on how to plan your sprints, see Plan your sprint activities in 
Agile Development 2.0.

Track sprint progress

The scrum master manages the sprint team efforts, provides progress reports, 
and removes any blockers that the team encounters. Team members update 
story records and conduct daily standup meetings to discuss their progress and 
communicate the concerns to the scrum master and product owners.

The team is expected to complete all the stories that are committed for a sprint. The 
scrum master expects that the stories are fully tested and are ready for release, 
according to the acceptance criteria.
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Ideally, the committed stories and the scope for a specific sprint should not change 
while the sprint is in progress. Agile Development 2.0  provides the flexibility to 
update as necessary and adapt to changing priorities. However, stories must be 
added or removed from a sprint only after a discussion between the group, scrum 
master, and product owner.

You can use the Agile 2.0 Sprint dashboard  with reports such as burnup and 
burndown charts to track the progress of the team for a sprint.

Tip: 

If you're running a hybrid or traditional project delivery, you can still use 
the Agile 2.0 Sprint dashboard to track workflow state transitions using the 
cumulative flow diagram. For more information about enabling dashboard 
access, see Performance Analytics Content Pack for Agile 2.0.

Track release progress

The product owner tracks the progress of the release and verifies whether the team 
is completing stories in the pace that is necessary to achieve the release goal.

You can use the Agile 2.0 Release dashboard  with reports such as burnup, 
burndown, and cycle time charts to track the progress of the team for a release.

Note: 
All Agile 2.0 dashboards are available with Performance Analytics Content Pack for Agile 
2.0.

Agile Development  use cases

Learn the different methods that organizations could use to plan their backlog and deliver 
stories.

Some common delivery methods are:

• Release-based delivery

• Project-based delivery

• Standalone project development

Agile Development 2.0  provides the flexibility to maintain a unified backlog that can be used for 
both release-based or project-based types of delivery. You can maintain all your backlog in one 
place and associate the stories to a product,project, or both. You can also select stories from the 
backlog and execute them as a project, as a standalone project development.

The following example shows how Agile Development 2.0  supports a unified backlog for both 
project-based and release-based type of deliveries.
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Agile development work flow use cases

Release-based development use case in Agile Development

An example of release-based development and delivery model using Agile Development.

The usual activities involved in a release-based agile development are:

• Maintain Product Backlog: Product owners maintain the product backlog. They continuously 
groom their backlogs by adding stories, prioritizing, and estimating them.

In Agile Development 2.0, navigate to Agile Development  > Backlog  > All Stories  for the list of 
all the stories. You can filter the list for a specific product.

• Release Planning: Organizations have definite release cycles such as quarterly release, 
bi-yearly release, yearly release. The product owners select the prioritized stories from the 
product backlog that should be completed in a given release to form Release Backlog.

• Assignment of stories: In Agile Development 2.0, navigate to Agile Development  > Stories. 
Select the stories that you want to assign to a release and select Assign to release/group. 
Specify a team that you want to associate these stories with.

• Sprint planning: The scrum teams define their sprint schedule such as two-week sprint or 
three-week sprint. They work with the product owner, and select stories from the release 
backlog that should be completed in each sprint to create Sprint Backlog. The group members 
along with product owner and scrum master decide stories for each sprint using Sprint 
Planning.

In Agile Development 2.0, navigate to Agile Development  > Agile Board  > Sprint Planning.

Project-based development use case in Agile Development

An example of project-based development and delivery model in Agile Development.

The usual activities involved in a project-based Agile Development  include the following:

• Product Backlog: Product owners maintain the product backlog. They continuously groom their 
backlogs by adding stories, prioritizing and estimating them.

In Agile Development 2.0, navigate to Agile Development  > Backlog  > All Stories  for the list of 
all the stories.
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• Project Backlog: Product owners select the prioritized stories and assign them to one or more 
projects, thus creating the project backlog. Product owners can create one or more projects 
and capture additional details such as required resources, cost, risk, strategic alignment. All 
these projects undergo portfolio prioritization process, and the selected projects are executed 
by the project teams.

Note: 
Some organizations also define release cycles such as quarterly release, bi-yearly 
release, yearly release. They then move the stories from product backlog to the release 
backlog. In these cases, stories are assigned to the projects from the release backlog.

In Agile Development 2.0, navigate to Agile Development  > Stories  and select Assign to 
project  to assign stories to a new or existing project.

You can also open an existing project and associate stories to the project from the backlog. 
These stories are then executed as part of project execution.

• Assignment of stories: Assign the stories of the project to an assignment group so that the 
team can pick these up in the upcoming sprints.

In Agile Development 2.0, select the stories that you want to assign to a release, select Assign 
to release/group  and specify an assignment group.

• Sprint planning: The scrum teams define their sprint schedule such as two-week sprint or 
three-week sprint. They work with the product owner, and select stories from the release 
backlog that should be completed in each sprint to create Sprint Backlog. The group members 
along with product owner and scrum master decide stories for each sprint using Sprint 
Planning.

In Agile Development 2.0, navigate to Agile Development  > Agile Board  > Sprint Planning.

Standalone project development use case in Agile Development

An example of a standalone project development and delivery model in Agile Development.

In this case, a request (demand) for a new product or feature or system is raised. Demand 
managers capture the requirements in terms of stories. They also capture the other details for 
the demand such as resources required, cost, risks, and strategic direction. Such demands are 
converted into projects upon approval. Project managers can choose pure agile or hybrid mode 
of project execution. In hybrid mode, the initial phases such as planning, and analysis are taken 
up as waterfall tasks, and then the execution is done as agile phase. The agile phase is assigned 
to an agile group. The agile group then completes the work by sprint execution.

Using Agile Development 2.0 for standalone hybrid project development

Steps to execute a standalone hybrid project:

1. Create demand: Capture requirements  at demand state in terms of user stories. Use the 
Stories related list on the demand form to create stories.

2. Demand to Project conversion: When the demand is converted to a project, the stories in 
demand move to the project so that the project team (assignment group) can execute them. 
During the conversion, an Agile phase is also created, and the stories are assigned to the Agile 
phase.

3. Sprint planning: The agile group members along with project manager, and scrum master 
perform sprint planning. Navigate to Agile Development  > Agile Board  > Sprint Planning  to 
plan sprints.
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Agile board in Agile Development 2.0

The Agile board is a landing page where you can perform key actions of the scrum process such 
as managing your backlogs, planning your sprints, and tracking the sprint progress.

The Agile board is organized in the following tabs to help you manage these activities. You 
would require one or more of the scrum_admin, scrum_master, scrum_product_owner, or 
scrum_sprint_planner user roles.

Backlog

The Backlog tab helps you manage your personalized backlogs. Within the Backlog tab, you can:

• Create stories, epics, and themes.

• View all active stories that are assigned to a team but that are not assigned to any sprint.

• View cards indicating the total number of stories, stories that do not have story points, and 
stories that do not have acceptance criteria in your backlog.

Clicking any of these cards gives you a list of stories from that category.

• Reorder stories in the backlog across pages.

• Filter the stories by epic by using the Records by epic section.

In this section, only those epics are listed, which belong to the stories of the selected backlog.

◦ The epics for the stories from your backlog are listed in this section.

◦ Epic completion is indicated by a progress bar and percentage.

◦ You can show or hide this section by selecting the configuration icon ( ).

• Personalize columns by using the personalize icon ( ).

• Use the search option to filter stories using a keyword.

For more information on how to manage your backlog, see Manage your product backlog in Agile 
Development 2.0.
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Backlog tab on Agile Board

Sprint Planning

The Sprint Planning tab of the Agile board shows the team backlog and sprints as sections, 
which contain the list of stories. You can create, edit, and plan for sprints using the options 
available in this tab.

From the Sprint Planning tab, you can:

• Create, organize, monitor, start, and complete sprints.

• View current and future sprints in chronological order.

• View planned start and end dates, story points, percentage group velocity, and the number of 
story points (total, complete, and pending) for the current sprint.

• Assess stories in the backlog and drag them to sprints.

• Add stories to the backlog and set up their order of implementation.

• Move unfinished stories from the completed sprint to the backlog or to a future sprint.
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Sprint Planning tab on Agile Board

Sprint Tracking

From the Sprint Tracking tab, you can track the progress of your current sprint in a Story board, 
Task board, or list view.

Story board

• Track all the stories of the current sprint across lanes.

• Move a story from one lane to another, which updates the state of the story.

• Filter stories by search criteria.

For more information, see Track progress of stories for a sprint in Agile Development 
2.0.

Sprint Tracking in the Story board view
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Task board

The Task board enables you to track all the scrum tasks for stories of the current 
sprint across lanes. You can:

• Move scrum tasks from one lane to another, which updates the state of the 
stories.

• Filter scrum tasks by search criteria.

For more information on tracking your scrum tasks using the board view, see Track 
progress of scrum tasks for a sprint in Agile Development 2.0.

Sprint Tracking in the Task board view

List

The List view displays scrum tasks and tests for the stories of the current sprint. In 
the List view, you can:

• Add scrum task and tests without leaving the context of the record.

• View the state, short description, and assignee of the scrum task.

• View the short description and result of a test.

• Assess scrum tasks and tests that are still pending before the current sprint is 
closed.

For more information on tracking a sprint's progress using the List view, see Track 
sprint progress in Agile Development 2.0.
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Sprint Tracking in the List view

Related topics

Visual Task Boards

Reporting defects in Agile Development 2.0

Create defects for the issues that are reported for your product using Agile Development 2.0. You 
can then create stories for these defects so that your teams can start working on resolving them.

Defects can be used to report and track the resolution of issues that are noticed during the 
development of a new feature, or as a feedback for existing features. Product owners then review 
these defects and decides on creating stories for them, which are assigned to the relevant 
assignment groups.

User role to create defects

Users who are expected to create defects in Agile Development 2.0  must have one of the 
following roles:

• feature_user

• scrum_story_creator

• scrum_admin

However, if a user has just the feature_user role, they can only view the defects from the Defects 
module of the Agile Development  application. They can not view the stories associated with the 
defects in the Stories related list of the defect record.

For information on how to create Defects, see Report a defect in Agile Development 2.0.

Enhancement requests in Agile Development 2.0

Create enhancement requests for different areas of your product in Agile Development 2.0. You 
can then create stories for these requests so that your teams can start working on developing 
them.

Enhancement requests can be used to log feature enhancements for a product. These requests 
can arise from internal requirements or customer feedback. Product owners review these logged 
requests and decides on creating stories for them based on priority. These stories are then 
assigned to the relevant assignment groups for development.
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User role to create enhancement requests

Creating or editing enhancement requests requires one of the following roles:

• feature_user

• scrum_story_creator

• scrum_admin

• rm_enhancement_admin

However, a user without scrum roles can only access these requests from the Enhancement 
Requests  module of the Agile Development  application and not stories that are created for this 
request.

Note: 
The administrator must grant the feature_user role to all users who are expected to create 
an enhancement request in the Agile Development  application.

For information on how to create enhancement requests, see Create an enhancement request in 
Agile Development 2.0.

After an enhancement request is created, users with scrum_story_creator or scrum_admin role 
can:

• Review the enhancement request and create a story for it.

• Manage stories from the Stories  related list in the Enhancements form.

Agile Development — Unified Backlog

The ServiceNow®  Agile Development — Unified Backlog  application helps you maintain 
a centralized backlog for records of different task types, such as defects, problems, or 
enhancements. Prioritize different task types from one location, and automatically create stories 
for these records, saving time.

The work flow described here represents the common practice of creating and managing 
records using the Agile Development — Unified Backlog  with Agile Development 2.0.

Set up a triage board

Define filter criteria and create your triage boards. Triage boards help you view 
records of a specific task type,giving better visibility. For example, you can 
create one triage board for defects and another for incidents. The triage board is 
automatically updated with any new record that matches the defined filter criteria.

See Set up a triage board in Agile Development 2.0

Triage records

From the Backlog tab of the Agile board, you can:

• View the total numbers of records in the triage boards of all task types

• Open the triage board of a specific task type

• Edit the filter definition of an existing triage board
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You can triage the records and add them to your product or team backlog. Items 
added to the backlog from the triage board will also have stories created for them 
automatically. See Triage items and add them to a backlog in Agile Development 2.0.

Assign records

After a record is added to the backlog from a triage board, treat it as you would a 
regular story. You can assign it to the relevant product teams and schedule it for 
upcoming sprints. See Plan your sprint activities in Agile Development 2.0.

Work with the assigned records in a board view

Records from a triage board are represented by stories on the Agile board. You can 
track the status of these stories from the Story board view of the Sprint Tracking tab. 
See Track progress of stories for a sprint in Agile Development 2.0.

When you move these stories to different lanes on the story board to update their 
state, the state of the associated story is updated but the state of the original triaged 
record remains the same. To change the state of the original record, open the story 
and switch to the original record tab.

Configuring Agile Development 2.0
Activate Agile Development 2.0, migrate from Agile Development 1.0, and perform other related 
tasks to set up Agile Development 2.0.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1918



Using guided setup to implement Agile Development 2.0

Agile Development 2.0  guided setup provides a sequence of tasks that help you configure the 
application on your ServiceNow  instance.

To open Agile Development 2.0  guided setup, navigate to All  > Agile Development  > Agile 
Development Guided Setup.

For more information about using the guided setup interface, see Using guided setup .

Activate Agile Development 2.0

Activate the Agile Development 2.0  plugin (com.snc.sdlc.agile.2.0) if you have the admin role.

Before you begin
Role required: admin

About this task

• If you are upgrading from an earlier ServiceNow  release version of Agile Development  to Agile 
Development 2.0, read upgrade information before activating the plugin.

• The dashboards for Agile Development 2.0, if required, must be activated separately using 
the Performance Analytics – Content Pack – Project Portfolio Suite Dashboards plugin 
(com.snc.pps_dashboards). The Performance Analytics license is required to use the 
dashboards.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Migration from Agile Development 1.0  to Agile Development 2.0

Migrate from Agile Development 1.0  to Agile Development 2.0  for enhanced agile capabilities and 
features.

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

Apply the following migration steps on a non-production instance, verify if the migration is 
completed as intended, and then perform the migration steps on a production instance.
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• Manage customizations before upgrading to Agile Development 2.0.

• Delete customizations.

• Activate Agile Development 2.0.

• Complete the prerequisites for converting teams to Agile Development 2.0 groups

• Convert Agile Development 1.0 teams to Agile Development 2.0 groups

• Verify the conversion of Agile Development 1.0 teams to Agile Development 2.0 groups

Related topics

Migration Guide - Agile Development 1.0 to Agile Development 2.0

Manage customizations before upgrading to Agile Development 2.0

You can take complete advantage of enhanced agile functionality by managing your 
customizations before upgrading to Agile Development 2.0.

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

As of any regular upgrade, if core platform artifacts such as form layout, adding of fields, removal 
of preconfigured fields, list layout, business rules, or client scripts, are customized in your 
environment, then changes made to any of these artifacts as part of the Agile Development 2.0 
enhancements are not applied in your environment. You should delete all your customizations 
before upgrading to Agile Development 2.0, and selectively reapply customizations as needed 
after upgrade.

Following are the three possible scenarios:

No customizations

You do not have any customizations in your Agile Development  implementation and 
want to use the Agile Development 2.0  functionality. In such a case, install the Agile 
Development 2.0  plugin (com.snc.sdlc.agile.2.0).

Minor customizations

There are few minor customizations, but you want to use the Agile Development 2.0 
functionality. In such a case, delete all customizations.

Customizations require review

There are a few customizations in your Agile Development  implementation that are 
mapped to your business process. Though you want to use the Agile Development 
2.0  functionality, you may want to review your customizations and decide whether to 
delete all the customizations or retain a few customizations. For such a case:

• A utility is provided which automatically detects the customized platform artifacts, 
such as list layout, form layout, business rules, that were enhanced as part of 
the Agile Development 2.0  enhancements. For details of this utility and list of 
all platform artifacts enhanced in Agile Development 2.0, see Review a utility 
customization for Agile Development 2.0.

• After analyzing, if you do not want to retain any of the customizations, then delete 
the customizations. If you want to retain a few, delete the customizations and 
reapply them after the upgrade.

• If you have created your own artifacts, such as business rules and UI policies, 
verify whether the artifacts work as intended after the upgrade.
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Delete customizations before upgrading to Agile Development 2.0

Take complete advantage of enhanced functionality by deleting all your customizations before 
upgrading to Agile Development 2.0.

Before you begin
Role required: admin

About this task

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

Procedure

1. In the Navigation filter, enter sys_properties.list.
The entire list of properties in the System Properties [sys_properties] table appears.

2. Click New.

3. On the form, fill in the fields as follows:

Field Value

Name com.snc.sdlc.scrum.pp.delete_customer_updates

Description Delete customizations in the Agile 
Development  application from the Customer 
Update [sys_update_xml] table.

Type true|false

Value true

4. Click Submit.

All customizations would be deleted and the property also would be automatically deleted.

What to do next
If the Agile Development 2.0  plugin (com.snc.sdlc.agile.2.0) has been installed before deleting 
the customizations, refresh the plugin by reinstalling it.

Related topics

Add a system property

Convert Agile Development 1.0  teams to Agile Development 2.0  groups

Complete most of the migration steps by converting teams in Agile Development 1.0  to groups in 
Agile Development 2.0.

Before you begin
Complete the procedure given in Complete the prerequisites for converting teams to Agile 
Development 2.0 groups.

Role required: admin
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About this task

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

Procedure

1. Navigate to All  > Agile Development  > Groups.
An empty list is displayed because there are no assignment groups with the type Agile Team. If 
there are any groups with the type Agile Team, a list of groups are displayed.

2. Click the Convert Release Teams to Groups  related link.
The list of all release teams (scrum_pp_team) table that you had defined in the Agile 
Development  plugin is displayed. If you have been defining teams for each release, multiple 
records are displayed for the team (team with the same name), one for each release. In the 
following screenshot, four records are displayed for the team Facilities Software Team, one for 
each release.

3. Complete the prerequisites for converting teams to groups.

Since migration is performed on a non-production instance first, convert one team to a group, 
verify if the migration is done successfully for the team, and then perform the same procedure 
for rest of the teams.

In the preceding example, all the four records for the Facilities Software Team can be selected 
at once. Consider the Facilities Software Team team as a sample team.

4. Select all records of the sample team and click Convert to Group.
All the teams are converted to an assignment group. If an assignment group exists with the 
same name, a new group is not created, but other migration activities are carried out for the 
group, for example, updating the group reference to the sprint and story table. Perform the 
following steps manually:

◦ Update the group type to Agile Team.

◦ If release team members and group members are different, synchronize the members 
between group and team.

Complete the prerequisites for converting teams to Agile Development 2.0  groups

Perform prerequisite steps to later ensure that the conversion of teams to Agile Development 2.0 
groups is successful.

Before you begin
Role required: admin

About this task
Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

The team being selected should have at least one sprint that is current. The current sprint 
should have a few completed and a few WIP stories. This is to verify that the sprint burndown is 
updated correctly post conversion. If you do not have such a team, you may select any team for 
conversion.
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Procedure

1. Find out the sprints assigned to the team across all a release.

Note: 
Use this step to verify whether the assignment group is updated successfully across all 
the sprints.

a. In the search panel in navigator, type rm_sprint.list to view the list of all sprints.

b. Display the Team  and Assignment group  fields if not displayed.

c. Apply the team name filter. The Assignment group  field is empty.

d. Capture the screen or export the list of all sprints. In the sample example, sprint 5 is the 
current sprint for the team being converted.

2. Find out the stories that are associated with the sprints of the team being converted.

Note: 
Use this step to verify that the assignment group is updated successfully across all 
stories.

a. In search panel in navigator, type rm_story.list to view the list of all stories.

b. Filter out the stories belonging to the sprints noted in the preceding step.

c. Display Sprint.Team  and Assignment group  fields in the list layout. The Assignment group 
field is empty.

d. Capture the screen or export this list.

e. Filter the story table to fetch the list of all stories belonging to sprints of the team being 
converted. Apply the following filter:

sprint.release_teamSTARTSWITH<name of the team>

Verify the conversion of Agile Development 1.0  teams to Agile Development 2.0  groups

Perform verification steps to ensure that the conversion of a team to an assignment group is 
successful.

Before you begin
Role required: admin

About this task

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Verify that the team has been converted to an assignment group.

If group appears here, it implies that the group type is already set to Agile Team.

3. Verify that the assignment group is updated across all the sprints of the team.
It is the same sprint list that you have noted prior to conversion. This list must have the 
assignment group updated after conversion.
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4. Verify that the stories associated with the sprints of team have been updated with the 
assignment group.

Following is the list of stories that were noted prior to converting to group:

5. Review the sprint burndown for the sprint that was noted prior to conversion.

It must be same as it was prior to conversion.

a. Open the rm_srpint table (rm_sprint.list), or open the assignment group.

b. Click the current sprint.

c. Mark any WIP story as complete.

d. Review the sprint burndown that is to be updated with the completed story.

6. Once the story is complete, the release burndown must also be updated correctly.

For example, in the following screenshot, the burndown is updated correctly for the current 
release.

7. For Group Velocity:

a. Navigate to Agile Development  > Groups.

b. Review the velocity of the group. It must be same as it did prior to conversion.

c. Complete the current sprint. It must display the velocity of group for the completed sprint in 
addition to the sprints that were completed before conversion.

8. Once you verify the steps for one group, it is confirmed that the migration has completed 
successfully.
You can repeat this procedure for all other teams one by one. This is a synchronous process, 
hence, you should perform these steps on one team at a time.

Agile Development 2.0  enhancements over Agile Development 1.0

Agile Development 2.0  offers a few enhancements over Agile Development  1.0.

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

These enhancements can be divided into the following categories:

• Data model enhancements from Agile Development 1.0 to Agile Development 2.0

• Usability enhancements from Agile Development 1.0 to Agile Development 2.0

• Functionality enhancements from Agile Development 1.0 to Agile Development 2.0

Data model enhancements from Agile Development 1.0  to Agile Development 2.0

Agile Development 2.0  offers a few data model enhancements over Agile Development  1.0.

Use of the common platform construct — Assignment Group

To map an agile team (scrum team), Agile Development  1.0 uses a separate entity called the 
Release Team table ( scrum_pp_team). This entity is associated to a release entity as displayed 
in the following screen shot.
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Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

All other tasks on platform such as incidents, problems, changes, projects rely on the 
assignment group entity to make assignments to a group. Group managers can run reports on an 
assignment group to gain insight into the work assigned to their groups.

To standardize the use of a group across platform even for scrum work such as stories and tasks, 
the standard construct Assignment Group is used as opposed to the standalone entity Release 
Team. Agile Development 2.0  uses assignment groups to map agile teams. An assignment group 
of type Agile Team is used for defining an agile team.

Agile team (group) need not be created for each release

With Agile Development  1.0, teams are to be created for each release and the teams are to be 
associated to each release. For example, if a scrum team called Team — Alpha works on multiple 
quarterly releases. You cannot create the team for one time and associate the team to any 
release, or release over release. Each time a new release is created, you must create a team with 
the same name and associate team to the release.

With Agile Development 2.0, groups are created independent of releases, and you can work on 
stories from multiple releases without recreating the group for every release.

Sprints can be created without a release

With Agile Development  1.0, creating a release is mandatory for creating sprints. Sprints cannot 
be created for a team independently. Agile Development  1.0 mandates the creation of a release 
for story execution via sprints. If there is no release, sprint cannot be populated on a story 
record.In Agile Development 2.0, sprints are associated with Assignment Groups.

Team backlog can be maintained independent of release

Typically, a team can have an ongoing team backlog release after release, it can pull stories from 
its backlog, and execute them through sprints in the release.

With Agile Development  1.0, a team cannot be defined without defining a release. Hence, team 
backlog cannot be maintained independent of a release.

With Agile Development 2.0, an assignment group is not created within a release. It can be 
associated to the release, but not created within a release. Hence, an assignment group can 
maintain its own backlog.

Association between Release and Group
As there is no direct relation between a release and a group in Agile Development 
2.0  (groups are independent and do not have to create groups for each release), the 
m2m_release_group_list table has been introduced. This table stores the association of a 
group with a release. This association is not used for sprint generation, but is used to derive the 
capacity of a release.

Specify the number of sprints for which the group works in a release. From the capacity of the 
team, the capacity of the release is derived.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1925



m2m_release_group

Team Start Sprint End Sprint
Points (each 
sprint)

Total Group 
Capacity For 
Release

A A_Sprint 1 A_Sprint 3 30 90 (3*30)

B B_Sprint 1 B_Sprint 4 40 160 (4*40)

Total Release Capacity = 90+ 160 = 250 points

Functionality enhancements from Agile Development 1.0  to Agile Development 2.0

Agile Development 2.0  offers a few functionality enhancements over Agile Development  1.0.

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

Integration with Test Management 2.0

Agile Development 2.0  is integrated with Test Management 2.0. This integration allows you to 
define tests for your stories, and run the tests before a story is marked as complete.

Note: 
This integration is available from the London  release.

Integration with Agile Development — Unified Backlog

Agile Development — Unified Backlog  is integrated with Agile Development 2.0. This integration 
allows you to maintain a centralized backlog containing records of different task types, such 
as defects, problems, incident tasks, and stories. It facilitates in prioritizing and sequencing 
of different task type records in one location, saving you steps. It removes the overhead of 
converting records to stories.

Note: 
This integration is available from the London  release.

Usability enhancements from Agile Development 1.0  to Agile Development 2.0

Agile Development 2.0  offers a few usability enhancements over Agile Development  1.0.

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

Manage and groom your backlog

Flexible backlog definition

Agile Development 2.0  enables you to define backlogs. For example, you can create 
different backlogs by products or teams, or combine backlogs for one or more 
epics.

Backlog grooming
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Agile Development 2.0  provides an advanced view for your backlog, where you can 
drag stories to rank them. Also, you can view backlogs by epics and get analytics 
about the overall backlog situation. For example, analytics of stories without 
acceptance criteria.

Enhanced sprint planning experience

Sprint Tracking

Agile Development 2.0  leverages the visual task boards feature to track the progress of stories in 
a sprint. It also provides the ability to create scrum tasks from the tracking view.

Review a utility customization for Agile Development 2.0

Use the Agile_2.0_Upgrade_Diagnostics update set to analyze your customizations on the 
platform artifacts (such as form layout, list layout, business rules, and client scripts) that are 
modified as part of the Agile Development 2.0  enhancements. Delete the customizations prior to 
upgrade.

Before you begin

• Role required: admin

• Download the Agile_2.0_Upgrade_Diagnostics update set .

About this task

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

Procedure

1. Click the Retrieved Update Sets  module.

2. Click Import Update Set from XML.

3. Select and upload the update set.

4. Preview and commit the update set.

5. Navigate to Agile Development 2.0  > Upgrade Diagnostics  > View Diagnostics.
Displays all the artifacts from Agile Development 1.0 that have been modified on the instance 
and on Agile Development 2.0.

6. Click the file name of the artifact, or click the View Update  link to review the latest update on 
the file.

List of platform artifacts modified after upgrading to Agile Development 2.0

Post migration, you can review the list of artifacts that are modified in Agile Development 2.0.

Important: 
Agile Development 1.0  and its features such as Sprint burndown chart and release 
burndown chart are deprecated and no longer available. Agile Development 2.0  provides 
the latest experience for supporting your Agile work methodology.

• sys_ui_list_control_3f85b6907f00000135a05e41c7547354,

• sys_ui_list_control_3f8607b47f0000012aaff213c654be45,

• sys_ui_list_control_6daa4a777f000001007607d32a0b44f0,
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• sys_ui_list_control_7d3d1f917f000001798fc58141419300,

• sys_ui_list_control_aa8a1aae7f000001432d0e1142a85c2d,

• sys_ui_list_control_aa8a4bbe7f00000139552678204587f7,

• sys_ui_list_control_aa8ace2f7f000001514936314eb4c441,

• sys_ui_list_control_aa8b47f57f000001024db35639e9239d,

• sys_ui_list_control_aa8b87c57f0000014da26c6926295c45,

• sys_ui_list_control_aa8bb1fe7f000001566e2efad03b5d1d,

• sys_ui_list_control_f2e3f8447f0000010e16b6f2131e4c51,

• sys_ui_list_control_f2e421e97f0000015fecc4e84539ca3f,

• sys_ui_list_control_f31a7ea37f00000111797ad94bfc17a7,

• sys_ui_form_sections_6dd15dd77f00000146435a3f9ec1b5c2,

• sys_ui_form_sections_6dd2cbb17f0000016bc846fa867d9527,

• sys_ui_form_sections_6dd47d6f7f0000011b43299d37b79da0,

• sys_ui_section_09c7f68d0a0a2c39447a64370c6851bb,

• sys_ui_section_09c9c4eb0a0a2c390ca461bae347c0c8,

• sys_ui_section_6da8bbff7f00000119f52f9d2ba74f7e,

• sys_ui_section_6dc344847f0000017a3badab86eae0f4,

• sys_ui_section_6dc409c57f0000016dd1fbecc461c7b9,

• sys_ui_section_6dd15e0a7f00000104ddce3e4fec5457,

• sys_ui_section_6dd2cbc97f0000016b6662d744a1766c,

• sys_ui_section_6dd47d857f000001783b95cc64af46a4,

• sys_ui_section_8756880b7f00000147213f08234c9a57,

• sys_ui_section_87569f2d7f00000116c556f5821ae434,

• sys_ui_section_8757b94d7f0000011c1ae8aa30062c20,

• sys_ui_section_87580cdb7f00000145cff7762bcac315,

• sys_ui_section_a19b5086c1252a7b3632553861b5440c,

• sys_ui_section_a7ee48bfc1252a7b377ac0507a9a6dc8,

• sys_ui_section_aa8a5d967f0000010d9bd63883019d20,

• sys_ui_list_rm_epic_rm_epic_scrum,

• sys_ui_list_rm_epic_scrum_theme_scrum,

• sys_ui_list_rm_scrum_task_rm_story_scrum,

• sys_ui_list_rm_sprint_rm_release_scrum_scrum,

• sys_ui_list_rm_story_rm_epic_scrum,

• sys_ui_list_rm_story_rm_release_scrum_scrum,

• sys_ui_list_rm_story_rm_sprint_scrum,

• sys_ui_list_rm_story_scrum_theme_scrum,

• sys_ui_list_scrum_group_permissions_scrum_theme_scrum,

• sys_ui_list_scrum_user_permissions_scrum_theme_scrum,

• sys_ui_list_rm_release_scrum_scrum,
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• sys_ui_list_rm_sprint_scrum,

• sys_ui_list_rm_epic_scrum,

• sys_ui_list_rm_story_scrum,

• sys_ui_list_rm_release_scrum_null,

• sys_ui_list_rm_sprint_null,

• sys_ui_list_rm_epic_null,

• sys_ui_list_rm_story_null,

• sys_ui_related_rm_defect_scrum,

• sys_ui_related_rm_doc_scrum,

• sys_ui_related_rm_epic_scrum,

• sys_ui_related_rm_release_scrum_scrum,

• sys_ui_related_rm_release_scrum,

• sys_ui_related_rm_sprint_scrum,

• sys_ui_related_rm_story_scrum,

• sys_ui_related_rm_test_scrum,

• sys_ui_related_rm_defect_null,

• sys_ui_related_rm_doc_null,

• sys_ui_related_rm_epic_null,

• sys_ui_related_rm_release_scrum_null,

• sys_ui_related_rm_release_null,

• sys_ui_related_rm_sprint_null,

• sys_ui_related_rm_story_null,

• sys_ui_related_rm_test_null,

• sys_ui_list_control_3f85b6907f00000135a05e41c7547354,

• sys_ui_section_87569f2d7f00000116c556f5821ae434,

• sys_ui_section_8757b94d7f0000011c1ae8aa30062c20,

• sys_ui_section_87580cdb7f00000145cff7762bcac315,

• sys_ui_section_a7ee48bfc1252a7b377ac0507a9a6dc8,

• sys_ui_section_aa8a5d967f0000010d9bd63883019d20,

• sys_ui_list_rm_story_null,

• sys_ui_list_rm_sprint_scrum,

• sys_ui_list_rm_story_scrum,

• sys_ui_related_rm_release_scrum_scrum,

• sys_ui_related_rm_sprint_scrum,

• sys_ui_section_0ffe390037412000dadaa3549dbe5d0d,

• sys_ui_list_rm_story_project,

• sys_ui_list_rm_story_sprint_planning,

• sys_ui_list_rm_epic_sys_ref_list,

• sys_ui_list_rm_story_release_backlog,
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• sys_ui_list_control_0b28c540ef301000a7450fa3f82256a4,

• sys_app_module_0e28cb14ef941000a7450fa3f8225643,

• sys_app_module_0b57e8009f503100598a5bb0657fcfae,

• sys_app_module_b5b5b092871031003706db5eb2e3ec5b,

• sys_app_module_d5d3212593320200ea933007f67ffb36,

• sys_app_module_f0ca98ca874321003706db5eb2e3ecdd,

• sys_app_module_f1e8dc8a874321003706db5eb2e3ecfa,

• sys_app_module_2117c480ef012000a7450fa3f82256fc,

• sys_app_module_30154714ef941000a7450fa3f82256ef,

• sys_app_module_437d1419ef41200099620fa3f822560c,

• sys_app_module_6d691477efb42000a7450fa3f8225612,

• sys_app_module_5697aaa0efd41000a7450fa3f8225682,

• sys_app_module_876add92ef931000a7450fa3f82256c9,

• sys_app_module_97fd7218ef541000a7450fa3f8225648,

• sys_app_module_ae802859ef41200099620fa3f8225656,

• sys_app_module_b47c5091ef41200099620fa3f8225688,

• sys_app_module_0a68918e37031000dadaa3549dbe5dd4,

• sys_app_module_237c98d5ef41200099620fa3f82256e5,

• sys_app_module_297d5419ef41200099620fa3f82256e9,

• sys_app_module_2b80e819ef41200099620fa3f82256a6,

• sys_app_module_487f9459ef41200099620fa3f82256db,

• sys_app_module_4c836231ef002000a7450fa3f8225612,

• sys_app_module_5600c718ef541000a7450fa3f8225636,

• sys_app_module_717d1419ef41200099620fa3f82256ed,

• sys_app_module_7580e499ef41200099620fa3f8225675,

• sys_app_module_b17e9819ef41200099620fa3f8225692,

• sys_app_module_db7f1099ef41200099620fa3f822564e,

• sys_app_module_eb7dd019ef41200099620fa3f8225611,

• sys_ui_policy_6c5665c293030200ea933007f67ffb18,

• sys_ui_policy_823c84a6ef271000a7450fa3f8225653,

• sys_ui_policy_128dc58293030200ea933007f67ffbb3,

• sys_ui_policy_49dc0ca093030200ea933007f67ffb0c,

• sys_ui_policy_830b62d6877121003706db5eb2e3ec6d,

• sys_ui_policy_cb2b8826ef271000a7450fa3f82256b3,

• sys_ui_policy_d8476e96877121003706db5eb2e3eca3,

• sys_ui_policy_267d5c2aef271000a7450fa3f8225636,

• sys_ui_policy_63a823ecefb31000a7450fa3f8225627,

• sys_ui_action_22ada00a93330200ea933007f67ffbd5,

• sys_ui_action_e89e773593330200ea933007f67ffbb7,
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• sys_ui_action_f6ea06e2870321003706db5eb2e3ec7d,

• sys_ui_action_view_f9e0ee3393330200ea933007f67ffb38,

• sys_ui_action_96bd90b28f1321001a83cfd827bdee4a,

• sys_ui_action_c4ac45a147332100846e7eaecb9a7150,

• sys_ui_action_c5c37126ef202000a7450fa3f8225650,

• sys_ui_action_dd4398b937301000dadaa3549dbe5db8,

• sys_ui_action_eaaae247873321003706db5eb2e3ec61,

• sys_ui_action_706b5e96ef301000a7450fa3f82256a2,

• sys_ui_action_7c972317ff231000dadaefff0efe1e62,

• sys_ui_action_8aba60e6ef96200099620fa3f8225645,

• sys_ui_action_93d4b3423701200054b6a3549dbe5d25,

• sys_ui_action_d07eddaa37202000dadaa3549dbe5d46,

• sys_ui_action_d67cdea1c32030003d2ae219cdba8f60,

• sys_ui_action_db07e836c320310028d7d56bc3d3ae2c,

• sys_ui_action_e2018d4237502000dadaa3549dbe5d32,

• sys_ui_action_ee01494237502000dadaa3549dbe5dec,

• sysrule_view_203b7ce58f3221001a83cfd827bdee67,

• sysrule_view_43bdcd758f3221001a83cfd827bdee78,

• sysrule_view_522cfce58f3221001a83cfd827bdeeb6,

• sysrule_view_6b8dcd758f3221001a83cfd827bdee3b,

• sysrule_view_9c4c79709f203100598a5bb0657fcf7d,

• sys_script_client_3d260d71873221003706db5eb2e3ec47,

• sys_script_client_f086b853873121003706db5eb2e3ec11,

• sys_script_client_cdf24c2493030200ea933007f67ffb90,

• sys_script_client_e1ea25e193002200ea933007f67ffbff,

• sys_script_2cc257b0373321001a8326877e41f1d0,

• sys_script_235ccb809f203100598a5bb0657fcfea,

• sys_script_3a06ffd59f322100598a5bb0657fcf40,

• sys_script_6940d94fef902000a7450fa3f8225689,

• sys_script_b0490d9047103100846e7eaecb9a7165,

• sys_script_c5dcb4f09f203100598a5bb0657fcffb,

• sys_script_21d6b274ef202000a7450fa3f822565d,

• sys_script_8cd24091ef52200099620fa3f8225619,

• sys_script_9f298c85efa1200099620fa3f82256ba

Activate Agile Development — Unified Backlog

You can activate the Agile Development — Unified Backlog plugin (com.snc.sdlc.agile.multi_task) 
if you have the admin role.
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Before you begin
Activate Agile Development 2.0.

Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Related topics

Agile Development — Unified Backlog

Quick start tests for Agile Development 2.0

Validate that Agile Development 2.0  still works after you make any configuration change such as 
apply an upgrade or develop an application. Copy and customize these quick start tests to pass 
when using your instance-specific data.

Danger: 
By default, the system property that is used to run automated tests is disabled to prevent 
you from accidentally running these tests on a production system. To avoid data corruption 
or an outage, run tests only on development, test, and other non-production instances. See 
Enable or disable executing Automated Test Framework tests .

Agile Development 2.0  quick start tests require activating the Agile Development 
2.0  plugin (com.snc.sdlc.agile.2.0) and the Agile Development 2.0 - ATF Tests plugin 
(com.snc.sdlc.agile.2.0.atf ).

Agile Development 2.0  quick start test suite

Test Description Release version

Verify that global rank is 
populated when a story is 
created

Verify the global rank of a 
story after creation.

Madrid

Verify that closing a sprint with 
active stories is prevented

Verify that a sprint with active 
stories cannot be closed.

Madrid

Verify that sprints cannot 
overlap in the same group

Verify that sprints in the same 
group do not overlap.

Madrid
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Agile Development 2.0  quick start test suite  (continued)

Test Description Release version

Verify that sprint points are 
updated

Verify that changes to stories 
produce accurate sprint point 
totals.

Madrid

Verify that only one sprint in 
a group can have the current 
state

Verify sprint statuses. Madrid

Verify sprint end date is after 
the sprint start date

Verify sprint start and end 
dates.

Madrid

Verify that any update on story 
rolls up to Epic

Verify that adding, estimating, 
removing, deleting, updating, 
or cancelling a story updates 
the epic-level roll-ups 
correctly.

Orlando

Verify changes to the scope 
of a current sprint do not 
alter the value of the Total 
Committed Points

Verify that the value of Total 
Committed Points does not 
change with change in the 
scope of a sprint after its state 
is changed to Current.

Orlando

Verify active flag is set false 
when Agile Story state is 
changed to Completed/
Cancelled

Verify that active flag of 
an Agile story is set to the 
following:

• False, if the state is changed 
to Completed or Cancelled

• True, for all other states

Orlando

Verify that updating the team/
group capacity overrides 
the capacity on all the future 
sprints

Verify that any update to the 
Group capacity  field of the 
assignment group results in 
the following changes to the 
Group capacity  field of the 
various sprints associated 
with this assignment group:

• For the sprints that are in 
the Draft and Planning state:

◦ The group capacity is 
updated to the new value.

◦ The Group capacity  field 
is editable.

• For the sprints in the 
Current, Complete, or 
Cancelled state:

◦ The group capacity 
remains the old value.

◦ The Group capacity  field 
is read-only.

Paris
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Agile Development 2.0  quick start test suite  (continued)

Test Description Release version

For the sprints in the Draft 
or Planning state, you can 
individually edit the group 
capacity of the sprint anytime 
later. This would not change 
the group capacity of the 
assignment group associated 
with this sprint.

Verify create and edit 
functionality of an epic 
backlog on the scrum program 
board

• Verify that you can create 
an epic backlog for scrum 
programs from the Backlog 
tab of Agile Board.

• Verify that you can update 
an existing epic backlog for 
scrum programs from the 
Backlog tab of Agile Board.

• The epics listed in the 
backlog must belong to the 
selected epic backlog.

Quebec

Verify a Demand is converted 
to a scrum story

If the PPM Standard plugin 
(com.snc.financial_planning_pmo) 
is active, verify that a Demand 
can be converted to an Agile 
2.0 story using the Create 
Story  related link on the 
Demand form.

For more information on how 
to create an Agile 2.0 story 
from a demand, see Create an 
artifact from a demand.

Quebec

Verify a Demand is converted 
to a scrum epic

If the PPM Standard plugin 
(com.snc.financial_planning_pmo) 
is active, verify that a Demand 
can be converted to an Agile 
2.0 epic using the Create Epic 
related link on the Demand 
form.

For more information on how 
to create an Agile 2.0 epic 
from a demand, see Create an 
artifact from a demand.

Quebec

Related topics

Quick start tests
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Using Agile Development 2.0
Learn how to use the features of Agile Development 2.0  to efficiently manage your product 
development life cycle.

Create a release in Agile Development 2.0

Create a release to start associating the stories and scrum tasks of your product development to 
the release in Agile Development 2.0.

Before you begin
Role required: scrum_release_planner, scrum_admin

About this task
Use the Releases module to create a release record to start planning for your upcoming release.

A release has a start and end date during which several development iterations are completed. 
Releases are created by a product owner and contain user stories, sometimes from multiple 
products, and can also involve multiple teams. The stories associated to a release form its 
release backlog.

Procedure

1. Navigate to All  > Agile Development  > Releases.

2. Select New  in the record list.
Alternatively, if you already created Product records in Agile Development 2.0, you can use the 
Releases related list to open the new release form.

3. On the form, fill in the fields.

New release form

Field Description

Number System-generated unique number for the release.

State Current state of the release. The default is Draft.

Total 
committed 
points

Sum of all story points from the stories associated with this release.

Release 
capacity

Sum of group capacity of all the assignment groups associated with the release.

Group capacity of an assignment group for a release is calculated as: Group 
capacity * Number of sprints in the release for that 
group

Release capacity is updated only when the Start sprint  and End sprint  fields 
are populated for the groups in the Groups  related list in the release record.

Planned 
start date

Estimated start date of the release.

Planned 
end date

Estimated end date for the release.

Assigned 
to

User assigned to the release.
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Field Description

Release must be assigned to a scrum user, such as a release planner or 
product owner, whose role allows rights to create and edit releases.

Short 
Description

Brief description of the release.

Description Detailed description of the release.

Work notes Updates about the work being performed on the release. This field is updated 
by the Assigned to  user as the work progresses on the release.

4. Select Submit.

What to do next
Start planning your release by associating products, stories, and the assignment groups to this 
release record. Use the related lists available in the release record for these actions.

For information on the related lists of a release, see Related lists for a Release in Agile 
Development 2.0

Create a theme in Agile Development 2.0

Create a theme in Agile Development 2.0  to group stories of different products together for an 
abstract goal.

Before you begin
Role required: scrum_product_owner, scrum_release_planner, scrum_admin

Procedure

1. Navigate to All  > Agile Development  > Themes.

2. Select New.
Alternatively, you can open the new theme form by using:

◦ Backlog Planning or Sprint Planning tabs of the Agile board

◦ Themes related lists of a Product record

3. On the form, fill in the fields.

New theme form

Field Description

Number System-generated unique number for the theme.

Name Name for the theme that states the high-level business case.

Product Product with which this theme is associated.

You can associate a theme with just one product at a time.

Short Description Brief description of the theme.

Description Detailed description about the theme.

4. Select Submit.
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What to do next
Add epics and stories to the theme using the related lists available in the Theme record. For 
more information, see Related lists for a Theme in Agile Development 2.0

Create a product in Agile Development 2.0

Create a product to represent a feature or functionality important to customers. A product can 
contain themes, epics, and stories that describe these enhancements from the perspective of a 
user.

Before you begin
Role required: scrum_product_owner, scrum_release_planner, scrum_admin

Procedure

1. Navigate to All  > Agile Development  > Products.

2. Select New.

Alternatively, you can use the Products related list of a Release record to open the form for a 
new product.

3. On the form, fill in the fields.

Product form

Field Description

Name Name of the product.

Short 
Description

Description of the product that briefly explains its features and mentions the 
theme and groups associated to it.

Product 
owner

User responsible for managing the development and releases for the product.

4. Select Submit.

What to do next
Use the related lists of the Product record to associate releases, themes, epics, stories, 
and assignment groups with it. For more information, see Related lists for a Product in Agile 
Development 2.0.

Assignment groups in Agile Development 2.0

Learn the requirements to create and manage your assignment groups in Agile Development 2.0.

Creating assignment groups

https://player.vimeo.com/video/1070078725?
h=f04196c519&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

A user with the admin role can create assignment groups of the type Agile Team. Your scrum 
teams are represented by these agile groups, which you can use to assign to work items such as 
stories and epics. For more information, see Create an assignment group in Agile Development 
2.0.
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Adding members to assignment groups

• New customers: After an agile group is created, you can request your admin to add  members 
to the group.

• Existing customers: If you upgraded to the Zurich  release, a user with the scrum_admin role or 
the scrum_master role can add members to your agile group.

Note: 
You can restrict this function just to the admin by creating the 
scrum.disallow_scrum_add_group_member  property and setting it to true. For 
information on how to create a property, see Add a system property .

For information on the procedure to add members to groups, see Add members to an 
assignment group in Agile Development 2.0

Capacity of an assignment group

For each group member, a default number of story points can be defined. At the group level, the 
sum of these story points determines the group capacity.

Create an assignment group in Agile Development 2.0

Create an assignment group of the type Agile Team so that you can assign these groups to a 
product or a release.

Before you begin
Role required: admin

About this task

https://player.vimeo.com/video/1070078725?
h=f04196c519&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Procedure

1. Navigate to All  > Agile Development  > Create Agile Group.

2. On the form, fill in the fields.

Agile Group form

Field Description

Name Name of your assignment group.

Description Brief description of the assignment group. 
You can indicate the products or the releases 
that this groups works on.

3. Select Submit.
Assignment group is created and the form reopens with additional fields, related links, and 
related lists.

4. Optional:  Fill in additional fields.
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Group form

Field Description

Manager Manager of the group

Group capacity (points) Number of points a group can accommodate 
in each sprint.

Group email Email address of the group.

Result
The Agile assignment groups are created and stored in the Groups [sys_user_group] table and 
the Type  of these groups is set to Agile Team.

What to do next

• Add members to an assignment group in Agile Development 2.0.

• Use the related links and lists to create sprints and plan the sprint activities for your group. For 
more information, see Related links and lists of assignment group in Agile Development 2.0.

Convert a release team to a group (only for existing customers having release teams)

Convert an existing release team to an assignment group of type Agile Team so that you can 
assign them to a product or a release.

Before you begin
Role required: admin

About this task
Agile Development 2.0  does not use Release Teams. Existing users who have created release 
teams must convert the existing teams to assignment groups.

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Click the Convert Release Teams to Groups  related link.

3. Select the team that you want to convert to an assignment group.

4. Click Convert to Group.

Result

• The release team is available as assignment group from Agile Development  > Groups.

• The members of the release team are copied to the assignment group.

Add members to an assignment group in Agile Development 2.0

Add members who would work on the scrum stories and tasks.

Before you begin
Role required: admin
Any user that you want to add to the assignment group must have the scrum_user role.

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Open the group to which you want to add members.
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3. From the Group Members related list, select Edit.

4. Add the required scrum user.

Result
The selected scrum user is listed in the Group Members related list.

Create an epic in Agile Development 2.0

Define the high-level requirements of the features that you want to develop by creating epics in 
Agile Development 2.0.

Before you begin
Role required: scrum_story_creator, scrum_admin

About this task
Create epics in Agile Development 2.0  and organize them in a hierarchy of parent and children. 
You can associate an epic to a product, theme, or configuration item (an item or service that is 
affected).

Procedure

1. Navigate to Agile Development  > Epics.

2. Select New.

Alternatively, you can open the new epic form using the Agile board, from a theme record, or 
from a product record.

You can also convert an existing active story into an epic. For details, see Related links and 
lists for a Story in Agile Development 2.0.

3. On the form, fill in the fields.

Epic form

Field Description

Number System-generated number for the epic.

Product Product associated with this epic.

You can associate an epic with only one product at a time.

Priority Priority of the epic.

State State of the epic. Select one of the following:

Draft

The epic requirements, such as the detailed description, are still 
being drafted.

Ready

The epic is ready for pickup by the product team. The product 
manager and the scrum team can break the epic down into 
stories.

Work in Progress

The development team is working on the stories for epic and 
recording the changes in the work notes field.
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Field Description

Complete

The development and testing efforts on all the stories and any 
child epics for the epic are complete.

Cancelled

The epic has been canceled.

This field is automatically set to Draft.

Short 
Description

Brief description of the epic.

Description Detailed description of the epic.

Work notes Notes about the work done on the epic.

Total story 
count

Number of stories in the epic.

Completed 
count

Number of completed stories in the epic.

Percent 
complete by 
count

Percentage of completed work in the epic. Story count is used to calculate 
this value.

Total estimate Sum of the estimates of all stories in the epic.

Completed 
estimate

Sum of the estimates of all the completed stories in the epic.

Percent 
complete by 
epic

Percentage of completed work in the epic. Story estimate is used to calculate 
this value.

Missing 
estimate

Number of stories in the epic that are missing estimates.

Top program Program mapped to the scrum work enabling top-down hybrid planning.

This field is visible in the Scrum view of the epic form if you activate the PPM 
Standard plugin (com.snc.financial_planning_pmo).

Fill in the Planning section if you want to create benefit plans for the epic. This section is 
available in the Benefit view of the epic form.

4. Click Submit.

What to do next

• Add child epics or stories to the epic:

◦ Create a child epic for this epic by selecting New  from the Child Epics related list.

◦ Add stories to this epic by selecting New  from the Stories related list. For more information, 
see Create a story in Agile Development 2.0.

An epic can have one or more stories, but a story can belong to only one epic at a time.
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• You can also associate epics to a project in Project Portfolio Management  from the Epics 
related list.

This related list appears only when the value for the Execution Type  field is selected as Agile 
and the Agile Development 2.0  plugin is installed.

Create a monetary benefit plan for an epic

Epic benefit plans capture the potential benefits accrued by the epic when the epic is executed. 
Create a monetary benefit plan to specify the estimated benefit in a category spanning one or 
more fiscal periods.

Before you begin
Role required: scrum_master, scrum_product_owner, or scrum_admin

About this task
The monetary benefit plan breakdown records are automatically created when you save the 
benefit plan.

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Select View  > Benefit  from the Additional actions menu ( ).

4. On the form, fill in the required fields in the Planning section.
This section is available when the Benefit view is selected.

Planning section of the Epic form

Field Description

Planned 
start date

Projected start date for the epic. The planned start date can be the current date 
or a future date.

Planned 
end date

Projected end date for the epic. The planned end date must be after the 
planned start date.

Planned 
benefit

Benefit value that is rolled up from the benefit breakdown.

Actual start 
date

Actual start date for the epic. The actual start date can be on or before the 
planned start date.

Actual end 
date

Actual end date for the epic. The actual end date can be before the planned 
start date but not before the actual start date.

Actual 
benefit

Actual benefit value that is rolled up from the actual benefit in the benefit 
breakdown.

5. Save the record.

6. In the Monetary Benefit Plans related list, click New.

7. On the form, fill in the fields.
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Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Epic to which the benefit plan belongs.

Sponsor Sponsor for the epic.

Category Type of benefit:

◦ Hard: Benefits that can be measured in terms of revenue.

◦ Soft: Benefits that are measured in terms of value.

Sub 
category

Sub-categories of hard and soft benefits.

The selection in Category  field determines the selections available in this field.

Benefit 
type

Type of benefit. Select Monetary benefits.

Offset type Field to indicate when the benefits start realizing. Select any of the following 
options:

◦ None: The default value is None. When you select None, you need to 
manually enter the benefit plan start and end fiscal periods.

◦ Milestone: After completion of a milestone.

◦ Start Date: At the start of the epic.

◦ End Date: After the epic ends.

If the value in the selected offset type changes, the benefit plan start date shifts 
accordingly. For example, if the offset type is set to End Date  and the end date 
of the epic changes, the benefit plan start date shifts to align with the new end 
date of the epic.

Milestone Epic milestones to which the benefit plan belongs. The field appears if you 
select Milestone  in the Offset type  field.

Milestone 
start date

Start date of the selected milestone. The field appears if you select Milestone  in 
the Offset type  field.

Work start 
date

Start date of the epic. The field appears if you select Start Date  in the Offset 
type  field.

Work end 
date

End date of the epic. The field appears if you select End Date  in the Offset type 
field.

Offset Number of periods before or after the offset type when the benefit plan starts. 
For example, if the offset type is selected as End Date  and the offset is -2, the 
benefit plan is two periods prior to the epic end date. If the epic end date shifts, 
the benefit plan start date shifts to two periods prior to the new epic due date.

Duration in 
periods

The length, in periods, of the benefit plan.

Start fiscal 
period

Starting fiscal period. Populated based on the value in the Offset field relative 
to the selected Milestone, Work start date, or Work end date, and Duration in 
period  values.

The field is editable if you select None  in the Offset type  field.
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Field Description

When you change the start fiscal period, the associated benefit breakdown 
values also change.

End fiscal 
period

Ending fiscal period. Populated based on the value in the Offset field relative 
to the selected Milestone, Work start date, or Work end date, and Duration in 
period  values.

The field is editable if you select None  in the Offset type  field.

When you change the end fiscal period, the associated benefit breakdown 
values also change.

Associated 
benefit

Non-monetary benefit that is associated to this monetary benefit plan.

Benefit Plan form - Financials details

Field Description

Entered benefit Benefit incurred from the epic specified in 
terms of entered currency.

Entered currency Currency in which you want the benefit plan 
to be created.

Functional currency Currency that is obtained from the 
glide.system.locale  property .

Total planned benefit Estimated amount of potential benefit of the 
epic.

Benefit in functional currency Benefit incurred from epic in terms of 
functional currency. The value in this field 
changes if the Entered currency  is different 
from the functional currency.

Actual benefit Actual benefit that is incurred from the epic. 
This value is rolled up from the Actual benefit 
field of all the benefit plan breakdowns.

Recurring Option to indicate that the benefit is recurring 
for all the fiscal periods in the benefit plan.

8. Click Submit.

What to do next
On the Benefit Plan form, view the benefit breakdown by fiscal period in the Monetary Benefit 
Plan Breakdowns related list.

Update a monetary benefit plan breakdown for an epic

Update a monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.

Before you begin
Role required: scrum_master, scrum_product_owner, or scrum_admin
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Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Select View  > Benefit  from the Additional actions menu ( ).

4. Click the Monetary Benefit Plans related list.

5. Open the required monetary benefit plan.

6. In the Monetary Benefit Plan Breakdowns related list, click the information icon ( ) for a 
monetary benefit plan breakdown.

7. Click Open Record.

8. On the Monetary Benefit Plan Breakdown form, view and update the enabled fields.

9. Click Update.

Create a non-monetary benefit plan for an epic

Epic benefit plans capture the potential non-financial benefits accrued by the epic when the epic 
is executed. Create a non-monetary benefit plan to specify the estimated benefit in a category 
spanning one or more fiscal periods.

Before you begin
Role required: scrum_master, scrum_product_owner, or scrum_admin

About this task
The non-monetary benefit plan breakdown records are automatically created when you save the 
benefit plan by selecting Automatic  or Manual  in the Breakdown Type  field. The non-monetary 
benefit plan breakdown records specify the estimated and actual non-financial benefits at a 
granular level for specific fiscal periods, such as FY16: April and FY16: May. The Non-monetary 
Benefit Plan Breakdowns related list shows the aggregated benefits for estimated and actual 
non-financial benefits for each fiscal period for the epic.

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Select View  > Benefit  from the Additional actions menu ( ).

4. On the form, fill in the required fields in the Planning section.
This section is available when the Benefit view is selected.

Planning section of the Epic form

Field Description

Planned 
start date

Projected start date for the epic. The planned start date can be the current date 
or a future date.

Planned 
end date

Projected end date for the epic. The planned end date must be after the 
planned start date.

Planned 
benefit

Benefit value that is rolled up from the benefit breakdown.
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Field Description

Actual start 
date

Actual start date for the epic. The actual start date can be on or before the 
planned start date.

Actual end 
date

Actual end date for the epic. The actual end date can be before the planned 
start date but not before the actual start date.

Actual 
benefit

Actual benefit value that is rolled up from the actual benefit in the benefit 
breakdown.

5. Save the record.

6. Click the Non-monetary Benefit Plans related list.

7. To create a non-monetary benefit plan, click New.

8. On the form, fill in the fields.

Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Epic to which the benefit plan belongs.

Sponsor Sponsor for the epic.

Category Type of benefit:

◦ Hard: Benefits that can be measured in terms of revenue.

◦ Soft: Benefits that are measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The value of the Category  field determines the choices available in this field.

Benefit 
type

Type of benefit. Select Non-monetary benefits.

Offset type Field to indicate when the benefits start to be realized. Select any of the 
following options:

◦ None: The default value is None. When you select None, you must manually 
enter the benefit plan start and end fiscal periods.

◦ Milestone: After completion of a milestone.

◦ Start Date: At the start of the epic.

◦ End Date: After the epic ends.

If the value in the Offset type  field changes, the benefit plan start date shifts 
accordingly. For example, if the Offset type  field is set to End Date  and the end 
date of the epic changes, the start date of the benefit plan shifts to align with the 
new end date of the epic.

Milestone Epic milestones to which the benefit plan belongs. This field appears only when 
Milestone  is selected from the Offset type  field.

Milestone 
start date

Start date of the selected milestone. This field appears only when Milestone  is 
selected from the Offset type  field.
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Field Description

Work start 
date

Start date of the epic. This field appears only when Start Date  is selected from 
the Offset type  field.

Work end 
date

End date of the epic. This field appears only when End Date  is selected from the 
Offset type  field.

Offset Number of periods before or after the offset type when the benefit plan starts. 
For example, if the offset type is selected as End Date  and the offset is -2, 
the benefit plan is two periods prior to the epic end date. If the epic end date 
changes, the benefit plan start date shifts to two periods prior to the new epic 
due date.

Duration in 
periods

The length, in periods, of the benefit plan.

Start fiscal 
period

Starting fiscal period. This field is populated based on the value in the Offset 
field relative to the selected Milestone, Work start date, or Work end date, and 
Duration in periods  field values.

This field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown 
values also change.

End fiscal 
period

Ending fiscal period. This field is populated based on the value in the Offset 
field relative to the selected Milestone, Project or Demand start date, or Project 
or Demand end date, and Duration in period values.

This field is editable if you select None  in the Offset type  field.

When you change the end fiscal period, the associated benefit breakdown 
values also change.

Associated 
benefit

Monetary benefit that is associated to this non-monetary benefit plan.

Non-monetary Details section of the Benefit form

Field Description

Measure Type of measure for the non-monetary 
benefit plan. The measure types are Count, 
Percentage, Hours, Days, and Score.

Select the option Yes/No  to track the benefits 
that are not quantifiable. When this option is 
selected, the only field available is Benefits 
achieved. You can select the check box 
to indicate that the benefits have been 
achieved.

Non-monetary entered benefit
Estimated value of the potential benefit.

Any change in the planned benefit in the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods 
only.
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Field Description

Non-monetary planned benefit Benefit value that is rolled up from the benefit 
breakdown.

Benefits achieved Option to indicate if the benefit is achieved.

Breakdown type Type of breakdown creation when you save 
the benefit plan.

◦ None: No breakdowns are created.

◦ Automatic: A Non-monetary Benefit 
Plan Breakdowns record is created 
automatically with data. The breakdown is 
calculated linearly.

◦ Manual: A Non-monetary Benefit Plan 
Breakdown record is created automatically 
but without data in the Entered benefit 
column.

Aggregation mode Determines how the roll-up happens from 
breakdowns to the benefit plan and updates 
the values in the Non-monetary planned 
benefit  and Non-monetary actual benefit 
fields.

◦ Sum: Aggregates data from all breakdowns.

◦ Average: Average value from all 
breakdowns.

◦ Most recent: Recent breakdown value.

◦ Max: Maximum value among the 
breakdowns.

◦ Min: Minimum value among the 
breakdowns.

Non-monetary actual benefit Actual benefit value that is rolled up from the 
actual benefit in the non-monetary benefit 
plan breakdown.

9. Click Submit.

What to do next

• On the Benefit Plan form, view the benefit breakdown by fiscal period in the Non-monetary 
Benefit Plan Breakdowns related list.

• Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the epic for the hybrid benefit plans.

Update a non-monetary benefit plan breakdown for an epic

Update a non-monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.

Before you begin
Role required: scrum_master, scrum_product_owner, or scrum_admin
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Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Select View  > Benefit  from the Additional actions menu ( ).

4. Click the Non-monetary Benefit Plans related list.

5. Open the required non-monetary benefit plan.

6. In the Non-monetary Benefit Plan Breakdowns related list, click the information icon ( ) for a 
non-monetary benefit plan breakdown.

7. Click Open Record.

8. On the Non-monetary Benefit Plan Breakdown form, view and update the enabled fields.

9. Click Update.

Associate monetary and non-monetary benefit plans

Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the epic for the hybrid benefit plans.

Before you begin
Role required: scrum_master, scrum_product_owner, or scrum_admin

About this task
You can associate a monetary benefit plan with a non-monetary benefit plan and vice versa.

Note: 
When you delete a benefit plan, any relationship with the associated benefit plan is also 
removed.

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Select View  > Benefit  from the Additional actions menu ( ).

4. Select the Monetary Benefit Plans or Non-monetary Benefit Plans related list.

5. Select the information icon ( ) for a benefit plan that you want to associate.

6. Select Open Record.

7. On the Benefit Plan form, select Associate new benefit.

8. On the form, fill in the fields.
For description of fields, see Create a monetary benefit plan for an epic  and Create a non-
monetary benefit plan for an epic.

9. Select Save.

Result
The selected benefit plan is associated with another plan.

What to do next
Select the View Associated benefit plan  related link to view the associated benefit plan.
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Generate labor costs for epics

View the labor cost expenses based on the resource assignments for your epics.

Before you begin

• The epic should have the resource assignments.

• Role required: sn_spm_financial_user

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Select the required epic.

3. Select the Generate labor costs  related link.
Refresh the page to view generated labor costs in the Cost Plan related list.

Create a story in Agile Development 2.0

Create high-level definitions of your requirements in the form of stories in Agile Development 
2.0. Manage and track your stories by associating them to a product, project, or release and by 
assigning them to an assignment group.

Before you begin
Role required: scrum_story_creator, scrum_admin

Procedure

1. Navigate to All  > Agile Development  > Stories.

2. Select New.
Alternatively, you can create a Story from one of the following:

◦ Backlog Planning or Sprint Planning tab of the Agile board.

◦ Stories related list of a product, release, sprint, theme, or epic.

◦ Defect or enhancement record.

3. On the form, fill in the fields.

Note: 
Some of the fields on the Story form may appear filled depending on the option that you 
used to create the story.

Story form

Field Description

Number System-generated number for the story.

Theme Theme associated with the story.

A theme can have one or more stories, but a story can belong to only one 
theme at a time.

Select the theme for this story from a list of themes that are associated with 
the Product  field.

Epic Epic associated with the story.
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Field Description

An epic can have one or more stories, but a story can belong to only one epic 
at a time.

Select an epic for this story from the epics that are associated with the 
Product  field.

Type Type of story.

Choose from options such as Development, Documentation, Spike, and 
others.

Classification Type of development that the story involves. This field is automatically set to 
Feature.

This field has no connection to the Defect  and Enhancement  fields in the 
Related Records  tab.

State State of the story. Select one of the following:

◦ Draft:The story requirements, such as the description and acceptance 
criteria, are still being drafted.

◦ Ready: The story is ready for pickup by the development team.

◦ Work in Progress: The development team is working on the story and 
recording the changes in the work notes field.

◦ Ready for Testing: The story is ready for pickup by a tester.

◦ Testing: The tester is testing the story based on the requirements provided 
in the story.

◦ Complete: The development and testing efforts on the story are complete.

◦ Cancelled: The story has been canceled.
This field is automatically set to Draft.

Points Number of points that indicate the estimated effort that is required to 
complete the story.

A larger point value indicates that the story requires a greater amount of effort.

Priority Priority assigned to the story.

A product owner can use priorities to rank stories in the planning board.

Product Product that this story is associated with.

Release Release that this story is associated with.

The release can be from the releases associated with the selected product.

Assignment 
group

Agile team that the story belongs to.

Sprint Sprint that this story is associated with.

This field is available only when a value is selected from the Assignment 
group  field.
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Field Description

Assigned to User who is working on the story. Users on this list have appropriate scrum 
roles.

Demand Demand that this story is associated with.

When the demand is converted to project, the demand stories move from 
demand to project.

When a demand is converted to a story, the reference to the demand is 
displayed here.

Project Project that this story is associated with.

Project 
phase

Name of the agile project phase that this story is associated with. This field is 
available only when a value is selected from the project  field.

If a project has only one phase, then the story is automatically tagged to that 
phase.

Note: 
An agile phase can have stories that belong to more than one group.

Blocked An indicator to show that there are issues that prevent the story from 
progressing.

Short 
description

A brief description of the story.

Description A detailed description of the story.

Acceptance 
criteria

The functional criteria or testing results that are required to move this story to 
the Complete state.

Work notes Notes about the work done for this story.

Related Records section of the Story form

Field Description

Defect Defect that is associated with the story. This 
field is a reference field from the Defect 
[rm_defect] table. This field is required if the 
story is created for a defect.

Click the search icon ( ) in this field to 
display the existing defects or to open a new 
defect.

Only users with the feature_user role can 
open a defect. The admin must grant 
the feature_user role to all users who are 
expected to open defects in the Agile 
Development application. This field is the 
only location in the Agile Development 
application where records from the Defect 
[rm_defect] table appear.
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Field Description

For more information on defects, see 
Reporting defects in Agile Development 2.0.

Enhancement Enhancement associated with the story. 
This field is a reference field from the 
Enhancement [rm_enhancement] table. This 
field is required if the story is created for an 
enhancement.

Click the search icon ( ) in this field to 
display the existing enhancement requests 
or to open a new enhancement.

Only users with the feature_user role can 
open an enhancement. The admin must grant 
the feature_user role to all users who are 
expected to open enhancement requests 
in the Agile Development application. 
This field is the only location in the Agile 
Development application where records from 
the Enhancement [rm_enhancement] table 
appear.

For more information on enhancements, see 
Enhancement requests in Agile Development 
2.0.

4. Select Submit.

Result

• The story is created and the form reopens with related links and lists.

• The story is listed in the backlog depending on the fields filled in the story form.

What to do next

• Use the related links and lists of the story to create scrum tasks for this story, or convert this 
story into an epic or split this story into two stories. For more information, see Related links and 
lists for a Story in Agile Development 2.0.

• Add dependencies for Agile Development 2.0 stories

• You can create a story with the same details as this story by using the Insert  or Insert and Stay 
options from the story additional actions ( ).

When you use Insert and Stay, the form of the newly created story stays open. You can modify 
the details of the story or create more stories with these details. On the Agile board, the 
new story is positioned right below the original story. The global rank of the new story is set 
accordingly.

Note: 
Set the glide.ui.task.insert  and glide.ui.advance  properties to true  to 
access these actions. These actions are not allowed on stories added from the triage 
board.
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Generate acceptance criteria for stories using Now Assist for Strategic 
Portfolio Management (SPM)

Create clear, comprehensive, and testable acceptance criteria for user stories without writing 
them manually in Agile Development 2.0. Review and refine suggested options to ensure they 
meet your requirements.

Before you begin
Ensure that Now Assist for SPM  is installed in your instance and that the following two skills are 
active:

• Acceptance criteria generation

• Refine records

For more information, see Configure Now Assist Admin features.

Role required: scrum_story_editor

About this task
For an Agile 2.0 story, you can generate acceptance criteria by selecting Generate acceptance 
criteria  from the story header or using the Now Assist context menu in the Acceptance criteria 
field.

Procedure

1. Navigate to All  > Agile Development  > Stories.

2. Open your story record.

3. Generate acceptance criteria for the story using one of the following options:

◦ From the story form header: Select Generate acceptance criteria.

◦ From the Acceptance criteria field:

a. Place your mouse cursor in the field.

b. Select Refine with Now Assist  menu ( ).

c. Select Generate acceptance criteria.

4. Review the generated acceptance criteria.

5. You can choose to further refine the generated content using the Now Assist context menu 

( ) or generate a new criteria.

6. Save the Story form.
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Add dependencies for Agile Development 2.0  stories

Add prerequisite and dependent items for stories in Agile Development 2.0  so that you can 
visualize these dependencies on the scrum planning board and plan your sprints accordingly.

Before you begin
Role required: scrum_story_creator, scrum_story_editor

Procedure

1. Navigate to All  > Agile Development  > Stories.

2. Open the story to which you want to add dependencies.
Alternatively, you can use the scrum program board from the Agile board to open your story 
and add dependencies.

3. Add dependencies to the stories using the Prerequisite Stories or Dependent Stories related 
lists.

◦ Prerequisite Stories is the list of all stories that must be complete before the current story.

◦ Dependent Stories is the list of all stories that depend on the completion of the current story.

4. Select Save  and then select Update.

What to do next
You can visually analyze the dependencies of the stories using the scrum program board to help 
with your sprint planning.

1. Navigate to All  > Agile Development  > Agile Board  > Program  > Planning

2. Use the dependencies icon ( ) to show or hide dependencies between stories.

Note: 
Access to the Scrum program board is available only with the Scrum Programs plugin 
(com.snc.sdlc.scrum_program).

Create a scrum task for Agile Development 2.0  stories

Create scrum tasks in Agile Development 2.0  to break down a story into manageable pieces for 
your team to work on. You can create one scrum task at a time or multiple scrum tasks at once.

Before you begin
Role required: scrum_story_creator, scrum_admin

About this task
Team members volunteer for tasks based on their skills and track the hours remaining daily. If the 
task is not complete within the planned hours, it can be further split into additional tasks. A story 
is not complete until all its tasks are complete.

This task explains how to create one scrum task at a time. To save time, you can create multiple 
scrum tasks at once. See Create multiple scrum tasks for stories in Agile Development 2.0.

Procedure

1. Navigate to All  > Agile Development  > Stories

2. Open a story that you want to create tasks for.

3. From the Scrum tasks related list, select New.
Alternatively, you can create a scrum task using the Task board view of the Sprint tracking tab, 
on the Agile board.
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4. On the form, fill the fields.

Scrum Task form

Field Description

Number System-generated number for the story.

Story Displays the story associated with the scrum task.

Priority Priority for the task.

Planned 
hours

Estimated number of hours to complete the task.

A typical scrum task should take between 4 and 12 hours. If the task requires 
more than 12 hours, consider breaking it down into multiple tasks.

Remaining 
hours

Estimated number of hours remaining to complete the scrum task. The 
assigned group member updates this value as work is progressing on the task.

Actual 
hours

After the task is complete, enter the number of hours the task actually took.

Type Type of work involved.

State Current state of the scrum task. The default for a new task is Draft.

Assignment 
group

Group that would work on this task.

This field is automatically populated from the Assignment group  of the story 
from which the task is created.

Assigned to User working on the scrum task. This field is set to the story owner by default.

Blocked Indicator to show that there are issues that prevent the scrum task from 
progressing.

Short 
description

Brief description of the scrum task.

Description Detailed summary of the scrum task.

Work notes Notes to indicate progress on the scrum task or issues blocking it.

5. Select Submit.

Important: 
When a Scrum Task is created under a Story, the date fields on the Story become read-
only.

Create multiple scrum tasks for stories in Agile Development 2.0

For your Agile Development 2.0  stories, create batches of different types of scrum tasks at a time, 
to save time.

Before you begin
Role required: scrum_story_creator, scrum_admin

About this task
Select a story that need scrum tasks and create all these tasks together. You can create tasks of 
different types such as Testing, Analysis, and others. All these tasks are created with the short 
description ToDo.... Open the task records later and fill in more details for the task.
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Procedure

1. Navigate to All  > Agile Development  > Stories

2. Right-click a story number and select Add Scrum Tasks.

3. On the form, enter the number of scrum tasks to create for each task type.

◦ Analysis

◦ Coding

◦ Documentation

◦ Testing

4. Select OK.

Result
A batch of tasks of the selected types is created with a short description of ToDo...  and are listed 
in the Scrum Tasks related list of the story record.

What to do next
Open each scrum task record and fill in more details such as description, priority, and others. For 
field information of a Scrum Task form, see Scrum Task form.

Create a personalized backlog in Agile Development 2.0

Create filters to define which stories appear in your backlog in Agile Development 2.0.

Before you begin
Role required: scrum_product_owner

About this task
A backlog is a prioritized list of stories that are related to a specific product, epic, release, and so 
on. The definition of a backlog is flexible and it is set up by the product owner.

Procedure

1. Navigate to All  > Agile Development  > Personal Backlogs.

2. Select New.

3. On the form, fill in the fields.

Backlog definition form

Name Name for the backlog.

Table Table from which records are pulled for this 
backlog.

The default value for this field is Story 
[rm_story].

Visible to Users that you want to share the backlog with. 

Use the Unlock Visible to icon ( ) to add 
users.

Visible to Groups Groups of users that you want to share the 
backlog with. Use the Unlock Visible to icon 

( ) to add groups.
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Filter Filter criteria that are applied to stories in the 
backlog.

The default filter criteria is Active is True  and 
Sprint is Empty.

4. Select Submit.

What to do next
You can create any number of personal backlogs that match different priorities. Access all your 
personal backlogs by navigating to Agile Development  > Personal Backlogs  and also on the 
Backlog tab of your Agile Board.

Manage your product backlog in Agile Development 2.0

Manage your product backlog from a centralized location called the Agile board in Agile 
Development 2.0. Add stories to a personalized backlog and prioritize them as needed.

Before you begin
Role required: scrum_product_owner

About this task
Prioritize stories in your backlog. You can add stories, assign stories to a release or a product, 
add triaged records, and so on.

• Steps 1 and 2 take you to where you can manage your scrum backlogs.

• Steps 3 through 12 provide guidance on the different actions that you can perform on your 
backlog. Choose the actions based on your requirement.

• All actions that involve a triage board are accessible only when the Agile Development — 
Unified Backlog  plugin (com.snc.sdlc.agile.multi_task) is active.

Procedure

1. Navigate to All  > Agile Development  > Agile Board  > Backlog.

If you have already created a personalized backlog, it automatically appears in this tab. If you 
have not created a personalized backlog, then a welcome page appears that provides a link to 
create a backlog.
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2. From the list at the top-left corner, select the required backlog or create a backlog by using the 

Create Backlog icon ( ).

3. Update the existing filter criteria of your selected backlog by using the Edit Backlog icon ( ).

4. Personalize columns in a list by selecting the personalize icon .

5. Add a story to the backlog.

a. Click Create Story.

b. Specify the required details in the Story form.

c. Click Submit.
The story is listed at the bottom of the backlog on the last page.

If you want to add a story at a particular position in the backlog, select a story just above this 
position, and then click Create Story. The new story is listed below the story that you selected.

6. Update a story from the backlog.

a. Click the story number of the story that you want to update.

b. Edit the story details and click Update.
If you have read-only access, you can open the Story form but cannot edit the story details.

7. Create an epic or a theme directly from the Backlog  tab.

a. Select the options icon ( ) next to the Create Story  option.

b. Select Create Epic  or Create Theme  from the list.

c. On the form, fill in the fields and submit it.

The new epic is listed in the epics filter only if its stories meet the filter criteria of the selected 
backlog.

8. Arrange stories within a Backlog page using one of the following options.

◦ Use the mouse device to select and hold a story, drag it to the required position, and drop it.

◦ Use the keyboard. For more information, see Arrange Agile Development 2.0 stories in Agile 
Board using the keyboard

Rearranging stories in the backlog adjusts the ranking of stories in the global_rank column in 
the Story [rm_story] table. When you move a story within a backlog, its rank changes relative to 
the stories within the same backlog. So, the story at the top of the backlog list has a lower rank 
value and assumes higher priority while the story at the bottom of the backlog list has a higher 
rank value and assumes lower priority.
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9. Perform any of the following actions on a single story or a set of stories by selecting the 

required stories and clicking the Options icon ( ).

10. Use the Triage Board  option to view and edit the records in your triage boards.
You can do the following actions using the Triage Board  option:

◦ View and edit the total number of records (such as problems or defects) in the triage boards 
of all task types

◦ Open the list of a specific task type

◦ Edit an existing triage filter definition

11. Add a triaged record, such as a defect, to the bottom of your backlog.

a. Click Triage Board.

b. Select your triage filter definition.
For example, a definition for all defects.

c. Select the records that you want to add to your backlog.

d. Click Add to Backlog.

12. Move a triaged record from your backlog back to the triage board.

a. Open the triaged record by clicking its number.

b. Click the Move back to triage board  related link.
You need a specific role that provides access to a triaged record in the backlog. For example, 
to view a problem in the backlog, you must have the itil role. If you do not have access to any 
record, an error message appears.

Related topics

Agile board in Agile Development 2.0

Create a personalized backlog in Agile Development 2.0

Arrange Agile Development 2.0  stories in Agile Board using the keyboard

Learn how to use the keyboard to move and rearrange Agile Development 2.0  stories in the 
Backlog and Sprint Planning tabs of your Agile board.

Before you begin
Role required: scrum_admin, scrum_master, scrum_product_owner, or scrum_sprint_planner

Procedure

1. Reorder a single story:

a. Highlight the desired story by pressing the Tab key.

b. Highlight the context menu ( ) icon on the story by pressing the Tab key again.

c. Select the story by pressing the Enter key.

d. Move the story to the desired position using the up and down arrow keys.

e. Fix the position of the story by pressing the Enter key.
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2. Reorder multiple stories:

a. Highlight the desired story by pressing the Tab key.

b. Select the story by pressing the Enter key.

c. Select multiple stories using the up and down arrow keys and the Shift or Control keys.

▪ To select consecutive stories, use the down arrow key to highlight the last story that you 
want to select, and then press the Shift and Enter keys.

▪ To select stories that are in different positions on the page, use the down arrow key till you 
go to the next story that you want to select. Then, press the Control and Enter keys.

Repeat this process to select other stories.

d. Highlight the context menu ( ) icon on the story by pressing the Tab key again.

e. Press the Enter key to group all the selected stories.

Multiple stories that you selected appear 

grouped.

f. Move the stories to the desired position using the up and down arrow keys.

g. Fix the position of the stories by pressing the Enter key.

Plan your sprint activities in Agile Development 2.0

Streamline your sprint activities such as creating, editing, and completing sprints, or adding 
stories to sprints, using the Sprint Planning tab of the Agile board.

Before you begin

• You must be a member of an agile group to access the Sprint Planning tab.

• You can perform only a set of actions on the Sprint Planning tab based on the role that 
is assigned to you. For more information, see roles in Components installed with Agile 
Development 2.0.

• Role required: scrum_admin, scrum_master, or scrum_sprint_planner
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About this task

• Steps 1 through 3 take you to where you can plan your sprint activities.

• Steps 4 through 11 provide various actions that you can perform to plan your sprints. Choose 
the ones that suit your requirement.

For more information on the Agile board, see Agile board in Agile Development 2.0.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. Select the Sprint Planning tab.

3. From the Group  field, select an assignment group for which you want to plan the sprint 
activities.

The list displays all the teams to which you are added as a group member. The default 
assignment group is the team that you have selected earlier or the first team in which you were 
added as a group member.

4. Create a sprint.

a. Select Create Sprint.

b. On the form, fill in or update the fields.

c. Select Submit
Alternatively, you can also create sprints in bulk for an assignment group and come back 
to this planning tab to continue planning your sprints. See Create sprints in bulk in Agile 
Development 2.0.

5. Edit a sprint.

a. Open the sprint form by selecting its name.

b. In the Sprint form, update its details.
Until the sprint begins, you can also update the capacity of the assignment group using the 
Group capacity  field to account for changes in team composition, holidays, or vacations.

c. Select Update.

6. Add a new story to the backlog.

a. Select Create Story.

b. On the form, fill in the fields.
For field information, see Create a story in Agile Development 2.0.

c. Select Submit.

The story appears at the bottom of the backlog. You can edit the story details by selecting its 
number. If you have read-only access, you can view the story form but cannot edit the story 
details.

7. Add a story to the backlog or a sprint and simultaneously decide its order of implementation.
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a. From the Backlog or a sprint, select the row of a story under which you want to add the new 
story.

b. Repeat steps 6a through 6c.
The new story is placed under the story that you initially selected.

8. Personalize columns in a list using the personalize option ( ).

9. Arrange the stories according to your priority by reordering the stories in the Backlog or any of 
the sprint sections.

10. Start a sprint by selecting Start Sprint  in the section of the top sprint.
The Sprint Tracking tab appears.

11. Mark a sprint complete by selecting Complete Sprint  in the section of the top sprint.

a. In the Complete Sprint dialog box, move any incomplete stories to the backlog or a future 
sprint.

b. Select Complete.
The sprint is marked complete and disappears from the Sprint Planning tab.

Related topics

Agile board in Agile Development 2.0

Create sprints in bulk in Agile Development 2.0

Create multiple sprints at once for one or more Agile Development 2.0  assignment groups to 
save time.

Before you begin
Role required: scrum_admin, scrum_master, or scrum_sprint_planner

About this task
Create multiple sprints for an assignment group at a time. If multiple assignment groups follow 
the same sprint cadence, you can generate sprints in bulk for all these groups together.

Procedure

1. Navigate to All  > Agile Development  > Groups.

2. Select the assignment groups that you want to create sprints for and select Create Sprints.

3. On the form, fill in the fields.

Create Sprints form

Field Description

Name Name for the sprint that applies to all the 
selected assignment groups.

For example, if all the selected assignment 
groups would work for the upcoming release, 
you can name your sprint by the release 
name, such as <Release name> sprint.

Starting Number Starting number of the sprint.
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Field Description

The sprints created for the selected 
assignment groups are named as <Name> 
<Starting Number>.

Start date Date that the sprint starts on.

Duration (days) Number of days that a sprint contains.

Number of Sprints Number of sprints that you want to create for 
the selected assignment groups.

4. Select OK

Result
The sprints are created for the selected assignment groups and are listed in the Sprints related 
list of these groups.

Track progress of stories for a sprint in Agile Development 2.0

Use the Sprint Tracking tab of the Agile board in Agile Development 2.0  to track the development 
of the stories from your current sprint.

Before you begin
You must be a member of an assignment group to access the board.

Role required: scrum_user or scrum_admin

About this task
Use the Story board view of the Sprint Tracking tab to check the state of your stories for the 
current sprint. On the board, stories are shown as cards, and their states are indicated as lanes.

You can move the story cards into different lanes or add new stories for the team, to make real-
time updates during scrum calls or other status meetings.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. Select the Sprint Tracking  tab.

3. From the Story board  view, review the stories for the current sprint using the state lanes.

4. Optional:  Change the state of a story by moving the story from one lane to another.

(Optional) If you use triage board and add those records to your backlog, your board could 
have stories associated to the triaged records. When you move these stories to different lanes 
on the story board to update their state, the state of the associated story is updated but the 
state of the original triaged record remains the same. To change the state of the original record, 
open the story and switch to the original record tab.
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5. Optional:  Hide lanes that you do not want to be displayed by selecting Hide Lane  from the 

vertical lane menu ( ).

6. Optional:  Display any hidden lanes and change the board theme.

a. Select Configuration  ( ).

b. Select Advanced Settings.

c. Select the lanes you want to be displayed.
You can also change the order of the lane display by reordering them in the Lane 
configuration section.

d. Select a different color to change the board theme.

7. Optional:  Add a story to a specific lane.

a. Select + Add Card.

b. On the form, fill in the fields and click Submit.
For field information, see Create a story in Agile Development 2.0.

Track progress of scrum tasks for a sprint in Agile Development 2.0

Use the Sprint Tracking tab of the Agile board in Agile Development 2.0  to track the progress of 
scrum tasks for the stories from your current sprint.

Before you begin
You must be a member of an agile group to access the board.

Role required: scrum_user or scrum_admin

About this task
Use the Task board view of the Sprint Tracking tab to check the state of your scrum tasks for the 
current sprint. On the board, each story is a collapsible section. Tasks for each story are shown 
as cards in these sections, with their states indicated as lanes.
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You can move the task cards into different lanes or add new task for a story, to make real-time 
updates during scrum calls or other status meetings.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. Click the Sprint Tracking  tab.

3. From the Task board  view, review the states of the scrum tasks of all stories scheduled for the 
current sprint.

4. Change the state of a scrum task by moving the task from one lane to another.

5. Add a scrum task to a specific lane.

a. Click + Add Card.

b. On the form, fill in the fields and click Submit.
For field information, see Create a scrum task for Agile Development 2.0 stories.

Track sprint progress in Agile Development 2.0

Track the progress of stories, scrum tasks, and tests for the current sprint from a single 
consolidated view on the Agile board in Agile Development 2.0.

Before you begin

• You must be a member of an Agile 2.0 assignment group to access the Sprint Tracking board.

• Viewing, adding, or updating tests for stories requires activating the Test Management 2.0 
plugin (com.snc.test_management.2.0).

Role required: scrum_user or scrum_admin.

About this task
Using the List view of the Sprint Tracking tab, review the progress of scrum tasks and tests 
created for the stories of the current sprint.

Each story is listed as section that can be expanded to show the tasks or tests created for it. You 
can add new tasks or tests to the stories, or run tests that are in the Ready state.

Steps 3 through 8 provide different actions to perform on the Sprint Tracking board. Choose the 
ones that suit your requirement.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. From the Sprint Tracking tab, select the List  view.

All stories scheduled for the current sprint are listed as sections, which can be expanded and 
collapsed. The details of the story such as the current state, short description, and assigner 
user can be seen.

3. From the Show  field, select the items that you want to review the status of.

◦ Scrum Tasks

◦ Tests

4. Expand each story section to see the details of the tasks or tests added to it.

You can customize the information shown for these items using the personalize option ( ).
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5. Add a new scrum task to a story.

a. In step 3, select Scrum Tasks.

b. From the section of the story that you want to add the task for, select Add Scrum Task.

c. On the form, fill in the fields.
For field information, see Create a scrum task for Agile Development 2.0 stories.

d. Select Submit.

6. Add a new test for a story.

a. In step 3, select Tests.

b. From the story that you want to add the test for, select Add Test.

c. Enter the short description and select Submit.
A test is created and listed in the story section. You can open the test form, add test steps, 
verify them and mark the test as ready to run. For information on the test form, see Test version 
form in Agile Development 2.0.

Note: 
Adding tests to a Story requires activating the Test Management 2.0 plugin. See Activate 
Test Management 2.0.

7. If there are tests in Ready state for a story, you can run those tests.
For more information, see Run tests for a story in Agile Development 2.0.

Run tests for a story in Agile Development 2.0

For a story whose tests are marked ready to be run, run those tests and execute all the test steps 
using the Sprint Tracking tab of the Agile board in Agile Development 2.0.

Before you begin
Role required: scrum_user

About this task
From the Agile board, use the List view of the Sprint Tracking tab to check stories that have test 
versions ready to be run. These stories have a Run  option next to their state. Run those tests by 
executing and verifying each test step.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. From the Sprint Tracking tab, select the Listview.

All stories scheduled for the current sprint are listed as sections, which can be expanded and 
collapsed.

3. From the Show  field, select Tests

4. For the story that you want to run the tests on, select Run.

5. Select the environment on which the test is to be run and confirm by selecting Run.

6. In the Test Execution window, execute each test step and mark them as passed, failed, or 
blocked accordingly.
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◦ Passed ( )

◦ Failed ( )

◦ Blocked ( )

If you select Failed or Blocked for a test step, you can enter comments and attach files to 
support your selection.

7. If you're running multiple tests for the story, use the Next Test option ( ) to move to the next 
test after verifying the current one.

8. Repeat step 6 and 7 until you've executed and verified all the test steps.

9. Optional:  You can pause the test for the moment by selecting Pause

(Optional) If you've paused the test, skip step 10.

When you want to resume the paused test run later, you can find it at Test Management  > 
Runs.

10. After marking all test steps, select Done.

Result
The result of each test is indicated on the Agile board as Passed, Failed, Blocked, or Not finished 
according to the following conditions.

• If all the test steps are passed, the status is Passed.

• If at least one step of the test is not executed, the status of the test is Not finished.

• If at least one step of the test fails, the overall status of the test is Failed. This rule takes 
precedence over the previous rule.

• If at least one step of the test is blocked, the overall status of the test is Blocked. This rule 
takes precedence over the previous two rules.

What to do next
View the test results for a story in Agile Development 2.0

View the test results for a story in Agile Development 2.0

Analyze results of the tests that you run on Agile Development 2.0  stories. Troubleshoot failures 
so that the story can be moved to completion.

Before you begin
Role required: scrum_user

About this task
Use the Sprint Tracking tab of the Agile board to review the tests run for a story. The results of the 
run tests are listed in the Test results related list of each test form. From these results, you can 
find additional details such as the comments for why a test has been blocked or failed, and any 
attachments supporting the comments. Use these additional details to troubleshoot and fix any 
issues in your product or feature.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. From the Sprint Tracking tab, select the List  view.
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All stories scheduled for the current sprint are listed as sections, which can be expanded and 
collapsed.

3. From the Show  field, select Tests

4. From a story section, select a test that you want to analyze the results of.

5. From the Test results related list, select a test result to view its details in a form.

Test results form

Field Description

Number Automatically generated number for the test 
result.

Test Test that is run.

Result Execution status of the test: Passed,Failed, 
or Blocked.

Version Version of the test that is executed.

Execution environment Environment on which the test is executed.

Updated Date and time that the test result was 
recorded.

Run by Name of the tester who executed the test 
plan.

Test run Name of the test run.

Beneath these fields, the tests steps that are executed and verified for this test are listed along 
with their execution status. Any comments or attachments that are added to these steps are 
also displayed for reference.

Related topics

Track sprint progress in Agile Development 2.0

Report a defect in Agile Development 2.0

Track issues associated to your product or feature by reporting defects in Agile Development 2.0.

Before you begin
Role required: feature_user, scrum_story_creator, or scrum_admin

The administrator must grant the feature_user role to all those users who are expected to report 
defects using the Agile Development 2.0  application.

About this task
Create a defect record using the Defects module. You can later create a story for this defect so 
that the relevant assignment group can work on resolving the issues.

Procedure

1. Navigate to All  > Agile Development  > Defects.

2. Select New.

3. On the form, fill in the fields.
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Defect form fields

Field Description

Number System-generated unique identifier for the defect.

Priority Priority assigned to the defect. A product owner can use priorities when 
creating stories.

State State of the defect. Select one of the following:

◦ Draft:The defect details are still being drafted.

◦ Scoping: The defect is being triaged and the scope of the defect and its fix is 
being analyzed.

◦ Awaiting approval: The scope of the defect is finalized and the team is 
awaiting approval to start working on it.

◦ Work in progress: The team is working on the fix for the defect.

◦ Testing/QA: The tester is testing the defect fix based on the scope provided.

◦ Deploy/Launch: The team is ready to launch the fix for the defect.

◦ Closed Complete: The fix for the defect is deployed into the product.

◦ On Hold: The defect is put on hold due to any blockers and until further 
review.

◦ Cancelled: The team cancels working on this defect.
This field is automatically set to Draft.

Assignment 
group

The group to which the defect belongs.

Assigned to The user assigned to the defect.

Product Product with which this defect is associated. The field is required if the defect is 
part of a product.

Reported 
against

Problem, change, or other task record that this defect is reported against.

Short 
Description

Brief description of the defect.

Description Detailed description of the defect.

Work notes Notes about the work being performed on the defect. Work notes can be 
updated as the work progresses on this defect.

4. Select Submit.

Result
The defect is created and the form reopens with the Stories related list. The list of stories is only 
visible to users with a scrum role.

What to do next
A scrum product owner can review the defect and decide if a story must be created for it. See 
Create a story in Agile Development 2.0.
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Create an enhancement request in Agile Development 2.0

Capture enhancement ideas for your feature or product as enhancement requests in Agile 
Development 2.0  so that you can review and prioritize them later.

Before you begin
Role required: Any one of the feature_user, scrum_story_creator, scrum_admin, or 
rm_enhancement_admin roles

The administrator must grant the feature_user role to all users who are expected to create an 
enhancement request in the Agile Development  application.

About this task
Create an enhancement record using the Enhancements module. You can later review this 
record and create a development story for it if you choose to prioritize for any of your upcoming 
releases.

Procedure

1. Navigate to All  > Agile Development  > Enhancements.

2. Click New.

3. Fill in the fields, as appropriate.

Enhancement form

Field Description

Number System-generated number for the enhancement.

Priority Priority assigned to the enhancement.

Product owners can refer to this value when creating stories and scoping it into 
upcoming releases.

State Current state of the enhancement. The default is Draft.

Assignment 
group

Group that would work on this enhancement

Assigned to User assigned to the enhancement.

Product Product with which this enhancement is associated. The field is required if the 
enhancement is part of a product.

Short 
Description

Brief description of the enhancement.

Description Detailed description of the enhancement.

Work notes Notes about the work being performed on the enhancement.

4. Click Submit.

Result
The enhancement request is created and the form reloads with the Stories related list. The list of 
stories is only visible to users with a scrum role.

What to do next
A scrum product owner can review the request and decide whether to create stories for it.
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Set up a triage board in Agile Development 2.0

Set up your own triage board to view and manage records that are important to your product, 
such as problems, incident tasks, defects, or change requests at one place easily.

Before you begin
Ensure that you own a backlog. See Create a personalized backlog in Agile Development 2.0.

Role required: scrum_product_owner

About this task
Define filters to create a triage board, so that you can access and manage the records that you 
want easily.

You can create as many triage boards as you want. For example, you can create one triage board 
for defects and incidents and another for enhancements.

Procedure

1. Navigate to All  > Agile Development  > Agile Board  > Backlog.

2. Set up a new triage board.

◦ If this is your first triage board, select Triage Board  > Set up Triage Board.

◦ If you already have a triage board, select Triage Board  > New Triage Definition

3. On the form, fill in these fields.

Field Description

Name Name for the triage board.

Table Table from which you want to filter records for 
the triage board.

Filter Filter criteria to be applied on the selected 
table to populate the triage board.

Important: 
Do not to remove the default conditions: 
Active is true  and Agile story is empty.

◦ Active is true  ensures that your triage 
board only shows the tasks that are active 
and not completed or cancelled.

◦ Agile story is empty  ensures that the task 
doesn't already have a story associated to 
it and is not already present in some other 
backlog.

Backlog definition Backlog that any stories created from this 
triage board would be added to.

4. Select Submit.

Result
A triage board is created and can be accessed from the Backlog section of the Agile board.
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What to do next

• Edit the filter criteria for existing triage boards.

Select Triage Board  and then select Edit Triage Definitions.

• Open the new triage board to view its contents.

Select Triage Board  and then select the board that you created.

• Triage items and add them to a backlog in Agile Development 2.0

Related topics

Manage your product backlog in Agile Development 2.0

Triage items and add them to a backlog in Agile Development 2.0

Review the list of items in your triage board and add them to your Agile Development 2.0  backlog. 
Based on their priority, you can schedule them in the upcoming sprints for your product teams to 
work on them.

Before you begin

• Activate Agile Development — Unified Backlog

• Set up a triage board in Agile Development 2.0

Role required: scrum_product_owner

About this task
Select the items from your triage board and add them to your backlog based on their priority for 
your product. Every item that is added to the backlog from the triage board has an associated 
story to it. From the Agile board, you can switch between the original item Information and Story 
Information tabs for more details.

These stories can be later assigned to product teams and scheduled into sprints.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. From the Backlog section of the Agile board, select your product or team backlog from the 
Backlog  field.

3. Select Triage Board  and select the triage board that you want to review the items of.
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For example, in the screenshot here, Defects board can be selected.

4. Review the list and select the ones that you want to add to the backlog.

5. Select Add to Backlog.

Result
The selected list of items from the triage board is added to the backlog as stories. You can 
schedule these stories into upcoming sprints using the Sprint Planning tab of the Agile board.

An example here shows how an associated story is created for a defect that is added to the 
backlog. The story has a reference to this defect in the Original task  field.

Scrum Programs for Agile Development 2.0
Plan and track the work of multiple teams that work together, either toward a common short-term 
outcome or on an ongoing basis.

This video provides an overview of Scrum Programs for Agile Development 2.0.

The examples of short-term outcomes are a demand, project, epic, or a release. Teams that work 
together on a scrum program can:
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• Work in synchronized or varied sprint cadences.

• Contribute to work outside of this common scrum program.

With the centralized Planning page for a scrum program on ServiceNow®  Agile Development 2.0, 
you can:

• Assign work and compare the workload of multiple teams across sprints.

• Set, view, and adjust dependencies between stories across multiple teams.

Activate Scrum Programs

Activate the Scrum Programs (com.snc.sdlc.scrum_program) plugin to start planning your scrum 
programs in Agile Development 2.0.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Components installed with Scrum Programs

Understand the roles, tables, business rules, and UI macros that are installed when you activate 
the Scrum Programs plugin.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed with Scrum Programs

Role title [name] Description Contains roles

Program manager 
[it_program_manager]

Users with this role have 
full control on all the scrum 
programs.

• program_manager

• scrum_product_owner

• scrum_master
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Note: 
The it_program_manager role is installed with the activation of Scrum Programs only if it is 
not already installed through the Project Portfolio Management  plugin.

Tables installed with Scrum Programs

Table Description

epic_backlog_definition Stores the filter criteria that is used to create 
the epic backlogs.

scrum_program_m2m_group Stores the relationship between a scrum 
program and its teams.

Business rules installed with Scrum Programs

Name Table Description

Set global rank for epic rank_configuration Contains fix script to populate 
global rank for existing epics.

UI macros installed with Scrum Programs

Name Description

program_planning_constants
Contains customizable TEAM_LIMIT and 
STORY_LIMIT properties.

These properties limit the number of teams 
and stories that can be shown on the scrum 
program planning board.

The default value for the TEAM_LIMIT property is 15 and STORY_LIMIT property is 1000. You can 
change these values according to your preferences.

Note: 
Increasing the values might result in longer loading times and degraded performance of the 
scrum program planning board.

Create an epic backlog

Categorize epics into epic backlogs by defining a set of filters according to your preferences. 
While planning your scrum program, you can use these epic backlogs to plan for only those 
stories that belong to the epics in this backlog.

Before you begin
Role required: it_program_manager

About this task
With epic backlogs, you can filter stories on the planning board, to display the stories from only 
certain epics. For example, you can create a backlog of epics with Priority set as High. Later on 
the planning board, you can focus only on the stories belonging to these high-priority epics and 
plan your sprints accordingly.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1976



Procedure

1. Navigate to the Epic Backlog form in one of the following ways:

Option Action

From the Epic Backlogs module a. Navigate to Agile Development  > Epic 
Backlogs.

b. Click New.

From Agile Board Navigate to Agile Development  > Agile Board 
> Program  > Backlog  and do one of the 
following:

◦ If you are creating an epic backlog for the 
first time, click Create Backlog.

◦ If this backlog that you want to create is an 
addition to existing epic backlogs, click the 

create icon ( ).

2. In the Name  field, enter a name of your choice for the epic backlog.

3. To set the desired filter conditions, click Add Filter Condition  or Add "OR" Clause.

For example, you can choose to filter your epics by the priority set for them.

Note: 
The default filter condition is Task type is Epic  and Active is true.

4. Click Submit.

Related topics

Manage your epic backlogs

Manage your epic backlogs

Create, update, and rearrange your epics by using a centralized view of epic backlogs on Agile 
Board.

Before you begin
Role required: it_program_manager, scrum_user

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. From the Program  tab, select Backlog.

◦ If an epic backlog exists, the page populates a list of epics that match the criteria of this 
backlog.

◦ If you have no existing epic backlogs, see Create an epic backlog.

3. To switch between the available epic backlogs, select a backlog from the Backlog list.

4. To edit the selected backlog, click the edit icon ( ).
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Note: 
You must have the role of it_program_manager to perform this step.

5. To add a new epic to the selected backlog, click Create Epic.

6. To filter the list of epics by product, select a product category from Epics by product.

You can show or hide the Epics by product  filter. Click the configuration icon ( ) and toggle 
Show Products Filter  on or off.

7. To locate an epic from the backlog, using the short description or the epic number, use the 
search bar.

8. To edit the details of an epic, click the epic number.

9. To rearrange the epics based on their priority, do one of the following:

Action Description

Use the mouse device to rearrange the epics a. Select the required epics.

b. Drag the selection to the desired position 
and drop it.

Use the keyboard to rearrange a single epic

a. To highlight the context menu icon ( ) 
of the desired epic, press the Tab  key and 
press the Enter  key.

b. Move the epic to the desired position by 
using the up and down arrow keys.

c. To fix the position of the epic, press the 
Enter  key.

Use the keyboard to rearrange a group of 
epics a. To highlight an epic, press the Tab  key.

b. To select the epic, press the Enter key.

c. Navigate using the up and down arrow keys 
and do the following:

i. To select consecutive epics, press the 
Shift  and Enter  keys together.

ii. To select random epics, press the Ctrl 
(for Windows) or Command  (for Mac) key 
and the Enter  key together.

d. To highlight the context menu icon ( ) of 
an epic, press the Tab  key and press the 
Enter  key.

e. Move the epics to the desired position by 
using the up and down arrow keys.

f. To fix the position of the epics, press the 
Enter  key.

You can also perform the following actions on a single epic or a group of epics:
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a. Select the required epics.

b. Click the more options icon ( ) of an epic and select any of the following options:

Option Action

Move to top Moves epics to the top of the Backlog list.

Move to bottom Moves epics to the bottom of the Backlog list.

Product Opens the Products list. Select the product to 
which the epics belong.

10. To view the backlog in a standard platform list, click the standard list view icon ( ).

Create a scrum program

Create a scrum program to plan sprints and track the progress of the multiple scrum teams that 
are working together.

Before you begin
Ensure that you have the information of the teams to be included in the program.

Role required: it_program_manager

Procedure

1. Navigate to the Program form using one of the following ways:

Option Action

From the Scrum Programs module a. Navigate to Agile Development  > Scrum 
Programs.

b. Click New.

From Agile Board a. Navigate to Agile Development  > Agile 
Board.

b. From the Program  tab, select Planning.

c. Click Create Program.

Note: 
You can create a scrum program from 
the Planning  page of Agile Board but 
only if it is your first scrum program.

2. On the form, fill in the fields.
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Program form

Field Description

Planned start date
Start date of the program. Manually enter the 
date or pick from the calendar.

The default date is the current day.

Planned end date
End date of the program. Manually enter the 
date or pick from the calendar.

Planned duration
Duration of the program in days and hours. 
This field auto-populates based on the start 
and end dates.

The default duration of a scrum program is 
one day.

Program manager
Manager of the program.

Default Epic Backlog
Initial epic backlog that is applied to the 
planning page, when you select this scrum 
program.

Currently on the planning page, the epic 
backlog is not automatically applied for a 
program. So, it is recommended that you 
manually select the required backlog while 
planning.

Program Name
Brief description of the program.

3. Click Submit.
Any user with the role scrum_user can view the created scrum programs.

What to do next

• Assign teams to a scrum program.

• Click the Scrum Program Board  related link to plan your scrum program.

Assign teams to a scrum program

Add teams to your scrum program to assign work and track the progress of the work.

Before you begin
Ensure that the teams that work on this scrum program are created as agile groups. For the 
procedure to create an agile group and assign members to it, see Create an agile group in Agile 
Development 2.0.

Role required: it_program_manager
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Procedure

1. Navigate to All  > Agile Development  > Scrum Programs.

2. Open your scrum program record.

3. In the Teams related list, click Edit.

4. Move the desired teams from Collection  to Teams List.

5. Click Save.

You can add a team to multiple scrum programs by following the same procedure. The teams 
that you add to a scrum program are displayed in its Teams related list.

What to do next
Plan a scrum program.

Scrum program planning board

Use a centralized view on Agile Board to plan work for the teams that are working on your scrum 
program.

Quick view of the scrum program planning board UI components.

Agile Board has a program planning board where you can plan, schedule, and review work for 
your scrum teams. The planning page contains the following components that guide you during 
your planning process.

Program selector

Select a program that you want to plan or review. After you select a program, you 

can add teams or update other information by clicking the edit icon ( ).

Program timeline

Navigate the program timeline by scrolling horizontally or by using the forward ( ) 

and back ( ) icons.

Epic Backlog filter

Select an epic backlog that is associated with your scrum program. You can filter 
the stories on the program planning board and the epic backlog pane. By analyzing 
the workload for just these selected epics, you can understand how the workload is 
scheduled across sprints.

Configuration panel

Turn on or off the following components on the planning board by using the 

configuration panel icon ( ).

Team backlog

Enables you to show or hide the team's backlog lane.

Story dependencies

Enables you to visually analyze dependencies between the stories of 
different sprints and teams by using the story dependency lines. You 
can use the dependencies option to show or hide these dependency 
lines. If you choose to hide the dependencies or if the dependencies 
involve a story that's not on the board, then you can see a colored 
border on the story card.
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The color of the dependency indicates the way you've scheduled the 
stories.

• Green: The prerequisite story is scheduled in a sprint first. Then, the 
dependent story is scheduled in a later sprint.

• Red: The dependent story is scheduled in a sprint first. Then, 
the prerequisite story is scheduled in a later sprint. Review the 
dependency and reschedule the story as required.

If none of the stories have a prerequisite or dependent story that is 
associated with them, the dependencies option is not visible.

For information on how to add story dependencies, see Add 
dependencies for Agile Development 2.0 stories.

Epic Backlog pane

Enables you to see a list of all the epics that are based on the filter criteria in the 
epic backlog definition. For more information, see Create an epic backlog.

In the backlog pane, you can do the following actions for an epic:

• View the epic description.

• View the unassigned and unscheduled stories of the epic as cards with their short 
descriptions and story points.

• Edit the epic's information by clicking its name.

• Add a new story to the epic by clicking Create Story.

Scrum teams

View all the teams that are involved in the selected scrum program toward the left of 
the planning board.

You can update a team's information, such as the team members, group capacity, or 
description, by clicking the team's name.

If your teams do not have sprints added to them, or if you want to add more sprints, 
you can Add sprints from the program planning board  directly.

Team backlog lane

Enables you to see the stories that are assigned to the team but these stories aren't 
scheduled yet into any sprint.

While planning your scrum program, if you know which stories must be assigned 
to the team but you don't know what sprints to use, you can move these stories 
to the team's backlog lane. By doing so, you can have a clear idea of the team's 
workload for the upcoming sprints and then eventually add these stories to the 
correct sprints.

You can also unplan a story that has already been scheduled to a sprint by dragging 
the story card back to the team's backlog. Use the backlog lane on the planning 
board to see which team has the story. Then, decide which sprint to schedule it in.

If you want to unassign a story from a team, you can drag the story card and drop it 
back into the epic backlog lane.

Team sprint lanes

Enable you to see the sprint cadences of the teams.
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Pointing your cursor to a sprint's name shows you its details such as the duration, 
total story points, and filled capacity. You can edit details, such as group capacity 
and planned start and end dates, by clicking the sprint name.

While planning your scrum program, if you know the sprint in which the story would 
be worked on, you can move the story card to that sprint.

Story cards

Enable you to see the stories of the epics from your scrum program in the form of 
cards. You can move these cards around to assign them to teams and to plan them 
into sprints.

If you have activated the Agile Development — Unified Backlog  plugin 
(com.snc.sdlc.agile.multi_task), you can also see stories that were added from the 
triage board to your unified backlog. From the planning board, you can double-
click a story card to open it in a pop-up window and edit its details. If the story is 
created from a record on the triage board, such as a defect, you can see both the 
story information and the defect information side-by-side.

Note: 
Stories can be created from enhancements, defects, incidents, or other such 
records only if you have activated the Agile Development — Unified Backlog 
plugin (com.snc.sdlc.agile.multi_task).

Sprint workload capacity bar

Plan a sprint efficiently. The bar, which is under a sprint name, indicates the 
workload that is planned for the team versus the team's capacity for that sprint. 
Pointing your cursor to the sprint name gives you additional details.

Zoom in and zoom out

Adjust the board view using the zoom in icon ( ) and the zoom out icon ( ).

Search

Filter the stories on the planning board using a search term. For example, you can 
enter a story number or a phrase from a short description.

Stories list

View a list of all stories of the program using the standard list view icon ( ).

Plan a scrum program

Plan work for sprints, using a centralized view on Agile Board, of multiple scrum teams that are 
working together on a scrum program.

Before you begin

• Create an epic backlog.

• Create a scrum program.

• Role required: scrum_sprint_planner

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. From the Program  tab, select Planning.

3. From the Program list, select a scrum program that you want to plan.
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A planning board displays all the teams that are working on the selected program, their sprint 
cadences, and sprint capacities.

4. From the Backlog list, select an epic backlog and click the backlog icon ( ) to display the 
epics from the selected backlog.

5. View the stories of an epic by selecting the epic from the backlog.

6. Assign a story to a scrum team by dragging a story card from the backlog and dropping it either 
in a sprint or team's backlog lane.

You can reschedule the stories across teams and sprints by rearranging the story cards.

◦ If you move the story card to a team's backlog, the Assignment group  field is updated 
accordingly.

◦ If you plan the story card into a sprint, the Assignment group  and the Sprint  fields of the 
story are updated accordingly.

The sprint capacity bar below the sprint name fills up depending on the stories that are 
scheduled for it.

7. Optional:  Update the group capacity of a team's sprint by clicking the sprint name.

8. Optional:  Unplan a story by dragging it from the planning board and dropping it either in the 
epic backlog pane or the team's backlog lane.

◦ Dropping the story back into the epic backlog pane clears the references of the sprint and 
assignment group from the story.

◦ Moving the story to the team's backlog lane clears only the sprint reference but retains the 
assignment group.

Related topics

Scrum program planning board

Add sprints from the program planning board

Add sprints to your scrum teams directly from the scrum program planning board without having 
to navigate to another module.

Before you begin
Role required: scrum_sprint_planner

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. From the Program  tab, select Planning.

3. From the Program list, select a scrum program that you want to plan.

4. Under the team name, click Add sprints.

5. On the form, fill in the fields.

Create Sprints form

Field Description

Name Name of the sprint for the team.

Starting Number Number that you want the sprints to start with.
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Field Description

For example, if it's your team's first sprint, 
enter 1.

Start date Start date of the team's sprint.

Duration (days) Sprint duration of the team.

Number of Sprints Number of sprints that you want to add to the 
team.

For example, if you want to add four sprints to 
the team, enter 4.

6. Click OK.

You can see new sprints for the team on the program planning board.

Work Progress Status for Agile Teams
The Work Progress Status for Agile Teams application provides you with indicators such 
as estimated completion date and progress status (green, yellow, red) for all your Agile 
Development 2.0  epics.

As a product owner or a team lead, these indicators help you understand if your Agile team 
could complete the epics' work by the planned end dates so that you can adjust your plans 
accordingly. As a team member working on stories of an epic, these status indicators help you 
understand your contribution to the overall work and your progress so that you can review your 
work strategy if necessary.

Note: 
You must enter a value for the Planned end date  field for an Agile Development 2.0  epic for 
these work progress status indicators to populate.

Install Work Progress Status for Agile Teams

Install the Work Progress Status for Agile Teams (sn_scrum_progress) application from 
ServiceNow Store.

Before you begin

• Activate the Agile Development 2.0  (com.snc.sdlc.agile.2.0) plugin.

• Install Performance Analytics Content Pack for Agile 2.0.

To verify that plugins and applications are activated and installed, navigate to Subscription 
Management  > Subscriptions  in your instance. The list displays the subscriptions your 
organization has purchased. Activation of Agile Development 2.0  and Performance Analytics 
Content Pack for Agile 2.0 on production instances may require separate licenses. Contact 
ServiceNow  Support for details.

Role required: admin

Procedure

1. Navigate to ServiceNow®  Store .

2. Search for Work Progress Status for Agile Teams.
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3. Click the application tile.
You can view detailed information about the application you are installing.

Note: 
Consider reading the Other Requirements and Dependencies sections, as applicable.

4. Click Get  and enter your Now Support  login credentials.

5. Click Request Install.

6. In the Instance Name  field, enter your details and click Validate Instance.

7. In the Reason for the Instance  field, enter your details and click Request.
You receive an email with detailed installation instructions.

8. Log in to the instance you want to install Work Progress Status for Agile Teams on.

9. Navigate to System Applications  > Applications.

10. Locate the Epic Progress Status for Agile 2.0 application, select it, and click Install.

What to do next
If you haven't already, start the [Scrum] Daily Data Collection job. For more information, see 
Enable daily data collection for Agile 2.0 dashboards.

Reviewing progress status for Agile Development 2.0  epics

Understand if your work would be completed by the planned end dates by reviewing progress 
status of your Agile Development 2.0  epics.

Navigate to Agile Development 2.0  > Epics  and filter the epics for your team.

The Status column of the epics list shows a Green, Yellow, or Red indicator for each epic to 
indicate the following:

• Green: Your epic is on track to be complete by the planned end date.

• Yellow: Your epic is off track and your plan of execution must be reviewed.

• Red: Your epic is not progressing well and might be at risk of not being complete by the 
planned end date,

The estimated completion date displays a date with the likelihood of the epic's completion.

The [Scrum] daily data collection job  helps generate the burnup report for your epics. Using 
the data generated for these epic burnup reports, an estimated completion date is determined 
for each of your epics. You can see that this date is the intersection of Completed and Scope 
forecast series in the respective epic burnup reports.

Based on this estimated completion date, the progress status for your epics is determined. 
Progress status for an epic is calculated only under the following conditions:

• Planned end date is populated in the epic.

• Percentage completion of the epic is a value greater than 0.

The color of the progress status indicator is determined using the following conditions:

• Green: Estimated completion date is on or before the planned end date.

• Yellow: Estimated completion date is beyond the planned end date by a deviation of 1% to 14%.

• Red: Estimated completion date is beyond the planned end date by a deviation of 15% or more.
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Related topics

Agile 2.0 Epic Dashboard

Performance Analytics  Content Pack for Agile 2.0
Improve your Agile processes and practices using preconfigured dashboards with data 
visualizations from the Platform Analytics  Content Pack for Agile 2.0.

Enabling the Performance Analytics  Solution

Use the Performance Analytics  widgets on the dashboard to visualize data over time, analyze 
your business processes, and identify areas of improvement. With solutions, you can get value 
from Performance Analytics  for your application with minimal setup.

Note: 
Solutions include some dashboards that are inactive by default. You can activate these 
dashboards to make them visible to end users according to your business needs.

For unlimited access to all features of this Platform Analytics Solution, purchase a 
Performance Analytics  subscription. For more information, see Activating your Performance 
Analytics subscription .

To use this Platform Analytics Solution, you must activate your subscription to Performance 
Analytics  for Business Management. For more information about entitlements to Performance 
Analytics, see Activating your Performance Analytics subscription .

This base system Performance Analytics  Solution is available from the ServiceNow Store. To 
enable this solution, as an admin, navigate to System Applications  > Search ServiceNow Store. 
When the landing page for the ServiceNow Store  opens, search for Performance Analytics 
Content Pack for Agile 2.0. When you find the solution, follow the instructions in the ServiceNow 
Store. The ServiceNow Store  has its own documentation.

Business stakeholder role support

The business stakeholder role (sn_agile_read) has read-only access to all Agile 2.0 dashboards. 
For more information, see Business stakeholder role for Agile Development 2.0.

Available dashboards and charts

The Platform Analytics Content Pack for Agile 2.0 includes the following preconfigured 
dashboards, each containing charts such as burnup, burndown, and cumulative flow diagrams:

• Agile 2.0 Sprint dashboard: Tracks sprint-level progress using burnup, burndown, and 
cumulative flow charts.

• Agile 2.0 Release dashboard: Tracks release-level progress using burnup, burndown, and 
cycle time charts.

• Agile 2.0 Team dashboard: Provides velocity history and velocity by type reports.

For more information about using these dashboards, see Agile Development process flow.

Related topics

Activate your Performance Analytics subscription
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Install Performance Analytics Content Pack for Agile 2.0

Install the Performance Analytics Content Pack for Agile 2.0 application from the ServiceNow 
Store.

Before you begin

• Activate the Agile Development 2.0  (com.snc.sdlc.agile.2.0) plugin.

• Activate the Performance Analytics (com.snc.pa) plugin.

Role required: admin

Note: 

• To verify that plugins and applications are installed and activated, navigate to 
Subscription Management  > Subscriptions  in your instance. The list displays the 
subscriptions your organization has purchased.

• Activation of the Agile Development 2.0  and Performance Analytics plugins on 
production instances may require separate licenses. Contact ServiceNow  Support for 
details.

Procedure

1. Navigate to ServiceNow®  Store .

2. Search for Performance Analytics Content Pack for Agile 2.0.

3. Click the application tile.
You can view detailed information about the application you are installing.

Note: 
Consider reading the Other Requirements and Dependencies sections, as applicable.

4. Click Get  and enter your Now Support  login credentials.

5. Click Request Install.

6. In the Instance Name  field, enter your details and click Validate Instance.

7. In the Reason for the Instance  field, enter your details and click Request.
You receive an email with detailed installation instructions.

8. Log in to the instance you want to install Performance Analytics Content Pack for Agile 2.0 on.

9. Navigate to System Applications  > Applications.

10. Locate the application, select it, and click Install.

Result
You can access the Agile Development 2.0  dashboard from Agile Development  > Dashboards.

What to do next
Start the [Scrum] Daily Data Collection job. For more information, see Enable daily data collection 
for Agile 2.0 dashboards.

Enable daily data collection for Agile 2.0 dashboards

Enable scheduled data collection to begin collecting scores on new data automatically. Data 
collection jobs automatically collect scores for automated indicators and breakdowns.
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Before you begin
Role required: pa_admin or admin

About this task

Note: 
Historical data collection is not supported for the underlying indicators of the [Scrum] Daily 
Data Collection job.

Procedure

1. Navigate to All  > Performance Analytics  > Data Collector  > Jobs.

2. Find and open the [Scrum] Daily Data Collection job.

3. Start the [Scrum] Daily Data Collection job.

a. Scroll down to the Job parameters section.

b. Set the Run as  field to a user that has one of the following roles: pa_admin, 
pa_data_collector, or admin roles.

c. Verify that the time zone in the Run As tz  field is appropriate for your organization.
This timezone is used for the following:

▪ Database queries created for this job

▪ Indicator conditions such as [[Created][on][Today]]

d. Enable the scheduled run of the job by selecting the Active  checkbox.

4. Click Update.

Upgrading the layout of Agile 2.0 dashboards

Upgrade to the latest layout of Agile 2.0 dashboards using Solution Library.

Existing users who upgraded to the latest version 1.1 of Performance Analytics Content Pack for 
Agile 2.0 can install the latest layout of the dashboards from Solution Library.

For example, if you are upgrading from version 1.0.2 or earlier of the application, then install the 
following dashboards from Solution Library to access the latest layout:

• Agile 2.0 Epic Dashboard

• Agile 2.0 Sprint Dashboard

• Agile 2.0 Prior Sprint Dashboard

• Agile 2.0 Release Dashboard

• Agile 2.0 Team Dashboard

Note: 
For users on the Paris  release, the Install  and Upgrade  buttons are not visible on the 
Solution Library content form. For information on resolving this issue, see Allow PA Solution 
Library for Store apps .
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Agile 2.0 Epic Dashboard

Visually analyze the progress of the stories of an epic over a given period using the Epic 
Dashboard.

Navigate to All  > Agile Development  > Dashboards  and select Agile 2.0 Epic Dashboard.

Epic Summary tab
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Cycle Time tab

The Agile 2.0 Epic Dashboard provides the following information:

• Displays the number of stories that are complete, and number of stories that are missing 
estimates for an epic.

• Displays the number of stories of the epic in their current state and their progress.

• Indicates the scope changes, if any, and trends of those scope changes.

• Indicates the pace at which the team is working on stories in the epic.

• Forecasts when the epic is likely to be completed based on scope change and completion rate 
trends.

• Shows time elapsed for the stories of an epic to go from an in-progress state to a completed 
state.

Canceled stories are not included in any of this data.

End user and roles

End user goal with required role and benefits

End user and goal Required role Benefits

Scrum master: Needs clear 
visibility into real-time 
progress of team stories and 
the changes in scope for the 
epic to complete the epic on 
time.

scrum_user • View current states and time 
in each state for the stories 
of the epic

• View epic burnup trend

• Estimate epic completion 
dates

• Identify outlier stories that 
took longer than expected

Indicators

Scrum: Sum of story points of all stories in epics
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Generates the scope series in the Epic Burnup report, which indicates the size of 
the epic.

Scrum: Sum of story points of completed stories in epics

Generates the completed series in the Epic Burnup report, which indicates the 
amount of work that has been completed in the epic.

Scrum: Count of all stories in the current epic

Generates the area series the Epic Cumulative Flow Diagram report, which indicates 
the number of stories of the current epic by state.

Breakdowns

• Scrum: Epic

• Scrum: State

Widgets

Total Story Count

Indicates the total number of stories in the epic.

Stories Completed

Indicates the number of stories in the epic that are complete.

Missing Estimates

Indicates the number of stories in the epic that are missing estimates.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the 
following data visualizations:

• Epic Cumulative Flow Diagram

• Story Cycle Time

For more information, see Upgrading the layout of Agile 2.0 dashboards.

Epic Summary

Title Type Description

Epic Burnup
Line chart

Shows the epic burnup trends. You can estimate when the epic is likely to be 
completed.

The Epic Burnup report comprises the following series that can be hidden or 
displayed based on your preference:

• Scope: Indicates the size of the epic.

• Scope Forecast: Predicts the possibility of scope change for the future dates, 
which is based on historical data.
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Epic Summary  (continued)

Title Type Description

• Completed: Indicates the amount of work in the epic that is complete.

• Completed Forecast: Predicts the burnup for the future dates. It indicates 
whether you can complete the epic on time. This prediction is based on 
historical data.

Note: 
The point at which the Completed Forecast series intersects with or 
crosses the Scope Forecast series is a predictor for when the epic might be 
completed. If the Completed Forecast series and the Scope Forecast series 
do not appear to ever intersect, it is a warning that scope is being added 
faster than work is being completed.

Epic Cumulative 
Flow Diagram

Area chart
Monitor the progress of all the stories of your epic between its actual start and 
end dates.

View the number of stories in each state by their arrival to a state, time in this 
state, and its departure from this state.

The Epic Cumulative Flow Diagram report comprises the following areas that can 
be hidden or displayed based on your preference:

• Ready: Indicates the number of stories of the epic that are ready to start work 
on.

• Work in Progress: Indicates the number of stories of the epic that are in 
development.

• Ready for Testing: Indicates the number stories of the epic that are ready to be 
tested.

• Testing: Indicates the number of stories of the epic that are currently being 
tested.

• Complete: Indicates the number of stories that are complete.

Note: 
Stories in Ready and Cancelled states are not included in this report.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story in the epic to move 
from an in-progress state to 
completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
progress state to completion. 
The size of the story bubbles 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

1993



Cycle Time  (continued)

Title Type Description

are relative to each other 
based on their story points.

Hovering your mouse cursor 
over a bubble displays the 
following details about that 
story:

• Story points

• Date that the story is moved 
to completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
towards the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area of the 
report for a clearer view.
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Cycle Time  (continued)

Title Type Description

You can customize the Burnup and Cumulative Flow Diagram reports. For more information, see 
Customizing Agile 2.0 dashboard reports.

Agile 2.0 Sprint Dashboard

Track the progress of your stories in the current sprint and forecast sprint completion using the 
Sprint Dashboard.

Navigate to All  > Agile Development  > Dashboards  and select Agile 2.0 Sprint Dashboard.

Agile sprint dashboard widgets

Agile sprint dashboard burndown report
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Agile sprint dashboard burnup visualization

Agile sprint dashboard cumulative flow diagram

The Agile 2.0 Sprint Dashboard provides the following insights:

• Displays details of the sprint such as percentage of work that is complete, time elapsed, and 
total number of stories that are missing estimates.

• Displays the number of stories of the sprint in their current state and their progress.

• Indicates the scope changes, if any, and trends of those scope changes.

• Indicates the way the team needs to progress on stories to achieve the sprint goal.

• Forecasts data showing the likelihood of completing the sprint as planned.

End user and roles

End user and goal Required role Benefits

Scrum master and sprint 
planner: Need visibility into 
scope changes, completed 
and remaining work for a 
sprint to adjust plans to 
complete the sprint on time.

scrum_user • Analyse the sprint burnup 
and burndown trends

• Analyse the scope change 
for the sprint

• View current states and 
analyse the time in each 
state for the stories of the 
sprint

• Estimate sprint completion 
dates
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Indicators

Scrum: Sum of story points of all stories in the current sprint

Generates the scope series in the Sprint Burndown and Burnup reports. The scope 
series indicates the amount of work (in story points) that is the planned for the 
sprint.

Scrum: Sum of story points of active stories in the current sprint

Generates the completed series in the Sprint Burndown and Burnup reports. The 
completed series indicates the amount of work (in story points) completed in the 
sprint.

Scrum: Time elapsed in sprint

Calculates the time to be displayed in the Time Elapsed widget.

Scrum: Count of all stories in the current sprint

Generates the area series in the Sprint Cumulative Flow Diagram report. It indicates 
the number of stories in the current sprint.

Scrum: Percent Completed by Points

Calculates the amount of work (in percentage) completed for the sprint. The value is 
the result of the following formula:

([[Scrum: Sum of story points of completed stories in 
 current sprint]]/[[Scrum: Sum of story points of all 
 stories in the current sprint]]*100)

Breakdowns

• Scrum: Sprint

• Scrum: Current Sprint

• Scrum: State

Widgets

Scope

Indicates the amount of work in story points that is planned for the sprint. This 
widget lets you see at a glance how much work must be completed to achieve the 
sprint goal. It also lets you drill down to detail on the stories planned into the sprint.

Percent Completed

Indicates the percentage of work that has been completed in the sprint using story 
points. This widget lets you see at a glance how much work has been completed in 
the sprint. Together with the adjacent Time Elapsed widget, these widgets let you 
easily see whether you are completing work at a rate consistent with achieving the 
sprint goal on schedule.

Time Elapsed

Indicates the percentage of time that has elapsed between the start date and 
planned end date of the sprint. Together with the adjacent Percent Completed 
widget, these widgets let you easily see whether you are completing work at a rate 
consistent with achieving the sprint goal on schedule.
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Committed Points

Indicates the committed scope (in number of story points) of the sprint. Together 
with the adjacent Scope widget, these widgets let you see difference between the 
scope committed at the start of the sprint and the current scope of the sprint.

Note: 
This widget is not visible by default. You can add it from Reports to your 
dashboard. For more information, see Edit a responsive dashboard .

Missing Estimates

Indicates the total number of stories in the sprint that are missing estimates. It is 
required that you use estimates for the other indicators, widgets, and reports on this 
dashboard to be meaningful.

Tip: 
If you do not estimate stories, enter a "1" in the Story Points  field. The other 
indicators, widgets, and reports will then effectively function by count.

Blocked Work

Indicates the amount of work (in story points) in the sprint that is blocked.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the 
following visualizations:

• Sprint Burnup

• Sprint Cumulative Flow Diagram

For more information, see Upgrading the layout of Agile 2.0 dashboards.

Note: 
For all reports shown in the Sprint dashboard, the planned end date of the Sprints is used 
as a filter. Completed Sprints appear in the chart only if their Planned end date is less than 
or equal to the current date.

Title Type Description

Sprint 
Burndown

Line chart
Indicates the scope changes, if any, and trends of those scope 
changes. Indicates the ideal pace of work, how much work is 
remaining, and if the scope is likely to be completed before the 
end of the sprint.

The Sprint Burndown report comprises the following series that 
can be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that is planned for the 
sprint.

• Scope Forecast: Predicts the possibility of scope change for 
the future dates, which is based on historical data.

• Ideal Burndown: Indicates how the team needs to progress on 
stories to complete the sprint on time.
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Title Type Description

• Remaining: Indicates the amount of work left for completion in 
the sprint. If the actual burndown is above the ideal burndown, 
it implies that there is more work left than originally estimated. 
The team is running behind the schedule of the sprint. If the 
actual burndown is below the ideal burndown, it implies that 
there is less work left than originally estimated. The team is 
running ahead of the schedule of the sprint.

• Remaining Forecast: Predicts the burndown for the future 
dates. It indicates whether you can complete the sprint on 
time. The prediction is based on historical data.

Sprint 
Burnup

Line chart
Shows the sprint burnup trend indicating scope changes. 
Forecasts future changes in scope and the trend of work 
completion.

The Sprint Burnup report comprises the following series that can 
be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that is planned for the 
sprint.

• Scope Forecast: Predicts the possibility of scope change for 
the future dates, which is based on historical data.

• Completed: Indicates the amount of work completed in the 
sprint.

• Completed Forecast: Predicts the burnup for the future dates. 
It indicates whether you can complete the sprint on time. The 
prediction is based on historical data.

Sprint 
Cumulative 
Flow 
Diagram

Area chart
Monitor the progress of all the stories of your sprint between its 
actual start and end dates.

View the number of stories in each state by their arrival to a state, 
time in this state, and its departure from this state.

The Sprint Cumulative Flow Diagram report comprises the 
following areas that can be hidden or displayed based on your 
preference:

• Ready: Indicates the number of stories in the sprint that are 
ready to start work on.

• Work in Progress: Indicates the number of stories in the sprint 
that are in development.

• Ready for Testing: Indicates the number stories in the sprint 
that are ready to be tested.

• Testing: Indicates the number of stories in the sprint that are 
currently being tested.

• Complete: Indicates the number of stories in the sprint that are 
complete.
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Title Type Description

Note: 
Stories in Ready and Cancelled states are not included in 
this report.

You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more 
information, see Customizing Agile 2.0 dashboard reports.

Agile 2.0 Prior Sprint Dashboard

Prior Sprint Dashboard provides data visualization on scope, actual burndown and burnup, and 
forecast trends of previous sprints. Analyze the data and plan the work for upcoming sprints.

Navigate to All  > Agile Development  > Dashboards  and select Agile 2.0 Prior Sprint Dashboard.

Agile 2.0 prior sprint dashboard widgets

Agile 2.0 prior sprint dashboard burndown visualization
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Agile 2.0 prior sprint dashboard burnup visualization

Note: 
Canceled stories are not included in any of this data.

End user and roles

End user and goal Required role Benefits

Scrum master and sprint 
planner: Need visibility into 
actual changes in scope and 
forecast trends of the previous 
sprints.

scrum_user • Analyze sprint burndown 
and burnup trends

• Use the data to plan for 
upcoming sprints

Indicators

The following are the indicators which are used to generate the data for the reports of this 
dashboard.

Scrum: Sum of story points of all stories in the current sprint

Generates the scope series in the Sprint Burndown and Sprint Burnup reports.

Scrum: Sum of story points of active stories in the current sprint

Generates the completed series in the Sprint Burndown and Sprint Burnup reports.

Breakdowns

The following are the breakdowns used by the indicators.

• Scrum: Sprint

• Scrum: Prior Sprint

Widgets

Committed points
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Indicates the committed scope (in number of story points) of the sprint.

Stories Completed

Indicates the total number of stories that were completed in the previous sprint.

Completed

Indicates the amount of work (in story points) that was completed in the previous 
sprint.

Missing Estimates

Indicates the total number of stories in the previous sprint that were missing 
estimates.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Agile 
2.0, then install this dashboard from Solution Library to upgrade its layout and access the Sprint 
Burnup visualization. For more information, see Upgrading the layout of Agile 2.0 dashboards.

Title Type Description

Sprint 
Burndown

Line chart
Indicates the scope changes, if any, and trends of those scope 
changes. Indicates the ideal pace of work, how much work is 
remaining, and if the scope is likely to be completed before the 
end of the sprint.

The Sprint Burndown report comprises the following series that 
can be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that is planned for the 
sprint.

• Ideal Burndown: Indicates how the team needs to progress on 
stories to complete the sprint on time.

• Remaining: Indicates the amount of work left for completion in 
the sprint.

If Remaining is above the Ideal Burndown, it implies that there 
is more work left than originally estimated. The team is running 
behind the schedule of the sprint.

If Remaining is below Ideal Burndown, it implies that there is 
less work left than originally estimated. The team is running 
ahead of the schedule of the sprint.

Analyze the burndown trends and accordingly plan the workload 
for an upcoming sprint.

Sprint 
Burnup

Line chart
Shows the previous sprint burnup trend indicating scope 
changes. Analyze future changes the trend of team's work 
completion.

The Sprint Burnup report comprises the following series that can 
be hidden or displayed based on your preference:
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Title Type Description

• Scope: Indicates the amount of work that is planned for the 
sprint.

• Completed: Indicates the amount of work completed in the 
sprint.

You can customize the Burnup and Burndown reports. For more information, see Customizing 
Agile 2.0 dashboard reports.

Agile 2.0 Release Dashboard

Track the progress of your stories and analyze scope changes in the current release using Agile 
2.0 Release Dashboard.

Navigate to All  > Agile Development  > Dashboards  and select Agile 2.0 Release Dashboard.

Release Summary tab

Cycle Time tab
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The dashboard:

• Displays important details of the release such as percentage of work that is complete, time 
elapsed, and total number of stories that are missing estimates.

• Displays the number of stories of the release in their current state and their progress.

• Indicates the scope changes, if any, and trends of those scope changes.

• Indicates the pace at which the team is completing stories that are planned for the release.

• Forecasts data showing the likelihood of completing the release as planned.

• Shows time elapsed for the stories of a release to go from an in-progress state to a completed 
state.

Note: 
Canceled stories are not included in any of this data.

End user and roles

End user goal with required role and benefits

End user and goal Required role Benefits

Product owner: Needs 
visibility into scope changes, 
team's pace, and real-time 
progress of the stories for the 
release.

scrum_user • Track progress of your 
stories that are planned for 
a release

• Resolve any bottlenecks to 
deliver the release on time

• Identify outlier stories that 
took longer than expected

Indicators

Scrum: Sum of story points of completed stories in the active releases

Generates the Completed series in the Release Burndown and Burnup reports. 
These series indicate the amount of work in story points that has been completed 
for the release.

Scrum: Sum of story points of active stories in the current releases

Generates the scope series in the Release Burndown and Release Burnup reports. 
The scope series indicates the amount of work in story points that is planned for the 
release.

Scrum: Time elapsed in the release

Calculates the time to be displayed in the Time Elapsed widget.

Scrum: Count of all stories in the current release

Generates the area series in the Release Cumulative Flow Diagram report, which 
indicates the number of stories of the current release by state.
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Breakdowns

• Scrum: Release

• Scrum: State

Widgets

Percent Completed

Indicates the percentage of work (in story points) that has been completed in the 
release. This widget lets you see at a glance how much work has been completed in 
the release. Together with the adjacent Time Elapsed widget, these widgets let you 
easily see whether you are completing work at a rate consistent with achieving the 
release goal on schedule.

Scope

Indicates the amount of work in story points that is planned for the release. This 
widget lets you see at a glance how much work must be completed to achieve the 
releaser goal. It also lets you drill down to detail on the stories planned into the 
release.

Time Elapsed

Indicates the percentage of time that has elapsed between the start date and 
planned end date of the release. Together with the adjacent Percent Completed 
widget, these widgets let you easily see whether you are completing work at a rate 
consistent with achieving the Release goal on schedule.

Blocked Work

Indicates the total number of stories in the release that are missing estimates. It is 
required that you use estimates for the other indicators, widgets, and reports on this 
dashboard to be meaningful.

Note: 
If you do not estimate stories, enter a "1" in the Story Points  field. The other 
indicators, widgets, and reports will then effectively function by count.

Blocked Work

Indicates the number of stories in the release that are missing estimates.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the 
following visualizations:

• Release Cumulative Flow Diagram

• Story Cycle Time

For more information, see Upgrading the layout of Agile 2.0 dashboards.
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Release Summary

Title Type Description

Release 
Burnup

Line chart
Analyse the burnup trends, and estimate when the release work 
is likely to be completed. The release burnup report comprises 
the following series that can be hidden or displayed based on 
your preference:

• Scope: Indicates the amount of work that is planned for the 
release.

• Scope Forecast: Predicts the possibility of scope change for 
the future dates. This prediction is based on historical data.

• Completed: Indicates the amount of release work that is 
complete.

• Completed Forecast: Predicts the burnup for the future dates 
in the release. It indicates whether you can deliver the release 
on time.

Note: 
The point at which the Completed Forecast series 
intersects with or crosses the Scope Forecast series is a 
predictor for when the release might be completed. If the 
Completed Forecast series and the Scope Forecast series 
do not appear to ever intersect, it is a warning that scope is 
being added faster than work is being completed.

Release 
Burndown

Line chart
Indicates the scope changes, if any, and trends of those scope 
changes. Indicates the ideal pace of work, how much work is 
remaining, and if the scope likely to be completed before the 
end of the sprint. The Release Burndown report comprises the 
following series that can be hidden or displayed based on your 
preference:

• Scope: Indicates the amount of work that is planned for the 
release.

• Scope Forecast: Predicts the possibility of scope change for 
the future dates in the release. This prediction is based on 
historical data.

• Ideal Burndown: Indicates how the team needs to progress on 
stories to deliver the release on time.

• Remaining: Indicates the amount of work that is completed.

If Remaining is above the ideal burndown, it implies that 
there is more work left than originally estimated. The team is 
running behind the schedule of the release. If the Remaining 
is below the ideal burndown, it implies that there is less work 
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Release Summary  (continued)

Title Type Description

left than originally estimated. The team is running ahead of the 
schedule of the release.

• Completed Forecast: Predicts the burndown for the future 
dates in the release. It indicates whether you can deliver the 
release on time.

Release 
Cumulative 
Flow 
Diagram

Area chart
Monitor the progress of all the stories of your release between its 
actual start and end dates.

View the number of stories in each state by their arrival to a state, 
time in this state, and its departure from this state.

The Release Cumulative Flow Diagram report comprises the 
following areas that can be hidden or displayed based on your 
preference:

• Ready: Indicates the number of stories in the release that are 
ready to start work on.

• Work in Progress: Indicates the number of stories in the 
release that are in development.

• Ready for Testing: Indicates the number stories in the release 
that are ready to be tested.

• Testing: Indicates the number of stories in the release that are 
currently being tested.

• Complete: Indicates the number of stories in the release that 
are complete.

Note: 
Stories in Ready and Cancelled states are not included in 
this report.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story in the release to 
move from an in-progress 
state to completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
progress state to completion. 
The size of the story bubbles 
are relative to each other 
based on their story points.
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Cycle Time  (continued)

Title Type Description

Hovering your mouse cursor 
over a bubble displays the 
following details about that 
story:

• Story points

• Date the story is moved to 
completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
towards the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area of the 
report for a clearer view.
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You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more 
information, see Customizing Agile 2.0 dashboard reports.

Agile 2.0 Prior Release Dashboard

Prior Release Dashboard provides data visualization on scope, actual burnup and burndown, 
and forecast trends of previous releases. Analyze the data and plan the work for upcoming 
releases.

Navigate to All  > Agile Development  > Dashboards  and select Agile 2.0 Prior Release 
Dashboard.

Agile 2.0 prior release burndown report

Agile 2.0 prior release burnup report

Note: 
Canceled stories are not included in any of this data.
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End user and roles

End user goal with required role and benefits

End user and goal Required role Benefits

Product owner: Needs 
visibility into actual changes in 
scope and forecast trends of 
the previous releases.

scrum_user Analyze trends for the 
following:

• Scope changes

• Previous releases

Indicators

Scrum: Sum of story points of completed stories in the active releases

Generates the actual burndown series in the Release Burndown report, and the 
completed series in the Release Burnup report.

Scrum: Sum of story points of all stories in active releases

Generates the scope series in the Release Burndown and Release Burnup reports.

Breakdowns

• Scrum: Release

• Scrum: Prior release

Widgets

Stories Completed

Indicates the total number of stories that were completed in the previous release.

Completed

Indicates the amount of work (in story points) that was completed in the previous 
release.

Missing Estimates

Indicates the total number of stories in the release that are missing estimates.

Data visualizations

Prior release Summary

Title Type Description

Release 
Burnup

Line chart
Analyze the burnup trends of a previous release.

The prior release burnup report comprises the following series 
that can be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that was planned for the 
release.

• Completed: Indicates the amount of release work that is 
complete for this release.
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Prior release Summary  (continued)

Title Type Description

Release 
Burndown

Line chart
Shows the scope and rate of scope change, the ideal rate for 
work completion, and the actual rate of work completion. Analyze 
the burndown trends and accordingly plan the workload for an 
upcoming release.

The prior release burnup report comprises the following series 
that can be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that was planned for the 
release.

• Ideal Burndown: Indicates how the team had to progress on 
stories to deliver the release on time.

• Remaining: Indicates the amount of work that is completed.

If the actual burndown (Remaining) is above the ideal 
burndown, it implies that the team was running behind the 
schedule of the release. If the actual burndown (Remaining) is 
below the ideal burndown, it implies that the team was running 
ahead of the schedule of the release.

You can customize the Burnup and Burndown reports. For more information, see Customizing 
Agile 2.0 dashboard reports.

Agile 2.0 Team Dashboard

Team Dashboard provides a visualization of the team's progress on stories over a given period. 
It provides team predictability charts and helps you plan the team's capacity for the upcoming 
sprints. In addition, it provides details of all the team members.

Navigate to All  > Agile Development  > Dashboards  and select Agile 2.0 Team Dashboard.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2011



Work item progress tab

Sprint Performance tab
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Team Members tab

Cycle Time tab

End user and roles

End user goal with required role and benefits

End user and goal Required role Benefits

Team member: Needs visibility 
into team's predictability and 
progress in completing stories

scrum_user • View progress of the team 
by work items

• Analyze the time taken for 
stories to move from one 
state to another

• Analyze sprint performance 
of the team

• Analyze trends in sprint 
variance of the team 
comparing completed work 
to expected capacity and 
committed work

Indicators

Scrum: Scrum: Average Story State Duration
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Generates data that is displayed in the Average Cycle Time per State report.

Scrum: Story State Duration

Generates data that is displayed in the Time in State report.

Scrum: Total stories in a sprint

Generated data that is displayed in the Active Stories by State report.

Breakdowns

• Scrum: Group

• Scrum: State

Data visualizations

The Team Dashboard reports are segregated into the following three tabs:

• Work item progress: Reports of Active Stories by State, Time in State, and Average Cycle Time 
per State

• Sprint Performance: Reports of Velocity History and Sprint Variance

• Team Members: List of all the members of the team

Note: 
For existing customers who upgrade to the latest version, the list of the team members 
appears in both the Work item progress and Team Members tabs but only one of these 
locations would display the accurate information. You can remove this widget from the 
Work item progress tab to avoid this issue. For more information on how to remove a 
widget, see Edit a responsive dashboard .

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the 
following visualizations:

• Velocity History

• Velocity by Type

• Sprint Variance

• Story Cycle Time

For more information, see Upgrading the layout of Agile 2.0 dashboards.

Work item progress

Title Type Description

Active Stories by 
State

Bar chart
View the total number of stories in each state of a story, 
for example, testing, work in progress, and testing.
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Work item progress  (continued)

Title Type Description

Time in State
Stacked bar 
chart View the time in hours that the team spends in each 

state of a story.

Average Cycle 
Time per State

Line chart
View how the work in progress is trending over time and 
what are the most significant cycle times.

Sprint Performance

Title Type Description

Velocity History
Bar chart

Gain an insight on the overall 
velocity of the team for the 
past 10 sprints. Understand if 
the team is achieving a stable, 
predictable velocity, and is 
meeting the commitments.

The Team Velocity History 
report comprises the following 
series per sprint that can be 
hidden or displayed based on 
your preference:

• Team Capacity: Indicates 
the team capacity (in story 
points) for the sprint.

• Committed Story Points: 
Indicates the number of 
story points committed by 
the team for the sprint.

• Completed Story Points: 
Indicates the number of 
story points completed by 
the team for the sprint.

• Average Completed Points: 
Indicates the average 
number of story points 
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Sprint Performance  (continued)

Title Type Description

completed by the team for 
the sprint.

• Linear (Actual): Indicates 
if the amount of completed 
work is trending up, trending 
down, or relatively stable 
over sprints.

Velocity by Type
Stacked bar chart Analyze the way your team's 

velocity changes over time 
and compare the team's 
strategic workload with 
operational or other types of 
workload.

The bar charts have two 
stacks that show the sum 
of the story points of the 
following types of completed 
stories:

• Regular stories

• Stories added to the unified 
backlog from the items in 
the triage board

Clicking any bar would take 
you to its corresponding sprint 
details.

Data displayed in this report is 
of the past 10 sprints with the 
earliest sprint on the left.

Note: 
This report is not 
available by default. You 
can add it from Scrum 
custom charts to your 
dashboard. For more 
information, see Edit a 
responsive dashboard .

Sprint Variance
Bar chart

Analyze the percentage 
variance of the team 
compared to the capacity and 
committed points, for the past 
10 sprints.

The Team Sprint Variance 
report comprises the following 
series per sprint that can be 
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Sprint Performance  (continued)

Title Type Description

hidden or displayed based on 
your preference:

• Completed to Capacity: 
Indicates the percentage of 
completed work compared 
to the expected capacity for 
the sprint.

• Completed to Committed: 
Indicates the percentage of 
completed work compared 
to the committed work of the 
team for the sprint.

Team Members

Title Type Description

Team Members List
View the details of all team 
members.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story, which the team 
has worked on, to move 
from an in-progress state to 
completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
progress state to completion. 
The size of the story bubbles 
are relative to each other 
based on their story points.

You can compare the cycle 
times of stories with different 
story points and analyze 
the trend in the time taken 
by the team to complete 
them. Identify the stories that 
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Cycle Time  (continued)

Title Type Description

took longer to complete and 
analyze the reasons so that 
you can chart an action plan 
to reduce the team's cycle 
time in the future.

Hovering your mouse cursor 
over a bubble displays the 
following details about that 
story:

• Story points

• Date the story is moved to 
completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
towards the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area of the 
report for a clearer view.
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Cycle Time  (continued)

Title Type Description

Note: 
The stories shown in this 
chart are the ones that 
the team has completed 
in the past 30 days.

Customizing Agile 2.0 dashboard reports

Customize the Burnup, Burndown, and Cumulative Flow Diagram reports of your Agile 2.0 
dashboards according to the custom states of your scrum stories.

• Configure indicators to reflect your customizations.

For example, if there are any new states introduced to the scrum story table, then the 
corresponding indicators and indicator sources for the story table that rely on the State  field 
must be updated as well.

For more information, see Customize indicators of your Agile 2.0 dashboard reports.

• Update or clone UI scripts for modifications to use your own indicators.

Add customizations by overriding methods in empty implementation (Impl) classes of UI 
scripts such as ScrumAreaChartImpl and ScrumVelHistoryImpl.

For more information, see Update UI scripts to use customized indicators for Agile 2.0 
dashboards.

Customize indicators of your Agile 2.0 dashboard reports

Configure indicators to reflect your customizations on the Agile 2.0 dashboards.

Before you begin
Role required: admin or pa_admin

Procedure

1. Navigate to All  > Performance Analytics  > Indicators  > Automated Indicators.

2. Search for and open the required indicator.
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For example, if you want to customize the Sprint Burnup report, open Scrum: Sum of story 
points of completed stories in current sprint from the list of indicators.

3. In the Additional conditions section, modify the conditions according to your preferences.

4. Click Update.

Update UI scripts to use customized indicators for Agile 2.0 dashboards

Customize UI scripts by overriding methods in empty implementation (Impl) classes.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System UI  > UI Scripts.

2. Search for and open the required UI script.
For example, if you want to customize the Sprint Cumulative Flow Diagram report, open 
ScrumAreaChartImpl from the list of UI scripts.

3. Overwrite the base implementation according to your preferences.

4. Click Update.

Customize story states of your Agile Development 2.0  dashboard reports

Configure story states to reflect your customizations on the Agile Development 2.0  dashboards.

Before you begin
Role required: admin or pa_admin

Procedure

1. Navigate to All  > Agile Development  > Stories.

2. Open a story to which you would like to add the custom states.

3. Right-click State  and select Configure Choices  from the drop-down menu.

4. In the New item text  field, enter the new custom state name.

5. In the Numeric value  field, enter any corresponding number.

6. Click Add.
The new state appears in the Selected list.

7. Click Save.

Integrating Agile Development 2.0  with third-party applications
Integrate third-party applications such as Microsoft Azure DevOps  or Atlassian  Jira  with 
Agile Development 2.0, so that the planned and executed work can be synchronized in both 
applications.

After the integration is set up, plan the work, such as epics and stories, in Agile Development 
2.0  and enable your teams to deliver using the execution application of their choice, such as 
Microsoft Azure DevOps  or Atlassian  Jira.

All the existing work items are synced between the two applications. New items that are created 
in either application are easily exported and imported between each other. Changes made to 
these items would automatically synchronize between the two applications.

To get started with configuring these integrations, see:
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• Microsoft Azure DevOps Integration for Agile Development

• Atlassian Jira Integration for Agile Development

Atlassian Jira Integration for Agile Development

Enable bidirectional synchronization of records between Atlassian Jira and ServiceNow®  Agile 
Development  by integrating the two applications.

If the source of your work is in the ServiceNow  platform while the progress of the work is tracked 
in Jira, you can perform integrated tracking of your product development efforts by integrating 
Agile Development 2.0  with Jira.

For example, if you update a record in Jira, you can find that update in Agile Development 2.0. 
Similarly, if you update a record in Agile Development 2.0, you can find the same update in Jira.

When you synchronize Jira with Agile Development 2.0, you can:

• View available Jira projects and boards in Agile Development 2.0.

• Perform a bulk import of records from Jira to Agile Development 2.0.

• Perform single record updates between Jira and Agile Development 2.0.

• Avoid duplicating record update entries in Jira and Agile Development 2.0.

• Plan, track, and update your tasks from a single application.

Starting with version 1.1.1, Atlassian  Jira  Integration for Agile Development 2.0  supports map 
configuration at the project level and not at the instance level. Also, the application supports the 
following project types associated with Jira  Cloud and Jira  Server:

• Classic

◦ Scrum

◦ Kanban

◦ Bug tracking

• Next-gen

◦ Scrum

◦ Kanban

Note: 
Integration with Jira Data Center, Jira Align and other Atlassian  products is not available.

Importing issues from Kanban projects in Jira

Before importing Jira projects that are of the Kanban type, consider the following notes:

• Issues such as epics and stories are imported to Agile Development 2.0

• If your Kanban project has one or more Jira Boards, not all those Boards would be mapped to 
distinct Agile groups. The Jira project is mapped to a single group in Agile Development 2.0 
and all issues of this project, regardless of their association to boards, would be assigned to 
one Agile group.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .
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Install Atlassian Jira Integration for Agile Development

Install the Atlassian Jira Integration for Agile Development (sn_agile_jira_int) application v2.0.1 
from ServiceNow Store.

Before you begin
Ensure that the application and all of its associated store applications have valid ServiceNow 
entitlements. For more information, see Get entitlement for a ServiceNow  product or 
application .

Complete the following setup tasks for a smooth installation and configuration.

1. Navigate to Subscription Management  > Subscriptions  in your instance. The list displays the 
subscriptions that your organization has purchased.

2. Verify that Agile Development 2.0  (com.snc.sdlc.agile.2.0) is activated.

3. Verify that ServiceNow Integration Hub Starter Pack Installer (com.glide.hub.integrations) is 
activated.

4. Verify that Jira Spoke 2.6.8 (sn_jira_spoke) is activated.

5. Verify that Integrations - External Authentication Framework (com.glide.external.app) is 
activated.

Role required: admin

Note: 
Activation of the Agile Development 2.0, ServiceNow Integration Hub Starter Pack Installer, 
Jira Spoke, and Integrations - External Authentication Framework plugins on production 
instances may require separate licenses. Contact ServiceNow  Customer Support for 
details.

Procedure

1. Navigate to the ServiceNow Store .

2. In the ServiceNow Store, search for Atlassian Jira Integration for Agile Development.

3. Click the application tile.
You can view detailed information about the application. Consider reading the Other 
Requirements and Dependencies sections, as applicable.

4. Click Get  and enter your Now Support  login credentials.

5. Click Request Install.

6. In the Instance Name  field, enter your details and click Validate Instance.

7. In the Reason for the Instance  field, enter your details and click Request.
You receive an email with detailed installation instructions.

8. Log in to the instance on which you want to install the Atlassian Jira Integration for Agile 
Development application.

9. Select System Applications  > All Available Applications  > All.

10. Locate the application using the filter criteria and search bar, select it, and click Install.

Result
The following components are installed with installation of the application:

• Roles

• Scheduled Jobs

• Tables
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For more information, see Components installed with Atlassian Jira integration for Agile 
Development.

Components installed with Atlassian Jira integration for Agile Development

Several types of components are installed with activation of the Atlassian Jira integration for 
Agile Development application, including tables, user roles, and scheduled jobs.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description Contains roles

Jira integration 
admin

[sn_jira_int.admin]

Has complete access to the application • sn_int_common.admin

• sn_jira_int.user

Jira integration 
user

[sn_jira_int.user]

• Sets up integration between Jira and Agile 
Development

• Can create new or update the existing 
map configurations between Jira and Agile 
Development

• connection_admin

• sn_int_common.user

• credential_admin

Scheduled jobs installed

Scheduled job Description

Import Jira 
Issue

Imports issues and sprints from Jira automatically at a scheduled time.

This job is inactive by default.

For more information, see Schedule a job to auto-import issues from Jira to Agile 
Development 2.0.

Tables installed

Table Description

Attachment Map

[sn_int_common_attachment_map]

Stores the mapping of attachments to issues 
between Jira and Agile Development.

Choice Map

[sn_int_common_choice_map]

Stores the list of workflow state mapping for 
Jira projects.

Event Type Stores information of the type of webhook 
events such as create, update, or delete of a 
work item.
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Table Description

[sn_int_common_input_event_type]

External Identifiers

[sn_int_common_external_identifiers]

Stores the list of all Jira reference identifiers 
such as External ID, External Key, External 
Project, External URL, and so on.

External Project

[sn_int_common_project]

Stores information of the Jira project such as 
project ID, the Jira instance of this project, 
project name, and so on.

External system

[sn_int_common_external_system]

Stores information of Jira application used for 
the integration.

External System Version

[sn_int_common_external_system_version]

Stores version information of Jira application 
used for the integration.

Field Map

[sn_int_common_field_map]

Stores the list of field mapping of different 
issue types for Jira projects.

Jira Board

[sn_jira_int_board]

Stores the list of imported boards from Jira.

Jira Import Request

[sn_jira_int_import_request]

Stores the list of all import requests created 
to import projects, boards, and project style 
mappings from Jira.

Jira Instance

[sn_jira_int_instance]

Stores the list of all Jira instances.

Jira Project

[sn_jira_int_project]

Stores the list of all imported projects from Jira.

Project Integration Settings

[sn_agile_jira_int_import_settings]

Stores the list of one-to-one relation between 
a Jira project, board, and an Agile assignment 
group.

Project Style Mapping

[sn_jira_int_prj_style_mapping]

Store the list of map configuration templates 
per Jira project style.

Table Map

[sn_int_common_table_map]

Stores the list of table maps for Jira projects.

Webhook Registry

[sn_int_common_webhook_registry]

Stores details of the registry callback path for 
webhooks registered in Jira to receive event 
updates.

Setting up the integration between Jira and Agile Development 2.0

Understand the setup process of Atlassian Jira Integration for Agile Development 2.0.
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After you have the application installed in your ServiceNow  instance, you can proceed to set up 
the integration, using the sn_jira_int.user role.

The setup process for the integration includes the following tasks:

1. Connect Agile Development 2.0  with Jira.

2. Discover and import available projects and boards from Jira.

3. Enable import and export of issues and import issues in bulk from Jira projects to Agile 
Development 2.0.

4. Associate Jira projects with assignment groups in Agile Development 2.0.

5. Import sprints from Jira to Agile Development 2.0.

6. Enable a scheduled job to periodically import projects and issues from Jira.

7. Create custom map configurations for tables, fields, and workflow states between Jira and 
Agile Development 2.0.

Using guided setup to implement integration between Jira  and Agile 
Development 2.0

Guided setup provides a sequence of tasks that help you configure the integration between 
Agile Development 2.0  and Jira  on your ServiceNow  instance. To open guided setup, navigate to 
All  > Agile Jira Integration  > Guided Setup.

Connecting Agile Development 2.0  to Jira

Establish a connection between Agile Development 2.0  and Jira using a Jira connection alias 
and a Jira instance.

When you connect Agile Development 2.0  to Jira, a webhook is registered in Jira which receives 
the following event updates between Jira and Agile Development 2.0.

• Creating or updating projects.

• Creating, updating, or deleting information of epic, story, sprint, and any custom table maps 
and their fields.

Create a Jira connection alias for integration with Agile Development 2.0

Create a Basic Auth credential and an HTTP(s) connection with a Jira connection alias to 
establish a connection with Jira.

Before you begin
Roles required:

• admin to create a connection and credential alias

• sn_jira_int.admin or sn_jira_int.user to create basic authorization credentials and HTTP(s) 
connection

Procedure

1. Create a Connection & Credential alias

◦ You can use the connection alias (sn_jira_int.Jira) that is available by default.

◦ You must create a connection alias for every Jira instance that you use.

◦ For Jira server (on-prem) users, ensure that the server_type  and server_version  connection 
attributes are present.

2. Create Basic authorization credentials .
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Ensure that the user for whom the basic authorization credentials are created has access to all 
Jira projects.

3. Create an HTTP(s) connection .

Create a Jira Instance for integration with Agile Development 2.0

Create a Jira instance record using the connection alias that you created to enable the setup of 
Jira integration with Agile Development 2.0.

Before you begin
Role required: sn_jira_int.admin or sn_jira_int.user

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Click New.

3. On the form, fill in the fields.

Jira Instance form

Field Description

Name Name of the Jira instance. Enter a name of 
your choice.

Connection Alias Jira connection alias that you already 

created. Use the lookup ( ) option to select 
your connection alias.

Version Jira version. Use the lookup ( ) option to 
select your Jira API version.

4. Click Submit.

Connect Agile Development 2.0  to Jira

Connect Jira to Agile Development 2.0  to enable the integration.

Before you begin
Role required: sn_jira_int.user

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. Click Connect.

Result

• If the connection is successful, the State  field on the Jira Instance record shows Connected. A 
webhook is now registered in Jira to receive update events.

• If the connection could not be established, the State  field on the Jira Instance record shows 
Connection Failed. You can view the reason for the failure in the error message.

What to do next
Discover and import Jira projects and boards

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2026

https://www.servicenow.com/docs/access?context=create-https-connection&version=zurich&pubname=zurich-platform-security&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-https-connection&version=zurich&pubname=zurich-platform-security&ft:locale=en-US
https://www.servicenow.com/docs/access?context=create-https-connection&version=zurich&pubname=zurich-platform-security&ft:locale=en-US


.

Discover and import Jira projects and boards

Discover and import all available Jira projects and boards into Agile Development 2.0  to start 
using the integration between the two applications.

Before you begin

• Connecting Agile Development 2.0 to Jira.

• Role required: sn_jira_int.user

About this task

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. Click Discover Projects.

This action creates requests to import Jira projects, map configuration for all these projects, 
and Jira Boards. You can view all the import requests in the Jira Import Requests related list 
and the initial state of all the requests would be Requested.

Result
Once the status of each import request changes to Complete, you can see that the related lists 
of this Jira instance are populated as follows:

• Jira Projects: All available projects from Jira

• Jira Boards: All available boards from Jira

• Project Style Mappings: Map configuration for all the imported Jira projects according to the 
type of your Jira instance as follows:

◦ The classic_on_prem  project template contains the map configurations related to the Jira 
Server projects.

◦ The classic  project template contains the map configurations related to Jira Cloud Classic 
projects.

◦ The next-gen  project template contains the map configurations related to Jira Cloud Next-
gen projects.

Once the status of the Create Mappings request changes to Completed, you can see the map 
configuration for each of the imported Jira project under the Mapping Config column of the Jira 
Projects related list. For more information on the default map configuration of work items, see 
Default mapping configuration between Agile Development 2.0 and Jira.

What to do next
Import your issues from Jira to Agile Development 2.0. For more information, see Importing 
issues and sprints from Jira to Agile Development 2.0.

Default mapping configuration between Agile Development 2.0  and Jira

Understand the default field mapping configuration for work items of a project between Jira and 
Agile Development 2.0.

Mapping configuration is used to map records in Jira to Agile Development 2.0  for a project. If the 
table map does not exist for an issue type in your Jira project, the issue cannot be imported and 
exported between Jira and Agile Development 2.0.
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By looking at the default mapping configuration, you can understand how issue types in Jira 
are mapped to task types in Agile Development 2.0. You can also see how fields are mapped 
between the two applications. When you import the available issues and sprints of a Jira project, 
this data is stored in tables as defined in the project's map configuration.

From version 1.1.1 onwards, mapping configuration is generated per project and not at the 
instance level. You must update any custom maps that you previously configured to ensure that 
the import and export of work items is not impacted.

Here's how you can view the default map configuration tables of your Jira project.

1. Navigate to Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. From the Jira Projects related list, open a Jira project.

4. From the Table Maps related list, open the record for Story or Epic.

The following table lists the default field map configuration for a Story and Epic.

Map configuration for Epic

Field in Jira Field in Agile Development

Epic Name Short Description

Priority Priority

Summary Description

Status State

Map configuration for Story

Field in Jira Field in Agile Development 2.0

Status State

Sprint Sprint

Description Description

Priority Priority

Epic Link Epic

Summary Short Description

Assignee Assigned to

You can add or update the configuration for field, table, and choice maps of your projects 
between Jira and Agile Development 2.0  according to your organizational preferences. For 
details, see Customizing map configuration for your Jira projects.

Importing issues and sprints from Jira to Agile Development 2.0

Understand the process of importing existing issues and sprints from Jira to Agile Development 
2.0.

You can import existing issues from Jira projects as stories and epics, and existing sprint data 
from Jira boards as sprints to Agile Development 2.0. After importing the available data, any 
updates that you make to the epic, story, or sprint records will be synchronized automatically in 
both Jira and Agile Development 2.0.
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Importing issues

From version 2.0.1, you can proceed to import issues from a Jira project directly after discovering 
projects from Jira. You do not have to create team integration settings. However, the imported 
issues are not associated to any assignment group in Agile Development 2.0. You can manually 
assign these issues to an assignment group later.

If you want your imported issues to be assigned to an assignment group automatically, you can 
create team integration settings for your Jira project by associating it to an Agile 2.0 assignment 
group and then proceed to import the issues. This setting ensures that any imported issues that 
belong to a Jira project are assigned to its associated assignment group.

Importing sprints

Importing sprint data from Jira boards require that the board has team integration settings 
that associate it to an Agile 2.0 assignment group. Sprint data of a Jira board is imported to its 
assignment group, only if these sprints have already started in Jira. Also, only the completed and 
current sprints of Jira are imported.

Team integration settings

From version 2.0.1, the Project Integration Settings module is available as Team Integration 
Settings. Team integration settings help you associate Jira projects and boards with Agile 2.0 
assignment groups to facilitate the bidirectional synchronization of record updates.

Associating a Jira project to an assignment group allows the following:

• Enable import and export of all available stories and epics between this project and its 
associated group.

• View any new stories and epics or updates made to the existing stories and epics in both Agile 
Development 2.0  and Jira.

Associating a Jira board to an assignment group allows the following:

• Import all completed and current sprints from this board into the associated group.

• View any completed and current sprints or updates made to them in both Agile Development 
2.0  and Jira.

To understand the workflow of the import and export of issues between Agile Development 2.0 
and Jira, see Importing and exporting issues between Agile Development 2.0 and Jira.

Associate a Jira project and board with an assignment group in Agile Development 2.0

Associate your Jira projects and boards with assignment groups in Agile Development 2.0  to 
enable import and export of all available issues between the associated project and assignment 
group.

Before you begin

• Discover and import Jira projects and boards.

• Create assignment groups in Agile Development 2.0. See Create an assignment group in Agile 
Development 2.0.

• Ensure that your Jira project has a defined mapping configuration.

• Role required: sn_jira_int.user
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About this task
Create team integration settings to associate a Jira project and Jira board with an Agile 2.0 
assignment group.

Important: 
You can associate an assignment group with only one project and board from Jira.

Procedure

1. Navigate to All  > Agile Jira Integration  > Team Integration Settings.

2. Click New.

3. On the Team Integration Settings form, select the following:

◦ A Jira project

◦ A Jira board

◦ An assignment group in Agile Development 2.0  to which you want to associate the selected 
Jira project and board

Selecting a Jira board in the form is optional. If you do not want to synchronize the sprint data 
of the board between Agile Development 2.0  and Jira, you can skip selecting a Jira board.

Note: 
If your Jira project is of Kanban type, you can leave the Jira board  field empty. All issues 
of your Kanban project will be mapped to a single Agile 2.0 group.

4. Click Submit.

What to do next
You can import or issues from this Jira project or sprints from this Jira board to the associated 
assignment group.

Related topics

Import issues from a Jira project to Agile Development 2.0

Import sprints from Jira to Agile Development 2.0

Import issues from a Jira project to Agile Development 2.0

Import available issues from a Jira project, with or without the team integration settings for this 
project, so that you can update existing records of Jira from Agile Development 2.0.

Before you begin

• Discover and import Jira projects and boards

• Role required: sn_jira_int.user

About this task
If your Jira project has team integration settings, then the imported issues are assigned to an 
assignment group according to the team integration settings. If your Jira project does not have 
team integration settings, then the imported issues are not associated to any assignment group.

Note: 
This task does not explain importing sprints. For information on how to import sprints from 
Jira, see Import sprints from Jira to Agile Development 2.0.
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Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. From the Jira Projects related list, open the project from which you want to import the issues.

4. Enable the import and export of issues by selecting the Enable Import  and Enable Export 
options as applicable.
Synchronisation of multi-select fields between Agile and Jira is now supported.

5. Click Import Issues.

6. Select a date range from which you want to import the issues from Jira.

7. Click Submit.

An import request of type Import Issues is created in the Jira Import Requests related list. 
Once the state of this request changes to Completed, you can view all the imported records in 
the Epics and Stories modules in Agile Development 2.0. The relationship between the stories 
and epics is retained as it is in Jira.

Note: 
Existing comments and attachments of issues are not imported from Jira during a bulk 
import.

Import sprints from Jira to Agile Development 2.0

Import sprints from a Jira board so that you can track progress of these sprints directly in Agile 
Development 2.0.

Before you begin

• Ensure that the Jira board from which you want to import the sprints has team integration 
settings. For more information, see Associate a Jira project and board with an assignment 
group in Agile Development 2.0.

• Role required: sn_jira_int.user

About this task
Import completed and current sprints of Jira board into Agile Development 2.0.

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. From the Jira Projects related list, open the project that is associated to a Jira board from which 
you want to import the sprints.

4. Enable the import and export of sprints by selecting the Enable Import  and Enable Export 
options as applicable.

5. Click Import Issues.

6. Select a date range from which you want to import the sprints from Jira.

7. Click Submit.

An import request of type Import Sprints is created in the Jira Import Requests related list. 
Once the state of this request changes to Completed, you can view all the imported sprint data 
in the Sprints related list of the associated assignment group in Agile Development.
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Schedule a job to auto-import issues from Jira to Agile Development 2.0

Schedule a job to auto-import issues and sprints periodically from Jira into Agile Development 
2.0.

Before you begin
Role required: sn_jira_int.user

About this task
After you've configured the scheduled job, it imports issues from all the projects for which you've 
selected the Enable import  option.

If you do not configure the scheduled job, you must manually import issues for the discovered 
projects.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open the Import Jira Issue job.

The job is inactive by default.

3. Execute the job manually by clicking Execute Now.

4. Set the job to run at a scheduled time by selecting the Active  check box.
You can edit the details of the Run  and Time  fields according to your preference.

5. Click Update.

Customizing map configuration for your Jira projects

Customize the field, table, or workflow state map configuration for your Jira projects. You can 
customize map configuration of a single project or multiple projects of the same project style.

Note: 
Only fields of type number, select, text, and date are supported for custom map 
configuration.

Customize your table map configuration

Map a Agile Development 2.0  table of your preference for a Jira project.

Before you begin

• Discover and import Jira projects and boards.

• Role required: sn_jira_int.user

About this task
Create a custom table map of your preference for your Jira project and configure its fields.

If you have a custom table that is applicable to all Jira projects of a specific project type, see 
Apply custom map configuration to multiple Jira projects.

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. From the Jira Projects related list, open a Jira project for which you want to customize the map 
configuration.
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4. From the Table maps related list of the Jira project, click New.

5. On the form, fill in the fields.

Table Map form

Field Description

Internal Table Table name in Agile Development 2.0.

Map configuration Map configuration for this project.

This field is auto-populated based on the 
project.

External Table Table ID in Jira.

External Table Name Display name of the table in Jira.

6. Save the table configuration.

7. From the Field Maps related list of your table map record, create new field maps for the 
following fields:

Field in Jira Field in Agile Development 2.0

Summary of the issue Short description

Description of the issue Description

For information on how to configure field mapping for a table, see Customize your field map 
configuration. You can also create other field maps for your new table configuration.

What to do next

1. Validate your new table map configuration by clicking Validate and fix mapping  from your 
project form.

2. In the Table maps related list of your project, if the Valid column of your configuration shows:

◦ true, validation of your map configuration is successful.

◦ false, validation of your map configuration failed. Ensure that you enter correct values for all 
the fields and validate again.

3. Create a business rule to support export of this new table map configuration to Jira. See Create 
a business rule to apply a custom Agile Development 2.0 table map configuration.

4. If you want to support import and export of attachments for this new table map, see Allow 
import and export of attachments on a custom Agile Development 2.0 table.

5. If you want to enable display of fields that reference Jira identifiers in your custom table map, 
see Populate Jira project identifier reference fields for Agile Development 2.0 custom table.

Customize your field map configuration

Map a field of your preference for a Jira project.

Before you begin

• Discover and import Jira projects and boards.

• Role required: sn_jira_int.user

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2033



About this task
If you have a custom field for a Jira project that you want to map with a field in Agile Development 
2.0, you can create custom field map configuration that would apply only to this Jira project.

If you have a custom field that is applicable to all Jira projects of a specific project type, see 
Apply custom map configuration to multiple Jira projects.The following field types are supported 
for custom field map configuration:

• Number

• Select

• Text

• Date

• Identity

• Date time

• Reference

• List

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. From the Jira Projects related list, open a Jira project for which you want to customize the map 
configuration.

4. From the Table Maps related list, open the Sprint, Epic, or Story record to add a new field map 
configuration for that record.

5. From the Field Maps related list, click New.

6. On the form, fill in the fields.

Field Map form

Field Description

Internal Field Field name in Agile Development 2.0.

Table Map Table map in Agile Development 2.0, in which 
this field is created.

This field is auto-populated based on the 
table map record you select.

Internal Table Table in Agile Development 2.0.

This field is auto-populated based on the 
table map record you select.

External Field Field ID in Jira.

External Field Name Display name of the field in Jira.

Ensure that this field is added to the Jira 
project screen.

7. Click Update.
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What to do next

1. Validate your field map configuration by clicking Validate and fix mapping  from your project 
form.

2. From the Table maps related list of your project, navigate to your new field map configuration. If 
the Valid column of your configuration shows:

◦ true, validation of your map configuration is successful.

◦ false, validation of your map configuration failed. Ensure that you enter the correct values for 
all fields and validate again.

Important: 
If your custom map configuration is invalid or if the custom field configured is not added 
to the default screen scheme of the issue, the export action does not work.

Configuring a reference field in Jira

Understand how to configure a reference field while creating a new field map configuration.

When you select a reference field for the Internal Field  field, you must select a value for the 
Lookup Column Name  field. The value from the Lookup Column Name  field is used during the 
import and export of work items between Jira DevOps and Agile Development 2.0.

During import, the integration application searches for the record in the reference table using the 
Lookup Column Name  field. If the record is not found, the value in the work item will be empty in 
Agile Development 2.0.

Customize your workflow state configuration

Create a custom workflow state map of your preference for a Jira project.

Before you begin

• Discover and import Jira projects and boards.

• Role required: sn_jira_int.user

About this task
Map a custom workflow state from Jira to Agile Development 2.0.

You can map a workflow state in Jira to multiple workflow states in Agile Development 2.0. In such 
cases, the state in Agile Development 2.0  for an issue type depends on the choice order value 
that you provide for this state configuration.

For example, the In Progress  state in Jira is mapped to multiple states such as Work in progress, 
Ready for testing, and Testing  in Agile Development 2.0  using a choice order of 10, 20, and 30.

So, when an In Progress  issue from Jira is imported, the State  field in Agile Development 2.0  is 
set to Work in progress  as it has the lowest choice order value.

You can also map multiple workflow states in Jira to a single workflow state in Agile Development 
2.0.

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. From the Jira Projects related list, open a Jira project for which you want to customize the 
choice map configuration.
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4. Open the workflow state map for this project.

a. From the Table Maps related list, click Story.

b. From the Field Maps related list, click Status.

5. From the Choice Maps related list, click New.

6. On the form, fill in the fields.

Choice Map form

Field Description

Internal Choice Value of the workflow state in Agile 
Development 2.0. This value is an integer.

External Choice ID of the workflow transition in Jira.

Note: 
In case there is no transition, insert the 
ID of the workflow state.

External Choice Name Display name of the workflow transition in 
Jira.

Note: 
In case there is no transition, insert the 
display name of the workflow state.

7. Click Update.

What to do next

1. Validate your choice map configuration by clicking Validate and fix mapping  from your project 
form.

2. From the Table maps related list of your project, navigate to your new choice map 
configuration. If the Valid column for your configuration shows:

◦ true, validation of your map configuration is successful.

◦ false, validation of your map configuration failed. Ensure that you enter correct values for all 
fields and validate again.

Apply custom map configuration to multiple Jira projects

Add a custom table or field, which is applicable to all your Jira projects of a specific type, to the 
map configuration template in Agile Development 2.0.

Before you begin

• Discover and import Jira projects and boards.

• Role required: sn_jira_int.user

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.
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3. From the Project Style Mappings related list, select the project template to which you want to 
add the custom field.
For example, if the field that you want to add is applicable to all Jira projects of the type 
Classic, then select classic.

4. Add the custom table or field from Agile Development 2.0  to the existing map configuration in 
the Default Mapping  field.
You can copy the contents of the Default Mapping  field into a JSON viewer to view the 
contents in a format of your preference. For example, as shown in the following figures, you 
can add a new table for Defect [rm_defect] to map the Bug table from Jira or a new field in the 
existing Story [rm_story] table to map story points.

Custom table map for Defects
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Custom field map for Story Points

Custom field map for Multi-select fields

If you're adding a new field, ensure that the custom field configured is added to the default 
screen scheme of the issue.

5. Click Update.

What to do next
Apply the custom project style map to all its related Jira projects.
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1. Delete the existing map configuration of all the imported Jira projects.

You can delete the map configuration of a project by making its Mapping Config  field empty.

Tip: 
From the Jira Projects related list, make a multiple select on the Mapping Config  field of 
all the Jira project records and remove their value, making all these fields empty.

2. If you've created a new table map, create a business rule to apply this new table map 
configuration. See Create a business rule to apply a custom Agile Development 2.0 table map 
configuration.

3. Import these projects from Jira by clicking Discover Projects.

This would import all the Jira projects with their map configuration as per the customized 
project style map.

Create a business rule to apply a custom Agile Development 2.0  table map configuration

Create a business rule to enable export from your new custom Agile Development 2.0  table map 
configuration to your Jira projects.

Before you begin
Role required: admin or sn_jira_int.admin

About this task
After you create a custom table map for a single or multiple Jira projects, create a business rule 
similar to Synch Story with Jira to support export of information from this new table map from 
Agile Development 2.0  to Jira.

Procedure

1. Navigate to All  > System Definition  > Business Rules.

2. From the list of available business rules, locate and open the Synch Story with Jira rule.

3. From the context menu ( ), perform an Insert and Stay operation on this business rule.
If you have not enabled the Insert and Stay  action in your ServiceNow  instance, see Allow 
insert options on records .

4. On the business rule form, edit the following fields.

Business rule form

Field Description

Name Unique name for the business rule.

For example, if your new table map is to map 
defects, name this rule as Sync Defect with 
Jira.

Table Select the Agile Development 2.0  table for 
which you've created the custom map.

For example, Defect [rm_defect].

5. Click Update.
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Allow import and export of attachments on a custom Agile Development 2.0  table

Enable import and export of attachments between Jira and Agile Development 2.0  for a custom 
Agile 2.0 table that you added to the map configuration.

Before you begin
Role required: admin or sn_jira_int.admin

Procedure

1. Navigate to All  > System Definitions  > Business Rules.

2. From the list of business rules, locate and open the Sync Attachment to Jira rule.

3. In the When to run section of the form, include your custom table map by adding it to the filter 
conditions.
For example, if the custom table that you added is Defect, do the following:

a. Click Add "OR" Clause.

b. Set the new clause to Table name  is  rm_defect.

4. Click Update.

Populate Jira project identifier reference fields for Agile Development 2.0  custom table

Enable Jira identifier reference fields for your Agile Development 2.0  custom table that you 
added to the map configuration.

Before you begin
Role required: admin or sn_jira_int.admin

About this task
You can display references of ID, key, Jira project, and the project URL on your custom table form 
by adding this table to the Populate External Identifier Reference business rule.

Procedure

1. Navigate to All  > System Definitions  > Business Rules.

2. From the list of business rules, locate and open the Populate External Identifier Reference rule.

3. In the When to run section of the form, include your custom table map by adding it to the filter 
conditions.
For example, if the custom table that you added is Defect, do the following:

a. Click Add "OR" Clause.

b. Set the new clause to Reference table  is  rm_defect.

4. Click Update.

What to do next
Configure the form layout or personalize the list layout of your custom table to display any or all of 
the following fields.

• External ID

• External Key

• External Project

• External URL
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Related topics

Personalise a v2 list

Configuring the form layout

Reset mapping configuration of Jira projects

Reset the existing mapping configuration for multiple Jira projects to a default mapping 
configuration.

Before you begin

• Discover and import Jira projects and boards

• Role required: sn_jira_int.user

About this task
Apply a default mapping configuration to all or a few Jira projects. Any existing custom mapping 
configuration for these projects will be deleted after you reset the mappings.

If you've cleared the Mapping Config  field or deleted the existing table maps for this project, 
resetting the mappings for this project will restore the mapping configuration to the default 
configuration.

Procedure

1. Navigate to All  > Agile Jira Integration  > Jira Instances.

2. Open your Jira instance record.

3. Reset the mappings of multiple Jira projects using one of the following ways.

Result
The mapping configuration of the projects is updated to as per the Default Mapping  field in the 
Project Style Mappings form that the selected projects belong to.

Importing and exporting issues between Agile Development 2.0  and Jira

Understand the workflow for the import and export of issues between Agile Development 2.0  and 
Jira.

To export and import issues between Agile Development 2.0  and Jira, you must complete the 
team integration settings  for your Jira projects.

Importing to Agile Development 2.0  from Jira

• When you create an issue of type epic in a Jira project, an epic is created for the assignment 
group according to the team integration settings that you configured.

• When you create an issue of type story in a Jira project, a story is created for the assignment 
group according to the team integration settings that you configured.

◦ The relationship between the story and its epic is retained as it is in Jira.

◦ The Assigned To  field in the story displays the user from Jira, only if a user with the same 
email address is found in Agile Development 2.0.

• Only the fields that are defined in the field map are retained in the story or epic. For details 
of the default mapping configuration, see Default mapping configuration between Agile 
Development 2.0 and Jira.
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• When you add an attachment to an issue in Jira, the same attachment is added to the 
corresponding story or epic in Agile Development 2.0.

• When you add comments for an issue in Jira, they are updated in the Work notes  field of the 
story or epic in Agile Development 2.0, based on the map configuration.

Note: 
The images added in the comments appear as attachments.

• When you delete an issue in Jira, the corresponding record is deleted in Agile Development 
2.0.

Note: 
To delete records in Agile Development 2.0, set the Can Delete  field to true  in the 
Application access of the respective tables. For details, see Table design and runtime 
settings .

• When you start a sprint in Jira, a sprint is created for the assignment group in Agile 
Development 2.0, if the Jira board is configured in the team integration settings.

Import workflow for issue 
created in Jira

Import workflow for issue 
updated in Jira

Exporting from Agile Development  to Jira

• When you create an epic for an assignment group, it is exported to the project in Jira according 
to the team integration settings that you configured.

• When you create a story for an assignment group, it is exported to the project in Jira according 
to the team integration settings that you configured.

◦ The relationship between the story and its epic is retained in Jira.

◦ Updates to the Assigned To  field in the ServiceNow  platform is exported to Jira.

• When you add an attachment to a story or an epic, the same attachment is added to the 
corresponding issue in Jira.

• When you add work notes to a story or an epic, they are updated in the corresponding issue in 
Jira as comments.

• When you update the assignment group of an existing story in Agile Development 2.0, the 
issue is recreated in the Jira project that is associated with the updated assignment group.
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• When you create a sprint for an assignment group in Agile Development 2.0, it is exported to 
Jira only if you configured the Jira board in the team integration settings.

Note: 
If your Jira  instance has state transition rules, the export sync from Agile Development 2.0 
to Jira  might fail. For example, if a transition rule in Jira  restricts a story or work item from 
moving directly to a Complete  state without first passing through an In Progress  state, 
and the story is marked Complete  without that intermediate step, the sync fails.

Troubleshooting issues of Jira integration with Agile Development 2.0

Resolve common issues that you might face while working with the integration of Jira and Agile 
Development 2.0.

Issue Action

The export action is not working. • Review your custom map configuration.

If your custom map configuration is invalid or 
if the custom field configured is not added 
to the default screen scheme of the issue, 
export does not work.

• Ensure that the Enable Export  check box is 
selected in the project integration settings 
for this Jira project or board.

• Check if your Jira password has expired.

The sprint is not associated to the imported 
stories.

Verify if the sprint is started in Jira. If the sprint 
that is associated with the stories is a future 
sprint, then it is not associated to the stories in 
Agile Development.

Sprint data from Jira is updated in Agile 
Development  only if the sprint is active in Jira.

The sprint is not imported into Agile 
Development 2.0.

• Ensure that your sprint in Jira has dates.

• Ensure that the dates of a sprint in Jira does 
not overlap with another sprint in the same 
assignment group in Agile Development 2.0.

A value from a field in Jira is not populated in 
Agile Development 2.0.

Verify if the custom field map is configured.

The value of Priority  or State  fields from Jira is 
not populated in Agile Development 2.0.

Verify if the custom workflow state map is 
configured.

An update by a user in Jira is not updated in 
Agile Development 2.0.

Ensure that the user credentials that are used 
to set up the integration of Jira with Agile 
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Issue Action

Development  are not used to perform record 
updates.

The issue is deleted in Jira and not deleted in 
Agile Development 2.0.

Ensure that the Can Delete  field in the 
Application access of the respective tables is 
set to true.

For Jira cloud users, when you import, you see 
duplicate comments.

Verify the cyclic payload. Ensure that the 
privacy settings should be enabled for the 
connection user (used in http connection in 
Agile Development 2.0) to make the Email 
address visible in webhook events.

Deleting a project or board in Jira does not 
result in any action in Agile Development 2.0.

After deleting the project or board in Jira, the 
Jira administrator must manually delete the 
associated stories in the Agile Development 
2.0.

Using rich text in Jira results in garbled text in 
Agile Development 2.0.

The wiki text format that is used in Jira is not 
supported.

For a Next-gen Jira project, when a story 
is created for an epic in Jira, the relation 
between story and epic is not imported to 
Agile Development 2.0.

In Jira, make a nominal update to the story 
which would send the epic relation along with 
this update to the Agile Development 2.0.

Sub tasks information is neither imported nor 
exported between Jira and Agile Development 
2.0.

To enable import of sub tasks from Jira to 
Agile Development 2.0, you must manually 
configure custom mapping for this task type. 
For more information, see Customize your 
table map configuration.

For a Next-gen Jira project, scrum tasks are not 
exported from Agile Development 2.0  to Jira.

The application supports only the import of 
sub tasks from Jira to the Agile Development 
2.0  but not the export of these tasks to Jira.

After discovering and importing projects, map 
configuration is not generated for a project.

Ensure that the user for whom the connection 
alias is created has access to all Jira projects.

The UI actions for Connect, Disconnect, and 
Validate and Fix result in an error when using 
for the first time.

This is a known issue. Retry the UI action.

While fetching Jira project metadata, the 
API call fails in the Flow designer, with a API 
response size exceeded  error.

Reduce the value of the batch size property by 
setting it to any value between 1 and 50. For 
more information, see Define batch size for 
Jira project metadata.

Import Issues are staying in 'Processing' state 
forever.

Import requests are stuck because Reset 
mapping in't working as server type, as it was 
incorrectly set as 'cloud' instead of 'server'. 
Few customers will not setup connection 
attributes, and therefore 'server type' and 
'server verions' are defaulted to 'cloud' and 
'8' respectively. Set guidelines for Jira on-
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Issue Action

prem customers to use proper connection 
attributes.

Bulk importing of work items data fails with a 
API response size exceeded  error.

Reduce the value of MAX_LIMIT  in the 
JiraConstants Script Include and then try to 
bulk import the work items data again.

Enabling detailed project logs

To view all the details on project logging, enable the integration project logging property. For 
more information, see Enable detailed project logging in Jira Integration with Agile Development.

Enable detailed project logging in Jira Integration with Agile Development

Understand how to enable integration project logging in Jira so that you can view details of the 
project logs.

Before you begin
Role required: sn_jira_int.admin (with edit access) or sn_jira_int.user (with read access).

About this task
Enable the project logging property in the Agile Jira Integration application.

Procedure

1. Navigate to All  > Agile Jira Integration  > Properties.

2. Click the Enable Integration Project Logging  check box.

Agile Jira Integration Properties

3. Click Save.
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Define batch size for Jira project metadata

Define a batch size value that is used to fetch the metadata from the Jira projects.

Before you begin
Role required: sn_jira_int.admin (with edit access) or sn_jira_int.user (with read access).

About this task
Reduce the value of the batch size property to resolve the API response size exceeded  error that 
you might get while fetching Jira project metadata.

Procedure

1. Navigate to All  > Agile Jira Integration  > Properties.

2. Modify the Define the batch size for fetching Jira project metadata  field value to a value less 
than 50.
The suggested value range is 5–50.

3. Click Save.

Microsoft Azure  DevOps Integration for Agile Development

Enable bidirectional synchronization of work items between Microsoft Azure  DevOps and 
ServiceNow®  Agile Development 2.0  by integrating the two applications.

For example, if you update a record in Microsoft Azure  DevOps, the update is reflected in Agile 
Development 2.0. Similarly, if you update a record in Agile Development 2.0, the update is 
reflected in Microsoft Azure  DevOps.

The Integration of Microsoft Azure  DevOps with Agile Development  enables you to do the 
following:

• View available Microsoft Azure  DevOps projects in Agile Development.

• Perform a bulk import of records from Microsoft Azure  DevOps to Agile Development 2.0.

• Perform single record updates between Microsoft Azure  DevOps and Agile Development 2.0.

• Avoid duplicating record update entries in Microsoft Azure  DevOps and Agile Development 
2.0.

• Plan, track, and update your tasks from a single application.

Starting with version 1.3, Microsoft Azure  DevOps Integration for Agile Development  supports 
process-level map configuration enabling you to configure multiple processes to be 
synchronized with Agile Development 2.0.

Request apps on the Store

Visit the ServiceNow Store  website to view all the available apps and for information about 
submitting requests to the store. For cumulative release notes information for all released apps, 
see the ServiceNow Store  version history release notes .

Components installed with Microsoft Azure  DevOps integration for Agile Development

Several types of components are installed with activation of the Microsoft Azure  DevOps 
integration for Agile Development  application, including user roles, scheduled jobs, and tables.
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Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description Contains roles

Azure DevOps 
integration admin

[sn_ado_int.admin]

Has complete access to the application • sn_int_common.admin

• sn_ado_int.user

Azure DevOps 
integration user

[sn_ado_int.user]

• Sets up integration between Azure DevOps 
and Agile Development

• Can create new or update the existing map 
configurations between Azure DevOps and 
Agile Development

• connection_admin

• sn_int_common.user

• credential_admin

Scheduled jobs installed

Scheduled job Description

Discover Azure Project Job Discovers new Azure DevOps projects at a scheduled time 
and imports them automatically.

Import Azure DevOps Teams 
Areas and Iterations

Imports teams, areas, and iterations from Azure DevOps 
automatically at a scheduled time.

Import Azure DevOps Work 
Items

Imports work items from Azure DevOps automatically at a 
scheduled time.

All the scheduled jobs are inactive by default. For more information, see Schedule jobs to import 
projects, teams, areas, and work items from Azure DevOps.

Tables installed

Table Description

Area Team M2M

[sn_ado_int_m2m_area_team]

Stores the relationship between teams and areas.

Attachment Map

[sn_int_common_attachment_map]

Stores the mapping of attachments to issues 
between Azure DevOps and Agile Development.

Azure DevOps Area

[sn_ado_int_area]

Stores the list of imported areas from Azure 
DevOps.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2047

https://www.servicenow.com/docs/access?context=find-components&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=find-components&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=find-components&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=find-components&version=zurich&pubname=zurich-platform-administration&ft:locale=en-US


Table Description

Azure DevOps Import Request

[sn_ado_int_import_request]

Stores the list of all import requests created to 
import projects and process mappings from Azure 
DevOps.

Azure DevOps Instance

[sn_ado_int_instance]

Stores the list of all Azure DevOps instances.

Azure DevOps Iteration

[sn_ado_int_iteration]

Stores the list of imported iterations from Azure 
DevOps.

Azure DevOps project

[sn_ado_int_project]

Stores the list of imported projects from Azure 
DevOps.

Azure DevOps Subscriptions

[sn_ado_int_subscription]

Stores the subscription IDs of the event type for 
the webhooks registered in Azure.

Azure DevOps Team

[sn_ado_int_team]

Stores the list of imported Azure DevOps teams.

Choice Map

[sn_int_common_choice_map]

Stores the list of workflow state mapping for Azure 
DevOps projects.

Event Type

[sn_int_common_input_event_type]

Stores information of the type of webhook events 
such as creating, updating, or deleting a work 
item.

External Identifiers

[sn_int_common_external_identifiers]

Stores the list of all Azure DevOps reference 
identifiers such as External ID, External Key, 
External Project, External URL, and so on.

External Project

[sn_int_common_project]

Stores information of the Azure DevOps project 
such as project ID, the Azure DevOps instance of 
this project, project name, and so on.

External System

[sn_int_common_external_system]

Stores information of the Azure DevOps 
application used for the integration.

External System Version

[sn_int_common_external_system_version]

Stores the API version information of the Azure 
DevOps application used for the integration.

Field Map

[sn_int_common_field_map]

Stores the list of field mapping of different work 
items for Azure DevOps projects.

Process Mapping

[sn_ado_int_process_mapping]

Stores the list of map configuration templates per 
Azure DevOps process.

Table Map Stores the list of table maps for Azure DevOps 
projects.
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Table Description

[sn_int_common_table_map]

Team Integration Settings

[sn_agile_ado_int_import_settings]

Stores the list of one-to-one relation between 
Azure DevOps project, team, and an Agile 
assignment group.

Webhook Registry

[sn_int_common_webhook_registry]

Stores details of the registry callback path for 
webhooks registered in Azure DevOps to receive 
event updates.

Setting up the integration between Microsoft Azure DevOps  and Agile Development 2.0

Understand the setup process of Microsoft Azure DevOps  Integration for Agile Development 2.0.

After you have the application installed in your ServiceNow  instance, you can proceed to set up 
the integration, using the sn_ado_int.user role.

The setup process for the integration includes the following tasks:

1. Connect Agile Development 2.0  with Azure DevOps.

2. Discover and import available projects from Azure DevOps.

3. Import area, teams, and iterations into Agile Development 2.0  from Azure DevOps.

4. Set up the import and export between Agile Development 2.0  and Azure DevOps.

a. Register webhooks for an Azure DevOps  project.

b. Associate Azure DevOps projects with assignment groups in Agile Development 2.0.

5. Bulk import work items and iterations into Agile Development 2.0. Enable a scheduled job to 
auto-import issues from Azure DevOps.

6. Create custom map configurations for tables, fields, and workflow states between Azure 
DevOps and Agile Development 2.0.

Connecting Agile Development 2.0  and Azure DevOps

Establish a connection between Agile Development 2.0  and Azure DevOps using a connection 
alias and an Azure DevOps  instance.

Create an Azure DevOps  connection alias

Create a Basic Auth credential and an HTTP(s) connection which will together be used as a 
connection alias to establish a connection with Azure DevOps.

Before you begin
Roles required:

• admin to create a connection and credential alias

• sn_ado_int.admin or sn_ado_int.user to create basic authorization credentials and HTTP(s) 
connection

Procedure

1. Create a Connection & Credential alias

◦ A connection alias (sn_ado_int.Azure_DevOps) is available by default.

◦ You must create a connection alias for every Azure DevOps organization that you use.

2. Use OAuth 2.0 or Basic Auth to create credentials.
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◦ OAuth 2.0: See Set up the Microsoft Azure DevOps Boards spoke using OAuth .

Important: 
Make sure to specify a username in the OAuth 2.0 Credentials [oauth_2_0_credentials] 
table for the Credential Alias record. This username must correspond to the service 
account used to interact with Azure DevOps.

◦ Basic Authentication: See Basic authentication credentials .

Note: 
When creating Basic Auth credentials, use the details of your personal access token in 
Azure DevOps.

▪ Set the Password  field of the basic authentication credential as the personal access 
token in Azure DevOps.

▪ Set the User Name  field of the basic authentication credential as the username used 
to create the personal access token in Azure DevOps.

If your login is in the format of domainname\username, use only the username.

3. Create Create an HTTP(s) connection .

What to do next
Create an Azure DevOps instance

.

Create an Azure DevOps  instance

Create an Azure DevOps  instance record using the connection alias that you created. This 
instance is used to establish an integration between Agile Development 2.0  and Azure DevOps.

Before you begin
Role required: sn_ado_int.admin or sn_ado_int.user

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Click New.

3. On the form, fill in the fields.

Azure DevOps  Instance form

Field Description

Name Name of the Azure DevOps  instance. Enter a 
name of your choice.

Connection Alias Azure DevOps  connection alias that you 

already created. Use the lookup ( ) option 
to select your connection alias.

Version Azure DevOps  version. Use the lookup ( ) 
option to select your Azure DevOps  version.

4. Click Submit.
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What to do next
Connect to Azure DevOps

.

Connect to Azure DevOps

Connect Azure DevOps  with Agile Development 2.0  to enable the integration.

Before you begin
Role required: sn_ado_int.user

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps  instance record.

3. Click Connect.

Result
If the State  field on the Azure DevOps  Instance record shows:

• Connected, the connection is successful.

• Not connected, the connection could not be established. You can view the reason for the 
failure in the error message.

What to do next
Discover and import Azure DevOps projects

.

Discover and import Azure DevOps  projects

Discover and import all available Azure DevOps  projects into Agile Development 2.0  to start 
using the integration between the two applications.

Before you begin

• Complete connecting Agile Development  and Azure DevOps.

• Role required: sn_ado_int.user

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps  instance record.

3. Click Discover Projects.

This action creates requests to import Azure DevOps  projects and process map configuration 
for all these projects. You can view all import requests in the Azure DevOps Import Requests 
related list. The initial state of these requests is Requested.

Result
Once the status of each import request changes to Complete, you can see that the related lists 
of this Azure DevOps  instance are populated as follows:

• Azure DevOps  Projects: All available projects from Azure DevOps

• Process Mappings: Map configuration for all the imported Azure DevOps  projects according to 
the process type.
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For example, default process types such as Agile, Basic, and CMMI or any custom process 
types that you defined for your Azure DevOps  projects.

For more information on the default map configuration of work items, see Default map 
configuration for Azure DevOps integration with Agile Development 2.0.

What to do next
Import areas, teams, and iterations from Azure DevOps

.

Default map configuration for Azure DevOps  integration with Agile Development 2.0

Understand the default field map configuration, of different process types, between Azure 
DevOps  and Agile Development 2.0.

By looking at the default map configuration for different process types, you can see how work 
item types in Azure DevOps  are mapped in Agile Development. You can also see how fields are 
mapped between the two applications.

When you import available epics, stories, and issues from Azure DevOps, this data is stored in 
tables as defined in the process map configuration.

Note: 

When you upgrade to version 1.3 of the application, map configuration is generated at the 
process level per process type and not at the instance level. You must update any custom 
maps that you previously configured to ensure that the import and export of work items is 
not impacted.

Here's how you can view the default map configuration for different process types.

1. Navigate to Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps  instance record.

3. From the Process Mappings related list, open the record for a process map.

You can add or update the configuration for field, table, and choice maps between Azure DevOps 
and Agile Development 2.0. For details, see Customizing your map configuration for Azure 
DevOps integration.

The following are the details of the default map configuration for various process types in Azure 
DevOps.

Default mapping for Agile process

Default mapping configuration for Agile Process

Table in Azure DevOps Table in Agile Development 2.0

User Story Story [rm_story]

Epic Epic [rm_epic]

Feature Feature [ sn_safe_feature]
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Default mapping for Basic process

Default mapping configuration for Basic process

Table in Azure DevOps Table in Agile Development 2.0

Issue Story [rm_story]

Epic Epic [rm_epic]

Default mapping for CMMI process

Default mapping configuration for CMMI process

Table in Azure DevOps Table in Agile Development 2.0

Epic Epic [rm_epic]

Requirement Story [rm_story]

Default mapping for Scrum process

Default mapping configuration for Scrum process

Table in Azure DevOps Table in Agile Development 2.0

Product Backlog Item Story [rm_story]

Epic Epic [rm_epic]

Import areas, teams, and iterations from Azure DevOps

Import areas, teams, and iterations of your Azure DevOps  projects. These details are used to 
import sprint data and associate your Azure DevOps projects with assignment groups in Agile 
Development 2.0.

Before you begin

• Discover and import Azure DevOps projects.

• Role required: sn_ado_int.user

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps  instance record.

3. From the Azure DevOps Projects releated list, open a project record.

4. Click Import Areas, Iterations and Teams.

Details of your import requests are available in the Azure DevOps Import Requests related list.

You can view all the imported teams, iterations, and areas in the Azure DevOps Teams, Azure 
DevOps Iterations, and Azure DevOps Areas related lists of this project.

What to do next
Setting up import and export between Azure DevOps and Agile Development 2.0

.
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Setting up import and export between Azure DevOps  and Agile Development 2.0

Configure the settings for the import and export actions of work items between Agile 
Development 2.0  and Azure DevOps.

To enable synchronization of work items, register webhooks for your Azure DevOps  projects and 
associate your Azure DevOps  projects and teams with assignment groups in Agile Development 
2.0.

Register webhooks for an Azure DevOps  project

Register webhooks to subscribe to the events from your Azure DevOps  projects to Agile 
Development 2.0.

Before you begin

• Discover and import Azure DevOps projects.

• Role required: sn_ado_int.user

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps instance record.

3. From Azure DevOps Projects related list, open your project record.

4. Click Register Webhooks.
If the webhook registration is successful, the State  field in the project form changes from Not 
Registered  to Registered.

Result
When you register webhooks in Azure DevOps,it receives the following event updates between 
Azure DevOps and Agile Development 2.0.

• Create a work item

• Update a work item

• Delete a work item

• Restore a work item

• Comment on a work item

For more information on synchronization of work items according to these webhook events, see 
Importing and exporting work items between Agile Development and Azure DevOps.

What to do next
Associate Azure DevOps projects with assignment groups in Agile Development 2.0

.

Associate Azure DevOps projects with assignment groups in Agile Development 2.0

Associate your Azure DevOps projects and teams with assignment groups in Agile Development 
2.0  to enable import and export of issues between the two applications.

Before you begin

• Import areas, teams, and iterations from Azure DevOps.

• Create assignment groups in Agile Development. See Create an assignment group in Agile 
Development 2.0.

• Role required: sn_ado_int.user
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About this task
After you associate an Azure DevOps team with an assignment group, you can:

• Import all available stories and epics of this team into the associated group.

• View any new stories and epics or updates made to the existing stories and epics in both Agile 
Development 2.0  and Azure DevOps.

• Import iterations as sprints in Agile Development 2.0.

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Team Integration Settings.

2. Click New.

3. In the Team Integration Settings form, select:

◦ An Azure DevOps project.

◦ A team of your Azure DevOps project.

◦ An assignment group in Agile Development 2.0  with which you want to associate the 
selected Azure DevOps team.

The value of the Default Area  field is filled automatically depending on the selected team.

Note: 
If a Default Area  value is already used for a Team Integration Settings record, then it 
cannot be used for another Team Integration Settings record because Backlog in Agile 
Development 2.0  can't be shared among multiple assignment groups.

Stories or epics that don't have an Assignment group in Agile Development 2.0  will not be 
synced with Azure DevOps. This is because values from the Team Integration Setting record 
are used determine which ADO project a story or epic in Agile Development 2.0  belongs to.

4. Click Submit.
You can view the details of your settings in the Team Integration Settings in the Azure DevOps 
Project form.

Note: 
You can associate an assignment group with only one Azure DevOps team.

What to do next
Import work items from Azure DevOps to Agile Development 2.0

.

Related topics

Importing and exporting work items between Agile Development and Azure DevOps

Import work items from Azure DevOps to Agile Development 2.0

Import work items and iterations of an Azure DevOps project into Agile Development  to track and 
update the status of your work.

Before you begin

• Set up team integration settings for your Azure DevOps projects. For more information, see 
Associate Azure DevOps projects with assignment groups in Agile Development 2.0.

• Role required: sn_ado_int.user
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Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps instance record.

3. From the Azure DevOps Projects related list, open a project record.

4. Enable import and export of work items by selecting the Enable Workitems Import  and Enable 
Workitems Export  options.

5. Enable synchronization of sprint data by selecting the Sync Sprints  option.

6. Click Import Work Items.

7. Select a date and time range.

8. Click Submit.

Note: 
The bulk import action doesn’t import the Description  and Acceptance criteria  fields. 
However, if there’s an update on these records in Azure DevOps after the import is done, 
these fields are synced in Agile through webhook events.

Details of your import requests are available in the Azure DevOps Import Requests related list.

You can view all the imported work items and sprints in the Agile Development  application.

◦ The relationship between the stories and epics stays as it is in Azure DevOps.

The Assigned to  field of the story is set to the user based on the user's email address, which 
must be unique per user account.

◦ The mapping of states of an iteration in Azure DevOps to sprints in Agile Development  is as 
follows:

State in Azure DevOps State in Agile Development 2.0

Past Completed

Future Draft

Current Current

◦ Sprints are not created in Agile Development 2.0  for the following conditions:

▪ If the date fields of the iteration in Azure DevOps are empty.

▪ If the iteration has a child iteration associated to it.

▪ If the sprints have overlapping dates.

◦ If two or more teams share a backlog iteration in Azure DevOps, a separate sprint record for 
each team is created in Agile Development 2.0.

What to do next
Schedule jobs to import projects, teams, areas, and work items from Azure DevOps

.

Schedule jobs to import projects, teams, areas, and work items from Azure DevOps

Schedule jobs to automatically import new projects, teams, areas, work items, and sprints 
periodically from Azure DevOps into Agile Development 2.0.
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Before you begin
Role required: admin

About this task
If you do not configure the scheduled job, you must manually discover projects and import areas 
and teams.

Procedure

1. Navigate to All  > System Definition  > Scheduled Jobs.

2. Open one of the following jobs:

◦ Discover Azure Project Job

◦ Import Azure DevOps Teams Areas and Iterations

◦ Import Azure DevOps Work Items

These jobs are inactive by default.

3. To execute the job manually, click Execute Now.

4. To run the job at a scheduled time, select the Active check box.
You can edit the details of the Run  and Time  fields according to your preference.

5. Click Update.

6. Repeat the procedure for the other two scheduled jobs.

Customizing your map configuration for Azure DevOps integration

Customize the table, field, or state map configuration between Azure DevOps and Agile 
Development 2.0  according to your organizational preferences.

• Any modifications that you do to the existing map configuration of the process types would 
apply to all the Azure DevOps projects that use this process map.

• Only fields of type number, select, text, date, identity, date, date time, and reference are 
supported for custom map configuration.

Customize your table map configuration

Configure table maps between tasks, iterations, and work areas of Azure DevOps and tables in 
Agile Development 2.0  and configure its fields for Azure DevOps projects of a process type.

Before you begin

• Discover and import Azure DevOps projects.

• Role required: sn_ado_int.user

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps instance record.

3. From the Process Mapping related list, open a process map for which you want to customize 
the map configuration.

4. From the Table maps related list, click New.

5. On the form, fill in the fields.
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Table Map form

Field Description

Internal Table Name of the table in Agile Development 2.0.

External Table Table ID in Azure DevOps.

External Table Name Display name of the table in Azure DevOps.

6. Save the table configuration.

7. From the Field Maps related list of your table map record, create new field maps to map the 
following fields.

Field in Azure DevOps Field in Agile Development

Title of the work item Short description

For information on how to configure field mapping for a table, see Customize your field map 
configuration. You can also create other field maps for your new table configuration.

What to do next

1. Validate your new table map configuration by clicking Validate and fix mapping  from your 
process map form.

2. In the Table maps related list, if the Valid column of your configuration shows:

◦ true, validation of your map configuration is successful.

◦ false, validation of your map configuration failed. Ensure that you enter correct values for all 
fields and validate again.

3. Create a business rule to support export of this new table map configuration to Azure DevOps. 
For more information, see Create a business rule to apply a custom table map configuration.

Customize your field map configuration

Create a custom field map configuration to map a field in an Agile Development 2.0  table for 
Azure DevOps projects of a process type.

Before you begin

• Discover and import Azure DevOps projects.

• Role required: sn_ado_int.user

About this task
The following field types are supported for custom field map configuration:

• Number

• Select

• Text

• Date

• Identity

• Date time
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• Reference

• List

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps instance record.

3. From the Process Mapping related list, open a process map for which you want to customize 
the map configuration.

4. From the Table maps related list, open a record to create a field map configuration for that table 
map.

5. From the Field Maps relates list, click New.

6. On the form, fill in the fields.

Field Map form

Field Description

Internal Field Field name in Agile Development 2.0.

Lookup Column Name
This field is required when you select a 
reference field as the internal field.

For more information, see Configuring a 
reference field in Azure DevOps.

Table Map Table map in Agile Development 2.0, in which 
this field is created.

This field is auto-populated based on the 
table map record you select.

External Field Field ID in Azure DevOps.

External Field Name Display name of the field in Azure DevOps.

7. Click Submit.

What to do next

1. Validate your new table map configuration by clicking Validate and fix mapping  from your 
process map form.

2. From the Table maps related list, navigate to your new field map configuration. If the Valid 
column of your configuration shows:

◦ true, validation of your map configuration is successful.

◦ false, validation of your map configuration failed. Ensure that you enter the correct values for 
all fields and validate again.

Important: 
If your custom map configuration is invalid or if the required fields are not mapped for that 
work item, the export and import action does not work.
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Configuring a reference field in Azure DevOps

Understand how to configure a reference field while creating a new field map configuration.

When you select a reference field for the Internal Field  field, you must select a value for the 
Lookup Column Name  field. The value from the Lookup Column Name  field is used during the 
import and export of work items between Azure DevOps and Agile Development 2.0.

During import, the integration application searches for the record in the reference table using the 
Lookup Column Name  field. If the record is not found, the value in the work item will be empty in 
Agile Development 2.0.

Customize your state map configuration

Create a custom state map for a field of an Agile Development 2.0  table to map the workflow 
states of your preference for Azure DevOps projects of a process type.

Before you begin

• Discover and import Azure DevOps projects.

• Role required: sn_ado_int.user

About this task
You can map a state in Azure DevOps to multiple states in Agile Development 2.0. In such cases, 
the state in Agile Development 2.0  for an issue type depends on the choice order value that you 
provide for this state configuration.

For example, when an work item from Azure DevOps that is in the Active  state imported, the 
State  field in Agile Development 2.0  is set to Work in progress  as it has the lowest choice order 
value.

You can also map multiple states in Azure DevOps to a single state in Agile Development 2.0.

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps instance record.

3. From the Process Mapping related list, open a process map for which you want to customize 
the choice map configuration.

4. Open the workflow state map for this process type.

a. From the Table Maps related list, click User Story.

b. From the Field Maps related list, click state.

5. From the Choice maps related list, click New.

6. On the form, fill in the fields.

Choice Map form

Field Description

Internal Choice Value of the state in Agile Development 2.0. 
This value is an integer.

External Choice Name of the state in Azure DevOps.
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Field Description

External Choice Name Display name of the state in Azure DevOps.

7. Click Submit.

What to do next

1. Validate your new table map configuration by clicking Validate and fix mapping  from your 
process map form.

2. Navigate to your new choice map configuration. If the Valid column of your configuration 
shows:

◦ true, validation of your map configuration is successful.

◦ false, validation of your map configuration failed. Ensure that you enter the correct values for 
all fields and validate again.

Create a business rule to apply a custom table map configuration

Create a business rule to enable export from your new custom map configuration of an Agile 
Development 2.0  table to your Azure DevOps projects.

Before you begin
Role required: admin

About this task
After you create a custom table map for an Azure DevOps process type, create a business rule 
similar to Synch Story with Azure DevOps to support export of information using this new table 
map to Azure DevOps.

Procedure

1. Navigate to All  > System Definition  > Business Rules.

2. From the list of available business rules, locate and open the Synch Story with Azure DevOps 
rule.

3. From the context menu ( ), perform an Insert and Stay operation on this business rule.
If you have not enabled the Insert and Stay  action in your ServiceNow  instance, see Allow 
insert options on records .

4. On the business rule form, edit the following fields.

Business rule form

Field Description

Name Unique name for the business rule.

For example, if your new table map is to map 
defects, name this rule as Sync Defect with 
Azure DevOps.

Table Select the table in Agile Development 2.0  for 
which you've created the custom map.

For example, Defect [rm_defect].

5. Click Update.
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Allow import and export of attachments on a custom table

Enable import and export of attachments between Azure DevOps and Agile Development 2.0  for 
a custom table that you added to the map configuration of a process type.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Definitions  > Business Rules.

2. From the list of business rules, locate and open the Sync Attachment to Azure rule.

3. In the When to run section of the form, include your custom table map by adding it to the filter 
conditions.
For example, if the custom table that you added is Defect, do the following:

a. Click Add "OR" Clause.

b. Set the new clause to Table name  is  rm_defect.

4. Click Update.

Populate Azure DevOps identifier reference fields for a custom table

Enable Azure DevOps project identifier reference fields for an Agile Development 2.0  table that 
you added to the map configuration of a process type.

Before you begin
Role required: admin

About this task
You can display references of ID, key, Azure DevOps project, and the project URL on your custom 
table form by adding this table to the Populate External Identifier Reference business rule.

Procedure

1. Navigate to All  > System Definitions  > Business Rules.

2. From the list of business rules, locate and open the Set external URL for Work Items rule.

3. In the When to run section of the form, include your custom table map by adding it to the filter 
conditions.
For example, if the custom table that you added is Defect, do the following:

a. Click Add "OR" Clause.

b. Set the new clause to Reference table  is  rm_defect.

4. Click Update.

What to do next
Configure the form layout or personalize the list layout of your custom table to display any or all of 
the following fields.

• External ID

• External Key

• External Project

• External URL
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Related topics

Personalise a v2 list

Configuring the form layout

Configuring Azure DevOps integration with SAFe

Understand how to set up Microsoft Azure DevOps integration with SAFe  in your ServiceNow 
instance.

1. Identify the process in Azure DevOps that maps to SAFe.

From the Process Mappings related list of your Azure DevOps instance record, identify the 
process that maps to SAFe  configuration.

If the Process Mappings related list is empty, discover Azure DevOps projects  and try again.

2. Update the map configuration to import SAFe  entities.

For information on how to create a table, field, and workflow state mapping for SAFe  entities, 
see Customizing your map configuration for Azure DevOps integration.

3. See Configuring Azure DevOps projects for SAFe.

Configuring Azure DevOps projects for SAFe

Set up SAFe related configuration in Azure DevOps projects and understand the workflow of 
SAFe  PI and Sprint integration with Azure DevOps.

After creating map configuration for SAFe  entities, import areas, teams, and iterations  for your 
Azure DevOps projects and update the following fields. These fields are mandatory if Sync 
Sprints  is set to true.

• ART: Select an agile release train (ART).

• ART Iteration Path: Select an iteration that is an equivalent to the parent of PI.

Note: 
If the ART Iteration Path lookup ( ) does not return any records, import areas, teams, 
and iterations from Azure DevOps  and try again.

For the example shown in the following screenshot, Fabrikam  must be selected as the ART 
Iteration path.

The application will then automatically identify PI 1 as the program increment and Sprint 1, Sprint 
2, and so on, as the corresponding SAFe  sprints in the ServiceNow  instance.
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Important: 

• To create team integration settings  for a project, the SAFe  teams must be a part of the 
project's ART.

• All teams of an ART must share the same sprint cycle.
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SAFe  sprint and PI integration workflow
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Troubleshooting issues of Azure DevOps integration with SAFe

Resolve common issues that you might face while working with the integration of Azure DevOps 
and SAFe.

Issue Action

The ART  and ART Iteration Path  fields are not 
displayed in the Azure DevOps project form.

Ensure that table mapping exists for SAFe 
stories.

Sprint is not imported from Azure DevOps to 
SAFe.

• Check the state of the sprints. Sprints of 
only the states Future and Current are 
imported.

• Ensure that there are no overlapping sprints.

PI is not imported from Azure DevOps to SAFe. • Ensure that there are no overlapping PIs.

• Ensure that the correct ART Iteration Path is 
selected in the Azure DevOps project form.

The error message Ensure that the 
selected assignment group 
belongs to the ART and try 
again  is displayed in the Azure DevOps 
project form.

The assignment groups in all the team 
integration settings of this Azure DevOps 
project must be the SAFe  teams that belong to 
the ART selected for this project.

If not, add these SAFe  teams to the ART and 
proceed to create team integration settings 
using these SAFe teams as assignment 
groups.

Sprints are not linked with SAFe  features Features can be linked to the PI but not with 
the sprints, as it's not supported in SAFe. 
Select the PI iteration path in the feature in the 
Azure DevOps portal, which should link the 
feature to the PI in SAFe.

Related topics

Troubleshooting issues for Azure DevOps integration with Agile Development

Generate a default map configuration between Azure DevOps and Agile Development 2.0

Generate a default mapping for an Azure DevOps process type if you want to reset the existing 
map configuration.

Before you begin

• Discover and import Azure DevOps projects.

• Role required: sn_ado_int.user

About this task
You can restore the default map configuration of an Azure DevOps process type by deleting the 
existing table maps and then creating mappings for this process type.
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When you import available work items such as epics and stories from Azure DevOps, this data is 
stored in tables as defined in the map configuration of the project's process type.

If the table map does not exist for a work item in your Azure DevOps process, this work item 
cannot be imported and exported between Azure DevOps and Agile Development 2.0.

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Azure DevOps Instances.

2. Open your Azure DevOps instance record.

3. From the Process Mapping related list, open a process map for which you want to generate the 
default map configuration.

4. Click Create Mappings.

Note: 
If a table maps already exist for this process, the Create Mappings  button is not 
displayed.

A request of the type Create Mappings is created and is visible in the Azure DevOps Import 
Requests related list of your Azure DevOps instance.

Result
Once the state of the Create mappings request changes to Completed, you can see that the 
Mapping Config  field of this Azure DevOps process is populated. Also, you can see the default 
map configuration in the Table Maps related list of this process.

Related topics

Customizing your map configuration for Azure DevOps integration

Importing and exporting work items between Agile Development  and Azure DevOps

Understand the workflow for the import and export of work items between Agile Development 
and Azure DevOps.

To enable import and export of work items between Agile Development 2.0  and Azure DevOps, 
you must configure the settings.

Importing to Agile Development 2.0  from Azure DevOps

• When you create a work item of type epic in Azure DevOps, an epic is created for the 
assignment group according to the team integration settings that you configured.

• When you create a work item of type story in Azure DevOps, a story is created for the 
assignment group according to the team integration settings that you configured.

The relationship between the story and its epic is retained as it is in Azure DevOps.

• Only the fields that are defined in the field map configuration are retained in the story or 
epic. For the details of the default map configuration, see Default map configuration for Azure 
DevOps integration with Agile Development 2.0.

• When you add an attachment to a work item in Azure DevOps, the same attachment is added 
to the corresponding story or epic in Agile Development 2.0.

• Any new iterations created in Azure DevOps do not create a corresponding sprint record in 
Agile Development 2.0  immediately.
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When a work item is added for the first time to the new iteration in Azure DevOps, only then a 
corresponding sprint record is created in Agile Development 2.0. To ensure consistent data 
across the two applications at all times, create sprints in Agile Development 2.0.

• Only leaf level iterations are retained as sprints in Agile Development 2.0.

• When you add comments for an issue in Azure DevOps, they are updated in the Work notes 
field of the story or epic in Agile Development, based on the map configuration.

Note: 
The images added in the comments are not supported.

• When you delete a work item in Azure DevOps, the corresponding record is deleted in Agile 
Development 2.0.

• When you delete an iteration in Azure DevOps, the corresponding sprint is deleted in the Agile 
Development 2.0.

Note: 
To delete records in the Agile Development 2.0, set the Can Delete  field to true  in the 
Application access of the respective tables. For details, see Table design and runtime 
settings .

• When you restore a work item from recycle bin in Azure DevOps, a corresponding record is 
created in Agile Development 2.0  according to its team integration settings.

Import workflow for work items created in Azure DevOps
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Import workflow for areas updated in Azure DevOps

Exporting from Agile Development  to Azure DevOps

• When you create an epic for an assignment group, it is exported as a work item to the area in 
Azure DevOps according to the team integration settings that you configured.

• When you create a story for an assignment group, it is exported as a work item to the area in 
Azure DevOps according to the team integration settings that you configured.

The relationship between the story and its epic is retained in Azure DevOps.

• When you add an attachment to a story or an epic, the same attachment is added to the 
corresponding work item in Azure DevOps.

• When you update the assignment group of an existing story in the Agile Development 2.0, 
the work item is recreated for the Azure DevOps area that is associated with the updated 
assignment group.

• When you create a sprint for an assignment group in Agile Development 2.0, it is exported to 
Azure DevOps under its backlog iteration as per the team integration settings.

• When you delete a sprint for an assignment group in Agile Development 2.0, it unlinks the 
sprint selection from the team's iteration in Azure DevOps.

• When you update a work item in Agile Development 2.0, only the fields that are updated are 
sent to Azure DevOps as a part of the payload
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Export workflow for assignment groups updated in Agile Development 2.0

Sync sprint details between Agile Development 2.0  and Azure DevOps

Sync sprint details from Agile Development 2.0  to Azure Devops. Any change in the sprint details 
in Agile Development 2.0  is exported to Iteration paths in Azure DevOps, when the Sync sprint 
field is checked.

Sync Sprint details for a new work item in Agile Development 2.0

Sync Sprint Export Import

Disabled (Iteration path 
available in Azure Devops)

Sends the default iteration 
path for the project to Azure 
DevOps.

Sprint value does not change 
in Agile Development 2.0.

Disabled (Iteration path is not 
available in Azure Devops)

Sends the default iteration 
path for the project to Azure 
DevOps.

Sprint value does not change 
in Agile Development 2.0.

Enabled (Iteration path is 
available in Azure Devops)

Sends the appropriate 
iteration path for the project to 
Azure DevOps.

Sprint value does not change 
in Agile Development 2.0.

Enabled (Iteration path is not 
available in Azure Devops)

Sends the default iteration 
path for the project to Azure 
DevOps.

Sprint value clears in Agile 
Development 2.0.

Sync sprint details for an existing work item in Agile Development 2.0

Sync sprint Export Import

Disabled Sends the previous iteration 
path to Azure. Iteration path 
will be same in Azure DevOps.

Sprint value in Agile 
Development 2.0  is selected.

Enabled Sends the new iteration 
path based on the selection. 
Iteration will be changed 
based on selection.

Sprint value in Agile 
Development 2.0  is selected.
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Troubleshooting issues for Azure DevOps integration with Agile Development

Resolve common issues that you might face while working with the integration of Azure DevOps 
and Agile Development 2.0.

Issue Action

The export action is not working. • Review your custom map configuration.

If your custom map configuration is invalid or 
if the required fields are not mapped for that 
work item, export does not work.

• Ensure that the Enable Export  check box is 
selected for the project.

• Check to see if your Azure DevOps 
password has expired.

Sprint is not imported from Azure DevOps to 
Agile Development 2.0.

Sprints are not imported to Agile Development 
2.0  for one of the following reasons:

• Any new iterations created in Azure DevOps 
do not create a corresponding sprint record 
in Agile Development 2.0  immediately.

When a work item is added for the first 
time to the new iteration in Azure DevOps, 
only then a corresponding sprint record is 
created in Agile Development 2.0.

To ensure consistent data across the two 
applications at all times, create sprints in 
Agile Development 2.0.

• Ensure that there are no overlapping sprints.

An assignment group is not populated for a 
story or an epic.

If the team is not associated with an 
assignment group in Agile Development 2.0, 
it can result in assignment group not being 
populated. Verify that project integration 
settings exist for your Azure DevOps team.

If the area of a work item is mapped to multiple 
teams, the assignment group for that work 
item in Agile Development 2.0  is empty. In 
such cases, you can manually select an 
assignment group for this work item.

A value from a field in Azure DevOps is not 
populated in Agile Development 2.0.

Verify if the custom field map is configured.
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Issue Action

The value of Priority  or State  fields from 
Azure DevOps is not populated in Agile 
Development 2.0.

Verify if the custom state map is configured.

An update by a user in Azure DevOps is not 
updated in Agile Development 2.0.

Ensure that the user credentials that are used 
to set up the integration of Azure DevOps with 
Agile Development 2.0  are not used to perform 
record updates.

The work item is deleted in Azure DevOps but 
not deleted in Agile Development 2.0.

Ensure that the Can Delete  field in the 
Application access of the respective tables is 
set to true.

For details, see Table design and runtime 
settings .

Deleting a project, team, or area does not 
result in any action in Agile Development 2.0.

After deleting the project, team, or area 
in Azure DevOps, the Azure DevOps 
administrator must manually delete the 
corresponding Azure DevOps project and its 
associated stories in Agile Development 2.0.

New Azure DevOps projects are not imported 
automatically.

Manually discover projects from the Azure 
DevOps instance record to immediately synch 
the project updates or schedule a job to 
discover and import these updates on a daily 
basis.

For more details on the scheduled jobs, see 
Schedule jobs to import projects, teams, 
areas, and work items from Azure DevOps.

Imported work items (epics and stories) of a 
project have no assignment group associated 
with them.

Ensure that you have team integration settings 
for this project. For more information, see 
Associate Azure DevOps projects with 
assignment groups in Agile Development 2.0.

The assignment group associated to any 
imported work item of an Azure DevOps 
project is based on the team integration 
settings of that project. If the project does 
not have any team integration setting, the 
imported work item will have an empty 
assignment group.

Changes made to iterations in Azure DevOps 
are not reflecting immediately in Agile 
Development 2.0.

Manually import iterations from the Azure 
DevOps project record or schedule a job to 
discover and import these updates daily.
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Issue Action

For more details on the scheduled jobs, see 
Schedule jobs to import projects, teams, 
areas, and work items from Azure DevOps.

The UI actions for Connect, Disconnect, and 
Validate and Fix result in an error when using 
for the first time.

This error is a known issue. Retry the UI action.

When the Description  field has &  in Azure 
DevOps, it renders as &amp;  in Agile 
Development 2.0.

The field mapping between Agile 
Development 2.0  and Azure DevOps is not 
supported for HTML fields.

Export still works when the webhooks are de-
registered.

Webhooks are only to import data from Azure 
DevOps to Agile Development 2.0. To stop 
the export of workitems, de-select the Export 
Work Items  checkbox for the project.

Enabling detailed project logs

To view all the details on project logging, enable the integration project logging property. For 
more information, see Enable detailed project logging in Microsoft Azure DevOps Integration with 
Agile Development 2.0.

Enable detailed project logging in Microsoft Azure  DevOps Integration with Agile 
Development 2.0

Understand how to enable the integration project logging in Microsoft Azure  DevOps integration 
with Agile Development 2.0  so that you can view detailed project logs.

Before you begin
Role required: sn_jira_int.admin (with edit access) or sn_jira_int.user (with read access).

About this task
Enable the project logging property in the Agile Azure DevOps Integration application.

Procedure

1. Navigate to All  > Agile Azure DevOps Integration  > Properties.

2. Select the Enable Integration Project Logging  check box.
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3. Click Save.

Agile Development 2.0  reference
Reference information to provide additional details about Agile Development 2.0  application 
such as the fields, related lists, user roles, tables, guidelines, and domain separation information.

Components installed with Agile Development 2.0

Several types of components are installed with activation of the Agile Development 2.0  plugin, 
including tables, user roles, and properties.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Demo data is available for this feature.

Roles installed

Role title [name] Description Contains roles

Scrum admin

[scrum_admin]
A scrum admin has full control on the 
Agile Development 2.0 application.

• scrum_user

• rm_product_admin

• rm_task_admin

• rm_test_admin

• rm_doc_admin
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Role title [name] Description Contains roles

• rm_story_admin

• rm_epic_admin

• rm_releasescrum_admin

• rm_sprint_admin

Scrum master

[scrum_master]
A scrum master guides team members 
through a sprint and serves as a 
sounding board for issues that arise.

A scrum master can move stories 
between a release backlog and a 
sprint. This user can create and 
manage:

• Epics

• Stories

• Sprints

• Team Members

• scrum_sprint_planner

• scrum_story_creator

• scrum_user

Scrum product owner

[scrum_product_owner]
Users with this role are responsible for 
the business value of a project and for 
maintaining the product backlog.

A product owner can move stories 
between the product backlog and 
releases. This user can create and 
manage:

• Themes

• Epics

• Stories

• Products

• Releases

• Teams

• scrum_release_planner

• scrum_story_creator

• scrum_user

Scrum release planner

[scrum_release_planner]
Users with this role perform release 
planning activities.

A release planner can create and 
manage:

• Themes

• Products

• Releases

• scrum_user

• scrum_story_creator
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Role title [name] Description Contains roles

Scrum sprint planner

[scrum_sprint_planner]
Users with this role manage the sprint 
process.

A sprint planner can create and 
manage:

• Stories

• Sprints

• scrum_user

• scrum_story_creator

Scrum story creator

[scrum_story_creator]
Users with this role create the 
descriptive elements of a product.

A story creator can create and manage:

• Epics

• Stories

• Tasks

• rm_scrum_task_admin

• scrum_user

Scrum story editor

[scrum_story_editor]
Users with this role have edit access to 
the Story [rm_story] table.

• scrum_user

• rm_scrum_task_admin

Scrum team member

[scrum_team_member]
Users with this role are the scrum users 
who work on a story in a sprint.

A team member can create a scrum 
task, perform updates to a story, and 
log enhancement requests or defect 
reports.

• scrum_user

• scrum_story_creator

• scrum_story_editor

• rm_defect_admin

• rm_enhancement_admin

• rm_scrum_task_admin

Scrum task admin

[rm_scrum_task_admin]
Scrum task administrator with access to 
[rm_scrum_task] table.

scrum_user

Scrum user

[scrum_user]
Basic scrum role that all other roles 
inherit. It confers read-only rights to the 
Agile Development application.

A scrum user can view all elements 
of agile, but cannot create, edit, or 
manage records of any type.

cmdb_read

Tables installed

Table Description

Product Assignment Group

[m2m_product_group]

Stores relationship between products and groups.
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Table Description

Release Assignment Group

[m2m_release_group]

Stores relationship between releases and groups.

Application Model

[cmdb_application_product_model]

Represents whole product whose releases are being 
managed.

Release Product

[m2m_product_release]

Represents all managed products.

Story Dependencies

[m2m_story_dependencies]

Represents all related stories (prerequisite and 
dependent) to an existing story.

Scrum task

[rm_scrum_task]

Represents a discrete amount of work for a story carried 
out during a sprint.

Release team member

[scrum_pp_release_team_member]

Represents the list of users who are part of a release.

Sprint team member

[scrum_pp_sprint_team_member]

Represents the list of users who are part of a sprint.

Team

[scrum_pp_team]

Represents who completes scrum tasks and stories 
during releases and sprints.

Team name

[scrum_pp_team_name]

Represents the name of the scrum team.

Theme

[scrum_theme]

Represents either a tangible product (such as a trading 
application) or an abstract goal (such as performance 
tuning).

Scrum release

[rm_release_scrum]

Represents individual versions (releases) of the product. 
Each release contains a list of sprints with a time range in 
which the stories in those sprints must be completed.

Sprint

[rm_sprint]

Stores sprints, which are the backlog items to be 
addressed together during a given time period.

Epic

[rm_epic]

Represents related stories or requirements that you have 
not yet transformed into stories.

Story

[rm_story]

Represents self-contained pieces of work that can be 
completed within a sprint.

Defect Represents a deviation from the expected behavior of a 
product.
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Table Description

[rm_defect]

Documentation Task

[rm_doc]

Represents documentation tasks for the product.

Enhancement

[rm_enhancement]

Represents an improvement to an existing product.

SDLC release

[rm_release_sdlc]

Represents individual versions of the product.

Testing Task

[rm_test]

Represents testing tasks for the product.

Note: 

Dashboards in Agile Development  require a separate plugin to be installed and configured. 
For information about Agile 2.0 dashboards and reports, including burndown charts and 
cumulative flow diagrams, see Agile Development process flow  and Performance Analytics 
Content Pack for Agile 2.0.

Properties installed with Agile Development 2.0

Properties are added with activation of Agile Development 2.0.

Agile Development 2.0 adds the following properties.

Note: 
All of these properties are located in the System Properties [sys_properties] table. To 
access the table, enter sys_properties.list  in the navigation filter.

Property Usage

Draw Burndown Chart ideal line as a linear 
straight line

com.snc.sdlc.scrum.pp.burndown.ideal.linear

Draws the burn down chart ideal line as a 
straight line.

• Type: true|false

• Default value: false

Stories in any one of the states specified in 
this comma separated list will be shown in the 
progress board (in the order specified)

com.snc.sdlc.scrum.pp.progress.story.states

Specify the story states using a comma 
separated list that should be shown in the 
story progress board. The states in the 
progress board follow the same order as 
specified here.

• Type: integer

• Default values in their order:

◦ -6: Draft

◦ 1: Ready
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Property Usage

◦ 2: Work in progress

◦ -7: Ready for testing

◦ -8: Testing

◦ 3: Complete

Tasks in any one of the states specified in this 
comma separated list will be shown in the 
progress board (in the order specified)

com.snc.sdlc.scrum.pp.progress.task.state

Specify the task states using a comma 
separated list that should be shown in the 
progress board. The states in the progress 
board follow the same order as specified 
here.

• Type: integer

• Default values in their order:

◦ -6: Draft

◦ 1: Ready

◦ 2: Work in progress

◦ 3: Complete

Enable the Actual Hours field for scrum tasks

com.snc.sdlc.scrum.pp.task_uses_actual_hours

Enable the Actual hours  field in the Scrum 
Task form. Displays actual hours of tasks on 
the task progress board.

• Type: true|false

• Default value: true

The default sprint length (in days) used if the 
length cannot be calculated from the sprint.

com.snc.sdlc.scrum.pp.default_sprint_length

Specify a default sprint duration that should 
be used when creating a sprint, if the sprint 
length cannot be calculated from the sprint.

• Type: integer

• Default value: 14

Writing effective stories in Agile Development 2.0

Well-written stories are easy to understand by all developers and members of team members, 
such as Testing or Documentation.

Stories enable the assignment group to accurately estimate the effort required to implement the 
work according to the definition of done. Definition of done is the exit criteria agreed to by the 
group, that determines when a story is complete.

A story has the following basic conditions:

• Description: The story description relates to a user persona, such as administrator, and either 
describes a business value or addresses a technical debt.

• Acceptance criteria: The story acceptance criteria are measurable and testable.

Story descriptions

A good user story description identifies the following for meeting the stated requirement:
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• the role of the user persona in the system

• the need expressed by the user persona

• the benefit to all stakeholders such as developers, users, and others

Typically, a story description is expressed as: "As a <role>, I want <goal or need>, so that 
<benefit>".

Examples of good story description

• Description: As a developer, I want to publish the current state of my application 
to an update set, so that I can deploy it to a production system.

• Description: As a customer, I want to receive notifications when comments are 
entered for an incident so that I am updated on the status.

• Description: As a change manager, I want to enable the assessment of risk for any 
given change by establishing a list of questions with multiple choice answers.

Example of bad story description

Description: Notifications are sent when incidents are created.

This description is poor because:

• The description does not state who or what is sending the notifications, not in 
what form the notification takes, such as email.

• The description does not include any benefit information, so the business value is 
not clear.

It could be better written as:

Description: As an incident creator, I want email notifications to be sent to a 
predefined set of interested parties when I create an incident, so that they can be 
informed when an incident affecting them is created.

Story acceptance criteria

Acceptance criteria define the boundaries of a user story, and are used to confirm when the 
software is working as intended, which means the story is completed. Acceptance criteria are an 
essential part of the 'Definition of Done' for a story.

Good acceptance criteria

Good acceptance criteria should include the following, where relevant:

• Usability: Be sure to include measures of usability in the acceptance criteria. 
Indicate how to answer the question: Is it easy to use? The key is to identify the 
right measurements and make sure each is quantifiable.

• Functionality: Identify specific user tasks, business processes, or functions that 
must be in place at the end of the project. A functional requirement might be: The 
user can choose from multiple sizes.

• Error handling: Enumerate error cases and how each should be handled. For 
example, if a user performs the steps in the wrong order, how will the software 
handle it?

• Performance: Test system performance from the perspective of an individual user. 
For example: Is the UI responsive?
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• Stress tests: Describe how the system responds when it is under stress because 
there are many users, transactions, or queries. Acceptance criteria should 
define acceptable thresholds for stress testing. For example: Does the system 
respond within a 250-millisecond threshold when 100 users submit queries 
simultaneously?

Example of Good Acceptance Criteria

Description: As a customer, I want to order and pay for the book via a secure web-
based form, so that my credit card information is safe.

Acceptance Criteria:

• All mandatory fields must be completed before a customer can submit a form.

• Information from the form is stored in the customer orders database.

• Payment can be made via Amex, Master Card, or Visa credit card.

• The system shall accurately calculate and apply sales tax.

• The system shall accurately calculate and apply shipping charges.

• The customer shall be able to verify the accuracy of the order.

• An acknowledgment email is sent to the customer submitting the form.

• Protection against spam is working.

Example of Bad Acceptance Criteria

Description: As a customer, I want to receive notifications when an incident is 
commented, so that I am updated on the status.

Acceptance Criteria: The appropriate people are notified when incidents are 
commented.

The acceptance criteria are poor because they do not give enough detail to test, for 
example, it is not clear who the appropriate people are.

The acceptance criteria could be better written as:

1. As an ESS user, create an incident.

2. Select Notify interested parties.

3. Save the incident.

4. Log in as an interested party.

5. Check that you have received an email for the logged incident.

Agile Development  process data model

Learn about the relationship between tables that Agile Development 2.0  uses to manage the 
agile process, represent releases, and represent product backlog items to be included in a 
sprint.

The following diagram displays the Agile Development tables as well as their relationships to 
other tables.
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Agile development process relationship diagram

Business stakeholder role for Agile Development 2.0

Use the business stakeholder role to read and retrieve data from any table of the Agile 
Development 2.0  and Scrum Programs applications to generate reports.

When you activate the Business Stakeholder plugin (com.snc.business_stakeholder) in your 
ServiceNow  instance, the Read only roles for Agile 2.0 plugin (com.snc.agile_read_roles) is also 
activated. This plugin provides a business stakeholder role (sn_agile_read) with which you can 
access all the tables of Agile Development 2.0  and Scrum Programs applications. You can assign 
this role to any user in your organization who is a business stakeholder.

Plugin availability

If you are a new customer, the Read only roles for the Agile 2.0 plugin (com.snc.agile_read_roles) 
is activated on zBoot. However, the business stakeholder role (sn_agile_read) is available only 
when you activate the Agile Development 2.0  plugin (com.snc.sdlc.agile.2.0).

If you are an upgrade customer, you must manually activate the read-only roles for Agile 2.0 
plugin (com.snc.agile_read_roles).

Agile Development 2.0  tables accessible by users with the business stakeholder 
role

When both the Read only roles for Agile 2.0 plugin (com.snc.agile_read_roles) and the Agile 
Development 2.0  plugin (com.snc.sdlc.agile.2.0) are active in your ServiceNow  instance, the user 
with the business stakeholder role (sn_agile_read) has read access to the following tables.
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Agile Development 2.0  tables

Table Description

Product Assignment Group

[m2m_product_group]

Stores relationship between products and groups.

Release Assignment Group

[m2m_release_group]

Stores relationship between releases and groups.

Application Model

[cmdb_application_product_model]

Represents a whole product whose releases are being 
managed.

Release Product

[m2m_product_release]

Represents all managed products.

Story Dependencies

[m2m_story_dependencies]

Represents all related stories (prerequisite and 
dependent) to an existing story.

Scrum task

[rm_scrum_task]

Represents a discrete amount of work for a story carried 
out during a sprint.

Sprint team member

[scrum_pp_sprint_team_member]

Represents the list of users who are part of a sprint.

Team

[scrum_pp_team]

Represents who completes scrum tasks and stories 
during releases and sprints.

Team name

[scrum_pp_team_name]

Represents the name of the scrum team.

Theme

[scrum_theme]

Represents either a tangible product (such as a trading 
application) or an abstract goal (such as performance 
tuning).

Scrum release

[rm_release_scrum]

Represents individual versions (releases) of the product. 
Each release contains a list of sprints with a time range in 
which the stories in those sprints must be completed.

Sprint

[rm_sprint]

Stores sprints, which are the backlog items to be 
addressed together during a given time period.

Epic

[rm_epic]

Represents related stories or requirements that you have 
not yet transformed into stories.

Story

[rm_story]

Represents self-contained pieces of work that can be 
completed within a sprint.
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Agile Development 2.0  tables  (continued)

Table Description

Defect

[rm_defect]

Represents a deviation from the expected behavior of a 
product.

Enhancement

[rm_enhancement]

Represents an improvement to an existing product.

Scrum Programs tables

Table Description

epic_backlog_definition Stores the filter criteria that is used to create 
the epic backlogs.

scrum_program_m2m_group Stores the relationship between a scrum 
program and its teams.

Domain separation in Agile Development 2.0

This is an overview of domain separation and how it works with Agile Development 2.0. Domain 
separation enables you to separate data, processes, and administrative tasks into logical 
groupings called domains. You can control several aspects of this separation, including which 
users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

How domain separation works in Agile Development 2.0

• The entities in Agile 2.0 extend the functions of task, so they inherit the domain behavior of 
tasks. The new entries you create go into the domain of the user currently logged in.

• Agile Board  honors domain separation and lists the groups that the user belongs to for Sprint 
Planning and Sprint Tracking pages. The backlog entries that display are in the same domain 
as those that the current user owns or shares with other users. The stories that display in Agile 
Board are limited to the domain of the current logged-in user.
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Related topics

Domain separation for service providers

Related links and lists of assignment group in Agile Development 2.0

Use the related lists in the Group form for the actions that you need to perform for your 
assignment group in Agile Development 2.0, such as adding sprints and editing group members.

Related links in the Group form

Name Description

Create 
Sprints

Create sprints for the team. New sprints are listed in the Sprints related list of 
the group.

Sprint 
Planning

Plan your sprint activities in Agile Development 2.0.

Related lists in the Group form

Name Description

Group Members Lists the members of the group. You can add 
or remove members in the agile group by 
selecting Edit.

The Average points per sprint  field rolls up to 
derive the group capacity for a sprint.

Sprints Lists the sprints for the group. Click New  to 
add a sprint to the group.

Related lists for a Product in Agile Development 2.0

Use the related lists in the Product form for the actions that you need to perform on your product 
record in Agile Development 2.0, such as associating releases, themes, epics, stories, or 
assignment groups.

The Product form related lists help you organize your agile work. Agile Development 2.0  extends 
the standard Scrum framework with Themes, which are a high-level organizational structure 
above Epics.

Tip: 

In Agile Development 2.0, Product > Theme > Epic > Story > Scrum Task. For detailed 
definitions, see Basics of Agile Development.

Product form related lists

List Description

Releases Lists the releases associated with the product.

You can create a release and associate it with this product by selecting New  or add 
an existing release by selecting Add.
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Product form related lists  (continued)

List Description

Themes
A high-level area of focus with associated business value, related to one or more 
company goals. Themes help prioritize work and can be associated with multiple 
epics.

Lists the themes that are part of the product. You can create a theme and associate 
it with this product by selecting New  or add an existing theme by selecting Add.

For more information, see Create a theme in Agile Development 2.0.

Epics
High-level definition of a requirement that provides business value, such as a new 
feature or significant enhancement. Epics are broken down into stories and can be 
worked on by single or multiple teams.

Lists the epics associated with the product. You can create an epic and associate it 
with this product by selecting New  or add an existing epic by selecting Add.

For more information, see Create an epic in Agile Development 2.0.

Stories
Short, manageable pieces of work related to an epic. Stories capture the who, 
what, and why of a requirement in a simple, concise way, enabling accurate effort 
estimation.

Lists the stories associated with the product. You can create a story and associate it 
with this product by selecting New  or add an existing story by selecting Add.

For more information, see Create a story in Agile Development 2.0.

Groups Lists the groups assigned to the product. You can assign an existing agile group to 
the product by selecting Edit.

You can associate one or more assignment groups (of type Agile Team) to a product.

When you associate a product to a release, the groups assigned to the product are 
automatically added to the release too.

Related lists for a Release in Agile Development 2.0

Use the related lists in the Release form for the actions that you need to perform for your release 
in Agile Development 2.0, such as associating products, stories, or assignment groups.

Release form related lists

List Description

Products Lists the products associated with the release.

You can create a product and associate it with this release by selecting New  or add 
an existing product by selecting Add.

Stories Lists the stories associated with the release.
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Release form related lists  (continued)

List Description

You can create a story and associate it with this release by selecting New  or add an 
existing story by selecting Add.

The stories you add here create the release backlog.

Groups Lists the groups assigned to the release. You can assign an existing agile group to 
the release by selecting Edit.

When you associate a product to a release, the groups assigned to this product are 
automatically added to the release.

Related links and lists for a Story in Agile Development 2.0

Use the related links and related lists on the Story form for the actions that you need to perform 
on your story in Agile Development 2.0, such as adding scrum tasks, dependencies, or splitting 
the story.

Related links of a story

Name Description

Split 
Story

Splits the story into two stories by creating a new story with the same details. Any 
incomplete tasks from the old story are moved to this new story.

Note: 
State of the Story cannot be Cancelled  or Completed, and the Original task 
field, if present, cannot contain a non-story record such as a Catalog Task or 
Defect.

Add 
Scrum 
Tasks

Enables you to create multiple scrum tasks for the current story.

The scrum tasks are listed in the Scrum Tasks related list of the story.

For more information, see Create multiple scrum tasks for stories in Agile 
Development 2.0.

Convert 
into 
epic

Converts an active story into an epic and moves the story into the Cancelled state.

If the story that you created is too large, you can convert it into an epic and then break 
it down into multiple stories.

• If this story is already associated with an epic, then the story is turned into a child 
epic for this epic.

For example, STRY01 is converted to EPIC01. If STRY01 was associated with 
EPIC02, then EPIC01 becomes a child epic to EPIC02. Otherwise, EPIC01 is created 
as a standalone epic.

• The state of the newly created epic is automatically set to Draft.

• The canceled story is associated with the newly created epic.

Copy 
Story

Copies the details of an existing active story to a new story. The tests and tasks of the 
story are also copied.
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Related links of a story  (continued)

Name Description

The state of the newly created story is automatically set to Draft.

This action is not available for stories added from the triage board.

Note: 
State of the Story cannot be Cancelled  or Completed, and the Original task 
field, if present, cannot contain a non-story record such as a Catalog Task or 
Defect.

Related lists of a story

Name Description

Scrum Tasks Lists the scrum tasks created for the story. 
Click New  to create a scrum task.

For more information, see Create a scrum task 
for Agile Development 2.0 stories.

Prerequisite Stories Lists the stories that must be completed 
before the current story can be completed. 
Click Edit  to add prerequisite stories.

Dependent Stories Lists the stories that depend on the current 
story. Click Edit  to add dependent stories.

Tests Adds existing tests to the story.

These tests are also listed on the Sprint 
Tracking  tab of Agile Board after the sprint of 
this story starts.

Related topics

Create a story in Agile Development 2.0

Writing effective stories in Agile Development 2.0

Related lists for a Theme in Agile Development 2.0

Use the related lists on the Theme form for the actions that you need to perform for your theme in 
Agile Development 2.0, such as associating stories or epics with the theme.

Related lists of a theme in Agile Development 2.0

Field Description

Epics Lists the epics associated with the theme.

You can create a new epic and associate it with this theme by selecting New

Stories Lists the stories associated with the theme.

You can create a new story and associate it with this theme by selecting New
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Test version form in Agile Development 2.0

Learn about the fields of the Test version form. Use this form to create and run tests for a story in 
Agile Development 2.0.

Test Version Form

Fields Description

Test Unique name of the test.

Owner Owner who created the test.

Version Automatically generated version of the test.

State Current state of the test.

• Draft: State of the test when it is created.

• Ready: State of the test when it is not editable. When the test has multiple 
versions, only one test will be in Ready  state at any one time

• Retired: State of the test when it is no longer used.

Short 
description

Brief description about the test.

Add Step Option to add step to a test.

Run Button used to run steps, which is displayed only when the test is in the Ready 
state. See Run tests for a story in Agile Development 2.0.

Update Option to update the details of a test version.

Ready Option to change the state of the test version to ready.

Create New 
Version

Option to create another version of the test.

Delete Option to delete the test version.

Change step 

order ( )

Option to change the order of a test step. Select the icon and drag a step to the 
required location.

Needs 
Verification

Option to mark a test step for verification.

Delete a test 

step ( )

Option to delete a test step.

Related topics

Track sprint progress in Agile Development 2.0

Related lists of a test version in Agile Development 2.0

Use the related lists in the Test version form for the actions that you need to perform on your 
test in Agile Development 2.0, such as verifying the test results, viewing other associated test 
versions and test sets.
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Related list Description

Other versions Shows all the versions of a test.

Test Results Shows the run results of each test version.

Test Sets Shows related tests in a test set.

Related topics

Track sprint progress in Agile Development 2.0

Mobile experience for Agile Development 2.0
Track and update the status of your stories and scrum tasks of the current sprint from your 
mobile device using the Agile Development  v2 mobile app.

With the Agile Development  v2 mobile app, you track sprints for the assignment groups that you 
are a part of. From your mobile device, you can do the following operations for the current sprint:

• View the status and details of stories and scrum tasks from the assignment groups that you are 
a part of.

• Edit and update the details of stories and scrum tasks.

• Create scrum tasks for a story.

• Add work notes and attachments to a story or scrum task.

• Collaborate with other stakeholders on a story or scrum task.

• Receive mobile notifications when notes are added to your story or scrum task.

Install Agile Development  v2

Install the Agile Development  v2 mobile app (sn_store_agile_mob) from ServiceNow Store.

Before you begin
Role required: admin

Procedure

1. Navigate to ServiceNow Store .

2. In ServiceNow Store, search for Agile Development  v2.

3. Click the application tile.
You can view detailed information about the application.

Note: 
Consider reading the Other Requirements and Dependencies sections, as applicable.

4. Click Request App  and enter your Now Support  login credentials.

5. Click Buy.

6. Enter the Instance Name  and Reason for the Instance, and click Validate Instance.

7. Click Request.
You receive an email with detailed installation instructions.

8. Log in to the instance on which you want to install the Agile Development.
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9. Navigate to System Applications  > Applications.

10. Locate the application, select it, and click Install.

What to do next
Get started with Agile Development v2 mobile app

.

Get started with Agile Development  v2 mobile app

Access the Agile Development  mobile app to track your sprints, stories, and tasks.

Before you begin

• Download the Mobile Agent  mobile app from App Store (iOS) or Google Play Store (Android).

• Install Agile Development v2  on your ServiceNow  instance.

• Role required: admin

Procedure

1. Log in with your ServiceNow  instance address on the Mobile Agent  app on your mobile device 
in one of the following ways:

Existing user

◦ If you installed the Agile Development  v2 
mobile app on an instance that you already 
use in the Mobile Agent  app, refresh the 
app to see Agile 2.0  as an applet launcher.

◦ If you installed the Agile Development 
mobile v2 app on a different instance:

a. Log out by tapping Settings  > Log out.

b. Tap the add icon ( ) and log in with 
your new ServiceNow  instance address.

New user

a. Enter the instance address in one of the 
following two ways:

▪ Type the instance address in the 
instance address field.

▪ If your administrator provided you with a 

QR code, tap the QR icon ( ), and scan 
the QR code.

b. Tap Save and log in.

2. Log in using your user name and password.

3. Tap the Agile Development  v2 icon ( ) to start tracking your sprints, stories, and scrum tasks.

What to do next
Go to
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• Managing stories on Agile Development v2 mobile app.

• Managing scrum tasks on Agile Development v2 mobile app.

Managing stories on Agile Development  v2 mobile app

View, edit, and update the details of stories assigned for the current sprint on your mobile device.

On your mobile device, open the Mobile Agent  app and navigate to Agile Development  v2. 
Perform the following actions with the role of scrum_product_owner, scrum_team_member, or 
scrum_master.

Tracking stories on Agile Development  v2

From your mobile device, track all stories of an assignment group including the stories that are 
assigned to you from multiple assignment groups.

All stories of an assignment group

1. In the Sprint Tracking applet, tap See All.

2. Tap the name of an assignment group to open it.

3. Tap All Stories.

Stories assigned to you from an assignment group

1. In the Sprint Tracking applet, tap See All.

2. Tap the name of an assignment group to open it.

3. Tap My Stories.

Note: 
The My Stories  tab appears only to the users of role scrum_team_member.

All stories assigned to you

The My Stories applet shows all stories that are assigned to you for the current sprint, from all 
assignment groups.

• To view all stories as cards, swipe left in the applet.

• To view the list of all stories, tap See All  on the applet.

Note: 
The My Stories applet appears only to the users of role scrum_team_member.

Blocked stories

The Blocked Stories applet shows all stories that are blocked.

• To view all blocked stories as cards, swipe left in the applet.

• To view the list of all blocked stories, tap See All  on the applet.

Note: 
The Blocked Stories applet appears only to the users of role scrum_master and 
scrum_product_owner.

Swipe left on a story record to find quick actions that enable you to add comments to the story or 
update its state.
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Tap a story to view more details. For example, you can view the epic, acceptance criteria, 
description, and so on.

Update a story on Agile Development  v2

Edit and update the details of your Agile Development 2.0  stories from your mobile device.

Before you begin
Role required: scrum_product_owner, scrum_team_member, or scrum_master

Procedure

1. Navigate to a story from the Sprint Tracking or My Stories applet.

2. Tap the story to open it.

3. To update the story details:

a. Tap Details  and then tap Edit.

b. Edit the fields that you want to update.

You can edit the fields for state, short description, story points, assigned to, priority, and the 
sprint to which the story belongs.

c. Tap Submit.

Note: 
If you update the sprint of the story to a future sprint, this story no longer appears in the 
app unless that sprint starts. Ensure that the state of the sprint is current.

4. To add work notes or attachments to the story:

a. Tap Activity.

b. Choose the activity that you want to perform.

Available options include adding work notes, files, pictures, and so on.

Managing scrum tasks on Agile Development  v2 mobile app

View, edit, and update the details of scrum tasks that were created for the stories of the current 
sprint on your mobile device.

On your mobile device, open the Mobile Agent  app and navigate to Agile Development  v2. 
Perform the following actions with the role of scrum_product_owner, scrum_team_member, or 
scrum_master.

Tracking scrum tasks on Agile Development  v2

From your mobile device, track all scrum tasks of an assignment group including the scrum tasks 
assigned to you from multiple assignment groups.

All scrum tasks of an assignment group

1. In the Sprint Tracking applet, tap See All.

2. Tap the name of an assignment group to open it.

3. Tap All Scrum Tasks.
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Scrum tasks assigned to you from an assignment group

1. In the Sprint Tracking applet, tap See All.

2. Tap the name of an assignment group to open it.

3. Tap My Scrum Tasks.

Note: 
The My Scrum Tasks  tab appears only to the users of role scrum_team_member.

All scrum tasks assigned to you

The My Scrum Tasks applet shows all scrum tasks that are assigned to you for the current sprint, 
from all assignment groups.

• To view all scrum tasks as cards, swipe left in the applet.

• To view the list of all scrum tasks, tap See All  on the applet.

Note: 
The My Scrum Tasks applet is visible only to the users of role scrum_team_member.

Swipe left on a scrum task record to find quick actions that enable you to add comments to it or 
update its state.

Tap a scrum task to view more details such as the task type, story, assigned to, description, 
activity, and so on.

Create a scrum task on Agile Development  v2

Add a scrum task for a story from the mobile app.

Before you begin
Role required: scrum_product_owner, scrum_team_member, or scrum_master

Procedure

1. Navigate to a story from the Sprint Tracking or My Stories applet.

2. Tap which story you want to add a new scrum task to.

3. Tap the more options icon (  on iOS) or (  on Android) and tap New Scrum Task.

4. On the form, fill in the fields.

New scrum task mobile form

Field Description

Short Description Brief description of the scrum task.

Description Detailed description of the scrum task.

Planned Hours
Estimated number of hours to complete the 
task.

A typical scrum task takes between 4 and 12 
hours. If the task requires more than 12 hours, 
consider breaking it down into multiple tasks.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2094



Field Description

Priority Priority for the task.

Type Type of work involved.

State Current state of the scrum task. The default 
state for a new scrum task is Draft.

5. Tap Submit

Note: 
Submit  appears only if all the required fields are filled.

Update a scrum task on Agile Development  v2

Edit and update the details of the scrum tasks of your stories from your mobile device.

Before you begin
Role required: scrum_product_owner, scrum_team_member, or scrum_master

Procedure

1. Navigate to a scrum task from the Sprint Tracking or My Scrum Tasks applet.

2. Tap the scrum task which you want to update the details of.

3. To update the scrum task details:

a. Tap Details  and then tap Edit.

b. Edit the fields that you want to update.

You can edit the fields of state, task short description, description, assigned to, actual hours, 
and priority of the scrum task.

c. Tap Submit.

4. To add work notes or attachments to the scrum task:

a. Tap Activity.

b. Choose the activity that you want to perform.

Available options include adding work notes, files, pictures, and so on.

Scaled Agile Framework (SAFe)
The ServiceNow®  Scaled Agile Framework (SAFe)  application helps you apply lean and agile 
principles to your large enterprise enabling you to develop and deliver software products with 
fewer defects in the shortest viable lead time.

Scaled Agile Framework application overview. Approximately three minutes long.

SAFe  overview

• Provides a broader, high-level perspective as well as the ability to manage development 
processes throughout all levels of your organization.

• Facilitates collaboration and streamlines the planning and monitoring of activities across 
business units, departments, and teams.
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Note: 
SAFe  and Scaled Agile Framework are registered trademarks of Scaled Agile, Inc , and 
ServiceNow  is a Scaled Agile, Inc. Platform Partner.

Configurations of SAFe

ServiceNow  provides applications that support two different configurations of SAFe: Essential 
SAFe  and Portfolio SAFe. The sections below explain the features of each configuration, and will 
help you choose the right configuration for your organization.

Essential SAFe

With Essential SAFe, you can apply lean and agile principles to your Agile Release 
Trains and teams, and develop and deliver work with fewer defects in the shortest 
viable lead time.

Portfolio SAFe

With Portfolio SAFe, you can align your organizational goals and strategies with your 
portfolios, and apply lean and agile principles to seamlessly manage and deliver 
your portfolio work.

Domain separation and Scaled Agile Framework (SAFe)
Domain separation is supported in the Scaled Agile Framework (SAFe)  application. Domain 
separation enables you to separate data, processes, and administrative tasks into logical 
groupings called domains. You can control several aspects of this separation, including which 
users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Business stakeholder role for Essential SAFe  and Portfolio SAFe
Use the business stakeholder role to read and retrieve data from any table of the Essential SAFe 
and Portfolio SAFe  applications to generate reports.
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Important: 

Starting with the Xanadu  release, the plugins Portfolio SAFe, Essential SAFe, Performance 
Analytics Content Pack for Essential SAFe, Work Progress Status for SAFe, Agile - Scaled 
Agile Framework - Unified Backlog, and Read only roles for SAFe are being prepared for 
future deprecation. These plugins will be hidden and can no longer be activated on new 
instances but will continue to be supported. Enterprise Agile Planning in Strategic Planning 
provides the latest experience for this functionality.

For more information on the deprecation process and its impact, see the Application/Plugin 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

When you activate the Business Stakeholder plugin (com.snc.business_stakeholder) in your 
ServiceNow  instance, the Read only roles for SAFe plugin (com.snc.sdlc.safe_read_roles) is also 
activated. This plugin provides a business stakeholder role (sn_safe_read) with which you can 
access all the tables of Essential SAFe  and Portfolio SAFe  applications. You can assign this role 
to any user in your organization who is a business stakeholder.

Plugin availability

If you are a new customer, the Read only roles for SAFe plugin (com.snc.sdlc.safe_read_roles) is 
activated on zBoot. However, the business stakeholder role (sn_safe_read) is available only when 
you activate the Agile - Scaled Agile Framework - Essential SAFe plugin (com.snc.sdlc.safe) or 
Agile - Scaled Agile Framework - Portfolio SAFe plugin (com.snc.sdlc.portfolio_safe).

If you are an upgrade customer, you must manually activate the Read only roles for Essential 
SAFe  and Portfolio SAFe  plugins (com.snc.sdlc.safe_read_roles).

SAFe  tables accessible by users with the business stakeholder role

When the read-only roles for SAFe plugin (com.snc.sdlc.safe_read_roles) is active in your 
ServiceNow  instance along with either the Essential SAFe plugin (com.snc.sdlc.safe) or 
Portfolio SAFe plugin (com.snc.sdlc.portfolio_safe), the user with the business stakeholder role 
(sn_safe_read) has read access to the following tables.

Essential SAFe  tables

Table Description

SAFe epic

[sn_safe_epic]

Information about epics.

SAFe feature

[sn_safe_feature]

Information about features.

Agile Release Train

[sn_safe_program]

Information about ART.

Program Increment

[sn_safe_program_increment]

Information about program increments. Stores the 
predictability measure data from PI objectives.

SAFe ART team

[sn_safe_program_m2m_group]

Relationships between groups and ART.
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Essential SAFe  tables  (continued)

Table Description

SAFe ART Member

[sn_safe_program_member]

Information about members within an ART.

SAFe ART Sprint

[sn_safe_program_sprint]

Sprint schedules of teams within the ART.

SAFe ART VTB Board

[sn_safe_program_vtb_board]

Records displayed on the ART level, Board tab.

SAFe Scrum Task

[sn_safe_scrum_task]

Information about SAFe scrum tasks.

SAFe Sprint

[sn_safe_sprint]

Information about sprints.

SAFe Story

[sn_safe_story]

Information about stories.

SAFe Team VTB Board

[sn_safe_team_vtb_board]

Records displayed on the Team level, Board tab.

SAFe PI Objectives

[sn_safe_pi_objective]

Stores the SAFe PI objectives.

SAFe team predictability 
measure

[sn_safe_pi_m2m_group]

Stores the business value achieved per team from PI 
objectives which is used for team-level predictability measure 
data.

Portfolio SAFe  tables

Table Description

SAFe epic

[sn_safe_epic]

Information about epics.

SAFe feature

[sn_safe_feature]

Information about features.

Agile Release Train

[sn_safe_program]

Information about ART.

Program Increment Information about program increments.
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Portfolio SAFe  tables  (continued)

Table Description

[sn_safe_program_increment]

SAFe ART team

[sn_safe_program_m2m_group]

Relationships between groups and ART.

SAFe ART Member

[sn_safe_program_member]

Information about members within an ART.

SAFe ART Sprint

[sn_safe_program_sprint]

Sprint schedules of teams within the ART.

SAFe ART VTB Board

[sn_safe_program_vtb_board]

Records displayed on the ART level, Board tab.

SAFe Scrum Task

[sn_safe_scrum_task]

Information about SAFe scrum tasks.

SAFe Sprint

[sn_safe_sprint]

Information about sprints.

SAFe Story

[sn_safe_story]

Information about stories.

SAFe PI Objectives

[sn_safe_pi_objective]

Stores the SAFe PI objectives.

SAFe team predictability 
measure

[sn_safe_pi_m2m_group]

Stores the business value achieved per team from PI 
objectives which is used for team-level predictability measure 
data.

Portfolios

[pm_portfolio]

Information about portfolios.

Portfolio SAFe VTB board

[sn_portfolio_safe_vtb_board]

Records displayed on the portfolio level, Board tab.

SAFe Team VTB Board

[sn_safe_team_vtb_board]

Records displayed on the Team level, Board tab.
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Essential SAFe
With Essential SAFe, you can apply lean and agile principles to your Agile Release Trains and 
teams, and develop and deliver work with fewer defects in the shortest viable lead time.

This video explains how to use Essential SAFe features

Essential SAFe  is the most basic configuration of SAFe that works in two levels for both product 
managers and team members. At the Agile Release Train (ART) level, product managers can 
capture and prioritize features in a centralized backlog, and monitor the progress of features in a 
visual task board.

At the Team level, team members can implement stories that are decomposed from features. To 
learn more about the levels, see the SAFe Board section below.

To start using the features of Essential SAFe, install the Agile - Scaled Agile Framework - 
Essential SAFe plugin (com.snc.sdlc.safe).

SAFe Board

The table below provides an overview of how you can access the key levels of Essential SAFe  on 
SAFe Board.

Level Description

Agile 
Release 
Train (ART)

As a product manager, you can plan and monitor activities across teams within an 
ART by accessing the ART  level on the Scaled Agile Framework (SAFe)  > SAFe 
Board. In addition, you can:

• manage the ART backlog in a centralized location.

• define a program increment and identify the features that need to be completed 
within that program increment.

• perform big room planning.

• track all the features of the ART and view their transition from one state (lane) to 
another, in a visual task board.

Team As a team member, you can plan and monitor activities within the team by 
accessing the Team  level on the Scaled Agile Framework (SAFe)  > SAFe Board. 
In addition you can:

• manage the team backlog in a centralized location.

• streamline sprint planning and completion activities.

• track all stories and view their transition from one state (lane) to another, in a 
visual task board.

Components installed with Essential SAFe

Several types of components are installed with activation of the Agile - Scaled Agile Framework - 
Essential SAFe plugin (com.snc.sdlc.safe), including tables and user roles.
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Roles installed

Role Description Contains roles

SAFe admin

[safe_admin]

• Edits, creates, and deletes SAFe ART, 
epics, features, stories, and program 
increments.

• Has read-only access to SAFe teams.

• safe_art_user

• safe_scrum_master

• safe_product_owner

SAFe scrum product 
owner

[safe_product_owner]

• Maintains the team backlog and can edit, 
create, and delete SAFe stories.

• Has access to create PI objectives.

• Has read-only access to SAFe ART, teams, 
epics, and features.

• Has read-only access to SAFe program 
increments.

safe_story_creator

SAFe ART user

[safe_art_user]

• Maintains the ART backlog and can edit, 
create, and delete SAFe epics, features, 
stories, and program increments.

• Has access to create PI objectives.

• Edits SAFe teams.

• Has create and edit access to SAFe ART.

safe_story_creator

SAFe scrum master

[safe_scrum_master]

• Edits, and deletes SAFe stories.

• Has access to create PI objectives.

• Edits SAFe teams.

• Has read-only access to SAFe ART, epics, 
features, and program increments.

• Has access to the triage board when the 
Scaled Agile Framework — Unified Backlog 
plugin (com.snc.sdlc.safe.multi_task) is 
activated

safe_story_creator

SAFe scrum user

[safe_scrum_user]

Can view all elements of SAFe, but cannot 
create, edit, or manage records of any type.

None

SAFe scrum story 
creator

[safe_story_creator]

• Edits, creates, and deletes SAFe stories.

• Has read-only access to SAFe ART, teams, 
epics, features, and program increments.

safe_story_editor
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Role Description Contains roles

SAFe scrum story 
editor

[safe_story_editor]

• Arranges stories within the team backlog 
using the drag and drop feature.

• Edits SAFe stories.

• Has read-only access to SAFe ART, teams, 
epics, features, and program increments.

• safe_scrum_user

• rm_scrum_task_admin

Tables installed

Table Description

SAFe epic

[sn_safe_epic]

Information about epics.

SAFe feature

[sn_safe_feature]

Information about features.

Agile Release Train

[sn_safe_program]

Information about ART.

Program Increment

[sn_safe_program_increment]

Information about program increments. Stores the 
predictability measure data from PI objectives.

SAFe ART team

[sn_safe_program_m2m_group]

Relationships between groups and ART.

SAFe ART Member

[sn_safe_program_member]

Information about members within an ART.

SAFe ART Sprint

[sn_safe_program_sprint]

Sprint schedules of teams within the ART.

SAFe ART VTB Board

[sn_safe_program_vtb_board]

Records displayed on the ART level, Board tab.

SAFe Scrum Task

[sn_safe_scrum_task]

Information about SAFe scrum tasks.

SAFe Sprint

[sn_safe_sprint]

Information about sprints.

SAFe Story

[sn_safe_story]

Information about stories.
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Table Description

SAFe Team VTB Board

[sn_safe_team_vtb_board]

Records displayed on the Team level, Board tab.

SAFe PI Objectives

[sn_safe_pi_objective]

Stores the SAFe PI objectives.

SAFe team predictability 
measure

[sn_safe_pi_m2m_group]

Stores the business value achieved per team from PI 
objectives which is used for team-level predictability measure 
data.

Quick start tests for Essential SAFe

Validate that Essential SAFe  still works after you make any configuration change such as apply 
an upgrade or develop an application. Copy and customize these quick start tests to pass when 
using your instance-specific data.

Essential SAFe  quick start tests require activating the Agile - Scaled Agile Framework - Essential 
SAFe plugin (com.snc.sdlc.safe) and the Agile - Scaled Agile Framework - Essential SAFe - ATF 
Tests plugin (com.snc.sdlc.safe.atf).

Essential SAFe test suites

Test Description Release version

Essential SAFe: Feature tests
Verify feature global rank 
updates.

Madrid

Essential SAFe: Feature tests
For a SAFe feature, verify that:

• Actual start date is 
populated after the state is 
changed to Implementation, 
Validation on Staging, or 
Deployment.

• Actual end date is 
populated after the state 
is changed to Released  or 
Cancelled.

• Active flag is set to the 
appropriate value:

◦ False, if the state is 
changed to Released  or 
Cancelled.

◦ True, for all other states.

Orlando

Essential SAFe: Feature tests If the PPM Standard plugin 
(com.snc.financial_planning_pmo) 
is active, verify that a Demand 
can be converted to a SAFe 
feature using the Create SAFe 

Quebec
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Essential SAFe test suites  (continued)

Test Description Release version

Feature  related link on the 
Demand form.

For more information on how 
to create an SAFe feature 
from a demand, see Create an 
artifact from a demand.

Essential SAFe: Program 
increment tests

Verify program increment date 
overlapping.

Madrid

Essential SAFe: Sprint tests
Verify the generation of ART 
sprints and team sprints as 
well as updates to sprint 
points and dates.

Madrid

Essential SAFe: Sprint tests
Verify that any update to the 
Group capacity  field of the 
assignment group results in 
the following changes to the 
Group capacity  field of the 
various sprints associated 
with this assignment group:

• For the sprints that are in 
the Draft  or Planning  states:

◦ The group capacity is 
updated to the new value.

◦ The Group capacity  field 
is editable.

• For the sprints in the 
Current, Complete, or 
Cancelled  states:

◦ The group capacity 
remains the old value.

◦ The Group capacity  field 
is read-only.

For the sprints in the Draft 
or Planning  state, you can 
individually edit the group 
capacity of the sprint anytime 
later. This would not change 
the group capacity of the 
assignment group associated 
with this sprint.

Paris

Essential SAFe: Story tests
Verify story global rank 
updates.

Madrid
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Essential SAFe test suites  (continued)

Test Description Release version

Essential SAFe: Story tests
Verify that active flag of 
the SAFe story is set to the 
appropriate value:

• False, if the state of 
the state is changed to 
Completed or Cancelled.

• True, for all other states.

Orlando

Essential SAFe: Story tests
Verify that adding, estimating, 
removing, deleting, updating, 
or cancelling a SAFe story 
updates the SAFe feature-
level and then the epic-level 
roll-ups correctly.

Orlando

Essential SAFe: Story tests
Verify that adding, updating, or 
deleting the feature on a SAFe 
story updates the Epic field on 
the SAFe story form.

Orlando

Essential SAFe: Story tests If the PPM Standard plugin 
(com.snc.financial_planning_pmo) 
is active, verify that a Demand 
can be converted to a SAFe 
story using the Create SAFe 
Story  related link on the 
Demand form.

For more information on how 
to create a SAFe story from 
a demand, see Create an 
artifact from a demand.

Quebec

Essential SAFe: Team tests Verify team association with 
an ART.

Madrid

Essential SAFe: Epic tests For a SAFe epic, verify that:

• Actual start date is 
populated after the 
state is changed to 
Implementation.

• Actual end date is 
populated after the state is 
changed to Complete.

• Active flag is set to the 
appropriate value:

Orlando
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Essential SAFe test suites  (continued)

Test Description Release version

◦ False, if the state is 
changed to Released  or 
Cancelled  states.

◦ True, for all other states.

Essential SAFe: Epic tests If the PPM Standard plugin 
(com.snc.financial_planning_pmo) 
is active, verify that a Demand 
can be converted to a SAFe 
epic using the Create SAFe 
Epic  related link on the 
Demand form.

For more information on how 
to create a SAFe epic agile 
from a demand, see Create an 
artifact from a demand.

Quebec

Essential SAFe: Program PI 
Objective tests

Verify the functionality of 
creating and updating PI 
objectives

• Verify that you can create 
a program increment-level 
objective

• Verify that you can update 
the created PI objective with 
the planned business value 
(PBV) and actual business 
value (ABV)

• Verify that the percentage 
of business value achieved 
is computed as the 
percentage of ABV 
complete, for only the 
committed PI objectives, as 
compared to the PBV of the 
program in the PI

Rome

Essential SAFe: Team PI 
Objective tests

Verify the functionality of 
creating and updating team PI 
Objectives

• Verify that you can create a 
team-level PI objective

• Verify that you can update 
the created PI objective with 
the planned business value 
(PBV) and actual business 
value (ABV)

Rome
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Essential SAFe test suites  (continued)

Test Description Release version

• Verify that the percentage 
of business value achieved 
is computed as the 
percentage of ABV 
complete, for only the 
committed PI objectives, as 
compared to the PBV of the 
team in the PI

Related topics

Quick start tests

SAFe entities

Learn about the various SAFe entities that are used to successfully plan, track, and deliver your 
software products.

Epic

Epic in SAFe is the largest unit of work, which can be continuously worked through 
multiple program increments. Epic captures business hypotheses and is prioritized 
and assessed using the WSJF (Weighted Shortest Job First is used to prioritize and 
sequence jobs to produce optimum business value) score.

An epic is further decomposed into features for implementation and delivery by 
SAFe ARTs.

Feature

A SAFe feature is equivalent to an epic in Agile Development. It must be small 
enough for completion within a program increment cycle. It is prioritized and 
sequenced in an ART backlog based on its global ranking. A feature is further 
decomposed into user stories for implementation and delivery by SAFe teams.

Story

A SAFe story is a brief statement encapsulating a product requirement or business 
case written in user-centric language. A story must be small enough for completion 
in one sprint. The estimated effort required to complete a story is measured in story 
points. More points are assigned to a story requiring more effort. Story points are 
arbitrary measurements of the effort (not necessarily the time) required to complete 
a story, based on the estimates from the SAFe team members.

Agile Release Train

Agile Release Train (ART) comprises a set of teams working towards a single 
solution.

Program Increment

A program increment is set period during which teams in an ART collaborate and 
produce to achieve agreed-upon goals. A program increment in SAFe is similar to 
a sprint in Agile Development, typically spanning 8–12 weeks. The most common 
form of program increment comprises four development sprints followed by one 
innovation and planning sprint.
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SAFe  team

SAFe team is an autonomous, cross-functional team containing members 
possessing different skill-sets who work in collaboration to achieve a common goal.

A user with the safe_scrum_master or safe_art_user role can create a SAFe  team. 
You can assign these teams to SAFe  work items such as stories, epics, and features.

Once a SAFe  team is created, you can add members to it.

• New customers: System administrator can add members to the team.

• Existing customers: A user with the safe_scrum_master or safe_art_user role can 
add members to your SAFe team.

Note: 

You can restrict this function just to the system administrator by creating the 
safe.disallow_scrum_add_group_member  property and setting it 
to true.

For information on how to create a property, see Add a system property .

Sprint

Program Increments in SAFe are further segmented into sprints for teams involved 
in it, and are measured in terms of weeks.

Define an epic in SAFe

Create an epic within SAFe. An epic is the largest unit of work that has one common objective 
such customer request, or business requirement. An epic is further decomposed into features for 
implementation and delivery by SAFe  agile release trains (ARTs).

Before you begin
Role required: safe_art_user or safe_admin

Procedure

1. Create an epic using either of the following options.

2. In the form, fill in the fields:

SAFe Epic Form

Field Description

Number System-generated number for the epic.

Enabler Check box identifying the epic as an enabler. Enablers do not add direct 
business value but help lay a foundation for future work. For example, an 
enabler epic might be an investigation into the architecture used to build 
features.

State State of the epic:

◦ Funnel: Created from Scaled Agile Framework (SAFe)  > Epic.

◦ Review: Under review considering parameters like WSJF score and WIP 
limited.
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Field Description

◦ Analysis: Approved or rejected based on parameters like WSJF score 
refinement, cost estimation, alternatives, and WIP limited.

◦ Backlog: Approved and assigned to an ART. In this state, the ART level user 
segments the epic into features.

◦ Implementation: Epic is being implemented.

◦ Done: Implementation is complete.

Color Color that you attribute to the epic. Epic colours help you visually identify and 
group features by their epic on the ART's backlog page of the SAFe board.

WSJF 
Score

Weighted Shortest Job First (WSJF) score is used to prioritize and sequence 
jobs to produce optimum business value. A job with the highest WSJF score 
receives the highest priority for implementation. A job can refer to an epic, 
feature, or any business capability.

Short 
description

Brief description of the epic.

Description A more detailed description of the epic.

Weighted shortest job first score section of the Epic form

Field Description

User-business Value Business value of the job based on 
parameters like impact on revenue or other 
solutions in the market offering similar 
capabilities.

Time criticality Impact on the business when deadlines are 
missed. For example, how projected revenue 
gains are reduced over time when deadlines 
are shifted.

Risk reduction Analyze how much risk this epic can help you 
avoid by answering questions such as:

◦ Does the job add value to the business in 
other ways?

◦ Does the job bring in new business 
opportunities?

◦ Does the job reduce the risk for a future 
delivery?

Job size Estimated duration for completion of the job.

Total story count Number of active stories in the epic.

This field is not displayed by default. 
Configure the field in the form layout.

Completed count Number of stories that have been completed 
in the epic.

This field is not displayed by default. 
Configure the field in the form layout.
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Field Description

Percent complete by count Percentage of work that has been completed 
in the epic. Value is calculated by story count.

This field is not displayed by default. 
Configure the field in the form layout.

Total estimate Sum of estimates of all the active stories in 
the epic.

This field is not displayed by default. 
Configure the field in the form layout.

Completed estimate Sum of estimates of all the completed stories 
in the epic.

This field is not displayed by default. 
Configure the field in the form layout.

Percent complete by estimate Percentage of work that has been completed 
in the epic. Value is calculated by points 
(estimate) of stories in the epic.

This field is not displayed by default. 
Configure the field in the form layout.

Missing estimates Number of stories without estimation points.

This field is not displayed by default. 
Configure the field in the form layout.

Top program Program mapped to the SAFe work enabling 
top-down hybrid planning. All the active child 
SAFe features of this epic are automatically 
associated with the selected program.

This field is visible in the SAFe view of the 
epic form if you activate the PPM Standard 
plugin (com.snc.financial_planning_pmo).

3. Fill in the Planning section if you want to create benefit plans for the epic.
This section is available when the Benefit view is selected.

Planning section of the Epic form

Field Description

Planned 
start date

Projected start date for the epic. The planned start date can be the current date 
or a future date.

Planned 
end date

Projected end date for the epic. The planned end date must be after the 
planned start date.

Planned 
benefit

Benefit value that is rolled up from the benefit breakdown.

Actual start 
date

Actual start date for the epic. The actual start date can be on or before the 
planned start date.
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Field Description

Actual end 
date

Actual end date for the epic. The actual end date can be before the planned 
start date but not before the actual start date.

Actual 
benefit

Actual benefit value that is rolled up from the actual benefit in the benefit 
breakdown.

4. Click Submit.

Create a monetary benefit plan for an epic

Epic benefit plans capture the potential benefits accrued by the epic when the epic is executed. 
Create a monetary benefit plan to specify the estimated benefit in a category spanning one or 
more fiscal periods.

Before you begin
Role required: safe_product_owner, safe_scrum_master, or safe_admin

About this task
The monetary benefit plan breakdown records are automatically created when you save the 
benefit plan.

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Click the hamburger icon ( ) and navigate to View  > Benefit.

4. On the form, fill in the fields in the Planning section.
This section is available when the Benefit view is selected.

Planning section of the Epic form

Field Description

Planned 
start date

Projected start date for the epic. The planned start date can be the current date 
or a future date.

Planned 
end date

Projected end date for the epic. The planned end date must be after the 
planned start date.

Planned 
benefit

Benefit value that is rolled up from the benefit breakdown.

Actual start 
date

Actual start date for the epic. The actual start date can be on or before the 
planned start date.

Actual end 
date

Actual end date for the epic. The actual end date can be before the planned 
start date but not before the actual start date.

Actual 
benefit

Actual benefit value that is rolled up from the actual benefit in the benefit 
breakdown.

5. Save the record.

6. In the Monetary Benefit Plans related list, click New.

7. On the form, fill in the fields.
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Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Epic to which the benefit plan belongs.

Sponsor Sponsor for the epic.

Category Type of benefit:

◦ Hard: Benefits that can be measured in terms of revenue.

◦ Soft: Benefits that are measured in terms of value.

Sub 
category

Sub-categories of hard and soft benefits.

The selection in Category  field determines the selections available in this field.

Benefit 
type

Type of benefit. Select Monetary benefits.

Offset type Field to indicate when the benefits start realizing. Select any of the following 
options:

◦ None: The default value is None. When you select None, you need to 
manually enter the benefit plan start and end fiscal periods.

◦ Milestone: After completion of a milestone.

◦ Start Date: At the start of the epic.

◦ End Date: After the epic ends.

If the value in the selected offset type changes, the benefit plan start date shifts 
accordingly. For example, if the offset type is set to End Date  and the end date 
of the epic changes, the benefit plan start date shifts to align with the new end 
date of the epic.

Milestone Epic milestones to which the benefit plan belongs. The field appears if you 
select Milestone  in the Offset type  field.

Milestone 
start date

Start date of the selected milestone. The field appears if you select Milestone  in 
the Offset type  field.

Work start 
date

Start date of the epic. The field appears if you select Start Date  in the Offset 
type  field.

Work end 
date

End date of the epic. The field appears if you select End Date  in the Offset type 
field.

Offset Number of periods before or after the offset type when the benefit plan starts. 
For example, if the offset type is selected as End Date  and the offset is -2, the 
benefit plan is two periods prior to the epic end date. If the epic end date shifts, 
the benefit plan start date shifts to two periods prior to the new epic due date.

Duration in 
periods

The length, in periods, of the benefit plan.

Start fiscal 
period

Starting fiscal period. Populated based on the value in the Offset field relative 
to the selected Milestone, Work start date, or Work end date, and Duration in 
period  values.

The field is editable if you select None  in the Offset type  field.
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Field Description

When you change the start fiscal period, the associated benefit breakdown 
values also change.

End fiscal 
period

Ending fiscal period. Populated based on the value in the Offset field relative 
to the selected Milestone, Work start date, or Work end date, and Duration in 
period  values.

The field is editable if you select None  in the Offset type  field.

When you change the end fiscal period, the associated benefit breakdown 
values also change.

Associated 
benefit

Non-monetary benefit that is associated to this monetary benefit plan.

Benefit Plan form - Financials details

Field Description

Entered benefit Benefit incurred from the epic specified in 
terms of entered currency.

Entered currency Currency in which you want the benefit plan 
to be created.

Functional currency Currency that is obtained from the 
glide.system.locale  property .

Total planned benefit Estimated amount of potential benefit of the 
epic.

Benefit in functional currency Benefit incurred from epic in terms of 
functional currency. The value in this field 
changes if the Entered currency  is different 
from the functional currency.

Actual benefit Actual benefit that is incurred from the epic. 
This value is rolled up from the Actual benefit 
field of all the benefit plan breakdowns.

Recurring Option to indicate that the benefit is recurring 
for all the fiscal periods in the benefit plan.

8. Click Submit.

What to do next
On the Benefit Plan form, view the benefit breakdown by fiscal period in the Monetary Benefit 
Plan Breakdowns related list.

Update a monetary benefit plan breakdown for an epic

Update a monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.

Before you begin
Role required: safe_product_owner, safe_scrum_master, or safe_admin
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Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Click the hamburger icon ( ) and navigate to View  > Benefit.

4. Click the Monetary Benefit Plans related list.

5. Open the required monetary benefit plan.

6. In the Monetary Benefit Plan Breakdowns related list, click the information icon for a monetary 
benefit plan breakdown.

7. Click Open Record.

8. On the Monetary Benefit Plan Breakdown form, view and update the enabled fields.

9. Click Update.

Create a non-monetary benefit plan for an epic

Epic benefit plans capture the potential non-financial benefits accrued by the epic when the epic 
is executed. Create a non-monetary benefit plan to specify the estimated benefit in a category 
spanning one or more fiscal periods.

Before you begin
Role required: safe_product_owner, safe_scrum_master, or safe_admin

About this task
The non-monetary benefit plan breakdown records are automatically created when you save the 
benefit plan by selecting Automatic  or Manual  in the Breakdown Type  field. The non-monetary 
benefit plan breakdown records specify the estimated and actual non-financial benefits at a 
granular level for specific fiscal periods, such as FY16: April and FY16: May. The Non-monetary 
Benefit Plan Breakdowns related list shows the aggregated benefits for estimated and actual 
non-financial benefits for each fiscal period for the epic.

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Click the hamburger icon ( ) and navigate to View  > Benefit.

4. On the form, fill in the required fields in the Planning section.
This section is available when the Benefit view is selected.

Planning section of the Epic form

Field Description

Planned 
start date

Projected start date for the epic. The planned start date can be the current date 
or a future date.

Planned 
end date

Projected end date for the epic. The planned end date must be after the 
planned start date.

Planned 
benefit

Benefit value that is rolled up from the benefit breakdown.
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Field Description

Actual start 
date

Actual start date for the epic. The actual start date can be on or before the 
planned start date.

Actual end 
date

Actual end date for the epic. The actual end date can be before the planned 
start date but not before the actual start date.

Actual 
benefit

Actual benefit value that is rolled up from the actual benefit in the benefit 
breakdown.

5. Save the record.

6. Click the Non-monetary Benefit Plans related list.

7. To create a non-monetary benefit plan, click New.

8. On the form, fill in the fields.

Benefit Plan form

Field Description

Name Descriptive name of the benefit plan.

Work Epic to which the benefit plan belongs.

Sponsor Sponsor for the epic.

Category Type of benefit:

◦ Hard: Benefits that can be measured in terms of revenue.

◦ Soft: Benefits that are measured in terms of value.

Sub 
category

Subcategories of hard and soft benefits.

The value of the Category  field determines the choices available in this field.

Benefit 
type

Type of benefit. Select Non-monetary benefits.

Offset type Field to indicate when the benefits start to be realized. Select any of the 
following options:

◦ None: The default value is None. When you select None, you must manually 
enter the benefit plan start and end fiscal periods.

◦ Milestone: After completion of a milestone.

◦ Start Date: At the start of the epic.

◦ End Date: After the epic ends.

If the value in the Offset type  field changes, the benefit plan start date shifts 
accordingly. For example, if the Offset type  field is set to End Date  and the end 
date of the epic changes, the start date of the benefit plan shifts to align with the 
new end date of the epic.

Milestone Epic milestones to which the benefit plan belongs. This field appears only when 
Milestone  is selected from the Offset type  field.

Milestone 
start date

Start date of the selected milestone. This field appears only when Milestone  is 
selected from the Offset type  field.
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Field Description

Work start 
date

Start date of the epic. This field appears only when Start Date  is selected from 
the Offset type  field.

Work end 
date

End date of the epic. This field appears only when End Date  is selected from the 
Offset type  field.

Offset Number of periods before or after the offset type when the benefit plan starts. 
For example, if the offset type is selected as End Date  and the offset is -2, 
the benefit plan is two periods prior to the epic end date. If the epic end date 
changes, the benefit plan start date shifts to two periods prior to the new epic 
due date.

Duration in 
periods

The length, in periods, of the benefit plan.

Start fiscal 
period

Starting fiscal period. This field is populated based on the value in the Offset 
field relative to the selected Milestone, Work start date, or Work end date, and 
Duration in periods  field values.

This field is editable if you select None  in the Offset type  field.

When you change the start fiscal period, the associated benefit breakdown 
values also change.

End fiscal 
period

Ending fiscal period. This field is populated based on the value in the Offset 
field relative to the selected Milestone, Project or Demand start date, or Project 
or Demand end date, and Duration in period values.

This field is editable if you select None  in the Offset type  field.

When you change the end fiscal period, the associated benefit breakdown 
values also change.

Associated 
benefit

Monetary benefit that is associated to this non-monetary benefit plan.

Non-monetary Details section of the Benefit form

Field Description

Measure Type of measure for the non-monetary 
benefit plan. The measure types are Count, 
Percentage, Hours, Days, and Score.

Select the option Yes/No  to track the benefits 
that are not quantifiable. When this option is 
selected, the only field available is Benefits 
achieved. You can select the check box 
to indicate that the benefits have been 
achieved.

Non-monetary entered benefit
Estimated value of the potential benefit.

Any change in the planned benefit in the 
benefit plan updates the associated benefit 
breakdown values for future fiscal periods 
only.
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Field Description

Non-monetary planned benefit Benefit value that is rolled up from the benefit 
breakdown.

Benefits achieved Option to indicate if the benefit is achieved.

Breakdown type Type of breakdown creation when you save 
the benefit plan.

◦ None: No breakdowns are created.

◦ Automatic: A Non-monetary Benefit 
Plan Breakdowns record is created 
automatically with data. The breakdown is 
calculated linearly.

◦ Manual: A Non-monetary Benefit Plan 
Breakdown record is created automatically 
but without data in the Entered benefit 
column.

Aggregation mode Determines how the roll-up happens from 
breakdowns to the benefit plan and updates 
the values in the Non-monetary planned 
benefit  and Non-monetary actual benefit 
fields.

◦ Sum: Aggregates data from all breakdowns.

◦ Average: Average value from all 
breakdowns.

◦ Most recent: Recent breakdown value.

◦ Max: Maximum value among the 
breakdowns.

◦ Min: Minimum value among the 
breakdowns.

Non-monetary actual benefit Actual benefit value that is rolled up from the 
actual benefit in the non-monetary benefit 
plan breakdown.

9. Click Submit.

What to do next

• On the Benefit Plan form, view the benefit breakdown by fiscal period in the Non-monetary 
Benefit Plan Breakdowns related list.

• Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the epic for the hybrid benefit plans.

Update a non-monetary benefit plan breakdown for an epic

Update a non-monetary benefit plan breakdown record that specifies the estimated and actual 
benefits, at a granular level, for specific fiscal periods.

Before you begin
Role required: safe_product_owner, safe_scrum_master, or safe_admin
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Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Click the hamburger icon ( ) and navigate to View  > Benefit.

4. Click the Non-monetary Benefit Plans related list.

5. Open the required non-monetary benefit plan.

6. In the Non-monetary Benefit Plan Breakdowns related list, click the information icon for a non-
monetary benefit plan breakdown.

7. Click Open Record.

8. On the Non-monetary Benefit Plan Breakdown form, view and update the enabled fields.

9. Click Update.

Associate monetary and non-monetary benefit plans

Associate monetary and non-monetary benefit plans, so that you can capture the potential 
benefits (financial and non-financial) accrued by the epic for the hybrid benefit plans.

Before you begin
Role required: safe_product_owner, safe_scrum_master, or safe_admin

About this task
You can associate a monetary benefit plan with a non-monetary benefit plan and vice versa.

Note: 
When you delete a benefit plan, any relationship with the associated benefit plan is also 
removed.

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Open the required epic.

3. Select View  > Benefit  from the Additional actions menu ( ).

4. Click the Monetary Benefit Plans or Non-monetary Benefit Plans related list.

5. Click the information iconfor a benefit plan that you want to associate.

6. Click Open Record.

7. Associate a monetary or non-monetary benefit plan.

8. Click Save.

Result
The selected benefit plan is associated with another plan.

What to do next
Click the View Associated benefit plan  related link to view the associated benefit plan.

Generate labor costs for epics

View the labor cost expenses based on the resource assignments for your epics.
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Before you begin

• The epic should have the resource assignments.

• Role required: sn_spm_financial_user

Procedure

1. Navigate to All  > Agile Development  > Epics.

2. Select the required epic.

3. Select the Generate labor costs  related link.
Refresh the page to view generated labor costs in the Cost Plan related list.

Define a feature in SAFe

Create a feature in SAFe  and break it down into smaller user stories for implementation and 
delivery by SAFe  teams.

Before you begin
Role required: safe_art_user or safe_admin

Procedure

1. Create a feature using any of the following options.
You can also convert an active SAFe story into a SAFe feature. For details, see Related links 
and lists for a SAFe story.

2. On the form, fill in the fields.

SAFe Feature Form

Field Description

Number System-generated number for the feature.

Enabler Option that identifies a feature as an enabler. An enabler does not bring any 
business value but helps in laying the foundation for future work. For example, 
you can use an enabler to investigate the architecture that is used to build 
stories.

Color Color that you attribute to the feature. Feature colors help you visually identify 
and group stories by their feature on the team's backlog page of the SAFe 
board.

This color also appears as a filled circle on the SAFe story cards on the SAFe PI 
planning board so that you can identify its feature.

WSJF 
score

Weighted Shortest Job First (WSJF) score that you use to prioritize and 
sequence jobs to produce an optimum business value.

A job with the highest WSJF score receives the highest priority for 
implementation. A job can be an epic, feature, or any business capability.

State State of the feature. Select one of the following:

◦ Funnel: In this state, you can create features from approved ideas.

◦ Analysis: In this state, the product management team reviews the features 
and considers the acceptance criteria, benefit hypothesis, technical 
feasibility, and scope estimates.
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Field Description

◦ Backlog: In this state, you can prioritize approved features and assign them to 
an ART.

◦ Implementation: In this state, you can break down a feature into stories that 
you can later assign to a team.

◦ Validation on staging: In this state, you can integrate the feature in the 
system and present it to the product management team for approval and 
feedback.

◦ Deployment: In this state, the deployment testing of feature is complete.

◦ Released: In this state, you are ready to release the feature to the end users 
and assess the benefit hypotheses.

◦ Cancelled: In this state, a feature has been canceled.

SAFe epic Epic to which the feature belongs.

Agile 
release 
train

Agile release train to which the feature belongs.

Program 
increment

Program increment in which the feature is scheduled for completion.

SAFe team Team that is primarily responsible for the delivery of the feature.

Short 
description

Brief description of the feature.

Description Detailed description of the feature.

Work notes Work notes that indicate the progress of the feature at various stages in its life 
cycle.

Weighted shortest job first section of the SAFe Feature form

Field Description

User-business Value Estimate of the business value of the job from 
this feature. Consider the impact on revenue 
or other solutions in the market that offer 
similar capabilities.

Time criticality Estimated impact on the business when 
deadlines are missed. For example, consider 
how shifting deadlines can reduce the 
projected revenue gain.

Risk reduction Analysis of how much risk this feature can 
help you avoid. Answer questions such as the 
following:

◦ Does the job add value to the business in 
other ways?

◦ Does the job bring in new business 
opportunities?

◦ Does the job reduce the risk for a future 
delivery?
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Field Description

Job size Estimated duration for completion of the job.

3. Click Submit.

What to do next
Use the SAFe stories related list to view and add stories to the feature.

Related topics

Define a story in SAFe

Split a SAFe  feature

Split a SAFe  feature into two separate features so that you can track complete and incomplete 
stories. You can move the feature with the incomplete stories to your backlog or to a future 
program increment (PI) so that you can maintain accurate metrics of the previous sprints and PIs.

Before you begin
Role required: safe_art_user or safe_admin

About this task
If your SAFe feature has incomplete stories at the end of a PI, you can split this feature into two 
features.

The new feature has a reference to the original feature and the field values are copied from the 
original feature.

The completed stories of the original feature move to a new feature whose state is set to 
Released.

Note: 
To split a SAFe feature, you must have at least one complete and incomplete story each.

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top-left corner, select the level as ART  and select your agile release train.

3. Click the Backlog  tab.

4. Select the List  view.

5. From your current PI section, locate the SAFe feature that has incomplete stories and click its 
number to open its form.
You can click Complete  to get the list of incomplete features.

6. On the feature form, click the Move completed stories to new feature  related link.

◦ The updated feature form shows only those stories that are incomplete.

◦ The new feature contains the completed stories from the original feature.

◦ The Original feature  field on the new feature references to the original feature that you've 
split.
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Note: 
Configure your feature form layout to view this field.

◦ "- Completed" is appended to the short description of the new feature to indicate that it is 
complete.

What to do next
Schedule the feature that has incomplete stories to your backlog or a new PI of your choice.

Define a story in SAFe

Create high-level definitions of your requirements in the form of stories in SAFe.

Before you begin
Role required: safe_sprint_planner, safe_art_user, safe_scrum_master, safe_story_editor, 
safe_team_member, or safe_admin

Procedure

1. Create a story using either of the following options.

2. In the form, fill in the fields:

SAFe Story Form

Field Description

Number System-generated number for the story.

Feature Feature to which the story belongs.

SAFe epic Epic to which the story belongs.

SAFe sprint Sprint in which the story is scheduled for completion.

Points Number of points indicating the estimated effort required to complete the story. 
A larger point value indicates that a greater amount of effort is required.

State State of the story. Select one of the following:

◦ Draft: In this state, the story requirements, such as the description and 
acceptance criteria, are still being drafted.

◦ Ready: In this state, the story is marked as ready to be picked up by the 
development team.

◦ Work in Progress: In this state, the development team works on the story 
and records their changes in the work notes field.

◦ Ready for Testing: In this state, the story is marked as ready to be taken up 
by a tester.

◦ Testing: In this state, the tester works on testing the story based on the 
requirements provided in the story.

◦ Complete: In this state, the development and testing efforts on a story are 
complete.

◦ Cancelled: In this state, a story has been cancelled.
The default state for a new story is Draft.

SAFe team Team to which the story is assigned.
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Field Description

Assigned to User to which the story is assigned.

Enabler Check box identifying the story as an enabler. Enablers do not add direct 
business value but help lay a foundation for future work.

Short 
description

Brief description of the story.

Description A more detailed description of the story.

Acceptance 
criteria

The functional criteria or testing results required to move the story to the state 
of Complete.

Work notes Work notes indicating the progress of the story at various stages in its life cycle.

3. Click Submit.

What to do next

• Use the related links and lists of the story to create tasks for this story, or add dependencies of 
the current story to other stories. You can also convert this story into a SAFe feature or split this 
story into two, based on your requirements. For more information, see Related links and lists 
for a SAFe story.

• You can create a story with the same details as this story using the Insert  or Insert and Stay 
options from the story additional actions ( ).

When you use Insert and Stay, the form of the newly created story remains open so that you 
can modify its details, create more stories with these details, or do both.

On SAFe Board, the new story is positioned right below the original story and the global rank of 
the new story is set accordingly.

Note: 

◦ Set the glide.ui.task.insert and glide.ui.advance properties to true  to access these 
actions.

◦ These actions are not allowed on stories added from the triage board.

Related links and lists for a SAFe  story

Use the related links and related lists in your SAFe  story form based on the actions that you need 
to perform on your story.

The following are the related links and lists on a SAFe  story form.

Related links of a SAFe story

Name Description

Split Story Splits the story into two stories by creating 
a new story with the same details. Any 
incomplete tasks from the old story are moved 
to this new story.

Convert into feature Converts an active story into a feature and 
moves the story into the Cancelled state.

The following changes occur:
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Related links of a SAFe story  (continued)

Name Description

• The default state of the newly created 
feature is Funnel.

• The canceled story is associated with the 
newly created feature.

If the story that you created is too big, you can 
convert it into a feature and then break it down 
into multiple stories.

Copy Story Copies the details of an existing active story to 
a new story. The tests and tasks of the story are 
also copied.

The newly created story is moved set to the 
Draft state.

This action is not available for stories that are 
added from the triage board.

Related lists of a SAFe story

Name Description

SAFe scrum tasks Lists the scrum tasks created for the story. 
Click New  to create a scrum task.

Prerequisites Stories Lists the stories that must be completed 
before the current story can be completed. 
Click Edit  to add prerequisite stories.

Dependent Stories Lists the stories that depend on the current 
story. Click Edit  to add dependent stories.

Tests Lists the tests that are used for the story. Add 
existing tests to the story.

Add dependencies to your SAFe  stories

Set dependencies to your SAFe  story by adding prerequisite and dependent stories to it. Using 
the SAFe Planning board, you can distinguish these dependencies between stories during your 
big room planning and replan the stories as required.

Before you begin
Role required: safe_story_creator

About this task
Prerequisite stories are the stories that must be completed before the current story can be 
completed. Dependent stories are the stories that depend on the completion of the current story.

Procedure

1. Navigate to a story by using any of the following options.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2124



2. In the Prerequisite Stories or Dependent Stories related lists, add stories according to the 
dependencies.

3. Click Save.

4. Click Update.
If you're on the SAFe planning board, click the dependencies icon to show or hide 
dependency lines between stories.

Define an Agile Release Train

From SAFe, define an Agile Release Train (ART) which is a group of agile teams working towards a 
single solution.

Before you begin
Role required: safe_admin

Procedure

1. Create an agile release train using either of the following options.

2. Enter a suitable name for the agile release train and click Submit.

What to do next
Use the following related lists:

Related list Description

Members Add or remove members from the Agile Release Train. Members are on the ART, 
but are not part of any specific agile team. For example, business owner, product 
manager, release train engineer, or system architect.

Teams Teams that are part of the Agile Release Train.

SAFe 
features

View or add features to the Agile Release Train.

Program 
increments

View or add program increments.

PI 
Objectives

List of all PI objectives of this ART. View, create, and update the PI objectives.

This related list is visible in the SAFe view of the ART form.

Related topics

Define a feature in SAFe

Define a program increment in SAFe

Define a program increment in SAFe

With SAFe, define a program increment (PI). A program increment is typically 8–12 weeks long, 
during which an ART delivers incremental value in the form of working, tested software and 
systems.

Before you begin
Role required: safe_admin
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Procedure

1. Navigate to the program increment form using either of the following options.

2. On the form, fill in the fields:

SAFe Program Increment form

Field Description

Number System-generated number for the story.

Agile release 
train

ART to which the PI belongs.

Sprint length Duration of each of the sprints in the PI.

PI Capacity Expected PI capacity; usually the aggregate of the group capacity of each 
team for each sprint in the PI.

Helps determine the load of planned features as compared to your expected 
PI capacity

Name Name of the PI.

State Current state of the PI.

The default state is Draft.

Planned start 
date

Start date of the PI.

Planned end 
date

End date of the PI.

Number of 
sprints

Number of sprints included in the program increment.

Total planned 
business 
value

Planned business value score set for all the objectives in this PI.

Field value is read-only and is calculated as the sum of all planned business 
value scores of the committed PI objectives for this PI.

Total actual 
business 
value

Realized business value score for all the objectives in this PI

Field value is read-only and is calculated as the sum of all the actual 
business value scores of both committed and uncommitted PI objectives for 
this PI.

Business 
value 
achieved

Percentage of business value achieved computed using the total planned 
and actual business value scores.

The sprints for the teams in the PI are determined from the values provided for Sprint length, 
Planned start date, and Number of sprints.

3. Click Submit.

What to do next
Access the following related lists:
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Related list Description

SAFe 
features

List of features that are scheduled for completion in a program increment.

SAFe 
stories

View, add, modify, or remove stories that are scheduled for completion in a 
program increment.

SAFe 
sprints

View, add, modify, or remove sprints in a program increment.

SAFe 
Teams

List of all teams that participated in the PI for an ART. Gain visibility into the scores 
of the total planned and actual business value and percentage achieved for each 
team.

This related list is visible in the SAFe view of the PI form.

PI 
Objectives

List of all the objectives for this PI. View, create, and update the PI objectives.

This related list is visible in the SAFe view of the PI form.

Related topics

Define a feature in SAFe

Define a story in SAFe

Define a SAFe team

From SAFe, create an agile team and associate it to an ART.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Teams.

2. Click New.

3. On the form, fill in the fields:

Group form

Field Description

Name Suitable name for the group.

Manager Designated servant leader of the team.

Group capacity (points) Total capacity of the team per sprint measured in story points.

Group email Email distribution list of the group.

Description Suitable description for the group.

4. Click Submit.

5. Navigate to Scaled Agile Framework (SAFe)  > Agile Release Trains.

6. Select an ART to which you want to associate the SAFe team.
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7. Click Edit, to you associate your team to the ART.

8. Click Save.

What to do next
Use the following related lists:

Related list Description

Group 
Members

Add or remove members from the group.

Stories Add or edit stories assigned to the group.

Sprints View or add sprints for the group.

PI Objectives List of all PI objectives of this team. View, create, and update the PI 
objectives.

This related list is visible in the SAFe view of the Group form.

SAFe  PI objectives

Use SAFe  program increment (PI) objectives to highlight the overall goals for a team or for an 
agile release train (ART) in a PI.

SAFe  PI objectives are created to summarize business and technical goals for the team or ART. 
During PI planning, the teams first create their PI objectives that they intend to accomplish in 
the upcoming PI. Program managers can then summarize the PI objectives into a separate set of 
high-level PI objectives.

PI objectives can directly relate to a feature. But sometimes, multiple features can contribute to a 
single objective. This situation could require a collaboration between multiple teams.

Although a team should ideally have around 7 to 10 PI objectives, there is no limit on the number 
of objectives that a team can have.

PI objectives can be committed or uncommitted, either at the team level or program level. A 
committed objective is an objective that your team is confident about reaching. In contrast, an 
uncommitted objective is an objective that your team is less confident about reaching because 
of different dependencies or other factors. The work for an uncommitted objective is planned but 
it can vary within the scope of the PI.

As PI planning progresses and is finalized, the business owners assign a planned business value 
(PBV) score to all the PI objectives. The score is on a scale of 1-10, where 1 indicates the lowest 
priority and 10 indicates the highest priority. As the teams complete the PIs, the business owners 
assign an actual business value (ABV) score to the PI objectives that are met. At the end of the 
PI, the PBV and ABV scores are used to compute the achievement values for each team and also 
for the ART as a whole.

Using the planned and actual business value scores of the PI objectives, SAFe  ART members 
can track the historical performance of the teams. By using that performance data, the ART 
members can then chart the SAFe  predictability measure of the PIs. These reports provide 
visibility into the business value that the teams and ARTs provide on a PI-to-PI basis.

Define a SAFe  PI objective

Create SAFe  program increment (PI) objectives so that you can summarize the goals of your team 
or agile release train (ART) for the upcoming PIs.
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Before you begin
Role required: safe_art_user, safe_scrum_master, or safe_product_owner

About this task
Create your business and technical goals in the form of PI objectives. Associate your PI 
objectives to an ART or to a team for the duration of a PI.

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > PI Objectives.
You can also use the PI Objectives related list on the SAFe team form, ART form, or PI form.

2. Click New.

3. On the form, fill in the fields.

SAFe Objective form

Field Description

Number System-generated number for the objective.

Program increment PI that this objective is planned for.

Committed Option to indicate if this objective is 
committed or not.

Type Type of the objective. Select from either 
Program  or Team.

Agile release train ART that this objective is planned for.

Planned business value Planned business value for this objective. The 
field is set as an integer score in the range of 
1-10. A score of 1 indicates the lowest priority, 
whereas a score of 10 indicates the highest 
priority.

Actual business value Actual business value that is realized from this 
objective. The field is set as an integer score 
in the range of 1-10. A score of 1 indicates 
the lowest priority, whereas a score of 10 
indicates the highest priority.

Short description Brief statement of the objective.

Description Detailed summary of the objective. Ensure 
that your description is not too technical or 
vague.

Work notes Work notes that indicate the progress of the 
objective during the PI.

4. Click Submit.

SAFe  Board — ART level

As a product manager, you can plan and monitor activities across teams within your agile release 
train (ART) by accessing the ART level on the SAFe  Board.

The ART level includes the following tabs:
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• Board

• Backlog

• Planning

Board

The Board  tab enables you to track all the features of your agile release train in a single view. 
Board is built on visual task boards, which transform the navigation of the Classic Environment 
into an interactive graphical experience. The visual task board interface provides a graphic-
rich environment for managing and collaborating. To learn more about the actions that can be 
performed in the board, see Visual Task Boards .

You can move a feature from one lane to another, which in turn updates the state of the feature. 
For example, when you move a feature from the Analysis lane to the Backlog lane, the state of the 
feature updates to Backlog.

Backlog

The Backlog  tab enables you to manage your ART backlog, and pre-plan the next program 
increment on the level of features.

A program increment is a time frame in which various agile teams work in collaboration to 
deliver a substantial amount of work towards the end of the program increment cycle. Program 
increment in SAFe is equivalent to a sprint in Agile Development, typically spanning 8–12 weeks. 
The most common form of program increment comprises four development sprints followed by 
one innovation and planning sprint.

Program increment

Planning
The Planning  tab facilitates a detailed planning of the upcoming program increment. It allows 
ART members to discuss the features in the program increment, break them down into stories, 
and pre-plan the sprints needed to complete the program increment. The Planning  tab surfaces 
the dependencies between stories and dependencies between features, which helps in the 
planning process.
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Planning tab

Track features in a board

Track the progress of features in the ART. View their transition from one state (lane) to another.

Before you begin
Role required: safe_admin or safe_art_user

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the choice list at the top left corner, select the level as ART.

3. Select the Board view.

4. Move a feature to the required state by dragging and dropping the feature card.

5. Optional:  Add a feature to a specific state:

a. Click Add Card.

b. On the form, fill in the fields and submit it.
For more information on the Feature form fields, see Define a feature in SAFe.

Manage your ART backlog from the SAFe  Board

Prioritize and manage features in your agile release train (ART) backlog. The ART backlog lists 
only the active features that are not assigned to any program increment.

Before you begin
Role required: safe_art_user or safe_admin

About this task
On the SAFe  Board, you can perform various actions to manage your backlog, such as adding 
new features or managing existing features.

Note: 
Steps 1 through 3 take you to where you can manage ART backlogs. Steps 4 through 11 
provide guidance on different actions that you can perform on your SAFe  Board. For steps 4 
through 11, choose whatever actions you want to take.
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Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the top-left corner of the SAFe Board, select the level as ART  and select your ART.

3. Click the Backlog  tab.

4. Add a feature to the backlog.

a. Click Create Feature.

b. Specify the required details in the Feature form.

c. Click Submit.
The feature is listed at the bottom of the backlog on the last page.

If you want to add a feature at a particular position in the backlog, select a feature just above 
this position, and then click Create Feature. The new feature is now listed below the feature 
that you selected.

5. Update a feature from the backlog.

a. Click the number of the feature that you want to update.

b. Edit the feature details and click Update.

6. To filter the list of epics in the Backlog and program Increment (PI) sections, use the epics that 
are listed under the Features by SAFe  epic section.
The Features by SAFe  epic section lists only those epics that are assigned to your ART. The 
section does not list epics that do not contain features.

7. Add an epic to the Features by SAFe epic section.

a. Select the options icon ( ) that is next to the Create Feature  option.

b. Select Create Epic.

c. On the SAFe  Epic form, fill in the fields and submit the form.
For more details, see Define an epic in SAFe.

8. To arrange features within a Backlog page, use one of the following options.

◦ Use the mouse device to select and hold a feature, drag it to the required position, and drop 
it.

◦ Use the keyboard. For more information, see Arrange a feature in the SAFe backlog page 
using the keyboard.

9. To personalize the columns in a list, select the Personalize icon.

10. Perform various actions on a single feature or set of features.

a. Select the required features.

b. Click the options icon ( ) and select one of the following options.

11. To view records in a standard list, select the standard list icon ( ).
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Arrange a feature in the SAFe  backlog page using the keyboard

Use the keyboard to move and arrange SAFe features in the Backlog  tab of the SAFe  Board.

Before you begin
Role required: safe_art_user or safe_admin

About this task
You can use the keyboard to change the order of a feature in the Backlog list or in the program 
increment (PI) list.

Procedure

1. Highlight the feature by pressing the Tab key.

2. Press the Tab key again.

The context menu icon ( ) on the feature is highlighted.

3. Select the feature by pressing the Enter key.

4. Move the feature to the desired position by using the Up and Down arrow keys.

5. Fix the position of the feature by pressing the Enter key.

Arrange multiple features in the SAFe  Board using the keyboard

Use the keyboard to move and arrange multiple SAFe features in the Backlog  tab of your SAFe 
Board.

Before you begin
Role required: safe_art_user or safe_admin

About this task
You can use the keyboard to rearrange multiple features in the Backlog list or in the program 
increment (PI) list.

Procedure

1. Highlight a feature by pressing the Tab key.

2. Select the feature by pressing the Enter key.

3. Select multiple features by using the Up and Down arrow keys and the Shift or Control key.

◦ To select consecutive features, use the Down arrow key to highlight the last feature that you 
want to select. Press the Shift and Enter keys.

◦ To select features that are in different positions on the page, use the Down arrow key to go 
to the next feature that you want to select. Press the Control and Enter keys. Repeat this 
process to select other features.

4. Highlight the context menu icon ( ) of the feature by pressing the Tab key again.

5. Press the Enter key to group all the selected features.

The multiple features that you selected now appear grouped together.

6. Move the features to your desired position by using the Up and Down arrow keys.

7. Fix the position of the features by pressing the Enter key.

Schedule features for your program increments

Define a program increment (PI) and plan the features scheduled for completion within that PI.
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Before you begin
Role required: safe_art_user or safe_admin

Procedure

1. Create features for PIs.

2. View current and future program increments either in a list view or on a Visual Task Board 
(VTB).

3. Assess features in the backlog and move them to a PI.

Use the SAFe  program list view

Use the SAFe  program list view to create, organize, track, start, and complete your program 
increments (PIs).

Before you begin
Role required: safe_admin or safe_art_user

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top-left corner, select the level as ART  and select your ART.

3. Click the Backlog  tab.

4. Select the List  view.

5. To create a PI, click Create Program Increment.

Fill the required fields in the PI form. To edit an existing PI, click the program increment number 
and edit the required details in a form.

6. To schedule a feature, drag the feature in the Backlog  section and drop it in the required PI.

7. To personalise and view columns on a list, click the Personalize icon.

8. To start the first PI, click Start  that appears in its section.
The Planning  tab opens.

9. To complete a PI, click Complete  that appears in its section.

A dialog box appears to indicate the number of completed and incomplete stories, features, 
and sprints. Move incomplete features to a future program increment, or mark features and 
remaining sprints as Complete.

Use the SAFe  program roadmap view

Use the SAFe  program roadmap view to track program increments (PIs) of your agile release train 
(ART) and plan features for future PIs.

Before you begin
Role required: safe_admin or safe_art_user

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top-left corner, select the level as ART  and choose your ART.

3. Click the Backlog  tab.
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4. Select the Roadmap  view.

5. Schedule a feature by dragging the feature from the No Program increment  lane and drop it in 
the required program increment lane.
You can reschedule features from one PI lane into the other by rearranging the feature cards.

6. Add a feature directly to a PI lane by clicking Add Card  at the bottom of the list in the lane.

You can also click the more options icon ( ) and click Add card.

7. Hide a PI lane by clicking the more options icon ( ) and click Hide lane.

SAFe  PI planning board

Use a centralized board to plan your program increments (PIs) for an agile release train (ART). 
You can create and assign stories to teams, add and view story dependencies, track stories by 
sprints, and re-plan these stories if required.

The SAFe  PI planning board contains the following components that guide you during your 
planning process.

Stories and Features toggle

Select the Stories  toggle to plan stories of your PI into sprints.

Select the Features  toggle to track the progress of all features of the PI.

SAFe PI selector

Select a PI that you want to plan or review.

Feature filter

Select a feature that is associated with your PI. By selecting a feature, you can filter 
the stories on the program planning board and on the feature backlog pane. You 
can analyze the workload from this feature and understand how the workload is 
scheduled across sprints.

Story dependencies

Visually analyze dependencies between stories of different sprints and teams 

by using the story dependency lines. Use the dependencies icon ( ) to show 
or hide these dependency lines. If you choose to hide the dependencies or if 
the dependencies involve a story that is not present on the board, you can see a 
colored border on the story card.

The color of the dependency indicates the way you've scheduled the stories. 
Possible colors are the following:

• Green: A prerequisite story is scheduled in a sprint that's before the sprint of the 
dependent story.

• Yellow: A prerequisite story is scheduled in the same sprint as the dependent 
story.

• Red: A prerequisite story is scheduled in a sprint that's after the sprint of the 
dependent story. Review the dependency and reschedule the story as required.

If none of the stories are associated with a prerequisite or dependent story, 

the dependencies icon ( ) is not visible. For information on how to add story 
dependencies, see Add dependencies to your SAFe stories.
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Feature Backlog pane

Use the backlog pane to view a list of all the features of the selected PI. You can do 
the following actions for a feature:

• View the description.

• Edit the information by clicking the feature's name.

• Add a new story to the feature by clicking Create Story.

• View the unassigned and unscheduled stories of this feature as cards that show 
the short descriptions and story points.

SAFe Teams

View all the teams of the selected ART toward the left of the planning board. At a 
time, the planning board can display a maximum of 15 teams. This limit is set to 
ensure optimum performance of the board during planning activities.

Team backlog lane

See the stories that are assigned to the team but that aren't scheduled yet into any 
sprint.

If you know which stories must be assigned to the team but you don't know what 
sprints to use, then you can move these stories from the feature backlog lane to the 
team's backlog lane. By doing so, you can have a clear idea of the team's workload 
for the upcoming sprints and then eventually add these stories to the correct 
sprints.

You can also unplan a story that has already been scheduled to a sprint by dragging 
the story card back to the team's backlog. When you later revisit the planning board, 
you know which team has this story and you can decide on which sprint to use.

Team sprint lanes

See the sprint cadences of the teams.

By pointing your cursor to a sprint's name, you can see the sprint details such as the 
duration, total story points, and filled capacity. You can click the sprint name to edit 
details such as group capacity, the planned start date, and the end date.

While planning your PI, if you know the sprint in which the story would be worked 
on, then you can move the story card to that sprint.

Story cards

See the stories of your SAFe  features in the form of cards. You can move these 
cards around to assign them to teams and to plan them into sprints.

If you have activated the SAFe — Unified Backlog  plugin 
(com.snc.sdlc.safe.multi_task), then you can also see stories that were added from 
the triage board into your unified backlog. From the PI planning board, you can 
double-click a story card to open it in a modal form and edit its details. If the story 
is created from a record on the triage board, such as an incident, then you can see 
both the story information and the defect information side-by-side.

The story cards use the following indicators:
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Legend for story cards on the SAFe  PI Planning board

Indicators for story cards on the SAFe  PI Planning board

Number Indicator description

1 Story is not complete.

2 Story is complete.

3 Story points.

4 Story is associated with a dependent story. If this band appears in 
red or yellow, the color indicates that the dependency is not set 
correctly and needs to be reviewed.

5 Story is associated with a prerequisite story. If this band appears 
in red or yellow, the color indicates that the dependency is not set 
correctly and needs to be reviewed.

6 Story belongs to a feature that has this color attributed to it. Point 
your cursor to the dot to view the feature's name.

7 Story belongs to a feature that does not have a color attributed to 
it. Point your cursor to the dot to view the feature's name.

8 Short description of the story.

9 Story is a regular story. This icon changes with the type of the 
story record. For example, you can create stories from incidents, 
enhancements, defects, problems, and other such records.

Note: 
Stories can be created from enhancements, defects, incidents, or other 
such records only if you have activated the SAFe — Unified Backlog  plugin 
(com.snc.sdlc.safe.multi_task).

Sprint workload capacity bar

Plan a sprint efficiently by using the workload capacity bar that is located under a 
sprint name. The bar indicates the workload that is planned for the team versus the 
team's capacity for that sprint.

If the group capacity of a sprint is zero, then you can't view the details of the sprint 
load and capacity.

Zoom in and zoom out
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Adjust the board view using the zoom in icon ( ) and zoom out icon ( ).

Search

Filter the stories on the planning board by using a search term. For example, you 
can enter a story number or a phrase from a short description.

Stories list

View the list of all stories of the program by using the standard list view icon ( ).

Plan a SAFe program increment

Plan your SAFe  program increments (PIs) and track the progress of stories and features in an 
interactive planning board.

Before you begin
Roles required:

• safe_scrum_user to view the Planning tab

• safe_story_creator to create stories

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. Click Planning.

3. From the list on the top-left of the screen, select ART  and select your agile release train.

4. From the PI list, select a PI.

5. Select the Stories  tab.

6. Assign stories to teams and sprints.

a. Click the feature backlog icon ( ).

b. Optional:  Add a new story to this feature by clicking Create Story  in the backlog pane.

c. Drag a story card from the feature backlog pane and drop it in the required sprint or Backlog 
lane of the team.

You can reschedule the stories across teams and sprints by rearranging the story cards.

◦ If you move the story card to a team's backlog, the SAFe team  field is updated accordingly.

◦ If you plan the story card into a sprint, the SAFe team  and the SAFe sprint  fields of the story 
are updated accordingly.

The sprint capacity bar below the sprint name fills up depending on the stories that are 
scheduled for it.

7. Optional:  Add dependencies between the planned stories.

(Optional) Dependencies that you add between stories automatically apply to the features of 
the stories.

Click the dependencies icon to show or hide dependencies between the stories.

For more information on story dependencies, see Add dependencies to your SAFe stories.

8. Optional:  Update the group capacity of a team's sprint by clicking the sprint name.
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Group capacity is the projected capacity of the group, in story points, for each sprint. If the 
group capacity of a sprint is zero, you can't view the details of the sprint load and capacity.

Note: 
You can update the sprint details only if you have the safe_scrum_master role.

SAFe  Board — Team level

As a team member, you can plan and monitor activities within your team by accessing the Team 
level on the SAFe  Board.

The Team level includes the following tabs:

• Backlog

• Sprint Tracking

Backlog

The Backlog  tab enables you to plan and prioritize stories for a sprint or multiple sprints by 
assessing stories in the backlog.

In addition, you can:

• Create stories.

• Reorder stories in the backlog using the drag feature. The story at the top of the backlog 
assumes higher priority with a lesser rank value. The story at the bottom of the backlog 
assumes lower priority with a higher rank value.

• Filter stories by a feature.

• Type a keyword in the search box to view only stories whose details match with the keyword.

• Create, organize, monitor, start, and complete sprints.

• View current and future sprints in chronological order.

• View these key aspects of a sprint: planned start and end dates, number of story points (total, 
complete, and pending) for the current sprint.

• Assess stories in the backlog and drag them to sprints.

• Move unfinished stories from the completed sprint to the backlog or a future sprint.

Note: 
To see the backlog of your team on SAFe Board, ensure that your team is:

• Of the group type SAFe Team, with the role safe_scrum_user assigned to the team 
members

• Added to Agile Release Trains
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Sprint Tracking

The Sprint Tracking  tab provides the following views:

Story board

Story board is built on visual task boards, which transform the navigation of lists 
and forms into an interactive graphical experience. The visual task board interface 
provides a graphic-rich environment suited for managing and collaborating records. 
To know more about the actions that can be performed in the board, see Visual Task 
Boards . In addition, you can:

• Track all the stories of the current sprint across lanes.

• Move stories from one lane to another, which in turn updates the state of the 
stories.

• Filter stories based on search criteria.

Task board

Task board enables you to track all the scrum tasks of stories of the current sprint 
across lanes.

• Move scrum tasks from one lane to another, which in turn updates the state of the 
scrum tasks.

• Filter scrum tasks based on search criteria.

List

List displays scrum tasks and tests associated to stories in each sprint. You can:

• Add scrum task and tests without leaving the context of the record.

• View the state, short description, and assignee of the scrum task without drilling 
down into details.
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• View the short description and run result of a test.

• Assess scrum tasks and tests that are pending before the closure of current 
sprint.

Manage your team backlog

Manage, evaluate, prioritize, and sequence stories in your team backlog.

Before you begin

• Program, to which the team belongs, must contain an active program increment.

• The tab displays only the sprints of the current program increment.

Role required: scrum_product_owner, scrum_master, safe_product_owner, or 
safe_scrum_master

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the choice list at the top-left corner, select the level as Team.

3. Select the Backlog  tab.

4. To add a story to the backlog.

a. Click Create Story.

b. Specify the required details in the story form.

c. Click Submit.
The story appears at the bottom of the backlog.

5. To add a story to the backlog and simultaneously decide its order of implementation, perform 
these steps.

a. Select a story in the backlog.

b. Click Create Story.

c. Specify the required details in the story form and click Submit.
The story is created beneath the story that was selected in the backlog.

6. The Records by SAFe feature  section lists features that the records of the backlog belong to.
Select a feature. Only records that belong to this feature appear.
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7. To open the triage board of a specific task type (such as problems or defects), view the total 
numbers of records in the triage boards of all task types, edit the filter definition of a triage 
board, or create another triage definition, click Triage Board.

Note: 
Triage Board  link is displayed only when the Agile — Scaled Agile Framework — Unified 
Backlog plugin (com.snc.sdlc.safe.multi_task) is installed.

8. To view records in a standard platform list, click the icon to view records in a standard list 

( ).

9. To personalize columns in a list, click the Personalize icon.

10. To move a triaged record from the Backlog  tab to Triage Board.

a. Open the record in a form.

b. Click the Move back to triage board  related link.

11. Use either of the following options to arrange stories that are not assigned to any sprint.

12. To perform an action on a set of stories.

◦ Select the required stories.

◦ Click  and select any of the following options:

Perform sprint planning

Perform sprint planning by evaluating stories in the backlog, selecting stories for the sprint, and 
estimating work effort for the stories.

Before you begin
Role required: scrum_master
The tab displays only the sprints of the current program increment.

About this task
In SAFe, the main portion of sprint planning occurs during the Big Room Planning process. The 
team backlog and the sprint planning portion of it is designed for refinement sessions. Though 
the overall plan of each sprint of a program increment already exists, the team still has sprint 
planning sessions every two weeks to add any missing stories and adjust the initial plan.

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the choice list at the top left corner, select the level as Team.

3. Select the Backlog  tab.

4. To add a story to the sprint and simultaneously decide its order of implementation, perform 
these steps:

a. Point to a story in the sprint.

b. Click Create Story.
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c. Specify the required details in the story form and click Submit.
The story is created beneath the story that was selected in the backlog or a sprint.

5. To personalize columns in a list, click the Personalize icon.

6. To start a sprint, click Start  that appears at right corner of the first or top sprint.

7. To complete a sprint, click Complete Sprint  that appears at right corner of the first or top sprint.
A dialog box appears indicating the number of completed and incomplete stories in the sprint. 
Move incomplete stories, if any, to the backlog or a future sprint. Click Complete.

Track your SAFe tasks from the Board view

Track the progress of your SAFe stories and scrum tasks. View their transition from one state 
(lane) to another in a visual task board.

Before you begin
Role required: safe_scrum_user or safe_admin

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top-left corner, select the level as Team.

3. Click the Sprint Tracking  tab.

4. To track the progress of stories of the current sprint, select the Story board  view.

a. To change the state of a story, move the story from one lane to another.

b. To add a story to a specific lane:

i. Click Add Task.

ii. In the form, fill in the fields.

iii. Click Submit.

5. To track the progress of scrum tasks of stories of the current sprint, select the Task board  view.

a. To change the state of a scrum task, move the scrum task from one lane to another.

b. To add a scrum task to a specific lane:

i. Click Add Task.

ii. In the form, fill in the fields.

iii. Click Submit.

Track your SAFe team work from the list view

Create, execute, track, and complete the scrum tasks and tests of a SAFe story from the list view.

Before you begin
Role required: safe_scrum_user or safe_admin

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top left corner, select the level as Team.

3. From the adjacent list, select the required team value.

4. Click the Sprint Tracking  tab, and select the List  view.
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5. To breakdown a story into scrum tasks:

a. From the Show  list at the top right corner, select Scrum Tasks.

b. Click Add Scrum Task.

c. On the form, fill in the fields.

Scrum Task form

Field Description

Number System generated number for the SAFe story.

SAFe story SAFe story that is associated with the scrum task.

Priority Priority set for the scrum task.

Type Type of effort required to complete the scrum task.

State Current state of the scrum task. Denotes the progress of the scrum task.

Assigned to User to whom the scrum task is assigned.

Short 
description

Brief description of the scrum task.

Description Detailed description of the scrum task.

Work notes Work notes indicating the progress of the scrum task at various stages in 
its life cycle.

d. Click Submit.

6. To create a test for a SAFe story:

Note: 
The option to create a test is available only when Test Management 2.0  is installed.

a. From the Show  list at the top-right corner, select Tests.

b. Click Add Test. For more information, see Create a test for a SAFe story.

7. To run tests that are in the Ready  state for a SAFe story:

a. Click the Run  button on a story.

b. In the pop-up, select the environment on which the tests are to be run, and click Run. For 
more information, see Run a test for a SAFe story.

8. To personalize columns in a list, click the Personalize icon.

Create a test for a SAFe story

Create a test, add steps to the test, and create and maintain different versions of the test. A test 
is a collection of conditions or steps used to determine whether a SAFe story is working correctly. 
A test can also include an expected result that determines whether the test passes or fails.

Before you begin

• Role required: safe_scrum_user or safe_admin

• You can create a test from the List view only when the Test Management 2.0  plugin is installed.
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Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top left corner, select the level as Team.

3. From the adjacent list, select the required team value.

4. Click the Sprint Tracking  tab, and select the List  view.

5. From the Show  list at the top right corner, select Tests.

6. Click Add Test.

7. In the form, fill in the fields:

Test Version form

Fields Description

Test Unique name of the test.

Owner Owner who created the test.

Version Automatically generated version of the test.

State Current state of the test.

◦ Draft: State of the test when it is created.

◦ Ready: State of the test when it is not editable. When the test has multiple 
versions, only one test will be in the Ready  state at any one time.

◦ Retired: State of the test when it is no longer used.

Short 
description

Brief description about the test.

Add Step Button used to add step to a test.

Run Button used to run steps, which is displayed only when the test is in the 
Ready  state.

Update Button used to update the details of a test version.

Ready Button used to change the state of the test version to ready.

Create New 
Version

Button used to create another version of the test.

Delete Test Button used to delete the test version.

Change the 
order of a 
step

Icon used to change the order of a test step. Select the icon and drag a step 
to the required location.

Needs 
Verification

Check box used to mark a test step for verification.

Delete a test 

step ( )

Icon used to delete a test step.

What to do next
View information in the following related lists:

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2145



Related list Description

Other versions Displays all the versions of a test.

Test Results Displays the run results of each test version.

Test Sets Displays related tests in a test set.

Run a test for a SAFe story

View the test scenario and execute all the steps of a test for verifying a SAFe story.

Before you begin
Role required: safe_scrum_user or safe_admin

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top left corner, select the level as Team.

3. From the adjacent list, select the required team value.

4. Click the Sprint Tracking  tab, and select the List  view.

5. From the list, select Tests.

6. Verify a story by clicking the Run  button.
This action runs all tests of the story at once.

7. In the pop-up, select the environment on which the test has to be run.

8. In the Test Execution pop-up, mark a step as passed, failed, or blocked using the following 
icons.

◦ To select an icon, you can also press Tab  and then press Enter.

◦ To pause and work on the test at a later point in time, click Pause.

9. Click Done.

Result
The test result is saved to the Test Result form. The latest test result of each test is displayed in 
the List view.

The overall status of the test is defined by statuses of the test steps:

• If all the test steps are passed, the status of the test is Passed.

• If at least one step of the test is not run, the status of the test is Not finished.

• If at least one step of the test fails, the status of the test is Failed. This rule takes precedence 
over the previous rule.

• If at least one step of the test is blocked, the status of the test is Blocked. This rule takes 
precedence over the previous two rules.

Troubleshoot test failures

View the history of test runs. Troubleshoot and rectify the test failures in SAFe.

Before you begin
Role required: safe_scrum_user or safe_admin
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Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the list at the top left corner, select the level as Team.

3. Click the Sprint Tracking  tab and select the List  view.

4. Click a test within a story.

5. Click the Test Result  related list.
Test results related to that version of the test are displayed.

6. Click a test result to view its details in a form.

Test Result form

Field Description

Number Automatically generated number for the test result.

Result Run status of the test: Passed,Failed, or Blocked.

Execution environment Environment on which the test is run.

Run by Name of the tester who runs the test plan.

Test Test that is run.

Version Version of the test that is run.

Updated Date and time when the test result was recorded.

Test run Name of the test run.

Short description Brief description of the test result.

The execution status of each step of the test is also indicated at the bottom of the form.

Portfolio SAFe
With Portfolio SAFe, you can align your organizational goals and strategies with your portfolios, 
and apply lean and agile principles to seamlessly manage and deliver your portfolio work.

Portfolio SAFe  works at three levels for portfolio managers, product managers, and team 
members. At the Portfolio level, portfolio managers can capture and prioritize epics in a 
centralized backlog, and monitor the progress of epics in a visual task board. An epic is the 
largest unit of work that has one common objective such as a customer request or business 
requirement.

At the ART level, product managers can capture, prioritize, and monitor features that are 
decomposed from epics. At the Team level, team members can implement stories that are 
decomposed from features. To learn more about the levels, see the SAFe Board section below.

To start using the features of Portfolio SAFe, install the Agile - Scaled Agile Framework - Portfolio 
SAFe plugin (com.snc.sdlc.portfolio_safe).

SAFe Board

The table below provides an overview of how you can access the key levels of Portfolio SAFe  on 
SAFe Board.
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Level Description

Portfolio As a portfolio manager, you can plan and monitor activities within a portfolio by 
accessing the Portfolio  level on the Scaled Agile Framework (SAFe)  > SAFe 
Board. In addition, you can:

• manage the portfolio backlog in a centralized location.

• track all the epics of the portfolio and view their transition from one state (lane) 
to another, in a visual task board.

Agile 
Release 
Train (ART)

As a product manager, you can plan and monitor activities across teams within an 
ART by accessing the ART  level on the Scaled Agile Framework (SAFe)  > SAFe 
Board. In addition, you can:

• manage the ART backlog in a centralized location.

• define a program increment and identify the features to be completed within 
that program increment.

• perform big room planning.

• track all the features of the ART and view their transition from one state (lane) to 
another, in a visual task board.

Team As a team member, you can plan and monitor activities within the team by 
accessing the Team  level on the Scaled Agile Framework (SAFe)  > SAFe Board. 
In addition you can:

• manage the team backlog in a centralized location.

• streamline sprint planning and completion activities.

• track all stories and view their transition from one state (lane) to another, in a 
visual task board.

Components installed with Portfolio SAFe

Several types of components are installed with activation of the Agile - Scaled Agile Framework - 
Portfolio SAFe plugin (com.snc.sdlc.portfolio_safe), including tables and user roles.

Roles installed

Role Description Contains roles

SAFe admin

[safe_admin]

• Edits, creates, and deletes 
SAFe ART, epics, features, 
stories, and program 
increments.

• Has read-only access to 
SAFe teams.

• safe_art_user

• safe_scrum_master

• safe_product_owner

SAFe portfolio user

[sn_portfolio_safe.safe_portfolio_user]

Maintains the portfolio 
backlog and can edit, create, 
and delete SAFe epics, 
features, and stories.

safe_art_user

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2148



Role Description Contains roles

SAFe scrum product owner

[safe_product_owner]

• Maintains the team 
backlog and can edit, 
create, and delete SAFe 
stories.

• Has read-only access to 
SAFe ART, teams, epics, 
and features.

• Has read-only access to 
SAFe program increments.

safe_story_creator

SAFe ART user

[safe_art_user]

• Maintains the ART backlog 
and can edit, create, 
and delete SAFe epics, 
features, stories, and 
program increments.

• Edits SAFe teams.

• Has read-only access to 
SAFe ART.

safe_story_creator

SAFe scrum master

[safe_scrum_master]

• Edits, and deletes SAFe 
stories.

• Edits SAFe teams.

• Has read-only access to 
SAFe ART, epics, features, 
and program increments.

safe_story_creator

SAFe scrum user

[safe_scrum_user]

Can view all elements of 
SAFe, but cannot create, 
edit, or manage records of 
any type.

None

SAFe scrum story creator

[safe_story_creator]

• Edits, creates, and deletes 
SAFe stories.

• Has read-only access to 
SAFe ART, teams, epics, 
features, and program 
increments.

safe_story_editor

SAFe scrum story editor

[safe_story_editor]

• Arranges stories within the 
team backlog using the 
drag and drop feature.

• Edits SAFe stories.

• safe_scrum_user

• rm_scrum_task_admin
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Role Description Contains roles

• Has read-only access to 
SAFe ART, teams, epics, 
features, and program 
increments.

Tables installed

Table Description

SAFe epic

[sn_safe_epic]

Information about epics.

SAFe feature

[sn_safe_feature]

Information about features.

Agile Release Train

[sn_safe_program]

Information about ART.

Program Increment

[sn_safe_program_increment]

Information about program increments.

SAFe ART team

[sn_safe_program_m2m_group]

Relationships between groups and ART.

SAFe ART Member

[sn_safe_program_member]

Information about members within an ART.

SAFe ART Sprint

[sn_safe_program_sprint]

Sprint schedules of teams within the ART.

SAFe ART VTB Board

[sn_safe_program_vtb_board]

Records displayed on the ART level, Board tab.

SAFe Scrum Task

[sn_safe_scrum_task]

Information about SAFe scrum tasks.

SAFe Sprint

[sn_safe_sprint]

Information about sprints.

SAFe Story

[sn_safe_story]

Information about stories.

SAFe PI Objectives Stores the SAFe PI objectives.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2150



Table Description

[sn_safe_pi_objective]

SAFe team predictability 
measure

[sn_safe_pi_m2m_group]

Stores the business value achieved per team from PI 
objectives which is used for team-level predictability measure 
data.

Portfolios

[pm_portfolio]

Information about portfolios.

Portfolio SAFe VTB board

[sn_portfolio_safe_vtb_board]

Records displayed on the portfolio level, Board tab.

SAFe Team VTB Board

[sn_safe_team_vtb_board]

Records displayed on the Team level, Board tab.

Define a portfolio

From SAFe, define a portfolio which is a group of ARTs working towards a single solution.

Before you begin
Role required: sn_portfolio_safe.safe_portfolio_user

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > Portfolios.

2. Click New.

3. In the form, fill in the fields:

Portfolio form

Field Description

Name Unique name for the portfolio.

Portfolio manager Manager to whom the portfolio is assigned.

Description More detailed description of the portfolio.

What to do next

• Define an Agile Release Train

• Define an epic in SAFe

SAFe Board—Portfolio level

As a portfolio manager, you can plan and monitor activities within your portfolio by accessing the 
Portfolio level on the SAFe Board.

The Portfolio level includes the following tabs:

• Board

• Backlog
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Board

The Board  tab enables you to track all the epics of your portfolio in a single view. Board is built on 
visual task boards, which transform the navigation of lists and forms into an interactive graphical 
experience. The visual task board interface provides a graphic-rich environment for managing 
and collaborating.

In addition, you can move an epic from one lane to another, which in turn updates the state of 
the epic. To learn more about the actions that can be performed in the board, see Visual Task 
Boards .

Backlog

The Backlog  tab enables you to manage your portfolio backlog, which comprises epics.

Track your epics

Using the Board tab, track all epics of your portfolio and view their transition from one state (lane) 
to another.

Before you begin
Role required: sn_portfolio_safe.safe_portfolio_user

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the choice list at the top left corner, select the level as Portfolio.

3. Select the Board view.

4. Move an epic to the required state by dragging and dropping the epic card.

5. Optional:  Add an epic to a specific state:

a. Click Add Card.

b. On the form, fill in the fields and submit it.
For more information on epic fields, see Define an epic in SAFe.

Manage your portfolio backlog

Manage, evaluate, prioritize, and sequence epics in your portfolio backlog.

Before you begin
Role required: sn_portfolio_safe.safe_portfolio_user

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. From the choice list at the top left corner, select the level as Portfolio.

3. Click the Backlog  tab.

4. To add an epic at the bottom of the backlog.

a. Click Create Epic.

b. Specify the required details in the form and click Submit.

5. To add an epic while simultaneously deciding its order of implementation in the backlog.
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a. Select an epic in the backlog.

b. Click Create Epic.

c. Specify the required details in the form and click Submit.
The epic is created beneath the epic that was selected in the backlog.

6. To search for epics by their short descriptions, type a word in the search box and press Enter.

7. To arrange epics within the backlog, use either of the following options.

If the backlog contains more than 50 epics, then a pagination control appears at the bottom of 
the list enabling you to navigate to the first, last, previous, or next page in the list.

8. To view the backlog as a standard platform list, click View Standard List.

9. To perform any action on a set of epics.

◦ Select the required epics.

◦ Click  and select any of the following options:

SAFe — Unified Backlog
SAFe — Unified Backlog  allows you to maintain a centralized backlog containing records of 
different task types, such as defects, problems, incident tasks, and stories. It facilitates in 
prioritizing and sequencing different task type records in one location, saving you steps. It also 
removes the overhead of converting records to stories.

Important: 

Starting with the Xanadu  release, the plugins Portfolio SAFe, Essential SAFe, Performance 
Analytics Content Pack for Essential SAFe, Work Progress Status for SAFe, Agile - Scaled 
Agile Framework - Unified Backlog, and Read only roles for SAFe are being prepared for 
future deprecation. These plugins will be hidden and can no longer be activated on new 
instances but will continue to be supported. Enterprise Agile Planning in Strategic Planning 
provides the latest experience for this functionality.

For more information on the deprecation process and its impact, see the Application/Plugin 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

The flow described below represents the common practice of creating and managing records 
using SAFe — Unified Backlog  along with Essential SAFe.

Setting up a triage board

You can set up a triage board by defining filter criteria, and view records of a specific 
task type on the triage board. For example, you can create one triage board for 
defects and another for incidents. Records are dynamically updated in all triage 
boards.

Triaging and assigning records

You can move records from a triage board to the Backlog  tab. In the Backlog  tab, 
you can estimate points and assign the record to a user using the Points, and 
Assignment fields in the Story Information tab of the record. You can open the 
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triage board of any specific task type, view the total numbers of records in the triage 
boards of all task types, or edit the filter definition of a specific triage board.

Working with the triaged records in the Board view

As you work with stories, work with the triaged records (represented by stories) 
in the Sprint Tracking  tab, Board view. When you move a triaged record from one 
lane to another, the state of its wrapper story changes, but the state of the original 
triaged record remains the same. To change the state of the original triaged record, 
you would need to open the record in a form and update the state.

Set up a triage board in SAFe

Set up your own triage board by defining filter criteria, and view records that are important to 
your team, such as problems, incident tasks, defects, or change requests. For example, you can 
create one triage board for defects and another for incidents.

Before you begin
You must be added to the SAFe team that would be responsible for handling work from this triage 
board.

Role required: safe_scrum_master

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > SAFe Board.

2. Select the Backlog  tab.

3. Select Triage Board.

4. On the form, fill in the fields:

SAFe Triage Definition form

Field Description

Name Suitable name for the triage board.

Table Table from which you want to filter records.

Filter Filter criteria to be applied on the table for 
refinement of records.

Note: 
When setting up a triage board, do not to remove these default conditions:

◦ Active is true: This condition ensures that the tasks on your Triage Board are relevant.

◦ Agile story is empty: This condition ensures that the task is not present in some other 
backlog.

5. Click Submit.
A triage definition is created.

What to do next

1. Select the triage definition.

2. To add a record to the triage definition, click New.

3. To move a record from the triage board to the Backlog  tab, click Add to Backlog.
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Performance Analytics  Content Pack for Essential SAFe
Improve your SAFe  processes and practices using the Platform Analytics  Content Pack for 
Essential SAFe  that contains preconfigured dashboards with data visualizations.

Overview of the Performance Analytics  dashboards for Essential SAFe.

Important: 

Starting with the Xanadu  release, the plugins Portfolio SAFe, Essential SAFe, Performance 
Analytics Content Pack for Essential SAFe, Work Progress Status for SAFe, Agile - Scaled 
Agile Framework - Unified Backlog, and Read only roles for SAFe are being prepared for 
future deprecation. These plugins will be hidden and can no longer be activated on new 
instances but will continue to be supported. Enterprise Agile Planning in Strategic Planning 
provides the latest experience for this functionality.

For more information on the deprecation process and its impact, see the Application/Plugin 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

Enabling the Performance Analytics  Solution

Use the Performance Analytics  widgets on the dashboard to visualize data over time, analyze 
your business processes, and identify areas of improvement. With solutions, you can get value 
from Performance Analytics  for your application with minimal setup.

Note: 
Solutions include some dashboards that are inactive by default. You can activate these 
dashboards to make them visible to end users according to your business needs.

For unlimited access to all features of this Platform Analytics Solution, purchase a 
Performance Analytics  subscription. For more information, see Activating your Performance 
Analytics subscription .

To use this Platform Analytics Solution, you must activate your subscription to Performance 
Analytics  for Business Management. For more information about entitlements to Performance 
Analytics, see Activating your Performance Analytics subscription .

This base system Platform Analytics Solution  is available from the ServiceNow Store. To enable 
this solution, as an admin, navigate to System Applications  > Search ServiceNow Store. When 
the landing page for the ServiceNow Store  opens, search for Performance Analytics  Content 
Pack for Essential SAFe. When you find the solution, follow the instructions in the ServiceNow 
Store. The ServiceNow Store  has its own documentation.

Business stakeholder role support

The business stakeholder role (sn_safe_read) has read-only access to all Essential SAFe 
dashboards. For more information, see Business stakeholder role for Essential SAFe and 
Portfolio SAFe.

Related topics

Activate your Performance Analytics subscription

Enable daily data collection for Essential SAFe  dashboards

Enable scheduled data collection to begin collecting scores on new data automatically for 
Essential SAFe  dashboards. Data collection jobs automatically collect scores for automated 
indicators and breakdowns.
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Before you begin
Role required: pa_admin or admin

About this task

Note: 
Historical data collection is not supported for the underlying indicators of the [SAFe] Daily 
Data Collection job.

Procedure

1. Navigate to All  > Performance Analytics  > Data Collector  > Jobs.

2. Find and open the [SAFe] Daily Data Collection job.

3. Start the [SAFe] Daily Data Collection job.

a. Scroll down to the Job parameters section.

b. Set the Run as  field to pa_admin, pa_data_collector or admin roles.

c. Verify that the time zone in the Run As tz  field is appropriate for your organization.
This timezone is used for the following:

▪ Database queries created for this job

▪ Indicator conditions such as [[Created][on][Today]]

d. Enable the scheduled run of the job by selecting the Active  checkbox.

4. Click Update.

Using Solution Library for Essential SAFe  dashboards

Upgrade to the latest layout of Essential SAFe  dashboards using Solution Library.

Existing users who upgraded to the latest version 1.1 of Performance Analytics Content Pack for 
Essential SAFe  can install the latest layout of the dashboards from Solution Library.

For example, if you are upgrading from version 1.0.1 or earlier of the application, install the 
following dashboards from Solution Library to access the latest layout:

• SAFe  Feature Dashboard

• SAFe  Sprint Dashboard

• SAFe  PI Dashboard

• SAFe  Epic Dashboard

• SAFe  Team Dashboard

Note: 
For users on the Zurich  release, the Install  and Upgrade  buttons are not visible on the 
Solution Library content form. For information on resolving this issue, see Allow PA Solution 
Library for Store apps .

SAFe  Feature Dashboard

The SAFe  Feature Dashboard provides a visualization of the changes in scope and the progress 
of the stories in the feature over a given period.
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Feature Summary tab

Cycle Time tab

End user and roles

End user goal with required role

End user and goal Required role

SAFe ART user: View the amount of work 
that has been completed in a feature. Gauge 
whether the feature can be completed on time.

SAFe_scrum_user

Indicators

SAFe: Sum of story points of all stories in the feature

Generates the completed line in the Feature Burnup report.

SAFe: Sum of story points of completed stories in feature

Generates the scope line in the Feature Burnup report.
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Widgets

Stories

Indicates the total number of stories in the feature.

Scope

Indicates the scope of the feature which is in story points. This widget lets you see 
at a glance how much work must be completed in a feature.

Stories Missing Estimates

Indicates the number of stories in the feature that are missing estimates.

Blocked Work

Indicates the amount of work (in story points) in the feature that is blocked.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access 
the following visualizations:

• Feature Burnup

• Story Cycle Time

For more information, see Using Solution Library for Essential SAFe dashboards.

Work item progress

Title Type Description

Stories By 
State

Bar chart At a single glance, understand the overall progress of a feature 
seeing all of its stories grouped by state.

Feature 
Burnup

Line chart
Indicates the scope changes, if any, and trends of those scope 
changes. You can estimate when the feature is likely to be 
completed.

The Feature Burnup report comprises the following series that can 
be hidden or displayed based on your preference:

• Scope: Indicates the size of the feature, as the sum of story 
points defined in this feature.

• Scope Forecast: Predicts the possibility of scope change for 
the future dates, which is based on historical data.
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Work item progress  (continued)

Title Type Description

• Completed: Indicates the amount of work (in story points) in the 
feature that is complete.

• Completed Forecast: Predicts the burnup for the future dates. 
It indicates whether you can complete the feature on time. This 
prediction is based on historical data.

Note: 
The point at which the Completed Forecast series intersects 
with or crosses the Scope Forecast series is a predictor 
for when the feature might be completed. If the Completed 
Forecast series and the Scope Forecast series do not 
appear to ever intersect, it is a warning that scope is being 
added faster than work is being completed.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story in the feature to 
move from an in-progress 
state to completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
progress state to completion. 
The size of the story bubbles 
are relative to each other 
based on their story points.

Hovering your mouse cursor 
over a bubble displays the 
following details about that 
story:

• Story points

• Date on which the story is 
moved to completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state
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Cycle Time  (continued)

Title Type Description

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
towards the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area of the 
report for a clearer view.

You can customize the Burnup report. For more information, see Customizing Essential SAFe 
dashboard reports.

SAFe  Epic Dashboard

The SAFe  Epic Dashboard provides a visualization of how the features of an epic are progressing 
over a given period of time.
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Epic Summary tab

Cycle Time tab

The SAFe epic dashboard displays such as total number of features that are complete, and 
number of stories that are missing estimates. It also indicates the pace at which the ART 
members are completing the features in the epic.
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End user and roles

End user goal with required role

End user and goal Required role

SAFe ART user: View the progress of every 
feature in the epic.

safe_scrum_user

Indicators

SAFe: Sum of story points of all stories in epics

Generates the scope series in the Epic Burnup report.

SAFe: Sum of story points of completed stories in epics

Generates the complete series in the Epic Burnup report. This series indicates the 
amount of work that has been completed in the epic.

SAFe: Count of all stories in current epic

Generates the area series the Epic Cumulative Flow Diagram report, which indicates 
the number of stories of the current epic by state.

Breakdowns

• SAFe: Epic

• SAFe: State

Widgets

Features

Indicates the total number of features in the epic.

Features Released

Indicates the number of features in the epic that have been completed.

Stories Missing Estimates

Indicates the number of stories in the epic that are missing estimates.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access 
the following visualizations:

• Epic Burnup

• Epic Cumulative Flow Diagram

• Story Cycle Time

For more information, see Using Solution Library for Essential SAFe dashboards.
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Epic Summary

Title Type Description

Feature Progress Horizontal bar chart View the progress of every feature in an epic.

Epic Burnup
Line chart

Shows the epic burnup trends. You can estimate when the epic is likely to be 
completed.

The Epic Burnup report comprises the following series that can be hidden or 
displayed based on your preference:

• Scope: Indicates the size of the epic.

• Scope Forecast: Predicts the possibility of scope change for the future dates, 
which is based on historical data.

• Completed: Indicates the amount of work in the epic that is complete.

• Completed Forecast: Predicts the burnup for the future dates. It indicates 
whether you can complete the epic on time. This prediction is based on 
historical data.

Note: 
The point at which the Completed Forecast series intersects with or 
crosses the Scope Forecast series is a predictor for when the epic might be 
completed. If the Completed Forecast series and the Scope Forecast series 
do not appear to ever intersect, it is a warning that scope is being added 
faster than work is being completed.

Epic Cumulative Flow 
Diagram

Area chart
Monitor the progress of all the stories of your epic between its actual start and 
end dates.

View the number of stories in each state by their arrival to a state, time in this 
state, and its departure from this state.

The Epic Cumulative Flow Diagram report comprises the following areas that can 
be hidden or displayed based on your preference:

• Ready: Indicates the number of stories of the epic that are ready to start work 
on.

• Work in Progress: Indicates the number of stories of the epic that are in 
development.

• Ready for Testing: Indicates the number stories of the epic that are ready to be 
tested.

• Testing: Indicates the number of stories of the epic that are currently being 
tested.

• Complete: Indicates the number of stories that are complete.
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Epic Summary  (continued)

Title Type Description

Note: 
Stories in Ready and Cancelled states are not included in this report.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story in the epic to move 
from an in-progress state to 
completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
progress state to completion. 
The size of the story bubbles 
are relative to each other 
based on their story points.

Hovering your mouse cursor 
over a bubble displays the 
following details about that 
story:

• Story points

• Date on which the story is 
moved to completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
towards the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2164



Cycle Time  (continued)

Title Type Description

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area of the 
report for clearer view.

You can customize the Burnup and Cumulative Flow Diagram reports. For more information, see 
Customizing Essential SAFe dashboard reports.

SAFe  Sprint Dashboard

Track the progress of your SAFe  stories in the current sprint and forecast sprint completion using 
the SAFe  Sprint Dashboard.

SAFe sprint dashboard widgets
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SAFe sprint dashboard burndown report

SAFe sprint dashboard burnup report

SAFe sprint dashboard cumulative flow diagram
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The dashboard:

• Displays important details of the sprint such as percentage of work that is complete, time 
elapsed, and total number of stories that are missing estimates.

• Displays the number of stories of the sprint in their current state and their progress.

• Indicates the scope changes, if any, and trends of those scope changes.

• Indicates how the team needs to progress on stories to achieve the sprint goal.

• Forecasts data showing the likelihood of completing the sprint as planned.

Note: 
Canceled stories are not included in any of this data.

End user and roles

End user and goal Required role Benefits

SAFe scrum master: Reviews 
the sprint burndown trends. 
Resolves any bottlenecks and 
targets to complete the sprint 
on time.

safe_scrum_user

• Analyse the scope changes 
for the sprint

• View current states and 
analyse the time in each 
state for the stories of the 
sprint

• Estimate sprint completion 
dates

Indicators

SAFe: Sum of story points of all stories in the current sprint

Generates the scope series in the Sprint Burndown report. The scope series 
indicates the amount of work in story points that is planned for the sprint.

SAFe: Sum of story points of active stories in the current sprint

Generates the actual burndown series in the Sprint Burndown report. The actual 
burndown series indicates the amount of work left (in story points) for completion.

SAFe: Sum of story points of completed stories in current sprint

Generates the percentage of stories completed for the current sprint.

SAFe: Time elapsed in sprint

Calculates the time to be displayed in the Time Elapsed widget.

SAFe: Count of stories in the current sprint

Generates the area series in the Sprint Cumulative Flow Diagram report. It indicates 
the number of stories in the current sprint.
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Breakdowns

• SAFe: Sprint

• SAFe: Current Sprint

• SAFe: State

Widgets

Scope

Indicates the amount of work in story points that is planned for the sprint. This 
widget lets you see at a glance how much work must be completed to achieve the 
sprint goal. It also lets you drill down to detail on the stories planned into the sprint.

Percent Completed

Indicates the percentage of work that has been completed in the sprint using story 
points. This widget lets you see at a glance how much work has been completed in 
the sprint. Together with the adjacent Time Elapsed widget, these widgets lets you 
easily see whether you are completing work at a rate consistent with achieving the 
sprint goal on schedule.

Time Elapsed

Indicates the percentage of time that has elapsed between the start date and 
planned end date of the sprint. Together with the adjacent Percent Completed 
widget, these widgets let you easily see whether you are completing work at a rate 
consistent with achieving the sprint goal on schedule.

Committed Points

Indicates the committed scope (in number of story points) of the sprint. Together 
with the adjacent Scope widget, these widgets let you see difference between the 
scope committed at the start of the sprint and the current scope of the sprint.

Note: 
This widget is not visible by default. You can add it from Reports to your 
dashboard. For more information, see Edit a responsive dashboard .

Blocked Work

Indicates the amount of work (in story points) in the sprint that is blocked.

Stories Missing Estimates

Indicates the total number of stories in the sprint that are missing estimates. It is 
required that you use estimates for the other indicators, widgets, and reports on this 
dashboard to be meaningful.

Note: 
If you do not estimate stories, enter a "1" in the Story Points  field. The other 
indicators, widgets, and reports will then effectively function by count.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access 
the following visualizations:
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• Sprint Burnup

• Sprint Cumulative Flow Diagram

For more information, see Using Solution Library for Essential SAFe dashboards.

Title Type Description

Sprint 
Burndown

Line chart
Indicates the scope changes, if any, and trends of those scope 
changes. Indicates the ideal pace of work, how much work is 
remaining, and if the scope is likely to be completed before the 
end of the sprint. The Sprint Burndown report comprises the 
following series that can be hidden or displayed based on your 
preference:

• Scope: Indicates the amount of work that is currently planned 
for the sprint. This can vary if stories are added to or removed 
from the sprint after it is started.

• Scope Forecast: Predicts the possibility of scope change for 
the future dates based on historical changes in the current 
sprint.

• Ideal Burndown: Indicates how the team needs to progress on 
stories to complete the sprint on time.

• Remaining: Indicates the amount of work left for completion in 
the sprint.

If the actual burndown (Remaining) is above the ideal 
burndown, it implies that there is more work left than originally 
estimated. The team is running behind the schedule of the 
sprint. If the actual burndown (Remaining) is below the ideal 
burndown, it implies that there is less work left than originally 
estimated. The team is running ahead of the schedule of the 
sprint.

• Remaining Forecast: Predicts the burndown for the future 
dates based on historical changes in the current sprint.

Sprint 
Burnup

Line chart 
Shows the sprint burnup trend indicating scope changes. 
Forecasts future changes in scope and the trend of work 
completion.

The Sprint Burnup report comprises the following series that can 
be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that is planned for the 
sprint.

• Scope Forecast: Predicts the possibility of scope change for 
the future dates, which is based on historical data.

• Completed: Indicates the amount of work completed in the 
sprint.

• Completed Forecast: Predicts the burnup for the future dates. 
It indicates whether you can complete the sprint on time. The 
prediction is based on historical data.
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Title Type Description

Sprint 
Cumulative 
Flow 
Diagram

Area 

chart

Monitor the progress of all the stories of your sprint between its 
actual start and end dates.

View the number of stories in each state by their arrival to a state, 
time in this state, and its departure from this state.

The Sprint Cumulative Flow Diagram report comprises the 
following areas that can be hidden or displayed based on your 
preference:

• Ready: Indicates the number of stories in the sprint that are 
ready to start work on.

• Work in Progress: Indicates the number of stories in the sprint 
that are in development.

• Ready for Testing: Indicates the number stories in the sprint 
that are ready to be tested.

• Testing: Indicates the number of stories in the sprint that are 
currently being tested.

• Complete: Indicates the number of stories in the sprint that are 
complete.

Note: 
Stories in Ready and Cancelled states are not included in 
this report.

You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more 
information, see Customizing Essential SAFe dashboard reports.

SAFe  Prior Sprint Dashboard

The SAFe  Prior Sprint Dashboard provides data visualization on scope, actual burnup and 
burndown, and forecast trends of previous sprints. Analyze the data and plan the work for 
upcoming sprints.

SAFe prior sprint dashboard widgets
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SAFe prior sprint dashboard burndown report

SAFe prior sprint dashboard burnup report

Note: 
Canceled stories are not included in any of this data.

End user and roles

End user and goal Required role Benefits

SAFe scrum master: Analyze 
data on scope, actual burnup 
and burndown, and forecast 
trends of previous sprints.

SAFe_scrum_user

• Analyze sprint burndown 
and burnup trends

• Use the data to plan for 
upcoming sprints

Indicators

SAFe: Sum of story points of all stories in the current sprint

Generates the scope series in the SAFe Sprint Burndown report.
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SAFe: Sum of story points of active stories in the current sprint

Generates the actual burndown series in the SAFe Sprint Burndown report.

Breakdowns

• SAFe: Sprint

• SAFe: Prior Sprint

Widgets

Committed points

Indicates the committed scope (in number of story points) of the sprint.

Stories

Indicates the total number of stories that were completed in the previous sprint.

Completed

Indicates the amount of work (in story points) that was completed in the previous 
sprint.

Stories Missing Estimates

Indicates the total number of stories in the previous sprint that were missing 
estimates.

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access 
the Sprint Burnup report. For more information, see Using Solution Library for Essential SAFe 
dashboards.

Title Type Description

Sprint 
Burndown

Line 

chart

Shows the scope and rate of scope change, the ideal rate for 
work completion, and the actual rate of work completion. Analyze 
the burndown trends and accordingly plan the workload for an 
upcoming sprint.

The Sprint Burndown report comprises the following series that 
can be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that is planned for the 
sprint.

• Ideal Burndown: Indicates how the team needs to progress on 
stories to complete the sprint on time.

• Remaining: Indicates the amount of work left for completion in 
the sprint.

If Remaining is above the Ideal Burndown, it implies that there 
is more work left than originally estimated. The team is running 
behind the schedule of the sprint.

If the Remaining is below Ideal Burndown, it implies that there 
is less work left than originally estimated. The team is running 
ahead of the schedule of the sprint.
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Title Type Description

Analyze the burndown trends and accordingly plan the workload 
for an upcoming sprint.

Sprint 
Burnup

Line chart
Shows the previous sprint burnup trend indicating scope 
changes. Analyze future changes the trend of team's work 
completion.

The Sprint Burnup report comprises the following series that can 
be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that is planned for the 
sprint.

• Completed: Indicates the amount of work completed in the 
sprint.

You can customize the Burnup and Burndown reports. For more information, see Customizing 
Essential SAFe dashboard reports.

SAFe  PI Dashboard

The SAFe  PI Dashboard allows you to track the progress of your features in the current program 
increment (PI).
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PI Summary tab
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Cycle Time tab

The SAFe PI dashboard provides the following details:

• Displays important details of the PI such as percentage of work that is complete, time elapsed, 
and total number of stories that are missing estimates.

• Displays the number of stories of the PI in their current state and their progress.

• Indicates the scope changes, if any, and trends of those scope changes.

• Indicates the pace at which the ART members are completing features that are planned for the 
PI.

• Forecasts data showing the likelihood of completing the PI as planned.

• Shows time elapsed for the stories of the PI to go from an in-progress state to a completed 
state.

End user and roles

End user goal with required role

End user and goal Required role

SAFe ART user: Track the progress of your 
stories that are planned for the PI. Resolve any 
bottlenecks and target to complete the PI on 
time.

safe_scrum_user

Indicators

SAFe: Count of all stories in the current PI

Generates the area series the PI Cumulative Flow Diagram report, which indicates 
the number of stories of the current PI by state.

SAFe: Sum of story points of all stories in the current PI

Generate the scope series in the PI Burndown report. This series indicates the 
amount (in story points) of work planned for the PI.

SAFe: Sum of story points of completed stories in the current PI
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Generates the actual burndown series in the PI Burndown report, and the 
completed series in the PI Burnup report. These series indicate the amount of work 
(in story points) that has been completed for the PI.

SAFe: Sum of story points of active stories in the current PI

Generates the scope series in the PI Burndown and PI Burnup reports. The scope 
series indicates the amount of work (in story points) that is planned for the PI.

SAFe: Time elapsed in the PI

Calculates the time to be displayed in the Time Elapsed widget.

Breakdowns

• SAFe: PI

• SAFe: State

Widgets

Scope

Indicates the amount of work in story points that is planned for the PI. This widget 
lets you see at a glance how much work must be completed to achieve the PI goal. It 
also lets you drill down to detail on the stories that are planned for completion in the 
PI.

Percent Completed

Indicates the percentage of work that has been completed in the PI using story 
points. This widget lets you see at a glance how much work has been completed in 
the PI. Together with the adjacent Time Elapsed widget, these widgets let you easily 
see whether you are completing work at a rate consistent with achieving the PI goal 
on schedule.

Time Elapsed

Indicates the percentage of time that has elapsed between the start date and 
planned end date of the PI. Together with the adjacent Percent Completed 
widget, these widgets let you easily see whether you are completing work at a rate 
consistent with achieving the PI goal on schedule.

Features

Indicates the total number of features that are planned for completion in the PI.

Features Released

Indicates the total number of features in the PI that have been completed.

Stories Missing Estimates

Indicates the total number of stories in the PI that are missing estimates. It is 
required that you use estimates for the other indicators, widgets, and reports on this 
dashboard to be meaningful.

Note: 
If you do not estimate stories, enter a "1" in the Story Points  field. The other 
indicators, widgets, and reports will then effectively function by count.

Blocked Work

Indicates the amount of work (in story points) in the PI that is blocked.
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Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access 
the following visualizations:

• PI Cumulative Flow Diagram

• Story Cycle Time

For more information, see Using Solution Library for Essential SAFe dashboards.

SAFe PI Summary

Title Type Description

PI Burndown Line chart Indicates the scope changes, if any, and trends of those scope changes. Indicates 
the ideal pace of work, how much work is remaining, and if the scope is likely to be 
completed before the end of the PI. The PI Burndown report comprises the following 
series that can be hidden or displayed based on your preference:

• Scope: Indicates the amount of work that is planned for the PI.

• Scope Forecast: Predicts the possibility of scope change for the future dates in 
the PI. This prediction is based on historical data.

• Ideal Burndown: Indicates how the ART members need to progress on stories to 
deliver the PI on time.

• Remaining: Indicates the amount of work completed in the PI.

• Remaining Forecast: Predicts the burndown for the future dates in the release. It 
indicates whether you can deliver the PI on time.

PI burnup Line chart Analyse the burnup trends, and estimate when the PI work is likely to be completed. 
The PI burnup report comprises the following series that can be hidden or displayed 
based on your preference:

• Scope: Indicates the amount of work that is planned for the PI.

• Scope Forecast: Predicts the possibility of scope change for the future dates. 
This prediction is based on historical data.

• Completed: Indicates the amount of work in the PI that is complete.

• Completed Forecast: Predicts the burnup for the future dates in the PI. It 
indicates whether you can complete the PI on time.

Note: 
The point at which the Completed Forecast series intersects with or crosses 
the Scope Forecast series is a predictor for when the PI might be completed. If 
the Completed Forecast series and the Scope Forecast series do not appear 
to ever intersect, it is a warning that scope is being added faster than work is 
being completed.

PI Feature Progress Horizontal bar chart Analyze the progress of every feature of the PI, by viewing the count of the stories 
segregated by their state.
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SAFe PI Summary  (continued)

Title Type Description

Velocity by Sprint Bar chart View the velocity of the ART members across PIs. Understand if the ART members 
are achieving a stable, predictable velocity over sprints, and meeting the 
commitments.

PI Cumulative Flow 
Diagram

Area chart
Monitor the progress of all the stories of your PI between its actual start and end 
dates.

View the number of stories in each state by their arrival to a state, time in this state, 
and its departure from this state.

The PI Cumulative Flow Diagram report comprises the following areas that can be 
hidden or displayed based on your preference:

• Ready: Indicates the number of stories of the PI that are ready to start work on.

• Work in Progress: Indicates the number of stories of the PI that are in 
development.

• Ready for Testing: Indicates the number stories of the PI that are ready to be 
tested.

• Testing: Indicates the number of stories of the PI that are currently being tested.

• Complete: Indicates the number of stories that are complete.

Note: 
Stories in Ready and Cancelled states are not included in this report.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story in the PI to move 
from an in-progress state to 
completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
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Cycle Time  (continued)

Title Type Description

progress state to completion. 
The size of the story bubbles 
are relative to each other 
based on their story points.

Hovering your mouse cursor 
over a bubble displays the 
following details about that 
story:

• Story points

• Date on which the story is 
moved to completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
towards the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area of the 
report for a clearer view.
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Cycle Time  (continued)

Title Type Description

You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more 
information, see Customizing Essential SAFe dashboard reports.

SAFe  Prior PI Dashboard

The SAFe  Prior PI Dashboard provides data visualization on scope, actual burndown, and 
forecast trends of previous program increments (PI). Analyze the data and plan the work for 
upcoming PIs.

SAFe Prior PI dashboard widgets
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SAFe Prior PI burnup report

SAFe Prior PI burnup report

End user and roles

End user and goal Required role

SAFe ART user: Analyze the scope, burndown, 
and forecast trends of previous program 
increments.

safe_scrum_user

Indicators

SAFe: Sum of story points of completed stories in the active PIs

Generates the actual burndown series in the PI Burndown report, and the 
completed series in the PI Burnup report.
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SAFe: Sum of story points of all stories in active PIs

Generates the scope series in the PI Burndown and PI Burnup reports.

Breakdowns

SAFe: Prior PI.

Widgets

Features

Indicates the total number of features that were planned for completion in the 
previous PI.

Completed

Indicates the total number of features that were completed in the previous PI.

Stories Missing Estimates

Indicates the total number of stories in the previous PI that were missing estimates.

Data visualizations

Title Type Description

PI Burnup Line chart Analyze the burnup trends of 
the previous PI.

PI Burndown Line chart View the scope and rate of 
scope change, the ideal rate 
for work completion, and the 
actual rate of work completion. 
Analyze the burndown trends 
and accordingly plan the 
workload for an upcoming PI.

PI Velocity Chart Bar chart View the velocity of the ART 
members for the previous PI 
and plan the workload for an 
upcoming PI.

You can customize the Burnup and Burndown reports. For more information, see Customizing 
Essential SAFe dashboard reports.
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SAFe  ART Dashboard

Visualize how the ART members are progressing on features and program increments (PIs) over 
a given period using the SAFe  ART dashboard. Gain insight on the overall velocity of the ART 
members, historical performance of the ART on the PI objectives so that you can plan the work 
accordingly for the upcoming program increments.

ART Summary tab

Cycle Time tab

Program Predictability Tab
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End user and roles

End user goal with required role

End user and goal Required role

SAFe ART user: View how the ART members 
are progressing on features and PIs.

safe_scrum_user

Data visualizations

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access 
the Story Cycle Time report. For more information, see Using Solution Library for Essential SAFe 
dashboards.

ART Summary

Title Type Description

Feature Progress Horizontal bar chart View the progress of all 
the features that the ART 
members are working on.

Velocity by PI Bar chart View the velocity of the 
ART across various PIs. 
Understand if the ART is 
achieving a stable, predictable 
velocity.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story in the ART to move 
from an in-progress state to 
completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
progress state to completion. 
The size of the story bubbles 
are relative to each other 
based on their story points.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2184



Cycle Time  (continued)

Title Type Description

Pointing your mouse cursor 
over a bubble displays the 
following details about that 
story:

• Story points

• Date on which the story is 
moved to completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
towards the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area of the 
report for a clearer view.
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Title Type Description

ART: Program Predictability Line chart
Track the historical 
performance of the ART on 
achieving their PI objectives.

The series in this report 
show the performance of the 
ART as whole and also the 
performance of each team of 
the ART.

The horizontal axis shows 
the completed PIs and the 
vertical axis shows the range 
of business value achieved in 
percentage (%).

Each series is the 
representation of the business 
value achieved, which is 
calculated from the planned 
and actual business values 
of the PI objectives. For more 
information, see SAFe PI 
objectives.

From the chart, you can see 
which teams are consistently 
achieving between 80% and 
100% of the set PI objectives, 
which is the ideal range 
according to SAFe.

The Linear (ART) dotted-line 
series on the chart provides 
a linear regression on the 
business value achieved for 
the ART. This series serves 
as an indication of how the 
scores of the business value 
achieved are trending.

Pointing your mouse cursor 
at a data point on any of the 
series gives you the numeric 
value of business value 
achieved.

• Clicking any of the data 
points for a PI on the 
ART series lets you drill 
down and see the list of PI 
objectives that are used 
to plot the chart for the PI 
which you clicked.
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Title Type Description

Filtering the list by setting 
the Type column to Program 
displays the PI objectives 
only for the ART.

• Clicking any of the data 
points for a PI on a team 
series lets you drill down 
and see the list of PI 
objectives that are used 
to plot the chart for the PI 
which you clicked.

The objectives shown in this 
list are only for the selected 
team.

SAFe  Team Dashboard

Visually analyze how a team is progressing on stories over a given period. Gain insight on the 
overall velocity of the team and helps you plan the team's capacity for the upcoming sprints and 
program increments (PIs). In addition, this dashboard provides details of all the team members.

Work item progress tab
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Sprint Performance tab

Team Members tab
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Cycle Time tab

Program Predictability

End user and roles

End user goal with required role

End user and goal Required role

SAFe  scrum master: View how your team is 
progressing on stories.

safe_scrum_user

Indicators

SAFe: Average Story State Duration

Generates data that is displayed in the Average Cycle Time per State report.

SAFe: Story State Duration

Generates data that is displayed in the Time in State report.

Breakdowns

• SAFe: State

• SAFe: Team
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Data visualizations

The Team Dashboard visualizations are segregated into the following tabs:

• Work item progress: Reports of Active Stories by State, Time in State, and Average Cycle Time 
per State

• Sprint Performance: Reports of Velocity History and Sprint Variance

• Team Members: List of all the members of the team

Note: 
For existing customers who upgrade to the latest version, the list of the team members 
appears in both the Work item progress and Team Members tabs but only one of these 
locations would display the accurate information. You can remove this widget from the 
Work item progress tab to avoid this issue. For more information on how to remove a 
widget, see Edit a responsive dashboard .

• Cycle Time: Report of the story cycle for the team.

• Program Predictability: Report of the team's historical performance in meeting the PI 
objectives.

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for 
Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access 
the following reports:

• Velocity History

• Velocity by Type

• Sprint Variance

• Story Cycle Time

For more information, see Using Solution Library for Essential SAFe dashboards.

Work item progress

Title Type Description

Active Stories By 
State

Bar chart View the total number of stories in each state of a story, for 
example, testing, work in progress, and testing.

Time in State Bar chart View the time in hours that the team spends in each state 
of a story.
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Work item progress  (continued)

Title Type Description

Average Cycle 
Time per State

Line chart View how the work in progress is trending over time and 
what are the most significant cycle times.

Sprint Performance

Title Type Description

Velocity History Grouped bar chart Gain an insight on the overall 
velocity of the team for the 
past 10 sprints. Understand if 
the team is achieving a stable, 
predictable velocity, and is 
meeting the commitments.

The Team Velocity History 
report comprises the following 
series per sprint that can be 
hidden or displayed based on 
your preference:

• Team Capacity: Indicates 
the team capacity (in story 
points) for the sprint.

• Committed Story Points: 
Indicates the number of 
story points committed by 
the team for the sprint.

• Completed Story Points: 
Indicates the number of 
story points completed by 
the team for the sprint.

• Average Completed Points: 
Indicates the average 
number of story points 
completed by the team for 
the sprint.

• Linear (Actual): Indicates 
if the amount of completed 
work is trending up, trending 
down, or relatively stable 
over sprints.

Velocity by Type
Stacked bar chart Analyze the way your team's 

velocity changes over time 
and compare the team's 
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Sprint Performance  (continued)

Title Type Description

strategic workload with 
operational or other types of 
workload.

The bar charts have two 
stacks that show the sum 
of the story points of the 
following types of completed 
stories:

• Regular stories

• Stories added to the unified 
backlog from the items in 
the triage board

Clicking any bar would take 
you to its corresponding sprint 
details.

Data displayed in this report is 
of the past 10 sprints with the 
earliest sprint on the left.

Note: 
This report is not 
available by default. You 
can add it from Scrum 
custom charts to your 
dashboard. For more 
information, see Edit a 
responsive dashboard .

Sprint Variance Grouped bar chart Analyze the percentage 
variance of the team 
compared to the capacity and 
committed points, for the past 
10 sprints.

The Team Sprint Variance 
report comprises the following 
series per sprint that can be 
hidden or displayed based on 
your preference:

• Completed to Capacity: 
Indicates the percentage of 
completed work compared 
to the expected capacity for 
the sprint.

• Completed to Committed: 
Indicates the percentage of 
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Sprint Performance  (continued)

Title Type Description

completed work compared 
to the committed work of the 
team for the sprint.

Team Members

Title Type Description

Team Members List
View the details of all team 
members.

Cycle Time

Title Type Description

Story Cycle Time Bubble chart Identify the time taken for 
each story, which the team 
has worked on, to move 
from an in-progress state to 
completion.

Each bubble on the graph 
represents a story. The height 
of the bubble from the x-
axis shows how long that 
story took to move from an in-
progress state to completion. 
The size of the story bubbles 
are relative to each other 
based on their story points.

You can compare the cycle 
times of stories with different 
story points and analyze 
the trend in the time taken 
by the team to complete 
them. Identify the stories that 
took longer to complete and 
analyze the reasons so that 
you can chart an action plan 
to reduce the team's cycle 
time in the future.

Pointing your cursor over a 
bubble displays the following 
details about that story:
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Cycle Time  (continued)

Title Type Description

• Story points

• Date on which the story is 
moved to completion

• Total cycle time (in days) of 
the story

• Number of days that the 
story was in the Work in 
progress  state

• Number of days that the 
story was in the Ready for 
testing  state

• Number of days that the 
story was in the Testing 
state

From the Story State section 
toward the right of the report, 
you can filter the report to view 
the cycle time of the stories for 
the selected states. The chart 
displays the cycle time for 
each story as the cumulative 
sum of all duration of the 
selected states.

If there are too many stories 
at any area of the chart and 
the bubbles appear crowded 
on the report, you can zoom 
in that particular area for a 
clearer view.
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Cycle Time  (continued)

Title Type Description

Note: 
The stories shown in this 
chart are the ones that 
the team has completed 
in the past 30 days.

Title Type Description

Team: Program Predictability Line chart
Track the historical 
performance of the team on 
achieving their PI objectives.

The series in this report show 
the performance of the team, 
and the ART that this team 
belongs to, over multiple PIs.

The horizontal axis shows 
the completed PIs and the 
vertical axis shows the range 
of business value achieved in 
percentage (%).

Each series is the 
representation of the business 
value achieved, which is 
calculated from the planned 
and actual business values 
of the PI objectives. For more 
information, see SAFe PI 
objectives.

From the chart, you can if the 
team is consistently achieving 
between 80% and 100% of the 
set PI objectives, which is the 
ideal range according to SAFe.

The Linear (Team) dotted-line 
series on the chart provides 
a linear regression on the 
business value achieved for 
the team. This series serves 
as an indication of how the 
scores of the business value 
achieved are trending.

Pointing your cursor at a data 
point on any of the series 
gives you the numeric value of 
business value achieved.
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Title Type Description

• Clicking any of the data 
points for a PI on the 
ART series lets you drill 
down and see the list of PI 
objectives that are used to 
plot the chart for the PI that 
you clicked.

Filtering the list by setting 
the Type column to Program 
displays the PI objectives 
only for the ART.

• Clicking any of the data 
points for a PI on a team 
series lets you drill down 
and see the list of PI 
objectives that are used to 
plot the chart for the PI that 
you clicked.

The objectives shown in this 
list are only for the selected 
team.

Customizing Essential SAFe  dashboard reports

Customize the Burnup, Burndown, and Cumulative Flow Diagram reports of your dashboards 
according to the custom states of your SAFe  stories.

• Configure indicators to reflect your customizations.

For example, if there are any new states introduced to the SAFe  story table, then the 
corresponding indicators and indicator sources for the story table that rely on the State  field 
must be updated as well.

For more information, see Customize indicators of your Essential SAFe dashboard reports.

• Update or clone UI scripts for modifications to use your own indicators.

Add customizations by overriding methods in empty implementation (Impl) classes of UI 
scripts such as SafeAreaChartImpl and SafeVelHistoryImpl.

For more information, see Update UI scripts to use your indicators for Essential SAFe 
dashboards.

Customize indicators of your Essential SAFe  dashboard reports

Configure indicators to reflect your customizations in Essential SAFe  dashboards.

Before you begin
Role required: admin or pa_admin
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Procedure

1. Navigate to All  > Performance Analytics  > Indicators  > Automated Indicators.

2. Search for and open the required indicator.
For example, if you want to customize the SAFe Burnup report, open SAFe: Sum of story points 
of all stories in the feature in current sprint from the list of indicators.

3. In the Additional conditions section, modify the conditions according to your preferences.

4. Click Update.

Update UI scripts to use your indicators for Essential SAFe  dashboards

Customize UI scripts by overriding methods in empty implementation (Impl) classes.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System UI  > UI Scripts.

2. Search for and open the required UI script.
For example, if you want to customize the SAFe  Sprint Cumulative Flow Diagram report, open 
SAFeAreaChartImpl from the list of UI scripts.

3. Overwrite the base implementation according to your preferences.

4. Click Update.

Customize story states of your Essential SAFe  dashboard reports

Configure story states to reflect your customizations on the Essential SAFe  dashboards.

Before you begin
Role required: admin or pa_admin

Procedure

1. Navigate to All  > Scaled Agile Framework (SAFe)  > Stories.

2. Open a story to which you would like to add the custom states.

3. Right-click State  and select Configure Choices  from the drop-down menu.

4. In the New item text  field, enter the new custom state name.

5. In the Numeric value  field, enter any corresponding number.

6. Click Add.
The new state appears in the Selected list.

7. Click Save.

Work Progress Status for SAFe
The Work Progress Status for SAFe  application provides you with indicators such as estimated 
completion date and progress status (green, yellow, red) for all your SAFe  epics and features.
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Important: 

Starting with the Xanadu  release, the plugins Portfolio SAFe, Essential SAFe, Performance 
Analytics Content Pack for Essential SAFe, Work Progress Status for SAFe, Agile - Scaled 
Agile Framework - Unified Backlog, and Read only roles for SAFe are being prepared for 
future deprecation. These plugins will be hidden and can no longer be activated on new 
instances but will continue to be supported. Enterprise Agile Planning in Strategic Planning 
provides the latest experience for this functionality.

For more information on the deprecation process and its impact, see the Application/Plugin 
Deprecation Process [KB0867184]  article in the Now Support  Knowledge Base.

As a product owner or a team lead, these indicators help you understand if your SAFe  team could 
complete the work by the planned end dates so that you can adjust your plans accordingly. 
As a team member working on SAFe  stories, these status indicators help you understand your 
contribution to the overall work and your progress so that you can review your work strategy if 
necessary.

Note: 
You must enter a value for the Planned end date  field for a SAFe  feature or epic for these 
work progress status indicators to populate.

Reviewing progress status for SAFe  features and epics

Understand if your work would be completed by the planned end dates by reviewing progress 
status of your SAFe  features and epics.

Navigate to Scaled Agile Framework (SAFe)  > Epics  or Scaled Agile Framework (SAFe)  > 
Features  and filter the records for your team.

The Status column of the list shows a Green, Yellow, or Red indicator for each record to indicate 
the following:

• Green: Your work is on track to be complete by the planned end date.

• Yellow: Your work is off track and your plan of execution must be reviewed.

• Red: Your epic or feature is not progressing well and might be at risk of not being complete by 
the planned end date.

The estimated completion date displays a date with the likelihood of the epic's or feature's 
completion.

SAFe epic progress status

The [SAFe] daily data collection job  helps generate the burnup report for your epics and features. 
Using the data generated for these epic burnup reports, an estimated completion date is 
determined. You can see that this date is the intersection of Completed and Scope forecast 
series in the respective burnup reports.

Based on this estimated completion date, the progress status for your SAFe  epics and features is 
determined. Progress status is calculated only under the following conditions:
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• Planned end date is populated for the SAFe  epic and feature.

• Percentage completion of the epic is a value greater than 0.

The color of the progress status indicator is determined using the following conditions:

• Green: Estimated completion date is on or before the planned end date.

• Yellow: Estimated completion date is beyond the planned end date by a deviation of 1% to 14%.

• Red: Estimated completion date is beyond the planned end date by a deviation of 15% or more.

Related topics

SAFe Feature Dashboard

SAFe Epic Dashboard

Test Management applications
The ServiceNow®  Test Management  application streamlines the management of testing 
processes to help you deliver software products more efficiently and with fewer errors.

Test Management  is available in two versions.

• Test Management 2.0  offers many enhancements, including integration with Agile 
Development 2.0  and Scaled Agile Framework (SAFe)

• Test Management 1.0  may have specific capabilities that are useful for your organization.

Use the following comparison to make an informed decision for your organization.

Differences between Test Management 1.0  and Test Management 2.0

Test Management 1.0  covers user acceptance testing. It does not include some key data model 
structures like test versions, test runs, or test results. In addition, you cannot structure test plans 
in Test Management 1.0.

Test Management 2.0  includes data model structures that match industry standards. It provides 
you with an intuitive user interface called the Test Board  from which you can structure test plans 
and plan the phases of your testing effort.

Tip: 

If you need Agile Development integration, test versioning, or detailed test run traceability, 
use Test Management 2.0. If your organization requires only basic user acceptance testing 
without Agile integration, Test Management 1.0 may be sufficient.

Feature Test Management 1.0 Test Management 2.0

Integration with 
Project Portfolio 
Management

no yes

Integration 
with Agile 
Development 
2.0

no yes

Integration with 
Scaled Agile 

no yes

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2199



Feature Test Management 1.0 Test Management 2.0

Framework 
(SAFe)

Test version You cannot create and 
maintain multiple versions 
of a test.

You can create and maintain multiple versions 
of a test.

Test relation You can associate a test to 
one test suite only.

You can associate a test to multiple test sets, 
test plans, and test cycles.

Time duration You can create a test plan 
describing how a product 
or a feature is to be tested.

• You can create a test plan describing how a 
product or a feature is to be tested and the 
time frame in which the test plan must be run.

• You can further decompose a test plan into 
test cycles, test cycles into test execution 
sets, and specify a time range for their 
execution.

Traceability of 
test runs and 
test results

You can:

• run a single test at a time.

• view the test result.

You can:

• run a single test at a time.

• view which version of test has been run.

• view the test result.

Note: 

• If you are an existing Test Management  user on a release prior to London, you are using 
Test Management  1.0 activated through the Test Management  (com.snc.test_mgmt) 
plugin. See the Test Management 1.0  documentation for more information.

• If you are a new user, you can activate the Test Management 2.0 
(com.snc.test_management.2.0) plugin as it provides enhanced testing capabilities. See 
the Test Management 2.0documentation for more information.

Domain separation and Test Management
Domain separation is supported in Test Management. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service 
provider use cases.

• The application supports domain separation at run time. The domain separation includes 
separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s 
message, the customer must be able to see the SP's response.
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For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

Test Management 1.0
The ServiceNow®  Test Management 1.0  application provides a tool for manual software testing.

With the Test Management  plugin (com.snc.test_mgmt), test managers and testers can perform 
the following functions and manage all phases of the testing process.

• Create and maintain the test repository by creating test suites, test cases, and tests. For more 
information, see Create a test suite.

• Enable test execution by creating test plans, adding test cases, and assigning testers to test 
cases. For more information, see Create a test plan.

• Initiate the testing process and monitor the progress.

• Perform tests and record test results. For more information, see Performing tests and updating 
the test status.

• Update test case status. For more information, see Update the status of a test case.

• Report defects and retest, as necessary. For more information, see Report a defect from a 
failed test.

• Evaluate test results and complete the test plan sign-off form. For more information, see 
Complete the test plan sign-off.

• View testing reports on the Test Management dashboard. For more information, see Test 
Management dashboard.

Activate Test Management

To activate the Test Management  (com.snc.test_mgmt) plugin you must have an admin role.

Before you begin
Role required: admin

About this task
Note: 

There are two ways to activate the Test Management  plugin:

• As an individual application

• As part of the Project Portfolio Suite with Financials  plugin.

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.
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Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .

Components installed with Test Management

Several types of components are installed with activation of the Test Management  plugin, 
including tables and user roles.

Note: 
The Application Files table lists the components that are installed with this application. 
For instructions on how to access this table, see Find components installed with an 
application .

Roles installed

Role title [name] Description
Contains 
roles

Test manager

[tm_test_manager]

Manages test plans and test suites (metadata). Has all 
privileges within test management, including planning, 
execution, and administration.

tm_tester

Tester

[tm_tester]

Executes test cases and tests. feature_user

Tables installed

Table Description

Test Case

[tm_test_case]

Stores the test cases.

Test Case Instance

[tm_test_case_instance]

Extends the Planned Task table.

Test Suite

[tm_test_suite]

Stores the test suites.

Test Environment

[tm_test_environment]

Stores the test environments.

Test

[tm_test]

Stores the tests.
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Table Description

Test Instance

[tm_test_instance]

Stores the tests under a test plan.

Test Plan

[tm_test_plan]

Stores the test plans. Extends the Planned Task table.

Test Case Defects

[m2m_tm_test_case_instance_defect]

Stores the test case defects that are recorded for failed 
tests.

Business stakeholder role for Test Management 1.0

Use the business stakeholder role to read and retrieve data from any table of the Test 
Management 1.0  application to generate reports.

When you activate the Business Stakeholder plugin (com.snc.business_stakeholder) 
in your ServiceNow  instance, the Read only roles for Test Management 1.0 plugin 
(com.snc.tm1_read_roles) is also activated. This plugin provides a business stakeholder role 
(sn_tm1_read) with which you can access all the tables of the Test Management 1.0  application. 
This role also allows read-only access to the Test Management dashboard. You can assign this 
role to any user in your organization who is a business stakeholder.

Plugin availability

If you are a new customer, the Read only roles for Test Management 1.0 plugin 
(com.snc.tm1_read_roles) is activated on zBoot. However, the business stakeholder 
role (sn_tm1_read) is available only when you activate the Test Management 1.0  plugin 
(com.snc.test_mgmt).

If you are an upgrade customer, you must manually activate the Read only roles for Test 
Management 1.0 plugin (com.snc.tm1_read_roles).

Test Management 1.0  tables accessible by users with the business stakeholder 
role

When both the Read only roles for Test Management 1.0 plugin (com.snc.tm1_read_roles) and 
Test Management 1.0  plugin (com.snc.test_mgmt) are active in your ServiceNow  instance, the 
user with the business stakeholder role (sn_tm1_read) has read access to the following tables.

Test Management 1.0  tables

Table Description

Test Case

[tm_test_case]

Stores the test cases.

Test Case Instance

[tm_test_case_instance]

Extends the Planned Task table.

Test Suite

[tm_test_suite]

Stores the test suites.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2203



Test Management 1.0  tables  (continued)

Table Description

Test Environment

[tm_test_environment]

Stores the test environments.

Test

[tm_test]

Stores the tests.

Test Instance

[tm_test_instance]

Stores the tests under a test plan.

Test Plan

[tm_test_plan]

Stores the test plans. Extends the Planned Task table.

Test Case Defects

[m2m_tm_test_case_instance_defect]

Stores the test case defects that are recorded for failed 
tests.

Test Management  key terms

Key terms describe the terminology used in Test Management.

Key terminology

Term Definition

Test suite A repository of test cases. Test cases in a test suite can be copied over to a test 
plan.

Test case A collection of related tests. A test case is saved as part of a test suite and can 
be added to a test plan. Each test case within a test plan has an assigned tester.

Test A collection of conditions or steps used to determine whether a feature is 
working correctly. A test also includes an expected result, which is used to 
determine if the test case passes or fails.

Test plan The tasks for how a product or a feature is to be tested. A test plan includes one 
or more test cases and can also specify a test environment. The test manager 
uses the test plan to assign and execute test cases and to track the testing 
progress.

Test 
environment

The instance where testing should be performed, specified as a URL. A test 
environment is an optional parameter that the test manager can associate with a 
test plan.

Test 
execution

The process of performing tests. The test manager assigns testers to test cases 
in a test plan; testers perform the tests in the assigned test cases.

Guided test 
execution

An automated notification process for performing tests. The test manager 
assigns testers to test cases in a test plan and initiates testing from the Test Plan 
form. Testers receive notification to begin testing using the Assessments engine.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2204



Test Management process flow

The tasks associated with manual software testing can be divided into several steps.

The test manager and the tester are involved in the following activities in a manual testing 
process for a product or feature:

• Build the test repository by creating test suites, test cases, and tests.

• Create a test plan to test a specific product or feature

• Adds test cases to the test plan.

• Assign a tester to each test case.

• If required, define a test environment.

• Perform tests for the assigned test cases.

• Record the results and update the status of each test.

• Update the status of test cases.

• Monitor the progress of the test plans, test cases, and tests.

Stakeholders review the test results and any open issues to decide on the sign-off of the test 
plan.

Except for completing the test plan sign-off form at the end, there is no required order for 
performing these testing tasks. Each task can be independently performed.

Setting up the manual testing process

Set up and monitor the test suites, test cases, and test plans.

With Test Management 1.0, you can perform the following tasks:

• Create and maintain the test repository, including test suites, test cases, and tests.

• Create test plans.

• Define test environments, if desired.

• Add test cases to a test plan.

• Assign a tester to each test case.

• Notify testers to begin testing.

• Monitor the testing process.

• Evaluate test results.

• Complete the test sign-off form.

Test suites

Use test suites to group test cases together so that you can execute your tests efficiently.

Navigate to Test Management  > Test Repository  > Test Suites  to display a list of test suites. Click 
a test suite to display the Test Suite form, which lists all test cases included in the suite.

Create a test suite

A test suite is made up of one or more test cases that are grouped for execution purposes.

Before you begin
Role required: tm_test_manager or tm_tester
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Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Suites.

2. Click New.

3. On the form, fill in the fields.

Test Suite form

Field Description

Number System-generated unique identifier of the test suite.

Name Name of the test suite.

Active Option to indicate if the test suite is active.

If indicated as active, this test suite is visible to users when they try to add a test 
case to this suite from the Test Case form.

Owner Owner of the test suite.

Description Detailed description of the test suite.

4. Click Submit.

What to do next
You can use the related links and related lists of the new test suite for the following actions:

• Add this test case to a test plan by clicking the Add to Test Plan  related link.

• Create a copy of this test suite by clicking the Create duplicate  related link. For more 
information, see Create a copy of an existing test suite.

• Associate test cases to this test suite by using the Test Cases related list. For more information, 
see Add a test case to a test suite.

Create a copy of an existing test suite

Create a test suite with the details of an existing test suite.

Before you begin

• Create a test suite.

• Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Suites.

2. Open the test suite that you want to create a copy of.

3. In the related links section at the bottom of the test suite form, click Create duplicate.

Tip: 

If the Create duplicate  related link is not visible, verify that you have the 
tm_test_manager or tm_tester role and that the test suite is active.

4. Enter a name in the Test Suite Name  field.

5. Click OK.
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What to do next
You can use the related links and related lists of the new test suite for the following actions:

• Add this test suite, with all associated test cases, to a test plan by clicking the Add to Test Plan 
related link.

• use the Test Cases related list to associate test cases to this test suite.

Add a test case to a test suite

Create and add a new test case to an existing test suite.

Before you begin

• Create a test suite.

• Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Suites.

2. Open the test suite to which you want to add a test case.

3. From the Test Cases related list, click New.

4. On the form, fill in the fields.

Test Case form

Field Description

Number System-generated unique identifier of the test case.

Active Option to indicate if the test case is active.

Test Suite Test suite which the test case is added to.

Short Description Detailed description of the test case.

Prerequisites Any conditions that must be met before the test case is executed.

5. Click Submit.

Test cases

Use test cases to group related tests together so that you can add them to a test suite or a test 
plan.

A test case contains one or more related individual tests and defines the conditions under which 
a feature must be verified. Test cases are the primary unit for organizing and executing tests in 
Test Management.

Navigate to Test Management  > Test Repository  > Test Cases  to view a list of test cases. Select 
a test case to display the Test Case form, which lists all tests in the test case.

Test organization hierarchy

Tests in Test Management  are organized in the following hierarchy:

1. Tests: Individual test steps that verify a specific condition.

2. Test cases: Groups of related tests.
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3. Test suites: Collections of related test cases.

4. Test plans: Structured plans that contain test suites and define how a product must be tested.

For more information, see Create a test case.

Create a test case

Create a test case to group one or more related individual tests.

Before you begin
Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Cases.

2. Click New.

3. On the form, fill in the fields.

Test Case form

Field Description

Number System-generated unique identifier of the test case.

Active Option to indicate if the test case is active.

Test suite Test suite that the test case belongs to.

Short 
description

Brief summary of the test case. Use a consistent naming convention such as 
[Feature]: [Scenario]  to make test cases easy to identify in lists and reports.

Prerequisites Conditions that must be met before the test case is executed, such as 
required roles or data setup.

4. Click Submit.

What to do next
You can use the related link and related list of the new test case for the following actions:

• Add this test case to a test plan by clicking the Add to Test Plan  related link.

• Add tests to this test case by using the Tests related list. For more information, see Add a test 
to a test case.

Add a test to a test case

Create and add a new test to an existing test case.

Before you begin

• Create a test case.

• Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Cases.

2. Open test case which you want to add the test to.

3. From the Tests related list, click New.
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4. On the form, fill in the fields.

Test form

Field Description

Number System-generated unique identifier of the test

State State of the test. Select from one of the following:

◦ Draft: Test is not ready to be performed.

◦ Ready: Test is ready to be performed.

◦ Inactive: Test is no longer active.

Order Order in which the test is performed, relative to other tests in this test 
case.

Test Name of the test.

Expected result Expected result of the test.

Detailed 
description

Detailed description of what is being tested.

5. Click Submit.

What to do next
You can create a copy of this test by using the Create Duplicate  related link on the test form.

Delete a test case

Delete a test case and all the tests associated to it.

Before you begin
Role required: tm_test_manager

Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Cases.

2. Open the test case that you want to delete.

3. Click Delete.

4. Optional:  Read the warning message in the confirmation pop-up window.

5. Click Delete  to confirm the deletion.

Result
The test case is removed from the list and all the associated tests are deleted.

Tests

Use tests to determine if a feature or an application is working correctly.

A test is made up of conditions, variables, or steps that are used to determine whether a feature 
is working correctly. A test also includes an expected result, which is used to determine whether 
the test passes or fails.

Related tests are grouped together in a test case. From the Tests related list on a Test Case form, 
you can view a list of all tests associated with the test case. Navigate to Test Management  > Test 
Repository  > Test Cases  and select a test case to view the list of its tests.
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Create a test

Create a test to see if your features are working correctly.

Before you begin

• Create a test case.

• Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Cases.

2. Open a test case to which you want to add a test.

3. From the Tests related list, click New.

4. On the form, fill in the fields.

Test form

Field Description

Number
System-generated unique identifier for this test.

State Status of the test. Choose from one of the following:

◦ Draft: Test is not ready to be performed.

◦ Ready: Test is ready to be performed.

◦ Inactive: Test is no longer active

Order Order in which this test is performed, relative to other tests in this test case.

Test Name of the test indicating what the test is for. For example, Approve Quote 
and convert to Order.

Expected 
result

Expected result of the test.

Detailed 
description

Description of what is being tested.

5. Click Submit.

What to do next
You can create a copy of this test by clicking the Create Duplicate  related link. For more 
information, see Create a copy of an existing test.

Create a copy of an existing test

Create a test with the details of an existing test.

Before you begin

• Create a test.

• Role required: tm_test_manager or tm_tester
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Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Cases.

2. Open the test case which has the test that you want to duplicate.

3. From the Tests  related list, open the test that you want to duplicate.

4. Select the Create Duplicate  related link.
A new test is created with details from the old test and the test form is 

opened.

5. Optional:  Make any necessary changes to details of the new test.

6. Select Update.

Create a test environment

Create a test environment to define the setup to be used when conducting the tests in a test 
plan.

Before you begin
Role required: tm_test_manager

About this task
A test plan can specify the software version or the operating system to be used. The Test 
Environment form includes the type of environment and can also include a URL.

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Environments.

2. Click New.

3. On the form, fill in the fields.

Test Environment form

Field Description

Number
System-generated unique identifier of the test environment.
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Field Description

Name Name of the test environment.

Type Type of environment. Select one from the following:

◦ Development

◦ Production

◦ QA

◦ User Acceptance Testing (UAT)

◦ Staging

◦ Support

URL URL of the test environment.

Short description Brief description of the test environment.

4. Click Submit.

Test plans

Use test plans in Test Management 1.0  to plan how to test your feature or application.

A test plan includes one or more test cases and can also specify a test environment. Test plans 
are used to assign test cases to testers and to monitor the progress of the tests.

You can view the list of test plans by navigating to Test Management  > Test Execution  > 
Test Plans. This list shows the current test plans, along with the percentage of the test cases 
completed and the status of the test cases. Open a test plan to view more details such as the 
test environment that is used for this plan and a list of test cases added to this plan.

Create a test plan

Create a test plan to detail how a product or a feature is to be tested.

Before you begin
Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Click New.

3. On the form, fill in the fields.

Test Plan form

Field Description

Short 
Description

Brief description of the test plan indicating what the test plan is for.

Owner Owner of the test plan.

Test 
environment

Specific environment to be used for testing.

Users can see the details of the assigned test environment by clicking to the 

information icon ( ) next to the Test environment field.
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Field Description

Active Option to indicate if the test plan is active.

If indicated as active, this test plan is visible to users when they try to add a 
test suite to this plan from the Test Suite form.

Instructions Any specific instructions for this test plan.

Project The name of the associated project.

This field appears on the Test Plan form if the Test Management PPM 
Integration is activated as part of the Project Portfolio Suite plugin 
(com.snc.project_portfolio_suite).

Project 
Phase

The name of the associated project phase in the Project Workbench.

This field appears on the Test Plan form if the Test Management 
PPM Integration is activated as part of Project Portfolio Suite plugin 
(com.snc.project_portfolio_suite).

Planned 
start date

Projected start date for the test plan. The planned start date can be the current 
date or a future date.

This field is automatically set to the current date. To change the planned start 
date, click the calendar icon ( ) and select a new date.

You may need to configure the form to add this field. For more information, see 
Display test plan execution start and end dates.

Planned 
end date

Projected end date for the test plan. The planned end date must be after the 
planned start date.

This field is automatically set to the current date. To change the planned end 
date, click the calendar icon ( ) and select a new date.

You may need to configure the form to add this field. For more information, see 
Display test plan execution start and end dates.

Actual start 
date

Actual start date for the test plan. The actual start date can be on or before the 
planned start date.

You may need to configure the form to add this field. For more information, see 
Display test plan execution start and end dates.

Actual end 
date

Actual end date for the test plan. The actual end date can be before the 
planned start date but not before the actual start date.

You may need to configure the form to add this field. For more information, see 
Display test plan execution start and end dates.

4. Save the test plan by using one of the following choices.

◦ Click Submit  to return to the Test Plans list.

◦ Click Save  to remain on the Test Plan form.

What to do next
You can use the related links and related lists of the new test suite for the following actions:
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• Add existing test cases to this test plan from a test suite by clicking the Add Test Cases from 
Test Suite  related link.

• Add new test cases to this test plan from the Test Cases related list. For more information, see 
Add a new test case to a test plan.

• Save this test plan as a new test suite by clicking the Save as Test Suite  related link. A new test 
suite is created with all the test cases of this plan making them available to add to another test 
plan.

• Start the test plan and notify the testers about the target end date for testing by using the 
Notify Tester  related link. For more information, see Initiate guided test execution.

• Cancel the test execution by clicking Cancel test execution  related link. This link is available 
only if you've used the Notify Tester  related link and started the test plan. For more 
information, see Cancel guided test execution.

• View all the test cases in a Visual Task Board (VTB) by clicking Show Visual task Board  related 
link. The VTB shows test cases in lanes organized by their execution states.

• Create a copy of this test plan by clicking Copy Test Plan.

• View the test execution summary and sign off the test plan by clicking the Sign-off Test Plan 
related link.

• View the Test Plan Defects related list for the list of all the defects logged from the test cases.

Display test plan execution start and end dates

Add the planned and actual start and end date fields on the Test Plan form to see the execution 
date information.

Before you begin
Role required: tm_test_manager or tm_tester

About this task
Configure the Test Plan form layout to display the planned and actual start and end dates for the 
test plan.

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Open a test plan for which you want to see the execution start and end dates.

3. Open the form layout configuration.

a. Right-click the form header.

b. Select Configure.

c. Select Form Layout.

4. Move the following fields from the Available list to the Selected list.

◦ Planned start date

◦ Planned end date

◦ Actual start date

◦ Actual end date

5. Optional:  Rearrange the order of the fields in the Selected list.

6. Click Save.
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Result
The Test Plan form is displayed with the newly added date fields.

Add a new test case to a test plan

Add new test cases to your test plans so that you can assign them to testers and start test 
execution.

Before you begin
Role required: tm_test_manager or tm_tester

About this task
You can add test cases that are not already a part of existing test suites. Create a test case 
directly from the Test Plan form through the Test Cases related list.

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Open the test plan which you want to add the test cases to.

3. In the Test Cases  related list, click New.

4. On the form, fill in the fields.
For information on the Test Case form fields, see Create a test case.

5. Click Submit.

Result
The new test case is added to the Test Cases  related list.

Assigning testers to test cases

Assign the test cases in a test plan to users with the tester (tm_tester) role and to business users.

Test cases can be assigned to users from the Test Plan form directly, or from the Visual Task 
Board (VTB) view of the test cases in the test plan.

Users with the tm_tester role can choose to perform testing from the Test Plan form or the Test 
Case form, the VTB, or by using the guided test execution feature. Business users can only 
perform testing using the guided test execution.

Assign testers from the Test Plan form

Use the Test Cases related list on the Test Plan form to assign testers.

Before you begin
Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Open a test plan.

3. From the Test Cases  related list, open a test case to which you want to assign a tester.

4. Select a user in the Assigned to  field.

5. Click Update.

Assign testers from the Visual Task Board

Assign the test case to a tester from the Visual Task Board (VTB).
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Before you begin
Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Open a test plan.

3. Click the Show View Task Board  related link.

The VTB displays lanes for test case statuses. A card for each test case appears in the 
appropriate lane based on its status. Test cases that are not assigned to any user display 
Unassigned on their cards.

Unassigned test case card on the Test Plan Visual task Board

4. Click the Unassigned card to open the test case form.

5. Click ASSIGNED TO  from the right side panel.

6. Click Add Primary Assignee  and select a user.

7. Close the card by clicking the close icon ( ).

Guided test execution

Notify testers about the test cases that are assigned to them through guided test execution by 
using the Assessments application to notify testers about assigned test cases.

Any user can perform tests using the guided testing feature. The tester (tm_tester) role is not 
required. An assessment metric category is created for each tester in a test plan.

The test manager assigns testers to test cases from the Test Plan form and initiates the testing 
by assigning an end date for the testing. Testers can navigate to Self-Service  > My Tests  or 
Self-Service  > My Assessments  to view and work on the test cases assigned to them. For more 
information, see Initiate guided test execution.

Any changes to the test plan, test case, or tests are automatically updated in the assessment. As 
the tester progresses through the assessment, the test plan and test case are updated when the 
tester submits results.

The test manager can cancel the guided test execution at any time directly from the Test Plan 
form. For more information, see Cancel guided test execution.

Initiate guided test execution

Create assessments for the assigned testers of each test case in a test plan by notifying them to 
start testing. The test manager can initiate guided test execution from the Test Plan form.
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Before you begin

• Create a test plan.

• Add test cases to the test plan.

• Assign testers from the Test Plan form.

• Role required: tm_test_manager or tm_tester

About this task
If you are using guided test execution, you can notify testers to start testing directly from the Test 
Plan form. The testers are notified through an email about their assigned assessments. Testers 
can find these assessments by navigating to Self-Service  > My Tests  or Self-Service  > My 
Assessments.

Procedure

1. Navigate to Test Management  > Test Execution  > Test Plans.

2. Open the test plan that you want to start executing.

3. From the Test Cases related list, use the Assigned to  field to assign the test cases to testers.

4. Click the Notify Tester  related link.

5. Enter a date in the Testing end date  field and click OK.
This date is used as the due date for the assessment.

Result
Assessments for each tester are created and email is sent to each tester with the assessment 
and testing details. After the testers are notified through the email, the Notify Tester  related link 
on the Test Plan form changes to Cancel test execution.

Cancel guided test execution

Cancel the guided testing process after it has started so that you can restart it when appropriate.

Before you begin

• Create a test plan.

• Add test cases to the test plan.

• Assign testers from the Test Plan form.

• Initiate guided test execution

• Role required: tm_test_manager or tm_tester

About this task
Use the related link on the Test Plan form to cancel a test execution that has already started.

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Open the test plan that you want to stop the testing for.

3. Click the Cancel test execution  related link.

4. Click OK.

Result
A message indicates that the test plan execution has been canceled and the metric type that has 
been created for the test plan is deleted.
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The Cancel test execution  related link on the Test Plan page changes to Notify Tester.

Performing tests and updating the test status

Perform tests, record test results, and update the test status after test cases are assigned.

Testers can perform the following actions in the Test Management  application:

• Perform the tests in a test case and record the results.

• Update the test status.

• Report a defect if a test fails.

• Report a blocking issue if a test is blocked.

• Retest as necessary.

• Update the test case status.

If a guided test execution feature is used, any user can be assigned to a test case and can 
perform the tests within that test case.

Perform tests using the Test Case form

Perform tests from an assigned test case and record results using the Test Case form.

Before you begin
Role required: tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Click the assigned test case in the Test Cases  related list.

3. Set the Execution Status  field on the Test Case form to In progress  and click Save.

4. In the Tests related list, open the first test.
The test order is determined by the number in the Order  field.

5. Set the Status  field for the test to In progress.

6. Right-click the form header and click Save.

7. Perform the steps outlined in the Detailed description  field.

8. Record the result in the Actual result  field.

9. Compare the actual result to the expected result and update the test status in the Status  field 
to one of the following:

◦ Passed

◦ Failed

◦ Blocked

10. Click Update.

11. Repeat steps 4-10 for the remaining tests in the test case.

12. After all of the tests are complete, update the test case status.
For more information, see Update the status of a test case.

Perform tests using the Visual Task Board

Perform tests from an assigned test case and record results using a bulletin board-type graphical 
interface.
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Before you begin
Role required: tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Click the Show Visual Task Board  related link.

3. Open the assigned test case by clicking the test case number on the card.

4. Set the Execution Status  field on the Test Case form to In progress  and click Save.

5. In the Tests related list, open the first test.
The number in the Order  field determines the test order.

6. Set the Status  field for the test to In progress.

7. Right-click the form header and click Save.

8. Perform the steps outlined in the Detailed description  field.

9. Record the result in the Actual result  field.

10. Compare the actual result to the expected result and update the test status in the Status  field 
to one of the following values:

◦ Passed

◦ Failed

◦ Blocked

11. Click Update.

12. Repeat steps 5–11 for the remaining tests in the test case.

13. After all tests are complete, update the test case status.
For more information, see Update the status of a test case.

Perform tests using guided test execution

Perform tests from an assigned test case and record results.

Before you begin
Role required: none

About this task
When the guided testing is initiated, the testers assigned to the test cases in the test plan are 
notified by email and can begin testing.

Procedure

1. Navigate to the assigned test case using one of the following ways.

◦ Self-Service  > My Tests

◦ Self-Service  > My Assessments
A card with the test plan name and assignment information appear.

2. Click the Start Testing  button to display a list of assigned test cases and the tests included in 
each case.

3. Perform each of the tests in the test case by following the individual test steps.

4. Record one of the following results for each of the tests performed.
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◦ Passed

◦ Failed

◦ Blocked

5. At the bottom of the list, choose an overall result from the following for the test case.

◦ Passed

◦ Failed

◦ Blocked

6. Click Save.

Update the status of a test case

Manually update the status of a test case. The status of the individual tests in a test case does 
not affect the overall status of the test case.

Before you begin
Role required: tm_test_manager or tm_tester

Procedure

1. Navigate to All  > Test Management  > Test Repository  > Test Plans.

2. Open the test plan that contains your test case.

3. From the Test Cases  related list, click your test case.

4. In the Execution Status  field, select a status.

◦ Unexecuted: Test is not executed yet.

◦ In Progress: Testing is in progress for this test case.

◦ Passed: All tests assigned to this test case have a status of Passed.

◦ Failed: One or more of the tests assigned to this test case have a status of Failed.

◦ Blocked: One or more of the tests assigned to this test case have a status of Blocked.

◦ Retest: Test is ready to be run again as a defect resulting from a failed test has been set to 
Closed Complete.

5. If you select Blocked  as the status, enter a reason for this test being blocked in the Blocked 
Reason  field.

6. Save the update by using one of the following choices.

◦ Click Submit  to save and return to the Test Cases list.

◦ Click Save  to save and remain on the Test Case form.
The test results are updated in the test plan.

What to do next
If a test case has failed, you can create a defect for this test case from the failed test by clicking 
the Report Defect  related link. For more information, see Report a defect from a failed test.

You can link an existing defect to the test case by clicking the Assign Defect  related link. For 
more information, see Assign a defect to a test case.

The reported and assigned defects are listed in the Defects for Test Case related list.
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Report a defect from a failed test

Report a defect from an individual test that has failed so that you can further investigate the test 
failure.

Before you begin

• Activate Agile Development 2.0

The ability to report a defect is available only if the Agile Development 2.0  plugin is activated.

• Perform tests and update the test status. For more information, see Performing tests and 
updating the test status.

• Role required: tm_tester

Important: 

Verify that the rm_tester role is assigned to you in your instance. This role is required to 
use the Report Defect link. If the role is not available, contact your system administrator to 
confirm the correct role for your organization.

About this task
Use the Test form to report a defect for a test that has failed. The reported defect is also linked to 
the test case which this test is related to.

Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Open the test plan which has the failed test.

3. From the Test Cases related list, open the test case which has the failed test.

4. From the Tests related list, open the test that failed.

5. On the Test form, click one of the following links:

◦ The Report Defect  link next to the Status  field.

◦ The Report defect  related link.

6. On the form, fill in the fields.

Report Defect form

Field Description

Number System-generated unique identifier for the defect.

Assignment group Group assigned to fix this defect.

Assigned to Individual assigned to fix this defect.

Priority Priority of the defect. Choose one from the following:

◦ 1- Critical

◦ 2 - High

◦ 3 - Moderate

◦ 4 - Low

◦ 5 - Planning

State The current state of the defect. Select one from the following:
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Field Description

◦ Draft

◦ Scoping

◦ Awaiting Approval

◦ Work in Progress

◦ Testing/QA

◦ Deploy/Launch

◦ Closed/Complete

◦ On hold

◦ Canceled

Short description Brief explanation of the defect.

Description Detailed explanation of the defect.

Work notes Any comments, notes, or other information related to the defect.

7. Click Submit.

Result
A defect is created and added to the following related lists:

• Defects for Test Case related list of the test case associated with the failed test.

• Test Plan Defects related list of the test plan associated with the failed test.

What to do next
After submitting the defect, you can modify it from the defect record. The role required to modify 
a defect depends on your organization's configuration. By default, the defect is assigned to the 
group or individual specified in the Assignment group  and Assigned to  fields.

Assign a defect to a test case

Assign an existing defect to a test case to track the relationship between defects and test cases.

Before you begin

• Activate Agile Development 2.0

The ability to assign a defect is available only if the Agile Development 2.0 plugin is activated.

• A defect record must exist in your instance. If no defect exists, create one first. For more 
information, see Report a defect from a failed test.

• Perform tests and update the test status. For more information, see Performing tests and 
updating the test status.

• Role required: tm_tester

About this task
When you link a defect to a test case, a reference to the defect is added both to the test case and 
the test plan of this test case.
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Procedure

1. Navigate to All  > Test Management  > Test Execution  > Test Plans.

2. Open a test plan which contains your test case.

3. From the Test Cases related list, open the test case to which you want to assign the defect.

4. Click Assign Defect.

5. Select a defect from the Defect  field..

6. Click OK.

Result
The defect that you assigned to the test case is added to the following related lists:

• Defects for Test Case related list of the test case.

• Test Plan Defects related list of the test plan associated with the test case.

You can also configure the Defect form to display the Test Cases related list so that you can see 
the test case associated with this defect.

Monitoring the progress of testing

Track the testing progress for test plans, test cases, and individual tests using the Test Plans 
module or the Test Management  dashboard.

Test Plans module

To understand the progress of all your test plans, navigate to Test Management  > Test Execution 
> Test Plans  and use the following information from the list of test plans:

• Percent complete: Amount of testing that is complete in the test plan.

This value calculated as (number of cases passed + number of cases failed)/total number of 
test cases.

• Test cases failed: Number of failed test cases in the test plan

• Test cases passed: Number of passed test cases in the test plan

• Number of test cases: Total number of test cases in the test plan

From here, you can drill down to the details of test cases associated with this test plan and the 
tests attached to each of the test cases.

From the Test Cases related list on the Test Plan form, you can view the following information for 
each test case:

• Tests passed

• Tests failed

• Test case execution status

When you open a test case from the Test Cases related list, you can view the following 
information for each of its tests:

• Expected result

• Actual result

• Test status
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Test Management  dashboard

Analyze the progress of all your active test plans by using multiple reports on the Test 
Management  dashboard. For more information, see Test Management dashboard.

Test Management dashboard

View test plan reports on the Test Management  dashboard.

From each report on the Test Management  dashboard, you can select an individual test plan or 
all active test plans for an overview of all testing.

To access the dashboard, navigate to Test Management  > Overview. Then select a test plan that 
you want to analyze the progress of, from the Select a Test Plan  field in the reports. The data in 
the report updates automatically.

Test Management Dashboard

Test Management Dashboard Reports

Report title
Report 
type

Description

Overall Test 
Coverage

Pie Displays the test case distribution by the execution status:

• Passed

• Failed

• Blocked

• In progress

• Unexecuted

Test 
Coverage 
By 

Bar This report employs the tagging feature, which you can use to assign 
tags to test cases. Then use this report to display the test case 
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Test Management Dashboard Reports  (continued)

Report title
Report 
type

Description

Component 
Tags

distribution based on the assigned tags. For each tag, the different 
colors represent the execution status:

• Passed

• Failed

• Blocked

• In progress

• Unexecuted

Defect 
Distribution 
By 
Component 
Tags

Bar This report employs the tagging feature, which you can use to assign 
tags to test cases. Then use this report to display test case defects 
based on the assigned tags. For each tag, the different colors represent 
the defect priority:

• Critical

• High

• Moderate

• Low

Pending 
Test 
Cases By 
Assignee

List Number of test cases pending for each assigned tester.

Test plan sign-off

Record approval of the test plan by using the functionality to sign off a test plan.

Navigate to the test execution sign-off report by navigating to the Test Plan form and clicking the 
Sign-off Test Plan  related link. The report provides an overview of the test case results, open test 
cases, and any open issues as of the current date by using the following information:

• A count of how many test cases passed, failed, are blocked, or are not tested.

• A list of the open test cases. This list displays cases that are blocked, failed, in progress, and 
not executed.

• A list of open defects and open issues ().

• Sign-off details, including sign-off history.

The test manager can review the details and proceed to sign off the test plan.

Multiple sign-offs can be required for one test plan and a test plan can be signed off even if it 
has failed test cases. Each sign-off takes a snapshot of the test plan in its current state, saves the 
snapshot as a PDF, and attaches the file to the test plan. This snapshot captures all test cases, 
including failed and unexecuted test cases as well as open defects.
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Complete the test plan sign-off

Review and sign off the test plan so that you can record the approval of the test plan.

Before you begin
Role required: tm_test_manager

Procedure

1. Navigate to Test Management > Test Execution > Test Plans.

2. Open the test plan that you want to sign off.

3. Click the Sign-off Test Plan  related link.

4. In the Sign Off section, enter any additional information in the Comments  field.

5. Optional:  Review the user in the Sign-off By  field.

6. Optional:  Review the date in the Sign-off Date  field.

7. Click Submit.

Test Management 2.0
The ServiceNow®  Test Management 2.0  application streamlines the management of testing 
processes to help you deliver software products more efficiently and with fewer errors. You can 
create multiple versions of a test and integrate with Agile Development 2.0.

To learn about the different versions of Test Management  and to choose the version that helps 
you meet your testing requirements, see Test Management applications.

Explore

• Test Management 2.0 
overview

• Testing using Test 
Management 2.0

• Sprint testing

Set up

• Activate Test Management 
2.0

• Quick start tests for Test 
Management 2.0

Use

Test Board in Test 
Management 2.0

Develop

• Developer training

• Developer documentation

• Installed with Test 
Management 2.0

Troubleshoot and get help

• Ask or answer questions in 
the Business Management 
community

• Search the Known Error 
Portal for known error 
articles

• Contact Customer Service 
and Support

Test Management 2.0 overview

Test Management 2.0  helps you deliver software products more efficiently and with fewer defects 
by managing and streamlining testing processes for both testers and managers. You can create 
multiple versions of a test and integrate with Agile Development 2.0.
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To learn about the different versions of Test Management  and to choose the version that helps 
you meet your testing requirements, see Test Management applications.

Important: 

Test Management 2.0 is not active by default on all instances. To use Test Management 
2.0, activate the com.snc.test_management.2.0  plugin. For more information, see 
Activate Test Management 2.0.

User Description

Tester Can run tests and track defects for a software product by:

• Creating tests and test sets.

• Performing tests and recording test results.

• Updating status of tests.

• Creating defect records manually and linking them to failed tests for retesting.

Important: 

To record a defect for a failed test in Test Management 2.0, create a defect 
record manually and reference the test in the defect description.

Test 
Manager

Can set up and monitor the manual testing process of a software product by:

• Creating and maintaining tests and test sets.

• Evaluating the tests, test steps, and test sets created by testers.

• Facilitating test execution by creating test plans, fragmenting a test plan into test 
cycles, and test cycles into test execution suites.

• Initiating a testing process by assigning tests to testers and then monitoring 
overall progress.

• Assessing test results and closing a test plan.

Key terminology
The following section describes the key terms used in Test Management 2.0.

Term Description

Test A collection of conditions or steps used to determine whether a feature is working 
correctly. A test can also include an expected result, which is used to determine if the 
test case passes or fails.

You can use the Tests  module to create and maintain different versions of a test.

Test 
set

A collection of related tests. A test can be a part of one or more test sets.

You can use the Test Sets  module to create a test set and group related tests into that 
test set.

Test 
plan

Plan describing how a product or a feature is to be tested and the time frame in which it 
must be executed. A test plan can be further broken into test cycles, and test cycles into 
test execution suites.
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Term Description

You can use the Test Plans  module to create test plans.

Test 
cycle

A subdivision of a test plan that represents a phase or iteration of testing, such as a 
regression cycle or a sprint cycle. A test plan can contain multiple test cycles, and each 
test cycle can be further divided into test execution suites.

Use the Planning tab on the Test Board to create and manage test cycles.

Test 
case

A collection of related tests. A test case is saved as part of a test suite and can be added 
to a test plan. Each test case within a test plan has an assigned tester.

Runs Detailed report of tests results, such as start time and end time of test execution, 
environment details, result of test execution.

You can use the Run module to view the test results.

Getting started with Test Management 2.0

1. Activate the Test Management 2.0 plugin. For more information, see Activate Test Management 
2.0.

2. Create your first test. For more information, see Create a test in Test Management 2.0.

3. Create a test set to organize related tests. For more information, see Create a test set in Test 
Management 2.0.

4. Create a test plan and assign tests to testers. For more information, see Create a test plan 
using Test Board in Test Management 2.0.

5. Run your assigned tests. For more information, see Run your test assignments in Test 
Management 2.0.

Activate Test Management 2.0

Activate the Test Management 2.0  plugin (com.snc.test_management.2.0) if you've the admin 
role.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install  to start the installation process.

Note: 
When domain separation and delegated Admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components 
installed with a plugin, see Find components installed with an application .
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Installed with Test Management 2.0

Several types of components are installed with activation of the Test Management 2.0  plugin 
(com.snc.sdlc.test_management), including tables, and user roles.

Roles installed

Role Description Contains roles

Tester

[sn_test_management.tester]

Can create tests, and group 
similar tests to a test set.

None

Test Manager

sn_test_management.test_manager

Can create tests, group 
similar tests into test sets, 
manage test plans, and 
view the run results.

sn_test_management.tester

Tables installed

Table Description

Task Test

[sn_test_management_m2m_task_test]

Associates tests to multiple scrum tasks.

Test Set Test

[sn_test_management_m2m_test_set_test]

Associates tests to multiple test sets.

Planned Test Task

[sn_test_management_planned_task]

Extends the Planned Task table.

Steps

[sn_test_management_step]

Stores details of test steps.

Step Result

[sn_test_management_step_result]

Stores details of step results.

Test

[sn_test_management_test]

Stores details of tests.

Test Execution Assignment

[sn_test_management_test_assignment]

Stores the linking of tests to testers.

Test Cycle

[sn_test_management_test_cycle]

Stores details of test cycles.

Test Environment

[sn_test_management_test_environment]

Stores details of test environments.
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Table Description

Test Execution Suite

[sn_test_management_test_execution_suite]

Stores details of test execution suites.

Test Plan

[sn_test_management_test_plan]

Stores details of test plans.

Test Result

[sn_test_management_test_result]

Stores details of test results.

Test Run

[sn_test_management_test_run]

Stores details of test runs.

Test Set

[sn_test_management_test_set]

Stores details of test sets.

Test Version

[sn_test_management_test_version]

Stores details of test versions.

Business stakeholder role for Test Management 2.0

Use the business stakeholder role to read and retrieve data from any table of the Test 
Management 2.0  applications to generate reports.

When you activate the Business Stakeholder plugin (com.snc.business_stakeholder) 
in your ServiceNow  instance, the Read only roles for Test Management 2.0  plugin 
(com.snc.tm2_read_roles) is also activated. This plugin provides a business stakeholder role 
(sn_tm2_read) with which you can access all the tables of Test Management 2.0  application. This 
role also allows read-only access to the Test Management dashboard. You can assign this role to 
any user in your organization who is a business stakeholder.

Plugin availability

If you are a new customer, the Read only roles for Test Management 2.0  plugin 
(com.snc.tm2_read_roles) is activated on zBoot. However, the business stakeholder 
role (sn_tm2_read) is available only when you activate the Test Management 2.0  plugin 
(com.snc.test_management.2.0).

If you are an upgrade customer, you must manually activate the Read only roles for Test 
Management 2.0  plugin (com.snc.tm2_read_roles).

Test Management 2.0  tables accessible by users with the business stakeholder 
role

When the read-only roles for Test Management 2.0 plugin (com.snc.tm2_read_roles) and Test 
Management 2.0  plugin (com.snc.test_management.2.0) are active in your ServiceNow  instance, 
the user with the business stakeholder role (sn_tm2_read) has read access to the following 
tables.
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Test Management 2.0  tables

Table Description

Task Test

[sn_test_management_m2m_task_test]

Associates tests to multiple scrum tasks.

Test Set Test

[sn_test_management_m2m_test_set_test]

Associates tests to multiple test sets.

Planned Test Task

[sn_test_management_planned_task]

Extends the Planned Task table.

Steps

[sn_test_management_step]

Stores details of test steps.

Step Result

[sn_test_management_step_result]

Stores details of step results.

Test

[sn_test_management_test]

Stores details of tests.

Test Execution Assignment

[sn_test_management_test_assignment]

Stores the linking of tests to testers.

Test Cycle

[sn_test_management_test_cycle]

Stores details of test cycles.

Test Environment

[sn_test_management_test_environment]

Stores details of test environments.

Test Execution Suite

[sn_test_management_test_execution_suite]

Stores details of test execution suites.

Test Plan

[sn_test_management_test_plan]

Stores details of test plans.

Test Result

[sn_test_management_test_result]

Stores details of test results.

Test Run

[sn_test_management_test_run]

Stores details of test runs.

Test Set

[sn_test_management_test_set]

Stores details of test sets.
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Test Management 2.0  tables  (continued)

Table Description

Test Version

[sn_test_management_test_version]

Stores details of test versions.

Quick start tests for Test Management 2.0

Validate that Test Management 2.0  still works after you make any configuration change such as 
apply an upgrade or develop an application. Copy and customize these quick start tests to pass 
when using your instance-specific data.

Test Management 2.0  quick start tests require activating the Test Management 2.0 
plugin (com.snc.test_management.2.0). and the Test Management 2.0  - ATF Tests plugin 
(com.snc.test_management.2.0.atf).

Test Management 2.0: Test version test suite

Test Description Release version

Create test version should 
create test

Validate test creation and 
version.

Madrid

Should be able to mark test 
version as ready when it 
contains verification steps

Validate test state when test 
has verification steps.

Madrid

Should not able to mark test 
version as ready when it does 
not contain verification step

Validate test state when test 
does not have verification 
steps.

Madrid

Marking a test version as 
ready should retire other test 
version in ready state

Validate test state when 
marking test ready.

Madrid

Test Management 2.0: Test results rollup test suite

Test Description
Release 
version

When test run closed, should update 
execution suite progress

Validate execution state progress. Madrid

Should not be able to assign a test not in 
ready state

Validate test assignment. Madrid

Test progress should roll up for test plan and 
test cycle

Validate test progress for test plan 
and test cycle.

Madrid

Related topics

Quick start tests
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Testing using Test Management 2.0

You can use Test Management 2.0  for general testing such as testing a phase in a release, 
testing a set of features or products before their market launch, or performing release readiness 
testing on integration and accessibility (for new software).

General testing comprises the following steps:

1. Creating tests. See Create a test in Test Management 2.0

2. Creating test sets, and grouping similar tests into a test set. See Create a test set in Test 
Management 2.0.

3. Using the Test Board feature to create a test plan. See Create a test plan using Test Board in 
Test Management 2.0.

4. Structuring the test plan in the Planning tab of the Test Board.

◦ Breaking down the test plan into test cycles to plan and schedule the phases of the testing 
effort. See Add and modify test cycles and test execution suites in Test Management 2.0.

◦ Breaking down the test cycles into test execution sets to schedule tests, and assign users to 
run those tests. See Create a test execution suite in Test Management 2.0.

5. Running tests and viewing the test run results. See Run your test assignments in Test 
Management 2.0.

Create a test in Test Management 2.0

Create a test specifying conditions or steps to determine whether a feature is working correctly.

Before you begin
Role required: sn_test_management.tester or sn_test_management.test_manager

Procedure

1. Create a test using either of the following options.

2. In the Test version form, fill in the test name and add steps for your test.

3. Select Submit.

4. From the list of Tests, open the test that you just created.

5. From the Test versions related list, open the test version that you just created.

Test Version Form

Fields Description

Test Unique name of the test.

Owner Owner who created the test.

Version Automatically generated version of the test.

State Current state of the test.

◦ Draft: Initial state when a test is created. The test is 
editable in this state.

◦ Ready: State when a test is approved for execution. The 
test is not editable in this state. To modify a test in Ready 
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Fields Description

state, create a version using the Create New Version 
button.

◦ Retired: State when the test is no longer used.

Tip: 

To edit a test, open the test version, confirm that it is in 
Draft  state, make your changes, and select Update.

Short description Brief description about the test.

Add Step Button used to add step to a test.

Change step order ( ) Icon used to change the order of a test step. Select the icon 
and drag a step to the required location.

This icon is displayed next to a test step.

Needs Verification Check box used to mark a test step for verification.

This icon is displayed after a test step is added.

If this checkbox is not selected, you need not verify that if 
this step passed, failed, or is blocked when you run the test.

Delete a test step ( ) Icon used to delete a test step.

Run Button used to run steps, which is displayed only when the 
test is in the Ready  state.

See Run your test assignments in Test Management 2.0.

Update Button used to update the details of a test version.

Ready Button used to change the state of the test version to 
Ready.

Create New Version Button used to create another version of the test.

Delete Button used to delete the test version.

6. Click Submit.

What to do next
To add a test to a test set:

1. Select the test from the Test list.

2. Click Add to Test Set.

Create a test set in Test Management 2.0

Group related tests into a test set. Test sets help you find tests by category or tag.

Before you begin
Role required: sn_test_management.tester or sn_test_management.test_manager
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Procedure

1. Navigate to All  > Test Management 2.0  > Test Sets.

2. Click New.

3. Enter a name for the test set and click Submit.

What to do next
You must add tests to the test set.

1. Navigate to Test Management 2.0  > Tests.

2. Select the required tests.

3. Click Add to Test Set.

4. In the Select Test Set window, search for the required test set and click Add.

To reorder the tests in the test set, open the test set record and use the drag-and-drop 
functionality to move it to the required position.

Tip: 

To change the order of steps within an individual test, see Create a test in Test 
Management 2.0.

Test Board in Test Management 2.0

Test Board gives you a comprehensive view of your test plans and enables you to manage test 
plans more efficiently.

In Test Board, you can:

• Aggregate all your test plans and view them as cards at a single location. Each card displays 
key details of your test plan such as the start and end date, percentage of tests that have 
passed, percentage of tests that have failed, percentage of tests that have been blocked, and 
number of days left for completion.

• Search for specific test plans by defining filter conditions such as name, duration, or owner.

• Track, manage, and complete your test plans from a single interface, which saves you time and 
effort.

1. Define how a product or feature must be tested by creating a test plan.

2. Structure your test plan in the Planning tab.  Break down your test plan into test cycles to 
plan and schedule the phases of testing effort. Further break down your test cycles into test 
execution sets, schedule the tests, and assign users to run those tests.

3. Monitor the progress and completion of your test plans.

Planning tasks

You can structure a test plan in the Test Board Planning  tab, which provides the following 
capabilities:

Test plan work item hierarchy

The Test plan work item hierarchy presents a wide variety of test plan information in 
expandable rows. It provides a quick overview of the test plan, with test cycles and 
test execution suites nested within the test plan.

In addition, you can:
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• Modify the attributes (such as start and end time) of the test plan, test cycles, 
and test execution suites rather than opening each form and modifying the field 
values one by one.

• Add or delete test cycles and test execution suites, adjust their start and end 
dates, and then assess the overall progress of the test plan.

• Configure the columns displayed in the Test plan work item hierarchy.

Gantt chart

The Gantt chart provides a visual representation of the timeline of the test plan 
and its child tasks using a blue task bar. The length of the task bar pertaining to the 
test plan increases and decreases depending on the adjustments you make to the 
duration of its child tasks. You can also manually increase or decrease the duration 
by dragging the edge of the task bar to the required location.

Create a test plan using Test Board in Test Management 2.0

Define how to test a product or feature by creating a test plan.

Before you begin
Role required: sn_test_management.test_manager

Procedure

1. Navigate to All  > Test Management 2.0  > Test Board.

2. Click Create Test Plan.

3. In the form, fill in the fields:

Test Plan form

Field Value

Name Unique name for the test plan.

Planned start date Planned date and time for starting the test plan execution.

4. Click OK.
The Details  tab opens.

5. Provide, review, and edit the test plan details.

Field Value

Planned 
end date

Planned date and time for ending the test plan execution.

Duration Estimated duration of test plan. This is the difference between the planned start 
date and the planned end date.

Number Automatically generated unique ID number for the test plan.

Owner Owner who created the test plan.

State Current state of the test plan.

◦ Pending: Test plan is not yet ready to be performed.

◦ Open: Test plan is ready to be performed.

◦ Work in progress: Test plan is currently being performed.
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Field Value

◦ Closed complete: Test plan has been closed after completion.

◦ Closed incomplete: Test plan has been closed without completion.

◦ Closed skipped: Test has been closed without being performed.

Description Description of the test plan.

Note: 
The Progress section displays the overall status of the test plan indicating the percentage 
of tests in the test plan that have passed, failed, or been blocked.

Add and modify test cycles and test execution suites in Test Management 2.0

Add and modify test cycles and test execution suites from a single user interface without having 
to switch between multiple user interfaces and forms.

Before you begin
Role required: sn_test_management.test_manager

About this task
In Test Management 2.0, a test plan is broken into test cycles, and test cycles are broken into test 
execution suites. A test cycle represents a phase or iteration of testing within a test plan, such 
as regression testing or smoke testing. A test execution suite is the smallest unit of organization, 
containing the individual test assignments for testers.

Use the Planning  tab to manage this hierarchy from a single view. For more information about key 
terms, see Test Management 2.0 overview.

Procedure

1. Navigate to All  > Test Management 2.0  > Test Board.

2. Select the test plan.

3. Select the Planning  tab.

4. Add or modify test plans and test execution suites in the Test plan work item hierarchy.

5. View the summary or adjust the duration of a task in the Gantt chart.

Define a custom column in the Planning tab of Test Board in Test Management 2.0

Define a custom column to display information important to you in the Test plan work item 
hierarchy section of the Planning tab. For example, define a column to view the percentage of 
test plan that has been completed.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > Test Management 2.0  > Settings  > Planning Console.

2. Click the gear icon ( ) at the top right corner of the page.

3. In the System Settings window:
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a. Select the Developer section.

b. In the Application  list, select Test Management  and then close the window.

4. In the Planning Console Display Columns  related list, click New.

5. In the Planning Console Display Column form, provide a label and other details for the column.

6. Click Submit.

What to do next
After you create a column, associate the column to the required table.

Create a test execution suite in Test Management 2.0

Create a short test plan when the testing effort is minimal and you do not want to go through the 
overhead of creating a test plan and a test cycle for a test execution suite.

Before you begin
Role required: sn_test_management.test_manager

Procedure

1. Navigate to All  > Test Management 2.0  > Test Execution Suites.

2. In the form, fill in the fields:

Test Execution Suite form

Field Description

Name Unique name for the test execution suite.

Planned 
start date

Planned date and time for starting the test execution suite.

Planned 
end date

Planned date and time for ending the test execution suite.

Planned 
duration

Estimated duration for the test execution suite. This duration is the difference 
between the planned start date and the planned end date.

Number Automatically generated number for the test execution suite.

State Current state of the test execution suite.

Assignment 
group

Group working on test execution suite.

Progress section of the Test Execution form

Field Description

Percent complete Percentage of test execution suites that 
have been completed. Value is calculated 
automatically.

Percent passed Percentage of test execution suites that have 
passed. Value is calculated automatically.

Percent failed Percentage of test execution suites that have 
failed. Value is calculated automatically.
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Field Description

Percent blocked Percentage of test execution suites that were 
blocked. Value is calculated automatically.

3. Click Submit.

What to do next

• To add tests to the test execution suite, click Add tests. From the Tests  list, select the required 
tests, and click Add to Execution Suite.

• To add test sets to the test execution suite, click Add test sets. From the Test Sets  list, select 
the required test sets, and click Add to Execution Suite.

• In the Test execution assignments  related list, select the test and assign it to a user.

Run your test assignments in Test Management 2.0

Run your test assignments and capture the results.

Before you begin
Before you begin, ensure the following conditions are met:

• Your test manager has set the tests to Ready  state and assigned them to you.

• At least one execution environment is configured in your instance.

Role required: sn_test_management.tester

Procedure

1. Navigate to All  > Test Management 2.0  > Tests Assigned to me.

2. Select the required tests and click Run.
Only the tests that are in the Ready state can be run.

Trouble? 

If no tests appear in the Tests Assigned to me  list, confirm with your test manager that tests 
have been assigned to you and set to Ready  state.

3. In the pop-up, select the execution environment on which the tests must be run.

An execution environment specifies the hardware or software configuration on which tests run, 
such as a browser version or operating system. If no environments appear in the list, contact 
your system administrator to configure one.

4. In the Test Execution pop-up, mark a step as passed, failed, or blocked using the following 
icons.
To pause and work on the test at a later point in time, click Pause.

5. Click Done.

Result
Test results are saved to the Test Result form. The overall status of the test is defined by statuses 
of the test steps:

• If all the test steps are passed, the status of the test is Passed.

• If at least one step of the test is not run, the status of the test is Not finished.
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• If at least one step of the test fails, the overall status of the test is Failed.This rule takes 
precedence over the previous rule.

• If at least one step of the test is blocked, the overall status of the test is Blocked. This rule 
takes precedence over the previous two rules.

What to do next
To view the full history of test runs and results across all test plans, navigate to Test Management 
2.0  > Test Runs. For more information about monitoring test plan progress, see Test Board in Test 
Management 2.0.

Sprint testing

You can use Test Management 2.0  with Agile Development 2.0  to test the work of a scrum team 
sprint-by-sprint.

Sprint testing lets you verify user stories sprint by sprint. The process involves the following 
steps:

1. Create tests for the stories in the current sprint. For more information, see Create a test in Test 
Management 2.0.

2. Run the assigned tests and capture results. For more information, see Run your test 
assignments in Test Management 2.0.

3. Review test results and close stories when all tests pass. For information about monitoring 
progress, see Test Board in Test Management 2.0.

Test Management 2.0  integration with Agile Development 2.0

With the integration of Test Management 2.0  and Agile Development 2.0, you can perform sprint 
testing from Agile Development 2.0  > Agile Board  > Sprint Tracking.

• Find what tests are to be run for the sprint.

• Create tests for the stories in sprints.

• Maintain multiple versions of a test.

• Run a single version of a test at one time.

• View which version of test has been run.

• Review the history of test results.

• Close stories.

When you create a test through the Sprint Tracking  view, the test is automatically associated 
with the story displayed in that row. You can verify this link by opening the story record and 
reviewing the Tests  related list. To view all tests linked to stories in a sprint, use the Test Board.

Viewing sprint test results

After testers run their assignments, you can review results at two levels:

• In the Sprint Tracking  view, each story row displays the test status for that story's tests.

• In Test Board, the test plan card displays the percentage of tests that have passed, failed, and 
been blocked.

When all tests for a story pass, the story is ready to be closed. To close a story from the Sprint 
Tracking view, select the story and update its state to Complete.
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Create a test for a story

Create a test from the Sprint Tracking view to automatically link it to a story and track whether the 
story meets its acceptance criteria.

Before you begin

• Role required: scrum_user or scrum_admin

• You can create a test from the List view only when Agile Development 2.0  is installed along with 
Test Management 2.0.

• You must be a member of an agile group.

About this task
Create a test, add steps to the test, and create and maintain different versions of the test. A test 
is a collection of conditions or steps used to determine whether a story is working correctly. A 
test can also include an expected result, which determines whether the test passes or fails. 
When you create a test from the Sprint Tracking  view, the test is automatically linked to the story 
displayed in that row. To confirm the link after creation, open the story record and locate the 
Tests  related list.

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. Click the Sprint Tracking  tab, and select the List  view.

3. From the Show  list at the top right corner, select Tests.

4. Click Add Test.

5. Optional:  To link an existing test to a story instead of creating a new one, open the story 
record from the sprint list and locate the Tests  related list to add the pre-existing test.
To create a standalone test to link later, see Create a test in Test Management 2.0.

6. In the form, fill in the fields:

Test Version form

Field Description

Test Unique name of the test.

Owner Owner who created the test.

Version Automatically generated version of the test.

State Current state of the test.

◦ Draft: State of the test when it is created.

◦ Ready: State of the test when it is not editable. When the test has multiple 
versions, only one test will be in the Ready  state at any one time

◦ Retired: State of the test when it is no longer used.

Short 
description

Brief description about the test.

Add Step Button used to add step to a test.

Run Button used to run steps, which is displayed only when the test is in the Ready 
state. See Run your tests from the List view.

Update Button used to update the details of a test version.
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Field Description

Ready Button used to change the state of the test version to ready.

Create New 
Version

Button used to create another version of the test.

Delete Button used to delete the test version.

Change 
step order 

( )

Icon used to change the order of a test step. Select the icon and drag the step 
to the required location.

Needs 
Verification

Check box used to mark a test step for verification.

Delete a test 

step ( )

Icon used to delete a test step.

What to do next
View information in the following related lists:

Related list Description

Other versions Displays all the versions of a test.

Test Results Displays the run results of each test version.

Test Sets Displays related tests in a test set.

Tests created through this workflow are automatically linked to the story. To confirm the link, open 
the story record and locate the Tests  related list, which displays all tests associated with that 
story.

Run your tests from the List view

View the test scenario, execute all the steps of the test, and review the test result.

Before you begin
Role required: scrum_user

Procedure

1. Navigate to All  > Agile Development  > Agile Board.

2. Click the Sprint Tracking  tab and select the List  view.

3. Click a test.

4. Verify a story by clicking Run  on the story.
This step runs all tests of the story at once.

5. In the pop-up, select the environment on which the test is to be run.

a. Click Lookup using list  icon.

b. Click Run.

6. In the Test Execution pop-up, mark a step as passed, failed, or blocked using the following 
icons.
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◦ To select an icon, you can also use the Tab  key. Press Tab  and then press Enter.

◦ To pause and work on the test at a later point in time, click Pause.

7. Click Done.

Result
Test result is saved to the Test Result form, and the latest test result of each test is displayed in 
the List view.

The overall status of the test is defined by statuses of the test steps:

• If all the test steps are passed, the status of the test is Passed.

• If at least one step of the test is not run, the status of the test is Not finished.

• If at least one step of the test fails, the overall status of the test is Failed. This rule takes 
precedence over the previous rule.

• If at least one step of the test is blocked, the overall status of the test is Blocked. This rule 
takes precedence over the previous two rules.

Migration from Test Management 1.0 to Test Management 2.0
Migrate your test data from Test Management 1.0  to Test Management 2.0, and start using Test 
Management 2.0  for its enhanced testing capabilities and features.

Apply the following migration steps on a non-production instance, verify if the migration is 
completed as intended, and then perform the migration steps on a production instance.

Migration steps

To migrate your test data from Test Management 1.0  to Test Management 2.0, complete the 
following steps in order:

1. Activate the required plugins. For more information, see Migration from Test Management 1.0 to 
Test Management 2.0.

2. Convert your test suites. For more information, see Convert test suites.

3. Verify the migrated data on a non-production instance before repeating on production.

Activate plugins

Activate the Test Management 2.0  (com.snc.test_management.2.0) and Test Management 2.0 — 
Data Migration (com.snc.test_migration_v1_v2) plugins.

Migrate data

The migration process allows you to move test suites, test cases, and tests.

Note: 

• Test plans cannot be migrated due to significant change of data model.

• Test suites, test cases, and tests that are migrated to Test Management 2.0  will not be 
removed from Test Management 1.0.

Test cases that are migrated to Test Management 2.0  are converted to test versions in the 
following manner:
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Test Management 1.0: Test case Test Management 2.0: Test version

Short Description Short Description

Domain Domain

Test Suite Creates a relationship between test and test set

Prerequisites Link to the old test case

Tests that are migrated to Test Management 2.0  are converted to test steps in the following 
manner:

Test Management 1.0: Test Test Management 2.0: Test step

Order Order

Domain Domain

Detailed description Link to the old test

Test Step

Test data Link to the old test

Expected result Verification step

Test suites that are migrated to Test Management 2.0  are converted to test sets in the following 
manner:

Test set in Test Management 1.0 Test set in Test Management 2.0

Name Name

Owner Owner

Domain Domain

Add custom fields to migration

You have added custom fields to the tables of Test Management 1.0, and want to move 
the fields to the corresponding custom columns in Test Management 2.0. In such a case, 
include the custom fields into migration by overriding the mapping information in the script 
include TestMigrationTableMapping. The default mapping is provided in the script include 
TestMigrationTableMappingBase.

Convert test suites

Convert test suites  with underlying test cases to test sets and tests.

Convert test suites

Convert test suites in Test Management 1.0  to test sets in Test Management 2.0. Start using Test 
Management 2.0  for its enhanced testing capabilities and features.

Before you begin

• Role required: admin

• Install the Test Management 2.0 — Data Migration plugin (com.snc.test_migration_v1_v2).
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Procedure

1. Navigate to All  > Test Migration  > Migrate Test Suites.
A list of test suites available in Test Management 1.0  are displayed.

2. Select the required test suites and convert to them to test sets.

What to do next
After converting test suites, verify that the migrated test sets and tests appear correctly in Test 
Management 2.0  before performing the migration on a production instance. For more information 
about verifying migrated data, see Migration from Test Management 1.0 to Test Management 2.0.

Appendix — Test Management 2.0

Test Management 2.0  offers a few enhancements over Test Management 1.0.

These enhancements can be divided into the following categories:

• Functionality enhancements

• Data model enhancements

• Usability enhancements

Functionality enhancements in Test Management 2.0

Test Management 2.0  offers a few functionality enhancements over Test Management 1.0.

Integration with Agile Development 2.0

Integration of Test Management 2.0  with Agile Development 2.0  provides embedded testing 
capabilities for scrum teams. Test Management 2.0  enables you to create tests for stories of the 
sprint, and also track the execution and completion of those tests. As a scrum lead or product 
owner, you gain an insight of the stories that are tested and are to be closed.

Data model enhancements in Test Management 2.0

Test Management 2.0  offers a few data model enhancements over Test Management 1.0.

Enhanced traceability

Each test in Test Management 2.0  can have multiple versions. When a test version 
is in the state Ready, it can be run but cannot be edited. Every test result is 
associated with a specific run and a specific version of the test. Due to this logic, 
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you can always be sure of the content of the test when a specific test result was 

received.

More flexible approach to organize tests

Unlike Test Management 1.0, where test cases can be placed in only one test suite, in Test 
Management 2.0  tests can be placed in multiple test sets. Test sets are free-form collections 
of tests. Tests can be grouped into test sets using any logic: by product, by component, or by 
release.
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Test plan defines the time frame

A test plan in Test Management 2.0  captures the time frame during which the tests are 
to be run. In addition, a test plan can be broken down into smaller planning windows, 
test cycles, for more precise planning, such as user acceptance testing, and integration 
testing. Further test cycles can be broken down into test execution suites, which are 
similar to sprints in testing. A test execution suite defines when a test must be run and by 

whom.

Usability enhancements in Test Management 2.0

Test Management 2.0  offers a few usability enhancements over Test Management 1.0.

Create and track the execution of tests for stories of the sprint in the Sprint Tracking  tab in Agile 
Board. In addition, you can:

• View the test result of each test.

• Run all the tests for a story at one time.

Easier way to create tests

Test Management 2.0  provides a new user experience for creating tests.

• Test steps can be created without leaving the context of test form.

• Entire test scenario can be created at one time. Type in the step description, and press Enter to 
proceed to the next step.

• You need not create an extra record to capture expected results. Expected results can be 
captured as another test step that is marked as a verification step.

Enhanced user experience for running tests

Test Management 2.0  provides a new user interface for running tests. The interface opens in a 
small browser window, which can be placed side by side with the system that is being tested. 
You can go through multiple tests at one time, without having to relaunch the window. Whenever 
a step is marked as failed or blocked, you can add a comment and attachment to record your 
observation.
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Visual approach of structuring test plans

Test Management 2.0  provides a designated user interface, Test Board, for creating and 
structuring test plans. As a test manager, you can create a test plan, test cycles, and test 
execution suites and define the time frame for their execution. The names of the test cycles and 
execution suites can be edited inline, without leaving the page. Test execution suites can then be 
filled with tests, and those tests can be assigned to testers.

The test plan work hierarchy item in the Test Board provides a visual representation of the 
timeline of the test plan and its child tasks using a blue task bar. The length of the task bar 
pertaining to the test plan increases and decreases depending on the adjustments you make 
to the duration of its child tasks. You can also manually increase or decrease the duration by 
dragging the edge of the task bar to the required location.

Business Planning Portal
A business plan includes a business goal and a plan to achieve that goal. Business planning 
involves various entities of a business such as goals, business units, business capabilities, 
capability map, enterprise strategies, and business unit strategies. As a business planner you 
can manage these entities from the business planning portal.

To access the business planning portal, the Business Planner (com.snc.apm.business_planner) 
plugin must be activated. This plugin is installed only when any one of the other Strategic 
Portfolio Management  (SPM) plugins is already installed.

Access the business planning entities, goals, business units, enterprise strategy, business unit 
strategy, capabilities, and capability in the Business Planner  module.

Business planning portal for the business planner

As a business planner, you can do various tasks from the business planning portal such as view, 
create, and update the business entities to achieve business goals. In addition, the Business 
Planner can . Use capability map for planning - Legacy .

Note: 
The role of a business planner involves only planning and managing the entities to achieve 
the business goal. It doesn't deal with the business applications or technologies that 
support the business.
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Business planning portal

The business planning portal helps the business planner to view and create goals, business unit, 
capabilities, and strategies.

Number of capabilities

Displays the number of capabilities that have been created. Click to view the list 
of capabilities defined for the business enterprise. Create business capability and 
relate the capability with an application - Legacy  if the existing capabilities don't 
conform to your business plan.

If you have installed Enterprise Architecture  (formerly APM), then the Map  link is 
available. Click Map  to launch the capability map.

Strategies

Displays the number of objectives that have been created. Click to view the list of 
strategic objectives that align with your business plans. Click to create a business 
unit strategy  or an enterprise strategy  to fulfill a new business plan. You can also 
assign strategies to a goal.

• Enterprise strategy is at a higher level and business unit strategies can be 
assigned at its child level.

• Business unit strategy is at a lower level and an enterprise strategy or a business 
unit strategy can be assigned as a parent strategy.

Business Units

A business unit is a segment of an enterprise that represents a business function. 
View the existing number of business units in your organization. Click to create a 
business unit  to define its functions.

No. of goals

View the number of goals created to achieve a business plan. You can relate goals 
to many enterprise and business unit strategies. Similarly, more than one enterprise 
and business unit strategies can be related to more than one goal. Click a goal from 
the list to update its status and assign a task to it. You can also create a goal for an 
application strategy .

Recent Activity
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View the recent goals, strategic objectives, and business units that you had created.

Business units
Business units are parts of your organization that are in charge of certain operations, such as 
Finance, HR, IT.

Business units usually comprise departments and are associated with a company. By default, 
the Hierarchy of Segments includes a segment for business units, departments, and vendors, 
which are companies with the Vendor  option selected. With the segment setup, you can allocate 
expenses to business units, departments, or vendors, or have expense allocations roll up to 
them. You can configure both departments and companies as part of user management.

Create business units

Create a business unit to define your organizational functions. A business unit is also necessary 
to set up the top-most segment in the hierarchy to create roll up rules and have expenses roll up 
to these business units.

Before you begin
Role required: business_planner

Procedure

1. Navigate to All  > Organization  > Business Units.

2. Click New.

3. Fill out the fields on the form (see table).

4. Click Save.

Business Unit form

Field Description

Name Name of the business unit.

Company The company, if any, related with this business unit. You can choose any 
company, including the ones that don’t have the Vendor  field selected.

Business 
Unit Head

Person who heads the business unit.

Description A description of the business unit.

Parent Refers to another business unit. The Parent  field makes the business unit as a 
hierarchy element.

Hierarchy 
level

Number or text to indicate the level of the business unit.

Related list section of the Business Unit form

Field Description

Departments Departments that comprise this business 
unit. Add as many departments as necessary.

The Departments related list isn’t visible by default. If necessary, you can add the Departments 
related list on the business unit record you created. To add the Departments related list:
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a. Right-click in the form header, and select Configure  > Related Lists.

b. Locate the Departments  item in the Available  box and move it to the Selected  box.

c. Select Save.

Create an enterprise strategy
As a business planner you can manage the business entities such as goals, business units, 
business enterprise strategies, and business unit strategies. Create an enterprise strategy to 
orient your business plan toward your goal.

Before you begin
Role required: user_admin, business_planner

About this task
To understand how your organizational strategies are performing, see the Strategic Spend 
Tracking for PPM dashboard  topic. It provides a comprehensive visual to help you understand 
how the planned costs, actual costs, and benefits for projects aligned to your organization's 
strategies trend over time.

Procedure

1. Navigate to All  > Business Planner  > Enterprise Strategy.

You can also navigate to Organization  > Enterprise Strategy.

2. Click New  or open a record.

3. Fill in the form fields.

Enterprise Strategy form

Field Description

Title A short title describing the enterprise 
strategy.

Number System assigned enterprise number.

Assigned To Person to whom the enterprise strategy is 
assigned.

From Date Date from which the enterprise strategy is 
valid.

To Date Date until which the enterprise strategy 
remains valid.

Type Select a type of organization strategy that this 
strategy aligns to.

Active Enable the check box to make the enterprise 
strategy active.

Description Short description about the enterprise 
strategy.

4. Click Submit.
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What to do next
Use the Business Unit Strategies  related list to create a strategy for a business unit and 
associate the business unit strategy to the enterprise strategy, to another business unit, or to 
another business unit strategy.

Related topics

Allocate or modify the strategy and goal percentage for a project

Create a business unit strategy
Business units are segments of an enterprise that are in charge of certain operations such as 
Finance, HR, IT. Each of these business units can have a strategy that aligns with the enterprise 
or with another business unit.

Before you begin
Role required: user_admin, business_planner

Procedure

1. Navigate to All  > Business Planner  > Business Unit Strategy.

You can also navigate to Organization  > Business Unit Strategy.

2. Click New  or open a record.

3. Fill in the form fields.

Business Unit Strategy form

Field Description

Title A short title describing the business unit 
strategy.

Number System assigned business unit number.

Assigned To Person to whom the business unit strategy is 
assigned to.

From Date Date from which the business unit strategy is 
valid.

To Date Date until which the business unit strategy 
remains valid.

Business Unit The business unit for which the strategy is 
being created.

Strategy Strategic objectives of the organization that 
the business unit strategy complies to.

Type Select a type of organization strategy that this 
strategy aligns to.

Active Enable the check box to make the business 
unit strategy active.

Description Short description about the business unit 
strategy.

4. Click Submit.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2252



What to do next
View the strategic objectives that you’ve created in the business planning portal. The records of 
business planning strategic objectives give you a clear visibility of the status, to whom they’re 
assigned to, the period of validity, and their type.

Cost Management
The ServiceNow®  Cost Management application tracks configuration item costs. The costs can 
be allocated to business units and used in reports.

Cost management enables these features:

• Using rate cards.

• Defining configuration item (CI) costs.

• Tracking one-time costs for CIs.

• Processing recurring CI costs to generate expense lines.

• Distributing bulk costs to multiple expense line sources.

• Tracking costs related to tasks and projects.

• Aggregating configuration item costs and charging the total cost to a business service or 
application.

• Allocating expense lines to business units with flexible allocation rules.

• Tracking planned and actual budget costs by cost center.

Cost Management Options

Use the following cost management options to plan and control business costs.

• Create rate cards to properly track configuration item, contract, task, and labor costs.

• Create expense lines and expense allocation rules.

• Aggregate configuration item costs and apply the total cost to a business service or application 
using relationship paths.

• Create distribution costs and distribution cost rules to divide costs between a group of 
records.

Activate Cost Management
Activate the Cost Management plugin (com.snc.cost_management) using the admin role.

Before you begin
Role required: admin

Procedure

1. Navigate to All  > System Applications  > All Available Applications  > All.

2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to 
request it from ServiceNow  personnel.

3. Select Install.
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Note: 
When domain separation and delegated admin are enabled in an instance, the 
administrative user must be in the global  domain. Otherwise, the following error appears: 
Application installation is unavailable because another 
operation is running: Plugin Activation for <plugin name>.

4. Select Activate.

Note: 
To load the demo data, select the Load demo data  check box.

Components installed with Cost Management

Several components are installed with the Cost Management application.

Demo data is available with Cost Management. The demo data provides sample budgets, 
distribution costs, expense allocations, contract rate cards, and rate card costs.

Tables

Cost Management adds the following tables.

Tables

Table Description

Allocation Unit [allocation_unit] Tracks capacity and usage for a business service. 
Stores reference to business service, total, 
allocated, and remaining units of capacity.

Budget [fm_budget] Tracks planned and total expense allocation 
amounts for a collection of cost centers.

Budget Cost Center 
[fm_budget_cost_center]

Associates one or more cost centers to a budget.

CI Cost Center Relationship 
[fm_cmdb_rel_cc]

Associates a cost center to a business service that 
it consumes and the number of units it uses. This 
is used to calculate the number of allocated units 
to update the allocation unit record.

CI Rate Card [fm_ci_rate_card] Links configuration items and costs. A 
classification can also be defined to allow for 
multiple rate cards for a group of CIs.

CI Rate Cards 
[fm_ci_rate_card_cmdb_ci_m2m]

Associates configuration items to a rate card.

Contract Rate Card 
[fm_contract_rate_card]

Provides detailed price information for a contract 
and enables you to generate recurring expenses 
automatically.

Distribution Cost 
[fm_distribution_cost]

Represents costs which can be divided among a 
group of records. For example, the cost of power at 
a datacenter which can be divided among the CIs 
in the datacenter.

Distribution Cost Rule 
[fm_distribution_cost_rule]

Determines how the costs are distributed to CIs.
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Tables  (continued)

Table Description

Distribution Units 
[fm_distribution_units]

Stores the number of units to associate to 
configuration items linked to the current rate card.

Expense Allocation 
[fm_expense_allocation]

Associates the value of an expense to a target 
reference. The value is generated from an expense 
line by processing allocation rules. The target is 
the record that is responsible for that expense 
amount. Common targets are cost centers, 
departments, companies, groups, and users.

Expense Allocation Rule 
[fm_expense_allocation_rule]

Determines how to process an expense line 
into an expense allocation. The logic starts by 
defining a table and condition to run against. 
Expenses linked to the selected table will be 
evaluated by this rule. If the condition is met, an 
allocation of a defined percentage is created 
for the reference defined by the allocation field 
value. Advanced scripts can also be used to define 
custom allocation generation.

Financial Management Log [fm_log] Logs financial management information for 
tracking and to asset with debugging. Extends the 
system log table.

Labor Rate Card 
[fm_labor_rate_card]

Defines hourly labor rates for expense line 
generation based on functional roles.

Rate Card [fm_rate_card] Associates configuration items to a rate card.

Rate Card 
[fm_recurring_rate_card]

Represents a collection of recurring costs.

Rate Card Cost 
[fm_ci_rate_card_cost]

Associates a recurring CI cost to a rate card so that 
it is applied to all CIs associated with the rate card.

Rate Card Users 
[clm_m2m_rate_card_user]

Associates users to a rate card.

Relationship Path 
[fm_relationship_path]

Defines the relationship between configuration 
items, such as parent records and child records.

Task Rate Card 
[fm_task_rate_card]

Stores records that define task costs.

User Roles

Cost Management adds the following user roles. A user with the user_admin or admin role can 
assign these roles.

User Roles

Role Description Contains Roles

Financial User 
(financial_mgmt_user) Financial users participate in financial 

processes and have limited access to 
functionality.

None
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User Roles  (continued)

Role Description Contains Roles

Can read allocation units and expense 
allocations. Can create, read, and write rate 
cards and expense lines. Can create, read, 
write, and delete fixed assets, depreciation, 
distribution costs.

Financial Admin 
(financial_mgmt_admin) Financial administrators manage financial 

processes in the system.

Can create, write, and delete allocation 
units, fixed assets, depreciation, rate cards, 
distribution costs, expense lines, and expense 
allocations.

financial_mgmt_user

Properties

Cost Management adds the following properties.

Properties

Name Description

com.snc.time_card.default_rate Sets a default hourly rate to use 
if no labor rate cards apply to the 
user.

glide.cost_mgmt.calc_actual_cost Sums all task expense lines and 
adds the total to the Work cost 
field on the task record when an 
expense line is created for any 
task with a Type  of Planned task.

glide.cost_mgmt.debug Enables debugging of cost 
management processing. All 
logging events are recorded in 
the Financial Management Log 
[fm_log]  table. This should 
only be enabled during initial 
testing or when troubleshooting 
because it can generate a large 
number of log records.

glide.cost_mgmt.process_task_cis Creates expense lines to 
affected configuration items 
when creating a task expense 
line. The default value is false.

glide.cost_mgmt.service_allocation.method Defines if business service to 
cost center allocation costs 
should be calculated based on 
total units or allocated units.
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UI Policies

Cost Management adds the following UI policies.

UI Policies

Name Table Description

Control flat 
rate vs bill 
rate fields

[fm_task_rate_card] Hides the Task rate  field and displays 
the Default labor rate  field on the 
Task Rate Cards form if the Use time 
worked  check box is selected.

Hide if 
define 
condition 
disabled

[fm_ci_rate_card] Displays the Table  and Condition 
fields on the CI Rate Cards form if 
the Define condition  check box is 
selected.

Hide parent 
class if all 
enabled

[fm_relationship_path] Hides the Parent class  field on the 
Relationship Paths form if the All 
parent classes  check box is selected.

Hide 
recurring 
fields for 
one time 
cost

[fm_distribution_cost] Hides the End date  and Interval  fields 
on the Distribution Costs form if the 
Recurring  check box is cleared.

Hide 
relationship 
type if all 
enabled

[fm_relationship_path] Hides the Relationship type  field on 
the Relationship Paths form if the All 
relationships  check box is selected.

Hide Show 
Advanced 
Field

[fm_distribution_cost_rule] Hides the Table  and Condition  fields 
on the Distribution Cost Rules form 
and displays the Script  field if the 
Advanced  check box is selected.

Hide table 
field

[fm_labor_rate_card] Hides the Table  field on the Labor Rate 
Cards form at all times.

Modify 
value field 
rules on 
distribution 
method

[fm_contract_rate_card] Changes the Value  field from read-
only to mandatory on the Contract 
Rate Cards form if the Distribute cost 
field is set to Allocate and distribute 
cost based on value.

Show script 
field if 
advanced

[fm_expense_allocation_rule] Displays the Script  field on the 
Expense Allocation Rules form if the 
Advanced  check box is selected.

Client Scripts

Cost Management adds the following client scripts.
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Client Scripts

Name Table Description

Calculate 
Tax Cost - 
Base cost

[fm_rate_card] On the contract rate card record, calculates 
the tax cost and total cost based on changes 
to the base cost.

Calculate 
Tax Cost - 
Sales tax

[fm_rate_card] On the contract rate card record, calculates 
the total cost if the Sales tax option is 
selected.

Calculate 
Tax Cost - 
Tax rate

[fm_rate_card] On the contract rate card record, calculates 
the tax cost and total cost based on changes 
to the tax rate.

Set Rate 
Card End 
Date

[fm_contract_rate_card] On the contract rate card record, sets the rate 
card end date to the contract end date if the 
contract has an end date.

Business rules

Cost Management adds the following business rules.

Business rules

Name Table Description

Calculate Totals with Tax [fm_recurring_rate_card] Updates the Tax rate, 
Tax cost, and Total cost 
fields when Sales tax, 
Base cost, or Tax rate 
field values change.

Process time card [time_card] Creates an expense 
line after a time card is 
approved.

fm_calcBudgetValues [fm_budget] Updates remaining 
budget amount when 
planned or actual values 
change.

fm_Disable rate card costs [fm_ci_rate_card] Disables all rate card 
costs when a rate card is 
disabled.

fm_InsertBudget [fm_budget] Shows a message with 
the next budget number 
when a new record is 
inserted.

fm_Populate Month Field [fm_expense_allocation] Fills in the Month  field 
based on the Expense 
date  field.

fm_processExpenseAllocation [fm_expense_line] Processes expense 
allocation rules when an 
expense line is created 
for pending items.
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Business rules  (continued)

Name Table Description

fm_Set default next process [fm_ci_rate_card_cost] Sets the default next 
process date for a new 
configuration item rate 
card cost.

fm_Set default next process [fm_distribution_cost] Sets the default next 
process date for a new 
distribution cost.

fm_updateAllocationAvailable [allocation_unit] Recalculates the number 
of available units when 
the number of allocated 
units is updated.

fm_updateAllocationUnits [fm_cmdb_rel_cc] Recalculates the number 
of allocated units for a 
business service.

Next process date validation [fm_contract_rate_card] If the next process date 
for the contract rate card 
is after the start date, this 
business rule sets the 
next date to the start date.

Prevent more than one 
allocation per ci

[allocation_unit] Prevents more than 
one allocation per 
configuration item.

Process CI Relationships [fm_expense_line] Processes parent related 
items and generates 
expense lines for 
configuration item source 
expenses. Processes 
task cost into affected 
configuration item 
expense lines for task 
source expenses.

Process Task Rate Cards [task] Processes task rate cards 
when a task is set to 
inactive.

Update Contract [fm_contract_rate_card] Rolls costs from rate card 
to contract. Updates the 
contract total cost, tax 
cost, tax rate, and base 
cost when total cost, tax 
cost or tax rate values 
change.

Update Planned Task Actual 
Cost

[fm_expense_line] Calculates the total 
actual costs from related 
expense lines for planned 
task source expenses.

Verify rate card's start and end 
dates

[fm_contract_rate_card] Validates that the 
rate card start date is 

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2259



Business rules  (continued)

Name Table Description

specified and is not 
after the end date. This 
business rule also:

• Validates that the rate 
card start date is not 
before the contract 
start date and that the 
rate card end date is 
not after the contract 
end date.

• Sets the rate card end 
date to the contract 
end date if a value is 
not entered and the 
contract has an end 
date.

Cost Management Demo Data
The demo data available with Cost Management provides samples of the data types to illustrate 
its use.

Demo data should be loaded only in a development or test instance to prevent conflict with 
production data.

High-Level Data Review

The Cost Overview module has a number of commonly requested reports.

Business Service Overview

The business service owner would like to know how much it costs to maintain the service over 
some period of time. This requires gathering the dependent CI costs and representing them at 
the business service level. For CI costs to roll up to business services, relationships must exist 
between CIs and services.

The demo data contains a number of services that have costs from their dependent CIs. In the 
Cost Overview  homepage, the Business Service Cost 12 Month  report shows an overview of 
this information:

Allocation Overview

Expense allocation rules costs allow you to allocate costs to one or more business entities 
such as a user, group, department, company, or cost center. The purpose of the allocation is to 
represent the cost that the business is responsible for. This is not considered charge-back or 
billing, but could be used as a source for billing. The primary purpose of expense allocation is to 
represent the consumer of the process that has incurred some expense.

The following diagram shows the distribution of expenses to cost centers.
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Budget Overview

The amount of money allocated to cost centers can be tracked against a planned budget. A 
budget represents a collection of cost centers, a duration, and the amount of money that is 
expected to be allocated to the cost centers during that period. The administration budget 
contains three cost centers and has incurred $173,610.83 so far during this period.

Cost overview module
The Cost Overview module displays various cost management reports.

It gives financial administrators and other users a summary view of key cost management 
information.

The Cost Overview is a type of homepage.

Only users with certain roles have access to the Cost Overview module. See Cost overview 
module roles  for more information.

Cost overview module roles

Only certain roles can customize Cost Overview modules. In addition to viewing, roles with 
access can refresh, add, delete, and rearrange reports.

Cost Overview Module Role Access

Role Access

admin View, customize

asset View, customize

financial_mgmt_admin View

financial_mgmt_user View

procurement_user View

sam View

CI rate cards
A configuration item (CI) rate card is a group of recurring configuration item costs associated with 
multiple configuration items. Rate cards make it easier to enter and track costs that are the same 
across multiple configuration items.

Rate cards usually follow a framework in which all costs are recorded and allocated. For example, 
the contract costs of a specific model server in a New York datacenter could be different than the 
same server model running in a Madrid datacenter. Each model would have a separate rate card 
detailing the costs.

Users with the Financial Admin (financial_mgmt_admin) and Financial User 
(financial_mgmt_user) roles can manage CI rate cards.

Create a CI rate card

You can add a CI rate card that specifies an hourly rate and associate a rate code.

Before you begin
Role required: financial_mgmt_admin
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Procedure

1. Navigate to All  > Cost  > Costs  > CI Rate Cards.

2. Click New.

3. Fill in the fields, as appropriate.

Field Description

Number
[Read-only] The CI rate card identification number. Automatically assigned.

Define 
condition Check box that indicates whether to use the Condition  field to filter 

configuration items for the rate card.

Name
The CI rate card name.

Summary 
type The CI rate card category: Grow Business, Run Business, or Transform 

Business. Categorizing can be useful for reporting.

Active
Check box that indicates whether the rate card is available for use. Clear the 
check box to disable the rate card and deactivate all associated rate card costs.

Table
The table to query with conditions for configuration items. This field is available 
if Define condition  is selected.

Condition
The condition to query on the specified Table. This field has a condition count 
widget to preview what records are captured by the conditions. This field is 
available if Define condition  is selected.

Short 
Description A brief description of the rate card.

Add a condition to a CI rate card

If you're adding a condition to a CI rate card, use the Update CI List  related link to create the 
relationship between the configuration item or items and the rate card.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Costs  > CI Rate Cards.

2. Select a rate card.

3. Select Define condition.

4. Create the Condition.

5. Right-click the header bar and select Save.

6. In Related Links, select Update CI List.
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Example 

Update CI List

7. Select one of the choices.

◦ Replace:  removes any existing items that do not match the condition and adds all remaining 
items from the condition results.

◦ Merge:  keeps existing items and adds all remaining items from the condition results.

8. Select Return to rate card.

CI rate card costs

CI rate card costs generate expense lines for configuration items on the associated rate card

Costs associated with rate cards are stored in the Rate Card Cost (fm_ci_rate_card_cost) 
table. Each cost is applied to every configuration item associated with the rate card when the 
costs are processed.

Expense Line is active by default.

Add a CI rate card cost

You can add a rate card cost to the CI rate card.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Costs  > CI Rate Cards.

2. Select a rate card.

3. In the Rate Card Costs  related list, click New.

4. Enter a Start date.

5. Fill in the fields, as appropriate.
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Field Description

Number
[Read-only] The rate card cost identification number. Automatically assigned.

Rate card
The identification number of the rate card to which this rate card cost is 
associated.

Name
The rate card cost name.

Active
Check box that indicates whether to enable cost processing for this cost.

Short 
description

A brief description of the rate card cost. The description is used to identify the 
processed cost on an expense line record.

Start date
The date the cost should start being processed.

End date
The date the cost should stop being processed.

Interval
The frequency at which the rate card cost recurs.

Recurring
Check box that indicates whether the cost is a repeating cost. Also sets 
generated expense lines to show as recurring. If this check box is cleared, no 
further expenses are generated automatically.

Sales tax
Check box that indicates whether to apply sales tax to the cost.

Tax rate
The tax rate to apply to the cost.

Order Used by task rate cards.

Last 
processed [Read-only] The date and time this cost was last processed.

Next 
process The next date on which new expenses will be processed based on the Process 

FM Costs scheduled job.

Base cost
The amount that must be paid before taxes.

Tax cost
Total cost of the tax.

Total cost
Total rate card cost, including taxes.

Description
Detailed description of the rate card cost.
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Remove a rate card cost

You can remove a rate card cost on the CI Rate Card form.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Costs  > CI Rate Cards.

2. Select a rate card.

3. In the Rate Card Costs  related list, click a Number.

4. Click Delete.

Disable a rate card cost

To prevent a cost from processing, clear the Active  option. Use the option to make a rate card 
cost permanently inactive or to temporarily skip a cost from processing.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Costs  > CI Rate Cards.

2. Select a rate card.

3. In the Rate Card Costs  related list, click a Number.

4. Clear the Active  check box.

Modify a rate card cost

Configuration item costs often change over time as facilities or vendor rates change.

Before you begin
Role required: financial_mgmt_admin

About this task
Expense lines are the snapshot of a given interval's costs, so changing the cost does not affect 
already generated expense lines. When costs change, either modify the cost amount or disable 
the current cost and create a new cost to represent the cost going forward. The changes are 
processed in the next generated expense line. To keep historical records of costs, create new 
costs rather than modifying existing ones and set the end date of the disabled cost to show that 
the cost agreement expired.

Procedure

1. Navigate to All  > Cost  > Costs  > CI Rate Cards.

2. Select a rate card.

3. Click a rate card cost Number.

4. Modify the fields, as necessary.

Aggregate CI costs

Expense lines can be aggregated to apply all configuration item expenses to a parent business 
service or application with relationship paths.
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Define relationship paths from a child configuration class to one or many parent classes. If a 
path does not match one of the relationship path record criteria, the path is not viewed as a 
relationship when determining expense aggregations. See CI relationships.

Enable relationship aggregation

The Process Last Month CI Costs scheduled job processes costs of configuration items. To start 
aggregating expenses to parents, identify the relationships to use for aggregation. Because there 
are many options for CMDB relationships, using all available paths for aggregation is generally 
not efficient.

Before you begin
Role required: financial_mgmt_admin

About this task
You can have multiple relationships for each child class. For example, to enable only certain 
relationships or parent classes, create a new record for each type and class combination paired 
with the child class.

When an expense line is generated from a configuration item cost, the parents of the 
configuration item are evaluated. The parent class and relationship type are compared to the 
list of relationship path records to see if there is a match to use for aggregation. If there is a 
match, an expense line is generated for the parent configuration item. The process repeats for all 
parents until there are either no parent relationships or the relationships in place do not meet the 
criteria defined in the relationship path records.

Procedure

1. Navigate to All  > Cost  > Administration  > Relationship Paths.

2. Click New.

3. Fill in the fields, as appropriate.

Field Description

Active
Check box that indicates whether the relationship path is enabled.

Child class
The child configuration item class. This class is the source of the expense 
generated during configuration item cost processing.

All parent 
classes Check box that indicates whether CI relationships in the CMDB  to all parent 

classes are processed.

Parent class
A valid parent CI class for the selected child class. Available only if All parent 
classes  is not selected.

All 
relationships Check box that indicates whether all relationship types between the child and 

parent classes are processed.

Relationship 
type The type of relationship to process between the child and parent classes. 

Available only if All relationships  is selected.
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What to do next
When a configuration item has multiple parents that have valid relationship paths, the amount 
aggregated to each parent is split to prevent over-aggregation of a item cost. When evaluating 
parent relationships to active relationship paths, the aggregation counts the total number of 
valid relationships. The expense line amount from the child configuration item is evenly divided 
among the number valid paths and that amount is used when creating the inherited expense line 
for the parent.

Task and labor rate cards
In Cost Management, task rate cards and labor rate cards capture operating costs by generating 
expense lines representing the cost of performing a task

• Task rate cards are templates used to define the type of task and the method of calculating the 
associated costs.

• Labor rate cards are templates used to define worker's labor rates when calculating task cost 
based on time worked.

Manage a labor rate card

The labor rate card associates a rate code with a labor rate.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Labor Rate Cards.

2. Create or edit a record (see table for details).

Field Input Value

Name
String field summarizing the purpose of the rate card.

Rate 
code For reference use only, if you want to align rates with an external system.

Rate type The rate type that is used to determine if the labor rate card matches with the rate 
type on the time card.

Active
Check box which determines if the rate card will be actively used.

Hourly 
rate Identifies the hourly rate to be applied to task time worked entries if the worker 

meets the condition defined.

Condition
Defines a filter on the user table to determine whether the task time worked user 
applies to this rate card. This field uses the Condition Count Widget to preview 
what records would be returned by the conditions.

Rate type in labor rate card

The rate type functionality is used to categorize different types of work. For example, Standard 
versus Overtime.
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The Labor Rate Card form contains options to specify rate type, specify hourly rate for the 
rate type, and specify users for whom the labor rate card is applicable. A single user can be 
associated with multiple labor rate cards that contain different rate types.

Assume that a user logs time against a task and selects the rate type Standard in the Time 
Cards form. Upon approval, the expense line (cost) for the time card is derived by matching 
the user and rate type on the time card to a labor rate card assigned to that user, and that 
has the same rate type. When the user has multiple labor rate cards with the same rate type, 
the expense line is generated based on the labor rate card that has the lowest value in the 
Order  field. When there is no labor rate card associated with the user and rate type, the default 
hourly rate found in theTime Sheets  > Administration  > Time Sheet Policy  form is used 
(com.snc.time_card.default_rate  property).

Note: 
A user can enter a rate type only if it is permitted by the users Time sheet policies.

Related topics

Create a rate type

Manage a task rate card

Task rate cards are rate cards associated with records in a task table.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Costs.

2. Create or edit a record (see table for details).

Field Input Value

Name
String field summarizing the purpose of the rate card.

Table
Which type of tasks the rate card applies to.

Order
If more than one task rate card apply to the same task, the one with the lowest 
order is used.

Active
Check box which determines if the rate card will be actively used.

Summary 
type High-level type of expense for easier summary reports. This value will be used to 

set the expense line summary type field.

Condition Filter to run on the table selected to determine whether this rate card applies to 
a given task. This field uses the Condition Count Widget to preview what records 
would be returned by the conditions.

Task rate Rate of the task, with a currency list. To add a new currency, use the Edit  link.
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Field Input Value

Use time 
worked By default a flat rate per task is defined in the rate card. Selecting the check box 

will force the rule to calculate the task cost based on the related task time worked 
entries.

Default 
labor rate Defines the default hourly rate to apply to the time worked entries if the worker 

does not have a labor rate card. Displayed when Use time worked  is selected.

Process task rate cards

The business rule Process Task Rate Cards runs when tasks close and checks to see if any task 
rate cards apply. If they do, an expense line is created according to the rate card.

The process flow of the "Process Task Rate Cards" business rule is:

1. Task closes.

2. Business rule runs.

3. Query active task rate cards in order looking for a matching condition.

4. Qualifying rate card not using time worked.

Generate expense line linked to the task using the task rate value.

5. Qualifying rate card using time worked.

a. Get task time worked entries for the task grouped by user (worker).

b. For each user, check to see if they match conditions in any of the labor rate cards.

i. Labor rate card found, generate expense line using the time worked and labor rate.

ii. Labor rate card not found, generate expense line using the default labor rate from the task 
rate card.

Budgets and cost centers
Understand what budgets and cost centers are and how to manage them in the Cost 
Management  application.

Budgets

Budgets allow tracking of planned and actual spending. Budgets are defined for a 
given time period for one or more cost centers.

Cost centers

Cost Centers are used to represent a business entity. All expense allocations 
assigned to the budget's cost center during the budget period are used to calculate 
the budget's actual expense allocations.

It is also possible to assign a cost center to a budget from the cost center record. 
The cost center record contains a budgets related list.

Budgets and cost centers example

The most common business entity to associate financial information is the cost center.
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The example here shows how cost centers can be allocated expenses based on service usage. 
This example uses that information to compare with a defined budget for the cost centers.

A budget is a placeholder for an amount of planned spending for one or more cost centers. To 
view an example, navigate to Financial Management  > Budgets  and select the Investments 
budget:

This budget has a defined start and end date, planned amount, and actual amount. In the Cost 
Center  related list, Trading  is a member.

For all expense allocations assigned to the Trading  cost center during the budget time periods, 
the allocations will be totaled to populate the actual budget field. The related expense allocation 
records can also be viewed in the Expense Allocations  related list.

Create or update cost centers

Define a new cost center or update the details of the existing cost centers.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Config  > Cost Center.

2. Select a cost center record to edit or select New  to create one.

3. On the form, fill in the fields.

Cost Center form

Field Description

Name Name of the cost center.

Manager Manager of this cost center.

Account number Account number for this cost center.

Valid from Date this cost center is valid from. Select a 
date using the calendar option.

Code Code assigned to this cost center.

Valid to Date this cost center is valid up to. Select a 
date using the calendar option.

Location Location of this cost center. Select one using 
the lookup option.

Parent Parent cost center, if any. Select one using 
the lookup option.

4. Select Submit.

What to do next
Review the related lists for this cost center and update them as necessary. See Cost centers 
related records.

Related topics

Budgets and cost centers
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Create or update a budget

Cost management provides budgets for you to plan expenses for a certain time period.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Config  > Budgets.

2. Select a Budget to edit or select New.

3. Fill in the form (see table)

Budget form

Field Input value

Number System generated record number.

Name String field for the name of the budget.

Start Date field defining the beginning of the budget period.

End Date field defining the end of the budget period.

Planned Currency field representing the planned amount of expenses for the associated 
cost centers during the budget period. This value is inputted or imported.

Actual Currency field representing the actual amount of expenses for the associated 
cost centers during the budget period. This is a calculated field using the list of 
expense allocations for the cost centers.

Remaining Currency field representing the amount of planned minus actual expenses. This 
is a calculated field.

Projected Currency field representing the estimated amount of expenses for the 
associated cost centers during the budget period. An average daily expense 
amount is calculated and applied to the rest of the budget period to determine 
the estimated projection.

What to do next
Review the related lists for this budget and update them as necessary. See Budget related 
records.

Related topics

Budgets and cost centers

Cost centers related records

Cost centers are related to additional records, displayed as related lists on its form.

The Cost Management  plugin adds the following related lists to the cost center record. You can 
add additional records in these related lists or remove existing ones.

• Budgets: Budgets that this cost center is a member of.

• CI Cost Center Relationships: Defines how much of a business service capacity this cost 
center is consuming.

• Expense Allocations: Shows all the expense allocation records that have this cost center as 
the target.
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Cost center related lists

Associate cost centers to a budget

You create cost centers and associate budgets and expense allocations with them.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Open an existing budget from the Cost  > Config  > Budgets  module.

2. Make sure the Cost Centers related list is displayed.

3. Use the Edit to add or remove existing cost centers from the budget.

4. Use the New button to create a new cost center record.

Using distribution costs and rules
Distribution Costs are costs which can be divided among a group of records.

For example, the cost of power at a datacenter which can be divided among the CIs in the 
datacenter.

Distribution Rules determine how the Distribution Costs are divided among the CIs.

Defining Distribution Costs

To define new distribution costs, navigate to Financial Management  > Cost Management  > 
Distribution Costs, and select New. Populate the following fields:

Defining Distribution Costs

Field Input Value

Number A system-generated unique identifier for the Distribution Cost.

Name A human-readable identifier for the cost.
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Defining Distribution Costs  (continued)

Field Input Value

Amount The amount of the cost, with a currency list. To add a new currency, use the Edit 
link.

Distribution 
Rule

Select a Distribution Rule to determine how the costs are distributed to CIs. For 
more information, see Distribution Rules.

Active Determines if the cost is actively used.

Start Date The date of the cost, or if the cost is recurring, the first date of the cost.

Recurring If checked, the cost will recur, and will be added regularly.

End Date If Recurring  is true, the last date to add the distribution cost.

Summary 
Type

Identifies a high-level type of expense for easier summary reports. This value will 
be used to set the expense line summary type field.

Interval If Recurring  is true, the time between each addition of the distribution cost 
between Start Date  and End Date.

Last 
Processed

A read-only display of the last time the distribution cost was processed.

Next 
Process

A read-only display of the scheduled next process date.

Defining distribution rules

Define distribution rules to view distribution costs that are distributed according to the rules.

To define new distribution rules, navigate to Financial Management  > Admin  > Distribution Cost 
Rules, and select New and populate the following:

Distribution Rules form

Field Input Value

Name A unique name for the rule.

Active Determines if the rule is actively used.

Advanced If checked, the distribution rule will be determined by script. If not checked, it will 
be determined by table and conditions.

Description A description of the rules and any notes on its use.

Script If Advanced  is true, the script which will determine the rule's behavior.

Table If Advanced  is false, a list list of tables to find the records to distribute the cost to.

Condition If Advanced  is false, a condition builder to determine which records will receive 
the distributed cost, on the table determined by the Table  field. Cost amount will 
be distributed evenly across the records identified by the table and condition 
values. This field uses the Condition Count Widget to preview what records would 
be returned by the conditions.

Once submitted, the Distribution Costs related list is displated, which helps determine which 
costs will be distributed according to the rules.
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Scripted distribution

Scripted distributions allow for custom distribution amounts, versus the evenly split distributions 
when using table and condition filters.

To enable scripted processing on a distribution rule:

• Check the advanced field check box, this will display the script field.

• Build the script using the following concepts:

◦ Query for target records and data to use for calculating the allocation amount.

◦ Create expense line records using the ExpenseLine API.

For more information, see ExpenseLine .

As noted in the default script, when the advanced field is enabled, the following variables are 
available during the script processing:

• distCost  - GlideRecord for the distribution cost, allowing access to all fields.

• distCostAmount  - cost amount in the system currency.

Processing Distribution Costs

A scheduled job called Process FM Costs  automatically processes distribution costs daily.

Use business services with expenses
Manage the relationships between business services and their expenses with allocation units 
and cost centers.

Define a cost center

Cost centers are a commonly used reference between financial systems and IT. Cost center 
records represent business entities, and have a related list of CI Cost Center Relationships that 
measure the cost center's consumption of business services.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Config  > Cost Center.

2. Select a record to edit or select New.

Field Description

Name A unique name for the cost center.

Account Number An account number associated with the cost center, if one exists.

Code A code associated with the cost center, if one exists.

Location A reference to the location of the cost center.

Manager A reference to the user who manages the cost center.

Valid from The date that the cost center is valid from.

Valid to The date that the cost center is valid to.
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CI Cost Center Relationships

Field Description

Service A reference to a Business Service.

Cost 
Center

The cost center to apply the relationship to. If reached through the related list, it 
should already be related to the appropriate cost center.

Allocation 
Percentage

Feature not yet implemented.

Allocation 
Type

A choice list. Should be Units.

Allocation 
Units

The number of units that the cost center is using. This is measured using the 
same type of unit used to define the total capacity of the business service in 
the allocation unit record. This number will be used to update the number of 
allocated units in the allocation unit record. It will also be used to determine the 
amount of expenses to allocate to the cost center based on the percentage of 
business service used versus the total capacity.

Default allocation rule

For every expense line generated for a business service, the default allocation rule Process Svc-
CC Relationships will attempt to process the expense and create allocations for each cost center 
that is consuming the service.

The amount of the expense allocation is calculated by dividing the number of units the cost 
center is consuming by the total number of units for the business service. This calculation 
method is refereed to as "all unit" allocation as it uses the total unit capacity to determine the 
allocation percentage.

Refer to the demo walk-through for a detailed example.

For a given business service expense line, it is typical that less than 100% of the expense would 
be allocated using this method not all units have been allocated to cost centers. The unallocated 
expenses could be considered IT overhead. Some organizations prefer to show 100% expense 
allocation regardless of how many units are in use. This method is referred to as "allocated unit" 
since the percent of allocation calculated by dividing the number of units the cost center is 
consuming by total number of allocated units from all cost centers.

Allocation 
calculation 
method

Example

all_units Service supports 100 units but only has 50 units allocated, and cost center 
ABC is allocated 25 units. This method will result in an allocation cost of 
25/100, or 25% of the total cost of the service. 50% of the expenses (from the 
50 unallocated units) will not be allocated.

allocated_units Service supports 100 units but only has 50 units allocated, and cost center 
ABC is allocated 25 units. This method will result in an allocation cost of 
25/50, or 50% of the total cost of the service. 100% of the expenses will be 
allocated, showing full cost recovery.

This is a system wide setting that can be configured by navigating to Financial Management  > 
Properties  module and selecting an option from the choice list.
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Define an allocation unit

Allocation unit records define the capacity and usage of a business service.

Before you begin
Role required: financial_mgmt_admin

Procedure

1. Navigate to All  > Cost  > Config  > Allocation Units.

2. Select a record to edit or select New.

Note: 
Selecting the name of the configuration item will display the CI record, not the Allocation 
Units.

Field Description

Configuration 
Item

Select the Business Service to define allocation units for.

Total Units The total number of units of expense available to allocate. A unit is a generic 
measurement which can represent anything. Should match the cost center 
relationship unit. What units represent can be recorded in the Unit Type  field. 
Using the Total units  option may result in unallocated expenses if there are 
unallocated business service units. Using the Allocated unit  option always 
results in 100% expense allocations.

Allocated 
Units

How many of the total units are allocated. Populated by script.

Available 
Units

How many of the total units are unallocated. Populated by script.

Updated When the units were last updated.

Unit Type 
(added by 
configuring 
the form)

Used to record what the units represent (e.g. seats, licenses, Gigabytes, and 
so on).

Cost sources
There are a several ways to generate expense lines for objects in the system.

These are generally classified as one of three types:

• CI costs

• Task costs

• Custom generated costs - these are not covered in the demo data, refer to the ExpenseLine 
API for more information.

CI Rate Cards

A CI rate card is a template that defines costs for a particular type of CI. This example uses only 
server-related costs. Since there are only a few different server models and the costs are the 
same for each model, CI rate cards can define a template of costs for each model.
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Following is the Sun E20K Servers NY rate card:

It represents the common costs and CIs in the UNIX servers in the NY datacenter, regardless of 
what the server is used for.

The related lists contain information on how this rate card is used. The Configuration Items 
related list display the each of the servers that will use this rate card. This list of items can be 
managed manually with the Edit  button or with the Update CI List  related link. The rate card 
condition for this rate card is Table=Unix Server. Clicking the Update CI List  related link shows 
two things:

• CIs that are a member of the rate card but do not match the condition.

• CIs that match the condition but are not a member of the rate card.

To "true-up" the rate card, use the Replace  or Merge  button.

In this case, there are two extra UNIX servers that are not in the rate card. Use the Merge  button 
to add them. The rate card now shows nine items.

Note: 
Counts may vary if there are additional CIs in the instance.

The Rate Card Costs  related list displays the recurring costs that all of the servers will incur, in 
this case on a monthly basis.

Adding the Expense Line  related list to the CI Rate Card form shows the list of expense lines that 
have been generated from this rate card's costs. Here are the expenses for the Server backup 
services for two of the servers:

Distribution Costs

For more generic bulk costs that are generated by multiple CIs, distribution costs can 
represent the broader costs where individual CI rate cards do not apply. Navigate to Financial 
Management  > Distribution Costs  to view a few examples.

Select Datacenter Facilities (amort)  from the list:

In this example, the datacenter's power costs for a month have been amortized and represented 
as a monthly recurring distribution cost.

This bulk cost should be distributed to all servers evenly to enable reporting on costs per server 
and cost center. This is accomplished with the Distribution Rule  listed on the cost's form. To view 
the distribution cost, click the reference icon for the All Installed Servers  rule in the Distribution 
rule  field:

This rule takes the $5,500 and distributes it to each of the servers that match the rule condition. 
The condition here is All servers with install status of installed. The '"View Condition Results 
related link displays the current records matching the condition.

Task Costs

Task-related activity can also generate expense lines to track the costs associated with 
processing tasks. The primary method of generating task-related costs is to use Task Rate 
Cards.

Task Rate Cards

A task rate card is a condition-based record that the system uses to determine how to calculate 
the costs of a task.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

2277



To view an example, navigate to Financial Management  > Task Rate Card  and select Incident 
P1:

Rate cards are processed whenever a task is closed. This processing is triggered by a business 
rule. The rate card contains the following information:

• When an incident with priority 1 - Critical  is closed, it generates an expense line for $150.

• This is a flat rate defined for each P1 incident.

The Expense Line  related list displays the list of expenses that have been created by this rate 
card.

Return to the Task Rate Card  list and open the Change Request (emergency)  rate card:

This rate card for emergency change requests demonstrates an example of creating a task cost 
based on the amount of time it took to work the task, instead of the flat rate model in the incident 
rate card.

• The Use time worked  flag in the rate card tells the system to use the task time worked records 
associated with the task when determining the task cost.

• Processing this rate will:

◦ Query the list of task time worked records for the task.

◦ Attempt to resolve an hourly rate for the user in the task time worked record, or use the 
default rate of $250/hr defined in the rate card.

◦ Generate an expense line for each time worked entry.

The Expense Lines  related list shows the expenses generated from this rate card.

Labor Rate Cards

Labor rate cards are a way to define common patterns for hourly worker rates so rates need not 
be managed for each individual in the system.

To view the sample rates, navigate to Financial Management  > Labor Rate Cards  and select the 
Development  rate card:

The conditions state that for users in the Development  department, time worked costs will use 
$100 as the hourly rate.

CI relationships
To get reports that represent the total costs for a business service, there must be some 
association between the service and the CIs that make up the service. This is done with CI 
relationships.

Before you begin
Role required: financial_mgmt_admin

About this task
Use the demo data of the Cost Management  plugin to understand how to check all expense lines 
related to a business service.

Procedure

1. Navigate to All  > Cost  > Config  > Business Services.

2. Select Retail.
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3. View the business service map by selecting the dependency views icon ( ).

This view shows that the dbaix901nyc server is a dependency of the Retail Adding Points, 
Retail POS, and Retail business services. So whenever the dbaix901nyc server incurs a cost, it 
would be represented at each of the business services.

The dbaix901nyc server is a member of the Sun E20K Servers NY CI rate card, so the expenses 
can be verified from this CI rate card.

To view them:

a. Navigate to All  > Cost  > Costs  > CI Rate Cards.

b. Select Sun E20K Servers NY.

c. Select the Expense Line related list.

If this related list is not available, configure your form layout to display the Expense Line → 
Rate Card related list.

d. Filter the related list for short description contains dbaix901nyc.

The server's expenses are now visible:

Example server expenses

This example contains one direct expense (inherited = false), and three inherited expenses 
that have been generated from other direct expenses. These inherited expenses are based on 
CI relationships, which allow for reporting at any business service level.

For more information on expense aggregation, see Enable relationship aggregation.

Allocating expenses
Expenses can also be allocated to a business entity that is responsible for the expense.

This is not considered charge-back or billing but could be used as a source for billing. The 
primary purpose of expense allocation is to represent the consumer of the process that has 
incurred some expense. This can be accomplished by defining expense allocation rules.

Simple Example

This example demonstrates allocating every server-related expense line to the department 
responsible for the server.

To view the example:

1. Navigate to Financial Management  > Expense Allocation Rules.

2. Remove the list filter to view inactive rules as well as active ones.

3. Select the Server - Department  rule.
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The rule states that for every expense line associated (Expense source  field) with a server that 
has one of the selected statuses, generate an expense location record for 100% of the expense 
amount and assign the allocation to the server's department.

To view expense allocations, add the Expense Allocation  related list to the form. The Target  field 
is the business unit that the expense is allocated to.

Complex Example

A more common example would be to allocate the costs of a business service to the business 
consumers. Since cost centers are generally used when referring to business finances, this 
example allocates business service costs to each cost center that is consuming the service and 
bases the amount allocated on the amount of the service the cost center consumes.

To view the example, navigate to Financial Management  > Business Services  and select Retail. 
Switch to the Cost  view to gain access to additional related lists.

The Allocation Units  record defines the amount of capacity that this service provides. In this 
case, the Retail service can support 50 locations (units), of which 45 are allocated. A unit is a 
generic concept that can represent something that makes sense for that business service. This 
record uses units to represent allocation. The objective is to use the unit count and the cost 
center unit count to determine a percentage of total to calculate the allocation amount.

The CI Cost Center Relationships list shows which cost centers are using the service and 
how many units they are using. This information is used to determine how much of the service 
expenses to allocate to each cost center. For example, the Trading department is using 10 of the 
50 allocated units, so they will be allocated 20% of all Retail expenses. There's also an option to 
allocate based on the total (10 or 45).

To see how the expense lines are allocated, select an entry in the Expense Lines  related list and 
add the Expense Allocation  related list to the Expense Line form.

The following is an expense from the dbaix901nyc server for $2,500. Two expense allocations 
are generated from the expense. The Trading  cost center was allocated $500 (20%) of the 
expense based on the CI cost center relationship seen earlier.

This type of business-service-to-cost-center allocation is accomplished through the Process 
Svc-CC Relationships  expense allocation rule. This is an advanced rule that uses script to 
determine the allocation logic.

Budget related records
Budgets are related to additional records, displayed as related lists on its form.

The following are the related lists on a Budget record. You can add additional records to these 
related lists or remove existing ones.

• Cost Centers: Shows the cost centers that are a member of this budget.

• Expense Allocations: Shows all of the expense allocation records during the budget time 
period for all of the budget's cost centers.

Domain separation and Cost Management
Domain separation is unsupported in Cost Management. Domain separation enables you to 
separate data, processes, and administrative tasks into logical groupings called domains. You 
can control several aspects of this separation, including which users can see and access data.
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Support level: No support

• The domain field may exist on data tables but there is no business logic to manage the data.

• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation .

Related topics

Domain separation for service providers

SPM  custom tables
Strategic Portfolio Management  (SPM) includes several custom tables that enable you to 
enhance SPM  according to your specific business requirements. These tables are provided 
without predefined business logic, allowing you to use them as fully customizable entities to suit 
your unique needs.

SPM  custom tables
The SPM  custom tables enable organizations to scale Strategic Portfolio Management  by 
integrating custom features and business-specific functionality.

The following tables from the Strategic Planning  application and the PPM Standard  plugin 
support Microsoft Active Directory  SPM implementations, with a focus on cost efficiency and 
scalability for large-scale deployments, particularly within financial institutions.

Table Description
Application/
Plugin

Custom planning item 1

[sn_align_core_custom_planning_item_1]

Stores information for an additional 
planning item type.

Strategic 
Planning

Custom planning item 2

[sn_align_core_custom_planning_item_2]

Stores information for an additional 
planning item type.

Strategic 
Planning

Custom planning item 3

[sn_align_core_custom_planning_item_3]

Stores information for an additional 
planning item type.

Strategic 
Planning

Custom planning item 3

[sn_align_core_custom_planning_item_3]

Stores information for an additional 
planning item type.

Strategic 
Planning

Custom planning item 4

[sn_align_core_custom_planning_item_4]

Stores information for an additional 
planning item type.

Strategic 
Planning

Custom planning item 5

[sn_align_core_custom_planning_item_5]

Stores information for an additional 
planning item type.

Strategic 
Planning

Inbound Actuals Configuration

[sn_invst_pln_inbound_actuals_config]

Import and map project codes from 
ERP systems to SPM.

PPM 
Standard
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Table Description
Application/
Plugin

Inbound Actuals

[sn_invst_pln_inbound_actuals]

Import expense lines from ERP 
systems to SPM.

PPM 
Standard

Related topics

Planning item configuration for lenses and portfolio plans

Define a new planning item type in Strategic Planning

Enable custom item types in Strategic Planning

Investment Funding administration
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